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1 iPod shuffle Basics
Congratulations on purchasing iPod shuffle. Read this 
chapter to learn about the features of iPod shuffle, how 
to use its controls, and more.
To use iPod shuffle, you put songs and other audio files on your computer and then 
load them onto iPod shuffle.
Use iPod shuffle to:
Â Load songs for listening on the go
Â Listen to podcasts, downloadable radio-style shows delivered over the Internet
Â Listen to audiobooks purchased from the iTunes Store or audible.com
Â Store or back up files and other data, using iPod shuffle as an external disk4 Chapter 1    iPod shuffle Basics 
iPod shuffle at a Glance
Using the iPod shuffle Controls
The simple controls make it easy to play songs, audiobooks, and podcasts on 
iPod shuffle.
Headphones port
Previous/Rewind
Play/Pause
Next/Fast-forward
Volume Down Power switch
Top status light
Volume Up
Shuffle switch Bottom status light
OFF
To Do this
Turn iPod shuffle on or off Slide the power switch (green indicates iPod shuffle is on).
Play Press Play/Pause (’). 
Pause Press Play/Pause (’)
Change the volume Press Volume Up (∂) or Volume Down (D).
Set the play order Slide the shuffle switch (¡ to shuffle, ⁄ to play in order).
Skip to the next track Press Next/Fast-forward (‘).
Start a track over Press Previous/Rewind (]).
Play the previous track Press Previous/Rewind (]) twice.
Go to the first track Press Play/Pause (’) three times quickly.
Fast-forward or rewind Press and hold Next/Fast-forward (‘) or Previous/Rewind (]).
Disable the iPod shuffle buttons
(so nothing happens if you press 
them accidentally)
Press Play/Pause (’) for about three seconds (until the status 
light blinks orange three times).
Repeat to reenable the buttons (the status light blinks green 
three times).
Reset iPod shuffle
(if iPod shuffle isn’t responding)
Remove iPod shuffle from the Dock. Turn iPod shuffle off, wait 
5 seconds, and then turn it back on again.
Find the iPod shuffle serial 
number
Look on the notch underneath the clip on iPod shuffle. Or, in 
iTunes (with iPod shuffle connected to your computer), select 
iPod shuffle in the Source pane and click the Settings tab.Chapter 1    iPod shuffle Basics 5
Connecting and Disconnecting iPod shuffle
Connect iPod shuffle to your computer to load songs and other audio files, and to 
charge the battery. Disconnect iPod shuffle when you’re done.
Connecting iPod shuffle
To connect iPod shuffle to your computer:
m Plug the included iPod shuffle Dock into a USB port on your computer. Then put 
iPod shuffle in the Dock.
Note:  Connect the Dock to a high-power USB port to charge the battery. A USB 2.0 
port is recommended. Do not use the USB port on your keyboard.
The first time you connect iPod shuffle to your computer, the iPod Setup Assistant 
helps you configure iPod shuffle and sync it with your iTunes library.
Important:  Once you’ve synced iPod shuffle with the iTunes library on a computer, a 
message appears whenever you connect iPod shuffle to another computer, asking if 
you want to sync with the iTunes library on the new computer. Click Cancel if you want 
to keep the current music content on iPod shuffle. Or, click Transfer Purchases to keep 
the contents on iPod shuffle and copy the purchased songs on it to the iTunes library 
on the new computer. See iTunes Help for more information.
Disconnecting iPod shuffle
It’s important not to disconnect iPod shuffle from your computer while audio files are 
being loaded or when iPod shuffle is being used as an external disk. You can see if it’s 
OK to disconnect iPod shuffle by looking at the top of the iTunes window or by 
checking the iPod shuffle status light.
Important:  If you see the “Do not disconnect” message in iTunes or if the status light 
on iPod shuffle is blinking orange, you must eject iPod shuffle before disconnecting it. 
Otherwise, you could damage files on iPod shuffle. 
If you enable iPod shuffle for disk use (see page 19), you must always eject iPod shuffle 
before disconnecting it.6 Chapter 1    iPod shuffle Basics 
To eject iPod shuffle:
m In iTunes, click the Eject (C) button next to iPod shuffle in the Source pane.
If you’re using a Mac, you can also eject iPod shuffle by dragging the iPod shuffle icon 
on the desktop to the Trash.
If you’re using a Windows PC, you can also eject iPod shuffle by clicking the Safely 
Remove Hardware icon in the Windows system tray and selecting iPod shuffle.
To disconnect iPod shuffle:
m Remove iPod shuffle from the dock.
Charging the Battery
iPod shuffle has an internal, rechargeable battery. 
For best results, charge the battery fully the first time you use iPod shuffle. A depleted 
battery can be 80-percent charged in about two hours and fully charged in about four 
hours.
If iPod shuffle isn’t used for a while, the battery might need to be recharged. 
To charge the battery using your computer:
m Connect iPod shuffle to a high-power USB port on your computer using the included 
iPod shuffle Dock. The computer must be turned on and not in sleep mode (some 
models of Macintosh can charge iPod shuffle while in sleep mode). 
When the battery is charging, the status light on iPod shuffle is orange. When the 
battery is fully charged, the status light turns green. 
Note:  If iPod shuffle is being used as a disk (see page 19) or if iTunes is loading songs or 
settings onto iPod shuffle, the status light blinks orange to let you know that you must 
eject iPod shuffle before disconnecting it.
If you don’t see the status light, iPod shuffle might not be connected to a high-power 
USB port. Try another USB port on your computer. 
Note:  You can load music while the battery is charging.
If you want to charge iPod shuffle when you’re away from your computer, you can 
connect iPod shuffle to an iPod USB Power Adapter, available at www.apple.com.Chapter 1    iPod shuffle Basics 7
To charge the battery using an iPod USB Power Adapter:
1 Connect the AC plug adapter to the power adapter (they might already be connected).
2 Plug the USB connector of the iPod shuffle Dock into the power adapter. 
3 Plug the power adapter into a working electrical outlet. 
4 Put iPod shuffle in the dock.
You can disconnect and use iPod shuffle before it is fully charged.
Note:  Rechargeable batteries have a limited number of charge cycles. Battery life 
and number of charge cycles vary by use and settings. For information, go to 
www.apple.com/batteries.
Checking the Battery Status
When you turn iPod shuffle on, or disconnect it from your computer or power adapter, 
the status light tells you approximately how much charge is in the battery. See the 
table in the following section. If iPod shuffle is already on, you can check the battery 
status without interrupting playback by quickly switching iPod shuffle off and then 
on again.
Status Lights
iPod shuffle has two status lights, one on the top and one on the bottom, that let you 
know when you’ve pressed a button, the state of the battery, that iPod shuffle is 
enabled as a disk, or if there’s something wrong. 
WARNING:  Read all safety instructions about using the iPod USB Power Adapter on 
page 28 before use.
AC plug adapter
iPod USB Power Adapter
iPod shuffle Dock cable8 Chapter 1    iPod shuffle Basics 
Turning on or disconnecting
 green Good charge (30% – 100%)
 orange Low charge (10% – 30%)
 red Very low charge (< 10%)
 no light No charge
 alternating green and two 
 orange (10 seconds)
ERROR:  iPod shuffle must 
be restored
Connected
 orange (continuous) Charging
 green (continuous) Fully charged
 blinking orange
 (continuous)
Do not disconnect (iTunes is 
syncing, or iPod shuffle is enabled 
for disk use)
Pressing buttons
 green Play (’)
 green (1 minute) Pause (’)
Pressing and holding:
 green, then three orange Disable buttons
 orange, then three green Enable buttons
green Volume up (∂) or down (D)
 three orange User-set volume limit reached
Pressing and holding:
 green Volume up (∂) or down (D)
 no light Maximum or zero volume reached
 three orange User-set volume limit reached
green Previous track (])
Pressing and holding:
 green Rewind (])
green Next track (‘)
Pressing and holding:
 green Fast forward (‘)
Any button orange No action (buttons are disabled)
 alternating green and 
 orange (2 seconds)
ERROR:  No music loaded
While iPod shuffle is playing
 blinking red (continuous) Battery nearly discharged2
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2 Loading and Playing Music
With iPod shuffle, you can take your music collection 
with you wherever you go. Read this chapter to learn 
about loading music and listening to iPod shuffle.
You use iPod shuffle by importing songs, audiobooks, and podcasts (radio-style audio 
shows) to your computer and then loading them onto iPod shuffle. Read on to learn 
more about the steps in this process, including:
Â Getting music from your CD collection, hard disk, or the iTunes Store (part of iTunes 
and available in some countries only) into the iTunes application on your computer
Â Organizing your music and other audio into playlists
Â Loading songs, audiobooks, and podcasts onto iPod shuffle
Â Listening to music or other audio on the go
About iTunes
iTunes is the software you use to sync music, audiobooks, and podcasts with 
iPod shuffle. When you connect iPod shuffle to your computer, iTunes opens 
automatically. 
This guide explains how to use iTunes to import songs and other audio to your 
computer, create personal compilations of your favorite songs (called playlists), load 
iPod shuffle, and adjust iPod shuffle settings.
iTunes also has many other features. For information, open iTunes and choose Help > 
iTunes Help.10 Chapter 2    Loading and Playing Music 
Importing Music into Your iTunes Library
To listen to music on iPod shuffle, you first need to get that music into your iTunes 
library on your computer.
There are three ways to get music into your iTunes library:
Â Buy music and audiobooks or download podcasts online from the iTunes Store.
Â Import music from audio CDs.
Â Add music and other audio that’s already on your computer.
Buying Songs and Downloading Podcasts Using the iTunes Store
If you have an Internet connection, you can easily purchase and download songs, 
albums, and audiobooks online using the iTunes Store. You can also subscribe to and 
download podcasts, radio-style audio shows.
To purchase music online using the iTunes Store, you set up an Apple account in 
iTunes, find the songs you want, and then buy them. If you already have an Apple 
account, or if you have an America Online (AOL) account (available in some countries 
only), you can use that account to sign in to the iTunes Store and buy songs.
To sign in to the iTunes Store:
m Open iTunes and then:
Â If you already have an iTunes account, choose Store > Sign In.
Â If you don’t already have an iTunes account, choose Store > Create Account and follow 
the onscreen instructions to set up an Apple account or enter your existing Apple 
account or AOL account information.
To find songs, audiobooks, and podcasts:
You can browse or search the iTunes Store to find the album, song, or artist you’re 
looking for. Open iTunes and click iTunes Store in the Source pane.
Â To browse the iTunes Store, choose a music genre from the Choose Genre pop-up 
menu, click one of the displayed releases or songs, or click Browse in the main iTunes 
Store window.
Â To browse for podcasts, click the Podcasts link in the main iTunes Store window.
Â To search the iTunes Store, type the name of an album, song, artist, or composer in the 
Search iTunes Store field.Chapter 2    Loading and Playing Music 11
Â To narrow your search, type something in the Search iTunes Store field, press Return 
or Enter on your keyboard, and then click items in the Search Bar. For example, to 
narrow your search to song titles and albums, click MUSIC.
Â To search for a combination of items, click Power Search in the iTunes Store window.
Â To return to the main page of the iTunes Store, click the Home button in the top-left 
corner of the main iTunes Store window.
To buy a song, album, or audiobook:
1 Click iTunes Store in the Source pane, and then find the item you want to buy.
You can double-click a song or other item to listen to a portion of it and make sure it’s 
what you want.
2 Click Buy Song, Buy Album, or Buy Book.
The item is downloaded to your computer and charged to the credit card listed in your 
Apple or AOL account.
To download or subscribe to a podcast:
1 Click iTunes Store in the Source pane.
2 Click the Podcasts link on the left side of the main page in the iTunes Store.
3 Browse for the podcast you want to download.
Â To download a single podcast episode, click the Get Episode button next to the 
episode.
Â To subscribe to a podcast, click the Subscribe button next to the podcast graphic. 
iTunes downloads the most recent episode. As new episodes become available, they 
are automatically downloaded to iTunes when you connect to the Internet.
Importing Music from Your Audio CDs into iTunes
Follow these instructions to get music from your CDs into iTunes.
To import music from an audio CD into iTunes:
1 Insert a CD into your computer and open iTunes. 
If you have an Internet connection, iTunes gets the names of the songs on the CD from 
the Internet (if available) and lists them in the window.
If you don’t have an Internet connection, you can import your CDs and, later, when you’re 
connected to the Internet, choose Advanced > Get CD Track Names. iTunes will get the 
track names for the imported CDs. 
If the CD track names aren’t available online, you can enter the names of the songs 
manually. See “Entering Names of Songs and Other Details” on page 12.
With song information entered, you can browse for songs in iTunes by title, artist, 
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2 Click to remove the checkmark next to any song you don’t want to import from the CD.
3 Click the Import CD button. The display area at the top of the iTunes window shows 
how long it will take to import each song.
By default, iTunes plays songs as they are imported. If you’re importing a lot of songs, 
you might want to stop the songs from playing to improve performance.
4 To eject the CD, click the Eject (C) button.
5 Repeat these steps for any other CDs with songs you want to import.
Entering Names of Songs and Other Details
You can manually enter song titles and other information, including comments, for 
songs and other items in your iTunes library.
To enter CD song titles and other information manually:
1 Select the first track on the CD and choose File > Get Info.
2 Click Info.
3 Enter the song information.
4 Click Next to enter information for the next track.
Adding Songs Already on Your Computer to Your iTunes Library
If you have digital music files such as MP3s already on your computer, you can easily 
add them to your iTunes library.
To add songs on your computer to your iTunes library:
m Drag the folder or disk containing the audio files to the LIBRARY heading in the iTunes 
Source pane (or choose File > Add to Library and select the folder or disk). If iTunes 
supports the song file format, the songs are automatically added to your iTunes library.
You can also drag individual song files to iTunes. 
Note:  Using iTunes for Windows, you can convert unprotected digital music files 
created with Windows Media Player to an iTunes-compatible file format, such as AAC or 
MP3. This can be useful if you have music encoded in WMA format. For more 
information, open iTunes and choose Help > iTunes Help.
Organizing Your Music
Using iTunes, you can organize songs and other items into lists, called playlists, in any 
way you want. For example, you can make playlists with songs to listen to while 
exercising or playlists with songs for a particular mood. 
You can also make Smart Playlists that update automatically based on rules you 
choose. When you add songs to iTunes that match the rules, they automatically get 
added to the Smart Playlist.Chapter 2    Loading and Playing Music 13
You can make as many playlists as you like using any of the songs in your iTunes library. 
Adding a song to a playlist or later removing it doesn’t remove it from your iTunes 
library. 
To make a playlist in iTunes:
1 Click the Add (∂) button or choose File > New Playlist.
2 Type a name for the playlist. 
3 Click Music in the LIBRARY list, and then drag a song or other item to the playlist. 
To select multiple songs, hold down the Shift key or the Command (x) key on a Mac, 
or the Shift key or the Control key on a Windows PC, as you click each song.
To make a Smart Playlist:
m Choose File > New Smart Playlist and define the rules for your playlist.
Loading Music onto iPod shuffle
After your music is imported and organized in iTunes, you can easily load it onto 
iPod shuffle.
You set how music is loaded from iTunes onto iPod shuffle by connecting iPod shuffle 
to your computer, selecting iPod shuffle in the Source pane, and configuring options at 
the bottom of the Contents pane. Additional options for loading music and using 
iPod shuffle appear in the Settings pane.
Autofilling iPod shuffle
iTunes can automatically load a selection of your songs onto iPod shuffle with the click 
of a button. You can choose your entire library or a specific playlist to gets songs from, 
and set other options for Autofill. 
To autofill music onto iPod shuffle:
1 Connect iPod shuffle to your computer.
2 Select iPod shuffle from the list of devices in the Source pane.
3 Click the Contents tab.14 Chapter 2    Loading and Playing Music 
4 Choose the playlist you want to autofill from using the pop-up menu.
To autofill music from your entire library, choose Music.
5 Select which of the following options you want:
Choose items randomly:  iTunes shuffles the order of songs as it loads them onto 
iPod shuffle. If this option is not selected, iTunes downloads songs in the order they 
appear in your library or selected playlist.
Choose higher rated items more often:  iTunes autofills the songs you listen to most.
Replace all items when Autofilling:  iTunes replaces the songs on iPod shuffle with the 
new songs you’ve chosen. If this option is not selected, songs you’ve already loaded 
onto iPod shuffle remain and iTunes selects more songs to fill the available space.
6 Click Autofill.
While music is being loaded from iTunes onto iPod shuffle, the iTunes status window 
shows the progress. When the autofill is done, a message in iTunes says “iPod update is 
complete.”
Limiting Autofill to Items Checked in Your iTunes Library
You can set iTunes to autofill only items that are checked in your iTunes library. Items 
that you’ve deselected will be ignored.
To limit autofill to checked items:
1 Connect iPod shuffle to your computer.
2 When iPod shuffle appears in the iTunes window, select it.
3 Click the Settings tab.
4 Select “Only update checked songs.”
5 Click Apply.
Loading Songs, Audiobooks, and Podcasts Manually
You can load songs and playlists onto iPod shuffle manually. If you want to load 
audiobooks and podcasts onto iPod shuffle, you must load them manually. 
To load a song or other item onto iPod shuffle:
1 Connect iPod shuffle to your computer.
2 In iTunes, select your library or a playlist in the Source pane.
3 Drag the song or other item to the iPod shuffle in the Source pane.
You can also drag entire playlists to load them onto iPod shuffle.Chapter 2    Loading and Playing Music 15
Arranging the Order of Songs on iPod shuffle
Once songs are loaded onto iPod shuffle, you can arrange the order of the songs in the 
same way you can with any playlist in iTunes.
To arrange the order of songs on iPod shuffle:
1 Connect iPod shuffle to your computer.
2 In iTunes, select iPod shuffle in the Source pane.
3 Click the Contents tab.
4 Click the blank header above the first column to arrange the songs by number.
5 Drag the songs to the order you want.
Fitting More Songs onto iPod shuffle
If you’ve imported songs into iTunes at higher bit-rate formats, such as AIFF, you can set 
iTunes to automatically convert songs to 128 kbps AAC files as they are loaded onto 
iPod shuffle. This does not affect the quality or size of the songs in iTunes.
Note:  Songs in formats not supported by iPod shuffle, such as Apple Lossless, must be 
converted if you want to load them onto iPod shuffle. For more information about 
formats supported by iPod shuffle, see “If you can’t load a song or other item onto 
iPod shuffle” on page 24.
To convert higher bit rate songs to AAC files:
1 Connect iPod shuffle to your computer.
2 In iTunes, select iPod shuffle in the Source pane.
3 Click the Settings tab.
4 Select “Convert higher bit rate songs to 128 kbps AAC.”
5 Click Apply.
Removing Songs and Other Items from iPod shuffle
You can have iTunes automatically replace items on iPod shuffle when you load items 
using Autofill. You can also remove items from iPod shuffle manually.
To automatically replace items on iPod shuffle when autofilling:
1 Connect iPod shuffle to your computer.
2 In iTunes, select iPod shuffle in the Source pane.
3 Select the Contents tab.
4 Make sure “Replace all items when Autofilling” is selected.
To remove a song or other item from iPod shuffle:
1 Connect iPod shuffle to your computer.
2 In iTunes, select iPod shuffle in the Source pane.16 Chapter 2    Loading and Playing Music 
3 Select a song or other item on iPod shuffle and press the Delete or Backspace key on 
your keyboard.
Manually removing a song or other item from iPod shuffle does not delete the song 
from your iTunes library.
Playing Music
After you load iPod shuffle with music and other audio, you can listen to it. 
To listen to the songs and other items on iPod shuffle:
1 Plug the earphones into iPod shuffle and place the earbuds in your ears.
2 Press Play/Pause (’).
Press Volume Up (∂) or Volume Down (D) to adjust the volume. Take care not to turn 
the volume up too high. See “Setting a Volume Limit” on page 17. 
For a summary of the iPod shuffle controls, see “Using the iPod shuffle Controls” on 
page 4.
Note:  If you’re listening to an audiobook, set the shuffle switch to repeat (⁄) so that 
the chapters play in order.
Setting iPod shuffle to Shuffle Songs or Play Songs in Order
You can set iPod shuffle to shuffle songs or play them in order.
To set iPod shuffle to shuffle: 
m Slide the shuffle switch to shuffle (¡).
To reshuffle songs, press Play/Pause (’) three times quickly.
To set iPod shuffle to play songs in order:
m Slide the shuffle switch to repeat (⁄).
To return to the first song, press Play/Pause (’) three times quickly.
Setting Songs to Play at the Same Volume Level
The loudness of songs and other audio may vary depending on how the audio was 
recorded or encoded. iTunes can automatically adjust the volume of songs, so they play 
at the same relative volume level. You can set iPod shuffle to use the iTunes volume 
settings.
WARNING:  Read all safety instructions about avoiding hearing damage on page 28 
before use.Chapter 2    Loading and Playing Music 17
To set iTunes to play songs at the same sound level:
1 In iTunes, choose iTunes > Preferences if you are using a Mac, or choose 
Edit > Preferences if you are using a Windows PC.
2 Click Playback and select Sound Check.
To set iPod shuffle to use the iTunes volume settings:
1 Connect iPod shuffle to your computer.
2 In iTunes, select iPod shuffle in the Source pane.
3 Click the Settings tab.
4 Select Enable Sound Check.
5 Click Apply.
Important:  If you have not turned on Sound Check in iTunes, setting it on iPod shuffle 
has no effect.
Setting a Volume Limit
You can set a limit for the volume on iPod shuffle. You can also set a password in iTunes 
to prevent this setting from being changed by someone else.
If you’ve set a volume limit on iPod shuffle, the status light blinks orange three times if 
you try to increase the volume beyond the limit.
To set a volume limit for iPod shuffle:
1 Set iPod shuffle to the desired maximum volume.
2 Connect iPod shuffle to your computer.
3 In iTunes, select iPod shuffle in the Source pane.
4 Click the Settings tab.
5 Select “Limit maximum volume.”
6 Drag the slider to the desired maximum volume.
The initial slider setting shows the volume the iPod shuffle was set to when you 
selected the “Limit maximum volume” checkbox.
7 To require a password to change this setting, click the lock and enter a password.
If you set a password, you must enter it before you can change or remove the volume 
limit. 
Note:  The volume level may vary if you use different earphones or headphones.18 Chapter 2    Loading and Playing Music 
To remove the volume limit:
1 Connect iPod shuffle to your computer.
2 In iTunes, select iPod shuffle in the Source pane.
3 Click the Settings tab.
4 Deselect “Limit maximum volume.”
Enter the password, if required.
Note:  If you forget the password, you can restore iPod shuffle. See “Updating and 
Restoring iPod shuffle Software” on page 26 for more information.
Disabling and Enabling the iPod shuffle Buttons
You can disable the buttons on iPod shuffle so that nothing happens if they are 
pressed accidentally.
To disable the iPod shuffle buttons:
m Press and hold Play/Pause (’) for three seconds.
The status light glows green, and then blinks orange three times when the buttons 
become disabled. If you press a button when the buttons are disabled, the status light 
blinks orange once.
To reenable the buttons:
m Press and hold Play/Pause (’) again for three seconds.
The status light glows orange, and then blinks green three times when the buttons 
become enabled.3
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3 Storing Files on iPod shuffle
Use iPod shuffle to carry your data as well as your music.
Read this chapter to find out how to use iPod shuffle as an external disk.
Using iPod shuffle as an External Disk
You can use iPod shuffle as an external disk to store data files. 
Note:  To load iPod shuffle with music and other audio that you want to listen to, you 
must use iTunes. You cannot play audio files that you copy to iPod shuffle using the 
Macintosh Finder or Windows Explorer.
To enable iPod shuffle as an external disk:
1 Connect iPod shuffle to your computer.
2 In iTunes, select iPod shuffle in the Source pane.
3 Click the Settings tab.
4 In the Options section, select “Enable disk use.”
Note:  You may need to scroll down to see the disk settings.
5 Adjust the slider to set how much space to reserve for songs versus data.
6 Click Apply.
When you use iPod shuffle as an external disk, the iPod shuffle disk icon appears on the 
desktop on the Mac, or as the next available drive letter in Windows Explorer on a 
Windows PC.
Transferring Files Between Computers
When you enable disk use on iPod shuffle, you can transfer files from one computer to 
another. iPod shuffle is formatted as a FAT-32 volume, which is supported by both Macs 
and PCs. This allows you to use iPod shuffle to transfer files between computers with 
different operating systems. 20 Chapter 3    Storing Files on iPod shuffle 
To transfer files between computers:
1 After enabling disk use on iPod shuffle, connect it to the computer you want to get files 
from.
Important:  When you connect iPod shuffle to a different computer (or different user 
account on your computer), a message asks if you want to erase iPod shuffle and sync 
with the new iTunes library there. Click Cancel if you don’t want to delete the current 
music content on iPod shuffle. 
2 Using the computer’s file system (the Finder on a Mac, Windows Explorer on a PC), drag 
the files you want to your iPod shuffle.
3 Disconnect iPod shuffle, and then connect it to the other computer.
Again, click Cancel if you don’t want to delete the current music contents on 
iPod shuffle.
4 Drag the files from iPod shuffle to a disk on the new computer.
Preventing iTunes from Opening Automatically
You can keep iTunes from opening automatically when you connect iPod shuffle to 
your computer.
To prevent iTunes from opening automatically:
1 Connect iPod shuffle to your computer.
2 In iTunes, select iPod shuffle in the Source pane.
3 Click the Settings tab.
4 In the Options section, deselect “Open iTunes when this iPod is connected.”
5 Click Apply.4
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4 iPod shuffle Accessories
iPod shuffle comes with earphones and an iPod shuffle 
Dock.
Learn about your Apple earphones, the iPod shuffle Dock, and other accessories 
available for iPod shuffle.
Apple Earphones
iPod shuffle comes with a pair of high-quality earphones. 
To use the earphones:
m Plug the earphones into the Headphones port. Then place the earbuds in your ears as 
shown. 
WARNING:  Read all safety instructions about avoiding hearing damage on page 28 
before use.
The earphones
cord is adjustable.22 Chapter 4    iPod shuffle Accessories 
iPod shuffle Dock
iPod shuffle comes with an iPod shuffle (2nd Generation) Dock, which you use to 
connect iPod shuffle to your computer and other USB devices. See “Connecting and 
Disconnecting iPod shuffle” on page 5.
iPod USB Power Adapter
The iPod USB Power Adapter is an optional accessory that allows you to charge 
iPod shuffle when you’re away from your computer. 
Available Accessories
To purchase iPod shuffle accessories, go to www.apple.com/ipodstore.
Available accessories include:
Â Apple iPod In-Ear Headphones
Â iPod shuffle (2nd Generation) Dock
Â iPod USB Power Adapter5
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5 Tips and Troubleshooting
Most problems with iPod shuffle can be solved quickly by 
following the advice in this chapter.
If iPod shuffle won’t turn on or respond
Â If the status light blinks orange when you press a button, the iPod shuffle buttons are 
disabled. Press and hold Play/Pause (’) for about three seconds, until the status light 
blinks green.
Â Connect iPod shuffle to a high-power USB port on your computer. Your iPod shuffle 
battery may need to be recharged. 
Â Turn iPod shuffle off, wait five seconds, and then turn it on again.
Â You may need to restore iPod shuffle software. See “Updating and Restoring 
iPod shuffle Software” on page 26.
The 5 Rs: Reset, Retry, Restart, Reinstall, Restore
Remember these five basic suggestions if you have a problem with iPod shuffle. Try 
these steps one at a time until the problem is resolved. If one of the following doesn’t 
help, read on for solutions to specific problems. 
Â Reset iPod shuffle by turning it off, waiting five seconds, and then turning it back on 
again.
Â Retry with a different USB port if you cannot see iPod shuffle in iTunes.
Â Restart your computer, and make sure you have the latest software updates 
installed.
Â Reinstall iTunes software from the latest version on the web.
Â Restore iPod shuffle. See “Updating and Restoring iPod shuffle Software” on 
page 26.24 Chapter 5    Tips and Troubleshooting 
If iPod shuffle isn’t playing music
Â Make sure the earphone or headphone connector is pushed in all the way.
Â Make sure the volume is adjusted properly. A volume limit might be set. See “Setting 
a Volume Limit” on page 17.
Â iPod shuffle might be paused. Try pressing Play/Pause (’). 
If you connect iPod shuffle to your computer and nothing happens
Â Connect iPod shuffle to a high-power USB port on your computer. iPod shuffle may 
need to be recharged. 
Â Make sure you have installed the latest iTunes software from 
www.apple.com/ipod/start. 
Â Try connecting to a different USB port on your computer. Make sure iPod shuffle is 
firmly seated in the dock. Make sure the USB connector is oriented correctly. It can be 
inserted only one way.
Â iPod shuffle might need to be reset. Turn iPod shuffle off, wait five seconds, and then 
turn it back on again.
Â If there is no status light (or the status light is dimmed) and iPod shuffle doesn’t 
appear in iTunes or the Finder, the battery may be completely discharged. Let 
iPod shuffle charge for several minutes to see if it comes back to life.
Â Make sure you have the required computer and software. See “If you want to doublecheck the system requirements” on page 25.
Â Try restarting your computer.
Â If none of the previous suggestions solves the problem, you might need to restore 
iPod software. See “Updating and Restoring iPod shuffle Software” on page 26.
Â If restoring iPod shuffle doesn’t solve the problem, iPod shuffle may need to be 
repaired. You can arrange for service on the iPod shuffle Service & Support website at 
www.apple.com/support/ipodshuffle/service.
If songs load slowly
Connect iPod shuffle to a USB 2.0 port on your computer for fast loading speeds. USB 
2.0 loads songs and data faster than USB 1.1.
If you can’t load a song or other item onto iPod shuffle
The song might have been encoded in a format that iPod shuffle doesn’t support. The 
following audio file formats are supported by iPod shuffle. These include formats for 
audiobooks and podcasts:
Â AAC (M4A, M4B, M4P) (up to 320 kbps)
Â MP3 (up to 320 kbps)
Â MP3 Variable Bit Rate (VBR)
Â WAV
Â AA (audible.com spoken word, formats 2, 3, and 4)
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A song encoded using Apple Lossless format has full CD-quality sound, but takes up 
only about half as much space as a song encoded using AIFF or WAV format. The same 
song encoded in AAC or MP3 format takes up even less space. When you import music 
from a CD using iTunes, it is converted to AAC format by default.
You can have iPod shuffle automatically convert files encoded at higher bit rates (such 
as Apple Lossless) to 128 kbps AAC files as they are loaded onto iPod shuffle. See 
“Fitting More Songs onto iPod shuffle” on page 15.
Using iTunes for Windows, you can convert nonprotected WMA files to AAC or MP3 
format. This can be useful if you have a collection of music encoded in WMA format. 
iPod shuffle does not support Apple Lossless, WMA, MPEG Layer 1, MPEG Layer 2 audio 
files, or audible.com format 1.
If you have a song in iTunes that isn’t supported by iPod shuffle, you can convert it to a 
format iPod shuffle supports. For more information, see iTunes Help.
If the chapters in an audiobook play out of order
Â Make sure the shuffle switch on iPod shuffle is set to repeat (⁄) so that the chapters 
of the audiobook play in order.
Â If the chapters were added to iPod shuffle out of order, connect iPod shuffle to your 
computer and rearrange the tracks using iTunes. See “Arranging the Order of Songs 
on iPod shuffle” on page 15.
If you want to double-check the system requirements
To use iPod shuffle, you must have:
Â One of the following computer configurations:
Â A Macintosh with a USB port (USB 2.0 recommended)
Â A Windows PC with a USB port or a USB card installed (USB 2.0 recommended) 
Â One of the following operating systems:  Mac OS X v10.3.9 or later, Windows 2000 
with Service Pack 4 or later, or Windows XP Home or Professional with Service Pack 2 
or later
Â Internet access (a broadband connection is recommended)
Â iTunes 7.0.2 or later (iTunes can be downloaded from www.apple.com/ipod/start)
If your Windows PC doesn’t have a high-power USB port, you can purchase and install a 
USB 2.0 card. For information, go to www.apple.com/ipodstore.
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If you want to use iPod shuffle with a Mac and a Windows PC
Whenever you sync iPod shuffle with a different iTunes library, you must erase the 
music already on iPod shuffle, regardless of the operating system. When you connect 
iPod shuffle to a different computer or user account, a message asks if you want to 
erase iPod shuffle and sync to the new iTunes library.
However, you can use iPod shuffle as an external disk with both Macintosh computers 
and PCs, allowing you to transfer files from one operating system to the other. See 
Chapter 3, “Storing Files on iPod shuffle,” on page 19.
Updating and Restoring iPod shuffle Software
You can use iTunes to update or restore the iPod shuffle software. It is recommended 
that you update iPod shuffle to use the latest software. You can also restore the 
software, which returns iPod shuffle to its original state.
Â If you choose to update, the software is updated but your settings and songs are not 
affected. 
Â If you choose to restore, all data is erased from iPod shuffle, including songs and any 
other data. All iPod shuffle settings are restored to their original state.
To update or restore iPod shuffle:
1 Make sure you have an Internet connection and have installed the latest version of 
iTunes from www.apple.com/ipod/start.
2 Connect iPod shuffle to your computer.
3 In iTunes, select iPod shuffle in the Source pane and click the Settings tab.
The Version section tells you whether iPod shuffle is up to date or needs a newer 
version of the software. 
4 Do one of the following:
Â To install the latest version of the software, click Update.
Â To restore iPod shuffle to its original settings, click Restore. This erases all data from 
iPod shuffle. Follow the onscreen instructions to complete the restore process.6
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6 Safety and Handling
This chapter contains important safety and handling 
information for iPod shuffle.
Keep this features guide for your iPod shuffle handy for future reference.
Important Safety Information
Handling iPod shuffle  Do not bend, drop, crush, puncture, incinerate, or open 
iPod shuffle. 
Avoiding water and wet locations  Do not use iPod shuffle in rain or near washbasins, 
or other wet locations. Take care not to spill any food or liquid into iPod shuffle. In case 
iPod shuffle gets wet, unplug all cables and turn iPod shuffle off before cleaning, and 
allow it to dry thoroughly before turning it on again.
Repairing iPod shuffle  Never attempt to repair iPod shuffle yourself. iPod shuffle 
does not contain any user-serviceable parts. For service information, choose iPod Help 
from the Help menu in iTunes or go to www.apple.com/support/ipod/service. The 
battery in iPod shuffle is not user-replaceable. For more information about batteries, 
go to www.apple.com/batteries.
± Read all safety information below and operating instructions before using 
iPod shuffle to avoid injury. 
WARNING:  Failure to follow these safety instructions could result in fire, electric shock, 
or other injury or damage.28 Chapter 6    Safety and Handling 
Using the iPod USB Power Adapter (available separately)  If you use the iPod USB 
Power Adapter (sold separately at www.apple.com/ipodstore) to charge iPod shuffle, 
make sure that the power adapter is fully assembled before you plug it into a power 
outlet. Then insert the iPod USB Power Adapter firmly into the power outlet. Do not 
connect or disconnect the iPod USB Power Adapter with wet hands. Do not use any 
power adapter other than the Apple iPod USB Power Adapter to charge your 
iPod shuffle.
The iPod USB Power Adapter may become warm during normal use. Always allow 
adequate ventilation around the iPod USB Power Adapter and use care when handling.
Unplug the iPod USB Power Adapter if any of the following conditions exist:
Â The power cord or plug has become frayed or damaged.
Â The adapter is exposed to rain or excessive moisture.
Â The adapter case has become damaged.
Â You suspect the adapter needs service or repair.
Â You want to clean the adapter.
Avoiding hearing damage  Permanent hearing loss may occur if earbuds or 
headphones are used at high volume. Set the volume to a safe level. You can adapt 
over time to a higher volume of sound that may sound normal but can be damaging to 
your hearing. If you experience ringing in your ears or muffled speech, stop listening 
and have your hearing checked. The louder the volume, the less time is required before 
your hearing could be affected. Hearing experts suggest that to protect your hearing:
Â Limit the amount of time you use earbuds or headphones at high volume.
Â Avoid turning up the volume to block out noisy surroundings.
Â Turn the volume down if you can’t hear people speaking near you.
For information about how to set a volume limit on iPod shuffle, see “Setting a Volume 
Limit” on page 17.
Using headphones safely  Use of headphones while operating a vehicle is not 
recommended and is illegal in some areas. Be careful and attentive while driving. Stop 
using iPod shuffle if you find it disruptive or distracting while operating any type of 
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Important Handling Information
Carrying iPod shuffle  iPod shuffle contains sensitive components. Do not bend, drop, 
or crush iPod shuffle.
Using connectors and ports  Never force a connector into a port. Check for 
obstructions on the port. If the connector and port don’t join with reasonable ease, 
they probably don’t match. Make sure that the connector matches the port and that 
you have positioned the connector correctly in relation to the port.
Keeping iPod shuffle within acceptable temperatures  Operate iPod shuffle in a place 
where the temperature is always between 0º and 35º C (32º to 95º F). iPod play time 
might temporarily shorten in low-temperature conditions.
Store iPod shuffle in a place where the temperature is always between -20º and 45º C 
(-4º to 113º F). Don’t leave iPod shuffle in your car, because temperatures in parked cars 
can exceed this range.
When you’re using iPod shuffle or charging the battery, it is normal for iPod shuffle to 
get warm. The exterior of iPod shuffle functions as a cooling surface that transfers heat 
from inside the unit to the cooler air outside.
Keeping the outside of iPod shuffle clean To clean iPod shuffle, remove it from the 
dock and turn iPod shuffle off. Then use a soft, slightly damp, lint-free cloth. Avoid 
getting moisture in openings. Don’t use window cleaners, household cleaners, aerosol 
sprays, solvents, alcohol, ammonia, or abrasives to clean iPod shuffle.
Disposing of iPod shuffle properly  For information about the proper disposal of 
iPod shuffle, including other important regulatory compliance information, see 
“Regulatory Compliance Information” on page 31.
NOTICE:  Failure to follow these handling instructions could result in damage to 
iPod shuffle or other property.7
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7 Learning More, Service, 
and Support 
You can find more information about using iPod shuffle 
in onscreen help and on the web.
The following table describes where to get iPod-related software and service 
information.
To learn about Do this
Service and support, 
discussions, tutorials, and 
Apple software downloads
Go to:  www.apple.com/support/ipodshuffle
Using iTunes Open iTunes and choose Help > iTunes Help. 
For an online iTunes tutorial (available in some areas only), go to:   
www.apple.com/ilife/tutorials/itunes
The latest information about 
iPod shuffle
Go to:  www.apple.com/ipodshuffle
Registering iPod shuffle To register iPod shuffle, install iTunes on your computer and 
connect iPod shuffle.
Finding the iPod shuffle serial 
number
Look on the notch underneath the clip on iPod shuffle. Or, in 
iTunes (with iPod shuffle connected to your computer), select 
iPod shuffle in the Source pane and click the Settings tab.
Obtaining warranty service First follow the advice in this booklet, the onscreen help, and 
online resources, and then go to:  
www.apple.com/support/ipodshuffle/service    31
Regulatory Compliance Information
FCC Compliance Statement
This device complies with part 15 of the FCC rules. 
Operation is subject to the following two conditions: 
(1) This device may not cause harmful interference, 
and (2) this device must accept any interference 
received, including interference that may cause 
undesired operation. See instructions if interference 
to radio or television reception is suspected.
Radio and Television Interference
This computer equipment generates, uses, and can 
radiate radio-frequency energy. If it is not installed 
and used properly—that is, in strict accordance with 
Apple’s instructions—it may cause interference with 
radio and television reception.
This equipment has been tested and found to 
comply with the limits for a Class B digital device in 
accordance with the specifications in Part 15 of FCC 
rules. These specifications are designed to provide 
reasonable protection against such interference in a 
residential installation. However, there is no 
guarantee that interference will not occur in a 
particular installation.
You can determine whether your computer system is 
causing interference by turning it off. If the 
interference stops, it was probably caused by the 
computer or one of the peripheral devices.
If your computer system does cause interference to 
radio or television reception, try to correct the 
interference by using one or more of the following 
measures:
Â Turn the television or radio antenna until the 
interference stops.
Â Move the computer to one side or the other of the 
television or radio.
Â Move the computer farther away from the 
television or radio.
Â Plug the computer into an outlet that is on a 
different circuit from the television or radio. (That 
is, make certain the computer and the television or 
radio are on circuits controlled by different circuit 
breakers or fuses.)
If necessary, consult an Apple-authorized service 
provider or Apple. See the service and support 
information that came with your Apple product. Or, 
consult an experienced radio/television technician 
for additional suggestions.
Important:  Changes or modifications to this product 
not authorized by Apple Inc. could void the EMC 
compliance and negate your authority to operate 
the product.
This product was tested for EMC compliance under 
conditions that included the use of Apple peripheral 
devices and Apple shielded cables and connectors 
between system components. 
It is important that you use Apple peripheral devices 
and shielded cables and connectors between system 
components to reduce the possibility of causing 
interference to radios, television sets, and other 
electronic devices. You can obtain Apple peripheral 
devices and the proper shielded cables and 
connectors through an Apple Authorized Reseller. 
For non-Apple peripheral devices, contact the 
manufacturer or dealer for assistance. 
Responsible party (contact for FCC matters only):
Apple Inc. Product Compliance, 1 Infinite Loop 
M/S 26-A, Cupertino, CA 95014-2084, 408-974-2000.
Industry Canada Statement
This Class B device meets all requirements of the 
Canadian interference-causing equipment 
regulations.
Cet appareil numérique de la classe B respecte 
toutes les exigences du Règlement sur le matériel 
brouilleur du Canada.
VCCI Class B Statement
Korea Class B Statement32    
Russia
European Community
Complies with European Directives 2006/95/EEC and 
89/336/EEC.
Disposal and Recycling Information
Your iPod contains a battery. Dispose of your iPod 
according to your local environmental laws and 
guidelines.
For information about Apple’s recycling program, 
go to:  www.apple.com/environment
Deutschland:  Dieses Gerät enthält Batterien. Bitte 
nicht in den Hausmüll werfen. Entsorgen Sie dieses 
Gerätes am Ende seines Lebenszyklus entsprechend 
der maßgeblichen gesetzlichen Regelungen.
China:
Nederlands:  Gebruikte batterijen kunnen worden 
ingeleverd bij de chemokar of in een speciale 
batterijcontainer voor klein chemisch afval (kca) 
worden gedeponeerd.
Taiwan:  
European Union—Disposal Information:  
This symbol means that according to local laws and 
regulations your product should be disposed of 
separately from household waste. When this product 
reaches its end of life, take it to a collection point 
designated by local authorities. Some collection 
points accept products for free. The separate 
collection and recycling of your product at the time 
of disposal will help conserve natural resources and 
ensure that it is recycled in a manner that protects 
human health and the environment.
Apple and the Environment 
At Apple, we recognize our responsibility to 
minimize the environmental impacts of our 
operations and products.
For more information, go to: 
www.apple.com/environment
© 2007 Apple Inc. All rights reserved. Apple, the Apple logo, FireWire, 
iPod, iTunes, Mac, Macintosh, and Mac OS are trademarks of Apple Inc., 
registered in the U.S. and other countries. Finder and Shuffle are 
trademarks of Apple Inc. Apple Store is a service mark of Apple Inc., 
registered in the U.S. and other countries. Other company and product 
names mentioned herein may be trademarks of their respective 
companies. 
Mention of third-party products is for informational purposes only and 
constitutes neither an endorsement nor a recommendation. Apple 
assumes no responsibility with regard to the performance or use of 
these products. All understandings, agreements, or warranties, if any, 
take place directly between the vendors and the prospective users. 
Every effort has been made to ensure that the information in this 
manual is accurate. Apple is not responsible for printing or clerical 
errors.
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Contents 7Welcome to the world of professional video and film grading and manipulation using
Color.
This preface covers the following:
• About Color (p. 9)
• About the Color Documentation (p. 10)
• Additional Resources (p. 10)
About Color
Color has been designed from the ground up as a feature-rich color correction environment
that complements a wide variety of post-production workflows, whether your project is
standard definition, high definition, or a 2K digital intermediate. If you've edited a program
using Final Cut Pro, it's easy to send your program to Color for grading and then send it
back to Final Cut Pro for final output. However, it's also easy to reconform projects that
originate as EDLs from other editing environments.
Color has the tools that professional colorists demand, including:
• Primary color correction using three-way color balance and contrast controls with
individual shadow, midtone, and highlight controls
• Curve controls for detailed color and luma channel adjustments
• Up to eight secondary color correction operations per shot with HSL qualifiers, vignettes,
user shapes, and separate adjustments for the inside and outside of each secondary
• Color FX node-based effects for creating custom color effects
• Pan & Scan effects
• Motion tracking that can be used to animate vignettes, user shapes, and other effects
• Broadcast legal settings to guarantee adherence to quality control standards
• Support for color correction–specific control surfaces
• And much, much more
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Welcome to Color
PrefaceAll of these tools are divided among eight individual “rooms” of the Color interface,
logically arranged in an order that matches the workflow of most colorists. You use Color
to correct, balance, and create stylized “looks” for each shot in your program as the last
step in the post-production workflow, giving your programs a final polish previously
available only to high-end facilities.
About the Color Documentation
The Color User Manual provides comprehensive information about the application and
is written for users of all levels of experience.
• Editors and post-production professionals from other disciplines who are new to the
color correction process will find information on how to get started, with detailed
explanations of how all controls work, and why they function the way they do.
• Colorists coming to Color from other grading environments can skip ahead to find
detailed information about the application’s inner workings and exhaustive
parameter-by-parameter explanations for every room of the Color interface.
Additional Resources
The following websites provide general information, updates, and support information
about Color, as well as the latest news, resources, and training materials.
Color Website
For more information about Color, go to:
• http://www.apple.com/finalcutstudio/color
Apple Service and Support Websites
The Apple Service and Support website provides software updates and answers to the
most frequently asked questions for all Apple products, including Color. You’ll also have
access to product specifications, reference documentation, and Apple product technical
articles:
• http://www.apple.com/support
For support information that's specific to Color, go to:
• http://www.apple.com/support/color
To provide comments and feedback about Color, go to:
• http://www.apple.com/feedback/color.html
A discussion forum is also available to share information about Color. To participate, go
to:
• http://discussions.apple.com
10 Preface Welcome to ColorFor more information on the Apple Pro Training Program, go to:
• http://www.apple.com/software/pro/training
Preface Welcome to Color 11To better learn how Color works, it’s important to understand the overall color correction
process and how images work their way through post-production in standard definition
(SD), high definition (HD), and film workflows.
If you’re new to color correction, the first part of this chapter provides a background in
color correction workflows to help you better understand why Color works the way it
does. The second part goes on to explain color and imaging concepts that are important
to the operation of the Color interface.
This chapter covers the following:
• The Fundamental Color Correction Tasks (p. 13)
• When Does Color Correction Happen? (p. 16)
• Image Encoding Standards (p. 23)
• Basic Color and Imaging Concepts (p. 28)
The Fundamental Color Correction Tasks
In any post-production workflow, color correction is generally one of the last steps taken
to finish an edited program. Color has been created to give you precise control over the
look of every shot in your project by providing flexible tools and an efficient workspace
in which to manipulate the contrast, color, and geometry of each shot in your program.
When color correcting a given program, you’ll be called upon to perform many, if not all,
of the tasks described in this section. Color gives you an extensive feature set with which
to accomplish all this and more. While the deciding factor in determining how far you
go in any color correction session is usually the amount of time you have in which to
work, the dedicated color correction interface in Color allows you to work quickly and
efficiently.
Every program requires you to take some combination of the following steps.
13
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1Stage 1: Correcting Errors in Color Balance and Exposure
Frequently, images that are acquired digitally (whether shot on analog or digital video,
or transferred from film) don’t have optimal exposure or color balance to begin with. For
example, many camcorders and digital cinema cameras deliberately record blacks that
aren’t quite at 0 percent in order to avoid the inadvertent crushing of data unnecessarily.
Furthermore, accidents can happen in any shoot. For example, the crew may not have
had the correctly balanced film stock for the conditions in which they were shooting, or
someone may have forgotten to white balance the video camera before shooting an
interview in an office lit with fluorescent lights, resulting in footage with a greenish tinge.
Color makes it easy to fix these kinds of mistakes.
Stage 2: Making Sure That Key Elements in Your Program Look the Way They Should
Every scene of your program has key elements that are the main focus of the viewer. In
a narrative or documentary video, the focus is probably on the individuals within each
shot. In a commercial, the key element is undoubtedly the product (for example, the label
of a bottle or the color of a car). Regardless of what these key elements are, chances are
you or your audience will have certain expectations of what they should look like, and
it’s your job to make the colors in the program match what was originally shot.
When working with shots of people, one of the guiding principles of color correction is
to make sure that their skin tones in the program look the same as (or better than) in real
life. Regardless of ethnicity or complexion, the hues of human skin tones, when measured
objectively on a Vectorscope, fall along a fairly narrow range (although the saturation
and brightness vary). Color gives you the tools to make whatever adjustments are
necessary to ensure that the skin tones of people in your final edited piece look the way
they should.
Stage 3: Balancing All the Shots in a Scene to Match
Most edited programs incorporate footage from a variety of sources, shot in multiple
locations over the course of many days, weeks, or months of production. Even with the
most skilled lighting and camera crews, differences in color and exposure are bound to
occur, sometimes within shots meant to be combined into a single scene.
When edited together, these changes in color and lighting can cause individual shots to
stand out, making the editing appear uneven. With careful color correction, all the different
shots that make up a scene can be balanced to match one another so that they all look
as if they’re happening at the same time and in the same place, with the same lighting.
This is commonly referred to as scene-to-scene color correction.
Stage 4: Creating Contrast
Color correction can also be used to create contrast between two scenes for a more jarring
effect. Imagine cutting from a lush, green jungle scene to a harsh desert landscape with
many more reds and yellows. Using color correction, you can subtly accentuate these
differences.
14 Chapter 1 Color Correction BasicsStage 5: Achieving a “Look”
The process of color correction is not simply one of making all the video in your piece
match some objective model of exposure. Color, like sound, is a property that, when
subtly mixed, can result in an additional level of dramatic control over your program.
With color correction, you can control whether your video has rich, saturated colors or a
more muted look. You can make your shots look warmer by pushing their tones into the
reds, or make them look cooler by bringing them into the blues. You can pull details out
of the shadows, or crush them, increasing the picture’s contrast for a starker look. Such
subtle modifications alter the audience’s perception of the scene being played, changing
a program’s mood. Once you pick a look for your piece, or even for an individual scene,
you can use color correction to make sure that all the shots in the appropriate scenes
match the same look, so that they cut together smoothly.
Stage 6: Adhering to Guidelines for Broadcast Legality
If a program is destined for television broadcast, you are usually provided with a set of
quality control (QC) guidelines that specify the “legal” limits for minimum black levels,
maximum white levels, and minimum and maximum chroma saturation and composite
RGB limits. Adherence to these guidelines is important to ensure that the program is
accepted for broadcast, as “illegal” values may cause problems when the program is
encoded for transmission. QC standards vary, so it’s important to check what these
guidelines are in advance. Color has built-in broadcast safe settings (sometimes referred
to as a legalizer) that automatically prevent video levels from exceeding the specified
limits. For more information, see The Project Settings Tab.
Stage 7: Adjusting Specific Elements Separately
It’s sometimes necessary to selectively target a narrow range of colors to alter or replace
only those color values. A common example of this might be to turn a red car blue or to
mute the excessive colors of an article of clothing. These sorts of tasks are accomplished
with what’s referred to assecondary color correction, and Color provides you with numerous
tools with which to achieve such effects. For more information, see The Secondaries
Room.
Stage 8: Making Digital Lighting Adjustments
Sometimes lighting setups that looked right during the shoot don’t work as well in
post-production. Changes in the director’s vision, alterations to the tone of the scene as
edited, or suggestions on the part of the director of photography (DoP) during post may
necessitate alterations to the lighting within a scene beyond simple adjustments to the
image’s overall contrast. Color provides powerful controls for user-definable masking
which, in combination with secondary color correction controls, allow you to isolate
multiple regions within an image and fine-tune the lighting. This is sometimes referred
to as digital relighting. For more information, see The Secondaries Room and Controls in
the Shapes Tab.
Chapter 1 Color Correction Basics 15Stage 9: Creating Special Effects
Sometimes a scene requires more extreme effects, such as manipulating colors and
exposure intensively to achieve a day-for-night look, creating an altered state for a
flashback or hallucination sequence, or just creating something bizarre for a music video.
In the Color FX room, Color provides you with an extensible node-based tool set for
creating such in-depth composites efficiently, in conjunction with the other primary and
secondary tools at your disposal. For more information, see The Color FX Room.
When Does Color Correction Happen?
A program’s color fidelity shouldn’t be neglected until the color correction stage of the
post-production process. Ideally, every project is begun with a philosophy of color
management that’s applied during the shoot, is maintained throughout the various
transfer and editing passes that occur during post-production, and concludes with the
final color correction pass conducted in Color. This section elaborates on how film and
video images have traditionally made their way through the post-production process.
For detailed information, see:
• Color Management Starts During the Shoot
• Initial Color Correction When Transferring Film
• Traditional Means of Final Color Correction
• Advantages of Grading with Color
Color Management Starts During the Shoot
Whether a program is shot using film, video, or high-resolution digital imaging of another
means, it’s important to remember that the process of determining a program’s overall
look begins when each scene is lit and shot during production. To obtain the maximum
amount of control and flexibility over shots in post-production, you ideally should start
out with footage that has been exposed with the end goals in mind right from the
beginning. Color correction in post-production is no substitute for good lighting.
Optimistically, the process of color correction can be seen as extending and enhancing
the vision of the producer, director, and director of photography (DoP) as it was originally
conceived. Often, the DoP gets personally involved during the color correction process
to ensure that the look he or she was trying to achieve is perfected.
At other times, the director or producer may change his or her mind regarding how the
finished piece should look. In these cases, color correction might be used to alter the
overall look of the piece (for example, making footage that was shot to look cool look
warmer, instead). While Color provides an exceptional degree of control over your footage,
it’s still important to start out with clean, properly exposed footage.
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video format and camera settings used, can have a profound effect on the amount of
flexibility that’s available during the eventual color correction process.
Initial Color Correction When Transferring Film
When a project has been shot on film, the camera negatives must first be transferred to
the videotape or digital video format of choice prior to editing and digital post using a
telecine or datacine machine. A telecine is a machine for transferring film to videotape,
while a datacine is set up for transferring film directly to a digital format, usually a DPX
(Digital Picture eXchange) or Cineon image sequence.
Camera Negative Telecine Videotapes Usually, the colorist running the film transfer session performs some level of color
correction to ensure that the editor has the most appropriate picture to work with. The
goals of color correction at this stage usually depend on both the length of the project
and the post-production workflow that’s been decided upon.
• Short projects, commercials, spots, and very short videos may get a detailed color
correction pass right away. The colorist will first calibrate the telecine’s own color
corrector to balance the whites, blacks, and color perfectly. Then the colorist, in
consultation with the DoP, director, or producer, will work shot by shot to determine
the look of each shot according to the needs of the project. As a result, the editor will
be working with footage that has already been corrected.
• Long-form projects such as feature-length films and longer television programs probably
won’t get a detailed color correction pass right away. Instead, the footage that is run
through the telecine will be balanced to have reasonably ideal exposure and color for
purposes of having a good image for editing, and left at that. Detailed color correction
is then done at another stage.
• Projects of any length that are going through post-production as a digital intermediate
are transferred with a color correction pass designed to retain the maximum amount
of image data. Since a second (and final) digital color correction pass is intended to be
performed at the end of the post-production process, it’s critical that the image data
is high quality, preserving as much highlight and shadow detail as possible. Interestingly,
since the goal is to preserve the image data and not to create the final look of the
program, the highest-quality image for grading may not be the most visually appealing
image.
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once complete, the footage goes through the typical post-production processes of offline
and online editorial.
Color Correcting Video Versus Film
Color has been designed to fit into both video and film digital intermediate workflows.
Since all footage must first be transferred to a QuickTime or image sequence format to
be imported into Color, film and video images are corrected using the same tools and
methods.
Three main attributes affect the quality of media used in a program, all of which are
determined when the footage is originally captured or transferred prior to Color import:
• The type and level of compression applied to the media
• The bit depth at which it’s encoded
• The chroma subsampling ratio used
For color correction, spatial and temporal compression should be minimized, since
compression artifacts can compromise the quality of your adjustments. Also, media at
higher bit depths is generally preferable (see Bit Depth Explained).
Most importantly of all, high chroma subsampling ratios, such as 4:4:4 or 4:2:2, are
preferred to maximize the quality and flexibility of your corrections. There’s nothing
stopping you from working with 4:1:1 or 4:2:0 subsampled footage, but you may find
that extreme contrast adjustments and smooth secondary selections are a bit more
difficult to accomplish with highly compressed color spaces.
For more information, see Chroma Subsampling Explained.
Traditional Means of Final Color Correction
Once editing is complete and the picture is locked, it’s time for color correction (referred
to as color grading in the film world) to begin. Traditionally, this process has been
accomplished either via a color timing session for film or via a tape-to-tape color correction
session for video.
Color Timing for Film
Programs being finished and color corrected on film traditionally undergo a negative
conform process prior to color timing. When editorial is complete, the original camera
negative is conformed to match the workprint or video cut of the edited program using
a cut list or pull list. (If the program was edited using Final Cut Pro, this can be derived
using Cinema Tools.) These lists list each shot used in the edited program and show how
each shot fits together. This is a time-consuming and detail-oriented process, since
mistakes made while cutting the negative are extremely expensive to correct.
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together onto alternating A and B rolls, the negative can be color-timed by being run
through an optical printer designed for this process. These machines shine filtered light
through the original negatives to expose an intermediate positive print, in the process
creating a single reel of film that is the color-corrected print.
The process of controlling the color of individual shots and doing scene-to-scene color
correction is accomplished with three controls to individually adjust the amount of red,
green, and blue light that exposes the film, using a series of optical filters and shutters.
Each of the red, green, and blue dials is adjusted in discrete increments called printer
points (with each point being a fraction of an f-stop, the scale used to measure film
exposure). Typically there’s a total range of 50 points, where point 25 is the original neutral
state for that color channel. Increasing or decreasing all three color channels together
darkens or brightens the image, while making disproportionate adjustments to the three
channels changes the color balance of the image relative to the adjustment.
The machine settings used for each shot can be stored (at one time using paper tape
technology) and recalled at any time, to ease subsequent retiming and adjustments, with
the printing process being automated once the manual timing is complete. Once the
intermediate print has been exposed, it can be developed and the final results projected.
Camera Negative Conform Negative Optical Color Timing Final Film Print While this system of color correction may seem cumbersome compared to today’s digital
tools for image manipulation, it’s an extremely effective means of primary color correction
for those who’ve mastered it.
Note: Color includes printer points controls for colorists who are familiar with this method
of color correction. For more information, see The Advanced Tab.
Tape-to-Tape Color Correction
For projects shot on videotape (and for those shot on film that will not receive a second
telecine pass), the color correction process fits into the traditional video offline/online
workflow. Once the edit has been locked, the final master tape is assembled, either by
being reconformed on the system originally used to do the offline or by taking the EDL
(Edit Decision List) and original source tapes to an online suite compatible with the source
tape formats. For more information about EDLs, see Importing Projects from Other Video
Editing Applications.
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be performed either during the assembly of the master tape or after assembly by running
the master tape through a color correction session.
Videotapes Offline Edit Tape Suite Final Master Tape Note: If the final master tape is color corrected, the colorist must carefully dissolve and
wipe color correction operations to match video dissolves and wipes happening in the
program.
Either way, the video signal is run through dedicated video color correction hardware
and software, and the colorist uses the tape’s master timecode to set up and preserve
color correction settings for every shot of every scene.
The evolution of the online video color correction suite introduced many more tools to
the process, including separate corrections for discrete tonal zones, secondary color
correction of specific subjects via keying and shapes controls, and many other creative
options.
Color Correcting via a Second Telecine Pass
Programs shot on film that are destined for video mastering, such as for an episodic
broadcast series, may end up back in the telecine suite for their final color correction
pass. Once editing is complete and the picture is locked, a cut list or pull list (similar to
that used for a negative conform) is created that matches the EDL of the edited program.
Using the cut list, the post-production supervisor pulls only the film negative that was
actually used in the edit. Since this is usually a minority of the footage that was originally
shot, the colorist now has more time (depending on the show’s budget, of course) to
perform a more detailed color correction pass on the selected footage that will be
assembled into the final video program during this final telecine pass.
Although this process might seem redundant, performing color correction directly from
the film negative has several distinct advantages. Since film has greater latitude from
black to white than video has, a colorist working straight off the telecine potentially has
a wider range of color and exposure from which to draw than when working only with
video.
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to match (and is sometimes identical to) the tools available to online video colorists, with
the added advantage that the colorist can work directly on the uncompressed images
provided by the telecine.
After the conclusion of the second color correction pass, the color-corrected selects are
reassembled to match the original edit, and the project is mastered to tape.
Camera
Negative
Offline Media Reconform
Final Master
Inexpensive
One-Light
Telecine Pass
Best-Light
Telecine Pass
Offline Edit
Incidentally, even if you don’t intend to color correct your program in the telecine suite,
you might consider retransferring specific shots to make changes that are easier or of
higher quality to make directly from the original camera negative. For example, after
identifying shots you want to retransfer in your Final Cut Pro sequence, you can use
Cinema Tools to create a selects list just for shots you want to optically enlarge, speeding
the transfer process.
Other Advantages to Telecine Transfers
In addition to color correction, a colorist working with a telecine has many other options
available, depending on what kinds of issues may have come up during the edit.
• Using a telecine to pull the image straight off the film negative, the colorist can
reposition the image to include parts of the film image that fall outside of the action
safe area of video.
• With the telecine, the image can also be enlarged optically, potentially up to 50
percent without visible distortion.
• The ability to reframe shots in the telecine allows the director or producer to make
significant changes to a scene, turning a medium shot into a close-up for dramatic
effect, or moving the entire frame up to crop out a microphone that’s inadvertently
dropped into the shot.
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When Does Color Correction Happen? discusses how color correction is accomplished in
other post-production environments. This section describes how Color fits into a typical
film or video post-production process.
Color provides many of the same high-end color correction tools on your desktop that
were previously available only in high-end tape-to-tape and telecine color correction
suites. In addition, Color provides additional tools in the Color FX room that are more
commonly found in dedicated compositing applications, which give you even more
detailed control over the images in your program. (For more information, see The Color
FX Room.)
Color has been designed as a color correction environment for both film and video. It’s
resolution-independent, supporting everything from standard definition video up to 2K
and 4K film scans. It also supports multiple media formats and is compatible with image
data using a variety of image sequence formats and QuickTime codecs.
Color also has been designed to be incorporated into a digital intermediate workflow.
Digital intermediate refers to a high-quality digital version of your program that can be
edited, color corrected, and otherwise digitally manipulated using computer hardware
and software, instead of tape machines or optical printers.
Editors, effects artists, and colorists who finish video programs in a tapeless fashion have
effectively been working with digital intermediates for years, but the term usually describes
the process of scanning film frames digitally, for the purposes of doing all edit conforming,
effects, and color correction digitally. It is then the digital image data which is printed
directly to film or compiled as a file for digital projection.
Finishing film or video programs digitally frees colorists from the limitations of film and
tape transport mechanisms, speeding their work by letting them navigate through a
project as quickly as they can in a nonlinear editing application. Furthermore, working
with the digital image data provides a margin of safety, by eliminating the risk of scratching
the negative or damaging the source tapes.
When Does Color Correction in Color Happen?
Color correction using Color usually happens at or near the conclusion of the online edit
or project conform, often at the same time the final audio mix is being performed. Waiting
until the picture is locked is always a good idea, but it’s not essential, as Color provides
tools for synchronizing projects that are still being edited via XML files or EDLs.
Color has been designed to work hand in hand with editing applications like Final Cut Pro;
Final Cut Pro takes care of input, editing, and output, and Color allows you to focus on
color correction and related effects.
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To work on a program in Color, you must be provided with two sets of files:
• Final Cut Pro sequence data can be sent to Color directly using the Send To Color
command. Otherwise, the edited project file (or files, if the program is in multiple reels)
should be provided in a format that can be imported into Color. Compatible formats
include Final Cut Pro XML files, and compatible EDL files from nearly any editing
environment.
• High-quality digital versions of the original source media, in a compatible QuickTime
or image sequence format.
Project and media format flexibility means that Color can be incorporated into a wide
variety of post-production workflows. For an overview of different color correction
workflows using Color, see Color Correction Workflows.
About Exporting Projects from Color
Color doesn’t handle video capture or output to tape on its own. Once you finish color
correcting your project in Color, you render every shot in the project to disk as an alternate
set of color-corrected media files, and you then send your Color project back to
Final Cut Pro, or hand it off to another facility for tape layoff or film out. For more
information, see The Render Queue.
What Footage Does Color Work With?
Color can work with film using scanned DPX or Cineon image sequences, or with video
clips using QuickTime files, at a variety of resolutions and compression ratios. This means
you have the option of importing and outputting nearly any professional format, from
highly compressed standard definition QuickTime DV-25 shots up through uncompressed
2K or 4K DPX image sequences—whatever your clients provide.
Image Encoding Standards
The sections listed below provide important information about the image encoding
standards supported by Color. The image data you’ll be color correcting is typically
encoded either using an RGB or Y′CBCR
(sometimes referred to as YUV) format. Color is
extremely flexible and capable of working with image data of either type. For detailed
information, see:
• The RGB Additive Color Model Explained
• The Y′CBCR Color Model Explained
• Chroma Subsampling Explained
• Bit Depth Explained
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In the RGB color model, three color channels are used to store red, green, and blue values
in varying amounts to represent each available color that can be reproduced. Adjusting
the relative balance of values in these color channels adjusts the color being represented.
When all three values are equal, the result is a neutral tone, from black through gray to
white.
More typically, you’ll see these ratios expressed as digital percentages in the Color Parade
scope or Histogram. For example, if all three color channels are 0%, the pixel is black. If
all three color channels are 50%, the pixel is a neutral gray. If all three color channels are
100% (the maximum value), the pixel is white.
Animation (an older, 8-bit codec) and Apple ProRes 4444 (a newer 10-bit codec) are the
two most commonly used RGB QuickTime codecs. In digital intermediate workflows,
RGB-encoded images are typically stored as uncompressed DPX or Cineon image
sequences.
The Y′CBCR Color Model Explained
Video is typically recorded using the Y′CBCR
 color model. Y′CBCR color coding also employs
three channels, or components. A shot’s image is divided into one luma component (luma
is image luminance modified by gamma for broadcast) and two color difference
components which encode the chroma (chrominance). Together, these three components
make up the picture that you see when you play back your video.
• The Y′ component represents the black-and-white portion of an image’s tonal range.
Because the eye has different sensitivities to the red, green, and blue portions of the
spectrum, the image “lightness” that the Y′ component reproduces is derived from a
weighted ratio of the (gamma-corrected) R, G, and B color channels. (Incidentally, the
Y′ component is mostly green.) Viewed on its own, the Y′ component is the
monochrome image.
• The two color difference components, CB and CR
, are used to encode the color
information in such a way as to fit three color channels of image data into two. A bit
of math is used to take advantage of the fact that the Y′ component also stores green
information for the image. The actual math used to derive each color component is CB
= B′ - Y′, while CR = R′ - Y′.
Note: This scheme was originally created so that older black-and-white televisions would
be compatible with the newer color television transmissions.
Chroma Subsampling Explained
In Y′CBCR encoded video, the color channels are typically sampled at a lower ratio than
the luma channel. Because the human eye is more sensitive to differences in brightness
than in color, this has been used as a way of reducing the video bandwidth (or data rate)
requirements without perceptible loss to the image.
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, and CR channels is notated as a three-value ratio.
There are four common chroma subsampling ratios:
• 4:4:4: 4:4:4 chroma subsampled media encodes completely uncompressed color, the
highest quality possible, as the color difference channels are sampled at the same rate
as the luma channel. 4:4:4 subsampled image data is typically obtained via telecine or
datacine to an image sequence or video format capable of containing it, and is generally
employed for digital intermediate and film workflows. RGB encoded images such as
DPX and Cineon image sequences and TIFF files are always 4:4:4.
The Apple ProRes 4444 codec lets you capture, transcode to, and master media at this
high quality. (The fourth 4 refers to the ability of Apple ProRes 4444 to preserve an
uncompressed alpha channel in addition to the three color channels; however, Color
doesn’t support alpha channels.)
Be aware that simply rendering at 4:4:4 doesn’t guarantee a high-quality result. If media
is not acquired at 4:4:4, then rendering at 4:4:4 will preserve the high quality of
corrections you make to the video, but it won’t add color information that wasn’t there
to begin with.
As of this writing, few digital acquisition formats are capable of recording 4:4:4 video,
but those that do include HDCAM SR, as well as certain digital cinema cameras, including
the RED, Thompson Viper FilmStream, and Genesis digital camera systems.
• 4:2:2: 4:2:2 is a chroma subsampling ratio typical for many high-quality standard and
high definition video acquisition and mastering formats, including Beta SP (an analog
format), Digital Betacam, Beta SX, IMX, DVCPRO 50, DVCPRO HD, HDCAM, and D-5 HD.
Although storing half the color information of 4:4:4, 4:2:2 is standard for video mastering
and broadcast. As their names imply, Apple Uncompressed 8-bit 4:2:2, Apple
Uncompressed 10-bit 4:2:2, Apple ProRes 422, and Apple ProRes 422 (HQ) all use 4:2:2
chroma subsampling.
• 4:1:1 and 4:2:0: 4:1:1 is typical for consumer and prosumer video formats including
DVCPRO 25 (NTSC and PAL), DV, and DVCam (NTSC).
4:2:0 is another consumer-oriented subsampling rate, used by DV (PAL), DVCAM (PAL),
and MPEG-2, as well as the high definition HDV and XDCAM HD formats.
Due to their low cost, producers of all types have flocked to these formats for acquisition,
despite the resulting limitations during post-production (discussed below). Regardless,
whatever the acquisition format, it is inadvisable to master using either 4:1:1 or 4:2:0
video formats.
It’s important to be aware of the advantages of higher chroma subsampling ratios in the
color correction process. Whenever you’re in a position to specify the transfer format with
which a project will be finished, make sure you ask for the highest-quality format your
system can handle. (For more information about high-quality finishing codecs, see A
Tape-Based Workflow.)
Chapter 1 Color Correction Basics 25As you can probably guess, more color information is better when doing color correction.
For example, when you make large contrast adjustments to 4:1:1 or 4:2:0 subsampled
video, video noise in the image can become exaggerated; this happens most often with
underexposed footage. You’ll find that you can make the same or greater adjustments
to 4:2:2 subsampled video, and the resulting image will have much less grain and noise.
Greater contrast with less noise provides for a richer image overall. 4:4:4 allows the most
latitude, or flexibility, for making contrast adjustments with a minimum of artifacts and
noise.
Furthermore, it’s common to use chroma keying operations to isolate specific areas of
the picture for correction. This is done using the HSB qualifiers in the Secondaries room.
(For more information, see Choosing a Region to Correct Using the HSL Qualifiers.) These
keying operations will have smoother and less noisy edges when you’re working with
4:2:2 or 4:4:4 subsampled video. The chroma compression used by 4:1:1 and 4:2:0
subsampled video results in macroblocks around the edges of the resulting matte when
you isolate the chroma, which can cause a “choppy” or “blocky” result in the correction
you’re trying to create.
Despite these limitations, it is very possible to color correct highly compressed video. By
paying attention to image noise as you stretch the contrast of poorly exposed footage,
you can focus your corrections on the areas of the picture where noise is minimized.
When doing secondary color correction to make targeted corrections to specific parts of
the image, you may find it a bit more time consuming to pull smooth secondary keys.
However, with care and patience, you can still achieve beautiful results.
Film Versus Video and Chroma Subsampling
With a bit of care you can color correct nearly any compressed video or image sequence
format with excellent results, and Color gives you the flexibility to use highly compressed
source formats including DV, HDV, and DVCPRO HD.
Standard and high definition video, on the other hand, is usually recorded with lower
chroma subsampling ratios (4:2:2 is typical even with higher-quality video formats, and
4:1:1 and 4:2:0 are common with prosumer formats) and higher compression ratios,
depending entirely upon the recording and video capture formats used. Since the
selected video format determines compression quality at the time of the shoot, there’s
nothing you can do about the lost image data, other than to make the best of what you
have.
In general, film footage is usually transferred with the maximum amount of image data
possible, especially when transferred as a completely uncompressed image sequence
(4:4:4) as part of a carefully managed digital intermediate workflow. This is one reason
for the higher quality of the average film workflow.
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Another factor that affects the quality of video images, and can have an effect on the
quality of your image adjustments, is the bit depth of the source media you’re working
with. With both RGB and Y′CBCR encoded media, the higher the bit depth, the more image
data is available, and the smoother both the image and your corrections will be. The
differences between images at different bit depths is most readily apparent in gradients
such as skies, where lower bit depths show banding, and higher bit depths do not.
The bit depth of your source media depends largely on how that media was originally
acquired. Most of the media you’ll receive falls into one of the following bit depths, all of
which Color supports:
• 8-bit: Most standard and high definition consumer and professional digital video formats
capture 8-bit image data, including DV and DVCPRO-25, DVCPRO 50, HDV, DVCPRO
HD, HDCAM, and so on.
• 10-bit: Many video capture interfaces allow the uncompressed capture of analog and
digital video at 10-bit resolution.
• 10-bit log: By storing data logarithmically, rather than linearly, a wider contrast ratio
(such as that of film) can be represented by a 10-bit data space. 10-bit log files are often
recorded from datacine scans using the Cineon and DPX image sequence formats.
• 12-bit: Some cameras, such as the RED ONE, capture digital images at 12-bit, providing
for even smoother transitions in gradients.
• 16-bit: It has been said that it takes 16 bits of linear data to match the contrast ratio
that can be stored in a 10-bit log file. Since linear data is easier for computers to process,
this is another data space that’s available in some image formats.
• Floating Point: The highest level of image-processing quality available. Refers to the
use of floating-point math to store and calculate fractional data. This means that values
higher than 1 can be used to store data that would otherwise be rounded down using
the integer-based 8-bit, 10-bit, 12-bit, and 16-bit depths. Floating Point is a
processor-intensive bit depth to work with.
Higher bit depths accommodate more image data by using a greater range of numbers
to represent the tonal range that’s available. This is apparent when looking at the numeric
ranges used by the two bit depths most commonly associated with video.
• 8-bit images use a full range of 0–255 to store each color channel. (Y′CBCR video uses
a narrower range of 16–235 to accommodate super-black and super-white.) 255 isn’t
a lot of values, and the result can be subtly visible “stairstepping” in areas of the picture
with narrow gradients (such as skies).
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channel. (Again, Y′CBCR video uses a narrower range of 64–940 to accommodate
super-black and super-white.) The additional numeric range allows for smoother
gradients and virtually eliminates bit depth–related artifacts.
Fortunately, while you can’t always control the bit depth of your source media, you can
control the bit depth at which you work in Color independently. This means that even if
the source media is at a lower bit depth, you can work at a higher bit depth to make sure
that the quality of your corrections is as high as possible. In particular, many effects and
secondary corrections look significantly better when Color is set to render at higher bit
depths. For more information, see Playback, Processing, and Output Settings.
Basic Color and Imaging Concepts
Color correction involves controlling both an image’s contrast and its color (exercising
separate control over its hue and saturation). This section explains these important imaging
concepts so that you can better understand how the Color tools let you alter the image.
For detailed information, see:
• Contrast Explained
• Luma Explained
• Gamma Explained
• Chroma Explained
• Primary and Secondary Color Relationships Explained
• The HSL Color Space Model Explained
Contrast Explained
Contrast adjustments are among the most fundamental, and generally the first,
adjustments made. Contrast is a way of describing an image’s tonality. If you eliminate
all color from an image, reducing it to a series of grayscale tones, the contrast of the
picture is seen by the distribution of dark, medium, and light tones in the image.
Controlling contrast involves adjustments to three aspects of an image’s tonality:
• The black point is the darkest pixel in the image.
• The white point is the brightest pixel in the image.
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points.
Black Mids White
An image’s contrast ratio is the difference between the darkest and brightest tonal values
within that image. Typically, a higher contrast ratio, where the difference between the
two is greater, is preferable to a lower one. Unless you’re specifically going for a
low-contrast look, higher contrast ratios generally provide a clearer, crisper image. The
following two images, with their accompanying Histograms which show a graph of the
distribution of shadows, midtones, and highlights from left to right, illustrate this.
In addition, maximizing the contrast ratio of an image aids further color correction
operations by more evenly distributing that image’s color throughout the three tonal
zones that are adjusted with the three color balance controls in the Primary In, Secondaries,
and Primary Out rooms. This makes it easier to perform individual corrections to the
shadows, midtones, and highlights.
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Luma Explained
Luma (which technically speaking is gamma-corrected luminance) describes the exposure
(lightness) of a video shot, from absolute black, through the distribution of gray tones,
all the way up to the brightest white. Luma can be separated from the color of an image.
In fact, if you desaturate an image completely, the grayscale image that remains is the
luma.
Luma is measured by Color as a digital percentage from 0 to 100, where 0 represents
absolute black and 100 represents absolute white. Color also supports super-white levels
(levels from 101 to 109 percent) if they exist in your shot. While super-white video levels
are not considered to be safe for broadcast, many cameras record video at these levels
anyway.
Black
0% luminance 100% 109%
White
Super-white
Note: Unadjusted super-white levels will be clamped by the Broadcast Safe settings (if
they’re turned on with their default settings), so that pixels in the image with luma above
100 percent will be set to 100 percent.
What Is Setup?
People often confuse the black level of digital video with setup. Setup refers to the
minimum black level assigned to specific analog video signals and is only an issue with
analog video output to the Beta SP tape format. If you are outputting to an analog tape
format using a third-party analog video interface, you should check the documentation
that came with that video interface to determine how to configure the video interface
for the North American standard for setup (7.5 IRE) or the Japanese standard (0 IRE).
Most vendors of analog video interfaces include a software control panel that allows
you to select which black level to use. Most vendors label this as “7.5 Setup” versus “0
Setup,” or in some cases “NTSC” versus “NTSC-J.”
Video sent digitally via SDI has no setup. The Y′CBCR minimum black level for all digital
video signals is 0 percent, 0 IRE, or 0 millivolts, depending on how you’re monitoring
the signal.
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Gamma refers to two different concepts. In a video signal, gamma refers to the nonlinear
representation of luminance in a picture displayed on a broadcast or computer monitor.
Since the eye has a nonlinear response to light (mentioned in The Y′CBCR Color Model
Explained), applying a gamma adjustment while recording an image maximizes the
perceptible recorded detail in video signals with limited bandwidth. Upon playback, a
television or monitor applies an inverted gamma function to return the image to its
“original” state.
You want to avoid unplanned gamma adjustments when sending media from Final Cut Pro
to Color. It’s important to keep track of any possible gamma adjustments that occur when
exporting or importing clips in Final Cut Pro during the editing process, so that these
adjustments are accounted for and avoided during the Final Cut Pro–to–Color roundtrip.
For more information on gamma handling in Final Cut Pro, see the Final Cut Pro 7
User Manual.
Gamma is also used to describe a nonlinear adjustment made to the distribution of
midtones in an image. For example, a gamma adjustment leaves the black point and the
white point of an image alone, but either brightens or darkens the midtones according
to the type of adjustment being made. For more information on gamma and midtones
adjustments, see The Primary In Room.
Chroma Explained
Chroma (also referred to as chrominance) describes the color channels in your shots,
ranging from the absence of color to the maximum levels of color that can be represented.
Specific chroma values can be described using two properties, hue and saturation.
Hue
Hue describes the actual color itself, whether it’s red or green or yellow. Hue is measured
as an angle on a color wheel.
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Saturation describes the intensity of that color, whether it’s a bright red or a pale red. An
image that is completely desaturated has no color at all and is a grayscale image. Saturation
is also measured on a color wheel, but as the distance from the center of the wheel to
the edge.
As you look at the color wheel, notice that it is a mix of the red, green, and blue primary
colors that make up video. In between these are the yellow, cyan, and magenta secondary
colors, which are equal mixes of the primary colors.
Primary and Secondary Color Relationships Explained
Understanding color wheel interactions will help you to see how the Color controls actually
affect colors in an image.
Primary Colors
In any additive color model, the primary colors are red, green, and blue. These are the
three purest colors that can be represented, by setting a single color channel to 100
percent and the other two color channels to 0 percent.
Secondary Colors
Adding any two primary colors produces a secondary color. In other words, you create a
secondary color by setting any two color channels to 100 percent while setting the third
to 0 percent.
• Red + green = yellow
• Green + blue = cyan
• Blue + red = magenta
One other aspect of the additive color model:
• Red + green + blue = white
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any two primaries overlap, the secondary appears, and where all three overlap, white
appears.
Complementary Colors
Two colors that appear 180 degrees opposite each other on the wheel are referred to as
complementary colors.
Adding two complementary colors of equal saturation to each other neutralizes the
saturation, resulting in a grayscale tone. This can be seen in the two overlapping color
wheels in the illustration below. Where red and cyan precisely overlap, both colors become
neutralized.
Understanding the relationship of colors to their complementaries is essential in learning
how to eliminate or introduce color casts in an image using the Color Primary or Secondary
color correction controls. For example, to eliminate a bluish cast in the highlights of
unbalanced daylight, you add a bit of orange to bring all the colors to a more neutral
state. This is covered in more detail in The Primary In Room.
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The HSL color space model is another method for representing color and is typically used
for user interface controls that let you choose or adjust colors. HSL stands for hue,
saturation, and lightness (roughly equivalent to luminance) and provides a way of
visualizing the relationships among luminance, hue, and saturation.
The HSL color space model can be graphically illustrated as a three-dimensional cone.
Hue is represented by an angle around the base of the cone, as seen below, while
saturation is represented by a color’s distance from the center of the cone to the edge,
with the center being completely desaturated and the edge being saturated to maximum
intensity. A color’s brightness, then, can be represented by its distance from the base to
the peak of the cone.
Color actually provides a three-dimensional video scope that’s capable of displaying the
colors of an image within an extruded HSL space, for purposes of image analysis. For
more information, see The 3D Scope.
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outlines where Color fits into your post-production workflow.
Color has been designed to work hand in hand with editing applications like Final Cut Pro
via XML and QuickTime media support, or with other editorial environments via EDL and
image sequence support. While video and film input and editing are taken care of
elsewhere, Color gives you a dedicated environment in which to focus on color correction
and related effects.
This chapter gives you a quick overview of how to guide your project through a workflow
that includes using Color for color correction. Information is provided about both standard
and high definition broadcast video workflows, as well as 2K digital intermediate workflows.
This chapter covers the following:
• An Overview of the Color Workflow (p. 35)
• Limitations in Color (p. 37)
• Video Finishing Workflows Using Final Cut Pro (p. 39)
• Importing Projects from Other Video Editing Applications (p. 47)
• Digital Cinema Workflows Using Apple ProRes 4444 (p. 50)
• Finishing Projects Using RED Media (p. 56)
• Digital Intermediate Workflows Using DPX/Cineon Media (p. 65)
• Using EDLs, Timecode, and Frame Numbers to Conform Projects (p. 73)
An Overview of the Color Workflow
All controls in Color are divided into eight tabbed rooms, each of which corresponds to
a different stage in a typical color correction workflow. When you move from room to
room, the buttons, dials, and trackballs of your control surface (if you have one) remap
to correspond to the controls in that room.
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2Each room gathers all the controls pertaining to that particular step of the color correction
process onto a single screen. These rooms are organized from left to right in the order
colorists will typically use them, so that after adjusting your project’s preferences in the
Setup room, you can work your way across from the Primary controls, to the Secondary
controls, Color FX, Primary Out, and finally Geometry as you adjust each shot in your
project.
• Setup: All projects begin in the Setup room. This is where you import and manage the
shots in your program. The grade bin, project settings, and application preferences are
also found within the Setup room. For video colorists, the project settings area of the
Setup room is where you find the Broadcast Safe controls, which allow you to apply
gamut restrictions to the entire program.
• Primary In: Primary color corrections affect the entire image, so this room is where you
make overall adjustments to the color and contrast of each shot. Color balance and
curve controls let you adjust colors in the shadows, midtones, and highlights of the
image. The lift, gamma, and gain controls let you make detailed contrast adjustments,
which affect the brightness of different areas of the picture. There are also controls for
overall, highlight, and shadow saturation, and printer point (or printer light) controls
for colorists used to color timing for film.
• Secondaries: Secondary color corrections are targeted adjustments made to specific
areas of the image. This room provides numerous methods for isolating, or qualifying,
the parts of the image you want to correct. Controls are provided with which to isolate
a region using shape masks. Additional controls let you isolate areas of the picture
using a chroma-keyed matte with individual qualifications for hue, saturation, and
luminance. Each shot can have up to eight secondary operations. Furthermore,
special-purpose secondary curves let you make adjustments to hue, saturation, and
luma within specific portions of the spectrum.
• Color FX: The Color FX room lets you create your own custom effects via a node-based
interface more commonly found in high-end compositing applications, similar to Shake.
These individual effects nodes can be linked together in thousands of combinations,
providing a fast way to create many different types of color effects. Your custom effects
can be saved in the Color FX bin for future use, letting you apply your look to future
projects.
• Primary Out: The Primary Out room is identical to the Primary In room except that its
color corrections are applied to shots after they have been processed by all the other
color grading rooms. This provides a way to post-process your images after all other
operations have been performed.
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necessary. The Geometry room also provides tools for creating custom masks and for
applying and managing motion-tracking analyses. How Geometry room transformations
are handled depends on your workflow:
• For projects being roundtripped from Final Cut Pro, Geometry room transformations
are not rendered by Color when outputting the corrected project media. Instead, all
the geometric transformations you create in Color are translated into Final Cut Pro
Motion tab settings when the project is sent back to Final Cut Pro. You then have
the option to further customize those effects in Final Cut Pro prior to rendering and
output.
• For 2K and 4K digital intermediates, as well as projects using 4K native RED QuickTime
media, Geometry room transformations are processed by Color when rendering the
output media.
Note: When you send a project from Final Cut Pro to Color, compatible Motion tab
settings are translated into Geometry room settings. You can preview and adjust these
transformations as you color correct. For more information, see The Geometry Room.
• Still Store: You can save frames from anywhere in the Timeline using the Still Store,
creating a reference library of stills from your program from which you can recall images
to compare to other shots you're trying to match. You can load one image from the
Still Store at a time into memory, switching between it and the current frame at the
position of the playhead using the controls in the Still Store menu. The Still Store also
provides controls for creating and customizing split screens you can use to balance
one shot to another. All Still Store comparisons are sent to the preview and broadcast
monitor outputs.
• Render Queue: When you finish grading your program in Color, you use the Render
Queue to manage the rendering of the shots in your project.
Limitations in Color
Color has been designed to work hand in hand with Final Cut Pro; Final Cut Pro lets you
take care of input, editing, and output, while Color allows you to focus on color correction
and related effects. Given this relationship, there are specific things it does not do:
• Recording: Color is incapable of either scanning or capturing film or video footage. This
means that you need to import projects and media into Color from another application.
• Editing: Color is not intended to be an editing application. The editing tools that are
provided are primarily for colorists working in 2K workflows where the Color project is
the final version that will become the digital master. By default, the tracks of imported
XML project files are locked to prevent new edits from introducing errors when the
project moves back to Final Cut Pro.
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an EDL or Final Cut Pro sequence with the version of that project being graded in Color.
For more information, see Reconforming Projects.
• Filters: Final Cut Pro FXScript or FxPlug filters are neither previewed nor rendered by
Color. However, their presence in your project is maintained, and they show up again
once the project is sent back to Final Cut Pro.
Note: It's not generally a good idea to allow various filters that perform color correction
to remain in your Final Cut Pro project when you send it to Color. Even though they
have no effect as you work in Color, their sudden reappearance when the project is
sent back to Final Cut Pro may produce unexpected results.
• Final Cut Pro Color Corrector 3-way filters: Color Corrector 3-way filters applied to clips
in your sequence are automatically converted into adjustments to the color balance
controls, primary contrast controls, and saturation controls in the Primary In room of
each shot to which they’re applied. Once converted, these filters are removed from the
XML data for that sequence, so that they do not appear in the sequence when it’s sent
back to Final Cut Pro.
If more than one filter has been applied to a clip, then only the last Color Corrector
3-way filter appearing in the Filters tab is converted; all others are ignored. Furthermore,
any Color Corrector 3-way filter with limit effects turned on is also ignored.
• Transitions: Color preserves transition data that might be present in an imported EDL
or XML file, but does not play the transitions during previews. How they're rendered
depends on how the project is being handled:
• For projects being roundtripped from Final Cut Pro, transitions are not rendered in
Color. Instead, Color renders handles for the outgoing and incoming clips, and
Final Cut Pro is relied upon to render each transition after the project's return.
• When rendering 2K or 4K DPX or Cineon image sequences, all video transitions are
rendered as linear dissolves when you use the Gather Rendered Media command to
consolidate the finally rendered frames of your project in preparation for film output.
This feature is only available for projects that use DPX and Cineon image sequence
media or RED QuickTime media, and is intended only to support film out workflows.
Only dissolves are rendered; any other type of transition (such as a wipe or iris) will be
rendered as a dissolve instead.
• Superimpositions: Superimposed shots are displayed in the Timeline, but compositing
operations involving opacity and composite modes are neither displayed nor rendered.
• Speed effects: Color doesn't provide an interface for adding speed effects, relying instead
upon the editing application that originated the project to do so. Linear and variable
speed effects that are already present in your project, such as those added in
Final Cut Pro, are previewed during playback, but they are not rendered in Color during
output. Instead, Final Cut Pro is relied upon to render those effects in roundtrip
workflows.
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are completely ignored by Color. How you handle these types of effects also depends
on your workflow:
• If you're roundtripping a project between Final Cut Pro and Color, and you want to
grade these effects in Color, you should render these effects as self-contained
QuickTime .mov files. Then, edit the new .mov files into your sequence to replace
the original effects shots prior to sending your project to Color.
• If you're roundtripping a project between Final Cut Pro and Color, and there's no
need to grade these effects, you don't need to do anything. Even though these effects
aren't displayed in Color, their position in the Timeline is preserved, and these effects
will reappear in Final Cut Pro when you send the project back. Titles are a good
example of effects that don't usually need to be graded.
• If you're working on a 2K or 4K digital intermediate or RED QuickTime project, you
need to use a compositing application like Shake or Motion to composite any effects
using the image sequence data.
Important: When you send frames of media to a compositing application, it's vital that
you maintain the frame number in the filenames of new image sequence media that
you generate. Each image file's frame number identifies its position in that program's
Timeline, so any effects being created as part of a 2K digital intermediate workflow
require careful file management.
• Video or film output: While Color provides broadcast output of your project's playback
for preview purposes, this is not intended to be used to output your program to tape.
This means that when you finish color correcting your project in Color, the rendered
output needs to be moved to Final Cut Pro for output to tape or to another environment
for film output.
Video Finishing Workflows Using Final Cut Pro
If a program has been edited using Final Cut Pro, the process of moving it into Color is
fairly straightforward. After editing the program in Final Cut Pro, you must reconform the
program, if necessary, to use the original source media at its highest available quality.
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for color correction. Upon completion of the color correction pass, you need to render
the result and send the project back to Final Cut Pro for final output, either to tape or as
a QuickTime file.
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Exactly how you conform your source media in Final Cut Pro depends on the type of
media that's used. For more information, see:
• A Tape-Based Workflow.
• Reconforming Online Media in a Tapeless Digital Video Workflow.
• Reconforming Online Media in a Film-to-Tape Workflow.
A Tape-Based Workflow
For a traditional offline/online tape-based workflow, the video finishing process is simple.
The tapes are captured into Final Cut Pro, possibly at a lower-quality offline resolution to
ease the initial editing process by using media that takes less hard disk space and is easier
to work with using a wider range of computers.
40 Chapter 2 Color Correction WorkflowsAfter the offline edit is complete, the media used by the edited program must be
recaptured from the source tapes at maximum quality. The resulting online media is what
will be used for the Final Cut Pro–to–Color roundtrip.
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The following steps break this process down more explicitly.
Stage 1: Capturing the Source Media at Offline or Online Resolution
How you decide to capture your media prior to editing depends on its format. Compressed
formats, including DV, DVCPRO-50, DVCPRO HD, and HDV, can be captured at their highest
quality without requiring enormous storage resources. If this is the case, then capturing
and editing your media using its native resolution and codec lets you eliminate the
time-consuming step of recapturing (sometimes called conforming or reconforming) your
media later.
Uncompressed video formats, or projects where there are many, many reels of source
media, may benefit from being captured at a lower resolution or with a more highly
compressed codec. This will save disk space and also enable you to edit using less
expensive equipment. Later, you'll have to recapture the media prior to color correction.
Stage 2: Editing the Program in Final Cut Pro
Edit your program in Final Cut Pro, as you would any other project. If you're planning on
an extensive use of effects in your program during editorial, familiarize yourself with the
topics covered in Limitations in Color.
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If you originally captured your source media using an offline format, you need to recapture
the media used in your project at the highest available quality prior to sending it to Color.
• If your media was originally recorded using a compressed format (such as DV,
DVCPRO-50, DVCPRO HD, or HDV), then recapturing it using the original source codec
and resolution is fine; Color can work with compressed media and automatically
promotes the image data to higher uncompressed bit depths for higher quality imaging
when monitoring and rendering.
• If you're capturing a higher-bandwidth video format (such as Betacam SP, Digital
Betacam, HDCAM, and HDCAM SR) and require high quality but need to use a
compressed format to save hard disk space and increase performance on your particular
computer, then you can recapture using the Apple ProRes 422 codec, or the higher
quality Apple ProRes 422 (HQ) codec.
• If you're capturing high-bandwidth video and require the highest-quality uncompressed
video data available, regardless of the storage requirements, you should recapture your
media using Apple Uncompressed 8-bit 4:2:2 or Apple Uncompressed 10-bit 4:2:2.
You may also want to take the opportunity to use the Final Cut Pro Media Manager to
delete unused media prior to recapturing in order to save valuable disk space, especially
when recapturing uncompressed media. For more information, see the Final Cut Pro 7
User Manual.
Note: Some codecs, such as HDV, can be more processor-intensive to work with than
others. In this case, capturing or recompressing the media with a less processor-intensive
codec, such as Apple ProRes 422 or Apple ProRes 422 (HQ), will improve your performance
while you work in Color, while maintaining high quality and low storage requirements.
Stage 4: Preparing Your Final Cut Pro Sequence
To prepare your edited sequence for an efficient workflow in Color, follow the steps
outlined in Before You Export Your Final Cut Pro Project.
Stage 5: Sending the Sequence to Color or Exporting an XML File
When you finish prepping your edited sequence, there are two ways you can send it to
Color.
• If Color is installed on the same computer as Final Cut Pro, you can use the Send To
Color command to move an entire edited sequence to Color, automatically creating a
new project file.
• If you're handing the project off to another facility, you may want to export the edited
sequence as an XML file for eventual import into Color. In this case, you'll also want to
use the Final Cut Pro Media Manager to copy the project's media to a single,
transportable hard drive volume for easy handoff.
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Use Color to grade your program. When working on a roundtrip from Final Cut Pro, it's
crucial to avoid unlocking tracks or reediting shots in the Timeline. Doing so can
compromise your ability to send the project back to Final Cut Pro.
If the client needs a reedit after you've started grading, you should instead perform the
edit back in Final Cut Pro, and export an XML version of the updated sequence which
you can use to quickly update the Color project in progress using the Reconform
command. For more information, see Reconforming Projects.
Stage 7: Rendering New Source Media and Sending the Updated Project to
Final Cut Pro
When you finish grading, you use the Color Render Queue to render all the shots in the
project as a new, separate set of graded media files.
Afterward, you need to send the updated project to Final Cut Pro using one of the two
following methods:
• If Color is installed on the same computer as Final Cut Pro, you can use the Send To
Final Cut Pro command.
• If you're handing the color-corrected project back to the originating facility, you need
to export the Color project as an XML file for later import into Final Cut Pro.
Important: Some parameters in the Project Settings tab of the Setup room affect how
the media is rendered by Color. These settings include the Deinterlace Renders, QuickTime
Export Codec, Broadcast Safe, and Handles settings. Be sure to verify these and other
settings prior to rendering your final output.
Stage 8: Adjusting Transitions, Superimpositions, and Titles in Final Cut Pro
To output your project, you need to import the XML project data back into Final Cut Pro.
This happens automatically if you use the Send To Final Cut Pro command. At this point,
you can add or adjust other effects that you had applied previously in Final Cut Pro, before
creating the program's final master. Things you may want to consider while prepping
the program at this stage include:
• Do you need to produce a "textless" master of the program, or one with the titles
rendered along with the image?
• Are there any remaining effects clips that you need to import and color correct within
Final Cut Pro?
Stage 9:Outputting the Final Video Master to Tape or Rendering a Master QuickTime
File
Once you complete any last adjustments in Final Cut Pro, you can use the Print to Video,
Edit to Tape, or Export QuickTime Movie command to create the final version of your
program.
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If a program uses a tapeless video format, the steps are similar to those described in A
Tape-Based Workflow; however, they likely involve multiple sets of QuickTime files: the
original media at online resolution and perhaps a second set of media files that have
been downconverted to an offline resolution for ease of editing. After the offline edit,
the online conform involves relinking to the original source media, prior to going through
the Final Cut Pro–to–Color roundtrip.
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Here's a more detailed explanation of the offline-to-online portion of this workflow.
Stage 1: Shooting and Backing Up All Source Media
Shoot the project using whichever tapeless format you've chosen. As you shoot, make
sure that you're keeping backups of all your media, in case anything happens to your
primary media storage device.
Stage 2: Creating Offline Resolution Duplicates and Archiving Original-Resolution
Media
If necessary, create offline resolution duplicates of the source media in whatever format
is most suitable for your system. Then, archive the original source media as safely as
possible.
44 Chapter 2 Color Correction WorkflowsImportant: When you create offline duplicates of tapeless media, it's vital that you
duplicate and maintain the original filenames and timecode with which the source files
were created. This is critical to guaranteeing that you'll be able to easily relink to the
original high-resolution source files once the offline edit is complete.
Stage 3: Editing the Program in Final Cut Pro
Edit your program in Final Cut Pro, as you would any other project. If you're planning on
an extensive use of effects in your program during editorial, familiarize yourself with the
topics covered in Limitations in Color.
Stage 4: Relinking Your Edited Sequence to the Original Source Media
Once your offline edit is complete, you need to restore the original online-quality source
media and relink to or retransfer the high-resolution files.
Stage 5: Prerendering Effects, Sending the Sequence to Color, and Grading
At this point, the workflow is identical to Stage 6: Grading Your Program in Color in A
Tape-Based Workflow.
Reconforming Online Media in a Film-to-Tape Workflow
If you're working on a project that was shot on film but will be mastered on video, it must
be transferred from film to tape using a telecine prior to being captured and edited in
Final Cut Pro. At that point, the rest of the offline and online edit is identical to any other
tape-based format.
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Here's a more detailed explanation of the offline-to-online portion of this workflow.
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Shoot the project as you would any other film project.
Stage 2: Telecining the Dailies
After the film has been shot, process and telecine the dailies to a video format appropriate
for your workflow.
• Some productions prefer to save money up front by doing an inexpensive "one-light"
transfer of all the footage to an inexpensive offline video format for the initial offline
edit. (A one-light transfer refers to the process of using a single color correction setting
to transfer whole scenes of footage.) This can save time and money up front, but may
necessitate a second telecine session to retransfer only the footage used in the edit at
a higher level of visual quality.
• Other productions choose to transfer all the dailies (or at least the director's selected
takes) via a "best-light" transfer, where the color correction settings are individually
adjusted for every shot that's telecined, optimizing the color and exposure for each
clip. The footage is transferred to a high-quality video format capable of preserving as
much image data as possible. This can be significantly more expensive up front, but
saves money later since a second telecine session is not necessary.
Stage 3: Capturing the Source Media at Offline or Online Resolution
How you capture your media prior to editing depends on your workflow. If you telecined
offline-quality media, then you might as well capture using an offline-quality codec.
If you instead telecined online-quality media, then you have the choice of either pursuing
an "offline/online" workflow or capturing via an online codec and working at online quality
throughout the entire program.
Stage 4: Editing the Program in Final Cut Pro
Edit your program in Final Cut Pro, as you would any other project. If you're planning on
the extensive use of effects in your program during editorial, familiarize yourself with the
topics covered in Limitations in Color.
Stage 5: Recapturing or Retransferring the Media at Online Resolution
The way you conform your offline project to online-quality media depends on how you
handled the initial video transfer.
• If you originally did a high-quality telecine pass to an online video format, but you
captured your source media using an offline format for editing, you need to recapture
the media from the original telecine source tapes using the highest-quality
uncompressed QuickTime format that you can accommodate on your computer (such
as Apple ProRes 4444, Apple ProRes 422 (HQ), or Apple Uncompressed) and relink the
new media to your project.
46 Chapter 2 Color Correction Workflows• If you did an inexpensive one-light telecine pass to an offline video format, you'll want
to do another telecine pass where you transfer only the media you used in the program
at high quality. Using Cinema Tools, you can generate a pull list, which you then use
to carefully retransfer the necessary footage to an online-quality video format. Then,
you need to recapture the new online transfer of this media using the highest-quality
uncompressed QuickTime format that you can accommodate on your computer.
Important: Do not use the Media Manager to either rename or delete unused media in
your project when working with offline media that refers to the camera negative. If you
do, you'll lose the ability to create accurate pull lists in Cinema Tools.
Stage 6: Prerendering Effects, Sending the Sequence to Color, and Grading
At this point, the workflow is identical to Stage 6: Grading Your Program in Color in A
Tape-Based Workflow.
Importing Projects from Other Video Editing Applications
Color is also capable of importing projects from other editing environments, by importing
edit decision lists (EDLs). An EDL is an event-based list of all the edits and transitions that
make up a program.
Once you've imported your project file into Color and copied the program media onto a
storage device with the appropriate performance, you can then link the shots on the
Color Timeline with their corresponding media.
• For more information about importing EDLs into Final Cut Pro before sending to Color,
see Importing EDLs in a Final Cut Pro–to–Color Roundtrip.
• For more information about importing EDLs directly into Color, see Importing and
Notching Preedited Program Masters.
Importing EDLs in a Final Cut Pro–to–Color Roundtrip
If you've been provided with an edit decision list of the edited program and a box of
source media, you can import the EDL into Final Cut Pro to capture the project's media
and prepare the project for sending to Color. In addition to being able to recapture the
footage, Final Cut Pro is compatible with more EDL formats than is Color. Also, Final Cut Pro
is capable of reading superimpositions, all SMPTE standard transitions, and audio edits,
in addition to the video edits.
Chapter 2 Color Correction Workflows 47Note: Although capable of importing EDLs directly, Color reads only the video portion
of edits in track V1. Video transitions, audio, and superimpositions are ignored.
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Here's a more detailed explanation of this workflow.
Stage 1: Importing the Project into Final Cut Pro
Import the EDL of the edited project into Final Cut Pro.
Stage 2: Capturing Media at Online Resolution
You need to recapture the sequence created when importing the EDL using the
highest-quality QuickTime format that you can accommodate on your computer (such
as Apple ProRes 422 or Apple Uncompressed).
Stage 3: Prerendering Effects, Sending the Sequence to Color, and Grading
At this point, the workflow is identical to that in Stage 6: Grading Your Program in Color
in A Tape-Based Workflow.
Importing and Notching Preedited Program Masters
Another common way of obtaining a program for color correction is to be provided with
an edited master, either on tape or as a QuickTime movie or image sequence, and an
accompanying EDL. You can use the EDL to automatically add edits to the master media
file in Color (called "notching" the media), to make it easier to grade each shot in the
program individually.
48 Chapter 2 Color Correction WorkflowsImportant: The EDL import capabilities of Color are not as thorough as those in
Final Cut Pro, and are limited only to shots on track V1. All transitions in EDLs are imported
as dissolves. Superimpositions and audio are not supported, and will be ignored.
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Here's a more detailed explanation of this workflow.
Stage 1: Capturing the Program Master
If you were given the program master on tape, you need to capture the entire program
using the highest-quality QuickTime format that you can accommodate on your computer
(such as Apple ProRes 4444, Apple ProRes 422 (HQ), or Apple Uncompressed). If you're
being given the program master as a QuickTime file, you should request the same from
whoever is providing you with the media.
For this process to work correctly, it's ideal if the timecode of the first frame of media
matches the first frame of timecode in the EDL.
Stage 2: Importing the EDL into Color and Relinking to the Master Media File
Either select the EDL from the Projects dialog that appears when you first open Color, or
use the File > Import > EDL command. When the EDL Import Settings dialog appears,
choose the EDL format, project, EDL, and source media frame rates.
To properly "notch" the master media file, you need to turn on "Use as Cut List," and then
choose the master media file that you captured or were given. For more information, see
Importing EDLs.
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Use Color to grade your program, as you would any other.
Stage 4: Rendering New Source Media and Sending the Updated Project to
Final Cut Pro
When you finish grading, you use the Color Render Queue to render all the shots in the
project as a new, separate set of graded media files.
Afterward, you need to send the updated project to Final Cut Pro using one of the two
following methods:
• If Color is installed on the same computer as Final Cut Pro, use the Send To Final Cut Pro
command.
• If you're handing the color-corrected project back to the originating facility, you need
to export the Color project as an XML file for later import into Final Cut Pro.
Stage 5: Adjusting Transitions, Superimpositions, and Titles in Final Cut Pro
To output your project, you can use the Send To Final Cut Pro command, or you can
export an XML project file that can be manually imported into Final Cut Pro. At this point,
you can add other effects in Final Cut Pro, before creating the program's final master.
Stage 6:Outputting the Final Video Master to Tape or Rendering a Master QuickTime
File
Once you complete any last adjustments in Final Cut Pro, you can use the Print to Video,
Edit to Tape, or Export QuickTime Movie commands to create the final version of your
program.
Digital Cinema Workflows Using Apple ProRes 4444
If you’re working with images that were originated on film, HDCAM SR, or some other
high-resolution, RGB-based media, and your intention is to finish and output a project
to film, the Apple ProRes 4444 codec enables you to follow a simple, consolidated
workflow. Consider the following:
• If you’re working with film, you can scan all footage necessary for the project, and then
convert the DPX or Cineon files to Apple ProRes 4444 media in Color.
• If you’re working with DPX or Cineon image sequences from other sources, these can
be converted into Apple ProRes 4444 media using Color, as well.
• If you’re working with HDCAM SR media, you can ingest it directly as Apple ProRes
4444 clips using Final Cut Pro with a capture device that supports this. Both HDCAM
SR and Apple ProRes 4444 are RGB-based, 4:4:4 color subsampled formats, so one is a
natural container for the other.
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can be imported into your Final Cut Pro project. If necessary, you can then create a
duplicate set of lower-resolution offline media with which you can edit your project more
efficiently.
Upon completion of the offline edit, you then relink the program to the original
Apple ProRes 4444 media before sending the sequence to Color, where you’ll be grading
your program. Ultimately, you’ll send the finished media that Color renders directly to
the film recording facility.
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making media management straightforward, and eliminating the need to retransfer or
relink to the source DPX media later. The only disadvantage to this method is that it can
require a substantial amount of storage, depending on the length and shooting ratio of
the project.
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The following steps break this process down more explicitly. Because of the extra steps
needed, this workflow assumes that you’re shooting film.
Stage 1: Running Tests Before You Begin Shooting
Ideally, you should do some tests before principal photography to see how the film
scanner–to–Color–to–film recorder pipeline works with your choice of film formats and
stocks. It's always best to consult with the film lab you'll be working with in advance to
get as much information as possible.
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Depending on how the shoot was conducted, you can opt to do a best-light datacine of
just the selects, or of all the camera negative (if you can afford it). The scanned 2K or 4K
digital source media should be saved as DPX or Cineon image sequences.
To track the correspondence between the original still frames and the offline QuickTime
files that you'll create for editing, you should ask for the following:
• A non-drop frame timecode conversion of each frame's number (used in that frame's
filename), saved within the header of each scanned image.
• It can also help to organize all of the scanned frames into separate directories, saving
all the frames from each roll of negative to separate directories (named by roll). This
will help you to keep track of each shot’s roll number later.
Stage 3: Converting DPX Image Sequences to Apple ProRes 4444 QuickTime Files in
Color
Since Final Cut Pro doesn’t work directly with image sequences, you need to create
high-quality, online-resolution QuickTime duplicates using Color before you can begin
editing. Once you’ve done this, it’s a good idea to archive both the original source media
and the converted Apple ProRes 4444 media as safely as possible.
You can use Color to create online-resolution QuickTime versions of each DPX image
sequence you need to use in your edit. To do this, create a new project with the Render
File Type set to QuickTime and the Export Codec set to Apple ProRes 4444. Then, edit all
the shots you want to convert into the Timeline, grade them if necessary, add them to
the Render Queue, and click Start Render.
When you convert the DPX files to offline QuickTime files using Color, the timecode
metadata stored in the header of each DPX frame is copied into the timecode track of
each .mov file that’s created. (If there’s no timecode in the DPX headers, the frame number
in the DPX filename will be converted into timecode, instead. For more information, see
How Does Color Relink DPX/Cineon Frames to an EDL?).
This helps you to maintain the correspondence between the source DPX media and the
Apple ProRes 4444 QuickTime files you’ve created, in case you ever need to go back to
the original media. To make this easier, enter the roll number of each image sequence
into the reel number of the converted QuickTime clip. You can do this in the Final Cut Pro
Browser.
For more information, see Converting Cineon and DPX Image Sequences to QuickTime.
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This step is especially useful if you’re working on a project at 4K resolution. High-resolution
media can be processor-intensive, reducing application responsiveness and real-time
processing unless you have an exceptionally robust system. If this is the case, you can
create an offline set of media (using whichever resolution and codec your particular
workflow requires) with which to work using the Media Manager in Final Cut Pro.
If you downconvert to a compressed high definition format, such as Apple ProRes 422 or
Apple ProRes 422 (HQ), you can offline your project on an inexpensively equipped
computer and still be able to output and project it at a resolution suitable for high-quality
client and audience screenings during the editorial process.
Once you finish your offline edit, you can easily reconform your sequence to the
high-resolution Apple ProRes 4444 source media you generated.
Stage 5: Doing the Offline Edit in Final Cut Pro
Edit your project in Final Cut Pro, being careful not to alter the timecode or duration of
the offline master media in any way.
Stage 6: Preparing Your Final Cut Pro Sequence
To prepare your edited sequence for an efficient workflow in Color, follow the steps
outlined in Before You Export Your Final Cut Pro Project. If you’re planning on printing
to film, it’s prudent to be even more cautious and eliminate any and all effects that are
unsupported by Color, since the media rendered by Color will be the final media that’s
delivered to the film recording facility.
• Clips using speed effects should be rendered as self-contained QuickTime movies, with
the resulting media files reedited into the Timeline to replace the original effects. This
is also true for any clip with effects you want to preserve in the final program, including
filters, animated effects, composites, opacity settings, and embedded Motion projects.
• The only type of transition that Color is capable of processing is the dissolve. Any other
type of transition in the sequence will be rendered as a dissolve of identical duration.
• The only other types of effect that Color supports are Position, Rotation, Scale, and
Aspect Ratio Motion tab settings, which are converted into Pan & Scan room settings.
While keyframes for these settings in Final Cut Pro cannot be sent to Color, the Pan &
Scan settings can be keyframed in Color later.
Stage 7: Sending the Sequence to Color or Exporting an XML File
When you finish prepping your edited sequence, there are two ways you can send it to
Color.
• If Color is installed on the same computer as Final Cut Pro, you can use the Send To
Color command to move an entire edited sequence to Color, automatically creating a
new project file.
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sequence as an XML file for eventual import into Color. In this case, you'll also want to
use the Final Cut Pro Media Manager to copy the project's media to a single,
transportable hard drive volume for easy handoff.
Stage 8: Grading Your Program in Color
Grade your program in Color as you would any other.
Important: When grading scanned film frames for eventual film output, it's essential to
systematically use carefully profiled LUTs (look up tables) for monitor calibration and to
emulate the ultimate look of the project when printed out to film. For more information,
see Using LUTs.
Stage 9: Rendering Graded Media Out of Color
Once you finish grading the project in Color, use the Render Queue to render out the
final media. If the film recording facility you’re working with requires an image sequence,
now is the time to:
• Change the Render File Type to DPX or Cineon, depending on what the facility has
requested.
• Choose the Printing Density to match your facility’s recommendations.
• If you’ve been using a LUT to monitor your program while you work, turn it off by
choosing File > Clear Display LUT. Otherwise, you’ll bake the LUT into the rendered
media.
• Double-check the Broadcast Safe and Internal Pixel Format settings to make sure they’re
appropriate for your project.
Rendering high-resolution media will take time. Keep in mind that the Render Queue has
been set up to let you easily render your project incrementally; for example, you can
render out all the shots of a program that have been graded that day during the following
night to avoid having to render the entire project at once.
However, when you're working on a project using 2K image sequence scans, rendering
the media is only the first step. The rendered output is organized in the specified render
directory in such a way as to easily facilitate managing and rerendering the media for
your Color project, but it's not ready for delivery to the film recording facility until the
next step.
Stage 10: Assembling the Final Image Sequence for Delivery
Once every single shot in your program has been rendered, you need to use the Gather
Rendered Media command to consolidate all the frames that have been rendered,
eliminating handles, rendering dissolves, copying every frame used by the program to a
single directory, and renumbering each frame as a contiguously numbered image
sequence. Once this has been done, the rendered media is ready for delivery to the film
recording facility.
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In a 2K or 4K workflow, you can also use a compositing application such as Shake to create
additional transitions or layered effects, including superimpositions, titles, and other
composites, after the color correction has been completed.
Each image file's frame number identifies its position in that program's Timeline. Because
of this, when you send frames to a compositing application, it's vital that the frame
numbers in filenames of newly rendered media are identical to those of the original
source media. This requires careful file management.
Finishing Projects Using RED Media
RED media has become an important acquisition format for both broadcast and digital
cinema. When you install the necessary software to use RED media with Final Cut Studio,
you get access to a variety of workflows for ingesting, grading, and mastering programs
using native RED QuickTime movies in Final Cut Pro and Color.
This section describes the various RED workflows that Final Cut Studio supports. For
information about grading controls that are specific to native RED QuickTime clips, see
The RED Tab.
When you’re working on a project that uses RED media, there are essentially four workflows
you can follow:
Transcode All Native RED QuickTime Media to Apple ProRes 422 (HQ)
If you’re mastering specifically to video, one very simple workflow is to transcode from
RED to Apple ProRes 422 (HQ) clips, and then master Apple ProRes 422 (HQ). After initially
ingesting and transcoding using the Log and Transfer window, this workflow is similar
to the master flowchart shown in Video Finishing Workflows Using Final Cut Pro.
Keep in mind that whenever you transcode native RED R3D media to Apple ProRes using
the Log and Transfer window, you preprocess the original RAW image data. For more
information, see RED Metadata Versus Color Processing in Transcoded Media.
• Advantages: Simple workflow for video mastering. Apple ProRes 422 (HQ) can be easily
edited on most current computers. Apple ProRes 422 (HQ) is suitable for high definition
video mastering, and media can be sent directly to Color for finishing without the need
to reconform.
• Disadvantages: Transcoding may take a long time. You lose the quality advantage of
being able to grade and finish using the RAW RGB 4:4:4 data that native RED QuickTime
files provide.
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It’s also possible to edit and finish using native RED QuickTime media. This is an efficient
workflow that skips the need for reconforming, and gives you access to the high-quality
native image data when you grade in Color. Since working with native RED QuickTime
media is processor-intensive, this workflow may be most appropriate for short-form
projects and spots. This workflow is illustrated in Editing and Finishing with RED QuickTime
Media.
• Advantages: Ingesting RED QuickTime media is fast when compared to transcoding.
Skips the need for an offline reconform. Provides maximum data fidelity through direct
access to each shot’s native R3D image data.
• Disadvantages: RED QuickTime media is processor-intensive when editing.
Ingest Transcoded Apple ProRes Media for Editing; Conform to Native RED QuickTime
for Finishing
The most practical workflow for long-form work when you want to be able to grade using
native RED QuickTime media involves transcoding the original RED media to Apple ProRes
media for efficient offline editing, and then reconforming your edited sequence back to
native RED QuickTime media for final mastering and color correction in Color. This workflow
is illustrated in Offline Using Apple ProRes; Finishing with RED Media.
• Advantages: Apple ProRes 422 (HQ) can be easily edited on most current computers.
After you reconform, this workflow provides maximum data fidelity through direct
access to each shot’s native R3D image data.
• Disadvantages: Reconforming is an extra step that requires good organization.
Improving Performance When Using Native RED QuickTime Media in
Color
To get the best performance when working with native RED QuickTime media (especially
when working with 4K media, which can be extremely processor-intensive), be sure to
turn on Enable Proxy Support in the User Prefs tab of the Setup room. These are the
suggested settings for optimal performance:
• Set Grading Proxy to Half Resolution
• Set Playback Proxy to Quarter Resolution
Proxies for native RED QuickTime media are generated on the fly, without the need to
prerender proxy files as you do with DPX or Cineon media. For more information on
the Color proxy settings, see Using Proxies.
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An advantage to editing with Apple ProRes media is that it’s less processor-intensive than
editing using RED QuickTime files, which makes editing in Final Cut Pro more efficient.
After you reconform, you can still work in Color at the higher quality with access to all of
the raw image data in the R3D file, since Color can bypass QuickTime and use the RED
framework directly to read the native 2K or 4K RGB 4:4:4 data inside of each file.
The only real disadvantages to this workflow are that the initial transcoding stage can be
time-consuming, and that later, reconforming is an extra step that requires careful
organization.
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The following steps break this process down more explicitly.
58 Chapter 2 Color Correction WorkflowsStage 1: Archiving the Original RED Media
It’s always recommended that you archive all of the original RED media for your project
onto one or more backed-up volumes. Whether you’re shooting with CF cards or a RED
drive, you should always copy the entire contents of each CF card or drive that you’ve
finished recording with to an individually named folder on your archive volume.
• If you’re using CF cards: The contents of each card should be copied into separate
directories. For example, if you’ve shot a project using 12 CF cards, at the end of the
process you should have 12 different directories (perhaps named “MyGreatProject_01”
through “MyGreatProject_12”), each of which contains the entire contents of the CF
card to which it corresponds.
• If you’re using RED drives: You should copy the entire contents of the drive to a new
folder every time you fill it up or are finished with a particular part of your shoot. For
example, if you’re archiving the contents of the drive after every day’s shoot, then after
four days you should have four directories (perhaps named “MyGreatProject _Day01”
through “MyGreatProject_Day04”).
Each folder or disk image you copy RED media into must have a unique name; preferably
one that clearly identifies the contents. After you copy the RED media into these folders,
they will contain one or more sub-folders with an .RDM extension that contain the actual
RED media. The name of the enclosing RDM folder will be used as the reel name for each
clip that’s ingested by Final Cut Pro during the log and transfer process.
After you initially copy the RED media, you may elect to change the name of the RDM
folders to something more readable (the .RDM extension itself is optional). If you make
such changes, make sure that the name of each folder is unique, and do not under any
circumstances change the names of any folders or files that appear within.
After you've ingested the media using the Log and Transfer window, do not change the
name of the RDM folder again. Doing so will jeopardize your ability to later reconform
offline sequences to the original RED source media.
Important: It's not recommended to enter new reel names for RED media that you ingest
using the Reel field of the Log and Transfer window.
Stage 2: Ingesting Media Using Apple ProRes to Perform the Offline-Quality Edit
If it’s necessary to edit your program at offline quality for efficiency, transcode the archived
RED media to one of the Apple ProRes codecs using the Log and Transfer window in
Final Cut Pro.
See the Final Cut Pro 7 User Manual for more information about transcoding on ingest,
and which codec to choose for offline work.
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Edit your project in Final Cut Pro, being careful not to alter the timecode of the offline
master media in any way. If you want to minimize the amount of preparation you’ll be
doing later in Stage 5: Preparing Your Final Cut Pro Sequence, keep the following
limitations in mind while you edit:
• Restrict transitions in your project to cross dissolves only. When you render DPX image
sequences out of Color and use the Gather Rendered Media command to prepare a
single image sequence for film printing, Color automatically processes all cross dissolves
in your program. Other transitions are not supported, and will instead be processed as
cross dissolves if they’re present in your project.
• Keyframes are not sent from Final Cut Pro to Color, so don’t use the Motion tab to create
animated Pan & Scan effects. Instead, use the Pan & Scan tab in the Geometry room of
Color, which lets you scale, recenter, change the aspect ratio of, and rotate your clips,
and which can be keyframed. Pan & Scan effects are rendered along with your grades
when you render DPX or Cineon image sequences out of Color.
• Don’t use superimpositions, transfer modes, speed effects, or filters, unless you’re
planning on prerendering these clips (exporting each as a self-contained QuickTime
clip and reediting them into the Timeline to replace the original effects) as Apple ProRes
4444 media before you send them to Color. Color does not render these effects.
Stage 4: Reconforming Your Project to Native RED QuickTime Media
Once your edit is locked, prepare your edited sequence to be media-managed by moving
all video clips that aren’t being superimposed as part of a compositing operation down
to track V1. This makes navigation and grade management much easier once you start
working in Color, and also eliminates unused clips directly from the Timeline, reducing
the amount of media needing to be reconformed.
Next, you’ll media manage your project to create an offline version of your edited sequence
with the appropriate sequence settings, and then batch transfer the resulting sequence
using the Log and Transfer window to reingest native RED QuickTime media from the
originally archived RED media directories.
See the Final Cut Pro 7 User Manual for more information.
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To prepare your edited sequence for an efficient workflow in Color, follow the steps
outlined in Before You Export Your Final Cut Pro Project. If you’re planning on printing
to film, it’s prudent to be even more cautious and eliminate any and all effects that are
unsupported by Color, since the media rendered by Color will be the final media that’s
delivered to the film recording facility.
• Clips using speed effects should be rendered as self-contained QuickTime movies, with
the resulting media files reedited into the Timeline to replace the original effects. This
is also true for any clip with effects you want to preserve in the final program, including
filters, animated effects, composites, opacity settings, and embedded Motion projects.
• The only type of transition that Color is capable of processing is the dissolve. Any other
type of transition in the sequence will be rendered as a dissolve of identical duration.
• The only other types of effect that Color supports are Position, Rotation, Scale, and
Aspect Ratio Motion tab settings, which are converted into Pan & Scan room settings.
While keyframes for these settings in Final Cut Pro cannot be sent to Color, the Pan &
Scan settings can be keyframed in Color later.
Stage 6: Sending the Finished Sequence to Color
When you finish prepping your edited sequence, there are two ways you can send it to
Color.
• If Color is installed on the same computer as Final Cut Pro, you can use the Send To
Color command to move an entire edited sequence to Color, automatically creating a
new project file.
• If you're handing off the project to another facility, you may want to export the edited
sequence as an XML file for eventual import into Color. In this case, you'll also want to
use the Final Cut Pro Media Manager to copy the project's media to a single,
transportable hard drive volume for easy handoff.
Stage 7: Grading Using Additional RED Tab Settings in the Primary In Room
Once in Color, you have access to each clip’s camera setting metadata via the RED tab in
the Primary In room. You can use the RED image data as is, or make adjustments as
necessary. For more information, see The RED Tab.
You may also find it to your advantage to use a proxy setting in Color to speed up effects
processing as you work, especially if you’re working with 4K source media. For example,
setting Grading Proxy to Half Resolution and Playback Proxy to Quarter Resolution will
significantly improve real-time performance as you work in Color, while still allowing you
to monitor your data with complete color accuracy at approximately 1K. For more
information, see Using Proxies.
Important: Clips that have been transcoded to Apple ProRes 422 (HQ) cannot access
these native camera settings, as they no longer contain the native RED raw image data.
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When working with native RED QuickTime media, the frame size of your final graded
media is determined by the Resolution Presets menu in the Project Settings tab of the
Setup room. For more information, see Resolution and Codec Settings.
The format you use to render your final graded media depends on whether you’re planning
on printing to film, or sending the program back to Final Cut Pro for output to video.
• If you’re rendering for film output: Change the Render File Type pop-up menu to DPX
or Cineon (depending on what the facility doing the film printing asks for), and choose
the appropriate 2K or 4K resolution from the Resolution Preset pop-up menu. If you
choose DPX, you also need to choose the appropriate Printing Density. For more
information, see Choosing Printing Density When Rendering DPX Media.
• If you’re rendering to send back to Final Cut Pro for video output: Keep the Render File
Type pop-up menu set to QuickTime and choose an appropriate mastering codec from
the QuickTime Export Codec pop-up menu. For more information, see Compatible
QuickTime Codecs for Output. Keep in mind that the RED QuickTime format is a
read-only format; you cannot master a program using this format.
Note: Rendering native RED QuickTime media is processor-intensive, and rendering times
can be long, especially at 4K resolutions.
Stage 9: Assembling the Final Image Sequence for Delivery, or Sending Back to
Final Cut Pro
The final stage of finishing your project depends, again, on whether you’re printing to
film, or outputting to video.
• If you’re rendering for film output: Once every single shot in your program has been
rendered, use the Gather Rendered Media command to consolidate all the frames that
have been rendered, eliminating handles, rendering dissolves, copying every frame
used by the program to a single directory, and renumbering each frame as a
contiguously numbered image sequence. Once this has been done, the rendered media
is ready for delivery to the film recording facility. For more information, see Gather
Rendered Media.
• If you’re rendering to send back to Final Cut Pro for video output: Simply send your project
back to Final Cut Pro after you finish rendering it. For more information, see Sending
Your Project Back to Final Cut Pro.
Editing and Finishing with RED QuickTime Media
The advantage of this workflow is that it skips the need for reconforming, giving you
access to high-quality image data when you grade in Color. Ingesting RED QuickTime
media is fast when compared to transcoding. This is a good workflow for projects such
as short-form and spots.
62 Chapter 2 Color Correction WorkflowsThe main disadvantage is that RED QuickTime media is processor-intensive when editing.
Because of performance limitations, editing with less powerful computers or editing a
feature length show using 4K RED QuickTime media may not be practical.
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The following steps break this process down more explicitly.
Stage 1: Importing Media as Native RED QuickTime Clips
Import all of your RED media using the Native option in the Log and Transfer window.
For more information, see the Final Cut Pro 7 User Manual.
Stage 2: Editing Using Native RED QuickTime Media
Edit your project in Final Cut Pro. For the smoothest editing experience, choose Unlimited
RT from the Timeline RT pop-up menu, set Playback Video Quality to Low or Medium,
and set Playback Frame Rate to Full.
Chapter 2 Color Correction Workflows 63For more information on editing programs that will be printed to film, see Stage 3: Editing
Using Apple ProRes Media.
Stage 3: Preparing Your Final Cut Pro Sequence, Sending to Color, Grading, Rendering,
and Finishing
Because you’re already working with native RED QuickTime media, no reconforming is
necessary. At this point, the workflow is identical to Stage 5: Preparing Your Final Cut Pro
Sequence.
Use Unlimited RT When Editing Native RED QuickTime Media in
Final Cut Pro
As mentioned previously, RED QuickTime media is processor-intensive to work with in
Final Cut Pro. For the smoothest editing experience, choose Unlimited RT from the
Timeline RT pop-up menu, set Playback Video Quality to Low or Medium, and set
Playback Frame Rate to Full.
RED Metadata Versus Color Processing in Transcoded Media
The Color, Color Temp, and View RED camera settings in use while shooting are stored
as metadata within each recorded R3D file. If you ingest or reconform using native RED
QuickTime media, this metadata remains intact, and is accessible via the RED tab of the
Primary In room. This is the most flexible way to work, as this image metadata has no
effect on the actual RAW R3D data that the camera has recorded, and, in fact, if you’re
unhappy with how the current metadata settings are processing the image, you can
change them to retrieve additional image data from the RAW source.
When you transcode R3D media to one of the Apple ProRes codecs using the Log and
Transfer window, this metadata is used to preprocess the color and contrast of the
transcoded media as long as the RED FCP Log and Transfer plugin submenu of the Action
pop-up menu is set to Native, which is the default setting. The result is that each
transcoded clip visually matches the image that was monitored during the shoot. This
preprocessing is “baked” into each ingested clip. If you want to later reapply a different
type of image preprocessing to a clip, you need to reingest it from the original source
media.
If necessary, you can choose other color processing options from the RED FCP Log and
Transfer plugin submenu of the Action pop-up menu. For more information, see the
Final Cut Pro 7 User Manual.
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Color supports grading for 2K and 4K digital intermediate workflows. Simply put, the term
digital intermediate (DI) describes the process of performing all effects and color correction
using high-resolution digital versions of the original camera negative. Color can work
with 2K and 4K 10-bit log image sequences produced by datacine scanners, processing
the image data with extremely high quality and rendering the result as an image sequence
suitable for film output.
The following sections describe different 2K and 4K workflows that you can follow and
show you how to keep track of your image data from stage to stage.
• For more information on tapeless online/offline DI workflows, see A Tapeless DI
Workflow.
• For more information about DI workflows involving telecined offline media, see A Digital
Intermediate Workflow Using Telecined Media.
• For more information about how Color reconforms media in DI workflows, see Using
EDLs, Timecode, and Frame Numbers to Conform Projects.
A Tapeless DI Workflow
The easiest digital intermediate (DI) workflow is one where you scan all footage necessary
for the offline edit and then create a duplicate set of offline media to edit your project
with. Upon completion of the offline edit, you then relink the program to the original 2K
or 4K source frames in Color.
Chapter 2 Color Correction Workflows 65Deriving the offline media from the original digital media keeps your workflow simple
and eliminates the need to retransfer the source film later. The only disadvantage to this
method is that it can require an enormous amount of storage space, depending on the
length and shooting ratio of the project.
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The following steps break this process down more explicitly.
Stage 1: Running Tests Before Shooting
Ideally, you should do some tests before principal photography to see how the film
scanner–to–Color–to–film recorder pipeline works with your choice of film formats and
stocks. It's always best to consult with the film lab you'll be working with in advance to
get as much information as possible.
Stage 2: Scanning All Film as 2K or 4K DPX Image Sequences
Depending on how the shoot was conducted, you could opt to do a best-light datacine
of just the selects or of all the camera negative, if you can afford it. The scanned 2K digital
source media should be saved as DPX or Cineon image sequences.
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files that you'll create for editing, you should ask for the following:
• A non-drop frame timecode conversion of each frame's number (used in that frame's
filename) saved within the header of each scanned image.
• It can also help to organize all of the scanned frames into separate directories, saving
all the frames from each roll of negative to separate directories (named by roll).
• The resulting DPX files should be named using the following format:
fileName_0123456.dpx (For more information on naming DPX and Cineon files, see
Required Image Sequence Filenaming.)
Stage 3: Converting the DPX Image Sequences to Offline-Resolution QuickTime Files
Create offline-resolution duplicates of the source media in whatever format is most
suitable for your editing system. Then, archive the original source media as safely as
possible.
When you convert the DPX files to offline QuickTime files:
• The roll number of each image sequence (taken from the name of the directory that
encloses the frames being converted) is used as the reel number for each .mov file.
• The timecode values stored in the header of each frame file are used as the timecode
for each .mov file. If there’s not timecode in the header, the frame number in the
filename is converted to timecode and used, instead.
You can use Color to perform this downconversion by creating a new project with the
Render File Type set to QuickTime and the Export Codec set to the codec you want to
use. Then, simply edit all the shots you want to convert into the Timeline, add them to
the Render Queue, and click Start Render. For more information, see Converting Cineon
and DPX Image Sequences to QuickTime.
You can also use Compressor to perform this downconversion. For more information, see
the Compressor documentation.
Tip: If you downconvert to a compressed high definition format, such as Apple ProRes
422 or Apple ProRes 422 (HQ), you can offline your project on an inexpensively equipped
computer system and still be able to output and project it at a resolution suitable for
high-quality client and audience screenings during the editorial process.
Stage 4: Doing the Offline Edit in Final Cut Pro
Edit your project in Final Cut Pro, being careful not to alter the timecode or duration of
the offline media in any way.
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To prepare your edited sequence for an efficient workflow in Color, follow the steps
outlined in Before You Export Your Final Cut Pro Project. Because you’ll be exporting an
EDL to Color in order to relink to the original DPX image sequences, it’s prudent to be
extremely conservative and eliminate any and all effects that are unsupported by the
CMX EDL formats, or by Color itself.
Cross dissolves are the one exception. These are the only type of transition that Color
supports. Any other type of transition will be rendered as a cross dissolve of identical
length.
Stage 6: Exporting an EDL
When you finish with the edit, you need to generate an EDL in either the CMX 340, CMX
3600, or GVG 4 Plus formats.
Important: You cannot use the Send To Color command to move projects to Color that
are being reconformed to DPX or Cineon media.
Stage 7: Importing the EDL into Color and Relinking to the Original DPX Media
Use the File > Import > EDL command to import the EDL. In the Import EDL dialog, specify
the directory where the original high-resolution source media is located, so that the EDL
is imported and the source media is relinked in one step. For more information, see
Importing EDLs.
Stage 8: Grading Your Program in Color
Grade your program in Color as you would any other. For better performance, it’s advisable
to use the Proxy controls in the User Prefs tab of the Setup Room to work at a lower
resolution than the native 2K or 4K frame size of the media. For more information, see
Using Proxies.
Important: When grading scanned film frames, it's essential to systematically use carefully
profiled LUTs for monitor calibration and to emulate the ultimate look of the project
when printed out to film. For more information, see Using LUTs.
Stage 9: Conforming Transitions, Effects, and Titles
In a 2K workflow, you also need to use a compositing application such as Shake to create
any transitions or layered effects, including superimpositions, titles, and other composites,
using the 2K image sequence data.
Important: Each image file's frame number identifies its position in that program's
Timeline. Because of this, when you send frames to a compositing application, it's vital
that the frame numbers in filenames of newly rendered media are identical to those of
the original source media. This requires careful file management.
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Once you finish grading the project in Color, use the Render Queue to render out the
final media. The Render Queue has been set up to let you easily render your project
incrementally; for example, you can render out all the shots of a program that have been
graded that day during the following night to avoid rendering the entire project at once.
However, when you're working on a project using 2K image sequence scans, rendering
the media is only the first step. The rendered output is organized in the specified render
directory in such a way as to easily facilitate managing and rerendering the media for
your Color project, but it's not ready for delivery to the film recording facility until the
next step.
Stage 11: Assembling the Final Image Sequence for Delivery
Once every single shot in your program has been rendered, you need to use the Gather
Rendered Media command to consolidate all the frames that have been rendered,
eliminating handles, copying every frame used by the program to a single directory, and
renumbering each frame as a contiguously numbered image sequence. Once this has
been done, the rendered media is ready for delivery to the film recording facility.
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A more traditional way to edit and color correct a project is to do an offline edit using a
less expensive telecine transfer of the dailies, and then do a datacine film scan of only
the shots used in the edit to create the online media.
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The following steps break this process down more explicitly.
Stage 1: Shooting the Film
Ideally, you should do some tests before principal photography to see how the film
scanner–to–Color–to–film recorder pipeline works with your choice of film formats and
stocks. It's always best to consult with the film facility you'll be working with in advance
to get as much information as possible.
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Once the film has been shot, telecine the dailies to a video format that's appropriate for
the offline edit. Whether or not you telecine to a high definition video format for the
offline depends on the configuration of the editing system you'll be working with and
the amount of hard disk space available to you.
Of more importance is the frame rate at which you choose to telecine the dailies.
• To eliminate an entire media management step, it's recommended that you telecine
the film directly to a 23.98 fps video format.
• Otherwise, you can telecine to a 29.97 fps video format and use Cinema Tools in a
second step to perform 3:2 pull-down removal.
To more easily maintain the correspondence between the telecined video and the 2K or
4K film frames that will be scanned later, you should request that:
• A marker frame is assigned to each roll of film at a point before the first shot begins,
with a hole punch permanently identifying that frame. This marker frame is assigned
the timecode value of XX:00:00:00 (where XX is an incremented hour for each
subsequent camera roll being transferred), and determines the absolute timecode for
each shot on that roll.
• The timecode recorded to tape during the offline telecine must be non-drop frame.
• Each roll of negative should be telecined to a separate reel of tape. This way, the reels
specified by the EDL will match the rolls of camera negative from which the shots are
scanned.
• If the transfer is being done strictly for offline editing, you can ask for a window burn
that displays both timecode and edgecode to provide an additional means of reference.
If you’re transferring film to a 4:3 aspect ratio video format, you may elect to have this
window burn made in the black letterboxed area so it doesn’t obscure the image. It
may also be possible to write the edgecode number of the source film to the user bit
of VITC timecode for electronic tracking. Ask the facility doing the transfer what would
be best for your situation.
Stage 3: Using Cinema Tools and Final Cut Pro to Perform the Offline Edit
As with any other film edit, generate a Cinema Tools database from the ATN, FLEx, FTL,
or ALE telecine log files provided by the telecine operator, then export an XML-based
batch capture list you can import into Final Cut Pro to use to capture the corresponding
media and edit the program.
Important: When working with offline media that tracks the original camera negative,
do not use the Media Manager to either rename or delete unused media in your project.
If you do, you'll lose the ability to create accurate pull lists in Cinema Tools.
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To prepare your edited sequence for an efficient workflow in Color, follow the steps
outlined in Before You Export Your Final Cut Pro Project. Because you’ll be exporting an
EDL to Color in order to relink to the original DPX image sequences, it’s prudent to be
extremely conservative and eliminate any and all effects that are unsupported by the
CMX EDL formats, or by Color itself.
Cross dissolves are the one exception. These are the only type of transition that Color
supports. Any other type of transition will be rendered as a cross dissolve of identical
length.
Stage 5: Exporting an EDL for Color and a Pull List for the Datacine Transfer
Once the offline edit is complete, you need to export a pull list out of Final Cut Pro to give
to the facility doing the final datacine transfer at 2K or 4K resolution. You also need to
export the entire project as an EDL for importing and conforming in Color.
• The pull list specifies which shots were used in the final version of the edit. (This is
usually a subset of the total amount of footage that was originally shot.) Ideally, you
should export a pull list that also contains the timecode In and Out points corresponding
to each clip in the edited project. This way, the timecode data can be written to each
frame that's scanned during the datacine transfer to facilitate conforming in Color.
• The EDL moves the project's edit data to Color and contains the timecode data necessary
to conform the scanned image sequence frames into the correct order.
Stage 6: Doing a Datacine Transfer of the Selected Shots from Negative to DPX
Using the pull list generated by Cinema Tools, have a datacine transfer made of every
shot used in the project.
During the datacine transfer, specify that the timecode of each frame of negative be
converted to frames and used to generate the filenames for each scanned DPX file, and
that the timecode also be written into the DPX header of each shot. The names of the
resulting image sequence should take the following form: fileName_0123456.dpx. For
more information about filenaming conventions, see Required Image Sequence Filenaming.
Each image sequence from the film scanner must be saved into a directory that is named
with the number of the roll of camera negative from which it was scanned. There should
be separate directories for each roll of camera negative that's scanned.
Stage 7: Importing the EDL into Color and Relinking to the Original DPX Media
Use the File > Import > EDL command to import the EDL. In the Import EDL dialog, you
also specify the directory where the original high-resolution source media is located, so
that the EDL is imported and the source media is relinked in one step.
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Grade your program in Color as you would any other. For better performance, it’s advisable
to use the Proxy controls in the User Prefs tab of the Setup room to work at a lower
resolution than the native 2K or 4K frame size of the media. For more information, see
Using Proxies.
Important: When grading scanned film frames, it's essential to systematically use carefully
profiled LUTs for monitor calibration and to emulate the ultimate look of the project
when printed out to film. For more information, see Using LUTs.
Stage 9: Conforming Transitions, Effects, and Titles, Rendering Media, and Gathering
Rendered Media
At this point, the process is the same as in Stage 9: Conforming Transitions, Effects, and
Titles in A Tapeless DI Workflow.
Using EDLs, Timecode, and Frame Numbers to Conform Projects
Using careful data management, you can track the relationship of the original camera
negative to the video or digital transfers that have been made for offline editing using
timecode. The following sections provide information on how Color tracks these
correspondences.
• For more information on how Color relinks DPX images to EDLs, see How Does Color
Relink DPX/Cineon Frames to an EDL?
• For more information on how color parses EDLs for DI conforms, see Parsing EDLs for
Digital Intermediate Conforms.
• For more information on how your image sequences should be named for DI workflows,
see Required Image Sequence Filenaming.
How Does Color Relink DPX/Cineon Frames to an EDL?
The key to a successful conform in Color is to make sure that the timecode data in the
EDL is mirrored in the scanned DPX or Cineon frames you're relinking to. The
correspondence between film frames and timecode is created during the first telecine
or datacine transfer session.
How Is Film Tracked Using Timecode?
A marker frame is assigned to the very beginning of each roll of film, at a point before
the first shot begins (typically before the first flash frame). A hole is punched into the
negative, which permanently identifies that frame. This marker frame is assigned the
timecode value of XX:00:00:00 (where XX is an incremented hour for each subsequent
camera roll being transferred), creating an absolute timecode reference for each frame
of film on that roll. Each camera roll of film is usually telecined to a new reel of videotape
(each reel of tape usually starts at a new hour), or datacined to a separate directory of
DPX files.
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between the original camera negative and the transferred video or DPX media. This
correspondence carries through to the captured or converted QuickTime media that you
edit in Final Cut Pro. As an added benefit of this process, you can always go back to the
original rolls of camera negative and retransfer the exact frames of film you need, as long
as you accurately maintain the reel number and timecode of each clip in your edited
sequence.
If you’re having a datacine transfer done, you also need to request that the frame numbers
incorporated into the filenames of the transferred image files be based on the absolute
timecode that starts at each camera roll’s marker frame. Your final DPX or Cineon image
sequences should then have frame numbers in the filename that, using a bit of
mathematical conversion, match the timecode value in the header information, providing
valuable data redundancy.
How Color Relinks DPX/Cineon Media to EDLs Using Timecode
Later, when Color attempts to relink the EDL that you’ve exported from Final Cut Pro to
the transferred DPX or Cineon image sequence media, it relies on several different
methods, depending on what information is available in the image sequence files:
• First, Color looks for a timecode value in the header metadata of each DPX or Cineon
frame file. If this is found, it's the most reliable method of relinking.
• If there's no matching timecode number in the header metadata, then Color looks for
a correspondence between the timecode value requested in the EDL and the frame
numbers in the filename of each DPX or Cineon frame. This also requires that the files
be strictly named. For more information, see Required Image Sequence Filenaming.
• Color also looks for each shot’s corresponding reel number (as listed in the EDL) in the
name of the directory in which the media is stored. Each frame of DPX or Cineon media
from a particular roll of camera negative should be stored in a separate directory that’s
named after the roll number it was scanned from. If there are no roll numbers in the
enclosing directory names, then Color attempts to relink all the shots using the timecode
number only.
After you import an EDL with linked DPX or Cineon image sequence media, a Match
column appears in the Shots browser. This column displays the percentage of confidence
that each shot in the Timeline has been correctly linked to its corresponding DPX, Cineon,
or QuickTime source media, based on the methods used to do the linking. For more
information, see Explanation of Percentages in the Match Column.
Relinking DPX/Cineon Frames to an EDL Using a Cinema Tools Database
If issues arise when conforming an EDL to DPX or Cineon media in Color, you can create
a Cinema Tools database with which to troubleshoot the problem.
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create one. To create a Cinema Tools database from one or more directories of DPX or
Cineon image sequences, simply drag all of the enclosing directories onto the Cinema Tools
application icon, and a database is generated automatically. If necessary, you can use the
Cinema Tools interface to check the reel numbers and timecode values of each shot,
correcting any problems you find.
Afterward, when you’re conforming an EDL to DPX or Cineon media in Color, you can
choose the Cinema Tools database as your source directory in the EDL Import Settings
window. (See Importing EDLsfor more information.) This way, your updated reel numbers
and timecode values will be used to link your Color project to the correct source media.
For more information on creating Cinema Tools databases from DPX or Cineon media,
see the Cinema Tools documentation.
Note: Changing information in a Cinema Tools database does nothing to alter the source
media files on disk.
Parsing EDLs for Digital Intermediate Conforms
This section explains how Color makes the correspondence between the timecode values
in an EDL and the frame numbers used in the timecode header or filename of individual
image sequence frames.
Here's a sample line from an EDL:
001 004 V C 04:34:53:04 04:35:03:04 00:59:30:00 00:59:40:00
In every EDL, the information is divided up into eight columns:
• The first column contains the edit number. This is the first edit in the EDL, so it is labeled
001.
• The second column contains the reel number, 004. This is what the directory that
contains all of the scanned DPX or Cineon image files from camera roll 004 should be
named.
• The next two columns contain video/audio track and edit information that, while used
by Color to assemble the program, isn't germane to conforming the media.
The last four columns contain timecode—they're pairs of In and Out points.
• The first pair of timecode values are the In and Out points of the original source media
(usually the telecined tape in ordinary online editing). In a digital intermediate workflow,
this is used for naming and identifying the scanned frames that are output from the
datacine.
• The second pair of In and Out points identifies that shot's position in the edited program.
These are used to place the media in its proper location on the Timeline.
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Here's a sample filename of the first image sequence file that corresponds to the EDL
event shown in Parsing EDLs for Digital Intermediate Conforms:
fileName_0494794.dpx
The first portion of the filename for each scanned frame (the alpha characters and
underscore) is an ignored but necessary part of the filename. The file's frame number
should equal the (non-dropframe) timecode conversion of that value appearing in the
EDL.
For example, a frame with timecode 05:51:18:28 would have a frame number of 632368.
Numeric extensions must always be padded to seven digits; in this case, you would add
one preceding 0, like this:
fileName_0632368.dpx
The following filename formats are also acceptable:
fileName 0632368.dpx
fileName0632368.dpx
fileName-0632368.dpx
fileName.0632368.dpx
Important: For Color to be able to link to a media file, filenames need at minimum an
alpha-only character name (consisting of at least one upper- or lowercase character),
frame number, and a .dpx or .cin file extension.
76 Chapter 2 Color Correction WorkflowsYou can work in Color either by using a mouse with the onscreen interface, or, more
directly, by using a dedicated control surface that’s been designed for professional color
correction work.
This chapter covers the general interface conventions used by Color. It describes the use
of controls that are shared by multiple areas of the interface, as well as some of the
specialized controls that are unique to color correction applications.
This chapter covers the following:
• Setting Up a Control Surface (p. 78)
• Using Onscreen Controls (p. 78)
• Using Organizational Browsers and Bins (p. 82)
• Using Color with One or Two Monitors (p. 88)
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Using the Color Interface
3Setting Up a Control Surface
Color was designed from the ground up to support control surfaces specifically designed
for color correction from manufacturers such as Tangent and JL Cooper Designs. These
control surfaces typically include three trackballs that correspond to the three overlapping
tonal zones of the Primary and Secondary color balance controls (shadows, midtones,
and highlights), three rotary controls for the three contrast controls (black level, gamma,
and white point), and a number of other rotary controls and buttons that support different
functions depending on which room you’ve selected.
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You can either choose a control surface to use when Color starts up, or click Show Control
Surface Dialog in the User Prefs tab of the Setup room to choose an available control
surface at any time. For more information on setting up a control surface, see Setting Up
a Control Surface. For more information on configuring a control surface from within
Color, see Control Surface Settings.
Using Onscreen Controls
If you don’t have a control surface, you can still operate every feature in Color using the
onscreen controls. In addition to the standard buttons, checkboxes, and pop-up menus
common to most applications, Color uses some custom controls that are described in
this section. See the referenced sections for more information on:
• Using the Mouse
• Tabs
• Using Text Fields and Virtual Sliders
• Using Timecode Fields
• Using Color Balance Controls
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Color supports the use of a three-button mouse, which provides quick access to shortcut
menus and various navigational shortcuts. Color also supports the middle scroll wheel
or scroll ball of a three-button mouse, either for scrolling or as a button.
Mouse button Documentation reference
Left mouse button Click
Middle mouse button Middle mouse button or middle-click
Right mouse button Right-click (identical to Control-click with a single button mouse)
Note: Many controls can be accelerated up to ten times their normal speed by pressing
the Option key while you drag.
Tabs
Tabs are used to navigate among the eight different Color “rooms.” Each room is a distinct
portion of the interface that contains all the controls necessary to perform a specific task.
Changing rooms changes the available interface, the keyboard shortcuts, and the mapping
of the control surface controls.
Some rooms have additional features that are revealed via tabs within that room.
Using Text Fields and Virtual Sliders
There are four types of data that can populate edit fields in Color:
• Timecode
• Text, including filenames, directory paths, and so forth
• Whole numbers; fields that display whole numbers cannot accept either decimals or
fractional values
• Percentages and fractional values, such as 0.25 or 1.873
There are four ways you can modify text fields.
To enter text into a field using the keyboard
1 Move the pointer into the text field you want to edit, and do one of the following:
• Click once within any field to place the insertion point at the position you clicked.
• Double-click within any field to select the word at the position of the pointer.
• Triple-click within any field to select the entire contents of that field.
The text in that field becomes highlighted.
2 Type something new.
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To modify the value of a numeric or percentage-based text field with a virtual slider
1 Move the pointer to the field you want to adjust.
2 Middle-click and drag to the left to decrease its value, or to the right to increase its value.
3 Release the mouse button when you’re finished.
To modify the value of a numeric or percentage-based text field with a scroll wheel
1 Move the pointer to the field you want to adjust.
2 Without clicking in the field, roll the scroll wheel or ball up to increase that field’s value,
or down to decrease that field’s value.
To adjust a field using a shortcut menu
µ Control-click or right-click any field, and choose one of the following options from the
shortcut menu:
• Reset: Resets the field to its default setting.
• Min: Chooses the minimum value available to that field.
• Max: Chooses the maximum value available to that field.
• Set as Default: Changes the default value of a parameter to whatever value is currently
specified. After changing the default value, you can change the value of that parameter
back to the value you specified by clicking Reset.
Using Timecode Fields
Timecode fields display timing information, such as media In and Out points, and the
position of the playhead. Time is represented in Color in one of two ways:
• Within fields, most time values are represented with standard SMPTE timecode. SMPTE
timecode is represented by four colon-delimited pairs of digits: hh:mm:ss:ff, where hh
is hours, mm is minutes, ss is seconds, and ff is frames.
• Time values in the Timeline ruler may be displayed as non-drop frame timecode, drop
frame timecode, or frames.
Note: Drop frame timecode appears with a semicolon between the seconds and frames
positions.
Here are some pointers for entering values into the hours, minutes, seconds, and frames
positions of timecode fields:
• Time values are entered from left to right (similar to entering a duration into a
microwave); however, the last value you type is assumed to be the last digit of the
frames position.
• Press Return whenever you’ve finished typing a timecode value to confirm the new
value you entered.
80 Chapter 3 Using the Color Interface• If you enter a partial number, the rightmost pair of numbers is interpreted as frames
and each successive pair of numbers to the left populates the remaining seconds,
minutes, and hours positions. Omitted numbers default to 00.
For example, if you enter 1419, Color interprets it as 00:00:14:19.
• When you enter timecode in a field, you don’t need to enter all of the separator
characters (such as colons); they’re automatically added between each pair of digits.
• You can type a period to represent a pair of zeros when entering longer durations.
For example, type “3.” (3 and a period) to enter timecode 00:00:03:00. The period is
automatically interpreted by Color as 00.
• To enter 00:03:00:00, type “3..” (3 and two periods).
These periods insert pairs of zeros into both the seconds and frames position.
• Type “3...” to enter 03:00:00:00.
• Use the Plus Sign key (+) to enter a series of single-digit values for each time position.
For example, type “1+5+8” to enter timecode 00:01:05:08.
Using Color Balance Controls
Color controls are used in several rooms in Color to let you choose and modify colors
using the HSL model.
• Dragging within the main color wheel lets you simultaneously adjust the hue and
saturation of the selected color.
A crosshair within the color wheel shows the current color value that’s being selected.
The remaining controls depend on the type of color control being displayed.
• Dragging up and down within the multicolored Hue slider lets you adjust the hue.
• Dragging up within the single-colored Saturation slider increases the saturation of the
current hue; dragging down decreases its saturation.
• Dragging up within the single-colored Brightness slider increases the brightness of the
current color; dragging down decreases its brightness.
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to match the interface of other color correction systems you may be used to. In addition,
the speed with which control surface joyballs (trackballs) adjust the corresponding Color
color controls can be modified. For more information, see Control Surface Settings.
Using Organizational Browsers and Bins
Color offers several browsers and bins for organizing shots, media, and grades that share
some common controls. All these browsers and bins are used to manage files on your
hard disk, rather than data that’s stored within the Color project file itself. As a result, their
controls are used to navigate and organize the directory structure of your hard disk, much
as you would in the Finder. See the following sections for more information on:
• The File Browser
• The Shots Browser
• The Grades Bin
• Corrections Bins
• Browser, Still Store, Grades, and Corrections Bins Controls
• How Are Grades and Corrections Saved and Organized?
The File Browser
The browser that dominates the left half of the Setup room lets you navigate the directory
structure of your computer’s disk drives (and by extension any RAID, DAS, and SAN
volumes that are currently mounted) in order to find and import compatible QuickTime
and still image media files.
It’s important to remember that the file browser is not the same as a project bin. The files
displayed within the file browser are not associated with your Color project in any way
unless you drag them into the Timeline manually, or relink the shots of an imported
project to their associated media files on disk using the Relink Media or Reconnect Media
command.
Note: The file browser displays only directories and media files that are compatible with
Color.
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the first frame of that file along with information underneath.
The information given includes:
• Shot Name: The filename
• Duration: Its total duration
• Codec: The codec used to encode that file
• Resolution: The frame size of the file, width by height
• Frame Rate: The frame rate of the file
• Timecode: The timecode value of the first frame in that file
• Import: This button lets you edit the currently selected shot into the Timeline at the
current position of the playhead.
Collapsing the File Browser
If you like, the file browser can be collapsed so that the tabbed area on the right can
occupy the entire Color window.
To collapse the file browser
µ Move the pointer to the file browser divider at the right side of the file browser, and when
it’s highlighted in blue, click once to collapse it.
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µ Move the pointer to the file browser divider at the left side of the window, and when it’s
highlighted in blue, click once to expand it.
For more information on the Setup room, see Configuring the Setup Room.
The Shots Browser
The other browser in the Setup room is the Shots browser. This browser lets you see all
the shots that are in the current project in either icon or list view.
In icon view, you can create groups of shots to which you can apply a single correction
or grade to at once. For more information, see Managing Grades in the Shots Browser.
In list view, you can sort all of the shots using different info fields. For more information
on using the Shots browser, see Using the Shots Browser.
The Grades Bin
The Grades bin, in the Setup room, lets you save and organize grades combining primary,
secondary, and Color FX corrections into a single unit.
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of the Grades bin are available to all Color projects opened while logged into that user
account. For more information on saving and applying grades, see Saving Grades into
the Grades Bin.
Corrections Bins
The Primary In and Out, Secondaries, and Color FX rooms all allow you to save the
corrections made inside those rooms as individual presets that you can apply to later
shots. The contents of corrections bins are available to all Color projects opened while
logged into that user account.
• Primary In and Out: Let you save and organize primary corrections. The Primary In and
Primary Out rooms both share the same group of saved corrections.
• Secondaries: Lets you save and organize secondary corrections.
• Color FX: Lets you save and organize Color FX corrections.
Corrections Versus Grades
There is a distinct difference between corrections and grades in Color. Corrections refer
to adjustments made within a single room. You have the option to save individual
corrections inside the Primary In and Out, Secondaries, and Color FX rooms and apply
them to shots individually.
A grade can include multiple corrections across several rooms; you can save one or more
primary, secondary, and Color FX corrections together. By saving a group of corrections
as a grade, you can apply them all together as a single preset.
Browser, Still Store, Grades, and Corrections Bins Controls
All browsers and bins share the following controls:
Display Controls
All browsers and bins have display controls that let you choose how you want to view
and organize their contents.
• List View button: Displays the contents of the current directory as a list of filenames.
• Icon View button: Displays the contents of the current directory as icons.
• Icon Size slider: Appears only in icon view. Scales the size of icons.
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The file browser and Grades and corrections bins also have directory navigation controls
that you can use to organize and browse the grades and corrections that are saved on
your hard disk.
• Up Directory: Moves to and displays the contents of the parent directory.
• Home Directory: Navigates to the appropriate home directory for that browser or bin.
This is not your Mac OS X user home directory. The home directory is different for each
bin:
• File browser: The Home button takes you to the currently specified Color media
directory.
• Primary In, Secondaries, Color FX, and Primary Out: Home takes you to the appropriate
subdirectory within the /Users/username/Library/Application Support/Color directory.
Each room has its own corresponding subdirectory, within which are stored all the
corrections you’ve saved for future use.
• Still Store: Home takes you to the StillStore directory inside the current project
directory structure.
File Controls
The file browser and Grades and corrections bins also have directory creation and
navigation controls at the bottom.
• File field: Displays the file path of the currently viewed directory.
• Directory pop-up menu: This pop-up menu gives you a fast way to traverse up and down
the current directory hierarchy or to go to the default Color directory for that room.
• New Folder button: Lets you create a new directory within the currently specified path.
You can create as many directories as you like to organize the grades and corrections
for that room.
• Save button: This button saves the grade or correction settings of the shot at the current
position of the playhead in the directory specified in the above text fields.
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position of the playhead (if no other shots are selected) or to multiple selected shots
(ignoring the shot at the playhead if it’s not selected). As with any Color bin, items
displayed can be dragged and dropped from the bin into the Timeline.
How Are Grades and Corrections Saved and Organized?
Grades and corrections that you save using the Grades and Corrections bins in Color are
saved within the Color preferences directory in your /Users/username/Library/Application
Support/Color directory.
Saved correction category Location on disk
Grades /Users/username/Library/Application Support/Color/Grades/
Primary corrections /Users/username/Library/Application Support/Color/Primary/
Secondary corrections /Users/username/Library/Application Support/Color/Secondary/
Color FX corrections /Users/username/Library/Application Support/Color/Effects/
Saved grades and corrections in these bins are available to every project you open.
Individual corrections in each of the above directories are saved as a pair of files: an .lsi
file that contains a thumbnail for visually identifying that grade, and the specific file for
that type of correction which actually defines its settings. Unless you customized the
name, both these files have the same name, followed by a dot, followed by the date (day
month year hour.minute.secondTimeZone), followed by the file extension that identifies
the type of saved correction it is.
• Grade_Name.date.lsi: The thumbnail image used to represent that grade in icon view
• Grade_Name.date.pcc: Primary correction file
• Grade_Name.date.scc: Secondary correction file
• Grade_Name.date.cfx: Color FX correction file
Saved grades are, in fact, file bundles that contain all the correction files that make up
that grade. For example, a grade that combines primary, secondary, and Color FX
corrections would be a directory using the name given to the grade,
“Grade_Name.date.grd,” containing the following files:
• Grade_Name.date.lsi
• Grade_Name.date.pcc
• Grade_Name.date.scc
• Grade_Name.date.cfx
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Each of the corrections bins in Color simply mirrors the contents of the corresponding
subdirectory in the /Users/username/Library/Application Support/Color directory. You
can use the Finder to reorganize your saved corrections and grades by creating new
subdirectories and moving previously saved grades and corrections into them.
When you move saved corrections from one directory to another, it’s important that you
copy both the .lsi thumbnail image for that grade and the .pcc, .scc, or .cfx file that contains
the actual grade information, together.
If you reorganize saved grades and corrections in the Finder while Color is open, you
need to manually refresh the contents of the Grades and corrections bins you changed
so that they correctly display the current contents.
To update the contents of the currently displayed corrections bin
µ Click the Home button.
Moving Saved Corrections and Grades to Other Computers
If you have saved corrections and grades that you want to move to Color installations on
other computers, you can simply copy the folders described in How Are Grades and
Corrections Saved and Organized? to a portable storage device and then copy their
contents into the corresponding folders on the new system. The next time you open
Color, the saved corrections and grades will appear as they did before.
Using Color with One or Two Monitors
Color is compatible with both one- and two-monitor computer configurations, and
requires a minimum resolution of 1680 x 1050 in either mode. Most users will benefit
from using Color in dual display mode with two monitors, as this provides the most screen
real estate and also allows for the most flexible use of the preview and video scopes
displayed in the Scopes window of the second monitor.
However, Color can also be used in single display mode, which lets you operate Color in
situations where a second display is not available. Single display mode is only
recommended on 30-inch Cinema Displays.
Warning: It is not recommended to run Color on a system with more then one graphics
card. For two-monitor support, both monitors should be connected to the same graphics
card.
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Do one of the following:
µ Choose Window > Single Display Mode or Dual Display Mode.
µ Press Shift-Command-0 to switch between modes.
You must quit Color and reopen it for this change to take effect.
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This chapter describes the commands and methods used to create and save projects,
move projects from Final Cut Pro to Color and back again, and link and otherwise manage
your projects and media once they’re within Color. It also covers compatible media
formats, EDL import and export, and the conversion of DPX and Cineon image sequences
to QuickTime media.
This chapter covers the following:
• Creating and Opening Projects (p. 92)
• Saving Projects (p. 92)
• Saving and Opening Archives (p. 95)
• Moving Projects from Final Cut Pro to Color (p. 95)
• Importing EDLs (p. 101)
• EDL Import Settings (p. 102)
• Relinking Media (p. 104)
• Importing Media Directly into the Timeline (p. 105)
• Compatible Media Formats (p. 106)
• Moving Projects from Color to Final Cut Pro (p. 112)
• Exporting EDLs (p. 114)
• Reconforming Projects (p. 115)
• Converting Cineon and DPX Image Sequences to QuickTime (p. 115)
• Importing Color Corrections (p. 117)
• Exporting JPEG Images (p. 118)
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and Media 4Creating and Opening Projects
When you open Color, you’re presented with a dialog from which you can open an existing
project or create a new one. Most users will send projects to Color straight from
Final Cut Pro, but there are specific workflows that require you to create a new project
in Color.
To open an existing project
Do one of the following:
µ If Color is already open, choose File > Open (or press Command-O), choose a project from
the Projects dialog, then click Open.
µ Double-click a Color project file in the Finder.
µ Open Color, choose a Color project file using the Projects dialog, then click Open.
Color can have only one project open at a time, so opening a second project closes the
one that was originally open.
To create a new project when Color is first opened
1 Open Color.
The Projects dialog opens to the Default Project Directory you chose when you first
opened Color.
2 Click New Project.
The New Project dialog appears.
3 Type a name for the project in the Name of New Project field, then click Save.
A new project is created and opened.
To create a new project while Color is open
1 If necessary, save the current project.
Color can have only one project open at a time, so creating a new project will close the
currently open project.
2 Choose File > New (or press Command-N).
3 Click New Project.
The New Project dialog appears.
4 Type a name for the project in the Name of New Project field, then click Save.
A new project is created and opened.
Saving Projects
Saving a project works the same way in Color as it does in any other application you’ve
used. As with any application, you should save early and often as you work.
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µ Choose File > Save (or press Command-S).
To revert the project to the last saved state
µ Choose File > Revert (or press Command-R).
Color also has an automatic saving mechanism which, when turned on, saves the current
project at an interval set by the Auto Save Time (Minutes) parameter in the User Prefs
tab of the Setup room. By default, automatic saving is turned on, with the interval set to
5 minutes. For more information, see Auto Save Settings.
Note: Whenever you manually save a project, an archive is also automatically saved with
the date and time as its name. When a project is automatically saved, an archive is not
created. This prevents your archive list from being inundated with entries. For more
information, see Saving and Opening Archives.
What Is a Color Project?
The only shots that are in your project are those in the Timeline (which are also mirrored
in the Shots browser). Color projects only contain a single sequence of shots. Furthermore,
Color projects have no organizational notion of shots that aren’t actually in the Timeline,
and so they contain no unused media.
Chapter 4 Importing and Managing Projects and Media 93The Contents of Color Projects
Color projects are actually bundles. Inside each Color project bundle is a hierarchical
series of directories, each of which contains specific components belonging to that
project, which are either image or XML files. It’s possible to open a Color bundle using
the Show Package Contents command in the Finder. The directory structure and contents
of these bundles are described here.
• Archives directory: Contains all the saved archives of that project. Each archive is
compressed using both .tar and .gzip compression (a “tarball”) and is identified with
the .tgz extension.
• .lsi file: This is an image file that contains the frame at the position of the playhead
when you last saved.
• .pdl file: This is the XML-based project file itself, which contains all the information
that organizes the shots, timing, and grades used in that project.
• Shots directory: Each shot in your project’s Timeline has a corresponding subdirectory
here. Each subdirectory contains some or more of the following:
• Grade1 (through 4) subdirectories: These directories contain all the correction files
associated with that grade.
• ShotName.lsi file: This is that shot’s thumbnail as displayed in the Timeline.
• ShotName.si file: This file contains that shot’s name, media path, and timing
information.
• Grade_Name.date.pcc: Primary correction description
• Grade_Name.date.scc: Secondary correction description
• Grade_Name.date.cfx: Color FX correction description
• PanAndScan subdirectory: This directory contains a .kfd file that stores keyframe
data and a .pns file that stores pan and scan data.
• shot_notes.txt file: If a note is present for that shot, it’s saved here.
• StillStore directory: This directory contains all the Still Store images that you’ve saved
for reference within that project. Each reference still has two corresponding files, an
.lsi file which is that image’s thumbnail icon and a .sri file which is the full-resolution
image (saved using the DPX image format).
Important: It is not recommended that you modify the contents of Color project files
unless you know exactly what you’re doing. Making changes manually could cause
unexpected problems.
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An archive is a compressed duplicate of the project that’s stored within the project bundle
itself. For efficiency, the archive file lacks the thumbnail and Still Store image files that
the full version of the project contains. Archives only save the state of the internal project
file, Timeline, shot settings, grades, corrections, keyframes, and Pan & Scan settings, which
are easily compressed and occupy little space.
Whenever you manually save your project, an archive is automatically created that is
named using the date and time at which it was saved. If you want to save an archive of
your project at a particular state with a more easily identifiable name, you can use the
Save Archive As command.
To save an archive of the project with a specific name
1 Choose File > Save Archive As (or press Command-Option-S).
2 Type a name into the Archive Name field, then click Archive.
There is no limit to the number of archives you can save, so the archives list can grow
quite long. Archives are compressed using both .tar and .gzip (a “tarball”) so they take
up little room. All archive files for a particular project are saved in the Archives subdirectory
inside that project bundle.
Later, if anything should happen to your project file’s settings, or if you want to return
the project to a previously archived state, you can load one of the archive files.
To open an archive
1 Choose File > Load Archive (or press Command-Option-O).
2 Select an archive to open from the Load Archive window, then click Load Archive.
Opening an archive overwrites the current state of the project with that of the archive.
Moving Projects from Final Cut Pro to Color
One of the easiest ways of importing a project is to send a Final Cut Pro sequence to Color
using one of two XML-based workflows. This section discusses how to prepare your
projects in Final Cut Pro and how to send them using XML. For more information, see:
• Before You Export Your Final Cut Pro Project
• Using the Send To Color Command in Final Cut Pro
• Importing an XML File into Color
• Video Finishing Workflows Using Final Cut Pro
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Whether you’re working on your own project, or preparing a client’s project in advance
of a Color grading session, you should take some time to prepare the Final Cut Pro
sequence you’ll be sending in order to ensure the best results and smoothest workflow.
Here are some recommended steps.
Move Clips That Aren’t Being Composited to Track V1 in the Timeline
Editors often use multiple tracks of video to assemble scenes, taking advantage of the
track ordering rules in Final Cut Pro to determine which clips are currently visible. It’s
generally much faster and easier to navigate and work on a project that has all its clips
on a single video track. It’s recommended that you move all video clips that aren’t being
superimposed as part of a compositing operation down to track V1.
Remove Unnecessary Video Filters
You aren’t required to remove video filters from a sequence you’re sending to Color. In
fact, if there are one or more effects filters that you want to keep, then it’s perfectly fine
to leave them in. However, it's not usually a good idea to allow filters that perform color
correction operations (such as Brightness and Contrast, RGB Balance, or Desaturate) to
remain in your sequence. Even though they have no effect as you work in Color, they’ll
be redundant after you’ve made additional corrections, and their sudden reappearance
when the project is sent back to Final Cut Pro may produce unexpected results.
Organize All Color Corrector 3-Way Filters
Color Corrector 3-way filters applied to clips are handled differently; they’re automatically
converted into Primary In room adjustments. However, if more than one filter has been
applied to a clip, then only the last Color Corrector 3-way filter appearing in the Filters
tab is converted; all others are ignored. Furthermore, any Color Corrector 3-way filter with
Limit Effects turned on is also ignored.
Converted Color Corrector 3-way filters are removed from the XML data for that sequence,
so that they do not appear in the sequence when it’s sent back to Final Cut Pro.
Note: Because Final Cut Pro is a Y′CBCR processing application, and Color is an RGB
processing application, Color Corrector 3-way conversions are only approximations and
will not precisely match the original corrections made in Final Cut Pro.
Divide Long Projects into Reels
To better organize rendering and output, and to maximize performance when you work
with high-bandwidth formats (such as uncompressed high definition, RED, or DPX media),
you should consider breaking long-form projects down into separate 15- to 23-minute
sequences (referred to asreels) prior to sending them to Color. While reel length is arbitrary,
film reels and broadcast shows often have standard lengths that fall within this range.
(Twenty-two minutes is standard for a film reel.) If your project has an unusually large
number of edits, you might consider dividing your program into even shorter reels.
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of a scene, the Out point of the last shot of a scene, or the end of the last frame of a fade
to black. As you’re creating your reels, make sure you don’t accidentally omit any frames
in between each reel. This makes it easier to reassemble all of the color-corrected reels
back into a single sequence when you’re finished working in Color.
Tip: Breaking a single program into reels is also the best way for multi-room facilities to
manage simultaneous rendering of projects. If you have multiple systems with identical
graphics cards and identical versions of Color in each room, you can open a reel in each
room and render as many reels simultaneously as you have rooms. Each system must
have identical graphics cards as the type of GPU and amount of VRAM may affect render
quality. For more information, see The Graphics Card You’re Using Affects the Rendered
Output.
Export Self-Contained QuickTime Files for Effects Clips You Need to Color Correct
Color is incapable of either displaying or working with the following types of clips:
• Generators
• Motion projects
If you want to grade such clips in Color, you need to export them as self-contained
QuickTime files and reedit them into the Timeline of your Final Cut Pro sequence to
replace the original effects before you send the sequence to Color.
If you don’t need to grade these effects in Color, then you can simply send the project
with these clips as they are, and ignore any gaps that appear in Color. Even though these
effects won’t appear in Color, they’re preserved within the XML of the Color project and
they will reappear when you send that project back to Final Cut Pro.
Tip: Prior to exporting a project from Final Cut Pro, you can also export a single,
self-contained QuickTime movie of the entire program and then reimport it into your
project and superimpose it over all the other clips in your edited sequence. Then, when
you export the project to Color, you can turn this “reference” version of the program on
and off using track visibility whenever you want to have a look at the offline effects or
color corrections that were created during the offline edit.
Use Uncompressed or Lightly Compressed Still Image Formats
If your Final Cut Pro project uses still image files, then Color supports every still format
that Final Cut Pro supports. (Color supports far fewer image file formats for direct import;
see Compatible Image Sequence Formats for more information.) For the best results, you
should consider restricting stills in your project to uncompressed image formats such as
.tiff, or if using .jpg stills, make sure they’re saved at high quality to avoid compression
artifacts. If you’ve been using low-quality placeholders for still images in your program,
now is the time to edit in the full-resolution versions.
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any larger then 4096 x 2304, which is the maximum image size that Color supports. If
you’re using larger resolution stills in your project, you may want to export them as
self-contained QuickTime files with which to replace the original effects.
To optimize rendering time, Color only renders a single frame for each still image file.
When your project is sent back to Final Cut Pro, that clip reappears as a still image clip in
the Final Cut Pro Timeline.
Important: If any stills in your project are animated using Scale, Rotate, Center, or Aspect
Ratio parameter keyframes from Final Cut Pro, these keyframes do not appear and are
not editable in Color, but they are preserved and reappear when you send your project
back to Final Cut Pro. For more information, see Exchanging Geometry Settings with
Final Cut Pro.
Make Sure All Freeze Frame Effects Are on Track V1
All freeze frame effects need to be on track V1 for Color to correctly process them. After
rendering, freeze frames continue to appear in the sequence that is sent back to
Final Cut Pro as freeze frame clips.
Important: Freeze frame clips on any other video track will not be rendered, and will
reappear after the sequence is sent to Final Cut Pro as the original, ungraded clip.
Make Sure All Clips Have the Same Frame Rate
It’s not recommended to send a sequence to Color that mixes clips with different frame
rates, particularly when mixing 23.98 fps and 29.97 fps media. The resulting graded media
rendered by Color may have incorrect timecode and in or out points that are off by a
frame. If you have one or more clips in your sequence with a frame rate that doesn’t
match the timebase of the sequence, you can use Compressor to do a standards conversion
of the mismatched clips. For more information, see Rendering Mixed Format Sequences.
Media Manage Your Project, If Necessary
If you’re delivering a Final Cut Pro project to a Color suite at another facility, you may
want to eliminate unused media to save disk space (especially if you’ll be recapturing
uncompressed media), and consolidate all the source media used by your project into a
single directory for easy transport and relinking. This is also a good step to take prior to
recapturing your media, to avoid recapturing unnecessary media.
Recapture Offline Media at Online Quality, If Necessary
If the project was edited at offline quality, you need to recapture all the source media at
the highest available quality before you send it to Color. Be sure you choose a high-quality
codec, either using the native codec that the source footage was recorded with or using
one of the supported uncompressed codecs. For more information on which codecs are
supported by Color, see Compatible Media Formats.
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with a Y′CBCR
format, be sure that the codec you use to recapture, export, or transcode
your media doesn’t clamp super-white and overly high chroma components from the
original, uncorrected media. It’s usually better to correct out-of-gamut values within Color
than it is to clamp these levels in advance, potentially losing valuable image data.
Check All Transitions and Effects If You Plan to Render 2K or 4K Image Sequences
for Film Out
When rendering out 2K or 4K DPX or Cineon image sequences, all video transitions are
rendered as linear dissolves when you use the Gather Rendered Media command to
consolidate the finally rendered frames of your project in preparation for film output. This
feature is only intended to support film out workflows. Any other type of transition (such
as a wipe or iris) will be rendered as a dissolve instead, so it’s a good idea to go through
your project and change the type and timing of your transitions as necessary before
sending your project to Color.
Furthermore, effects that would ordinarily reappear in a sequence that is sent back to
Final Cut Pro, such as speed effects, superimpositions, composites, video filters, motion
settings that don’t translate into Pan & Scan parameters, generators, and Motion projects,
will not be rendered if you render 2K or 4K DPX or Cineon image sequences for film output.
In this case, it’s best to export all such clips as self-contained QuickTime files with which
to replace the original effects, before you send the sequence to Color.
Using the Send To Color Command in Final Cut Pro
Once you’ve prepared your sequence, you can use the Send To Color command in
Final Cut Pro to automatically move your sequence into Color (as long as Final Cut Pro
and Color are installed on the same computer).
You can only send whole sequences to Color. It’s not possible to send individual clips or
groups of clips from a sequence unless you first nest them inside a sequence.
To send a sequence from Final Cut Pro to Color
1 Open the project in Final Cut Pro.
2 Select a sequence in the Browser.
3 Do one of the following:
• Choose File > Send To > Color.
• Control-click the selection, then choose Send To > Color from the shortcut menu.
4 Choose a name for the project to be created in Color, then click OK.
A new Color project is automatically created in the default project directory specified in
User Preferences. The shots that appear in the Timeline should match the original
Final Cut Pro sequence that was sent.
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By default, all the video tracks of projects sent from Final Cut Pro are locked. When you’re
grading a project, it’s important to avoid unlocking them or making any editorial changes
to the shots in the Color Timeline if you’re planning to send the project back to
Final Cut Pro.
If you need to make an editorial change, reedit the original sequence in Final Cut Pro,
export a new XML file, and use the Reconform command to update the Color Timeline
to match the changes. For more information, see Reconforming Projects. For more
information about Final Cut Pro XML files, see the Final Cut Pro 7 User Manual.
Importing an XML File into Color
If you need to deliver a Final Cut Pro sequence and its media to another facility to be
graded using Color, you can also use the Export XML command in Final Cut Pro to export
the sequence. For more information about exporting XML from Final Cut Pro, see the
Final Cut Pro 7 User Manual.
In Color, you then use the Import XML command to turn the XML file into a Color project.
To speed up this process, you can copy the XML file you want to import into the default
project directory specified by Color.
To import an XML file into Color
1 Do one of the following:
• Open Color.
• If Color is already open, choose File > Import > XML.
2 Choose an XML file from the Projects dialog.
3 Click Load.
A new Color project is automatically created in the default project directory specified in
User Preferences. The shots that appear in the Timeline should match the original
Final Cut Pro sequence that was exported.
Don’t Reedit Imported XML Projects in Color
By default, all the video tracks of imported XML projects are locked. When you’re grading
a project, it’s important to avoid unlocking them or making any editorial changes to
the shots in the Color Timeline if you’re planning to send the project back to Final Cut Pro.
If you need to make an editorial change, reedit the original sequence in Final Cut Pro,
export a new XML file (see the Final Cut Pro 7 User Manual for more information), and
use the Reconform command to update the Color Timeline to match the changes. For
more information, see Reconforming Projects.
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You can import an EDL directly into Color. There are two reasons to use EDLs instead of
XML files:
• To color correct a video master file: You can approximate a tape-to-tape color correction
workflow by importing an EDL and using the Use As Cut List option to link it to a
corresponding master media file (either a QuickTime .mov file or a DPX image sequence).
Note: If you’re going to work this way, it’s best to work with uncompressed media and
to work in reels of 20 minutes or less to avoid potential performance bottlenecks caused
by sequences with an excessive number of edit points.
• To import a 2K digital intermediate project: EDLs are also the only way to import projects
as part of a 2K digital intermediate workflow when you’re relinking the project to DPX
image sequences from film scans. For more information, see Digital Intermediate
Workflows Using DPX/Cineon Media.
Color imports the following EDL formats:
• Generic
• CMX 340
• CMX 3600
• GVG 4 Plus
To speed up the process of importing an EDL, you can copy all EDL files to the default
project directory specified by Color.
To import an EDL
1 Do one of the following:
• Open Color.
• If Color is already open, Choose File > Import > EDL.
2 Choose an EDL file from the Projects dialog.
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in the User Prefs tab of the Setup room.
3 Choose the appropriate project properties from the available lists and pop-up menus.
For more information, see EDL Import Settings.
4 When you finish choosing all the necessary settings, click Import.
A new project is created, and the EDL is converted into a sequence of shots in the Timeline.
The position of each shot should match the Timeline of the original project.
Note: If the Source Directory you specified has any potential media conflicts (for example,
two clips with overlapping timecode or a missing reel number), you see a warning dialog
that gives you the option of writing a text file log of all potential conflicts to help you
sort them out.
EDL Import Settings
The settings in this dialog determine the options used when importing an EDL into Color.
• EDL Format: The format of the EDL file you’re importing.
• Project Frame Rate: The frame rate of the Color project you’re about to create. In most
cases, this should match the frame rate of the EDL you’re importing.
• EDL Frame Rate: Choose the frame rate of the EDL you’re importing. If the EDL Frame
Rate is 29.97 fps but you set the Project Frame Rate to 24 fps, Color will automatically
do the necessary conversions to remove 3:2 pull-down from the shots in the project.
Note: This option lets you deal with workflows where the imported EDL was generated
from an offline edit of a project using telecined 29.97 fps video, but the subsequent
scanned 2K image sequences were reacquired at film’s native 24 fps.
• Source Frame Rate: The frame rate of the source media on disk that you’re linking to.
• Use As Cut List: This checkbox lets you specify that this EDL should be used as a cut list
to “notch” a matching video master file.
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should match the resolution of the source media that you’re linking to.
• Height: The height of the selected frame size.
• Width: The width of the selected frame size.
• Source Directory: The directory specified here directs the EDL parser to the exact path
where the DPX or Cineon scans or QuickTime files associated with that project are
located. You can specify the location of the source media by typing the directory path
into this field, or clicking Browse to use the file browser. There are two methods you
use to link an EDL to the source media it corresponds to.
• If you simply choose a directory that contains media, that media will be linked using
each clip’s timecode track and reel number. If you’re linking to DPX or Cineon scans,
the methods used are described in How Does Color Relink DPX/Cineon Frames to
an EDL?
• Choose a Cinema Tools database, if one is available. When you choose a Cinema Tools
database associated with the Final Cut Pro project that created an EDL, Cinema Tools
is directed to relink the EDL with all associated DPX, Cineon, or even QuickTime media
based on information within the database. The advantage of this method is that, in
the event of problems, you can troubleshoot the Cinema Tools database
independently to resolve the discrepancy before trying to import the EDL into Color.
For more information, see Relinking DPX/Cineon Frames to an EDL Using a
Cinema Tools Database.
After you initiate EDL import, if the Source Directory you specified has any potential
media conflicts (for example, two clips with overlapping timecode or a missing reel
number), you see a warning dialog that gives you the option of writing a text file log
of all potential conflicts to help you sort them out.
After import, a Match column appears in the Shots browser of the Setup room. This
column displays the percentage of confidence that each shot in the Timeline has been
correctly linked to its corresponding DPX, Cineon, or QuickTime source media, based
on the methods used to do the linking. For more information on how EDLs are linked
with DPX or Cineon image sequence frames, see How Does Color Relink DPX/Cineon
Frames to an EDL? For more information on the Match column in the Shots browser,
see Explanation of Percentages in the Match Column.
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SAN or LAN with sufficient performance to accommodate the data rate of the project’s
media.
• Browse Button: This button opens the file browser, allowing you to set the source
directory for the EDL you want to import. Choosing a directory populates the Source
Directory field.
Relinking Media
If necessary, you can manually relink media to a Color project. When you use the Relink
command, Color matches each shot in the Timeline with its corresponding media file
using the following criteria:
• Starting timecode
• Filename
If neither of these criteria matches, you’re given the following warning:
If you click Yes and proceed with relinking to a different file, then the original Source In
and Source Out values for that shot will be overwritten with those of the new clip.
To relink every shot in your project
1 Choose File > Reconnect Media.
2 Choose the directory where the project’s media is saved from the Choose Media Path
dialog, then click Choose.
If that directory contains all the media used by the project, then every shot in the Timeline
is automatically relinked. If there are still missing media files, you are warned, and these
shots will remain offline; you need to use the Reconnect Media command again to relink
them.
To relink a single shot in the Timeline
1 Control-click or right-click a shot in the Timeline, then choose Relink Media from the
shortcut menu.
2 Choose a clip to relink to from the Select Media To Relink dialog, then click Load.
If the name and starting timecode of the media file matches that of the shot in the
Timeline, the media link is restored.
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You also have the option of importing media files to the Timeline directly, which lets you
use Color to process digital dailies and convert DPX or Cineon image sequences to suitable
QuickTime formats. You can import individual shots, or entire folders of shots.
For more information on doing batch DPX to QuickTime conversions, see Converting
Cineon and DPX Image Sequences to QuickTime.
To import a single shot into the Timeline
1 Do one of the following:
• Choose File > Import > Clip.
• Click the Setup tab.
2 Use the navigation controls at the top left of the file browser to find the directory
containing the media you want to import.
Tip: If the media you need is on another hard drive, click the Up Directory button
repeatedly until you’re at the top level of your computer’s directory structure, then
double-click the Volumes directory to open it. This will provide you with a list of all the
hard drives and partitions that are currently mounted on your system. From here, it should
be easy to find the media you need.
3 Double-click the directory to open it, then click to select an individual media file to import
into the Timeline.
4 Do one of the following:
• Double-click the shot in the file browser to edit the shot into the Timeline at the position
of the playhead.
• Drag the shot directly into the Timeline.
• Click the Import button below that shot’s preview to edit the shot into the Timeline at
the position of the playhead.
5 If you import a shot into an empty Timeline in Color, you’ll be asked if you want to change
the project settings to match those of the shot you’re importing. Click Yes if you want to
do so. (This is recommended.)
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To import a folder of shots into the Timeline
1 Do one of the following:
• Choose File > Import > Clip.
• Click the Setup tab.
2 Use the navigation controls at the top left of the file browser to find the directory
containing the media you want to import.
Tip: If the directory you need is on another hard drive, click the Up Directory button
repeatedly until you’re at the top level of your computer’s directory structure, then
double-click the Volumes directory to open it. This will provide you with a list of all the
hard drives and partitions that are currently mounted on your system. From here, it should
be easy to find the directory you need.
3 Click once to select the directory.
An Import Folder button appears within the file browser.
4 Click the Import Folder button to edit every shot within that folder into the Timeline, one
after the other, starting at the position of the playhead.
Important: When you import a folder of shots, all shots that are contained by subfolders
within the selected folder are also imported. This makes it convenient to import an entire
nested hierarchy of image sequence media that has been organized into multiple
individual folders.
Compatible Media Formats
Color is compatible with a wide variety of QuickTime files and image sequences. The
following sections provide information about all of these formats:
• Compatible QuickTime Codecs for Import
• Compatible Third-Party QuickTime Codecs
• Compatible Image Sequence Formats
Compatible QuickTime Codecs for Import
The list of codecs that are supported by Color is limited to high-quality codecs suitable
for media exchange and mastering. Codec support falls into four categories, listed in the
chart that follows:
• QuickTime codecs that are supported by Color when importing projects and media.
(These appear in column 1 of the table below.)
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Format is chosen in the Export Codec pop-up menu of the Project Settings tab of the
Setup room. (These appear in column 2.) Original Format is only available when you’ve
used the Send To Color command in Final Cut Pro or when you’ve imported a
Final Cut Pro file that’s been exported as an XML file.
• By default, only seven codecs are available in the Export Codec pop-up menu for
upconverting your source media to a higher-quality format. (These appear in column
3.) These include the Apple ProRes 422, Apple ProRes 422 (HQ), and Apple ProRes 4444
codecs, and the Apple Uncompressed 8-bit 4:2:2 and Apple Uncompressed 10-bit 4:2:2
codecs. Apple ProRes 422 (LT) and Apple ProRes 422 (Proxy) are included for offline
media conversions in digital intermediate and other workflows.
• If you’ve installed a video interface from AJA, you should see an additional option—AJA
Kona 10-bit RGB.
Important: Many of the codecs in column 1 that Color supports for media import, such
as the XDCAM, MPEG IMX, and HDV families of codecs, cannot be rendered using the
Original Format option. If the media in your project uses a codec that’s not supported
for output, every shot in your project will be rendered using one of the supported codecs
listed in column 3. For more information, see Some Media Formats Require Rendering to
a Different Format.
Supported for import Supported as original format Supported as export codec
Animation No No
Apple Intermediate Codec No No
Apple Pixlet Yes No
Apple ProRes 422 (Proxy) Yes Yes
Apple ProRes 422 (LT) Yes Yes
Apple ProRes 422 Yes Yes
Apple ProRes 422 (HQ) Yes Yes
Apple ProRes 4444 Yes Yes
AVCHD No No
AVC-Intra No No
DVCPRO 50 - NTSC Yes No
DVCPRO 50 - PAL Yes No
DV - PAL Yes No
DV/DVCPRO - NTSC Yes No
DVCPRO - PAL Yes No
DVCPRO HD 1080i50 Yes No
DVCPRO HD 1080i60 Yes No
Chapter 4 Importing and Managing Projects and Media 107Supported for import Supported as original format Supported as export codec
DVCPRO HD 1080p25 Yes No
DVCPRO HD 1080p30 Yes No
DVCPRO HD 720p50 Yes No
DVCPRO HD 720p60 Yes No
DVCPRO HD 720p Yes No
H.264 No No
HDV 720p24 No No
HDV 720p25 No No
HDV 720p30 No No
HDV 1080p24 No No
HDV 1080p25 No No
HDV 1080p30 No No
HDV 1080i60 No No
HDV 1080i50 No No
Photo - JPEG Yes No
MPEG IMX 525/60 (30 Mb/s) No No
MPEG IMX 525/60 (40 Mb/s) No No
MPEG IMX 525/60 (50 Mb/s) No No
MPEG IMX 625/50 (30 Mb/s) No No
MPEG IMX 625/50 (40 Mb/s) No No
MPEG IMX 625/50 (50 Mb/s) No No
Uncompressed 8-bit 4:2:2 Yes Yes
Uncompressed 10-bit 4:2:2 Yes Yes
XDCAM EX No No
XDCAM HD 1080i50 (35 Mb/s No No
VBR)
XDCAM HD 1080i60 (35 Mb/s No No
VBR)
XDCAM HD 1080p24 (35 Mb/s No No
VBR)
XDCAM HD 1080p25 (35 Mb/s No No
VBR)
XDCAM HD 1080p30 (35 Mb/s No No
VBR)
XDCAM HD 422 No No
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Color supports the following third-party codecs from AJA for import:
• AJA Kona 10-bit Log RGB
• AJA Kona 10-bit RGB
Note: The AJA Kona codecs are not installed by QuickTime by default and are available
only from AJA.
Color also supports native RED QuickTime files when you install the necessary RED software
for Final Cut Studio. For more information, visit http://www.red.com.
Compatible QuickTime Codecs for Output
The purpose of Color is to create high-quality, color-corrected media that can be
reimported into Final Cut Pro for output to tape, QuickTime conversion, or compression
for use by DVD Studio Pro. For this reason, the list of codecs that are supported for
rendering out of Color is limited to high-quality codecs suitable for media exchange and
mastering.
• Apple ProRes 422: A medium-bandwidth, high-quality compressed codec, suitable for
mastering standard definition video. Encodes video at 10 bits per channel with 4:2:2
chroma subsampling. Supports a variable bit rate (VBR) of 35 to 50 mbps. Supports any
frame size.
• Apple ProRes 422 (HQ): A higher-bandwidth version of Apple ProRes 422, suitable for
capturing and mastering high definition video. Supports a variable bit rate (VBR) of 145
to 220 mbps. Supports any frame size.
• Apple ProRes 4444: The highest-bandwidth version of Apple ProRes, suitable for high
definition or digital cinema mastering. Lightly compressed, with a variable bit rate (VBR)
depending on frame size and frame rate. (An example is 330 mbps at 1920x1080 60i
or 1280x720 60p.) Encodes video at up to 10 bits per channel with 4:4:4 chroma
subsampling. Supports a lossless compressed alpha channel, although Color does not
render alpha channel data.
• Uncompressed 8-bit 422: A completely uncompressed, 8-bit per channel codec with
4:2:2 chroma subsampling. Supports any frame size. Suitable for mastering any format
of video.
• Uncompressed 10-bit 422: A completely uncompressed, 10-bit per channel codec with
4:2:2 chroma subsampling. Supports any frame size. Suitable for mastering any format
of video.
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convert DPX or Cineon image sequences to offline-quality QuickTime clips for editing.
Because they’re so highly compressed, these codecs are not suitable for high-quality
mastering. DPX/Cineon conversions to QuickTime clone both the timecode and reel
number of each shot. For more information, see Converting Cineon and DPX Image
Sequences to QuickTime.
• Apple ProRes 422 (LT): A more highly compressed codec than Apple ProRes 422,
averaging 100 Mbps at 1920 x 1080 60i and 1280 x 720 60p. Designed to allow
low-bandwidth editing at full-raster frame sizes, eliminating awkward frame-size
conversions when conforming offline-to-online media for finishing and mastering.
• Apple ProRes 422 (Proxy): An even more highly compressed codec than Apple ProRes
422 (LT), averaging 36 Mbps at 1920 x 1080 24p, or 18 Mbps at 1280 x 720 24p. Designed
to allow extremely low-bandwidth editing at full-raster frame sizes, eliminating awkward
frame-size conversions when conforming offline-to-online media for finishing and
mastering.
Color supports the following third-party codec for rendering.
• AJA Kona 10-bit RGB
Note: The AJA Kona codecs are not installed by QuickTime by default and are available
only from AJA.
You can render your project out of Color using one of several high-quality mastering
codecs, regardless of the codec or level of compression that is used by the source media.
You can take advantage of this feature to facilitate a workflow where you import
compressed media into Color and then export the corrected output as uncompressed
media before sending your project to Final Cut Pro. This way, you reap the benefits of
saving hard disk space and avoiding rerendering times up front, while preserving all the
quality of your high–bit depth adjustments when you render your output media prior to
sending your project back to Final Cut Pro.
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When choosing the codec you want to use for rendering the final output, there are four
considerations:
• If you’ll be outputting to a high-bandwidth RGB format (such as HDCAM SR), or are
mastering 2K or 4K RGB media using QuickTime, you should export your media using
the Apple ProRes 4444 codec for the highest-quality result. This format is appropriate
for mastering at a quality suitable for film out, but the results will require a fast
computer and accelerated storage for playback.
• If you’ll be outputting to a high-bandwidth Y′CBCR video format (such as Betacam SP,
Digital Betacam, HDCAM, and DVCPRO HD) and require the highest-quality video data
available, regardless of storage or system requirements, you should export your media
using the Apple Uncompressed 10-bit 4:2:2 codec.
• If you’ll be outputting to one of the above video formats and require high quality,
but need to use a compressed format to save hard disk space and increase
performance on your particular computer, then you can export using the Apple ProRes
422 codec (good for standard definition) or the higher-quality Apple ProRes 422 (HQ)
codec (good for high definition), both of which are 10-bit, 4:2:2 codecs.
• If your system is not set up to output such high-bandwidth video, and your program
uses a source format that’s supported by the Original Format option in the QuickTime
Export Codecs pop-up menu in the Project Settings tab of the Setup room, you’ll be
able to render back to the original codec used by your Final Cut Pro sequence. If your
codec is unsupported, the QuickTime Export Codecs pop-up menu will default to
Apple ProRes 422. For more information on which codecs can be rendered using the
Source Format, see Compatible Media Formats.
Compatible Image Sequence Formats
Although Color supports a wide variety of image formats for clips that are edited into
Final Cut Pro projects that are sent to Color, the list of supported image formats that you
can import directly into Color is much shorter. The following RGB-encoded image formats
are compatible with Color, and are primarily intended for importing image sequences
directly into the Color Timeline.
• Cineon (import and export): A high-quality image format developed by Kodak for digitally
scanning, manipulating, and printing images originated on film. Developed as a 10-bit
log format to better contain the greater latitude of film for exposure.
• DPX (import and export): The Digital Picture eXchange format was derived from the
Cineon format and is also used for high-quality uncompressed digital intermediate
workflows. Color supports 8-bit and 10-bit log DPX and Cineon image files.
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for RGB graphics on a variety of platforms. Color is compatible with 16-bit TIFF
sequences.
• JPEG (import only): A highly compressed image format created by the Joint Photographic
Experts Group. The amount of compression that may be applied is variable, but higher
compression ratios create visual artifacts, visible as discernible blocks of similar color.
JPEG is usually used for offline versions of image sequences, but in some instances
(with minimal compression) this format may be used in an online workflow. JPEG is
limited to 8-bit encoding.
• JPEG 2000 (import only): Developed as a high-quality compressed format for production
and archival purposes, JPEG 2000 uses wavelet compression to allow compression of
the image while avoiding visible artifacts. Advantages include higher compression
ratios with better visible quality, options for either lossless or lossy compression methods,
the ability to handle both 8- and 16-bit linear color encoding, error checking, and
metadata header standardization for color space and other data.
Important: Only Cineon and DPX are supported for rendering image sequences out of
Color.
Moving Projects from Color to Final Cut Pro
Once you finish grading your project in Color, there are two ways of moving it back to
Final Cut Pro if you’re planning on mastering on video. For more information, see:
• Sending Your Project Back to Final Cut Pro.
• Exporting XML for Final Cut Pro Import.
• Revising Projects After They’re Sent to Final Cut Pro.
Sending Your Project Back to Final Cut Pro
After you grade your project in Color, you need to render it (described in The Render
Queue) and then send it back to Final Cut Pro. This is accomplished using XML, as your
Color project is automatically converted to XML data and then reconverted to a
Final Cut Pro sequence. There are two ways you can initiate this process.
Important: Projects using Cineon or DPX image sequences can’t be sent back to
Final Cut Pro.
To send a graded, rendered project to Final Cut Pro using the Send To command
1 Go through the Timeline and choose which grade you want to use for each of the clips
in your project.
Since each shot in your program may have up to four separately rendered versions of
media in the render directory, the rendered media that each shot is linked to in the
exported XML project file is determined by its currently selected grade.
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There are two possible warnings that may come up at this point:
• If you haven’t rendered every shot in Color at this point, you are warned. It’s a good
idea to click No to cancel the operation and render all of your shots prior to sending
the project back to Final Cut Pro.
• If the codec or frame size has been changed, either by you or as a result of rendering
your media to a mastering quality format, you are presented with the option to change
the sequence settings of the sequence being sent. For more information, see Some
Media Formats Require Rendering to a Different Format.
A new sequence is automatically created within the original Final Cut Pro project from
which the program came. However, if the Final Cut Pro project the program was originally
sent from is unavailable, has been renamed, or has been moved to another location, then
a new Final Cut Pro project will be created to contain the new sequence. Either way, every
clip in the new sequence is automatically linked to the color-corrected media you rendered
out of Color.
Exporting XML for Final Cut Pro Import
Another way of moving a Color project back to Final Cut Pro is to export an XML version
of your Color project.
To export an XML file back to Final Cut Pro for final output
1 Go through the Timeline and choose which grade you want to use for each of the clips
in your project.
Since each shot in your program may have up to four separately rendered versions of
media in the render directory, the rendered media that each shot is linked to in the
exported XML project file is determined by its currently selected grade.
2 Chose File > Export > XML.
3 When the Export XML Options dialog appears, click Browse.
4 Enter a name for the XML file you’re exporting in the File field of the Export XML File
dialog.
5 Choose a location for the file, then click Save.
6 Click OK.
A new XML project file is created, and the clips within are automatically linked to the
media directory specified in the Project Settings tab in the Setup room.
Note: If you haven’t exported rendered media from your Color project yet, the XML file
is linked to the original project media.
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If you need to make revisions to the color corrections of a sequence that you’ve already
sent from Color to Final Cut Pro, don’t send the sequence named “from Color” back to Color.
The correct method is to quit Final Cut Pro, reopen the originating Color project, make
your changes, and then do one of the following:
• If you didn’t change the grade number used by any of the shots in Color, simply rerender
the clips you changed, save the Color project, and then reopen the Final Cut Pro project
that has the sequence that was originally sent “from Color.” The rerendered media
overwrites the previous media, and is immediately reconnected when you reopen the
Final Cut Pro project.
• If you do change the grade number of any of the shots in Color, you need to send the
project back to Final Cut Pro, and use the new “from Color” sequence to finish your
program.
This makes it easier to manage your media, easier to keep track of your revisions, and
prevents any of your clips from being rendered twice unnecessarily.
Exporting EDLs
You can export EDLs out of Color, which can be a good way of moving projects back to
other editorial applications. When exporting an EDL, it’s up to the application with which
you’ll be importing the EDL to successfully relink to the media that’s rendered out of
Color.
Note: To help facilitate media relinking, the media path is written to the comment column
in the exported EDL, although not all editing applications support this convention.
To export an EDL
1 Choose File > Export > EDL.
2 When the Export EDL dialog appears, click Browse.
3 Enter a name for the EDL you’re exporting in the File field of the Export EDL File dialog,
choose a location for the file, then click Save.
4 If you didn’t change any of the shot names when you exported the final rendered media
for this project, turn on “Use original media name.”
5 Click OK.
A new EDL file is created, and the clips within are linked to the media directory you
specified.
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Whether your project was sent from Final Cut Pro, or imported via an EDL from any other
editing environment, you have the option of automatically reconforming your Color
project to match any editorial changes made to the original Final Cut Pro sequence, which
can save you hours of tedious labor.
Color matches each project to the sequence that was originally sent to Color using an
internal ID number. Because of this, you can only reconform by reediting the actual
sequence that you originally sent to Color. Any attempt to reconform a duplicate of the
original sequence will not work.
To reconform an XML-based Color project
1 Export an updated XML file of the reedited Final Cut Pro sequence from Final Cut Pro.
2 Open the Color project you need to update, then choose File > Reconform.
3 Select the XML file that was exported in step 1 using the Reconform XML dialog, then
click Load.
The shots in the Timeline should update to reflect the imported changes, and the
Reconform column in the Shots browser is updated with the status of every shot that
was affected by the Reconform operation.
You can also reconform projects that were originally imported using EDLs.
To reconform an EDL-based Color project
1 Export an updated EDL of the reedited sequence from the originating application.
2 Open the Color project you need to update, then choose File > Reconform.
3 Select the EDL file that was exported in step 1 using the Reconform dialog, then click
Load.
As is the case when you reconform an XML-based project, the Reconform column in the
Shots browser in the Setup room is updated with the status of each shot that’s been
modified by the Reconform operation. This lets you identify shots that might need
readjustment as a result of such changes, sorting them by type for fast navigation. For
more information, see Column Headers in the Shots Browser.
Converting Cineon and DPX Image Sequences to QuickTime
You can use Color to convert Cineon and DPX image sequences to QuickTime files to
facilitate a variety of workflows.
• If you’re starting out with 2K or 4K DPX or Cineon film scans or digital camera output,
you can downconvert matching QuickTime media files at offline resolution by choosing
a smaller resolution preset, and choosing ProRes 422 as the QuickTime export codec.
You can then use this media to do an offline edit.
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finishing-quality QuickTime media files by simply choosing ProRes 4444 as the QuickTime
export codec.
• If your project media is in the QuickTime format, but you want to output a series of
Cineon or DPX image sequences, you can do this conversion as well.
The timecode of converted DPX or Cineon film scans is copied to the new media that’s
created. This allows you to track the correspondence between the QuickTime clips you
generate, and the original image sequences from which they came. This conversion uses
the following rules:
• Timecode header metadata in DPX or Cineon files, if present, is converted into a
timecode track in each converted QuickTime file.
• If there is no timecode header data in the DPX or Cineon files, then the frame numbers
used in the filename of the image sequence are converted into timecode and written
to the timecode track of the converted QuickTime files. (For more information, see
Required Image Sequence Filenaming.)
• If a directory containing DPX or Cineon image sequences has the reel number of those
sequences as its name (highly recommended), that number will be used as the reel
number of the converted QuickTime files.
When converting from Cineon and DPX to high definition or standard definition QuickTime
video (and vice versa), Color automatically makes all necessary color space conversions.
Log media is converted to linear, and Rec. 701 and 601 color spaces are taken into account.
To convert Cineon or DPX image sequences to QuickTime media
1 Create a new, empty project. (For more information, see Creating and Opening Projects.)
2 Using the file browser, select the folder that contains all of the shots you want to convert,
and click the Import Folder button to edit every shot within that folder into the Timeline.
When you import a folder of shots, all shots that are contained by subfolders within the
selected folder are also imported. This makes it convenient to import an entire nested
hierarchy of image sequence media that has been organized into multiple individual
folders. For more information about importing media into the Timeline, see Importing
Media Directly into the Timeline.
3 Open the Project Settings tab of the Setup room, and do the following:
a Click Project Render Directory, choose a render directory for the converted media, then
click Choose.
b Choose QuickTime from the Render File Type pop-up menu.
c Choose a resolution from the Resolution Presets pop-up menu.
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pop-up menu. (For more information about choosing a suitable output codec, see
Compatible QuickTime Codecs for Output.)
4 If necessary, grade the shots to make any corrections to the offline media that you’ll be
generating.
Sometimes, the source media from a particular camera or transfer process needs a specific
color correction or contrast adjustment in order to look good during the offline edit. If
this is the case, you can use a single correction to adjust every shot you’re converting
(the equivalent of a one-light transfer). At other times, you’ll want to individually correct
each shot prior to conversion to provide the best-looking media you can for the editing
process (the equivalent of a best-light transfer).
Tip: To quickly apply a single correction to every shot in the Timeline, grade a
representative shot in the Primary In room, then click Copy to All.
5 Open the Render Queue, then click Add All.
6 Click Start Render.
All of the shots are converted, and the rendered output is written to the currently specified
render directory.
Important: After you’ve rendered the converted output, it’s a good idea to save the Color
project file you created to do the conversion, in case you need to reconvert the media
again. You might do this to improve the “one-light” color correction you applied to the
converted media, or to change the codec used to do the conversion. Keeping the original
conversion project makes it easy to reconvert your media in the same order, with the
same automatically generated file names, so you can easily reconnect a Final Cut Pro
sequence containing previously converted media to a new set of reconverted media.
For more information about options in the Render File Type, Resolution Presets, and
Export Codec pop-up menus, see Resolution and Codec Settings.
Importing Color Corrections
The File > Import > Color Corrections command lets you apply the grades and color
corrections from the shots of one project file to those within the currently open project.
It’s meant to be used with Color projects that are based on the same source, so that a
newly imported version of a project you’ve already been working on can be updated
with all the grades that were applied to the previous version.
For this command to work properly, the project you’re importing the color corrections
from must have the same number of shots in the Timeline as the project you’re applying
the imported color corrections to. The shot numbers in each project are used to determine
which color correction is copied to which shot. For example, the color correction from
shot 145 in the source project is copied to shot 145 in the destination project.
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from the source.
To import the color corrections from one project to another
1 Open the Color project into which you want to import the corrections.
2 Choose File > Import > Color Corrections.
3 In the Projects dialog, select the Color project containing the corrections you want to
import, then click Load.
The shots in the currently open project are updated with the color corrections from the
other project file.
Exporting JPEG Images
Color also provides a way of exporting a JPEG image of the frame at the position of the
playhead. JPEG images are exported at the current size of the Preview area of the Scopes
window.
To export a JPEG image of the frame at the current position of the playhead
1 Move the playhead to the frame you want to export.
2 Choose Export > JPEG Still.
3 Enter a name in the File field and select a directory using the Save Still As dialog.
Note: This defaults to the Still Store subdirectory inside the project bundle.
4 Click Save.
The frame is saved as a JPEG image to the location you selected. JPEG images are exported
with a frame size that matches the size of the Preview area of the Scopes window.
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environment and project settings in the Setup room.
The Setup room serves many purposes. It’s where you import media files, sort and manage
saved grades, organize and search through the shots used in your program, choose your
project’s render and broadcast safe settings, and adjust user preferences.
This chapter covers the following:
• The File Browser (p. 119)
• Using the Shots Browser (p. 122)
• The Grades Bin (p. 128)
• The Project Settings Tab (p. 129)
• The Messages Tab (p. 135)
• The User Preferences Tab (p. 135)
The File Browser
The file browser, occupying the left half of the Setup room, lets you directly navigate the
directory structure of your hard disk. It's like having a miniature Finder right there in the
Setup room. Keep in mind that the file browser is not a bin. The files displayed within the
file browser are not associated with your Color project in any way unless you drag them
into the Timeline manually or relink the shots of an imported project to their associated
media files on disk using the Relink Media or Reconnect Media command.
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Color opens.
For more information on how to use the file browser, see Importing Media Directly into
the Timeline. For more information on importing project data from other applications,
see Importing and Managing Projects and Media.
File Browser Controls
These two buttons are at the top of the file browser.
• Up Directory button: Moves to the next directory up the current file path.
• Home Directory button: Moves to the currently specified default media directory.
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When you click a shot to select it, an enlarged thumbnail appears to the right of the list
of media.
Underneath the thumbnail, information appears about the shot, including its name,
duration, resolution, frame rate, and timecode. If it’s an image sequence, its white point,
black point, and transfer mode metadata also appear. Depending on the type of media,
one or two buttons may appear at the bottom of the file browser.
Fix Headers Button
If the selected shot (or shots) is an image sequence, the Fix Headers button appears.
Clicking it opens the DPX Header Settings window, which lets you change the transfer
mode (Linear or Logarithmic), the Low Reference (black point) and High Reference (white
point), of DPX and Cineon image sequences that may have incorrect data in the headers.
Change the parameters to the necessary settings and click Fix to rewrite this header data
in all of the currently selected shots.
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Selecting one or more shots and clicking Import edits the selection into the end of the
current Timeline for an unlocked project. This is useful if you’re using Color to convert
DPX or Cineon image sequences to QuickTime, or vice versa. For more information, see
Importing Media Directly into the Timeline.
Note: You cannot import media into locked projects. This includes any project sent from
Final Cut Pro.
Using the Shots Browser
The Shots browser lists every shot used by the current program that appears in the
Timeline.
This bin can be used for sorting the shots in your program using different criteria, selecting
a group of shots to apply an operation to, or selecting a shot no matter where it appears
in the Timeline. For more information, see:
• Shots Browser Controls
• Column Headers in the Shots Browser
• Customizing the Shots Browser
• Adding Notes to Shots in the Shots Browser
• Selecting Shots and Navigating Using the Shots Browser
Shots Browser Controls
These controls are used to control both what and how items are viewed in the Shots
browser.
• Icon View button: Click to put the shot area into icon view.
• List View button: Click to put the shot area into list view.
• Shots browser: Each shot in your project appears here, either as a thumbnail icon or as
an entry (in list view).
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Icons or entries in the Shots browser are colored based on their selected state.
• Dark gray: The shot is not currently being viewed, nor is it selected.
• Light gray: The shot at the current position of the playhead is considered to be the
current shot and is highlighted with gray in both the Timeline (at the bottom of the
screen) and the Shots browser. The current shot is the one that's viewed and that is
corrected when the controls in any room are adjusted.
• Cyan: You can select shots other than the current shot. Selected shots are highlighted
with cyan in both the Timeline and the Shots browser. To save time, you can apply
grades and corrections to multiple selected shots at once.
Goto Shot and Find Fields in the Shots Browser
The Goto Shot and Find fields let you jump to and search for specific shots in your project.
These fields work with the Shots browser in either icon or list view modes.
To go to a specific shot
µ Enter a number in the Goto Shot field, then press Enter.
The list scrolls down to reveal the shot with that number, which is automatically selected,
and the playhead moves to the first frame of that shot in the Timeline.
To search for a specific shot
1 Click the header of the column of data you want to search.
2 Enter a name in the Search field.
As soon as you start typing, the Shots browser empties except for those items that match
the search criteria. As you continue to type, the Shots browser dynamically updates to
show the updated list of corresponding items.
Note: All searches are performed from the first character of data in the selected column,
read from left to right. The Find function is not case-sensitive.
To reveal all shots after a Find operation
µ Select all of the text in the Find field, then press Delete.
All shots should reappear in the Shots browser.
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When the Shots browser is in list view, up to nine columns of information are visible.
• Shots Browser Column Headers: These columns appear when the Shots browser is in
list view.
• Number: Lists a shot's position in the edit. The first shot is 1, the second is 2, and so
on.
• Shot Name: The name of that shot, based on its filename.
• Colorist: Lists the name that occupied the Colorist field in the Project Settings when
that shot was last corrected. This column is useful for keeping track of who worked
on which shots when multiple colorists are assigned to a project.
• Status: Shows that shot's rendered status. You can right-click on this column for any
selected shot and choose a new state from the shortcut menu. For more information
on the five possible render states, see Possible Render States in the Status Column.
• Reconform: Lists whether that shot has been affected by a Reconform operation. For
example, you can sort by this column to quickly identify and navigate to new shots
that aren't yet graded because they were added to the Timeline as a result of a
Reconform operation. For more information on reconforming a project, see
Reconforming Projects. For more information on the four possible Reconform flags,
see Possible Flags in the Reconform Column.
• Time Spent: This column appears only when the Show Time button below the Shots
browser is turned on. It shows how much time has been spent grading that particular
shot. Color keeps track of how long you spend working on each shot in each program,
in order to let you track how fast you've been working.
• Notes: The Notes column provides an interface for storing and recalling text notes
about specific shots. Shots with notes appear with a checkmark in this column.
• Match: The Match column only appears when a project has been created by importing
an EDL into Color. This column displays the percentage of confidence that each shot
in the Timeline has been correctly linked to its corresponding DPX, Cineon, or
QuickTime source media. The confidence value is based on the methods used to do
the linking. For more information, see Explanation of Percentages in the Match
Column.
Possible Render States in the Status Column
Each shot has one of five possible render states that appear in the Status column of the
Shots browser:
• Queued: The shot has been added to the Render Queue.
• Rendering: The shot is currently being rendered.
• Rendered: The shot has been successfully rendered.
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• Aborted: Rendering of this shot has been stopped.
Possible Flags in the Reconform Column
Each shot that has been affected by a Reconform operation has one of four possible flags
that appear in the Reconform column of the Shots browser:
• Shorten: The shot has been shortened.
• Content Shift: The shot's duration and position in the Timeline are the same, but its
content has been slipped.
• Moved: The shot has been moved to another position in the Timeline.
• Added: This shot has been added to the project.
Explanation of Percentages in the Match Column
The Match column displays the percentage of confidence that each shot in the Timeline
has been correctly linked to the corresponding DPX, Cineon, or QuickTime source media,
based on the methods used to do the linking. The percentages displayed correspond to
the following linking methods:
• 100% confidence means the timecode for that shot in the EDL matched the timecode
found in the header data of the corresponding DPX or Cineon frame, and the EDL reel
number matched the name of the directory in which that frame appears.
• 75% confidence means the timecode for that shot in the EDL matched the frame
number of that DPX or Cineon frame, and the EDL reel number matched the name of
the directory in which that frame appears. For more information on timecode–to–frame
number conversions, see Required Image Sequence Filenaming.
• 50% confidence means the timecode for that shot in the EDL matched the timecode
found in the header data of the corresponding DPX or Cineon frame, but the reel
number could not be matched to the name of the directory in which that frame appears.
• 25% confidence means the timecode for that shot in the EDL matched the frame
number of that DPX or Cineon frame, but the reel number could not be matched to
the name of the directory in which that frame appears. For more information on
timecode–to–frame number conversions, see Required Image Sequence Filenaming.
• 0% confidence means that no media could be found to match the timecode for that
shot in the EDL, and the shot is offline in the Color Timeline.
Customizing the Shots Browser
The following procedures describe ways you can sort and modify the Shots browser.
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µ Click a column's header to sort by that column.
Shots are sorted in descending order only. Numbers take precedence over letters, and
uppercase takes precedence over lowercase.
To resize a column in the Shots browser
µ Drag the right border of the column you want to resize.
To reveal or hide the Time Spent column
µ Click Show Time, located underneath the Shots browser.
Adding Notes to Shots in the Shots Browser
Color provides an interface for keeping track of client or supervisor notes on specific shots
as you work on a project.
To add a note to a shot, or to read or edit an existing note
1 Open the Setup room, then click the Shots tab.
2 Control-click or right-click the Notes column of the Shots browser, then choose Edit File
from the shortcut menu.
A plain text editing window appears.
3 Enter your text.
4 To save the note and close it, do one of the following:
• Press Command-S, then close the window.
• Close the window and click Save in the dialog that appears.
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To remove a note from a shot
µ Control-click or right-click the Notes column of the Shots browser, then choose Delete
File from the shortcut menu.
Note: Notes are saved within the subdirectory for that particular shot, within the /shots/
subdirectory inside that project bundle. Removing a note deletes the note file.
Selecting Shots and Navigating Using the Shots Browser
You can use the Shots browser to quickly find and select specific shots—for example, to
apply a single grade to a group of shots at once. You can also use the Shots browser to
quickly navigate to a particular shot in the Timeline. These procedures work whether the
Shots browser is in icon or list view.
To select one or more shots
Do one of the following:
µ Click any shot in the Shots browser to select that shot.
µ Command-click any group of shots to select a noncontiguous group of shots.
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from the first selection to the second.
Selected shots appear with a cyan overlay.
To navigate to a specific shot in the Timeline using the Shots browser
Do one of the following:
µ Double-click any shot.
µ Type a number into the Goto Shot field.
The new current shot turns gray in the Shots browser, and the playhead jumps to the
first frame of that shot in the Timeline. That shot is now ready to be corrected using any
of the Color rooms.
The Grades Bin
The Grades bin in the Setup room lets you save and manage grades that you can use in
your programs.
A grade, as described in Using the Color Interface, can contain one or more of the following
individual corrections:
• Primary
• Secondary
• Color FX
• Primary Out
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Grades saved into the Grades bin are available to all Color projects opened while logged
into that user account. The Grades bin can display grades in either icon or list view, and
shares the same controls as the other bins in Color. For more information on using the
Grades bin controls, see Using Organizational Browsers and Bins.
For more information on saving and applying grades, see Saving Grades into the Grades
Bin.
The Project Settings Tab
The options in the Project Settings (Prjct Settings) tab are saved individually on a
per-project basis. They let you store additional information about that project, adjust how
the project is displayed, and specify how the shots in that project will be rendered.
For more information, see:
• Informational and Render Directory Settings
• Resolution and Codec Settings
• Broadcast Safe Settings
• Handles
Informational and Render Directory Settings
These settings provide information about Color and your project and let you set up the
directory into which media generated by that project is written.
• Project Name: The name of the project. This defaults to the name of the project file on
disk, but you can change it to anything you like. Changing the project name does not
change the name of the project file.
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for this project are stored. (For more information about rendering Color projects, see
The Render Queue.) It’s always best to choose the appropriate location for the render
directory before you add items to the Render Queue, to make sure your shots are
rendered in the correct location. If the specified render directory becomes unavailable
the next time you open a project, you will be prompted to choose a new one.
• Project Render Dir button: Clicking this button lets you select a new project render
directory using the Choose Project Render Directory dialog.
• Colorist: This field lets you store the name of the colorist currently working on the
project. This information is useful for identifying who is working on what in multi-suite
post-production facilities, or when moving a project file from one facility to another.
• Client: This field lets you store the name of the client of the project.
Resolution and Codec Settings
These settings let you set up the display and render properties of your project. They affect
how your program is rendered both for display purposes, and when rendering the final
output.
• Display LUT: A display LUT (look up table) is a file containing color adjustment
information that's typically used to modify the monitored image that's displayed on
the preview and broadcast displays. LUTs can be generated to calibrate your display
using hardware probes, and they also let you match your display to other characterized
imaging mediums, including digital projection systems and film printing workflows. If
you've loaded a display LUT as part of a color management workflow, this field lets you
see which LUT file is being used. For more information on LUT management, see
Monitoring Your Project.
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frame rate is set when the project is created, and it can be changed by a pop-up menu
so long as no shots appear in the Timeline. Once one or more shots have been added
to the Timeline, the project's frame rate cannot be changed.
• Resolution Presets pop-up menu: This pop-up menu lists all of the project resolutions
that Color supports, including PAL and NTSC standard definition, high definition, 2K
and 4K frame sizes. The options that are available in this menu are sometimes limited
by the currently selected QuickTime export codec.
If you change the Resolution Preset to a different frame size than the one the project
was originally set to, how that frame size affects the final graded media that is rendered
depends on the source media you’re using, and the Render File Type you’ve chosen:
• If you’re rendering QuickTime media, each shot in your project is rendered at the
same frame size as the original source media. The new Resolution Preset you choose
only affects the resolution of the sequence that is sent back to Final Cut Pro. Pan &
Scan settings are converted to Motion tab settings when the project is sent back to
Final Cut Pro.
• If your project uses 4K native RED QuickTime media, each shot in your project is
rendered at the new resolution you’ve specified. Any Pan & Scan tab adjustments
you’ve made are also rendered into the final media. (2K native RED QuickTime media
is rendered the same as other QuickTime media.)
• If the Render File Type pop-up menu is set to DPX or Cineon, then each shot in your
project is rendered at the new resolution you’ve specified. Any Pan & Scan tab
adjustments you’ve made are also rendered into the final media.
Important: Whenever you change resolutions, a dialog appears asking “Would you like
Color to automatically scale your clips to the new resolution?” Clicking Yes automatically
changes the Scale parameter in the Pan & Scan tab of the Geometry room to conform
each clip to the new resolution, letterboxing or pillarboxing clips as necessary to avoid
cropping. Clicking No leaves the Scale parameter of each clip unchanged, but may
result in the image being cropped if the new resolution is smaller than the previous
resolution.
If the QuickTime export codec allows custom frame sizes, the width and height fields
below can be edited. Otherwise, they remain uneditable. If these fields are set to a
user-specified frame size, the Resolution Presets pop-up menu displays "custom."
• Width: The currently selected width of the frame size
• Height: The currently selected height of the frame size
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the Render File Type is set to DPX. It lets you choose how to map 0 percent black and
100 percent white to the minimum and maximum numeric ranges that each format
supports. Additionally, the option you choose determines whether or not super-white
values are preserved. For more information, see Choosing Printing Density When
Rendering DPX Media.
Note: Choosing Cineon as the Render File Type limits the Printing Density to Film (95
Black - 685 White : Logarithmic), while choosing QuickTime as the Render File Type
limits it to Linear (0 Black - 1023 White).
• Render File Type pop-up menu: This parameter is automatically set based on the type
of media your project uses. If you send a project from Final Cut Pro, this parameter is
set to QuickTime, and is unalterable. If you create a Color project from scratch, this
pop-up menu lets you choose the format with which to render your final media. When
working on 2K and 4K film projects using image sequences, you'll probably choose
Cineon or DPX, while video projects will most likely be rendered as QuickTime files.
• Deinterlace Renders: Turning this option on deinterlaces all shots being viewed on the
preview and broadcast displays and also deinterlaces media that's rendered out of
Color.
Note: Deinterlacing in Color is done very simply, by averaging both fields together to
create a single frame. The resulting image may appear softened. There is also a
deinterlacing parameter available for each shot in the Shot Settings tab next to the
Timeline, which lets you selectively deinterlace individual shots without deinterlacing
the entire program. For more information, see The Settings 2 Tab.
• Deinterlace Previews: Turning this option on deinterlaces all shots being viewed on the
preview and broadcast displays but media rendered out of Color remains interlaced.
• QuickTime Export Codecs pop-up menu: If QuickTime is selected in the Render File Type
pop-up menu, this pop-up menu lets you choose the codec with which to render media
out of your project. If this menu is set to Original Format, the export codec will
automatically match the codec specified in the sequence settings of the originating
Final Cut Pro sequence. (This option is only available when using the Send To Color
command or when importing an exported Final Cut Pro XML file.)
The QuickTime Export codec does not need to match the codec used by the source
media. You can use this menu to force Color to upconvert your media to a minimally
compressed or uncompressed format. The options in this pop-up menu are limited to
the QuickTime codecs that are currently supported for rendering media out of Color.
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mastering codecs, regardless of the codec or level of compression that is used by the
source media. You can use the QuickTime Export Codecs pop-up menu to facilitate a
workflow where you import compressed media into Color and then export the corrected
output as uncompressed media before sending your project to Final Cut Pro. This way,
you reap the benefits of saving hard disk space and avoiding rerendering times up
front, while preserving all the quality of your high–bit depth adjustments when you
render your output media prior to sending your project back to Final Cut Pro. The
codecs most suitable for mastering include Apple Uncompressed 8-bit 4:2:2, Apple
Uncompressed 10-bit 4:2:2, Apple ProRes 422, and Apple ProRes 422 (HQ). For more
information, see Compatible QuickTime Codecs for Output.
Broadcast Safe Settings
When color correcting any program destined for broadcast, it's important to obtain the
specific quality control (QC) guidelines from the broadcaster. There are varying standards
for the maximum and minimum allowed IRE, chroma, and composite amplitude, and
some broadcasters are more conservative than others.
The Broadcast Safe settings let you set up Color to limit the minimum and maximum
luma, chroma, and composite values of shots in your program. These settings are all
completely customizable to accommodate any QC standard and prevent QC violations.
• Broadcast Safe button: Turning on Broadcast Safe enables broadcast legalization for
the entire project, affecting both how it's displayed on your secondary display and
broadcast monitor and how it's rendered for final output. This button turns the following
settings on and off:
• Ceiling IRE: Specifies the maximum luma that's allowable, in analog IRE units. Signals
with luma above this limit will be limited to match this maximum value.
• Floor IRE: Specifies the minimum luma that's allowable, in analog IRE units. Signals
with luma below this limit will be limited to match this minimum value.
• Amplitude: This is not a limiting function. Instead, it lets you apply an adjustment to
the amplitude of the chroma. The default value of 0 results in no change.
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is made.
• Offset: Lets you adjust the offset of a chroma adjustment. If Amplitude is set to 0, no
change is made.
• Chroma Limit: Sets the maximum allowable saturation. The chroma of signals with
saturation above this limit will be limited to match this maximum value.
• Composite Limit: Sets the maximum allowable combination of luma and chroma.
Signals exceeding this limit will be limited to match this maximum value.
Ways of Using Broadcast Safe
The Broadcast Safe parameters can be set to match the required QC guidelines for your
program. When enabled, they guarantee that your program will not exceed these
standards while you monitor your program and when you render the finally corrected
media. There are three ways you can limit broadcast levels in your program.
Turn Broadcast Safe On, and Leave It Turned On While You Make Your Adjustments
The safest way to work (and the default behavior of new projects) is to simply turn
Broadcast Safe on at the beginning of your work, and leave it on throughout your entire
color correction pass. With practice, you can tell if a highlight or shadow is being crushed
too much by looking at the image on the monitor and watching for clumping exhibited
at the top and bottom of the graphs in the Waveform scope. If the image is being clipped
more than you prefer, you can make a correction to adjust the signal.
Turn Broadcast Safe Off While Making an Adjustment, Then Turn It Back On to Render
Output
If you leave Broadcast Safe on, illegal portions of the signal are always limited, and it
can be difficult to see exactly how much data is being clipped. When you're color
correcting media that was consistently recorded with super-white levels and high
chroma, you may find that it's sometimes a good idea to turn the Broadcast Safe settings
off while you do an initial color correction pass, so you can more easily see which parts
of the signal are out of bounds and make more careful judgments about how you want
to legalize it.
Turn Enable Clipping On for Individual Shots in Your Program
The Enable Clipping button in the Basic tab of the Primary Out room lets you set ceiling
values for the red, green, and blue channels for individual shots in your program (RGB
clipping). This lets you prevent illegal broadcast values in shots to which you're applying
extreme primary, secondary, or Color FX corrections, without turning on Broadcast Safe
for the entire program. If Enable Clipping and Broadcast Safe are both on, the lowest
standard is applied. For more information, see Ceiling Controls.
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This field lets you specify a duration of extra media to be added to the head and tail of
each media file that's rendered out of Color. When a project is sent back to Final Cut Pro,
handles allow editors to make small adjustments without running out of corrected media.
The default value is 00:00:00:00.
Note: Although Color doesn’t allow you to preview transition effects as you work, shots
that are joined by transitions are automatically rendered with handles in order to provide
the necessary overlap for the transitions to work. This is true whether or not you’ve set
handles greater than zero.
The Messages Tab
The Messages tab contains a running list of all the warnings and error messages that are
generated by Color while it operates. Messages highlighted in yellow are warnings.
Messages highlighted in red signify that an error has occurred (for example, "Directory
not writable trying to re-save a project."). There are no controls in the Messages tab.
The User Preferences Tab
The User Preferences (User Prefs) tab contains settings that affect the operation of Color
with any project you open. It includes options for customizing control surface sensitivity,
Timeline display, playback behavior, video output, and the bit depth that's used for both
display and rendering.
The state of each of these settings is automatically saved whenever they're changed. If
necessary, you can restore the settings to their original defaults.
To reset the default user preferences
µ Click Reset Preferences, at the bottom of the User Preferences tab.
Chapter 5 Configuring the Setup Room 135For more information, see:
• Media and Project Directories
• Control Surface Settings
• User Interface Settings
• Grade and Scope Color Controls
• Limit Shadow Adjustments and Show Control Surface Controls
• Using Proxies
• Playback, Processing, and Output Settings
• How Do Bit Depth and Channel Data Correspond?
• Auto Save Settings
Media and Project Directories
The Media and Project directories let you control where new files are saved by default.
• Default Project Dir.: The default directory where all new Color projects are saved. This
is also the default directory that appears in the dialogs for the Import EDL and Import
XML commands. Click the Browse button to choose a new directory.
• Default Media Dir.: The default directory for the file browser. This is also the default
media location used by the Import EDL and Import XML commands. Click the Browse
button to choose a new directory.
• Default Render Dir.: The default directory for media that's rendered by Color for export.
Click the Browse button to choose a new directory.
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If you're using a control surface with Color, the following parameters let you adjust how
motion applied to a particular control corresponds to the resulting adjustment that's
made.
• Hue Wheel Angle: This parameter specifies the angle at which colors appear on the
color wheel of color controls in the Color interface and the corresponding angle at
which these colors are adjusted when using the joyballs of a control surface. This is
customizable in order to accommodate colorists who are used to working with different
systems:
• 122 is the default angle of red for DaVinci color correction systems, which corresponds
to the angle at which red appears on a Vectorscope. This is the default Color setting.
• 0 is the default angle of red for Pogle color correction systems, which corresponds
to the orientation of the controls of the older Mk III telecine.
Hue wheel angle at 122 Hue wheel angle at 0
• Encoder Sensitivity: This parameter controls the speed with which the rotation of knobs
on a control surface changes the value of their associated Color controls.
• Jog/Shuttle Sensitivity: This parameter controls the speed at which the playhead moves
relative to the amount of rotation that's applied to a control surface's Jog/Shuttle wheel.
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adjusted when using a control surface's joyballs to adjust the Shadow, Midtone, and
Highlight color controls in the Primary In, Secondary, and Primary Out rooms. The
default setting is 1, which is extremely slow. Raise this value to increase the rate at
which corrections are made with the same amount of joyball motion.
User Interface Settings
The following settings let you customize the Color interface.
• UI Saturation: This value controls how saturated the Color user interface controls appear.
Many colorists lower the UI saturation to avoid eye fatigue and the potential for biasing
one's color perception during sessions. UI saturation also affects the intensity of colors
displayed by the Scopes window when the Monochrome Scopes option is turned off.
• Frames/Seconds/Minutes/Hours: These buttons let you choose how time is displayed
in the Timeline ruler. They do not affect how time is represented in the other timecode
fields in Color.
• Show Shot Name: Turning this option on displays each shot's name in the Timeline.
• Show Shot Number: Turning this option on displays the shot number for each shot in
the Timeline.
• Show Thumbnail: With this setting turned on, single frame thumbnails appear within
every shot in the Timeline.
• Loop Playback: Turning this option on loops playback from the current In point to the
Out point of the Timeline. How this affects playback depends on how the Playback
Mode is set. For more information, see Switching the Playback Mode.
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order to maintain the project's frame rate during playback.
• If Maintain Framerate is turned on (the default): The current frame rate is maintained
no matter what the current processing workload is. If the currently playing grade is
processor-intensive, then frames will be dropped during playback to maintain the
project's frame rate. If not, playback occurs in real time.
• If Maintain Framerate is turned off: Every frame is always played back. If the currently
playing grade is processor-intensive, playback will slow to avoid dropping frames. If
not, playback may actually occur faster than real time.
• Synchronize Refresh (slower): Turning this option on eliminates video refresh artifacts
in the monitored image. (These may appear as "tearing" of the video image.) It affects
playback performance, but only slightly, resulting in a playback penalty of approximately
1 fps.
Grade and Scope Color Controls
The following parameters use miniature color controls that operate identically to those
described in Color Casts Explained.
• Grade Complete color control: The color that's displayed in the Timeline render bar for
rendered shots. The default color is green.
• Grade Queued color control: The color that's displayed in the Timeline render bar for
shots that have been added to the Render Queue, but that are not yet rendered. The
default color is yellow.
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shots that have had their rendering stopped. The default color is red.
• Monochrome Scopes: Turning this option on draws the video scope graticules with a
single color (specified by the Scope Color option, below). Many colorists prefer this
display to avoid eye fatigue. On the other hand, it also eliminates the full-color display
in the Vectorscope. Another option for those wishing to have color feedback in the
scopes is to lower the UI Saturation setting to a less vivid intensity.
• Scope Color: This color control lets you adjust the color that's used to draw the video
scope graticules when Monochrome Scopes is turned on.
Limit Shadow Adjustments and Show Control Surface Controls
These controls are used to limit shadow adjustments and display the Control Surface
Startup dialog.
• Limit Shadow Adjustments: When this option is turned on, a falloff is applied to the
Shadows color and contrast adjustments such that 0 percent values (pure black) receive
100 percent of the correction, while 100 percent values (pure white) receive 0 percent
of the correction. When this option is turned off, adjustments made to the Shadows
color and contrast controls are applied uniformly to the entire image.
• Show Control Surface Dialog: Turning this option on immediately opens the Control
Surface Startup dialog, from which you can choose a Color-compatible control surface
with which to work. While this option is turned on, the Control Surface Startup dialog
appears every time you open Color. If you don't have a control surface, turn this option
off.
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If you're working with a project that uses Cineon or DPX image sequences, you can use
the Color proxy mechanism to work faster with high-resolution media. The proxy
mechanism in Color is not available to projects using QuickTime media, unless you’re
using native RED QuickTime media. RED QuickTime media is capable of generating proxy
data on the fly depending on how the Render Proxy, Grading Proxy, and Playback Proxy
pop-up menus are set.
• Enable Proxy Support: Turning this button on enables the use of lower-resolution
substitute media, called proxies, in place of the source media in your project. Using
proxies increases playback, grading, and rendering performance, although your shots
are displayed at lower quality. If you’re grading DPX or Cineon media, proxies may only
be used once they've been generated; proxies are generated using the same format
as the source media. (For more information on how to generate proxies, see Generating
and Deleting Proxies.)
If you’re grading native RED QuickTime media, you can turn on proxy resolutions at
any time, without the need to generate proxy media; they’re generated on the fly.
Note: In all cases, while resolution may be reduced, proxies are completely
color-accurate.
• Render Proxy pop-up menu: Lets you choose a proxy resolution with which to render
your output media. This can be useful if you want to quickly render a set of media to
test the return trip of a roundtrip workflow. This menu defaults to Half Resolution and,
in most cases, should be left at that setting.
• Grading Proxy pop-up menu: Lets you choose a proxy resolution to use while adjusting
the controls in any of the rooms. This increases the interactivity of the user interface
and the speed with which the image being worked on updates while you adjust different
grading controls. When you finish making an adjustment, the image goes back to its
full resolution.
• Playback Proxy pop-up menu: Lets you choose a proxy resolution to use during playback,
increasing your playback frame rate by lowering the quality of the image. When playback
stops, the image goes back to its full resolution.
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In order to use proxies while working on projects using DPX and Cineon media, you need
to first generate a set of half- and quarter-resolution proxy media for your project.
To generate a set of proxy media for your project
µ Choose File > Proxies > Generate Proxies.
To delete all the proxies that have been generated for a project
µ Choose File > Proxies > Delete Proxies.
Important: The proxy mechanism is not available for projects using QuickTime files, unless
they’re native RED QuickTime media. Native RED QuickTime media uses the proxy
mechanism, but proxies are generated on the fly, so you don’t have to use the Generate
Proxies command.
Playback, Processing, and Output Settings
The following settings affect playback quality, render quality, and performance.
• Video Output pop-up menu: The options in this pop-up menu correspond to the video
output options available to the broadcast video interface that's installed on your
computer. Choose Disabled to turn off video output altogether.
Note: Currently, Digital Cinema Desktop previews and Apple FireWire output are not
available for monitoring the output from Color.
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to be used when you're working with high definition Y′CBCR
source media that you're
monitoring on an external broadcast monitor via a supported broadcast video interface.
It determines how the RGB image data that's calculated internally by Color is converted
to Y′CBCR
image data for display:
• If Force RGB is turned off: This conversion is done by Color in software. This consumes
processor resources and may noticeably reduce your real-time performance as a
result.
• If Force RGB is turned on: Color sends RGB image data straight to the broadcast video
interface that's installed on your computer and relies on the interface to do the
conversion using dedicated hardware. This lightens the processing load on your
computer and is recommended to optimize your real-time performance. When
monitoring legalized video between 0 and 100 IRE, there should be a minimal
difference between the image that's displayed with Force RGB turned on or off. When
Force RGB is turned on, super-white and out-of-gamut chroma values will not be
displayed by your broadcast display, nor will they appear on external video scopes
analyzing your broadcast video interface's output. This limitation only affects
monitoring; the internal image processing performed by Color retains this data. As
a result, you will always see super-white image data on the Color software scopes
when it's present, and uncorrected super-white and out-of-gamut chroma levels are
always preserved when you export your final media. If Broadcast Safe is turned on
in the Project Settings, you may not notice any difference in the display of these
"illegal" levels, since they're being limited by Color.
• Disable Vid-Out During Playback: Turning this option on disables video output via your
broadcast interface during playback. While paused, the frame at the position of the
playhead is still output to video. This is useful if your project is so effects-intensive that
video playback is too slow to be useful. With this option turned on, you can make
adjustments and monitor the image while paused and then get a look at the program
in motion via the preview display, which usually plays faster.
• Update UI During Playback: Turning this option on allows selected windows of the Color
interface to update dynamically as the project plays back. This updates the controls
and scopes during playback from grade to grade, but potentially slows playback
performance, so it's off by default. There are two options:
• Update Primary Display: Updates the main interface controls in the Primary In,
Secondaries, Color FX, Primary Out, and Geometry rooms. Turning this option on lets
you see how the controls change from grade to grade and how they animate if you
have keyframed grades.
• Update Secondary Display: Updates the Scopes window. This is the way to get updated
video scopes during playback. With this option turned off, the video preview still
plays, but the video scopes disappear.
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interpolated from one hue to another.
• Turning this setting on causes keyframed changes in hue to be animated radially,
with the hue cycling through all hues on the color wheel in between the current and
target hues. This results in visible color cycling if you're animating a change from
one hue to any other that's not directly adjacent on the color wheel. This is the
method that Final Cut Pro uses when animating color adjustments in the Color
Corrector and Color Corrector 3-way filters.
• With this setting turned off (the default state), keyframed changes in hue are animated
linearly, directly from one point on the color wheel to another. This results in the
most direct animated adjustments and minimizes unwanted color cycling. This is the
method that the DaVinci and Pogle systems use to animate color adjustments.
Animated Color Control Adjustment
with Radial Interpolation turned on
Animated Color Control Adjustment
with Radial Interpolation turned off
• Internal Pixel Format pop-up menu: The options available in this pop-up menu depend
on the graphics card you have installed in your computer. The option you choose from
this pop-up menu determines the bit depth Color uses for the internal processing of
color, both during real-time playback and when rendering the final output. Bit depth
is expressed as the number of bits per color channel and describes the total number
of values used to display the range of color by every pixel of an image. Higher bit depths
result in a higher-quality image, but are more processor-intensive to play back and
render.
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at a lower bit depth in order to maximize real-time performance. Then, you can switch
to the desired bit depth prior to rendering your final output to maximize image quality.
However, If you graded your program with the Internal Pixel Format pop-up menu set
to 8- through 16-bit, changing it to Floating Point may alter how certain Color FX
operations work. If you intend to work at a lower bit depth but render at Floating Point,
it’s a good idea to double-check all shots with Color FX corrections applied to them
prior to rendering to make sure that they look the way you intended.
• 8-bit: The lowest bit depth at which Color can operate, and the least
processor-intensive.
• 10-bit: The minimum recommended bit depth for projects incorporating secondary
color correction and vignetting, regardless of the source.
• 12-bit: A higher bit depth supported by some video cards.
• 16-bit: An extremely high-quality bit depth. It has been suggested that 16-bit is the
best linear equivalent to 10-bit log when working on images scanned from film.
• Floating Point: The highest level of image-processing quality available in Color, and
recommended if your graphics card doesn’t support 10- through 16-bit image
processing. Refers to the use of floating-point math to store and calculate fractional
data. This means that values higher than 1 can be used to store data that would
otherwise be rounded down using the integer-based 8-bit, 10-bit, 12-bit, and 16-bit
depths. Floating Point is a processor-intensive bit depth to work with, so plan for
longer rendering times. Floating Point is not available on systems with 128 MB or
less of VRAM.
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Aside from providing a qualitative edge when processing high-resolution, high–bit
depth images, setting the Internal Pixel Format to Floating Point changes how image
data is handed off from one room to the next, specifically in the Color FX and Primary
Out rooms.
At 8- through 16-bit, out-of-range image data (luma or chroma going below the Floor
IRE or above the Ceiling IRE of the Broadcast Safe settings, or below 0 and above 110 if
Broadcast Safe is turned off) is clipped as your image goes from one room to another.
Out-of-range image data is also clipped as the image is handed off from one node to
another in the Color FX room.
If you set the Internal Pixel Format to Floating Point, out-of-range image data is still
clipped as it moves from the Primary In room to the Secondaries room, and from the
Secondaries room to the Color FX room. However, starting with the Color FX room,
out-of-range image values are preserved as image data is handed off from node to
node. Furthermore, out-of-range image data is preserved when the image goes from
the Color FX room to the Primary Out room.
Here’s an example of how this works. At 16 bit, if you raise the highlights of an image
beyond 110 percent in the Color FX room, then lower the highlights in the Primary Out
room, your highlights stay clipped.
Original image Still clipped in Primary Out room 
when signal is compressed
Signal clipped in Color FX room
At Floating Point, if you raise the highlights beyond 110 percent, and then lower them
again in the Primary Out room, all of the image data is retrievable.
Original image Highlights and shadows 
preserved in Primary Out room 
when signal is compressed 
Signal clipped in Color FX room
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initially corrected at less than 16-bit, and the same images changed to render at Floating
Point. This is particularly true in the Color FX room.
For more information about bit depth, see How Do Bit Depth and Channel Data
Correspond?
How Do Bit Depth and Channel Data Correspond?
The actual range of values used by each channel for every pixel at a given bit depth is
calculated by taking 2 to the nth power, where n is the bit depth itself. For example, the
range of values used for 8-bit color is 2 to the 8th power, or 256 values per channel. The
range of values for 16-bit color is 2 to the 10th power, or 65536 values per channel.
However, this isn't the whole story. How much of the available numeric range is actually
used depends on how the image data is encoded.
• Full Range: Image data using the RGB color space encodes each color channel using
the full numeric range that's available. This means that 8-bit video color channels use
a value in the range of 0–255 and 10-bit channels use a range of 1–1023.
• Studio Range: 8- and 10-bit video image data that's stored using the Y′CBCR color space
uses a range of values for each channel. This means that a subset of the actual range
of available values is used, in order to leave the headroom for super-black and
super-white that the video standard requires.
For example, the luma of 8-bit Y′CBCR uses the range of 16–236, leaving 1–15 and
235–254 reserved for headroom in the signal. The luma of 10-bit Y′CBCR uses the range
of 64–940, with 4–63 and 941–1019 reserved for headroom.
Furthermore, the lowest and highest values are reserved for non-image data, and the
chroma components (CB and CR
) use a wider range of values (16–240 for 8-bit video,
and 64–960 for 10-bit video).
Auto Save Settings
Two settings let you turn on or off automatic saving in Color.
• Auto-Save Projects: Turning this option on enables automatic saving.
• Auto-Save Time (Minutes): Specifies how many minutes pass before the project is saved
again. This is set to 5 minutes by default.
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project. For more information about creating and recalling archives, see Saving and
Opening Archives.
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an accurate result.
The importance of proper monitoring for color correction cannot be overemphasized.
This chapter covers the monitoring options available in Color, including the configuration
of the Scopes window, options for broadcast video output, the generation and use of
LUTs for calibration and simulation, and how the Still Store is output to video for
monitoring and evaluation.
This chapter covers the following:
• The Scopes Window and Preview Display (p. 149)
• Monitoring Broadcast Video Output (p. 151)
• Using Display LUTs (p. 153)
• Monitoring the Still Store (p. 159)
The Scopes Window and Preview Display
The simplest way to monitor your work in Color is with the Scopes window. This is the
second of the two windows that comprise the Color interface. You can configure Color
to use one or two displays.
Using two displays, the Scopes window is viewed on the second one, occupying its own
display. Using one display, the Scopes window shares the screen with the Color window.
To switch between the Color and Scopes windows
µ Choose Window > Composer (or press Command-Shift-1) to switch to the Color user
interface.
µ Choose Window > Viewer (or press Command-Shift-2) to switch to the Color Scopes
window.
To switch between single and dual display modes
Do one of the following:
µ Choose Window > Single Display Mode or Dual Display Mode.
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6µ Press Command-Shift-0 to switch between both modes.
The Scopes window provides a preview display of the image that you’re working on, and
it can also show either two (in single-display mode) or three (in dual-display mode) video
scopes to aid you in image evaluation. For more information, see Analyzing Signals Using
the Video Scopes.
The preview display shows you either the frame at the current position of the playhead
in the Timeline, as it appears with all the corrections you’ve applied in all rooms (unless
you choose Grade > Disable Grade), or the currently enabled Still Store image. Whichever
image is shown in the preview display is mirrored on the broadcast monitor that’s
connected to the video output of your computer. The preview display is also affected by
LUTs that you import into your Color project.
Note: The only other time the current frame is not displayed is when one of the alternate
secondary display methods is selected in the Previews tab of the Secondaries room. For
more information, see Controls in the Previews Tab.
The preview display in the Scopes window can be switched between full- and
partial-screen modes.
To switch the preview image between full- and quarter-screen
Do one of the following:
µ Control-click or right-click the preview image in the Scopes window, then choose Full
Screen from the shortcut menu.
µ Double-click the image preview in the Scopes window.
All video scopes are hidden while the preview display is in full-screen mode.
Using the Preview Display as Your Evaluation Monitor
Whether or not the preview display in the Scopes window is appropriate to use as your
evaluation monitor depends on a number of factors, the most important of which is
the amount of confidence you have in the quality of your preview display.
Many users opt to use the preview display as an evaluation monitor, especially when
grading scanned film in a 2K workflow, but you need to make sure that you’re using a
monitor capable of displaying the range of contrast and color necessary for maintaining
accuracy to your facility’s standards. Also, success depends on proper monitor calibration,
combined with color profiling and simulation of the eventual film output using LUT
management. (See What Is a LUT? for more information.)
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For the most accurate monitoring of broadcast programs, Color ouputs standard and
high definition video using supported third-party video interfaces. The drivers installed
for the interface you have determine what resolutions, bit depths, and frame rates are
available for outputting to an external monitor.
To turn on external video monitoring
µ Choose an option from the Video Output pop-up menu, in the User Prefs tab of the Setup
room.
To turn off external video monitoring
µ Choose Disabled from the Video Output pop-up menu, in the User Prefs tab of the Setup
room.
For more information about monitoring, see:
• Mixing and Matching Program and Viewing Resolutions
• Bit Depth and Monitoring
• Choose Your Monitor Carefully
• Set Up Your Viewing Environment Carefully
• Calibrate Your Monitor Regularly
• Adjust the Color Interface for Your Monitoring Environment
Mixing and Matching Program and Viewing Resolutions
Ideally, you should monitor your program at its native resolution (in other words, the
resolution of its source media). However, Color will do its best to output the video at
whatever resolution is set in the Video Output pop-up menu of the User Prefs tab. If the
Video Output pop-up menu is set to a different resolution than the currently selected
Resolution Preset, then Color will automatically scale the image up or down as necessary
to fit the image to the display size.
Bit Depth and Monitoring
The working bit depth can have a significant impact on the quality of your monitored
image. The monitored bit depth depends on three factors:
• The bit depth of the source media
• The bit depth selected in the Video Output pop-up menu
• The bit depth selected in the Internal Pixel Format pop-up menu
Chapter 6 Monitoring Your Project 151Other than specifying or choosing the initial shooting or transfer format, the bit depth
of the source media on disk is predetermined (usually 8-bit, 10-bit, or 10-bit log). Since
low bit depths can be prone to banding and other artifacts during the color correction
process (especially when gradients are involved), it’s usually advantageous to process
the video at a higher bit depth than that of the original source media (secondary
corrections and vignettes can especially benefit).
Color will process and output your video at whatever bit depth you select. However, most
broadcast video interfaces max out at 10-bit resolution. For maximum quality while
monitoring, you should set the Internal Pixel Format to the highest bit depth you want
to work at and make sure the Video Output pop-up menu is set to a 10-bit option.
Note: Video noise and film grain often minimize the types of artifacts caused by color
correction operations at low bit depths, so the advantages of working at higher bit depths
are not always obvious to the naked eye.
Monitoring at high bit depths is processor-intensive, however, and can reduce your
real-time performance. For this reason, you also have the option of lowering the bit depth
while you work and then raising it when you’re ready to render the project’s final output.
For more information about the monitoring options available in the User Prefs tab, see
Playback, Processing, and Output Settings.
Choose Your Monitor Carefully
It’s important to choose a monitor that’s appropriate to the critical evaluation of the type
of image you’ll be grading. At the high end of the display spectrum, you can choose from
CRT-based displays, a new generation of flat-panel LCD-based displays, and high-end
video projectors utilizing a variety of technologies.
You should choose carefully based on your budget and needs, but important characteristics
for critical color evaluation include:
• Compatibility with the video formats you’ll be monitoring
• Compatibility with the video signal you’ll be monitoring, such as Y′PBPR
, SDI, HD-SDI,
or HDMI
• Suitable black levels (in other words, solid black doesn’t look like gray)
• A wide contrast range
• Appropriate brightness
• User-selectable color temperature
• Adherence to the Rec. 601 (SD) or 709 (HD) color space standards as appropriate
• Proper gamma (also defined by Rec. 709)
• Controls suitable for professional calibration and adjustment
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for professional work, although they can be valuable for previewing how your program
might look in an average living room.
Set Up Your Viewing Environment Carefully
The environment in which you view your monitor also has a significant impact on your
ability to properly evaluate the image.
• There should be no direct light spilling on the front of your monitor.
• Ambient room lighting should be subdued and indirect, and there should be no direct
light sources within your field of view.
• Ambient room lighting should match the color temperature of your monitor (6500K
in North and South America and Europe, and 9300K in Asia).
• There should be indirect lighting behind the viewing monitor that’s between 10–25%
of the brightness of the installed monitor set to display pure white.
• The ideal viewing distance for a given monitor is approximately five times the vertical
height of its screen.
• The color of the room within your working field of vision should be a neutral gray.
These precautions will help to prevent eye fatigue and inadvertent color biasing while
you work and will also maximize the image quality you’ll perceive on your display.
Calibrate Your Monitor Regularly
Make sure you calibrate your monitor regularly. For maximum precision, some monitors
have integrated probes for automatic calibration. Otherwise, you can use third-party
probes and calibration software to make the same measurements. In a purely broadcast
setting, you can also rely on the standard color bars procedure you are used to.
For more information on adjusting a monitor using color bars, see Calibrating Your
Monitor.
Adjust the Color Interface for Your Monitoring Environment
The Color interface is deliberately darkened in order to reduce the amount of light spill
on your desktop. If you want to subdue the interface even further, the UI Saturation
setting in the User Prefs tab of the Setup room lets you lower the saturation of most of
the controls in the Primary In, Secondaries, and Primary Out rooms, as well as the color
displayed by the video scopes.
Using Display LUTs
Color supports the use of 3D look up tables (LUTs) for calibrating your display to match
an appropriate broadcast standard or to simulate the characteristics of a target output
device (for example, how the image you’re correcting will look when printed to film).
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very different technologies. If you show an identical test image on two different types of
displays—for example, a broadcast display and a video projector—you can guarantee
there will be a variation in color between the two. This variation may not be noticeable
to the average viewer, but as a colorist, you need a predictable viewing environment that
adheres to the standards required for your format, and to make sure that you aren’t driven
crazy by changes being requested as a result of someone’s viewing the program on a
display showing incorrect color.
There is also variation within a single category of device:
• CRT monitors from different manufacturers use different phosphor coatings.
• Digital projectors are available using many types of imaging systems.
• Projected film is output using a variety of printing methods and film stocks.
All these variables inevitably result in significant color variation for any image going from
one viewing environment to another. One solution to this is calibration using LUTs.
What Is a LUT?
Simply put, look up tables (LUTs) are precalculated sets of data that are used to adjust
the color of an image being displayed with the gamut and chromaticity of device A to
match how that image would look using the gamut and chromaticity of device B.
The gamut of a particular device represents the total range of colors that can be displayed
on that device. Some types of displays are capable of displaying a greater range of colors
than others. Furthermore, different video and film standards specify different gamuts of
color, such that colors that are easily represented by one imaging medium are out of
bounds for another. For example, film is capable of representing far more color values
than the broadcast video standard.
154 Chapter 6 Monitoring Your ProjectChromaticity refers to the exact values a display uses to represent each of the three primary
colors. Different displays use different primary values; this can be seen on a chromaticity
diagram that plots the three primaries as points against a two-dimensional graph
representing hue and saturation within the visible spectrum. Since all colors represented
by a particular display are a mix of the three primaries, if the three primary points vary
from display to display, the entire gamut of color will shift.
While the chromaticity diagram shown above is useful for comparing displays on paper,
to truly represent the hue (color), saturation (intensity of color), and lightness (luminance
from black to white) that defines a complete gamut, you need to use a 3D color space.
When extruded into 3D space, the gamut and chromaticity of different devices create
different shapes. For example, the standard RGB color space can be represented with a
simple cube (as seen in the ColorSync Utility application):
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represent each color. The black corner is (0,0,0), the opposing white corner is (1,1,1), the
blue corner is (0,0,1), the red corner is (1,0,0), and so forth. The RGB color cube is an
idealized abstraction, however. Actual display devices appear with much different shapes,
defined by their individual gamut and chromaticity.
To accurately transform one device’s gamut to match that of another involves literally
projecting its gamut into a 3D representation and then mathematically changing its shape
to match that of the other device or standard. This process is referred to as characterizing
a device and is the standard method used by the color management industry. Once
calculated, the method of transformation is stored as a 3D LUT file.
Once a device has been characterized and the necessary LUT has been calculated, the
hard computational work is done, and the LUT can be used within Color to modify the
output image without any significant impact on real-time performance.
When Do You Need a LUT?
The following examples illustrate situations in which you should consider using LUTs:
• If you’re matching multiple displays in a facility: LUTs can be useful for calibrating multiple
displays to match a common visual standard, ensuring that a program doesn’t look
different when you move it to another room.
• If you’re displaying SD or HD video on a nonbroadcast monitor: You can use a LUT to
emulate the Rec. 601 (SD) or 709 (HD) color space and gamma setting that’s appropriate
to the standard of video you’re viewing.
• If you’re displaying video or film images using a video projector: You can use a LUT to
calibrate your device to match, as closely as possible, the gamut of the broadcast or
film standard you’re working to.
• If you’re grading images destined to be printed to film: You can use a LUT to profile the
characteristics of the film printing device and film stock with which you’ll be outputting
the final prints, in order to approximate the look of the final projected image while you
work.
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to improve muddy blacks, an inherently low contrast range, or a too-narrow gamut.
When Don’t You Need a LUT?
If you’re color correcting video and monitoring using a properly calibrated broadcast
display that’s compatible with the standard of video that you’re displaying, it’s not
generally necessary to use a LUT.
Generating LUTs
There are several ways you can generate a LUT.
Create One Yourself Using Third-Party Software
There are third-party applications that work in conjunction with hardware monitor probes
to analyze the characteristics of individual displays and then generate a LUT in order to
provide the most accurate color fidelity possible. Because monitor settings and
characteristics drift over time, it’s standard practice to periodically recalibrate displays
every one to two weeks.
If you’re creating a LUT to bring another type of display into line with broadcast standards
(such as a digital projector), you’ll then use additional software to modify the calibration
LUT to match the target display characteristics you require.
Have One Created for You
At the high end of digital intermediate for film workflows, you can work with the lab that
will be doing the film print and the company that makes your monitor calibration software
to create custom LUTs based on profiles of the specific film recorders and film stocks that
you’re using for your project.
This process typically involves printing a test image to film at the lab and then analyzing
the resulting image to generate a target LUT that, together with your display’s calibration
LUT (derived using a monitor probe and software on your system), is used to generate a
third LUT, which is the one that’s used by Color for monitoring your program as you work.
Creating LUTs in Color
In a pinch, you can match two monitors by eye using the controls of the Primary In room
and generating a LUT to emulate your match directly out of Color.
You can also export a grade as a “look” LUT to see how a particular correction will affect
a digitally recorded image while it’s being shot. To do this, the crew must be using a field
monitor capable of loading LUTs in the .mga format.
To create your own LUT
1 Arrange your Color preview display and the target monitor so that both can be seen at
the same time.
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3 Display the same image on the target display using a second reliable video source.
4 Open the Primary In room and adjust the controls appropriate to make the two images
match.
5 Choose File > Export > Display LUT.
6 When the Save LUT As dialog appears, enter a name for that LUT into the File field, choose
a location to save the file, and click Save.
By default, LUTs are saved to the /Users/username/Library/Application Support/Color/LUTs
directory.
Important: If your project is already using a LUT when you export a new one, the currently
loaded LUT is concatenated with your adjustments, and the combination is exported as
the new LUT.
Using LUTs
All LUTs used and generated by Color are 3D LUTs. Color uses the .mga LUT format
(originally developed by Pandora), which is compatible with software by Rising Sun
Research, Kodak, and others. If necessary, there are also applications available to convert
LUTs from one format into another.
LUTs don’t impact processing performance at all.
To use a LUT
1 Choose File > Import > Display LUT.
2 Select a LUT file using the Load LUT dialog, then click Load.
Note: By default, LUTs are saved to the /Users/username/Library/Application
Support/Color/LUTs directory.
The LUT immediately takes effect, modifying the image as it appears on the preview and
broadcast displays. LUTs that you load are saved in a project’s settings until you specifically
clear the LUT from that project.
To stop using a LUT
µ Choose File > Clear Display LUT.
To share a LUT with other Color users, you must provide them with a copy of the LUT file.
For ease of use, it’s best to place all LUT files into the /Users/username/Library/Application
Support/Color/LUTs directory.
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The Still Store lets you save and recall images from different parts of your project that
you can use to compare to shots you’re working on. The Still Store is basically an image
buffer that lets you go back and forth between the currently loaded Still Store image and
the current image at the position of the playhead. You have options for toggling between
the full image and a customizable split-screen view that lets you see both images at once.
When you enable the Still Store, the full-screen or split-screen image is sent to both the
preview and broadcast displays. To go back to viewing the frame at the position of the
playhead by itself, you need to disable the Still Store.
Enabled Still Store images are analyzed by the video scopes, and they are affected by
LUTs. For more information on using the Still Store, see The Still Store.
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shots to grade, and limited editing.
The Timeline and the Shots browser (in the Setup room) both provide ways of viewing
the shots in your project. The Shots browser gives you a way to nonlinearly sort and
organize your shots, while the Timeline provides a sequential display of the shots in your
program arranged in time. In this chapter, you’ll learn how to use the Timeline to navigate
and play through the shots in your program, as well as how to perform simple edits.
This chapter covers the following:
• Basic Timeline Elements (p. 162)
• Customizing the Timeline Interface (p. 163)
• Working with Tracks (p. 165)
• Selecting the Current Shot (p. 166)
• Timeline Playback (p. 166)
• Zooming In and Out of the Timeline (p. 169)
• Timeline Navigation (p. 170)
• Selecting Shots in the Timeline (p. 171)
• Working with Grades in the Timeline (p. 172)
• The Settings 1 Tab (p. 174)
• The Settings 2 Tab (p. 175)
• Editing Controls and Procedures (p. 176)
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Timeline Playback, Navigation, and
Editing 7Basic Timeline Elements
The Timeline is divided into a number of tracks that contain the shots, grades, and
keyframes used by your program.
• Render bar: The render bars above the Timeline ruler show whether or not a shot is
unrendered (red), or has been rendered (green).
• Timeline ruler: Shows a time scale for the Timeline. Dragging within the Timeline ruler
lets you move the playhead, scrubbing through the program.
• Playhead: Shows the position of the currently displayed frame in the Timeline. The
position of the playhead also determines the current shot that’s being worked on.
• Video tracks and shots: Each shot in the program is represented within one of the video
tracks directly underneath the Timeline ruler. Color only allows you to create up to five
video tracks when you’re assembling a project from scratch, but will accommodate
however many superimposed video tracks there are in imported projects.
Note: Color does not currently support compositing operations. During playback,
superimposed clips take visual precedence over clips in lower tracks.
• Track resize handles: The tracks can be made taller or shorter by dragging their resize
handles up or down.
• Lock icon: The lock icon shows whether or not a track has been locked.
• Grades tracks: Color allows you to switch among up to four primary grades applied to
each shot. This option lets you quickly preview different looks applied to the same shot,
without losing your previous work. Each grade is labeled Grade 1–4.
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Primary Out corrections. By default, each grade appears with a single primary grade
bar, but additional correction bars appear at the bottom if you’ve made adjustments
to any of the other rooms for that grade. Each correction bar has a different color.
• P(rimary) bar: Shows whether a primary correction has been applied.
• S(econdary) bar: Shows whether one or more secondary corrections have been
applied.
• CFX (color FX) bar: Shows whether a Color FX correction has been applied.
• PO (primary out) bar: Shows whether a Primary Out correction has been applied.
• Tracker area: If you add a motion tracker to a shot and process it, the tracker’s In and
Out points appear in this area, with a green bar showing how much of the currently
selected tracker has been processed. If no tracker is selected in the Tracking tab of the
Geometry room, nothing appears in this area. For more information, see The Tracking
Tab.
• Keyframe graph: This track contains both the keyframes and the curves that interpolate
the change from one keyframe’s value to another. For more information about
keyframing corrections and effects, see Keyframing.
Customizing the Timeline Interface
There are a number of ways you can customize the visual interface of the Timeline. See
the following sections for specifics:
• Customizing Unit and Information Display
• Resizing Tracks in the Timeline
Customizing Unit and Information Display
The following options in the User Prefs tab of the Setup room let you change how shots
are shown in the Timeline.
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Do one of the following:
µ Click the Setup room tab, then click the User Prefs tab and click the Frames, Seconds,
Minutes, or Hours button corresponding to the units you want to use.
µ Press one of the following keys:
• Press F to change the display to frames.
• Press S to change the display to seconds.
• Press M to change the display to minutes.
• Press H to change the display to hours.
To customize the way shots are displayed in the Timeline
µ Click the Setup room tab, then click the User Prefs tab. Turn on or off individual shot
appearance settings to suit your needs.
Three settings in the User Prefs tab of the Setup room let you customize the way shots
appear in the Timeline.
• Show Shot Name: Turning this on displays each shot’s name in the Timeline.
• Show Shot Number: Turning this on displays each shot’s number in the Timeline.
• Show Shot Thumbnail: With this setting turned on, single frame thumbnails appear
within every shot in the Timeline.
Resizing Tracks in the Timeline
You can also resize the tracks in the Timeline, making them taller or shorter, as you prefer.
Video tracks, the grades track, and the keyframe graph are all resized individually.
To resize all video tracks, the grades track, or the keyframe graph
µ Drag the center handle of the gray bar at the bottom of any track in the Timeline until
all tracks are the desired height.
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µ Hold down the Shift key, then drag the center handle of the gray bar at the bottom of
the track you want to resize until it’s the desired height.
Note: The next time you resize all video tracks together, individually resized tracks snap
to match the newly adjusted track size.
Working with Tracks
This section describes different ways you can change the state of tracks in the Timeline
as you work.
Note: The tracks of imported XML projects are automatically locked. For the best roundtrip
results, these tracks should not be unlocked.
To lock or unlock a track
µ Control-click or right-click anywhere within a track, then choose one of the following
from the shortcut menu:
• Lock Track: Locks all the shots so that they can’t be moved or edited.
• Unlock Track: Allows shots to be moved and edited.
Note: You can also lock the grades track in the Timeline using the same methods.
To hide or show a track
µ Control-click or right-click anywhere within a track, then choose one of the following:
• Hide Track: Disables a track such that superimposed shots are neither visible nor
selectable when the playhead passes over them.
• Show Track: Makes a track visible again. Superimposed shots take precedence over
shots on lower tracks and are selected by default whenever that track is visible.
Tip: Prior to exporting a project from Final Cut Pro, you can export a self-contained
QuickTime movie of the entire program and superimpose it over the other clips in your
edited sequence. Then, when you export the project to Color, you can turn this “reference”
version of the program on and off using track visibility whenever you want to have a look
at effects or color corrections that were created during the offline edit.
To add a track
µ Control-click or right-click anywhere within a track, then choose New Track from the
shortcut menu.
To remove a track
µ Control-click or right-click anywhere within a track, then choose Remove Track from the
shortcut menu.
Note: You cannot remove the bottom track.
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Whichever shot you move the playhead to becomes the current shot. The current shot is
the one that’s adjusted whenever you manipulate any of the controls in the Primary In,
Secondary, Color FX, Primary Out, or Geometry room. There can only be one current shot
at a time. It’s the only one that’s highlighted in light gray.
As you move the playhead through the Timeline, the controls and parameters of all rooms
automatically update to match the grade of the current shot at the position of the
playhead.
If there is more than one shot stacked in multiple video tracks at any point in the Timeline,
the topmost shot becomes the current shot except in the following two cases:
• Shots on hidden tracks cannot become the current shot. If there’s a superimposed shot
that doesn’t let you expose the settings of a shot underneath, you can hide the
superimposed track.
• Offline shots are invisible, and any shots appearing underneath in the Timeline
automatically have their settings exposed in the Color interface.
To make a shot in the Timeline the current shot
Do one of the following:
µ Double-click any shot in the Timeline.
µ Move the playhead to a new shot.
Note: When you double-click a shot, the Timeline moves so that the shot is centered in
the Timeline, and it becomes the current shot.
Timeline Playback
In general, the purpose of playback in Color is to preview how your various corrections
look when the shot you’re working on is in motion or how the grades that are variously
applied to a group of clips look when they’re played together. For this reason, playback
works somewhat differently than in applications like Final Cut Pro.
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the Out point. If the playhead is already within this area, then playback begins at the
current position of the playhead, and ends at the Out point. If the playhead happens to
be outside of this area, it automatically jumps to the In point when you next initiate
playback. This makes it faster to loop the playback of a specific shot or scene in the
Timeline, which is a common operation during color correction sessions. For more
information, see:
• Starting and Stopping Playback
• Switching the Playback Mode
• Loop Playback
• Maintain Framerate
Starting and Stopping Playback
The following controls let you play and stop your program.
Important: When you start playback, you enter a mode in which you’re unable to work
with the Color controls until you stop playback.
To play the program
Do one of the following:
µ Press the Space bar.
µ Press J to play backward, or L to play forward.
µ Click the Play Forward or Play Backward button.
To stop the program
Do one of the following:
µ Press the Space bar while the program is playing.
µ Press Escape.
µ Press K.
Color and JKL
Color has a partial implementation of the JKL playback controls found in other editing
applications. However, the finer points of JKL, such as slow-motion and frame-by-frame
playback, are not implemented.
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The playback mode lets you choose whether the In and Out points are automatically
changed to match the duration of the current shot whenever you move the playhead or
whether they remain set to a larger portion of your program.
Shot Mode
Shot mode is the default playback method. Whenever the playhead moves to a new shot,
the Timeline In and Out points are automatically changed to match that shot’s Project In
and Project Out points. As a result, playback is constrained to just that shot. If Loop
Playback is turned on, the playhead will loop repeatedly over the current shot until
playback is stopped.
Note: You can still click other shots in the Timeline to select them, but the In and Out
points don’t change until the playhead is moved to intersect another shot.
Movie Mode
When you first enter movie mode, the Timeline In point is set to the first frame of the
first shot in the Timeline, and the Out point is set to the last frame of the last shot. This
allows you to play through as many shots as you like, previewing whole scenes of your
project. While in movie mode, you can also set your own In and Out points wherever you
want, and they won’t update when you move the playhead to another shot.
Placing Your Own In and Out Points
Regardless of what playback mode you’ve chosen, you can always manually set new In
and Out points wherever you want to. When you set your own In and Out points, the
playback mode changes to movie mode automatically.
To switch the playback mode
Do one of the following:
µ Choose Timeline > Toggle Playback Mode.
µ Press Shift-Control-M.
To customize the playback duration
1 Move the playhead to the desired In point, then press I.
2 Move the playhead to the desired Out point, then press O.
Loop Playback
If Loop Playback is turned on, the playhead jumps back to the In point whenever it reaches
the Out point during playback.
To turn on loop playback
1 Click the Setup room tab, then click the User Prefs tab.
2 Click the Loop Playback button to turn it on.
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The Maintain Framerate setting in the User Prefs tab of the Setup room determines
whether or not frames are dropped in order to maintain the project’s frame rate during
playback.
• If Maintain Framerate is turned on (the default): The current frame rate is maintained no
matter what the current processing workload is. If the currently playing grade is
processor-intensive, then frames will be dropped during playback to maintain the
project’s frame rate. If not, playback occurs in real time.
• If Maintain Framerate is turned off: Every frame is always played back. If the currently
playing grade is processor-intensive, playback will slow in order to avoid dropping
frames. If not, playback may actually occur at faster than real time.
Zooming In and Out of the Timeline
The following controls let you zoom in and out of your program in the Timeline, changing
how many shots are visible at once.
How far you can zoom in to the Timeline depends on what units the Timeline ruler is set
to display. The larger the units the Timeline is set to display, the farther you can zoom
out. For example, in order to view more shots in the Timeline simultaneously, you can
zoom out farther when the Timeline ruler is set to Minutes than when it’s set to Frames.
Note: Zooming using the mouse allows you to zoom in or out as far as you want to go;
the Timeline ruler’s units change automatically as you zoom.
To zoom in to and out of the Timeline
1 Move the playhead to a position in the Timeline where you want to center the zooming
operation.
2 With the pointer positioned within the Timeline, do one of the following:
• Choose Timeline > Zoom In, or press Minus Sign (–) to zoom in.
• Choose Timeline > Zoom Out, or press Equal Sign (=) to zoom out.
Note: You can also use the Plus Sign (+) and Minus Sign (–) keys in the numeric keypad
to zoom in to or out of the Timeline.
To zoom in to and out of the Timeline using the mouse
µ Right-click in the Timeline ruler, then drag right to zoom in, or left to zoom out.
To fit every shot of your program into the available width of the Timeline
µ Press Shift-Z.
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The following procedures let you navigate around your program in the Timeline, scrolling
through it, and moving the playhead from shot to shot.
To move the playhead from shot to shot
Do one of the following:
µ Drag within the Timeline ruler to scrub the playhead from shot to shot.
µ Press Up Arrow to move to the first frame of the next shot to the left.
µ Press Down Arrow to move to the first frame of the next shot to the right.
µ Click the Next Shot or Previous Shot buttons.
To move from frame to frame
Do one of the following:
µ Press Left Arrow to go to the previous frame.
µ Press Right Arrow to go to the next frame.
To go to the first or last frame of your project
µ Press Home to go to the first frame.
µ Press End to go to the last frame.
To go to the current In or Out point
µ Press Shift-I to go to the In point.
µ Press Shift-O to go to the Out point.
When there are more tracks than can be displayed within the Timeline at once, small
white arrows appear either at the top, the bottom, or both, to indicate that there are
hidden tracks in the direction that’s indicated.
When this happens, you can scroll vertically in the Timeline using the middle mouse
button.
To scroll around the Timeline horizontally or vertically without moving the playhead
Do one of the following:
µ Middle-click and drag the contents of the Timeline left, right, up, or down.
µ To scroll more quickly, hold down the Option key while middle-clicking and dragging.
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There are certain operations, such as copying primary corrections, that you can perform
on selected groups of shots. Color provides standard methods of selecting one or more
shots in the Timeline.
Note: You can also select shots using the Shots browser. For more information, see Using
the Shots Browser.
To select a shot in the Timeline
µ Click any shot.
Selected shots appear with a cyan highlight in the Timeline.
To select a contiguous number of shots
1 Click the first of a range of shots you want to select.
2 Shift-click another shot at the end of the range of shots.
All shots in between the first and second shots you selected are also selected.
To select a noncontiguous number of shots
µ Command-click any number of shots in the Timeline.
Note: Command-clicking a selected shot deselects it.
To select all shots in the Timeline
µ Choose Edit > Select All (or press Command-A).
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Do one of the following:
µ Choose Edit > Deselect All (or press Command-Shift-A).
µ Select a previously unselected shot to clear the current selection.
µ Click in an empty area of the Timeline.
Important: If the current shot at the position of the playhead is not selected, it will not
be automatically included in the selection when you apply saved corrections or grades
from a bin.
Working with Grades in the Timeline
Each shot in the Timeline can be switched among up to four different grades, shown in
the grades track.
These four grades let you store different looks for the same shot. For example, if you’ve
created a satisfactory grade, but you or your client would like to try “one other thing,”
you can experiment with up to three different looks, knowing that you can instantly recall
the original, if that’s what’s ultimately preferred.
Only one grade actually affects a shot at a time—whichever grade is selected in the
Timeline is the grade you will see on your preview and broadcast displays. All unselected
grades are disabled. For more information on creating and managing grades, see Managing
Corrections and Grades.
By default, each shot in a new project starts off with a single empty grade, but you can
add another one at any time.
To add a new grade to a shot
Do one of the following:
µ Move the playhead to the shot you want to add a new grade to, then press Control-1
through Control-4.
µ Control-click or right-click the grade you want to switch to, then choose Add New Grade
from the shortcut menu.
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one will be created. Whenever a new grade is added, the grades track expands, and the
new grade becomes the selected grade. New grades are clean slates, letting you begin
working from the original state of the uncorrected shot.
To select the current grade
1 Move the playhead to the shot you want to switch the grade of.
2 Do one of the following:
• Click the grade you want to switch to.
• Press Control-1 through Control-4.
• Control-click or right-click the grade you want to switch to, then choose Select Grade
[x] from the shortcut menu, where x is the number of the grade you’re selecting.
That shot in the Timeline is updated with the newly selected grade.
To reset a grade in the Timeline
1 Move the playhead to the shot you want to switch the grade of.
2 Control-click or right-click the grade you want to reset to in the grades track of the
Timeline, then choose Reset Grade [x] from the shortcut menu, where x is the number of
the grade.
When you reset a grade, every room associated with that grade is reset, including the
Primary In, Secondary, Color FX, and Primary Out rooms. The Geometry room is unaffected.
For more information, see Managing Corrections and Grades.
To delete a grade in the Timeline
1 Move the playhead to the shot you want to remove the grade from.
2 Control-click or right-click the grade you want to reset to in the grades track of the
Timeline, then choose Remove Grade [x] from the shortcut menu, where x is the number
of the grade.
Note: If the grades track is locked, you cannot delete grades.
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The timing properties listed in the Settings 1 tab are not editable. Instead, they reflect
each shot’s position in the Timeline and the properties of the source media that each
shot is linked to.
• Project In and Project Out: Defines the location of the shot in the Timeline.
• Trim In and Trim Out: Defines the portion of source media that’s actually used in the
project, relative to the total available duration of the source media file on disk. The
Trim In and Trim Out timecodes cannot be outside the range of Source In and Source
Out parameters.
• Source In and Source Out: Defines the start and end points of the original source media
on disk. If Trim In is equal to Source In and Trim Out is equal to Source Out, there are
no unused handles available in the source media on disk—you are using all available
media.
• Frame Rate pop-up menu: This pop-up menu lets you set the frame rate of each clip
individually. This setting overrides the Frame Rate setting in the Project Settings tab.
For most projects using source media in the QuickTime format, this should be left at
the default settings. For projects using DPX image sequences as the source media, this
pop-up menu lets you change an incorrect frame rate in the DPX header data.
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The Settings 2 tab contains additional settings that let you modify the header data of
DPX and Cineon image files.
• Override Header Settings: Selecting this button enables the Printing Density pop-up
menu to be manually changed, so that you can override the printing density settings
in the DPX header for the current shot.
• Printing Density pop-up menu: This pop-up menu is initially disabled, displaying the
numeric range of values that 0 percent black and 100 percent white are mapped to in
the source media. There are three options:
• Film (95 Black - 685 White : Logarithmic)
• Video (65 Black - 940 White : Linear)
• Linear (0 Black - 1023 White)
If you’re working with logarithmic DPX and Cineon film scans, the default black point
is typically 95, and the default white point is typically 685. When you first load a project
that uses scanned film media, it’s important to make sure that the Black Point and
White Point settings aren’t filled with spurious data. Check with your lab to verify the
appropriate settings, and if the settings in your source media don’t match, turn on
Override Header Settings, and then choose a new printing density from this pop-up
menu. For more information, see Choosing Printing Density When Rendering DPX
Media.
• DeInterlace: Selecting this button lets you individually deinterlace clips. This setting
overrides the Deinterlace Renders and Deinterlace Previews settings in the Project
Settings tab. When DeInterlace is turned on, both video fields are averaged together
to create a single frame.
• Copy To All: Copies the current header settings to every single shot in the Timeline.
This is useful if you find that the header data for all of the film scan media your program
uses is incorrect. Use this with extreme caution.
• Copy To Selected: Copies the current header settings to all currently selected shots in
the Timeline. Useful if your project consists of a variety of scanned media from different
sources with different header values.
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Color is not intended to be an editing environment, and as a result its editing tool set
isn’t as complete as that of an application like Final Cut Pro. In fact, most of the time you
want to be careful not to make any editorial changes at all to your project in Color, for a
variety of reasons:
• If you unlock the tracks of projects that were imported via XML or sent from Final Cut Pro
and that will be returning to Final Cut Pro, you risk disrupting the project data, which
will prevent you from successfully sending the project back to Final Cut Pro.
• If you make edits to a project that was sent from Final Cut Pro, you’ll only be able to
send a simplified version of that project back to Final Cut Pro which contains only the
shots and transitions in track V1, and the Pan & Scan settings in the Geometry room.
• If you import an EDL and make edits, you can export an EDL from Color that incorporates
your changes; however, that EDL will only contain the shots and transitions in track V1.
• If the project you’ve imported is synchronized to an audio mix, making any editorial
changes risks breaking the audio sync.
However, if you’re working on a project where these issues aren’t important, you can use
editing tools and commands in Color to edit shots in unlocked tracks in the Timeline.
Tip: If you need to make an editorial change, you can always reedit the original sequence
in Final Cut Pro, export a new XML file, and use the Reconform command to update the
Color Timeline to match the changes you made.
Select Tool
The Select tool is the default state of the pointer in Color. As the name implies, this tool
lets you select shots in the Timeline, move them to another position in the edit, or delete
them.
It’s a good idea to reselect the Select tool immediately after making edits with any of the
other tools, to make sure you don’t inadvertently continue making alterations in the
Timeline that you don’t intend.
To reposition a shot in the Timeline
µ Drag the shot to another position in the Timeline.
When you move a shot in the Timeline, where it ends depends on the In point’s relation
to shots that are already there. Shots you move in Color never overwrite other shots.
Instead, the other shots in the Timeline are moved out of the way to make way for the
incoming shot, and the program is rippled as a result.
• If the In point of the moved shot overlaps the first half of another shot, nothing is
changed.
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you’re moving will be insert edited, and all other shots in the Timeline will be rippled
to the right to make room.
• If you’re moving a shot into an area of the Timeline where it doesn’t overlap with any
other shot, it’s simply moved to that area of the Timeline without rippling any other
shots.
To delete a shot in the Timeline
1 Select one or more shots in the Timeline.
2 Do one of the following:
• Press Delete.
• Press Forward Delete.
The result is a lift edit, which leaves a gap in the Timeline where that shot used to be. No
other shots move as a result of deleting a shot.
Roll Tool
The Roll tool lets you adjust the Out point and In point of two adjacent shots
simultaneously. If you like where two shots are placed in the Timeline, but you want to
change the cut point, you can use the Roll tool. No shots move in the Timeline as a result;
only the edit point between the two shots moves. This is a two-sided edit, meaning that
two shots’ edit points are affected simultaneously; the first shot’s Out point and the next
shot’s In point are both adjusted by a roll edit. However, no other shots in the sequence
are affected.
Note: When you perform a roll edit, the overall duration of the sequence stays the same,
but both shots change duration. One gets longer while the other gets shorter to
compensate. This means that you don’t have to worry about causing sync problems
between linked shot items on different tracks.
A B C
A B C
Before edit
After edit
In the example above, shot B gets shorter while shot C becomes longer, but the combined
duration of the two shots stays the same.
To perform a roll edit
1 Do one of the following to choose the Roll edit tool:
• Choose Timeline > Roll Tool.
• Press Control-R.
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it either left or right to make the edit.
The Timeline updates to reflect the edit you’re making.
Ripple Tool
A ripple edit adjusts a shot’s In or Out point, making that shot longer or shorter, without
leaving a gap in the Timeline. The change in duration of the shot you adjusted ripples
through the rest of the program in the Timeline, moving all shots that are to the right of
the one you adjusted either earlier or later in the Timeline.
A ripple edit is a one-sided edit, meaning that you can only use it to adjust the In or Out
point of a single shot. All shots following the one you’ve adjusted are moved—to the left
if you’ve shortened it or to the right if you’ve lengthened it. This is a significant operation
that can potentially affect the timing of your entire program.
A B C
A B C
Before edit
After edit
Important: Ripple edits can be dangerous if you are trying to maintain sync between
your program in Color and the original audio in the Final Cut Pro sequence or source EDL
that is being mixed somewhere else entirely, since the shots in your Color project may
move forward or backward while the externally synced audio doesn’t.
To perform a ripple edit
1 Do one of the following to choose the Ripple edit tool:
• Choose Timeline > Ripple Tool.
• Press Control-T.
2 Move the pointer to the In or Out point of the shot you want to shorten or lengthen, then
drag it either left or right to make the edit.
The Timeline updates to reflect the edit you’re making, with all the shots following the
one you’re adjusting moving to the left or right to accommodate the change in timing.
Slip Tool
Performing a slip edit doesn’t change a shot’s position or duration in the Timeline; instead
it changes what portion of that shot’s media appears in the Timeline by letting you change
its In and Out points simultaneously.
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position in the Timeline stays the same. No other shots in the Timeline are affected by a
slip edit, and the overall duration of the project remains unaffected.
A B C
A B C
Before edit
00:00:10:00 00:00:30:00
00:00:17:00 00:00:37:00
After edit
In the example above, the slip edit changes the In and Out points of shot B, but not its
duration or position in the sequence. When the sequence plays back, a different portion
of shot B’s media will be shown.
To perform a slip edit
1 Move the playhead to the shot you want to adjust, in order to be able to view the change
you’re making as you work.
2 Do one of the following to choose the Slip edit tool:
• Choose Timeline > Slip Tool.
• Press Control-Y.
3 Move the pointer to the shot you want to slip, then drag it either left or right to make
the edit.
Unlike Final Cut Pro, Color provides no visual feedback showing the frames of the new
In and Out points you’re choosing with this tool. The only image that’s displayed is the
frame at the current position of the playhead being updated as you drag the shot back
and forth. This is why it’s a good idea to move the playhead to the shot you’re adjusting
before you start making a slip edit.
Split Tool
The Split tool lets you add an edit point to a shot by cutting it into two pieces. This edit
point is added at the frame you click in the Timeline. This can be useful for deleting a
section of a shot or for applying an effect to a specific part of a shot.
To split one shot into two
1 Do one of the following to choose the Split tool:
• Choose Timeline > Split Tool.
• Press Control-X.
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white line intersecting the shots in the Timeline), drag it to the frame of the shot where
you want to add an edit point.
3 Click to add an edit point.
The Timeline updates to reflect the edit you’ve made, with a new edit point appearing
at the frame you clicked.
Splice Tool
Whenever you cut a shot with the Split tool, the original shot is split into two shots
separated by a through edit. There is no visual indication of through edits in the Color
Timeline, but any edit point that splits an otherwise contiguous range of frames is
considered to be a through edit, which can be joined back together with the Splice tool.
Joining two shots separated by a through edit merges them back into a single shot. You
cannot join two shots that aren’t separated by a through edit; if you try you’ll simply get
a warning message.
Important: When you splice two shots that have different grades and corrections, the
grades and corrections of the shot to the left overwrite those of the shot to the right.
To splice two shots into one
1 Do one of the following to choose the Splice tool:
• Choose Timeline > Splice Tool.
• Press Control-Z.
2 Move the pointer to the Timeline ruler, and when the splice overlay appears (a vertical
white line intersecting the shots in the Timeline), drag it to the edit point you want to
splice.
3 Click to splice that edit point.
The Timeline updates to reflect the edit you’ve made, and the two shots that were
previously separated by a through edit are spliced into one.
Create an Edit Command
The Create an Edit command in the Timeline menu (Control-V) is similar to the Split tool.
It cuts a single shot in the Timeline into two at the current position of the playhead. Using
this command eliminates the need to choose a tool.
To create an edit point
1 Move the playhead to the frame where you want to add an edit point.
2 Do one of the following:
• Choose Timeline > Create an Edit.
• Press Control-V.
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at the position of the playhead.
Merge Edits Command
The Merge Edits command (Control-B) is similar to the Splice tool. It joins two shots
separated by a through edit at the current position of the playhead into a single shot.
Using this command eliminates the need to choose a tool.
To merge two shots into one at a through edit point
1 Move the playhead to the frame at the through edit you want to merge.
2 Do one of the following:
• Choose Timeline > Merge Edits.
• Press Control-B.
The Timeline updates to reflect the edit you’ve made, and the two shots that were
previously separated by a through edit are merged into one.
Important: When you splice two shots that have different grades and corrections, the
grades and corrections of the shot to the left overwrite those of the shot to the right.
Snapping
When snapping is on, clips “snap to” the 00:00:00:00 time value in the Timeline.
To turn snapping on or off
µ Choose Timeline > Snapping.
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way to quantitatively evaluate and compare images.
Color provides most of the video scope displays that you’d find in other online video and
color correction suites and includes a few that are unique to software-based image
analysis. Together, these scopes provide graphic measurements of the luma, chroma,
and RGB levels of the image currently being monitored, helping you to unambiguously
evaluate the qualities that differentiate one shot from another. This feature lets you make
more informed decisions while legalizing or comparing shots in Color.
This chapter covers the following:
• What Scopes Are Available? (p. 183)
• Video Scope Options (p. 185)
• Analyzing Images Using the Video Scopes (p. 187)
What Scopes Are Available?
The following video scopes are available in the Scopes window:
• The Waveform Monitor
• The Parade Scope
• The Overlay Scope
• The Red/Green/Blue Channels Scopes
• The Luma Scope
• The Chroma Scope
• The Y′CBCR Scope
• The Vectorscope
• The Histogram
• The RGB Histogram
• The R, G, and B Histograms
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Scopes 8• The Luma Histogram
• The 3D Scope
• The RGB Color Space
• The HSL Color Space
• The Y′CBCR Color Space
• The IPT Color Space
The location where the video scopes appear depends on whether Color is configured to
single- or dual-display mode:
• In single-display mode: Two video scopes are displayed underneath the video preview
in the Scopes window, which is positioned to the left of the Color interface window.
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addition to the video preview.
The Accuracy of Color Video Scopes
To create a real-time analysis of the video signal (even during adjustment and playback),
Color downsamples the current image to a resolution of 384 x 192. The downsampled
image is then analyzed and the resulting data displayed by the currently selected scopes.
This same downsampled resolution is used regardless of the original resolution of the
source media.
Using this method, every pixel contributes to the final analysis of the image. In tests,
the graphs produced by the Color video scopes closely match those produced by
dedicated video scopes and are extremely useful as an aid to evaluating and matching
shots while you work in Color. However, you should be aware that the Color analysis is
still an approximation of the total data. Dedicated video scopes are still valuable for
critical evaluation.
Note: If you’re concerned about catching stray out-of-gamut pixels while you make
adjustments for QC purposes, you can turn on the Broadcast Safe settings to protect
yourself from QC violations. For more information, see Broadcast Safe Settings.
Video Scope Options
You can modify the display and behavior of the video scopes in a number of ways.
To turn on real-time video scope updates
1 Open the User Prefs tab located inside the Setup room.
2 Select Update UI During Playback.
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Tip: You can turn off Update Primary Display to improve playback performance.
Some scopes can be switched among different modes.
To change a scope to a different mode
µ Click the button corresponding to the mode you want at the top of that scope.
Any quadrant containing a video scope can also be switched to a different kind of scope.
To switch the layout of the Scopes window
Do one of the following:
µ Control-click or right-click within any scope, then choose a different scope from the
shortcut menu.
µ Move the pointer within any region of the Scopes window, and press W (Waveform), V
(Vectorscope), H (Histogram), or C (3D scopes) to change scopes.
You can zoom in to all scopes to get a closer look at the graph.
To zoom a scope’s display
Do one of the following:
µ Roll the scroll wheel or scroll ball of your mouse down to zoom in to a particular scope’s
display, and up to zoom out.
µ Click one of the percentage buttons in the upper-left corner of the Vectorscope to scale
the scope’s display.
The 3D video scopes can also be rotated in space so that you can view the analysis from
any angle.
To reposition any 3D scope
Do one of the following:
µ Drag horizontally or vertically to rotate the scope model in that direction.
µ Hold down the middle mouse button and drag to reposition the scope model in that
direction.
To reset any scope to its original scale and orientation
µ Control-click or right-click within any scope, then choose Reset from the shortcut menu.
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To turn video scope color on and off
1 Open the User Prefs tab, located inside the Setup room.
2 Click Monochrome Scopes to turn scope color on or off.
Scope color is affected by the following customizable parameters:
• When Monochrome Scopes is turned off: The UI Saturation parameter determines how
intense the scope colors are.
• When Monochrome Scopes is turned on: The Scope Color control directly underneath
controls the color of the scope graticules.
Analyzing Images Using the Video Scopes
The following sections describe the use of each scope that Color provides:
• The Waveform Monitor
• The Vectorscope
• The Histogram
• The 3D Scope
• Sampling Color for Analysis
The Waveform Monitor
The Waveform Monitor is actually a whole family of scopes that shows different analyses
of luma and chroma using waveforms.
What Is a Waveform?
To create a waveform, Color analyzes lines of an image from left to right, with the resulting
values plotted vertically on the waveform graticule relative to the scale that’s used—for
example, –20 to 110 IRE (or –140 to 770 mV) on the Luma graph. In the following image,
a single line of the image is analyzed and plotted in this way.
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image are superimposed over one another.
Because the waveform’s values are plotted in the same horizontal position as the portion
of the image that’s analyzed, the waveform mirrors the image to a certain extent. This
can be seen if a subject moves from left to right in an image while the waveform is playing
in real time.
With all the waveform-style scopes, high luma or chroma levels show up as spikes on the
waveform, while low levels show up as dips. This makes it easy to read the measured
levels of highlights or shadows in the image.
Changing the Graticule Values
The Waveform Monitor is the only scope in which you can change the numeric values
used to measure the signal. By default, the Waveform Monitor is set to measure in IRE,
but you can also switch the scope to measure using millivolts (mV) instead by clicking
one of the buttons to the right of the waveform selection buttons.
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The Waveform Monitor has eight different modes. For more information, see:
• The Parade Scope
• The Overlay Scope
• The Red/Green/Blue Channels Scopes
• The Luma Scope
• The Chroma Scope
• The Y′CBCR Scope
The Parade Scope
The Parade scope displays separate waveforms for the red, green, and blue components
of the image side by side. If Monochrome Scopes is turned off, the waveforms are tinted
red, green, and blue so you can easily identify which is which.
Note: To better illustrate the Parade scope’s analysis, the examples in this section are
shown with Broadcast Safe disabled so that image values above 100 percent and below
0 percent won’t be clipped.
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image, by comparing the contours of the top and the bottom of each waveform. Since
whites, grays, and blacks are characterized by exactly equal amounts of red, green, and
blue, neutral areas of the picture should display three waveforms of roughly equal height
in the Parade scope. If not, the correction is easy to make by making adjustments to level
the three waveforms.
Before color correction
After color correction
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between two shots. If one shot has more red than another, the difference shows up as
an elevated red waveform in the one and a depressed red waveform in the other, relative
to the other channels. In the first shot, the overall image contains quite a bit of red. By
comparison, the second shot has substantially less red and far higher levels of green,
which can be seen immediately in the Parade scope. If you needed to match the color
of these shots together, you could use these measurements as the basis for your correction.
An elevated red channel betrays the degree of the color cast.
An elevated green channel reveals a different correction to be made.
The Parade scope also lets you spot color channels that are exceeding the chroma limit
for broadcast legality, if the Broadcast Safe settings are turned off. This can be seen in
waveforms of individual channels that either rise too high or dip too low.
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The Overlay scope presents information that’s identical to that in the Parade scope, except
that the waveforms representing the red, green, and blue channels are superimposed
directly over one another.
This can make it easier to spot the relative differences or similarities in overlapping areas
of the three color channels that are supposed to be identical, such as neutral whites,
grays, or blacks.
Another feature of this display is that when the video scopes are set to display color (by
turning off the Monochrome Scopes parameter), areas of the graticule where the red,
green, and blue waveforms precisely overlap appear white. This makes it easy to see
when you’ve eliminated color casts in the shadows and highlights by balancing all three
channels.
The Red/Green/Blue Channels Scopes
These scopes show isolated waveforms for each of the color channels. They’re useful
when you want a closer look at a single channel’s values.
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The Luma scope shows you the relative levels of brightness within the image. Spikes or
drops in the displayed waveform make it easy to see hot spots or dark areas in your
picture.
The difference between the highest peak and the lowest dip of the Luma scope’s graticule
shows you the total contrast ratio of the shot, and the average thickness of the waveform
shows its average exposure. Waveforms that are too low are indicative of images that are
dark, while waveforms that are too high may indicate overexposure.
Overexposed waveform
Underexposed waveform Well-exposed waveform
If you’re doing a QC pass of a program with the Broadcast Safe settings turned off, you
can also use the scale to easily spot video levels that are over and under the recommended
limits.
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This scope shows the combined CB and CR color difference components of the image. It’s
useful for checking whether or not the overall chroma is too high, and also whether it’s
being limited too much, as it lets you see the result of the Chroma Limit setting being
imposed when Broadcast Safe is turned on.
For example, the following graph shows extremely saturated chroma within the image:
When you turn Broadcast Safe on with the default Chroma Limit value of 50, you can see
that the high chroma spikes have been limited to 50.
The Y′CBCR Scope
This scope shows the individual components of the Y′CBCR encoded signal in a parade
view. The leftmost waveform is the luma (Y′) component, the middle waveform is the CB
color difference component, and the rightmost waveform is the CR color difference
component.
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The Vectorscope shows you the overall distribution of color in your image against a
circular scale. The video image is represented by a graph consisting of a series of connected
points that all fall at about the center of this scale. For each point within the analyzed
graph, its angle around the scale indicates its hue (which can be compared to the color
targets provided), while its distance from the center of the scale represents the saturation
of the color being displayed. The center of the Vectorscope represents zero saturation,
and the farther from the center a point is, the higher its saturation.
If the Monochrome Scopes option is turned off in the User Prefs tab of the Setup room,
then the points of the graph plotted by the Vectorscope will be drawn with the color
from that part of the source image. This can make it easier to see which areas of the graph
correspond to which areas of the image.
Comparing Saturation with the Vectorscope
The Vectorscope is useful for seeing, at a glance, the hue and intensity of the various
colors in your image. Once you learn to identify the colors in your shots on the graph in
the Vectorscope, you will be better able to match two images closely because you can
see where they vary. For example, if one image is more saturated than another, its graph
in the Vectorscope will be larger.
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You can also use the Vectorscope to spot whether there’s a color cast affecting portions
of the picture that should be neutral (or desaturated). Crosshairs in the Vectorscope
graticule indicate its center. Since desaturated areas of the picture should be perfectly
centered, an off-center Vectorscope graph representing an image that has portions of
white, gray, or black clearly indicates a color imbalance.
The Color Targets
The color targets in the Vectorscope line up with the traces made by the standard color
bar test pattern, and can be used to check the accuracy of a captured video signal that
has recorded color bars at the head.
These targets also correspond to the angles of hue in the color wheels surrounding the
Color Balance controls in the Primary In and Out and Secondaries rooms. If the hues of
two shots you’re trying to match don’t match, the direction and distance of their offset
on the Vectorscope scale give you an indication of which direction to move the balance
control indicator to correct for this.
At a zoom percentage of 75 percent, the color targets in the Vectorscope are calibrated
to line up for 75 percent color bars. Zooming out to 100 percent calibrates the color
targets to 100 percent color bars. All color is converted by Color to RGB using the Rec.
709 standard prior to analysis, so color bars from both NTSC and PAL source video will
hit the same targets.
Note: If Broadcast Safe is turned on, color bars’ plots may not align perfectly with these
targets.
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The –I bar (negative I bar) shows the proper angle at which the hue of the dark blue box
in the color bars test pattern should appear. This dark blue box, which is located to the
left of the 100-percent white reference square, is referred to as the Inphase signal, or I for
short.
The I bar (positive I bar) overlay in the Vectorscope is also identical to the skin tone line
in Final Cut Pro. It’s helpful for identifying and correcting the skin tones of actors in a shot.
When recorded to videotape and measured on a Vectorscope, the hues of human skin
tones, regardless of complexion, fall along a fairly narrow range (although the saturation
and brightness vary). When there’s an actor in a shot, you’ll know whether or not the skin
tones are reproduced accurately by checking to see if there’s an area of color that falls
loosely around the I bar.
If the skin tones of your actors are noticeably off, the offset between the most likely nearby
area of color in the Vectorscope graph and the skin tone target will give you an idea of
the type of correction you should make.
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The Q bar shows the proper angle at which the hue of the purple box in the color bars
test pattern should appear. This purple box, which is located at the right of the 100-percent
white reference square, is referred to as the +Quadrature signal, or Q for short.
When troubleshooting a video signal, the correspondence between the Inphase and
+Quadrature components of the color bars signal and the position of the –I and Q bars
shows you whether or not the components of the video signal are being demodulated
correctly.
The Histogram
The Histogram provides a very different type of analysis than the waveform-based scopes.
Whereas waveforms have a built-in correspondence between the horizontal position of
the image being analyzed and that of the waveform graph, histograms provide a statistical
analysis of the image.
Histograms work by calculating the total number of pixels of each color or luma level in
the image and plotting a graph that shows the number of pixels there are at each
percentage. It’s really a bar graph of sorts, where each increment of the scale from left
to right represents a percentage of luma or color, while the height of each segment of
the histogram graph shows the number of pixels that correspond to that percentage.
The RGB Histogram
The RGB histogram display shows separate histogram analyses for each color channel.
This lets you compare the relative distribution of each color channel across the tonal
range of the image.
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or conversely, weaker green and blue histograms. In the following example, the red cast
in the highlights can be seen clearly.
The R, G, and B Histograms
The R, G, and B histograms are simply isolated versions of each channel’s histogram graph.
The Luma Histogram
The Luma histogram shows you the relative strength of all luminance values in the video
frame, from black to super-white. The height of the graph at each step on the scale
represents the number of pixels in the image at that percentage of luminance, relative
to all the other values. For example, if you have an image with few highlights, you would
expect to see a large cluster of values in the Histogram display around the midtones.
The Luma histogram can be very useful for quickly comparing the luma of two shots so
you can adjust their shadows, midtones, and highlights to match more closely. For
example, if you were matching a cutaway shot to the one shown above, you can tell just
by looking that the image below is underexposed, but the Histogram gives you a reference
for spotting how far.
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image. A low-contrast image, such as the one shown above, has a concentrated clump
of values nearer to the center of the graph. By comparison, a high-contrast image has a
wider distribution of values across the entire width of the Histogram.
The 3D Scope
This scope displays an analysis of the color in the image projected within a 3D area. You
can select one of four different color spaces with which to represent the color data.
The RGB Color Space
The RGB color space distributes color in space within a cube that represents the total
range of color that can be displayed:
• Absolute black and white lie at two opposing diagonal corners of the cube, with the
center of the diagonal being the desaturated grayscale range from black to white.
• The three primary colors—red, green, and blue—lie at the three corners connected to
black.
• The three secondary colors—yellow, cyan, and magenta—lie at the three corners
connected to white.
In this way, every color that can be represented in Color can be assigned a point in three
dimensions using hue, saturation, and lightness to define each axis of space.
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from the black to white corners represents 0-percent saturation. Darker colors fall closer
to the black corner of the cube, while lighter colors fall closer to the diagonally opposing
white corner of the cube.
The HSL Color Space
The HSL (Hue, Saturation, and Luminance) color space distributes a graph of points within
a two-pointed cone that represents the range of color that can be displayed:
• Absolute black and white lie at two opposing points at the top and bottom of the
shape.
• The primary and secondary colors are distributed around the familiar color wheel, with
100-percent saturation represented by the outer edge of the shape, and 0-percent
saturation represented at the center.
In this way, darker colors lie at the bottom of the interior, while lighter colors lie at the
top. More saturated colors lie closer to the outer sides of the shape, while less saturated
colors fall closer to the center of the interior.
The Y′CBCR Color Space
The Y′CBCR color space is similar to the HSL color space, except that the outer boundary
of saturation is represented with a specifically shaped six-sided construct that shows the
general boundaries of color in broadcast video.
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illustrate the general range of color that’s available. For example, the following image
has illegal saturation and brightness.
If you turn on the Broadcast Safe settings, the distribution of color throughout the Y′CBCR
color space becomes constricted.
The IPT Color Space
The IPT color space is a perceptually weighted color space, the purpose of which is to more
accurately represent the hues in an image distributed on a scale that appears uniformly
linear to your eye.
While the RGB, HSL, and Y′CBCR color spaces present three-dimensional analyses of the
image that are mathematically accurate, and allow you to see how the colors of an image
are transformed from one gamut to another, they don’t necessarily show the distribution
of colors as your eyes perceive them. A good example of this is a conventionally calculated
hue wheel. Notice how the green portion of the hue wheel presented below seems so
much larger than the yellow or red portion.
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of the primaries (red, green, and blue). As a result, a mathematically linear distribution of
analyzed color is not necessarily the most accurate way to represent what we actually
see. The IPT color space rectifies this by redistributing the location of hues in the color
space according to tests where people chose and arranged an even distribution of hues
from one color to another, to define a spectrum that “looked right” to them.
In the IPT color space, I corresponds to the vertical axis of lightness (desaturated black
to white) running through the center of the color space. The horizontal plane is defined
by the P axis, which is the distribution of red to green, and the T axis, which is the
distribution of yellow to blue.
Here’s an analysis of the test image within this color space.
Sampling Color for Analysis
The 3D video scope also provides controls for sampling and analyzing the color of up to
three pixels within the currently displayed image. Three swatches at the bottom of the
video scope let you sample colors for analysis by dragging one of three correspondingly
numbered crosshairs within the image preview area. A numerical analysis of each sampled
color appears next to the swatch control at the bottom of the 3D video scope.
The color channel values that are used to analyze the selected pixel change depending
on which color space the 3D scope is set to. For example, if the 3D scope is set to RGB,
then the R, G, and B values of each selected pixel will be displayed. If the 3D scope is
instead set to Y′CBCR
, then the Y′, CB
, and CR values of the pixel will be displayed.
You can choose different samples for each shot in the Timeline, and the position of each
shot’s sampling crosshairs is saved as you move the playhead from clip to clip. This makes
it easy to compare analogous colors in several different shots to see if they match.
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to be a specific value. For example, you can drag swatches across the frame if you’re
trying to adjust a black, white, or colored background to be a uniform value, or if you
have a product that’s required to be a highly specific color in every shot in which it
appears.
Note: These controls are visible only when the 3D scope is occupying an area of the
Scopes window.
To sample and analyze a color
1 Click one of the three color swatch buttons at the bottom of the 3D scope.
2 Click or drag within the image preview area to move the color target to the area you
want to analyze.
As you drag the color target over the image preview, four things happen:
• The color swatch updates with that color.
• The H, S, and L values of the currently analyzed pixel are displayed to the right of the
currently selected swatch.
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of color in the 3D scope itself.
Each color target is numbered to identify its corresponding color swatch.
• A vertical line appears within the Hue, Sat, and Lum curves of the Secondaries room,
showing the position of the sample pixels relative to each curve.
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shot, this is where you begin, and in many cases this may be all you need.
Simply speaking, primary corrections are color corrections that affect the entire image at
once. The Primary In room provides a variety of controls that will be familiar to anyone
who’s worked with other image editing and color correction plug-ins and applications.
Each of these controls manipulates the contrast and color in the image in a different way.
Note: Many of the controls in the Primary In room also appear in the Secondaries and
Primary Out rooms, in which they have identical functionality.
This chapter covers the following:
• What Is the Primary In Room Used For? (p. 207)
• Where to Start in the Primary In Room? (p. 208)
• Contrast Adjustment Explained (p. 210)
• Using the Primary Contrast Controls (p. 212)
• Color Casts Explained (p. 222)
• Using Color Balance Controls (p. 224)
• The Curves Controls (p. 234)
• The Basic Tab (p. 245)
• The Advanced Tab (p. 249)
• Using the Auto Balance Button (p. 251)
• The RED Tab (p. 252)
What Is the Primary In Room Used For?
Typically, you'll use the Primary In room to do tasks such as the following:
• To adjust image contrast, so that the shadows are deep enough, the highlights are
bright enough, and the overall lightness of the image is appropriate to the scene.
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9• To adjust color in the highlights and midtones to correct for unwanted color casts due
to a video camera's incorrect white balance settings, or lighting that was inappropriate
for the type of film stock that was used.
• To make changes to the overall color and contrast of an image in order to change the
apparent time of day. For example, you might need to alter a shot that was
photographed in the late afternoon to look as if it were shot at high noon.
• To adjust the color and contrast of every shot in a scene so that there are no irregularities
in exposure or color from one shot to the next.
All these tasks and more can be performed using the tools that are available in the Primary
In room. In fact, when working on shows that require relatively simple corrections, you
may do all your corrections right here, including perhaps a slight additional adjustment
to warm up or cool down the image for purely aesthetic purposes. (On the other hand,
you can also perform different stages of these necessary corrections in other rooms for
organizational purposes. For more information about how to split up and organize
corrections in different ways, see Managing a Shot’s Corrections Using Multiple Rooms.)
The Primary In room also lets you make specific adjustments. Even though the Primary
In room applies corrections to the entire image, you can target these corrections to specific
aspects of the picture. Many of the controls in the Primary In room are designed to make
adjustments to specific regions of tonality. In other words, some controls adjust the color
in brighter parts of the picture, while other controls only affect the color in its darker
regions. Still other types of controls affect specific color channels, such that you can lower
or raise the green channel without affecting the red or blue channels.
Where to Start in the Primary In Room?
Many colorists use the tools in the Primary In room in a specific order. This order is used
to organize the sections of this document to provide you with a workflow with which to
get started. In general, you'll probably find that you work on most images using the
following steps.
• Stage 1: Adjusting the Contrast of the Image
• Stage 2: Adjusting the Color Balance of the Image
• Stage 3: Adjusting the Saturation of the Image
• Stage 4: Making More Specific Adjustments
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Most colorists always begin by correcting the contrast of an image before moving on to
adjusting its color. This adjustment can be made using the primary contrast controls, the
Luma curve control, and the Master Lift, Master Gain, and Master Gamma controls in the
Basic tab.
Stage 2: Adjusting the Color Balance of the Image
Once the black and white points of the image have been determined, the color balance
is tackled. Fast adjustments to the color balance in the shadows, midtones, and highlights
can be made using the primary color balance controls. More detailed adjustments can
be made using the red, green, and blue curves controls, and specific numeric adjustments
can be made using the Red, Green, and Blue Lift, Gamma, and Gain controls in the
Advanced tab.
Stage 3: Adjusting the Saturation of the Image
Once you're happy with the quality of the color, you can make adjustments to raise or
lower the saturation, or intensity, of the colors in the image. The Saturation, Highlight
Sat., and Shadow Sat. controls in the Basic tab let you adjust the overall saturation or only
the saturation within specific tonal regions.
Chapter 9 The Primary In Room 209Stage 4: Making More Specific Adjustments
If you still feel that there are specific aspects of the image that need further adjustment
after Stages 1 through 3, you can turn to the curves controls, which let you make targeted
adjustments to the color and contrast of the image within specifically defined zones of
tonality. Past a certain point, however, it may be easier to move on to the Secondaries
room, covered in The Secondaries Room.
Contrast Adjustment Explained
If you strip away the color in an image (you can do this by setting the Saturation control
to 0), the grayscale image that remains represents the luma component of the image,
which is the portion of the image that controls the lightness of the image. As explained
in The Y′CBCR Color Model Explained, the luma of an image is derived from a weighted
ratio of the red, green, and blue channels of the image which corresponds to the eye's
sensitivity to each color.
Although luma was originally a video concept, you can manipulate the luma component
of images using the contrast controls in Color no matter what the originating format.
These controls let you adjust the lightness of an image more or less independently of its
color.
Note: Extreme adjustments to image contrast will affect image saturation.
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One of the most important adjustments you can make to an image is to change its contrast
ratio. The contrast ratio of an image is the difference between the darkest pixel in the
shadows (the black point) and the lightest pixel in the highlights (the white point). The
contrast ratio of an image is easy to quantify by looking at the Waveform Monitor or
Histogram set to Luma. High-contrast images have a wide distribution of values from the
black point to the white point.
Low-contrast images, on the other hand, have a narrower distribution of values from the
black point to the white point.
The Shadows, Midtones, and Highlights contrast sliders let you make individual
adjustments to each of the three defining characteristics of contrast.
Note: Contrast adjustments made with the primary contrast sliders can affect the saturation
of the image. Raising luma by a significant amount can reduce saturation, while reducing
luma can raise image saturation. This behavior is different from that of the Color Corrector
3-way filter in Final Cut Pro, in which changes to contrast have no effect on image
saturation.
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The primary contrast controls consist of three vertical sliders that are used to adjust the
black point, the distribution of midtones, and the white point of the image.
Adjusts black point Adjusts midtones distribution Adjusts white point
Output:  0.00h   0.00s   0.001 Output:  0.00h   0.00s   0.501 Output:  0.00h   0.00s   1.001
Shadow Midtone Highlight
Each slider is a vertical gradient. Dragging down lowers its value, while dragging up raises
its value. A blue bar shows the current level at which each slider is set, while the third
number in the Output display (labeled L) below each color control shows that slider's
numeric value. Contrast adjustment is a big topic. For more information, see:
• Adjusting the Black Point with the Shadow Slider
• Adjusting the Midtones with the Midtone Slider
• Adjusting the White Point with the Highlight Slider
• Expanding and Reducing Image Contrast
• Contrast Affects Color Balance Control Operation
Using Contrast Sliders with a Control Surface
In the Primary In, Secondaries, and Primary Out rooms, the three contrast sliders usually
correspond to three contrast rings, wheels, or knobs on compatible control surfaces.
Whereas you can adjust only one contrast slider at a time using the onscreen controls
with a mouse, you can adjust all three contrast controls simultaneously using a hardware
control surface.
When you’re using a control surface, the Encoder Sensitivity parameter in the User Prefs
tab of the Setup room lets you customize the speed with which these controls make
adjustments. For more information, see Control Surface Settings.
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The behavior of the Shadow contrast slider depends on whether or not the Limit Shadow
Adjustments preference (in the User Prefs tab of the Setup room) is turned on. (For more
information, see User Interface Settings.)
• If Limit Shadow Adjustments is turned off: Contrast adjustments with the Shadow slider
are performed as a simple lift operation. The resulting correction uniformly lightens or
darkens the entire image, altering the shadows, midtones, and highlights by the same
amount. This can be seen most clearly when adjusting the black point of a linear
black-to-white gradient, which appears in the Waveform Monitor as a straight diagonal
slope. Notice how the entire slope of the gradient in the Waveform Monitor moves up.
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remains at 100 percent. This means that when you make any adjustments with the
Shadow contrast slider, all midtones in the image are scaled between the new black
point and 100 percent. Notice how the top of the slope in the Waveform Monitor stays
in place while the black point changes.
You'll probably leave the Limit Shadow Adjustments control turned on for most of your
projects, since this setting gives you the most control over image contrast (and color, as
you'll see later) in your programs.
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perform. Lowering the blacks so that the darkest shadows touch 0 percent (seen in the
bottom of the Waveform Monitor's graph or on the left of the Histogram's graph when
either is set to Luma) deepens the shadows of your image. Deeper shadows can enrich
the image and accentuate detail that was being slightly washed out before.
Lowering the blacks even more, (called crushing the blacks because no pixel can be darker
than 0 percent), creates even higher-contrast looks. Crushing the blacks comes at the
expense of losing detail in the shadows, as larger portions of the image become uniformly
0 percent black. This can be seen clearly in the black portion of the gradient at the bottom
of the image.
Note: Even if Limit Shadow Adjustments is turned on, you can still make lift adjustments
to the image using the Master Lift parameter in the Basic tab. See Master Contrast Controls.
Adjusting the Midtones with the Midtone Slider
The Midtone contrast slider lets you make a nonlinear adjustment to the distribution of
midtones in the image (sometimes referred to generically as a gamma adjustment). What
this means is that you can adjust the middle tones of the image without changing the
darkness of the shadows or the lightness of the highlights.
Chapter 9 The Primary In Room 215Here are two examples of using the Midtone contrast slider. The midtones have been
lowered in the following image. Notice how the overall image has darkened, with more
of the picture appearing in the shadows; however, the highlights are still bright, and the
shadow detail has not been lost. The top and bottom of the gradient's slope in the
Waveform Monitor remain more or less in place, and the slope itself curves downward,
illustrating the nonlinear nature of the adjustment.
Next, the Midtone slider is raised. The image has clearly lightened, and much more of the
picture is in the highlights. Yet the deepest shadows remain rich and dark, and the detail
in the highlights isn't being lost since the highlights are staying at their original level.
Again, the top and bottom of the gradient's slope in the Waveform Monitor remain more
or less in place, but this time the slope curves upward.
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is one of your main tools for adjusting overall image lightness when creating mood,
adjusting the perceived time of day, and even when simply ensuring that the audience
can see the subjects clearly.
Note: Even though midtones adjustments leave the black and white points at 0 and 100
percent respectively, extreme midtones adjustments will still crush the blacks and flatten
the whites, eliminating detail in exchange for high-contrast looks.
Adjusting the White Point with the Highlight Slider
The Highlight slider is the inverse of the Shadow slider. Using this control, you can raise
or lower the white point of the image, while leaving the black point relatively untouched.
All the midtones of the image are scaled between your new white point and 0 percent.
If the image is too dark and the highlights seem lackluster, you can raise the Highlight
slider to brighten the highlights, while leaving the shadows at their current levels. Notice
that the black point of the gradient's slope in the Waveform Monitor remains at 0 percent
after the adjustment.
Note: In this example, Broadcast Safe has been turned off, and you can see the white
level of the gradient clipping at the maximum of 109 percent.
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down, without worrying about crushing the blacks.
Overly bright highlights are often the case with images shot on video, where super-white
levels above the broadcast legal limit of 100 percent frequently appear in the source
media (as seen in the previous example). If left uncorrected, highlights above 100 percent
will be clipped by the Broadcast Safe settings when they're turned on, resulting in a loss
of highlight detail when all pixels above 100 percent are set to 100 percent.
By lowering the white point yourself, you can bring clipped detail back into the image.
Note: Values that are clipped or limited by Color are preserved internally and may be
retrieved in subsequent adjustments. This is different from overexposed values in source
media, which, if clipped at the time of recording, are lost forever.
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they will have an effect on the midtones that is proportional to the amount of your
adjustment. The influence of the Highlight slider falls off toward the shadows, but it's fair
to say that adjustments made with the Highlight slider have a gradually decreasing effect
on approximately the brightest 80 percent of the image.
For this reason, you may find yourself compensating for a Highlight slider adjustment's
effect on the midtones of your image by making a smaller inverse adjustment with the
Midtone slider.
The suitable white point for your particular image is highly subjective. In particular, just
because something is white doesn't mean that it's supposed to be up at 100 percent.
Naturally bright features such as specular highlights, reflected glints, and exposed light
sources are all candidates for 100 percent luma. (Chances are these areas are at super-white
levels already, so you'll be turning the brightness down if broadcast legality is an issue.)
On the other hand, if you're working on an interior scene with none of the previously
mentioned features, the brightest subjects in the scene may be a wall in the room or the
highlights of someone's face, which may be inappropriately bright if you raise them to
100 percent. In these cases, the brightness at which you set the highlights depends largely
on the kind of lighting that was used. If the lighting is subdued, you'll want to keep the
highlights lower than if the lighting is intentionally bright.
Expanding and Reducing Image Contrast
For a variety of reasons, it's often desirable to stretch the contrast ratio of an image so
that it occupies the widest range of values possible, without introducing unwanted noise.
(This can sometimes happen in underexposed images that require large contrast
adjustments.)
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example, even in well-exposed shots, video cameras often don't record black at 0 percent,
instead recording black levels at around 3 to 4 percent. For this reason alone, small
adjustments to lower the black point often impress without the need to do much more.
In other cases, an image that is slightly over or underexposed may appear washed out
or muddy, and simple adjustments to lower the darkest pixels in the image and raise the
brightest pixels in the image to widen the contrast ratio have an effect similar to “wiping
a layer of grime off the image” and are often the first steps in simply optimizing a shot.
In other cases, you may choose to deliberately widen the contrast ratio even further to
make extreme changes to image contrast. This may be because the image is severely
underexposed, in which case you need to adjust the Highlight and Midtone sliders in an
effort to simply make the subjects more visible. You might also expand the contrast ratio
of an otherwise well-exposed shot to an extreme, crushing the shadows and clipping the
highlights to create an extremely high-contrast look.
Important: When you expand the contrast of underexposed shots, or make other extreme
contrast adjustments, you may accentuate film grain and video noise in the image. This
is particularly problematic when correcting programs that use video formats with low
chroma subsampling ratios. For more information, see Chroma Subsampling Explained.
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be done as an adjustment to change the apparent time of day (dulling shadows while
maintaining bright highlights for a noon-time look) or simply as a stylistic choice (lighter
shadows and dimmer highlights for a softer look).
What Exactly Is Image Detail?
Image detail is discussed frequently in this and other chapters, mainly within the context
of operations that enhance perceived detail, and those that result in the loss of image
detail. Simply put, image detail refers to the natural variation in tone, color, and contrast
between adjacent pixels.
Because they occur at the outer boundaries of the video signal, the shadows and
highlights of an image are most susceptible to a loss of image detail when you make
contrast adjustments. This results in the "flattening" of areas in the shadows or highlights
when larger and larger groups of pixels in the picture are set to the same value (0 in
the shadows and 100 in the highlights).
It's important to preserve a certain amount of image detail in order to maintain a natural
look to the image. On the other hand, there's no reason you can't discard a bit of image
detail to achieve looks such as slightly crushed blacks, or widely expanded contrast for
a "high-contrast look" with both crushed blacks and clipped whites. Just be aware of
what, exactly, is happening to the image when you make these kinds of adjustments.
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There's another reason to expand or otherwise adjust the contrast ratio of an image before
making any other color corrections. Every adjustment you make to the contrast of an
image changes which portions of that image fall into which of the three overlapping
tonal zones the color balance controls affect (covered in Using Color Balance Controls).
For example, if you have a low-contrast image with few shadows, and you make an
adjustment with the Shadow color balance control, the resulting correction will be small,
as you can see in the following gradient.
If, afterward, you adjust the Shadow or Midtone contrast sliders to lower the shadows,
you'll find more of the image becoming affected by the same color correction, despite
the fact that you've made no further changes to that color control.
This is not to say that you shouldn't readjust contrast after making other color corrections,
but you should keep these interactions in mind when you do so.
Color Casts Explained
A color cast is an unwanted tint in the image due to the lighting, the white balance of
the video camera, or the type of film stock used given the lighting conditions during the
shoot. Color casts exist because one or more color channels is inappropriately strong or
weak. Furthermore, color casts aren't usually uniform across an entire image. Often, color
casts are stronger in one portion of the image (such as the highlights) and weaker or
nonexistent in others (the shadows, for example).
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can often see the disproportionate levels of each channel that cause the color cast when
you examine the tops of the waveforms (representing the highlights) and the bottoms
of the waveforms (representing the shadows).
Note: For clarity, the Parade scope is shown with the tinted red, green, and blue waveforms
that appear when Monochrome Scopes is turned off in the User Prefs tab.
When Is a Color Cast a Creative Look?
It's important to bear in mind that color casts aren't always bad things. In particular, if
the director of photography is being creative with the lighting, there may in fact be
color casts throughout the tonal range of the image. It's important to distinguish between
color casts that are there either accidentally or because of conditions of the shoot and
the stylistic choices made when lighting each scene. In all cases, clear communication
between the director of photography and the colorist is essential.
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The color balance controls (which are sometimes referred to as hue wheels) work as virtual
trackballs on the screen; however, they consist of three separate controls.
Saturation slider
Hue slider
Output display Luma reset button
Color balance reset 
button
• Color Balance wheel: A virtual trackball that lets you adjust the hue (set by the handle's
angle about the center) and saturation (set by the handle's distance from the center)
of the correction you're using to rebalance the red, green, and blue channels of the
image relative to one another. A handle at the center of the crosshairs within the wheel
shows the current correction. When the handle is centered, no change is made.
• Hue slider: This slider lets you change the hue of the adjustment without affecting the
saturation.
• Saturation slider: This slider lets you change the saturation of the adjustment without
affecting the hue. Drag up to increase the saturation, and down to decrease it.
• H, S reset button: Clicking the H, S reset button resets the color balance control for that
tonal zone. If you're using a control surface, this corresponds to the color reset control
for each zone. (These are usually one of a pair of buttons next to each color balance
trackball.)
• L reset button: Clicking the L reset button resets the contrast slider for that tonal zone.
If you're using a control surface, this corresponds to the contrast reset control for each
zone. (These are usually one of a pair of buttons next to each color balance trackball.)
• Output display: The output display underneath each color control shows you the current
hue and saturation values of the color balance control and the lightness value of the
contrast slider for that zone.
Note: The color balance controls can be accelerated to 10x their normal speed by
pressing the Option key while you drag.
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The three color balance controls correspond to the three trackballs, or joyballs, on
compatible control surfaces. Whereas you can only adjust one color balance control at
a time using the onscreen controls with a mouse, you can adjust all three color balance
controls simultaneously using a hardware control surface.
When you’re using a control surface, the Hue Wheel Angle and Joyball Sensitivity
parameters in the User Prefs tab of the Setup room let you customize the operation of
these controls. For more information on adjusting these parameters, see Control Surface
Settings.
Rebalancing a Color Cast
By dragging the handle of a color balance control, you can rebalance the strength of the
red, green, and blue channels of an image to manipulate the quality of light in order to
either correct such color casts or introduce them for creative purposes. The color balance
controls always adjust all three color channels simultaneously.
In the following example, the image has a red color cast in the highlights, which can be
confirmed by the height of the top of the red channel in the Parade scope.
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channel, which you can do by dragging the Highlight color balance control. The easy
way to remember how to make a correction of this nature is to drag the color balance
control handle toward the secondary of the color that's too strong. In this case, the color
cast is a reddish/orange, so dragging the color control in the opposite direction, toward
bluish/cyan, rebalances the color channels in the appropriate manner. The Midtone color
balance control is used because the majority of the image that's being adjusted lies
between 80 and 20 percent.
If you watch the Parade scope while you make this change, you can see the color channels
being rebalanced, while you also observe the correction affecting the image on your
broadcast display.
There are three color balance controls in the Primary In, Secondaries, and Primary Out
rooms. Each one lets you make adjustments to specific tonal regions of the image.
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Like many other color correction environments, Color provides a set of three color balance
controls for the specific adjustment of color that falls within each of three overlapping
zones of image tonality. These tonal zones are the shadows, midtones, and highlights of
the image. If you were to reduce the tonality of an image into these three zones, it might
look something like the following illustration.
Original color image           Simulated tonal zones, shadows, midtones,
and highlights
Areas most affected by the Shadow color
balance control
Areas most affected by the Highlight color
balance control
Areas most affected by the Midtone color
balance control
Three zone controls allow you to make targeted adjustments to the color that falls within
the highlights of an image, without affecting color in the shadows. Similarly, they allow
you to make separate adjustments to differently lit portions of the image to either make
corrections or achieve stylized looks.
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overlap broadly, with each color balance control's influence over the image diminishing
gradually at the edges of each zone. This overlap is shown in the following graph.
Shadow control influence
Midtone influence
Highlight control influence
The ways in which these zones overlap are based on the OpenCDL standard, and their
behavior is described below.
Important: If you're used to the way the Color Corrector 3-way filter works in Final Cut Pro,
you'll want to take some time to get used to the controls of the Primary In room, as they
respond somewhat differently. Also, unlike adjustments using the Color Corrector 3-way
filter in Final Cut Pro, adjustments made using the color balance control affect the luma
of the image, altering its contrast ratio.
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The behavior of the Shadow color balance control depends on whether or not the Limit
Shadow Adjustments preference is turned on. (For more information, see User Interface
Settings.)
• If Limit Shadow Adjustments is turned off: Color adjustments made using the Shadow
control are performed as a simple add operation. (The color that's selected in the
Shadow color control is simply added to that of every pixel in the image.) The resulting
correction affects the entire image (and can be seen clearly within the gradient at the
bottom of the image), producing an effect similar to a tint.
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made with the Shadow control such that black receives 100 percent of the adjustment
and white receives 0 percent of the adjustment. This is the method to use if you want
to be able to selectively correct shadows while leaving highlights untouched.
Note: To better illustrate the effect of the Shadow color control, the previous examples
were shown with Broadcast Safe turned off so that image values below 0 percent wouldn't
be clipped.
Midtones Color Adjustments
Adjustments made with the Midtone color balance control apply the correction using a
power operation (the new pixel value = old pixel value ^ adjustment). The result is that
midtones adjustments have the greatest effect on color values at 50 percent lightness
and fall off as color values near 0 and 100 percent lightness.
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image. For example, you could add a bit of blue to the midtones to cool off an actor's
skin tone, while leaving your shadows deep and untinted and your highlights clean and
pure.
Highlights Color Adjustments
Adjustments made using the Highlight color balance control apply a multiply operation
to the image—the color that's selected in the Highlight color control is simply multiplied
with that of every pixel in the image. By definition, multiply color correction operations
fall off in the darker portions of an image and have no effect whatsoever in regions of 0
percent black.
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resulting from the dominant light source that's creating the highlights, without
inadvertently tinting the shadows. In the following example, a bit of blue is added to the
highlights to neutralize the orange from the tungsten lighting.
Color Balance Control Overlap Explained
The broadly overlapping nature of color correction adjustments made with the three
color balance controls is necessary to ensure a smooth transition from adjustments made
in one tonal zone to another, in order to prevent banding and other artifacts. In general,
adjustments made to the color in one tonal zone also affect other tonal zones in the
following ways:
• Adjustments made to the Shadow color controls overlap the midtones and the darker
portion of the highlights but exclude areas of the image at the highest percentages.
• Adjustments made to the midtones affect the broadest area of the image but don't
affect the lowest percentages of the shadows or the highest percentages of the
highlights.
• Adjustments made to the highlights affect the midtones as well, but not the lowest
percentages of the shadows.
Controlling Color Balance Control Overlap
While the tonal zones that are affected by the three color balance controls are predefined
by the mathematical operations they perform, it is possible to exert some control over
what areas of an image are being affected by the corrections of a particular color balance
control. This is done by applying opposing corrections with other color balance controls.
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balance control to add blue to a linear gradient, you'll see the following preview.
As you can see, this change affects both the whites and midtones. If you want to restrict
the correction that's taking place in the midtones, while leaving the correction at the
upper portion of the whites, you can take advantage of the technique of using
complementary colors to neutralize one another, making a less extreme, opposite
adjustment with the Midtone color balance control.
The result is that the highlights correction that had been affecting the midtones has been
neutralized in the lower portion of the midtones.
Although making opposing adjustments to multiple color balance controls may seem
contradictory, it's a powerful technique. With practice, you'll find yourself instinctively
making adjustments like this all the time to limit the effect of corrections on neighboring
zones of tonality.
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The curves controls, located underneath the color controls in the Primary In room, provide
an additional method for adjusting the color and contrast of your images. If you're familiar
with image editing applications such as Photoshop, chances are you've used curves
before.
The three main differences between the curves controls and the color balance controls
are:
• The curves controls let you make adjustments to as many specific tonal ranges that
you choose to define, while the color balance controls affect three predefined tonal
ranges.
• Each curves control affects only a single color channel, while the color balance controls
let you quickly adjust all three color channels simultaneously.
• Curves cannot be animated with keyframes, although every other parameter in the
Primary In and Primary Out rooms can be.
Color balance controls are usually faster to use when making broad adjustments to the
shadows, midtones, and highlights of the image. Curves, on the other hand, often take
more time to adjust, but they allow extremely precise adjustments within narrow tonal
zones of the image, which can border on the kinds of operations typically performed
using secondary color correction.
Important: While the power of curves can be seductive, be wary of spending too much
time finessing your shots using the curves controls, especially in client sessions where
time is money. It's easy to get lost in the minutiae of a single shot while the clock is ticking,
and such detail work may be faster to accomplish with other tools.
How Curves Affect the Image
Curves work by remapping the original color and luma values to new values that you
choose, simply by changing the height of the curve. The x axis of the graph represents
the source values that fall along the entire tonal range of the original image, from black
(left) to white (right). The y axis of the graph represents the tonal range available for
adjustment, from black (bottom) to white (top).
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each source value equals its adjustment value, so no change is made.
Source Value
Adjustment Value If part of a curve is raised by one or more control points, then the tonal area of the image
that corresponds to that part of the curve is adjusted to a higher value. In other words,
that part of the image is lightened.
Effect of raising midtones using the Luma curve
If part of a curve is lowered with one or more control points, then the tonal area of the
image that corresponds to that part of the curve is adjusted to a lower value. In other
words, that part of the image is darkened.
Effect of lowering midtones using the Luma curve
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By default, each curve has two control points. The bottom-left control point is the black
point and the top-right control point is the white point for that channel. These two control
points anchor the bottom and top of each curve.
Curves in Color are edited using B-Splines, which use control points that aren't actually
attached to the curve control to "pull" the curve into different shapes, like a strong magnet
pulling thin wire. For example, here's a curve with a single control point that's raising the
highlights disproportionately to the midtones:
The control point hovering above the curve is pulling the entire curve upward, while the
ends of the curve are pinned in place.
The complexity of a curve is defined by how many control points are exerting influence
on the curve. If two control points are added to either side and moved down, the curve
can be modified as seen below.
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gentle, move the control points farther away from one another.
The following procedures describe how to create, remove, and adjust the control points
that edit curves controls.
To add control points to a curve
µ Click anywhere on the curve itself.
To adjust a control point
µ Drag it anywhere within the curve control area.
To remove control points from a curve
µ Drag a point up or down until it's outside the curve control area.
To remove all control points from a curve
µ Click the reset button (at the upper-left side of each curve graph) for the curve from which
you want to clear control points.
Using Curves to Adjust Contrast
One of the most easily understood ways of using curves is to adjust contrast with the
Luma curve. The Luma curve actually performs a simultaneous adjustment to the red,
green, and blue channels of the image (as you can see if you take a look at the Parade
scope while making Luma curve adjustments), so the overall effect is to adjust the lightness
of the image.
Note: Adjustments made to the Luma curve may affect its saturation. Raising luma by a
significant amount can reduce its saturation.
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Adjustment Explained and the black point, midtones, and white point of the Luma curve.
For example, moving the black point of the curve up raises the black point.
Moving the white point of the curve down lowers the white point of the image.
These two control points roughly correspond to the Shadow and Highlight contrast
controls. If you add a third control point to the Luma curve somewhere in the center, you
can adjust the distribution of midtones that fall between the black and white points. This
adjustment is similar to that of using the Midtone contrast control. Moving this middle
control point up raises the distribution of midtones, lightening the image while leaving
the white and black points pinned in place.
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image while leaving the white and black points pinned in place.
While these three control points can mimic the functionality of the Shadow, Midtone,
and Highlight contrast controls, the true power of curves comes from the ability to add
several control points to make targeted adjustments to the lightness of specific tonal
regions in the image.
The Luma Curve Limits the Range of the Primary Contrast Sliders
One important aspect of the curves controls is that they can limit the range of subsequent
adjustments with the primary contrast sliders in the same room. This can be clearly seen
when you make an adjustment to lower the white point of the image using the Luma
curve. Afterward, you'll find yourself unable to use the Highlight contrast slider to raise
the image brightness above the level that's set by the Luma curve. You can still make
additional contrast adjustments in other rooms.
An Example of the Luma Curve in Use
The following example illustrates how to make very specific changes to the contrast of
an image using the Luma curve. In this shot, the sky is significantly brighter than the rest
of the image. In order to bring viewer attention more immediately to the subject sitting
at the desk, you need to darken the sky outside the window, without affecting the
brightness of the rest of the image.
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1 Before making any actual adjustments, pin down the midtones and shadows of the image
by adding a control point to the curve without moving it either up or down.
Adding control points to a portion of a curve that you don't want to adjust, and leaving
them centered, is a great way to minimize the effect of other adjustments you're making
to specific areas of an image. When you add additional control points to adjust the curve,
the unedited control points you placed will help to limit the correction.
Tip: When adding multiple control points to a curve, you can use the grid to identify
where to position parts of a curve you want to be at the original, neutral state of the
image. At its uncorrected state, each curve passes through the diagonal intersections of
the background grid.
2 To make the actual adjustment, drag the white point at the upper-right corner down to
darken the sky.
You want to make sure that you don't drag the new control point down too far, since it's
easy to create adjustments that look unnatural or solarized using curves, especially when
part of a curve is inverted.
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subdued, you may want to brighten the highlights of the man's face by increasing the
contrast in that part of the image.
3 Add a control point below the first control point you created, and drag it up until the
man's face lightens.
The man's face is now brighter, but the shadows are now a bit washed out.
4 Add one last control point underneath the last control point you created, and drag it
down just a little bit to deepen the shadows, without affecting the brighter portions of
the image.
As you can see, the Luma curve is a powerful tool for making extremely specific changes.
Using Curves to Adjust Color
Unlike the color balance controls, which adjust all three color channels simultaneously,
each of the color curves controls affects a single color channel. Additionally, the red,
green, and blue color curves let you make adjustments within specific areas of tonality
defined by the control points you add to the curve. This means that you can make very
exact color adjustments that affect regions of the image that are as narrow or broad as
you define.
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Contrast in this documentation usually describes the differences between light and dark
tones in the image. There is another way to describe contrast, however, and that is the
contrast between different colors in an image. Color contrast is a complex topic, touching
upon hue, color temperature, lightness, and saturation. To greatly simplify this diverse
topic, color contrast can pragmatically refer to the difference in color that exists in
different regions of the image.
In the following example, the image starts out with an indiscriminate color cast; in other
words, there is red in the shadows, red in the midtones, and red in the highlights, so
there aren’t many clearly contrasting colors in different areas of the image. By removing
this color cast from some parts of the image, and leaving it in others, you can enhance
the color contrast between the main subject and the background. In images for which
this is appropriate, color contrast can add depth and visual sophistication to an otherwise
flat image.
Correcting a Color Cast Using Curves
In the following example, you'll see how to make a targeted correction to eliminate a
color cast from the lower midtones, shadows, and extreme highlights of an image, while
actually strengthening the same color cast in the lower highlights.
The following image has a distinct red color cast from the shadows through the highlights,
as you can see by the elevated red waveform in the Parade scope.
Note: For clarity, Broadcast Safe has been turned off so you can better see the bottoms
of the waveforms in the Parade scope.
In this particular shot, you want to keep the red fill light on the woman's face, as it was
intentionally part of the look of the scene. However, to deepen the shadows of the scene
and make the subject stand out a little more from the background, you'd like to remove
some of the red from the shadows.
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1 Add a control point to the red curve near the bottom of the curve, and pull down until
the red color cast becomes subdued.
This should coincide with the bottom of the red waveform in the Parade scope lining up
with the bottoms of the green and blue waveforms.
This operation certainly neutralizes the red in the shadows; unfortunately, because this
one control point is influencing the entire curve, the correction also removes much of
the original red from the midtones as well.
Tip: If you're wondering where you should place control points on a curve to make an
alteration to a specific area of the image, you can use the height of the corresponding
graphs in the Waveform Monitor set to either Parade (if you're adjusting color) or Luma
(if you're adjusting the Luma curve). For example, if you want to adjust the highlights of
the image, you'll probably need to place a control point in the curve at approximately
the same height at which the highlights appear in the Waveform graph.
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"fill" reappears on the side of the woman's face.
This adjustment adds the red back to the woman's face, but now you've added red to
the highlights of the key light source, as well.
Since the key light for this shot is the sun coming in through the window, this effect is
probably inappropriate and should be corrected.
3 Drag the control point for the white point in the red curve control down until the red in
the brightest highlights of the face is neutralized, but not so far that the lighting begins
to turn cyan.
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woman's face, while the shadows and very brightest highlights from the sun are nice and
neutral, enhancing the color contrast of the image.
Here is a before-and-after comparison so you can see the difference.
The Basic Tab
The Basic tab contains the controls for Saturation, as well as Master Lift, Gamma, and Gain
parameters that let you make additional adjustments to the contrast of your image.
For more information, see:
• Saturation Controls
• Master Contrast Controls
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Saturation describes the intensity of the color in an image. Image saturation is controlled
using three parameters which, similar to the other controls in the Primary In room, let
you make individual adjustments to different tonal zones of an image. Like the contrast
and color controls, tonality-specific saturation adjustments fall off gently at the edges of
each correction to ensure smooth transitions.
• Saturation: This parameter controls the saturation of the entire image. The default value
of 1 makes no change to image saturation. Reducing this value lowers the intensity of
the color of every pixel in the image; at 0 the image becomes a grayscale monochrome
image showing only the luma. Raising the saturation increases the intensity of the color.
The maximum saturation you can obtain by adjusting the “virtual slider” of this
parameter with the mouse is 4. However, you can raise this parameter to even higher
values by entering a number directly into this field.
Saturation reduced by more than half
Original image
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"bleed" into one another and a signal that's illegal for broadcast.
A dramatically oversaturated image
If the Broadcast Safe settings are turned on, the legality of the image will be protected,
but you may see some flattening in particularly colorful parts of the image that results
from the chroma of the image being limited at the specified value. You can see this in
the Vectorscope by the bunching up at the edges of the graph. Even if you're not
working on a project for video, severely oversaturated colors can cause problems and
look unprofessional.
• Highlight Sat.: This parameter controls the saturation in the highlights of your image.
You can selectively desaturate the highlights of your image, which can help legalize
problem clips, as well as restore some white to the brightest highlights in an image.
Highlight saturation turned all the way down
Highlight saturation turned up
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can selectively desaturate the shadows on your image to create deeper looking blacks
and to eliminate inappropriate color in the shadows of your images for a more cinematic
look.
Shadow saturation turned up
Shadow saturation turned all the way down Master Contrast Controls
Three additional parameters also affect image contrast. For more information on contrast
adjustments, see Contrast Adjustment Explained.
• Master Lift: Unlike the primary Shadow contrast slider, the Master Lift parameter only
functions as an add or subtract operator, making an overall luma adjustment to the
entire image regardless of how the Limit Shadow Adjustments control is set. For more
information on lift adjustments, see Adjusting the Black Point with the Shadow Slider.
• Master Gain: This parameter works exactly the same as the primary Highlight contrast
slider, adjusting the white point while leaving the black point at its current level and
scaling all the midtones in between the two.
• Master Gamma: This parameter works exactly the same as the primary Midtone contrast
slider, adjusting the distribution of midtones between 0 and 100 percent.
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This tab contains another set of parameters for adjusting each of the three primary color
channels within each of the three tonal zones. Additionally, there is a set of Printer Points
controls for colorists who are used to optical color grading for film.
For more information, see:
• RGB Controls
• Printer Points Controls
RGB Controls
These parameters provide per-channel control over contrast and color. These are not
numerical representations of any of the other controls in the Primary In room. Like the
parameters in the Basic tab, they're available as an additional set of controls.
Typically, these parameters are adjusted when the Auto Balance button is used to
automatically adjust a shot. (For more information, see Using the Auto Balance Button.)
However, you can use them as you see fit.
• Red, Green, and Blue Lift: These parameters work exactly the same as the Master Lift
parameter, but affect the individual color channels.
• Red, Green, and Blue Gain: These parameters work exactly the same as the Master Gain
parameter, but affect the individual color channels.
• Red, Green, and Blue Gamma: These parameters work exactly the same as the Master
Gamma parameter, but affect the individual color channels.
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These parameters are available for colorists who are used to working with the printer
points system for color timing film. Employed by film printing machines, the printer points
system allows color correction to be performed optically, by shining filtered light through
the conformed camera negatives to expose an intermediate positive print, in the process
creating a single reel of film that is the color-corrected print.
The process of controlling the color of individual shots and doing scene-to-scene color
correction is accomplished using just three controls to individually adjust the amount of
red, green, and blue light that exposes the film, using a series of optical filters and shutters.
This method of making adjustments can be reproduced digitally using the Printer Points
parameters.
Tip: These parameters are controllable using knobs on most compatible control surfaces.
What Is a Printer Point?
Each of the Red, Green, and Blue parameters is adjusted in discrete increments called
printer points (with each point being a fraction of an ƒ-stop, the scale used to measure
film exposure). Color implements a standard system employing a total range of 50 points
for each channel, where point 25 is the original neutral state for that color channel.
Technically speaking, each point represents 1/4 of an ƒ-stop of exposure (one ƒ-stop
represents a doubling of light). Each full stop of exposure equals 12 printer points.
Making Adjustments Using Printer Points
Unlike virtually every other control in the Primary In room, the Red, Green, and Blue Printer
Points parameters make a uniform adjustment to the entire color channel, irrespective
of image tonality.
Also unique is the way in which adjustments are made. To emulate the nature of the
filters employed by these kinds of machines, raising a parameter such as the Printer Points
Red parameter doesn’t actually boost the red; instead, it removes red, causing the image
to shift to cyan (the secondary of green and blue). To increase red, you actually need to
decrease the Printer Points Red parameter.
Increasing or decreasing all three Printer Points parameters together darkens the image
(by raising all three parameters) or lightens it (by lowering all three parameters). Making
disproportionate adjustments to the three channels changes the color balance of the
image relative to the adjustment, altering the color of the image and allowing for the
correction or introduction of color casts.
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These parameters control calibration and individual printer points for each color channel.
• Printer Points Calibration: This value calibrates the printer points system according to
the film gamma standard you wish to use. The default value of 7.8 is derived by
multiplying the value 12 (points per ƒ-stop) by a value of 0.65 (the default film gamma
standard used). 0.65 * 12 = 7.8. To recalibrate for a different film gamma value, insert
your own gamma value into the equation.
• Printer Points Red: The value with which to raise or lower the red channel.
• Printer Points Green: The value with which to raise or lower the green channel.
• Printer Points Blue: The value with which to raise or lower the blue channel.
Note: There is also a printer points node available in the Color FX room, which works
identically to the parameters covered in this section.
Using the Auto Balance Button
The Auto Balance button performs an automatic analysis of the current shot, based on
the frame at the position of the playhead. This is useful for quickly bringing a problem
shot with a subtly inobvious color cast to a neutral state, prior to performing further color
correction.
When you click this button, Color automatically samples the darkest and lightest 5 percent
of the image’s Luma channel in order to determine how to make shadow and highlight
adjustments to neutralize any color casts that are present in the image. In addition, the
black and white points of the image are adjusted to maximize image contrast, so that
the shot occupies the widest available range from 0 to 100.
Note: Unlike the Auto Balance controls in the Final Cut Pro Color Corrector 3-way filter,
the Auto Balance button is completely automatic, and does not require you to select
individual areas of the image for analysis.
To use the Auto Balance button
1 Move the playhead in the Timeline to a representative frame of the shot you want to
automatically color balance.
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Once the analysis has been performed, the Red, Green, and Blue Lift and Gain parameters
in the Advanced tab of the Primary In room are automatically set to contain the results
of these adjustments. The result should render whites, grays, and blacks in the image
completely neutral.
Since the necessary adjustments are made to the Lift and Gain parameters in the Advanced
tab, the main Shadow, Midtone, Highlight, and Curves controls remain unused and remain
available to you for further adjustment of the image.
The RED Tab
When native RED QuickTime media is sent to or imported into Color, a RED tab appears
in the Primary In room, next to the Basic and Advanced tabs. There is no corresponding
RED tab in the Primary Out room.
Important: This tab only appears if you’ve installed the appropriate RED supporting
software for Final Cut Studio.
The RED camera writes raw, linear light image data to the R3D files that are recorded. The
controls found in the RED camera’s Audio/Video menus in no way alter the way the image
data is written within each R3D file. Instead, whatever settings were chosen at the time
are stored within each recorded clip as metadata (similar to a LUT) that determines how
these media files are displayed by compatible software. This metadata can be overridden
during the Log and Transfer process in Final Cut Pro.
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the clip Color, Color Temp, and View metadata originally written by the RED camera.
However, this metadata can also be overwritten during ingest using a custom color
processing option in the Log and Transfer window. These parameters are provided so
that you can begin grading each clip in the state at which it was originally monitored
during the shoot, or at which it was ingested using the Final Cut Pro Log and Transfer
window.
Note: Although there is functional overlap between the controls found in this tab and
those found elsewhere in Color, the Kelvin and Tint controls are specially calibrated to
provide the most photometrically accurate white balance adjustments for RED QuickTime
media.
• Enabled: Turns all of the parameters found within the RED tab on or off. Turning Enabled
off suspends the effect of these parameters on the final rendered image in Color.
• Saturation: This parameter is available in the RED camera’s Color submenu, and adjusts
the color intensity of the image. The overall range is 0 (monochome) through 5.0
(extremely high), where 1 is unity.
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Tint. This setting is designed to compensate for the “warmth” of the available lighting
to keep white elements of the scene looking neutral. Low Kelvin values will compensate
for “warmer” lighting (such as tungsten), while higher Kelvin values compensate for
“cool” lighting (such as noon-day sun or overcast days). Two user-selectable options
set Kelvin to predetermined values: Tungsten (3,200K), and Daylight (5,600K). The Auto
WB option automatically chooses a custom value for this parameter based on analysis
of a white card, while Manual WB lets the operator choose any value. The correction
made by this parameter is designed to work specifically with RED linear light image
data to provide the most photometrically correct result.
• Tint: This value is adjustable within the RED camera’s Color Temp menu, along with
Kelvin. Tint is designed as an additional white balance compensation for light sources
with a green or magenta component, such as fluorescent or sodium vapor bulbs. The
correction made by this parameter is designed to work specifically with RED linear light
image data to provide the most photometrically correct result.
• Exposure: Available in the RED camera’s Color menu. Increases and lowers image
lightness in increments calibrated to ƒ-stops. When raising the signal up to 100 or
lowering it down to 0, the image is clipped at the boundaries of broadcast legality. The
overall range is –7 to +7, where 0 is unity.
• Red, Green, and Blue Gain: Available in the RED camera’s Gain submenu. Allows individual
adjustment of each color channel. Adjusting any of these gain parameters boosts or
lowers the maximum value of the corresponding color channel and scales the midtones
while pinning the bottom of the channel to 0 percent. Lowering does the opposite.
The overall range is 0 to 10, where 1 is unity.
• Contrast: Available in the RED camera’s Color menu. Raising the contrast boosts the
highlights and lowers the shadows, while leaving the midtones centered around 50
percent unaffected. As the video signal reaches the boundaries of 100 and 0 percent,
it’s compressed rather than clipped. The overall range is –1 to +1, where 0 is unity.
• Brightness: Available in the RED camera’s Color menu. Raises and lowers image lightness.
When raising the signal close to 100 or lowering it down to 0, the image is compressed
rather than clipped. The overall range is –10 to +10, where 0 is unity.
• Gamma pop-up menu: In-camera, the Gamma setting is determined by the Color Space
option that’s selected in the RED Camera’s View menu. (It’s not available as an
individually adjustable parameter.) There are six options for gamma available in Color.
• Linear: No gamma adjustment is applied, linear-to-light as captured by the Mysterium
sensor.
• Rec. 709: The standard Gamma curve as specified by the Rec. 709 standard for video
gamma.
• REDspace: Similar to Rec. 709, but tweaked to be perceptually more appealing, with
higher contrast and lighter midtones.
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image data to a 10-bit curve. The blacks and midtones that occupy the lowest 8 bits
of the video signal maintain the same precision as in the original 12-bit data, while
the highlights that occupy the highest 4 bits are compressed. While this reduces the
precision of detail in the highlights, this is a relative loss as the linearly encoded data
has an overabundance of precision.
• PDLOG 685: Another logarithmic gamma setting that maps the native 12-bit RED
image data into the linear portion of a Cineon or film transfer curve.
• Color Space pop-up menu: These options are available in the RED Camera’s View menu.
(In-camera, these options are tied to corresponding gamma settings.)
• CameraRGB: Identified on the camera as RAW, this mode bypasses the RED camera
matrix and represents the original, uncorrected sensor data.
• REDspace: Fits the raw RED image data into a color space that’s larger than that of
Rec. 709. Appropriate for digital cinema mastering and film output.
• Rec. 709: Fits the raw RED image data into the standard color space specified by the
Rec. 709 standard for high definition video. Appropriate for HD video mastering.
• ISO pop-up menu: A gain operation (similar to Exposure), which pins the black point at
0 while raising or lowering the white point of the image, linearly scaling everything in
between. The range is 100–2000; 320 is the default unity gain setting (no change is
made). Raising the signal too much can result in clipping.
Important: Changing the ISO setting of your RED camera does not alter the recorded
data. However, since it changes the lightness of the image you’re monitoring during
the shoot, it will influence how you light the scene and adjust the camera’s iris.
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adjust it without affecting the rest of the picture.
Once you’ve made your initial corrections using the Primary In room, the next step in
adjusting any shot is to move on to the Secondaries room to make more targeted
adjustments.
This chapter covers the following:
• What Is the Secondaries Room Used For? (p. 258)
• Where to Start in the Secondaries Room? (p. 259)
• The Enabled Button in the Secondaries Room (p. 260)
• Choosing a Region to Correct Using the HSL Qualifiers (p. 261)
• Controls in the Previews Tab (p. 268)
• Isolating a Region Using the Vignette Controls (p. 270)
• Adjusting the Inside and Outside of a Secondary Operation (p. 277)
• The Secondary Curves Explained (p. 278)
• Reset Controls in the Secondaries Room (p. 283)
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10What Is the Secondaries Room Used For?
The Secondaries room has been designed for maximum flexibility. While its central purpose
is to facilitate targeted corrections to specific features of the image, it can be used for a
variety of tasks.
• Isolating areas for targeted corrections: This is the primary purpose of the Secondaries
room. Using a variety of techniques, you can perform functions such as isolating the
highlights in an image to change the quality of light; targeting the color of an overly
bright sweater to desaturate it without affecting the rest of the image; or selecting an
actor’s face to create a post-production sunburn. Once you master the ability to
selectively adjust portions of the image, the possibilities are endless.
Before After
• Creating vignetting effects: Traditionally, vignettes used for creative purposes described
a darkening around the edges of the image that used to be created with mattes or lens
filters. You can create any type of vignette you need using either preset or custom
shapes, to darken or otherwise flag areas of the image. Vignettes can be used to focus
viewer attention by highlighting a subject in the foreground or by shading background
features that you don’t want sticking out.
Before After
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drawing custom shapes to isolate regions of the image and add beams or pools of light
where previously there were none. This can come in handy in situations where the
lighting is a bit flat, and you want to add some interest to a feature in the scene.
Before After
• Making modifications changing the Primary In correction: A somewhat unconventional
use of the Secondaries room is to apply an additional correction to the entire image
on top of the original correction you made with the Primary In room. When all three
secondary qualifiers are set to include the entire image (which is the default setting),
adjustments made with the color balance, contrast, and saturation controls affect
everything in the frame, just as they do in the Primary In room. You can use this to
keep stylized adjustments separate from the baseline corrections you’re making in the
Primary In room. For more information on this type of workflow, see Managing a Shot’s
Corrections Using Multiple Rooms.
Where to Start in the Secondaries Room?
The process of secondary color correction is fairly straightforward and involves the
following steps.
• Stage 1: Isolating the Region You Need to Adjust
• Stage 2: Making Color Balance, Contrast, and Saturation Adjustments
• Stage 3: Moving Through the Eight Tabs to Make More Corrections
Stage 1: Isolating the Region You Need to Adjust
There are three basic methods you can use to isolate, or qualify, features or areas within
an image in the Secondaries room:
• Key on a range of color, saturation, or brightness.
• Use a shape as a mask.
• Use one of the secondary curves to selectively adjust a portion of the spectrum.
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image to work on, the Control pop-up menu lets you apply separate operations to the
inside and outside of the selection.
Stage 2: Making Color Balance, Contrast, and Saturation Adjustments
After you’ve qualified an area for correction, you can use the same color balance controls,
primary contrast sliders, Saturation and Lift/Gain/Gamma parameters in the Basic tab, as
well as the RGB parameters in the Advanced tab that are available in the Primary In room.
For more information about these controls, see The Primary In Room.
Note: There is one additional correction parameter available in the Secondaries room
that’s not available in the Primary In and Out rooms, and that is the Global Hue parameter.
Using Global Hue, you can rotate the hue of every single color in the image at once. Unlike
the other parameters in the Secondaries room, Global Hue affects every pixel of the image,
and is not limited by the HSL qualifiers or the vignette controls.
Stage 3: Moving Through the Eight Tabs to Make More Corrections
Once you’ve completed the correction at hand, you can move on to the next secondary
operation you need to perform. The Secondaries room supports up to eight separate
secondary operations (although you may only have seven if you’re in single display mode).
In the next few sections, you’ll learn how to isolate areas of the image in different ways.
The Enabled Button in the Secondaries Room
The Enabled button, at the top left of the Secondaries control area, is one of the most
important controls in this room. Each of the eight tabs in the Secondaries room has its
own Enabled button.
Whenever you make an adjustment to any parameter or control in the Secondaries room,
this button is automatically turned on.
This button can be used to disable any Secondaries tab. For example:
• You can turn the Enabled button off and on to get a before-and-after preview of how
the secondary is affecting the image.
• You can turn the Enabled button off to disable a secondary effect without resetting it,
in case you want to bring it back later.
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to control this button to turn a secondary effect on and off as the shot plays. For more
information on keyframing, see Keyframing Secondary Corrections.
Choosing a Region to Correct Using the HSL Qualifiers
One of the most common ways of isolating a feature for targeted correction is to use the
HSL qualifiers (so named because they qualify part of the image for correction) to key on
the portion you want to color correct. HSL stands for hue, saturation, and lightness, which
are the three properties of color that together define the entire range of color that can
be represented digitally.
HSL qualification is often one of the fastest ways to isolate irregularly shaped subjects,
or subjects that are moving around in the frame. However, as with any chroma or luma
key, the subject you’re trying to isolate should have a color or level of brightness that’s
distinct from the surrounding image. Fortunately, this is not unusual, and reddish skin
tones, blue skies, richly saturated clothing or objects, and pools of highlights and shadows
are often ideal subjects for secondary correction.
If you’re familiar with the Limit Effect controls of the Color Corrector 3-way filter in
Final Cut Pro, you’ll find that the Secondaries room HSL controls work more or less the
same way.
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lightness, you create a matte that is then used to define the region to which corrections
are applied. Everything outside the matte remains unaffected (although you can also
specify which portion of the matte you want to adjust, the inside or the outside).
Original image HSL qualifier settings
Matte Corrected image
The HSL Qualifier controls always sample image data from the original, uncorrected image.
This means that no matter what adjustments have been made in the Primary In room,
the original image values are actually used to pull the key. For example, even if you
completely desaturate the image in the Primary In room, you can still pull a chroma key
in the Secondaries room.
Tip: It is not necessary to use all three qualifiers when keying on a region of the image.
Each qualifier has a checkbox and can be turned on and off individually. For example, if
you turn off the H (hue) and S (saturation) controls, you can use the L (lightness) control
by itself as a luma keyer. This is a powerful technique that lets you isolate areas of an
image based solely on image brightness.
Creating Fast Secondary Keys Using the HSL Eyedropper
The eyedropper, at the top-left corner of the Basic tab, provides a quick and easy way to
sample color values from images you’re correcting.
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1 Click the eyedropper.
The eyedropper becomes highlighted, and crosshairs appear superimposed over the
image in the preview and broadcast monitors. You use these crosshairs to sample the
HSL values from pixels in the image.
2 Move the mouse to position the crosshairs on a pixel with the color you want to key on,
then click once to sample color from a single pixel.
The crosshairs disappear, and the HSL controls are adjusted to include the sampled values
in order to create the keyed matte. In addition, the Enabled button turns on automatically
(which turns on the effect of the secondary operation in that tab). The Previews tab
becomes selected in the middle of the Secondaries room, showing the keyed matte that’s
being created by the HSL qualifiers. (For more information, see Controls in the Previews
Tab.)
Once you’ve created the keyed matte, the next step is to use the color correction controls
at the top of the Secondaries room to actually make the correction. For more information,
see The Primary In Room.
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an entire range of values.
To use the eyedropper to sample a range of values
µ Click the eyedropper, then drag the crosshairs over the range of pixels you want to sample.
The HSL controls expand to include the entire range of hues, saturation, and lightness in
the pixels you sampled. As a result, the keyed matte in the Previews tab is much more
inclusive.
To expand the HSL selection using the eyedropper
µ Click the eyedropper, then hold down the Shift key and either click a single pixel or drag
over a range of pixels with the crosshairs.
The crosshairs disappear, and the HSL controls are expanded to include the range of
sampled values you dragged on to expand the keyed matte in the Previews tab.
Note: When selecting a range of multiple HSL values, you can only select a contiguous
range of values. You cannot, for example, exclude yellow if you’ve included both red and
green, since yellow falls in between. If you need to select noncontiguous HSL ranges, you
should use multiple secondary operations. For example, choosing red with Secondaries
tab 1, and choosing green with Secondaries tab 2.
The HSL Controls
You don’t have to use the eyedropper to select a range of HSL values. You can also use
the HSL controls at the top of the Basic tab to select specific ranges of hue, saturation,
and lightness directly.
Each of these qualifiers can be turned on and off individually. Each qualifier that’s turned
on contributes to the keyed matte. Turning a qualifier off means that aspect of color is
not used.
264 Chapter 10 The Secondaries RoomEach qualifier has three sets of handles—center, range, and tolerance—which correspond
to three knobs on compatible control surfaces. These handles can also be manipulated
directly onscreen using the mouse.
Range
Center
Tolerance HSL Qualifiers Explained
To make HSL adjustments efficiently, you should have an in-depth understanding of the
nature of each type of adjustment.
• H (hue): Defines the range of colors that contribute to the key. Using hue by itself to
define a keyed matte can yield similar results to using the Hue, Sat, and Lum secondary
curves. Because the visible spectrum is represented by a wraparound gradient, the H
handles are the only ones that wrap around the ends of this control, allowing you to
select a complete range of blue to green, when necessary.
• S (saturation): Defines the range of saturation that contributes to the key. Using
saturation by itself to define a keyed matte can be effective for manually limiting
oversaturated colors. Using saturation and hue, but excluding lightness, lets you
manually limit specific colors throughout the image regardless of their lightness.
• L (lightness): Defines the range of lightness that contributes to the key. Using lightness
by itself to define a keyed matte is an extremely powerful technique that lets you quickly
isolate regions of the highlights, midtones, or shadows to perform specific adjustments
such as increasing or reducing the specific lightness of shadows, or manipulating the
color within highlights.
• Reset button: Resets all three qualifiers to the default state, which is an all-inclusive
selection.
HSL Qualifier Controls
This section describes the HSL qualifier controls.
• Center: A single handle defines the middle of the selected range of values.
• Range: An inner pair of handles to the left and right of the center handle defines the
initial range of values that contribute to the keyed matte. These are the solid white
pixels seen in the matte.
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values to create falloff, giving a soft edge to the keyed matte. These are the lighter gray
pixels seen in the matte.
Adjusting the HSL Controls
This section explains how to adjust the HSL controls.
To adjust the center point for any qualifier
µ Drag anywhere within the center of the two Range handles.
To make a symmetric adjustment to the Range handles
µ Drag the Range handles directly, or drag anywhere between the Range and Tolerance
handles (if the tolerance is wide enough) to widen or narrow the range.
To make an asymmetric adjustment to the Range handles
µ Hold down the Shift key and drag the handle you want to adjust; the opposing handle
remains fixed in place.
When you make an asymmetric adjustment, the center point also readjusts to match the
new range.
Note: You cannot make asymmetric adjustments using knobs on a control surface.
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µ Drag anywhere outside of the Center, Range, and Tolerance handles to widen or narrow
the tolerance.
You can also make asymmetric adjustments to tolerance by holding down the Shift key
while dragging.
The Color Swatches
A set of six swatches underneath the HSL qualifiers lets you automatically set the Hue
qualifier to a narrow range that’s centered on one of the primary red, green, and blue,
and secondary cyan, magenta, and yellow colors.
The swatches can be useful when you need to quickly make a hue selection for a feature
in the image that corresponds to one of these colors. When you choose one of these
swatches, the Saturation and Lightness controls remain completely unaffected.
To adjust the Hue qualifier using one of the color swatches
µ Shift-click any of the swatches.
The Hue qualifier resets itself to select the corresponding range of color.
Key Blur
The Key Blur parameter lets you apply a uniform blur to the keyed matte in order to soften
it. This can go a long way toward making an otherwise noisy or hard-to-pull key usable.
This parameter defaults to 0, with a maximum possible value of 8.
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into the Key Blur field.
No key blur With key blur One of the nice things about keying for color correction is that, unlike keying to create a
visual effects composite, you don’t always have to create keyed mattes with perfect edges
or completely solid interiors. Often an otherwise mediocre key will work perfectly well,
especially when the adjustment is subtle, so long as the effect doesn’t call attention to
itself by adding noise, or by causing vibrating “chatter” around the edges of the matte.
For example, holes in a keyed matte often correspond to shadows that are falling on the
subject you’re isolating. If you’re making a naturalistic adjustment to the highlights of
the image, you probably don’t want to include such shadowed areas in the correction,
so there’s no need to make further adjustments to the matte.
Check Your Secondary Keys During Playback
It’s always important to double-check to see how the secondary keys you pull look
during playback. Sometimes a secondary operation that looked perfectly good while
you were making the correction exhibits flickering or “chatter” at the edges that is the
result of noise, or of including a range of marginal values that are just at the edge of
the selected range. (This happens frequently for “hard-to-key” features in an image.) In
these cases, additional adjustments may be necessary to eliminate the problem.
Also, secondary keys that work well in one part of a shot may not work as well a couple
of seconds later if the lighting changes. Before moving on, it’s always a good idea to
see how a secondary operation looks over the entire duration of a shot.
Controls in the Previews Tab
The Previews tab is a two-part display that helps you guide your adjustments while you
use the HSL qualifiers and the vignette controls. Two reduced-resolution images show
you different views of the operation you’re performing.
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the Scopes window only when the Previews tab in the Secondaries room is selected.
Matte Preview 
Mode buttons
Vignette outline
Vignette preview HSL Qualifier Matte preview
• Vignette preview: The image on the left (above) shows you the position and size of the
currently selected vignette shape, when the Vignette button is enabled. When you use
the square or circle vignette, this window also contains an onscreen control you can
use to move, resize, and soften the vignette. If you’ve selected a user shape in the
Geometry room instead, you’ll see a noneditable outline of that shape. For more
information, see Isolating a Region Using the Vignette Controls.
• HSL qualifier preview: The image on the right shows you the matte that’s being generated
by the HSL qualifiers. This window does not include the mask that’s generated by the
vignette controls, nor does it display the HSL matte as it appears when the Key Blur
parameter is used. (The final HSL matte as it’s modified by both vignetting and key blur
is visible in the preview display only when the Matte Preview Mode is set to Matte
Only.)
The white areas of the mask indicate the parts of the image that are selected with the
current qualification settings, that will be affected by the adjustments you make. The
black areas of the image are the parts of the picture that remain unaffected.
• Matte Preview Mode buttons: These buttons control what is visible in the preview display
in the Scopes window. There are three modes:
• Final image: Shows a preview of how the final effect looks. This is similar to the
ordinary preview that’s displayed in the Scopes window, except that it also shows
the vignette outline, when the Vignette button is enabled.
• Desaturated preview: The areas of the image that are selected with the current
qualification settings appear in color, while the areas of the image that remain
unaffected are desaturated and appear monochrome.
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the image displayed in the HSL Qualifier preview display, except that it shows the
sum of the vignette mask and the HSL mask, as well as the results of the mask as it’s
modified by the Key Blur parameter.
Final image Desaturated preview
Matte only
• Vignette outline button: When the Vignette button is turned on, the Vignette outline
button lets you display or hide the vignette outline that appears in the Preview window.
Isolating a Region Using the Vignette Controls
The vignette controls give you an extremely fast way to isolate areas of an image that
are geometrically round or rectangular, such as the face of someone in close-up, or a
window in the background. Vignettes are also useful for isolating subjects that are too
hard to key using the HSL qualifiers.
On the other hand, if the subject you’re vignetting moves, you need to either keyframe
the shape to move along with it (see Keyframing) or use motion tracking to automatically
create a path for the shape to follow. (For more information, see The Tracking Tab.)
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darkening. One common example of this is to use a shape to surround a region of the
image you want to draw the viewer’s attention to, switch the Control pop-up menu to
Outside, and darken the background outside of this shape using the contrast sliders to
make the subject “pop out” more, visually.
Before After vignette adjustment
Lastly, if the square or circle vignettes aren’t sufficient for isolating an irregularly shaped
subject, you can create a custom User Shape in the Shapes tab of the Geometry room,
and use that to limit the correction. You could go so far as to rotoscope (the process of
tracing something frame by frame) complex subjects in order to create highly detailed
adjustments that are too difficult to isolate using the HSL qualifiers.
User Shapes can be edited and animated only in the Geometry room, but the mattes
they create can be used to isolate adjustments in any of the eight Secondaries tabs.
The Vignette Controls
The vignette controls are located underneath the Previews tab. Some of these controls
can also be manipulated using the onscreen controls in the Previews tab.
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the vignette. See Setting Up a Control Surface for more information.
• Vignette button: This button turns the vignette on or off for that tab.
• Use Tracker pop-up menu: If you’ve analyzed one or more motion trackers in the current
project, you can choose which tracker to use to automatically animate the position of
the vignette using this pop-up menu. To disassociate a vignette from the tracker’s
influence, choose None.
Note: When Use Tracker is assigned to a tracker in your project, the position of the
vignette (the center handle) is automatically moved to match the position of the
keyframes along that tracker’s motion path. This immediately transforms your vignette,
and you may have to make additional position adjustments to move the vignette into
the correct position. This is especially true if the feature you’re vignetting is not the
feature you tracked.
• Shape pop-up menu: This pop-up menu lets you choose a shape to use for the vignette.
• Square: A user-customizable rectangle. You can use the onscreen controls in the
Previews tab or the other vignette parameters to modify its position and shape. For
more information, see Using the Onscreen Controls to Adjust Vignette Shapes.
• Circle: A user-customizable oval. You can either use the onscreen controls in the
Previews tab, or the other vignette parameters to modify its position and shape.
• User Shape: Choosing User Shape from the Shape pop-up menu automatically moves
you to the Shapes tab of the Geometry room, where you can click to add points to
draw a custom shape to use for the vignette. When you finish, click the Attach button,
and then go back to the Secondaries room to make further adjustments. When you
use a User Shape as the vignette, the rest of the vignette parameters become
unavailable; you can modify and animate that shape only from the Shapes tab of the
Geometry room. For more information, see The Shapes Tab.
Parameters That Adjust Square or Circle Vignettes
The following parameters are only available when you use the Square or Circle options
in the Shape pop-up menu.
• Angle: Rotates the current shape.
• X Center: Adjusts the horizontal position of the shape.
• Y Center: Adjusts the vertical position of the shape.
• Softness: Blurs the edges of the shape.
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• Aspect: Adjusts the width-to-height ratio of the shape.
Using the Onscreen Controls to Adjust Vignette Shapes
The Angle, X Center, Y Center, Softness, Size, and Aspect parameters can all be adjusted
via onscreen controls in the image on the left of the Previews tab.
Note: Although you can also view the outlines that correspond to these onscreen controls
in the preview display of the Scopes window when you turn the Vignette Outline button
on, this outline has no onscreen controls that you can manipulate. You can only make
these adjustments in the Previews tab.
To move the vignette
µ Drag anywhere inside or outside the shape in the Previews tab to move the vignette in
that direction.
The X Center and Y Center parameters are simultaneously adjusted. Color uses the same
coordinate system as Final Cut Pro to define position.
To resize the vignette
Do one of the following:
µ Drag any of the four corners of the vignette to resize the vignette relative to the opposite
corner, which remains locked in position.
µ Option-drag to resize the vignette relative to its center. (The center of a vignette is visible
as green crosshairs.)
µ Shift-drag to resize the vignette while locking its aspect, enlarging or reducing the shape
without changing its width-to-height ratio.
Depending on the operation you perform, the X and Y Center, Size, and Aspect parameters
may all be adjusted.
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µ Right-click or Control-click any of the four corners of the vignette and drag to rotate it to
the left or right.
To adjust the softness of the vignette
µ Middle-click and drag to blur the edges of the vignette.
This adjustment modifies the Softness parameter. The degree of softness is visualized in
the Previews tab with a pair of concentric circles. The inner circle shows where the edge
blurring begins, and the outer circle shows where the edge blurring ends, along with the
shape.
Animating Vignettes
One of the most common operations is to place an oval over someone’s face and then
either lighten the person, or darken everything else, to draw more attention to the
subject’s face. If the subject is standing still, this is easy, but if the subject starts to shift
around or move, you need to animate the vignette using keyframes so that the lighting
effect follows the subject. For more information on keyframing, see Keyframing.
Another option is to use the motion tracker to automatically track the moving subject,
and then apply the analyzed motion to the vignette. For more information, see The
Tracking Tab.
Creating a User Shape for Vignetting
The following procedure outlines how you use the User Shape option in the Shape pop-up
menu of the vignette controls.
To use a user shape for vignetting
1 Open the Secondaries room, click one of the eight Secondaries tabs to select which
secondary operator to work on, and then select the Vignette checkbox to enable the
vignette controls.
2 Choose User Shape from the Shape pop-up menu.
The Shapes tab of the Geometry room opens, with a new shape in the shapes list to the
right, ready for you to edit.
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to isolate, then click the first control point you created to close the shape and finish
adding points.
The shapes you draw in the Geometry room default to B-Spline shapes, which use control
points that are unattached to the shape they create to push and pull the shape into place
(similar to the B-Splines used by the curves controls in the Primary In and Out rooms).
You can also change these shapes to simple polygons if you need a shape with hard
angles rather than curves, by clicking the Polygon button in the Shapes tab. For more
information on working with shapes, see The Shapes Tab.
Tip: If you’re not sure how many control points to add to create the shape you want,
don’t hesitate to create a few more than you think you’ll need. It’s easy to edit them after
they’re created, but you can’t add or remove control points to shapes that have already
been created.
4 If necessary, edit the shape to better fit the feature you’re trying to isolate by dragging
the control points to manipulate the shape.
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Two additional editable shapes appear to the inside and outside of the shape you drew.
The inner shape shows where the feathering begins, while the outer shape shows the
very edge of the feathered shape. If necessary, each border can be independently adjusted.
6 As an optional organizational step, you can type an identifying name into the Shape
Name field, and press Return to accept the change.
7 Click Attach, at the top of the Shapes tab, to attach the shape you’ve created to the tab
of the Secondary room you were in. (The number of the secondary tab should be displayed
in the Current Secondary field at the top of the Shapes tab.)
8 If necessary, you can also add keyframes or motion tracking to animate the shape to
match the motion of the camera or subject, so the shape you created matches the action
of the shot.
9 When you finish with the shape, open the Secondaries room.
You’ll see the shape you created within the vignette area of the Previews tab. At this
point, the matte that’s created by the shape can be used to limit the corrections you
make, as with any other secondary matte.
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assigned become disabled. If at any point you need to edit the shape, you must do so in
the Geometry room; the secondary corrections that use that shape will automatically
update to reflect your changes.
Using Secondary Keying and Vignettes Together
When you turn on the vignette controls while also using the HSL qualifiers to create a
secondary key, the vignette limits the matte that’s created by the key. This can be
extremely helpful when the best-keyed matte you can produce to isolate a feature in the
frame results in unwanted selections in the background that you can’t eliminate without
reducing the quality of the matte. In this case, you can use the vignette as a garbage
matte, to eliminate parts of the keyed matte that fall outside the vignette shape.
Adjusting the Inside and Outside of a Secondary Operation
You can choose whether the color, contrast, and saturation adjustments you make affect
the inside or the outside of the isolated feature using the Control pop-up menu.
One of the most powerful features of the Secondaries room is the ability to apply separate
corrections to the inside and outside of a secondary matte in the same tab. This means
that each of the eight secondary tabs can actually hold two separate corrections.
Whenever you choose another region to work on, the controls update to reflect those
settings.
• Control pop-up menu: The Control pop-up menu also provides additional commands
for modifying these settings.
• Inside: The default setting. When set to Inside, all adjustments you make affect the
interior of the secondary matte (the area in white, when looking at the mask itself).
Before inside adjustment After
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of the secondary matte (the area in black). Making a darkening adjustment to the
outside of a softly feathered circle matte that surrounds the entire frame is one way
of creating a traditional vignette effect.
Before outside adjustment After
• Copy Inside to Outside: Copies the correction that’s currently applied to the inside of
the matte to the outside as well. This is a handy operation if you want to copy the
same correction to the outside as a prelude to making a small change, so that the
difference between the corrections applied to the inside and the outside is not so
large.
• Copy Outside to Inside: Copies the correction that’s applied to the outside to the
inside.
• Swap: Switches the corrections that are applied to the inside and outside of the
secondary matte, so that they’re reversed.
The Secondary Curves Explained
The secondary curves are a deceptively powerful set of controls that allow you to make
very small or large adjustments to the hue, saturation, and luminance of an image based
solely on regions of hue that you specify using control points on a curve.
Important: Curves cannot be animated with keyframes, although just about every other
parameter in the Secondaries room can be.
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of the secondary curves controls defaults to a flat horizontal line running halfway through
the graph area.
The visible spectrum is represented along the surface of the curve by a wrap-around
gradient, the ends of which wrap around to the other side of the curve. The control points
at the left and right of this curve are linked, so that moving one moves the other, to
ensure a smooth transition if you make any adjustments to red, which wraps around the
end of the curve.
Tip: If you’re having a hard time identifying the portion of curve that affects the part of
the image you want to adjust, you can use the color swatches in the 3D scopes to sample
a pixel from the preview, and a horizontal indicator will show the point on the curve that
corresponds to the sampled value. For more information, see Sampling Color for Analysis.
Adding points to the surface of this curve lets you define regions of hue that you want
to adjust. Raising the curve in these regions increases the value of the particular aspect
of color that’s modified by a specific curve, while lowering the curve decreases the value.
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green-through-blue range of the curve, you can smoothly desaturate everything that’s
blue and green throughout the frame, while leaving all other colors intact.
Before After
Sat curve adjustment One of the nicest aspects of these controls is that they allow for extremely specific
adjustments to narrow or wide areas of color, with exceptionally smooth transitions from
the corrected to the uncorrected areas of the image. In many instances, the results may
be smoother than might be achievable with the HSL qualifiers.
Another key advantage these controls have over the HSL qualifiers is that you can make
simultaneous adjustments to noncontiguous ranges of hue. In other words, you can boost
or lower values in the red, green, and blue areas of an image while minimizing the effect
of this adjustment on the yellow, cyan, and magenta portions of the image.
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and edit control points on the secondary curves in exactly the same way. For more
information, see Curve Editing Control Points and B-Splines.
Important: Adjustments made using the secondary curves cannot be limited using the
vignette or HSL controls.
Using the Secondary Curves
This section provides examples of how to use each of the three kinds of secondary curves.
Important: Curves cannot be animated with keyframes, although just about every other
parameter in the Secondaries room can be.
The Hue Curve Tab
When you raise or lower part of the secondary Hue curve, you make a hue adjustment
similar to the one you make when you use the Global Hue control, except that you only
rotate the hue value for the selected range of hue specified by the curve. Raising the
curve shifts the values toward red, while lowering the curve shifts the values toward blue.
Before
Hue curve adjustment
After
This control can be valuable for making narrow, shallow adjustments to the reddish/orange
section of the spectrum that affects skin tones, in order to quickly and smoothly add or
remove warmth.
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Raising the Saturation curve increases the saturation in that portion of the spectrum,
while lowering it decreases the saturation. This is a powerful tool for creating stylized
looks that enhance or subdue specific colors throughout the frame.
Before
Sat curve adjustment
After
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Raising the Luminance curve lightens the colors in that portion of the spectrum, while
lowering it darkens them. This is a good tool to use when you need to make contrast
adjustments to specific regions of color.
Before
Lum curve adjustment
After
Reset Controls in the Secondaries Room
The Secondaries room has two reset buttons, which are used to reset adjustments made
in the secondary tabs.
• Reset Secondary button: Resets only the currently open secondary tab.
• Reset All Secondaries button: Resets every secondary tab in the Secondaries room. Use
this button with care.
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look you need, Color FX lets you create sophisticated effects using a node-based interface.
The Color FX room is a node-based effects environment. It’s been designed as an
open-ended toolkit that you can use to create your own custom looks by processing an
image with combinations of operations that take the form of nodes. Each node is an
individual image processing operation, and by connecting these nodes into combinations,
called node trees, you can create sophisticated effects of greater and greater complexity.
This chapter covers the following:
• The Color FX Interface Explained (p. 286)
• How to Create Color FX (p. 286)
• Creating Effects in the Color FX Room (p. 294)
• Using Color FX with Interlaced Shots (p. 300)
• Saving Favorite Effects in the Color FX Bin (p. 301)
• Node Reference Guide (p. 302)
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The Color FX Room
11The Color FX Interface Explained
The Color FX room is divided into four main areas.
Node list Node view Parameters Color FX bin
The functionality of these areas is as follows:
• Node list: A list at the left of the Color FX room contains every image processing
operation that you can add. Some of these nodes are single input, performing that
operation to whatever image is input into them, while others are multi-input, taking
multiple versions of the image and combining them using different methods. All nodes
are alphabetically organized.
• Node view: The Node view, at the center of the Color FX room, is the area where nodes
that you create appear and are connected together and arranged into the node trees
that create the effect.
• Parameters tab: When you select a node in the Node view, its parameters appear in
this tab so that you can adjust and customize them.
• Color FX bin: This bin works similarly to the corrections and Grades bins, giving you a
way of saving effects that you create for future use.
How to Create Color FX
The Color FX room is not a compositing environment in which you combine multiple
images together. The only image you can bring into this room for processing is that of
the current shot. You create effects by assembling one or more image processing nodes
into node trees; these work together to reprocess the image in different ways. For more
information, see:
• How Node Trees Work
• Node Inputs and Outputs Explained
• Creating and Connecting Nodes
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• Bypassing Nodes
• Cutting, Copying, and Pasting Nodes
How Node Trees Work
In the Color image processing pipeline, the Color FX room processes the image as it
appears after whatever corrections have been applied in the Primary In and Secondaries
rooms. Unattached node inputs automatically connect to the state of the image as it’s
affected by the Primary In and Secondaries rooms. This is how each node tree begins,
with an empty input that’s automatically connected to the corrected image.
Note: The sole exception to this is the Color node, which generates a frame of solid color
that you can use with multi-input math nodes to tint an image in different ways.
To perform more operations on an image, you simply add more nodes, connecting the
outputs of previously added nodes to the inputs of new nodes using noodles.
You can think of a node tree as a waterfall of image processing data. Image processing
operations begin at the top and cascade down, from node to node. Each node exerts its
effect on the image that’s output from the node above it, until the bottom is reached, at
which point the image is at its final state.
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the image that’s been processed by the Color FX room back into the Color image
processing pipeline. If there is no Output node, or if the Output node is disconnected,
then the node tree will have no effect on that shot, and its effect will not be rendered by
the Render Queue.
Note: A CFX bar will only appear in the grades track of the Timeline for clips with
connected Output nodes. For more information on correction bars in the Timeline, see
Basic Timeline Elements.
Node Inputs and Outputs Explained
Single input nodes take the image and perform an operation upon it. Single input nodes
can only process one incoming image at a time, so you can only connect a single noodle
to any one input.
Multi-input nodes are designed to combine multiple variations of the image in different
ways, in order to produce a single combined effect. These nodes provide multiple inputs
so that you can connect multiple noodles.
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feed duplicate versions of the image as it appears at that point in the tree to multiple
operations.
When you position the pointer over any node’s input, a small tooltip appears that displays
its name. This helps you to identify which input to connect a node to so you can achieve
the result you want.
Creating and Connecting Nodes
In this section, you’ll learn the methods used to add, delete, and arrange nodes to a tree
to create any effect.
To add a node to the Node view along with an automatically attached Output node
µ Drag the first node you create from the Node list into the Node view.
The first node you drag into the Timeline from the Node list always appears with an
Output node automatically connected to it.
To add a new node to the Node view
Do one of the following:
µ Double-click any node in the Node list.
µ Select a node from the Node list, then click Add.
µ Drag a node from the Node list into the Node view.
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To insert a new node between two nodes that are already connected
µ Drag a node from the Node list on top of the noodle connecting any two nodes, and
drop it when the noodle turns blue.
To automatically attach a new node to the input or output of a previously created
node
µ Drag a node from the Node list so that the hand pointer is directly on top of a disconnected
input or output, then drop it.
The new node appears with a noodle connecting it to the node input or output you
dropped it onto.
To delete one or more nodes from the Node view
µ Select one or more nodes in the Node view, then press Delete or Forward Delete.
The node disappears, and any noodles that were connected to it are disconnected.
To connect the output of one node to the input of another
µ Drag a noodle from the output of one node to the input of another.
Noodles are green while they’re being created, but turn gray once they’re connected.
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Do one of the following:
µ Click the input of any node with a connected noodle to disconnect it.
µ Drag a noodle from the input of the node you want to disconnect to any empty area of
the Node view.
Tip: If you want to eliminate the effect a node is having without deleting or disconnecting
it, you can turn on its Bypass button, at the top of the Parameters tab. For more
information, see Bypassing Nodes.
When you’re working on large node trees, it pays to keep them organized so that their
operation is clear.
To rearrange nodes in the Node view
Do one of the following:
µ Drag a single node in any direction.
µ Drag a selection box over a group of nodes, then drag any of the selected nodes into any
direction to move them all together.
Adjusting Node Parameters
The operation of most nodes can be customized using parameters that vary from node
to node, depending on a node’s function. All node parameters appear in the Parameters
tab, to the left of the Color FX bin.
To show any node’s parameters in the Parameters tab
µ Click once on the node you want to edit.
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they appear to the right, ready for editing. You can edit node parameters the same way
you edit parameters in any other room.
You can also choose the point in a node tree at which you want to view the image.
To show the image being processed at any node in the Node view
µ Double-click the node you want to view.
The currently viewed node appears highlighted in yellow, and the image as it appears at
that node in the tree appears in the onscreen preview and broadcast output displays.
Note: Because double-clicking a node loads its image and opens its parameters in the
Parameters tab, it appears with a blue outline as well.
For more information on making adjustments to a node while viewing the effect on
another node downstream in the node tree, see Viewing a Node’s Output While Adjusting
Another’s Parameters.
Viewing a Node’s Output While Adjusting Another’s Parameters
When you’re creating multinode effects, it’s often valuable to view a node that appears
at the bottom of the node tree while you’re adjusting a node that’s farther up the tree.
This way you can adjust any parameter while viewing its effect on the entire tree’s
operation.
In the following example, a high-contrast gauzy look is created with a series of nodes
consisting of the B&W, Curve, and Blur nodes on one side (to create a gauzy overlay), and
a Bleach Bypass on the other (providing high contrast), with both sides connected to a
Multiply node to create the gauzy combination.
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contributes to the final effect by adjusting the Curve node, but you need to view the
output of the Multiply node in order to see how far to make the adjustment. In this case,
you double-click the Multiply node so that it becomes the viewed node (highlighted in
yellow).
Then, click the Curve node once to load its parameters into the Parameters tab. (The node
becomes highlighted in cyan.)
Bypassing Nodes
Each node has a Bypass button that appears at the top of its list of parameters. Click
Bypass to turn off the effect that node has on the tree without deleting the node from
the Node view.
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If you want to suspend the effect of an entire node tree without deleting it or individually
turning on each node’s Bypass button, you must disconnect the Output node entirely.
Cutting, Copying, and Pasting Nodes
You can cut, copy, and paste selected nodes in the Color FX room. Using the Copy and
Paste operations, you can duplicate one or more nodes whenever necessary. This can be
especially useful when creating color effects for projects using interlaced media. (For
more information, see Using Color FX with Interlaced Shots.)
To cut one or more selected nodes
µ Choose Edit > Cut (or press Command-X).
The selected nodes are removed from the Node view, and are copied to the Clipboard.
To copy one or more selected nodes
µ Choose Edit > Copy (or press Command-C).
The selected nodes are copied to the Clipboard.
To paste nodes that you’ve previously cut or copied
µ Choose Edit > Paste (or press Command-V).
New instances of whichever nodes were previously cut or copied to the Clipboard appear
in the Node view.
Creating Effects in the Color FX Room
This section outlines some of the most common operations you’ll perform in the Color
FX room. For more information, see:
• Using Single Input Nodes
• Using Layering Nodes
• Math Layering Nodes Explained
• Creating Layered Effects Using Mattes
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The simplest use of this room is to apply one or two single-input nodes to create a stylized
effect. In this case, all you need to do is add the nodes you want to use, connect them
together in the order in which you want them applied, and then add an Output node to
the very end.
In the following example, a Bleach Bypass node (which alters the saturation and contrast
of an image to simulate a chemical film process) is followed by a Curve node (to further
alter image contrast), which is followed by the Output node that must be added to the
end of all node trees.
Using Layering Nodes
A more sophisticated use of nodes is to use multi-input nodes to combine two or more
separately processed versions of the image for a combined effect.
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generates a user-definable color) to one input of a Multiply layering node.
This adjustment multiplies the color with the corrected image. (Remember, disconnected
inputs always link to the corrected image data.) Because of the way image multiplication
works, the lightest areas of the image are tinted, while progressively darker areas are less
tinted, and the black areas stay black.
In a slightly more complicated example, the image is processed using three nodes: a
Duotone node (which desaturates the image and remaps black and white to two
customizable colors), a Curve node (to darken the midtones), and a Blur node. The result
is connected to one input of an Add node (with both Bias parameters set to 1).
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to the corrected image (coming in via input 2), and the result is a diffusion effect with
hot, glowing highlights.
Math Layering Nodes Explained
The layering nodes shown in Using Layering Nodes use simple math to combine two
differently modified versions of the image together. These mathematical operations rely
on the following numerical method of representing tonality in each of the three color
channels of an image:
• Black = 0 (so black for RGB = 0, 0, 0)
• Midtone values in each channel are fractional, from .00001 through .999999
• White = 1 (so white for RGB = 1, 1, 1)
Bear these values in mind when you read the following sections.
Add
The pixels from each input image are added together. Black pixels have a value of 0, so
black added to any other color results in no change to the image. All other values are
raised by the sum of both values. The order in which the inputs are connected doesn’t
matter.
Add operations are particularly well suited to creating aggressive glowing effects, because
they tend to raise levels very quickly depending on the input images. Bear in mind that
the best way of controlling which areas of the image are being affected when using an
Add operation is to aggressively control the contrast of one of the input images. The
darker an area is, the less effect it will have.
Note: By default, the Bias parameters of the Add node divide each input image’s values
by half before adding them together. If the results are not as vivid as you were hoping
for, change the Source 1 and Source 2 Bias parameters to 1.
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The pixels from the image that’s connected to Source 1 are subtracted from the pixels
from the image that’s connected to Source 2. Black pixels have a value of 0, so any color
minus black results in no change to the Source 1 image. The order in which the inputs
are connected matters.
This node is useful for darkening the Source 1 image based on the brightness of the
Source 2 image.
Multiply
The pixels from each input image are multiplied together. White pixels have a value of
1, so white multiplied with any other color results in no change to the other image.
However, when black (0) is multiplied with any other color, the result is black.
When multiplying two images, the darkest parts of the images remain unaffected, while
the lightest parts of the image are the most affected. This is useful for tinting operations,
as seen previously, as well as for operations where you want to combine the darkest
portions of two images.
Creating Layered Effects Using Mattes
An extremely important method of creating layered effects involves using a grayscale
matte to control where in an image two inputs are added together. The Alpha Blend
node has three inputs that work together to create exactly this effect.
This node blends the Source 2 input to the Source 1 input in all the areas where the
Source 3 Alpha input image is white. Where the Alpha input image is black, only the
Source 1 input is shown.
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input, for a variety of effects. In the following example, a Curve node is used to manipulate
the contrast of an image so that an Edge Detector node can better isolate the edges to
create a grayscale matte; a Blur node is used to soften the result, and an Invert node is
used to reverse the black and white areas of the matte so that the edges of the face
become the areas of the matte that are transparent, or not to be adjusted.
This matte is connected to the Alpha input of the Alpha Blend node (the third input). A
Blur node is then connected to the Source 2 input.
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Alpha input limits its effect to the areas of the image that don’t include the image detail
around the edges that were isolated using the Edge Detector node.
As you can see, the image that’s connected to the Alpha input of the Alpha Blend node
limits the way the Source 1 and Source 2 inputs are combined. This is but one example
of the power of the Alpha Blend node. You can use this node to limit many different
effects.
Using Color FX with Interlaced Shots
One of the limitations of the Color FX room is that many effects need to be specially
assembled when you’re working on interlaced video.
When you’re creating an effect for an interlaced shot, you need to separate each field at
the beginning of the node tree with two Deinterlace nodes, one set to Even and one set
to Odd. Once that’s done, you need to process each individual field using identical node
trees.
When you’re finished with the effect, you need to reassemble the fields into frames using
the Interlace node, connecting the Even branch of the node tree to the Even input on
the left and the Odd branch of the node tree to the Odd input on the right. The Output
node is attached to the Interlace node, and you’re finished.
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especially when using filtering and transform nodes such as Blur, Sharpen, Stretch, and
Translate.
Saving Favorite Effects in the Color FX Bin
When you’ve created a Color FX effect you really like, you can save it for future use using
the Color FX bin. This bin works the same way as the corrections bins in every other room.
To save an effect in the Color FX bin
1 Move the playhead to a shot with a node tree you want to save.
2 Type a name for the effect into the File field underneath the bin. (This step is optional,
but recommended.)
3 Click Save.
The effect is saved with a thumbnail taken from the shot it was saved from. Entering a
custom name is optional, but recommended, to help you keep track of all your corrections.
If you don’t enter a name, saved corrections (and grades) are automatically named using
the default Effect.Date.Time.cfx convention.
To apply a saved effect or grade to a single shot
1 Move the playhead to the shot you want to apply the effect to.
2 Do one of the following:
• Double-click the effect you want to apply.
• Select an effect, then click the Load button underneath the bin.
• Drag the effect onto the shot you want to apply it to.
The selected effect is applied to the shot at the position of the playhead. You can also
apply a saved effect to multiple shots.
To apply a saved effect to multiple shots
1 Select all of the shots you want to apply the correction to in the Timeline.
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• Double-click the effect in the bin.
• Select a saved effect, then click the Load button underneath the bin.
• Drag the saved effect onto the selected shots in the Timeline.
The effect is then applied to all selected shots in the Timeline.
For more information on saving and managing corrections, see Managing Corrections
and Grades.
Node Reference Guide
This node reference guide contains a brief description of each node that appears in the
Node list. It’s broken down into three sections:
• Layer Nodes
• Effects Nodes
• Utility Nodes
Layer Nodes
The following nodes have multiple inputs and are used to combine two or more differently
processed versions of the corrected image in different ways.
Add
Mathematically adds each pixel from the two input images together. Add operations are
particularly well suited to creating aggressive glowing effects, because they tend to raise
levels very quickly depending on the input images. Bear in mind that the best way of
controlling which areas of the image are being affected when using an Add operation is
to aggressively control the contrast of one of the input images. The darker an area is, the
less effect it will have.
The order in which the inputs are connected does not matter. Add has two parameters:
• Source 1 Bias: Controls how much of the Source 1 image is added to create the final
result by multiplying the value in each channel by the specified value. Defaults to 0.5.
• Source 2 Bias: Controls how much of the Source 2 image is added to create the final
result by multiplying the value in each channel by the specified value. Defaults to 0.5.
Alpha Blend
This node blends (similar to the Blend node) the Source 2 input to the Source 1 input in
all the areas where the Source 3 Alpha input image is white. Where the Alpha input image
is black, only the Source 1 input is shown. The order in which the inputs are connected
affects the output.
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This node mixes two inputs together based on the Blend parameter. The order in which
the inputs are connected does not matter. Blend has one parameter:
• Blend: When set to 0, only Input 1 is output. When set to .5, Input 1 and Input 2 are
blended together equally and output. When set to 1, only Input 2 is output.
Darken
Emphasizes the darkest parts of each input. Overlapping pixels from each image are
compared, and the darkest pixel is preserved. Areas of white from either input image
have no effect on the result. The order in which the inputs are connected does not matter.
Difference
The pixels from the image that’s connected to Source 1 are subtracted from the pixels
from the image that’s connected to Source 2. Black pixels have a value of 0, so any color
minus black results in no change to the image from Source 1. Since this is subtraction,
the order in which the inputs are connected matters.
Interlace
The images connected to each input are interlaced. The Left input is for the Even field,
and the Right input is for the Odd field. This node is used at the end of node trees that
begin with Deinterlace nodes to process effects for projects using interlaced media.
Lighten
Lighten emphasizes the lightest parts of each input. Overlapping pixels from each image
are compared, and the lightest pixel is preserved. The order in which the inputs are
connected does not matter.
Multiply
The pixels from each input image are multiplied together. White pixels have a value of
1, so white multiplied with any other color results in no change to the other image.
However, when black (0) is multiplied with any other color, the result is black.
When multiplying two images, the darkest parts of the images remain unaffected, while
the lightest parts of the image are the most affected. This is useful for tinting operations,
as well as for operations where you want to combine the darkest portions of two images.
RGB Merge
The three inputs are used to insert individual channels into the red, green, and blue color
channels. You can split the three color channels apart using the RGB Split node, process
each grayscale channel individually, and then reassemble them into a color image again
with this node.
Effects Nodes
The following nodes have a single input and are used to apply a single correction or effect
to an image.
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Desaturates the image to produce a monochrome image consisting of only the Luma
component. This is done using very specific math, adding together 0.299 of the red
channel, 0.587 of the green channel, and 0.114 of the blue channel to arrive at the final
monochrome result.
Bleach Bypass
Raises the contrast and desaturates the image. Simulates laboratory silver-retention
processes used to raise image contrast in film by skipping the bleaching stage of film
development, leaving exposed silver grains on the negative which boost contrast, increase
grain, and reduce saturation.
Blur
Blurs the image. Blur has one parameter:
• Spread: The amount of blur. Can be set to a value from 0 (no blur) to 40 (maximum
blur).
Clamp
Two parameters clip the minimum and maximum values in the image. Clamp has two
parameters:
• Min: The minimum level in the image. Any levels below this value are set to this value.
• Max: The maximum level in the image. Any levels above this value are set to this value.
Curve
A curve that affects image contrast similar to the Luma curve in the Primary In room.
Selecting this node displays a curve control in the Parameters tab that works identically
to those found in the Primary In room. Four buttons below let you choose which channel
the curve operates upon:
• Luma: Sets the curve to adjust the luma component of the image.
• Red: Sets the curve to adjust the red color channel of the image.
• Green: Sets the curve to adjust the green color channel of the image.
• Blue: Sets the curve to adjust the blue color channel of the image.
Duotone
Desaturates the image, mapping the black and white points of the image to two
user-customizable colors to create tinted images with dual tints from white to black.
Duotone has two parameters:
• Light Color: The color that the white point is mapped to.
• Dark Color: The color that the black point is mapped to.
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A Convolution filter that boosts image contrast in such a way as to reduce the image to
the darkest outlines that appear throughout. Edge Detector has three parameters:
• B&W: Desaturates the resulting image. Useful when using this node to generate mattes.
• Scale: Adjusts the white point. Lowering Scale helps increase contrast and crush midtone
values to emphasize the outlines.
• Bias: Adjusts overall contrast. Lowering Bias increases contrast, while raising it lowers
contrast.
Exposure
Raises the highlights or crushes the shadows, depending on whether you raise or lower
the Exposure parameter. This node has one parameter:
• Exposure: Raising this parameter raises the highlights while keeping the black point
pinned. Setting this parameter to 0 results in no change. Lowering this parameter scales
the image levels down, crushing the shadows while lowering the highlights by a less
severe amount.
Film Grain
Adds noise to the darker portions of an image to simulate film grain or video noise due
to underexposure. Highlights in the image are unaffected. This node is useful if you have
to match a clean, well-exposed insert shot into a scene that’s noisy due to underexposure.
Also useful for creating a distressed film look. This node has three parameters:
• Grain Intensity: Makes the noise more visible by raising its contrast ratio (inserting both
light and dark pixels of noise) as well as the saturation of the noise.
• Grain Size: Increases the size of each “grain” of noise that’s added. Keep in mind that
the size of the film grain is relative to the resolution of your project. Film grain of a
particular size applied to a standard definition shot will appear “grainier” than the
same-sized grain applied to a high definition shot.
• Monochrome: Turning this button on results in the creation of monochrome, or
grayscale, noise, with no color.
Film Look
An “all-in-one” film look node. Combines the Film Grain operation described above with
an “s-curve” exposure adjustment that slightly crushes the shadows and boosts the
highlights. Contrast in the midtones is stretched, but the distribution of the midtones
remains centered, so there’s no overall lightening or darkening. This node has three
parameters:
• Grain Intensity: Makes the noise more visible by raising its contrast ratio (inserting both
light and dark pixels of noise) as well as the saturation of the noise.
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the size of the film grain is relative to the resolution of your project. Film grain of a
particular size applied to a standard definition shot will appear “grainier” than the
same-sized grain applied to a high definition shot.
• Contrast: Makes an “s-curve” adjustment to contrast, which crushes the shadows and
boosts the highlights, while leaving the midtones centered. A value of 0 preserves the
original contrast of the corrected image, while a value of 1 is the maximum contrast
expansion that is possible with this node.
Gain
Adjusts contrast by raising or lowering the white point of the image while leaving the
black point pinned in place, and scaling the midtones between the new white point and
the black point. This node has four parameters:
• Gain: Adjusts the red, green, and blue channels simultaneously, for an overall change
to image highlights and midtones.
• Red Gain: Adjusts the red channel only, enabling color correction based on a white
point adjustment for that channel.
• Green Gain: Adjusts the green channel only, enabling color correction based on a white
point adjustment for that channel.
• Blue Gain: Adjusts the blue channel only, enabling color correction based on a white
point adjustment for that channel.
Gamma
Makes a standard gamma adjustment, which makes a nonlinear adjustment to raise or
lower the distribution of midtones of the image while leaving the black and white points
pinned in place. This is a power function, (f(x) = x
a
). This node has four parameters:
• Gamma: Adjusts the red, green, and blue channels simultaneously, for an overall change
to image midtones.
• Red Gamma: Adjusts the red channel only, enabling color correction based on a gamma
adjustment for that channel.
• Green Gamma: Adjusts the green channel only, enabling color correction based on a
gamma adjustment for that channel.
• Blue Gamma: Adjusts the blue channel only, enabling color correction based on a
gamma adjustment for that channel.
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Reduces grain and noise in an image by averaging adjacent pixels in that frame according
to the values specified in the Master, Red, Green, and Blue Scale parameters. Edge
detection can be used to preserve sharpness in areas of high-contrast detail via the Edge
Retention parameter, and a sharpening operation can be applied after grain reduction
to boost overall detail. Because some shots have noise that’s more apparent in specific
color channels, you can make independent adjustments to each channel. This node has
six parameters:
• Master Scale: Averages the adjacent pixels of every color channel in the image to reduce
grain and noise, at the expense of a certain amount of image softness.
• Red Scale: Selectively averages pixels in the red channel.
• Green Scale: Selectively averages pixels in the green channel.
• Blue Scale: Selectively averages pixels in the blue channel.
• Edge Retention: Uses edge detection to isolate areas of high-contrast detail in the image
(such as hair, eyes, and lips in an actor’s close-up), and excludes those areas of the
image from the Grain Reduction operation to preserve the most valuable image detail
from softening. Higher values preserve more of the original image in these areas.
• Post Sharpening: Applies a Sharpening Convolution filter after the Grain Reduction
operation to try and restore some lost detail once the grain has been softened. Use
this parameter sparingly—if you set this too high, you’ll end up reintroducing the grain
you’re trying to reduce.
Hue
Rotates the hue of every pixel in the entire image. This node has one parameter:
• Shift: The amount by which you want to shift the hue. This is not done in degrees, as
is represented in the Vectorscope. Instead, you use a value from –1 to 1, where –1, 0,
and 1 place the hue at the original values.
Invert
Inverts the image. Useful for creating “positives” from the image negative. Also useful for
reversing a grayscale image that you’re using as a matte with the Alpha Blend node, to
reverse the portions of the matte that will be solid and transparent.
Lift
Lift uniformly lightens or darkens the entire image, altering the shadows, midtones, and
highlights by the same amount. This node has four parameters:
• Lift: Adjusts the red, green, and blue channels simultaneously, for an overall change
to image brightness.
• Red Lift: Adjusts the red channel only, enabling color correction based on a lift
adjustment for that channel.
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adjustment for that channel.
• Blue Lift: Adjusts the blue channel only, enabling color correction based on a lift
adjustment for that channel.
Maximum
Averages adjacent pixels together (how many is based on the Brush Size parameter) to
produce a single, larger pixel based on the brightest value in that pixel group. Larger
values result in flattened, almost watercolor-like versions of the image. This node is also
useful for expanding the white areas and smoothing out grayscale images that you’re
using as mattes. This node has one parameter:
• Brush Size: Defines how many pixels are averaged into a single, larger pixel. Extremely
large values result in progressively larger, overlapping square pixels of uniform color,
emphasizing lighter pastel-like tones in the image.
Minimum
Averages adjacent pixels together (how many is based on the Brush Size parameter) to
produce a single, larger pixel based on the darkest value in that pixel group. Larger values
result in flattened, darkened versions of the image. This node is also useful for expanding
the black areas and smoothing out grayscale images that you’re using as mattes. This
node has one parameter:
• Brush Size: Defines how many pixels are averaged into a single, larger pixel. Extremely
large values result in progressively larger, overlapping square pixels of uniform color,
emphasizing darker, muddier tones in the image.
Printer Lights
Provides Red, Green, and Blue parameters for color correction that work identically to the
printer points controls in the Advanced tab of the Primary In room. For more information,
see Printer Points Controls.
Saturation
Raises or lowers overall image saturation, making the image more or less colorful. If you
use the Saturation node to completely desaturate an image, all three color channels are
blended together equally to create the final monochrome result, which looks different
then if you had used the B&W node. This node has one parameter:
• Saturation: The default value of 1 produces no change. 0 is a completely desaturated
image, while the maximum value of 10 produces an excessively saturated, hyper-stylized
version of the image.
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Expands or contracts the overall contrast ratio of a shot, from the black point to the white
point, centering the midpoint of this operation at a percentage of image tonality that
you specify. This node has two parameters:
• Scale: The amount by which to expand or contract the overall contrast ratio in the shot.
This is a multiplicative operation, so a value of 1 produces no change, while larger
values increase the contrast ratio, and smaller values decrease the contrast ratio.
• Center: Specifies the percentage of image tonality upon which the expansion and
contraction is centered, so the original image values at this percentage remain at that
percentage. The default value of 0.5 adjusts the white and black points equally in both
directions (the white point goes up, the black point goes down, and whatever values
are at 50 percent remain at 50 percent). A value of 0 pins the black point while applying
the entire adjustment to the white point, and a value of 1 pins the white point while
applying the entire adjustment to the black point.
Sharpen
Applies a Sharpen Convolution filter that selectively enhances contrast in areas of image
detail to provide the illusion of sharpness. Should be used sparingly as this operation also
increases the sharpness of film grain and video noise. This node has one parameter:
• Sharpen: Higher values increase image detail contrast. A value of 0 does no sharpening.
Smooth Step
Applies a nonadjustable “s-curve” adjustment to slightly crush the blacks and boost the
whites, leaving the black and white points pinned at 0 and 100 percent. Designed to
emulate the exposure tendencies of film at the “toe” and “shoulder” of the image. This
is a similar contrast adjustment to that made by the Film Look node.
Stretch
Provides separate vertical and horizontal scaling operations that let you “squeeze” and
“stretch” the image. You can change the center pixel at which this scaling is performed.
This node has four parameters:
• Horizontal Center: The pixel at which horizontal scaling is centered. The center pixel
doesn’t move; instead, the scaling of the image is relative to this position.
• Vertical Center: The pixel at which vertical scaling is centered. The center pixel doesn’t
move; instead, the scaling of the image is relative to this position.
• Horizontal Scale: Specifies how much to stretch the image, horizontally. Higher values
stretch the image outward, while lower values squeeze the image inward. The default
value at which the image is unchanged is 1.
• Vertical Scale: Specifies how much to stretch the image, vertically. Higher values stretch
the image outward, while lower values squeeze the image inward. The default value
at which the image is unchanged is 1.
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Offsets the image relative to the upper-right corner. This node has two parameters:
• Horizontal Offset: Moves the image left.
• Vertical Offset: Moves the image down.
Utility Nodes
The following nodes don’t combine images or create effects on their own. Instead, they
output color channel information or extract matte imagery in different ways. All these
nodes are meant to be used in combination with other layering and effects nodes to
create more complex interactions.
Color
Produces a frame of solid color. This can be used with different layering nodes to add
colors to various operations. This node has one control:
• Color: A standard color control lets you choose the hue, saturation, and lightness of
the color that’s generated.
Deinterlace
Removes the interlacing of a shot in one of three ways, corresponding to three buttons.
You can use this node to either remove interlacing by blending the fields together, or
you can use two Deinterlace nodes to separate the Even and Odd fields of an interlaced
shot prior to processing each field separately and reassemble them using the Interlace
node. This node has three buttons:
• Merge: Outputs the blended combination of both fields.
• Even: Outputs only the Even field, line-doubled to preserve the current resolution.
• Odd: Outputs only the Odd field, line-doubled to preserve the current resolution.
HSL Key
An HSL keyer that outputs a grayscale matte which you can use to isolate effects using
the Alpha Blend node, or simply to combine with other layering nodes in different ways.
This keyer works identically to the one found in the Secondaries room. For more
information, see Choosing a Region to Correct Using the HSL Qualifiers.
Output
This must be the last node in any node tree. It outputs the effect created within the Color
FX room to the main Color image processing pipeline for rendering. If an Output node
is not connected to the node tree, that effect will not be rendered by the Render Queue.
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Outputs the red, green, and blue color channels individually, depending on which button
you click. Each grayscale color channel can then be independently manipulated with
different node tree branches, before being reassembled using the RGB Merge node. This
node has three checkboxes:
• Red: Outputs the red channel.
• Green: Outputs the green channel.
• Blue: Outputs the blue channel.
Vignette
Creates a simple square or circle vignette. This vignette appears as a color-against-grayscale
preview if the Vignette node is viewed directly. When the results are viewed “downstream,”
by viewing a different node that’s processing its output, the true grayscale image is seen.
This node has the following parameters:
• Use Tracker: If you’ve analyzed one or more motion trackers in the current project, you
can choose which tracker to use to automatically animate the position of the vignette
from this pop-up menu. To disassociate a vignette from the tracker’s influence, choose
None.
• Shape Type: Lets you choose the type of vignette, either Circle or Square.
• Invert: Click this button to make the white area black, and the black area white.
• X Center: Adjusts the horizontal position of the shape.
• Y Center: Adjusts the vertical position of the shape.
• Size: Enlarges or shrinks the shape.
• Aspect: Adjusts the width-to-height ratio of the shape.
• Angle: Rotates the current shape.
• Softness: Blurs the edges of the shape.
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but it can also be used as a tool to trim the grades applied to a selected group of shots.
This chapters covers the different uses of the Primary Out room, which shares the same
controls as the Primary In room. For more information about primary color correction
controls, see The Primary In Room.
This chapter covers the following:
• What Is the Primary Out Room Used For? (p. 313)
• Making Extra Corrections Using the Primary Out Room (p. 314)
• Understanding the Image Processing Pipeline (p. 314)
• Ceiling Controls (p. 315)
What Is the Primary Out Room Used For?
The controls and functionality of the Primary Out room duplicate those of the Primary In
room. This includes sharing saved corrections as the Primary In and Out rooms access
the same saved corrections in their bins.
The Primary Out room is valuable for three main reasons:
• It provides an extra room that you can use to make additional modifications to a shot’s
grade, without changing the adjustments applied using the Primary In room.
• The Primary Out room comes after the Primary In, Secondaries, and Color FX rooms in
the image processing pipeline, so you can apply adjustments to the overall image after
the corrections and effects have been added in the other rooms.
• There are three additional controls in the Primary Out toom that don’t exist in the
Primary In room. The Ceiling parameters give you one more way to limit the color
values in a shot to legalize or stylize them.
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The Color interface was designed for flexibility. The functionality of each of the color
correction rooms overlaps broadly, and although each room has been arranged to optimize
certain types of operations, you can perform corrections using whichever controls you
prefer.
In many cases, colorists like to split up different steps of the color correction process
among different rooms. This is detailed in Managing a Shot’s Corrections Using Multiple
Rooms.
Using this approach, you might perform a shot’s main correction using the Primary In
room, use the Secondaries room for stylized “look” adjustments, and then apply one of
your previously saved “secret sauce” Color FX room effects to give the shot its final grade.
Once your client has had the opportunity to screen the program, you’ll no doubt be given
additional notes and feedback on your work. It’s at this time that the value of the Primary
Out room becomes apparent.
Up until now, this room has remained unused, but because of that, it’s a great place to
easily apply these final touches. Because you can apply these final corrections in a
completely separate room, it’s easy to clear them if the client changes his or her mind.
Furthermore, it’s easy to use the Primary Out room to apply changes that affect an entire
scene to multiple clips at once (sometimes referred to as trimming other grades).
To trim one or more selected grades using the Primary Out room
1 Move the playhead to the shot you want to adjust, then click the Primary Out room.
2 Make whatever adjustments are required using the color and contrast controls.
3 Select all the shots in the Timeline that you want to apply these adjustments to.
4 Click Copy To Selected.
The corrections you made in the Primary Out room of the current shot are applied to
every shot you’ve selected.
Note: The Copy To Selected command overwrites any previous settings in the Primary
Out room of each selected clip, so if you need to make a different adjustment, you can
simply repeat the procedure described above to apply it to each selected shot again.
Understanding the Image Processing Pipeline
Another use of the Primary Out room is to apply corrections to clips after the corrections
that have been applied in each of the previous rooms.
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FX rooms, the corrections in each room are applied to the image that’s handed off from
the previous room. Since the Primary Out room is the very last correction room in every
grade, it processes the image that’s output from the Color FX room. You can take
advantage of this to apply overall corrections to the post-processed image.
In the following example, a series of corrections that affect saturation are made in each
of the rooms, but the Primary Out room is used to reduce the saturation of the end result.
You can see that the final correction modifies the collective output from every other
room.
Primary Out Adjustment
(Saturation adjustment affects the sum
of all corrections)
Secondary Adjustment
(Boost orange saturation)
Primary In Adjustment
(Original image adjustment)
Color FX Adjustment
(Add blue vignette)
Ceiling Controls
Lastly, the Primary Out room has a single group of controls that aren’t found in the Primary
In room. The Enable Clipping button in the Basic tab of the Primary Out room lets you
turn on the effect of the three individual ceiling parameters for the red, green, and blue
color channels of the current shot.
This option lets you prevent illegal broadcast values in shots to which you’re applying
extreme Primary In, Secondary, or Color FX corrections if you don’t want to turn on
Broadcast Safe for the entire program.
The Ceiling parameters can also be used to perform RGB limiting for hard-to-legalize clips.
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is applied.
These controls are used to adjust color channel ceiling settings:
• Enable Clipping: Enables the Ceiling Red/Green/Blue controls.
• Ceiling Red: Sets the maximum allowable chroma in the red channel. All values above
this level will be set to this level.
• Ceiling Green: Sets the maximum allowable chroma in the green channel. All values
above this level will be set to this level.
• Ceiling Blue: Sets the maximum allowable chroma in the blue channel. All values above
this level will be set to this level.
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You can work even faster by saving, copying, and applying corrections and grades you've
already created to multiple shots at once.
There are three areas of the Color interface where you can save, organize, copy, apply,
and otherwise manage corrections and grades: the corrections bin inside each room, the
Grades bin and the Shots browser in the Setup room, and the grades track in the Timeline.
This chapter describes the use of all these areas of the interface in more detail.
This chapter covers the following:
• The Difference Between Corrections and Grades (p. 317)
• Saving and Using Corrections and Grades (p. 318)
• Managing Grades in the Timeline (p. 325)
• Using the Copy To Buttons in the Primary Rooms (p. 332)
• Using the Copy Grade and Paste Grade Memory Banks (p. 334)
• Setting a Beauty Grade in the Timeline (p. 334)
• Disabling All Grades (p. 335)
• Managing Grades in the Shots Browser (p. 336)
• Managing a Shot’s Corrections Using Multiple Rooms (p. 343)
The Difference Between Corrections and Grades
There is a distinct difference between corrections and grades in Color. Understanding
the difference is key to managing each set of adjustments correctly.
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13Corrections are adjustments that are made within a single room. You have the option to
save individual corrections into the bins available in the Primary In and Out, Secondaries,
and Color FX rooms. Once saved, corrections can be applied to one or more shots in your
project without changing the settings of any other rooms. For example, if there are five
shots in a scene to which you want to apply a previously saved secondary correction, you
can do so without affecting the primary corrections that have already been made to those
shots. Each room has its own corrections bin for saving and applying individual corrections,
although the Primary In and Primary Out rooms share the same saved corrections.
A grade, on the other hand, encompasses multiple corrections across several rooms,
saving every primary, secondary, and Color FX correction together as a single unit. When
you save a group of corrections as a grade, you can apply them all together as a single
preset. Applying a saved grade overwrites any corrections that have already been made
to the shot or shots you're applying it to. Saved grades are managed using the Grades
bin, located in the Setup room.
Saving and Using Corrections and Grades
You can save any correction and grade, in order to apply one shot's settings to others at
a later time. Examples of the use of saved corrections and grades include:
• Saving the finished grade of a shot in your program in order to apply it to other shots
that are also from the same angle of coverage
• Saving a correction to a shot from a specific problem reel of tape (for example, a reel
with a uniformly incorrect white balance) that you'll want to apply to every other shot
from the same reel
• Saving a stylistic "look" correction in the Primary, Secondaries, or Color FX room that
you want to apply to other scenes or programs
For more information, see:
• Saving Corrections into Corrections Bins
• Saving Grades into the Grades Bin
• Deleting Saved Corrections and Grades
• Organizing Saved Corrections and Grades with Folders
• Applying Saved Corrections and Grades to Shots
Saving Corrections into Corrections Bins
The Primary In, Secondaries, Color FX, and Primary Out rooms all have corrections bins
where you can save corrections that are specific to those rooms for future use. When you
save corrections in any room, they're available to every project you open in Color.
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1 Move the playhead to the shot with a correction you want to save.
2 Click in the File field underneath the corrections bin, enter a name for the saved correction,
and press Return. (This step is optional.)
3 Click Save.
The correction is saved into the current room's bin with a thumbnail of the shot it was
saved from.
To save any shot’s correction into the current room’s bin
1 Click in the File field underneath the corrections bin, enter a name for the saved correction,
and press Return. (This step is optional.)
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to the corrections bin.
Tip: To overwrite a previously saved correction with a new one using the same name,
select the correction you want to overwrite before saving the new grade, then click
Replace when a warning appears. This is useful when you’ve updated a grade that you
previously saved.
Entering a custom name for your saved correction is optional, but recommended, to help
you keep track of all your corrections during extensive grading sessions. If you don't enter
a name, saved corrections (and grades) are automatically named using the following
method:
CorrectionType.Day Month Year Hour.Minute.Second TimeZone.extension
The date and time used correspond to the exact second the correction is saved. For
example, a saved secondary correction might have the following automatic name:
Secondary.01 May 2007 10.31.47EST.scc
Corrections from each room are saved into corresponding directories in the
/Users/username/Library/Application Support/Color directory. For more information, see
How Are Grades and Corrections Saved and Organized?.
Saving Grades into the Grades Bin
Saved grades store the corrections that are applied in the Primary In, Secondaries, Color
FX, and Primary Out rooms all at once, so there's one more step.
To save a grade from the current shot
1 Click the Grades tab in the Setup room.
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3 Select the grade that you want to save by clicking it in the Timeline.
4 Click in the File field underneath the corrections bin, enter a name for the saved correction,
and press Return. (This step is optional.)
5 Click the Save button (in the bottom-right corner of the Grades bin).
The grade is saved to the Grades bin.
The grade is saved with a thumbnail from the shot it was saved from. Once you've saved
a grade, deleting, organizing, and applying grades is identical to deleting, organizing,
and applying saved corrections.
Grades are saved to the /Users/username/Library/Application Support/Color/Grades
directory.
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1 Click in the File field underneath the corrections bin, enter a name for the saved correction,
and press Return. (This step is optional.)
2 Drag the grade bar of any shot you want to save into the Grades bin.
Tip: To overwrite a previously saved grade with a new one using the same name, select
the grade you want to overwrite before saving the new grade, then click Replace when
a warning appears. This is useful when you’ve updated a grade that you previously saved.
Deleting Saved Corrections and Grades
You can delete saved corrections and grades you no longer need.
To delete a saved correction or grade
1 Select a correction or grade in any bin.
2 Press Delete or Forward Delete.
3 When a warning appears, click Yes.
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cannot be undone.
Organizing Saved Corrections and Grades with Folders
Saved corrections and grades are available to every project you open. For this reason,
you may find it useful to save your corrections and grades into folders within each room's
bin. There are a number of different ways you can use folders to organize your saved
corrections and grades:
• You can create a folder for each new project you work on, saving all the corrections
that are specific to a particular project within the corresponding folder.
• You can also create folders for grades that you have saved for use with any project. For
example, you may create a library of your own stylistic "looks" that you can apply to
instantly present your clients with different options.
Note: You can only save corrections and grades in a folder after that folder has been
created.
To create a new folder inside a bin
1 Click New Folder.
2 Enter a name for the new folder in the New Folder dialog, then click Create.
A new folder with the name you entered is created inside the corrections bin of that
room.
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correction directory for that room within the /Users/username/Library/Application
Support/Color directory.
To save a correction or grade into a folder
1 Move the playhead to the shot with a correction or grade you want to save.
2 Double-click a folder in the corrections or Grades bin to open it.
The Directory pop-up menu updates to display the directory path in the Finder of the
currently open folder.
3 Enter a name for the saved correction or grade in the File field underneath the corrections
or Grades bin. (This step is optional.)
4 Click Save.
The correction or grade is saved within that folder.
Important: There is no way of moving a saved correction into a folder after it's been saved
using the Color interface.
Reorganizing Saved Corrections and Grades in the Finder
Since each corrections bin simply mirrors the contents of the corresponding
subdirectories in the /Users/username/Library/Application Support/Color directory, you
can also use the Finder to reorganize your saved corrections and grades. For more
information, see Reorganizing Saved Corrections and Grades in the Finder.
Applying Saved Corrections and Grades to Shots
Once you've saved a correction or grade, applying it to one or more shots in your project
is easy.
To apply a saved correction or grade from a bin to a single shot
1 Move the playhead to the shot you want to apply the correction or grade to.
2 Do one of the following:
• Double-click the correction or grade you want to apply.
• Select a correction or grade to apply, then click the Load button underneath the bin.
• Drag the correction or grade onto the shot you want to apply it to.
The selected grade is applied to the shot at the position of the playhead.
To apply a saved correction or grade from a bin to multiple shots
1 In the Timeline, select all of the shots you want to apply the correction to.
Important: If the current shot at the position of the playhead is not selected, it will not
be included in the selection when you apply a saved correction from a bin.
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• In the Grades or corrections bin, double-click the correction or grade you want to apply.
• Select a saved correction or grade in the Grades or corrections bin, then click the Load
button underneath the bin.
• Drag the saved correction or grade from the Grades or corrections bin, then drop it
onto the selected shots in the Timeline.
The correction or grade is then applied to all selected shots in the Timeline.
Managing Grades in the Timeline
Each shot can have up to four alternate grades, shown with different colors in the grades
tracks that are located underneath the video track. The currently selected grade for each
shot is blue, while unselected grades are gray. The bars showing the individual corrections
that contribute to the currently selected grade are shown in other colors, underneath
each shot's grade bars.
You can use the grades and correction bars in the grades tracks to add, switch, and copy
grades directly in the Timeline. For more information, see:
• Adding and Selecting Among Multiple Grades
• Resetting Grades in the Timeline
• Copying Corrections and Grades in the Timeline
Adding and Selecting Among Multiple Grades
Each shot in the Timeline can be set to use one of up to four alternate grades. Only the
currently selected grade actually affects a shot. The other unused grades let you store
alternate corrections and looks, so that you can experiment with different settings without
losing the original.
By default, each shot in a project has a single primary grade applied to it, although you
can add more at any time.
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Do one of the following:
µ Control-click or right-click a grade, then choose Add New Grade from the shortcut menu.
µ Move the playhead to the shot you want to add a new grade to, then press Control-1
through Control-4.
If a grade corresponding to the number of the grade you entered doesn't already exist,
one will be created. Whenever a new grade is added, the grades track expands, and the
new grade becomes the selected grade. New grades are clean slates, letting you begin
working from the original state of the uncorrected shot.
To change the selected grade
1 Move the playhead to the shot you want to change the grade of.
2 Do one of the following:
• Click the grade you want to switch to.
• Press Control-1 through Control-4.
• Control-click or right-click a grade, then choose Select Grade [x] from the shortcut
menu, where x is the number of the grade you're selecting.
The shot is updated to use the newly selected grade.
Resetting Grades in the Timeline
If necessary, you can reset any of a shot's four grades.
To reset a grade in the Timeline
1 Move the playhead to the shot whose grade you want to reset.
2 in the grades track of the Timeline, Control-click or right-click the grade you want to reset
to and choose Reset Grade [x] from the shortcut menu, where x is the number of the
grade.
Resetting a grade clears all settings from the Primary In, Secondaries, Color FX, and Primary
Out rooms, bringing that shot to its original state. Pan & Scan settings in the Geometry
room are left intact.
Copying Corrections and Grades in the Timeline
You can drag a correction or grade from one shot to another to copy it in the Timeline.
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µ Drag a single correction bar in the grades track of the Timeline to the shot you want to
copy it to.
The shot you drag the correction onto becomes highlighted, and after you drop the
correction, the current grade for that shot appears with the same grade bar.
Note: When you copy individual corrections, secondary corrections overwrite other
secondary corrections of the same number.
To copy a grade from one shot to another
µ Drag a shot's grade bar in the grades track of the Timeline to a second shot you want to
copy it to.
The shot you drag the grade onto becomes highlighted, and after you drop it, every
correction in the current grade for that shot is overwritten with those of the grade you
copied.
You can also copy a grade to another grade within the same shot. This is useful for
duplicating a grade to use as a starting point for creating variations on that grade.
Chapter 13 Managing Corrections and Grades 327To copy a grade to another grade in the same shot
µ Drag a grade bar in the grades track of the Timeline onto another grade bar for the same
shot.
The copied grade overwrites all previous corrections.
Tip: This is a great way to save a shot's grade at a good state before continuing to
experiment with it. If you don't like your changes, you can easily switch back to the original
grade.
You can also drag a corrections or grade bar to copy it to multiple selected shots.
To copy a correction or grade to multiple selected shots in the Timeline
1 Select the shots you want to copy a correction or grade to.
Tip: You can select multiple clips directly in the Timeline, or you can select them in the
Shots browser of the Setup room if that’s easier. Shots that you select in the Shots browser
are also automatically selected in the Timeline.
2 Drag the correction or grade that you want to copy onto the grade bar of any of the
selected shots, either from the Timeline, or from a bin.
The grade bars of the shots you’re about to copy to should highlight in cyan.
Note: When dragging corrections or grades from one shot to another in the Timeline,
you should always drop them inside of the grades track of the Timeline. Dropping a
correction or grade onto an item in a video track may only copy it to the shot you drop
it onto.
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Keep in mind the following rules when dragging corrections and grades onto multiple
selected shots:
• Dragging onto one of several selected shots copies that correction or grade to the
currently selected grade of each shot in the selection.
Before
After
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or grade into the alternate grade of the shot you dropped it onto, but it’s copied into
the currently selected grade of every other shot in the selection.
Before
After
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or grade to that shot.
Before
After
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operation unless it’s specifically selected (with a cyan highlight).
Before
After
Using the Copy To Buttons in the Primary Rooms
The Copy To Selected and Copy To All buttons in the Primary In and Primary Out rooms
are powerful tools for applying Primary In room or Primary Out room corrections to other
shots in your project.
To copy a primary correction to all currently selected shots in the Timeline
1 Move the playhead to a shot with a grade you want to copy to other shots in your program.
2 Set the grade used by that shot to the one you want to copy.
3 Select all the shots in the Timeline you want to copy the current grade to, being careful
not to move the playhead to another shot.
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The grade at the current position of the playhead is copied to all selected shots.
To copy a primary correction to every single shot in the Timeline
1 Move the playhead to a shot with a grade you want to copy to other shots in your program.
2 Set the grade used by that shot to the one you want to copy.
3 Click Copy To All.
The grade at the current position of the playhead is copied to every shot in your program.
Note: The Secondaries and Color FX rooms don’t have Copy To Selected or Copy To All
buttons. However, you can accomplish the same task in one of two ways: select the shots
you want to copy a correction to and then drag and drop within the Timeline (see Copying
Corrections and Grades in the Timeline); or save a Secondaries or Color FX correction to
that room’s bin, then select the shots you want to apply that correction to and drag it
onto one of the selected shots. For more information, see Applying Saved Corrections
and Grades to Shots.
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You can use the Copy Grade and Paste Grade commands to copy grades from one shot
and paste them into others. Five memory banks are available for copying and pasting
grades. This means that you can copy up to five different grades—with one in each
memory bank—and then paste different grades into different shots as necessary.
To copy a grade into one of the five memory banks
1 Move the playhead to the shot you want to copy a grade from.
2 Make the grade you want to copy the currently selected grade.
3 Choose Grade > Copy Grade > Mem-Bank 1 through 5 (or press Shift–Option–Control–1
through 5).
To paste a grade from one of the five memory banks
1 Move the playhead to the shot you want to copy a grade to.
2 Set the currently selected grade to the grade you want to paste into.
3 Choose Grade > Paste Grade > Mem-Bank 1 through 5 (or press Shift–Option–1 through
5).
The grade is applied to the shot at the position of the playhead.
Note: You cannot paste a grade from one of the five memory banks to multiple selected
shots at once.
You can also use the Copy and Paste memory banks feature via a supported control
surface. For more information, see Setting Up a Control Surface.
Setting a Beauty Grade in the Timeline
When you've set up a project with multiple grades for each shot, it may become difficult
to keep track of the grade you like best for any given shot. Marking a particular grade as
the beauty grade lets you keep track of the currently preferred grade for each shot.
While the beauty grade setting is primarily intended as a visual marker for your reference,
there is a command available from the Render Queue menu to add all beauty grades to
the Render Queue. (For more information, see How to Render Shots in Your Project.) This
means that you can use the beauty grade designation to control which shots are added
to the Render Queue. For example, you might use the beauty grade to keep track of
which clips you’ve changed during a revisions session, making it easy to render only the
changed shots at the end of the day.
The beauty grade does not have to be the currently selected grade, although if you begin
using the beauty grade designation, it’s best to keep it up-to-date for each shot in your
project to avoid confusion.
334 Chapter 13 Managing Corrections and GradesTo mark a grade as the beauty grade
1 Move the playhead to the shot on which you want to set a beauty grade.
2 Select the grade you want to set as the beauty grade.
3 Do one of the following:
• Choose Grade > Set Beauty Grade.
• Press Shift-Control-B.
• Move the pointer into the Timeline area, then press B.
The currently selected grade turns rust red to show that it's the beauty grade.
You can change which grade is set as the beauty grade at any time, or you can clear
beauty grade designations altogether.
To clear the beauty grade designation of one or more shots
1 Select one or more shots in the Timeline.
2 Choose Grade > Clear Selected Beauty Grades.
The beauty grade color is removed from all selected shots.
To clear the beauty grade designation from all shots
µ Choose Grade > Clear All Beauty Grades.
The beauty grade color is removed from all shots in the Timeline
Disabling All Grades
It's often valuable to disable every single correction you've applied to a shot, in order to
see a before-and-after view of the current state of your grade.
To disable and reenable rendering for all grades
µ Press Control-G.
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are disabled, and the grades track of the Timeline turns red to indicate that all grades are
currently disabled.
Note: Pan & Scan settings in the Geometry room remain enabled even when grades are
disabled.
Managing Grades in the Shots Browser
The Shots browser provides a different way to navigate and organize the shots in your
program, in a more nonlinear fashion than the Timeline allows. For example, you can use
the Find field in list view to search for groups of shots with common names.
You can also use icon view as an organizational tool to rearrange the shots in your program
into groups based not on their position in the program, but on the angle of coverage
they're from or the type of grade you'll be applying, to give but two examples. For more
information, see Using the Shots Browser.
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When you're working on a project with many shots, it can help to scroll around and zoom
in and out to find the shots you're looking for.
To scroll around the Shots browser when in icon view
µ Middle-click anywhere within the Shots browser, then drag in the direction you want to
scroll.
To zoom in to or out of the Shots browser when in icon view
Do one of the following:
µ Press the Control key and drag with the left mouse button.
µ Right-click and drag up to zoom out, or down to zoom in.
You can also rearrange shots freely when the Shots browser is in icon view. Rearranging
the order of shots in icon view does nothing to change the shot order in the Timeline,
but it can help you to organize shots visually so they’re faster to find, select, and work
with later.
To move a shot in icon view
µ Drag the name bar of a shot to another location in the Shots browser.
Choosing Grades in Icon View
You can show all the alternate grades that are available to a shot and select the grade
that is currently in use.
To show all of a shot's available grades
µ Double-click the name bar underneath a shot's icon.
All the grades available to that shot appear as bars underneath, connected to the shot
with blue connection lines. Once the grades are revealed, you can change which one is
selected.
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µ Double-click the grade you want to select.
The selected grade turns blue, while the unselected grades remain dark gray.
Note: Grades that have been rendered are colored green.
Selecting Shots in the Shots Browser in Icon View
When in icon view, you can select one or more shots in the Timeline just as you can when
in list view. Additionally, you can select which grade a shot uses by expanding a shot to
reveal all its grades.
To change the current shot in icon view
µ Click the arrow to the right of a shot's name bar.
The current shot's name bar appears gray, and the playhead moves to that shot's first
frame in the Timeline.
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µ Click the shot's name bar, underneath its icon.
Selected shots appear with a cyan highlight over their name bars, and are simultaneously
selected in the Timeline.
To select multiple shots
µ Command-click the name bars of all the shots you want to select.
Grouping and Ungrouping Shots
A group is an organizational construct that's available in the Shots browser only when
it's in icon view. The purpose of groups is very simple: they provide targets with which
you can copy a grade to multiple shots at once.
Some examples of ways you might use groups include:
• You can organize all shots in a particular scene in a single group to facilitate applying
and updating stylized corrections to every shot in that scene at the same time.
• You could also organize only those shots within a scene that are from the same angle
of coverage (and so may be able to share the same corrections), so that you can apply
and update the same grade to every shot at once.
• Every shot of a certain type (for example, all head shots of a specific speaker) can be
grouped together to similarly let you apply corrections or grades to all those shots
simultaneously.
The uses of groups are endless. In short, any time you find yourself wanting to apply a
single correction or grade to an entire series of shots, you should consider using groups.
Note: Shots can only belong to one group at a time.
There are several different ways you can select shots you want to group together.
To select shots in the Timeline or Shots browser (in list view) and create a group
1 Select the shots you want to include in the group by doing one of the following:
• Shift-click or Command-click to select a range of contiguous or noncontiguous shots
in the Timeline.
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of contiguous or noncontiguous shots.
• Use the Find field, or click a column header to sort the list view, to help you identify
the shots you want to group together.
2 Set the Shots browser to icon view.
3 Press G.
A group is created, and a group node appears with blue connection lines showing all the
shots that belong to that group. Once created, you can rearrange the shot icons as
necessary to clean up the browser.
To create a group in icon view
1 Open the Shots browser in the Setup room.
2 Set the Shots browser to icon view.
3 Rearrange the shots you want to group within the Shots browser area (optional).
Even though this step is not strictly necessary, it can be helpful visually for you to see
which shots you're grouping together as a spatially arranged set of icons.
4 Select all the shots you want to group by Command-clicking their name bars.
5 Press G.
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shots that belong to that group.
To add a shot to an already existing group
µ Right-click anywhere on a shot's name bar, then drag a connection line to the node of
the group you want to add it to.
To ungroup a collection of grouped clips
µ Select the group node you want to delete, then press Delete or Forward Delete.
The node and its connection lines disappear, leaving the shots ungrouped.
To remove a single shot from a group
µ Right-click anywhere on a shot's name bar, then drag a connection line to an empty area
of the Shots browser.
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For more information on working with groups once you’ve created them, see Working
with Groups.
Working with Groups
Once you've created one or more groups of shots, you can use the group node to show
and hide the shots that are connected to the group, and to copy grades and corrections
to every shot that's connected to that group.
When a group is collapsed, the shots that are connected to that group are hidden.
Double-clicking a collapsed group makes all the hidden shots visible again.
To collapse or expand a group
µ Double-click any group's node.
Once you've created a group, copying a correction or grade to the group is easy.
To copy a correction to a group
µ Drag the correction bar you want to copy from the Timeline onto any group node.
The correction you dragged overwrites the settings in the same room of every shot in
that group.
342 Chapter 13 Managing Corrections and GradesImportant: You can only copy corrections and grades from the Timeline to groups in the
Shots browser.
To copy a grade to a group
µ Drag a grade bar from the Timeline onto any group node.
The grade you dragged overwrites the currently selected grade of every shot in that
group. Unselected grades are not affected.
Managing a Shot’s Corrections Using Multiple Rooms
Color's interface for correcting and manipulating the color of your shots is extremely
flexible. While each room has individual controls that are tailored to specific kinds of
operations, some functions do overlap, and the Primary In, Secondaries, Color FX, and
Primary Out rooms collectively contribute to the final appearance of your piece. How you
use these rooms is entirely up to you.
At minimum, the grading of every project involves the following steps:
Stage 1: Optimizing the Exposure and Color of Each Shot
See Stage 1: Correcting Errors in Color Balance and Exposure for more information.
Stage 2: Balancing Every Shot in a Scene to Have Similar Contrast and Color Balance
See Stage 3: Balancing All the Shots in a Scene to Match for more information.
Stage 3: Applying a Creative Look to the Scene
See Stage 5: Achieving a “Look for more information.
Stage 4: Making Modifications in Response to Client Feedback
See Stage 8: Making Digital Lighting Adjustments for more information.
These steps can all be performed within a single room, or they can be broken up among
several rooms.
Doing Everything in One Room
• Excluding special operations such as secondary color corrections and Color FX, each
of these steps in the grading process can be performed via a single set of adjustments
within the Primary In room. In fact, for simple programs that don't require extensive
corrections, this may be the only room you use.
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worked to achieve the desired look during the shoot, leaving you with the tasks of
balancing the shots in each scene and making whatever adjustments are necessary to
simply expand and perfect the contrast and color that you’ve been provided.
Grading Across Multiple Rooms
• You can also distribute the different color correction steps outlined above among
multiple rooms. This technique lets you focus your efforts during each stage of the
color correction process and also provides a way of discretely organizing the adjustments
you make, making each change easier to adjust later. For more detailed information,
see Grading a Shot Using Multiple Rooms.
Grading a Shot Using Multiple Rooms
One common color correction strategy is to break up the various stages of correction you
apply to a shot among several rooms in Color, instead of trying to do everything within
the Primary In room. This can focus your efforts during each step of the color correction
process, and it also provides a way of discretely organizing the adjustments you make,
making them easier to adjust later once the client has notes.
This section suggests but one out of countless ways in which the different rooms in Color
can be used to perform the steps necessary to grade your projects.
Stage 1: Optimizing the Exposure and Color of Each Shot
You might start by optimizing each shot's exposure and color in the Primary In room. As
a way of prepping the project in advance of working with the client in a supervised
session, you might restrict your adjustments to simply making each shot look as good as
possible on its own by optimizing its exposure and balancing the color, regardless of the
later steps you'll perform.
Stage 2: Balancing Every Shot in a Scene to Have Similar Contrast and Color Balance
After optimizing each clip, you can balance the contrast and color of each shot to match
the others in that scene using the first tab in the Secondaries room. If you select the
Enable button of the Secondaries room without restricting the default settings of the HSL
qualifiers, the adjustments you make are identical to those made in one of the Primary
rooms.
Important: If you're using a secondary tab to affect the entire image, make sure the
Previews tab is not the selected tab while you work. If the Previews tab is selected, the
monitored image is modified by the selected Matte Preview Mode and may exhibit a
subtle color shift as a result while the Secondaries tab is selected. Clicking the Hue, Sat,
or Lum Curve tabs, even though you're not using them, lets you monitor the image
correctly.
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Now that the shots have been optimized and the scenes balanced, you can focus on
specific creative issues using tabs 2 through 8 in the Secondaries room. You might use
these tabs to apply a creative look, or you could go further and make specific digital
relighting adjustments. At this point in the process, you can also use the Color FX room
to further extend your creative possibilities.
Stage 4: Making Modifications in Response to Client Feedback
Once your client has had the opportunity to screen the nearly finished grade of the
program, you'll no doubt be given additional notes and feedback on your work. You can
use the Primary Out room, which up until now has remained unused, to easily apply these
final touches.
Moreover, because each step of the color grading process was performed in a specific
room of the Color interface, it will hopefully be easier to identify which client notes
correspond to the adjustments needing correction.
The steps outlined above are simply suggestions. With time, you'll undoubtedly develop
your own way of managing the different processes that go into grading programs in
Color.
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The keyframing mechanism in Color is simple, but effective. It’s designed to let you quickly
animate color corrections, vignettes, Color FX nodes, Pan & Scan effects, and user shapes
with a minimum number of steps.
This chapter covers the following:
• Why Keyframe an Effect? (p. 347)
• Keyframing Limitations (p. 347)
• How Keyframing Works in Different Rooms (p. 349)
• Working with Keyframes in the Timeline (p. 351)
• Keyframe Interpolation (p. 353)
Why Keyframe an Effect?
In many cases, you may work on entire projects where there's no need to keyframe any
of your corrections. However, keyframed primary corrections will often let you compensate
for dynamic changes in exposure or color in shots that might otherwise be unusable. You
can also use keyframes to create animated lighting and color effects to further extend a
scene's original lighting.
Here are some common examples of ways you can use animated keyframes:
• Correct an accidental exposure change in the middle of a shot.
• Create an animated lighting effect, such as a light being turned off or on.
• Correct an accidental white balance adjustment in the middle of a shot.
• Move a vignette to follow the movement of a subject.
• Animate a user shape to rotoscope a subject for an intensive correction.
Keyframing Limitations
There are three major limitations to the use of keyframes in Color.
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14You Can’t Keyframe Clips That Use Speed Effects
While color correcting projects that were sent from Final Cut Pro, there’s a limitation to
shots with speed effects applied to them. While they can be adjusted in any of the rooms
in Color like any other shot, speed-effected shots cannot be keyframed in Color.
If you’re prepping a project in Final Cut Pro that you want to send to Color, you can avoid
this limitation by exporting all clips with speed effects as self-contained QuickTime files
and reedit them into the Timeline of your Final Cut Pro sequence to replace the original
effects before you send the sequence to Color.
Tip: If you’re exporting clips with speed effects in order to make them self-contained
QuickTime files, you may want to try sending slow motion clips to Motion, where you
can set the clip’s Frame Blending parameter to Optical Flow for smoother effects
processing. After you’ve processed your slow motion clips in Motion, it’s best to export
self-contained QuickTime files from Motion, which you can then reedit into your
Final Cut Pro sequence to replace the original effects.
You Can’t Keyframe Curves in the Primary or Secondaries Room
Curves in the Primary In and Out rooms, or in the Secondaries room, can’t be animated
with keyframes. The other parameters in the room will be animated, but curves remain
static throughout the shot.
Pan & Scan Room Keyframes Can’t Be Sent Back to Final Cut Pro
Pan & Scan keyframes that are created in Color cannot be translated into corresponding
motion effect keyframes in Final Cut Pro. All Color keyframes are removed when you send
your project back to Final Cut Pro, with the settings at the first frame of each clip being
used for translation.
Note: Keyframed Scale, Rotation, Center, and Aspect Ratio Motion tab parameters in
Final Cut Pro do not appear and are not editable in Color, but these keyframes are
preserved and reappear when you send your project back to Final Cut Pro. If a clip has
Motion tab keyframes from Final Cut Pro, it appears in Color with the geometry of the
last keyframe that’s applied to the clip. If necessary, you can Reset the geometry room
to see the entire clip, since this will have no effect on the keyframes being internally
preserved and returned to Final Cut Pro.
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You can keyframe effects in the Primary In, Secondaries, Color FX, Primary Out and
Geometry rooms. Each room has its own separate set of keyframes, stored in individual
tracks of the keyframe graph of the Timeline. These tracks are hidden until you start
adding keyframes within a particular room, which makes that room's keyframe track
visible.
Keyframes created in each room are visible in the Timeline all at once, but you can edit
and delete only the keyframes of the room that's currently open. All other keyframes are
locked until you open their associated rooms.
Although the ways you create, edit, and remove keyframes are identical for every room,
keyframes have different effects in each room. For more information, see:
• Keyframing Corrections in the Primary In and Out Rooms
• Keyframing Secondary Corrections
• Keyframing Color FX
• Keyframing Pan & Scan Effects
• Keyframing User Shapes
Keyframing Corrections in the Primary In and Out Rooms
You can keyframe every control and parameter in the Primary In and Out rooms. This lets
you correct inappropriately shifting lighting and color caused by automatic camera
settings, as well as create animated effects of your own. There are two caveats to
keyframing corrections in the Primary In and Out rooms:
• Keyframes in the Primary rooms record the state of all controls and parameters at once.
It's not possible to independently keyframe individual parameters.
• Curves cannot be animated with keyframes, although every other parameter in the
Primary In and Primary Out rooms can be.
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setting in the User Prefs tab of the Setup room. In nearly all cases, you'll get the best
results by leaving this option turned off. For more information, see The User Preferences
Tab.
Keyframing Secondary Corrections
Like parameters and controls in the Primary In and Out rooms, most of the color correction
parameters and controls in the Secondaries room can be animated. Each of the eight
secondary tabs has its own keyframe track. Furthermore, each secondary tab's Inside and
Outside settings are individually keyframed.
In addition to the color and contrast controls, the following secondary controls can also
be animated using keyframes:
• The Enable button that turns each secondary correction off and on
• The qualifiers for the secondary keyer
• The Vignette button that turns vignetting off and on
• All vignette shape parameters
Note: Secondary curves cannot be animated with keyframes.
The ability to keyframe all these controls means you can automate secondary color
correction operations in extremely powerful ways. For example, you can adjust the
qualifiers of the secondary keyer to compensate for a change of exposure in the original
shot that's causing an unwanted change in the area of isolation.
Keyframing the vignette shape parameters lets you animate vignettes to follow a moving
subject, or to create other animated spotlight effects.
Keyframing Color FX
You can keyframe node parameters in the Color FX room to create all sorts of effects.
Even though the Color FX room only has a single keyframe track, each node in your node
tree has its own keyframes. You can record the state of every parameter within a node
using a single set of keyframes; however, a node's parameters cannot be individually
keyframed.
The only keyframes that are displayed in the Color FX room's keyframe track are those of
the node that's currently selected for editing. All other node keyframes are hidden. This
can be a bit confusing at first, as keyframes appear and disappear in the Timeline
depending on which node is currently being edited.
Keyframing Pan & Scan Effects
You can keyframe all the adjustments you make using the Pan & Scan parameters and
onscreen controls in the Geometry room, creating animated Pan & Scan effects and
geometric transformations. All parameters are keyframed together.
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You can keyframe user shapes created in the Shapes tab of the Geometry room to
rotoscope (isolate by tracing frame by frame) moving subjects and areas of the frame for
detailed correction in the Secondaries room.
Note: You can only keyframe shapes after they have been assigned to a tab in the
Secondaries room.
Working with Keyframes in the Timeline
It takes a minimum of two keyframes to animate an effect of any kind. Each keyframe
you create stores the state of the room you're in at that frame. When you've added two
keyframes with two different corrections to a room, Color automatically animates the
correction that's applied to the image from the correction at the first keyframe to the
correction at the last.
Once you add a keyframe to a shot in a particular room, you can edit the controls and
parameters in that room only when the playhead is directly over a keyframe. If you want
to make further adjustments to a keyframed shot, you need to move the playhead to the
frame at which you want to make an adjustment and add another keyframe. Then you
can make the necessary adjustments while the playhead is over the new keyframe.
To add a keyframe for the currently open room
µ Choose Timeline > Add Keyframe (or press Control-9).
Once you've added one or more keyframes, you can use a pair of commands to quickly
move the playhead to the next keyframe to the right or left.
Chapter 14 Keyframing 351To move the playhead from one keyframe to the next in the currently open room
Do one of the following:
µ Press Option–Left Arrow to move to the next keyframe to the left.
µ Press Option–Right Arrow to move to the next keyframe to the right.
µ Control-click in the keyframe graph of the Timeline, then choose Next Keyframe or Previous
Keyframe from the shortcut menu.
Keyframes at the current position of the playhead are highlighted.
You can delete keyframes you don't need.
To delete a single keyframe
1 Move the playhead to the frame with the keyframe you want to delete.
2 Choose Timeline > Remove Keyframe (or press Control-0).
You can also delete every keyframe applied to a shot in a particular room all at once.
When you remove all the keyframes from a particular effect, the entire effect is changed
to match the values of the frame at the current position of the playhead.
To delete every keyframe in a single room
1 Click the tab of the room with the keyframes you want to remove.
2 Move the playhead to a frame where the effect is at a state you want applied to the entire
shot.
3 Control-click the keyframe you want to delete in the Timeline, then choose Remove All
Keyframes from the shortcut menu.
Every keyframe applied to that room or secondary tab is deleted, and the keyframe graph
for that room disappears from the Timeline. When you delete all a shot's keyframes at
once, the correction or effects settings of the frame at the position of the playhead become
the settings for the entire shot.
Important: The Remove All Keyframes command removes all the keyframes in the currently
selected room, regardless of which area in the Timeline's keyframe graph you Control-click.
You can easily adjust the timing of keyframes that you're already created.
To move a keyframe and change its timing
µ Drag it to the left or right.
You can also adjust the timing of a keyframe while previewing the frame you're moving
it to.
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µ Press Option while dragging a keyframe to the left or right.
If you need to, you can also make the keyframe graph in the Timeline taller, to make it
easier to see what you're doing. For more information, see Customizing the Timeline
Interface.
You can also use the keyframe graph to navigate to a room with keyframed effects.
To open the room corresponding to a keyframe track
µ Double-click any keyframe track in the Timeline.
Keyframe Interpolation
The interpolation method that a keyframe is set to determines how settings are animated
from one keyframe to the next. There are three possible types of interpolation:
• Smooth: Smooth keyframes begin the transition to the next keyframed state slowly,
reaching full speed in the middle of the transition and then slowing down to a stop at
the next keyframe. This "easing" from one keyframe to the next creates transitions
between color corrections, animated Color FX node parameters, Pan & Scan settings,
and animated user shapes that look and move smoothly and naturally. However, if you
have more than two keyframes, your effect will seem to pause for one frame as the
playhead passes over each keyframe, which may or may not be desirable.
• Linear: Linear keyframes make a steady transition from one keyframed state to the
next, with no acceleration and no slowing down. If you use linear keyframes to animate
an effect that happens somewhere in the middle of a shot, the animated effect may
appear to begin and end somewhat abruptly. On the other hand, if you are keyframing
an animated effect that begins at the first frame and ends at the last frame of the shot,
the appearance will be of a consistent rate of change.
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abruptly to the next keyframed state when the playhead reaches the next constant
keyframe. Constant keyframes are useful when you want an effect to change
immediately to another state, such as increasing the contrast to simulate a sudden
lightning strike flashing through a window.
By default, all new keyframes that you create are smooth, although you can change a
keyframe's interpolation at any time. Changing a keyframe's interpolation affects only
the way values are animated between it and the next keyframe to the right.
To change a keyframe's interpolation
1 Move the playhead to the keyframe you want to change.
2 Choose Timeline > Change Keyframe (or press Control-8).
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draw custom mattes for vignetted secondary operations, and track moving subjects to
automate the animation of vignettes and shapes.
The Geometry room is divided into an image preview (which contains the onscreen
controls for all of the functions in this room) and three tabs to the right. Each tab has
different tools to perform specific functions. The Pan & Scan tab lets you resize, rotate,
flip, and flop shots as necessary. The Shapes tab lets you create custom masks to use with
secondary corrections. Finally, the Tracking tab provides an interface for creating and
applying motion tracking, to use with vignettes and custom shapes in your project.
This chapter covers the following:
• Navigating Within the Image Preview (p. 355)
• The Pan & Scan Tab (p. 356)
• The Shapes Tab (p. 361)
• The Tracking Tab (p. 370)
Navigating Within the Image Preview
Each of the tabs in the Geometry room relies upon onscreen controls in the image preview
area to the left of the controls tabs. You can zoom in or out and scroll around this area
to get a better look at your image while you work, and you can even zoom and pan
around while you’re in the middle of drawing a shape.
To zoom in to or out of the image preview
µ Right-click and drag up to zoom out, and down to zoom in to the image preview.
To pan around the image preview
µ Middle-click to drag the image preview in any direction.
To reframe the image preview to fit to the current size of the screen
µ Press F.
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The Pan & Scan tab lets you apply basic transformations to the shots in your projects.
You can use these transformations to blow images up, reposition them to crop out
unwanted areas of the frame, and rotate shots to create canted angles. You can also use
pan and scan effects to reframe each shot when you’re downconverting a high-resolution
widescreen project to a standard definition 4:3 frame. For more information, see:
• Exchanging Geometry Settings with Final Cut Pro
• Working with the Pan & Scan Tab
• Animating Pan & Scan Settings with Keyframes and Trackers
• Copying and Resetting Pan & Scan Settings
Exchanging Geometry Settings with Final Cut Pro
When you send a sequence from Final Cut Pro to Color, the following Motion tab
parameters are translated into their equivalent Color parameters.
Pan & Scan parameters in Color
Motion tab parameters in
Final Cut Pro
Scale Scale
Rotation Rotation
Center Position X, Position Y
Aspect Ratio Aspect Ratio
While you grade your program, you can preview the effect these transformations have
on each shot and make further adjustments as necessary.
Once you finish working on your project in Color, whether or not Color processes Pan &
Scan adjustments when you render each shot from the Render Queue depends on what
kind of source media you’re using, and how you’re planning on rendering it:
• When projects are sent to Color from Final Cut Pro or imported via XML files, all the
Pan & Scan transformations that are applied to your shots in Color are translated back
into their equivalent Final Cut Pro Motion tab settings. You then have the option to
further customize those effects in Final Cut Pro prior to rendering and output.
• Keyframed Scale, Rotation, Center, and Aspect Ratio Motion tab parameters do not
appear and are not editable in Color, but these keyframes are preserved and reappear
when you send your project back to Final Cut Pro.
• Pan & Scan keyframes created in Color cannot be translated into corresponding Motion
tab keyframes in Final Cut Pro. All Color keyframes are removed when you send your
project back to Final Cut Pro, with the settings at the first frame of each clip being used
for translation.
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transformations are processed within Color along with your color corrections when
rendering the output media.
• If your project uses 4K native RED QuickTime media, then Pan & Scan transformations
are processed within Color, whether you’re rendering DPX/Cineon image sequences
for film output, or QuickTime media to send back to Final Cut Pro. Projects using 2K
native RED QuickTime media work similarly to other projects using QuickTime clips.
Motion Tab Keyframes Are Preserved In Roundtrips
If any clips are animated using Scale, Rotate, Center, or Aspect Ratio parameter keyframes
in Final Cut Pro, these keyframes do not appear and are not editable in Color, but they
are preserved and reappear when you send your project back to Final Cut Pro.
If a clip has Motion tab keyframes from Final Cut Pro, it appears in Color with the
geometry of the last keyframe that is applied to the clip. If necessary, you can reset the
geometry room to see the entire clip while you make corrections in Color, since this will
have no effect on the keyframes being internally preserved and returned to Final Cut Pro.
Working with the Pan & Scan Tab
You can transform shots in your program using two sets of controls. To the left, onscreen
controls appear within the image preview area, while to the right, numeric parameters
mirror these adjustments.
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The onscreen controls for the Pan & Scan tab consist of an outer bounding box that
represents the scaled output with four handles at each corner and a pair of action safe
and title safe indicators within. By default, the onscreen control is the same size as the
resolution of your project.
The onscreen controls are designed to work in conjunction with the image that’s displayed
by the preview and broadcast displays. In other words, you use the onscreen controls to
isolate the portion of the image you want to output, and you view the actual
transformation on the preview and broadcast displays.
To resize a shot
µ Drag any of the four corners of the onscreen control to resize the shot relative to its center.
The onscreen control shrinks or expands to include less or more of the image, and the
preview and broadcast displays show the result. This also adjusts the Scale parameter.
To rotate a shot
µ Drag just outside the four corner handles, right to rotate left, and left to rotate right.
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the onscreen control rotates in the opposite direction of the effect, but the preview and
broadcast displays show the correct result.
To reposition a shot
µ Drag anywhere within the red bounding box.
The onscreen control moves to select a different portion of the shot, and the preview
and broadcast displays show the result.
Note: There are no onscreen controls for the Aspect Ratio, Flip, and Flop controls.
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Each of the adjustments you make using the onscreen controls is mirrored and recorded
numerically by the parameters in the Pan & Scan tab to the right. If you want, you can
directly manipulate these parameters by either entering new values into the fields or by
holding down the middle mouse button and dragging within a field to adjust it using
the virtual slider.
• Position X and Y: Controls the portion of the image that’s viewed when you reposition
the onscreen control. These parameters translate to the two dimensions of the Center
parameter in Final Cut Pro.
• Scale: Controls the size of the image.
• Aspect Ratio: Lets you change the width-to-height ratio of shots to either squeeze or
stretch them. This parameter has no onscreen control.
• Rotation: Lets you spin the shot about the center of the onscreen control.
• Flip Image: Lets you reverse the image horizontally. Right and left are reversed.
• Flop Image: Lets you reverse the image vertically. Top and bottom are reversed.
Important: The Flip Image and Flop Image parameters are disabled when you’re working
with an XML project from Final Cut Pro because there are no equivalent parameters in
the Motion tab.
Animating Pan & Scan Settings with Keyframes and Trackers
Animation of the Pan & Scan parameters is primarily intended for projects which will be
rendered out of Color as DPX or Cineon image sequences. Animating Pan & Scan
parameters is not recommended for projects you’ll be sending back to Final Cut Pro, since
neither keyframes nor tracker data can be sent back.
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• Using keyframes: You can keyframe all the Pan & Scan transform controls. For more
information on keyframing in Color, see Keyframing.
• Using a tracker: You can also use motion tracking to automatically animate a Pan &
Scan effect; for example, to move to follow a character who is walking across the screen.
Once you create a tracker and analyze the shot (in the Tracking tab), you simply choose
the number of the tracker you want to use from the Use Tracker pop-up menu, and
the Position X and Y parameters are automatically animated. If Use Tracker is set to
None, no trackers are applied. For more information, see The Tracking Tab.
Copying and Resetting Pan & Scan Settings
Three buttons at the bottom of the Pan & Scan tab let you copy and reset the adjustments
you make with these controls.
• Copy To Selected button: Select one or more shots in the Timeline, then click this button
to copy the current Pan & Scan settings to all the selected shots.
• Copy To All button: Copies the Pan & Scan settings to all the shots in the program. This
is useful if you’re making a global adjustment when changing the format of a program.
• Reset Geometry button: Resets all the Pan & Scan parameters to the default scale for
your project.
The Shapes Tab
The Shapes tab lets you draw custom shapes to use as vignettes in the Secondaries room
for feature isolation, vignetting, or digital relighting. The Shapes tab is not meant to be
used by itself, nor are you meant to begin operations in the Shapes tab. Instead, shapes
are initially created by choosing the User Shape option from the Shape pop-up menu of
the Vignette controls in the Secondaries room.
When you choose this option, you are immediately taken to the Shapes tab of the
Geometry room, which provides the controls for drawing and editing your own custom
shapes. For a more thorough explanation of this workflow, see Creating a User Shape for
Vignetting.
Note: User Shapes can only be used with secondary operations in the Secondaries room.
They cannot be used in the Color FX room.
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The Shapes tab has the following controls:
• Current Secondary pop-up menu: Lists which of the eight available tabs in the Secondaries
room is the currently selected secondary operation, but you can choose any secondary
tab from this pop-up menu prior to making an assignment. When you click the Attach
button, this is the secondary tab that the currently selected shape will be attached to.
• Attached Shape: When you select a shape that has been attached to a shot’s secondary
tab, this field shows the selected shape’s name and the grade to which it’s been attached
using the following format: shapeName.gradeNumber
• Attach button: Once you’ve drawn a shape you want to use to limit a secondary
operation, click Attach to attach it to the currently open secondary tab in the Secondaries
room (shown in the Current Secondary field).
• Detach button: Click Detach to break the relationship between a shape and the
secondary tab to which it was previously assigned. Once detached, a shape no longer
has a limiting effect on a secondary operation.
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well as the shapes that have been assigned to the current shot. Clicking a shape in this
list displays it in the image preview area and updates all the parameters in the Shapes
tab with the selected shape’s settings.
• Name column: The name of the shape, editable in the Shape Name field.
• ID column: An identification number for the shape. ID numbers start at 0 for the first
shape and are incremented by one every time you create a new shape.
• Grade column: When a shape is attached, this column shows the grade to which it’s
been attached.
• Sec column: When a shape is attached, this column shows which of the eight
secondary tabs the shape has been attached to.
• Hide Shape Handles: Click Hide Shape Handles to hide the control points of shapes in
the image preview. The outline of the shape remains visible.
• Reverse Normals: When a shape is feathered using the Softness parameter, this button
reverses which shape defines the inner and outer edges of feathering.
• Use Tracker pop-up menu: If you’ve analyzed one or more Motion Trackers in the current
project, you can choose which tracker to use to automatically animate the position of
the vignette from this pop-up menu. To disassociate a vignette from the tracker’s
influence, choose None.
• Softness: A global feathering operation for the entire shape. When set to 0, the shape
has a hard (but anti-aliased) edge. When set to any value above 0, inner and outer
softness shapes appear along with their own control points. The inner shape shows
where the feathering begins, while the outer shape shows the very edge of the feathered
shape. If necessary, each border can be independently adjusted.
• Shape Name: This field defaults to “untitled”; however, you can enter your own name
for the currently selected shape in order to better organize the shapes list.
• New button: Click New to create a new, unassigned shape.
• Remove button: Choose a shape and click Remove to delete a shape from the Shapes
list.
• Close Shape/Open Shape button: This button switches the currently selected shape
between a closed and open state.
• Save button: Saves the currently selected shape to the Shape Favorites directory.
• Load button: Loads all shapes that are currently saved in the Shape Favorites directory
into the Shapes list of the current shot.
• B-spline/Polygon buttons: Switches the currently selected shape between B-Spline mode,
which allows for curved shapes, and Polygon mode, in which shapes only have angled
corners.
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select when dragging a selection box in the image preview, without locking any of the
other control points. You can always edit any control point, no matter what this control
is set to.
About the Shapes List
The Shapes list contains an entry for every unattached shape in the current project, as
well as for all of the attached shapes used by the shot at the current position of the
playhead. Clicking a shape in this list displays it in the image preview area and updates
all of the parameters in the Shapes tab with the selected shape’s settings.
• Name column: The name of the shape, editable in the Shape Name field.
• ID column: An identification number for the shape. ID numbers start at 0 for the first
shape and are incremented by one every time you create a new shape.
• Grade column: When a shape is attached, this column shows the grade to which it’s
been attached.
• Sec column: When a shape is attached, this column shows which of the eight secondary
tabs the shape has been attached to.
Saving and Loading Favorite Shapes
You can create a collection of custom shapes to use in other projects by using the Save
and Load buttons. When you select an unattached shape in the Shapes list and click
Save, it’s saved to the following directory:
/Users/username/Library/Application Support/Color/BShapes/ 
Click Load to load all the shapes that are saved within this directory into the Shapes list
of the current shot. Once you decide which shape you want to use, you can remove the
others.
Drawing Shapes
Drawing and editing shapes works in much the same way as other compositing
applications. Color uses B-Splines to draw curved shapes, which are fast to draw and edit.
These splines work similarly to those used in the curves in the Primary and Secondaries
rooms.
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the shape into different directions, like a strong magnet pulling thin wire. For example,
here’s a curve with three control points:
The control point hovering above the shape is pulling the entire shape toward itself,
while the surrounding control points help to keep other parts of the shape in place.
The complexity of a shape is defined by how many control points are exerting influence
on that shape. If two control points are added to either side, and moved down, the curve
can be modified as seen below.
To make curves in a shape sharper, move their control points closer together. To make
curves more gentle, move the control points farther away from one another.
The following procedures describe how to create, remove, and adjust the control points
that edit curve controls.
To draw a shape
1 Click one of the eight tabs in the Secondaries room to use it to make a secondary
correction, turn on the Enable and Vignette buttons, then choose User Shape from the
Shape pop-up menu.
The Shapes tab in the Geometry room opens, and you’re ready to draw a shape.
2 Click anywhere within the image preview area to add the first control point.
3 Continue clicking within the image preview area to add more points.
4 When you’re ready to finish, close the shape by clicking the first control point you created.
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6 Click the Attach button to use the shape in the secondary tab.
A duplicate of the shape you just drew appears in the list, which shows the number of
the grade and the secondary tab to which it’s attached. (The original shape you drew
remains in the list above, ready to be recycled at a future time.) At this point, you’re ready
to use that shape in the Secondaries tab to which it’s been attached.
To adjust a shape
µ Drag any of its control points in any direction.
Unlike Bezier splines, B-Splines have no tangents to adjust. The only adjustments you can
make require using the number and position of control points relative to one another.
To reposition a shape
µ Drag its green center handle in any direction.
The center handle is the point around which keyframing and motion tracking
transformations are made.
To resize a shape
1 Make sure the Main button is selected in the Shapes tab.
2 Drag a selection box around every control point you want to resize.
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You don’t have to select every control point in the shape; you can make a partial selection
to resize only a portion of the overall shape. The center of all selected control points
displays a small green crosshairs box that shows the position of the selected control
points relative to the center handle.
3 Do one of the following:
• Drag any of the four corners of the selection box to resize the shape relative to the
opposite corner, which remains locked in position.
• Option-drag the selection box to resize the shape relative to its center control (visible
as green crosshairs).
• Shift-drag the selection box to resize the shape while locking its aspect ratio, enlarging
or reducing the shape without changing its width-to-height ratio.
To toggle a shape between a curved B-Spline and an angled polygon
µ Click either B-Spline or Polygon in the Shapes tab to change the shape to that type of
rendering.
To feather the edge of a shape
1 Increase its Softness value.
Chapter 15 The Geometry Room 367The Softness parameter applies a uniform feathering around the entire shape. This also
reveals a pair of inside and outside shapes that represent the inner and outer boundaries
of the feathering effect that’s applied to the shape.
2 If necessary, adjust the shape’s inner and outer shape to create the most appropriate
feathering outline around the perimeter of the shape.
This lets you create irregularly feathered outlines when you’re isolating a feature where
one edge should be hard, and another feathered.
To add control points to a previously existing shape
1 Select a shape to edit in the Shapes list.
2 Click Open Shape.
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shape.
4 Click the first control point of the shape when you finish adding more control points.
Animating Shapes with Keyframes and Trackers
If necessary, you can animate shapes in one of two ways:
• Using keyframes: You can keyframe shapes. For more information on keyframing in
Color, see Keyframing.
• Using a tracker: You can also use motion tracking to automatically animate a shape;
for example, to move to follow a feature that’s moving because the camera is panning.
Once you create a tracker and analyze the shot (in the Tracking tab), you simply select
a shape from the Shapes list and choose the number of the tracker you want to use
from the Use Tracker pop-up menu, and the shape is automatically animated. If the
Use Tracker pop-up menu is set to None, no trackers are applied. For more information,
see The Tracking Tab.
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Motion tracking is the process of analyzing a shot in order to follow the motion of a
specific feature in the image to create a motion path. Once you’ve done this, you can use
these motion-tracked camera paths to animate secondary vignettes, Pan & Scan operations,
user shapes, and the Vignette node in the Color FX room to follow these motion paths.
This way, the corrections you make appear to follow moving subjects or the motion of
the camera.
There are actually two kinds of tracking:
• Automatic Tracking: Automatic tracking is ideal, as the computer analyzes part of the
image that you specify to follow a moving subject. This method creates a motion path
with a minimum of user input, but some shots may be difficult to track. When you
create an Automatic Tracker, a single onscreen control appears that consists of a pair
of boxes with crosshairs at the center.
When you process a tracker, Color analyzes an area of pixels specified by the outer
orange Search Region box of the onscreen control, over the range of frames specified
by the Mark In and Mark Out buttons. The tracker attempts to “follow” the feature
you’ve identified (using the inner red Reference Pattern box of the onscreen control)
as it moves across the frame. Angular, high-contrast features are ideal reference patterns
that will give you the best results.
• Manual Tracking: Manual tracking uses you as the computer, providing a streamlined
interface for you to follow a moving subject by clicking it with your mouse, frame by
frame from the In point to the Out point, until you’ve constructed a motion path by
hand. This method can be tedious, but it can also yield the best results for shots that
are difficult to track automatically.
You can use either one or both of these methods together to track a subject’s motion.
Note: Color can only use one-point motion tracking. Two- and four-point tracking are
not supported.
370 Chapter 15 The Geometry RoomWill Motion Tracking Solve All Your Problems?
With shots where there is a clearly defined target (something high-contrast and angular,
preferably), automatic motion tracking can be the fastest way to quickly and accurately
animate a vignette to follow the motion of the subject or camera in a shot, but not
always.
If you’re working on a shot where automatic tracking is almost usable, but has a few
errors, you might be able to use manual tracking on top of the automatic track to correct
the most egregious mistakes, and then increase Tracking Curve Smoothness to get an
acceptable result. For more information about manual tracking, see Using the Tracking
Tab.
However, if actors or other subjects in the shot pass in front of the feature you’re tracking,
or if the motion of a shot is so fast that it introduces motion blur, or if there’s excessive
noise, or if there’s simply not a feature on the subject you need to track that’s
well-enough defined, you may need to resort to manual tracking for the entire shot,
which can be tedious if it’s a long shot. In many cases, manual keyframing may well be
the most efficient solution. For more information on keyframing, see Keyframing.
Using Motion Tracking to Animate Vignettes and Shapes
After you’ve processed a tracker, you can use that tracker’s analysis to animate the
following:
• A vignette in the Secondaries room
• A user shape in the Geometry room
• X and Y positions in the Pan & Scan tab of the Geometry room
• The Vignette node in the Color FX room
When applied to a vignette or a user shape, the animation of the Motion Tracker is added
to the X and Y positioning of the shape. For this reason, it’s most efficient to track a subject
and assign that tracker to the vignette, shape, or setting first, and adjust the positioning
later.
For example, suppose you’ve used a tracker to follow the movement of someone’s eye,
and you want to apply that motion to a vignette that highlights that person’s face. You
should choose the tracker from the Use Tracker pop-up menu first. As soon as you choose
a tracker, the vignette or shape you’re animating moves so that it’s centered on the
tracked feature. At that point, you can position the center, angle, and softness of the
shape to better fit the person’s face. This way, the vignette starts out in the correct position
and goes on to follow the path created by the tracker. Because the tracker uses an
additional transformation, you can still reposition the vignette using the X and Y center
parameters or the onscreen control in the Previews tab.
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tracker that are shorter than the length of the shot, the vignette stays at the initial position
you drag it to until the playhead reaches the tracker’s In point, at which time the vignette
begins to follow the tracker’s motion path. When the playhead reaches the Out point,
the vignette stops and remains at the last tracked frame’s position until the end of the
shot.
Note: If you apply a tracker to the Pan & Scan settings for any shot in a project that was
sent from Final Cut Pro, the tracking data will be lost when the project is sent back to
Final Cut Pro. However, if it’s for a project that’s being rendered as a DPX or Cineon image
sequence, the animated Pan & Scan settings will be rendered into the final image.
Controls in the Tracking Tab
Motion tracking is accomplished by creating a tracker in the Tracker list in the Tracking
tab of the Geometry room. You can create as many trackers for a shot as you like, but
you can only use one at a time to animate a vignette or shape. The Tracker list shows
every tracker you’ve created and analyzed for a given shot, and each tracker has an ID
number (they’re numbered in the order in which they’re created). These ID numbers
appear in the Use Tracker pop-up menu for any vignette or shape that can be animated
using a tracker.
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• Tracker list: A list of all the trackers that have been created for the shot at the current
position of the playhead. This list has three columns:
• Name column: The name of that tracker. All trackers are named in the following
manner: tracker.idNumber
• ID number: The ID number that corresponds to a particular tracker. This is the number
you choose from any Use Tracker pop-up menu to pick a tracker to use to animate
that adjustment.
• Status column: A progress bar that shows whether or not a tracker has been processed.
Red means that a tracker is unprocessed, while green means processed.
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click on a feature in the preview area that you want to track. Each click positions the
onscreen tracker control manually to create a tracking keyframe, and then advances
the playhead one frame, until you reach the end of the shot. Using this feature, you
can rapidly hand-track features in shots that automatic tracking can’t resolve.
• Tracking Curve Smoothness: Smooths the tracking data to eliminate uneven or irregular
motion. Higher values smooth the tracked motion path more. You can smooth both
automatic and manual tracking data.
Note: The original Motion Tracker data is retained and never modified via the smoothing.
• Process: Once you’ve adjusted the onscreen controls to identify a reference pattern
and search area, click Process to perform the analysis.
• New: Creates a new tracker in the Tracker list.
• Remove: Deletes the currently selected tracker in the Tracker list.
• Mark In: Marks an In point in the current shot at which to begin processing. When you
create a new tracker, the In point is automatically created at the current position of the
playhead.
• Mark Out: Marks an Out point in the current shot at which to end processing. When
you create a new tracker, the Out point is automatically created at the end of the last
frame of the shot.
Using the Tracking Tab
This section describes how to use the Tracking tab to create motion paths with which to
animate vignettes, shapes, and Pan & Scan settings.
To automatically track a feature
1 Move the playhead to the shot you want to track.
Since a new In point will be created at the position of the playhead, make sure to move
it to the first frame of the range you want to track.
2 Open the Tracker tab in the Geometry room, then click New.
A new, unprocessed tracker appears in the Tracker list, and its onscreen controls appear
in the image preview area. A green In point automatically appears at the playhead in a
new track of the Timeline, and a green Out point appears at the end.
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you’re tracking is not visible or only moves for a small portion of the shot, you may want
to set In and Out points only for that section of the clip. If the In point was incorrectly
placed, you can always move the playhead to the correct frame and click Mark In.
3 Drag anywhere within the center box of the onscreen control to move it so that the
crosshairs are centered on the feature you want to track.
In this example, the Reference Pattern box is being centered on the man’s eye.
4 Adjust the handles of the inner box (the Reference Pattern box) to fit snugly around this
feature.
The bigger the box, the longer the track will take.
5 Next, adjust the outer box to include as much of the surrounding shot as you judge
necessary to analyze the shot.
Tip: For a successful track, the feature you’ve identified using the Reference Pattern box
should never move outside the search region you’ve defined as the shot proceeds from
one frame to the next. If the motion in the shot is fast, you’ll want to make the outer box
larger, even though this increases the length of time required for the analysis. If the
motion in the shot is slow, you can shrink the Search Region box to a smaller size to
decrease the time needed for analysis.
6 Move the playhead to the last frame of the range you want to track, then click Mark Out.
Chapter 15 The Geometry Room 375A green Out point appears in the Timeline.
In many cases, this will be the last frame of the shot. However, if the feature you’re tracking
becomes obscured, you’ll want to set the Out point to the last frame where the feature
is visible.
7 Click Process.
Color starts to analyze the shot, starting at the In point, and a green progress bar moves
from the In point to the Out point to show how much of the clip has been analyzed.
When processing is complete, that tracker appears with a green bar in the Status column
of the Tracker list, and that tracker is ready to be used in your project. That tracker’s motion
path appears in the image preview area whenever that tracker is selected.
If necessary, the tracker is ready to be refined with smoothing, manual repositioning of
individual control points in the motion path, or manual tracking. When you’re finished,
the tracker is ready to be used to animate a vignette or shape.
If the resulting motion path from an Automatic Tracker has a few glitches, you can drag
individual keyframes around to improve it.
To manually adjust a tracked motion path
1 If necessary, set the Tracking Curve Smoothness to 0 so you can more accurately see and
position the tracked keyframes.
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keyframes that stick out incorrectly, or that drift from the proper direction of the subject’s
motion.
3 Drag the offending control point in the preview area so that it better fits the overall
motion path.
You can drag any control point in the motion path to a new position, not just the keyframe
at the position of the playhead.
If there’s a shot in which the motion is too difficult to track automatically, you might try
manually tracking the feature. You can turn on the Manual Tracker option either to correct
mistakes in an automatically tracked motion path, or you can use manual tracking on its
own to create an entire motion path from scratch.
To manually track a feature
1 Move the playhead to the shot you want to track.
2 Open the Tracker tab in the Geometry room, and do one of the following:
• Click an existing tracker in the Tracker list to modify it.
• Click New to create a new motion path from scratch.
3 Click Manual Tracker to enter Manual Tracking mode.
When you turn on manual tracking, the onscreen tracker control disappears.
4 Move the playhead to the first frame of the range you want to track, then click Mark In.
5 Now that everything’s set up, simply click a feature in the preview area that you want to
track.
For example, if you were tracking someone’s face for vignetting later on, you might click
the nose. Whatever feature you choose, make sure it’s something that you can easily and
clearly click on, in the same place, on every frame you need to track.
Each click creates a keyframe manually, and then advances the playhead one frame.
6 Click the same feature you clicked in the previous frame, as each frame advances, until
you reach the Out point, or the end of the shot.
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of the feature you’re tracking.
7 When you’ve finished manually tracking, stop clicking.
That tracker is ready to be assigned to a parameter elsewhere in your project.
Note: Turning off the Manual Tracker does not turn off your manually tracked keyframes.
Sometimes a motion track is successful, but the resulting motion path is too rough to
use in its original state. Often, irregular motion will expose an animated effect that you’re
trying to keep invisible. These may be seen as jagged motion paths.
In these cases, you can use the Tracking Curve Smoothness slider to smooth out the
motion path that’s created by the tracker.
To smooth a track
1 Select a tracker in the Tracker list.
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tracking path is smooth enough for your needs.
The Tracking Curve Smoothness slider is nondestructive. This means that the original
tracking data is preserved, and you can raise or lower the smoothing that’s applied to
the original data at any time if you need to make further adjustments. Lowering the
Tracking Curve Smoothness to 0 restores the tracking data at its originally analyzed state.
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you do scene-to-scene color correction.
Using the Still Store interface, you can save images from different shots in a project to
use as reference stills for comparison to shots you’re correcting to match. This is a common
operation in scene-to-scene color correction, when you’re balancing all the shots in a
scene to match the exposure and color of one another, so they all look as if they were
shot at the same place, at the same time.
Using the Still Store, you can save reference stills from any shot in your project, for
comparison to any other shot. This means if you’re working on a documentary where a
particular style of headshot is interspersed throughout the program, you can save a
reference still of the graded master headshot, and recall it for comparison to every other
headshot in the program.
This chapter covers the following:
• Saving Images to the Still Store (p. 381)
• Saving Still Store Images in Subdirectories (p. 383)
• Removing Images from the Still Store (p. 383)
• Recalling Images from the Still Store (p. 384)
• Customizing the Still Store View (p. 384)
Saving Images to the Still Store
To use the Still Store, you must first save one or more images for later recall.
To add an image to the Still Store
1 Move the playhead to a frame you want to save to the Still Store.
You should choose a graded image that contains the subjects you need to compare and
that is representative of the lighting and color you’re trying to match.
2 If the Still Store is currently turned on, turn it off to make sure you don’t accidentally save
a still of the currently displayed split screen.
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163 Optionally, if you want to save the still with a custom name, you can click the Still Store
tab and type a name in the File field below the Still Store bin.
If you don’t enter a custom name, each still image you save will be automatically named
in the following manner:
Still.Day_Month_Year_Hour_Minute_SecondTimezone.sri
The date and time reflect exactly when the still image was saved.
Note: If you load a still image into the Still Store immediately prior to saving another one,
the newly saved still image will use the name of the still you loaded, overwriting the
previously saved still as a result.
4 To save the still, do one of the following:
• From any room, choose Still Store > Store (or press Control-I).
• Click the Still Store tab, then click Save.
A still image of the frame at the position of the playhead is saved as an uncompressed
DPX file in the /StillStore/ subdirectory within the project bundle itself. It also appears
within Color as an item in the Still Store bin. When the Still Store is set to icon view, each
saved still appears with a thumbnail for reference.
Still Store images are saved at the native resolution of the source media from which
they’re derived, but they’re not saved with the currently applied LUT correction. That
way, if your project were using a LUT when you saved the images in the Still Store, and
you clear that LUT from your project, the saved still images will continue to match the
shots they originated from.
Important: Still Store images aren’t updated if the shot they originated from is regraded.
This means that if you save a Still Store image from a shot, and then later regrade that
shot to have a different look, the saved Still Store image will no longer be representative
of that shot and should be removed. If there is any question whether or not a still image
correctly reflects a shot’s current grade, the date and time the still image was saved might
provide a hint.
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Because all still images are saved within the “StillStore” subdirectory inside your project
bundle, you may notice that your project takes longer to back up than it used to if you
save a lot of still images. If you need to reduce the size of the project file, you should
delete as many unused Still Store images as you can.
Saving Still Store Images in Subdirectories
By default, whenever you save a still image, it’s saved in your project’s internal “StillStore”
subdirectory and appears in the Still Store bin along with all the other stills you saved.
All stills in the Still Store bin appear in the order in which they were created, with the
newest stills appearing last.
You can also organize your saved stills into subdirectories. You might create individual
subdirectories based on the date of work, the scene stills are saved from, or any other
organizational means of your own devising.
To create a custom subdirectory in the Still Store bin
1 Click the Still Store tab.
2 Click New Folder.
3 When the New Folder dialog appears, enter a name in the “Name of new folder” field,
then click Create.
A new subdirectory appears inside of the “StillStore” directory within your project bundle
and becomes the currently open directory to which all new still images are saved.
Important: You cannot move still images into subdirectories once they’ve been created.
To save new stills in a subdirectory, you need to navigate the Still Store bin to that directory
before saving any new stills.
Removing Images from the Still Store
Saved images can stack up pretty quickly in the Still Store, so you want to make sure you
regularly remove all unnecessary stills.
To remove an image from the Still Store
1 Click the Still Store tab.
2 Select the still image you want to remove.
3 Press the Delete or Forward Delete key.
4 Click Yes in the warning dialog that appears, to confirm that you really do want to delete
the selected still image.
You cannot undo the deletion of a still from the Still Store.
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Once an image has been added to the Still Store, it can be recalled at any time. To display
a saved still image, you need to load it into the Still Store and then enable the Still Store
to view the image.
To load an image into the Still Store
1 Click the Still Store tab.
2 Do one of the following:
• Select the still image you want to load, then click Load.
• Double-click the still image you want to load.
Once a still is loaded, you still have to turn on Display Loaded Still to make the image
visible.
To display an image that’s loaded into the Still Store
Do one of the following:
µ Choose Still Store > Display Loaded Still (or press Control-U).
µ Click the Still Store tab, then select Display Loaded Still.
The currently loaded still image appears both in the preview display and on your broadcast
monitor. By default, still images appear as a left-to-right split-screen comparison, but this
can be customized.
Customizing the Still Store View
Different colorists use the Still Store in different ways. Some prefer to flip between two
full-screen images as they make their comparisons, while others like to create a split
screen so they can compare the Still Store and the shot being graded side by side. Color
lets you work either way. For more information, see:
• Still Store View Settings
• Controls in the Still Store Bin
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Each still image has its own settings for how that image will appear when it’s recalled.
These settings can be found on the right side of the Still Store room.
• Enable: Makes the currently loaded Still Store image visible in the preview and video
output monitors. Identical to the Still Store > Enable (Control-U) command.
• Transition: This parameter determines how much of the loaded still is visible onscreen.
When set to 0, the loaded still is not visible at all. When set to 1, the loaded still fills the
entire screen. Any value in between creates a split-screen view.
• Angle: Changes the angle along which the border of a split screen is oriented. The
orientation buttons below automatically change the Angle parameter, but the only
way to create a diagonal split screen is to customize this control yourself.
• Left to Right: Changes the Angle parameter to 180 degrees, to create a vertical split
screen with the still to the left.
• Right to Left: Changes the Angle parameter to 0 degrees, to create a vertical split screen
with the still to the right.
• Top to Bottom: Changes the Angle parameter to –90 degrees, to create a horizontal
split screen with the still at the top.
• Bottom to Top: Changes the Angle parameter to 90 degrees, to create a horizontal split
screen with the still at the bottom.
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The Still Store bin has the following controls:
• Up Directory button: Clicking this button takes you to the next directory up the current
path. You cannot exit the project bundle. To keep your project organized you should
make sure that you save all your stills within the “StillStore" directory of your project
bundle.
• Home Directory button: Changes the directory path to the “StillStore” directory within
your project bundle.
• Icon View: Changes the Still Store bin to icon view. Each saved still image is represented
by a thumbnail, and all stills are organized according to the date and time they were
saved, with the oldest stills appearing first (from left to right).
• List View: In list view, all still images and directories are represented by two columns;
the still image file’s name appears to the left, and the date of its creation appears to
the right. All stills are organized according to the date and time they were saved, with
the oldest appearing at the top and the newest at the bottom.
• Icon Size slider: When the Still Store bin is in icon view, this slider lets you increase and
decrease the size of the thumbnails that are displayed for each still.
• File field: This field does double duty. When you load a still image, this field displays
the still image’s name. However, if you enter a custom name and then save another
still, the new still will be created with the name you entered.
• Directory pop-up menu: This pop-up menu shows you the current directory path and
lets you navigate farther up the current directory structure, if you wish.
• New Folder button: Creates a new subdirectory inside the StillStore directory of your
project bundle.
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for later recall.
• Load button: Loads a still so that it’s available for comparison using the Enable button,
or the Enable command in the Still Store menu (Control-U).
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let you render the appropriate set of media files for the final output of your program,
either to Final Cut Pro or for delivery to other compatible systems.
This chapter covers the following:
• About Rendering in Color (p. 389)
• The Render Queue Interface (p. 395)
• How to Render Shots in Your Project (p. 396)
• Rendering Multiple Grades for Each Shot (p. 400)
• Managing Rendered Shots in the Timeline (p. 401)
• Examining the Color Render Log (p. 401)
• Choosing Printing Density When Rendering DPX Media (p. 402)
• Gather Rendered Media (p. 403)
About Rendering in Color
Rendering has a different purpose in Color than it does in an application like Final Cut Pro.
In Color, all effects-processing for playback is done on the fly, either dropping frames or
slowing down as necessary to display your color-corrected output at high quality for
evaluation purposes. Playback in Color is not cached to RAM, and there is no way to
“pre-render” your project for playback while you work.
In Color, rendering is treated as the final step in committing your corrections to disk by
generating a new set of media files. The Render Queue lets you render some or all of the
shots in your project once they’ve been corrected in Color.
You can use the Render Queue to render your project either incrementally or all at once.
For example, if you’re working on a high-resolution project with a multi-day or multi-week
schedule, you may choose to add each scene’s shots to the Render Queue as they’re
approved, preparing them for an overnight render at the end of each day’s session. This
distributes the workload over many days and eliminates the need for a single
time-consuming render session to output the entire program at once.
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17The Graphics Card You’re Using Affects the Rendered Output
Color uses the GPU of the graphics card that’s installed in your computer to render the
color correction and geometry adjustments that you’ve applied to the shots in your
program. Different video cards have GPU processors with differing capabilities, so it’s
entirely possible for the same Color project to look slightly different when rendered on
computers with different graphics cards. To ensure color accuracy, it’s best to render
your project on a computer using the same graphics card that was used when color
correcting that program.
Which Effects Does Color Render?
Projects that are imported from XML and EDL project files may have many more effects
than Color is capable of processing. These include transitions, geometric transformations,
superimpositions, and speed effects. When rendering your finished program, your
import/export workflow determines which effects Color renders.
In particular, if you render out 2K or 4K DPX or Cineon image sequences to be printed to
film, Color renders the shots in your project very differently than if you’ve rendered
QuickTime files to be sent in a return trip back to Final Cut Pro.
In all cases, the corrections you’ve made using the Primary In, Secondary, Color FX, and
Primary Out rooms are always rendered.
Effects That Aren’t Rendered in a Color–to–Final Cut Pro Roundtrip
• When you shepherd a project through an XML-based Final Cut Pro–to–Color roundtrip,
all transitions, filters, still images, generators, speed effects, Motion tab keyframes and
superimposition settings, and other non-Color-compatible effects from the original
Final Cut Pro project are preserved within your Color project, even if those effects aren’t
visible.
• Color Corrector 3-way filters are the exception. The last Color Corrector 3-way filter
applied to any clip is converted into a Primary In correction in Color. When you send
the project back to Final Cut Pro, all Color Corrector 3-way filters will have been removed
from your project.
• When you’ve finished grading your program in Color and you render that project as a
series of QuickTime movies in preparation for returning to Final Cut Pro, any of the
previously mentioned effects that have been invisibly preserved are not rendered.
Instead, when you send the finished Color project back to Final Cut Pro, such effects
reappear in the resulting Final Cut Pro sequence. At that point you have the option of
making further adjustments and rendering the Final Cut Pro project prior to outputting
it to tape or as a QuickTime master movie file.
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• When rendering out DPX or Cineon image sequences, all clips are rendered at the
resolution specified by the Resolution Presets pop-up menu in the Project Settings tab
of the Setup Room.
• When rendering out DPX or Cineon image sequences, all the transformations you made
in the Geometry room’s Pan & Scan tab are rendered.
• When rendering out DPX or Cineon image sequences, all video transitions are rendered
as linear dissolves when you use the Gather Rendered Media command to consolidate
the finally rendered frames of your project in preparation for film output. This feature
is only available for projects that use DPX and Cineon image sequence media or RED
QuickTime media, and is intended only to support film out workflows. Only dissolves
are rendered; any other type of transition (such as a wipe or iris) will be rendered as a
dissolve instead.
• Effects that you need to manually create that aren’t rendered by Color include any
video transitions that aren’t dissolves, speed effects, composites, and titles. These must
be created in another application such as Shake.
Effects That Are Rendered When Projects Use 4K Native RED QuickTime Media
• When rendering projects using 4K native RED QuickTime media, the output is always
rendered at the resolution specified by the Resolution Presets pop-up menu in the
Project Settings tab of the Setup room. Additionally, all the transformations you’ve
made in the Geometry room’s Pan & Scan tab are always rendered into the final media.
This is not true of projects using 2K native RED QuickTime media.
• If you’re outputting to film and you’ve set the Render File Type pop-up menu in the
Project Settings tab of the Setup room to DPX or Cineon, then all video transitions are
rendered as linear dissolves when you use the Gather Rendered Media command to
consolidate the finally rendered frames of your project in preparation for film output.
This feature is only available for projects that use DPX and Cineon image sequence
media or RED QuickTime media, and is intended only to support film out workflows.
Only dissolves are rendered; any other type of transition (such as a wipe or iris) will be
rendered as a dissolve instead.
• If you’re sending the project back to Final Cut Pro and the Render File Type pop-up
menu in the Project Settings tab of the Setup room is set to QuickTime, effects such
as transitions that have been invisibly preserved are not rendered. Instead, when you
send the finished Color project back to Final Cut Pro, such effects reappear in the
resulting Final Cut Pro sequence. At that point, you have the option of making further
adjustments and rendering the Final Cut Pro project prior to outputting it to tape or
as a QuickTime master movie file.
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A subset of the static motion settings from Final Cut Pro is translated into the equivalent
Pan & Scan settings in Color when you first import the project. These settings have a
visible effect on your Color project and can be further adjusted as you fine-tune the
program. However, if you’re rendering QuickTime output in preparation for sending
your project back to Final Cut Pro, these effects are not rendered by Color unless your
project uses 4K native RED QuickTime media; ordinarily, static Pan & Scan settings are
passed from Color back to Final Cut Pro for rendering there. Keyframes are handled
differently:
• Keyframed Scale, Rotation, Center, and Aspect Ratio Motion tab parameters from
Final Cut Pro do not appear and are not editable in Color, but these keyframes are
preserved and reappear when you send your project back to Final Cut Pro.
• Color Pan & Scan keyframes cannot be translated into corresponding motion effect
keyframes in Final Cut Pro. All Color keyframes are removed when you send your
project back to Final Cut Pro, with the settings at the first frame of each clip being
used for translation.
For more information, see Exchanging Geometry Settings with Final Cut Pro.
Some Media Formats Require Rendering to a Different Format
There are many codecs that Color supports for media import, such as the XDCAM, MPEG
IMX, and HDV families of codecs, that cannot be used as the export format when rendering
out of Color. Most of these are formats which, because they’re so highly compressed,
would be unsuitable for mastering. Additionally, many of these formats use “squeezed”
anamorphic frame sizes, rather than the standard full-raster SD and HD frame sizes that
programs are typically mastered to. For all of these codecs, two things happen when you
render media for output:
• Media formats that are unsupported for output will be rendered using a different codec: If
the media in your project uses a codec that’s not supported for output, then every shot
in your project will be rendered using a different codec that issupported. In these cases,
Color supports a specific group of codecs that are either lightly or completely
uncompressed that are suitable for mastering. You can choose which of these codecs
to render your media with by choosing from the Resolution and Codec Settings controls
in the Project Settings tab of the Setup room.
• Media formats that are rendered using a different codec will be rendered full raster: If you’re
rendering using a different codec, all anamorphic media in your project will be resized
to the closest full-raster frame size. For example, media using the anamorphic
1280 x 1080 or 1440 x 1080 frame sizes will be rendered using the standard
1920 x 1080 frame size.
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with a dialog when you send your project to Final Cut Pro that asks: “Change graded
Final Cut Pro sequence to match the QuickTime export codec?”
• If you click Yes to change the sequence settings to match the graded media rendered
by Color, then the codec used by the sequence sent to Final Cut Pro will be changed
from the one that was originally sent to Color. Also, the frame size of the sequence will
change to match the frame size of the rendered media.
• If you click No, the settings of the sequence that Color sends back to Final Cut Pro will
be identical to those of the sequence that was originally sent from Final Cut Pro to
Color, but the codec used by the clips won’t match that of the sequence, and the
rendered clips will have their scale and aspect ratio altered to fit the original frame size.
For a complete list of which codecs are supported by Color, see Compatible QuickTime
Codecs for Import.
For a list of the mastering codecs that Color supports for output, see Compatible QuickTime
Codecs for Output.
Rendering Mixed Format Sequences
If you edit together a mixed format sequence in Final Cut Pro—for example, combining
standard definition and high definition clips of differing formats—you can still send it to
Color, as long as each clip of media throughout the sequence is in a format that’s
compatible with Color.
When you render the finished project, how the final media is processed depends on the
format you’re rendering to:
• If you’re rendering QuickTime media to send back to Final Cut Pro: Each shot is individually
rendered with the same frame size, aspect ratio, and interlacing as the original media
file it’s linked to. Regardless of the project’s resolution preset, standard definition shots
are rendered as standard definition, high definition shots are rendered as high definition,
progressive frame shots are rendered progressive, and interlaced shots are rendered
interlaced. On the other hand, every shot in the project is rendered using the QuickTime
export codec that’s specified in the Project Settings tab of the Setup room, and if the
original frame size is a nonstandard high definition frame size, then it is changed to
the nearest full-raster frame size when rendered.
When you send the project back to Final Cut Pro, the Position, Scale, Aspect Ratio, and
Rotation parameters of each shot in the Pan & Scan tab of the Geometry room are
passed back to each clip’s corresponding Motion tab settings in Final Cut Pro, so that
all of the clips conform to the sequence settings as they did before. However, each
rendered media file in the project that was sent back to Final Cut Pro should have the
same frame size, aspect ratio, and interlacing as the original media files that were
originally sent to Color.
Chapter 17 The Render Queue 393If the original frame size of the sequence was a nonstandard high definition frame size,
then you have the option of either changing the sequence frame size when you send
the project back to Final Cut Pro to match that of the full-raster media rendered by
Color, or leaving it alone. In either case, the Motion tab settings for each clip in
Final Cut Pro are automatically adjusted so that all clips fit into the returned sequence
in the same was as they did in in Color.
Ultimately, it’s up to Final Cut Pro to transform and render all clips that don’t match
the current sequence settings as necessary to output the program to whichever format
you require.
• If you’re rendering 4K native RED QuickTime media, or DPX or Cineon image sequences to
be output by a film printer: In this case, all shots are rendered according to the Position,
Scale, Aspect Ratio, and Rotation settings in the Pan & Scan tab settings, with the final
frame size conforming to the currently specified resolution preset. The final result is a
series of DPX or Cineon image sequences with uniform frame sizes.
Mixing Frame Rates is Not Recommended
Mixed format sequences are extremely convenient during the offline edit of a project
that incorporates a wide variety of source material. For example, it’s extremely common
to mix high definition and standard definition clips in documentary programs. In many
cases, you can mix formats with different frame sizes and finish your program using the
original media without problems.
However, it’s not recommended to send a sequence to Color that mixes clips with
different frame rates, particularly when mixing 23.98 fps and 29.97 fps media. The
resulting graded media rendered by Color may have incorrect timecode and in or out
points that are off by a frame.
Furthermore, when outputting to tape, all sequences should consist of clips with
matching frame rates and field handling (progressive or interlaced) for the highest
quality results.
If you have one or more clips in your sequence with a frame rate or field handling
standard that don’t match those of the sequence, you can use Compressor to do a
standards conversion of the mismatched clips. For more information, see Final Cut Studio
Workflows, available at http://documentation.apple.com/en/finalcutstudio/workflows.
Rendering Projects That Use Multiclips
If you’re working on a project that was edited using the multicamera editing features in
Final Cut Pro, the multiclips in your sequence need no special preparation for use in Color.
(They can be sent to Color either collapsed or uncollapsed.) However, no matter how
many angles a multiclip may have had in Final Cut Pro, once a sequence is sent to Color,
only the active angle for each multiclip is visible for grading and rendering. The resulting
sequence of rendered media that is sent back to Final Cut Pro consists of ordinary clips.
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You specify which shots in the program you want to render using the Render Queue list.
Whenever you add shots to this list, they’re organized by shot number. The order in which
shots appear in this column dictates the order in which they’re rendered—the topmost
unrendered shot in the list is rendered first, and then rendering continues for the next
unrendered shot on the list, and so on until the end of the list is reached.
• Render Queue list: Six columns of information appear in the Render Queue:
• Number column: Identifies that shot’s numeric position in the Timeline. All shots in
the Render Queue are listed in descending order based on their ID number.
• Shot Name column: Shows a thumbnail and the name of the shot.
• In column: The first frame of media that will be rendered for that shot. This timecode
is equal to the Project In point plus the current Handles value specified in the Project
Settings tab of the Setup room.
• Out column: The last frame of media that will be rendered for that shot. This timecode
is equal to the Project Out point plus the current Handles value specified in the
Project Settings tab of the Setup room. If there is no extra media available on disk
for handles at the beginning or end of shots, then handles will not be added.
• Grade ID column: Shows the currently selected grade for that shot. You can queue
up the same shot up to four times with different grades enabled, in order to render
media for each grade associated with that shot.
• Progress column: This is the column where a render bar appears to let you know how
long that shot is taking to render. If the shot is not currently rendering, this column
shows the render status of that shot (queued, rendering, or rendered).
Render Queue Controls
The following buttons beneath the Render Queue list let you add shots to the queue,
remove them, and initiate rendering.
• Add Unrendered: Adds all currently unrendered shots to the Render Queue.
• Add Selected: Adds all currently selected shots to the Render Queue.
• Add All: Adds every shot in the Timeline to the Render Queue. Shots that have already
been rendered are also placed in the queue and will be rerendered unless they’re first
removed. Shots that are rerendered overwrite the previously rendered media.
• Remove Selected: Removes only shots that you’ve selected from the Render Queue.
• Clear Queue: Removes all shots from the Render Queue.
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Queue. This button has the same function as the Render > Start Render menu command.
Important: Once you’ve initiated rendering, you can stop it by pressing either Escape
or Control-Period. When you’ve stopped rendering, whichever shot was interrupted
will need to be rerendered from its In point.
How to Render Shots in Your Project
The Render Queue is designed to let you manage the rendering of your project any way
you like. You can add every shot in the program to the Render Queue in order to render
everything at once, or you can add only the shots that were completed that day as part
of a process of rendering your project incrementally.
However you decide to render the media in your project, the process is pretty much the
same: you check your project and shot settings, add shots to the Render Queue, and then
use the Start Render command.
To check your Project Settings and User Preferences before you add shots to the Render
Queue
1 Before you add any shots to the Render Queue, always double-check the Render Directory
field in the Project Settings tab of the Setup room, to make sure that you’re using the
correct render directory. Otherwise, your media may not be rendered where you expect
it to be.
2 Next, check the following parameters in the Project Settings tab, since they affect how
your media is rendered:
• Display LUT: If you have a display LUT applied to your project, it will be rendered into
the output. If you were using the LUT to simulate an output profile (for example, film
printing), you don’t want this to happen. Choose File > Clear Display LUT to prevent
the LUT from affecting the rendered output. For more information, see Using Display
LUTs.
• Resolution Presets: If you change the resolution preset to a different frame size than
the one the project was originally set to, how that frame size affects the rendering of
your final graded media depends on whether your project uses ordinary QuickTime
media, native RED QuickTime media, or DPX/Cineon media. For more information, see
Resolution and Codec Settings.
• Render File Type: This setting determines whether you render QuickTime media
(appropriate for sending back to Final Cut Pro), or DPX or Cineon image sequences
(appropriate for printing to film). For more information, see Resolution and Codec
Settings.
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to the correct format. For more information, see Choosing Printing Density When
Rendering DPX Media.
• Deinterlace Renders: This setting forces Color to deinterlace all media that’s rendered.
Color does not have a sophisticated deinterlacing method, so this setting is inappropriate
for high-quality output. For more information, see Resolution and Codec Settings.
• QuickTime Export Codecs: Choose the QuickTime codec you want to use for rendering
your final output. The list of available codecs is limited to mastering-quality codecs
including Apple ProRes and Uncompressed. For more information, see Compatible
QuickTime Codecs for Output.
• Broadcast Safe: Turning Broadcast Safe on or off affects whether out-of-gamut values
are clipped when the output media is rendered. For more information, see Broadcast
Safe Settings.
3 Lastly, open the User Prefs tab and check the following settings:
• Internal Pixel Format: Make sure that the Internal Pixel Format is set to the correct bit
depth. If you graded your program with Internal Pixel Format set to 8- through 16-bit,
changing it to Floating Point may alter how certain Color FX operations work. If you
intend to work at a lower bit depth but render at Floating Point, it’s a good idea to
double-check all shots with Color FX corrections applied to them prior to rendering to
make sure that they look the way you intended.
• Render Proxy: If you’re rendering Cineon or DPX image sequences, or RED QuickTime
files, and you’re delivering full-quality files, make sure that the Render Proxy pop-up
menu is set to Full Resolution.
To render one or more shots in your program
1 Go through the Timeline and, for each of the shots you’re planning on rendering, choose
the grade you want to render.
The grade you select for each shot determines which grade is rendered when you add a
shot to the Render Queue.
2 Do one of the following to add shots to the Render Queue list:
• Click Add All, or choose Render Queue > Add All (or press Option-Shift-A) to add the
current grade for every shot in the project.
• Click Add Unrendered, or choose Render Queue > Add Unrendered to add only the
shots that haven’t yet been rendered.
• Select one or more shots, then click Add Selected, or choose Render Queue > Add
Selected (or press Option-A) to add only the selected shots.
• Turn on the beauty grade designation for specific shots to indicate which grades are
preferred or which shots you want to render, then choose Render > Add All Beauty
Grades. (Shots without beauty grade designations aren’t added to the Render Queue.)
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add changes to Queued in the Shots browser. In the Timeline, each of the shots that
you added appears with a yellow status bar over the currently used grade for each
queued shot, to show you which of the available grades is being rendered.
Note: You can add a shot to the Render Queue with one grade enabled, then choose
another grade for that shot and add it to the Render Queue again to render both grades
for that shot.
3 Click Start Render, or choose Render Queue > Start Render (or press Command-P).
Tip: You may find that your program renders more quickly if you set the Video Output
pop-up menu in the User Prefs tab of the Setup room to Disabled.
The shots in the Render Queue start rendering. A green progress bar appears in the
Progress column of the first unrendered shot in the list, which shows how long that shot
is taking to render.
At the same time, the render bar appearing above the Timeline ruler for the shot being
rendered gradually turns green to mirror the progress of the render, while the grade bar
that’s currently being rendered turns magenta.
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rendering continues from the top to the bottom of the list until the last shot is rendered.
All rendered shots in the Timeline appear with a green render bar above the Timeline
ruler and a green status bar over the grade that was rendered.
Note: To pause rendering, press Escape (whichever shot is interrupted will have to start
rendering over again from its beginning). You can click Start Render again to resume
rendering.
All rendered media is written to that project’s render directory, which is specified in the
Project Settings tab of the Setup room. The render directory is organized into numbered
subdirectories, with one subdirectory corresponding to each shot in your project’s Timeline.
The number of each subdirectory corresponds to each shot’s number in the Number
column of the Render Queue. Each of these subdirectories contains up to four rendered
sets of media corresponding to each rendered grade.
To save and export your program after rendering
1 After you’ve rendered all of the clips in your project, it’s important to save the project
immediately. The rendered status of each shot in the Timeline includes the path of each
rendered media file, which is used to relink the media when your project is sent back to
Final Cut Pro.
2 Once your Color project is safely saved, you need to send the project to the environment
in which it will be output.
• In a Final Cut Pro roundtrip: Send the project back to Final Cut Pro using the File > Send
To > Final Cut Pro command. For more information, see Sending Your Project Back to
Final Cut Pro.
• If you’re rendering for film output: The next step is to use the File > Gather Rendered
Media command to prepare the final image sequence that will be output to film. For
more information, see Gather Rendered Media.
For more information about options in the Project Settings tab or User Prefs tab in the
Setup room, see The Project Settings Tab or The User Preferences Tab.
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Each shot in your Color project uses one of up to four possible grades. As you work, you
have the ability to freely change which grade is used by any shot, switching among
different looks as necessary during the development of the program’s aesthetic.
You also have the ability to render each of a shot’s grades individually, or together. This
way, whenever there’s a scene where the client might approve one of four different looks,
you can hedge your bets by rendering all versions.
Color keeps track of which grade is currently selected when you send that project back
to Final Cut Pro, or when you use the Gather Rendered Media command, and makes sure
that the appropriate render file is used.
Each rendered grade is numbered. For example, if you rendered two different grades in
a QuickTime-based project for shot number 1, the subdirectory for that shot would have
two shots, named 1_g1.MOV and 1_g2.MOV, with the number coming immediately after
the g indicating which grade that file corresponds to.
To render multiple grades for a single shot
1 Move the playhead to a shot you want to render, and choose the first grade you want to
render out for that shot.
2 Select that shot, click the Render Queue tab, then click Add Selected to add that shot to
the Render Queue.
3 Change the grade used by that shot to the next one you want to render.
4 Click Add Selected again to add that shot to the Render Queue a second time.
Every grade that’s queued for rendering appears with a yellow render bar over the grade
bar in the Timeline.
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render for each shot.
Managing Rendered Shots in the Timeline
Once you’ve rendered shots in the Timeline, they stay rendered unless you make a change
to the grade. When you change the grade of a shot that’s already been rendered, its
render bar will once again turn red, showing that its current state is unrendered. Rendering
the new state of the grade for that shot overwrites the previous render file.
If you try to add a shot that’s currently shown as having been rendered to the Render
Queue (for example, you’ve inadvertently included one or more shots that have already
been rendered in a selection of shots you want to render), a dialog warns you which shots
will be rerendered, with the option to leave them out of the queue.
Clicking Yes forces Color to add them to the Render Queue, where they will be rendered
a second time.
Examining the Color Render Log
Every time you render shots in a project, information about what was rendered, when it
was rendered, and how long it took to render is written to a color.log file. This information
can be used to benchmark your system, troubleshoot rendering issues, and keep a record
of how long different projects take to render. Every time you render anything in any Color
project, information about that rendering session is appended to this one log.
Whenever you click Start Render, the date and time the render was started and number
of clips queued up for rendering is written into the log, followed by information and
statistics about each clip that is rendered. This information includes:
• Path the rendered file was written to
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• QuickTime Codec or Format
• Number of Frames rendered in each rendered file
• Time to render
• Performance (in frames per second)
The date and time that rendering was completed appears after the end of each session’s
individual clip entries.
The color.log file is stored in /Users/username/Library/Logs directory. However, you can
view this log from within Color.
To see the Color render log
µ Choose Render Queue > Show Render Log.
The render log appears in a Console window.
You have the option of clearing out the color.log file if it becomes too long.
To clear the Color render log
µ With the Render Log window showing, click Clear Display.
Choosing Printing Density When Rendering DPX Media
When you’re rendering DPX image sequences in preparation for printing to film, it’s
important that you choose the appropriate Printing Density from the Project Settings tab
of the Setup room. Consult with the film printing facility you’re working with to determine
the right setting for your program.
Note: Choosing Cineon as the Render File Type limits the Printing Density to Film (95
Black - 685 White : Logarithmic), while choosing QuickTime as the Render File Type limits
it to Linear (0 Black - 1023 White).
The Printing Density pop-up menu lets you choose how to map 0 percent black and 100
percent white in each color-corrected shot to the minimum and maximum numeric ranges
that each format supports. Additionally, the option you choose determines whether or
not super-white values are preserved. There are three possible settings:
• Film (95 Black - 685 White : Logarithmic): The minimum and maximum values of 0 and
100 percent in Color’s scopes correspond to the digital values of 95 and 685 in rendered
DPX files. Super-white values above 100, if present in Color, are preserved using this
format.
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percent in Color’s scopes correspond to the digital values of 64 and 940 in rendered
DPX files. Super-white values above 100, if present in Color, are preserved using this
format.
• Linear (0 Black - 1023 White): The minimum and maximum values of 0 and 100 percent
in Color’s scopes correspond to the digital values of 0 and 1023 in rendered DPX files.
Super-white values, if present in Color, are clipped using this format when rendering
DPX files.
This is also the default setting for QuickTime output. When rendering QuickTime files,
super-white values above 100 are preserved if the QuickTime export codec is set to a
Y′CBCR
-compatible codec, such as Apple ProRes 422 (HQ) or 10-bit Uncompressed 4:2:2.
If you’re rendering to an RGB-compatible codec, such as Apple ProRes 4444, super-white
values are clipped.
Gather Rendered Media
The Gather Rendered Media command can only be used if the shots of a project have
been rendered as a series of DPX or Cineon image sequences. This command is used to
reorganize all of a project’s rendered image sequence media in preparation for delivery
to a film printer.
This operation organizes your rendered image sequences in three ways:
• Every rendered frame of media for your project is placed within a single directory.
• Every frame of media for your project is renamed to create a single, continuous range
of frames from the first to the last image of the rendered project.
• All video transitions in your project are rendered as linear dissolves. Only dissolves are
rendered; any other type of transition appearing in your project, such as a wipe or iris,
will be rendered as a dissolve instead.
Important: You cannot gather media in an XML-based roundtrip.
To gather rendered media
1 Chose File > Gather Rendered Media.
2 Choose one of three options for gathering the rendered media for your project:
• Copy Files: Makes duplicates of the image sequence files, but leaves the originally
rendered files in the render directory.
• Move Files: Copies the image sequence files, and then deletes the originally rendered
files from the render directory.
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useful if you want to process the frames using an application on your computer, and
you don’t want to duplicate the media unnecessarily. This is not useful if you’re intending
to transport the media to another facility, since the alias files only point to the original
media in the render directory, and contain no actual image data.
3 Click Create New Directory if you want to place the gathered media inside of a new
directory.
4 Click Gather.
Every rendered frame of every shot in your project is renamed, renumbered, and placed
in the directory you specified, ready for further processing or delivery.
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color so you can color correct your video accurately.
This appendix covers the following:
• About Color Bars (p. 405)
• Calibrating Video Monitors with Color Bars (p. 405)
About Color Bars
Color bars are an electronically generated video signal that meet very strict specifications.
Because the luma and chroma levels are standardized, you can use color bars passing
through different components of a video system to see how each device is affecting the
signal.
NTSC and PAL each have specific color bar standards, and even within NTSC and PAL
there are several standards. When you evaluate color bars on a video scope, it is important
to know which color bars standard you are measuring, or you may make improper
adjustments. “SMPTE bars” is a commonly used standard.
When Should You Use Color Bars?
Analog devices always need to be calibrated and adjusted, even if only by minute
degrees. This is because heat, age, noise, cable length, and many other factors subtly
affect the voltage of an analog electronic video signal, which affects the brightness and
color of the video image. Color bars provide a reference signal you can use to calibrate
the output levels of an analog device.
Calibrating Video Monitors with Color Bars
Editors and broadcast designers shouldn’t rely on an uncalibrated monitor when making
crucial adjustments to the color and brightness of their programs. Instead, it’s important
to use a calibrated broadcast monitor to ensure that any adjustments made to exposure
and color quality are accurate.
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Calibrating Your Monitor
A AppendixMonitors are calibrated using SMPTE standard color bars. Brightness and contrast are
adjusted by eye, using the color bars onscreen. Adjusting chroma and phase involves
using the “blue only” button found on professional video monitors. This calibration should
be done to all monitors in use, whether they’re in the field or in the editing room.
To calibrate your monitor
1 Connect a color bars or test pattern generator to the monitor you’re using, or output one
of the built-in color bars generators in Final Cut Pro.
Important: Avoid using still image graphics of color bars. For more information, see Y′CBCR
Rendering and Color Bars.
2 Turn on the monitor and wait approximately 30 minutes for the monitor to “warm up”
and reach a stable operating temperature.
3 Select the appropriate input on the video monitor so that the color bars are visible on
the screen.
Near the bottom-right corner of the color bars are three black bars of varying intensities.
Each one corresponds to a different brightness value, measured in IRE. (IRE originally
stood for Institute of Radio Engineers, which has since merged into the modern IEEE
organization; the measurement is a video-specific unit of voltage.) These are the PLUGE
(Picture Lineup Generation Equipment) bars, and they allow you to adjust the brightness
and contrast of a video monitor by helping you establish what absolute black should be.
4 Turn the chroma level on the monitor all the way down.
This is a temporary adjustment that allows you to make more accurate luma adjustments.
The Chroma control may also be labeled color or saturation.
5 Adjust the brightness control of your monitor to the point where you can no longer
distinguish between the two PLUGE bars on the left and the adjacent black square.
At this point, the brightest of the bars (11.5 IRE) should just barely be visible, while the
two PLUGE bars on the left (5 IRE and 7.5 IRE) appear to be the same level of black.
6 Now, turn the contrast all the way up so that this bar becomes bright, and then turn it
back down.
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(The example shown below is exaggerated to demonstrate.)
When monitor
brightness and contrast
is properly adjusted, this
strip should barely be
visible above black.
When adjusting the contrast, also watch the white square in the lower left. If the contrast
is too high, the white square appears to “spill” into the surrounding squares. Adjust the
contrast until the luma of the white square no longer spills into surrounding squares.
Important: Contrast should only be adjusted after brightness.
7 Once you have finished adjusting luma settings, turn up the Chroma control to the middle
(detent) position.
Note: Some knobs stop subtly at a default position. This is known as the detent position
of the knob. If you’re adjusting a PAL monitor, then you’re finished. The next few steps
are color adjustments that only need to be made to NTSC monitors.
8 Press the “blue only” button on the front of your monitor to prepare for the adjustment
of the Chroma and Phase controls.
Note: This button is usually only available on professional monitors.
9 Make the following adjustments based on the type of video signal you’re monitoring:
• If you’re monitoring an SDI or component Y′CBCR
signal, you only need to adjust the
Chroma control so that the tops and bottoms of the alternating gray bars match. This
is the only adjustment you need to make, because the Phase control has no effect with
SDI or component signals.
• If you’re monitoring a Y/C (also called S-Video) signal, it’s being run through an RGB
decoder that’s built into the monitor. In this case, adjust both the Chroma and Phase
controls. The chroma affects the balance of the outer two gray bars; the phase affects
the balance of the inner two gray bars. Adjustments made to one of these controls
affects the other, so continue to adjust both until all of the gray bars are of uniform
brightness at top and bottom.
Appendix A Calibrating Your Monitor 407Note: The step in the second bullet also applies to the monitoring of composite signals,
but you really, really shouldn’t be monitoring a composite signal if you’re doing color
correction.
Once your monitor is correctly calibrated, all the gray bars will be evenly gray and all the
black bars evenly black.
When the phase (similar 
to hue) of the monitor is 
correctly adjusted, you 
should see alternating 
bars of gray and black,
as shown.
Y′CBCR Rendering and Color Bars
Y′CBCR
rendering must be supported by the codec used in a sequence in order for
Final Cut Pro to render color bars with a PLUGE (Picture Lineup Generation Equipment)
area that includes a super-black (4 IRE in NTSC, 2 IRE in PAL) signal for calibration. The
PLUGE part of the test signal cannot be rendered using an RGB-based codec.
408 Appendix A Calibrating Your MonitorThis chapter shows the various keyboard shortcuts that are available while working in
Color.
This appendix covers the following:
• Project Shortcuts (p. 409)
• Switching Rooms and Windows (p. 410)
• Scopes Window Shortcuts (p. 411)
• Playback and Navigation (p. 411)
• Grade Shortcuts (p. 412)
• Timeline-Specific Shortcuts (p. 413)
• Editing Shortcuts (p. 413)
• Keyframing Shortcuts (p. 414)
• Shortcuts in the Shots Browser (p. 414)
• Shortcuts in the Geometry Room (p. 414)
• Still Store Shortcuts (p. 414)
• Render Queue Shortcuts (p. 415)
Project Shortcuts
Keyboard shortcut Function
New project
N Open project
O
Revert to last saved state of the current project
R
Save project
S
Save archive as; allows you to name an archive
option S
409
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B AppendixKeyboard shortcut Function
Open archived version of project
option A
Import clip (opens the File browser in the Setup room)
I
Gather Rendered Media (only for Cineon or DPX projects)
option G
Undo; press Command-Z a second time to restore the change
Z
Cut
X
Copy
C
Paste
V
Select All
A
Deselect All
shift A Open Color Help
shift
?
Switching Rooms and Windows
Keyboard shortcut Function
Open Setup room
1 Open Primary In room
2 Open Secondaries room
3 Open Color FX room
4 Open Primary Out room
5 Open Geometry room
6 Open Still Store
7 Open Render Queue
8 Open Project Settings tab in the Setup room
9 Open Shots browser in the Setup room
0
410 Appendix B Keyboard Shortcuts in ColorKeyboard shortcut Function
Select Color window
shift 1
Select Scopes window
shift 2
Switches between single display and dual display modes the next
time Color is opened
shift 0
Scopes Window Shortcuts
Keyboard shortcut Function
Change scope to Waveform
W
Change scope to Vectorscope
V
Change scope to Histogram
H
Change scope to 3D Scope
C
Playback and Navigation
Keyboard shortcut Function
Switches between play and stop
space
Play backward
J
Stop
K
Play forward
L Move playhead to next shot
Move playhead to previous shot
Move playhead back one frame
Move playhead forward one frame
Go to beginning of Timeline
home
Go to end of Timeline
end
Appendix B Keyboard Shortcuts in Color 411Keyboard shortcut Function
Switch playback mode
shift control M
Set In point in Timeline for playback
I
Set Out point in Timeline for playback
O
Grade Shortcuts
Keyboard shortcut Function
Create new grade/switch to grade 1
control 1
Create new grade/switch to grade 2
control 2
Create new grade/switch to grade 3
control 3
Create new grade/switch to grade 4
control 4
Turns grade on/off
control G
Set current grade as the beauty grade
shift control B
Copy current grade to memory bank 1
shift option control 1
Copy current grade to memory bank 2
shift option control 2
Copy current grade to memory bank 3
shift option control 3
Copy current grade to memory bank 4
shift option control 4
Copy current grade to memory bank 5
shift option control 5
Paste grade from memory bank 1
shift option 1
Paste grade from memory bank 2
shift option 2
Paste grade from memory bank 3
shift option 3
Paste grade from memory bank 4
shift option 4
Paste grade from memory bank 5
shift option 5
412 Appendix B Keyboard Shortcuts in ColorTimeline-Specific Shortcuts
Keyboard shortcut Function
Zoom out
Zoom in
=
Zoom to fit every shot into the available width of the Timeline
shift Z
Set Timeline ruler to frames
F
Set Timeline ruler to seconds
S
Set Timeline ruler to minutes
M
Set Timeline ruler to hours
H
Switch Timeline ruler between frames/seconds/minutes/hours
tab
Select all shots in timeline
A
Deselect all shots in timeline
shift A
Shift-click Select a contiguous region of clips in the timeline
Command-click Select a noncontiguous region of clips in the timeline
Editing Shortcuts
Keyboard shortcut Function
Choose Select tool
control S
Choose Roll tool
control R
Choose Ripple tool
control T
Choose Slip tool
control Y
Choose Split tool
control X
Choose Splice tool
control Z
Create an edit at the position of the playhead
control V Merge an edit at the position of the playhead
control B
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Keyboard shortcut Function
Change keyframe interpolation type at position of playhead
control 8
Change keyframe interpolation type at position of playhead
8
Add keyframe at position of playhead
control 9
Add keyframe at position of playhead
9
Delete keyframe at position of playhead
control 0
Delete keyframe at position of playhead
0 Move playhead to previous keyframe of current shot in current
room
option
Move playhead to next keyframe of current shot in current room
option
Shortcuts in the Shots Browser
Keyboard shortcut Function
Assign selected shots into a group
G
Center the Shots browser
F
Shortcuts in the Geometry Room
Keyboard shortcut Function
Frame the preview image in the Geometry room
F
Still Store Shortcuts
Keyboard shortcut Function
Enable currently loaded still
control U
Save frame at the current position of the playhead to the Still Store
control I
414 Appendix B Keyboard Shortcuts in ColorRender Queue Shortcuts
Keyboard shortcut Function
Add selected shots to the Render Queue
option A
Add all shots in the Timeline to the Render Queue
shift option A
Start Render
P
Appendix B Keyboard Shortcuts in Color 415The tables in this section show the various Multi-Touch controls that are available in Color.
Multi-Touch controls require a Multi-Touch capable input device.
This appendix covers the following:
• Multi-Touch Control of the Timeline (p. 417)
• Multi-Touch Control in the Shots Browser (p. 417)
• Multi-Touch Control of the Scopes (p. 418)
• Multi-Touch Control in the Geometry Room (p. 418)
• Multi-Touch Control in the Image Preview of the Scopes Window (p. 419)
Multi-Touch Control of the Timeline
The following Multi-Touch controls let you modify the Timeline’s display.
Multi-Touch Gesture Description
Pinch close Zoom out
Pinch open Zoom in
Two-finger scroll Pan/scroll the Timeline
Three-finger swipe left Select the previous shot
Three-finger swipe right Select the next shot
Three-finger swipe up Select the previous grade
Three-finger swipe down Select the next grade
Rotate right Scrub the playhead forward
Rotate left Scrub the playhead back
Multi-Touch Control in the Shots Browser
The following Multi-Touch controls let you navigate the Shots browser when it’s in icon
view.
417
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Color C AppendixMulti-Touch Gesture Description
Pinch close Shrink icons
Pinch open Enlarge icons
Two-finger scroll Pan around the image preview
Multi-Touch Control of the Scopes
The following Multi-Touch controls let you modify the display of the Video Scopes.
Multi-Touch Gesture Description
Pinch close (Waveform, Zoom out
Vectorscope, 3D scope)
Pinch open (Waveform, Zoom in
Vectorscope, 3D scope)
Rotate left (3D scope) Rotates the 3D scope to the left
Rotate right (3D scope) Rotates the 3D scope to the right
Multi-Touch Control in the Geometry Room
The following Multi-Touch controls let you make adjustments to each shot’s onscreen
controls (scroll, pinch, or rotate inside the onscreen control box), or to the preview display
in the Geometry room (scroll or pinch outside the onscreen control box).
Multi-Touch Gesture Description
Pinch close (inside the onscreen Shrink image
control box)
Pinch open (inside the onscreen Enlarge image
control box)
Two-finger scroll (inside the Pan/scan image
onscreen control box)
Rotate left (inside the onscreen Rotate image left
control box)
Rotate right (inside the onscreen Rotate image right
control box)
Two-finger scroll (outside the Pan/scroll preview image
onscreen control box)
Pinch close (outside the Zoom out of the image preview
onscreen control box)
Pinch open (outside the Zoom into the image preview
onscreen control box)
418 Appendix C Using Multi-Touch Controls in ColorMulti-Touch Control in the Image Preview of the Scopes Window
The following Multi-Touch controls let you make adjustments to each shot’s Pan & Scan
settings in the Geometry room, without having that room open.
Multi-Touch Gesture Description
Pinch close Shrink image
Pinch open Enlarge image
Two-finger scroll Pan/scan image
Rotate left Rotate image left
Rotate right Rotate image right
Appendix C Using Multi-Touch Controls in Color 419Color is compatible with control surfaces from JLCooper and Tangent Devices.
A control surface lets you make simultaneous adjustments to multiple parameters while
you work. Not only is this faster, but it allows you to interactively make complex color
adjustments to different areas of the image at once. This appendix describes how to
connect and configure compatible control surfaces to your computer for use with Color.
This appendix covers the following:
• JLCooper Control Surfaces (p. 421)
• Tangent Devices CP100 Control Surface (p. 426)
• Tangent Devices CP200 Series Control Surface (p. 429)
• Customizing Control Surface Sensitivity (p. 434)
JLCooper Control Surfaces
JLCooper makes a variety of control surfaces that are compatible with both Color and
Final Cut Pro. The MCS family of control surfaces have both navigational and color
correction–specific controls in a variety of configurations. The Eclipse CS is an improved
version of the MCS-3000 and MCS-Spectrum that combines both units into a single control
surface.
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To use compatible JLCooper control surfaces with Color, you need the following:
• Eclipse CX, MCS-3000, MCS-3400, or MCS-3800 with an MCS-Spectrum
421
Setting Up a Control Surface
D Appendix• Your Controller configured with an Ethernet board supplied in Slot #1
• Multiport hub, router, or switch
• Cat-5 Ethernet cables
The Eclipse CX has a single Ethernet connection. The Ethernet connection for the
MCS-Spectrum is bridged to the MCS-3000 using an Expander Cable. The MCS-3000 then
connects to your computer via Ethernet.
Important: The JLCooper control surfaces cannot be connected to the second Ethernet
port of your Mac Pro; it must be connected to your computer’s primary Ethernet port, if
necessary, through a hub or switch if you need to share the port with an Internet
connection.
For more information, see:
• Configuring the MCS-3000 and MCS-Spectrum Control Surfaces
• Controls for the MCS-3000
• Controls for the MCS-Spectrum
Configuring the MCS-3000 and MCS-Spectrum Control Surfaces
The following procedures describe how to configure and use these control surfaces with
Color.
To set up the MCS-3000 and MCS-Spectrum for use with Color
1 Turn on the MCS-3000 and wait for the unit to power up.
The MCS-3000 works similarly to any other networked computer, so you must enter
Ethernet IP settings into the device itself so that it can network with your computer.
2 Hold down the SHIFT and ASSIGN/UTILITY buttons simultaneously.
The current IP address settings should appear in the display at the top of the unit.
3 Using the numeric keypad on the MCS-3000, type in the following values:
a Enter an IP Address, then press ENTER to accept and continue.
For example, you might enter: 192.168.001.010
Note: The first three period-delimited sets of numbers in the IP address must match
the first three sets of numbers that are used on your particular network. If you’re not
sure what values to use, you can check to see what IP address is used by your computer
(look for your computer’s IP address in the Network settings of System Preferences),
and base the MCS-3000 IP address on that, making sure you change the last three
numbers so that this address isn’t used by any other device on your network.
b Enter a gateway address, then press ENTER to accept and continue.
Note: The first three period-delimited sets of numbers in the gateway address must
match the IP address you used.
422 Appendix D Setting Up a Control Surfacec Enter a Subnet Mask number, then press ENTER to accept and continue.
For example, you might enter: 255.255.255.000
d Enter a port number, then press ENTER to accept and continue.
For example, you might enter: 49153
Note: To be safe, use one of the range of values set aside as “dynamic and/or private
ports” from 49152 through 65535.
4 Turn off both the MCS-3000 and the MCS-Spectrum.
Now that your control surface is configured, you need to set it up within Color.
To use the MCS-3000 and MCS-Spectrum with Color
1 Turn on the MCS-Spectrum first, then turn on the MCS-3000.
2 Open Color.
If you’re opening Color for the first time, you see the Control Surface Startup dialog. If
you’ve already opened Color and have turned off the option for making this dialog appear,
you need to click the Show Control Surface Dialog button in the User Prefs tab of the
Setup room.
3 When the Control Surface Startup dialog appears:
a Choose “JLCooper - MCS3000/Spectrum” from the Control Surface pop-up menu.
b Type the IP address you entered into the MCS-3000 into the IP Address field, then press
Enter.
c Type the Port number you entered into the MCS-3000 into the Port field, then press
Enter.
4 Click Yes.
The MCS-3000 and MCS-Spectrum should now be ready for use with Color.
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Many of the controls in the MCS-3000 are identified by the text displays running along
the top of each panel.
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The less obvious controls and functions are as follows:
• Page 1-8: Selects one of the eight main rooms in Color
• F1: Change keyframe interpolation
• F2: Add keyframe
• F3: Remove keyframe
• F4 (Secondaries room): Toggle secondary between inside and outside
• F5 (Secondaries room): Toggle vignette off and on
• F6 (Secondaries room): Open previous secondary tab
• F7 (Secondaries room): Open next secondary tab
• Rewind (>): Jump to end of shot or next shot
• Stop: Stop playback
• Play: Start playback
• Jog wheel: Playhead control
• Key pad: Used for numerical navigation, by either timecode or shot ID
• Locate: Locate Timecode or Shot ID
• Mode: Toggle Locate between Timecode and Shot ID
• Last: Return to last location
• Enter: Cue navigation
• M1: Speed control
424 Appendix D Setting Up a Control Surface• M2: Inch playback
• M3: Disable grade
• Bank1: Switch/Copy/Paste Grade Bank 1
• Bank2: Switch/Copy/Paste Grade Bank 2
• Bank3: Switch/Copy/Paste Grade Bank 3
• Bank4: Switch/Copy/Paste Grade Bank 4
• Assign: Toggle Switch/Copy/Paste grade. (LCD Display would indicate which state you
are in.)
Using the Navigational Controls
There are two different ways to navigate in the Timeline using the keypad on the
MCS-3000.
To switch between timecode and shot number navigation
1 Press Mode Locate or Set Locate on the MCS-3000.
2 Hold down Shift (the blue button under the F-buttons), then press Mode Locate.
The indicators on the MCS-3000 will switch between 00 00 00 00 (Timecode) and 0 (Shot
ID) to let you know what mode you’re in.
To locate a position on the Timeline using timecode (in timecode mode)
1 Press Mode Locate or Set Locate on the MCS-3000.
2 Enter the Timecode you wish to locate, then press Enter.
The playhead moves to that timecode location.
To locate a position on the Timeline using shot numbers (in shot number mode)
1 Press Mode Locate or Set Locate on the MCS-3000.
2 Enter the Shot ID you wish to locate, then press Enter.
The playhead moves to the shot associated with that ID on the Timeline.
Appendix D Setting Up a Control Surface 425Controls for the MCS-Spectrum
Many of the controls in the MCS-3000 and MCS-Spectrum are identified by the text
displays running along the top of each panel.
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The less obvious controls and functions are as follows:
• R1: Reset Shadow contrast slider
• B1: Reset Shadow color control
• Left joyball: Shadow color control adjustment
• Left wheel: Shadow contrast slider adjustment (black point)
• R2: Reset Midtone contrast slider
• B2: Reset Midtone color control
• Center joyball: Midtone color control adjustment
• Center wheel: Midtone contrast slider adjustment (gamma)
• R3: Reset HIghlight contrast slider
• B3: Reset Highlight color control
• Right joyball: HIghlight color control adjustment
• Right wheel: HIghlight contrast slider adjustment (white point)
Tangent Devices CP100 Control Surface
The Tangent Devices CP100 is a single, large control surface that combines all available
functionality into a single device.
The following procedure describes how to configure and use this control surface with
Color.
Note: You must be logged in as an administrator to set up the Tangent Devices CP100.
426 Appendix D Setting Up a Control SurfaceTo set up and use the CP100 for use with Color
1 Connect the TDLan port of the CP100 to the primary Ethernet port of your computer
using an Ethernet cable.
Important: The CP100 cannot be connected to the second Ethernet port of your Mac Pro;
it must be connected to your computer’s primary Ethernet port, if necessary through a
router or switch if you need to share the port with an Internet connection.
2 Turn on the CP100 and wait for the unit to power up.
3 Open Color.
If you’re opening Color for the first time, you see the Control Surface Startup dialog. If
you’ve already opened Color and have turned off the option for making this dialog appear,
you need to click the Show Control Surface Dialog button in the User Prefs tab of the
Setup room.
4 When the Control Surface Startup dialog appears:
a Choose “Tangent Devices - CP100” from the Control Surface pop-up menu.
b When you’re prompted for your Administrator password, enter it into the field and click
OK.
The CP100 should now be ready for use with Color.
Controls in the CP100
The CP100 features the following controls:
• Do: Copy grade (Mem-Bank 1)
• Undo: Paste grade (Mem-Bank 1)
• Redo: Copy grade from previous edit on Timeline
• Cue: Cue up the navigation (modes are Timecode or Shot ID)
• Mark: Create still
• In: Set play marker In
• Out: Set play marker out
Appendix D Setting Up a Control Surface 427• Select: Toggle playback mode
• Mix: Toggle show still
• Grade: Toggle show grade
• Delete: Return grade to identity or base-mem
• ||: Next event
• : Play forward
• Button next to jog/shuttle: Toggle x10 speed control
• /< (while holding down Left Alt): Previous keyframe
• >/ (while holding down Left Alt): Next keyframe
• < (while holding down Left Alt): Step backward one frame
• > (while holding down Left Alt): Step forward one frame
• F1: Toggle keyframe interpolation
• F2: Create keyframe
• F3: Delete keyframe
• F4 (Primary In and Out rooms): Alternate panel encoders
• F5 (Primary In and Out rooms): Set scope resolution to 100%
• F6 (Primary In and Out rooms): Set scope resolution to 25%
• F7 (Primary In and Out rooms): Open Parade waveform
• F8 (Primary In and Out rooms): Open Histogram
In the Secondaries room, F5-F9 serve different functions.
• F5 (Secondaries room): Toggle secondary off and on
• F6 (Secondaries room): Toggle secondary between inside and outside
• F7 (Secondaries room): Toggle vignette off and on
• F8 (Secondaries room): Open previous secondary tab
• F9 (Secondaries room): Open next secondary tab
428 Appendix D Setting Up a Control SurfaceTangent Devices CP200 Series Control Surface
The Tangent Devices CP200 is a modular series of controllers all designed to work together.
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To use the CP200 series of control surfaces with Color, you need the following:
• A CP200-BK Trackerball/Knob panel, CP200-TS Transport/Selection Panel, CP200-K Knob
Panel, and/or CP200-S Selection Panel
• Multiport hub or switch
• Cat-5 Ethernet cables
Important: The CP200 series control surfaces cannot be connected to the second Ethernet
port of your Mac Pro; they must be connected to your computer’s primary Ethernet port,
if necessary through a hub or switch if you need to share the port with an Internet
connection.
For more information, see:
• Configuring the CP200 Series Control Surfaces
• Controls in the CP200-BK (Trackerball/Knob Panel)
• Controls in the CP200-TS (Transport/Selection Panel)
• Controls in the CP200-K (Knob/Button Panel)
Configuring the CP200 Series Control Surfaces
The following procedures describe how to configure and use these control surfaces with
Color.
To set up the CP200 series controllers for use with Color
1 Connect each of the CP200 devices to the router, hub, or switch that’s connected to your
computer.
Appendix D Setting Up a Control Surface 429Important: The CP200 series control surfaces cannot be connected to the second Ethernet
port of your Mac Pro; they must be connected to your computer’s primary Ethernet port,
if necessary through a hub or switch if you need to share the port with an Internet
connection.
2 Before you open Color, turn on each of the CP200 devices you have, and write down the
two- to three-character ID numbers that appear on the display of each.
You use each device’s ID number to set up Color to communicate with these devices.
Note: The ID numbers that Color uses to connect to the CP200 control surfaces are not
the serial numbers that appear on the back or bottom of your CP200 panels.
3 Open Color.
If you’re opening Color for the first time, you see the Control Surface Startup dialog. If
you’ve already opened Color and have turned off the option for making this dialog appear,
you need to click the Show Control Surface Dialog button in the User Prefs tab of the
Setup room.
4 Choose “Tangent Devices - CP200” from the Control Surface pop-up menu.
Each CP200 device that Color is compatible with appears with an Enabled checkbox with
two fields: one for the ID number that you wrote down previously, and one for the IP
address.
5 For each CP200 device you own:
a Select its checkbox.
b Type its ID number into the corresponding field, then press Enter to continue.
c Type an IP address into the corresponding field, then press Enter to continue.
Note: The first three period–delimited sets of numbers in the IP address must match
the first three sets of numbers that are used on your particular network. If you’re not
sure what values to use, you can check to see what IP address is used by your computer,
and base the CP200 IP address on that, making sure you change the last three numbers
so that the address is unique.
6 Click Yes.
430 Appendix D Setting Up a Control SurfaceAfter you click Yes, Color connects with the control surfaces on the network. If this is
successful, then each panel’s display should now go blank.
The CP200 series control surfaces are now ready for use with Color.
Controls in the CP200-BK (Trackerball/Knob Panel)
The CP200-BK has the following controls:
F1 F2 F3
F4 F5 F6
F7 F8 F9
In the Primary In and Out rooms:
• Left (Dot) button above wheels: Reset contrast slider for that zone
• Right (Circle) button above wheels: Reset color control for that zone
• Left joyball: Shadow color control adjustment
• Left wheel: Shadow contrast slider adjustment (black point)
• Center joyball: Midtone color control adjustment
• Center wheel: Midtone contrast slider adjustment (gamma)
• Right joyball: HIghlight color control adjustment
• Right wheel: HIghlight contrast slider adjustment (white point)
• F1: Toggle keyframe Interpolation
• F2: Add keyframe
• F3: Delete keyframe
• F4: Alternate panel encoders
In the Secondaries room:
• F1: Toggle keyframe Interpolation
• F2: Add keyframe
• F3: Delete keyframe
• F4: Alternate panel encoders
Appendix D Setting Up a Control Surface 431• F5: Toggle secondary
• F6: Toggle secondary In/Out control
• F7: Toggle secondary vignette
• F8: Previous secondary
• F9: Next secondary
Note: In the Secondaries room, when switching to preview mode, the vignette controls
will override these controls.
In the Geometry room:
• F1: Change keyframe
• F2: Add keyframe
• F3: Delete keyframe
• F4: Alternate panel encoders
Controls in the CP200-TS (Transport/Selection Panel)
The CP200-TS has the following controls:
MEM
ALT
GRACE DELETE
MARK IN OUT
CUE
DO UNDO
MORE
REDO 7
4
1
00 0
2 3 -
5 6 +
8 9
PREV NEXT
MODE
CLEAR
• Do: Copy grade (mem-bank 1)
• Undo: Paste grade (mem-bank 1)
• Redo: Copy grade from previous edit on Timeline
• Cue: Cue up the navigation (modes are Timecode or Shot ID)
• Mark: Create still
• In: Set play marker In
• Out: Set play marker out
• Mem: Toggle show still
• Grade: Toggle show grade
432 Appendix D Setting Up a Control Surface• Delete: Return grade to Identity or base-mem
• ||: Next event
• : Play forward
• Button next to jog/shuttle: Toggle x10 speed control
When Left Alt is held down:
• ||: Next keyframe
• : Step forward one frame
Controls in the CP200-K (Knob/Button Panel)
The CP200-K has the following controls:
• RGB channel controls
Note: When you open the Previews tab in the Secondaries room, the HSL qualifier controls
override the RBG channel controls.
Appendix D Setting Up a Control Surface 433Customizing Control Surface Sensitivity
You can customize the sensitivity of the joyballs, knobs, contrast wheels, and the angle
at which the joyballs adjust color, using settings located in the User Prefs tab of the Setup
room.
For more information, see Control Surface Settings.
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1 Getting Started
Congratulations on purchasing AirPort Extreme. Read this 
guide to get started using it.
AirPort Extreme is based on an Institute of Electrical and Electronics Engineers (IEEE) 
draft 802.11n specification and provides better performance and greater range than 
previous IEEE 802.11 standards. AirPort Extreme is compatible with computers using 
802.11b, and 802.11g, as well as computers using the 802.11a wireless standards.
With AirPort Extreme, you can:
Â Create a wireless network in your home, and then connect to the Internet and share 
the connection with multiple computers simultaneously. An entire family or office 
can be connected to the Internet at the same time.
Â Connect AirPort Extreme to your Ethernet network.Wireless-equipped Macintosh 
computers or Windows XP computers can then have access to an entire network 
without being connected by a cable.
Â Connect a USB printer to your AirPort Extreme. All of the compatible computers on 
the AirPort network, both wireless and wired, can print to it.4 Chapter 1   Getting Started
Â Connect a USB hard disk to your AirPort Extreme. All of the compatible computers on 
the AirPort network, both wireless and wired, can access the information on the hard 
disk.
Â Connect a USB hub to your AirPort Extreme, and then connect multiple USB devices,
such as printers or hard disks, and all of the computers on the network have access to
those devices.Chapter 1   Getting Started 5
About AirPort Extreme
AirPort Extreme has five ports, located on the back:
Â One 10/100 Ethernet Wide Area Network (WAN) port ( All Programs > AirPort on a computer using Windows XP.
See “AirPort Extreme Networks” on page 10 for examples of all the ways you can use 
AirPort Extreme, and information about how to set it up.
Light Status/description
Off AirPort Extreme is unplugged.
Flashing green AirPort Extreme is starting up. The light flashes for one second.
Solid green AirPort Extreme is on and working properly. If you choose Flash 
On Activity from the Status Light pop-up menu (on the Base 
Station pane of AirPort settings in AirPort Utility), the status light 
may flash green to indicate normal activity.
Flashing amber AirPort Extreme cannot establish a connection to the network or 
the Internet. See “Your AirPort Extreme Status Light Flashes 
Amber” on page 26.
Solid amber AirPort Extreme is completing its startup sequence.
Flashing amber and green There may be a problem starting up. AirPort Extreme will restart 
and try again.10
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2 AirPort Extreme Networks
In this chapter you’ll find explanations of the different ways 
you can use AirPort Extreme.
This chapter gives examples of the different kinds of networks you can set up using 
AirPort Extreme. It provides diagrams and explanations of what you need to do to get 
your AirPort Extreme network up and running quickly.
See Chapter 3,“Setting Up AirPort Extreme,” on page 19 to find out more about using 
AirPort Utility to help set up your network.Chapter 2   AirPort Extreme Networks 11
Using AirPort Extreme with Your Broadband Internet Service
When you set up AirPort Extreme to provide network and Internet access, Macintosh 
computers with AirPort and AirPort Extreme Cards, and 802.11a, 802.11b, 802.11g, and 
IEEE 802.11n draft specification wireless-equipped computers can access the wireless 
AirPort network to share files, play games, and use Internet applications like web 
browsers and email applications.
It looks like this:
DSL or cable modem Internet WAN port
to Internet
 All Programs > AirPort on a computer using 
Windows), select your base station, and then click Continue.
3 Follow the onscreen instructions to create a new network. (See “Setting Up 
AirPort Extreme” on page 19.)
Computers using AirPort and computers using other wireless cards or adapters connect 
to the Internet through AirPort Extreme. Computers connected to AirPort Extreme 
Ethernet ports can also access the network and connect to the Internet.
Wireless computers and computers connected to the Ethernet ports can also 
communicate with one another through AirPort Extreme.Chapter 2   AirPort Extreme Networks 13
Using AirPort Extreme to Share a USB Printer
When you connect a USB printer to your AirPort Extreme, all computers on the network 
(wired and wireless) can print to it.
It looks like this:
USB port
Shared printer
d14 Chapter 2   AirPort Extreme Networks
To set it up:
1 Connect the printer to the AirPort Extreme USB port (d) using a USB cable.
2 Open AirPort Utility (located in the Utilities folder in the Applications folder on a 
computer using Mac OS X, and in Start > All Programs > AirPort on a computer using 
Windows), select your base station, and then click Continue.
3 Follow the onscreen instructions to create a new network.
To print from a computer using Mac OS X v10.2.7 or later:
1 Open Printer Setup Utility (located in the Utilities folder in the Applications folder).
2 Select the printer from the list.
If the printer is not in the list, click Add and choose Bonjour from the pop-up menu,
and then select the printer from the list.
To print from a computer using or Windows XP:
1 Install Bonjour for Windows from the CD that came with your AirPort Extreme.
2 Follow the onscreen instructions to connect your printer.Chapter 2   AirPort Extreme Networks 15
Using AirPort Extreme to Share a USB Hard Disk
When you connect a USB hard disk to your AirPort Extreme, all computers on the 
network (wired and wireless) can access the hard disk to access, share, and store files.
It looks like this:
Shared hard disk drive
d USB port16 Chapter 2   AirPort Extreme Networks
To set it up:
1 Connect the hard disk to the AirPort Extreme USB port (d) using a USB cable.
2 Open AirPort Utility (located in the Utilities folder in the Applications folder on a 
computer using Mac OS X, and in Start > All Programs > AirPort on a computer using 
Windows), select your base station, and then click Continue.
3 Follow the onscreen instructions to create a new network.
Computers can access the hard disk to share or store files using Mac OS X v10.4 or later,
or Windows XP (with Service Pack 2).Chapter 2   AirPort Extreme Networks 17
Using AirPort Extreme with Your AirPort Network
The illustration below shows a wireless network utilizing all the capabilities of AirPort 
Extreme.
DSL or cable
to USB port modem
to Internet
to Ethernet
port
Family Room Living Room
Shared hard
disk drive18 Chapter 2   AirPort Extreme Networks
To set it up:
1 Connect all the devices you plan to use in your network.
2 Open AirPort Utility (located in the Utilities folder in the Applications folder on a 
computer using Mac OS X, and in Start > All Programs > AirPort on a computer using 
Windows), select your base station, and then click Continue.
3 Follow the onscreen instructions to set up your network. (See “Setting Up 
AirPort Extreme” on page 19.)3
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3 Setting Up AirPort Extreme
This chapter provides information and instructions for using 
AirPort Utility to set up your AirPort Extreme.
Use the diagrams in the previous chapter to help you decide where you want to use 
your AirPort Extreme, and what features you want to set up on your AirPort network.
Then use the instructions in this chapter to easily configure AirPort Extreme and set up 
your AirPort network.
This chapter provides an overview for using the setup assistant in AirPort Utility to set 
up your network and other features of your AirPort Extreme. For more detailed wireless 
networking information, and for information about the advanced features of AirPort 
Utility, refer to the “Designing AirPort Extreme 802.11n Networks” document, located at 
www.apple.com/support/airport.
You can do most of your network setup and configuration tasks using the setup 
assistant in AirPort Utility. To set advanced options, choose Manual Setup from the Base 
Station menu of AirPort Utility. See “Setting Advanced Options” on page 23.20 Chapter 3   Setting Up AirPort Extreme
Using the AirPort Utility
To set up and configure your AirPort Extreme to use AirPort for wireless networking 
and Internet access, use the setup assistant in AirPort Utility. AirPort Utility is installed 
on your computer when you install the software on the AirPort Extreme CD.
On a Macintosh computer using Mac OS X v10.4 or later:
1 Open AirPort Utility, located in the Utilities folder in your Applications folder.
2 Select your base station and click Continue.
3 Follow the onscreen instructions to set up your AirPort Extreme and your wireless 
network.
On a computer using Windows XP (with Service Pack 2):
1 Open AirPort Utility, located in Start > All Programs > AirPort.
2 Select your base station and click Continue.
3 Follow the onscreen instructions to set up your AirPort Extreme and your wireless 
network.
The setup assistant in AirPort Utility asks you a series of questions about the type of 
network you want to use and the services you want to set up. The setup assistant helps 
you enter the appropriate settings for the network you are setting up.
If you are using AirPort Extreme to connect to the Internet, you need a broadband (DSL 
or cable modem) account with an Internet service provider, or a connection to the 
Internet using an existing Ethernet network. If you received specific information from 
your ISP (such as a static IP address or a DHCP client ID), you may need to enter it in 
AirPort Utility. Have this information available before you set up your AirPort Extreme.Chapter 3   Setting Up AirPort Extreme 21
Creating a New Wireless Network
You can use the setup assistant in AirPort Utility to create a new wireless network. The 
setup assistant guides you through the steps necessary to name your network, protect 
your network with a password, and set other options.
If you plan to share a USB printer or USB hard disk on your network:
1 Connect the printer or hard disk to the AirPort Extreme USB port (d).
2 Open AirPort Utility, located in Utilities folder in the Applications folder on a Macintosh,
or in Start > All Programs > AirPort on a computer using Windows XP.
3 Follow the onscreen instructions to create a new network.
Configuring and Sharing Internet Access
If you plan to share your Internet connection with wireless-enabled computers on your 
network or computers connected to the Ethernet ports, you need to set up your 
AirPort Extreme as an AirPort Base Station. Once it is set up, computers access the 
Internet via the AirPort network. The base station connects to the Internet and 
transmits information to the computers over the AirPort network.
Before you use the AirPort Utility to set up your base station, connect your DSL or cable 
modem to the AirPort Extreme Ethernet WAN port ( All Programs > AirPort on a computer using Windows XP.
3 Select your base station and click Continue.
4 Follow the onscreen instructions to configure and share Internet access on your 
AirPort Extreme.
Using AirPort Utility is a quick and easy way to set up your base station and network. If
you want to set additional options for your network, such as restricting access to your 
network, or setting advanced DHCP options, you can choose Manual Setup from the 
Base Station menu of AirPort Utility.Chapter 3   Setting Up AirPort Extreme 23
Setting Advanced Options
To set advanced options, you can use AirPort Utility to set up your AirPort Extreme 
manually. You can configure advanced base station settings, such as advanced security 
options, closed networks, DHCP lease time, access control, power controls, setting up 
user accounts, and more.
To set advanced options:
1 Choose the wireless network you want to change. On a Macintosh, use the AirPort 
status menu in the menu bar. On a computer using Windows XP, hold the pointer over 
the wireless connection icon until you see your AirPort network name (SSID), and 
choose it from the list if there are multiple networks available.
The default network name for an Apple base station is AirPort Network XXXXXX, where
XXXXXX is replaced with the last six digits of the AirPort ID, also know as the Media 
Access Control or MAC address. The AirPort ID is printed on the bottom of an AirPort 
Extreme and on the electrical-plug side of the AirPort Express.
2 Open AirPort Utility, located in the Utilities folder in the Applications folder on a 
Macintosh, and in Start > All Programs > AirPort on a computer using Windows XP.
3 If there is more than one base station in the list, select the base station you want to
configure. If you don’t see the base station you want to configure, click Rescan to scan 
for available base stations, then select the base station you want.
4 Choose Manual Setup from the Base Station menu. If you are prompted for a password,
enter it.
For more information and detailed instructions for using the manual setup features
AirPort Utility, see the “Designing AirPort Extreme 802.11n Networks” document, located 
at www.apple.com/support/airport.24
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4 Tips and Troubleshooting
You can quickly solve most problems with AirPort Extreme by
following the advice in this chapter.
You Forgot Your Network or Base Station Password
You can clear the AirPort network or base station password by resetting 
AirPort Extreme.
To reset the base station password:
1 Use the end of a straightened paper clip to press and hold the reset button for one (1) 
second.
Important:  If you hold the reset button for more than one (1) second, you may lose 
your network settings.
2 Select your AirPort network.
Â On a Macintosh, use the AirPort status menu in the menu bar to select the network 
created by AirPort Extreme (the network name does not change).
Â On a computer using Windows XP, hold the pointer over the wireless connection icon 
until you see your AirPort Network Name (SSID), and choose it from the list if there 
are multiple networks available.
3 Open AirPort Utility (in the Utilities folder in the Applications folder on a Macintosh,
and in Start > All Programs > AirPort on a computer using Windows XP).Chapter 4   Tips and Troubleshooting 25
4 Select your base station and then choose Manual Setup from the Base Station menu.
5 Click AirPort in the toolbar, and then click Base Station.
6 Enter a new password for the base station.
7 Click Wireless and choose an encryption method from the Wireless Security pop-up 
menu to turn on encryption and activate password protection for your AirPort network.
If you turn on encryption, enter a new password for your AirPort network.
8 Click Update to restart the base station and load the new settings.
Your AirPort Extreme Isn’t Responding
Try unplugging it and plugging it back in.
If your AirPort Extreme stops responding completely, you may need to reset it to the 
factory default settings.
Important:  This erases all of your base station settings and resets them to the settings 
that came with the AirPort Extreme.
To return AirPort Extreme to the factory settings:
m Use the end of a straightened paper clip to press and hold the reset button until the 
status light flashes quickly (about 5 seconds).
AirPort Extreme resets with the following settings:
Â AirPort Extreme receives its IP address using DHCP.
Â The network name reverts to Apple Network XXXXXX (where XXXXXX is replaced
with the last six digits of the AirPort ID).
Â The base station password returns to public.26 Chapter 4   Tips and Troubleshooting
If your base station is still not responding, try the following:
1 Unplug AirPort Extreme.
2 Use the end of a straightened paper clip to press and hold the reset button while you 
plug in AirPort Extreme.
Your AirPort Extreme Status Light Flashes Amber
The Ethernet cable may not be connected properly, AirPort Extreme may be out of 
range of an AirPort network, or there may be a problem with your Internet service 
provider. If you are connected to the Internet with a DSL or cable modem, the modem 
may have lost its connection to the network or the Internet. Even if the modem seems 
to be working properly, try disconnecting the modem from its power supply, waiting a 
few seconds, and then reconnecting it. Make sure AirPort Extreme is connected directly 
to the modem via Ethernet before reconnecting power to the modem.
For more information about the reason the light flashes, open AirPort Utility, select 
your base station, and then choose Manual Setup from the Base Station menu. The 
information about the flashing light is displayed on the Summary pane.
Your Printer Isn’t Responding
If you connected a printer to the USB port on AirPort Extreme and the computers on 
the AirPort network can’t print, try doing the following:
1 Make sure the printer is plugged in and turned on.
2 Make sure the cables are securely connected to the printer and to the AirPort Extreme 
USB port.Chapter 4   Tips and Troubleshooting 27
3 Make sure the printer is selected in the Printer List window on client computers. On a 
Macintosh using Mac OS X v10.2.7 or later:
Â Open Printer Setup Utility, located in the Utilities folder in the Applications folder.
Â If the printer is not in the list, click Add.
Â Choose Bonjour from the pop-up menu.
Â Select the printer and click Add.
To select your printer on a computer using Windows XP:
Â Open “Printers and Faxes” from the Start menu.
Â Select the printer. If the printer is not in the list, click Add Printer and then follow the 
onscreen instructions.
4 Turn the printer off, wait a few seconds, then turn it back on.
I Want to Update My AirPort Software
Apple periodically updates AirPort software to improve performance or add features.
It is recommended that you update your AirPort Extreme to use the latest software. To
download the latest version of AirPort software, go to
www.support.apple.com/airport.
AirPort Extreme Placement Considerations
The following recommendations can help your AirPort Extreme achieve maximum 
wireless range and optimal network coverage.
Â Place your AirPort Extreme in an open area where there are few obstructions, such as 
large pieces of furniture or walls. Try to place it away from metallic surfaces.
Â If you place your AirPort Extreme behind furniture, keep at least an inch of space 
between the AirPort Extreme and the edge of the furniture.28 Chapter 4   Tips and Troubleshooting
Â Avoid placing your AirPort Extreme in areas surrounded by metal surfaces on 
three or more sides.
Â If you place your AirPort Extreme in an entertainment center with your stereo 
equipment, avoid completely surrounding AirPort Extreme with audio, video, or 
power cables. Place your AirPort Extreme so that the cables are to one side. Maintain 
as much space as possible between AirPort Extreme and the cables.
Â Try to place your AirPort Extreme at least 25 feet from a microwave oven, 2.4 or 5 
gigahertz (GHz) cordless phones, or other sources of interference.
Items That Can Cause Interference With AirPort
The farther away the interference source, the less likely it is to cause a problem. The 
following items can cause interference with AirPort communication:
Â Microwave ovens
Â Direct Satellite Service (DSS) radio frequency leakage
Â The original coaxial cable that came with certain types of satellite dishes. Contact the 
device manufacturer and obtain newer cables.
Â Certain electrical devices such as power lines, electrical railroad tracks, and power 
stations
Â Cordless telephones that operate in the 2.4 or 5 GHz range. If you have problems 
with your phone or AirPort communication, change the channel your base station or 
AirPort Extreme uses, or change the channel your phone uses.
Â Nearby base stations using adjacent channels. For example, if base station A is set to
channel 1, base station B should be set to channel 6 or 11.5
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5 Learning More,
Service, and Support
You can find more information about using AirPort Extreme on 
the web and in onscreen help.
Online Resources 
For the latest information on AirPort Extreme, go to www.apple.com/airport.
To register AirPort Extreme (if you didn’t do it when you installed the software on the 
AirPort Extreme CD), go to www.apple.com/register.
For AirPort service and support information, a variety of forums with product-specific 
information and feedback, and the latest Apple software downloads, go to
www.apple.com/support/airport.
For support outside of the United States, go to www.apple.com/support, and then 
choose your country from the pop-up menu.30 Chapter 5   Learning More, Service, and Support
Onscreen Help
m To learn more about using AirPort, open AirPort Utility and choose Help > AirPort 
Utility Help.
Obtaining Warranty Service
If the product appears to be damaged or does not function properly, please follow the 
advice in this booklet, the onscreen help, and the online resources.
If the base station still does not function, go to www.apple.com/support for 
instructions about how to obtain warranty service.
Finding the Serial Number of Your AirPort Extreme
The serial number is printed on the bottom of your AirPort Extreme.31
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AirPort Extreme Specifications
AirPort Specifications
Â Frequency Band: 2.4 and 5 GHz
Â Radio Output Power: 20 dBm (nominal)
Â Standards: 802.11 DSSS 1 and 2 Mbps standard, 802.11a, 802.11b, 802.11g 
specifications, and a draft 802.11n specification
Interfaces
Â 1 RJ-45 10/100Base-T Ethernet WAN ( iTunes Help.Chapter 3    Setting Up iPod shuffle 11
If you already have iTunes installed on your computer and you’ve set up your iTunes 
library, you can skip to the next section, “Adding Music to iPod shuffle” on page 15.
Importing Music into Your iTunes Library
To listen to music on iPod shuffle, you first need to get that music into your iTunes 
library on your computer.
There are three ways to get music and other audio into your iTunes library:
Â Purchase music and audiobooks or download podcasts online from the iTunes Store.
Â Import music and other audio from audio CDs.
Â Add music and other audio that’s already on your computer.
Buying Songs and Downloading Podcasts Using the iTunes Store
If you have an Internet connection, you can easily purchase and download songs, 
albums, and audiobooks online using the iTunes Store. You can also subscribe to and 
download free radio-style audio podcasts. Video podcasts can’t be synced to 
iPod shuffle.
To purchase music online using the iTunes Store, you set up an Apple account in 
iTunes, find the songs you want, and then buy them. If you already have an Apple 
account, or if you have an America Online (AOL) account (available in some countries 
only), you can use that account to sign in to the iTunes Store and buy songs.
You don’t need an iTunes Store account to download or subscribe to podcasts.
To sign in to the iTunes Store:
m Open iTunes and then:
Â If you already have an iTunes account, choose Store > Sign In, and then sign in.
Â If you don’t already have an iTunes account, choose Store > Create Account and follow 
the onscreen instructions to set up an Apple account or enter your existing Apple or 
AOL account information.12 Chapter 3    Setting Up iPod shuffle 
You can browse or search the iTunes Store to find the album, song, or artist you’re 
looking for. Open iTunes and click iTunes Store in the list on the left.
Â To browse the iTunes Store, choose a category (for example, Music) on the left side of 
the iTunes Store home page. You can choose a genre, look at new releases, click one 
of the featured songs, look at Top Songs and more, or click Browse under Quick Links 
in the main iTunes Store window.
Â To browse for podcasts, click the Podcasts link on the left side of the iTunes Store 
home page.
Â To search the iTunes Store, type the name of an album, song, artist, or composer in the 
search field. Press Return or choose an item from the list that appears.
Â To narrow your search results, choose an item from the pop-up menu in the upper left 
(the default is All Results). For example, to narrow your search to songs and albums, 
choose Music from the pop-up menu.
Â To search for a combination of items, click Power Search in the Search Results page.
Â To return to the home page of the iTunes Store, click the Home button in the status line 
at the top of the page.
To buy a song, album, or audiobook:
1 Select iTunes Store, and then find the item you want to buy.
You can double-click a song or other item to listen to a portion of it and make sure it’s 
what you want. (If your network connection is slower than 128 kbps, choose iTunes 
Preferences, and in the Store pane, select “Load complete preview before playing.”)
2 Click Buy Song, Buy Album, or Buy Book.
The item is downloaded to your computer and charged to the credit card listed in your 
Apple or AOL account.
To download or subscribe to a podcast:
1 Select iTunes Store.
2 Click the Podcasts link on the left side of the home page in the iTunes Store.
3 Browse for the podcast you want to download.
Â To download a single podcast episode, click the Get Episode button next to the 
episode.
Â To subscribe to a podcast, click the Subscribe button next to the podcast graphic. 
iTunes downloads the most recent episode. As new episodes become available, 
they’re automatically downloaded to iTunes when you connect to the Internet.
Adding Songs Already on Your Computer to Your iTunes Library
If you have songs on your computer encoded in file formats that iTunes supports, you 
can easily add the songs to iTunes.Chapter 3    Setting Up iPod shuffle 13
To add songs on your computer to your iTunes library:
m Drag the folder or disk containing the audio files to your iTunes library (or choose File > 
Add to Library and select the folder or disk). If iTunes supports the song file format, the 
songs are automatically added to your iTunes library.
You can also drag individual song files to iTunes. 
Note:  Using iTunes for Windows, you can convert nonprotected WMA files to AAC or 
MP3 format. This can be useful if you have a library of music encoded in WMA format. 
For more information, open iTunes and choose Help > iTunes Help.
Importing Music from Your Audio CDs into iTunes
Follow these instructions to get music from your CDs into iTunes.
To import music from an audio CD into iTunes:
1 Insert a CD into your computer and open iTunes. 
If you have an Internet connection, iTunes gets the names of the songs on the CD from 
the Internet (if available) and lists them in the window.
If you don’t have an Internet connection, you can import your CDs, and later, when you’re 
connected to the Internet, select the songs in iTunes and then choose Advanced > Get 
CD Track Names. iTunes will bring in the track names for the imported CDs. 
If the CD track names aren’t available online, you can enter the names of the songs 
manually. See the following section, “Entering Names of Songs and Other Details.”
With song information entered, you can browse for songs in iTunes by title, artist, 
album, and more. 
2 Click to remove the checkmark next to any song you don’t want to import.
3 Click the Import button. The display area at the top of the iTunes page shows how long 
it will take to import each song.
By default, iTunes plays songs as they’re imported. If you’re importing a lot of songs, 
you might want to stop the songs from playing to improve performance.
4 To eject the CD, click the Eject (C) button.
You can’t eject a CD until the import is done.
5 Repeat these steps for any other CDs with songs you want to import.
Entering Names of Songs and Other Details
You can manually enter song titles and other information, including comments, for 
songs and other items in your iTunes library.
To enter CD song names and other information manually:
1 Select the first song on the CD and choose File > Get Info.
2 Click Info.14 Chapter 3    Setting Up iPod shuffle 
3 Enter the song information.
4 Click Next to enter information for the next track.
5 Click OK when you finish.
Organizing Your Music
Using iTunes, you can organize songs and other items into lists, called playlists, in any 
way you want. For example, you can create playlists with songs to listen to while 
exercising, or playlists with songs for a particular mood. 
You can also create Smart Playlists that update automatically based on rules you define. 
When you add songs to iTunes that match the rules, they get added automatically to 
the Smart Playlist. You can also pick a song and use the Genius feature to create a 
playlist for you (see the next section for more information). You can’t create a playlist on 
iPod shuffle when it’s disconnected from iTunes.
You can create as many playlists as you like, using any of the songs in your iTunes 
library. Changes you make to any of your playlists in iTunes, such as adding or 
removing songs, won’t change the contents of your iTunes library. 
When you listen to playlists on iPod shuffle, all playlists created in iTunes behave the 
same way. You can choose them by name on your iPod shuffle. 
To create a playlist in iTunes:
1 Click the Add (∂) button or choose File > New Playlist.
2 Type a name for the playlist. 
3 Click Music in the Library list, and then drag a song or other item to the playlist. 
To select multiple songs, hold down the Shift key or the Command (x) key on a Mac, 
or the Shift key or the Control key on a Windows PC, as you click each song.
To create a Smart Playlist:
m Choose File > New Smart Playlist and define the rules for your playlist.
Smart playlists created in iTunes can be synced to iPod shuffle like any other iTunes 
playlist.
Using Genius in iTunes
Genius automatically creates playlists containing songs in your library that go great 
together. To play Genius playlists on iPod shuffle, you first need to set up Genius in 
iTunes. Genius is a free service, but you need an iTunes Store account (if you don’t have 
one, you can set one up when you turn on Genius).
To set up Genius:
1 In iTunes, choose Store > Turn on Genius.Chapter 3    Setting Up iPod shuffle 15
2 Follow the onscreen instructions.
3 Connect and sync iPod shuffle.
You can now use Genius to create a Genius playlist that you can sync to iPod shuffle.
To create a Genius playlist in iTunes:
1 Click Music in the Library list or select a playlist.
2 Select a song.
3 Click the Genius button at the bottom of the iTunes window.
4 To change the maximum number of songs included in the playlist, choose a number 
from the pop-up menu.
5 To save the playlist, click Save Playlist. You can change a saved playlist by adding or 
removing items. You can also click Refresh to create a new playlist based on the same 
original song.
Genius playlists created in iTunes can be synced to iPod shuffle like any other iTunes 
playlist.
Adding Music to iPod shuffle
After your music is imported and organized in iTunes, you can easily add it to 
iPod shuffle.
To set how music is added from iTunes on your computer to iPod shuffle, you connect 
iPod shuffle to your computer, and then use iTunes preferences to choose iPod shuffle 
settings.
You can set iTunes to add music to iPod shuffle in three ways:
Â Sync songs and playlists:  When you connect iPod shuffle, it’s automatically updated to 
match the songs and other items in your iTunes library. You can sync all songs and 
playlists or selected playlists. Any other songs on iPod shuffle are deleted. See the 
following section for more information.16 Chapter 3    Setting Up iPod shuffle 
Â Manually add music to iPod shuffle:  When you connect iPod shuffle, you can drag 
songs and playlists individually to iPod shuffle, and delete songs and playlists 
individually from iPod shuffle. Using this option, you can add songs from more than 
one computer without erasing songs from iPod shuffle. When you manage music 
yourself, you must always eject iPod shuffle from iTunes before you can disconnect it. 
See “Managing iPod shuffle Manually” on page 17.
Â Autofill iPod shuffle:  When you choose to manually manage content on iPod shuffle, 
you can have iTunes automatically fill iPod shuffle with a selection of songs and other 
content that you specify. See “Autofilling iPod shuffle” on page 18.
Syncing Music Automatically
By default, iPod shuffle is set to sync all songs and playlists when you connect it to your 
computer. This is the simplest way to add music to iPod shuffle. You just connect 
iPod shuffle to your computer, let it add songs, audiobooks, and audio podcasts 
automatically, and then disconnect it and go. If you added any songs to iTunes since 
the last time you connected iPod shuffle, they’re synced with iPod shuffle. If you 
deleted songs from iTunes, they’re removed from iPod shuffle.
To sync music with iPod shuffle:
m Simply connect iPod shuffle to your computer. If iPod shuffle is set to sync 
automatically, the update begins.
Important:  The first time you connect iPod shuffle to a computer, a message asks if you 
want to sync songs automatically. If you accept, all songs, audiobooks, and podcasts 
are erased from iPod shuffle and replaced with songs and other items from that 
computer. If you don’t accept, you can still add songs to iPod shuffle manually without 
erasing any of the songs already on iPod shuffle.
While music is being synced from your computer to iPod shuffle, the iTunes status 
window shows progress, and you see a sync icon next to iPod shuffle in the list of 
devices. When the update is done, a message in iTunes says “iPod update is complete.”
If, during iPod shuffle setup, you didn’t choose to automatically sync music to 
iPod shuffle, you can do it later. You can sync all songs and playlists, or just selected 
playlists.
To set up iTunes to automatically sync music with iPod shuffle:
1 Connect iPod shuffle to your computer.
2 In iTunes, select iPod shuffle in the list of devices, and then click the Music tab.
3 Select “Sync music.”
4 Choose “All songs and playlists,” or choose “Selected playlists” and then select the 
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You can sync audiobooks when you sync music. Audiobooks appear in the list of 
selected playlists. You can choose to sync all or none of the audiobooks in your iTunes 
library.
5 Click Apply.
The update begins automatically.
If “Sync only checked songs” is selected in the Summary pane, iTunes syncs only items 
that are checked in your Music and other libraries.
Syncing Podcasts Automatically
The settings for adding podcasts to iPod shuffle are unrelated to the settings for 
adding songs. Podcast settings don’t affect song settings, and vice versa. You can set 
iTunes to automatically sync all podcasts or selected podcasts, or you can add podcasts 
to iPod shuffle manually. You can’t sync video podcasts to iPod shuffle.
To set iTunes to update the podcasts on iPod shuffle automatically:
1 Connect iPod shuffle to your computer.
2 In iTunes, select iPod shuffle in the list of devices, and then click the Podcasts tab.
3 Select “Sync ... episodes of” and choose the number of episodes you want from the 
pop-up menu.
4 Select “All podcasts,” or “Selected podcasts.” If you click “Selected podcasts,” also select 
the podcasts that you want to sync.
5 Click Apply.
When you set iTunes to sync podcasts automatically, iPod shuffle is updated each time 
you connect it to your computer.
Managing iPod shuffle Manually
Setting iTunes to let you manage iPod shuffle manually gives you the most flexibility 
for managing music and other content on iPod shuffle. You can add and remove 
individual songs, playlists, podcasts, and audiobooks. You can add music and other 
audio content from multiple computers to iPod shuffle without erasing items already 
on iPod shuffle.
To set iTunes to let you manage audio content on iPod shuffle manually:
1 In iTunes, select iPod shuffle in the list of devices, and then click the Summary tab. 
2 In the Options section, select “Manually manage music.”
3 Click Apply.
When you manage iPod shuffle manually, you must always eject iPod shuffle from 
iTunes before you disconnect it.
To add a song or other item to iPod shuffle:
1 Click Music or another Library item in iTunes.18 Chapter 3    Setting Up iPod shuffle 
2 Drag a song or other item to iPod shuffle.
You can also drag entire playlists to sync them with iPod shuffle. You can select 
multiple items and drag them all at once to iPod shuffle.
To remove a song or other item from iPod shuffle:
1 In iTunes, select iPod shuffle in the list of devices.
2 Select Music, Audiobooks, or Podcasts under iPod shuffle.
3 Select a song or other item and press the Delete or Backspace key on your keyboard. 
To use iTunes to create a new playlist on iPod shuffle:
1 In iTunes, select iPod shuffle in the list of devices, and then click the Add (∂) button or 
choose File > New Playlist.
2 Type a name for the playlist.
3 Click an item, such as Music, in the Library list, and then drag songs or other items to 
the playlist.
To add songs to or remove songs from a playlist on iPod shuffle:
m Drag a song to a playlist on iPod shuffle to add the song. Select a song in a playlist and 
press the Delete key on your keyboard to delete the song.
Keep these points in mind if you manually manage your content on iPod shuffle:
Â If you make changes to any of your playlists, remember to drag the changed playlist 
to iPod shuffle when it’s connected to iTunes.
Â If you remove a song or other item from iPod shuffle, it isn’t deleted from your iTunes 
library. 
Â If you set iTunes to manage music manually, you can reset it later to sync 
automatically. For information, see page 16.
Autofilling iPod shuffle
If you manually manage music, you can have iTunes automatically sync a selection of 
your songs onto iPod shuffle when you click the Autofill button. You can choose your 
entire library or a specific playlist to gets songs from, and set other Autofill options. 
Using Autofill gives you more control over the content that gets added to iPod shuffle 
than automatically syncing, and lets you quickly “top off” your iPod shuffle when you 
manually manage the contents.
To autofill music onto iPod shuffle:
1 Connect iPod shuffle to your computer. 
2 Select Music under iPod shuffle in the list of devices.
3 Choose the playlist you want to autofill from using the “Autofill from” pop-up menu.
To autofill music from your entire library, choose Music.Chapter 3    Setting Up iPod shuffle 19
4 Click the Settings button to select from the following options:
Replace all items when Autofilling:  iTunes replaces the songs on iPod shuffle with the 
new songs you’ve chosen. If this option isn’t selected, songs you’ve already synced with 
iPod shuffle remain and iTunes selects more songs to fill the available space.
Choose items randomly:  iTunes shuffles the order of songs as it syncs them with 
iPod shuffle. If this option isn’t selected, iTunes downloads songs in the order they 
appear in your library or selected playlist.
Choose higher rated items more often:  iTunes autofills iPod shuffle, giving preference to 
songs that you’ve rated with a higher number of stars.
5 To reserve space for disk use, adjust the slider to set how much space to reserve for 
iTunes content and how much for data.
For more information about using iPod shuffle as a hard disk, see “Using iPod shuffle as 
an External Disk” on page 26.
6 Click OK in the Autofill Settings dialog, and then click Autofill in the iTunes window.
While music is being synced from iTunes to iPod shuffle, the iTunes status window 
shows the progress. When the autofill is done, a message in iTunes says “iPod update is 
complete.”
Fitting More Songs onto iPod shuffle
If you’ve imported songs into iTunes at higher bit-rate formats, such as iTunes Plus, 
Apple Lossless, or WAV, you can set iTunes to automatically convert songs to 128 kbps 
AAC files as they’re synced with iPod shuffle. This doesn’t affect the quality or size of 
the songs in iTunes.
Note:  Songs in formats not supported by iPod shuffle must be converted if you want to 
sync them with iPod shuffle. For more information about formats supported by 
iPod shuffle, see “If you can’t sync a song or other item onto iPod shuffle” on page 29.
To convert higher bit-rate songs to AAC files:
1 Connect iPod shuffle to your computer.
2 In iTunes, select iPod shuffle in the list of devices.
3 Click the Summary tab.
4 Select “Convert higher bit rate songs to 128 kbps AAC.”
5 Click Apply.4
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4 Listening to Music
After you set up iPod shuffle, you can listen to songs, 
audiobooks, and podcasts. Read this chapter to learn 
about listening to iPod shuffle on the go.
When you disconnect iPod shuffle from your computer, you can clip on iPod shuffle 
and listen to music, audiobooks, and podcasts, while controlling playback with the 
earphone remote. VoiceOver lets you hear the name of the song you’re playing, choose 
from a spoken menu of playlists, or get battery status. 
Playing Music
After you sync iPod shuffle with music and other audio content, you can listen to it. 
To listen to songs and other items on iPod shuffle:
1 Plug the earphones into iPod shuffle and place the earbuds in your ears.
2 Slide the three-way switch on iPod shuffle from OFF to play in order (⁄) or 
shuffle (¡).
Playback begins. If iPod shuffle is on when you plug in earphones, playback doesn’t 
start automatically. Click the Center button on the remote or slide the three-way 
switch off and on again to start playback.
To preserve battery life when you aren’t using iPod shuffle, slide the three-way 
switch to OFF.
When you plug in earphones, wait until the green status light turns off before 
clicking buttons on the remote. Refer to the table that follows for information about 
controlling playback with the earphone remote. 
WARNING:  Read all safety instructions about avoiding hearing damage on page 33 
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The status light on iPod shuffle blinks in response when you click the buttons on the 
earphone remote.
Setting iPod shuffle to Play Songs in Order or Shuffle Songs
You can set iPod shuffle to shuffle songs or play them in the order in which they’re 
organized in iTunes. You hear a tone when you slide the three-way switch.
To set iPod shuffle to play songs in order:
m Slide the three-way switch to play in order (⁄).
After the last song plays, iPod shuffle starts playing the first song again.
Important:  When you listen to audiobooks or podcasts, slide the three-way switch to 
play in order so chapters or episodes play in the recorded order.
To set iPod shuffle to shuffle: 
m Slide the three-way switch to shuffle (¡).
To reshuffle songs, slide the three-way switch from shuffle (¡) to play in order (⁄) 
and back to shuffle again.
To Do this Status light response
Play Click the Center button once.  Blinks green once
Pause Click the Center button once.     Blinks green for 
30 seconds
Change the volume Click the Volume Up (∂) or Volume 
Down (D) button to increase or decrease 
the volume. You hear a tone when you 
change the volume while iPod shuffle is 
paused.
 Blinks green for each 
volume increment
   Blinks orange three 
times when the upper or lower 
volume limit is reached
Go to the next track (or 
audiobook chapter)
Double-click the Center button.  Blinks green once
Go to the previous track 
(or audiobook chapter)
Triple-click the Center button within 6 
seconds of the track starting. To restart 
the current track, triple-click after 6 
seconds.
 Blinks green once
Fast-forward Double-click and hold the Center button.  Blinks green once
Rewind Triple-click and hold the Center button.  Blinks green once
Hear song title and artist 
names
Click and hold the Center button.  Blinks green once
Hear playlist menu Click the Center button until you hear a 
tone, and then release to hear the 
playlist menu. When you hear the name 
of the playlist you want, click to select it. 
You can click ∂ or D to move quickly 
through the playlist menu.
 Blinks green once
Exit the playlist menu Click and hold the Center button.  Blinks green once22 Chapter 4    Listening to Music 
Using the VoiceOver Feature
iPod shuffle can provide more control over your playback options by speaking your 
song titles and artist names, and announcing a menu of playlists for you to choose 
from. VoiceOver also tells you battery status and other messages. VoiceOver is available 
in selected languages.
To hear these announcements, install the VoiceOver Kit and enable the VoiceOver 
feature in iTunes. You can enable VoiceOver when you first set up iPod shuffle, or you 
can do it later.
You set VoiceOver options on the Summary tab in iTunes. The following sections 
describe how to turn on and customize this feature. 
To enable VoiceOver when you set up iPod shuffle:
1 Connect iPod shuffle to your computer.
2 Follow the onscreen instructions in iTunes. Enable VoiceOver is selected by default.
3 Click Continue, and then follow the onscreen instructions to download and install the 
VoiceOver Kit. 
4 In the Summary tab, under Voice Feedback, choose the language you want from the 
Language pop-up menu.
This sets the language for your spoken system messages and playlist names, as well as 
many of the song titles and artist names. 
Note:  To pick a different language for specific songs, select them in iTunes, choose 
File > Get Info, choose a VoiceOver language from the pop-up menu on the Options 
tab, and then click OK.
5 Click Apply.
When setup is complete, VoiceOver is enabled on iPod shuffle.
To enable VoiceOver at a later time:
1 Connect iPod shuffle to your computer.
2 In iTunes, select iPod shuffle in the list of devices, and click the Summary tab.
3 Under Voice Feedback, select Enable VoiceOver. 
4 Click Apply.
5 Follow the onscreen instructions to download and install the VoiceOver Kit.
6 Choose the language you want from the pop-up menu under Voice Feedback.
7 Click Apply.
When syncing is finished, VoiceOver is enabled.Chapter 4    Listening to Music 23
To disable VoiceOver:
1 In iTunes, select iPod shuffle in the list of devices, and click the Summary tab.
2 Under Voice Feedback, click to deselect Enable VoiceOver.
3 Click Apply.
When syncing is finished, VoiceOver is disabled. You’ll still hear some system 
announcements in English on iPod shuffle, such as battery status, error messages, and a 
generic numbered playlist menu. You won’t hear song titles and artist names.
Hearing Song Announcements
The VoiceOver feature can speak the current song title and artist name while you’re 
listening to iPod shuffle. If you don’t want to hear song titles and artist names, you can 
disable VoiceOver in iTunes (see “Using the VoiceOver Feature” on page 22).
To hear the current song announcement:
m Click and hold the Center button on the remote. 
You hear the current song title and artist name. If you’re listening to an audiobook, you 
hear the book title.
You can use VoiceOver to navigate to another song when you’re listening to song 
announcements.
To navigate using song announcements:
Â If iPod shuffle is playing, click and hold the Center button to hear the current song 
announcement; double-click to hear the next announcement while the next song 
plays; triple-click to hear the previous announcement while the previous song plays.
Â If iPod shuffle is paused, click and hold the Center button to hear the current song 
announcement; double-click to hear the next announcement; triple-click to hear the 
previous announcement. Press the Center button to play the announced song.
Using the Playlist Menu
When VoiceOver is enabled, you can choose from a spoken menu to listen to any 
playlist you’ve synced from iTunes to iPod shuffle. If audiobooks and audio podcasts are 
synced to iPod shuffle, their titles are also read as part of the playlist menu. If VoiceOver 
is disabled in iTunes, you hear an abbreviated menu of playlists in numbered order, but 
not by name (for example, “Playlist 1, Playlist 2,” and so on).24 Chapter 4    Listening to Music 
The playlist menu announces items in this order: 
Â The current playlist (if applicable)
Â “All Songs” (default playlist of all the songs on iPod shuffle)
Â Any remaining playlists in order
Â “Podcasts” (if you choose this, you go to the first podcast in your list; you can 
navigate from there to other podcasts)
Â Audiobooks (each audiobook title is a separate playlist announcement)
To choose an item from the playlist menu:
1 Click and hold the Center button on the remote.
2 Continue holding after you hear the current song announcement, until you hear a tone.
3 Release the Center button at the tone. You hear the names of your playlists.
When you’re listening to the playlist menu, you can click the Volume Up (∂) or Volume 
Down (D) button to move forward or backward in the playlist menu.
4 When you hear the name of the playlist you want, click the Center button to select it. 
You hear a tone, and then the first item in your playlist plays.
To restart a playlist, follow these steps to select the playlist you want.
To exit from the playlist menu:
m Click and hold the Center button on the remote.
Setting Songs to Play at the Same Volume Level
The loudness of songs and other audio may vary depending on how the audio was 
recorded or encoded. You can set iTunes to automatically adjust the volume of songs 
so they play at the same relative volume level, and you can set iPod shuffle to use 
those same iTunes volume settings.
To set iTunes to play songs at the same volume level:
1 In iTunes, choose iTunes > Preferences if you’re using a Mac, or choose Edit > 
Preferences if you’re using a Windows PC.
2 Click Playback and select Sound Check.
To set iPod shuffle to use the iTunes volume settings:
1 Connect iPod shuffle to your computer.
2 In iTunes, select iPod shuffle in the list of devices.
3 Click the Summary tab.
4 Select Enable Sound Check.
5 Click Apply.
If you haven’t turned on Sound Check in iTunes, setting it on iPod shuffle has no effect.Chapter 4    Listening to Music 25
Setting a Volume Limit
You can set a limit for the volume on iPod shuffle. You can also set a password in iTunes 
to prevent anyone else from changing this setting.
If you’ve set a volume limit on iPod shuffle, the status light blinks orange three times if 
you try to increase the volume beyond the limit.
To set a volume limit for iPod shuffle:
1 Set iPod shuffle to the desired maximum volume.
2 Connect iPod shuffle to your computer.
3 In iTunes, select iPod shuffle in the list of devices, and then click the Summary tab.
4 Select “Limit maximum volume.”
5 Drag the slider to the desired maximum volume.
The initial slider setting shows the volume iPod shuffle was set to when you selected 
the “Limit maximum volume” checkbox.
6 To require a password to change this setting, click the lock and then enter and verify a 
password.
If you set a password, you must enter it before you can change or remove the volume 
limit. 
Note:  The volume level may vary if you use different earphones or headphones.
To remove the volume limit:
1 Connect iPod shuffle to your computer.
2 In iTunes, select iPod shuffle in the list of devices.
3 Click the Summary tab.
4 Deselect “Limit maximum volume.”
Enter the password, if required.
If you forget the password, you can restore iPod shuffle. See “Updating and Restoring 
iPod shuffle Software” on page 31.5
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5 Storing Files on iPod shuffle
Use iPod shuffle to carry your data as well as your music.
Read this chapter to find out how to use iPod shuffle as an external disk.
Using iPod shuffle as an External Disk
You can use iPod shuffle as an external disk to store data files. 
To sync iPod shuffle with music and other audio that you want to listen to, you must 
use iTunes. You can’t play audio files that you’ve copied to iPod shuffle using the 
Macintosh Finder or Windows Explorer.
To enable iPod shuffle as an external disk:
1 Connect iPod shuffle to your computer.
2 In iTunes, select iPod shuffle in the list of devices.
3 Click the Summary tab.
4 In the Options section, select “Enable disk use.”
You may need to scroll down to see the disk settings.
5 Click Apply.
When you set iTunes to autofill iPod shuffle, you can reserve space for disk use. See 
“Autofilling iPod shuffle” on page 18.
When you use iPod shuffle as an external disk, the iPod shuffle disk icon appears on the 
desktop on a Mac, or as the next available drive letter in Windows Explorer on a 
Windows PC.
When iPod shuffle is enabled as a hard disk and you connect it to your computer, the 
status light blinks orange continuously. Be sure to eject iPod shuffle in iTunes before 
you disconnect it from your computer.Chapter 5    Storing Files on iPod shuffle 27
Transferring Files Between Computers
When you enable disk use on iPod shuffle, you can transfer files from one computer to 
another. iPod shuffle is formatted as a FAT-32 volume, which is supported by both Macs 
and PCs. This allows you to use iPod shuffle to transfer files between computers with 
different operating systems. 
To transfer files between computers:
1 After enabling disk use on iPod shuffle, connect it to the computer you want to get the 
files from.
Important:  If iPod shuffle is set to sync automatically, when you connect iPod shuffle to 
a different computer or user account, a message asks if you want to erase iPod shuffle 
and sync with the new iTunes library. Click Cancel if you don’t want to erase what’s on 
iPod shuffle. 
2 Using the computer’s file system (the Finder on a Mac, Windows Explorer on a PC), drag 
the files to your iPod shuffle.
3 Disconnect iPod shuffle, and then connect it to the other computer.
Again, click Cancel if you don’t want to erase what’s on iPod shuffle.
4 Drag the files from iPod shuffle to a location on the other computer.
Preventing iTunes from Opening Automatically
You can keep iTunes from opening automatically when you connect iPod shuffle to 
your computer.
To prevent iTunes from opening automatically:
1 Connect iPod shuffle to your computer.
2 In iTunes, select iPod shuffle in the list of devices.
3 Click the Summary tab.
4 In the Options section, deselect “Open iTunes when this iPod is connected.”
5 Click Apply.6
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6 Tips and Troubleshooting
Most problems with iPod shuffle can be solved quickly by 
following the advice in this chapter.
If the status light glows red persistently or you hear the error message “Please use 
iTunes to restore”
Connect iPod shuffle to your computer and restore it in iTunes. See “Updating and 
Restoring iPod shuffle Software” on page 31.
If iPod shuffle won’t turn on or respond
Â Connect iPod shuffle to a high-power USB 2.0 port on your computer. Your 
iPod shuffle battery may need to be recharged. 
Â Turn iPod shuffle off, wait 10 seconds, and then turn it on again.
Â You may need to restore iPod shuffle software. See “Updating and Restoring 
iPod shuffle Software” on page 31.
The 5 Rs: Reset, Retry, Restart, Reinstall, Restore
Remember these five basic suggestions if you have a problem with iPod shuffle. Try 
these steps one at a time until the problem is resolved. If one of the following doesn’t 
help, read on for solutions to specific problems. 
Â Reset iPod shuffle by turning it off, waiting 10 seconds, and then turning it back on 
again.
Â Retry with a different USB 2.0 port if you cannot see iPod shuffle in iTunes.
Â Restart your computer, and make sure you have the latest software updates 
installed.
Â Reinstall iTunes software from the latest version on the web.
Â Restore iPod shuffle. See “Updating and Restoring iPod shuffle Software” on 
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If iPod shuffle isn’t playing music
Â iPod shuffle might not have any music on it. If you hear the message “Please use 
iTunes to sync music,” connect iPod shuffle to your computer to sync music to it.
Â Slide the three-way switch off and then on again.
Â Make sure the earphone or headphone connector is pushed in all the way. 
Â Make sure the volume is adjusted properly. A volume limit might be set. See “Setting 
a Volume Limit” on page 25.
Â iPod shuffle might be paused. Try clicking the Center button on the earphone 
remote. 
If you connect iPod shuffle to your computer and nothing happens
Â Connect iPod shuffle to a high-power USB 2.0 port on your computer. Your 
iPod shuffle battery may need to be recharged. 
Â Make sure you’ve installed the latest iTunes software from 
www.apple.com/ipod/start. 
Â Try connecting the USB cable to a different USB 2.0 port on your computer. Make 
sure the USB cable is firmly connected toiPod shuffle and to the computer. Make sure 
the USB connector is oriented correctly. It can be inserted only one way.
Â iPod shuffle might need to be reset. Turn iPod shuffle off, wait 10 seconds, and then 
turn it back on again.
Â If iPod shuffle doesn’t appear in iTunes or the Finder, the battery may be completely 
discharged. Let iPod shuffle charge for several minutes to see if it comes back to life.
Â Make sure you have the required computer and software. See “If you want to doublecheck the system requirements” on page 30.
Â Try restarting your computer.
Â You might need to restore iPod software. See “Updating and Restoring iPod shuffle 
Software” on page 31.
Â iPod shuffle may need to be repaired. You can arrange for service on the iPod shuffle 
Service & Support website at www.apple.com/support/ipodshuffle/service.
If you can’t sync a song or other item onto iPod shuffle
The song might have been encoded in a format that iPod shuffle doesn’t support. The 
following audio file formats are supported by iPod shuffle. These include formats for 
audiobooks and podcasts:
Â AAC (M4A, M4B, M4P) (up to 320 kbps)
Â Apple Lossless (a high-quality compressed format)
Â MP3 (up to 320 kbps)
Â MP3 Variable Bit Rate (VBR)
Â WAV
Â AA (audible.com spoken word, formats 2, 3, and 4)
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A song encoded using Apple Lossless format has near full CD-quality sound, but takes 
up only about half as much space as a song encoded using AIFF or WAV format. The 
same song encoded in AAC or MP3 format takes up even less space. When you import 
music from a CD using iTunes, it’s converted to AAC format by default.
You can have iPod shuffle automatically convert files encoded at higher bit rates to 128 
kbps AAC files as they’re synced with iPod shuffle. See “Fitting More Songs onto 
iPod shuffle” on page 19.
Using iTunes for Windows, you can convert unprotected WMA files to AAC or MP3 
format. This can be useful if you have a collection of music encoded in WMA format. 
iPod shuffle doesn’t support WMA, MPEG Layer 1, MPEG Layer 2 audio files, or 
audible.com format 1.
If you have a song in iTunes that isn’t supported by iPod shuffle, you can convert it to a 
format iPod shuffle supports. For more information, see iTunes Help.
If your podcasts or audiobooks don’t play correctly 
Â Make sure the three-way switch on iPod shuffle is set to play in order (⁄). If a 
playlist includes mixed tracks (songs, podcasts, and audiobooks, for example), 
audiobooks and podcasts won’t play if iPod shuffle is set to shuffle (¡).
Â If the chapters of an audiobook were added to iPod shuffle out of order, connect 
iPod shuffle to your computer and rearrange the tracks using iTunes.
If you want to double-check the system requirements
To use iPod shuffle, you must have:
Â One of the following computer configurations:
Â A Macintosh with a USB 2.0 port 
Â A Windows PC with a USB 2.0 port or a USB 2.0 card installed 
Â One of the following operating systems: Mac OS X v10.4.11 or later, Windows Vista, or 
Windows XP Home or Professional with Service Pack 3 or later
Â Internet access (a broadband connection is recommended)
Â iTunes 8.1 or later (iTunes can be downloaded from www.apple.com/ipod/start)
If your Windows PC doesn’t have a high-power USB 2.0 port, you can purchase and install 
a USB 2.0 card. 
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If you want to use iPod shuffle with a Mac and a Windows PC
If your iPod shuffle is set to manually manage music, you can add content to it from 
more than one iTunes library, regardless of the operating system on the computer. If 
your iPod shuffle is set to sync automatically, when you connect iPod shuffle to a 
different computer or user account, a message asks if you want to erase iPod shuffle 
and sync with the new iTunes library. Click Cancel if you want to keep the contents of 
iPod shuffle as is.
You can use iPod shuffle as an external disk with both Macintosh computers and PCs, 
allowing you to transfer files from one operating system to the other. See Chapter 5, 
“Storing Files on iPod shuffle,” on page 26.
Updating and Restoring iPod shuffle Software
You can use iTunes to update or restore the iPod shuffle software. It’s recommended 
that you update iPod shuffle to use the latest software. You can also restore the 
software, which returns iPod shuffle to its original state.
Â If you choose to update, the software is updated but your settings, songs, and other 
data aren’t affected. 
Â If you choose to restore, all data is erased from iPod shuffle, including songs and any 
other data. All iPod shuffle settings are restored to their original state.
To update or restore iPod shuffle:
1 Make sure you have an Internet connection and have installed the latest version of 
iTunes from www.apple.com/ipod/start.
2 Connect iPod shuffle to your computer.
3 In iTunes, select iPod shuffle in the list of devices, and click the Summary tab.
The Version section tells you whether iPod shuffle is up to date or needs a newer 
version of the software. 
4 Do one of the following:
Â To install the latest version of the software, click Update.
Â To restore iPod shuffle to its original settings, click Restore. This erases all data from 
iPod shuffle. Follow the onscreen instructions to complete the restore process.7
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7 Safety and Handling
This chapter contains important safety and handling 
information for iPod shuffle.
Keep this user guide for your iPod shuffle handy for future reference.
Important Safety Information
Handling iPod shuffle  Do not drop, dissemble, open, crush, bend, deform, puncture, 
shred, microwave, incinerate, paint, or insert foreign objects into iPod shuffle. 
Avoiding water and wet locations  Do not use iPod shuffle in rain, or near washbasins 
or other wet locations. Take care not to spill any food or liquid on iPod shuffle. In case 
iPod shuffle gets wet, unplug all cables, turn off iPod shuffle (slide the three-way switch 
to OFF) before cleaning, and allow it to dry thoroughly before turning it on again. Do 
not attempt to dry iPod shuffle with an external heat source, such as a microwave oven 
or hair dryer.
Repairing iPod shuffle  Never attempt to repair or modify iPod shuffle yourself. 
iPod shuffle doesn’t contain any user-serviceable parts. If iPod shuffle has been 
submerged in water, punctured, or subjected to a severe fall, do not use it until you 
take it to an Apple Authorized Service Provider. For service information, choose iPod 
Help from the Help menu in iTunes or go to www.apple.com/support/ipod/service. The 
rechargeable battery in iPod shuffle should be replaced only by an Apple Authorized 
Service Provider. For more information about batteries, go to www.apple.com/batteries.
± Read all safety information below and operating instructions before using 
iPod shuffle to avoid injury. 
WARNING:  Failure to follow these safety instructions could result in fire, electric shock, 
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Using the Apple USB Power Adapter (available separately)  If you use the Apple USB 
Power Adapter (sold separately at www.apple.com/ipodstore) to charge iPod shuffle, 
make sure that the power adapter is fully assembled before you plug it into a power 
outlet. Then insert the Apple USB Power Adapter firmly into the power outlet. Do not 
connect or disconnect the Apple USB Power Adapter with wet hands. Do not use any 
power adapter other than the Apple USB Power Adapter to charge your iPod shuffle.
The Apple USB Power Adapter may become warm during normal use. Always allow 
adequate ventilation around the Apple USB Power Adapter and use care when 
handling.
Unplug the Apple USB Power Adapter if any of the following conditions exist:
Â The power cord or plug has become frayed or damaged.
Â The adapter is exposed to rain, liquids, or excessive moisture.
Â The adapter case has become damaged.
Â You suspect the adapter needs service or repair.
Â You want to clean the adapter.
Avoiding hearing damage  Permanent hearing loss may occur if earbuds or 
headphones are used at high volume. Set the volume to a safe level. You can adapt 
over time to a higher volume of sound that may sound normal but can be damaging to 
your hearing. If you experience ringing in your ears or muffled speech, stop listening 
and have your hearing checked. The louder the volume, the less time is required before 
your hearing could be affected. Hearing experts suggest that to protect your hearing:
Â Limit the amount of time you use earbuds or headphones at high volume.
Â Avoid turning up the volume to block out noisy surroundings.
Â Turn the volume down if you can’t hear people speaking near you.
For information about how to set a volume limit on iPod shuffle, see “Setting a Volume 
Limit” on page 25.
Driving safely  Use of iPod shuffle alone, or with earphones (even if used in only one 
ear) while operating a vehicle is not recommended and is illegal in some areas. Be 
careful and attentive while driving. Stop using iPod shuffle if you find it disruptive or 
distracting while operating any type of vehicle, or performing any other activity that 
requires your full attention.34 Chapter 7    Safety and Handling 
Important Handling Information
Carrying iPod shuffle  iPod shuffle contains sensitive components. Do not bend, drop, 
or crush iPod shuffle.
Using connectors and ports  Never force a connector into a port. Check for 
obstructions on the port. If the connector and port don’t join with reasonable ease, 
they probably don’t match. Make sure that the connector matches the port and that 
you have positioned the connector correctly in relation to the port.
Keeping iPod shuffle within acceptable temperatures  Operate iPod shuffle in a place 
where the temperature is always between 32º and 95º F (0º and 35º C). iPod shuffle 
play time might temporarily shorten in low-temperature conditions.
Store iPod shuffle in a place where the temperature is always between -4º and 113º F 
(-20º and 45º C). Don’t leave iPod shuffle in your car, because temperatures in parked 
cars can exceed this range.
When you’re using iPod shuffle or charging the battery, it’s normal for iPod shuffle to 
get warm. The exterior of iPod shuffle functions as a cooling surface that transfers heat 
from inside the unit to the cooler air outside.
Keeping the outside of iPod shuffle clean  To clean iPod shuffle, unplug all cables, turn 
it off (slide the three-way switch to OFF), and use a soft, slightly damp, lint-free cloth. 
Avoid getting moisture in openings. Don’t use window cleaners, household cleaners, 
aerosol sprays, solvents, alcohol, ammonia, or abrasives to clean iPod shuffle.
Disposing of iPod shuffle properly  For information about the proper disposal of 
iPod shuffle, including other important regulatory compliance information, see 
“Regulatory Compliance Information” on page 36.
NOTICE:  Failure to follow these handling instructions could result in damage to 
iPod shuffle or other property.8
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8 Learning More, Service, 
and Support 
You can find more information about using iPod shuffle 
in onscreen help and on the web.
The following table describes where to get iPod-related software and service 
information.
To learn about Do this
Service and support, 
discussions, tutorials, and 
Apple software downloads
Go to:  www.apple.com/support/ipodshuffle
Using iTunes Open iTunes and choose Help > iTunes Help. 
For an online iTunes tutorial (available in some areas only), go to:   
www.apple.com/itunes/tutorials
The latest information about 
iPod shuffle
Go to:  www.apple.com/ipodshuffle
Registering iPod shuffle To register iPod shuffle, install iTunes on your computer and 
connect iPod shuffle.
Finding the iPod shuffle serial 
number
Look under the clip on iPod shuffle. Or, in iTunes (with iPod shuffle 
connected to your computer), select iPod shuffle in the list of 
devices, and click the Summary tab.
Obtaining warranty service First follow the advice in this booklet, the onscreen help, and 
online resources, and then go to:  
www.apple.com/support/ipodshuffle/service36    
Regulatory Compliance Information
FCC Compliance Statement
This device complies with part 15 of the FCC rules. 
Operation is subject to the following two conditions: 
(1) This device may not cause harmful interference, 
and (2) this device must accept any interference 
received, including interference that may cause 
undesired operation. See instructions if interference 
to radio or television reception is suspected.
Radio and Television Interference
This computer equipment generates, uses, and can 
radiate radio-frequency energy. If it is not installed 
and used properly—that is, in strict accordance with 
Apple’s instructions—it may cause interference with 
radio and television reception.
This equipment has been tested and found to 
comply with the limits for a Class B digital device in 
accordance with the specifications in Part 15 of FCC 
rules. These specifications are designed to provide 
reasonable protection against such interference in a 
residential installation. However, there is no 
guarantee that interference will not occur in a 
particular installation.
You can determine whether your computer system is 
causing interference by turning it off. If the 
interference stops, it was probably caused by the 
computer or one of the peripheral devices.
If your computer system does cause interference to 
radio or television reception, try to correct the 
interference by using one or more of the following 
measures:
Â Turn the television or radio antenna until the 
interference stops.
Â Move the computer to one side or the other of the 
television or radio.
Â Move the computer farther away from the 
television or radio.
Â Plug the computer into an outlet that is on a 
different circuit from the television or radio. (That 
is, make certain the computer and the television or 
radio are on circuits controlled by different circuit 
breakers or fuses.)
If necessary, consult an Apple-authorized service 
provider or Apple. See the service and support 
information that came with your Apple product. Or, 
consult an experienced radio/television technician 
for additional suggestions.
Important:  Changes or modifications to this product 
not authorized by Apple Inc. could void the EMC 
compliance and negate your authority to operate 
the product.
This product was tested for EMC compliance under 
conditions that included the use of Apple peripheral 
devices and Apple shielded cables and connectors 
between system components. 
It is important that you use Apple peripheral devices 
and shielded cables and connectors between system 
components to reduce the possibility of causing 
interference to radios, television sets, and other 
electronic devices. You can obtain Apple peripheral 
devices and the proper shielded cables and 
connectors through an Apple Authorized Reseller. 
For non-Apple peripheral devices, contact the 
manufacturer or dealer for assistance. 
Responsible party (contact for FCC matters only):
Apple Inc. Corporate Compliance
1 Infinite Loop, MS 26-A
Cupertino, CA 95014-2084
Industry Canada Statement
This Class B device meets all requirements of the 
Canadian interference-causing equipment 
regulations.
Cet appareil numérique de la classe B respecte 
toutes les exigences du Règlement sur le matériel 
brouilleur du Canada.
VCCI Class B Statement
Korea Class B Statement    37
Russia
European Community
Complies with European Directives 2006/95/EEC and 
89/336/EEC.
Disposal and Recycling Information
This symbol indicates that your product must be 
disposed of properly according to local laws and 
regulations. When your product reaches its end of 
life, contact Apple or your local authorities to learn 
about recycling options.
For information about Apple’s recycling program, 
go to:  www.apple.com/environment/recycling
Battery Replacement
The rechargeable battery in iPod shuffle should be 
replaced only by an authorized service provider. For 
battery replacement services, go to:
www.apple.com/batteries/replacements.html
Battery Disposal Information
Your iPod shuffle contains a battery. Dispose of your 
iPod shuffle according to your local environmental 
laws and guidelines.
Deutschland:  Dieses Gerät enthält Batterien. Bitte 
nicht in den Hausmüll werfen. Entsorgen Sie dieses 
Gerätes am Ende seines Lebenszyklus entsprechend 
der maßgeblichen gesetzlichen Regelungen.
China:
Nederlands:  Gebruikte batterijen kunnen worden 
ingeleverd bij de chemokar of in een speciale 
batterijcontainer voor klein chemisch afval (kca) 
worden gedeponeerd.
Taiwan:
European Union—Disposal Information: 
This symbol means that according to local laws and 
regulations your product should be disposed of 
separately from household waste. When this product 
reaches its end of life, take it to a collection point 
designated by local authorities. Some collection 
points accept products for free. The separate 
collection and recycling of your product at the time 
of disposal will help conserve natural resources and 
ensure that it is recycled in a manner that protects 
human health and the environment.
Apple and the Environment 
At Apple, we recognize our responsibility to 
minimize the environmental impacts of our 
operations and products.
For more information, go to: 
www.apple.com/environment
© 2009 Apple Inc. All rights reserved. Apple, the Apple logo, iPod, 
iTunes, Mac, Macintosh, and Mac OS are trademarks of Apple Inc., 
registered in the U.S. and other countries. Finder and Shuffle are 
trademarks of Apple Inc. Apple Store and iTunes Store are service 
marks of Apple Inc., registered in the U.S. and other countries. Other 
company and product names mentioned herein may be trademarks of 
their respective companies. 
Mention of third-party products is for informational purposes only and 
constitutes neither an endorsement nor a recommendation. Apple 
assumes no responsibility with regard to the performance or use of 
these products. All understandings, agreements, or warranties, if any, 
take place directly between the vendors and the prospective users. 
Every effort has been made to ensure that the information in this 
manual is accurate. Apple is not responsible for printing or clerical 
errors.
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4  
1 iPod classic Basics
Read this chapter to learn about the features of iPod classic, 
how to use its controls, and more.
To use iPod classic, you put music, videos, photos, and other files on your computer 
and then add them to iPod classic.
iPod classic is a music player and much more. Use iPod classic to:
Â Sync songs, videos, and digital photos for listening and viewing on the go
Â Listen to podcasts, downloadable audio and video shows delivered over the Internet
Â View video on iPod classic, or on a TV using an optional cable
Â View photos as a slideshow with music on iPod classic, or on a TV using an optional 
cable
Â Listen to audiobooks purchased from the iTunes Store or audible.com
Â Store or back up files and other data, using iPod classic as an external disk
Â Sync contact, calendar, and to-do list information from your computer
Â Play games, store text notes, set an alarm, and moreChapter 1    iPod classic Basics 5
iPod classic at a Glance
Get to know the controls on iPod classic:
Using iPod classic Controls
The controls on iPod classic are easy to find and use. Press any button to turn on 
iPod classic. 
The first time you turn on iPod classic, the language menu appears. Use the Click Wheel 
to scroll to your language, and then press the Center button to choose it. The main 
menu appears in your language.
Use the Click Wheel and Center button to navigate through onscreen menus, 
play songs, change settings, and get information. 
Hold switch
Menu
Previous/Rewind
Play/Pause
Dock connector
Headphones port
Click Wheel
Next/Fast-forward 
Center button6 Chapter 1    iPod classic Basics 
Move your thumb lightly around the Click Wheel to select a menu item. To choose the 
item, press the Center button. 
To go back to the previous menu, press Menu on the Click Wheel.
Here’s what else you can do with iPod classic controls.
To Do this
Turn on iPod classic Press any button.
Turn off iPod classic Press and hold Play/Pause (’).
Turn on the backlight Press any button or use the Click Wheel.
Disable the iPod classic controls
(so nothing happens if you press them 
accidentally)
Slide the Hold switch to HOLD (an orange bar appears).
Reset iPod classic
(if it isn’t responding)
Slide the Hold switch to HOLD and back again. Press Menu 
and the Center button at the same time for about 6 
seconds, until the Apple logo appears.
Choose a menu item Use the Click Wheel to scroll to the item, and then press the 
Center button to choose it.
Go back to the previous menu Press Menu.
Go directly to the main menu Press and hold Menu.
Access additional options Press and hold the Center button until a menu appears.
Browse for a song From the main menu, choose Music.
Browse for a video From the main menu, choose Videos.
Play a song or video Select the song or video and press the Center button or 
Play/Pause (’). iPod classic must be ejected from your 
computer to play songs or videos.
Pause a song or video Press Play/Pause (’) or unplug your headphones.
Change the volume From the Now Playing screen, use the Click Wheel.
Play all the songs in a playlist or album Select the playlist or album and press Play/Pause (’).
Play all songs in random order From the main menu, choose Shuffle Songs. You can also 
shuffle songs from the Now Playing screen.
Skip to any point in a song or video From the Now Playing screen, press the Center button to 
show the scrubber bar (the playhead on the bar shows the 
current location), and then scroll to any point in the song or 
video.
Skip to the next song or chapter in an 
audiobook or podcast
Press Next/Fast-forward (‘).
Start a song or video over Press Previous/Rewind (]).
Fast-forward or rewind a song or 
video
Press and hold Next/Fast-forward (‘) or Previous/Rewind 
(]).Chapter 1    iPod classic Basics 7
Disabling iPod classic Controls
If you don’t want to turn iPod classic on or activate controls accidentally, you can 
disable them with the Hold switch. 
To disable iPod classic controls:
m Slide the Hold switch to HOLD (an orange bar appears).
Add a song to the On-The-Go playlist Play or select a song, and then press and hold the Center 
button until a menu appears. Select “Add to On-the-Go,” 
and then press the Center button.
Play the previous song or chapter in 
an audiobook or podcast
Press Previous/Rewind (]) twice.
Create a Genius playlist Play or select a song, and then press and hold the Center 
button until a menu appears. Select Start Genius, and then 
press the Center button (Start Genius appears in the Now 
Playing screen only if there’s Genius data for the selected 
song).
Save a Genius playlist Create a Genius playlist, select Save Playlist, and then press 
the Center button.
Play a saved Genius playlist From the Playlist menu, select a Genius playlist, and then 
press Play/Pause (’).
Play a Genius Mix From the Music menu, choose Genius Mixes. Select a mix 
and then press Play/Pause (’).
Find the iPod classic serial number From the main menu, choose Settings > About and press 
the Center button until you get to the serial number, or look 
on the back of iPod classic.
To Do this8 Chapter 1    iPod classic Basics 
If you disable the controls while using iPod classic, the song, playlist, podcast, or video 
that’s playing continues to play. To stop or pause, slide the Hold switch to enable the 
controls again.
Using iPod classic Menus
When you turn on iPod classic, you see the main menu. Choose menu items to perform 
functions or go to other menus. Icons along the top of the screen show iPod classic 
status.
Adding or Removing Items in the Main Menu
You might want to add often-used items to the iPod classic main menu. For example, 
you can add a Songs item to the main menu, so you don’t have to choose Music before 
you choose Songs.
To add or remove items in the main menu:
1 Choose Settings > Main Menu.
2 Choose each item you want to appear in the main menu. A checkmark indicates which 
items have been added.
Display item Function
Menu title Displays the title of the current menu.
Lock icon The Lock icon appears when the Hold switch is set to HOLD. This 
indicates that the iPod classic controls are disabled.
Play icon The Play (“) icon appears when a song, video, or other item is 
playing. The Pause (1) icon appears when the item is paused.
Battery icon The Battery icon shows the approximate remaining battery charge.
Menu items Use the Click Wheel to scroll through menu items. Press the Center 
button to choose an item. An arrow next to a menu item indicates 
that choosing it leads to another menu or screen.
Menu title
Menu items
Battery icon
Play icon
Lock iconChapter 1    iPod classic Basics 9
Setting the Language
iPod classic can use different languages.
To set the language:
m Choose Settings > Language, and then choose a language.
Setting the Backlight Timer
You can set the backlight to illuminate the screen for a certain amount of time when 
you press a button or use the Click Wheel. The default is 10 seconds. 
To set the backlight timer:
m Choose Settings > Backlight, and then choose the time you want. Choose “Always On” 
to prevent the backlight from turning off (choosing this option decreases battery 
performance).
Setting the Screen Brightness
You can set the brightness of the iPod classic screen.
To set the screen brightness:
m Choose Settings > Brightness, and then use the Click Wheel to adjust the brightness.
You can also adjust the brightness during a slideshow or video. Press the Center button 
until the brightness slider appears, and then use the Click Wheel to adjust the 
brightness.
Note:  Your brightness setting may affect your battery performance.
Turning off the Click Wheel Sound
When you scroll through menu items, you can hear a clicking sound through the 
earphones or headphones and through the iPod classic internal speaker. If you like, you 
can turn off the Click Wheel sound.
To turn off the Click Wheel sound:
m Choose Settings and set Clicker to Off.
To turn the Click Wheel sound on again, set Clicker to On.
Scrolling Quickly Through Long Lists
You can scroll quickly through a long list of songs, videos, or other items by moving 
your thumb quickly on the Click Wheel.
Note:  Not all languages are supported.
To scroll quickly:
1 Move your thumb quickly on the Click Wheel, to display a letter of the alphabet on 
the screen.10 Chapter 1    iPod classic Basics 
2 Use the Click Wheel to navigate through the alphabet until you find the first letter of 
the item you’re looking for. 
Items beginning with a symbol or number appear after the letter Z.
3 Lift your thumb momentarily to return to normal scrolling.
4 Use the Click Wheel to navigate to the item you want.
Getting Information About iPod classic
You can get information about your iPod classic, such as the amount of space available, 
the number of songs, videos, photos, and other items, and the serial number, model, 
and software version.
To get information about iPod classic:
m Choose Settings > About, and press the Center button to cycle through the screens 
of information.
Resetting All Settings
You can reset all the items on the Settings menu to their default settings.
To reset all settings:
m Choose Settings > Reset Settings, and then choose Reset.
Connecting and Disconnecting iPod classic
You connect iPod classic to your computer to add music, videos, photos, and files, 
and to charge the battery. Disconnect iPod classic when you’re done.
Connecting iPod classic
To connect iPod classic to your computer:
m Plug the included iPod Dock Connector to USB Cable into a high-powered USB 2.0 port 
on your computer, and then connect the other end to iPod classic.
If you have an iPod Dock, you can connect the cable to a USB 2.0 port on your 
computer, connect the other end to the dock, and then put iPod classic in the dock.Chapter 1    iPod classic Basics 11
Note:  The USB port on most keyboards doesn’t provide enough power to charge 
iPod classic. Connect iPod classic to a USB 2.0 port on your computer, unless your 
keyboard has a high-powered USB 2.0 port.
By default, iTunes syncs songs on iPod classic automatically when you connect it to 
your computer. When iTunes is finished, you can disconnect iPod classic. You can sync 
songs while your battery is charging.
If you connect iPod classic to a different computer and it’s set to sync music 
automatically, iTunes prompts you before syncing any music. If you click Yes, the songs 
and other audio files already on iPod classic will be erased and replaced with songs and 
other audio files on the computer iPod classic is connected to. For information about 
adding music to iPod classic and using iPod classic with more than one computer, see 
Chapter 3, “Listening to Music,” on page 28.
Disconnecting iPod classic
It’s important not to disconnect iPod classic while it’s syncing. You can easily see if it’s 
OK to disconnect iPod classic by looking at the iPod classic screen. Don’t disconnect 
iPod classic if you see the “Connected” or “Synchronizing” messages, or you could 
damage files on iPod classic. 
If you see one of these messages, you must eject iPod classic before disconnecting it: 12 Chapter 1    iPod classic Basics 
If you see the main menu or a large battery icon, you can disconnect iPod classic.
If you set iPod classic to manage songs manually or enable iPod classic for disk use, 
you must always eject iPod classic before disconnecting it. See “Managing iPod classic 
Manually” on page 26 and “Using iPod classic as an External Disk” on page 49.
If you accidentally disconnect iPod classic without ejecting it, reconnect iPod classic to 
your computer and sync again.
To eject iPod classic:
m In iTunes, click the Eject (C) button next to iPod classic in the list of devices.
You can safely disconnect iPod classic while either of these messages is displayed:
If you’re using a Mac, you can also eject iPod classic by dragging the iPod classic icon on 
the desktop to the Trash.
If you’re using a Windows PC, you can also eject iPod classic in My Computer or by 
clicking the Safely Remove Hardware icon in the Windows system tray and selecting 
iPod classic.Chapter 1    iPod classic Basics 13
To disconnect iPod classic:
m Disconnect the cable from iPod classic. If iPod classic is in the dock, simply remove it. 
About the iPod classic Battery
iPod classic has an internal, non-user-replaceable battery. For best results, the first time 
you use iPod classic, let it charge for about four hours or until the battery icon in the 
status area of the display shows that the battery is fully charged. If iPod classic isn’t 
used for a while, the battery might need to be charged. 
The iPod classic battery is 80-percent charged in about two hours and fully charged in 
about four hours. If you charge iPod classic while adding files, playing music, watching 
videos, or viewing a slideshow, charging might take longer. 
Charging the iPod classic Battery
You can charge the iPod classic battery in two ways:
Â Connect iPod classic to your computer.
Â Use the Apple USB Power Adapter, available separately. 
To charge the battery using your computer:
m Connect iPod classic to a USB 2.0 port on your computer. The computer must be 
turned on and not in sleep mode (some Mac models can charge iPod classic while 
in sleep mode). 14 Chapter 1    iPod classic Basics 
If the battery icon on the iPod classic screen shows the Charging screen, the battery is 
charging. If it shows the Charged screen, the battery is fully charged.
If you don’t see the charging screen, iPod classic might not be connected to 
a high-power USB port. Try another USB port on your computer. 
Important:  If a “Charging, Please Wait” or “Connect to Power” message appears on 
the iPod classic screen, the battery needs to be charged before iPod classic can 
communicate with your computer. See “If iPod classic displays a “Connect to Power” 
message” on page 61.
If you want to charge iPod classic when you’re away from your computer, you can 
purchase the Apple USB Power Adapter.
To charge the battery using the Apple USB Power Adapter:
1 Connect the iPod Dock Connector to USB 2.0 Cable to the power adapter, and plug the 
other end of the cable into iPod classic. Chapter 1    iPod classic Basics 15
2 Plug the power adapter into a working electrical outlet. 
Understanding Battery States
When iPod classic isn’t connected to a power source, a battery icon in the top-right 
corner of the iPod classic screen shows approximately how much charge is left. 
When iPod classic is connected to a power source, the battery icon changes to show 
that the battery is charging or fully charged.
You can disconnect and use iPod classic before it’s fully charged.
Note:  Rechargeable batteries have a limited number of charge cycles and might 
eventually need to be replaced. Battery life and number of charge cycles vary by use 
and settings. For more information, go to www.apple.com/batteries.
WARNING:  Make sure the power adapter is fully assembled before plugging it into an 
electrical outlet.
Apple USB Power Adapter
(your adapter may look different)
iPod USB cable
Battery less than 20% charged
Battery about halfway charged
Battery fully charged
Battery charging (lightning bolt)
Battery fully charged (plug)2
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2 Setting Up iPod classic
You use iTunes on your computer to set up iPod classic to 
play your music, video, and other media content. 
You use iPod classic by importing songs, audiobooks, movies, TV shows, music videos, 
and podcasts into your computer and then syncing them with iPod classic. Read on to 
learn more about the steps in this process, including:
Â Getting music from your CD collection, hard disk, or the iTunes Store (part of iTunes 
and available in some countries only) into the iTunes application on your computer
Â Organizing your music and other audio into playlists, if you want
Â Syncing playlists, songs, audiobooks, videos, and podcasts with iPod classic
About iTunes
iTunes is the free software application you use to set up, organize, and manage your 
content on iPod classic. iTunes can sync music, audiobooks, podcasts, and more with 
iPod classic. If you don’t already have iTunes installed on your computer, you can 
download it at www.apple.com/downloads. iPod classic requires iTunes 9 or later. 
You can use iTunes to import music from CDs and the Internet, buy songs and other 
audio and video from the iTunes Store, create personal compilations of your favorite 
songs (called playlists), and sync your playlists with iPod classic.
iTunes also has a feature called Genius, which creates playlists and mixes of songs from 
your iTunes library that go great together. You can sync Genius playlists that you create 
in iTunes to iPod classic, and you can create Genius playlists and listen to Genius Mixes 
on iPod classic. To use Genius, you need an iTunes Store account.
iTunes has many other features. You can burn your own CDs that play in standard CD 
players (if your computer has a recordable CD drive); listen to streaming Internet radio; 
watch videos and TV shows; rate songs according to preference; and much more. 
For information about using these iTunes features, open iTunes and choose 
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If you already have iTunes 9 or later installed on your computer and you’ve set up your 
iTunes library, you can skip ahead to “Adding Music, Videos, and Other Content to 
iPod classic” on page 21.
Setting Up Your iTunes Library
To listen to music on iPod classic, you first need to get that music into iTunes on 
your computer.
There are three ways of getting music and other audio into iTunes:
Â Purchase music, audiobooks, and videos, or download podcasts online from the 
iTunes Store.
Â Import music and other audio from audio CDs.
Â Add music and other audio that’s already on your computer to your iTunes library.
Purchase Songs and Download Podcasts Using the iTunes Store
If you have an Internet connection, you can easily purchase and download songs, 
albums, audiobooks online using the iTunes Store. You can also subscribe to and 
download podcasts, and you can download free educational content from iTunes U.
To purchase music online using the iTunes Store, you set up a free iTunes account in 
iTunes, find the songs you want, and then buy them. If you already have an iTunes 
account, you can use that account to sign in to the iTunes Store and buy songs.
You don’t need an iTunes Store account to download or subscribe to podcasts.
To enter the iTunes Store, open iTunes and click iTunes Store (under Store) on the left 
side of the iTunes window.
Add Songs Already on Your Computer to Your iTunes Library
If you have songs on your computer encoded in file formats that iTunes supports, you 
can easily add the songs to iTunes. To learn how to get songs from your computer into 
iTunes, open iTunes and choose Help > iTunes Help.
Using iTunes for Windows, you can convert nonprotected WMA files to AAC or MP3 
format. This can be useful if you have a library of music encoded in WMA format. 
For more information, open iTunes and choose Help > iTunes Help.18 Chapter 2    Setting Up iPod classic 
Import Music From Your Audio CDs Into iTunes
iTunes can import music and other audio from your audio CDs. If you have an 
Internet connection, iTunes gets the names of the songs on the CD from the Internet 
(if available) and lists them in the window. When you add the songs to iPod classic, 
the song information is included. To learn how to import music from your CDs into 
iTunes, open iTunes and choose Help > iTunes Help.
Adding More Information to Your iTunes Library
After you import your music into iTunes, you can add more song and album 
information to your iTunes library. Most of this additional information appears on 
iPod classic when you add the songs.
Enter Song Names and Other Information
If you don’t have an Internet connection, if song information isn’t available for music 
you import, or if you want to include additional information (such as composer names), 
you can enter the information manually. To learn how to enter song information, open 
iTunes and choose Help > iTunes Help.
Add Lyrics
You can enter song lyrics in plain text format into iTunes so that you can view the song 
lyrics on iPod classic while the song is playing. To learn how to enter lyrics, open iTunes 
and choose Help > iTunes Help.
For more information, see “Viewing Lyrics on iPod classic” on page 30.
Add Album Artwork
Music you purchase from the iTunes Store includes album artwork, which iPod classic 
can display. You can add album artwork automatically for music you’ve imported from 
CDs, if the CDs are available from the iTunes Store. You can add album art manually if 
you have the album art on your computer. To learn more about adding album artwork, 
open iTunes and choose Help > iTunes Help. 
For more information, see “Viewing Album Artwork on iPod classic” on page 30.Chapter 2    Setting Up iPod classic 19
Organizing Your Music
In iTunes, you can organize songs and other items into lists, called playlists, in any way 
you want. For example, you can create playlists with songs to listen to while exercising, 
or playlists with songs for a particular mood. 
You can create Smart Playlists that update automatically based on rules you define. 
When you add songs to iTunes that match the rules, they automatically get added to 
the Smart Playlist.
You can turn on Genius in iTunes and create playlists of songs that go great together. 
Genius can also organize your music library automatically by sorting and grouping 
songs into collections called Genius Mixes.
You can create as many playlists as you like, using any of the songs in your iTunes 
library. Adding a song to a playlist or later removing it doesn’t remove it from your 
library. 
To learn how to set up playlists in iTunes, open iTunes and choose Help > iTunes Help.
Note:  To create playlists on iPod classic when iPod classic isn’t connected to your 
computer, see “Creating On-The-Go Playlists on iPod classic” on page 33.
Turning On Genius in iTunes
Genius finds songs in your library that go great together and uses them to create 
Genius playlists and Genius Mixes. 
A Genius playlist is based on a song that you select. iTunes then compiles a Genius 
playlist of songs that go great with the one you selected.
Genius Mixes are preselected compilations of songs that go great together. They’re 
created for you by iTunes, using songs from your library. Each Genius Mix is designed 
to provide a different listening experience each time you play it. iTunes creates up to 
12 Genius Mixes, based on the variety of music in your iTunes library.
To create Genius playlists and Genius Mixes on iPod classic, you first need to turn on 
Genius in iTunes. For information, open iTunes and choose Help > iTunes Help.
Genius playlists and Genius Mixes created in iTunes can be synced to iPod classic like 
any iTunes playlist. You can’t add Genius Mixes to iPod classic manually. See “Syncing 
Genius Playlists and Genius Mixes to iPod classic” on page 23.
Genius is a free service, but you need an iTunes Store account to use it. If you don’t 
have an account, you can set one up when you turn on Genius.
Importing Video to iTunes
There are several way to import video into iTunes, described below.20 Chapter 2    Setting Up iPod classic 
Purchase or Rent Videos and Download Video Podcasts from the 
iTunes Store
To purchase videos—movies, TV shows, and music videos—or rent movies online from 
the iTunes Store (part of iTunes and available in some countries only), you sign in to 
your iTunes Store account, find the videos you want, and then buy or rent them. 
A rented movie expires 30 days after you rent it or 24 hours after you begin playing it 
(rental requirements may vary outside the U.S.), whichever comes first. Expired rentals 
are deleted automatically. These terms apply to U.S. rentals. Rental terms vary among 
countries.
To enter the iTunes Store, open iTunes and click iTunes Store (under Store) on the left 
side of the iTunes window.
You can view a movie trailer or TV show preview by clicking the button next to it.
Purchased videos appear when you select Movies or TV shows (under Library) or 
Purchased (under Store) in the list on the left side of the iTunes window. Rented videos 
appear when you select Rented Movies (under Library).
Some items have other options, such as TV shows that let you buy a Season Pass for 
all episodes.
Video podcasts appear along with other podcasts in the iTunes Store. You can 
subscribe to them and download them just as you would other podcasts. You don’t 
need an iTunes Store account to download podcasts. See “Purchase Songs and 
Download Podcasts Using the iTunes Store” on page 17.
Create Versions of Your Own Videos to Work with iPod classic
You can view other video files on iPod classic, such as videos you create in iMovie on 
a Mac or videos you download from the Internet. Import the video into iTunes, convert 
it for use with iPod classic, if necessary, and then add it to iPod classic.
iTunes supports many of the video formats that QuickTime supports. For more 
information, see “If you can’t add a song or other item to iPod classic” on page 62.
Some videos may be ready for use with iPod classic after you import them to iTunes. 
If you try to add a video to iPod classic (see “Syncing Videos Automatically” on 
page 24), and a message says the video can’t play on iPod classic, then you must 
convert the video for use with iPod classic. Depending on the length and content of a 
video, converting it for use with iPod classic can take several minutes to several hours.
When you create a video for use with iPod classic, the original video also remains in 
your iTunes library. 
For more information about converting video for iPod classic, open iTunes and choose 
Help > iTunes Help, or go to www.info.apple.com/kbnum/n302758.Chapter 2    Setting Up iPod classic 21
Adding Music, Videos, and Other Content to iPod classic
After your music is imported and organized in iTunes, you can easily add it to 
iPod classic.
To manage how songs, videos, photos, and other content are added to iPod classic 
from your computer, you connect iPod classic to your computer, and then use iTunes 
preferences to choose iPod classic settings.
Connecting iPod classic to a Computer for the First Time
The first time you connect iPod classic to your computer after installing iTunes, iTunes 
opens automatically, and the iPod classic Setup Assistant appears.
To use the iPod classic Setup Assistant:
1 Enter a name of iPod classic. This is the name that will appear in the device list on the 
left side of the iTunes window.
2 Select your settings. Automatic syncing is selected by default.
For more information on automatic and manual syncing, see the next section.
3 Click Done.
You can change the device name and settings any time you connect iPod classic to 
your computer.
After you click Done, the Summary pane appears. If you selected automatic syncing, 
iPod classic begins syncing.
Adding Content Automatically or Manually 
There are two ways to add content to iPod classic:
Â Automatic syncing:  When you connect iPod classic to your computer, iPod classic is 
automatically updated to match the items in your iTunes library. You can sync all your 
songs, playlists, videos, and podcasts, or, if your entire iTunes library doesn’t fit on 
iPod classic, you can sync only selected items. You can sync iPod classic automatically 
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Â Manually managing iPod classic:  When you connect iPod classic, you can drag songs 
and playlists individually to iPod classic, and delete songs and playlists individually 
from iPod classic. Using this option, you can add songs from more than one 
computer without erasing songs from iPod classic. When you manage music yourself, 
you must always eject iPod classic from iTunes before you can disconnect it. To skip 
to the section on managing your content manually, see “Managing iPod classic 
Manually” on page 26.
Syncing Music Automatically
By default, iPod classic is set to sync all songs and playlists when you connect it to your 
computer. This is the simplest way to add music to iPod classic. You just connect 
iPod classic to your computer, let it add songs, audiobooks, videos, and other items 
automatically, and then disconnect it and go. If you added any songs to iTunes since 
the last time you connected iPod classic, they are synced with iPod classic. If you 
deleted songs from iTunes, they are removed from iPod classic.
To sync music with iPod classic:
m Connect iPod classic to your computer. If iPod classic is set to sync automatically, the 
update begins.
Important:  If you connect iPod classic to a computer that it’s not synced with, a 
message asks if you want to sync songs automatically. If you accept, all songs, 
audiobooks, and videos are erased from iPod classic and replaced with the songs and 
other items from that computer.
While music is being synced from your computer to iPod classic, the iTunes status 
window shows progress, and you see a sync icon next to the iPod classic icon in the 
device list.
When the update is done, you see the “iPod sync is complete” message in iTunes. A bar 
at the bottom of the iTunes window displays how much disk space is used by different 
types of content.
If there isn’t enough space on iPod classic for all your music, you can set iTunes to sync 
only selected songs and playlists. Only the songs and playlists you specify are synced 
with iPod classic.
Syncing Music From Selected Playlist, Artists, and Genres to 
iPod classic
You can set iTunes to sync selected playlists, artists, and genres to iPod classic if the 
music in your iTunes library doesn’t all fit on iPod classic. Only the music in the playlists, 
artists, and genres you select is synced to iPod classic.Chapter 2    Setting Up iPod classic 23
To set iTunes to sync music from selected playlists, artists, and genres to iPod classic:
1 In iTunes, select iPod classic in the device list and click the Music tab. 
2 Select “Sync music” and then choose “Selected playlists, artists, and genres.”
3 Select the playlists, artists, or genres you want.
4 To include music videos, select “Include music videos.”
5 To set iTunes to automatically fill any remaining space on iPod classic, select 
“Automatically fill free space with songs.”
6 Click Apply.
Note:  If “Sync only checked songs and videos” is selected in the Summary pane, 
iTunes syncs only items that are checked.
Syncing Genius Playlists and Genius Mixes to iPod classic
You can set iTunes to sync Genius playlists and Genius Mixes to iPod classic.
Genius playlists can be added to iPod classic manually. Genius Mixes can only be 
synced automatically, so you can’t add Genius Mixes to iPod classic if you manage your 
content manually. 
If you select any Genius Mixes to sync, iTunes may select and sync additional songs 
from your library that you didn’t select. 
To set iTunes to sync Genius playlists and selected Genius Mixes to iPod classic:
1 In iTunes, select iPod classic in the device list and click the Music tab.
2 Select “Sync music,” and then choose “Selected playlists, artists, and genres.”
3 Under Playlists, select the Genius playlists and Genius Mixes you want.
4 Click Apply.
If you choose to sync your entire music library, iTunes syncs all your Genius playlists 
and Genius Mixes.
If “Sync only checked songs and videos” is selected in the Summary pane, iTunes syncs 
only items that are checked.
Adding Videos to iPod classic
You add movies and TV shows to iPod classic much the same way you add songs. You 
can set iTunes to sync all movies and TV shows to iPod classic automatically when you 
connect iPod classic, or you can set iTunes to sync only selected playlists. Alternatively, 
you can manage movies and TV shows manually. Using this option, you can add videos 
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Note:  Music videos are managed with songs, under the Music tab in iTunes. 
See “Adding Music, Videos, and Other Content to iPod classic” on page 21.
Important:  You can view a rented movie on only one device at a time. So, for example, 
if you rent a movie from the iTunes Store and add it to iPod classic, you can only view it 
on iPod classic. If you transfer the movie back to iTunes, you can only watch it there 
and not on iPod classic. Be aware of the rental expiration date.
Syncing Videos Automatically
By default, iPod classic is set to sync all videos when you connect it to your computer. 
This is the simplest way to add videos to iPod classic. You just connect iPod classic to 
your computer, let it add videos and other items automatically, and then disconnect it 
and go. If you added any videos to iTunes since the last time you connected 
iPod classic, they’re added to iPod classic. If you deleted videos from iTunes, they’re 
removed from iPod classic.
If there isn’t enough space on iPod classic for all your videos, you can set iTunes to sync 
only the videos you specify. You can sync selected videos or selected playlists that 
contain videos.
The settings for syncing movies and TV shows are unrelated. Movie settings won’t 
affect TV show settings, and vice versa.
To set iTunes to sync movies to iPod classic:
1 In iTunes, select iPod classic in the device list and click the Movies tab.
2 Select “Sync movies.”
3 Select the movies or playlists you want.
All, recent, or unwatched movies:  Select “Automatically include … movies” and choose 
the options you want from the pop-up menu.
Selected movies or playlists:  Select the movies or playlists you want.
4 Click Apply.
If “Sync only checked songs and videos” is selected in the Summary pane, iTunes syncs 
only items that are checked.
To set iTunes to sync TV shows to iPod classic:
1 In iTunes, select iPod classic in the device list and click the TV Shows tab.
2 Select “Sync TV Shows.” 
All, recent, or unwatched episodes:  Select “Automatically include … episodes of …” and 
choose the options you want from the pop-up menus.
Episodes on selected playlists:  Select the playlists you want.
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If “Sync only checked songs and videos” is selected in the Summary pane, iTunes syncs 
only items that are checked.
Adding Podcasts to iPod classic
The settings for adding podcasts to iPod classic are unrelated to the settings for adding 
songs and videos. Podcast settings don’t affect song or video settings, and vice versa. 
You can set iTunes to automatically sync all or selected podcasts, or you can add 
podcasts to iPod classic manually.
To set iTunes to update the podcasts on iPod classic automatically:
1 In iTunes, select iPod classic in the device list and click the Podcasts tab.
2 In the Podcasts pane, select “Sync Podcasts.”
3 Select the podcasts, episodes, and playlists you want, and set your sync options.
4 Click Apply.
When you set iTunes to sync iPod classic podcasts automatically, iPod classic is updated 
each time you connect it to your computer.
If “Sync only checked songs and videos” is selected in the Summary pane, iTunes syncs 
only items that are checked.
Adding Video Podcasts to iPod classic
You add video podcasts to iPod classic the same way you add other podcasts (see 
“Adding Podcasts to iPod classic” on page 25). If a podcast has video, the video plays 
when you choose it from the Podcasts menu.
Adding iTunes U Content to iPod classic
The settings for adding iTunes U content to iPod classic are unrelated to the settings for 
adding other content. iTunes U settings don’t affect other settings, and vice versa. You 
can set iTunes to automatically sync all or selected iTunes U content, or you can add 
iTunes U content to iPod classic manually.
To set iTunes to update the iTunes U content on iPod classic automatically:
1 In iTunes, select iPod classic in the device list and click the iTunes U tab.
2 In the iTunes U pane, select “Sync iTunes U.”
3 Select the collections, items, and playlists you want, and set your sync options.
4 Click Apply.
When you set iTunes to sync iTunes U content automatically, iPod classic is updated 
each time you connect it to your computer.
If “Sync only checked songs and videos” is selected in the Summary pane, iTunes syncs 
only items that are checked in your iTunes U and other libraries.26 Chapter 2    Setting Up iPod classic 
Adding Audiobooks to iPod classic
You can purchase and download audiobooks from the iTunes Store or audible.com, or 
import audiobooks from CDs, and listen to them on iPod classic.
Use iTunes to add audiobooks to iPod classic. If you sync iPod classic automatically, all 
audiobooks in your iTunes library are included in a playlist named Audiobooks, which 
you can sync to iPod classic. If you manage your content on iPod classic manually, you 
can add audiobooks one at a time.
To sync audiobooks to iPod classic:
1 In iTunes, select iPod classic in the device list and click the Music tab.
2 Select Sync Music, and then do one of the following:
Â Select “Entire music library.”
Â Select “Selected playlists, artists, and genres,” and then select Audiobooks (under 
Playlists).
3 Click Apply.
The update begins automatically.
Adding Other Content to iPod classic
You can also use iTunes to sync photos, games, contacts, and more to iPod classic. You 
can set iTunes to sync your content automatically, or you can manage your content on 
iPod classic manually.
For more information about adding other types of content to iPod classic, see:
Â “Adding Photos from Your Computer to iPod classic” on page 44
Â “To sync games automatically to iPod classic:” on page 53
Â “Syncing Contacts, Calendars, and To-Do Lists” on page 54
Managing iPod classic Manually
If you manage iPod classic manually, you can add and remove individual songs 
(including music videos) and videos (including movies and TV shows). You can also 
add music and videos from multiple computers to iPod classic without erasing items 
already on iPod classic.
You can’t add Genius Mixes to iPod classic manually, but you can add Genius playlists 
manually.
Setting iPod classic to manually manage music and video turns off the automatic sync 
options in the Music, Movies, TV Shows, Podcasts, iTunes U, Photos, Contacts, and 
Games panes. You can’t manually manage some and automatically sync others at the 
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If you set iTunes to manage content manually, you can reset it later to sync 
automatically. 
To set iTunes to let you manage content on iPod classic manually:
1 In iTunes, select iPod classic in the device list and click the Summary tab. 
2 In the Options section, select “Manually manage music and video.”
3 Click Apply.
When you manage content on iPod classic manually, you must always eject iPod classic 
from iTunes before you disconnect it.
When you connect a manually-managed iPod classic to a computer, it appears in the 
device list on the left side of the iTunes window.
To add a song, video, or other item to iPod classic:
1 In iTunes, click Music or another item in the Library list on the left.
2 Drag a song or other item to iPod classic icon in the device list.
To remove a song, video, or other item from iPod classic:
1 In iTunes, select iPod classic in the device list.
2 Select a song or other item on iPod classic and press the Delete or Backspace key on 
your keyboard.
If you manually remove a song or other item from iPod classic, it isn’t deleted from your 
iTunes library.
To create a new playlist on iPod classic:
1 In iTunes, select iPod classic in the device list, and then click the Add (+) button or 
choose File > New Playlist. 
2 Type a name for the playlist.
3 Click an item, such as Music, in the Library list, and then drag songs or other items to 
the playlist.
To add items to or remove items from a playlist on iPod classic:
m Drag an item to a playlist on iPod classic to add the item. Select an item in a playlist 
and press the Delete key on your keyboard to delete the item.
To reset iTunes to sync music, video, and podcasts automatically:
1 In iTunes, select iPod classic in the device list and click the Summary tab. 
2 Deselect “Manually manage music and videos.”
3 Click Apply.
The update begins automatically.3
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3 Listening to Music
Read this chapter to learn about listening to iPod classic on 
the go.
After you set up iPod classic, you can listen to songs, podcasts, audiobooks, and more.
Playing Music and Other Audio
When a song is playing, the Now Playing screen appears. The following table describes 
the elements on the Now Playing screen of iPod classic.
Now Playing screen item Function
Shuffle (¡) icon Appears if iPod classic is set to shuffle songs or albums.
Repeat (⁄) icon Appears if iPod classic is set to repeat all songs. The Repeat Once 
(!) icon appears if iPod classic is set to repeat one song.
Play icon Appears when a song is playing. The Pause (1) icon appears when 
a song is paused.
Battery icon Shows the approximate remaining battery charge.
Album art Shows the album art, if it’s available.
Song information Displays the song title, artist, and album title. If you rate the song, 
rating stars are displayed. Also displays the number of the song 
that’s playing within the current sequence.
Progress bar Shows the elapsed and remaining times for the song that’s playing.
Shuffle icon
Repeat icon
Progress bar
Song information, 
rating, and sequence 
number
Album art
Battery icon
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Press the Center button to cycle through these additional items in the Now Playing 
screen:
Use the Click Wheel and Center button to browse for a song or music video.
When you play music videos from the Music menu, you only hear the music. When you 
play them from the Videos menu, you also see the video.
To browse for and play a song:
m Choose Music, browse for a song or music video, and then press Play/Pause.
To change the playback volume:
m When you see the progress bar, use the Click Wheel to change the volume.
If you don’t see the progress bar, press the Center button until it appears.
To listen to a different part of a song:
1 Press the Center button until you see the scrubber bar.
2 Use the Click Wheel to move the playhead along the scrubber bar.
To create a Genius playlist from the current song:
1 Press the Center button until you see the Genius slider.
2 Use the Click Wheel to move the slider to Start.
The Genius slider doesn’t appear if Genius information isn’t available for the current 
song.
To set shuffle songs from the Now Playing screen:
1 Press the Center button until you see the shuffle slider. 
2 Use the Click Wheel to move the slider to Songs or Albums.
Â Choose Songs to play all songs on iPod classic at random.
Â Choose Albums to play all songs in the current album in order. iPod classic then 
randomly selects another album and plays through it in order.
Screen item Function
Scrubber bar Lets you quickly navigate to a different part of the track.
Genius slider Creates a Genius playlist based on the current song. The slider 
doesn’t appear if Genius information isn’t available for the current 
song.
Shuffle slider Lets you shuffle songs or albums directly from the Now Playing 
screen.
Song rating Lets you rate the song.
Lyrics Displays the lyrics of the current song. Lyrics don’t appear if you 
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To just listen to a music video:
m Choose Music and browse for a music video. 
When you play the video, you hear it but don’t see it. When you play a playlist that 
includes video podcasts, you hear the podcasts but don’t see them.
To return to the previous menu:
m From any screen, press Menu.
Rating Songs
You can assign a rating to a song (from 1 to 5 stars) to indicate how much you like it. 
You can use a song rating to help you create Smart Playlists automatically in iTunes.
To rate a song:
1 Start playing the song. 
2 From the Now Playing screen, press the Center button until the five Rating bullets appear.
3 Use the Click Wheel to assign a rating (represented by stars).
The ratings you assign to songs on iPod classic are transferred to iTunes when you sync.
Note:  You cannot assign ratings to video podcasts.
Viewing Lyrics on iPod classic
If you enter lyrics for a song in iTunes (see “Add Lyrics” on page 18) and then add the 
song to iPod classic, you can view the lyrics on iPod classic. Lyrics don’t appear unless 
you enter them.
To view lyrics on iPod classic while a song is playing:
m On the Now Playing screen, press the Center button until you see the lyrics. You can 
scroll through the lyrics as the song plays.
Viewing Album Artwork on iPod classic
iTunes displays album artwork on iPod classic, if the artwork is available. Artwork 
appears on iPod classic in the album list, when you play a song from the album, and in 
Cover Flow (see the next section for more information about Cover Flow). 
To see album artwork on iPod classic:
m Play a song that has album artwork and view it in the Now Playing screen. 
For more information about album artwork, open iTunes and choose Help > iTunes Help.
Browsing Music Using Cover Flow
You can browse your music collection using Cover Flow, a visual way to flip through 
your library. Cover Flow displays your albums alphabetically by artist name. You see the 
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To use Cover Flow:
1 From the Music menu, choose Cover Flow.
2 Use the Click Wheel (or press Next/Fast-forward or Previous/Rewind) to move through 
your album art.
3 Select an album and press the Center button.
4 Use the Click Wheel to select a song, and then press the Center button to play it.
Accessing Additional Commands
Some additional iPod classic commands can be accessed directly from the Now Playing 
screen and some menus.
To access additional commands:
m Press and hold the Center button until a menu appears, select a command, and then 
press the Center button again.
If a menu doesn’t appear, no additional commands are available.
Using Genius on iPod classic
Even when iPod classic isn’t connected to your computer, Genius can automatically 
create instant playlists of songs that go great together. You can also play Genius Mixes, 
which are preselected compilations of songs that go great together. You can create 
Genius playlists in iTunes and add them to iPod classic, and you can sync Genius Mixes 
to iPod classic. 
To use Genius, you need to set up Genius in the iTunes Store, and then sync iPod classic 
to iTunes (see “Turning On Genius in iTunes” on page 19). 
To create a Genius playlist on iPod classic:
1 Select a song, and then press and hold the Center button until a menu appears.
You can select a song from a menu or playlist, or you can start from the Now Playing 
screen.
2 Choose Start Genius.
Start Genius doesn’t appear in the menu of additional commands, if any of the 
following apply:
Â You haven’t set up Genius in iTunes and then synced iPod classic with iTunes.
Â Genius doesn’t recognize the song you selected.
Â Genius recognizes the song, but there aren’t at least ten similar songs in your library.
3 Press the Center button. The new playlist appears.
4 To keep the playlist, choose Save Playlist.32 Chapter 3    Listening to Music 
The playlist is saved with the song title and artist of the song you used to make the 
playlist.
5 To change the playlist to a new one based on the same song, choose Refresh. If you 
refresh a saved playlist, the new playlist replaces the previous one. You can’t recover the 
previous playlist.
You can also start Genius from the Now Playing screen by pressing the Center button 
until you see the Genius slider, and then using the Click Wheel to move the slider to the 
right. The Genius slider won’t appear if Genius information isn’t available for the current 
song.
Genius playlists saved on iPod classic are synced back to iTunes when you connect 
iPod classic to your computer.
To play a Genius playlist:
m Choose Music > Playlists, and then choose a Genius playlist.
Playing Genius Mixes
Genius Mixes are created for you by iTunes and contain songs from your library that go 
great together. Genius Mixes provide a different listening experience each time you 
play one. iTunes creates up to 12 Genius Mixes, depending on the variety of music in 
your iTunes library.
To learn how to sync Genius Mixes to iPod classic, see “Syncing Genius Playlists and 
Genius Mixes to iPod classic” on page 23.
To play a Genius Mix:
1 Choose Music > Genius Mixes.
2 Use the Click Wheel (or press Next/Fast-forward or Previous/Rewind) to browse the 
Genius Mixes. The dots at the bottom of the screen indicate how many Genius Mixes 
are synced to iPod classic.
3 To start playing a Genius Mix, press the Center button or Play/Pause when you see 
its screen.
The Speaker icon
appears when the
selected Genius Mix is
playing.
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Creating On-The-Go Playlists on iPod classic
You can create On-The-Go playlists on iPod classic when iPod classic isn’t connected to 
your computer.
To create an On-The-Go playlist:
1 Select a song, and then press and hold the Center button until a menu appears. 
2 Choose “Add to On-The-Go,” and press the Center button.
3 To add more songs, repeat steps 1 and 2.
4 Choose Music > Playlists > On-The-Go to view and play your list of songs.
You can also add a group of songs. For example, to add an album, highlight the album 
title, press and hold the Center button until a menu appears, and then choose “Add to 
On-The-Go.” 
To play songs in the On-The-Go playlist:
m Choose Music > Playlists > On-The-Go, and then choose a song.
To remove a song from the On-The-Go playlist:
1 Select a song in the playlist, and hold down the Center button until a menu appears.
2 Choose “Remove from the On-The-Go,” and then press the Center button.
To clear the entire On-The-Go playlist:
m Choose Music > Playlists > On-The-Go > Clear Playlist and then click Clear.
To save the On-The-Go playlist on iPod classic:
m Choose Music > Playlists > On-The-Go > Save Playlist.
The first playlist is saved as “New Playlist 1” in the Playlists menu. The On-The-Go 
playlist is cleared. You can save as many playlists as you like. After you save a playlist, 
you can no longer remove songs from it.
To copy the On-The-Go playlists to your computer:
m If iPod classic is set to update songs automatically (see “Syncing Music Automatically” 
on page 22), and you make an On-The-Go playlist, the playlist is automatically copied 
to iTunes when you connect iPod classic. You see the new On-The-Go playlist in the list 
of playlists in iTunes. You can rename, edit, or delete the new playlist, just as you would 
any playlist.
Browsing Songs by Artist or Album
When you’re listening to a song, you can browse more songs by the same artist or all 
the songs from the current album.
To browse songs by artist:
1 From the Now Playing screen, press and hold the Center button until a menu appears.
2 Choose Browse Artist, and then press the Center button.34 Chapter 3    Listening to Music 
You see the other songs by that artist that are on iPod classic. You can select another 
song or return to the Now Playing screen.
To browse songs by album:
1 From the Now Playing screen, press and hold the Center button until a menu appears.
2 Choose Browse Album, and then press the Center button.
You see the other songs from the current album that are on iPod classic. You can select 
another song or return to the Now Playing screen.
Setting iPod classic to Shuffle Songs 
You can set iPod classic to play songs, albums, or your entire library in random order.
To set iPod classic to shuffle and play all your songs: 
m Choose Shuffle Songs from the iPod classic main menu. 
iPod classic begins playing songs from your entire music library in random order, 
skipping audiobooks and podcasts.
To set iPod classic to always shuffle songs or albums:
1 Choose Settings from the iPod classic main menu.
2 Set Shuffle to either Songs or Albums.
When you set iPod classic to shuffle songs, iPod classic shuffles songs within whatever 
list (for example, album or playlist) you choose to play. 
When you set iPod classic to shuffle albums, it plays all the songs on an album in order, 
and then randomly selects another album and plays through it in order. 
You can also set iPod classic to shuffle songs directly from the Now Playing screen.
To set iPod classic to shuffle songs from the Now Playing screen:
1 From the Now Playing screen, press the Center button until the shuffle slider appears.
2 Use the Click Wheel to set iPod classic to shuffle songs or albums.
Setting iPod classic to Repeat Songs
You can set iPod classic to repeat a song over and over, or repeat songs within the list 
you choose to play.
To set iPod classic to repeat songs:
m Choose Settings from the iPod classic main menu.
Â To repeat all songs in the list, set Repeat to All.
Â To repeat one song over and over, set Repeat to One.Chapter 3    Listening to Music 35
Searching Music
You can search iPod classic for songs, playlists, album titles, artist names, audio 
podcasts, and audiobooks. The search feature doesn’t search videos, notes, calendar 
items, contacts, or lyrics.
Note:  Not all languages are supported.
To search for music:
1 From the Music menu, choose Search.
2 Enter a search string by using the Click Wheel to navigate the alphabet and pressing 
the Center button to enter each character.
iPod classic starts searching as soon as you enter the first character, displaying the 
results on the search screen. For example, if you enter “b,” iPod classic displays all 
music items containing the letter “b.” If you enter “ab,” iPod classic displays all items 
containing that sequence of letters.
To enter a space, press the Next/Fast-forward button.
To delete the previous character, press the Previous/Rewind button.
3 Press Menu to display the results list, which you can navigate by using the Click Wheel.
Items appear in the results list with icons identifying their type: song, video, artist, 
album, audiobook, podcast, or iTunes U. 
To return to Search (if Search is highlighted in the menu), press the Center button.
Customizing the Music Menu
You can add items to or remove them from the Music menu, just as you do with the 
main menu. For example, you can add a Compilations item to the Music menu, so you 
can easily choose compilations that are put together from various sources.
To add or remove items in the Music menu:
1 Choose Settings > Music Menu.
2 Select each item you want to appear in the Music menu. A checkmark indicates which 
items have been added. To revert to the original Music menu settings, choose Reset Menu.36 Chapter 3    Listening to Music 
Setting the Maximum Volume Limit
You can choose to set a limit for the maximum volume on iPod classic and assign 
a combination to prevent the setting from being changed.
To set the maximum volume limit for iPod classic:
1 Choose Settings > Volume Limit.
The volume control shows the current volume. 
2 Use the Click Wheel to select the maximum volume limit.
You can press Play to hear the currently selected song play while you select the 
maximum volume limit.
3 Press the Center button to set the maximum volume limit.
A triangle on the volume bar indicates the maximum volume limit.
4 Press the Menu button to accept the maximum volume limit without requiring 
a combination to change it. Or, on the Enter Combination screen, set a combination 
to require that the combination be entered to change the maximum volume limit. 
5 To enter a combination:
Â Use the Click Wheel to select a number for the first position. Press the Center button 
to confirm your choice and move to the next position. 
Â Use the same method to set the remaining numbers of the combination. You can use 
the Next/Fast-forward button to move to the next position and the Previous/Rewind 
button to move to the previous position. Press the Center button in the final position 
to confirm the entire combination.
If you set a combination, you must enter it before you can change or remove the 
maximum volume limit. 
The volume of songs and other audio may vary depending on how the audio was 
recorded or encoded. See “Setting Songs to Play at the Same Volume Level” on page 37 
for information about how to set a relative volume level in iTunes and on iPod classic. 
Volume level may also vary if you use different earphones or headphones. With the 
exception of the iPod Radio Remote, accessories that connect through the iPod Dock 
Connector don’t support volume limits.
To change the maximum volume limit:
1 Choose Settings > Volume Limit. 
2 If you set a combination, enter it by using the Click Wheel to select the numbers and 
pressing the Center button to confirm them. 
3 Use the Click Wheel to change the maximum volume limit.
4 Press the Play/Pause button to accept the change.Chapter 3    Listening to Music 37
To remove the maximum volume limit:
1 If you’re currently listening to iPod classic, press Pause.
2 Choose Settings > Volume Limit. 
3 If you set a combination, enter it by using the Click Wheel to select the numbers and 
pressing the Center button to confirm them. 
4 Use the Click Wheel to move the volume limit to the maximum level on the volume bar. 
This removes any restriction on volume.
5 Press the Play/Pause button to accept the change.
If you forget the combination, you can restore iPod classic. See “Updating and 
Restoring iPod Software” on page 65 for more information.
Setting Songs to Play at the Same Volume Level
iTunes can automatically adjust the volume of songs, so they play at the same relative 
volume level. You can set iPod classic to use the iTunes volume settings.
To set iTunes to play songs at the same sound level:
1 In iTunes, choose iTunes > Preferences if you’re using a Mac, or choose 
Edit > Preferences if you’re using a Windows PC.
2 Click Playback and select Sound Check, and then click OK.
To set iPod classic to use the iTunes volume settings:
m Choose Settings and set Sound Check to On.
If you haven’t activated Sound Check in iTunes, setting it on iPod classic has no effect.
Using the Equalizer
You can use equalizer presets to change the sound on iPod classic to suit a particular 
music genre or style. For example, to make rock music sound better, set the equalizer 
to Rock. 
To use the equalizer to change the sound on iPod classic:
m Choose Settings > EQ and choose an equalizer preset. 
If you assigned an equalizer preset to a song in iTunes and the iPod classic equalizer is 
set to Off, the song plays using the iTunes setting. See iTunes Help for more information.38 Chapter 3    Listening to Music 
Playing Podcasts
Podcasts are free, downloadable shows available at the iTunes Store. Podcasts are 
organized by shows, episodes within shows, and chapters within episodes. If you stop 
playing a podcast and return to it later, the podcast begins playing where you left off.
To play a podcast:
1 From the main menu, choose Podcasts, and then choose a show.
Shows appear in reverse chronological order so you can play the most recent one first. 
You see a blue dot next to shows and episodes you haven’t played yet.
2 Choose an episode to play it.
For audio podcasts, the Now Playing screen displays the show, episode, and date 
information, along with elapsed and remaining time. Press the Center button to bring 
up the scrubber, star ratings, and other information about the podcast. For video 
podcasts, you control the podcast as you do other videos. 
If the podcast has chapters, you can press Next/Fast-forward or Previous/Rewind to skip 
to the next chapter or to the beginning of the current chapter in the podcast. 
If a podcast includes artwork, you also see a picture. Podcast artwork can change 
during an episode.
For more information about podcasts, open iTunes and choose Help > iTunes Help. 
Then search for “podcasts.”
Playing iTunes U Content
iTunes U is a part of the iTunes Store featuring free lectures, language lessons, 
audiobooks, and more, which you can download and enjoy on iPod classic. iTunes U 
content is organized by collections, items within collections, authors, and providers.
If you stop listening to iTunes U content and return to it later, the collection or item 
begins playing where you left off.
To play iTunes U content:
1 From the main menu, choose iTunes U, and then choose a collection.
Items within a collection appear in reverse chronological order so you can listen to the 
most recent one first. You see a blue dot next to collections and items you haven’t 
played yet.
2 Choose an item to play it.
For more information about iTunes U, open iTunes and choose Help > iTunes Help. 
Then search for “iTunes U.”Chapter 3    Listening to Music 39
Listening to Audiobooks
To listen to audiobooks on iPod classic, choose Audiobooks from the Music menu. 
Choose an audiobook and then press Play/Pause.
If you stop listening to an audiobook on iPod classic and return to it later, the 
audiobook begins playing where you left off. iPod classic skips audiobooks when 
it’s set to shuffle.
If the audiobook you’re listening to has chapters, you can press Next/Fast-forward or 
Previous/Rewind to skip to the next chapter or the beginning of the current chapter in 
the audiobook. You can also choose the audiobook from the Audiobooks menu and 
then choose a chapter, or choose Resume to begin playing where you left off. 
You can play audiobooks at speeds faster or slower than normal. Setting the playing 
speed affects only audiobooks purchased from the iTunes Store or from audible.com.
To set audiobook play speed:
m Choose Settings > Audiobooks and choose a speed. 
Listening to FM Radio
You can listen to radio using the optional iPod Radio Remote accessory for iPod classic.
iPod Radio Remote attaches to iPod classic using the Dock connector. When you’re 
using iPod Radio Remote, you see a Radio menu item on the iPod classic main menu. 
For more information, see the iPod Radio Remote documentation.4
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4 Watching Videos
You can use iPod classic to watch movies, TV shows, video 
podcasts, and more. Read this chapter to learn about 
watching videos on iPod classic and on your TV.
You can view and listen to videos on iPod classic. If you have a compatible AV cable 
(available separately at www.apple.com/ipodstore or your local Apple store), you can 
watch videos from iPod classic on your TV.
Watching Videos on iPod classic
Videos you add to iPod classic appear in the Videos menus. Music videos also appear in 
Music menus. 
To watch a video on iPod classic:
1 Choose Videos and browse for a video.
2 Select a video and then press Play/Pause.
When you play the video, you see and hear it.
Watching Video Podcasts
To watch a video podcast:
m From the main menu, choose Podcasts and then choose a video podcast.
For more information, see “Playing Podcasts” on page 38.
Watching Video Downloaded from iTunes U
To watch an iTunes U video:
m From the main menu, choose iTunes U and then choose a video.
For more information, see “Playing iTunes U Content” on page 38.Chapter 4    Watching Videos 41
Watching Videos on a TV Connected to iPod classic
If you have an AV cable from Apple, you can watch videos on a TV connected to 
iPod classic. First you set iPod classic to display videos on a TV, then connect 
iPod classic to your TV, and then play a video.
Use the Apple Component AV Cable, the Apple Composite AV Cable, or the Apple AV 
Connection Kit. Other similar RCA-type cables might not work. You can purchase the 
cables at www.apple.com/ipodstore or your local Apple store.
To set iPod classic to display videos on a TV:
m Choose Videos > Settings, and then set TV Out to Ask or On.
If you set TV Out to Ask, iPod classic gives you the option of displaying videos on TV or 
on iPod classic every time you play a video. If you set TV Out to On, iPod classic displays 
videos only on TV. If you try to play a video when iPod classic isn’t connected to a TV, 
iPod classic displays a message instructing you to connect to one.
You can also set video to display full screen or widescreen, and set video to display on 
PAL or NTSC devices.
To set TV settings:
m Choose Videos > Settings, and then follow the instructions below.
To use the Apple Component AV Cable to connect iPod classic to your TV:
1 Plug the green, blue, and red video connectors into the component video input 
(Y, Pb, and Pr) ports on your TV.
You can also use the Apple Composite AV Cable. If you do, plug in the yellow video 
connector into the video input port on your TV. Your TV must have RCA video and 
audio ports.
To set Do this
Video to display on a TV Set TV Out to Ask or On.
Video to display on PAL or 
NTSC TVs
Set TV Signal to NTSC or PAL. NTSC and PAL refer to TV broadcast 
standards. Your TV might use either of these, depending on the 
region where it was purchased. If you aren’t sure which your TV 
uses, check the documentation that came with your TV.
The format of your external TV Set TV Screen to Widescreen for 16:9 format or Standard for 4:3 
format.
Video to fit to your screen Set “Fit to Screen” to On. If you set “Fit to Screen” to Off, widescreen 
videos display in letterbox format on iPod classic or a standard (4:3) 
TV screen.
Alternate audio to play Set Alternate Audio to On.
Captions to display Set Captions to On.
Subtitles to display Set Subtitles to On.42 Chapter 4    Watching Videos 
2 Plug the white and red audio connectors into the left and right analog audio input 
ports, respectively, on your TV. 
3 Plug the iPod Dock Connector into iPod classic or the Universal Dock.
4 Plug the USB connector into your USB Power Adapter or your computer to keep 
iPod classic charged.
5 Turn on iPod classic and your TV or receiver to start playing.
Make sure you set TV Out on iPod classic to On.
Note:  The ports on your TV or receiver may differ from the ports in the illustration.
To view a video on your TV:
1 Connect iPod classic to your TV (see above).
2 Turn on your TV and set it to display from the input ports connected to iPod classic. 
See the documentation that came with your TV for more information.
3 On iPod classic, choose Videos and browse for a video.
USB Power
Adapter
USB
connector
iPod Left audio (white)
Dock Connector
Television
Video in (Y, Pb, Pr)
Right audio (red)5
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5 Adding and Viewing Photos
Read this chapter to learn about importing and viewing 
photos.
You can import digital photos to your computer and add them to iPod classic. 
You can view your photos on iPod classic or as a slideshow on your TV.
Importing Photos
If you computer is a Mac, you can import photos from a digital camera to your 
computer using iPhoto. 
You can import other digital images into iPhoto, such as images you download from 
the web. For more information about importing, organizing, and editing your photos, 
open iPhoto and choose Help > iPhoto Help. 
iPhoto is available for purchase as part of the iLife suite of applications at 
www.apple.com/ilife or your local Apple Store. iPhoto might already be installed on 
your Mac, in the Applications folder.
To import photos to a Windows PC, follow the instructions that came with your digital 
camera or photo application.44 Chapter 5    Adding and Viewing Photos 
Adding Photos from Your Computer to iPod classic
If you have a Mac and iPhoto 7.1.5 or later, you can sync iPhoto albums automatically 
(for Mac OS X v10.4.11, iPhoto 6.0.6 or later is required). If you have a PC or Mac, you can 
add photos to iPod classic from a folder on your hard disk.
Adding photos to iPod classic the first time might take some time, depending on how 
many photos are in your photo library.
To sync photos from a Mac to iPod classic using iPhoto:
1 In iTunes, select iPod classic in the device list and click the Photos tab.
2 Select “Sync photos from: …” and then choose iPhoto from the pop-up menu.
3 Select your sync options. 
Â If you want to add all your photos, select “All photos, albums, events, and faces.”
Â If you want to add selected photos, select “Selected albums, events, and faces, and 
automatically include …” and choose an option from the pop-up menu. Then select 
the albums, events, and faces you want to add. (Faces is supported only by iPhoto 8.1 
or later.)
Â If you want to add videos from iPhoto, select “Include videos.”
4 Click Apply.
To add photos from a folder on your hard disk to iPod classic:
1 Drag the images to a folder on your computer.
If you want images to appear in separate photo albums on iPod classic, create folders 
within the main image folder, and drag images to the new folders.
2 In iTunes, select iPod classic in the device list and click the Photos tab.
3 Select “Sync photos from: …” 
4 Choose “Choose Folder” from the pop-up menu and select the image folder.
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Adding Full-Resolution Image Files to iPod classic
When you add photos to iPod classic, iTunes optimizes the photos for viewing. 
Full-resolution image files aren’t transferred by default. Adding full-resolution image 
files is useful, for example if you want to move them from one computer to another, 
but isn’t necessary for viewing the images at full quality on iPod classic.
To add full-resolution image files to iPod classic:
1 In iTunes, select iPod classic in the device list and click the Photos tab.
2 Select “Include full-resolution photos.”
3 Click Apply.
iTunes copies the full-resolution versions of the photos to the Photos folder on 
iPod classic.
To delete photos from iPod classic:
1 In iTunes, select iPod classic in the source list and click the Photos tab.
2 Select “Sync photos from: …”
Â On a Mac, choose iPhoto from the pop-up menu.
Â On a Windows PC, choose Photoshop Album or Photoshop Elements from the pop-up 
menu.
3 Choose “Selected albums” and deselect the albums you no longer want on iPod classic.
4 Click Apply.
Viewing Photos
You can view photos on iPod classic manually or as a slideshow. If you have an optional 
AV cable from Apple (for example, the Apple Component AV Cable), you can connect 
iPod classic to a TV and view photos as a slideshow with music.
Viewing Photos on iPod classic
To view photos on iPod classic:
1 On iPod classic, choose Photos > All Photos. Or choose Photos and a photo album 
to see only the photos in the album. Thumbnail views of the photos might take 
a moment to appear.
2 Select the photo you want and press the Center button to view a full-screen version.
From any photo-viewing screen, use the Click Wheel to scroll through photos. Press the 
Next/Fast-forward or Previous/Rewind button to skip to the next or previous screen of 
photos. Press and hold the Next/Fast-forward or Previous/Rewind button to skip to the 
last or first photo in the library or album.46 Chapter 5    Adding and Viewing Photos 
Viewing Slideshows
You can view a slideshow, with music and transitions if you choose, on iPod classic. 
If you have an optional AV cable from Apple, you can view the slideshow on a TV.
To set slideshow settings:
m Choose Photos > Settings, and then follow these instructions:
To view a slideshow on iPod classic:
m Select any photo, album, or roll, and press the Play/Pause button. Or select any 
full-screen photo and press the Center button. To pause, press the Play/Pause button. 
To skip to the next or previous photo, press the Next/Fast-forward or Previous/Rewind 
button.
When you view a slideshow, you can use the Click Wheel to control the music volume 
and adjust the brightness. You can’t use the Click Wheel to scroll through photos 
during a slideshow.
If you view a slideshow of an album that includes videos, the slideshow pauses when 
it reaches a video. If music is playing, it continues to play. If you play the video, the 
music pauses while the video is playing, and then resumes. To play the video, press 
Play/Pause. To resume the slideshow, press Next/Fast-Forward.
To set Do this
How long each slide is shown Choose Time Per Slide and pick a time.
The music that plays during 
slideshows
Choose Music and choose a playlist. If you’re using iPhoto, you can 
choose From iPhoto to copy the iPhoto music setting. Only the 
songs that you’ve added to iPod classic play.
Slides to repeat Set Repeat to On.
Slides to display in random 
order
Set Shuffle Photos to On.
Slides to display with 
transitions
Choose Transitions and choose a transition type.
Slideshows to display on 
iPod classic
Set TV Out to Ask or Off.
Slideshows to display on TV Set TV Out to Ask or On.
If you set TV Out to Ask, iPod classic gives you the option of 
showing slideshows on TV or on iPod classic every time you start a 
slideshow.
Slides to show on PAL 
or NTSC TVs
Set TV Signal to PAL or NTSC.
PAL and NTSC refer to TV broadcast standards. Your TV might use 
either of these, depending on the region where it was purchased. 
If you aren’t sure which your TV uses, check the documentation 
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To adjust the brightness during a slideshow:
1 Press the Center button until the brightness indicator appears.
2 Use the Click Wheel to adjust the brightness.
To connect iPod classic to your TV:
1 Connect the optional Apple Component or Composite AV cable to iPod classic.
Use the Apple Component AV Cable, Apple Composite AV Cable, or Apple AV 
Connection Kit. Other similar RCA-type cables won’t work. You can purchase the 
cables at www.apple.com/ipodstore or your local Apple store.
2 Connect the video and audio connectors to the ports on your TV (see the illustration 
on page 42).
Make sure you set TV Out on iPod classic to Ask or On.
Your TV must have RCA video and audio ports. The ports on your TV or receiver may 
differ from the ports in the illustration.
To view a slideshow on a TV:
1 Connect iPod classic to a TV (see above).
2 Turn on your TV and set it to display from the input ports connected to iPod classic. 
See the documentation that came with your TV for more information.
3 Use iPod classic to play and control the slideshow. 
Adding Photos from iPod classic to a Computer
If you add full-resolution photos from your computer to iPod classic using the previous 
steps, they’re stored in a Photos folder on iPod classic. You can connect iPod classic to a 
computer and put these photos onto the computer. iPod classic must be enabled for 
disk use (see “Using iPod classic as an External Disk” on page 49).
To add photos from iPod classic to a computer:
1 Connect iPod classic to the computer.
2 Drag image files from the Photos folder or DCIM folder on iPod classic to the desktop or 
to a photo editing application on the computer.48 Chapter 5    Adding and Viewing Photos 
Note:  You can also use a photo editing application, such as iPhoto, to add photos 
stored in the Photos folder. See the documentation that came with the application 
for more information.
To delete photos from the Photos folder on iPod classic:
1 Connect iPod classic to the computer.
2 Navigate to the Photos folder on iPod classic and delete the photos you no longer 
want.6
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6 More Settings, Extra Features, and 
Accessories
iPod classic can do a lot more than play songs. And you can 
do a lot more with it than listen to music.
Read this chapter to find out more about the extra features of iPod classic, including 
how to use it as an external disk, alarm, or sleep timer; show the time of day in other 
parts of the world; display notes; and sync contacts, calendars, and to-do lists. Learn 
about how to use iPod classic as a stopwatch and to lock the screen, and about the 
accessories available for iPod classic.
Using iPod classic as an External Disk
You can use iPod classic as an external disk to store data files. 
Note:  To add music and other audio or video files to iPod classic, you must use 
iTunes. For example, you won’t see songs you add using iTunes in the Mac Finder 
or in Windows Explorer. Likewise, if you copy music files to iPod classic in the 
Mac Finder or Windows Explorer, you won’t be able to play them on iPod classic.
To enable iPod classic as an external disk:
1 In iTunes, select iPod classic in the device list and click the Summary tab.
2 In the Options section, select “Enable disk use.”
3 Click Apply.
When you use iPod classic as an external disk, the iPod classic disk icon appears on 
the desktop on Mac, or as the next available drive letter in Windows Explorer on a 
Windows PC.
Note:  Clicking Summary and selecting “Manually manage music and videos” in the 
Options section also enables iPod classic to be used as an external disk. Drag files to 
and from iPod classic to copy them.
If you use iPod classic primarily as a disk, you might want to keep iTunes from opening 
automatically when you connect iPod classic to your computer.50 Chapter 6    More Settings, Extra Features, and Accessories 
To prevent iTunes from opening automatically when you connect iPod classic 
to your computer:
1 In iTunes, select iPod classic in the device list and click the Summary tab.
2 In the Options section, deselect “Open iTunes when this iPod is connected.”
3 Click Apply.
Using Extra Settings
You can set the date and time, clocks in different time zones, and alarm and sleep 
features on iPod classic. You can use iPod classic as a stopwatch or to play games, and 
you can lock the iPod classic screen.
Setting and Viewing the Date and Time
The date and time are set automatically from your computer’s clock when you connect 
iPod classic, but you can change the settings.
To set date and time options:
1 Choose Settings > Date & Time.
2 Choose one or more of the following options:
To  Do this
Set the date Choose Date. Use the Click Wheel to change the selected value. 
Press the Center button to move to the next value.
Set the time Choose Time. Use the Click Wheel to change the selected value. 
Press the Center button to move to the next value.
Specify the time zone Choose Time Zone and use the Click Wheel to select a city in 
another time zone.
Display the time in 24-hour 
format
Choose 24 Hour Clock and press the Center button to turn the 
24-hour format on or off. 
Display the time in the title bar Choose Time in Title and press the Center button to turn the option 
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Adding Clocks for Other Time Zones
To add clocks for other time zones:
1 Choose Extras > Clocks.
2 On the Clocks screen, click the Center button and choose Add.
3 Choose a region and then choose a city.
The clocks you add appear in a list. The last clock you added appears last.
To delete a clock:
1 Choose Extras > Clocks.
2 Choose the clock.
3 Choose Delete.
Setting the Alarm
You can set an alarm for any clock on iPod classic.
To use iPod classic as an alarm clock:
1 Choose Extras > Alarms.
2 Choose Create Alarm and set one or more of the following options:
To delete an alarm:
1 Choose Extras > Alarms.
2 Choose the alarm and then choose Delete.
Setting the Sleep Timer
You can set iPod classic to turn off automatically after playing or other content for 
a specific period of time.
To set the sleep timer:
1 Choose Extras > Alarms.
To Do this
Turn the alarm on Choose Alarm and choose On.
Set the date Choose Date. Use the Click Wheel to change the selected value. 
Press the Center button to move to the next value.
Set the time Choose Time. Use the Click Wheel to change the selected value. 
Press the Center button to move to the next value.
Set a repeat option Choose Repeat and choose an option (for example, “weekdays”).
Choose a sound Choose Tones or a playlist. If you choose Tones, select Beep to hear 
the alarm through the internal speaker. If you choose a playlist, 
you’ll need to connect iPod classic to speakers or headphones to 
hear the alarm.
Name the alarm Choose Label and choose an option (for example, “Wake up”).52 Chapter 6    More Settings, Extra Features, and Accessories 
2 Choose Sleep Timer and choose how long you want iPod classic to play.
Using the Stopwatch
You can use the stopwatch as you exercise to track your overall time and, if you’re 
running on a track, your lap times. You can play music while you use the stopwatch.
To use the stopwatch:
1 Choose Extras > Stopwatch.
2 Press the Play/Pause button to start the timer. 
3 Press the Center button to record lap times. Up to three lap times show beneath the 
overall time.
4 Press the Play/Pause button to stop the overall timer, or choose Resume to start the 
timer again.
5 Choose New Timer to start a new stopwatch session.
Note:  After you start the stopwatch, the stopwatch continues to run as long as you 
display the Timer screen. If you start the stopwatch and then go to another menu, and 
iPod classic isn’t playing music or a video, the stopwatch timer stops and iPod classic 
turns off automatically after a few minutes.
To review or delete a logged stopwatch session:
1 Choose Extras > Stopwatch.
The current log and a list of saved sessions appear.
2 Choose a log to view session information.
iPod classic stores stopwatch sessions with dates, times, and lap statistics. You see the 
date and time the session started; the total time of the session; the shortest, longest, 
and average lap times; and the last several lap times.
3 Press the Center button and choose Delete Log to delete the chosen log, or Clear Logs 
to delete all current logs.
Playing Games
iPod classic comes with three games: iQuiz, Klondike, and Vortex. 
To play a game:
m Choose Extras > Games and choose a game.
You can purchase additional games from the iTunes Store (in some countries) to play 
on iPod classic. After purchasing games in iTunes, you can add them to iPod classic by 
syncing them automatically or by managing them manually. 
To buy a game:
1 In iTunes, select iTunes Store in the list on the left side of the iTunes window.
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3 Select the game you want and click Buy Game.
To sync games automatically to iPod classic:
1 In iTunes, select iPod classic in the device list and click the Games tab.
2 Select “Sync games.”
3 Click “All games” or “Selected games.” If you click “Selected games,” also select the 
games you want to sync.
4 Click Apply.
Locking the iPod classic Screen
You can set a combination to prevent iPod classic from being used by someone 
without your permission. When you lock an iPod classic that isn’t connected to a 
computer, you must enter a combination to unlock and use it.
Note:  This is different from the Hold button in that the Hold button prevents 
iPod classic buttons from being pressed accidentally. The combination prevents 
another person from using iPod classic.
To set a combination for iPod classic:
1 Choose Extras > Screen Lock.
2 On the New Combination screen, enter a combination:
Â Use the Click Wheel to select a number for the first position. Press the Center button 
to confirm your choice and move to the next position. 
Â Use the same method to set the remaining numbers of the combination. You can use 
the Next/Fast-forward button to move to the next position and the Previous/Rewind 
button to move to the previous position. Press the Center button in the final 
position.
3 On the Confirm Combination screen, enter the combination to confirm it, or press 
Menu to exit without locking the screen.
When you finish, you return to the Screen Lock screen, where you can lock the screen 
or reset the combination. Press the Menu button to exit without locking the screen.
To lock the iPod classic screen:
m Choose Extras > Screen Lock > Lock.
If you just finished setting your combination, Lock will already be selected on the 
screen. Just press the Center button to lock iPod classic.
When the screen is locked, you see a picture of a lock. 
Note:  You might want to add the Screen Lock menu item to the main menu so that 
you can quickly lock the iPod classic screen. See “Adding or Removing Items in the 
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When you see the lock on the screen, you can unlock the iPod classic screen in 
two ways:
Â Press the Center button to enter the combination on iPod classic. Use the Click Wheel 
to select the numbers and press the Center button to confirm them. If you enter the 
wrong combination, the lock remains. Try again.
Â Connect iPod classic to the primary computer you use it with, and iPod classic 
automatically unlocks.
Note:  If you try these methods and you still can’t unlock iPod classic, you can restore 
iPod classic. See “Updating and Restoring iPod Software” on page 65.
To change a combination you’ve already set:
1 Choose Extras > Screen Lock > Reset.
2 On the Enter Combination screen, enter the current combination.
3 On the New Combination screen, enter and confirm a new combination.
Note:  If you can’t remember the current combination, the only way to clear it and enter 
a new one is to restore the iPod classic software. See “Updating and Restoring iPod 
Software” on page 65.
Syncing Contacts, Calendars, and To-Do Lists
iPod classic can store contacts, calendar events, and to-do lists for viewing on the go. 
If you’re using Mac OS X v10.4 or later, you can use iTunes to sync the contact and 
calendar information on iPod classic with Address Book and iCal. If you’re using any 
version of Mac OS X earlier than 10.4, you can use iSync to sync your information. 
Syncing information using iSync requires iSync 1.1 or later, and iCal 1.0.1 or later.
If you’re using Windows XP, and you use Windows Address Book or Microsoft Outlook 
2003 or later to store your contact information, you can use iTunes to sync the address 
book information on iPod classic. If you use Microsoft Outlook 2003 or later to keep a 
calendar, you can also sync calendar information.
To sync contacts or calendar information using Mac OS X v10.4 or later:
1 Connect iPod classic to your computer.
2 In iTunes, select iPod classic in the device list and click the Contacts tab.
3 Do one of the following:
Â To sync contacts, in the Contacts section, select “Sync Address Book contacts,” and 
select an option:
Â To sync all contacts automatically, select “All contacts.”
Â To sync selected groups of contacts automatically, select “Selected groups” and 
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Â To copy contacts’ photos to iPod classic, when available, select “Include contacts’ 
photos.”
When you click Apply, iTunes updates iPod classic with the Address Book contact 
information you specified. 
Â To sync calendars, in the Calendars section, select “Sync iCal calendars,” and choose 
an option:
Â To sync all calendars automatically, choose “All calendars.”
Â To sync selected calendars automatically, choose “Selected calendars” and select 
the calendars you want to sync.
When you click Apply, iTunes updates iPod classic with the calendar information 
you specified. 
To sync contacts and calendars with a Mac and iSync using a version of Mac OS X 
earlier than v10.4:
1 Connect iPod classic to your computer.
2 Open iSync and choose Devices > Add Device. You need to do this step only the first 
time you use iSync with iPod classic.
3 Select iPod classic and click Sync Now. iSync puts information from iCal and Mac 
Address Book onto iPod classic. 
The next time you want to sync iPod classic, you can simply open iSync and click Sync 
Now. You can also choose to have iPod classic sync automatically when you connect it.
Note:  iSync syncs information from your computer with iPod classic. You can’t use iSync 
to sync information from iPod classic to your computer.
To sync contacts or calendars using Windows Address Book or Microsoft Outlook for 
Windows:
1 Connect iPod classic to your computer.
2 In iTunes, select iPod classic in the device list and click the Contacts tab.
3 Do one of the following:
Â To sync contacts, in the Contacts section, select “Sync contacts from” and choose 
Windows Address Book or Microsoft Outlook from the pop-up menu. Then select 
which contact information you want to sync.
Â To sync calendars from Microsoft Outlook, in the Calendars section, select “Sync 
calendars from Microsoft Outlook.”
4 Click Apply.
You can also add contact and calendar information to iPod classic manually. iPod classic 
must be enabled as an external disk (see “Using iPod classic as an External Disk” on 
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To add contact information manually: 
1 Connect iPod classic and open your favorite email or contacts application. You can add 
contacts using Palm Desktop, Microsoft Outlook, Microsoft Entourage, and Eudora, 
among others.
2 Drag contacts from the application’s address book to the Contacts folder on 
iPod classic.
In some cases, you might need to export contacts and then drag the exported file or 
files to the Contacts folder. See the documentation for your email or contacts 
application.
To add appointments and other calendar events manually:
1 Export calendar events from any calendar application that uses the standard iCal 
format (filenames end in .ics) or vCal format (filenames end in .vcs).
2 Drag the files to the Calendars folder on iPod classic. 
Note:  To add to-do lists to iPod classic manually, save them in a calendar file with a .ics 
or .vcs extension.
To view contacts on iPod classic:
m Choose Extras > Contacts.
To sort contacts by first or last name:
m Choose Settings > Sort By, and press the Center button to choose First or Last.
To view calendar events:
m Choose Extras > Calendars.
To view to-do lists:
m Choose Extras > Calendars > To Do’s.
Storing and Reading Notes
You can store and read text notes on iPod classic if it’s enabled as an external disk 
(see page 49).
1 In any word-processing application, save a document as a text (.txt) file.
2 Place the file in the Notes folder on iPod classic.
To view notes:
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Recording Voice Memos
You can record voice memos using the optional Apple Earphones with Remote and Mic 
or an optional iPod classic–compatible microphone (available for purchase at 
www.apple.com/ipodstore or your local Apple store). You can store voice memos on 
iPod classic and sync them with your computer. You can set voice memo quality to 
Low or High.
Note:  Voice memos can’t be longer than two hours. If you record for more than two 
hours, iPod classic automatically starts a new voice memo to continue your recording.
To record a voice memo:
1 Connect the Apple Earphones with Remote and Mic to iPod classic, or connect a 
microphone to the Dock connector port on iPod classic.
The Voice Memos item appears in the main menu.
2 To begin recording, choose Voice Memos > Start Recording. 
3 Speak while wearing the Apple Earphones with Remote and Mic, or hold the 
microphone a few inches from your mouth and speak. To pause recording, press the 
Play/Pause button.
Choose Resume to continue recording.
4 When you finish, choose Stop and Save. Your saved recording is listed by date and time.
To play a recording:
m Choose Extras > Voice Memos and select the recording.
Note:  You won’t see a Voice Memos menu item if you’ve never connected a 
microphone or the Apple Earphones with Remote and Mic to iPod classic.
To sync voice memos with your computer:
Voice memos are saved in the Voice Memos application on iPod classic in the WAV file 
format. If you enable iPod classic for disk use, you can drag voice memos from the 
folder to copy them.
If iPod classic is set to sync songs automatically (see “Syncing Music Automatically” on 
page 22) and you record voice memos, the voice memos are automatically synced 
to a playlist in iTunes (and removed from iPod classic) when you connect iPod classic. 
You see the new Voice Memos playlist in the list of playlists on the left side of the 
iTunes window.58 Chapter 6    More Settings, Extra Features, and Accessories 
Learning About iPod classic Accessories
iPod classic comes with some accessories, and many other accessories are available. To 
purchase iPod classic accessories, go to www.apple.com/ipodstore. 
Available accessories include:
Â iPod Radio Remote
Â Apple Universal Dock
Â Apple Component AV Cable
Â Apple Composite AV Cable
Â Apple USB Power Adapter 
Â Apple Earphones with Remote and Mic
Â Apple In-Ear Headphones with Remote and Mic
Â iPod Socks
To use the earphones included with iPod classic:
m Plug the earphones into the Headphones port. Then place the earbuds in your ears. 
WARNING:  Permanent hearing loss may occur if earbuds or headphones are used 
at high volume. You can adapt over time to a higher volume of sound that may sound 
normal but can be damaging to your hearing. If you experience ringing in your 
ears or muffled speech, stop listening and have your hearing checked. The louder the 
volume, the less time is required before your hearing could be affected. Hearing 
experts suggest that to protect your hearing:
Â Limit the amount of time you use earbuds or headphones at high volume.
Â Avoid turning up the volume to block out noisy surroundings. 
Â Turn the volume down if you can’t hear people speaking near you.
For information about setting a maximum volume limit on iPod classic, see “Setting 
the Maximum Volume Limit” on page 36.
The earphone
cord is adjustable.7
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7 Tips and Troubleshooting
Most problems with iPod classic can be solved quickly by 
following the advice in this chapter.
General Suggestions
Most problems with iPod classic can be solved by resetting it. First, make sure 
iPod classic is charged.
To reset iPod classic:
1 Toggle the Hold switch on and off (slide it to HOLD and then back again).
2 Press and hold the Menu and Center buttons for at least 6 seconds, until the 
Apple logo appears.
If iPod classic won’t turn on or respond
Â Make sure the Hold switch isn’t set to HOLD.
Â The iPod classic battery might need to be recharged. Connect iPod classic to your 
computer or to an Apple USB Power Adapter and let the battery recharge. Look for 
the lightning bolt icon on the iPod classic screen to verify that iPod classic is 
receiving a charge.
The 5 Rs:  Reset, Retry, Restart, Reinstall, Restore
Remember these five basic suggestions if you have a problem with iPod classic. Try 
these steps one at a time until your issue is resolved. If one of the following doesn’t 
help, read on for solutions to specific problems. 
Â Reset iPod classic. See “General Suggestions,” below.
Â Retry with a different USB port if you cannot see iPod classic in iTunes.
Â Restart your computer, and make sure you have the latest software updates 
installed.
Â Reinstall iTunes software from the latest version on the web.
Â Restore iPod classic. See “Updating and Restoring iPod Software” on page 65.60 Chapter 7    Tips and Troubleshooting 
To charge the battery, connect iPod classic to a USB 2.0 on your computer. 
Connecting iPod classic to a USB port on your keyboard won’t charge the battery, 
unless your keyboard has a high-powered USB 2.0 port.
Â Try the 5 Rs, one by one, until iPod classic responds.
If you want to disconnect iPod classic, but you see the message “Connected” or 
“Sync in Progress”
Â If iPod classic is syncing music, wait for it to complete.
Â Select iPod classic in the device list and click the Eject (C) button.
Â If iPod classic disappears from the device list, but you still see the “Connected” or 
“Sync in Progress” message on the iPod classic screen, disconnect iPod classic.
Â If iPod classic doesn’t disappear from the device list, drag the iPod classic icon from 
the desktop to the Trash (if you’re using a Mac) or, if you’re using a Windows PC, eject 
the device in My Computer or click the Safely Remove Hardware icon in the system 
tray and select iPod classic. If you still see the “Connected” or “Sync in Progress” 
message, restart your computer and eject iPod classic again.
If iPod classic isn’t playing music
Â Make sure the Hold switch isn’t set to HOLD.
Â Make sure the headphone connector is pushed in all the way.
Â Make sure the volume is set properly. A maximum volume limit might have been set. 
You can change or remove it by using Settings > Volume Limit. See “Setting the 
Maximum Volume Limit” on page 36.
Â iPod classic might be paused. Try pressing the Play/Pause button.
Â Make sure you’re using iTunes 9.0 or later (go to www.apple.com/ipod/start). Songs 
purchased from the iTunes Store using earlier versions of iTunes won’t play on 
iPod classic until you upgrade iTunes.
Â If you’re using the iPod Universal Dock, make sure the iPod classic is seated firmly in 
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If you connect iPod classic to your computer and nothing happens
Â Make sure you have installed the latest iTunes software from 
www.apple.com/ipod/start.
Â Try connecting to a different USB port on your computer. 
Note:  A USB 2.0 port is recommended to connect iPod classic. USB 1.1 is significantly 
slower than USB 2.0. If you have a Windows PC that doesn’t have a USB 2.0 port, in 
some cases you can purchase and install a USB 2.0 card. For more information, go to 
www.apple.com/ipod. 
Â iPod classic might need to be reset (see page 59). 
Â If you’re connecting iPod classic to a portable or laptop computer using the iPod 
Dock Connector to USB 2.0 Cable, connect the computer to a power outlet before 
connecting iPod classic.
Â Make sure you have the required computer and software. See “If you want to doublecheck the system requirements” on page 64.
Â Check the cable connections. Unplug the cable at both ends and make sure no foreign 
objects are in the USB ports. Then plug the cable back in securely. Make sure the 
connectors on the cables are oriented correctly. They can be inserted only one way.
Â Try restarting your computer.
Â If none of the previous suggestions solves your problems, you might need to restore 
iPod classic software. See “Updating and Restoring iPod Software” on page 65.
If iPod classic displays a “Connect to Power” message
This message may appear if iPod classic is exceptionally low on power and the battery 
needs to be charged before iPod classic can communicate with your computer. To 
charge the battery, connect iPod classic to a USB 2.0 port on your computer. 
Leave iPod classic connected to your computer until the message disappears and 
iPod classic appears in iTunes or the Finder. Depending on how depleted the battery is, 
you may need to charge iPod classic for up to 30 minutes before it will start up. 
To charge iPod classic more quickly, use the optional Apple USB Power Adapter.
Note:  Connecting iPod classic to a USB port on your keyboard won’t charge the 
battery, unless your keyboard has a high-powered USB 2.0 port. 62 Chapter 7    Tips and Troubleshooting 
If iPod classic displays a “Use iTunes to restore” message
Â Make sure you have the latest version of iTunes on your computer (download it from 
www.apple.com/ipod/start).
Â Connect iPod classic to your computer. When iTunes opens, follow the onscreen 
prompts to restore iPod classic. 
Â If restoring iPod classic doesn’t solve the problem, iPod classic may need to be 
repaired. You can arrange for service at the iPod Service & Support website:
www.apple.com/support/ipod
If songs or data sync more slowly over USB 2.0
Â If you sync a large number of songs or amount of data using USB 2.0 and the 
iPod classic battery is low, iPod classic syncs the information at a reduced speed in 
order to conserve battery power.
Â If you want to sync at higher speeds, you can stop syncing and keep the iPod classic 
connected so that it can recharge, or connect it to the optional iPod USB 2.0 Power 
Adapter. Let iPod classic charge for about an hour, and then resume syncing your 
music or data.
If you can’t add a song or other item to iPod classic
The song may have been encoded in a format that iPod classic doesn’t support. The 
following audio file formats are supported by iPod classic. These include formats for 
audiobooks and podcasting:
Â AAC (M4A, M4B, M4P, up to 320 Kbps)
Â Apple Lossless (a high-quality compressed format)
Â HE-AAC
Â MP3 (up to 320 Kbps)
Â MP3 Variable Bit Rate (VBR)
Â WAV
Â AA (audible.com spoken word, formats 2, 3, and 4)
Â AIFF
A song encoded using Apple Lossless format has full CD-quality sound, but takes up 
only about half as much space as a song encoded using AIFF or WAV format. The same 
song encoded in AAC or MP3 format takes up even less space. When you import music 
from a CD using iTunes, it’s converted to AAC format by default.
Using iTunes for Windows, you can convert nonprotected WMA files to AAC or MP3 
format. This can be useful if you have a library of music encoded in WMA format. 
iPod classic doesn’t support WMA, MPEG Layer 1, MPEG Layer 2 audio files, or 
audible.com format 1.
If you have a song in iTunes that isn’t supported by iPod classic, you can convert it to 
a format iPod classic supports. For more information, see iTunes Help.Chapter 7    Tips and Troubleshooting 63
If iPod classic displays a “Connect to iTunes to activate Genius” message
You haven’t activated Genius in iTunes, or you haven’t synced iPod classic since you 
activated Genius in iTunes. For more information, see page 19 or iTunes Help.
If iPod classic displays a “Genius is not available for the selected song” message
Genius is activated but doesn’t recognize the song you selected to start a Genius 
playlist. New songs are added to the iTunes Store Genius database regularly, so try 
again later.
If you accidentally set iPod classic to use a language you don’t understand
You can reset the language.
1 Press and hold Menu until the main menu appears.
2 Choose the sixth menu item (Settings).
3 Choose the last menu item (Reset Settings).
4 Choose the left item (Reset) and select a language.
Other iPod classic settings, such as song repeat, are also reset.
Note:  If you added or removed items from the iPod classic main menu (see “Adding or 
Removing Items in the Main Menu” on page 8) the Settings menu item may be 
in a different place. If you can’t find the Reset Settings menu item, you can restore 
iPod classic to its original state and choose a language you understand. See “Updating 
and Restoring iPod Software” on page 65.
If you can’t see videos or photos on your TV
Â You must use RCA-type cables made specifically for iPod classic, such as the 
Apple Component or Apple Composite AV cables, to connect iPod classic to 
your TV. Other similar RCA-type cables won’t work.
Â Make sure your TV is set to display images from the correct input source (see the 
documentation that came with your TV for more information).
Â Make sure all cables are connected correctly (see “Watching Videos on a TV 
Connected to iPod classic” on page 41).
Â Make sure the yellow end of the Apple Composite AV Cable is connected to the 
video port on your TV.
Â If you’re trying to watch a video, go to Videos > Settings and set TV Out to On, and 
then try again. If you’re trying to view a slideshow, go to Photos > Slideshow Settings 
and set TV Out to On, and then try again.
Â If that doesn’t work, go to Videos > Settings (for video) or Photos > Settings (for a 
slideshow) and set TV Signal to PAL or NTSC, depending on which type of TV you 
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If you want to double-check the system requirements
To use iPod classic, you must have:
Â One of the following computer configurations:
Â A Mac with a USB 2.0 port
Â A Windows PC with a USB 2.0 or a USB 2.0 card installed
Â One of the following operating systems:
Â Mac OS X v10.4.11 or later
Â Windows Vista
Â Windows XP (Home or Professional) with Service Pack 3 or later
Â iTunes 9.0 or later (iTunes can be downloaded from www.apple.com/ipod/start)
If your Windows PC doesn’t have a USB 2.0 port, you can purchase and install a USB 2.0 
card. For more information about cables and compatible USB cards, go to 
www.apple.com/ipod.
On the Mac, iPhoto 4.0.3 or later is recommended for adding photos and albums to 
iPod classic. This software is optional. iPhoto might already be installed on your Mac. 
Check the Applications folder. If you have iPhoto 4 you can update it by choosing 
Apple () > Software Update. 
On a Windows PC, iPod classic can sync photo collections automatically from Adobe 
Photoshop Album 2.0 or later, and Adobe Photoshop Elements 3.0 or later, available at 
www.adobe.com. This software is optional. 
On both Mac and Windows PC, iPod classic can sync digital photos from folders on 
your computer’s hard disk.
If you want to use iPod classic with a Mac and a Windows PC
If you’re using iPod classic with a Mac and you want to use it with a Windows PC, you 
must restore the iPod software for use with the PC (see “Updating and Restoring iPod 
Software” on page 65). Restoring the iPod software erases all data from iPod classic, 
including all songs.
You cannot switch from using iPod classic with a Mac to using it with a Windows PC 
without erasing all data on iPod classic.
If you lock the iPod classic screen and can’t unlock it
Normally, if you can connect iPod classic to the computer it’s authorized to work with, 
iPod classic automatically unlocks. If the computer authorized to work with iPod classic 
is unavailable, you can connect iPod classic to another computer and use iTunes to 
restore iPod software. See the next section for more information.
If you want to change the screen lock combination and you can’t remember the current 
combination, you must restore the iPod software and then set a new combination.Chapter 7    Tips and Troubleshooting 65
Updating and Restoring iPod Software
You can use iTunes to update or restore iPod software. It’s recommended that you 
update iPod classic to use the latest software. You can also restore the software, which 
puts iPod classic back to its original state.
Â If you choose to update, the software is updated, but your settings and songs aren’t 
affected. 
Â If you choose to restore, all data is erased from iPod classic, including songs, videos, 
files, contacts, photos, calendar information, and any other data. All iPod classic 
settings are restored to their original state.
To update or restore iPod classic:
1 Make sure you have an Internet connection and have installed the latest version of 
iTunes from www.apple.com/ipod/start.
2 Connect iPod classic to your computer.
3 In iTunes, select iPod classic in the device list and click the Summary tab.
The Version section tells you whether iPod classic is up to date or needs a newer 
version of the software. 
4 Click Update to install the latest version of the software.
5 If necessary, click Restore to restore iPod classic to its original settings (this erases all 
data from iPod classic). Follow the onscreen instructions to complete the restore 
process.8
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8 Safety and Cleaning
Read the following important safety and handling 
information for Apple iPods.
Keep the iPod classic User Guide handy for future reference.
Important Safety Information
Proper handling  Do not bend, drop, crush, puncture, incinerate, or open iPod classic. 
Water and wet locations  Do not use iPod classic in rain, or near washbasins or other 
wet locations. Take care not to spill any food or liquid into iPod classic. In case 
iPod classic gets wet, unplug all cables, turn iPod classic off, and slide the Hold switch 
to HOLD before cleaning, and allow it to dry thoroughly before turning it on again.
iPod classic repairs  Never attempt to repair iPod classic yourself. If iPod classic has 
been submerged in water, punctured, or subjected to a severe fall, do not use it 
until you take it to an Apple Authorized Service Provider. iPod classic does not 
contain any user-serviceable parts. For service information, choose iPod Help from 
the Help menu in iTunes or go to www.apple.com/support/ipod. The rechargeable 
battery in iPod classic should be replaced only by an Apple Authorized Service Provider. 
For more information about battery replacement service, go to 
www.apple.com/support/ipod/service/battery.
± To avoid injury, read all safety information below and operating instructions 
before using iPod classic. 
WARNING:  Failure to follow these safety instructions could result in fire, electric shock, 
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Apple USB Power Adapter (available separately)  If you use the Apple USB Power 
Adapter (sold separately at www.apple.com/ipodstore) to charge iPod classic, make 
sure that the power adapter is fully assembled before you plug it into a power outlet. 
Then insert the Apple USB Power Adapter firmly into the power outlet. Do not connect 
or disconnect the Apple USB Power Adapter with wet hands. Do not use any power 
adapter other than an Apple iPod power adapter to charge iPod classic.
The iPod USB Power Adapter may become warm during normal use. Always allow 
adequate ventilation around the iPod USB Power Adapter and use care when handling.
Unplug the iPod USB Power Adapter if any of the following conditions exist:
Â The power cord or plug has become frayed or damaged.
Â The adapter is exposed to rain, liquids, or excessive moisture.
Â The adapter case has become damaged.
Â You suspect the adapter needs service or repair.
Â You want to clean the adapter.
Hearing damage  Permanent hearing loss may occur if earbuds or headphones are 
used at high volume. Set the volume to a safe level. You can adapt over time to a 
higher volume of sound that may sound normal but can be damaging to your hearing. 
If you experience ringing in your ears or muffled speech, stop listening and have your 
hearing checked. The louder the volume, the less time is required before your hearing 
could be affected. Hearing experts suggest that to protect your hearing:
Â Limit the amount of time you use earbuds or headphones at high volume.
Â Avoid turning up the volume to block out noisy surroundings.
Â Turn the volume down if you can’t hear people speaking near you.
For information about how to set a maximum volume limit on iPod classic, see “Setting 
the Maximum Volume Limit” on page 36.
Headphones safety  Use of earphones while operating a vehicle is not recommended 
and is illegal in some areas. Check and obey the applicable laws and regulations on the 
use of earphones while operating a vehicle. Be careful and attentive while driving. Stop 
listening to your audio device if you find it disruptive or distracting while operating any 
type of vehicle or performing another activity that requires your full attention.68 Chapter 8    Safety and Cleaning 
Seizures, blackouts, and eye strain  A small percentage of people may be susceptible 
to blackouts or seizures (even if they have never had one before) when exposed to 
flashing lights or light patterns such as when playing games or watching video. If you 
have experienced seizures or blackouts or have a family history of such occurrences, 
you should consult a physician before playing games (if available) or watching video on 
iPod classic. Discontinue use and consult a physician if you experience: convulsion, eye 
or muscle twitching, loss of awareness, involuntary movements, or disorientation. To 
reduce the risk of blackout, seizures, and eyestrain, avoid prolonged use, hold 
iPod classic some distance from your eyes, use iPod classic in a well lit room, and take 
frequent breaks.
Repetitive motion  When you perform repetitive activities such as playing games on 
iPod classic, you may experience occasional discomfort in your hands, arms, shoulders, 
neck, or other parts of your body. Take frequent breaks and, if you have discomfort 
during or after such use, stop use and see a physician.
Important Handling Information
Carrying iPod classic  iPod classic contains sensitive components, including, in some 
cases, a hard drive. Do not bend, drop, or crush iPod classic. If you are concerned about 
scratching iPod classic, you can use one of the many cases sold separately.
Using connectors and ports  Never force a connector into a port. Check for 
obstructions on the port. If the connector and port don’t join with reasonable ease, 
they probably don’t match. Make sure that the connector matches the port and that 
you have positioned the connector correctly in relation to the port.
Keeping iPod classic within acceptable temperatures  Operate iPod classic in a place 
where the temperature is always between 0º and 35º C (32º to 95º F). iPod classic play 
time might temporarily shorten in low-temperature conditions.
Store iPod classic in a place where the temperature is always between -20º and 45º C 
(-4º to 113º F). Don’t leave iPod classic in your car, because temperatures in parked cars 
can exceed this range.
When you’re using iPod classic or charging the battery, it is normal for iPod classic to 
get warm. The exterior of iPod classic functions as a cooling surface that transfers heat 
from inside the unit to the cooler air outside.
NOTICE:  Failure to follow these handling instructions could result in damage to 
iPod classic or other property.Chapter 8    Safety and Cleaning 69
Keeping the outside of iPod classic clean To clean iPod classic, unplug all cables, 
turn iPod classic off, and slide the Hold switch to HOLD. Then use a soft, slightly 
damp, lint-free cloth. Avoid getting moisture in openings. Don’t use window cleaners, 
household cleaners, aerosol sprays, solvents, alcohol, ammonia, or abrasives to clean 
iPod classic.
Disposing of iPod classic properly  For information about the proper disposal of 
iPod classic, including other important regulatory compliance information, see 
“Regulatory Compliance Information” on page 71.9
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9 Learning More, Service, 
and Support 
You can find more information about using iPod classic in 
onscreen help and on the web.
The following table describes where to get more iPod-related software and service 
information.
To learn about Do this
Service and support, 
discussions, tutorials, and 
Apple software downloads
Go to:  www.apple.com/support/ipod
Using iTunes Open iTunes and choose Help > iTunes Help. 
For an online iTunes tutorial (available in some areas only), go to:   
www.apple.com/support/itunes
Using iPhoto (on Mac OS X) Open iPhoto and choose Help > iPhoto Help.
Using iSync (on Mac OS X) Open iSync and choose Help > iSync Help.
Using iCal (on Mac OS X) Open iCal and choose Help > iCal Help.
The latest information about 
iPod classic
Go to:  www.apple.com/ipodclassic
Registering iPod classic To register iPod classic, install iTunes on your computer and 
connect iPod classic.
Finding the iPod classic serial 
number
Look at the back of iPod classic or choose Settings > About and 
press the Center button. In iTunes (with iPod classic connected to 
your computer), select iPod classic in the device list and click the 
Settings tab.
Obtaining warranty service First follow the advice in this booklet, the onscreen help, and 
online resources. Then go to:  
www.apple.com/support/ipod/service    71
Regulatory Compliance Information
FCC Compliance Statement
This device complies with part 15 of the FCC rules. 
Operation is subject to the following two conditions: 
(1) This device may not cause harmful interference, 
and (2) this device must accept any interference 
received, including interference that may cause 
undesired operation. See instructions if interference 
to radio or TV reception is suspected.
Radio and TV Interference
This computer equipment generates, uses, and can 
radiate radio-frequency energy. If it is not installed 
and used properly—that is, in strict accordance with 
Apple’s instructions—it may cause interference with 
radio and TV reception.
This equipment has been tested and found to 
comply with the limits for a Class B digital device in 
accordance with the specifications in Part 15 of FCC 
rules. These specifications are designed to provide 
reasonable protection against such interference 
in a residential installation. However, there is 
no guarantee that interference will not occur in 
a particular installation.
You can determine whether your computer system is 
causing interference by turning it off. If the 
interference stops, it was probably caused by the 
computer or one of the peripheral devices.
If your computer system does cause interference to 
radio or TV reception, try to correct the interference 
by using one or more of the following measures:
Â Turn the TV or radio antenna until the interference 
stops.
Â Move the computer to one side or the other of the 
TV or radio.
Â Move the computer farther away from the TV or 
radio.
Â Plug the computer in to an outlet that is on a 
different circuit from the TV or radio. (That is, make 
certain the computer and the TV or radio are on 
circuits controlled by different circuit breakers or 
fuses.)
If necessary, consult an Apple Authorized Service 
Provider or Apple. See the service and support 
information that came with your Apple product. Or, 
consult an experienced radio/TV technician for 
additional suggestions.
Important:  Changes or modifications to this product 
not authorized by Apple Inc. could void the EMC 
compliance and negate your authority to operate 
the product.
This product was tested for EMC compliance under 
conditions that included the use of Apple peripheral 
devices and Apple shielded cables and connectors 
between system components. 
It is important that you use Apple peripheral devices 
and shielded cables and connectors between system 
components to reduce the possibility of causing 
interference to radios, TV sets, and other electronic 
devices. You can obtain Apple peripheral devices and 
the proper shielded cables and connectors through 
an Apple Authorized Reseller. For non-Apple 
peripheral devices, contact the manufacturer or 
dealer for assistance. 
Responsible party (contact for FCC matters only):
Apple Inc. Corporate Compliance
1 Infinite Loop, MS 26-A 
Cupertino, CA 95014
Industry Canada Statement
This Class B device meets all requirements of the 
Canadian interference-causing equipment 
regulations.
Cet appareil numérique de la classe B respecte 
toutes les exigences du Règlement sur le matériel 
brouilleur du Canada.
VCCI Class B Statement
Korea Class B Statement72    
Russia
European Community
Disposal and Recycling Information
Your iPod must be disposed of properly according to 
local laws and regulations. Because this product 
contains a battery, the product must be disposed of 
separately from household waste. When your iPod 
reaches its end of life, contact Apple or your local 
authorities to learn about recycling options. 
For information about Apple’s recycling program, 
go to:  www.apple.com/environment/recycling
Deutschland:  Dieses Gerät enthält Batterien. Bitte 
nicht in den Hausmüll werfen. Entsorgen Sie dieses 
Gerätes am Ende seines Lebenszyklus entsprechend 
der maßgeblichen gesetzlichen Regelungen.
Nederlands:  Gebruikte batterijen kunnen worden 
ingeleverd bij de chemokar of in een speciale 
batterijcontainer voor klein chemisch afval (kca) 
worden gedeponeerd.
China:
Taiwan:  
European Union—Disposal Information:  
This symbol means that according to local laws and 
regulations your product should be disposed of 
separately from household waste. When this product 
reaches its end of life, take it to a collection point 
designated by local authorities. Some collection 
points accept products for free. The separate 
collection and recycling of your product at the time 
of disposal will help conserve natural resources and 
ensure that it is recycled in a manner that protects 
human health and the environment.
Union Européenne—informations sur l’élimination
Le symbole ci-dessus signifie que vous devez vous 
débarasser de votre produit sans le mélanger avec 
les ordures ménagères, selon les normes et la 
législation de votre pays. Lorsque ce produit n’est 
plus utilisable, portez-le dans un centre de 
traitement des déchets agréé par les autorités 
locales. Certains centres acceptent les produits 
gratuitement. Le traitement et le recyclage séparé de 
votre produit lors de son élimination aideront à 
préserver les ressources naturelles et à protéger 
l’environnement et la santé des êtres humains.
Europäische Union—Informationen zur Entsorgung
Das Symbol oben bedeutet, dass dieses Produkt 
entsprechend den geltenden gesetzlichen 
Vorschriften und getrennt vom Hausmüll entsorgt 
werden muss. Geben Sie dieses Produkt zur 
Entsorgung bei einer offiziellen Sammelstelle ab. Bei 
einigen Sammelstellen können Produkte zur 
Entsorgung unentgeltlich abgegeben werden. Durch 
das separate Sammeln und Recycling werden die 
natürlichen Ressourcen geschont und es ist 
sichergestellt, dass beim Recycling des Produkts alle 
Bestimmungen zum Schutz von Gesundheit und 
Umwelt beachtet werden.    73
Unione Europea—informazioni per l’eliminazione
Questo simbolo significa che, in base alle leggi e alle 
norme locali, il prodotto dovrebbe essere eliminato 
separatamente dai rifiuti casalinghi. Quando il 
prodotto diventa inutilizzabile, portarlo nel punto di 
raccolta stabilito dalle autorità locali. Alcuni punti di 
raccolta accettano i prodotti gratuitamente. La 
raccolta separata e il riciclaggio del prodotto al 
momento dell’eliminazione aiutano a conservare le 
risorse naturali e assicurano che venga riciclato in 
maniera tale da salvaguardare la salute umana e 
l’ambiente.
Europeiska unionen—uttjänta produkter
Symbolen ovan betyder att produkten enligt lokala 
lagar och bestämmelser inte får kastas tillsammans 
med hushållsavfallet. När produkten har tjänat ut 
måste den tas till en återvinningsstation som utsetts 
av lokala myndigheter. Vissa återvinningsstationer 
tar kostnadsfritt hand om uttjänta produkter. Genom 
att låta den uttjänta produkten tas om hand för 
återvinning hjälper du till att spara naturresurser och 
skydda hälsa och miljö.
Battery Replacement and Disposal for 
iPod classic
The rechargeable battery in iPod classic should be 
replaced only by an Apple Authorized Service 
Provider. For battery replacement services, go to: 
www.apple.com/support/ipod/service/battery
When iPod classic reaches its end of life, contact 
local authorities to learn about disposal and 
recycling options, or simply drop it off at your local 
Apple retail store or return it to Apple. The battery 
will be removed and recycled in an environmentally 
friendly manner. For more information, go to:
www.apple.com/environment/recycling
Apple and the Environment 
At Apple, we recognize our responsibility to 
minimize the environmental impacts of our 
operations and products.
For more information, go to:
www.apple.com/environment
© 2009 Apple Inc. All rights reserved. Apple, the Apple logo, iCal, iLife, 
iPhoto, iPod, iPod classic, iPod Socks, iTunes, Mac, Macintosh, and 
Mac OS are trademarks of Apple Inc., registered in the U.S. and other 
countries. Finder and Shuffle are trademarks of Apple Inc. iTunes Store 
is a service mark of Apple Inc., registered in the U.S. and other 
countries. Other company and product names mentioned herein may 
be trademarks of their respective companies.
Mention of third-party products is for informational purposes only 
and constitutes neither an endorsement nor a recommendation. 
Apple assumes no responsibility with regard to the performance or 
use of these products. All understandings, agreements, or warranties, 
if any, take place directly between the vendors and the prospective 
users. Every effort has been made to ensure that the information in 
this manual is accurate. Apple is not responsible for printing or 
clerical errors.
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Index
A
accessories for iPod  58
adding album artwork  18
adding menu items  8, 35
adding music
automatically  22
disconnecting iPod  11
from more than one computer  22, 23
manually  26
On-The-Go playlists  33
tutorial  70
adding photos
about  43
all or selected photos  45
from iPod to computer  47
full-resolution image  45
address book, syncing  54
Adobe Photoshop Album  64
Adobe Photoshop Elements  64
alarms
deleting  51
setting  51
album artwork
adding  18
viewing  30
albums
browsing by  34
alternate audio  41
artist, browsing by  33
audio, alternate  41
audiobooks
setting play speed  39
AV cables  41, 47
B
backlight
setting timer  9
turning on  6, 9
battery
charge states when disconnected  15
charging  13
rechargeable  15
replacing  15
very low  14, 61
viewing charge status  14
brightness setting  9
browsing
by album  34
by artist  33
quickly  9
songs  6
videos  6
with Cover Flow  31
buttons
Center  5
disabling with Hold switch  6
Eject  12
C
calendar events, syncing  54
Center button, using  5
Charging, Please Wait message  14, 61
charging the battery
about  13
using the iPod USB Power Adapter  14
using your computer  13
when battery very low  14, 61
cleaning iPod  69
Click Wheel
turning off the Click Wheel sound  9
using  5
clocks
adding for other time zones  51
settings  50
close captions  41
compilations  35
component AV cable  41, 47
composite AV cable  41, 47
computer
charging the battery  13
connecting iPod  10
getting photos from iPod  47
problems connecting iPod  61
requirements  64
connecting iPodIndex 75
about  10
charging the battery  13
to a TV  41, 47
Connect to Power message  14
contacts
sorting  56
syncing  54
controls
disabling with Hold switch  7
using  5
converting unprotected WMA files  62
Cover Flow  31
customizing the Music menu  35
D
data files, storing on iPod  49
date and time
setting  50
viewing  50
determining battery charge  15
diamond icon on scrubber bar  6
digital photos. See photos
disconnecting iPod
about  10
during music update  11
ejecting first  12
instructions  13
troubleshooting  60
disk, using iPod as  49
displaying time in title bar  50
downloading
See also adding; syncing
E
Eject button  12
ejecting before disconnecting  11, 12
external disk, using iPod as  49
F
fast-forwarding a song or video  6
features of iPod  4
file formats, supported  62
finding your iPod serial number  70
fit video to screen  41
FM radio  39
full-resolution images  45
G
games  52
Genius
about  16
creating a playlist  7, 29
playing a playlist  7, 32
saving a playlist  7
setting up in iTunes  19
syncing to iPod classic  23
troubleshooting  63
using on iPod  31
Genius Mixes
playing  7, 32
syncing to iPod classic  23
getting help  70
getting information about your iPod  10
H
handling information  66
hearing loss warning  58
help, getting  70
Hold switch  6, 7
I
iCal, getting help  70
images. See photos
importing contacts, calendars, and to-do lists. See 
syncing
iPhoto
getting help  43, 70
recommended version  64
iPod Dock  10
iPod Dock Connector  10
iPod Updater application  65
iPod USB power adapter  13
iSync, getting help  70
iTunes
ejecting iPod  12
getting help  70
setting not to open automatically  49
Sound Check  37
iTunes Library, adding songs  17
iTunes U  25, 38, 40
L
language
resetting  63
specifying  9
letterbox format  41
library, adding songs  17
lightning bolt on battery icon  14
locating your iPod serial number  70
locking iPod screen  53
lyrics
adding  18
viewing on iPod  30
M
Mac OS X operating system  64
main menu
adding or removing items  8
opening  5
settings  8, 3576 Index
main menu, returning to  6
managing iPod manually  26
manually adding  26
maximum volume limit, setting  36
memos, recording  57
menu items
adding or removing  8, 35
choosing  6
returning to main menu  6
returning to previous menu  6
modifying playlists  27
movies
syncing selected  24
See also videos
music
iPod not playing  60
rating  30
setting for slideshows  46
syncing  22
tutorial  70
See also adding music; songs
Music menu, customizing  35
music videos
syncing  23
N
navigating quickly  9
notes, storing and reading  56
Now Playing screen
moving to any point in a song or video  6
scrubber bar  6
shuffling songs or albums  29
NTSC TV  41, 46
O
On-The-Go playlists  33
operating system requirements  64
overview of iPod features  4
P
PAL TV  41, 46
pausing
a song  6
a video  6
phone numbers, syncing  54
photos
adding and viewing  43
deleting  45, 48
full-resolution  45
syncing  44, 45
viewing on iPod  45
playing
games  52
Genius Mixes  7, 32
songs  6
videos  6
playlists
adding songs  7, 27
Genius  7, 32
making on iPod  33
modifying  27
On-The-Go  33
plug on battery icon  14
podcasts
listening  38
updating  25
ports
RCA video and audio  41, 47
USB  64
power adapter safety  67
previous menu, returning to  6
problems. See troubleshooting
Q
quick navigation  9
R
radio accessory  39
random play  6
rating songs  30
RCA video and audio ports  41, 47
rechargeable batteries  15
recording voice memos  57
registering iPod  70
relative volume, playing songs at  37
removing menu items  8, 35
repairing iPod  66
replacing battery  15
replaying a song or video  6
requirements
computer  64
operating system  64
reset all settings  10
resetting iPod  6, 59
resetting the language  63
restore message  62
restoring iPod software  65
rewinding a song or video  6
S
Safely Remove Hardware icon  12
safety considerations
setting up iPod  66
safety information  66
saving On-The-Go playlists  33
screen lock  53
scrolling quickly  9
scrubber bar  6
searching
iPod  35Index 77
Select button. See Center button
serial number, locating  70
service and support  70
sets of songs. See playlists
setting combination for iPod  53
settings
about your iPod  10
alarm  51
audiobook play speed  39
backlight timer  9
brightness  9
Click Wheel sound  9
date and time  50
language  9
main menu  8, 35
PAL or NTSC TV  41, 46
playing songs at relative volume  37
repeating songs  34
reset all  10
shuffle songs  34
sleep timer  51
slideshow  46
TV  41
volume limit  36
shuffling songs on iPod  6, 34
sleep mode and charging the battery  13
sleep timer, setting  51
slideshows  46
software
getting help  70
iPhoto  64
iPod Updater  65
support versions  64
updating  65
songs
adding to On-The-Go playlists  7
browsing  6
entering names  18
fast-forwarding  6
pausing  6
playing  6
playing at relative volume  37
rating  30
repeating  34
replaying  6
rewinding  6
shuffling  6, 29, 34
skipping ahead  6
viewing lyrics  18
See also music
sorting contacts  56
Sound Check  37
standard TV  41
stopwatch  52
storing
data files on iPod  49
notes on iPod  56
subtitles  41
supported operating systems  64
suppressing iTunes from opening  49
syncing
address book  54
automatically  22
music  21
music videos  23
photos  44, 45
selected movies  24
to-do lists  54
videos  24
voice memos  57
T
time, displaying in title bar  50
timer, setting for backlight  9
time zones, clocks for  51
title bar, displaying time  50
to-do lists, syncing  54
transitions for slides  46
troubleshooting
connecting iPod to computer  61
cross-platform use  64
disconnecting iPod  60
Genius  63
iPod not playing music  60
iPod won’t respond  59
resetting iPod  59
restore message  62
safety considerations  66
setting incorrect language  63
slow syncing of music or data  62
software update and restore  65
TV slideshows  63
unlocking iPod screen  64
turning iPod on and off  6
tutorial  70
TV
connecting to iPod  41, 47
PAL or NTSC  41, 46
settings  41
viewing slideshows  42, 47
TV shows
See also videos
U
unlocking iPod screen  54, 64
unresponsive iPod  59
unsupported audio file formats  62
updating and restoring software  65
USB 2.0 port
requirements  64
slow syncing of music or data  6278 Index
USB port on keyboard  11, 60
Use iTunes to restore message in display  62
V
video captions  41
video podcasts
downloading  20
viewing on a TV  41
videos
adding to iPod  23
browsing  6
fast-forwarding  6
pausing  6
playing  6
purchasing  20
replaying  6
rewinding  6
skipping ahead  6
syncing  24
viewing on a TV  41
viewing on iPod  40
viewing album artwork  30
viewing lyrics  30
viewing music videos  40
viewing photos  45
viewing slideshows
on a TV  42, 47
on iPod  46
settings  46
troubleshooting  63
voice memos
recording  57
syncing with your computer  57
volume
changing  6
setting maximum limit  36
W
warranty service  70
widescreen TV  41
Windows
supported operating systems  64
troubleshooting  64
WMA files, converting  62
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1 iPod nano Basics
Read this chapter to learn about the features of iPod nano, 
how to use its controls, and more.
iPod nano at a Glance
Get to know the controls on iPod nano:
Headphones port
Menu
Previous/Rewind
Play/Pause
Hold switch
30-pin connector
Click Wheel
Next/Fast-forward 
Center button
Lens
Microphone Chapter 1    iPod nano Basics 5
What’s New in iPod nano
Â Larger, 2.2-inch display
Â Polished aluminum finish
Â A built-in video camera that lets you record video with special effects
Â An FM radio that lets you pause live radio and tag songs for purchase from the 
iTunes Store (radio tagging may not be available in some countries)
Â Internal speaker and microphone
Â A pedometer that records your workout history
Using iPod nano Controls
The controls on iPod nano are easy to find and use. Press any button to turn on 
iPod nano.
The first time you turn on iPod nano, the language menu appears. Use the Click Wheel 
to scroll to your language, and then press the Center button to choose it. The main 
menu appears in your language.
Use the Click Wheel and Center button to navigate through onscreen menus, play 
songs, change settings, and get information.
Move your thumb lightly around the Click Wheel to select a menu item. To choose the 
item, press the Center button.
To go back to the previous menu, press Menu.6 Chapter 1    iPod nano Basics 
Here’s what else you can do with iPod nano controls.
To Do this
Turn on iPod nano Press any button.
Turn off iPod nano Press and hold Play/Pause (’).
Turn on the backlight Press any button or use the Click Wheel.
Disable iPod nano controls
(so nothing happens if you press 
them accidentally)
Slide the Hold switch to HOLD (an orange bar appears).
Reset iPod nano
(if it isn’t responding)
Slide the Hold switch to HOLD and back again. Press Menu and the 
Center button at the same time for about 6 seconds, until the 
Apple logo appears.
Choose a menu item Use the Click Wheel to scroll to the item and press the Center 
button to choose.
Go back to the previous menu Press Menu.
Go directly to the main menu Press and hold Menu.
Access additional options Press and hold the Center button until a menu appears.
Browse for a song From the main menu, choose Music.
Browse for a video From the main menu, choose Videos.
Play a song or video Select the song or video and press the Center button or Play/Pause 
(’). iPod nano must be ejected from your computer to play songs 
and videos.
Pause a song or video Press Play/Pause (’) or unplug your headphones.
Change the volume From the Now Playing screen, use the Click Wheel.
Play all the songs in a playlist 
or album
Select the playlist or album and press Play/Pause (’).
Play all songs in random order From the main menu, choose Shuffle Songs.
Skip to a random song Shake iPod nano.
Enable or disable Shake for 
shuffling songs
Choose Settings > Playback, choose Shake, and then select Shuffle 
or Off.
Skip to any point in a song or 
video
From the Now Playing screen, press the Center button to show the 
scrubber bar (the playhead on the bar shows the current location), 
and then scroll to any point in the song or video.
Skip to the next song or 
chapter in an audiobook or 
podcast
Press Next/Fast-forward (‘).
Start a song or video over Press Previous/Rewind (]).
Fast-forward or rewind a song, 
video, or paused radio
Press and hold Next/Fast-forward (‘) or Previous/Rewind (]).
Add a song to the On-The-Go 
playlist
Play or select a song, and then press and hold the Center button 
until a menu appears. Select “Add to On-The-Go,” and then press 
the Center button.Chapter 1    iPod nano Basics 7
Play the previous song or 
chapter in an audiobook or 
podcast
Press Previous/Rewind (]) twice.
Create a Genius playlist Play or select a song, and then press and hold the Center button 
until a menu appears. Select Start Genius, and then press the 
Center button (Start Genius appears in the Now Playing screen only 
if there’s Genius data for the selected song).
Save a Genius playlist Create a Genius playlist, select Save Playlist then press the Center 
button.
Play a saved Genius playlist From the Playlist menu, select a Genius playlist, and then press 
Play/Pause (’).
Play a Genius Mix From the Music menu, choose Genius Mixes. Select a mix and then 
press Play/Pause (’).
Record video Choose Video Camera from the main menu. Press the Center 
button to start or stop recording.
Record video with special 
effects
Before recording video, press and hold the Center button to display 
effects, then use the Click Wheel to browse and press the Center 
button to select. Press the Center button again to start recording.
Play back recorded video Press the Center button to stop recording, then press Menu to 
enter the Camera Roll screen. Choose a video and press the Center 
button to play.
Watch recorded video From the Videos menu, choose Camera Videos, then select a video 
and press Play/Pause (’).
Listen to FM radio Choose Radio from the main menu.
Tune to an FM station Use the Click Wheel to browse the radio dial.
Seek FM stations When the radio dial is visible, press Next/Fast-forward (‘) or 
Previous/Rewind (]) to skip to the next or previous station. 
Not available if you save any stations as favorites.
Scan FM stations When the radio dial is visible, press and hold Next/Fast-forward 
(‘). Press the Center button to stop scanning.
Save an FM station as a favorite Press and hold the Center button until a menu appears, and then 
choose Add to Favorites.
Pause and resume live radio From any screen, press Play/Pause (’) while listening to the radio. 
Press Play/Pause (’) again to resume playing. Changing the radio 
station clears paused radio.
Switch between the radio dial 
and the Live Pause screen
Press the Center button.
Tag a song on the radio Press and hold the Center button to tag songs marked with a tag 
symbol. Sync with iTunes to preview and purchase tagged songs.
Use the pedometer From the Extras menu, choose Fitness, and then choose Pedometer. 
Press the Center button to start or stop a session.
To Do this8 Chapter 1    iPod nano Basics 
Disabling iPod nano Controls
If you don’t want to turn iPod nano on or activate controls accidentally, you can disable 
them with the Hold switch. The Hold switch disables all Click Wheel controls, and also 
disables functions that are activated by movement, such as shaking to shuffle and 
rotating to enter or exit Cover Flow. 
To disable iPod nano controls:
m Slide the Hold switch to HOLD (an orange bar appears).
If you disable the controls while using iPod nano, the song, playlist, podcast, or video 
that’s playing continues to play, and if the pedometer is turned on it continues 
counting steps. To stop or pause, slide the Hold switch to enable the controls again.
Record a voice memo From the Extras menu, choose Voice Memos. Press Play/Pause (’) 
to start or stop recording. Press the Center button to add a chapter 
markers.
Find the iPod nano serial 
number
From the main menu choose Settings > About and press the 
Center button until you see the serial number, or look on the back 
of iPod nano.
To Do thisChapter 1    iPod nano Basics 9
Using iPod nano Menus
When you turn on iPod nano, you see the main menu. Choose menu items to perform 
functions or go to other menus. Icons along the top of the screen show iPod nano 
status.
Display item Function
Menu title Displays the title of the current menu. The menu title doesn’t 
appear when the Lock icon appears.
Pedometer icon Appears when the pedometer is on.
Play icon The Play (“) icon appears when a song, video, or other item is 
playing. The Pause (1) icon appears when the item is paused.
Battery icon The Battery icon shows the approximate remaining battery charge.
Lock icon The Lock icon appears when the Hold switch is set to HOLD. This 
indicates that the iPod nano controls are disabled. When the Lock 
icon appears, it replaces the menu title.
Menu items Use the Click Wheel to scroll through menu items. Press the Center 
button to choose an item. An arrow next to a menu item indicates 
that it leads to another menu or screen.
Preview panel Displays album art, photos, and other information relating to the 
menu item selected.
Menu title
Pedometer icon Battery icon
Menu items
Preview panel
Play icon
Lock icon10 Chapter 1    iPod nano Basics 
Adding or Removing Items on the Main Menu
You might want to add often-used items to the iPod nano main menu. For example, 
you can add a Songs item to the main menu, so you don’t have to choose Music before 
you choose Songs.
To add or remove items on the main menu:
1 Choose Settings > General > Main Menu.
2 Select each item you want to appear in the main menu. A checkmark indicates which 
items have been added.
Turning Off the Preview Panel
The preview panel at the bottom of the main menu displays album art, photo 
thumbnails, available storage, and other information. You can turn it off to allow more 
space for menu items.
To turn the preview panel on or off:
m Choose Settings > General > Main Menu > Preview Panel, and then press the Center 
button to select On or Off.
The preview panel displays art for a category only if iPod nano contains at least five 
items with art in the category.
Setting the Font Size in Menus
iPod nano can display text in two different sizes, standard and large.
To set the font size:
m Choose Settings > General > Font Size, and then press the Center button to select 
Standard or Large.
Setting the Language
iPod nano can use different languages.
To set the language:
m Choose Settings > Language, and then choose a language.Chapter 1    iPod nano Basics 11
Setting the Backlight Timer
You can set the backlight to illuminate the screen for a certain amount of time when 
you press a button or use the Click Wheel. The default is 10 seconds.
To set the backlight timer:
m Choose Settings > General > Backlight, and then choose the time you want. Choose 
“Always On” to prevent the backlight from turning off (choosing this option decreases 
battery performance).
Setting the Screen Brightness
You can adjust the brightness of the iPod nano screen.
To set the screen brightness:
m Choose Settings > General > Brightness, and then use the Click Wheel to adjust 
the brightness.
You can also set the brightness during a slideshow or video. Press the Center button 
until the brightness slider appears, and then use the Click Wheel to adjust the 
brightness.
Turning Off the Click Wheel Sound
When you scroll through menu items, you can hear a clicking sound through the 
earphones or headphones and through the iPod nano internal speaker. If you like, 
you can turn off the Click Wheel sound.
To turn off the Click Wheel sound:
m Choose Settings > General and set Clicker to Off.
To turn the Click Wheel sound on again, set Clicker to On.
Scrolling Quickly Through Long Lists
You can scroll quickly through a long list by moving your thumb quickly on the 
Click Wheel.
Note:  Not all languages are supported.
To scroll quickly:
1 Move your thumb quickly on the Click Wheel, to display a letter of the alphabet on 
the screen.
2 Use the Click Wheel to navigate through the alphabet until you find the first letter of 
the item you’re looking for. 
Items beginning with a symbol or number appear after the letter Z.
3 Lift your thumb momentarily to return to normal scrolling.
4 Use the Click Wheel to navigate to the item you want.12 Chapter 1    iPod nano Basics 
Getting Information About iPod nano
You can get details about your iPod nano, such as the amount of space available, 
the number of songs, videos, photos, and other items, and the serial number, model, 
and software version.
To get information about iPod nano:
m Choose Settings > About, and press the Center button to cycle through the screens 
of information.
Resetting All Settings
You can reset all the items on the Settings menu to their default setting.
To reset all settings:
m Choose Settings > Reset Settings, and then choose Reset.
About the iPod nano Internal Speaker
With the iPod nano internal speaker, you can listen to any audio on iPod nano without 
earphones or headphones — except for the built-in FM radio, which uses the earphone 
or headphone cord as an antenna.
Connecting earphones or headphones to iPod nano disables the internal speaker. Any 
audio that’s playing continues to play, but only through the earphones or headphones.
If you disconnect the earphones or headphones while audio is playing, the audio 
pauses. To resume listening through the internal speaker, press Play/Pause (’). If you 
disconnect the earphones or headphones while the radio is playing or paused, the 
radio stops and any paused radio is cleared.
If you choose Video Camera or Voice Memos while audio is playing, the audio turns off.Chapter 1    iPod nano Basics 13
Connecting and Disconnecting iPod nano
You connect iPod nano to your computer to add music, videos, photos, and files to 
iPod nano, to import recorded videos and voice memos to your computer, and to 
charge the battery. Disconnect iPod nano when you’re done.
Important:  The battery doesn’t charge when your computer is in sleep.
Connecting iPod nano
To connect iPod nano to your computer:
m Plug the included Dock Connector to USB Cable into a high-powered USB 2.0 port on 
your computer, and then connect the other end to iPod nano.
If you have an iPod dock, you can connect the cable to a USB 2.0 port on your 
computer, connect the other end to the dock, and then put iPod nano in the dock.
Note:  The USB port on most keyboards doesn’t provide enough power to charge 
iPod nano. Connect iPod nano to a USB 2.0 port on your computer.
By default, iTunes syncs songs on iPod nano automatically when you connect it to your 
computer. When iTunes is finished, you can disconnect iPod nano. You can sync songs 
while your battery is charging.
If you connect iPod nano to a different computer and it’s set to sync music 
automatically, iTunes prompts you before syncing any music. If you click Yes, the songs 
and other audio files already on iPod nano will be erased and replaced with songs and 
other audio files on the computer iPod nano is connected to. For information about 
adding music to iPod nano and using iPod nano with more than one computer, see 
Chapter 2, “Setting Up iPod nano,” on page 19.
Disconnecting iPod nano
It’s important not to disconnect iPod nano while it’s syncing. You can see if it’s OK to 
disconnect iPod nano by looking at the iPod nano screen. Don’t disconnect iPod nano 
if you see the “Connected” or “Synchronizing” message, or you could damage files on 
iPod nano.14 Chapter 1    iPod nano Basics 
If you see one of these messages, you must eject iPod nano before disconnecting it:
If you see the main menu or a large battery icon, you can disconnect iPod nano.
If you set iPod nano to manage songs manually (see “Managing iPod nano Manually” 
on page 30) or enable iPod nano for disk use (see “Using iPod nano as an External Disk” 
on page 84), you must always eject iPod nano before disconnecting it.
If you accidentally disconnect iPod nano without ejecting it, reconnect iPod nano to 
your computer and sync again.Chapter 1    iPod nano Basics 15
To eject iPod nano:
m In iTunes, click the Eject (C) button next to iPod nano in the device list on the left side 
of the iTunes window.
You can safely disconnect iPod nano while either of these messages is displayed:
If you’re using a Mac, you can also eject iPod nano by dragging the iPod nano icon on 
the desktop to the Trash.
If you’re using a Windows PC, you can also eject iPod nano in My Computer or by clicking 
the Safely Remove Hardware icon in the Windows system tray and selecting iPod nano.
To disconnect iPod nano:
1 Unplug your earphones or headphones, if they’re attached.
2 Disconnect the cable from iPod nano. If iPod nano is in the dock, simply remove it. 16 Chapter 1    iPod nano Basics 
About the iPod nano Battery
iPod nano has an internal, non–user-replaceable battery. For best results, the first time 
you use iPod nano, let it charge for about three hours or until the battery icon in the 
status area of the display shows that the battery is fully charged. If iPod nano isn’t used 
for a while, the battery might need to be charged.
Note:  iPod nano continues to use battery power after it’s been turned off.
The iPod nano battery is 80-percent charged in about one and a half hours, and fully 
charged in about three hours. If you charge iPod nano while adding files, playing 
music, watching videos, or viewing a slideshow, it might take longer.
Charging the iPod nano Battery
You can charge the iPod nano battery in two ways:
Â Connect iPod nano to your computer.
Â Use the Apple USB Power Adapter, available separately. 
To charge the battery using your computer:
m Connect iPod nano to a USB 2.0 port on your computer. The computer must be turned 
on and not in sleep. 
If the battery icon on the iPod nano screen shows the Charging screen, the battery is 
charging. If it shows the Charged screen, the battery is fully charged.
If you don’t see the Charging screen, iPod nano might not be connected to a 
high-power USB port. Try another USB port on your computer. Chapter 1    iPod nano Basics 17
Important:  If a “Charging, Please Wait” or “Connect to Power” message appears on the 
iPod nano screen, the battery needs to be charged before iPod nano can communicate 
with your computer. See “If iPod nano displays a “Connect to Power” message” on 
page 88.
If you want to charge iPod nano when you’re away from your computer, you can 
purchase the Apple USB Power Adapter.
To charge the battery using the Apple USB Power Adapter:
1 Connect the AC plug adapter to the power adapter (they might already be connected).
2 Connect the Dock Connector to USB Cable to the power adapter, and plug the other 
end of the cable into iPod nano. 
3 Plug the power adapter into a working power outlet.
Understanding Battery States
When iPod nano isn’t connected to a power source, a battery icon in the top-right 
corner of the iPod nano screen shows approximately how much charge is left. 
Apple USB Power Adapter
(your adapter may look different)
iPod USB cable
Battery less than 20% charged
Battery about halfway charged
Battery fully charged18 Chapter 1    iPod nano Basics 
When iPod nano is connected to a power source, the battery icon changes to show 
that the battery is charging or fully charged.
You can disconnect and use iPod nano before it’s fully charged.
Note:  Rechargeable batteries have a limited number of charge cycles and might 
eventually need to be replaced. Battery life and number of charge cycles vary by use 
and settings. For information, go to www.apple.com/batteries.
Improving Battery Performance with Energy Saver
Energy Saver can extend the time between battery charges by turning off the 
iPod nano screen when you aren’t using the controls.
Energy Saver is turned on by default.
To turn Energy Saver on or off:
m Choose Settings > Playback > Energy Saver, and then select On or Off.
If you turn Energy Saver off, iPod nano displays the following information after the 
backlight turns off:
Turning off Energy Saver increases the rate of battery consumption.
Battery charging (lightning bolt)
Battery fully charged (plug)2
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2 Setting Up iPod nano
You use iTunes on your computer to set up iPod nano to play 
your music, video, and other media content. No setup is 
needed to record video or listen to FM radio.
Using iTunes
iTunes is the free software application you use to set up, organize, and manage your 
content on iPod nano. iTunes can sync music, audiobooks, podcasts, and more with 
iPod nano. If you don’t already have iTunes installed on your computer, you can 
download it at www.apple.com/downloads. iPod nano requires iTunes 9 or later.
iTunes is available for Mac and Windows.
You can use iTunes to import music from CDs and the Internet, buy songs and other 
audio and video from the iTunes Store, create personal compilations of your favorite 
songs (called playlists), sync them to iPod nano, and adjust iPod nano settings.
iTunes also has a feature called Genius that creates playlists and mixes of songs from 
your iTunes library that go great together. You can sync Genius playlists that you create 
in iTunes to iPod nano, and you can create Genius playlists and listen to Genius Mixes 
on iPod nano. To use Genius, you need an iTunes Store account.
iTunes has many other features. You can burn your own CDs that play in standard CD 
players (if your computer has a recordable CD drive); listen to streaming Internet radio; 
watch videos and TV shows; rate songs according to preference; and much more. 20 Chapter 2    Setting Up iPod nano 
For information about using these iTunes features, open iTunes and choose 
Help > iTunes Help.
If you already have iTunes 9 or later installed on your computer and you’ve set up your 
iTunes library, you can skip ahead to “Adding Music, Videos, and Other Content to 
iPod nano” on page 24.
If you want to get started recording video or listening to FM radio, you can set up 
iPod nano at a later time. To learn how to record video, see “Using the Video Camera” 
on page 52. For information about the FM radio, see “Listening to FM Radio” on 
page 58.
Setting Up Your iTunes Library
To listen to music and watch videos on iPod nano, you first need to get that music and 
video into iTunes on your computer.
Importing Music to iTunes
There are three ways of getting music and other audio into iTunes.
Purchase Songs and Download Podcasts Using the iTunes Store
If you have an Internet connection, you can easily purchase and download songs, 
albums, and audiobooks online using the iTunes Store. You can also subscribe to and 
download podcasts, and you can download free educational content from iTunes U.
To purchase music online using the iTunes Store, you set up a free iTunes account in 
iTunes, find the songs you want, and then buy them. If you already have an iTunes 
account (also called an Apple ID), you can use that account to sign in to the iTunes 
Store and buy songs.
You don’t need an iTunes Store account to download or subscribe to podcasts.
To enter the iTunes Store, open iTunes and click iTunes Store below Store on the left 
side of the iTunes window.
Add Songs Already on Your Computer to Your iTunes Library
If you have songs on your computer encoded in file formats that iTunes supports, you 
can easily add the songs to iTunes. To learn how to get songs from your computer into 
iTunes, open iTunes and choose Help > iTunes Help.
Using iTunes for Windows, you can convert nonprotected WMA files to AAC or MP3 
format. This can be useful if you have a library of music encoded in WMA format. 
For more information, open iTunes and choose Help > iTunes Help.Chapter 2    Setting Up iPod nano 21
Import Music From Your Audio CDs Into iTunes
iTunes can import music and other audio from your audio CDs. If you have an Internet 
connection, iTunes gets the names of the songs on the CD from the Internet (if 
available) and lists them in the iTunes window. When you add the songs to iPod nano, 
the song information is included. To learn how to import music from your CDs into 
iTunes, open iTunes and choose Help > iTunes Help.
Adding More Details to Your iTunes Library
Once you import your music into iTunes, you can add more details to your iTunes 
library. Most of these additional details appear on iPod nano when you add songs.
Enter Song Names and Other Information
If you don’t have an Internet connection, if song information isn’t available for music 
you import, or if you want to include additional information (such as composer names), 
you can enter the information manually. To learn how to enter song information, open 
iTunes and choose Help > iTunes Help.
Add Lyrics
You can enter song lyrics in plain text format into iTunes so that you can view the song 
lyrics on iPod nano while the song is playing. To learn how to enter lyrics, open iTunes 
and choose Help > iTunes Help.
For more information, see “Viewing Lyrics on iPod nano” on page 37.
Add Album Artwork
Music you purchase from the iTunes Store includes album artwork, which iPod nano 
can display. You can add album artwork automatically for music you’ve imported from 
CDs, if the CDs are available from the iTunes Store. You can add album artwork 
manually if you have the album art on your computer. To learn more about adding 
album artwork, open iTunes and choose Help > iTunes Help.
For more information, see “Viewing Album Artwork on iPod nano” on page 37.
Organizing Your Music
In iTunes, you can organize songs and other items into lists, called playlists, in any way 
you want. For example, you can create playlists with songs to listen to while exercising, 
or playlists with songs for a particular mood. 
You can create Smart Playlists that update automatically based on rules you define. 
When you add songs to iTunes that match the rules, they automatically get added to 
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You can turn on Genius in iTunes and create playlists of songs that go great together. 
Genius can also organize your music library automatically by sorting and grouping it 
into collections called Genius Mixes.
You can create as many playlists as you like, using any of the songs in your iTunes 
library. Adding a song to a playlist or later removing it doesn’t remove it from 
your library. 
To learn how to set up playlists in iTunes, open iTunes and choose Help > iTunes Help.
Note:  To create playlists on iPod nano when iPod nano isn’t connected to your 
computer, see “Creating On-The-Go Playlists on iPod nano” on page 41.
Turning On Genius in iTunes
Genius finds songs in your library that go great together in order to create Genius 
playlists and Genius Mixes.
A Genius playlist starts with a song that you select. To create the Genius playlist, iTunes 
then compiles a collection of songs that go great with the one you selected.
Genius Mixes are pre-selected compilations of songs that go great together, and are 
created for you by iTunes using songs from your library. Genius Mixes are designed to 
provide a different listening experience each time you play one. iTunes creates up to 
12 Genius Mixes, depending on the variety of music in your iTunes library.
To use Genius on iPod nano to create Genius playlists and Genius Mixes, you first need 
to turn on Genius in iTunes. To learn about turning on and using Genius in iTunes, open 
iTunes and choose Help > iTunes Help.
Genius playlists and Genius Mixes created in iTunes can be synced to iPod nano like 
any iTunes playlist. Genius Mixes can’t be added to iPod nano manually. See “Syncing 
Genius Playlists and Genius Mixes to iPod nano” on page 26.
Genius is a free service, but an iTunes Store account is required to use it (if you don’t 
have an account, you can set one up when you turn on Genius).
Importing Video to iTunes
There are several ways to import video into iTunes, described below.
Purchase or Rent Videos and Download Video Podcasts from the 
iTunes Store
To purchase videos—movies, TV shows, and music videos—or rent movies online from 
the iTunes Store (part of iTunes and available in some countries only), you sign in to 
your iTunes Store account, find the videos you want, and then buy or rent them.Chapter 2    Setting Up iPod nano 23
A rented movie expires 30 days after you rent it or 24 hours after you begin playing it 
(48 hours outside the U.S.), whichever comes first. Expired rentals are deleted 
automatically. These terms apply to U.S. rentals. Rental terms vary among countries.
To enter the iTunes Store, open iTunes and click iTunes Store below Store on the left 
side of the iTunes window.
You can view movie trailers or TV show previews by clicking the Preview button next 
to them.
Purchased videos appear when you select Movies or TV Shows (under Library) or 
Purchased (under Store) in the source list. Rented videos appear when you select 
Rented Movies (under Library).
Some items have other options, such as TV shows that let you buy a Season Pass for 
all episodes. 
Video podcasts appear along with other podcasts in the iTunes Store. You can 
subscribe to them and download them just as you would other podcasts. You don’t 
need an iTunes Store account to download podcasts. See “Purchase Songs and 
Download Podcasts Using the iTunes Store” on page 20.
Create Versions of Your Own Videos to Work with iPod nano
You can view other video files on iPod nano, such as videos you create in iMovie on a 
Mac or videos you download from the Internet. Import the video into iTunes, convert it 
for use with iPod nano, if necessary, and then add it to iPod nano.
iTunes supports many of the video formats that QuickTime supports. For more 
information, see “If you can’t add a song or other item to iPod nano” on page 89.
Some videos may be ready for use with iPod nano after you import them to iTunes. 
If you try to add a video to iPod nano (see “Syncing Videos Automatically” on page 27), 
and a message says the video can’t play on iPod nano, then you must convert the video 
for use with iPod nano.
Depending on the length and content of a video, converting it for use with iPod nano 
can take several minutes to several hours.
When you create a version of a video for use with iPod nano, the original video also 
remains in your iTunes library. 
For more about converting video for iPod nano, open iTunes and choose Help  > 
iTunes Help, or go to www.info.apple.com/kbnum/n302758.24 Chapter 2    Setting Up iPod nano 
Adding Music, Videos, and Other Content to iPod nano
After your music and video are imported and organized in iTunes, you can easily add 
them to iPod nano.
To manage how music, videos, photos, and other content are added to iPod nano from 
your computer, you connect iPod nano to your computer, and then use iTunes to 
choose iPod nano settings.
Connecting iPod nano to a Computer for the First Time
The first time you connect iPod nano to your computer (after installing iTunes), 
iTunes opens automatically and the iPod nano Setup Assistant appears:
To use the iPod nano Setup Assistant:
1 Enter a name for iPod nano. This is the name that will appear in the device list on the 
left side of the iTunes window.
2 Select your settings. Automatic syncing and VoiceOver are selected by default.
If you don’t want to enable VoiceOver at this time, deselect Enable VoiceOver. If you 
change your mind, you can enable VoiceOver any time you connect iPod nano to your 
computer. See “Setting Up VoiceOver” on page 32.
3 Click Done.
If you selected to enable VoiceOver during setup, follow any onscreen instructions for 
downloading and installing the VoiceOver Kit. For more information, see “Using 
VoiceOver in iPod nano” on page 44. To learn how to set up VoiceOver in iPod nano, 
see “Setting Up VoiceOver” on page 32.Chapter 2    Setting Up iPod nano 25
You can change the device name and settings any time you connect iPod nano to 
your computer.
After you click Done, the Summary pane appears. If you selected automatic syncing, 
iPod nano begins syncing.
Adding Content Automatically or Manually
There are two ways to add content to iPod nano:
Â Automatic syncing:  When you connect iPod nano to your computer, iPod nano is 
automatically updated to match the items in your iTunes library. You can sync all your 
songs, playlists, videos, and podcasts, or, if your entire iTunes library doesn’t fit on 
iPod nano, you can sync only selected items. You can sync iPod nano automatically 
with only one computer at a time.
Â Manually managing iPod nano:  When you connect iPod nano, you can drag items 
individually to iPod nano and delete them individually from iPod nano. You can add 
songs from more than one computer without erasing songs from iPod nano. When 
you manage music yourself, you must always eject iPod nano from iTunes before you 
disconnect it.
Syncing Music Automatically
By default, iPod nano is set to sync all songs and playlists when you connect it to your 
computer. This is the simplest way to add music to iPod nano. You just connect 
iPod nano to your computer, let it add songs, audiobooks, videos, and other items 
automatically, and then disconnect it and go. If you added any songs to iTunes since 
the last time you connected iPod nano, they are synced with iPod nano. If you deleted 
songs from iTunes, they are removed from iPod nano.
To sync music with iPod nano:
m Connect iPod nano to your computer. If iPod nano is set to sync automatically, 
the update begins.
Important:  If you connect iPod nano to a computer that it’s not synced with, a 
message asks if you want to sync songs automatically. If you accept, all songs, 
audiobooks, and videos are erased from iPod nano and replaced with songs and 
other items from that computer.
While music is being synced from your computer to iPod nano, the iTunes status 
window shows progress, and you see a sync icon next to the iPod nano icon in the 
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When the update is done, a message in iTunes says “iPod sync is complete.” A bar at the 
bottom of the iTunes window displays how much disk space is used by different types 
of content.
If there isn’t enough space on iPod nano for all your music, you can set iTunes to sync 
only selected songs and playlists. Only the songs and playlists you specify are synced 
with iPod nano.
Syncing Music From Selected Playlists, Artists, and Genres to 
iPod nano
You can set iTunes to sync selected playlists, artists, and genres to iPod nano if the 
music in your iTunes library doesn’t all fit on iPod nano. Only the music from the 
playlists, artists, and genres you select is synced to iPod nano.
To set iTunes to sync music from selected playlists, artists, and genres to iPod nano:
1 In iTunes, select iPod nano in the device list and click the Music tab.
2 Select “Sync music,” and then choose “Selected playlists, artists, and genres.”
3 Select the playlists you want.
4 To include music videos, select “Include music videos.”
5 To set iTunes to automatically fill any remaining space on iPod nano, select 
“Automatically fill free space with songs.”
6 Click Apply.
If “Sync only checked songs and videos” is selected in the Summary pane, iTunes syncs 
only items that are checked.
Syncing Genius Playlists and Genius Mixes to iPod nano
You can set iTunes to sync Genius playlists and Genius Mixes to iPod nano.
Genius Mixes can only be synced automatically. You can’t add Genius Mixes to 
iPod nano if you manage your content manually. Genius playlists can be added 
manually to iPod nano.
If you select any Genius Mixes to sync, iTunes may select and sync additional songs 
from your library that you didn’t select.Chapter 2    Setting Up iPod nano 27
To set iTunes to sync Genius playlists and selected Genius Mixes to iPod nano:
1 In iTunes, select iPod nano in the device list and click the Music tab. 
2 Select “Sync music,” and then choose “Selected playlists, artists, and genres.”
3 Under Playlists, select the Genius playlists and Genius Mixes you want.
4 Click Apply.
If you choose to sync your entire music library, iTunes syncs all your Genius playlists 
and Genius Mixes.
If “Sync only checked songs and videos” is selected in the Summary pane, iTunes syncs 
only items that are checked.
Adding Videos to iPod nano
You add movies and TV shows to iPod nano much the same way you add songs. You 
can set iTunes to sync all movies and TV shows to iPod nano automatically when you 
connect iPod nano, or you can set iTunes to sync only selected playlists. Alternatively, 
you can manage movies and TV shows manually. Using this option, you can add videos 
from more than one computer without erasing videos already on iPod nano. 
Note:  Music videos are managed with songs, under the Music tab in iTunes. See 
“Adding Music, Videos, and Other Content to iPod nano” on page 24.
Important:  You can view a rented movie on only one device at a time. For example, 
if you rent a movie from the iTunes Store and add it to iPod nano, you can only view it 
on iPod nano. If you transfer the movie back to iTunes, you can only view it there and 
not on iPod nano. All standard time limits apply to rented movies added to iPod nano.
Syncing Videos Automatically
By default, iPod nano is set to sync all movies and TV shows when you connect it to 
your computer. This is the simplest way to add videos to iPod nano. You just connect 
iPod nano to your computer, let it add videos and other items automatically, and then 
disconnect it and go. If you added any videos to iTunes since the last time you 
connected iPod nano, they’re added to iPod nano. If you deleted videos from iTunes, 
they’re removed from iPod nano.
If there isn’t enough space on iPod nano for all your videos, you can set iTunes to sync 
only the videos you specify. You can sync selected videos or selected playlists that 
contain videos.
The settings for syncing movies and TV shows are unrelated. Movie settings don’t affect 
TV show settings, and vice versa.28 Chapter 2    Setting Up iPod nano 
To set iTunes to sync movies to iPod nano:
1 In iTunes, select iPod nano in the device list and click the Movies tab.
2 Select “Sync movies.”
3 Select the movies or playlists you want.
All, recent, or unwatched movies:  Select “Automatically include … movies” and choose 
the option you want from the pop-up menu.
Selected movies or playlists:  Select the movies or playlists you want.
4 Click Apply.
If “Sync only checked songs and videos” is selected in the Summary pane, iTunes syncs 
only movies that are checked.
To set iTunes to sync TV shows to iPod nano:
1 In iTunes, select iPod nano in the device list and click the TV Shows tab.
2 Select “Sync TV Shows.”
3 Select the shows, episodes, and playlists you want.
All, most recent, or unwatched episodes:  Select “Automatically include … episodes of … ” 
and choose the options you want from the pop-up menus.
Episodes on selected playlists:  Select the playlists you want.
4 Click Apply.
If “Sync only checked songs and videos” is selected in the Summary pane, iTunes syncs 
only TV show that are checked.
Adding Podcasts to iPod nano
The settings for adding podcasts to iPod nano are unrelated to the settings for adding 
songs and videos. Podcast settings don’t affect song or video settings, and vice versa. 
You can set iTunes to automatically sync all or selected podcasts, or you can add 
podcasts to iPod nano manually.
To set iTunes to update the podcasts on iPod nano automatically:
1 In iTunes, select iPod nano in the device list and click the Podcasts tab.
2 In the Podcasts pane, select “Sync Podcasts.”Chapter 2    Setting Up iPod nano 29
3 Select the podcasts, episodes, and playlists you want, and set your sync options.
4 Click Apply.
When you set iTunes to sync iPod nano podcasts automatically, iPod nano is updated 
each time you connect it to your computer.
If you select “Sync only checked songs and videos” in the Summary pane, iTunes syncs 
only items that are checked in your Podcasts and other libraries.
Adding Video Podcasts to iPod nano
You add video podcasts to iPod nano the same way you add other podcasts 
(see “Adding Podcasts to iPod nano” on page 28). If a podcast has video, the video 
plays when you choose it from the Podcasts menu.
Adding iTunes U Content to iPod nano
The settings for adding iTunes U content to iPod nano are unrelated to the settings 
for adding other content. iTunes U settings don’t affect other settings, and vice versa. 
You can set iTunes to automatically sync all or selected iTunes U content, or you can 
add iTunes U content to iPod nano manually.
To set iTunes to update the iTunes U content on iPod nano automatically:
1 In iTunes, select iPod nano in the device list and click the iTunes U tab.
2 In the iTunes U pane, select “Sync iTunes U.”
3 Select the collections, items, and playlists you want, and set your sync options.
4 Click Apply.
When you set iTunes to sync iTunes U content automatically, iPod nano is updated each 
time you connect it to your computer.
If you select “Sync only checked songs and videos” in the Summary pane, iTunes syncs 
only items that are checked in your iTunes U and other libraries.
Adding Audiobooks to iPod nano
You can purchase and download audiobooks from the iTunes Store or audible.com, 
or import audiobooks from CDs, and listen to them on iPod nano.
Use iTunes to add audiobooks to iPod nano. If you sync iPod nano automatically, all 
audiobooks in your iTunes library are included in a playlist named Audiobooks, which 
you can sync to iPod nano. If you manage your content on iPod nano manually, you 
can add audiobooks one at a time.30 Chapter 2    Setting Up iPod nano 
To sync audiobooks to iPod nano:
1 In iTunes, select iPod nano in the device list and click the Music tab.
2 Select Sync Music, and then do one of the following:
Â Select “Entire music library.”
Â Select “Selected playlists, artists, and genres,” and then select Audiobooks (below 
Playlists).
3 Click Apply.
The update begins automatically.
Adding Other Content to iPod nano
You can also use iTunes to sync photos, games, contacts, and more to iPod nano. 
You can set iTunes to sync your content automatically, or you can manage your content 
on iPod nano manually.
For more information about adding other types of content to iPod nano, see:
Â “Adding Photos from Your Computer to iPod nano” on page 67
Â “To sync games automatically to iPod nano:” on page 76
Â “Syncing Contacts, Calendars, and To-Do Lists” on page 81
Â “Mono Audio” on page 83
Managing iPod nano Manually
If you manage iPod nano manually, you can add and remove individual songs 
(including music videos) and videos (including movies and TV shows). You can also 
add music and video from multiple computers to iPod nano without erasing items 
already on iPod nano.
You can’t manually add Genius Mixes to iPod nano, but you can manually add Genius 
playlists.
Setting iPod nano to manually manage music and video turns off the automatic sync 
options in the Music, Movies, TV Shows, Podcasts, iTunes U, Photos, Contacts, and 
Games panes. You can’t manually manage some and automatically sync others at the 
same time.
If you set iTunes to manage content manually, you can reset it later to sync automatically.Chapter 2    Setting Up iPod nano 31
To set iTunes to manage content on iPod nano manually:
1 In iTunes, select iPod nano in the device list and click the Summary tab. 
2 In the Options section, select “Manually manage music and video.”
3 Click Apply.
When you manually manage content on iPod nano, you must always eject iPod nano 
from iTunes before you disconnect it.
When you connect a manually-managed iPod nano to a computer, it appears in the 
device list on the left side of the iTunes window.
To add a song, video, or other item to iPod nano:
1 In iTunes, click Music or another item below Library on the left side of the iTunes window.
2 Drag a song or other item to iPod nano in the device list.
To remove a song, video, or other item from iPod nano:
1 In iTunes, select iPod nano in the device list.
2 Select a song or other item on iPod nano, and then press the Delete or Backspace key 
on your keyboard.
If you remove a song or other item from iPod nano, it isn’t deleted from your iTunes 
library.
To create a new playlist on iPod nano:
1 In iTunes, select iPod nano in the device list, and then click the Add (+) button or 
choose File > New Playlist. 
2 Type a name for the playlist.
3 Click an item, such as Music, in the Library list, and then drag songs or other items to 
the playlist.
To add items to or remove items from a playlist on iPod nano:
m Drag an item to a playlist on iPod nano to add the item. Select an item in a playlist and 
press the Delete key on your keyboard to delete the item.
To reset iTunes to sync music, video, and podcasts automatically:
1 In iTunes, select iPod nano in the device list and click the Summary tab.
2 Deselect “Manually manage music and videos.”
3 Select the Music, Movies, TV Shows, and Podcasts tabs, and select your sync options.
4 Click Apply.
The update begins automatically.32 Chapter 2    Setting Up iPod nano 
Setting Up VoiceOver
VoiceOver announces the title and artist of the song you’re listening to, on demand. 
If you have the Apple Earphones with Remote and Mic or the In-Ear Headphones with 
Remote and Mic, you can also use VoiceOver to navigate playlists.
Note:  VoiceOver isn’t available in all languages.
You set VoiceOver options in the Summary pane in iTunes. When you first set up 
iPod nano, VoiceOver is enabled by default. Follow any onscreen instructions to 
download and install the VoiceOver Kit.
If you don’t want VoiceOver enabled when you set up iPod nano, deselect Enable 
VoiceOver in the Setup Assistant. If you change your mind, you can enable VoiceOver at 
a later time.
To enable VoiceOver at a later time:
1 Connect iPod nano to your computer.
2 In iTunes, select iPod nano in the device list and click the Summary tab.
3 Under Voice Feedback, select Enable VoiceOver.
4 Click Apply.
5 Follow the onscreen instructions to download and install the VoiceOver Kit.
6 Click Apply.
When syncing is finished, VoiceOver is enabled.
If your computer has a system voice that you want to use instead of the built-in voice 
that comes with VoiceOver, select “Use system voice instead of built-in voice” under 
Voice Feedback in the Summary pane.
You can disable VoiceOver any time you connect iPod nano to your computer.
To disable VoiceOver:
1 In iTunes, select iPod nano in the device list and click the Summary tab.
2 Under Voice Feedback, deselect Enable VoiceOver.
3 Click Apply.
When syncing is finished, VoiceOver is disabled.3
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3 Listening to Music
Read this chapter to learn about listening on the go.
After you set up iPod nano, you can listen to songs, podcasts, audiobooks, and more.
Playing Music and Other Audio
When a song is playing, the Now Playing screen appears. The following table describes 
the elements on the Now Playing screen.
Screen item Function
Shuffle icon Appears if iPod nano is set to shuffle songs or albums.
Repeat icon Appears if iPod nano is set to repeat all songs. The Repeat Once 
(!) icon appears if iPod nano is set to repeat one song.
Play icon Appears when song is playing. The Pause (1) icon appears when 
song is paused.
Battery icon Shows the approximate remaining battery charge.
Song information Displays the song title, artist, and album title.
Album art Shows the album art, if it’s available.
Progress bar Shows the elapsed and remaining times for the song that’s playing.
Progress bar
Click the Center button 
to see the scrubber bar, 
Genius or shuffle slider, 
song rating and lyrics.
Album art
Shuffle icon
Repeat icon Play icon
Battery icon
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Press the Center button to click through these additional items in the Now Playing screen:
Use the Click Wheel and Center button to browse for a song or music video. 
When you play music videos from the Music menu, you only hear the music. When you 
play them from the Videos menu, you also see the video.
To browse for and play a song:
m Choose Music, browse for a song or music video, and then press Play/Pause (’). 
To change the playback volume:
m When you see the progress bar, use the Click Wheel to change the volume.
If you don’t see the progress bar, press the Center button until it appears.
To listen to a different part of a song:
1 Press the Center button until you see the scrubber bar.
2 Use the Click Wheel to move the playhead along the scrubber bar.
Screen item Function
Scrubber bar Lets you quickly navigate to a different part of the track.
Genius slider Creates a Genius playlist based on the current song. The slider 
doesn’t appear if Genius information isn’t available for the current 
song.
Shuffle slider Lets you shuffle songs or albums directly from the Now Playing 
screen.
Song rating Lets you rate the song.
Lyrics Displays the lyrics of the song that’s playing. Lyrics don’t appear if 
you didn’t enter them in iTunes.Chapter 3    Listening to Music 35
To create a Genius playlist from the current song:
1 Press the Center button until you see the Genius slider.
2 Use the Click Wheel to move the slider to Start.
The Genius slider doesn’t appear if Genius information isn’t available for the 
current song.
To shuffle songs from the Now Playing screen:
1 Press the Center button until you see the shuffle slider.
2 Use the Click Wheel to move the slider to Songs or Albums.
Â Choose Songs to play all songs on iPod nano at random.
Â Choose Albums to play all songs in the current album in order. iPod nano then 
randomly selects another album and plays through it in order.36 Chapter 3    Listening to Music 
To just listen to a music video:
m Choose Music and browse for a music video.
When you play the video, you hear it but don’t see it. When you play a playlist that 
includes video podcasts, you hear the podcasts but don’t see them.
To return to the previous menu:
m From any screen, press Menu.
Rating Songs
You can assign a rating to a song (from 1 to 5 stars) to indicate how much you like it. 
You can use song ratings to help you create Smart Playlists automatically in iTunes.
To rate a song:
1 Start playing the song. 
2 From the Now Playing screen, press the Center button until the five rating bullets 
appear.
3 Use the Click Wheel to assign a rating.
The ratings you assign to songs on iPod nano are transferred to iTunes when you sync.
Note:  You can’t assign ratings to video podcasts.Chapter 3    Listening to Music 37
Viewing Lyrics on iPod nano
If you enter lyrics for a song in iTunes (see “Add Lyrics” on page 21) and then add the 
song to iPod nano, you can view the lyrics on iPod nano. Lyrics don’t appear unless you 
enter them.
To view lyrics on iPod nano while a song is playing:
m On the Now Playing screen, press the Center button until you see the lyrics. You can 
scroll through the lyrics as the song plays.
Viewing Album Artwork on iPod nano
iTunes displays album artwork on iPod nano, if the artwork is available. Artwork 
appears on iPod nano in Cover Flow, in the album list, and when you play a song from 
the album.
To see album artwork on iPod nano:
m Hold iPod nano horizontally to view Cover Flow, or play a song that has album artwork 
and view it in the Now Playing screen.
For more information about album artwork, open iTunes and choose Help > iTunes Help.
Browsing Music Using Cover Flow
You can browse your music collection using Cover Flow, a visual way to flip through 
your library. Cover Flow displays your albums alphabetically by artist name.
You can activate Cover Flow from the main menu, any music menu, or the Now Playing 
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To use Cover Flow:
1 Rotate iPod nano 90 degrees to the left or right. Cover Flow appears.
2 Use the Click Wheel to move through your album art.
3 Select an album and press the Center button.
4 Use the Click Wheel to select a song, and then press the Center button to play it.
You can also browse quickly through your albums in Cover Flow by moving your 
thumb quickly on the Click Wheel.
Note:  Not all languages are supported.
To browse quickly in Cover Flow:
1 Move your thumb quickly on the Click Wheel, to display a letter of the alphabet on 
the screen.
2 Use the Click Wheel to navigate through the alphabet until you find the first letter of 
the artist you’re looking for.
Albums by artists beginning with a symbol or number appear after the letter Z.
3 Lift your thumb momentarily to return to normal browsing.
4 Select an album and press the Center button.
5 Use the Click Wheel to select a song, and then press the Center button to play it.
To turn Cover Flow on or off:
1 From the main menu, choose Settings > General > Rotate.
2 Press the Center button to select Cover Flow or Off.Chapter 3    Listening to Music 39
Accessing Additional Commands
Some additional iPod nano commands can be accessed directly from the Now Playing 
screen and some menus.
To access additional commands:
m Press and hold the Center button until a menu appears, select a command, and then 
press the Center button again.
If a menu doesn’t appear, no additional commands are available.
Using Genius on iPod nano
Even when iPod nano isn’t connected to your computer, Genius can automatically 
create instant playlists of songs that go great together. You can also play Genius Mixes, 
which are pre-selected compilations of songs that go great together. To use Genius, 
you need to set up Genius in the iTunes Store, and then sync iPod nano to iTunes. 
You can also create Genius playlists in iTunes and add them to iPod nano, and you can 
sync Genius Mixes to iPod nano.
To learn how to set up Genius in iTunes, open iTunes and choose Help > iTunes Help. 
Genius is a free service, but you need an iTunes Store account to use it.40 Chapter 3    Listening to Music 
To make a Genius playlist on iPod nano:
1 Select a song, and then press and hold the Center button until a menu appears.
You can select a song from a menu or playlist, or you can start from the Now Playing 
screen.
2 Choose Start Genius.
Start Genius doesn’t appear in the menu of additional commands, if any of the 
following apply:
Â You haven’t set up Genius in iTunes and then synced iPod nano with iTunes.
Â Genius doesn’t recognize the song you selected.
Â Genius recognizes the song, but there aren’t at least ten similar songs in your library. 
3 Press the Center button. The new playlist appears.
4 To keep the playlist, choose Save Playlist.
The playlist is saved with the song title and artist of the song you used to make 
the playlist.
5 To change the playlist to a new one based on the same song, choose Refresh. If you 
refresh a saved playlist, the new playlist replaces the previous one. You can’t recover 
the previous playlist.
You can also start Genius from the Now Playing screen by pressing the Center button 
until you see the Genius slider, and then using the Click Wheel to move the slider to 
the right. The Genius slider won’t appear if Genius information isn’t available for the 
current song.
Genius playlists saved on iPod nano are synced back to iTunes when you connect 
iPod nano to your computer.
To play a Genius playlist:
m Choose Music > Playlists and choose the playlist.
Playing Genius Mixes
Genius Mixes are created for you by iTunes and contain songs from your library that go 
great together. Genius Mixes are designed to provide a different listening experience 
each time you play one. iTunes creates up to 12 Genius Mixes, depending on the variety 
of music in your iTunes library.
To find out how to sync Genius Mixes to iPod nano, see “Syncing Genius Playlists and 
Genius Mixes to iPod nano” on page 26.Chapter 3    Listening to Music 41
To play a Genius Mix:
1 Choose Music > Genius Mixes.
2 Use Next/Fast-forward (‘) or Previous/Rewind (]) to browse the Genius Mixes. 
The dots at the bottom of the screen indicate how many Genius Mixes are synced
to iPod nano.
3 To start playing a Genius Mix, press the Center button or Play/Pause (’) when you see 
its screen.
The Speaker ( ) icon appears when the selected Genius Mix is playing.
Creating On-The-Go Playlists on iPod nano
You can create On-The-Go Playlists on iPod nano when iPod nano isn’t connected to 
your computer.
To create an On-The-Go playlist:
1 Select a song, and then press and hold the Center button until a menu appears.
2 Choose “Add to On-The-Go.”
3 To add more songs, repeat steps 1 and 2.42 Chapter 3    Listening to Music 
4 Choose Music > Playlists > On-The-Go to browse and play your list of songs.
You can also add a group of songs. For example, to add an album, highlight the album 
title, press and hold the Center button until a menu appears, and then choose “Add to 
On-The-Go.”
To play songs in the On-The-Go playlist:
m Choose Music > Playlists > On-The-Go, and then choose a song.
To remove a song from the On-The-Go playlist:
1 Select a song in the playlist and hold down the Center button until a menu appears.
2 Choose “Remove from On-The-Go,” and then press the Center button.
To clear the entire On-The-Go playlist:
m Choose Music > Playlists > On-The-Go > Clear Playlist, and then click Clear.
To save the On-The-Go playlist on iPod nano:
m Choose Music > Playlists > On-The-Go > Save Playlist.
The first playlist is saved as “New Playlist 1” in the Playlists menu. The On-The-Go 
playlist is cleared and ready to reuse. You can save as many playlists as you like. 
After you save a playlist, you can no longer remove songs from it.
To copy On-The-Go playlists from iPod nano to your computer:
m If iPod nano is set to sync songs automatically (see “Syncing Music Automatically” on 
page 25) and you create an On-The-Go playlist, the playlist is automatically synced to 
iTunes when you connect iPod nano. The new On-The-Go playlist appears in the list of 
playlists in iTunes. You can rename, edit, or delete the new playlist, just as you would 
any playlist.
Browsing Songs by Album or Artist
When you’re listening to a song, you can browse more songs by the same artist or all 
the songs in the current album.
To browse songs by album:
1 From the Now Playing screen, press and hold the Center button until a menu appears.
2 Choose Browse Album, and then press the Center button.
You see all the songs from the current album that are on iPod nano. You can select a 
different song or return to the Now Playing screen.
To browse songs by artist:
1 From the Now Playing screen, press and hold the Center button until a menu appears.
2 Choose Browse Artist, and then press the Center button.
You see all the songs by that artist that are on iPod nano. You can select a different 
song or return to the Now Playing screen.Chapter 3    Listening to Music 43
Setting iPod nano to Shuffle Songs 
You can set iPod nano to play songs, albums, or your entire library in random order.
To set iPod nano to shuffle and play all your songs: 
m Choose Shuffle Songs from the iPod nano main menu. 
iPod nano begins playing songs from your entire music library in random order, 
skipping audiobooks and podcasts.
To set iPod nano to always shuffle songs or albums:
1 Choose Settings from the iPod nano main menu.
2 Set Shuffle to either Songs or Albums.
When you set iPod nano to shuffle songs, iPod nano shuffles songs within whatever list 
(for example, album or playlist) you choose to play. 
When you set iPod nano to shuffle albums, it plays all the songs on an album in order, 
and then randomly selects another album and plays through it in order. 
You can also set iPod nano to shuffle songs directly from the Now Playing screen.
To set iPod nano to shuffle songs from the Now Playing screen:
1 From the Now Playing screen, press the Center button until the shuffle slider appears.
2 Use the Click Wheel to set iPod nano to shuffle songs or albums.
You can skip ahead to a random song by shaking iPod nano.
To shuffle songs while a song is playing or paused:
m Shake iPod nano from side to side. A new song starts to play.
Shaking to shuffle doesn’t change your shuffle settings.44 Chapter 3    Listening to Music 
To disable shaking:
m Choose Settings > Playback > Shake and select Off.
To turn shaking on again, choose Settings > Playback > Shake, and then select Shuffle.
Shaking is also disabled when the Hold switch is in the HOLD position, when the 
iPod nano built-in radio is playing, or when the display is off. If iPod nano is off, you 
can’t turn it on by shaking it.
Setting iPod nano to Repeat Songs
You can set iPod nano to repeat a song over and over, or repeat songs within the list 
you choose to play.
To set iPod nano to repeat songs:
m Choose Settings from the iPod nano main menu.
Â To repeat all songs in the list, set Repeat to All.
Â To repeat one song over and over, set Repeat to One.
Using VoiceOver in iPod nano
With VoiceOver, iPod nano can announce the title and artist of the song you’re listening 
to. VoiceOver is available in selected languages.
To use VoiceOver, install the VoiceOver Kit and enable the VoiceOver feature in iTunes. 
For more information, see “Setting Up VoiceOver” on page 32.
To hear the current song announcement:
m From the Now Playing screen, press the Center button.
You hear the current song title and artist name. If you’re listening to an audiobook, 
you hear the book title and author’s name.
If you have the Apple Earphones with Remote and Mic or the In-Ear Headphones with 
Remote and Mic (available at store.apple.com or your local Apple Store), you can also 
use VoiceOver to navigate through playlists. For more information, see the 
documentation for those accessories.
Searching Music
You can search iPod nano for songs, playlists, album titles, artist names, audio podcasts, 
and audiobooks. The search feature doesn’t search videos, notes, calendar items, 
contacts, or lyrics.
Note:  Not all languages are supported.
To search for music:
1 From the Music menu, choose Search.
2 Enter a search string by using the Click Wheel to navigate the alphabet and pressing 
the Center button to enter each character.Chapter 3    Listening to Music 45
iPod nano starts searching as soon as you enter the first character, displaying the 
results on the search screen. For example, if you enter “b,” iPod nano displays all music 
items containing the letter “b.” If you enter “ab,” iPod nano displays all items containing 
that sequence of letters.
To enter a space character, press Next/Fast-forward (‘).
To delete the previous character, press Previous/Rewind (]).
3 Press Menu to display the results list, which you can navigate by using the Click Wheel.
Items appear in the results list with icons identifying their type: song, video, artist, 
album, audiobook, or podcast. 
To return to Search (if Search is highlighted in the menu), press the Center button.
Customizing the Music Menu
You can add items to or remove them from the Music menu, just as you do with the 
main menu. For example, you can add a Compilations item to the Music menu, so you 
can easily choose compilations that are put together from various sources.
To add or remove items in the Music menu:
1 Choose Settings > General > Music Menu.
2 Select each item you want to appear in the Music menu. A checkmark indicates 
which items have been added. To revert to the original Music menu settings, 
choose Reset Menu.
Setting the Maximum Volume Limit
You can set a limit for the maximum volume on iPod nano and assign a combination 
to prevent the setting from being changed.
To set the maximum volume limit for iPod nano:
1 Choose Settings > Playback > Volume Limit.
The volume control shows the current volume. 
2 Use the Click Wheel to select the maximum volume limit.
3 Press the Center button to set the maximum volume limit.
4 If you don’t want to require a combination to change the maximum volume, 
choose Done.
To require a combination to change the maximum volume:
1 After setting the maximum volume, choose Lock.
2 In the screen that appears, enter a combination. 
To enter a combination:
Â Use the Click Wheel to select a number for the first position. Press the Center button 
to confirm your choice and move to the next position. 46 Chapter 3    Listening to Music 
Â Use the same method to set the remaining numbers of the combination. You can use 
Next/Fast-forward (‘) to move to the next position and Previous/Rewind (]) to 
move to the previous position. Press the Center button in the final position to 
confirm the entire combination.
The volume of songs and other audio may vary depending on how the audio was 
recorded or encoded. See “Setting Songs to Play at the Same Volume Level” on page 46 
for information about how to set a relative volume level in iTunes and on iPod nano. 
The volume level may also vary if you use different earphones or headphones. 
Accessories that connect using the Dock Connector don’t support volume limits.
If you set a combination, you must enter it before you can change or remove the 
maximum volume limit. 
To change the maximum volume limit:
1 Choose Settings > Playback > Volume Limit. 
2 If you set a combination, enter it by using the Click Wheel to select the numbers and 
pressing the Center button to confirm them.
A triangle on the volume bar indicates the current volume limit.
3 Use the Click Wheel to change the maximum volume limit.
4 Press Play/Pause (’) to accept the change.
To remove the maximum volume limit:
1 If you’re currently listening to iPod nano, press Play/Pause (’).
2 Choose Settings > Playback > Volume Limit. 
3 If you set a combination, enter it by using the Click Wheel to select the numbers and 
pressing the Center button to confirm each number. 
4 Use the Click Wheel to move the volume limit to the maximum level on the volume bar. 
This removes any restriction on volume.
5 Press Play/Pause (’) to accept the change.
If you forget the combination, you can restore iPod nano. See “Updating and Restoring 
iPod Software” on page 92.
Setting Songs to Play at the Same Volume Level
iTunes can automatically adjust the volume of songs, so they play at the same relative 
volume level. You can set iPod nano to use the iTunes volume settings.
To set iTunes to play songs at the same sound level:
1 In iTunes, choose iTunes > Preferences if you’re using a Mac, or choose Edit > 
Preferences if you’re using a Windows PC.
2 Click Playback and select Sound Check, and then click OK.Chapter 3    Listening to Music 47
To set iPod nano to use the iTunes volume settings:
m Choose Settings > Playback and set Sound Check to On.
If you haven’t activated Sound Check in iTunes, setting it on iPod nano has no effect.
Using the Equalizer
You can use equalizer presets to change the sound on iPod nano to suit a particular 
music genre or style. For example, to make rock music sound better, set the equalizer 
to Rock. 
To use the equalizer to change the sound on iPod nano:
m Choose Settings > Playback > EQ, and then choose an equalizer preset. 
If you assigned an equalizer preset to a song in iTunes and the iPod nano equalizer is 
set to Off, the song plays using the iTunes setting. See iTunes Help for more 
information.
Crossfading Between Songs
You can set iPod nano to fade out at the end of each song and fade in at the beginning 
of the song following it.
To turn on crossfading:
m Choose Settings > Playback > Audio Crossfade and select On.
Note:  Songs that are grouped for gapless playback play without gaps even when 
crossfading is on.
Playing Podcasts
Podcasts are free, downloadable shows available at the iTunes Store. Podcasts are 
organized by shows, episodes within shows, and chapters within episodes. If you stop 
playing a podcast and return to it later, the podcast begins playing where you left off.
To play a podcast:
1 From the main menu, choose Podcasts, and then choose a show.
Shows appear in reverse chronological order so you can play the most recent one first. 
You see a blue dot next to shows and episodes you haven’t played yet.
2 Choose an episode to play it.
The Now Playing screen displays the show, episode, and date information, along with 
elapsed and remaining time. Press the Center button to see more information about 
the podcast.
If the podcast has chapters, you can press Next/Fast-forward (‘) or Previous/Rewind 
(]) to skip to the next chapter or the beginning of the current chapter in the podcast.48 Chapter 3    Listening to Music 
If a podcast includes artwork, you also see a picture. Podcast artwork can change 
during an episode.
For more information about podcasts, open iTunes and choose Help > iTunes Help. 
Then search for “podcasts.”
Playing iTunes U Content
iTunes U is a part of the iTunes Store featuring free lectures, language lessons, 
audiobooks, and more, which you can download and enjoy on iPod nano. iTunes U 
content is organized by collections, items within collections, authors, and providers.
If you stop listening to iTunes U content and return to it later, the collection or item 
begins playing where you left off.
To play iTunes U content:
1 From the main menu, choose iTunes U, and then choose a collection.
Items within a collection appear in reverse chronological order so you can listen to the 
most recent one first. You see a blue dot next to collections and items you haven’t 
watched or listened to yet.
2 Choose an item to play it.
For more information about iTunes U, open iTunes and choose Help > iTunes Help. 
Then search for “iTunes U.”
Listening to Audiobooks
To listen to audiobooks on iPod nano, choose Audiobooks from the Music menu. 
Choose an audiobook, and then press Play/Pause (’).
If you stop listening to an audiobook on iPod nano and return to it later, the audiobook 
begins playing where you left off. iPod nano skips audiobooks when set to shuffle.
If the audiobook you’re listening to has chapters, you can press Next/Fast-forward (‘) 
or Previous/Rewind (]) to skip to the next chapter or the beginning of the current 
chapter. You can also choose the audiobook from the Audiobooks menu, and then 
choose a chapter, or choose Resume to begin playing where you left off.
You can play audiobooks at speeds faster or slower than normal. Setting the play speed 
affects only audiobooks purchased from the iTunes Store or audible.com.
To set audiobook play speed:
m Choose Settings > Playback > Audiobooks and choose a speed, or press and hold the 
Center button from the Now Playing window, and then choose a speed.4
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4 Watching Videos
You can use iPod nano to watch TV shows, movies, video 
podcasts, and more. Read this chapter to learn about 
watching videos on iPod nano and on your TV.
You can view and listen to videos on iPod nano. If you have a compatible AV cable 
(available separately at www.apple.com/ipodstore), you can watch videos from 
iPod nano on your TV.
Watching Videos on iPod nano
Videos you add to iPod nano appear in the Videos menus. Music videos also appear in 
Music menus. Videos recorded with the iPod nano built-in video camera appear in the 
Videos menu, under Camera Videos.
To watch a video on iPod nano:
1 Choose Videos and browse for a video. To browse for a video recorded with the 
iPod nano built-in video camera, choose Camera Videos. 
2 Select a video and then press Play/Pause (’).
To watch the video, hold iPod nano horizontally. You can rotate iPod nano to either the 
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To watch videos recorded in portrait (vertical) format with the built-in video camera, 
hold iPod nano vertically.
Watching Video Podcasts
To watch a video podcast:
m From the main menu, choose Podcasts and then choose a video podcast.
For more information, see “Playing Podcasts” on page 47.
Watching Videos Downloaded from iTunes U
To watch an iTunes U video:
m From the main menu, choose iTunes U and then choose a video.
For more information, see “Playing iTunes U Content” on page 48.
Watching Videos on a TV Connected to iPod nano
If you have an AV cable from Apple, you can watch videos on a TV connected to your 
iPod nano. First you set iPod nano to display videos on a TV, then connect iPod nano to 
your TV, and then play a video.
Use the Apple Component AV Cable, the Apple Composite AV Cable, or the Apple AV 
Connection Kit. Other similar RCA-type cables might not work. You can purchase the 
cables at www.apple.com/ipodstore or your local Apple Store.
To set iPod nano to display videos on a TV:
m Choose Videos > Settings, and then set TV Out to Ask or On.
If you set TV Out to Ask, iPod nano gives you the option of displaying videos on TV or 
on iPod nano every time you play a video. If you set TV Out to On, iPod nano displays 
videos only on TV. If you try to play a video when iPod nano isn’t connected to a TV, 
iPod nano displays a message instructing you to connect to one.
You can also set video to display full screen or widescreen, and set video to display on 
PAL or NTSC devices.
To set TV settings:
m Choose Videos > Settings, and then follow the instructions below.
To set Do this
Video to display on a TV Set TV Out to Ask or On.
Video to display on a PAL or 
NTSC TV
Set TV Signal to PAL or NTSC. PAL and NTSC refer to TV broadcast 
standards. Your TV might use either of these, depending on the 
region where it was purchased. If you aren’t sure which your TV 
uses, check the documentation that came with your TV.
The format of your external TV Set TV Screen to Widescreen for 16:9 format or Standard for 4:3 
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To use the Apple Component AV Cable to connect iPod nano to your TV:
1 Plug the green, blue, and red video connectors into the component video 
(Y, Pb, and Pr) input ports on your TV.
If you use the Apple Composite AV cable, plug the yellow video connector into the 
video input port on your TV. Your TV must have RCA video and audio ports.
2 Plug the white and red audio connectors into the left and right analog audio input 
ports on your TV. 
3 Plug the 30-pin connector into your iPod nano or Universal Dock.
4 Plug the USB connector into your Apple USB Power Adapter or your computer to keep 
your iPod nano charged.
5 Turn on iPod nano and your TV or receiver to start playing. Make sure you set TV Out 
on iPod nano to On or Ask.
The ports on your TV or receiver may differ from the ports in the illustration.
To watch a video on your TV:
1 Connect iPod nano to your TV (see above).
2 Turn on your TV and set it to display from the input ports connected to iPod nano. 
For more information, see the documentation that came with your TV.
3 On iPod nano, choose Videos and browse for a video.
Video to fit to your screen Set “Fit to Screen” to On. If you set “Fit to Screen” to Off, widescreen 
videos display in letterbox format on iPod nano or a standard (4:3) 
TV screen.
Alternate audio to play Set Alternate Audio to On.
Captions to display Set Captions to On.
Subtitles to display Set Subtitles to On.
To set Do this
USB Power
Adapter
iPod Left audio (white)
30-pin connector
Television
Video in (Y, Pb, Pr)
Right audio (red)
USB
connector5
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5 Using the Video Camera
With the built-in iPod nano video camera, you can record 
high-quality video with sound wherever you go. You can even 
record video with special effects. You can watch your 
recorded videos on iPod nano, and you can transfer them to 
your computer to edit and share.
To use iPod nano as a video camera, choose Video Camera from the main menu. 
The display screen becomes a viewfinder.
You can record video in landscape or portrait mode. In either mode, your current 
recording time appears in the upper right corner of the display.Chapter 5    Using the Video Camera 53
The lens and microphone are on the back of iPod nano, so you can use the display to 
see the video you’re recording. Be careful not to block the lens or microphone.
Recording Video
To record video:
1 Choose Video Camera from the main menu.
2 When you’re ready to begin recording, press the Center button. Press the Center button 
again to stop recording.
When video is recording, a blinking red light appears in the upper right corner of the 
display, next to the recording time.
Recording time depends on the available disk space and battery level. 
A recorded video can be up to 2 GB in size. Once a recorded video takes up 2 GB of 
disk space, recording stops. To resume recording, press the Center button.
Recording Video with Special Effects
You can record video with a variety of special effects on iPod nano. 
Note:  Video effects can only be selected before recording. iPod nano can’t add effects 
to or remove effects from recorded videos. You can’t change video effects settings 
while recording.
To record video with special effects:
1 Choose Video Camera from the main menu.54 Chapter 5    Using the Video Camera 
2 Press and hold the Center button to display the video effects palette.
3 Use the Click Wheel to browse the effects, and press the Center button to select one.
The viewfinder screen appears with the selected effect.
4 Press the Center button again to start recording with video effects.
5 Press the Center button to stop recording.
If you exit the Video Camera screen to play back your video, video effects are turned 
off. To resume recording with a video effect, repeat steps 2 through 4.
Playing Recorded Videos
iPod nano saves your recorded videos to the Camera Roll. To go to the Camera Roll 
screen, press Menu from the Video Camera viewfinder screen.
iPod nano lets you access your recorded videos from the Camera Roll screen, so you 
can watch what you just recorded without leaving the Video Camera application. 
Your recorded videos can also be played from the Videos menu.
To play back a video you just recorded:
1 Press the Center button to stop recording.
2 Press Menu to enter the Camera Roll screen.
3 Choose the recording, and then press the Center button to play.
You can also access a complete list of recorded videos on iPod nano from the Videos 
menu.
To play a recorded video from the Videos menu:
1 Choose Videos in the main menu.
2 Choose Camera Videos to display a list of recorded videos.
3 Use the Click Wheel to scroll to the video you want to play, and then press Play/Pause 
(’) to start and stop playback. Playback stops automatically at the end of the video.Chapter 5    Using the Video Camera 55
Deleting Recorded Videos
Removing unwanted videos clears disk space for new videos. Recorded videos can be 
deleted one at a time, or all at once.
To delete a recorded video:
1 Go to Videos > Camera Videos and select a video from the list, or select a video from 
the Camera Roll screen.
2 Press and hold the Center button until a menu appears.
3 Choose Delete, or Delete All.
Importing Recorded Videos to Your Computer
You can import your recorded videos to your computer. If you have a Mac with iPhoto, 
you can easily share your recorded videos and add background music to them.
iPod nano formats recorded videos as VGA video H.264 w/AAC 30 fps files.
To import your recorded videos to your computer, iPod nano must be enabled for 
disk use.
To enable iPod nano for disk use:
1 Connect iPod nano to your computer.
2 In iTunes, click iPod nano in the device list and click the Summary tab.
3 Select “Enable disk use.”
In addition to appearing in iTunes, iPod nano also appears on your computer as an 
external disk, with the same name you gave it during initial setup. On a Mac, iPod nano 
appears in the Finder and on the Desktop. On a PC, iPod nano appears in Windows 
Explorer and My Computer.
Your recorded videos are stored in the DCIM folder on iPod nano, and can be copied to 
your computer when iPod nano is connected to it. See the documentation that came 
with your computer for more information about copying files.
After you copy your recorded videos to your computer, you can watch them on a Mac 
using QuickTime Player. You can watch them on a PC using QuickTime or Windows 
Media Player.
To clear disk space on iPod nano after you’ve copied your recorded videos to your 
computer, delete them from the DCIM folder.56 Chapter 5    Using the Video Camera 
Importing Recorded Videos to a Mac with iPhoto Installed
If your computer is a Mac with iPhoto 6.0.6 or later installed, you can use iPhoto to 
import your recorded videos from iPod nano to your Mac and post them on MobileMe. 
You can also add music by editing your recorded videos in QuickTime Player. To use 
iPhoto to import your recorded videos, iPod nano must be enabled for disk use.
To import videos to your Mac using iPhoto:
1 Connect iPod nano to your computer.
2 Open iPhoto if it doesn’t open automatically.
3 Click iPod nano in the iPhoto device list.
4 Select the videos to import, and then click Selected or Import All.
5 Select Delete Photos or Keep Photos.
Your recorded videos appear in your iPhoto library in Events and Photos, and in the list 
of recent imports.
To share recorded videos using iPhoto:
1 Follow the instructions to import your recorded videos to iPhoto.
2 In iPhoto, select a recorded video.
3 Click MobileMe at the bottom of the iPhoto window.
4 Follow the onscreen instructions.
You need a MobileMe account in order to share your recorded videos using MobileMe, 
and you need to set up iPhoto to publish to your account. For more information about 
online sharing, open iPhoto and choose Help > iPhoto Help.
Sharing Recorded Videos from a Mac or PC
After you import your recorded videos to your computer, you can post them on 
YouTube using a Mac or PC.
To post recorded videos on Facebook:
1 Go to www.facebook.com and log in if necessary.
2 Click the video icon to the left of the Share button at the top of your Facebook 
homepage, and then click “Upload a Video.”
3 Follow the onscreen instructions to select and upload your video.
To post recorded videos on YouTube:
1 Go to www.youtube.com and log in if necessary.
2 Click the Upload button at the top right of your YouTube homepage.
3 Follow the onscreen instructions to select and upload your video.
If you have a Mac with iPhoto 8.1 or later and Mac OS X v10.6.1 or later, you can also 
export your recorded videos directly to YouTube.Chapter 5    Using the Video Camera 57
To post recorded videos on YouTube using iPhoto 8.1 or later and Mac OS X v10.6.1 
or later:
1 In iPhoto, double-click the video you want to post. The video opens in QuickTime 
Player.
2 In QuickTime Player, choose Share > YouTube.
3 Enter your YouTube name and password, and then click Sign In.
4 Enter a description and tags. If you want to restrict access to your video, select “Make 
this movie personal.”
5 Click Next, and then click Share.
When the export is complete, click the link that appears to go to your video page on 
YouTube.
Accounts are required to upload videos to Facebook or YouTube. For more information, 
visit the websites.
Adding Music to Your Recorded Videos
You can use QuickTime Player to add music to your recorded videos. Select a recorded 
video in iPhoto, and then click Edit at the bottom of the iPhoto window. The recorded 
video opens in QuickTime Player, where you can add a music track to your recorded 
video.
To learn how to add music to your recorded videos with QuickTime Player, choose 
Help > QuickTime Player Help, and see the instructions for extracting, adding, and 
moving tracks.
To add music to your recorded videos with a Windows PC, see the documentation that 
came with your computer or photo application.6
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6 Listening to FM Radio
iPod nano has a built-in FM radio that displays station and 
song information, lets you pause live radio, and tags songs 
that you can preview and purchase in iTunes.
To listen to FM radio, connect earphones or headphones to iPod nano, and then 
choose Radio from the main menu.
iPod nano uses the earphone or headphone cord as the radio antenna. You must 
connect earphones or headphones to iPod nano in order to receive a radio signal. 
The radio doesn’t play through the iPod nano speaker.
After you choose Radio from the main menu, the radio screen appears.
When the radio dial is visible, you can use the Click Wheel or press Next/Fast-forward (‘) 
or Previous/Rewind (]) to tune to a station.
Important:  Radio frequencies shown in this chapter are for illustration purposes only 
and are not available in all areas.Chapter 6    Listening to FM Radio 59
When you tune to a station that supports RDS (Radio Data System), song, artist, and 
station information appear in the display. After you tune to a station, the progress bar 
replaces the radio dial. The progress bar fills up as you continue to listen to the station.
Display item Function
RDS data Displays the current station, song, and artist.
Radio dial Tunes the FM radio.
Favorite station markers Indicate that the current station is in the Favorites list.
Radio signal icon Appears when the radio is on and receiving a signal.
Station frequency Displays the number of the station that the radio is tuned to.
Tag icon Appears if the current song supports iTunes Tagging.
Progress bar Indicates the length of the radio buffer.
Radio signal icon
Progress bar
Radio dial
RDS data
Station frequency
Favorite station marker
RDS data
Tag icon
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Tuning the FM radio
You can tune the FM radio by browsing stations, seeking or scanning available stations, 
or saving your favorite stations and tuning to them directly.
To browse radio stations:
1 Choose Radio from the main menu. If you don’t see the radio dial, press the Center 
button until it appears.
2 Use the Click Wheel to browse the radio dial.
To seek available stations:
1 Choose Radio from the main menu. If you don’t see the radio dial, press the Center 
button until it appears.
2 Press Next/Fast-forward (‘) or Previous/Rewind (]) to seek the next or previous 
available station. Repeat to continue seeking.
The station seeking function isn’t available if any favorite stations are set. If favorites 
are set, pressing Next/Fast-forward (‘) or Previous/Rewind (]) tunes the radio to 
favorite stations.
To scan available stations:
1 Choose Radio from the main menu. If you don’t see the radio dial, press the Center 
button until it appears.
2 Press and hold Next/Fast-forward (‘) or Previous/Rewind (]) to scan available stations.
You hear a five-second preview of each station before advancing to the next one.
3 To stop scanning and listen to the current station, press the Center button.
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To save your favorite stations:
1 Tune to a station you want to save.
2 Press and hold the Center button until a menu appears.
3 Choose “Add to Favorites” and then press the Center button.
To tune to a favorite station:
1 Choose Radio from the main menu. If you don’t see the radio dial, press the Center 
button until it appears.
2 Press Next/Fast-forward (‘) or Previous/Rewind (]) to tune to the next or previous 
favorite station. Repeat to continue tuning.
Pausing Live Radio
You can pause a radio broadcast, and resume playing it from the same point up to 
15 minutes later.
To pause live radio:
m While the radio is playing, press Play/Pause (’) from any screen. 
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The Pause (1) icon appears, and the time at which you paused is displayed above the 
progress bar.
As Live Pause continues, a yellow triangle indicates the point where the radio was 
paused. The progress bar continues to fill up, indicating the time that’s passed since 
you paused.
When you press Play/Pause (’) again, the program resumes from the same point.Chapter 6    Listening to FM Radio 63
You can also navigate forward or back along the progress bar. To fast-forward or 
rewind, press and hold Next/Fast-forward (‘) or Previous/Rewind (]), or use the Click 
Wheel. To skip forward or back in one-minute intervals, press Next/Fast-forward (‘) or 
Previous/Rewind (]).
You can navigate through paused radio only when the progress bar appears, not the 
radio dial.
To switch between the progress bar and radio dial:
m Press the Center button.
The progress bar is completely filled when Live Pause reaches the 15-minute limit. 
As long as your paused radio isn’t cleared, you can navigate through the 15 most recent 
minutes of the station you’re listening to. Anything older than 15 minutes is cleared to 
make room for the continuing broadcast.
If you pause without resuming for 15 minutes, iPod nano goes to sleep and clears your 
paused radio.
Paused radio is cleared if any of the following occurs:
Â You change stations. If you try to change stations while Live Pause is active, a 
warning appears and gives you the option to cancel.
Â You turn off iPod nano.
Â You exit Radio to play other media content, use the video camera, or record a voice 
memo.
Â The battery is very low on power and needs to be charged.
Â You pause the radio for 15 minutes without resuming play.
You can disable Live Pause from the Radio menu, to conserve battery life.
To disable Live Pause:
1 From the Radio screen, press Menu.
2 Choose Live Pause, and then press the Center button to select Off. To enable Live Pause 
again, select On.64 Chapter 6    Listening to FM Radio 
Tagging Songs to Sync to iTunes
If you’re tuned to a radio station that supports iTunes Tagging, you can save a list of 
songs that you can preview and purchase later at the iTunes Store. Songs that can be 
tagged are marked with a tag icon next to the song title.
To tag a song:
1 Press and hold the Center button until a menu appears.
2 Choose Tag, and then press the Center button.
Your tagged songs appear in the Radio menu under Tagged Songs. The next time you 
sync iPod nano to iTunes, your tagged songs are synced and removed from iPod nano. 
They appear in Tunes, where you can preview and purchase them from the iTunes Store.
Note:  This feature may not be available for all radio stations.
To preview and purchase tagged songs in iTunes:
1 Click Tagged below Store on the left side of the iTunes window.
2 Click the View button for the song you want.
3 To preview the song, double-click it or click the preview button. To buy the song, 
click the Buy button.
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Using the Radio Menu
To go to the Radio menu, press Menu from the radio screen.
The Radio menu contains the following items.
Menu item What it does
Play Radio Turns the radio on, and returns iPod nano to the radio screen.
Stop Radio Turns the radio off, and clears paused radio (appears only if the 
radio is on).
Favorites Displays a list of the stations you’ve saved as favorites. Choose a 
station and press the Center button to play.
Tagged Songs Displays a list of songs you’ve tagged for preview and purchase 
since you last synced with iTunes.
Recent Songs Displays a list of recently played songs.
Radio Regions Lets you set the radio for the region you’re in.
Live Pause Enables or disables Live Pause.66 Chapter 6    Listening to FM Radio 
About Radio Regions
iPod nano can be used in many countries to receive FM radio signals. iPod nano comes 
with five preset signal ranges, identified by region: The Americas, Asia, Australia, 
Europe, and Japan.
To select a radio region:
m Choose Radio Regions from the Settings menu, and then choose your region.
The Radio Regions menu also appears in the Radio menu.
Region settings are determined by international radio standards, not actual geographic 
regions. If you live in a country not listed in the Radio Regions menu, choose a region 
that best matches the radio frequency specifications in your country. 
The following table specifies the radio frequency range of each region in the Radio 
Regions menu, along with the increments between stations (indicated by the ± sign).
Important:  iPod nano is intended for the reception of public broadcasts only. Listening 
to transmissions that are not intended for the public is illegal in some countries and 
violators may be prosecuted. Check and obey the laws and regulations in the areas 
where you plan to use iPod nano.
Radio region Radio frequency specifications
Americas 87.5—107.9 MHz / ± 200 kHz
Asia 87.5—108.0 MHz / ± 100 kHz
Australia 87.5—107.9 MHz / ± 200 kHz
Europe 87.5—108.0 MHz / ± 100 kHz
Japan 76.0—90.0 MHz / ± 100 kHz7
     67
7 Photo Features
Read this chapter to learn about importing and viewing 
photos.
You can import digital photos to your computer and add them to iPod nano. You can 
view your photos on iPod nano or as a slideshow on your TV. 
Importing Photos
If your computer is a Mac, you can import photos from a digital camera to your 
computer using iPhoto. You can import other digital images into iPhoto, such as 
images you download from the web. For more information about importing, 
organizing, and editing your photos, open iPhoto and choose Help > iPhoto Help.
iPhoto is available for purchase as part of the iLife suite of applications at 
www.apple.com/ilife or your local Apple Store. iPhoto might already be installed 
on your Mac, in the Applications folder.
To import photos to a Windows PC, follow the instructions that came with your digital 
camera or photo application.
Adding Photos from Your Computer to iPod nano
If you have a Mac and iPhoto 7.1.5 or later, you can sync iPhoto albums automatically 
(for Mac OS X v10.4.11, iPhoto 6.0.6 or later is required). If you have a PC or Mac, 
you can add photos to iPod nano from a folder on your hard disk.
Adding photos to iPod nano the first time might take some time, depending on how 
many photos are in your photo library.
To sync photos from a Mac to iPod nano using iPhoto:
1 In iTunes, select iPod nano in the device list and click the Photos tab.
2 Select “Sync photos from: …” and then choose iPhoto from the pop-up menu.
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Â If you want to add all your photos, select “All photos, albums, events, and faces.” 
Â If you want to add selected photos, select “Selected albums, events, and faces, and 
automatically include … “ and choose an option from the pop-up menu. Then select 
the albums, events, and faces you want to add (Faces is supported only by iPhoto 8.1 
or later).
Â If you want to add videos from iPhoto, select “Include videos.”
4 Click Apply.
Each time you connect iPod nano to your computer, photos are synced automatically.
To add photos from a folder on your hard disk to iPod nano:
1 Drag the images to a folder on your computer.
If you want images to appear in separate photo albums on iPod nano, create folders 
within the main image folder and drag images to the new folders.
2 In iTunes, select iPod nano in the device list and click the Photos tab.
3 Select “Sync photos from …” 
4 Choose “Choose Folder …” from the pop-up menu and select theimage folder.
5 Click Apply.
Adding Full-Resolution Image Files to iPod nano
When you add photos to iPod nano, iTunes optimizes the photos for viewing. 
Full-resolution image files aren’t transferred by default. Adding full-resolution image 
files is useful, for example if you want to move them from one computer to another, 
but isn’t necessary for viewing the images at full quality on iPod nano.
To add full-resolution image files to iPod nano:
1 In iTunes, select iPod nano in the device list and click the Photos tab.
2 Select “Include full-resolution photos.”
3 Click Apply.
iTunes copies the full-resolution versions of the photos to the Photos folder on 
iPod nano.
To delete photos from iPod nano:
1 In iTunes, select iPod nano in the device list and click the Photos tab.
2 Select “Sync photos from: …”
Â On a Mac, choose iPhoto from the pop-up menu.
Â On a Windows PC, choose Photoshop Album or Photoshop Elements from the pop-up 
menu.
3 Choose “Selected albums” and deselect the albums you no longer want on iPod nano.
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Viewing Photos
You can view photos on iPod nano manually or as a slideshow. If you have an optional 
AV cable from Apple (for example, the Apple Component AV Cable), you can connect 
iPod nano to your TV and view photos as a slideshow with music.
Viewing Photos on iPod nano
To view photos on iPod nano:
1 On iPod nano, choose Photos > All Photos. Or choose Photos and a photo album 
to see only the photos in the album. Thumbnail views of the photos might take a 
moment to appear.
2 Select the photo you want and press the Center button.
3 To view photos, hold iPod nano vertically for portrait format, or horizontally for 
landscape format.
From any photo-viewing screen, use the Click Wheel to scroll through photos (if you’re 
viewing a slideshow, the Click Wheel controls music volume only). Press Next/Fastforward (‘) or Previous/Rewind (]) to skip to the next or previous screen of photos. 
Press and hold Next/Fast-forward (‘) or Previous/Rewind (]) to skip to the last or first 
photo in the library or album.70 Chapter 7    Photo Features 
Viewing Slideshows
You can view a slideshow, with music and transitions if you choose, on iPod nano. 
If you have an optional AV cable from Apple, you can view the slideshow on your TV.
To set slideshow settings:
m Choose Photos > Settings, and then follow these instructions:
To view a slideshow on iPod nano:
m Select any photo, album, or roll, and press Play/Pause (’). Or select any full-screen 
photo and press the Center button. To pause, press Play/Pause (’). To skip to the next 
or previous photo, press Next/Fast-forward (‘) or Previous/Rewind (]).
When you view a slideshow, you can use the Click Wheel to control the music volume 
and adjust the brightness. You can’t use the Click Wheel to scroll through photos 
during a slideshow.
If you view a slideshow of an album that includes videos, the slideshow pauses when it 
reaches a video. If music is playing, it continues to play. If you play the video, the music 
pauses while the video is playing, and then resumes. To play the video, press Play/Pause 
(’). To resume the slideshow, press Next/Fast-Forward (‘).
To adjust the brightness during a slideshow:
1 Press the Center button until the brightness indicator appears.
2 Use the Click Wheel to adjust the brightness.
To set Do this
How long each slide is shown Choose Time Per Slide and pick a time.
The music that plays during 
slideshows
Choose Music and choose a playlist or Now Playing. If you’re using 
iPhoto, you can choose From iPhoto to copy the iPhoto music 
setting. Only the songs that you’ve added to iPod nano play.
Slides to repeat Set Repeat to On.
Slides to display in random 
order
Set Shuffle Photos to On.
Slides to display with 
transitions
Choose Transitions and choose a transition type. Random includes 
all transition types except Ken Burns.
Slideshows to display on 
iPod nano
Set TV Out to Ask or Off.
Slideshows to display on TV Set TV Out to Ask or On.
If you set TV Out to Ask, iPod nano gives you the option of showing 
slideshows on TV or on iPod nano every time you start a slideshow.
Slides to show on a PAL 
or NTSC TV
Set TV Signal to PAL or NTSC.
PAL and NTSC refer to TV broadcast standards. Your TV might use 
either of these, depending on the region where it was purchased. 
If you aren’t sure which your TV uses, check the documentation 
that came with your TV.Chapter 7    Photo Features 71
To connect iPod nano to your TV:
1 Connect the optional Apple Component or Composite AV cable to iPod nano.
Use the Apple Component AV Cable, Apple Composite AV Cable, or Apple AV 
Connection Kit. Other similar RCA-type cables might not work. You can purchase the 
cables at www.apple.com/ipodstore.
2 Connect the audio connectors to the ports on your TV.
Make sure you set TV Out on iPod nano to Ask or On.
Your TV must have RCA video and audio ports. The ports on your TV or receiver may 
differ from the ports in the illustration.
To view a slideshow on your TV:
1 Connect iPod nano to your TV (see page 51).
2 Turn on your TV and set it to display from the input ports connected to iPod nano. 
See the documentation that came with your TV for more information.
3 Use iPod nano to play and control the slideshow.
Adding Photos from iPod nano to a Computer
If you add full-resolution photos from your computer to iPod nano using the previous 
steps, they’re stored in a Photos folder on iPod nano. You can connect iPod nano to a 
computer and put these photos on the computer. iPod nano must be enabled for disk 
use (see “Using iPod nano as an External Disk” on page 84).
To add photos from iPod nano to a computer:
1 Connect iPod nano to the computer.
2 Drag image files from the Photos folder or DCIM folder on iPod nano to the desktop 
or to a photo editing application on the computer.
You can also use a photo editing application, such as iPhoto, to add photos stored in 
the Photos folder. See the documentation that came with the application for more 
information.
To delete photos from the Photos folder on iPod nano:
1 Connect iPod nano to the computer.
2 Navigate to the Photos folder on iPod nano and delete the photos you no longer want.8
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8 More Settings, Extra Features, 
and Accessories
iPod nano can do a lot more than play songs. And you can do 
a lot more with it than listen to music.
Read this chapter to find out more about the extra features of iPod nano, including 
how to use it as a pedometer; record voice memos; use it as an external disk, alarm, or 
sleep timer; play games; show the time of day in other parts of the world; display notes; 
and sync contacts, calendars, and to-do lists. Learn about how to use iPod nano as a 
stopwatch and to lock the screen, and about the accessories available for iPod nano.
Using iPod nano as a Pedometer
You can use iPod nano as a pedometer to count your steps and record your workouts.
For more accurate results, keep iPod nano in your pocket or in the iPod nano Armband 
while using the pedometer.
To use iPod nano as a pedometer:
1 From the Extras menu, choose Fitness and then choose Pedometer.
2 If you’re using the pedometer for the first time, enter your weight using the Click 
Wheel, and then press the Center button to begin a session.
3 At the end of the session, press the Center button to stop.Chapter 8    More Settings, Extra Features, and Accessories 73
To customize the pedometer settings:
1 From the Extras menu, choose Fitness and then choose Settings.
2 Choose from the following options:
To view your workout history:
1 From the Extras menu, choose Fitness and then choose History.
2 Select a date from the calendar. Use the Click Wheel to select a day. Press Next/Fastforward (‘) or Previous/Rewind (]) to navigate through the months.
3 Press the Center button to display your workout history for the selected date. If you 
had multiple workout sessions on the selected date, choose a session.
iPod nano displays your step goal, workout duration, start and end times, calories 
burned, and totals for the week and month.
To view a bar graph of one of your workout sessions, choose a session, and then rotate 
iPod nano to landscape mode.
The Pedometer menu item appears in the main menu when the pedometer is on, so 
you can stop your session quickly. The preview panel below the main menu displays 
your step count when you scroll to the Pedometer menu item.
To set iPod nano to count your steps throughout the day, choose Pedometer in the 
Settings menu and select Always On. The Pedometer records your daily totals, so you 
can track your history without turning the pedometer off at the end of each day. The 
Pedometer menu item appears continuously in the main menu.
To start sessions quickly, you can also add the Pedometer menu item to the main menu 
manually. See“Adding or Removing Items on the Main Menu” on page 10.
With the Nike + iPod Sport Kit (available separately), iPod nano can also monitor and 
record your speed, distance, time elapsed, and calories burned, and track your cardio 
workouts on Nike + iPod-compatible gym equipment.
To  Do this
Choose a pedometer mode Select Pedometer, and press the Center button to switch between 
Manual and Always On.
Set a workout goal Choose Daily Step Goal, and then choose a goal from the list, or 
choose Custom and then use the Click Wheel to set a goal.
Set your weight Choose Weight, use the Click Wheel to set your weight, and then 
press the Center button to enter.
Set the pedometer orientation Choose Screen Orientation, and then choose Vertical, Left, or RIght.74 Chapter 8    More Settings, Extra Features, and Accessories 
When you sync iPod nano with iTunes, you can upload your pedometer and other 
workout information to the Nike+ website, where you can track your history, compete 
with your friends, and more. You’ll need a Nike+ account, which you can set up when 
you sync.
To upload your workout information to Nike+:
1 Connect iPod nano to your computer and open iTunes (if it doesn’t open 
automatically). If you’re syncing workout information for the first time, a message 
appears:
2 Click Send, and then follow the onscreen instructions to set up your Nike+ account.
Once you set up your account, a new tab appears in the iTunes window:
3 Click the Nike + iPod tab, and select “Automatically send workout data to Nike+” if it 
isn’t selected already.
4 Click Apply.
To view and share your information at Nike+, click “Visit Nike+” in the Nike + iPod pane 
when iPod nano is connected to your computer, or go to www.nike.com and then log 
in to your account.
Recording Voice Memos
You can record voice memos using the built-in microphone in iPod nano or an optional 
iPod nano–compatible microphone (available for purchase at www.apple.com/
ipodstore). You can set chapter marks while you record, store voice memos on 
iPod nano and sync them with your computer, and add labels to voice memos.
Voice memos can be up to two hours long. If you record for more than two hours, 
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To record a voice memo:
1 From the Extras menu, choose Voice Memos. The Record screen appears.
2 Press Play/Pause (’) or the Center button to begin recording. Be careful not to block 
the microphone, which is on the back of iPod nano.
3 To pause recording, press Play/Pause (’).
Choose Resume to continue recording or press Play/Pause (’) again.
4 When you finish, press Menu and then choose “Stop and Save.” Your saved recording is 
listed by date and time.
To set chapter marks:
m While recording, press the Center button whenever you want to set a chapter mark.
During playback, you can go directly to the next chapter by pressing the Next/Fastforward button. Press Previous/Rewind (]) once to go to the start of the current 
chapter, and twice to go to the start of the previous chapter.
To label a recording:
1 From the Extras menu, choose Voice Memos and then press Menu.
2 Choose Voice Memos, and then choose a recording.
3 Choose Label, and then choose a label for the recording.
You can choose Podcast, Interview, Lecture, Idea, Meeting, or Memo. To remove a label 
from a recording, choose None.
To play a recording:
1 From the Extras menu, choose Voice Memos and then press Menu.
2 Choose Voice Memos, and then choose a recording.
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To delete a recording:
1 From the Extras menu, choose Voice Memos and then press Menu.
2 Choose Voice Memos, and then choose a recording.
3 Choose Delete and then press the Center button.
To sync voice memos with your computer:
Voice memos are saved in a Recordings folder on iPod in the WAV file format. If you 
enable iPod nano for disk use, you can drag voice memos from the folder to copy them 
to your computer.
If iPod nano is set to sync songs automatically (see “Syncing Music Automatically” on 
page 25) voice memos on iPod nano are automatically synced to a playlist in iTunes 
called Voice Memos (and removed from iPod nano) when you connect iPod nano. The 
Voice Memos playlist appears below Playlists on the left side of the iTunes window.
Playing Games
iPod nano comes with three games: Klondike, Maze, and Vortex. 
To play a game:
m Choose Extras > Games and choose a game.
When you play a game created for previous versions of iPod nano, you’re first shown 
how iPod nano controls work in the game you’re about to play.
You can purchase additional games from the iTunes Store (in some countries) to play 
on iPod nano. After purchasing games in iTunes, you can add them to iPod nano by 
syncing them automatically or by managing them manually. 
Many games can be played in portrait or landscape mode.
To buy a game:
1 In iTunes, select iTunes Store under Store on the left side of the iTunes window.
2 Choose iPod Games in the iTunes Store.
3 Select the game you want and click Buy Game.
To sync games automatically to iPod nano:
1 In iTunes, select iPod nano in the device list and click the Games tab.
2 Select “Sync games.”
3 Click “All games” or “Selected games.” If you click “Selected games,” also select the 
games you want to sync.
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Using Extra Settings
You can set the date and time, clocks in different time zones, and alarm and sleep 
features on iPod nano. You can use iPod nano as a stopwatch or to play games, and you 
can lock the iPod nano screen.
Setting and Viewing the Date and Time
The date and time are set automatically from your computer’s clock when you connect 
iPod nano, but you can change the settings.
To set date and time options:
1 Choose Settings > Date & Time.
2 Choose one or more of the following options:
Adding Clocks for Other Time Zones
To add clocks for other time zones:
1 Choose Extras > Clocks.
2 On the Clocks screen, click the Center button and choose Add.
3 Choose a region and then choose a city.
The clocks you add appear in a list. The last clock you added appears last.
To delete a clock:
1 Choose Extras > Clocks.
2 Choose the clock.
3 Press the Center button.
4 Choose Delete.
To  Do this
Set the date Choose Date. Use the Click Wheel to change the selected value. 
Press the Center button to move to the next value.
Set the time Choose Time. Use the Click Wheel to change the selected value. 
Press the Center button to move to the next value.
Specify the time zone Choose Time Zone and use the Click Wheel to select a city in 
another time zone.
Display the time in 24-hour 
format
Choose 24 Hour Clock and press the Center button to turn the 
24-hour format on or off. 
Display the time in the title bar Choose Time in Title and press the Center button to turn the option 
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Setting Alarms
You can set an alarm for any clock on iPod nano.
To use iPod nano as an alarm clock:
1 Choose Extras > Alarms.
2 Choose Create Alarm and set one or more of the following options:
If you sync calendar events with alarms to iPod nano, the events appear in the Alarms 
menu.
To delete an alarm:
1 Choose Extras > Alarms.
2 Choose the alarm and then choose Delete.
Setting the Sleep Timer
You can set iPod nano to turn off automatically after playing music or other content for 
a specific period of time.
To set the sleep timer:
1 Choose Extras > Alarms.
2 Choose Sleep Timer and choose how long you want iPod nano to play.
To Do this
Turn the alarm on Choose Alarm and choose On.
Set the date Choose Date. Use the Click Wheel to change the selected value. 
Press the Center button to move to the next value.
Set the time Choose Time. Use the Click Wheel to change the selected value. 
Press the Center button to move to the next value.
Set a repeat option Choose Repeat and choose an option (for example, “weekdays”).
Choose a sound Choose Alerts or a playlist. If you choose Alerts, select Beep to hear 
the alarm through the internal speaker. If you choose a playlist, 
connect iPod nano to speakers, earphones, or headphones to hear 
the alarm.
Name the alarm Choose Label and choose an option (for example, “Wake up”).Chapter 8    More Settings, Extra Features, and Accessories 79
Using the Stopwatch
You can use the stopwatch as you exercise to track your overall time and, if you’re 
running on a track, your lap times. You can play music while you use the stopwatch.
To use the stopwatch:
1 Choose Extras > Stopwatch.
2 Press Play/Pause (’) to start the timer. 
3 Press the Center button to record lap times. The two most recent lap times appear 
above the overall time. All lap times are recorded in the log.
4 Press Play/Pause (’) to stop the overall timer. To start the timer again, press Play/Pause 
(’).
To start a new stopwatch session, press Menu and then choose New Timer.
To review or delete a logged stopwatch session:
1 Choose Extras > Stopwatch.
The current log and a list of saved sessions appear.
2 Choose a log to view session information.
iPod nano stores stopwatch sessions with dates, times, and lap statistics. You see the 
date and time the session started; the total time of the session; the shortest, longest, 
and average lap times; and the last several lap times.
3 Press the Center button and choose Delete Log to delete the chosen log, or Clear Logs 
to delete all current logs.
Locking the iPod nano Screen
You can set a combination to prevent iPod nano from being used by someone without 
your permission. If you lock iPod nano while it isn’t connected to a computer, you must 
then enter a combination to unlock and use it.
This combination is different from the Hold button, which just prevents iPod nano 
buttons from being pressed accidentally. The combination prevents another person 
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To set a combination for iPod nano:
1 Choose Extras > Screen Lock.
2 On the New Combination screen, enter a combination:
Â Use the Click Wheel to select a number for the first position. Press the Center button 
to confirm your choice and move to the next position. 
Â Use the same method to set the remaining numbers of the combination. Press Next/
Fast-forward (‘) to move to the next position, or Previous/Rewind (]) to move to 
the previous position. Press the Center button in the final position.
3 On the Confirm Combination screen, enter the combination to confirm it, or press 
Menu to exit without locking the screen.
When you finish, you return to the Screen Lock screen, where you can lock the screen 
or reset the combination. Press Menu to exit without locking the screen.
To lock the iPod nano screen:
m Choose Extras > Screen Lock > Lock.
If you just finished setting your combination, Lock will already be selected on the 
screen. Just press the Center button to lock iPod.
When the screen is locked, you see a picture of a lock. 
You might want to add the Screen Lock menu item to the main menu so that you can 
quickly lock the iPod nano screen. See “Adding or Removing Items on the Main Menu” 
on page 10.
When you see the lock on the screen, you can unlock the iPod nano screen in two 
ways:
Â Press the Center button to enter the combination on iPod nano. Use the Click Wheel 
to select the numbers and press the Center button to confirm them. If you enter the 
wrong combination, the lock remains. Try again.
Â Connect iPod nano to the primary computer you use it with, and iPod nano 
automatically unlocks.
If you try these methods and you still can’t unlock iPod nano, you can restore 
iPod nano. See “Updating and Restoring iPod Software” on page 92.
To change a combination you’ve already set:
1 Choose Extras > Screen Lock > Reset Combination.
2 On the Enter Combination screen, enter the current combination.
3 On the New Combination screen, enter and confirm a new combination.
If you can’t remember the current combination, the only way to clear it and enter a 
new one is to restore the iPod nano software. See “Updating and Restoring iPod 
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Syncing Contacts, Calendars, and To-Do Lists
iPod nano can store contacts, calendar events, and to-do lists for viewing on the go. 
You can use iTunes to sync the contact and calendar information on iPod nano with 
Address Book and iCal.
If you’re using Windows XP, and you use Windows Address Book or Microsoft Outlook 
2003 or later to store your contact information, you can use iTunes to sync the address 
book information on iPod nano. If you use Microsoft Outlook 2003 or later to keep a 
calendar, you can also sync calendar information.
To sync contacts or calendar information using Mac OS X:
1 Connect iPod nano to your computer.
2 In iTunes, select iPod nano in the device list and click the Contacts tab.
3 Do one of the following:
Â To sync contacts, in the Contacts section, select “Sync Address Book contacts,” and 
select an option:
Â To sync all contacts automatically, select “All contacts.”
Â To sync selected groups of contacts automatically, select “Selected groups” and 
select the groups you want to sync.
Â To copy contacts’ photos to iPod nano, when available, select “Include contacts’ 
photos.”
When you click Apply, iTunes updates iPod nano with the Address Book contact 
information you specified. 
Â To sync calendars, in the Calendars section, select “Sync iCal calendars,” and choose 
an option:
Â To sync all calendars automatically, choose “All calendars.”
Â To sync selected calendars automatically, choose “Selected calendars” and select 
the calendars you want to sync.
When you click Apply, iTunes updates iPod nano with the calendar information you 
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To sync contacts or calendars using Windows Address Book or Microsoft Outlook for 
Windows:
1 Connect iPod nano to your computer.
2 In iTunes, select iPod nano in the device list and click the Contacts tab.
3 Do one of the following:
Â To sync contacts, in the Contacts section, select “Sync contacts from” and choose 
Windows Address Book or Microsoft Outlook from the pop-up menu. Then select 
which contact information you want to sync.
Â To sync calendars from Microsoft Outlook, in the Calendars section, select “Sync 
calendars from Microsoft Outlook.”
4 Click Apply.
You can also add contact and calendar information to iPod nano manually. iPod nano 
must be enabled as an external disk (see “Using iPod nano as an External Disk” on 
page 84).
To add contact information manually: 
1 Connect iPod nano and open your favorite email or contacts application. You can add 
contacts using Palm Desktop, Microsoft Outlook, Microsoft Entourage, and Eudora, 
among others.
2 Drag contacts from the application’s address book to the Contacts folder on iPod nano.
In some cases, you might need to export contacts and then drag the exported file or 
files to the Contacts folder. See the documentation for your email or contacts 
application.
To add appointments and other calendar events manually:
1 Export calendar events from any calendar application that uses the standard iCal 
format (filenames end in .ics) or vCal format (filenames end in .vcs).
2 Drag the files to the Calendars folder on iPod nano. 
To add to-do lists to iPod nano manually, save them in a calendar file with an .ics or 
.vcs extension.
To view contacts on iPod nano:
m Choose Extras > Contacts.
To sort contacts by first or last name:
m Choose Settings > General > Sort Contacts, and then select First or Last.
To view calendar events:
m Choose Extras > Calendars > All Calendars, and then choose a calendar.
To view to-do lists:
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Mono Audio
Mono Audio combines the sound of the left and right channels into a monaural signal 
that’s played through both sides. This enables users with a hearing impairment in one 
ear to hear both channels with the other ear.
To turn Mono Audio on or off:
m Choose Settings > Playback > Mono Audio, and then select On or Off.
Using Spoken Menus for Accessibility
iPod nano features optional spoken menus, enabling visually impaired users to browse 
through their iPod nano content more easily. 
iTunes generates spoken menus using voices that are included in your computer’s 
operating system or that you may have purchased from third parties. Not all voices 
from computer operating systems or third parties are compatible with spoken menus, 
and not all languages are supported.
To use spoken menus, VoiceOver must be enabled on iPod nano. For more information, 
see “Setting Up VoiceOver” on page 32.
You must enable spoken menus in iTunes before you can activate them on iPod nano.
To enable spoken menus in iTunes:
1 Connect iPod nano to your computer.
2 In iTunes, select iPod nano in the device list and click the Summary tab.
3 Select “Enable spoken menus.” 
In Mac OS X, if you have VoiceOver turned on in Universal Access preferences, this 
option is selected by default.
4 Click Apply.
After iPod nano syncs with iTunes, spoken menus are enabled and activated on your 
iPod nano. iPod nano takes longer to sync if spoken menus are being enabled.
To deactivate spoken menus on iPod nano:
m Choose Settings > General > Spoken Menus and then choose Off.
To turn spoken menus on again, choose Settings > General > Spoken Menus, and then 
choose On.
If VoiceOver is enabled, turning off spoken menus doesn’t disable VoiceOver.
Note:  The Spoken Menus option appears in the Settings menu on iPod nano only if 
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Using iPod nano as an External Disk
You can use iPod nano as an external disk to store data files. 
You won’t see songs you add using iTunes in the Mac Finder or in Windows Explorer. 
And if you copy music files to iPod nano in the Mac Finder or Windows Explorer, you 
won’t be able to play them on iPod nano.
Important:  To import photos and recorded videos from iPod nano to your computer, 
external disk use must be enabled.
To enable iPod nano as an external disk:
1 In iTunes, select iPod nano in the device list and click the Summary tab.
2 In the Options section, select “Enable disk use.”
3 Click Apply.
When you use iPod nano as an external disk, the iPod nano disk icon appears on 
the desktop on a Mac, or as the next available drive letter in Windows Explorer on a 
Windows PC. Drag files to and from iPod nano to copy them.
You can also click Summary and select “Manually manage music and videos” in the 
Options section to use iPod nano as an external disk. 
If you use iPod nano primarily as an external disk, you might want to keep iTunes from 
opening automatically when you connect iPod nano to your computer.
To prevent iTunes from opening automatically when you connect iPod nano to your 
computer:
1 In iTunes, select iPod nano in the device list and click the Summary tab.
2 In the Options section, deselect “Open iTunes when this iPod is connected.”
3 Click Apply.
Storing and Reading Notes
You can store and read text notes on iPod nano, if it’s enabled as an external disk 
(see “Using iPod nano as an External Disk” on page 84).
1 Save a document in any word-processing application as a text (.txt) file.
2 Place the file in the Notes folder on iPod nano.
To view notes:
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Learning About iPod nano Accessories
iPod nano comes with some accessories, and many other accessories are available. 
To purchase iPod nano accessories, go to www.apple.com/ipodstore. 
Available accessories include:
Â iPod nano Armband
Â Apple Earphones with Remote and Mic
Â Apple In-Ear Headphones with Remote and Mic
Â Apple USB Power Adapter 
Â Apple Component AV Cable
Â Apple Composite AV Cable
Â Apple Universal Dock
Â Nike + iPod Sport Kit
Â iPod Socks
To use the earphones included with iPod nano:
m Plug the earphones into the Headphones port. Then place the earbuds in your ears as 
shown.
WARNING:  Permanent hearing loss may occur if earbuds or headphones are used at 
high volume. You can adapt over time to a higher volume of sound that may sound 
normal but can be damaging to your hearing. If you experience ringing in your ears or 
muffled speech, stop listening and have your hearing checked. The louder the volume, 
the less time is required before your hearing could be affected. Hearing experts 
suggest that to protect your hearing:
Â Limit the amount of time you use earbuds or headphones at high volume.
Â Avoid turning up the volume to block out noisy surroundings. 
Â Turn the volume down if you can’t hear people speaking near you.
For information about setting a maximum volume limit on iPod, see “Setting the 
Maximum Volume Limit” on page 45.
The earphone
cord is adjustable.9
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9 Tips and Troubleshooting
Most problems with iPod nano can be solved quickly by 
following the advice in this chapter.
General Suggestions
Most problems with iPod nano can be solved by resetting it. First, make sure iPod nano 
is charged.
To reset iPod nano:
1 Toggle the Hold switch on and off (slide it to HOLD and then back again).
2 Press and hold Menu and the Center button for at least 6 seconds, until the 
Apple logo appears.
If iPod nano won’t turn on or respond
Â Make sure the Hold switch isn’t set to HOLD.
Â The iPod nano battery might need to be recharged. Connect iPod nano to your 
computer or to an Apple USB Power Adapter and let the battery recharge. Look for 
the lightning bolt icon on the iPod nano screen to verify that iPod nano is receiving 
a charge.
To charge the battery, connect iPod nano to a USB 2.0 port on your computer. 
Â Try the 5 Rs, one by one, until iPod nano responds.
The 5 Rs:  Reset, Retry, Restart, Reinstall, Restore
Remember these five basic suggestions if you have a problem with iPod nano. 
Try these steps one at a time until your issue is resolved. If one of the following 
doesn’t help, read on for solutions to specific problems. 
Â Reset iPod nano. See “General Suggestions,” below.
Â Retry with a different USB port if you cannot see iPod nano in iTunes.
Â Restart your computer, and make sure you have the latest software updates installed.
Â Reinstall iTunes software from the latest version on the web.
Â Restore iPod nano. See “Updating and Restoring iPod Software” on page 92.Chapter 9    Tips and Troubleshooting 87
If you want to disconnect iPod nano, but you see the message “Connected” or “Sync 
in Progress”
Â If iPod nano is syncing music, wait for it to complete.
Â Select iPod nano in the iTunes device list and click the Eject (C) button.
Â If iPod nano disappears from the device list in iTunes, but you still see the 
“Connected” or “Sync in Progress” message on the iPod nano screen, disconnect 
iPod nano.
Â If iPod nano doesn’t disappear from the device list in iTunes, drag the iPod nano icon 
from the desktop to the Trash if you’re using a Mac. If you’re using a Windows PC, 
eject the device in My Computer or click the Safely Remove Hardware icon in the 
system tray and select iPod nano. If you still see the “Connected” or “Sync in Progress” 
message, restart your computer and eject iPod nano again.
If iPod nano isn’t playing music
Â Make sure the Hold switch isn’t set to HOLD.
Â Make sure the headphone connector is pushed in all the way.
Â Make sure the volume is adjusted properly. A maximum volume limit might have 
been set. You can change or remove it by using Settings > Volume Limit. See “Setting 
the Maximum Volume Limit” on page 45.
Â iPod nano might be paused. Try pressing Play/Pause (’).
Â Make sure you’re using iTunes 9.0 or later (available at www.apple.com/downloads). 
Songs purchased from the iTunes Store using earlier versions of iTunes won’t play on 
iPod nano until you upgrade iTunes.
Â If you’re using the Apple Universal Dock, make sure the iPod nano is seated firmly in 
the dock and make sure all cables are connected properly. 
If the internal speaker continues to play audio after you connect earphones or 
headphones to iPod nano
Â Disconnect and then reconnect the earphones or headphones.
If the internal speaker doesn’t start playing audio after you disconnect earphones or 
headphones from iPod nano
Â Any audio that’s playing pauses automatically when you disconnect earphones or 
headphones from iPod nano. Press Play/Pause (’) to resume.
Â The FM radio doesn’t play through the internal speaker, because iPod nano uses the 
earphone or headphone cord as the radio antenna.88 Chapter 9    Tips and Troubleshooting 
If you connect iPod nano to your computer and nothing happens
Â Make sure you’ve installed the latest iTunes software from www.apple.com/downloads.
Â Try connecting to a different USB port on your computer. 
Note:  A USB 2.0 port is recommended to connect iPod nano. USB 1.1 is significantly 
slower than USB 2.0. If you have a Windows PC that doesn’t have a USB 2.0 port, in 
some cases you can purchase and install a USB 2.0 card. For more information, go to 
www.apple.com/ipod. 
Â iPod nano might need to be reset (see page 86). 
Â If you’re connecting iPod nano to a portable computer using the Apple Dock 
Connector to USB 2.0 Cable, connect the computer to a power outlet before 
connecting iPod nano.
Â Make sure you have the required computer and software. See “If you want to doublecheck the system requirements” on page 91.
Â Check the cable connections. Unplug the cable at both ends and make sure 
no foreign objects are in the USB ports. Then plug the cable back in securely. 
Make sure the connectors on the cables are oriented correctly. They can be inserted 
only one way.
Â Try restarting your computer.
Â If none of the previous suggestions solves your problems, you might need to restore 
iPod nano software. See “Updating and Restoring iPod Software” on page 92.
If iPod nano displays a “Connect to Power” message
This message may appear if iPod nano is exceptionally low on power and the battery 
needs to be charged before iPod nano can communicate with your computer. To 
charge the battery, connect iPod nano to a USB 2.0 port on your computer. 
Leave iPod nano connected to your computer until the message disappears and 
iPod nano appears in iTunes or the Finder. Depending on how depleted the battery is, 
you may need to charge iPod nano for up to 30 minutes before it will start up. 
To charge iPod nano more quickly, use the optional Apple USB Power Adapter.
If iPod nano displays a “Use iTunes to restore” message
Â Make sure you have the latest version of iTunes on your computer (download it 
from www.apple.com/downloads).
Â Connect iPod nano to your computer. When iTunes opens, follow the onscreen 
prompts to restore iPod nano. 
Â If restoring iPod nano doesn’t solve the problem, iPod nano may need to be 
repaired. You can arrange for service at the iPod Service & Support website:
www.apple.com/support/ipodChapter 9    Tips and Troubleshooting 89
If songs or data sync more slowly over USB 2.0
Â If you sync a large number of songs or amount of data using USB 2.0 and the 
iPod nano battery is low, iPod nano syncs the information at a reduced speed in 
order to conserve battery power.
Â If you want to sync at higher speeds, you can stop syncing and keep the iPod nano 
connected so that it can recharge, or connect it to the optional iPod USB 2.0 Power 
Adapter. Let iPod nano charge for about an hour, and then resume syncing your 
music or data.
If you can’t add a song or other item to iPod nano
The song may have been encoded in a format that iPod nano doesn’t support. 
The following audio file formats are supported by iPod nano. These include formats 
for audiobooks and podcasting:
Â AAC (M4A, M4B, M4P, up to 320 Kbps)
Â Apple Lossless (a high-quality compressed format)
Â MP3 (up to 320 Kbps)
Â MP3 Variable Bit Rate (VBR)
Â WAV
Â AA (audible.com spoken word, formats 2, 3, and 4)
Â AIFF
A song encoded using Apple Lossless format has full CD-quality sound, but takes up 
only about half as much space as a song encoded using AIFF or WAV format. The same 
song encoded in AAC or MP3 format takes up even less space. When you import music 
from a CD using iTunes, it’s converted to AAC format by default.
Using iTunes for Windows, you can convert nonprotected WMA files to AAC or MP3 
format. This can be useful if you have a library of music encoded in WMA format. 
iPod nano doesn’t support WMA, MPEG Layer 1, MPEG Layer 2 audio files, or 
audible.com format 1.
If you have a song in iTunes that isn’t supported by iPod nano, you can convert it to a 
supported format. For information, see iTunes Help.
If iPod nano displays a “Connect to iTunes to activate Genius” message
You haven’t turned on Genius in iTunes, or you haven’t synced iPod nano since you 
turned on Genius in iTunes. See “Turning On Genius in iTunes” on page 22.90 Chapter 9    Tips and Troubleshooting 
If iPod nano displays a “Genius is not available for the selected song” message
Genius is on but is unable to make a Genius playlist using the selected song. New 
songs are added to the iTunes Store Genius database all the time, so try again soon.
If iPod nano can’t receive a radio signal
You haven’t connected earphones or headphones. Make sure the connection is 
complete, and try moving around the earphone or headphone cord.
If you accidentally set iPod nano to use a language you don’t understand
You can reset the language:
1 Press and hold Menu until the main menu appears.
2 Use the Click Wheel to find the menu item that causes the iPod nano device name to 
appear in the preview panel, and then choose it. That’s the Settings menu.
3 Choose the last menu item (Reset Settings).
4 Choose the first item (Reset) and select a language.
Other iPod nano settings, such as song repeat, are also reset. Your synced content is 
not deleted or modified.
If you can’t find the Reset Settings menu item, you can restore iPod nano to its original 
state and choose a language. See “Updating and Restoring iPod Software” on page 92.
If you can’t see videos or photos on your TV
Â Use RCA-type cables made specifically for iPod nano, such as the Apple Component 
or Apple Composite AV cables, to connect iPod nano to your TV. Other similar RCAtype cables won’t work.
Â Make sure your TV is set to display images from the correct input source (see the 
documentation that came with your TV).
Â Make sure all cables are connected correctly (see “Watching Videos on a TV 
Connected to iPod nano” on page 50).
Â Make sure the yellow end of the Apple Composite AV Cable is connected to the 
video port on your TV.
Â If you’re trying to view a video, choose Videos > Settings and set TV Out to On, and 
then try again. If you’re trying to view a slideshow, choose Photos > Slideshow 
Settings and set TV Out to On, and then try again.
Â If that doesn’t work, choose Videos > Settings (for video) or Photos > Settings (for a 
slideshow) and set TV Signal to PAL or NTSC, depending on which type of TV you 
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If you want to double-check the system requirements
To use iPod nano, you must have:
Â One of the following computer configurations:
Â A Mac with a USB 2.0 port
Â A Windows PC with a USB 2.0 port or a USB 2.0 card installed
Â One of the following operating systems:
Â Mac OS X v10.4.11 or later
Â Windows Vista
Â Windows XP Home or Professional with Service Pack 3 or later
Â iTunes 9 or later (iTunes can be downloaded from www.apple.com/downloads)
If your Windows PC doesn’t have a USB 2.0 port, you can purchase and install a USB 2.0 
card. For more information about cables and compatible USB cards, go to 
www.apple.com/ipod.
On a Mac, iPhoto 7.1.5 or later is recommended for adding photos and albums to 
iPod nano. iPhoto 8.1 or later is required to use all iPod nano photo features. This 
software is optional. iPhoto might already be installed on your Mac. Check the 
Applications folder.
On both Mac and Windows PC, iPod nano can sync digital photos from folders on your 
computer’s hard disk.
If you want to use iPod nano with a Mac and a Windows PC
If you’re using iPod nano with a Mac and you want to use it with a Windows PC, you 
must restore the iPod software for use with the PC (see “Updating and Restoring iPod 
Software” on page 92). Restoring the iPod software erases all data from iPod nano, 
including all songs.
You cannot switch from using iPod nano with a Mac to using it with a Windows PC 
without erasing all data on iPod nano.
If you lock the iPod nano screen and can’t unlock it
Normally, if you can connect iPod nano to the computer it’s authorized to work with, 
iPod nano automatically unlocks. If the computer authorized to work with iPod nano is 
unavailable, you can connect iPod nano to another computer and use iTunes to restore 
iPod software. See the next section for more information.
If you want to change the screen lock combination and you can’t remember the 
current combination, you must restore the iPod software and then set a new 
combination.92 Chapter 9    Tips and Troubleshooting 
Updating and Restoring iPod Software
You can use iTunes to update or restore iPod software. It’s recommended that you 
update iPod nano to use the latest software. You can also restore the software, 
which puts iPod nano back to its original state.
Â If you choose to update, the software is updated, but your settings and songs aren’t 
affected. 
Â If you choose to restore, all data is erased from iPod nano, including songs, videos, 
files, contacts, photos, calendar information, and any other data. All iPod nano 
settings are restored to their original state.
To update or restore iPod nano:
1 Make sure you have an Internet connection and have installed the latest version of 
iTunes from www.apple.com/downloads.
2 Connect iPod nano to your computer.
3 In iTunes, select iPod nano in the device list and click the Summary tab.
The Version section tells you whether iPod nano is up to date or needs a newer version 
of the software. 
4 Click Update to install the latest version of the software.
5 If necessary, click Restore to restore iPod nano to its original settings (this erases all data 
from iPod nano). Follow the onscreen instructions to complete the restore process.10
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10 Safety and Cleaning
Read the following important safety and handling 
information before using iPod nano to avoid injury.
Keep this safety information and the iPod nano User Guide handy for future reference. 
For downloadable versions of the iPod nano User Guide and the latest safety 
information, visit support.apple.com/manuals/ipod.
Important Safety Information
Handling iPod nano  Do not drop, disassemble, open, crush, bend, deform, puncture, 
shred, microwave, incinerate, paint, or insert foreign objects into iPod nano.
Avoiding water and wet locations  Do not use iPod nano in rain, or near washbasins or 
other wet locations. Take care not to spill any food or liquid on iPod nano. In case 
iPod nano gets wet, unplug all cables, turn iPod nano off, and slide the Hold switch to 
HOLD before cleaning, and allow it to dry thoroughly before turning it on again. Do not 
attempt to dry iPod nano with an external heat source such as a microwave oven or 
hair dryer. An iPod nano that has been damaged as a result of exposure to liquids is 
not serviceable.
± Read all safety information below and operating instructions before using 
iPod to avoid injury. 
WARNING:  Failure to follow these safety instructions could result in fire, electric shock, 
or other injury or damage.94 Chapter 10    Safety and Cleaning 
Repairing iPod nano  Never attempt to repair iPod nano yourself. iPod nano does not 
contain any user-serviceable parts. If iPod nano has been submerged in water, 
punctured, or subjected to a severe fall, do not use it until you take it to an Apple 
Authorized Service Provider. For service information, choose iPod Help from the Help 
menu in iTunes or go to www.apple.com/support/ipod. The rechargeable battery in 
iPod nano should be replaced only by an Apple Authorized Service Provider. For more 
information about batteries, go to www.apple.com/batteries.
Charging iPod nano  To charge iPod nano, only use the included Apple Dock 
Connector to USB Cable with an Apple USB Power Adapter, or a high-power USB port 
on another device that is compliant with the USB 2.0 standard; another Apple branded 
product or accessory designed to work with iPod; or a third-party accessory certified to 
use the Apple “Made for iPod” logo.
Read all safety instructions for any products and accessories before using with 
iPod nano. Apple is not responsible for the operation of third party accessories or their 
compliance with safety and regulatory standards.
When you use the Apple USB Power Adapter (sold separately at www.apple.com/
ipodstore) to charge iPod nano, make sure that the power adapter is fully assembled 
before you plug it into a power outlet. Then insert the Apple USB Power Adapter firmly 
into the power outlet. Do not connect or disconnect the Apple USB Power Adapter 
with wet hands. Do not use any power adapter other than an Apple iPod power 
adapter to charge your iPod.
The Apple USB Power Adapter may become warm during normal use. Always allow 
adequate ventilation around the Apple USB Power Adapter and use care when handling.
Unplug the Apple USB Power Adapter if any of the following conditions exist:
Â The power cord or plug has become frayed or damaged.
Â The adapter is exposed to rain, liquids, or excessive moisture.
Â The adapter case has become damaged.
Â You suspect the adapter needs service or repair.
Â You want to clean the adapter.
Avoiding hearing damage  Permanent hearing loss may occur if the internal speaker, 
earbuds or headphones are used at high volume. Set the volume to a safe level. You 
can adapt over time to a higher volume of sound that may sound normal but can be 
damaging to your hearing. If you experience ringing in your ears or muffled speech, 
stop listening and have your hearing checked. The louder the volume, the less time is 
required before your hearing could be affected. Hearing experts suggest that to protect 
your hearing:
Â Limit the amount of time you use earbuds or headphones at high volume.
Â Avoid turning up the volume to block out noisy surroundings.Chapter 10    Safety and Cleaning 95
Â Turn the volume down if you can’t hear people speaking near you.
For information about how to set a maximum volume limit on iPod nano, see “Setting 
the Maximum Volume Limit” on page 45.
Driving and riding safely  Use of iPod nano alone, or with headphones (even if used 
in only one ear) while operating a vehicle is not recommended and is illegal in some 
areas. Check and obey the laws and regulations on the use of mobile devices like 
iPod nano in areas where you drive or ride. Be careful and attentive while driving or 
riding a bicycle. Stop using iPod nano if you find it disruptive or distracting while 
operating any type of vehicle, or performing any other activity that requires your 
full attention.
Seizures, blackouts, and eye strain  A small percentage of people may be susceptible 
to blackouts or seizures (even if they have never had one before) when exposed to 
flashing lights or light patterns such as when playing games or watching video. If you 
have experienced seizures or blackouts or have a family history of such occurrences, 
please consult a physician before playing games (if available) or watching videos on 
your iPod nano. Discontinue use and consult a physician if you experience: headaches, 
blackouts, seizures, convulsion, eye or muscle twitching, loss of awareness, involuntary 
movements, or disorientation. To reduce risk of headaches, blackouts, seziures, and 
eyestrain, avoid prolonged use, hold iPod nano some distance from your eyes, use 
iPod nano in a well lit room, and take frequent breaks.
Glass parts  The outside cover of the display on iPod nano is made of glass. This glass 
could break if iPod nano is dropped on a hard surface or receives a substantial impact. 
If the glass chips or cracks, do not touch or attempt to remove the broken glass. Stop 
using iPod nano until the glass is replaced by an Apple Authorized Service Provider. 
Glass cracked due to misuse or abuse is not covered under the warranty.
Repetitive motion  When you perform repetitive activities such as playing games on 
iPod nano, you may experience occasional discomfort in your hands, arms, shoulders, 
neck, or other parts of your body. Take frequent breaks and if you have discomfort 
during or after such use, stop use and see a physician.
Exercising  Before starting any exercise program, you should have a complete physical 
examination by your physician. Do a warmup or stretching exercise before beginning 
any workout. Be careful and attentive while exercising. Slow down, if necessary, before 
adjusting your device while running. Stop exercising immediately if you feel pain, or 
feel faint, dizzy, exhausted, or short of breath. By exercising, you assume the risks 
inherent in physical exercise, including any injury that may result from such activity.96 Chapter 10    Safety and Cleaning 
Important Handling Information
Carrying iPod nano  iPod nano contains sensitive components, including, in some 
cases, a hard drive. Do not bend, drop, or crush iPod nano. If you are concerned about 
scratching iPod nano, you can use one of the many cases sold separately.
Using connectors and ports  Never force a connector into a port. Check for 
obstructions on the port. If the connector and port don’t join with reasonable ease, 
they probably don’t match. Make sure that the connector matches the port and that 
you have positioned the connector correctly in relation to the port.
Operating iPod nano in acceptable temperatures  Operate iPod nano in a place where 
the temperature is always between 0º and 35º C (32º to 95º F). In low-temperature 
conditions, iPod nano play time may temporarily shorten and battery charge time may 
temporarily lengthen.
Store iPod nano in a place where the temperature is always between -20º and 45º C 
(-4º to 113º F). Don’t leave iPod nano in your car, because temperatures in parked cars 
can exceed this range.
When you’re using iPod nano or charging the battery, it is normal for iPod nano to get 
warm. The exterior of iPod nano functions as a cooling surface that transfers heat from 
inside the unit to the cooler air outside.
Keeping the outside of iPod nano clean  To clean iPod nano, unplug all cables, turn 
iPod nano off, and slide the Hold switch to HOLD. Then use a soft, slightly damp, lintfree cloth. Avoid getting moisture in openings. Don’t use window cleaners, household 
cleaners, aerosol sprays, solvents, alcohol, ammonia, or abrasives to clean iPod nano.
Disposing of iPod nano properly  For information about the proper disposal of 
iPod nano, including other important regulatory compliance information, see 
“Regulatory Compliance Information” on page 98.
NOTICE:  Failure to follow these handling instructions could result in damage to 
iPod nano or other property.11
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11 Learning More, Service, 
and Support 
You can find more information about using iPod nano in 
onscreen help and on the web.
The following table describes where to get more iPod-related software and service 
information.
To learn about Do this
Service and support, 
discussions, tutorials, and 
Apple software downloads
Go to:  www.apple.com/support/ipodnano
Using iTunes Open iTunes and choose Help > iTunes Help. 
For an online iTunes tutorial (available in some areas only), go to:   
www.apple.com/support/itunes
Using iPhoto (on Mac OS X) Open iPhoto and choose Help > iPhoto Help.
Using iCal (on Mac OS X) Open iCal and choose Help > iCal Help.
The latest information on 
iPod nano
Go to:  www.apple.com/ipodnano
Registering iPod nano To register iPod nano, install iTunes on your computer and connect 
iPod nano.
Finding the iPod nano serial 
number
Look at the back of iPod nano or choose Settings > About and 
press the Center button. In iTunes (with iPod nano connected to 
your computer), select iPod nano in the device list and click the 
Settings tab.
Obtaining warranty service First follow the advice in this booklet, the onscreen help, and 
online resources. Then go to:  www.apple.com/support/ipodnano98    
Regulatory Compliance Information
FCC Compliance Statement
This device complies with part 15 of the FCC rules. 
Operation is subject to the following two conditions: 
(1) This device may not cause harmful interference, 
and (2) this device must accept any interference 
received, including interference that may cause 
undesired operation. See instructions if interference 
to radio or TV reception is suspected.
Radio and TV Interference
This computer equipment generates, uses, and can 
radiate radio-frequency energy. If it is not installed 
and used properly—that is, in strict accordance with 
Apple’s instructions—it may cause interference with 
radio and TV reception.
This equipment has been tested and found to 
comply with the limits for a Class B digital device in 
accordance with the specifications in Part 15 of FCC 
rules. These specifications are designed to provide 
reasonable protection against such interference in a 
residential installation. However, there is no 
guarantee that interference will not occur in a 
particular installation.
You can determine whether your computer system is 
causing interference by turning it off. If the 
interference stops, it was probably caused by the 
computer or one of the peripheral devices.
If your computer system does cause interference to 
radio or TV reception, try to correct the interference 
by using one or more of the following measures:
Â Turn the TV or radio antenna until the interference 
stops.
Â Move the computer to one side or the other of the 
TV or radio.
Â Move the computer farther away from the TV or 
radio.
Â Plug the computer in to an outlet that is on a 
different circuit from the TV or radio. (That is, make 
certain the computer and the TV or radio are on 
circuits controlled by different circuit breakers or 
fuses.)
If necessary, consult an Apple Authorized Service 
Provider or Apple. See the service and support 
information that came with your Apple product. Or, 
consult an experienced radio/TV technician for 
additional suggestions.
Important:  Changes or modifications to this product 
not authorized by Apple Inc. could void the EMC 
compliance and negate your authority to operate 
the product.
This product was tested for EMC compliance under 
conditions that included the use of Apple peripheral 
devices and Apple shielded cables and connectors 
between system components. 
It is important that you use Apple peripheral devices 
and shielded cables and connectors between system 
components to reduce the possibility of causing 
interference to radios, TV sets, and other electronic 
devices. You can obtain Apple peripheral devices and 
the proper shielded cables and connectors through 
an Apple Authorized Reseller. For non-Apple 
peripheral devices, contact the manufacturer or 
dealer for assistance. 
Responsible party (contact for FCC matters only):
Apple Inc. Corporate Compliance
1 Infinite Loop, MS 26-A
Cupertino, CA 95014
Industry Canada Statement
This Class B device meets all requirements of the 
Canadian interference-causing equipment 
regulations.
Cet appareil numérique de la classe B respecte 
toutes les exigences du Règlement sur le matériel 
brouilleur du Canada.
VCCI Class B Statement
Korea Class B Statement
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Russia
European Community
Battery Replacement
The rechargeable battery in iPod nano should be 
replaced only by an authorized service provider. For 
battery replacement services go to:    
www.apple.com/support/ipod/service/battery
Disposal and Recycling Information
Your iPod must be disposed of properly according to 
local laws and regulations. Because this product 
contains a battery, the product must be disposed of 
separately from household waste. When your iPod 
reaches its end of life, contact Apple or your local 
authorities to learn about recycling options. 
For information about Apple’s recycling program, 
go to:  www.apple.com/environment/recycling
Deutschland:  Dieses Gerät enthält Batterien. Bitte 
nicht in den Hausmüll werfen. Entsorgen Sie dieses 
Gerätes am Ende seines Lebenszyklus entsprechend 
der maßgeblichen gesetzlichen Regelungen.
Nederlands:  Gebruikte batterijen kunnen worden 
ingeleverd bij de chemokar of in een speciale 
batterijcontainer voor klein chemisch afval (kca) 
worden gedeponeerd.
China:
Taiwan:  
European Union—Disposal Information:  
This symbol means that according to local laws and 
regulations your product should be disposed of 
separately from household waste. When this product 
reaches its end of life, take it to a collection point 
designated by local authorities. Some collection 
points accept products for free. The separate 
collection and recycling of your product at the time 
of disposal will help conserve natural resources and 
ensure that it is recycled in a manner that protects 
human health and the environment.
Apple and the Environment 
At Apple, we recognize our responsibility to 
minimize the environmental impacts of our 
operations and products.
For more information, go to:
www.apple.com/environment
© 2009 Apple Inc. All rights reserved. Apple, the Apple logo, iCal, iLife, 
iPhoto, iPod, iPod nano, iPod Socks, iTunes, Mac, Macintosh, and Mac 
OS are trademarks of Apple Inc., registered in the U.S. and other 
countries. Finder, the FireWire logo, and Shuffle are trademarks of 
Apple Inc. iTunes Store is a service mark of Apple Inc., registered in the 
U.S. and other countries. NIKE is a trademark of NIKE, Inc. and its 
affiliates and is used under license. Other company and product 
names mentioned herein may be trademarks of their respective 
companies.
Mention of third-party products is for informational purposes only and 
constitutes neither an endorsement nor a recommendation. Apple 
assumes no responsibility with regard to the performance or use of 
these products. All understandings, agreements, or warranties, if any, 
take place directly between the vendors and the prospective users. 
Every effort has been made to ensure that the information in this 
manual is accurate. Apple is not responsible for printing or clerical 
errors.
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Index
A
accessibility
using spoken menus  83
accessing additional options  6, 39
accessories for iPod  85
adding album artwork  21
adding menu items  10, 45
adding music
disconnecting iPod  13
from more than one computer  25, 27
manually  30
methods  24
On-The-Go playlists  42
tutorial  97
adding other content  30
adding photos
about  67
all or selected photos  67, 68
from computer to iPod  67
from iPod to computer  71
full-resolution image  68
address book, syncing  81
alarms
deleting  78
setting  78
album, browsing by  42
album artwork
adding  21
viewing  37
Apple USB Power Adapter  16
charging the battery  17
artist, browsing by  42
audiobooks  48
adding to iPod nano  29
setting play speed  48
automatic syncing  25, 27
AV cables  50, 51, 71
B
backlight
setting timer  11
turning on  6, 11
battery
charge states when disconnected  17
charging  16
Energy Saver  18
improving performance  18
rechargeable  18
replacing  18
very low  88
viewing charge status  16
brightness setting  11
browsing
by album  42
by artist  42
quickly  11, 38
songs  6, 34
videos  6
with Cover Flow  37, 38
buttons
Center  5
disabling with Hold switch  6
Eject  15
C
calendar events, syncing  81
Camera Roll  54
Center button, using  5, 34
Charging, Please Wait message  88
charging the battery
about  16
using the Apple USB Power Adapter  17
using your computer  16
when battery very low  88
cleaning iPod  96
Click Wheel
browsing songs  34
turning off the Click Wheel sound  11
using  5
clocks
adding for other time zones  77
settings  77
close captions  51
compilations  45
component AV cable  50, 51, 71Index 101
composite AV cable  50, 51, 71
computer
adding photos to iPod  67
charging the battery  16
connecting iPod  13
getting photos from iPod  71
problems connecting iPod  88
requirements  91
connecting iPod
about  13
charging the battery  16
to a TV  51, 71
contacts
sorting  82
syncing  81
controls
disabling with Hold switch  8
using  5
converting unprotected WMA files  89
Cover Flow  37, 38
crossfading  47
customizing the Music menu  45
D
data files, storing on iPod  84
date and time
setting  77
viewing  77
determining battery charge  17
diamond icon on scrubber bar  6
digital photos. See photos
disconnecting iPod
about  13
during music update  13
ejecting first  14
instructions  15
troubleshooting  87
disk, using iPod as  84
displaying time in title bar  77
downloading
See also adding; syncing
E
Eject button  15
ejecting before disconnecting  13, 14
Energy Saver  18
external disk, using iPod as  55, 84
F
fast-forwarding a song or video  6
file formats, supported  89
finding your iPod serial number  8
fit video to screen  51
font size
setting  10
full-resolution images  68
G
games  76
buying games  76
Genius
creating a playlist  7, 40
Genius slider  35
playing a playlist  7, 40, 41
saving a playlist  7, 40
syncing to iPod nano  26
turning on in iTunes  22
using on iPod nano  39
Genius Mixes
playing  7, 40
syncing to iPod nano  26
getting help  97
getting information about your iPod  12
getting started with iPod  91
H
hearing loss warning  85
help, getting  97
Hold switch  6, 8
I
iCal, getting help  97
images. See photos
importing
video  22
importing contacts, calendars, and to-do lists. See 
syncing
iPhoto
getting help  97
importing camera videos  56
recommended version  91
iPod Dock  13
iPod Dock Connector  13
iPod Updater application  92
iTunes
ejecting iPod  15
getting help  97
setting not to open automatically  84
Sound Check  47
iTunes U  29, 48, 50
L
language
resetting  90
specifying  10
letterbox  51
lightning bolt on battery icon  16
Live Pause  61
navigating  63
locating your iPod serial number  8102 Index
locking iPod screen  79, 80
lyrics
adding  21
viewing on iPod  37
M
Mac OS X operating system  91
main menu
adding or removing items  10
opening  5
returning to  6
settings  10, 45
using  9
Managing iPod manually  25
managing iPod manually  30
manually adding  30
maximum volume limit, setting  45
memos, recording  74
menu items
adding or removing  10, 45
choosing  6
returning to main menu  6
returning to previous menu  6
modifying playlists  31
movies
See also videos
music
iPod not playing  87
rating  36
setting for slideshows  70
tutorial  97
See also adding music; songs
Music menu, customizing  45
music videos
syncing  26
N
navigating quickly  11
notes, storing and reading  84
Now Playing screen
moving to any point in a song or video  6
scrubber bar  6
NTSC TV  50, 70
O
On-The-Go playlists
copying to computer  42
making  39, 41
rating songs  36
saving  42
operating system requirements  91
organizing your music  21
P
PAL TV  50, 70
pausing
a song  6
a video  6
Pedometer  72
settings  73
workout history  73
phone numbers, syncing  81
photo library  67
photos
adding to iPod nano  67
deleting  68, 71
full-resolution  68
importing  67
syncing  67, 68
viewing on iPod  69
viewing slideshows  70
playing
games  76
songs  6
videos  6
playlists
adding songs  6, 31
making on iPod  39, 41
modifying  31
On-The-Go  39, 41
plug on battery icon  16
podcasting  47
podcasts
listening  47
updating  28
ports
RCA video and audio  51, 71
USB  91
preview panel  10
previous menu, returning to  6
problems. See troubleshooting
Q
quick navigation  11
R
Radio  58
antenna  58, 90
Live Pause  61
Radio menu  65
screens  59
tagging songs  64
tuning  60
random play  6
rating songs  36
RCA video and audio ports  51, 71
rechargeable batteries  18
recorded videos
adding music  57
deleting from iPod nano  55Index 103
importing to your computer  55
playing  54
sharing with iPhoto  56
recording voice memos  74
registering iPod  97
relative volume, playing songs at  46
removing menu items  10, 45
repairing iPod  94
replacing battery  18
replaying a song or video  6
requirements
computer  91
operating system  91
reset all settings  12
resetting iPod  6, 86
resetting the language  90
restore message  88
restoring iPod software  92
rewinding a song or video  6
S
Safely Remove Hardware icon  15
safety considerations
setting up iPod  93
saving On-The-Go playlists  42
screen brightness, setting  11
screen lock  79
scrolling quickly  11
scrubber bar  6
searching
iPod  44
Select button. See Center button
serial number  8, 12
serial number, locating  97
service and support  97
sets of songs. See playlists
setting combination for iPod  79
settings
about your iPod  12
alarm  78
audiobook play speed  48
backlight timer  11
brightness  11
Click Wheel sound  11
date and time  77
font size  10
language  10
main menu  10, 45
PAL or NTSC TV  50, 70
playing songs at relative volume  46
repeating songs  44
reset all  12
shuffle songs  43
sleep timer  78
slideshow  70
TV  50
volume limit  45
setup  24
shake to shuffle  43
shuffle  35
shuffling songs on iPod  6, 43
sleep mode and charging the battery  16
sleep timer, setting  78
slideshows
background music  70
random order  70
settings  70
viewing on iPod  70
software
getting help  97
iPhoto  91
iPod Updater  92
updating  92
songs
adding to On-The-Go playlists  6
browsing  6
browsing and playing  34
fast-forwarding  6
pausing  6
playing  6
playing at relative volume  46
rating  36
repeating  44
replaying  6
rewinding  6
shuffling  6, 43
skipping ahead  6
viewing lyrics  21
See also music
sorting contacts  82
Sound Check  47
spoken menus  83
standard TV  50
stopwatch  79
storing
data files on iPod  84
notes on iPod  84
supported operating systems  91
suppressing iTunes from opening  84
syncing
address book  81
music  24
music videos  26
photos  67, 68
to-do lists  81
See also adding
system requirements  91
T
tagging songs  64104 Index
previewing and purchasing  64
time, displaying in title bar  77
timer, setting for backlight  11
time zones, clocks for  77
title bar, displaying time  77
to-do lists, syncing  81
transitions for slides  70
troubleshooting
connecting iPod to computer  88
cross-platform use  91
disconnecting iPod  87
iPod not playing music  87
iPod won’t respond  86
resetting iPod  86
restore message  88
safety considerations  93
setting incorrect language  90
slow syncing of music or data  89
software update and restore  92
TV slideshows  90
unlocking iPod screen  91
turning iPod on and off  6
tutorial  97
TV
connecting to iPod  51, 71
PAL or NTSC  50, 70
settings  50
viewing slideshows  51, 71
TV shows
See also videos
U
unlocking iPod screen  80, 91
unresponsive iPod  86
unsupported audio file formats  89
updating and restoring software  92
USB 2.0 port
recommendation  91
slow syncing of music or data  89
USB port on keyboard  13
Use iTunes to restore message in display  88
V
Video Camera  52
importing recorded videos  55
playing recorded videos  54
recording video  53
sharing recorded videos  56
special effects  53
video captions  51
video podcasts
viewing on a TV  50
videos
adding to iPod  27
browsing  6
fast-forwarding  6
importing from video camera  55
pausing  6
playing  6
playing recorded  54
renting  22
replaying  6
rewinding  6
skipping ahead  6
viewing on a TV  50
viewing on iPod  49
viewing album artwork  37
viewing lyrics  37
viewing photos  69
viewing slideshows
on a TV  51, 71
on iPod  70
settings  70
troubleshooting  90
Voice Memos
recording  74
syncing with your computer  76
VoiceOver
setting up  32
using  44
volume
changing  6
setting maximum limit  45
W
warranty service  97
widescreen TV  50
Windows
supported operating systems  91
troubleshooting  91
WMA files, converting  89
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1 Getting Started
What You Need
To use iPod touch, you need:
Â A Mac or a PC with a USB 2.0 port and one of the following operating systems:
Â Mac OS X version 10.4.10 or later
Â Windows XP Home or Professional with Service Pack 2 or later
Â Windows Vista Home Premium, Business, Enterprise, or Ultimate edition
Â iTunes 7.6 or later, available at www.apple.com/itunes
Â iTunes Store account (to purchase music over Wi-Fi)
Â An Internet connection
Setting Up iPod touch
Before you can use any of the iPod touch features, you must use iTunes to set up 
iPod touch. You can also register iPod touch and create an iTunes Store account 
(available in some countries) if you don’t already have one. 
Set up iPod touch
1 Download and install the latest version of iTunes from www.apple.com/itunes.
2 Connect iPod touch to a USB 2.0 port on your Mac or PC using the included cable.
· To avoid injury, read all operating instructions in this guide and safety 
information in the Important Product Information Guide at www.apple.com/
support/manuals/ipod before using iPod touch.Chapter 1    Getting Started 5
The USB port on most keyboards doesn’t provide enough power. Unless your keyboard 
has a high-powered USB 2.0 port, you must connect iPod touch to a USB 2.0 port on 
your computer.
3 Follow the onscreen instructions in iTunes to set up iPod touch and sync your music, 
video, photos, and other content.
Your computer must be connected to the Internet.
By default, iTunes automatically syncs all songs and videos in your iTunes library to 
iPod touch. If you have more content in your library than will fit on iPod touch, iTunes 
alerts you that it can’t sync your content. You’ll need to use iTunes to select some of 
your songs, videos, and other content to sync. The following section tells you how.
Getting Music, Videos, and Other Content onto 
iPod touch
iPod touch lets you enjoy music, videos, photos, and much more, with its great sound 
and stunning 3.5-inch widescreen display. You get media and other content onto 
iPod touch by connecting iPod touch to your computer and using iTunes to sync your 
iTunes library and other information on your computer. 
You can set iTunes to sync any or all of the following:
Â Music and audiobooks
Â Movies
Â TV Shows6 Chapter 1    Getting Started 
Â Podcasts
Â Photos
Â Contacts—names, phone numbers, addresses, email addresses, and so on
Â Calendars—appointments and events
Â Email account settings
Â Webpage bookmarks
Music, movies, TV shows, and podcasts are synced from your iTunes library. If you don’t 
already have content in iTunes, the iTunes Store (part of iTunes and available in some 
countries) makes it easy to purchase or subscribe to content and download it to iTunes. 
You can also get music into iTunes from your CDs. To learn about iTunes and the iTunes 
Store, open iTunes and choose Help > iTunes Help.
Photos, contacts, calendars, and webpage bookmarks are synced from applications on 
your computer, as described below.
Email account settings are only synced from your computer’s email application to 
iPod touch. This allows you to customize your email accounts on iPod touch without 
affecting email account settings on your computer.
You can set iPod touch to sync with only a portion of what’s on your computer. 
For example, you might want to sync certain playlists, the most recent unwatched 
movie, the most recent episodes of your favorite TV shows, and all unplayed podcasts. 
The sync settings make it easy to get just what you want onto iPod touch. You can 
adjust sync settings whenever iPod touch is connected to your computer. 
Important:  You cannot connect and sync more than one iPod at a time. Disconnect 
one before connecting another. You should be logged in to your own user account on 
the computer before connecting iPod touch. On a PC, if you sync more than one iPod 
to the same user account, use the same sync settings for each.
Syncing iPod touch
You use the iPod touch settings panes in iTunes to specify the iTunes content and other 
information you want to sync to iPod touch.
Sync iPod touch
1 Connect iPod touch to your computer, and open iTunes (if it doesn’t open 
automatically).Chapter 1    Getting Started 7
The USB port on most keyboards doesn’t provide enough power. You must connect 
iPod touch to a USB 2.0 port on your computer, unless your keyboard has a highpowered USB 2.0 port.
2 Select iPod touch in the iTunes source list (below Devices, on the left). 
3 Configure the sync settings in each of the settings panes.
4 Click Apply in the lower-right corner of the screen.
The following sections provide an overview of each of the iPod touch settings panes. 
For more information, open iTunes and choose Help > iTunes Help.
Summary Pane
Select “Open iTunes when this iPod is connected” to have iTunes open and sync 
iPod touch automatically whenever you connect it to your computer. Deselect this 
option if you want to sync only by clicking the Sync button in iTunes. For more 
information about preventing automatic syncing, see page 9.
Select “Sync only checked songs and videos” if you want to sync only items that are 
checked in your iTunes library.
Select “Manually manage music and videos” to turn off syncing in the Music, Movies, 
and TV Shows settings panes.
Music, Movies, TV Shows, and Podcasts Panes
Use these panes to specify the iTunes library content that you want to sync. You can 
sync all music, movies, TV shows, and podcasts, or select the specific playlists and items 
you want on iPod touch. Audiobooks and music videos are synced along with music. 8 Chapter 1    Getting Started 
If you want to watch rented movies on iPod touch, transfer them to iPod touch using 
the Movies pane in iTunes. 
If there’s not enough room on iPod touch for all the content you’ve specified, 
iTunes asks if you want to create a special playlist and set it to sync with iPod touch. 
Then iTunes randomly fills the playlist.
Photos Pane
You can sync photos from iPhoto 4.0.3 or later on a Mac, or from Adobe Photoshop 
Album 2.0 or later or Adobe Photoshop Elements 3.0 or later on a PC. You can also sync 
photos from any folder on your computer that contains images.
Info Pane
The Info pane lets you configure the sync settings for your contacts, calendars, and web 
browser bookmarks. 
Contacts
You can sync contacts with applications such as Mac OS X Address Book, Microsoft 
Entourage, and Yahoo! Address Book on a Mac, or with Yahoo! Address Book, Windows 
Address Book (Outlook Express), or Microsoft Outlook 2003 or 2007 on a PC. (On a Mac, 
you can sync contacts on your computer with more than one application. On a PC, you 
can sync contacts with only one application.)
If you sync with Yahoo! Address Book, you only need to click Configure to enter your 
new login information when you change your Yahoo! ID or password after you’ve set 
up syncing.
Note:  Syncing won’t delete any contact in Yahoo! Address Book that contains a 
Messenger ID, even if you’ve deleted the contact from your address book on your 
computer. To delete a contact with a Messenger ID, log in to your Yahoo! account and 
delete the contact using Yahoo! Address Book online.
Calendars
You can sync calendars from applications such as iCal and Microsoft Entourage on a 
Mac, or Microsoft Outlook on a PC. (On a Mac, you can sync calendars on your 
computer with more than one application on your computer. On a PC, you can sync 
calendars with only one application.)
Mail Accounts
You can sync email account settings from Mail on a Mac, and from Microsoft Outlook 
2003 or 2007 or Outlook Express on a PC. Account settings are only transferred from 
your computer to iPod touch. Changes you make to an email account on iPod touch 
don’t affect the account on your computer.Chapter 1    Getting Started 9
The password for your Yahoo! email account isn’t saved on your computer. 
If you sync a Yahoo! email account, you must enter the password on iPod touch. 
From the Home screen choose Settings > Mail, choose your Yahoo! account, then enter 
your password in the password field.
Web Browser
You can sync bookmarks from Safari on a Mac, or Safari or Microsoft Internet Explorer 
on a PC.
Advanced
These options let you replace the information on iPod touch with the information on 
your computer during the next sync.
Preventing Automatic Syncing
You may want to prevent iPod touch from syncing automatically if you prefer to add 
items manually, or when you connect iPod touch to a computer other than the one you 
sync with.
Turn off automatic syncing for iPod touch
m Connect iPod touch to your computer, then select iPod touch in the iTunes source list 
(below Devices, on the left) and click the Summary tab. Deselect “Open iTunes when 
this iPod is connected.” You can still use iTunes to sync manually by clicking the 
Sync button.
Prevent automatic syncing one time, without changing settings
m Open iTunes. Then, as you connect iPod touch to your computer, press and hold 
Command-Option (if you’re using a Mac) or Shift-Control (if you’re using a PC) until you 
see iPod touch in the iTunes source list (below Devices, on the left).
Sync manually
m Select iPod touch in the iTunes source list, then click Sync in the lower-right corner of 
the window. Or, if you’ve changed any sync settings, click Apply.
Disconnecting iPod touch from Your Computer
Unless iPod touch is syncing with your computer, you can disconnect it from your 
computer at any time.
When iPod touch is syncing with your computer, it shows “Sync in progress.” If you 
disconnect iPod touch before it finishes syncing, some data may not be transferred. 
When iPod touch finishes syncing, iTunes shows “iPod sync is complete.” 
To cancel a sync so you can disconnect iPod touch, drag the “slide to cancel” slider.2
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2 Basics
iPod touch at a Glance
Sleep/Wake button
Headphones port
Dock connector
Wi-Fi antenna
Home button
Touch screen
Application icons
Status barChapter 2    Basics 11
Status Icons
The icons in the status bar at the top of the screen give information about iPod touch:
Item What you can do with it
Stereo headphones Listen to music and videos.
Dock connector to 
USB cable
Use the cable to connect iPod touch to your computer to sync and charge, 
or to the Apple USB Power Adapter (available separately) to charge. 
The cable can be used with the optional dock or plugged directly into 
iPod touch.
Stand Stand up iPod touch for viewing videos or photo slideshows.
Polishing cloth Wipe the iPod touch screen.
Stand
Stereo headphones Dock connector to USB cable
Polishing cloth
iPod
Status icon What it means
Wi-Fi Shows that iPod touch is connected to a Wi-Fi network. The more 
bars, the stronger the connection. See page 21. 
¥ Lock Shows that iPod touch is locked. See page 15.
Play Shows that a song is playing. See page 26.
Alarm Shows that an alarm is set. See page 71.
Battery Shows the battery level or charging status. See page 22.12 Chapter 2    Basics 
Home Screen
Press the Home  button at any time to see the applications on iPod touch. Tap any 
application icon to get started.
iPod touch Applications
The following applications are included with iPod touch:
Music
Listen to your songs, podcasts, and audiobooks.
Videos
Watch movies, music videos, video podcasts, and TV shows.
Photos
View photos transferred from your computer. View them in portrait or landscape 
mode. Zoom in on any photo for a closer look. Watch a slideshow. Use photos as 
wallpaper.
iTunes
Search the iTunes Wi-Fi Music Store music catalog, or browse, preview, and purchase 
new releases, top-ten songs and albums, and more.1
 In select Starbucks locations,2
find out what song is playing in the café, then buy it instantly. Browse, preview, 
and purchase other songs from featured Starbucks Collections.
Safari
Browse websites over a Wi-Fi connection. Rotate iPod touch sideways for viewing in 
landscape orientation. Double-tap to zoom in or out—Safari automatically fits sections 
to the screen for easy reading. Add Safari Web Clips to the Home screen for fast access 
to favorite websites.
Calendar
View your iCal, Microsoft Entourage, or Microsoft Outlook calendar synced from 
your computer. 
Mail
Send and receive email using your existing email accounts. iPod touch works with the 
most popular email systems—including Yahoo! Mail, Google email, AOL, and .Mac 
Mail—as well as most industry-standard POP3 and IMAP email systems.
Contacts
Get contact information synced from Mac OS X Address Book, Yahoo! Address Book, 
Windows Address Book (Outlook Express), or Microsoft Outlook. Add, change, 
or delete contacts, which get synced back to your computer.
YouTube
Play videos from YouTube’s online collection.3
 Search for any video, or browse featured, 
most viewed, most recently updated, and top-rated videos.Chapter 2    Basics 13
Customizing the Home Screen Layout
You can customize the layout of icons on the Home screen—including the Dock icons 
along the bottom of the screen. If you want, arrange them over multiple Home screens.
Rearrange icons
1 Touch and hold any Home screen icon until all the icons begin to wiggle.
2 Arrange the icons by dragging them.
3 Press the Home  button to save your arrangement.
You can also add links to your favorite webpages on the Home screen. See “Adding 
Safari Web Clips to the Home Screen” on page 49.
Stocks
Watch your favorite stocks, updated automatically from the Internet.
Maps
See a street map, satellite, or hybrid view of locations around the world. 
Zoom in for a closer look. Find your current approximate location. Get detailed driving 
directions and see current highway traffic conditions. Find businesses in the area.4
Weather
Get current weather conditions and a six-day forecast. Store your favorite cities for a 
quick weather report anytime.
Clock
View the time in cities around the world—create clocks for your favorites. Set one or 
more alarms. Use the stopwatch, or set a countdown timer.
Calculator
Add, subtract, multiply, and divide.
Notes
Jot notes on the go—reminders, grocery lists, brilliant ideas. Send them in email.
Settings
Adjust all iPod touch settings in one convenient place. Join Wi-Fi networks. Set your 
wallpaper and screen brightness, and settings for music, video, photos, and more. 
Set auto-lock and a passcode for security.
1 Not available in all areas.
2
In the U.S. only.
3 Not available in all areas.
4
Some features or services not available in all areas.14 Chapter 2    Basics 
Create additional Home screens
m While arranging icons, drag a button to the edge of the screen until a new screen 
appears. You can flick to return to the original screen and drag more icons to the new 
screen.
You can create up to nine screens. The number of dots at the bottom shows the 
number of screens you have, and indicates which screen you are viewing.
Switch to another Home screen
m Flick left or right.
Reset your Home screen to the default layout
m Choose Settings > General > Reset and tap Reset Home Screen Layout.Chapter 2    Basics 15
iPod touch Buttons and Touchscreen
A few simple buttons and a high-resolution touchscreen make it easy to learn and use 
iPod touch. 
Locking iPod touch and Turning It On or Off
When you’re not using iPod touch, you can lock it. When iPod touch is locked, nothing 
happens if you touch the screen. By default, if you don’t touch the screen for a minute, 
iPod touch locks automatically.
Locking iPod touch does not stop music playback, so you can lock iPod touch and 
continue to listen to music. To temporarily display playback controls when iPod touch is 
locked, double-click the Home button.
For information about locking iPod touch with a passcode, see “Passcode Lock” on 
page 77.
Sleep/Wake
button
To Do this
Lock iPod touch Press the Sleep/Wake button.
Unlock iPod touch Press the Home  button or the Sleep/Wake button, then 
drag the slider.
Turn iPod touch completely off Press and hold the Sleep/Wake button for a few seconds until 
the red slider appears, then drag the slider.
Turn iPod touch on Press and hold the Sleep/Wake button until the Apple logo 
appears.
Display playback controls when 
iPod touch is locked
Double-click the Home button.16 Chapter 2    Basics 
Using the Touchscreen
The controls on the touchscreen change dynamically depending on the task you are 
performing. 
m Tap any application to open it. 
m Press the Home  button below the display at any time to return to the Home screen 
and see all the applications.
m Drag up or down to scroll.
Dragging your finger to scroll doesn’t choose or activate anything on the screen.Chapter 2    Basics 17
m Flick to scroll quickly.
You can wait for scrolling to stop, or tap or touch anywhere on the screen to stop it 
immediately. Tapping or touching to stop scrolling doesn’t choose or activate anything 
on the screen.
m Some lists have an index along the right side. Tap a letter to jump to items starting with 
that letter. Drag your finger along the index to scroll quickly through the list.
m Tap an item in the list to choose it. Depending on the list, tapping an item can do 
different things—for example, it may open a new list, play a song, or show someone’s 
contact information.
m The back button in the upper-left corner shows the name of the previous list. Tap it to 
go back.
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m When viewing photos, web pages, email, or maps, you can zoom in and out. Pinch your 
fingers together or apart. For photos and web pages, you can double-tap (tap twice 
quickly) to zoom in, then double-tap again to zoom out. For maps, double-tap to zoom 
in and tap once with two fingers to zoom out. 
Onscreen Keyboard
You can use the onscreen keyboard to enter text, such as contact information. 
The intelligent keyboard automatically suggests corrections as you type (some 
languages only), to help prevent mistyped words. 
iPod touch provides keyboards in multiple languages, and supports the following 
keyboard formats:
Â QWERTY
Â QWERTZ
Â AZERTY
Â QZERTY
Â Japanese IME
See “Keyboard” on page 78 for information about turning on keyboards for different 
languages and other keyboard settings.Chapter 2    Basics 19
Entering text
Start by typing with just your index finger. As you get more proficient, you can type 
more quickly by using your thumbs. 
1 Tap a text field, such as in a note or new contact, to bring up the keyboard. 
2 Tap keys on the keyboard. 
As you type, each letter appears above your thumb or finger. If you touch the wrong 
key, you can slide your finger to the correct key. The letter is not entered until you 
release your finger from the key.
To Do this
Type uppercase Tap the Shift  key before tapping a letter.
Quickly type a period and space Double-tap the space bar.
Turn caps lock on Enable caps lock (see page 78), then double-tap the 
Shift  key. The Shift key turns blue, and all letters you type 
are uppercase. Tap the Shift key again to turn caps lock off.
Shows numbers, punctuation, 
or symbols
Tap the Number  key. Tap the Symbol  key to see 
additional punctuation and symbols.20 Chapter 2    Basics 
Accepting or Rejecting Dictionary Suggestions
iPod touch has dictionaries for English, English (UK), French, French (Canada), German, 
Japanese, Spanish, Italian, and Dutch. The appropriate dictionary is activated 
automatically when you select a keyboard on iPod touch.
iPod touch uses the active dictionary to suggest corrections or complete the word 
you’re typing. If you’re using a keyboard that doesn’t have a dictionary, iPod touch 
won’t make suggestions.
You don’t need to interrupt your typing to accept the suggested word.
Â To use the suggested word, type a space, punctuation mark, or return character.
Â To reject the suggested word, finish typing the word as you want it, then tap the “x” to 
dismiss the suggestion before typing anything else. Each time you reject a 
suggestion for the same word, iPod touch becomes more likely to accept your word.
Editing text
m Touch and hold to see a magnified view, then drag to position the insertion point.
Suggested wordChapter 2    Basics 21
Connecting to the Internet
iPod touch connects to the Internet via Wi-Fi  networks. iPod touch can join AirPort 
and other Wi-Fi networks at home, at work, or at Wi-Fi hotspots around the world. 
When joined to a Wi-Fi network that is connected to the Internet, iPod touch connects 
to the Internet automatically whenever you use Mail, Safari, YouTube, Stocks, Maps, 
Weather, or the iTunes Wi-Fi Music Store.
Many Wi-Fi networks can be used free of charge. Some Wi-Fi networks require a fee. 
To join a Wi-Fi network at a hotspot where charges apply, you can usually open Safari 
to see a webpage that allows you to sign up for service.
Joining a Wi-Fi Network
The Wi-Fi settings let you turn on Wi-Fi and join Wi-Fi networks. 
Turn on Wi-Fi
m Choose Settings > Wi-Fi and turn Wi-Fi on.
Join a Wi-Fi network
m Choose Settings > Wi-Fi, wait a moment as iPod touch detects networks in range, 
then select a network. If necessary, enter a password and tap Join (networks that 
require a password appear with a lock icon).
Once you’ve joined a Wi-Fi network manually, iPod touch will automatically connect to 
it whenever the network is in range. If more than one previously used network is in 
range, iPod touch joins the one last used. 
When iPod touch is connected to a Wi-Fi network, the Wi-Fi icon  in the status bar at 
the top of the screen shows connection strength. The more bars you see, the stronger 
the connection.
For more information about joining Wi-Fi networks and configuring Wi-Fi settings, 
see page 74.22 Chapter 2    Basics 
Charging the Battery
iPod touch has an internal rechargeable battery.
Charge the battery and sync iPod touch
m Connect iPod touch to your computer (not your keyboard) using the included cable. 
Note:  If iPod touch is connected to a computer that’s turned off or in sleep or standby 
mode, the iPod touch battery may drain instead of charge.
An icon in the upper-right corner of the screen shows battery charging status.
If you charge the battery while syncing or using iPod touch, it may take longer to 
charge. You can also charge iPod touch using the Apple USB Power Adapter, available 
separately.
WARNING:  For important safety information about charging iPod touch, see the 
Important Product Information Guide at www.apple.com/support/manuals/ipod.
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Important:  If iPod touch is very low on power, it may display one of the following 
images indicating that iPod touch needs to charge for up to ten minutes before you 
can use it. If iPod touch is extremely low on power, the display may be blank for up to 
two minutes before one of the low-battery images appears.
Rechargeable batteries have a limited number of charge cycles and may eventually 
need to be replaced. The iPod touch battery is not user replaceable; it can be replaced 
only by an authorized service provider. For more information, go to: 
www.apple.com/batteries
Cleaning iPod touch
Use the polishing cloth that came with iPod touch to gently wipe the glass screen and 
the case. 
You can also use a soft, slightly damp, lint-free cloth. Unplug and turn off iPod touch 
(press and hold the Sleep/Wake button, then drag the onscreen red slider). 
Avoid getting moisture in openings. Don’t use window cleaners, household cleaners, 
aerosol sprays, solvents, alcohol, ammonia, or abrasives to clean iPod touch.
or3
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3 Music and Video
Tap Music to listen to songs, audiobooks, and podcasts, 
or tap Video to watch TV shows, movies, and other video.
iPod touch syncs with iTunes on your computer to get the songs, movies, TV shows, 
and other content you’ve collected in your iTunes library.
For information about using iTunes to get music and other media onto your computer, 
open iTunes and choose Help > iTunes Help.
Syncing Content from Your iTunes Library
If you’ve turned on syncing, iTunes automatically syncs content from your iTunes library 
to iPod touch each time you connect it to your computer. iTunes lets you sync all of 
your media, or specific songs, movies, videos, and podcasts. For example, you could set 
iTunes to sync selected music playlists, the most recent unwatched movie, and the 
three most recent episodes of your favorite TV show.
If there are more songs in your iTunes library than can fit on iPod touch, iTunes asks if 
you want to create a special playlist and set it to sync with iPod touch. Then iTunes 
randomly fills the playlist. You can add or delete songs from the playlist and sync again. 
If you set iTunes to sync more songs, videos, and other content than can fit on 
iPod touch, you can have iTunes automatically delete random content from iPod touch 
to make room, or you can stop the sync and reconfigure your sync settings.
When you sync podcasts or audiobooks on iPod touch with those on your computer, 
both iTunes and iPod touch remember where you stopped listening and start playing 
from that position.
For more information about syncing iPod touch with your iTunes library, see “Getting 
Music, Videos, and Other Content onto iPod touch” on page 5.Chapter 3    Music and Video 25
Transferring Purchased Content from iPod touch to Another 
Authorized Computer
Music, video, and podcasts sync from your iTunes library to iPod touch, but not from 
iPod touch to your iTunes library. However, content you purchased using the iTunes 
Wi-Fi Music Store on iPod touch is automatically copied to your iTunes library.
You can also transfer content on iPod touch that was purchased using iTunes on one 
computer to an iTunes library on another authorized computer.
Transfer content from iPod touch to another computer
m Connect iPod touch to the other computer. iTunes asks if you want to transfer 
purchased content. You can also connect iPod touch and, in iTunes, choose File > 
Transfer Purchases.
To play the content, the computer must be authorized to play content from your iTunes 
account.
Supported Music and Video Formats
Only songs and videos encoded in formats that iPod touch supports are transferred to 
iPod touch. For information about which formats iPod touch supports, see page 88.
Converting Videos for iPod touch
You can add videos other than those purchased from iTunes to iPod touch, such as 
videos you create in iMovie on a Macintosh or videos you download from the Internet.
If you try to add a video from iTunes to iPod touch and a message says the video can’t 
play on iPod touch, you can convert the video. 
Convert a video to work with iPod touch
m Select the video in your iTunes library and choose Advanced > “Convert Selection for 
iPod.” Then add the converted video to iPod touch.
Playing Music
The high resolution multi-touch display makes listening to songs on iPod touch as 
much a visual experience as a musical one. You can scroll through your playlists, or use 
Cover Flow to browse through your album art. 
WARNING:  For important information about avoiding hearing loss, see the Important 
Product Information Guide at www.apple.com/support/manuals/ipod.26 Chapter 3    Music and Video 
Playing Songs, Audiobooks, and Podcasts
Browse your collection
m Tap Music, then tap Playlists, Artists, Songs, or Albums. Tap More to browse 
Audiobooks, Compilations, Composers, Genres, or Podcasts.
Play a song
m Tap the song.
Controlling Song Playback
When you play a song, the Now Playing screen appears:
To Do this
Adjust the volume Drag the volume slider.
Pause a song Tap .
Resume playback Tap .
Restart a song or a chapter in an 
audiobook or podcast
Tap .
Skip to the next or previous song or 
chapter in an audiobook or podcast
Tap  twice to skip to the previous song. Tap  to skip to 
the next song.
Rewind or fast-forward Touch and hold  or .
Return to the browse lists Tap . Or swipe to the right over the album cover.
Return to the Now Playing screen Tap Now Playing.
See the tracks in your collection 
from the current album
Tap . Tap any track to play it.
Display a song’s lyrics Tap the album cover when playing a song. (Lyrics appear only 
if you’ve added them to the song using the song’s Info window 
in iTunes.)
Next/Fast-forward
Play/Pause
Track List
Now Playing screen
Back
Previous/Rewind
VolumeChapter 3    Music and Video 27
Displaying playback controls at any time
You can display playback controls at any time when you’re listening to music and using 
another application—or even when iPod touch is locked—by double-clicking the 
Home  button. If iPod touch is active, the playback controls appear over the 
application you’re using. After using the controls, you can close them or tap Music to 
go to the Now Playing screen. If iPod touch is locked, the controls appear onscreen, 
then are dismissed automatically after you finish using them.
Additional Controls
m From the Now Playing screen tap the album cover.
The repeat and shuffle controls and the scrubber bar appear. You can see time elapsed, 
time remaining, and the song number. The song’s lyrics appear also, if you’ve added 
them to the song using iTunes.
To Do this
Set iPod touch to repeat songs Tap . Tap  again to set iPod touch to repeat only the 
current song.
 = iPod touch is set to repeat all songs in the current album 
or list.
 = iPod touch is set to repeat the current song over and 
over.
 = iPod touch is not set to repeat songs. 
Skip to any point in a song Drag the playhead along the scrubber bar.
Set iPod touch to shuffle songs Tap . Tap  again to set iPod touch to play songs in order.
 = iPod touch is set to shuffle songs.
 = iPod touch is set to play songs in order. 
Shuffle the tracks in any playlist, 
album, or other list of songs
Tap Shuffle at the top of the list. For example, to shuffle all the 
songs on iPod touch, choose Songs > Shuffle. 
Whether or not iPod touch is set to shuffle, if you tap Shuffle at 
the top of a list of songs, iPod touch plays the songs from that 
list in random order.
Scrubber bar
Repeat Shuffle
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Browsing Album Covers in Cover Flow
When you’re browsing music, you can rotate iPod touch sideways to see your iTunes 
content in Cover Flow and browse your music by album artwork.
To Do this
See Cover Flow Rotate iPod touch sideways. 
Browse album covers Drag or flick left or right.
See the tracks on an album Tap a cover or .
To Do this
Play any track Tap the track. Drag up or down to scroll through the tracks. 
Return to the cover Tap the title bar. Or tap  again.
Play or pause the current song Tap  or . Chapter 3    Music and Video 29
Viewing All Tracks on an Album
See all the tracks on the album that contains the current song
m From the Now Playing screen tap . Tap a track to play it. Tap the album cover 
thumbnail to return to the Now Playing screen.
In track list view, you can assign ratings to songs. You can use ratings to create 
smart playlists in iTunes that dynamically update to show, for example, your highest 
rated songs.
Rate a song
m Drag your finger across the ratings bar to give the song zero to five stars.
Making Playlists Directly on iPod touch
Make an on-the-go playlist
1 Tap Playlists and tap On-The-Go.
2 Browse for songs using the buttons at the bottom of the screen. Tap any song or video 
to add it to the playlist. Tap Add All Songs at the top of any list of songs to add all the 
songs in the list. 
3 When you finish, tap Done.
When you make an on-the-go playlist and then sync iPod touch to your computer, the 
playlist is saved in your iTunes library, then deleted from iPod touch. The first is saved as 
“On-The-Go 1,” the second as “On-The-Go 2,” and so on. To get a playlist back on 
iPod touch, select iPod touch in the iTunes source list, click the Music tab, and set the 
playlist to sync.
Edit an on-the-go playlist
m Tap Playlists, tap On-The-Go, tap Edit, then do one of the following:
Â To move a song higher or lower in the list, drag  next to the song.
Â To delete a song from the playlist, tap  next to the song, then tap Delete. Deleting a 
song from the on-the-go playlist doesn’t delete it from iPod touch.
Â To clear the entire playlist, tap Clear Playlist.
Â To add more songs, tap .
Track list view
Ratings bar
Back to Now 
Playing screen
Album tracks30 Chapter 3    Music and Video 
Watching Videos
With iPod touch, you can view video content such as movies, music videos, and video 
podcasts. Videos play in widescreen to take full advantage of the display. If a video 
contains chapters, you can skip to the next or previous chapter, or bring up a list and 
start playing at any chapter that you choose. If a video provides alternate language 
features, you can choose an audio language or display subtitles. 
Playing Videos on iPod touch
Play a video
m Tap Videos and tap the video.
Display playback controls
m Tap the screen to show the controls. Tap again to hide them.
Say It Right by Nelly Furtado is available on iTunes in select countries.
Restart/Rewind
Video controls
Playhead
Scale
Play/Pause
Fast-forward
Volume
Scrubber bar
To Do this
Play or pause a video Tap  or .
Raise or lower the volume Drag the volume slider.
Start a video over Drag the playhead on the scrubber bar all the way to the left, 
or tap  if the video doesn’t contain chapters.
Skip to the previous or next chapter 
(when available)
Tap  to skip to the previous chapter. Tap  to skip to the 
next chapter.
Start playing at a specific chapter Tap , then choose the chapter from the list.
Rewind or fast-forward Touch and hold  or .
Skip to any point in a video Drag the playhead along the scrubber bar.
Stop watching a video before it 
finishes playing
Tap Done. Or press the Home  button.Chapter 3    Music and Video 31
Watching Rented Movies
You can rent movies from the iTunes Store and watch them on iPod touch. You use 
iTunes to rent the movies and transfer them to iPod touch. (Rented movies are available 
only in some regions. iTunes version 7.6 or later is required.)
Rented movies are playable only for a limited time. The remaining time in which you 
must finish watching a rented movie appears near its title. Movies are automatically 
deleted when they expire. Check the iTunes Store for the expiration times before 
renting a movie.
Transfer rented movies to iPod touch
m Connect iPod touch to your computer. Then select iPod touch in the iTunes window 
(below Devices, on the left), click Movies and select the rented movies you want to 
transfer. Your computer must be connected to the internet.
Note:  Once a rented movie is transferred to iPod touch, you can’t transfer it back to 
your computer to watch it there.
View a rented movie
m Tap Videos and select a movie.
Scale a video to fill the screen or fit 
to the screen
Tap  to make the video fill the screen. Tap  to make it 
fit the screen.
You can also double-tap the video to toggle between fitting 
and filling the screen.
When you scale a video to fill the screen, the sides or top may 
be cropped from view. When you scale it to fit the screen, 
you may see black bars above and below or on the sides of 
the video. 
Select an alternate audio language 
(when available)
Tap , then choose a language from the Audio list.
Show or hide subtitles (when 
available)
Tap , then choose a language, or Off, from the Subtitles list.
Play the sound from a music video 
or video podcast without showing 
the video
Browse for the music video or podcast through Music lists. 
To play the music and video for a music video or podcast, 
browse for it through the Videos list.
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Watching Videos on a TV Connected to iPod touch
You can connect iPod touch to your TV and watch your videos on the larger screen. 
Use the Apple Component AV Cable, Apple Composite AV Cable, or other iPod touch 
compatible cable. You can also use these cables with the Apple Universal Dock, 
available separately, to connect iPod touch to your TV. (The Apple Universal Dock 
includes a remote, which allows you to control playback from a distance.) Apple cables 
and docks are available for purchase at www.apple.com/ipodstore.
Video Settings
Video settings let you set where to resume playing videos that you previously started, 
turn closed captioning on or off, turn widescreen on or off, and set the TV signal to 
NTSC or PAL. See page 80.
Set Video settings
m Choose Settings > Video.
Deleting Videos from iPod touch
You can delete videos directly from iPod touch to save space.
Delete a video
m In the Videos list, swipe left or right over the video, then tap Delete.
When you delete a video (not including rented movies) from iPod touch, it isn’t deleted 
from your iTunes library and you can sync the video back to iPod touch later. If you 
don’t want to sync the video back to iPod touch, set iTunes to not sync the video 
(see page 6).
If you delete a rented movie from iPod touch, it is deleted permanently and can’t be 
transferred back to your computer.
Setting a Sleep Timer
You can set iPod touch to stop playing music or videos after a period of time.
m From the Home screen choose Clock > Timer, then flick to set the number of hours and 
minutes. Tap When Timer Ends and choose Sleep iPod, tap Set, then tap Start to start 
the timer.
When the timer ends, iPod touch stops playing music or video, closes any other open 
application, and then locks itself. Chapter 3    Music and Video 33
Changing the Buttons on the Music Screen
You can replace the Playlists, Artist, Songs, or Albums buttons at the bottom of the 
screen with ones you use more frequently. For example, if you listen to podcasts a lot 
and don’t browse by album, you can replace the Albums button with Podcasts.
m Tap More and tap Edit, then drag a button to the bottom of the screen, over the button 
you want to replace. 
You can drag the buttons at the bottom of the screen left or right to rearrange them. 
When you finish, tap Done.
Tap More at any time to access the buttons you replaced.4
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4 Photos
Tap Photos to view your photos, use a photo as 
wallpaper, and play slideshows.
iPod touch lets you sync photos from your computer so you can share them with your 
family, friends, and associates on the high-resolution display.
Syncing Photos from Your Computer
If you’ve set up photo syncing, iTunes automatically copies or updates your photo 
library (or selected albums) from your computer to iPod touch whenever you connect 
iPod touch to your computer. iTunes can sync your photos from the following 
applications:
Â On a Mac:  iPhoto 4.0.3 or later
Â On a PC:  Adobe Photoshop Album 2.0 or later or Adobe Photoshop Elements 3.0 
or later
For information about syncing iPod touch with photos and other information on your 
computer, see “Getting Music, Videos, and Other Content onto iPod touch” on page 5.Chapter 4    Photos 35
Viewing Photos
Photos synced from your computer can be viewed in Photos.
View photos
m Tap Photo Library to see all your photos, or tap an album to see just those photos.
See a photo at full screen
m Tap the thumbnail of a photo to see it at full screen. Tap the full screen photo to hide 
the controls.
Tap the photo again to show the controls.
See the next or previous photo
m Flick left or right. Or tap the screen to show the controls, then tap  or .36 Chapter 4    Photos 
Changing the Size or Orientation
See a photo in landscape orientation
m Rotate iPod touch sideways. The photo automatically reorients and, if it’s in landscape 
format, expands to fit the screen.
Zoom in on part of a photo
m Double-tap the part you want to zoom in on. Double-tap again to zoom out.
Zoom in or out
m Pinch to zoom in or out.
Pan around a photo
m Drag the photo.Chapter 4    Photos 37
Viewing Slideshows
View photos in a slideshow
m Choose an album and tap a photo, then tap . If you don’t see , tap the photo to 
show the controls.
Stop a slideshow
m Tap the screen.
Set slideshow settings
1 From the Home screen choose Settings > Photos.
2 To set:
Â The length of time each slide is shown, tap Play Each Slide For and choose a time.
Â Transition effects when moving from photo to photo, tap Transition and choose a 
transition type.
Â Whether slideshows repeat, turn Repeat on or off.
Â Whether photos are shown in random order, turn Shuffle on or off.
Play music during a slideshow
m From the Home screen choose Music, and play a song. Then choose Photos from the 
Home screen and start a slideshow.
Using a Photo as Wallpaper
You see a wallpaper background picture as you unlock iPod touch.
Set a photo as wallpaper
1 Choose any photo.
2 Drag to pan, or pinch to zoom in or out, until the photo looks the way you want.
3 Tap the photo to display the controls, then tap  and tap Set Wallpaper.
You can also choose from several wallpaper pictures included with iPod touch by 
choosing Settings > General > Wallpaper > Wallpaper from the Home screen.
Emailing a Photo
Email a photo
m Choose any photo and tap , then tap Email Photo. 
iPod touch must be set up for email (see “Setting Up Email Accounts” on page 53).38 Chapter 4    Photos 
Sending a Photo to a Web Gallery
If you have a .Mac account, you can send photos directly from iPod touch to a Web 
Gallery created with iPhoto ‘08. You can also send photos to someone else’s .Mac Web 
Gallery if that person has enabled email contributions.
To send photos to a Web Gallery, you need to do the following:
Â Set up your .Mac mail account on iPod touch 
Â Publish an iPhoto ‘08 album to a .Mac Web Gallery
Â Select “Allow photo uploading by email” in the Publish Settings pane of iPhoto ‘08
For more information about creating a Web Gallery in iPhoto ‘08, open iPhoto ‘08, 
choose Help, and search for Web Gallery.
Send a photo to your web gallery
Choose any photo and tap , then tap Send to Web Gallery.
Assigning a Photo to a Contact
You can assign a photo to a contact. 
Assign a photo to a contact
1 Choose any photo on iPod touch and tap .
2 Tap Assign to Contact and choose a contact.
3 Drag the photo to pan, or pinch the photo to zoom in or out, until it looks the way 
you want.
4 Tap Set Photo.
You can also assign a photo to a contact in Contacts by tapping edit and then tapping 
the picture icon.5
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5 iTunes Wi-Fi Music Store
Tap iTunes to purchase songs and albums from the 
iTunes Wi-Fi Music Store.
You can search for, browse, preview, purchase, and download songs and albums from 
the iTunes Wi-Fi Music Store directly to iPod touch. Your purchased content is 
automatically copied to your iTunes library the next time you sync iPod touch with your 
computer.
To use the iTunes Wi-Fi Music Store, iPod touch must join a Wi-Fi network that is 
connected to the Internet. For information about joining a Wi-Fi network, see page 21. 
You’ll also need an iTunes Store account to purchase songs over Wi-Fi (available in 
some countries). If you don’t already have an iTunes Store account, open iTunes and 
choose Store > Account to set one up.
Browsing and Searching
You can browse featured selections, top-ten categories, or search the iTunes Wi-Fi 
Music Store music catalog for the songs and albums you’re looking for. Use the 
featured selections to see new releases and iTunes Wi-Fi Music Store recommendations. 
Top Tens lets you see the most popular songs and albums in each of several categories. 
If you’re looking for a specific song, album, or artist, use Search.40 Chapter 5    iTunes Wi-Fi Music Store 
Browse featured songs and albums
m Tap Featured and select a category at the top of the screen.
Browse top ten songs and albums
m Tap Top Tens, then choose a category and tap Top Songs or Top Albums.Chapter 5    iTunes Wi-Fi Music Store 41
Search for songs and albums
m Tap Search, tap the search field and enter one or more words, then tap Search.
See the songs on an album
m Tap the album.
See the album a song is on
m Double-tab the song.
Browsing Starbucks Selections
If you’re in a select Starbucks location (available in the U.S. only), the Starbucks icon 
appears at the bottom of the screen next to Featured. Tap the Starbucks icon to find 
out what song is playing in the café and browse featured Starbucks Collections. 
For a list of select Starbucks locations, go to:
www.apple.com/itunes/starbucks42 Chapter 5    iTunes Wi-Fi Music Store 
Find out what song is playing
m Tap Starbucks.
The currently playing song appears at the top of the screen. Tap the song to see the 
album the song is on and the other songs on the album.
View Recently Played and other Starbucks playlists
m Tap Starbucks, then choose Recently Played or one of the Starbucks playlists.
Purchasing Songs and Albums
When you find a song or album you like in the the iTunes Wi-Fi Music Store, you can 
purchase and download it to iPod touch. You can preview a song before you purchase 
it to make sure it’s a song you want. In select Starbucks locations (available in the U.S. 
only), you can also preview and purchase the currently playing and other songs from 
featured Starbucks Collections.
Preview a song
m Tap the song.
Purchase and download a song or album
1 Tap the price, then tap Buy Now.
Note:  To purchase songs on iPod touch, you must have been signed in to your iTunes 
Store account in iTunes the last time you synced iPod touch. Chapter 5    iTunes Wi-Fi Music Store 43
2 Enter your password and tap OK.
Your purchase is charged to your iTunes Store account. For additional purchases made 
within the next fifteen minutes, you don’t have to enter your password again.
An alert appears if you’ve previously purchased one or more songs from an album. 
Tap Buy if you want to purchase the entire album including the songs you’ve already 
purchased, or tap Cancel if you want to purchase the remaining songs individually.
Note:  Some albums include bonus content, which is downloaded to your iTunes library 
on your computer. Not all bonus content is downloaded directly to iPod touch.
See the status of downloading songs and albums
m Tap Downloads.
To pause a download, tap .
If you need to turn off iPod touch or leave the area of your Wi-Fi connection, don’t 
worry about interrupting the download. iPod touch starts the download again the next 
time iPod touch joins a Wi-Fi network with an Internet connection. Or if you open 
iTunes on your computer, iTunes completes the download to your iTunes library. 
Purchased songs are added to a Purchased playlist on iPod touch. If you delete the 
Purchased playlist, iTunes creates a new one when you buy an item from the iTunes 
Wi-Fi Music Store.
Syncing Purchased Content
iTunes automatically syncs songs and albums you’ve purchased on iPod touch to your 
iTunes library when you connect iPod touch to your computer. This lets you listen to 
the purchases on your computer and provides a backup if you delete purchases from 
iPod touch. The songs are synced to the “Purchased on ” playlist. 
iTunes creates the playlist if it doesn’t exist.
iTunes also copies your purchases to the Purchased playlist that iTunes uses for 
purchases you make on your computer, if that playlist exists and is set to sync with 
iPod touch.44 Chapter 5    iTunes Wi-Fi Music Store 
Verifying purchases
You can use iTunes to verify that all the music, videos, and other items you bought 
from the the iTunes Wi-Fi Music Store are in your iTunes library. You might want to do 
this if a download was interrupted.
Verify your purchases
1 Make sure your computer is connected to the Internet.
2 In iTunes, choose Store > Check for Purchases.
3 Enter your iTunes Store account ID and password, then click Check.
Purchases not yet on your computer will be downloaded.
The Purchased playlist displays all your purchases. However, because you can add or 
remove items in this list, it might not be accurate. To see all your purchases, make 
sure you’re signed in to your account, choose Store > View My Account, and click 
Purchase History.
Changing Your iTunes Store Account Information
iPod touch gets your iTunes Store account information from iTunes, including whether 
you get iTunes Plus music (when available). You can view and change your iTunes Store 
account information using iTunes.
View and change your iTunes Store account information
m In iTunes, choose Store > View My Account.
You must be signed in to your iTunes Store account. If “View My Account” doesn’t 
appear in the Store menu, choose Store > Sign in.
Purchase music from another iTunes Store account
m Sign in to that account when you connect to iTunes Wi-Fi Music Store.6
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6 Applications
Safari
Surfing the Web
Safari lets you see webpages just as they were designed to be seen in computer-based 
browsers. A simple double-tap lets you zoom in; rotate iPod touch sideways for a wider 
view. Search using Google or Yahoo!—both are built in. 
To use Safari, iPod touch must join a Wi-Fi network that is connected to the Internet. 
For information about joining a Wi-Fi network, see page 21. 
Opening and Navigating Webpages
Open a webpage
m Tap the address field at the top of the screen, type the web address—apple.com or 
www.google.com, for example—and tap Go. If you don’t see the address field, tap the 
status bar at the top of the screen.
As you type, any web address in your bookmarks or history list that contains those 
letters appears below. Tap a web address to go to its webpage.
Erase all the text in the address field
m Tap the address field, then tap .
Follow a link on a webpage
m Tap the link. 
Text links are typically underlined in blue. Many images are also links. 46 Chapter 6    Applications 
If a link leads to a sound or movie file supported by iPod touch, Safari plays the sound 
or movie. For supported file types, see page 88.
Zooming In to See a Page More Easily
View a webpage in landscape orientation
m Rotate iPod touch sideways. Safari automatically reorients and expands the page.
To Do this
See a link’s destination address Touch and hold the link. The address pops up next to your 
finger. You can touch and hold an image to see if it has a link.
Stop a page from loading if you 
change your mind
Tap .
Reload a webpage Tap .
Return to the previous or next 
webpage
Tap  or  at the bottom of the screen. 
Return to any of the last several 
webpages you’ve visited
Tap  and tap History. To clear the history list, tap Clear.
Send a webpage address over email Tap  and tap Mail Link to this Page. You must have an email 
account set up on iPod touch (see page 53).Chapter 6    Applications 47
Resize any column to fit the screen
m Double-tap the column. The column expands so you can read it more easily.
Double-tap again to zoom out.
Zoom in on part of a webpage
m Double-tap the part of the page you want to zoom in on. Double-tap again to 
zoom out.
Zoom in or out manually
m Pinch to zoom in or out.
Scroll around the page
m Drag up, down, or sideways. When scrolling, you can touch and drag anywhere on the 
page without activating any links. If you tap a link, you follow the link, but if you drag a 
link, the page scrolls.
Scroll within a frame on a webpage
Use two fingers to scroll within a frame on a webpage. Use one finger to scroll the 
entire webpage. 
Jump to the top of a webpage
Tap the status bar at the top of the iPod touch screen. 
Searching the Web
By default, Safari searches using Google. You can set it to search using Yahoo!, instead.
Search for anything on the web
1 Tap  to go to the Google search field. 
2 Type a word or phrase that describes what you’re looking for, then tap Google. 
3 Tap a link in the list of search results to open a webpage.
Set Safari to search using Yahoo!
m From the Home screen choose Settings > Safari > Search Engine, then choose Yahoo!.48 Chapter 6    Applications 
Opening Multiple Pages at Once
You can have more than one webpage open at a time. Some links automatically open a 
new page instead of replacing the current one.
The number inside the pages icon  at the bottom of the screen shows how many 
pages are open. If there’s no number, just one page is open. 
For example:
 = one page is open
 = three pages are open
Open a new page
m Tap  and tap New Page.
See all open pages and go to another page that’s open
m Tap  and flick left or right. When you get to the page you want, tap it.
Close a page
m Tap  and tap . You can’t close a page if it’s the only one that’s open.
Typing in Text Fields
Some webpages have forms or text fields you can enter information in. 
Bring up the keyboard
m Tap inside a text field.
Move to other text fields on the page
m Tap another text field. Or tap the Next or Previous button.Chapter 6    Applications 49
Submit the form
m Once you finish filling out the text fields on the page, tap Go or Search. Most pages 
also have a link you can tap to submit the form.
Dismiss the keyboard without submitting the form
m Tap Done.
Adding Safari Web Clips to the Home Screen
You can add Web Clips for your favorite webpages to the Home screen for fast access. 
Web Clips appear as icons, which you can arrange however you want on the Home 
screen. See “Customizing the Home Screen Layout” on page 13.
Add a Web Clip to the Home screen
m Open the page and tap . Then tap “Add to Home Screen.”
Web Clips remember the displayed portion—zoom level and location—of webpages. 
When you open a Web Clip, Safari automatically zooms and scrolls to that portion of 
the webpage again. The displayed portion is also used to create the icon for the Web 
Clip on the Home screen.
Before you add a Web Clip, you can edit its name. If the name is too long (more than 
about 10 characters), it may appear abbreviated on the Home screen.
Delete a Web Clip from the Home screen
1 Touch and hold any Home screen icon until the icons begin to wiggle.
2 Tap the “x” in the corner of the Web Clip you want to delete.
3 Tap Delete, then press the Home  button to save your arrangement.
Using Bookmarks
You can bookmark webpages so that you can quickly return to them at any time 
without having to type the address.
Bookmark a webpage
m Open the page and tap . Then tap Add Bookmark.
Before you save a bookmark you can edit its title or choose where to save it. By default, 
the bookmark is saved in the top-level Bookmarks folder. Tap Bookmarks to choose 
another folder.
Open a bookmarked webpage
m Tap , then choose a bookmark or tap a folder to see the bookmarks inside.50 Chapter 6    Applications 
Edit a bookmark or bookmark folder
m Tap , choose the folder that has the bookmark or folder you want to edit, then tap 
Edit. Then do one of the following:
Â To make a new folder, tap New Folder.
Â To delete a bookmark or folder, tap  next to the bookmark or folder, then tap 
Delete.
Â To reposition a bookmark or folder, drag  next to the item you want to move.
Â To edit the name or address of a bookmark or folder, or to put it in a different folder,
tap the bookmark or folder.
When you finish, tap Done.
Syncing Bookmarks
If you use Safari on a Mac, or Safari or Microsoft Internet Explorer on a PC, you can sync 
bookmarks on iPod touch with bookmarks on your computer.
Sync bookmarks between iPod touch and your computer
m Connect iPod touch to your computer. If bookmarks are set to be synced (see page 9), 
the sync begins.
Safari Settings
From the Home screen choose Settings > Safari to adjust security and other settings. 
See page 83.
Calendar
Adding Calendar Events to iPod touch
If you’ve set iTunes to sync calendars, you can enter appointments and events on your 
computer and sync them with iPod touch. You can also enter appointments and events 
directly on iPod touch.
Entering Calendar Events on Your Computer
You can enter appointments and events in iCal and Microsoft Entourage on a Mac, 
or in Microsoft Outlook 2003 or 2007 on a PC.
Syncing Calendars
Sync calendars between iPod touch and your computer
Connect iPod touch to your computer. If iPod touch is set to sync calendars 
automatically (see page 6), the update begins.Chapter 6    Applications 51
Adding and Editing Calendar Events Directly on iPod touch
Add an event
m Tap  and enter event information. Then tap Done. 
You can enter any of the following:
Â Title
Â Location
Â Starting and ending times (or turn on All-day if it’s an all-day event)
Â Repeat times—none, or every day, week, two weeks, month, or year
Â Alert time—from five minutes to two days before the event
If you set an alert time, iPod touch gives you the option to set a second alert time, 
in case you miss the first one.
Â Notes
Set iPod touch to make a sound when you get a calendar alert
m In Settings, choose General > Sound Effects and select whether you want sound effects 
to play over the internal speaker, through the headphones, or both. Select Off to turn 
sound effects off.
If Sound Effects is off, iPod touch displays a message instead of making a sound when 
you get a calendar alert.
Edit an event
m Tap the event and tap Edit.
Delete an event
Tap the event, tap Edit, then scroll down and tap Delete Event.
Viewing Your Calendar
View your calendar
m Tap Calendar.
Switch views
m Tap List, Day, or Month. 
Â List view:  All your appointments and events appear in an easy-to-scan list. Scroll up 
or down to see previous or upcoming days.
Â Day view:  Scroll up or down to see hours earlier or later in the day. Tap  or  to see 
the previous or next day.52 Chapter 6    Applications 
Â Month view:  Days with events show a dot below the date. Tap a day to see its events 
in a list below the calendar. Tap  or  to see the previous or next month.
See today’s events
m Tap Today.
See the details of an event
m Tap the event.
Set iPod touch to adjust event times for a selected time zone
m From the Home screen tap Settings > General > Date & Time, then turn Time Zone 
Support on. Then tap Time Zone and search for a major city in the time zone you want.
When Time Zone Support is on, Calendar displays event dates and times in the time 
zone set for your calendars. When Time Zone Support is off, Calendar displays events in 
the time zone of your current location.
Days with dots have 
scheduled events
Month view
Switch views
Events for selected day
Go to todayChapter 6    Applications 53
Mail
Mail is a rich HTML email client that retrieves your email in the background while you 
do other things on iPod touch. iPod touch works with the most popular email 
systems—including Yahoo! Mail, Google email, AOL, and .Mac Mail—as well as most 
industry-standard POP3 and IMAP email systems. Mail lets you send and receive photos 
and graphics, which are displayed in your message along with the text. You can also 
get PDFs and other attachments and view them on iPod touch.
Setting Up Email Accounts
You must have an email address—which looks like “yourname@example.com”—to use 
iPod touch for email. If you have Internet access, you most likely got an email address 
from your Internet service provider. 
If you chose automatic syncing during setup, your existing email accounts should be 
already set up and ready to go. Otherwise, you can set iTunes to sync your email 
accounts, or configure email accounts directly on iPod touch.
Syncing Email Accounts to iPod touch
You use iTunes to sync your email accounts to iPod touch. iTunes supports Mail and 
Microsoft Entourage on a Mac, and Microsoft Outlook 2003 or 2007 and Outlook 
Express on a PC. See “Getting Music, Videos, and Other Content onto iPod touch” on 
page 5.
Note:  Syncing an email account to iPod touch copies the email account setup, not the 
messages themselves. Whether the messages in your inbox appear on both iPod touch 
and your computer depends on the type of email account you have and how it’s 
configured.
If You Don’t Have an Email Account
Email accounts are available from most Internet service providers. If you use a Mac, 
you can get an email address, along with other services, at www.mac.com. Fees may 
apply.
Free accounts are also available online: 
Â www.mail.yahoo.com
Â www.google.com/mail
Â www.aol.com54 Chapter 6    Applications 
Setting Up an Email Account on iPod touch
You can set up and make changes to an email account directly on iPod touch. 
Your email service provider can provide the account settings you need to enter.
Changes you make on iPod touch to an email account synced from your computer are 
not copied to your computer.
To use the online Mail Setup Assistant, go to:
www.apple.com/support/ipodtouch/mailhelper
Enter account settings directly on iPod touch 
1 If this is the first account you’re setting up on iPod touch, tap Mail. Otherwise, from the 
Home screen choose Settings > Mail > Accounts > Add Account.
2 Choose your email account type:  Y! Mail (for Yahoo!), Google email, .Mac, AOL, 
or Other. 
3 Enter your account information:
If you’re setting up a Yahoo!, Google email, .Mac, or AOL account, enter your name, 
email address, and password. After that, you’re done.
Otherwise, click Other, select a server type—IMAP, POP, or Exchange—and enter your 
account information: 
Â Your email address
Â The email server type (IMAP, POP, or Exchange)
Â The Internet host name for your incoming mail server (which may look like 
“mail.example.com”)
Â The Internet host name for your outgoing mail server (which may look like 
“smtp.example.com”)
Â Your user name and password for incoming and outgoing servers (you may not need 
to enter a user name and password for an outgoing server)
Note:  Exchange email accounts must be configured for IMAP in order to work with 
iPod touch. Contact your IT organization for more information.
Sending Email
You can send an email message to anyone who has an email address. You can send the 
message to one person or to a group of people.
Compose and send a message
1 Tap .
2 Type one or more names or email addresses in the To or Cc (carbon copy) fields, or tap 
 and choose a contact to add the contact’s email address. 
As you type an email address, comparable email addresses from your contacts list 
appear below. Tap one to add it.Chapter 6    Applications 55
3 Type a subject, then type a message.
4 Tap Send.
Send a photo in a message
m From the Home screen choose Photos, then choose a photo. Then tap  and tap 
Email Photo.
If you have more than one email account on iPod touch, the photo is sent using the 
default account (see page 83).
Save a message as a draft so you can work on it later
m Start composing the message and tap Cancel. Then tap Save. You can find the message 
in the Drafts mailbox, add to it or change it, and then send it.
Reply to a message
m Open a message and tap . Tap Reply to reply to just the person who sent the 
message. Tap Reply All to reply to the sender and the other recipients. Then add a 
message of your own if you like, and tap Send.
When you reply to a message, files or images attached to the initial message aren’t sent 
back.
Forward a message
m Open a message and tap , then tap Forward. Add one or more email addresses and 
a message of your own if you like, then tap Send.
When you forward a message, you can include the files or images attached to the 
original message.
Send a message to a recipient of a message you received
m Open the message and tap the recipient’s name or email address, then tap Email.
Checking and Reading Email
The Mail button shows the total number of unread messages in all of your inboxes. 
You may have other unread messages in other mailboxes.
Number of 
unread emails56 Chapter 6    Applications 
On each account screen, you can see the number of unread messages next to each 
mailbox. 
Tap a mailbox to see its messages. Unread messages have a blue dot  next to them.
Read a message
m Tap a mailbox, then tap a message. Within a message, tap  or  to see the next or 
previous message.
Delete a message
m Open the message and tap .
You can also delete a message directly from the mailbox message list by swiping left or 
right over the message title and then tapping Delete.
Or you can tap Edit and tap  next to a message.
Number of 
unread messages
Tap to see all
your email accounts
Unread messages
To show the Delete button, swipe 
left or right over the message.Chapter 6    Applications 57
Check for new messages
m Choose a mailbox, or tap  at any time.
Open an attached file
You can view or read some types of files and images attached to messages you receive. 
For example, if someone sends you a PDF, Microsoft Word, or Microsoft Excel 
document, you canread it on iPod touch.
m Tap the attachment. It downloads to iPod touch and then opens.
You can view attachments in both portrait and landscape orientation. If the format of 
an attached file isn’t supported by iPod touch, you can see the name of the file but you 
can’t open it. iPod touch supports the following email attachment file formats:
Â .doc, .docx, .htm, .html, .pdf, .txt, .xls, .xlsx
See all the recipients of a message
m Open the message and tap Details.
Tap a name or email address to see the recipient’s contact information. Then tap an 
email address to email the person. Tap Hide to hide the recipients.
Add an email recipient to your contacts list
m Tap the message and, if necessary, tap Details to see the recipients. Then tap a name or 
email address and tap Create New Contact or “Add to Existing Contact.”
Mark a message as unread
m Open the message and tap “Mark as Unread.” 
A blue dot  appears next to the message in the mailbox list until you open it again.
Move a message to another mailbox
m Open the message and tap , then choose a mailbox.
Tap attachment 
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Zoom in to a part of a message
m Double-tap the part you want to zoom in on. Double-tap again to zoom out.
Resize any column of text to fit the screen
m Double-tap the text.
Resize a message manually
m Pinch to zoom in or out.
Follow a link
m Tap the link. 
Text links are typically underlined in blue. Many images also have links. A link can take 
you to a webpage, open a map, or open a new preaddressed email message. 
Web and map links open Safari or Maps on iPod touch. To return to your email, press 
the Home button and tap Mail.
Mail Settings
From the Home screen choose Settings > Mail to set up and customize your email 
accounts for iPod touch. See page 81.
Contacts
With Contacts, it’s easy to have all your contact information with you.
Syncing Contact Information from Your Computer
If you’ve set iTunes to sync contacts, iTunes automatically keeps your contacts up-todate—whether you make changes on your computer or on iPod touch. You can sync 
contacts with applications such as:
Â On a Mac:  Mac OS X Address Book, Microsoft Entourage, and Yahoo! Address Book
Â On a PC:  Yahoo! Address Book, Windows Address Book (Outlook Express), 
or Microsoft Outlook
For information about syncing iPod touch with your contacts, see “Getting Music, 
Videos, and Other Content onto iPod touch” on page 5.
Viewing a Contact
m Tap Contacts, then tap a contact.
To view a specific group, tap the Group button.Chapter 6    Applications 59
Setting the Sort and Display Order
Use Contacts settings to set whether your contacts are sorted by first or last name, and 
to set the order in which the names are displayed.
m Tap Settings > Contacts, then tap Sort Order or Display Order and select “First, Last” or 
“Last, First.”
Adding and Editing Contacts Directly on iPod touch
You can enter new contacts on iPod touch, edit existing contacts, and delete contacts.
Add a contact to iPod touch
m Choose Contacts and tap , then enter the contact information. 
Edit a contact’s phone number, address, and other information
m Tap Contacts and choose a contact, then tap Edit. 
Â To add an item—such as a web address or mobile phone number, tap  next to 
the item. 
Â To delete an item, tap  next to it. 
Â To delete the contact from your contacts list, scroll down and tap Delete Contact.
Enter a pause in a number
m Tap , then tap Pause.
Pauses are sometimes required by phone systems—before an extension or password, 
for example. Each pause lasts 2 seconds. You may need to enter more than one.
Assign a photo to a contact or change a contact’s photo
1 Tap Contacts and choose a contact.
2 Tap Edit and tap Add Photo, or tap the existing photo. 
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4 Move and scale the photo the way you want it. Drag the photo up, down, or sideways. 
Pinch or double-tap to zoom in or out.
5 Tap Set Photo.
Delete a contact
1 Tap Contacts and choose a contact.
2 Tap Edit.
3 Scroll to the bottom of the contact information and tap Delete.
YouTube
Finding and Viewing Videos
YouTube features short videos submitted by people from around the world (not 
available in all languages, may not be available in all locations). 
To use YouTube, iPod touch must join a Wi-Fi network that is connected to the Internet. 
For information about joining a Wi-Fi network, see page 21. 
Browse videos
m Tap Featured, Most Viewed, or Bookmarks. Or tap More to browse by Most Recent, 
Top Rated, or History.
Â Featured:  Videos reviewed and featured by YouTube staff.
Â Most Viewed:  Videos most seen by YouTube viewers. Tap All for all-time most viewed 
videos, or Today or This Week for most viewed videos of the day or week.
Â Bookmarks:  Videos you’ve bookmarked.
Â Most Recent:  Videos most recently submitted to YouTube.
Â Top Rated:  Videos most highly rated by YouTube viewers. To rate videos, go to 
www.youtube.com.
Â History:  Videos you’ve viewed most recently.
Search for a video
1 Tap Search, then tap the YouTube search field. 
2 Type a word or phrase that describes what you’re looking for, then tap Search. YouTube 
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Play a video
m Tap the video. The video begins to download to iPod touch and a progress bar shows 
progress. When enough of the video has downloaded, it begins to play. You can also 
tap  to start the video.
Controlling Video Playback
When a video starts playing, the controls disappear so they don’t obscure the video.
m Tap the screen to show or hide the controls.
To Do this
Play or pause a video Tap  or .
Raise or lower the volume Drag the volume slider.
Start a video over Tap .
Skip to the next or previous video Tap  twice to skip to the previous video. Tap  to skip to 
the next video.
Rewind or fast-forward Touch and hold  or .
Skip to any point in a video Drag the playhead along the scrubber bar.
Stop watching a video before it 
finishes playing
Tap Done. Or press the Home  button.
Toggle between scaling a video to 
fill the screen or fit the screen.
Double-tap the video. You can also tap  to make the video 
fill the screen, or tap  to make it fit the screen.
Bookmark a video Tap  next to a video and tap Bookmark. Or start playing a 
video and tap . Tap Bookmarks to see your bookmarked 
videos.
See details about a video and 
browse related videos
Play the whole video, tap Done while a video is playing, or tap 
 next to any video in a list.
iPod touch shows the video’s rating, description, date added, 
and other information. You also see a list of related videos that 
you can tap to view.
Next/Fast-forward 
Play/Pause
Scale
Download progress
Playback controls
Volume
Previous/rewind
Bookmark
Playhead
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Changing the Buttons at the Bottom of the Screen
You can replace the Featured, Most Viewed, Bookmarks, and Search buttons at the 
bottom of the screen with ones you use more frequently. For example, if you often 
watch top rated videos but don’t watch many featured videos, you could replace the 
Featured button with Top Rated.
m Tap More and tap Edit, then drag a button to the bottom of the screen, over the button 
you want to replace. 
You can drag the buttons at the bottom of the screen left or right to rearrange them. 
When you finish, tap Done.
When you’re browsing for videos, tap More to access the buttons that aren’t visible.
Add Your Own Videos to YouTube
For information about adding your own videos to YouTube, go to www.youtube.com 
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Stocks
Viewing Stock Quotes
When you tap Stocks from the Home screen, the stock reader shows updated quotes 
for all your stocks. Quotes are updated every time you open Stocks while connected to 
the Internet. Quotes may be delayed by up to 20 minutes.
Add a stock, index, or fund to the stock reader
1 Tap , then tap .
2 Enter a symbol, company name, index, or fund name, then tap Search. 
3 Choose an item in the search list.
Delete a stock
m Tap  and tap  next to a stock, then tap Delete.
Reorder stocks
m Tap . Then drag  next to a stock to a new place in the list.
Switch between showing percentage change and change in monetary value
m Tap the number showing the change. Tap it again to switch back. 
You can also tap  and tap % or Numbers.
Show a stock’s progress over a longer or shorter time period
m Tap a stock symbol, then tap 1d, 1w, 1m, 3m, 6m, 1y, or 2y. The chart adjusts to show 
progress over one day, one week, one, three, or six months, or one or two years.
See information about a stock at Yahoo.com 
m Tap . 
You can see news, information, websites related to the stock, and more.64 Chapter 6    Applications 
Maps
Maps provides street maps, satellite photos, and hybrid views of locations in many of 
the world’s countries. You can get detailed driving directions and, in some areas, traffic 
information. Also in some areas, you can find your current approximate location, and 
use that location to get driving directions to or from another place.1
Finding and Viewing Locations
Find a location and see a map
m Tap the search field to bring up the keyboard, then type an address, intersection, 
general area, name of a landmark, bookmark name, name of someone in your contacts 
list, or zip code. Then tap Search. 
A pin marks the location on the map. Tap the pin to see the name or description of the 
location.
Find your current approximate location on a map
m Tap . A circle appears to show your current approximate location. Your approximate 
location is determined using information from some local Wi-Fi networks (if you have 
Wi-Fi turned on). The more accurate the available information, the smaller the circle on 
the map. This feature is not available in all areas.
1 Maps, directions, and location information depend on data collected and services provided by third parties. 
These data services are subject to change and may not be available in all geographic areas, resulting in maps, 
directions, or location information that may be unavailable, inaccurate, or incomplete. For more information, see 
www.apple.com/ipodtouch. In order to provide your location, data is collected in a form that does not personally 
identify you. If you do not want such data collected, don’t use the feature. Not using this feature will not impact the 
functionality of your iPod touch.
WARNING:  For important information about driving and navigating safely, see the 
Important Product Information Guide at www.apple.com/support/manuals/ipod.
Tap  to get information about 
the location, get directions, or add 
the location to your bookmarks or 
contacts listChapter 6    Applications 65
Use the dropped pin
m Tap , then tap Drop Pin. A pin drops down on the map, which you can then drag to 
any location you choose. 
To quickly move the pin to the area currently displayed, tap , then tap Replace Pin.
Zoom in to a part of a map
m Pinch the map with two fingers. Or double-tap the part you want to zoom in on. 
Double-tap again to zoom in even closer.
Zoom out
m Pinch the map. Or tap the map with two fingers. Tap with two fingers again to zoom 
out further.
Pan or scroll to another part of the map
m Drag up, down, left, or right.66 Chapter 6    Applications 
See a satellite or hybrid view
m Tap , then tap Satellite or Hybrid to see just a satellite view or a combined street 
map and satellite view.
Tap Map to return to map view.
See the location of someone’s address in your contacts list
m Tap  in the search field, then tap Contacts and choose a contact. 
To locate an address in this way, the contact must include at least one address. If the 
contact has more than one address, you must choose the one you want to locate. 
You can also find the location of an address by tapping the address directly in Contacts.
Bookmark a location
m Find a location, tap the pin that points to it, tap  next to the name or description, 
then tap “Add to Bookmarks.”
See a bookmarked location or recently viewed location
m Tap  in the search field, then tap Bookmarks or Recents. 
Add a location to your contacts list
m Find a location, tap the pin that points to it, tap  next to the name or description, 
then tap Create New Contact or “Add to Existing Contact.”
Getting Directions
Get directions
1 Tap Directions.
2 Enter starting and ending locations in the Start and End fields. By default, iPod touch 
starts with your current approximate location (when available). Tap  in either field 
and choose a location in Bookmarks (including your current approximate location and 
the dropped pin, when available), Recents, or Contacts. 
For example, if a friend’s address is in your contacts list, you can tap Contacts and tap 
your friend’s name instead of having to type the address.
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3 Tap Route, then do one of the following:
Â To view directions one step at a time, tap Start, then tap  to see the next leg of the 
trip. Tap  to go back. 
Â To view all the directions in a list, tap , then tap List. Tap any item in the list to see a 
map showing that leg of the trip.
The approximate driving time appears at the top of the screen. If traffic data is 
available, the driving time is adjusted accordingly.
You can also get directions by finding a location on the map, tapping the pin that 
points to it, tapping  next to the name, then tapping Directions To Here or 
Directions From Here.
Show or hide traffic conditions
When available, you can show highway traffic conditions on the map.
m Tap , then tap Show Traffic or Hide Traffic.
Highways are color-coded according to the flow of traffic:
If you tap Show Traffic and don’t see color-coded highways, you may need to zoom out 
to a level where you can see major roads, or traffic conditions may not be available for 
that area.
Switch start and end points, for reverse directions
m Tap .
If you don’t see , tap List, then tap Edit.
See recently viewed directions
m Tap  in the search field, then tap Recents.
Traffic
Gray = No data currently available
Red = less than 25 miles per hour
Yellow = 25–50 miles per hour
Green = more than 50 miles per hour68 Chapter 6    Applications 
Finding and Contacting Businesses
Find businesses in an area
1 Find a location—for example, a city and state or country, or a street address—or scroll 
to a location on a map.
2 Type the kind of business in the text field and tap Search. 
Pins appear for matching locations. For example, if you locate your city and then type 
“movies” and tap Search, pins mark movie theatres in your city.
Tap the pin that marks a business to see its name or description.
Find businesses without finding the location first
m Type things like: 
Â restaurants san francisco ca 
Â apple inc new york
Contact a business or get directions
m Tap the pin that marks a business, then tap  next to the name. 
From there, you can do the following:
Â Depending on what information is stored for that business, you can tap an email 
address to email, or web address to visit a website.
Â For directions, tap Directions To Here or Directions From Here.
Â To add the business to your contacts list, scroll down and tap Create New Contact or 
“Add to Existing Contact.”
See a list of the businesses found in the search
From the Map screen, tap List. Tap a business to see its location on the map. Or tap  
next to a business to see its information.
Get directions
Visit website
Call
Tap  to show
contact infoChapter 6    Applications 69
Weather
Viewing Weather Summaries
Tap Weather from the Home screen to see the current temperature and a six-day 
forecast for a city of your choice. You can store multiple cities, for quick access.
If the weather board is light blue, it’s daytime in that city—between 6:00 a.m. and 
6:00 p.m. If the board is dark purple, it’s nighttime—between 6:00 p.m. and 6:00 a.m.
Switch to another city
m Flick left or right. The number of dots below the weather board shows how many cities 
are stored.
Reorder cities
m Tap . Then drag  next to a city to a new place in the list.
Add a city
1 Tap , then tap .
2 Enter a city name or zip code, then tap Search. 
3 Choose a city in the search list.
Delete a city
m Tap  and tap  next to a city, then tap Delete.
Six-day forecast
Current temperature
Current conditions
Today’s high and low
Add and delete cities
Number of cities stored
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Set whether iPod touch shows the temperature in Fahrenheit or Celsius
m Tap , then tap ºF or ºC.
See information about a city at Yahoo.com
m Tap .
You can see a more detailed weather report, news and websites related to the city, 
and more.
Clock
Adding and Viewing Clocks for Locations Around the World
You can add multiple clocks to show the time in major cities and time zones around 
the world.
View clocks
m Tap World Clock.
If the clock face is white, it’s daytime in that city. If it’s black, it’s nighttime. If you have 
more than four clocks, scroll to see them all.
Add a clock
m Tap World Clock, then tap  and type the name of a city. Cities matching what you’ve 
typed appear below. Tap a city to add a clock for that city.
If you don’t see the city you’re looking for, try a major city in the same time zone.
Delete a clock
m Tap World Clock and tap Edit. Then tap  next to a clock and tap Delete.
Rearrange clocks
m Tap World Clock and tap Edit. Then drag  next to a clock to a new place in the list.Chapter 6    Applications 71
Setting Alarm Clocks
You can set multiple alarms. Set each alarm to repeat on days you specify, or to sound 
only once.
Set an alarm
m Tap Alarm and tap , then adjust any of the following settings: 
Â To set the alarm to repeat on certain days, tap Repeat and choose the days. 
Â To choose the sound that’s played when the alarm goes off, tap Sound. 
Â To set whether the alarm gives you the option to snooze, turn Snooze on or off. 
If Snooze is on and you tap Snooze when the alarm sounds, the alarm stops and then 
sounds again in ten minutes.
Â To give the alarm a description, tap Label. iPod touch displays the label when the 
alarm sounds.
If at least one alarm is set and turned on,  appears in the status bar at the top of the 
screen.
Turn an alarm on or off
m Tap Alarm and turn any alarm on or off. If an alarm is turned off, it won’t sound again 
unless you turn it back on. 
If an alarm is set to sound only once, it turns off automatically after it sounds. You can 
turn that alarm on again to reenable it.
Change settings for an alarm
m Tap Alarm and tap Edit, then tap  next to the alarm you want to change.
Delete an alarm
m Tap Alarm and tap Edit, then tap  next to the alarm and tap Delete.
Using the Stopwatch
Use the stopwatch to measure time
m Tap Stopwatch. Tap Start to start the stopwatch. To record lap times, tap Lap after each 
lap. Tap Stop to pause the stopwatch, then tap Start to resume. Tap Reset to reset the 
stopwatch to zero.
If you start the stopwatch and go to another iPod touch application, the stopwatch 
continues running in the background.72 Chapter 6    Applications 
Setting the Timer
Set the timer
m Tap Timer, then flick to set the number of hours and minutes. Tap When Timer Ends to 
choose the sound iPod touch makes when the timer ends. Tap Start to start the timer.
Set a sleep timer
m Set the timer, then tap When Timer Ends and choose Sleep iPod.
When you set a sleep timer, iPod touch stops playing music or videos when the 
timer ends.
If you start the timer and go to another iPod touch application, the timer continues 
running in the background.
Calculator
Using the Calculator
m Add, subtract, multiply, and divide, as with a standard calculator. 
When you tap the add, subtract, multiply, or divide button, a white ring appears around 
the button to indicate the operation to be carried out.
Using the Memory Functions
m C:  Tap to clear the displayed number.
m M+:  Tap to add the displayed number to the number in memory. If no number is in 
memory, tap to store the displayed number in memory.
m M–:  Tap to subtract the displayed number from the number in memory.
m MR/MC:  Tap once to replace the displayed number with the number in memory. 
Tap twice to clear the memory. If the MR/MC button has a white ring around it, there is 
a number stored in memory. If zero (“0”) is displayed, tap once to see the number 
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Notes
Writing, Reading, and Emailing Notes
Notes are listed by date added, with the most recent note at the top. You can see the 
first few words of each note in the list. 
Add a note
m Tap , then type your note and tap Done.
Read or edit a note
m Tap the note. Tap anywhere on the note to bring up the keyboard and edit the note. 
Tap  or  to see the next or previous note. 
Delete a note
m Tap the note, then tap .
Email a note
m Tap the note, then tap .
To email a note, iPod touch must be set up for email (see “Setting Up Email Accounts” 
on page 53).7
74  
7 Settings
Tap Settings to adjust iPod touch settings.
Settings allows you to customize iPod touch applications, set the date and time, 
configure Wi-Fi connections, and enter other preferences for iPod touch.
Wi-Fi
Wi-Fi settings determine when and how iPod touch joins a Wi-Fi network.
Turn Wi-Fi on or off
m Choose Wi-Fi and turn Wi-Fi on or off.
Join a Wi-Fi network
m Choose Wi-Fi, wait a moment as iPod touch detects networks in range, then select a 
network. If necessary, enter the password and tap Join. (Networks that require a 
password appear with a lock icon.)
Once you’ve joined a Wi-Fi network manually, iPod touch automatically joins it 
whenever the network is in range. If more than one previously used network is in 
range, iPod touch joins the one last used. 
When iPod touch is joined to a Wi-Fi network, the Wi-Fi icon  in the status bar at the 
top of the screen shows signal strength. The more bars you see, the stronger the signal.
Set iPod touch to ask if you want to join a new network
This option tells iPod touch to look for another network when you aren’t in range of a 
Wi-Fi network you’ve previously joined. iPod touch displays a list of all available Wi-Fi 
networks that you can choose from. (Networks that require a password appear with a 
lock icon.) 
m Choose Wi-Fi and turn “Ask to Join Networks” on or off. If you turn “Ask to Join 
Networks” off, you can still join new networks manually.Chapter 7    Settings 75
Forget a network, so iPod touch doesn’t join it automatically
m Choose Wi-Fi and tap  next to a network you’ve joined before. Then tap “Forget this 
Network.”
Join a closed Wi-Fi network (an available Wi-Fi network that isn’t shown in the list of 
scanned networks)
m Choose Wi-Fi > Other and enter the network name. If the network requires a password, 
tap Security, select the type of security the network uses, and then tap Other Network 
and enter the password. 
You must already know the network name, password, and security type to connect to a 
closed network. 
Some Wi-Fi networks may require you to enter or adjust additional settings, such as a 
client ID or static IP address. Ask the network administrator which settings to use.
Adjust settings for joining a Wi-Fi network
m Choose Wi-Fi, then tap  next to the network. 
Brightness
Screen brightness affects battery life. Dim the screen to extend the time before you 
need to recharge iPod touch. Or use Auto-Brightness, which is designed to conserve 
battery life.
Adjust the screen brightness
m Choose Brightness and drag the slider.
Set whether iPod touch adjusts screen brightness automatically
m Choose Brightness and turn Auto-Brightness on or off. If Auto-Brightness is on, 
iPod touch adjusts the screen brightness for current light conditions using the built-in 
ambient light sensor.
General
The General settings include date and time, security, and other settings that affect 
more than one application. This is also where you can find information about your 
iPod touch and reset iPod touch to its original state.
About
Choose General > About to get information about iPod touch, including:
Â number of songs
Â number of videos
Â number of photos
Â total storage capacity76 Chapter 7    Settings 
Â storage available
Â software version
Â serial number
Â model number
Â Wi-Fi address
Â legal information
Wallpaper
You see a wallpaper background picture when you unlock iPod touch. You can select 
one of the images that came with iPod touch, or use a photo you’ve synced to 
iPod touch from your computer.
Set wallpaper
m Choose General > Wallpaper and choose a picture.
Date and Time
These settings apply to the time shown in the status bar at the top of the screen, 
world clocks, and your calendar.
Set whether iPod touch shows 24-hour time or 12-hour time
m Choose General > Date & Time and turn 24-Hour Time on or off.
Set the time zone
m Choose General > Date & Time > Time Zone and enter your location. 
Set the date and time
1 Choose General > Date & Time > Set Date & Time
2 Tap a button to select the date or time, then use the spinners to change the setting.
Calendar Settings
Turn on calendar time zone support
m Choose General > Date & Time and turn Time Zone Support on. When Time Zone 
Support is on, Calendar displays event dates and times in the time zone set for your 
calendars. When Time Zone Support is off, Calendar displays events in the time zone of 
your current location.
Set calendar time zone
m Choose General > Date & Time > Time Zone and enter the time zone of your calendar.
International
Use the International settings to set the language for iPod touch, turn keyboards for 
different languages on and off, and set the date, time, and telephone number formats 
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Set the language for iPod touch
m Choose General > International > Language, choose the language you want to use, and 
tap Done.
Turn international keyboards on or off
You can change the language for your keyboard on iPod touch, or make two or more 
keyboards available. 
m Choose General > International > Keyboards, and turn on the keyboards you want.
If more than one keyboard is turned on, tap  to switch keyboards when you’re 
typing. When you tap the symbol, the name of the newly active keyboard appears 
briefly.
Set date, time, and telephone number formats
m Choose General > International > Region Format, and choose your region.
Auto-Lock
Locking iPod touch turns off the display to save your battery and to prevent 
unintended operation of iPod touch.
Set the amount of time before iPod touch locks
m Choose General > Auto-Lock and choose a time.
Passcode Lock
By default, iPod touch doesn’t require you to enter a passcode to unlock it.
Set a passcode 
m Choose General > Passcode Lock and enter a 4-digit passcode. iPod touch then requires 
you to enter the passcode to unlock it.
Turn passcode lock off
m Choose General > Passcode Lock and tap Turn Passcode Off, then enter your passcode.
Change the passcode
m Choose General > Passcode Lock and tap Change Passcode, enter the current passcode, 
then enter and reenter your new passcode.
If you forget your passcode, you must restore the iPod touch software. See page 89.
Set how long before your passcode is required
m Choose General > Passcode Lock > Require Passcode, then select how long iPod touch 
can be locked before you need to enter a passcode to unlock it.78 Chapter 7    Settings 
Sound Effects
iPod touch can play sound effects when you:
Â have an appointment
Â lock or unlock iPod touch
Â type on the keyboard
Turn sound effects on or off
m Choose General > Sound Effects and select whether you want sound effects to play 
over the internal speaker, through the headphones, or both. Select Off to turn sound 
effects off.
Keyboard
Turn auto-capitalization on or off
By default, iPod touch automatically capitalizes the next word after you type sentenceending punctuation or a return character.
m Choose General > Keyboard and turn Auto-Capitalization on or off.
Set whether caps lock is enabled
If caps lock is enabled and you double-tap the Shift  key on the keyboard, all letters 
you type are uppercase. The Shift key turns blue when caps lock is on.
m Choose General > Keyboard and turn Enable Caps Lock on or off.
Turn “.” shortcut on or off
The “.” shortcut lets you double-tap the space bar to enter a period followed by a space 
when you’re typing. It is on by default.
m Choose General > Keyboard and turn “.” Shortcut on or off.
Turn international keyboards on or off
You can change the language for your keyboard on iPod touch, or make two or more 
keyboards available. 
m Choose General > Keyboards > International Keyboards and turn on the keyboards 
you want.
If more than one keyboard is turned on, tap  to switch keyboards when you’re typing. 
When you tap the symbol, the name of the newly active keyboard appears briefly.
Resetting iPod touch Settings
Reset all settings
m Choose General > Reset and tap Reset All Settings.
All your preferences and settings are reset. Data (such as your contacts and calendars) 
and media (such as your songs and videos) are not deleted.Chapter 7    Settings 79
Erase all content and settings
m Choose General > Reset and tap “Erase All Content and Settings.”
All your data and media are deleted. You must sync iPod touch with your computer to 
restore contacts, songs, videos, and other data and media.
Reset the keyboard dictionary
m Choose General > Reset and tap Reset Keyboard Dictionary.
You add words to the keyboard dictionary by rejecting words iPod touch suggests as 
you type. Tap a word to reject the correction and add the word to the keyboard 
dictionary. Resetting the keyboard dictionary erases all words you’ve added.
Reset network settings
m Choose General > Reset and tap Reset Network Settings.
When you reset network settings, your list of previously used networks is removed. 
Wi-Fi is turned off and then back on (disconnecting you from any network you’re on), 
and the “Ask to Join Networks” setting is turned on.
Music
The Music settings apply to songs, podcasts, and audiobooks.
Set iTunes to play songs at the same sound level
iTunes can automatically adjust the volume of songs, so they play at the same relative 
volume level. 
m In iTunes, choose iTunes > Preferences if you’re using a Mac, or Edit > Preferences if 
you’re using a PC, then click Playback and select Sound Check.
You can set iPod touch to use the iTunes volume settings.
Set iPod touch to use the iTunes volume settings (Sound Check)
m Choose Music and turn Sound Check on.
Set audiobook play speed
You can set audiobooks to play faster than normal so you can hear them more quickly, 
or slower so you can hear them more clearly.
m Choose Music > Audiobook Speed, then choose Slower, Normal, or Faster.
Use the equalizer to change the sound on iPod touch to suit a particular sound 
or style
m Choose Music > EQ and choose a setting.
Set a volume limit for music and videos
m Choose Music > Volume Limit and drag the slider to adjust the maximum volume. 
Tap Lock Volume Limit to assign a code to prevent the setting from being changed.80 Chapter 7    Settings 
Setting a volume limit only limits the volume of music (including podcasts and 
audiobooks) and videos (including rented movies), and only when headphones, 
earphones, or speakers are connected to the headphones port on iPod touch.
Video
Video settings apply to apply to video content (including rented movies). You can set 
where to resume playing videos that you previously started, turn closed captioning on 
or off, and set up iPod touch to play videos on your TV.
Set where to resume playing
m Choose Video > Start Playing, then select whether you want videos that you previously 
started watching to resume playing from the beginning or where you left off.
Turn closed captioning on or off
m Choose Video and turn Closed Captioning on or off.
TV Out Settings
Use these settings to set up how iPod touch plays videos on your TV. For more 
information about using iPod touch to play videos on your TV, see “Watching Videos on 
a TV Connected to iPod touch” on page 32.
Turn widescreen on or off
m Choose Video and turn Widescreen on or off.
Set TV signal to NTSC or PAL
m Choose Video > TV Signal and select NTSC or PAL.
NTSC and PAL are TV broadcast standards. NTSC displays 480i and PAL displays 576i. 
Your TV might use either of these, depending on where it was sold. If you’re not sure 
which to use, check the documentation that came with your TV.
Photos
Photos settings let you specify how slideshows display your photos.
Set the length of time each slide is shown
m Choose Photos > Play Each Slide For and select the length of time.
Set transition effect
m Choose Photos > Transition and select the transition effect.
WARNING:  For important information about avoiding hearing loss, see the Important 
Product Information Guide at www.apple.com/support/manuals/ipod.Chapter 7    Settings 81
Set whether to repeat slideshows
m Choose Photos and turn Repeat on or off.
Set photos to appear randomly or in order
m Choose Settings > Photos and turn Shuffle on or off.
Mail 
Use Mail settings to customize your email account for iPod touch. Changes you make 
to accounts settings are not synced to your computer, allowing you to configure email 
to work with iPod touch without affecting email account settings on your computer.
Account Settings
The specific accounts settings that appear on iPod touch depend on the type of 
account you have—POP or IMAP. 
Note:  Microsoft Outlook 2003 or 2007 email accounts must be configured for IMAP in 
order to work with iPod touch.
Stop using an account
m Choose Mail, choose an account, then turn Account off. 
If an account is off, iPod touch doesn’t display the account and doesn’t send or check 
email from that account, until you turn it back on.
Adjust advanced settings
m Choose Mail > Accounts, choose an account, then do one of the following: 
Â To set whether drafts, sent messages, and deleted messages are stored on iPod touch or 
remotely on your email server (IMAP accounts only), tap Advanced and choose Drafts 
Mailbox, Sent Mailbox, or Deleted Mailbox.
If you store messages on iPod touch, you can see them even when iPod touch isn’t 
connected to the Internet. 
Â To set when deleted messages are removed permanently from iPod touch, tap Advanced 
and tap Remove, then choose a time:  Never, or after one day, one week, or one 
month. 
Â To adjust email server settings, tap Host Name, User Name, or Password under 
Incoming Mail Server or Outgoing Mail Server. Ask your network administrator or 
Internet service provider for the correct settings.
Â To adjust SSL and password settings, tap Advanced. Ask your network administrator or 
Internet service provider for the correct settings.
Delete an email account from iPod touch
m Choose Mail, tap an account, then scroll down and tap Delete Account.
Deleting an email account from iPod touch doesn’t delete it from your computer.82 Chapter 7    Settings 
Settings for Email Messages
iPod touch checks for and retrieves new email in your accounts whenever your open 
Mail. You can also set Mail to regularly check for email and download your messages 
even when you don’t have Mail open.
Set whether iPod touch checks for new messages automatically
m Choose Mail > Auto-Check, then tap Manual, “Every 15 minutes,” “Every 30 minutes,” 
or “Every hour.” 
If you have a Yahoo! email account, email is instantly transferred to iPod touch as it 
arrives at the Yahoo! server. 
Set the number of messages shown on iPod touch
m Choose Mail > Show, then choose a setting. You can choose to see the most recent 25, 
50, 75,100, or 200 messages. To download additional messages when you’re in Mail, 
scroll to the bottom of your inbox and tap “Download . . . more.”
Set how many lines of each message are previewed in the message list
m Choose Mail > Preview, then choose a setting. You can choose to see anywhere from 
zero to five lines of each message. That way, you can scan a list of messages in a 
mailbox and get an idea of what each message is about.
Set a minimum font size for messages
m Choose Mail > Minimum Font Size, then choose Small, Medium, Large, Extra Large, 
or Giant.
Setting whether iPod touch shows To and Cc labels in message lists
m Choose Mail, then turn Show To/Cc Label on or off. 
If Show To/Cc Label is on,  or  next to each message in a list indicates whether 
the message was sent directly to you or you were Cc’ed. 
Setting iPod touch to confirm that you want to delete a message
m Choose Mail and turn Ask Before Deleting on or off. 
If Ask Before Deleting is on, to delete a message you must tap , then confirm by 
tapping Delete.
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Settings for Sending Email
Set whether iPod touch sends you a copy of every message you send
m Choose Mail, then turn Always Bcc Myself on or off.
Add a signature to your messages
You can set iPod touch to add a signature—your favorite quote, or your name, title, and 
phone number, for example—that appears in every message you send. 
m Choose Mail > Signature, then type a signature.
Set the default email account
When you initiate sending a message from another iPod touch application, such as 
sending a photo from Photos or tapping a business’ email address in Maps, the 
message is sent from your default email account.
m Choose Mail > Default Account, then choose an account.
Safari 
General Settings
You can use Google or Yahoo! to perform Internet searches.
Select a search engine
m Choose Safari > Search Engine and select the search engine you want to use.
Security Settings
By default, Safari is set to show some of the features of the web, like some movies, 
animation, and web applications. You may wish to turn off some of these features to 
help protect iPod touch from possible security risks on the Internet.
Change security settings
m Choose Safari, then do one of the following:
Â To enable or disable JavaScript, turn JavaScript on or off. 
JavaScript lets web programmers control elements of the page—for example, a page 
that uses JavaScript might display the current date and time or cause a linked page 
to appear in a new pop-up page.
Â To enable or disable plug-ins, turn Plug-ins on or off. Plug-ins allow Safari to play some 
types of audio and video files and to display Microsoft Word files and Microsoft Excel 
documents.
Â To block or allow pop-ups, turn Block Pop-ups on or off. Blocking pop-ups stops only 
pop-ups that appear when you close a page or open a page by typing its address. 
It doesn’t block pop-ups that open when you click a link.84 Chapter 7    Settings 
Â To set whether Safari accepts cookies, tap Accept Cookies and choose Never, 
“From visited,” or Always. 
A cookie is a piece of information that a website puts on iPod touch so the website 
can remember you when you visit again. That way, webpages can be customized for 
you based on information you may have provided. 
Some pages won’t work correctly unless iPod touch is set to accept cookies.
Â To clear the history of webpages you’ve visited, tap Clear History.
Â To clear all cookies from Safari, tap Clear Cookies.
Â To clear the browser cache, tap Clear Cache.
The browser cache stores the content of pages so the pages open faster the next 
time you visit them. If a page you open isn’t showing new content, clearing the 
cache may help.
Developer Settings
The Debug Console can help you resolve webpage errors. When turned on, the console 
appears automatically when a webpage error occurs.
Turn the debug console on or off
m Choose Safari > Developer, and turn Debug Console on or off.
Contacts
Use Contacts settings to determine the sort and display order of your contacts.
Set the sort order
m Choose Settings > Contacts > Sort Order, and select “First, Last” or “Last, First.”
Set the display order
m Choose Settings > Contacts > Display Order, and select “First, Last” or “Last, First.”
Restoring or Transferring Your iPod touch Settings
When you connect iPod touch to your computer, settings on iPod touch are 
automatically backed up to your computer. You can restore this information if you need 
to—if you get a new iPod touch, for example, and want to transfer your previous 
settings to it. You may also want to reset the information on iPod touch if you’re having 
trouble connecting to a Wi-Fi network.
Automatically backed-up information includes notes, contact favorites, sound settings, 
and other preferences.Chapter 7    Settings 85
Restore or transfer settings
Do one of the following:
m Connect a new iPod touch to the same computer you used with your other iPod touch, 
open iTunes, and follow the onscreen instructions.
m Reset the information on iPod touch. In Settings, choose General > Reset, then choose 
“Reset All Settings,” “Erase All Content and Settings,” or “Reset Network Settings.” Then 
connect iPod touch to your computer, open iTunes, and follow the onscreen 
instructions.
When you reset network settings, your list of previously used networks is removed. 
Wi-Fi is turned off and then back on, disconnecting you from any network you’re on. 
The Wi-Fi and “Ask to Join Networks” settings are left turned on.
Delete a set of backed-up settings
m Open iTunes and choose iTunes > Preferences (on a Mac) or Edit > Preferences (on a 
PC). Then click Syncing, select an iPod touch, and click “Remove Backup.”
iPod touch doesn’t need to be connected to your computer.A
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A Tips and Troubleshooting
Most problems with iPod touch can be solved quickly by 
following the advice in this chapter.
General Suggestions
If the screen is blank or shows a low-battery image
iPod touch is low on power and needs to charge for up to ten minutes before you can 
use it. For information about charging iPod touch, see “Charging the Battery” on 
page 22.
If iPod touch doesn’t appear in iTunes or you can’t sync iPod touch
Â The iPod touch battery might need to be recharged. For information about charging 
iPod touch, see “Charging the Battery” on page 22.
Â If that doesn’t work, disconnect other USB devices from your computer and connect 
iPod touch to a different USB 2.0 port on your computer (not on your keyboard).
Â If that doesn’t work, turn off iPod touch and turn it on again. Press and hold the 
Sleep/Wake button on top of iPod touch for a few seconds until a red slider appears, 
then drag the slider. Then press and hold the Sleep/Wake button until the Apple logo 
appears.
Â If that doesn’t work, restart your computer and reconnect iPod touch to your 
computer.
orAppendix A    Tips and Troubleshooting 87
Â If that doesn’t work, download and install (or reinstall) the latest version of iTunes 
from www.apple.com/itunes.
If iPod touch won’t turn on, or if the display freezes or doesn’t respond
Â iPod touch may need charging. See “Charging the Battery” on page 22.
Â Press and hold the Home  button for at least six seconds, until the application you 
were using quits.
Â If that doesn’t work, turn off iPod touch and turn it on again. Press and hold the 
Sleep/Wake button on top of iPod touch for a few seconds until a red slider appears, 
and then drag the slider. Then press and hold the Sleep/Wake button until the Apple 
logo appears.
Â If that doesn’t work, reset iPod touch. Press and hold both the Sleep/Wake button 
and the Home  button for at least ten seconds, until the Apple logo appears.
If iPod touch continues to freeze or not respond after you reset it
Â Reset iPod touch settings. From the Home screen choose Settings > General > Reset 
> Reset All Settings. All your preferences are reset, but your data and media are left 
untouched.
Â If that doesn’t work, erase all content on iPod touch. From the Home screen choose 
Settings > General > Reset > “Erase All Content and Settings.” All your preferences 
are reset, and all your data and media are removed from iPod touch.
Â If that doesn’t work, restore the iPod touch software. See “Updating and Restoring 
iPod touch Software” on page 89.
If iPod touch isn’t playing sound
Â Unplug and reconnect the headphones. Make sure the connector is pushed in all 
the way.
Â Make sure the volume isn’t turned down all the way.
Â Music on iPod touch might be paused. From the Home screen tap Music, tap Now 
Playing, then tap .
Â Check to see if a volume limit is set. From the Home screen choose Settings > Music 
> Volume Limit. For more information, see page 79.
Â Make sure you are using iTunes 7.6 or later (go to www.apple.com/itunes). Songs 
purchased from the iTunes Store using earlier versions of iTunes won’t play on 
iPod touch until you upgrade iTunes.
Â If you are using the optional dock’s line out port, make sure your stereo or external 
speakers are turned on and working properly.
If iPod touch shows a message saying “This accessory is not supported by iPod”
The accessory you attached will not work with iPod touch.88 Appendix A    Tips and Troubleshooting 
If you can’t play a song you just purchased
Your purchase may still be downloading. Close and reopen Music, then try playing the 
song again.
If you can’t add or play a song, video, or other item
The media may have been encoded in a format that iPod touch doesn’t support. 
The following audio file formats are supported by iPod touch. These include formats for 
audiobooks and podcasting:
Â AAC (M4A, M4B, M4P, up to 320 Kbps)
Â Apple Lossless (a high-quality compressed format)
Â MP3 (up to 320 Kbps)
Â MP3 Variable Bit Rate (VBR)
Â WAV
Â AA (audible.com spoken word, formats 2, 3, and 4)
Â AAX (audible.com spoken word, AudibleEnhanced format)
Â AIFF
The following video file formats are supported by iPod touch:
Â H.264 (Baseline Profile Level 3.0)
Â MPEG-4 (Simple Profile)
A song encoded using Apple Lossless format has full CD-quality sound, but takes up 
only about half as much space as a song encoded using AIFF or WAV format. The same 
song encoded in AAC or MP3 format takes up even less space. When you import music 
from a CD using iTunes, it is converted to AAC format by default.
Using iTunes for Windows, you can convert nonprotected WMA files to AAC or MP3 
format. This can be useful if you have a library of music encoded in WMA format. 
iPod touch does not support WMA, MPEG Layer 1, MPEG Layer 2 audio files, 
or audible.com format 1.
If you have a song or video in your iTunes library that isn’t supported by iPod touch, 
you may be able to convert it to a format iPod touch supports. See iTunes Help for 
more information.
If you can’t remember your passcode
You must restore the iPod touch software. See “Updating and Restoring iPod touch 
Software” on page 89.
If you entered contacts on iPod touch that you don’t want to sync to your computer
Replace contacts on iPod touch with information from your computer.
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2 As you connect iPod touch to your computer, press and hold Command-Option 
(if you’re using a Mac) or Shift-Control (if you’re using a PC) until you see iPod touch in 
the iTunes source list on the left. This prevents iPod touch from syncing automatically.
3 Select iPod touch in the iTunes source list and click the Info tab.
4 Under “Replace information on this iPod,” select Contacts. You can select more 
than one.
5 Click Apply.
The contacts on iPod touch are replaced with the contacts on your computer. The next 
time you sync, iPod touch syncs normally, adding data you’ve entered on iPod touch to 
your computer, and vice versa.
If you can’t sync with Yahoo! Address Book
iTunes may not be able to connect to Yahoo!. Make sure your computer is connected to 
the Internet and that you’ve entered the correct Yahoo! ID and password in iTunes. 
Connect iPod touch to your computer, click the Info tab in iTunes, select “Sync Yahoo! 
Address Book contacts,” then enter your current Yahoo! ID and password.
If contacts you deleted on iPod touch or your computer are not removed from 
Yahoo! Address Book after syncing
Yahoo! Address Book does not allow contacts containing a Messenger ID to be deleted 
through syncing. To delete a contact containing a Messenger ID, log in to your online 
Yahoo! account and delete the contact using Yahoo! Address Book.
If you can’t access the iTunes Wi-Fi Music Store
To use the iTunes Wi-Fi Music Store, iPod touch must join a Wi-Fi network that is 
connected to the Internet. For information about joining a Wi-Fi network, see page 21. 
The iTunes Wi-Fi Music Store is not available in all countries.
If you can’t purchase music from the iTunes Wi-Fi Music Store
To purchase songs from the iTunes Wi-Fi Music Store (only available in some countries), 
you must have an iTunes Store account, and you must have been signed in to that 
account when you last synced iPod touch with iTunes. If you get a message that no 
account information is found when you try to purchase music, open iTunes, sign in to 
your iTunes Store account, and then connect and sync iPod touch. 
Updating and Restoring iPod touch Software
You can use iTunes to update or restore iPod touch software. You should always update 
iPod touch to use the latest software. You can also restore the software, which puts 
iPod touch back to its original state.
Â If you update, the iPod touch software is updated but your settings and songs are not 
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Â If you restore, all data is erased from iPod touch, including songs, videos, contacts, 
photos, calendar information, and any other data. All iPod touch settings are restored 
to their original state.
Update or restore iPod touch
1 Make sure you have an Internet connection and have installed the latest version of 
iTunes from www.apple.com/itunes.
2 Connect iPod touch to your computer.
3 In iTunes, select iPod touch in the source list and click the Summary tab.
4 Click “Check for Update.” iTunes tells you if there’s a newer version of the iPod touch 
software available.
5 Click Update to install the latest version of the software. Or click Restore to restore 
iPod touch to its original settings and erase all data and media on iPod touch. Follow 
the onscreen instructions to complete the restore process.
Using iPod touch Accessibility Features
The following features may make it easier for you to use iPod touch if you have a 
disability.
Closed captioning
When available, you can turn on closed captioning for videos. See “Turn closed 
captioning on or off” on page 80.
Minimum font size for Mail messages
Set a minimum font size for Mail message text to Large, Extra Large, or Giant to 
increase readability. See “Set a minimum font size for messages” on page 82.
Zooming
Double-tap or pinch webpages, photos, and maps to zoom in. See page 18.
Universal Access in Mac OS X
Take advantage of the Universal Access features in Mac OS X when you use iTunes to 
sync information and content from your iTunes library to iPod touch. In the Finder, 
choose Help > Mac Help, then search for “universal access.”
For more information about iPod touch and Mac OS X accessibility features, go to:
www.apple.com/accessibilityB
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B Learning More, Service, 
and Support 
There’s more information about using iPod touch, 
in onscreen help and on the web.
The following table describes where to get more iPod-related software and service 
information.
To learn about Do this
Using iPod touch safely Go to www.apple.com/support/manuals/ipod for the latest 
Important Product Information Guide, including any updates to the 
safety and regulatory information.
iPod touch support, tips, 
forums, and Apple software 
downloads
Go to www.apple.com/support/ipodtouch.
The latest information about 
iPod touch
Go to www.apple.com/ipodtouch.
Using iTunes Open iTunes and choose Help > iTunes Help.
For an online iTunes tutorial (available in some areas only), go to 
www.apple.com/support/itunes.
Using iPhoto in Mac OS X Open iPhoto and choose Help > iPhoto Help.
Using Address Book in 
Mac OS X
Open Address Book and choose Help > Address Book Help.
Using iCal on Mac OS X Open iCal and choose Help > iCal Help.
Microsoft Outlook, Windows 
Address Book, Adobe 
Photoshop Album, and Adobe 
Photoshop Elements
See the documentation that came with those applications.
Finding your iPod touch serial 
number
Look at the back of your iPod touch or choose Settings > General > 
About from the Home screen.
Obtaining warranty service First follow the advice in this guide and online resources. Then go 
to www.apple.com/support or see the Important Product 
Information Guide that comes with iPod touch.K Apple Inc.
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O
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pop-ups  83
power, low  23, 86
power adapter  11, 22
previewing music  42
problems. See troubleshooting
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status icons  11
stock information, Yahoo!  63
Stocks, adding and deleting quotes  63
stopwatch, using  71
storage capacity  75
subtitles  31
support information  91
surfing the web  45
syncing
“Sync in progress” message  9
calendars  50
email account settings  54
photos  34
preventing  9, 88
setting up  6
webpage bookmarks  50
Yahoo! Address Book  89
syncing purchased songs  43
system requirements  4
T
telephone number format  77
temperature. See Weather
Text, typing in webpages  48
time, setting  76
time format  77
timer
setting  72
sleep  72
time zone support  52, 76
touchscreen, using  16
traffic conditions, checking  67
transferring purchased content  25, 43
transition effects, setting  80
troubleshooting
can’t remember passcode  88
display freezes  87
iPod touch doesn’t appear in iTunes  86
iPod touch doesn’t respond  87
iPod touch doesn’t turn on  87
no sound  87
preventing syncing  88
problems playing songs or other content  88
software update and restore  89
turning iPod touch on or off  15
TV out settings  80
TV signal settings  80
typing
about  19
in webpage text fields  48
U
unlocking iPod touch  15
unread messages, marking  57
unsupported audio file formats  88
updating iPod touch software  89
USB
cable  11
power adapter  11, 22
V
videos
alternate audio language  31
deleting  32
playing  25
subtitles  31
syncing  7, 24
transferring purchased content  25
watching on a TV  32
See also Music, YouTube
video settings  80
volume
adjusting  26
setting limit  79
W
waking iPod touch  15
wallpaper
choosing  76
settings  37
using photo as  37
warranty service  91
watching videos on a TV  32
Weather
adding cities  69
deleting cities  69
temperature settings  70
viewing  69
weather information, Yahoo!  70
web. See Safari
Web Clips, adding to Home screen  49
Wi-Fi
forgetting a network  75
joining networks  21, 74
settings  74
status icon  11
turning on or off  7498 Index
Wi-Fi address  76
Windows Address Book  8, 58, 91
WMA files, converting  88
World Clock  70
Y
Y! Mail account  54
Yahoo!
Address Book  8, 89
email accounts  9, 82
free email account  53
search engine  83
searching using  47
stock information  63
syncing email accounts  9
weather information  70
Y! Mail accounts  54
Yahoo! Address Book  58
YouTube
bookmarking videos  61
browsing videos  60
playing videos  61
searching for videos  60
Z
zooming
email messages  58
maps  65
photos  36
webpages  46

Apple Wireless 
Mighty Mouse2 English
1 Setting Up Your Wireless Mighty Mouse
Congratulations on selecting the wireless Mighty Mouse as 
your input device. 
Using the Wireless Mighty Mouse 
Follow the steps on the following pages to install batteries in your mouse, set up your 
Mac, and use Setup Assistant to set up your mouse with your Mac.
Important:  Don’t turn on your mouse until just before you are ready to start up your 
Mac in step 3.
Step 1:  Installing the Batteries
Follow the instructions below to install batteries in your wireless Mighty Mouse. You 
can install either one or both of the nonrechargeable AA lithium batteries that came 
with your mouse (see “About Your Batteries” on page 7 for more information).
To install batteries in your mouse:
1 Turn the mouse over and remove the bottom cover.
2 Slide the batteries into the battery compartment as shown in the illustration.English 3
3 Replace the bottom cover and leave the mouse turned off.
Step 2:  Setting Up Your Mac
Follow the instructions in the user’s guide that came with your Mac to set it up. 
Because you have a wireless mouse, skip the instructions for connecting a USB mouse. 
Wait to start up your Mac until instructed to do so in step 3.
Slide the switch
up to turn the
mouse off.
Push the latch
down to remove
the bottom cover.
Insert one or both AA batteries
with the positive (+) end up.4 English
Step 3:  Pairing Your Mouse
Before you can use your wireless Mighty Mouse, you have to pair it with your Mac. 
Pairing allows your mouse and Mac to communicate wirelessly with each other. You 
only have to pair them once.
The first time you start up your Mac, Setup Assistant guides you in setting up your 
wireless Mighty Mouse and pairing it with your Mac.
To pair your mouse and your Mac:
1 Slide the switch down to turn the mouse on. 
The laser used by the Mighty Mouse is not visible, but a small green indicator light on 
the bottom of the mouse blinks when the mouse is on and the batteries are charged.
2 Turn on your Mac.
3 When your Mac starts up, follow the onscreen instructions in Setup Assistant. 
Slide the switch down to
turn the mouse on.
The indicator light shows
that the mouse is on.English 5
Using Your Mighty Mouse
The Mighty Mouse has laser tracking technology, so you can use it on most surfaces. 
The Mighty Mouse comes with left and right buttons, a scroll ball (which can be 
clicked) and a button on either side. To use your Mighty Mouse:
Â Click the left or right button.
Â Press the side buttons.
Â Click or roll the scroll ball. 
Either the left or right button can function as the primary button. Use the primary 
button to click, double-click, and drag items. Either button can also function as the 
secondary button. Use the secondary button to display an item’s shortcut menu. You 
can assign a function to the side buttons, which work together as a single button, and 
to the scroll ball, which also functions as a button. 
Scroll ball (button)
Left button
Side button Side button
Right button6 English
Customizing Your Mighty Mouse
Use the Mouse pane of Keyboard & Mouse preferences to change the way your Mighty 
Mouse works. 
To customize your mouse:
1 Choose Apple () > System Preferences.
2 Click Keyboard & Mouse.
3 Click Mouse.
Use the pop-up menu to assign an action to each button. You can set any of the 
buttons to activate Dashboard, Exposé, Spotlight, switch applications, or open 
applications. You can enable or disable scrolling and screen zoom, and adjust the 
speed for tracking, scrolling, and double-clicking. You can also activate screen zoom by 
simultaneously pressing a key on the keyboard and scrolling.
More Information
For more information about using your wireless Mighty Mouse, open Mac Help and 
search for “Mighty Mouse.”
Renaming Your Mouse
Your Mac automatically gives your wireless mouse a unique name the first time it’s 
paired. You can rename your mouse using Keyboard & Mouse preferences. Choose 
Apple () > System Preferences and click Keyboard & Mouse. Click the Bluetooth® tab 
and enter a name in the Name field.English 7
Cleaning Your Mouse and Scroll Ball
Follow these guidelines to clean the outside of your mouse and the scroll ball:
Â Remove the batteries.
Â Use a lint-free cloth that’s been lightly moistened with water to clean the mouse 
exterior and the scroll ball.
Â Don’t get moisture in any openings. Don’t use aerosol sprays, solvents, or abrasives.
If your mouse stops scrolling or if scrolling becomes rough, clean the mouse scroll ball. 
Rotate the ball while cleaning for complete coverage. If scrolling feels rough, hold the 
mouse upside down and roll the ball vigorously while cleaning it to help remove any 
particles that may have collected.
About Your Batteries
Your Mighty Mouse comes with two nonrechargeable AA lithium batteries. Lithium 
batteries provide longer battery life, but you can also use alkaline or rechargeable AA 
batteries. Your mouse works with either one or two batteries installed. To reduce the 
weight of your mouse, install one battery; to extend the time between battery 
replacements, install two.
WARNING:  When you replace the batteries, replace them all at the same time. Also, 
don’t mix old batteries with new batteries or mix battery types (for example, don’t mix 
alkaline and lithium batteries). Don’t open or puncture the batteries, install them 
backwards, or expose them to fire, high temperatures, or water. Don’t charge the 
nonrechargeable AA lithium batteries that came with your mouse. Keep batteries out 
of the reach of children.8 English
Battery Disposal
Dispose of batteries according to your local environmental laws and guidelines.
Battery Indicator
You can use Keyboard & Mouse preferences to check the battery level. Choose 
Apple () > System Preferences. Click Keyboard & Mouse and click Bluetooth.
Note:  To conserve battery power, turn your mouse off when you are not using it. If you 
are not planning to use your mouse for an extended period, remove the batteries.
Ergonomics
For information about ergonomics, health, and safety, visit the Apple ergonomics 
website at www.apple.com/about/ergonomics.
Support 
For support and troubleshooting information, user discussion boards, and the latest 
Apple software downloads, go to www.apple.com/support.910111213141516 Français
2 Configuration de votre souris 
Mighty Mouse sans fil
Félicitations pour l’acquisition de la souris Mighty Mouse 
sans fil comme périphérique d’entrée. 
Utilisation de la souris Mighty Mouse sans fil 
Pour installer les piles dans la souris, configurer votre Mac et utiliser l’Assistant réglages 
pour configurer la souris avec votre Mac, veuillez suivre les instructions des pages 
suivantes.
Important :  n’allumez votre souris que lorsque vous êtes sur le point d’allumer votre 
Mac comme décrit à l’étape 3.
Étape 1 :  Installation des piles
Pour installer les piles dans votre souris Mighty Mouse sans fil, veuillez suivre les instructions ci-dessous. Vous pouvez installer une ou deux des piles au lithium AA non 
rechargeables fournies avec votre souris (consultez la rubrique « À propos des piles » à 
la page 22 pour en savoir plus).
Pour installer les piles dans la souris :
1 Retournez la souris et retirez le couvercle.
2 Placez les piles dans le compartiment comme illustré.Français 17
3 Remettez le couvercle de la souris.
Étape 2 :  Configuration de votre Mac
Configurez votre Mac en suivant les instructions du Guide de l’utilisateur qui l’accompagne. Étant donné que vous possédez une souris sans fil, les instructions concernant 
la connexion d’une souris USB ne vous concernent pas. 
Ne démarrez votre Mac que lorsque cela vous est indiqué à l’étape 3.
Faites glisser
l’interrupteur 
vers le haut pour
éteindre la souris.
Poussez ce verrou vers
le bas pour retirer le
couvercle inférieur.
Insérez une ou deux piles AA.
La borne positive (+) doit être
placée vers le haut.18 Français
Étape 3 :  Jumelage de votre souris
Avant d’utiliser votre souris Mighty Mouse sans fil, vous devez la jumeler avec 
votre Mac. Grâce au jumelage, la souris peut communiquer sans fil avec votre Mac. 
Le jumelage ne s’effectue qu’une seule fois.
La première fois que vous démarrez votre Mac, l’Assistant réglages vous guide tout 
au long de la configuration de votre souris Mighty Mouse sans fil afin de la jumeler 
à votre Mac.
Pour jumeler votre souris à votre Mac :
1 Faites glisser l’interrupteur vers le bas pour allumer la souris. 
Le laser utilisé par la souris Mighty Mouse n’est pas visible, mais une petite lampe 
témoin verte placée en bas de la souris clignote lorsque celle-ci est en marche et 
que les piles sont suffisamment chargées.
Faites glisser l’interrupteur vers
le bas pour allumer la souris.
Le voyant lumineux indique
que la souris est allumée.Français 19
2 Allumez votre Mac.
3 Suivez ensuite les instructions à l’écran de l’Assistant réglages. 
Utilisation de votre Mighty Mouse
La souris Mighty Mouse intègre la technologie de déplacement par laser, ce qui 
permet de l’utiliser sur la plupart des surfaces. 
La Mighty Mouse possède deux boutons (un gauche et un droit), une boule de défilement cliquable et un bouton sur chaque côté. Pour utiliser votre Mighty Mouse, vous 
pouvez :
Â cliquer sur le bouton gauche ou droit,
Â appuyer sur un des boutons latéraux,
Â faire défiler ou cliquer sur la boule de défilement. 20 Français
Le bouton de gauche ou celui de droite peut agir en tant que bouton principal selon 
votre choix. Utilisez le bouton principal pour cliquer ou double-cliquer sur des éléments, 
ou encore pour les faire glisser. Ces boutons peuvent également servir de bouton secondaire. Celui-ci permet d’afficher le menu contextuel d’un élément. Vous pouvez affecter 
une fonction spécifique aux boutons latéraux, qui fonctionnent conjointement comme 
un seul bouton, et à la boule de défilement, faisant également office de bouton. 
Personnalisation de votre Mighty Mouse
Utilisez la sous-fenêtre Souris des préférences Clavier et souris pour modifier le mode 
de fonctionnement de votre Mighty Mouse. 
Pour personnaliser votre souris :
1 Sélectionnez le menu Pomme () > Préférences Système.
2 Cliquez sur Clavier et souris.
3 Cliquez ensuite sur Souris.
Boule de défilement 
(bouton)
Bouton gauche
Bouton latéral
Bouton latéral
Bouton droitFrançais 21
Utilisez les menus locaux pour affecter une action à chaque bouton. Vous pouvez ainsi 
régler n’importe quel bouton pour activer le Dashboard, Exposé, Spotlight, pour passer 
d’une application à l’autre ou en ouvrir directement. Vous pouvez activer ou désactiver 
le défilement ou le zoom de l’écran, mais aussi affiner la vitesse du déplacement du 
pointeur, du défilement et du double-clic. Enfin, vous avez la possibilité d’activer le 
zoom de l’écran en appuyant sur une touche du clavier tout en activant le défilement.
Informations complémentaires
Pour en savoir plus sur l’utilisation de votre Mighty Mouse sans fil, ouvrez l’Aide Mac et 
lancez une recherche du terme “Mighty Mouse”.
Changement du nom de votre souris
La première fois que la souris sans fil est jumelée, votre Mac lui attribue automatiquement un nom unique. Vous pouvez changer ce nom dans les préférences Clavier et 
souris. Sélectionnez le menu Pomme () > Préférences Système, puis cliquez sur 
Clavier et souris. Cliquez sur l’onglet Bluetooth® et saisissez un nouveau nom dans 
le champ Nom.
Entretien de votre souris et de la boule de défilement
Suivez les instructions suivantes pour assurer le nettoyage et l’entretien extérieur 
de votre souris et de la boule de défilement :
Â Retirez les piles.
Â Servez-vous d’un chiffon légèrement humide et ne peluchant pas pour nettoyer 
l’extérieur de la souris et la boule de défilement.22 Français
Â Faites en sorte que l’humidité ne s’infiltre pas par une des ouvertures. N’utilisez pas 
d’aérosol, de solvant ou tout autre produit abrasif.
Si votre souris ne défile plus ou si cela devient difficile, nettoyez la boule de défilement. Faites pivoter la boule tout en passant le chiffon afin de la nettoyer de toutes 
parts. Si la boule semble résister, retournez la souris et faites tourner la boule vigoureusement tout en procédant au nettoyage pour contribuer à faire tomber les particules 
qui s’y seraient accumulées.
À propos des piles
Votre Mighty Mouse est fournie avec deux piles au lithium AA non rechargeables. Les 
piles au lithium sont caractérisées par une durée de vie plus longue, mais vous pouvez 
également utiliser des piles AA alcalines ou rechargeables. Votre souris fonctionne aussi 
bien avec une qu’avec deux piles. Ne placez qu’une seule pile si vous voulez réduire 
le poids de votre souris mais placez-en deux si vous voulez éviter de changer les piles 
fréquemment.
AVERTISSEMENT :  lorsque vous changez les piles, remplacez-les toutes en même 
temps. Ne mélangez pas de vieilles piles avec des nouvelles, ni différents types de 
piles (par exemple, ne mettez pas de piles alcalines avec des piles au lithium). 
N’ouvrez pas les piles, ne les percez pas, ne les installez pas à l’envers et ne les exposez pas au feu, à des températures élevées ou à l’eau. Ne tentez pas de recharger les 
piles au lithium AA non rechargeables fournies avec votre souris. Conservez-les hors 
de portée des enfants.Français 23
Mise au rebut des piles
Mettez les piles au rebut en respectant la réglementation et les directives locales en 
matière d’environnement.
Témoin de charge
Vous pouvez utiliser les préférences Clavier & Souris pour connaître le niveau de charge 
des piles. Sélectionnez le menu Pomme () > Préférences Système. Cliquez sur Clavier 
et souris, puis sur Bluetooth.
Remarque :  pour économiser les piles, éteignez votre souris dès que vous avez fini 
de l’utiliser. Si vous ne comptez pas vous en servir pendant une période prolongée, 
retirez les piles.
Ergonomie
Pour obtenir des informations sur l’ergonomie, la santé et la sécurité, rendez-vous sur 
le site Web d’Apple concernant l’ergonomie : www.apple.com/fr/about/ergonomics
Assistance 
Pour accéder à toute information supplémentaire sur l’assistance et le dépannage, 
à des forums de discussion et aux derniers téléchargements de logiciels Apple 
rendez-vous sur à l’adresse www.apple.com/fr/support.24 Español
3 Configuración del ratón inalámbrico 
Mighty Mouse
Enhorabuena por haber elegido el ratón inalámbrico 
Mighty Mouse como dispositivo de entrada. 
Utilización del ratón inalámbrico Mighty Mouse 
Siga los pasos que se describen en las páginas siguientes para instalar las pilas en 
el ratón, configurar su Mac y utilizar el Asistente de Configuración para configurar 
el ratón con su ordenador.
Importante:  No encienda el ratón hasta que vaya a arrancar el ordenador en el paso 3.
Paso 1:  Colocación de las pilas
Siga las instrucciones que figuran a continuación para insertar las pilas en el ratón 
inalámbrico Mighty Mouse. Puede optar por instalar las dos pilas de litio AA no recargables incluidas con el ratón o solamente una (para más información al respecto, 
consulte el apartado “Acerca de las pilas” en la página 30).
Para colocar las pilas en el ratón:
1 Dé la vuelta al ratón y extraiga la tapa posterior.
2 Introduzca las pilas en el compartimento tal como se muestra en la ilustración.Español 25
3 Coloque de nuevo la tapa de la parte posterior y no encienda el ratón.
Paso 2:  Configuración del Mac
Para configurar su ordenador, siga las instrucciones que figuran en el manual que se 
suministraba con su Mac. Puesto que tiene un ratón inalámbrico, no es necesario que 
lea las instrucciones correspondientes a la conexión de un ratón USB. 
No arranque el Mac hasta que no se le solicite hacerlo en el paso 3.
Desplace el interruptor
hacia arriba para
apagar el ratón.
Presione este cierre hacia
abajo para abrir la tapa 
posterior del ratón.
Introduzca una o dos pilas AA con 
los polos positivos (+) hacia arriba.26 Español
Paso 3:  Enlace del ratón con el ordenador
Antes de poder utilizar el ratón inalámbrico Mighty Mouse, debe enlazarlo con su Mac. 
El proceso de enlace permite que el ratón se comunique de forma inalámbrica con 
el ordenador. Esta operación sólo deberá llevarse a cabo una vez.
La primera vez que arranca el ordenador, el Asistente de Configuración le guía a través 
de los pasos necesarios para configurar el ratón inalámbrico Mighty Mouse y enlazarlo 
con su Mac.
Para enlazar el ratón con el Mac:
1 Deslice el conmutador hacia abajo para encender el ratón. 
El láser que utiliza el Mighty Mouse es invisible, pero en la base del ratón hay un 
pequeño indicador luminoso de color verde que parpadea cuando el ratón está 
encendido y las pilas están cargadas.
Desplace el interruptor
hacia abajo para 
encender el ratón.
El indicador luminoso
indica que el ratón
está encendido.Español 27
2 Encienda el ordenador.
3 Cuando el sistema haya arrancado, siga las instrucciones del Asistente de 
Configuración que van apareciendo en pantalla. 
Uso del Mighty Mouse
Gracias a la tecnología láser del Mighty Mouse, es posible utilizarlo en la mayoría de 
las superficies. 
El Mighty Mouse incorpora un botón izquierdo, uno derecho, una bola de desplazamiento (que sirve para hacer clic) y dos botones laterales, uno en cada cara. Para usar 
el Mighty Mouse:
Â Haga clic en el botón izquierdo o derecho.
Â Pulse los botones laterales.
Â Haga clic o haga rodar la bola de desplazamiento. 28 Español
Tanto el botón derecho como el izquierdo pueden funcionar como botón principal. 
Utilice el botón principal para hacer un clic simple o doble y para arrastrar ítems. 
Ambos botones pueden hacer las veces también de botón secundario. Utilice el botón 
secundario para visualizar el menú de función rápida de un ítem. Puede asignar una 
función a los botones laterales, que funcionan juntos como un único botón, y también 
a la bola de desplazamiento, que también funciona como un botón. 
Bola de desplazamiento 
(botón)
Botón izquierdo
Botón lateral Botón lateral
Botón derechoEspañol 29
Cómo personalizar su Mighty Mouse
Utilice el panel Ratón del panel de preferencias Teclado y Ratón para cambiar el modo 
de funcionamiento del Mighty Mouse. 
Para personalizar el ratón:
1 Seleccione Apple () > Preferencias del Sistema.
2 Haga clic en Teclado y Ratón.
3 Haga clic en Ratón.
Utilice el menú local para asignar una acción a cada botón. Puede configurar cualquiera de los botones para activar el Dashboard, Exposé y Spotlight, alternar entre aplicaciones abiertas o abrir aplicaciones. Puede activar o desactivar el desplazamiento y 
el zoom de pantalla, así como ajustar la velocidad del cursor, del desplazamiento y del 
doble clic. Además, puede activar la ampliación o reducción de la pantalla pulsando 
simultáneamente una tecla del teclado y desplazando el ratón.
Más información
Para obtener más información acerca de cómo usar su Mighty Mouse inalámbrico, 
abra la Ayuda Mac y efectúe una búsqueda por “Mighty Mouse.”
Cómo cambiar el nombre del ratón
El Mac asigna automáticamente un nombre único al ratón inalámbrico la primera vez 
que se establece el enlace con el ratón. No obstante, si lo desea, puede modificar este 
nombre en el panel de preferencias Teclado y Ratón. Para ello, seleccione Apple () > 
Preferencias del Sistema y haga clic en Teclado y Ratón. Haga clic en la pestaña 
Bluetooth® e introduzca un nuevo nombre en el campo Nombre.30 Español
Limpieza del ratón y la bola de desplazamiento
Siga estas instrucciones para limpiar el exterior y la bola de desplazamiento del ratón:
Â Extraiga las pilas.
Â Utilice un paño suave que no desprenda pelusa y ligeramente humedecido en agua 
para limpiar la superficie exterior del ratón y la bola de desplazamiento.
Â Procure que no entre agua o humedad por las aberturas. No utilice aerosoles, 
disolventes ni limpiadores abrasivos.
Si la bola de desplazamiento no funciona correctamente o nota que el desplazamiento 
no se realiza con suavidad, limpie la bola de desplazamiento del ratón. Para ello, límpiela haciéndola girar en todas las direcciones. Si la bola no gira suavemente, sostenga 
el ratón boca abajo y hágala girar enérgicamente mientras la limpia para eliminar 
cualquier partícula que pueda estar adherida.
Acerca de las pilas
Con el Mighty Mouse se incluyen dos pilas AA de litio no recargables. Las pilas de litio 
duran más, pero también puede usar pilas alcalinas o pilas AA recargables. El ratón funciona indistintamente con una pila o con dos instaladas. Para reducir el peso del ratón, 
instale solo una pila; si lo que le interesa es alargar el tiempo transcurrido entre la instalación de unas pilas y su sustitución, instale dos.
ADVERTENCIA:  Cuando sea necesario cambiar las pilas, sustituya siempre todas y no 
mezcle pilas nuevas con viejas ni tipos de pilas distintos (por ejemplo, no mezcle pilas 
alcalinas con pilas de litio). No intente abrir ni perforar las pilas, no las coloque al 
revés y evite que entren en contacto con el fuego, con altas temperaturas o con 
el agua. No intente recargar las dos pilas de litio AA no recargables que venían con 
el ratón. Mantenga las pilas fuera del alcance de los niños.Español 31
Eliminación de las pilas
Tire las pilas siguiendo la normativa ambiental aplicable en su municipio.
Indicador de carga de las pilas
Puede comprobar el nivel de carga de las pilas a través del panel de preferencias 
Teclado y Ratón. Seleccione Apple () > Preferencias del Sistema. Haga clic en
Teclado y Ratón y, a continuación, en Bluetooth.
Nota:  Para prolongar la duración de las pilas, apague el ratón cuando no lo utilice. 
Si tiene pensado no utilizarlo durante un tiempo prolongado, es aconsejable extraer 
las pilas.
Ergonomía
Para obtener más información sobre ergonomía, salud y seguridad, visite la página web 
de Apple sobre ergonomía: www.apple.com/es/about/ergonomics.
Soporte 
Para obtener información acerca de soporte y resolución de problemas, sobre foros 
de discusión de usuarios y las últimas novedades en descargas de software de Apple, 
visite la página web www.apple.com/es/support32
Regulatory Compliance Information
Compliance Statement
This device complies with part 15 of the FCC rules. 
Operation is subject to the following two conditions:  (1) 
This device may not cause harmful interference, and (2) 
this device must accept any interference received, 
including interference that may cause undesired 
operation. See instructions if interference to radio or 
television reception is suspected.
L‘utilisation de ce dispositif est autorisée seulement aux 
conditions suivantes : (1) il ne doit pas produire de 
brouillage et (2) l’utilisateur du dispositif doit étre prêt à 
accepter tout brouillage radioélectrique reçu, même si 
ce brouillage est susceptible de compromettre le 
fonctionnement du dispositif. 
Radio and Television Interference 
The equipment described in this manual generates, 
uses, and can radiate radio-frequency energy. If it is not 
installed and used properly—that is, in strict accordance 
with Apple’s instructions—it may cause interference 
with radio and television reception.
This equipment has been tested and found to comply 
with the limits for a Class B digital device in accordance 
with the specifications in Part 15 of FCC rules. These 
specifications are designed to provide reasonable 
protection against such interference in a residential 
installation. However, there is no guarantee that 
interference will not occur in a particular installation.
You can determine whether your computer system is 
causing interference by turning it off. If the interference 
stops, it was probably caused by the computer or one of 
the peripheral devices. 
If your computer system does cause interference to 
radio or television reception, try to correct the 
interference by using one or more of the following 
measures:
Â Turn the television or radio antenna until the 
interference stops. 
Â Move the computer to one side or the other of the 
television or radio. 
Â Move the computer farther away from the television or 
radio. 
Â Plug the computer into an outlet that is on a different 
circuit from the television or radio. (That is, make 
certain the computer and the television or radio are on 
circuits controlled by different circuit breakers or 
fuses.)
If necessary, consult an Apple Authorized Service 
Provider or Apple. See the service and support 
information that came with your Apple product. Or, 
consult an experienced radio or television technician for 
additional suggestions.
Important:  Changes or modifications to this product 
not authorized by Apple Inc., could void the FCC 
compliance and negate your authority to operate the 
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3Application memory management is the process of allocating memory during your program’s runtime, using
it, and freeing it when you are done with it. A well-written program uses as little memory as possible. In
Objective-C, it can also be seen as a way of distributing ownership of limited memory resources among many
pieces of data and code. When you have finished working through this guide, you will have the knowledge
you need to manage your application’s memory by explicitly managing the life cycle of objects and freeing
them when they are no longer needed.
Although memory management istypically considered at the level of an individual object, your goal is actually
to manage object graphs. You want to make sure that you have no more objects in memory than you actually
need.
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At a Glance
Objective-C provides two methods of application memory management.
1. In the method described in this guide, referred to as“manual retain-release” or MRR, you explicitly manage
memory by keeping track of objects you own. This is implemented using a model, known as reference
counting, that the Foundation class NSObject provides in conjunction with the runtime environment.
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About Memory Management2. In Automatic Reference Counting, or ARC, the system uses the same reference counting system as MRR,
but it insertsthe appropriate memory management method callsfor you at compile-time. You are strongly
encouraged to use ARC for new projects. If you use ARC, there is typically no need to understand the
underlying implementation described in this document, although it may in some situations be helpful.
For more about ARC, see Transitioning to ARC Release Notes.
If you plan on writing code for iOS, you must use explicit memory management (the subject of this guide).
Further, if you plan on writing library routines, plug-ins, orshared code—code that might be loaded into either
a garbage-collection or non-garbage-collection process—you want to write your code using the
memory-management techniques described throughout this guide. (Make sure that you then test your code
in Xcode, with garbage collection disabled and enabled.)
Good Practices Prevent Memory-Related Problems
There are two main kinds or problem that result from incorrect memory management:
● Freeing or overwriting data that is still in use
This causes memory corruption, and typically resultsin your application crashing, or worse, corrupted user
data.
● Not freeing data that is no longer in use causes memory leaks
A memory leak is where allocated memory is not freed, even though it is never used again. Leaks cause
your application to use ever-increasing amounts of memory, which in turn may result in poor system
performance or (in iOS) your application being terminated.
Thinking about memory management from the perspective of reference counting, however, is frequently
counterproductive, because you tend to consider memory management in terms of the implementation details
rather than in terms of your actual goals. Instead, you should think of memory management from the perspective
of object ownership and object graphs.
Cocoa uses a straightforward naming convention to indicate when you own an object returned by a method.
See “Memory Management Policy” (page 7).
Although the basic policy is straightforward, there are some practical steps you can take to make managing
memory easier, and to help to ensure your program remains reliable and robust while at the same time
minimizing its resource requirements.
See “Practical Memory Management” (page 12).
About Memory Management
At a Glance
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5Autorelease pool blocks provide a mechanism whereby you can send an object a “deferred” release message.
Thisis useful in situations where you want to relinquish ownership of an object, but want to avoid the possibility
of it being deallocated immediately (such as when you return an object from a method). There are occasions
when you might use your own autorelease pool blocks.
See “Using Autorelease Pool Blocks” (page 20).
Use Analysis Tools to Debug Memory Problems
To identify problems with your code at compile time, you can use the Clang Static Analyzer that is built into
Xcode.
If memory management problems do nevertheless arise, there are other tools and techniques you can use to
identify and diagnose the issues.
● Many of the tools and techniques are described in Technical Note TN2239, iOS Debugging Magic , in
particular the use of NSZombie to help find over-released object.
● You can use Instruments to track reference counting events and look for memory leaks. See “Collecting
Data on Your App”.
About Memory Management
At a Glance
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6The basic model used for memory management in a reference-counted environment is provided by a
combination of methods defined in the NSObject  protocol and a standard method naming convention. The
NSObject class also defines a method, dealloc, that is invoked automatically when an object is deallocated.
This article describes all the basic rules you need to know to manage memory correctly in a Cocoa program,
and provides some examples of correct usage.
Basic Memory Management Rules
The memory management model is based on object ownership. Any object may have one or more owners.
Aslong as an object has at least one owner, it continuesto exist. If an object has no owners, the runtime system
destroys it automatically. To make sure it is clear when you own an object and when you do not, Cocoa sets
the following policy:
● You own any object you create
You create an object using a method whose name begins with “alloc”, “new”, “copy”, or “mutableCopy”
(for example, alloc, newObject, or mutableCopy).
● You can take ownership of an object using retain
A received object is normally guaranteed to remain valid within the method it was received in, and that
method may also safely return the object to its invoker. You use retain in two situations: (1) In the
implementation of an accessor method or an init method, to take ownership of an object you want to
store as a property value; and (2) To prevent an object from being invalidated as a side-effect of some
other operation (as explained in “Avoid Causing Deallocation of Objects You’re Using” (page 16)).
● When you no longer need it, you must relinquish ownership of an object you own
You relinquish ownership of an object by sending it a release message or an autorelease message.
In Cocoa terminology, relinquishing ownership of an object is therefore typically referred to as “releasing”
an object.
● You must not relinquish ownership of an object you do not own
This is just corollary of the previous policy rules, stated explicitly.
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Memory Management PolicyA Simple Example
To illustrate the policy, consider the following code fragment:
{
Person *aPerson = [[Person alloc] init];
// ...
NSString *name = aPerson.fullName;
// ...
[aPerson release];
}
The Person object is created using the alloc method, so it is subsequently sent a release message when it
is no longer needed. The person’s name is not retrieved using any of the owning methods, so it is not sent a
release message. Notice, though, that the example uses release rather than autorelease.
Use autorelease to Send a Deferred release
You use autorelease when you need to send a deferred release message—typically when returning an
object from a method. For example, you could implement the fullName method like this:
- (NSString *)fullName {
NSString *string = [[[NSString alloc] initWithFormat:@"%@ %@",
self.firstName, self.lastName]
autorelease];
return string;
}
You own the string returned by alloc. To abide by the memory management rules, you must relinquish
ownership of the string before you lose the reference to it. If you use release, however, the string will be
deallocated before it is returned (and the method would return an invalid object). Using autorelease, you
signify that you want to relinquish ownership, but you allow the caller of the method to use the returned string
before it is deallocated.
You could also implement the fullName method like this:
- (NSString *)fullName {
NSString *string = [NSString stringWithFormat:@"%@ %@",
Memory Management Policy
Basic Memory Management Rules
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8self.firstName, self.lastName];
return string;
}
Following the basic rules, you don’t own the string returned by stringWithFormat:,so you can safely return
the string from the method.
By way of contrast, the following implementation is wrong :
- (NSString *)fullName {
NSString *string = [[NSString alloc] initWithFormat:@"%@ %@",
self.firstName, self.lastName];
return string;
}
According to the naming convention, there is nothing to denote that the caller of the fullName method owns
the returned string. The caller therefore has no reason to release the returned string, and it will thus be leaked.
You Don’t Own Objects Returned by Reference
Some methods in Cocoa specify that an object is returned by reference (that is, they take an argument of type
ClassName ** or id *). A common pattern is to use an NSError object that contains information about an
error if one occurs, as illustrated by initWithContentsOfURL:options:error: (NSData) and
initWithContentsOfFile:encoding:error: (NSString).
In these cases, the same rules apply as have already been described. When you invoke any of these methods,
you do not create the NSError object, so you do not own it. There is therefore no need to release it, as
illustrated in this example:
NSString *fileName = ;
NSError *error;
NSString *string = [[NSString alloc] initWithContentsOfFile:fileName
encoding:NSUTF8StringEncoding error:&error];
if (string == nil) {
// Deal with error...
}
// ...
[string release];
Memory Management Policy
Basic Memory Management Rules
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9Implement dealloc to Relinquish Ownership of Objects
The NSObject class defines a method, dealloc, that is invoked automatically when an object has no owners
and its memory is reclaimed—in Cocoa terminology it is “freed” or “deallocated.”. The role of the dealloc
method is to free the object's own memory, and to dispose of any resources it holds, including ownership of
any object instance variables.
The following example illustrates how you might implement a dealloc method for a Person class:
@interface Person : NSObject
@property (retain) NSString *firstName;
@property (retain) NSString *lastName;
@property (assign, readonly) NSString *fullName;
@end
@implementation Person
// ...
- (void)dealloc
[_firstName release];
[_lastName release];
[super dealloc];
}
@end
Memory Management Policy
Implement dealloc to Relinquish Ownership of Objects
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10Important:  Never invoke another object’s dealloc method directly.
You must invoke the superclass’s implementation at the end of your implementation.
You should not tie management of system resources to object lifetimes; see “Don’t Use dealloc to Manage
Scarce Resources” (page 17).
When an application terminates, objects may not be sent a dealloc message. Because the process’s
memory is automatically cleared on exit, it is more efficient simply to allow the operating system to clean
up resources than to invoke all the memory management methods.
Core Foundation Uses Similar but Different Rules
There are similar memory management rules for Core Foundation objects (see Memory Management
Programming Guide for Core Foundation ). The naming conventions for Cocoa and Core Foundation, however,
are different. In particular, Core Foundation’s Create Rule (see “The Create Rule” in Memory Management
Programming Guide for Core Foundation ) does not apply to methods that return Objective-C objects. For
example, in the following code fragment, you are not responsible for relinquishing ownership of myInstance:
MyClass *myInstance = [MyClass createInstance];
Memory Management Policy
Core Foundation Uses Similar but Different Rules
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11Although the fundamental concepts described in “Memory Management Policy” (page 7) are straightforward,
there are some practical steps you can take to make managing memory easier, and to help to ensure your
program remains reliable and robust while at the same time minimizing its resource requirements.
Use Accessor Methods to Make Memory Management Easier
If your class has a property that is an object, you must make sure that any object that is set as the value is not
deallocated while you’re using it. You must therefore claim ownership of the object when it is set. You must
also make sure you then relinquish ownership of any currently-held value.
Sometimes it might seem tedious or pedantic, but if you use accessor methods consistently, the chances of
having problems with memory management decrease considerably. If you are using retain and release
on instance variables throughout your code, you are almost certainly doing the wrong thing.
Consider a Counter object whose count you want to set.
@interface Counter : NSObject
@property (nonatomic, retain) NSNumber *count;
@end;
The property declares two accessor methods. Typically, you should ask the compiler to synthesize the methods;
however, it’s instructive to see how they might be implemented.
In the “get” accessor, you just return the synthesized instance variable, so there is no need for retain or
release:
- (NSNumber *)count {
return _count;
}
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Practical Memory ManagementIn the “set” method, if everyone else is playing by the same rules you have to assume the new count may be
disposed of at any time so you have to take ownership of the object—by sending it a retain message—to
ensure it won’t be. You must also relinquish ownership of the old count object here by sending it a release
message. (Sending a message to nil is allowed in Objective-C, so the implementation will still work if _count
hasn’t yet been set.) You must send this after [newCount retain] in case the two are the same object—you
don’t want to inadvertently cause it to be deallocated.
- (void)setCount:(NSNumber *)newCount {
[newCount retain];
[_count release];
// Make the new assignment.
_count = newCount;
}
Use Accessor Methods to Set Property Values
Suppose you want to implement a method to reset the counter. You have a couple of choices. The first
implementation creates the NSNumber instance with alloc, so you balance that with a release.
- (void)reset {
NSNumber *zero = [[NSNumber alloc] initWithInteger:0];
[self setCount:zero];
[zero release];
}
The second uses a convenience constructor to create a new NSNumber object. There is therefore no need for
retain or release messages
- (void)reset {
NSNumber *zero = [NSNumber numberWithInteger:0];
[self setCount:zero];
}
Note that both use the set accessor method.
The following will almost certainly work correctly for simple cases, but as tempting as it may be to eschew
accessor methods, doing so will almost certainly lead to a mistake atsome stage (for example, when you forget
to retain or release, or if the memory management semantics for the instance variable change).
Practical Memory Management
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13- (void)reset {
NSNumber *zero = [[NSNumber alloc] initWithInteger:0];
[_count release];
_count = zero;
}
Note also that if you are using key-value observing, then changing the variable in this way is not KVO compliant.
Don’t Use Accessor Methods in Initializer Methods and dealloc
The only places you shouldn’t use accessor methods to set an instance variable are in initializer methods and
dealloc. To initialize a counter object with a number object representing zero, you might implement an init
method as follows:
- init {
self = [super init];
if (self) {
_count = [[NSNumber alloc] initWithInteger:0];
}
return self;
}
To allow a counter to be initialized with a count other than zero, you might implement an initWithCount:
method as follows:
- initWithCount:(NSNumber *)startingCount {
self = [super init];
if (self) {
_count = [startingCount copy];
}
return self;
}
Since the Counter class has an object instance variable, you must also implement a dealloc method. Itshould
relinquish ownership of any instance variables by sending them a release message, and ultimately it should
invoke super’s implementation:
Practical Memory Management
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14- (void)dealloc {
[_count release];
[super dealloc];
}
Use Weak References to Avoid Retain Cycles
Retaining an object creates a strong reference to that object. An object cannot be deallocated until all of its
strong references are released. A problem, known as a retain cycle, can therefore arise if two objects may have
cyclical references—that is, they have a strong reference to each other (either directly, or through a chain of
other objects each with a strong reference to the next leading back to the first).
The object relationships shown in Figure 1 (page 15) illustrate a potential retain cycle. The Document object
has a Page object for each page in the document. Each Page object has a property that keeps track of which
document it is in. If the Document object has a strong reference to the Page object and the Page object has
a strong reference to the Document object, neither object can ever be deallocated. The Document’s reference
count cannot become zero until the Page object is released, and the Page object won’t be released until the
Document object is deallocated.
Figure 1 An illustration of cyclical references
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15The solution to the problem of retain cycles is to use weak references. A weak reference is a non-owning
relationship where the source object does not retain the object to which it has a reference.
To keep the object graph intact, however, there must be strong references somewhere (if there were only
weak references, then the pages and paragraphs might not have any owners and so would be deallocated).
Cocoa establishes a convention, therefore, that a “parent” object should maintain strong references to its
“children,” and that the children should have weak references to their parents.
So, in Figure 1 (page 15) the document object has a strong reference to (retains) its page objects, but the page
object has a weak reference to (does not retain) the document object.
Examples of weak references in Cocoa include, but are not restricted to, table data sources, outline view items,
notification observers, and miscellaneous targets and delegates.
You need to be careful about sending messages to objects for which you hold only a weak reference. If you
send a message to an object after it has been deallocated, your application will crash. You must have well-defined
conditions for when the object is valid. In most cases, the weak-referenced object is aware of the other object’s
weak reference to it, asisthe case for circular references, and isresponsible for notifying the other object when
it deallocates. For example, when you register an object with a notification center, the notification centerstores
a weak reference to the object and sends messages to it when the appropriate notifications are posted. When
the object is deallocated, you need to unregister it with the notification center to prevent the notification
center from sending any further messages to the object, which no longer exists. Likewise, when a delegate
object is deallocated, you need to remove the delegate link by sending a setDelegate: message with a nil
argument to the other object. These messages are normally sent from the object’s dealloc method.
Avoid Causing Deallocation of Objects You’re Using
Cocoa’s ownership policy specifies that received objects should typically remain valid throughout the scope
of the calling method. It should also be possible to return a received object from the current scope without
fear of it being released. It should not matter to your application that the getter method of an object returns
a cached instance variable or a computed value. What matters is that the object remains valid for the time you
need it.
There are occasional exceptions to this rule, primarily falling into one of two categories.
1. When an object is removed from one of the fundamental collection classes.
heisenObject = [array objectAtIndex:n];
[array removeObjectAtIndex:n];
// heisenObject could now be invalid.
Practical Memory Management
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16When an object is removed from one of the fundamental collection classes, it is sent a release (rather
than autorelease) message. If the collection was the only owner of the removed object, the removed
object (heisenObject in the example ) is then immediately deallocated.
2. When a “parent object” is deallocated.
id parent = ;
// ...
heisenObject = [parent child] ;
[parent release]; // Or, for example: self.parent = nil;
// heisenObject could now be invalid.
In some situations you retrieve an object from another object, and then directly or indirectly release the
parent object. If releasing the parent causes it to be deallocated, and the parent was the only owner of
the child, then the child (heisenObject in the example) will be deallocated at the same time (assuming
that it is sent a release rather than an autorelease message in the parent’s dealloc method).
To protect against these situations, you retain heisenObject upon receiving it and you release it when you
have finished with it. For example:
heisenObject = [[array objectAtIndex:n] retain];
[array removeObjectAtIndex:n];
// Use heisenObject...
[heisenObject release];
Don’t Use dealloc to Manage Scarce Resources
You should typically not manage scarce resources such as file descriptors, network connections, and buffers
or caches in a dealloc method. In particular, you should not design classes so that dealloc will be invoked
when you think it will be invoked. Invocation of dealloc might be delayed or sidestepped, either because of
a bug or because of application tear-down.
Instead, if you have a class whose instances manage scarce resources, you should design your application such
that you know when you no longer need the resources and can then tell the instance to “clean up” at that
point. You would typically then release the instance, and dealloc would follow, but you will not suffer
additional problems if it does not.
Problems may arise if you try to piggy-back resource management on top of dealloc. For example:
Practical Memory Management
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171. Order dependencies on object graph tear-down.
The object graph tear-down mechanism is inherently non-ordered. Although you might typically
expect—and get—a particular order, you are introducing fragility. If an object is unexpectedly autoreleased
rather than released for example, the tear-down order may change, which may lead to unexpected results.
2. Non-reclamation of scarce resources.
Memory leaks are bugsthatshould be fixed, but they are generally not immediately fatal. Ifscarce resources
are not released when you expect them to be released, however, you may run into more serious problems.
If your application runs out of file descriptors, for example, the user may not be able to save data.
3. Cleanup logic being executed on the wrong thread.
If an object is autoreleased at an unexpected time, it will be deallocated on whatever thread’s autorelease
pool block it happens to be in. This can easily be fatal for resources that should only be touched from one
thread.
Collections Own the Objects They Contain
When you add an object to a collection (such as an array, dictionary, or set), the collection takes ownership of
it. The collection will relinquish ownership when the object isremoved from the collection or when the collection
is itself released. Thus, for example, if you want to create an array of numbers you might do either of the
following:
NSMutableArray *array = ;
NSUInteger i;
// ...
for (i = 0; i < 10; i++) {
NSNumber *convenienceNumber = [NSNumber numberWithInteger:i];
[array addObject:convenienceNumber];
}
In this case, you didn’t invoke alloc, so there’s no need to call release. There is no need to retain the new
numbers (convenienceNumber), since the array will do so.
NSMutableArray *array = ;
NSUInteger i;
// ...
for (i = 0; i < 10; i++) {
Practical Memory Management
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18NSNumber *allocedNumber = [[NSNumber alloc] initWithInteger:i];
[array addObject:allocedNumber];
[allocedNumber release];
}
In this case, you do need to send allocedNumber a release message within the scope of the for loop to
balance the alloc. Since the array retained the number when it was added by addObject:, it will not be
deallocated while it’s in the array.
To understand this, put yourself in the position of the person who implemented the collection class. You want
to make sure that no objects you’re given to look after disappear out from under you, so you send them a
retain message as they’re passed in. If they’re removed, you have to send a balancing release message,
and any remaining objects should be sent a release message during your own dealloc method.
Ownership Policy Is Implemented Using Retain Counts
The ownership policy is implemented through reference counting—typically called “retain count” after the
retain method. Each object has a retain count.
● When you create an object, it has a retain count of 1.
● When you send an object a retain message, its retain count is incremented by 1.
● When you send an object a release message, its retain count is decremented by 1.
When you send an object a autorelease message, its retain count is decremented by 1 at the end of
the current autorelease pool block.
●
If an object’s retain count is reduced to zero, it is deallocated.
Important:  There should be no reason to explicitly ask an object what itsretain count is(see retainCount).
The result is often misleading, as you may be unaware of what framework objects have retained an object
in which you are interested. In debugging memory management issues, you should be concerned only
with ensuring that your code adheres to the ownership rules.
Practical Memory Management
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19Autorelease pool blocks provide a mechanism whereby you can relinquish ownership of an object, but avoid
the possibility of it being deallocated immediately (such as when you return an object from a method). Typically,
you don’t need to create your own autorelease pool blocks, but there are some situations in which either you
must or it is beneficial to do so.
About Autorelease Pool Blocks
An autorelease pool block is marked using @autoreleasepool, as illustrated in the following example:
@autoreleasepool {
// Code that creates autoreleased objects.
}
At the end of the autorelease pool block, objects that received an autorelease message within the block
are sent a release message—an object receives a release message for each time it wassent an autorelease
message within the block.
Like any other code block, autorelease pool blocks can be “nested:”
@autoreleasepool {
// . . .
@autoreleasepool {
// . . .
}
. . .
}
(You wouldn’t normally see code exactly as above; typically code within an autorelease pool block in one
source file would invoke code in another source file that is contained within another autorelease pool block.)
For a given autorelease message, the corresponding release message issent at the end of the autorelease
pool block in which the autorelease message was sent.
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Using Autorelease Pool BlocksCocoa always expects code to be executed within an autorelease pool block, otherwise autoreleased objects
do not get released and your application leaks memory. (If you send an autorelease message outside of an
autorelease pool block, Cocoa logs a suitable error message.) The AppKit and UIKit frameworks process each
event-loop iteration (such as a mouse down event or a tap) within an autorelease pool block. Therefore you
typically do not have to create an autorelease pool block yourself, or even see the code that is used to create
one. There are, however, three occasions when you might use your own autorelease pool blocks:
●
If you are writing a program that is not based on a UI framework, such as a command-line tool.
●
If you write a loop that creates many temporary objects.
You may use an autorelease pool block inside the loop to dispose of those objects before the next iteration.
Using an autorelease pool block in the loop helps to reduce the maximum memory footprint of the
application.
●
If you spawn a secondary thread.
You must create your own autorelease pool block as soon as the thread begins executing; otherwise, your
application will leak objects. (See “Autorelease Pool Blocks and Threads” (page 23) for details.)
Use Local Autorelease Pool Blocksto Reduce Peak Memory Footprint
Many programs create temporary objects that are autoreleased. These objects add to the program’s memory
footprint until the end of the block. In many situations, allowing temporary objects to accumulate until the
end of the current event-loop iteration does not result in excessive overhead; in some situations, however,
you may create a large number of temporary objects that add substantially to memory footprint and that you
want to dispose of more quickly. In these latter cases, you can create your own autorelease pool block. At the
end of the block, the temporary objects are released, which typically results in their deallocation thereby
reducing the program’s memory footprint.
The following example shows how you might use a local autorelease pool block in a for loop.
NSArray *urls = ;
for (NSURL *url in urls) {
@autoreleasepool {
NSError *error;
NSString *fileContents = [NSString stringWithContentsOfURL:url
encoding:NSUTF8StringEncoding error:&error];
/* Process the string, creating and autoreleasing more objects. */
}
Using Autorelease Pool Blocks
Use Local Autorelease Pool Blocks to Reduce Peak Memory Footprint
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The for loop processes one file at a time. Any object (such as fileContents)sent an autorelease message
inside the autorelease pool block is released at the end of the block.
After an autorelease pool block, you should regard any object that was autoreleased within the block as
“disposed of.” Do not send a message to that object or return it to the invoker of your method. If you must
use a temporary object beyond an autorelease pool block, you can do so by sending a retain message to
the object within the block and then send it autorelease after the block, as illustrated in this example:
– (id)findMatchingObject:(id)anObject {
id match;
while (match == nil) {
@autoreleasepool {
/* Do a search that creates a lot of temporary objects. */
match = [self expensiveSearchForObject:anObject];
if (match != nil) {
[match retain]; /* Keep match around. */
}
}
}
return [match autorelease]; /* Let match go and return it. */
}
Sending retain to match within the autorelease pool block the and sending autorelease to it after the
autorelease pool block extends the lifetime of match and allows it to receive messages outside the loop and
be returned to the invoker of findMatchingObject:.
Using Autorelease Pool Blocks
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22Autorelease Pool Blocks and Threads
Each thread in a Cocoa application maintains its own stack of autorelease pool blocks. If you are writing a
Foundation-only program or if you detach a thread, you need to create your own autorelease pool block.
If your application or thread is long-lived and potentially generates a lot of autoreleased objects, you should
use autorelease pool blocks (like AppKit and UIKit do on the main thread); otherwise, autoreleased objects
accumulate and your memory footprint grows. If your detached thread does not make Cocoa calls, you do not
need to use an autorelease pool block.
Note:  If you create secondary threads using the POSIX thread APIsinstead of NSThread, you cannot
use Cocoa unless Cocoa is in multithreading mode. Cocoa enters multithreading mode only after
detaching its first NSThread object. To use Cocoa on secondary POSIX threads, your application
must first detach at least one NSThread object, which can immediately exit. You can test whether
Cocoa is in multithreading mode with the NSThread class method isMultiThreaded.
Using Autorelease Pool Blocks
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Figures, Tables, and ListingsThis document is the starting point for creating iOS apps. It describes the fundamental architecture of iOS
apps, including how the code you write fits together with the code provided by iOS. This document also offers
practical guidance to help you make better choices during your design and planning phase and guides you
to the other documents in the iOS developer library that contain more detailed information about how to
address a specific task.
The contents of this document apply to all iOS apps running on all types of iOS devices, including iPad, iPhone,
and iPod touch.
Note:  Development of iOS apps requires an Intel-based Macintosh computer with the iOS SDK
installed. For information about how to get the iOS SDK, go to the iOS Dev Center.
At a Glance
The starting point for any new app isidentifying the design choices you need to make and understanding how
those choices map to an appropriate implementation.
Translate Your Initial Idea into an Implementation Plan
Every great iOS app starts with a great idea, but translating that idea into actions requires some planning.
Every iOS app relies heavily on design patterns, and those design patterns influence much of the code you
need to write. So before you write any code, take the time to explore the possible techniques and technologies
available for writing that code. Doing so can save you a lot of time and frustration.
Relevant Chapter:  “App Design Basics” (page 12)
UIKit Provides the Core of Your App
The core infrastructure of an iOS app is built from objectsin the UIKit framework. The objectsin thisframework
provide all of the support for handling events, displaying content on the screen, and interacting with the rest
of the system. Understanding the role these objects play, and how you modify them to customize the default
app behavior, is therefore very important for writing apps quickly and correctly.
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About iOS App ProgrammingRelevant Chapter:  “Core App Objects” (page 17)
Apps Must Behave Differently in the Foreground and Background
An iOS device runs multiple apps simultaneously but only one app—the foreground app—has the user’s
attention at any given time. The current foreground app is the only app allowed to present a user interface
and respond to touch events. Other apps remain in the background, usually asleep but sometimes running
additional code. Transitioning between the foreground and background states involves changing several
aspects of your app’s behavior.
Relevant Chapter:  “App States and Multitasking” (page 33)
iCloud Affects the Design of Your Data Model and UI Layers
iCloud allows you to share the user’s data among multiple instances of your app running on different iOS and
Mac OS X devices. Incorporating support for iCloud into your app involves changing many aspects of how you
manage your files. Because files in iCloud are accessible by more than just your app, all file operations must
be synchronized to prevent data corruption. And depending on your app and how it presents its data, iCloud
can also require changes to portions of your user interface.
Relevant Chapter:  “Integrating iCloud Support Into Your App” (page 26)
Apps Require Some Specific Resources
There are some resources that must be present in all iOS apps. Most apps include images, sounds, and other
types of resources for presenting the app’s content but the App Store also requires some specific resources
be present. The reason is that iOS uses several specific resources when presenting your app to the user and
when coordinating interactions with other parts of the system. So these resources are there to improve the
overall user experience.
Relevant Chapter:  “App-Related Resources” (page 93)
Apps Should Restore Their Previous UI State at Launch Time
At launch time, your app should restore its user interface to the state it was in when it was last used. During
normal use, the system controls when apps are terminated. Normally when this happens, the app displays its
default user interface when it is relaunched. With state restoration, UIKit helps your app restore your app’s
interface to its previous state, which promotes a consistent user experience.
About iOS App Programming
At a Glance
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9Relevant Chapter:  “State Preservation and Restoration” (page 67)
Many App Behaviors Can Be Customized
The core architecture of all apps may be the same, but there are still ways for you to tweak the high-level
design of your app. Some of these tweaks are how you add specific high-level features, such as data protection
and URL handling. Others affect the design of specific types of apps, such as VoIP apps.
Relevant Chapter:  “Advanced App Tricks” (page 108)
Apps Must Be Tuned for Performance
Great apps are always tuned for the best possible performance. For iOS apps, performance means more than
just writing fast code. It often means writing better code so that your user interface remains responsive to user
input, your app does not degrade battery life significantly, and your app does not impact othersystem resources.
Before you can tune your code, though, learn about the types of changes that are likely to provide the most
benefit.
Relevant Chapter:  “Performance Tuning” (page 127)
The iOS Environment Affects Many App Behaviors
There are aspects of iOS itself that impact how you design and write applications. Because iOS is built for
mobile devices, it takes a more active role in providing security for apps. Other system behaviors also affect
everything from how memory is managed to how the system responds to hardware input. All of these system
behaviors affect the way you design your apps.
Relevant Appendix:  “The iOS Environment” (page 137)
How to Use This Document
This document providesimportant information about the core objects of your app and how they work together.
This document does not address the creation of any specific type of iOS app. Instead, it provides a tour of the
architecture that is common to all iOS apps and highlights key places where you can modify that architecture
to meet your needs. Whenever possible, the document also offers tips and guidance about ways to implement
features related to the core app architecture.
About iOS App Programming
How to Use This Document
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10Prerequisites
This document is the entry-point guide for designing an iOS app. This guide also covers many of the practical
aspects involved with implementing your app. However, this book assumes that you have already installed
the iOS SDK and configured your development environment. You must perform those steps before you can
start writing and building iOS apps.
If you are new to iOS app development, read Start Developing iOS Apps Today . This document offers a
step-by-step introduction to the development process to help you get up to speed quickly. It also includes a
hands-on tutorial that walks you through the app-creation process from start to finish, showing you how to
create a simple app and get it running quickly.
See Also
For additional information related to app design, see the following documents:
● For guidance about how to design an iOS app, read iOS Human Interface Guidelines. This book provides
you with tips and guidance about how to create a great experience for users of your app. It also conveys
the basic design philosophy surrounding iOS apps.
●
If you are not sure what is possible in an iOS app, read iOS Technology Overview. This book provides a
summary of iOS technologies and the situations where you might want to use them. This book is not
required reading but is a good reference during the brainstorming phase of your project.
About iOS App Programming
Prerequisites
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11If you are a new to developing iOS apps, you might be wondering where the app development process starts.
After devising your initial idea for an app, you need to turn that idea into an action plan for implementing your
app. From a design perspective, you need to make some high-level decisions about the best course of action
for implementing your ideas. You also need to set up your initial Xcode project in a way that makes it easy to
proceed with development.
If you are new to developing iOS apps altogether, spend some time familiarizing yourself with the basic
concepts. There are tutorials to help you jump right in if you want to start writing code, but iOS is a system
built from basic design patterns. Taking a little bit of time to learn those patterns will help you tremendously
later.
Doing Your Initial Design
There are many ways to design an app, and many of the best approaches do not involve writing any code. A
great app starts with a great idea that you then expand into a more full-featured product description. Early in
the design phase, it helps to understand just what you want your app to do. Write down the set of high-level
features that would be required to implement your idea. Prioritize those features based on what you think
your users will need. Do a little research into iOS itself so that you understand its capabilities and how you
might be able to use them to achieve your goals. And sketch out some rough interface designs on paper to
visualize how your app might look.
The goal of your initial design is to answer some very important questions about your app. The set of features
and the rough design of your interface help you think about what will be required later when you start writing
code. At some point, you need to translate the information displayed by your app into a set of data objects.
Similarly, the look of your app has an overwhelming influence on the choices you must make when implementing
your user interface code. Doing your initial design on paper (as opposed to on the computer) gives you the
freedom to come up with answers that are not limited by what is easy to do.
Of course, the most important thing you can do before starting your initial design is read iOS Human Interface
Guidelines. That book describes several strategies for doing your initial design. It also offers tips and guidance
about how to create apps that work well in iOS. You might also read iOS Technology Overview to understand
how the capabilities of iOS and how you might use those capabilities to achieve your design goals.
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App Design BasicsLearning the Fundamental iOS Design Patterns and Techniques
No matter what type of app you are creating, there are a few fundamental design patterns and techniques
that you must know before you start writing code. In iOS, the system frameworks provide critical infrastructure
for your app and in most cases are the only way to access the underlying hardware. In turn, the frameworks
use many specific design patterns and assume that you are familiar with them. Understanding these design
patterns is therefore an important first step to understanding how the system can help you develop your app.
The most important design patterns you must know are:
● Model-View-Controller—This design pattern governs the overall structure of your app.
● Delegation—This design pattern facilitates the transfer information and data from one object to another.
● Target-action—This design pattern translates user interactions with buttons and controls into code that
your app can execute.
● Block objects—You use blocks to implement callbacks and asynchronous code.
● Sandboxing—All iOS apps are placed in sandboxes to protect the system and other apps. The structure of
the sandbox affects the placement of your app’s files and has implications for data backups and some
app-related features.
Accurate and efficient memory management is important for iOS apps. Because iOS apps typically have less
usable memory than a comparable desktop computer, apps need to be aggressive about deleting unneeded
objects and be lazy about creating objects in the first place. Apps use the compiler’s Automatic Reference
Counting (ARC) feature to manage memory efficiently. Although using ARC is not required, it is highly
recommended. The alternative is to manage memory yourself by explicitly retaining and releasing objects.
There are other design patterns that you might see used occasionally or use yourself in your own code. For a
complete overview of the design patterns and techniques you will use to create iOS apps, see Start Developing
iOS Apps Today .
Translating Your Initial Design into an Action Plan
iOS assumes that all apps are built using the Model-View-Controller design pattern. Therefore, the first step you
can take toward achieving this goal is to choose an approach for the data and view portions of your app.
● Choose a basic approach for your data model:
● Existing data model code—If you already have data model code written in a C-based language, you
can integrate that code directly into your iOS apps. Because iOS apps are written in Objective-C, they
work just fine with code written in other C-based languages. Of course, there is also benefit to writing
an Objective-C wrapper for any non Objective-C code.
App Design Basics
Learning the Fundamental iOS Design Patterns and Techniques
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13● Customobjects datamodel—A custom object typically combinessome simple data (strings, numbers,
dates, URLs, and so on) with the businesslogic needed to manage that data and ensure its consistency.
Custom objects can store a combination of scalar values and pointers to other objects. For example,
the Foundation framework defines classes for many simple data types and for storing collections of
other objects. These classes make it much easier to define your own custom objects.
● Structured data model—If your data is highly structured—that is, it lends itself to storage in a
database—use Core Data (or SQLite) to store the data. Core Data provides a simple object-oriented
model for managing yourstructured data. It also provides built-in support forsome advanced features
like undo and iCloud. (SQLite files cannot be used in conjunction with iCloud.)
● Decide whether you need support for documents:
The job of a document isto manage your app’sin-memory data model objects and coordinate the storage
of that data in a corresponding file (or set of files) on disk. Documents normally connote files that the user
created but apps can use documents to manage non user facing files too. One big advantage of using
documents is that the UIDocument class makes interacting with iCloud and the local file system much
simpler. For appsthat use Core Data to store their content, the UIManagedDocument class providessimilar
support.
● Choosing an approach for your user interface:
● Building block approach—The easiest way to create your user interface isto assemble it using existing
view objects. Views represent visual elements such as tables, buttons, text fields, and so on. You use
many views as-is but you can also customize the appearance and behavior ofstandard views as needed
to meet your needs. You can also implement new visual elements using custom views and mix those
views freely with the standard views in your interface. The advantages of views are that they provide
a consistent user experience and they allow you to define complex interfaces quickly and with relatively
little code.
● OpenGL ES-based approach—If your app requiresfrequentscreen updates orsophisticated rendering,
you probably need to draw that content directly using OpenGL ES. The main use of OpenGL ES is for
games and appsthat rely heavily on sophisticated graphics, and therefore need the best performance
possible.
Starting the App Creation Process
After you formulate your action plan, it is time to start coding. If you are new to writing iOS apps, it is good to
take some time to explore the initial Xcode templates that are provided for development. These templates
greatly simplify the work you have to do and make it possible to have an app up and running in minutes. These
templates also allow you to customize your initial project to support your specific needs more precisely. To
that end, when creating your Xcode project, you should already have answers to the following questions in
mind:
App Design Basics
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14● What is the basic interface-style of your app? Different types of app require different sets of initial views
and view controllers. Knowing how you plan to organize your user interface lets you select an initial project
template that is most suited to your needs. You can always change your user interface later, but choosing
the most appropriate template first makes starting your project much easier.
● Do you want to create a Universal app or one targeted specifically for iPad or iPhone? Creating a
universal app requires specifying different sets of views and view controllers for iPad and iPhone and
dynamically selecting the appropriate set at runtime. Universal apps are preferred because they support
more iOS devices but do require you to factor your code better for each platform. For information about
how a universal app affects the code you write, see “Creating a Universal App” (page 108).
● Do you want your app to use storyboards? Storyboards simplify the design process by showing both
the views and view controllers of your user interface and the transitions between them. Storyboards are
supported in iOS 5 and later and are enabled by default for new projects. If your app must run on earlier
versions of iOS, though, you cannot use storyboards and should continue to use nib files.
● Do you want to use Core Data for your data model? Some types of apps lend themselves naturally to a
structured data model, which makes them ideal candidates for using Core Data. For more information
about Core Data and the advantages it offers, see Core Data Programming Guide .
From these questions, you can use Xcode to create your initial project files and start coding.
1. If you have not yet installed Xcode, do so and configure your iOS development team. For detailed
information about setting up your development teams and and preparing your Xcode environment, see
Developing for the App Store .
2. Create your initial Xcode project.
3. Before writing any code, build and run your new Xcode project. Target your app for iOS Simulator so that
you can see it run.
Every new Xcode project starts you with a fully functional (albeit featureless) app. The app itself should
run and display the default views found in the main storyboard or nib file, which are probably not very
interesting. The reason that the app runs at all, though, is because of the infrastructure provided to you
by UIKit. This infrastructure initializes the app, loads the initial interface file, and checks the app in with
the system so that it can start handling events. For more information about this infrastructure and the
capabilities it provides, see “The Core Objects of Your App” (page 17) and “The App Launch Cycle” (page
36).
4. Start writing your app’s primary code.
For new apps, you probably want to start creating the classes associated with your app’s data model first.
These classes usually have no dependencies on other parts of your app and should be something you can
work on initially. For information about ways to build your data model, see “The Data Model” (page 20).
App Design Basics
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15You might also want to start playing around with designs for your user interface by adding views to your
main storyboard or nib file. From these views, you can also start identifying the places in your code where
you need to respond to interface-related changes. For an overview of user interfaces and where they fit
into your app’s code, see “The User Interface” (page 26).
If your app supports iCloud, you should incorporate support for iCloud into your classes at an early stage.
For information about adding iCloud support to your app, see “Integrating iCloud Support Into Your
App” (page 26).
5. Add support for app state changes.
In iOS, the state of an app determines what it is allowed to do and when. App states are managed by
high-level objects in your app but can affect many other objects as well. Therefore, you need to consider
how the current app state affects your data model and view code and update that code appropriately.
For information about app states and how apps run in the foreground and background, see “App States
and Multitasking” (page 33)
6. Create the resources needed to support your app.
Apps submitted to the App Store are expected to have specific resources such as icons and launch images
to make the overall user experience better. Well-factored apps also make heavy use of resource files to
keep their code separate from the data that code manipulates. This factoring makes it much easier to
localize your app, tweak its appearance, and perform other tasks without rewriting any code. For information
about the types of resourcesfound in a typical iOS app and how they are used,see “The App Bundle” (page
30) and “App-Related Resources” (page 93).
7. As needed, implement any app-specific behaviors that are relevant for your app.
There are many ways to modify the way your app launches or interacts with the system. For information
about the most common types of app customizations, see “Advanced App Tricks” (page 108).
8. Add the advanced features that make your app unique.
iOS includes many other frameworksfor managing multimedia, advanced rendering, game content, maps,
contacts, location tracking, and many other advanced features. For an overview of the frameworks and
features you can incorporate into your apps, see iOS Technology Overview.
9. Do some basic performance tuning for your app.
All iOS appsshould be tuned for the best possible performance. Tuned appsrun faster but also use system
resources,such as memory and battery life, more efficiently. For information about areasto focus on during
the tuning process, see “Performance Tuning” (page 127).
10. Iterate.
App development is an iterative process. As you add new features, you might need to revisit some or all
of the preceding steps to make adjustments to your existing code.
App Design Basics
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16UIKit provides the infrastructure for all apps but it is your custom objects that define the specific behavior of
your app. Your app consists of a handful of specific UIKit objects that manage the event loop and the primary
interactions with iOS. Through a combination of subclassing, delegation, and other techniques, you modify the
default behaviors defined by UIKit to implement your app.
In addition to customizing the UIKit objects, you are also responsible for providing or defining other key sets
of objects. The largest set of objects is your app’s data objects, the definition of which is entirely your
responsibility. You must also provide a set of user interface objects, but fortunately UIKit provides numerous
classes to make defining your interface easy. In addition to code, you must also provide the resources and data
files you need to deliver a shippable app.
The Core Objects of Your App
From the time your app is launched by the user, to the time it exits, the UIKit framework manages much of
the app’s core behavior. At the heart of the app is the UIApplication object, which receives events from
the system and dispatches them to your custom code for handling. Other UIKit classes play a part in managing
your app’s behavior too, and all of these classes have similar ways of calling your custom code to handle the
details.
To understand how UIKit objects work with your custom code, it helps to understand a little about the objects
make up an iOS app. Figure 2-1 shows the objects that are most commonly found in an iOS app, and Table
2-1 describes the roles of each object. As you can see from the diagram, iOS apps are organized around the
model-view-controller design pattern. This pattern separates the data objects in the model from the views used
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Core App Objectsto present that data. This separation promotes code reuse by making it possible to swap out your views as
needed and is especially useful when creating universal apps—that is, apps that can run on both iPad and
iPhone.
Figure 2-1 Key objects in an iOS app
Table 2-1 The role of objects in an iOS app
Object Description
You use the UIApplication object essentially asis—that is, withoutsubclassing.
This controller object managesthe app event loop and coordinates other high-level
app behaviors. Your own custom app-level logic resides in your app delegate
object, which works in tandem with this object.
UIApplication
object
Core App Objects
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18Object Description
The app delegate is a custom object created at app launch time, usually by the
UIApplicationMain function. The primary job of this object is to handle state
transitions within the app. For example, this object is responsible for launch-time
initialization and handling transitionsto and from the background. For information
about how you use the app delegate to manage state transitions, see “Managing
App State Changes” (page 34).
In iOS 5 and later, you can use the app delegate to handle other app-related
events. The Xcode project templates declare the app delegate as a subclass of
UIResponder. If the UIApplication object does not handle an event, it
dispatches the event to your app delegate for processing. For more information
about the types of events you can handle, see UIResponder Class Reference .
App delegate
object
Data model objects store your app’s content and are specific to your app. For
example, a banking app might store a database containing financial transactions,
whereas a painting app might store an image object or even the sequence of
drawing commands that led to the creation of that image. (In the latter case, an
image object isstill a data object because it isjust a container for the image data.)
Apps can also use document objects (custom subclasses of UIDocument) to
manage some or all of their data model objects. Document objects are not required
but offer a convenient way to group data that belongs in a single file or file
package. For more information about documents,see “Defining a Document-Based
Data Model” (page 24).
Documents and
data model objects
View controller objects manage the presentation of your app’s content on screen.
A view controller manages a single view and its collection of subviews. When
presented, the view controller makes its views visible by installing them in the
app’s window.
The UIViewController class is the base class for all view controller objects. It
provides default functionality for loading views, presenting them, rotating them
in response to device rotations, and several otherstandard system behaviors. UIKit
and other frameworks define additional view controller classes to implement
standard system interfaces such as the image picker, tab bar interface, and
navigation interface.
For detailed information about how to use view controllers, see View Controller
Programming Guide for iOS .
View controller
objects
Core App Objects
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19Object Description
A UIWindow object coordinatesthe presentation of one or more views on a screen.
Most apps have only one window, which presents content on the main screen,
but apps may have an additional window for content displayed on an external
display.
To change the content of your app, you use a view controller to change the views
displayed in the corresponding window. You never replace the window itself.
In addition to hosting views, windows work with the UIApplication object to
deliver events to your views and view controllers.
UIWindow object
Views and controls provide the visual representation of your app’s content. A view
is an object that draws content in a designated rectangular area and responds to
events within that area. Controls are a specialized type of view responsible for
implementing familiar interface objects such as buttons, text fields, and toggle
switches.
The UIKit framework provides standard views for presenting many different types
of content. You can also define your own custom views by subclassing UIView (or
its descendants) directly.
In addition to incorporating views and controls, apps can also incorporate Core
Animation layersinto their view and control hierarchies. Layer objects are actually
data objects that represent visual content. Views use layer objects intensively
behind the scenes to render their content. You can also add custom layer objects
to your interface to implement complex animations and other types of
sophisticated visual effects.
View, control, and
layer objects
What distinguishes one iOS app from another is the data it manages (and the corresponding business logic)
and how it presents that data to the user. Most interactions with UIKit objects do not define your app but help
you to refine its behavior. For example, the methods of your app delegate let you know when the app is
changing states so that your custom code can respond appropriately.
For information about the specific behaviors of a given class, see the corresponding class reference. For more
information about how events flow in your app and information about your app’s responsibilities at various
points during that flow, see “App States and Multitasking” (page 33).
The Data Model
Your app’s data model comprises your data structures and the business logic needed to keep that data in a
consistent state. You never want to design your data model in total isolation from your app’s user interface;
however, the implementation of your data model objects should be separate and not rely on the presence of
Core App Objects
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20specific views or view controllers. Keeping your data separate from your user interface makes it easier to
implement a universal app—one that can run on both iPad and iPhone—and also makes it easier to reuse
portions of your code later.
If you have not yet defined your data model, the iOS frameworks provide help for doing so. The following
sections highlight some of the technologies you can use when defining specific types of data models.
Defining a Custom Data Model
When defining a custom data model, create custom objects to represent any high-level constructs but take
advantage of the system-supplied objects for simpler data types. The Foundation framework provides many
objects (most of which are listed in Table 2-2) for managing strings, numbers, and other types of simple data
in an object-oriented way. Using these objects is preferable to defining new objects both because it saves time
and because many other system routines expect you to use the built-in objects anyway.
Table 2-2 Data classes in the Foundation framework
Data Classes Description
Strings in iOS are Unicode based. The string classes
provide support for creating and manipulating strings
in a variety of ways. The attributed string classes
support stylized text and are used only in conjunction
with Core Text.
NSString
(NSMutableString)
NSAttributedString
(NSMutableAttributedString)
Strings and
text
When you want to store numerical values in a
collection, use number objects. The NSNumber class
can represent integer, floating-point values, Booleans,
and char types. The NSIndexPath class stores a
sequence of numbers and is often used to specify
multi-layer selections in hierarchical lists.
NSNumber
NSDecimalNumber
NSIndexPath
Numbers
For times when you need to store raw streams of bytes,
use data objects. Data objects are also commonly used
to store objectsin an archived form. The NSValue class
is typically extended (using categories) and used to
archive common data types such as points and
rectangles.
NSData (NSMutableData)
NSValue
Raw bytes
Use date objects to store timestamps, calendar dates,
and other time-related information.
NSDate
NSDateComponents
Dates and
times
Core App Objects
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21Data Classes Description
In addition to their traditional use for referring to
network resources, URLs in iOS are the preferred way
to store paths to files. The NSURL class even provides
support for getting and setting file-related attributes.
URLs NSURL
Use collections to group related objects together in a
single place. The Foundation framework provides
several different types of collection classes
NSArray
(NSMutableArray)
NSDictionary
(NSMutableDictionary)
NSIndexSet
(NSMutableIndexSet)
NSOrderedSet
(NSMutableOrderedSet)
NSSet (NSMutableSet)
Collections
In addition to data-related objects, there are some other data types that are commonly used by the iOS
frameworks to manage familiar types of data. You are encouraged to use these data types in your own custom
objects to represent similar types of data.
● NSInteger/NSUInteger—Abstractions for scalar signed and unsigned integers that define the integer
size based on the architecture.
● NSRange—A structure used to define a contiguous portion of a series. For example, you can use ranges
to define the selected characters in a string.
● NSTimeInterval—The number of seconds (whole and partial) in a given time interval.
● CGPoint—An x and y coordinate value that defines a location.
● CGSize—Coordinate values that define a set of horizontal and vertical extents.
● CGRect—Coordinate values that define a rectangular region.
Of course, when defining custom objects, you can always incorporate scalar values directly into your class
implementations. In fact, a custom data object can include a mixture of scalar and object types for its member
variables. Listing 2-1 shows a sample class definition for a collection of pictures. The class in this instance
contains an array of images and a list of the indexes into that array representing the selected items. The class
also contains a string for the collection’s title and a scalar Boolean variable indicating whether the collection
is currently editable.
Core App Objects
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22Listing 2-1 Definition of a custom data object
@interface PictureCollection : NSObject {
NSMutableOrderedSet* pictures;
NSMutableIndexSet* selection;
NSString* title;
BOOL editable;
}
@property (nonatomic, strong) NSString * title;
@property (nonatomic, readonly) NSOrderedSet* pictures;
// Method definitions...
@end
Note:  When defining data objects, it is strongly recommended that you declare properties for any
member variables that you to expose to clients of the object. Synthesizing these properties in your
implementation file automatically creates appropriate accessor methods with the attributes you
require. This ensures that object relationships are maintained appropriately and that references to
objects are removed at appropriate times.
Consider how undo operations on your custom objects might be handled. Supporting undo means being able
to reverse changes made to your objects cleanly. If your objects incorporate complex business logic, you need
to factor that logic in a way that can be undone easily. Here are some tips for implementing undo support in
your custom objects:
● Define the methods you need to make sure that changes to your object are symmetrical. For example, if
you define a method to add an item, make sure you have a method for removing an item in a similar way.
● Factor out your business logic from the code you use to change the values of member variables.
● For multistep actions, use the current NSUndoManager object to group the steps together.
For more information about how to implement undo support in your app, see Undo Architecture . For more
information about the classes of the Foundation framework, see Foundation Framework Reference .
Core App Objects
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23Defining a Structured Data Model Using Core Data
Core Data is a schema-driven object graph management and persistence framework. Fundamentally, Core
Data helps you to save model objects (in the sense of the model-view-controller design pattern) to a file and get
them back again. This is similar to archiving (see Archives and Serializations Programming Guide ), but Core
Data offers much more than that.
● Core Data provides an infrastructure for managing all the changes to your model objects. This gives you
automatic support for undo and redo, and for maintaining reciprocal relationships between objects.
●
It allows you to keep just a subset of your model objects in memory at any given time, which is very
important for iOS apps.
●
It uses a schema to describe the model objects. You define the principal features of your model
classes—including the relationships between them—in a GUI-based editor. This provides a wealth of basic
functionality “for free,” including setting of default values and attribute value validation.
●
It allows you to maintain disjoint sets of edits of your objects. This is useful if you want to, for example,
allow the user to make editsin one view that may be discarded without affecting data displayed in another
view.
●
It has an infrastructure for data store versioning and migration. This lets you easily upgrade an old version
of the user’s file to the current version.
●
It allows you to store your data in iCloud and access it from multiple devices.
For information about how to use Core Data, see Core Data Programming Guide .
Defining a Document-Based Data Model
A document-based data model is a convenient way to manage the files your app writes to disk. In this type of
data model, you use a document object to represent the contents of a single file (or file package) on disk. That
document object is responsible for reading and writing the contents of the file and working with your app’s
view controllers to present the document’s contents on screen. The traditional use for document objects is to
manage files containing user data. For example, an app that creates and managestext files would use a separate
document object to manage each text file. However, you can use document objects for private app data that
is also backed by a file.
Core App Objects
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24Figure 2-2 illustrates the typical relationships between documents, files, and the objects in your app’s data
model. With few exceptions, each document is self-contained and does not interact directly with other
documents. The document manages a single file (or file package) and creates the in-memory representation
of any data found in that file. Because the contents of each file are unique, the data structures associated with
each document are also unique.
Figure 2-2 Using documents to manage the content of files
You use the UIDocument class to implement document objects in your iOS app. This class provides the basic
infrastructure needed to handle the file management aspects of the document. Other benefits of UIDocument
include:
●
It provides support for autosaving the document contents at appropriate times.
●
It handlesthe required file coordination for documentsstored in iCloud. It also provides hooksfor resolving
version conflicts.
●
It provides support for undoing actions.
You mustsubclass UIDocument in order to implement the specific behavior required by your app’s documents.
For detailed information about how to implement a document-based app using UIDocument, see
Document-Based App Programming Guide for iOS .
Core App Objects
The Data Model
2012-09-19   |   © 2012 Apple Inc. All Rights Reserved.
25Integrating iCloud Support Into Your App
No matter how you store your app’s data, iCloud is a convenient way to make that data available to all of the
user’s devices. Supporting iCloud in your app just means changing where you store your files. Instead ofstoring
them in your app’s sandbox directory, you store them in a designated portion of the user’s iCloud storage. In
both cases, your app just works with files and directories. However, with iCloud, you have to do a little extra
work because the data is now shared and accessible to multiple processes. Fortunately, when you use iOS
frameworks to manage your data, much of the hard work needed to support iCloud is done for you.
● Document based apps get iCloud support through the UIDocument class. This class handles almost all of
the complex interactions required to manage iCloud-based files.
● Core Data apps also get iCloud support through the Core Data framework. This framework automatically
updates the data stores on all of the user’s devices to account for new and changed data objects, leaving
each device with a complete and up-to-date set of data.
●
If you implement a custom data model and manage files yourself, you can use file presenters and file
coordinators to ensure that the changes you make are done safely and in concert with the changes made
on the user’s other devices.
● For apps that want to share preferences or small quantities of infrequently changing data, you can use
the NSUbiquitousKeyValueStore object to do so. This objectsupportsthe sharing ofsimple data types
such as strings, numbers, and dates in limited quantities.
For more information about incorporating iCloud support into your apps, see iCloud Design Guide .
The User Interface
Every iOS app has at least one window and one view for presenting its content. The window provides the area
in which to display the content and is an instance of the UIWindow class. Views are responsible for managing
the drawing of your content (and handling touch events) and are instances of the UIView class. For interfaces
that you build using view objects, your app’s window naturally contains multiple view objects. For interfaces
built using OpenGL ES, you typically have a single view and use that view to render your content.
View controllers also play a very important role in your app’s user interface. A view controller is an instance of
the UIViewController class and is responsible for managing a single set of views and the interactions
between those views and other parts of your app. Because iOS apps have a limited amount of space in which
to display content, view controllers also provide the infrastructure needed to swap out the views from one
view controller and replace them with the views of another view controller. Thus, view controllers are you how
implement transitions from one type of content to another.
Core App Objects
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26You should always think of a view controller object as a self-contained unit. It handles the creation and
destruction of its own views, handles their presentation on the screen, and coordinates interactions between
the views and other objects in your app.
Building an Interface Using UIKit Views
Apps that use UIKit views for drawing are easy to create because you can assemble a basic interface quickly.
The UIKit framework provides many different types of views to help present and organize data. Controls—a
special type of view—provide a built-in mechanism for executing custom code whenever the user performs
appropriate actions. For example, clicking on a button causesthe button’s associated action method to be called.
The advantage of interfaces based on UIKit views is that you can assemble them graphically using Interface
Builder—the visual interface editor built in to Xcode. Interface Builder provides a library of the standard views,
controls, and other objects that you need to build your interface. After dragging these objects from the library,
you drop them onto the work surface and arrange them in any way you want. You then use inspectors to
configure those objects before saving them in a storyboard or nib file. The process of assembling your interface
graphically is much faster than writing the equivalent code and allows you to see the results immediately,
without the need to build and run your app.
Core App Objects
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27Note:  You can also incorporate custom views into your UIKit view hierarchies. A custom view is a
subclass of UIView in which you handle all of the drawing and event-handling tasks yourself. For
more information about creating custom views and incorporating them into your view hierarchies,
see View Programming Guide for iOS .
Figure 2-3 shows the basic structure of an app whose interface is constructed solely using view objects. In this
instance, the main view spansthe visible area of the window (minusthe scroll bar) and provides a simple white
background. The main view also contains three subviews: an image view, a text view, and a button. Those
subviews are what the app uses to present content to the user and respond to interactions. All of the views in
the hierarchy are managed by a single view controller object.
Figure 2-3 Building your interface using view objects
In a typical view-based app, you coordinate the onscreen views using your view controller objects. An app
always has one view controller that is responsible for presenting all of the content on the screen. That view
controller has a content view, which itself may contain other views. Some view controllers can also act as
containers for content provided by other view controllers. For example, a split view controller displays the
content from two view controllers side by side. Because view controllers play a vital role in view management,
understand how they work and the benefits they provide by reading View Controller Programming Guide for
iOS . For more information about views and the role they play in apps, see View Programming Guide for iOS .
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28Building an Interface Using Views and OpenGL ES
Games and other appsthat need high frame rates orsophisticated drawing capabilities can add viewsspecifically
designed for OpenGL ES drawing to their view hierarchies. The simplest type of OpenGL ES app is one that has
a window object and a single view for OpenGL ES drawing and a view controller to manage the presentation
and rotation of that content. More sophisticated applications can use a mixture of both OpenGL ES views and
UIKit views to implement their interfaces.
Figure 2-4 shows the configuration of an app that uses a single OpenGL ES view to draw its interface. Unlike
a UIKit view, the OpenGL ES view is backed by a different type of layer object (a CAEAGLLayer object) instead
of the standard layer used for view-based apps. The CAEAGLLayer object provides the drawing surface that
OpenGL ES can render into. To manage the drawing environment, the app also creates an EAGLContext object
and stores that object with the view to make it easy to retrieve.
Figure 2-4 Building your interface using OpenGL ES
For information on how to configure OpenGL ES for use in your app, see OpenGL ES Programming Guide for
iOS .
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29The App Bundle
When you build your iOS app, Xcode packages it as a bundle. A bundle is a directory in the file system that
groups related resources together in one place. An iOS app bundle contains the app executable file and
supporting resource files such as app icons, image files, and localized content. Table 2-3 lists the contents of
a typical iOS app bundle, which for demonstration purposes is called MyApp. This example is for illustrative
purposes only. Some of the files listed in this table may not appear in your own app bundles.
Table 2-3 A typical app bundle
File Example Description
The executable file contains your app’s compiled
code. The name of your app’s executable file is the
same as your app name minusthe .app extension.
This file is required.
App MyApp
executable
The Info.plist file contains configuration data
for the app. The system usesthis data to determine
how to interact with the app.
This file is required and must be called
Info.plist. For more information, see Figure
6-1 (page 120).
The information Info.plist
property list file
Your app icon is used to represent your app on the
device’s Home screen. Other icons are used by the
system in appropriate places. Icons with @2x in
their filename are intended for devices with Retina
displays.
An app icon is required. For information about
specifying icon image files, see “App Icons” (page
98).
Icon.png
Icon@2x.png
Icon-Small.png
Icon-Small@2x.png
App icons
The system uses this file as a temporary
background while your app is launching. It is
removed as soon as your app is ready to display
its user interface.
At least one launch image is required. For
information about specifying launch images, see
“App Launch (Default) Images” (page 100).
Default.png
Default-Portrait.png
Default-Landscape.png
Launch images
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30File Example Description
Storyboards contain the views and view controllers
that the app presents on screen. Views in a
storyboard are organized according to the view
controller that presents them. Storyboards also
identify the transitions (called segues) that take
the user from one set of views to another.
The name of the main storyboard file is set by
Xcode when you create your project. You can
change the name by assigning a different value to
the NSMainStoryboardFile key in the
Info.plist file.) Apps that use nib files instead
of storyboards can replace the
NSMainStoryboardFile key with the
NSMainNibFile key and use that key to specify
their main nib file.
The use of storyboards (or nib files) is optional but
recommended.
Storyboard MainBoard.storyboard
files (or nib
files)
If you are distributing your app ad hoc, include a
512 x 512 pixel version of your app icon. This icon
is normally provided by the App Store from the
materials you submit to iTunes Connect. However,
because apps distributed ad hoc do not go through
the App Store, your icon must be present in your
app bundle instead. iTunes uses this icon to
represent your app. (The file you specify should be
the same one you would have submitted to the
App Store, if you were distributing your app that
way.)
The filename of thisicon must be iTunesArtwork
and must not include a filename extension. This
file is required for ad hoc distribution but is
optional otherwise.
Ad hoc iTunesArtwork
distribution
icon
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If you want to expose custom app preferences
through the Settings app, you must include a
settings bundle. This bundle contains the property
list data and other resource files that define your
app preferences. The Settings app uses the
information in this bundle to assemble the
interface elements required by your app.
This bundle is optional. For more information about
preferences and specifying a settings bundle, see
Preferences and Settings Programming Guide .
Settings Settings.bundle
bundle
Nonlocalized resources include things like images,
sound files, movies, and custom data filesthat your
app uses. All of these files should be placed at the
top level of your app bundle.
sun.png
mydata.plist
Nonlocalized
resource files
Localized resources must be placed in
language-specific project directories, the names
for which consist of an ISO 639-1 language
abbreviation plusthe .lproj suffix. (For example,
the en.lproj, fr.lproj, and es.lproj
directories contain resources localized for English,
French, and Spanish.)
An iOS app should be internationalized and have a
language.lproj directory for each language it
supports. In addition to providing localized versions
of your app’s custom resources, you can also
localize your app icon, launch images, and Settings
icon by placing files with the same name in your
language-specific project directories.
For more information, see “Localized Resource
Files” (page 105).
en.lproj
fr.lproj
es.lproj
Subdirectories
for localized
resources
Formore information aboutthe structure of an iOS app bundle,see Bundle ProgrammingGuide . Forinformation
about how to load resource files from your bundle, see “Loading Resources Into Your App” (page 106).
Core App Objects
The App Bundle
2012-09-19   |   © 2012 Apple Inc. All Rights Reserved.
32For iOS apps, it is crucial to know whether your app is running in the foreground or the background. Because
system resources are more limited on iOS devices, an app must behave differently in the background than in
the foreground. The operating system also limits what your app can do in the background in order to improve
battery life and to improve the user’s experience with the foreground app. The operating system notifies your
app whenever it moves between the foreground and background. These notifications are your chance to
modify your app’s behavior.
While your app isin the foreground, the system sendstouch eventsto it for processing. The UIKit infrastructure
does most of the hard work of delivering eventsto your custom objects. All you have to do is override methods
in the appropriate objectsto processthose events. For controls, UIKitsimplifiesthings even further by handling
the touch events for you and calling your custom code only when something interesting happens, such as
when the value of a text field changes.
As you implement your app, follow these guidelines:
●
(Required) Respond appropriately to the state transitions that occur. Not handling these transitions
properly can lead to data loss and a bad user experience. For a summary of how to respond to state
transitions, see “Managing App State Changes” (page 34).
●
(Required) When moving to the background, make sure your app adjusts its behavior appropriately. For
guidelines about what to do when your app movesto the background,see “Being a Responsible Background
App” (page 63).
●
(Recommended) Register for any notifications that report system changes your app needs. When an app
is suspended, the system queues key notifications and delivers them when the app resumes execution.
Apps should use these notifications to make a smooth transition back to execution. For more information,
see “Processing Queued Notifications at Wakeup Time” (page 48).
●
(Optional) If your app needsto do actual work while in the background, ask the system for the appropriate
permissions to continue running. For more information about the types of background work you can do
and how to request permission to do that work, see “Background Execution and Multitasking” (page 54).
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At any given moment, your app is in one of the states listed in Table 3-1. The system moves your app from
state to state in response to actions happening throughout the system. For example, when the user presses
the Home button, a phone call comes in, or any of several other interruptions occurs, the currently running
apps change state in response. Figure 3-1 (page 35) shows the paths that an app takes when moving from
state to state.
Table 3-1 App states
State Description
Not running The app has not been launched or was running but was terminated by the system.
The app is running in the foreground but is currently not receiving events. (It may be
executing other code though.) An app usually stays in this state only briefly as it
transitions to a different state.
Inactive
The app is running in the foreground and is receiving events. This is the normal mode
for foreground apps.
Active
The app is in the background and executing code. Most apps enter this state briefly
on their way to being suspended. However, an app that requests extra execution time
may remain in thisstate for a period of time. In addition, an app being launched directly
into the background enters this state instead of the inactive state. For information
about how to execute code while in the background, see “Background Execution and
Multitasking” (page 54).
Background
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34State Description
The app is in the background but is not executing code. The system moves apps to
this state automatically and does not notify them before doing so. While suspended,
an app remains in memory but does not execute any code.
When a low-memory condition occurs, the system may purge suspended apps without
notice to make more space for the foreground app.
Suspended
Figure 3-1 State changes in an iOS app
Note:  Apps running in iOS 3.2 and earlier do not enter the background or suspended states. In
addition, some devices do not support multitasking or background execution at all, even when
running iOS 4 or later. Appsrunning on those devices also do not enter the background orsuspended
states. Instead, apps are terminated upon leaving the foreground.
Most state transitions are accompanied by a corresponding call to the methods of your app delegate object.
These methods are your chance to respond to state changes in an appropriate way. These methods are listed
below, along with a summary of how you might use them.
● application:willFinishLaunchingWithOptions:—This method is your app’s first chance to
execute code at launch time.
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35● application:didFinishLaunchingWithOptions:—This method allows you to perform any final
initialization before your app is displayed to the user.
● applicationDidBecomeActive:—Lets your app know that it is about to become the foreground app.
Use this method for any last minute preparation.
● applicationWillResignActive:—Lets you know that your app is transitioning away from being the
foreground app. Use this method to put your app into a quiescent state.
● applicationDidEnterBackground:—Lets you know that your app is now running in the background
and may be suspended at any time.
● applicationWillEnterForeground:—Lets you know that your app is moving out of the background
and back into the foreground, but that it is not yet active.
● applicationWillTerminate:—Lets you know that your app is being terminated. This method is not
called if your app is suspended.
The App Launch Cycle
When your app islaunched, it movesfrom the not running state to the active or background state, transitioning
briefly through the inactive state. As part of the launch cycle, the system creates a process and main thread
for your app and calls your app’s main function on that main thread. The default main function that comes
with your Xcode project promptly hands control over to the UIKit framework, which does most of the work in
initializing your app and preparing it to run.
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36Figure 3-2 shows the sequence of events that occurs when an app is launched into the foreground, including
the app delegate methods that are called.
Figure 3-2 Launching an app into the foreground
User taps app icon
main()
UIApplicationMain()
Load main UI file
First initialization
Restore UI state
Final initialization
Launch Time
application:
willFinishLaunchingWithOptions:
Various methods
application:
didFinishLaunchingWithOptions:
Handle events
Your Code
Switch to a different app
Running
applicationDidBecomeActive:
Event
Loop
Activate the app
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37If your app is launched into the background instead—usually to handle some type of background event—the
launch cycle changes slightly to the one shown in Figure 3-3. The main difference is that instead of your app
being made active, it entersthe background state to handle the event and then issuspended shortly afterward.
When launching into the background, the system still loads your app’s user interface files but it does not display
the app’s window.
Figure 3-3 Launching an app into the background
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38To determine whether your app islaunching into the foreground or background, check the applicationState
property ofthe shared UIApplication objectin your application:willFinishLaunchingWithOptions:
or application:didFinishLaunchingWithOptions: delegate method. When the app is launched into
the foreground, this property containsthe value UIApplicationStateInactive. When the app islaunched
into the background, the property contains the value UIApplicationStateBackground instead. You can
use this difference to adjust the launch-time behavior of your delegate methods accordingly.
Note:  When an app is launched so that it can open a URL, the sequence of startup events is slightly
different from those shown in Figure 3-2 and Figure 3-3. For information about the startup sequences
that occur when opening a URL, see “Handling URL Requests” (page 120).
About the main Function
Like any C-based app, the main entry point for an iOS app at launch time is the main function. In an iOS app,
the main function is used only minimally. Its main job is to hand control to the UIKit framework. Therefore,
any new project you create in Xcode comes with a default main function like the one shown in Listing 3-1.
With few exceptions, you should never change the implementation of this function.
Listing 3-1 The main function of an iOS app
#import 
int main(int argc, char *argv[])
{
@autoreleasepool {
return UIApplicationMain(argc, argv, nil, NSStringFromClass([MyAppDelegate
class]));
}
}
Note:  An autorelease pool is used in memory management. It is a Cocoa mechanism used to defer
the release of objects created during a functional block of code. For more information about
autorelease pools, see Advanced Memory Management Programming Guide .
The UIApplicationMain function takes four parameters and uses them to initialize the app. You should
never have to change the default values passed into thisfunction. Still, it is valuable to understand their purpose
and how they start the app.
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39● The argc and argv parameters contain any launch-time arguments passed to the app from the system.
These arguments are parsed by the UIKit infrastructure and can otherwise be ignored.
● The third parameter identifies the name of the principal app class. This is the class responsible for running
the app. It is recommend that you specify nil for this parameter, which causes UIKit to use the
UIApplication class.
● The fourth parameter identifies the class of your custom app delegate. Your app delegate is responsible
for managing the high-level interactions between the system and your code. The Xcode template projects
set this parameter to an appropriate value automatically.
Another thing the UIApplicationMain function does is load the app’s main user interface file. The main
interface file contains the initial view-related objects you plan to display in your app’s user interface. For apps
that use “Using Storyboards”, this function loads the initial view controller from your storyboard and installs it
in the window provided by your app delegate. For appsthat use nib files, the function loadsthe nib file contents
into memory but does not install them in your app’s window; you must install them in the
application:willFinishLaunchingWithOptions: method of your app delegate.
An app can have either a main storyboard file or a main nib file but it cannot have both. Storyboards are the
preferred way to specify your app’s user interface but are not supported on all versions of iOS. The name of
your app’s main storyboard file goes in the UIMainStoryboardFile key of your app’s Info.plist file. (For
nib-based apps, the name of your main nib file goes in the NSMainNibFile key instead.) Normally, Xcode
sets the value of the appropriate key when you create your project, but you can change it later if needed.
For more information about the Info.plist file and how you use it to configure your app,see “The Information
Property List File” (page 93).
What to Do at Launch Time
When your app is launched (either into the foreground or background), use your app delegate’s
application:willFinishLaunchingWithOptions: and
application:didFinishLaunchingWithOptions: methods to do the following:
● Check the contents of the launch options dictionary for information about why the app was launched,
and respond appropriately.
●
Initialize the app’s critical data structures.
● Prepare your app’s window and views for display.
Apps that use OpenGL ES should not use this method to prepare their drawing environment. Instead, they
should defer any OpenGL ES drawing calls to the applicationDidBecomeActive: method.
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40If your app does not automatically load a main storyboard or nib file at launch time, you can use the
application:willFinishLaunchingWithOptions: method to prepare your app’s window for display.
For apps that support both portrait and landscape orientations, always set up the root view controller of your
main window in a portrait orientation. If the device is in a different orientation at launch time, the system tells
the root view controller to rotate your views to the correct orientation before displaying the window.
Your application:willFinishLaunchingWithOptions: and
application:didFinishLaunchingWithOptions: methods should always be as lightweight as possible
to reduce your app’s launch time. Apps are expected to launch and initialize themselves and start handling
events in less than 5 seconds. If an app does not finish its launch cycle in a timely manner, the system kills it
for being unresponsive. Thus, any tasks that might slow down your launch (such as accessing the network)
should be executed asynchronously on a secondary thread.
When launching into the foreground, the system also calls the applicationDidBecomeActive: method
to finish the transition to the foreground. Because this method is called both at launch time and when
transitioning from the background, use it to perform any tasks that are common to the two transitions.
When launching into the background, there should not be much for your app to do except get ready to handle
whatever event arrived.
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41Responding to Interruptions
When an alert-based interruption occurs, such as an incoming phone call, the app moves temporarily to the
inactive state so that the system can prompt the user about how to proceed. The app remains in this state
until the user dismiss the alert. At this point, the app either returns to the active state or moves to the
background state. Figure 3-4 shows the flow of events through your app when an alert-based interruption
occurs.
Figure 3-4 Handling alert-based interruptions
In iOS 5, notificationsthat display a banner do not deactivate your app in the way that alert-based notifications
do. Instead, the banner is laid along the top edge of your app window and your app continues receive touch
events as before. However, if the user pulls down the banner to reveal the notification center, your app moves
to the inactive state just as if an alert-based interruption had occurred. Your app remains in the inactive state
until the user dismisses the notification center or launches another app. At this point, your app moves to the
appropriate active or background state. The user can use the Settings app to configure which notifications
display a banner and which display an alert.
Pressing the Sleep/Wake button is another type of interruption that causes your app to be deactivated
temporarily. When the user presses this button, the system disables touch events, moves the app to the
background butsetsthe value of the app’s applicationState property to UIApplicationStateInactive
App States and Multitasking
Managing App State Changes
2012-09-19   |   © 2012 Apple Inc. All Rights Reserved.
42(as opposed to UIApplicationStateBackground), and finally locksthe screen. A locked screen has additional
consequences for apps that use data protection to encrypt files. Those consequences are described in “What
to Do When an Interruption Occurs” (page 43).
What to Do When an Interruption Occurs
Alert-based interruptions result in a temporary loss of control by your app. Your app continues to run in the
foreground, but it does not receive touch events from the system. (It does continue to receive notifications
and other types of events, such as accelerometer events, though.) In response to this change, your app should
do the following in its applicationWillResignActive: method:
● Stop timers and other periodic tasks.
● Stop any running metadata queries.
● Do not initiate any new tasks.
● Pause movie playback (except when playing back over AirPlay).
● Enter into a pause state if your app is a game.
● Throttle back OpenGL ES frame rates.
● Suspend any dispatch queues or operation queues executing non-critical code. (You can continue processing
network requests and other time-sensitive background tasks while inactive.)
When your app is moved back to the active state, its applicationDidBecomeActive: method should
reverse any of the steps taken in the applicationWillResignActive: method. Thus, upon reactivation,
your app should restart timers, resume dispatch queues, and throttle up OpenGL ES frame rates again. However,
games should not resume automatically; they should remain paused until the user chooses to resume them.
When the user pressesthe Sleep/Wake button, apps with files protected by the NSFileProtectionComplete
protection option must close any referencesto those files. For devices configured with an appropriate password,
pressing the Sleep/Wake button locks the screen and forces the system to throw away the decryption keys for
files with complete protection enabled. While the screen is locked, any attempts to access the corresponding
files will fail. So if you have such files, you should close any references to them in your
applicationWillResignActive: method and open new references in your
applicationDidBecomeActive: method.
Adjusting Your User Interface During a Phone Call
When the user takes a call and then returns to your app while on the call, the height of the status bar grows
to reflect the fact that the user is on a call. Similarly, when the user ends the call, the status bar height shrinks
back to its regular size.
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43The best way to handle status bar height changes is to use view controllers to manage your views. When
installed in your interface, view controllers automatically adjust the height of their managed views when the
status bar frame size changes.
If your app does not use view controllers for some reason, you must respond to status bar frame changes
manually by registering for the UIApplicationDidChangeStatusBarFrameNotification notification.
Your handler for this notification should get the status bar height and use it to adjust the height of your app’s
views appropriately.
Moving to the Background
When the user presses the Home button, presses the Sleep/Wake button, or the system launches another app,
the foreground app transitions to the inactive state and then to the background state. These transitions result
in callsto the app delegate’s applicationWillResignActive: and applicationDidEnterBackground:
methods, as shown in Figure 3-5. After returning from the applicationDidEnterBackground: method,
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44most apps move to the suspended state shortly afterward. Apps that request specific background tasks (such
as playing music) or that request a little extra execution time from the system may continue to run for a while
longer.
Figure 3-5 Moving from the foreground to the background
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45Note:  Apps are moved to the background only on devices that support multitasking and only if
those devices are running iOS 4.0 or later. In all other cases, the app is terminated (and thus purged
from memory) instead of moved to the background.
What to Do When Moving to the Background
Apps can use their applicationDidEnterBackground: method to prepare for moving to the background
state. When moving to the background, all apps should do the following:
● Prepare to have their picture taken. When the applicationDidEnterBackground: method returns,
the system takes a picture of your app’s user interface and usesthe resulting image for transition animations.
If any views in your interface contain sensitive information, you should hide or modify those views before
the applicationDidEnterBackground: method returns.
● Save user data and app state information. All unsaved changes should be written to disk when entering
the background. This step is necessary because your app might be quietly killed while in the background
for any number of reasons. You can perform this operation from a background thread as needed.
● Free up as much memory as possible. For more information about what to do and why this is important,
see “Memory Usage for Background Apps” (page 47).
Your app delegate’s applicationDidEnterBackground: method has approximately 5 seconds to finish
any tasks and return. In practice, this method should return as quickly as possible. If the method does not
return before time runs out, your app is killed and purged from memory. If you still need more time to perform
tasks, call the beginBackgroundTaskWithExpirationHandler: method to request background execution
time and then start any long-running tasks in a secondary thread. Regardless of whether you start any
background tasks, the applicationDidEnterBackground: method must still exit within 5 seconds.
Note:  The UIApplicationDidEnterBackgroundNotification notification is also sent to let
interested parts of your app know that it is entering the background. Objects in your app can use
the default notification center to register for this notification.
Depending on the features of your app, there are other things your app should do when moving to the
background. For example, any active Bonjour services should be suspended and the app should stop calling
OpenGL ES functions. For a list of things your app should do when moving to the background, see “Being a
Responsible Background App” (page 63).
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46Memory Usage for Background Apps
Every app should free up as much memory as is practical upon entering the background. The system tries to
keep as many apps in memory at the same time as it can, but when memory runs low it terminates suspended
apps to reclaim that memory. Apps that consume large amounts of memory while in the background are the
first apps to be terminated.
Practically speaking, your app should remove strong referencesto objects assoon asthey are no longer needed.
Removing strong references gives the compiler the ability to release the objects right away so that the
corresponding memory can be reclaimed. However, if you want to cache some objectsto improve performance,
you can wait until the app transitions to the background before removing references to them.
Some examples of objects that you should remove strong references to as soon as possible include:
●
Image objects
● Large media or data files that you can load again from disk
● Any other objects that your app does not need and can recreate easily later
To help reduce your app’s memory footprint, the system automatically purges some data allocated on behalf
of your app when your app moves to the background.
● The system purges the backing store for all Core Animation layers. This effort does not remove your app’s
layer objectsfrom memory, nor doesit change the current layer properties. Itsimply preventsthe contents
of those layersfrom appearing onscreen, which given that the app isin the background should not happen
anyway.
●
It removes any system references to cached images. (If your app does not have a strong reference to the
images, they are subsequently removed from memory.)
●
It removes strong references to some other system-managed data caches.
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47Returning to the Foreground
Returning to the foreground is your app’s chance to restart the tasks that it stopped when it moved to the
background. The steps that occur when moving to the foreground are shown in Figure 3-6. The
applicationWillEnterForeground: method should undo anything that was done in your
applicationDidEnterBackground: method, and the applicationDidBecomeActive: method should
continue to perform the same activation tasks that it would at launch time.
Figure 3-6 Transitioning from the background to the foreground
Note:  The UIApplicationWillEnterForegroundNotification notification is also available
for tracking when your app reenters the foreground. Objects in your app can use the default
notification center to register for this notification.
Processing Queued Notifications at Wakeup Time
An app in the suspended state must be ready to handle any queued notifications when it returnsto a foreground
or background execution state. A suspended app does not execute any code and therefore cannot process
notifications related to orientation changes, time changes, preferences changes, and many others that would
affect the app’s appearance orstate. To make sure these changes are not lost, the system queues many relevant
notifications and delivers them to the app as soon as it starts executing code again (either in the foreground
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48or background). To prevent your app from becoming overloaded with notifications when it resumes, the system
coalesces events and delivers a single notification (of each relevant type) that reflects the net change since
your app was suspended.
Table 3-2 lists the notifications that can be coalesced and delivered to your app. Most of these notifications
are delivered directly to the registered observers. Some, like those related to device orientation changes, are
typically intercepted by a system framework and delivered to your app in another way.
Table 3-2 Notifications delivered to waking apps
Event Notifications
EAAccessoryDidConnectNotification
EAAccessoryDidDisconnectNotification
An accessory is connected or
disconnected.
UIDeviceOrientationDidChangeNotification
In addition to this notification, view controllers update
their interface orientations automatically.
The device orientation changes.
UIApplicationSignificantTimeChangeNotification
There is a significant time change.
UIDeviceBatteryLevelDidChangeNotification
UIDeviceBatteryStateDidChangeNotification
The battery level or battery state changes.
The proximity state changes. UIDeviceProximityStateDidChangeNotification
UIApplicationProtectedDataWillBecomeUnavailable
UIApplicationProtectedDataDidBecomeAvailable
The status of protected files changes.
UIScreenDidConnectNotification
UIScreenDidDisconnectNotification
An external display is connected or
disconnected.
The screen mode of a display changes. UIScreenModeDidChangeNotification
Preferences that your app exposes NSUserDefaultsDidChangeNotification
through the Settings app changed.
The current language or locale settings NSCurrentLocaleDidChangeNotification
changed.
The status of the user’s iCloud account NSUbiquityIdentityDidChangeNotification
changed.
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49Queued notifications are delivered on your app’s main run loop and are typically delivered before any touch
events or other user input. Most apps should be able to handle these events quickly enough that they would
not cause any noticeable lag when resumed. However, if your app appears sluggish when it returns from the
background state, use Instruments to determine whether your notification handler code is causing the delay.
An app returning to the foreground also receives view-update notifications for any views that were marked
dirty since the last update. An app running in the background can still call the setNeedsDisplay or
setNeedsDisplayInRect: methods to request an update for its views. However, because the views are not
visible, the system coalesces the requests and updates the views only after the app returns to the foreground.
Handling iCloud Changes
If the status of iCloud changes for any reason, the system delivers a
NSUbiquityIdentityDidChangeNotification notification to your app. The state of iCloud changes when
the user logs into or out of an iCloud account or enables or disables the syncing of documents and data. This
notification is your app’s cue to update caches and any iCloud-related user interface elementsto accommodate
the change. For example, when the user logs out of iCloud, you should remove references to all iCloud–based
files or data.
If your app has already prompted the user about whether to store files in iCloud, do not prompt again when
the status of iCloud changes. After prompting the user the first time, store the user’s choice in your app’s local
preferences. You might then want to expose that preference using a Settings bundle or as an option in your
app. But do not repeat the prompt again unless that preference is not currently in the user defaults database.
Handling Locale Changes Gracefully
If a user changes the current language while your app is suspended, you can use the
NSCurrentLocaleDidChangeNotification notification to force updates to any views containing
locale-sensitive information, such as dates, times, and numbers when your app returns to the foreground. Of
course, the best way to avoid language-related issues is to write your code in ways that make it easy to update
views. For example:
● Use the autoupdatingCurrentLocale class method when retrieving NSLocale objects. This method
returns a locale object that updates itself automatically in response to changes, so you never need to
recreate it. However, when the locale changes, you still need to refresh views that contain content derived
from the current locale.
● Re-create any cached date and number formatter objects whenever the current locale information changes.
For more information about internationalizing your code to handle locale changes, see Internationalization
Programming Topics.
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50Responding to Changes in Your App’s Settings
If your app has settings that are managed by the Settings app, it should observe the
NSUserDefaultsDidChangeNotification notification. Because the user can modify settings while your
app is suspended or in the background, you can use this notification to respond to any important changes in
those settings. In some cases, responding to this notification can help close a potential security hole. For
example, an email program should respond to changes in the user’s account information. Failure to monitor
these changes could cause privacy or security issues. Specifically, the current user might be able to send email
using the old account information, even if the account no longer belongs to that person.
Upon receiving the NSUserDefaultsDidChangeNotification notification, your app should reload any
relevant settings and, if necessary, reset its user interface appropriately. In cases where passwords or other
security-related information has changed, you should also hide any previously displayed information and force
the user to enter the new password.
App Termination
Although apps are generally moved to the background and suspended, if any of the following conditions are
true, your app is terminated and purged from memory instead:
● The app is linked against a version of iOS earlier than 4.0.
● The app is deployed on a device running a version of iOS earlier than 4.0.
● The current device does notsupportmultitasking;see “DeterminingWhether Multitasking Is Available” (page
54).
● The app includes the UIApplicationExitsOnSuspend key in its Info.plist file; see “Opting out of
Background Execution” (page 65).
If your app is running (either in the foreground or background) at termination time, the system calls your app
delegate’s applicationWillTerminate: method so that you can perform any required cleanup. You can
use this method to save user data or app state information that you would use to restore your app to its current
state on a subsequent launch. Your method has approximately 5 seconds to perform any tasks and return. If
it does not return in time, the app is killed and removed from memory.
Important:  The applicationWillTerminate: method is not called if your app is currently suspended.
Even if you develop your app using iOS SDK 4 and later, you must still be prepared for your app to be killed
without any notification. The user can kill apps explicitly using the multitasking UI. In addition, if memory
becomes constrained, the system might remove apps from memory to make more room. Suspended apps are
not notified of termination but if your app is currently running in the background state (and not suspended),
the system calls the applicationWillTerminate: method of your app delegate. Your app cannot request
additional background execution time from this method.
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51The Main Run Loop
The main run loop of your app is responsible for processing all user-related events. The UIApplication
objectsets up the main run loop at launch time and usesit to process events and handle updatesto view-based
interfaces. As the name suggests, the main run loop executes on the app’s main thread. This behavior ensures
that user-related events are processed serially in the order in which they were received.
Figure 3-7 shows the architecture of the main run loop and how user events result in actions taken by your
app. As the user interacts with a device, events related to those interactions are generated by the system and
delivered to the app via a special port set up by UIKit. Events are queued internally by the app and dispatched
one-by-one to the main run loop for execution. The UIApplication object is the first object to receive the
event and make the decision about what needs to be done. A touch event is usually dispatched to the main
window object, which in turn dispatches it to the view in which the touch occurred. Other events might take
slightly different paths through various app objects.
Figure 3-7 Processing events in the main run loop
Many types of events can be delivered in an iOS app. The most common ones are listed in Table 3-3. Many of
these event types are delivered using the main run loop of your app, but some are not. For example,
accelerometer events are delivered directly to the accelerometer delegate object that you specify. For information
about how to handle most types of events—including touch, remote control, motion, accelerometer, and
gyroscopic events—see Event Handling Guide for iOS .
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52Table 3-3 Common types of events for iOS apps
Event type Delivered to… Notes
Views are responder objects. Any touch events not
handled by the view are forwarded down the responder
chain for processing.
The view object in
which the event
occurred
Touch
Remote control events are for controlling media playback
and are generated by headphones and other accessories.
Remote First responder object
control
Motion events reflect specific motion-related events
(such as shaking a device) and are handled separately
from other accelerometer-based events. .
Motion First responder object
Events related to the accelerometer and gyroscope
hardware are delivered to the object you designate.
The object you
designate
Accelerometer
Core Motion
Redraw events do not involve an event object but are
simply calls to the view to draw itself. The drawing
architecture for iOS is described in Drawing and Printing
Guide for iOS .
The view that needs
the update
Redraw
You register to receive location events using the Core
Location framework. For more information about using
Core Location, see Location Awareness Programming
Guide .
The object you
designate
Location
Some events, such as touch and remote control events, are handled by your app’s responder objects. Responder
objects are everywhere in your app. (The UIApplication object, your view objects, and your view controller
objects are all examples of responder objects.) Most eventstarget a specific responder object but can be passed
to other responder objects (via the responder chain) if needed to handle an event. For example, a view that
does not handle an event can pass the event to its superview or to a view controller.
Touch events occurring in controls (such as buttons) are handled differently than touch events occurring in
many other types of views. There are typically only a limited number of interactions possible with a control,
and so those interactions are repackaged into action messages and delivered to an appropriate target object.
This target-action design pattern makes it easy to use controls to trigger the execution of custom code in your
app.
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53Background Execution and Multitasking
In iOS 4 and later, multitasking allows appsto continue running in the background even after the userswitches
to another app while still preserving battery life as much as possible. Most apps are moved to the suspended
state shortly after entering the background. Only apps that provide important services to the user are allowed
to continue running for any amount of time.
As much as possible, you are encouraged to avoid executing in the background and let your app be suspended.
If you find you need to perform background tasks, here are some guidelines for when that is appropriate:
● You need to implement at least one of several specific user services.
● You need to perform a single finite-length task.
● You need to use notifications to alert the user to some relevant piece of information when your app is not
running.
The system keeps suspended apps in memory for as long as possible, removing them only when the amount
of free memory gets low. Remaining in memory means that subsequent launches of your app are much faster.
At the same time, being suspended means your app does not drain the device’s battery as fast.
Determining Whether Multitasking Is Available
Apps must be prepared to handle situations where multitasking (and therefore background execution) is not
available. Even if your app is specifically built for iOS 4 and later, some devices running iOS 4 may not support
multitasking. And multitasking is never available on devices running iOS 3 and earlier. If your app supports
these earlier versions of iOS, it must be prepared to run without multitasking.
If the presence or absence of multitasking changes the way your app behaves, check the
multitaskingSupported property of the UIDevice class to determine whether multitasking is available
before performing the relevant task. For apps built for iOS 4 and later, this property is always available. However,
if your app supports earlier versions of the system, you must check to see whether the property itself is available
before accessing it, as shown in Listing 3-2.
Listing 3-2 Checking for background support in earlier versions of iOS
UIDevice* device = [UIDevice currentDevice];
BOOL backgroundSupported = NO;
if ([device respondsToSelector:@selector(isMultitaskingSupported)])
backgroundSupported = device.multitaskingSupported;
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54Executing a Finite-Length Task in the Background
Apps that are transitioning to the background can request an extra amount of time to finish any important
last-minute tasks. To request background execution time, call the
beginBackgroundTaskWithExpirationHandler: method of the UIApplication class. If your app moves
to the background while the task is in progress, or if your app was already in the background, this method
delays the suspension of your app. This can be important if your app is performing some important task, such
as writing user data to disk or downloading an important file from a network server.
The way to use the beginBackgroundTaskWithExpirationHandler: method is to call it before starting
the task you want to protect. Every call to this method must be balanced by a corresponding call to the
endBackgroundTask: method to mark the end of the task. Because apps are given only a limited amount
of time to finish background tasks, you must call this method before time expires; otherwise the system will
terminate your app. To avoid termination, you can also provide an expiration handler when starting a task and
call the endBackgroundTask: method from there. (You can use the value in the backgroundTimeRemaining
property of the app object to see how much time is left.)
Important:  An app can have any number of tasks running at the same time. Each time you start a task,
the beginBackgroundTaskWithExpirationHandler: method returns a unique identifier for the task.
You must pass this same identifier to the endBackgroundTask: method when it comes time to end the
task.
Listing 3-3 shows how to start a long-running task when your app transitionsto the background. In this example,
the request to start a background task includes an expiration handler just in case the task takes too long. The
task itself is then submitted to a dispatch queue for asynchronous execution so that the
applicationDidEnterBackground: method can return normally. The use of blocks simplifies the code
needed to maintain references to any important variables, such as the background task identifier. The bgTask
variable is a member variable of the class that stores a pointer to the current background task identifier and
is initialized prior to its use in this method.
Listing 3-3 Starting a background task at quit time
- (void)applicationDidEnterBackground:(UIApplication *)application
{
bgTask = [application beginBackgroundTaskWithExpirationHandler:^{
// Clean up any unfinished task business by marking where you.
// stopped or ending the task outright.
[application endBackgroundTask:bgTask];
bgTask = UIBackgroundTaskInvalid;
}];
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55// Start the long-running task and return immediately.
dispatch_async(dispatch_get_global_queue(DISPATCH_QUEUE_PRIORITY_DEFAULT, 0),
^{
// Do the work associated with the task, preferably in chunks.
[application endBackgroundTask:bgTask];
bgTask = UIBackgroundTaskInvalid;
});
}
Note:  Always provide an expiration handler when starting a task, but if you want to know how
much time your app has left to run, get the value of the backgroundTimeRemaining property of
UIApplication.
In your own expiration handlers, you can include additional code needed to close out your task. However, any
code you include must not take too long to execute because, by the time your expiration handler is called,
your app is already very close to its time limit. For this reason, perform only minimal cleanup of your state
information and end the task.
Scheduling the Delivery of Local Notifications
Notifications are a way for an app that is suspended, is in the background, or is not running to get the user’s
attention. Apps can use local notificationsto display alerts, play sounds, badge the app’sicon, or a combination
of the three. For example, an alarm clock app might use local notifications to play an alarm sound and display
an alert to disable the alarm. When a notification is delivered to the user, the user must decide if the information
warrants bringing the app back to the foreground. (If the app is already running in the foreground, local
notifications are delivered quietly to the app and not to the user.)
To schedule the delivery of a local notification, create an instance of the UILocalNotification class, configure
the notification parameters, and schedule it using the methods of the UIApplication class. The local
notification object contains information about the type of notification to deliver (sound, alert, or badge) and
the time (when applicable) at which to deliver it. The methods of the UIApplication class provide options
for delivering notifications immediately or at the scheduled time.
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56Listing 3-4 shows an example that schedules a single alarm using a date and time that is set by the user. This
example configures only one alarm at a time and cancels the previous alarm before scheduling a new one.
(Your own apps can have no more than 128 local notifications active at any given time, any of which can be
configured to repeat at a specified interval.) The alarm itself consists of an alert box and a sound file that is
played if the app is not running or is in the background when the alarm fires. If the app is active and therefore
running in the foreground, the app delegate’s application:didReceiveLocalNotification: method
is called instead.
Listing 3-4 Scheduling an alarm notification
- (void)scheduleAlarmForDate:(NSDate*)theDate
{
UIApplication* app = [UIApplication sharedApplication];
NSArray* oldNotifications = [app scheduledLocalNotifications];
// Clear out the old notification before scheduling a new one.
if ([oldNotifications count] > 0)
[app cancelAllLocalNotifications];
// Create a new notification.
UILocalNotification* alarm = [[UILocalNotification alloc] init];
if (alarm)
{
alarm.fireDate = theDate;
alarm.timeZone = [NSTimeZone defaultTimeZone];
alarm.repeatInterval = 0;
alarm.soundName = @"alarmsound.caf";
alarm.alertBody = @"Time to wake up!";
[app scheduleLocalNotification:alarm];
}
}
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57Sound files used with local notifications have the same requirements as those used for push notifications.
Custom sound files must be located inside your app’s main bundle and support one of the following formats:
Linear PCM, MA4, µ-Law, or a-Law. You can also specify the sound name default to play the default alert
sound for the device. When the notification is sent and the sound is played, the system also triggers a vibration
on devices that support it.
You can cancel scheduled notifications or get a list of notifications using the methods of the UIApplication
class. For more information about these methods,see UIApplication Class Reference . For additional information
about configuring local notifications, see Local and Push Notification Programming Guide .
Implementing Long-Running Background Tasks
For tasks that require more execution time to implement, you must request specific permissions to run them
in the background without their being suspended. In iOS, only specific app types are allowed to run in the
background:
● Apps that play audible content to the user while in the background, such as a music player app
● Apps that keep users informed of their location at all times, such as a navigation app
● Apps that support Voice over Internet Protocol (VoIP)
● Newsstand apps that need to download and process new content
● Apps that receive regular updates from external accessories
Apps that implement these services must declare the services they support and use system frameworks to
implement the relevant aspects of those services. Declaring the services lets the system know which services
you use, but in some cases it is the system frameworks that actually prevent your application from being
suspended.
Declaring Your App’s Supported Background Tasks
Support for some types of background execution must be declared in advance by the app that uses them. An
app declares support for a service using its Info.plist file. Add the UIBackgroundModes key to your
Info.plist file and set its value to an array containing one or more of the following strings:
● audio—The app plays audible content to the user while in the background. (This content includes
streaming audio or video content using AirPlay.)
● location—The app keeps users informed of their location, even while it is running in the background.
● voip—The app provides the ability for the user to make phone calls using an Internet connection.
● newsstand-content—The app is aNewsstand app that downloads and processesmagazine or newspaper
content in the background.
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58● external-accessory—The app works with a hardware accessory that needs to deliver updates on a
regular schedule through the External Accessory framework.
● bluetooth-central—The app works with a Bluetooth accessory that needs to deliver updates on a
regular schedule through the Core Bluetooth framework.
● bluetooth-peripheral—The app supports Bluetooth communication in peripheral mode through the
Core Bluetooth framework.
Each of the preceding values lets the system know that your app should be woken up at appropriate times to
respond to relevant events. For example, an app that begins playing music and then moves to the background
still needs execution time to fill the audio output buffers. Including the audio key tells the system frameworks
that they should continue playing and make the necessary callbacks to the app at appropriate intervals. If the
app does not include this key, any audio being played by the app stops when the app movesto the background.
Tracking the User’s Location
There are several ways to track the user’s location in the background, most of which do not actually require
your app to run continuously in the background:
● The significant-change location service (Recommended)
● Foreground-only location services
● Background location services
The significant-change location service is highly recommended for apps that do not need high-precision
location data. With this service, location updates are generated only when the user’s location changes
significantly; thus, it is ideal for social apps or apps that provide the user with noncritical, location-relevant
information. If the app is suspended when an update occurs, the system wakes it up in the background to
handle the update. If the app starts this service and is then terminated, the system relaunches the app
automatically when a new location becomes available. This service is available in iOS 4 and later, and it is
available only on devices that contain a cellular radio.
The foreground-only and background location services both use the standard location Core Location service
to retrieve location data. The only difference is that the foreground-only location services stop delivering
updates if the app is ever suspended, which is likely to happen if the app does not support other background
services or tasks. Foreground-only location services are intended for apps that only need location data while
they are in the foreground.
An app that provides continuous location updates to the user (even when in the background) can enable
background location services by including the UIBackgroundModes key (with the location value) in its
Info.plist file. The inclusion of this value in the UIBackgroundModes key does not preclude the system
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59from suspending the app, but it does tell the system that it should wake up the app whenever there is new
location data to deliver. Thus, this key effectively letsthe app run in the background to processlocation updates
whenever they occur.
Important:  You are encouraged to use the standard servicessparingly or use the significant location change
service instead. Location servicesrequire the active use of an iOS device’s onboard radio hardware. Running
this hardware continuously can consume a significant amount of power. If your app does not need to
provide precise and continuous location information to the user, it is best to minimize the use of location
services.
For information about how to use each of the different location services in your app, see Location Awareness
Programming Guide .
Playing Background Audio
An app that plays audio continuously (even while the app is running in the background) can register as a
background audio app by including the UIBackgroundModes key (with the value audio) in its Info.plist
file. Apps that include this key must play audible content to the user while in the background.
Typical examples of background audio apps include:
● Music player apps
● Apps that support audio or video playback over AirPlay
● VoIP apps
When the UIBackgroundModes key contains the audio value, the system’s media frameworks automatically
prevent the corresponding app from being suspended when it moves to the background. As long as it is
playing audio or video content, the app continues to run in the background. However, if the app stops playing
the audio or video, the system suspends it.
You can use any of the system audio frameworks to initiate the playback of background audio, and the process
for using those frameworks is unchanged. (For video playback over AirPlay, you can use the Media Player or
AV Foundation framework to present your video.) Because your app is not suspended while playing media
files, callbacks operate normally while your app is in the background. In your callbacks, though, you should do
only the work necessary to provide data for playback. For example, a streaming audio app would need to
download the music stream data from its server and push the current audio samples out for playback. You
should not perform any extraneous tasks that are unrelated to playback.
Because more than one app may support audio, the system limits which apps can play audio at any given time.
The foreground app always has permission to play audio. In addition, one or more background apps may also
be allowed to play some audio content depending on the configuration of their audio session objects. You
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60should always configure your app’s audio session object appropriately and work carefully with the system
frameworks to handle interruptions and other types of audio-related notifications. For information on how to
configure audio session objects for background execution, see Audio Session Programming Guide .
Implementing a VoIP App
A Voice over Internet Protocol (VoIP) app allows the user to make phone calls using an Internet connection
instead of the device’s cellular service. Such an app needs to maintain a persistent network connection to its
associated service so that it can receive incoming calls and other relevant data. Rather than keep VoIP apps
awake all the time, the system allowsthem to be suspended and providesfacilitiesfor monitoring theirsockets
for them. When incoming traffic is detected, the system wakes up the VoIP app and returns control of itssockets
to it.
To configure a VoIP app, you must do the following:
1. Add the UIBackgroundModes key to your app’s Info.plist file. Set the value of this key to an array
that includes the voip value.
2. Configure one of the app’s sockets for VoIP usage.
3. Before moving to the background, call the setKeepAliveTimeout:handler: method to install a handler
to be executed periodically. Your app can use this handler to maintain its service connection.
4. Configure your audio session to handle transitions to and from active use.
Including the voip value in the UIBackgroundModes key lets the system know that it should allow the app
to run in the background as needed to manage its network sockets. An app with this key is also relaunched in
the background immediately after system boot to ensure that the VoIP services are always available.
Most VoIP apps also need to be configured as background audio appsto deliver audio while in the background.
Therefore, you should include both the audio and voip values to the UIBackgroundModes key. If you do
not do this, your app cannot play audio while it is in the background. For more information about the
UIBackgroundModes key, see Information Property List Key Reference .
For specific information about the steps you must take to implement a VoIP app, see “Tips for Developing a
VoIP App” (page 115).
Downloading Newsstand Content in the Background
A Newsstand app that downloads new magazine or newspaper issues can register to perform those downloads
in the background. When your server sends a push notification to indicate that a new issue is available, the
system checks to see whether your app has the UIBackgroundModes key with the newsstand-content
value. If it does, the system launches your app, if it is not already running,so that it can initiate the downloading
of the new issue.
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61When you use the Newsstand Kit framework to initiate a download, the system handles the download process
for your app. The system continues to download the file even if your app is suspended or terminated. When
the download operation is complete, the system transfers the file to your app sandbox and notifies your app.
If the app is not running, this notification wakes it up and gives it a chance to process the newly downloaded
file. If there are errors during the download process, your app is similarly woken up to handle them.
For information about how to download content using the Newsstand Kit framework, see Newsstand Kit
Framework Reference .
Communicating with an External Accessory
Apps that work with external accessories can ask to be woken up if the accessory delivers an update when the
app is suspended. This support is important for some types of accessories that deliver data at regular intervals,
such as heart-rate monitors. When an app includes the UIBackgroundModes key with the
external-accessory value in its Info.plist file, the external accessory framework keeps open any active
sessions for the corresponding accessories. (In iOS 4 and earlier, these sessions are closed automatically when
the app is suspended.) In addition, new data arriving from the accessory causes the system to wake up the
app to processthat data. The system also wakes up the app to process accessory connection and disconnection
notifications.
Any app that supports the background processing of accessory updates must follow a few basic guidelines:
● Apps must provide an interface that allows the user to start and stop the delivery of accessory update
events. That interface should then open or close the accessory session as appropriate.
● Upon being woken up, the app has around 10 seconds to process the data. Ideally, it should process the
data as fast as possible and allow itself to be suspended again. However, if more time is needed, the app
can use the beginBackgroundTaskWithExpirationHandler: method to request additional time; it
should do so only when absolutely necessary, though.
Communicating with a Bluetooth Accessory
Apps that work with Bluetooth peripherals can ask to be woken up if the peripheral delivers an update when
the app issuspended. Thissupport isimportant for Bluetooth-le accessoriesthat deliver data at regular intervals,
such as a Bluetooth heart rate belt. When an app includes the UIBackgroundModes key with the
bluetooth-central value in its Info.plist file, the Core Bluetooth framework keeps open any active
sessionsfor the corresponding peripheral. In addition, new data arriving from the peripheral causesthe system
to wake up the app so that it can process the data. The system also wakes up the app to process accessory
connection and disconnection notifications.
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62In iOS 6, an app can also operate in peripheral mode with Bluetooth accessories. If the app wants to respond
to accessory-related changes using peripheral mode in the background, it must link against the Core Bluetooth
framework and include the UIBackgroundModes key with the bluetooth-peripheral value in its
Info.plist file. This key lets the Core Bluetooth framework wake the app up briefly in the background so
that it can handle accessory-related requests. Apps woken up for these events should process them and return
as quickly as possible so that the app can be suspended again.
Any app that supports the background processing of Bluetooth data must be session-based and follow a few
basic guidelines:
● Apps must provide an interface that allows the user to start and stop the delivery of Bluetooth events.
That interface should then open or close the session as appropriate.
● Upon being woken up, the app has around 10 seconds to process the data. Ideally, it should process the
data as fast as possible and allow itself to be suspended again. However, if more time is needed, the app
can use the beginBackgroundTaskWithExpirationHandler: method to request additional time; it
should do so only when absolutely necessary, though.
Being a Responsible Background App
The foreground app always has precedence over background apps when it comesto the use ofsystem resources
and hardware. Apps running in the background need to be prepared for this discrepancy and adjust their
behavior when running in the background. Specifically, apps moving to the background should follow these
guidelines:
● Do not make any OpenGL ES calls from your code. You must not create an EAGLContext object or issue
any OpenGL ES drawing commands of any kind while running in the background. Using these calls causes
your app to be killed immediately. Apps must also ensure that any previously submitted commands have
completed before moving to the background. For information about how to handle OpenGL ES when
moving to and from the background,see “Implementing a Multitasking-awareOpenGL ES Application” in OpenGL
ES Programming Guide for iOS .
● Cancel any Bonjour-related services before being suspended. When your app movesto the background,
and before it is suspended, it should unregister from Bonjour and close listening sockets associated with
any network services. A suspended app cannot respond to incoming service requests anyway. Closing out
those services prevents them from appearing to be available when they actually are not. If you do not
close out Bonjour services yourself, the system closes out those services automatically when your app is
suspended.
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63● Be prepared to handle connection failures in your network-based sockets. The system may tear down
socket connections while your app is suspended for any number of reasons. As long as your socket-based
code is prepared for other types of network failures, such as a lost signal or network transition, this should
not lead to any unusual problems. When your app resumes, if it encounters a failure upon using a socket,
simply reestablish the connection.
● Save your app state before moving to the background. During low-memory conditions, background
apps may be purged from memory to free up space. Suspended apps are purged first, and no notice is
given to the app before it is purged. As a result, apps should take advantage of the state preservation
mechanism in iOS 6 and later to save their interface state to disk. For information about how to support
this feature, see “State Preservation and Restoration” (page 67).
● Remove strong references to unneeded objects whenmoving to the background. If your app maintains
a large in-memory cache of objects(especially images), remove allstrong referencesto those caches when
moving to the background. For more information, see “Memory Usage for Background Apps” (page 47).
● Stop using shared system resources before being suspended. Apps that interact with shared system
resources such as the Address Book or calendar databases should stop using those resources before being
suspended. Priority for such resources always goes to the foreground app. When your app is suspended,
if it is found to be using a shared resource, the app is killed.
● Avoid updating your windows and views. While in the background, your app’s windows and views are
not visible, so you should not try to update them. Although creating and manipulating window and view
objects in the background does not cause your app to be killed, consider postponing this work until you
return to the foreground.
● Respond to connect and disconnect notifications for external accessories. For apps that communicate
with external accessories, the system automatically sends a disconnection notification when the app moves
to the background. The app must register for this notification and use it to close out the current accessory
session. When the app moves back to the foreground, a matching connection notification is sent, giving
the app a chance to reconnect. For more information on handling accessory connection and disconnection
notifications, see External Accessory Programming Topics.
● Clean up resources for active alerts when moving to the background. In order to preserve context when
switching between apps, the system does not automatically dismiss action sheets (UIActionSheet) or
alert views (UIAlertView) when your app moves to the background. It is up to you to provide the
appropriate cleanup behavior prior to moving to the background. For example, you might want to cancel
the action sheet or alert view programmatically orsave enough contextual information to restore the view
later (in cases where your app is terminated).
For apps linked against a version of iOS earlier than 4.0, action sheets and alerts are still dismissed at quit
time so that your app’s cancellation handler has a chance to run.
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64● Remove sensitive information from views before moving to the background. When an app transitions
to the background, the system takes a snapshot of the app’s main window, which it then presents briefly
when transitioning your app back to the foreground. Before returning from your
applicationDidEnterBackground: method, you should hide or obscure passwords and othersensitive
personal information that might be captured as part of the snapshot.
● Do minimal work while running in the background. The execution time given to background apps is
more constrained than the amount of time given to the foreground app. If your app plays background
audio or monitors location changes, you should focus on that task only and defer any nonessential tasks
until later. Apps that spend too much time executing in the background can be throttled back by the
system or killed.
If you are implementing a background audio app, or any other type of app that is allowed to run in the
background, your app responds to incoming messages in the usual way. In other words, the system may notify
your app of low-memory warnings when they occur. And in situations where the system needs to terminate
apps to free even more memory, the app calls its delegate’s applicationWillTerminate: method to
perform any final tasks before exiting.
Opting out of Background Execution
If you do not want your app to run in the background at all, you can explicitly opt out of background by adding
the UIApplicationExitsOnSuspend key (with the value YES) to your app’s Info.plist file. When an app
opts out, it cycles between the not-running, inactive, and active states and never enters the background or
suspended states. When the user pressesthe Home button to quit the app, the applicationWillTerminate:
method of the app delegate is called and the app has approximately 5 seconds to clean up and exit before it
is terminated and moved back to the not-running state.
Opting out of background execution is strongly discouraged but may be the preferred option under certain
conditions. Specifically, if coding for the background adds significant complexity to your app, terminating the
app might be a simpler solution. Also, if your app consumes a large amount of memory and cannot easily
release any of it, the system might kill your app quickly anyway to make room for other apps. Thus, opting to
terminate, instead of switching to the background, might yield the same results and save you development
time and effort.
Note:  Explicitly opting out of background execution is necessary only if your app is linked against
iOS SDK 4 and later. Apps linked against earlier versions of the SDK do not support background
execution as a rule and therefore do not need to opt out explicitly.
For more information about the keys you can include in your app’s Info.plist file, see Information Property
List Key Reference .
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65Concurrency and Secondary Threads
The system creates your app’s main thread but your app can create additional threads as needed to perform
other tasks. The preferred way to create threadsisto let the system do it for you by using Grand Central Dispatch
queues and operation queues. Both types of queue provide an asynchronous execution model for tasks that
you define. When you submit a task to a queue, the system spins up a thread and executes your task on that
thread. Letting the system manage the threads simplifies your code and allows the system to manage the
threads in the most efficient way available.
You should use queues whenever possible to move work off of your app’s main thread. Because the main
thread is responsible for processing touch and drawing events, you should never perform lengthy tasks on it.
For example, you should never wait for a network response on your app’s main thread. It is much better to
make the request asynchronously using a queue and process the results when they arrive.
Another good time to move tasks to secondary threads is launch time. Launched apps have a limited amount
of time (around 5 seconds) to do their initialization and start processing events. If you have launch-time tasks
that can be deferred or executed on a secondary thread, you should move them off the main thread right away
and use the main thread only to present your user interface and start handling events.
Formore information about using dispatch and operation queuesto execute tasks,see Concurrency Programming
Guide .
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66Even if your app supports background execution, it cannot run forever. At some point, the system might need
to terminate your app to free up memory for the current foreground app. However, the user should never
have to care if an app is already running or wasterminated. From the user’s perspective, quitting an app should
just seem like a temporary interruption. When the user returns to an app, that app should always return the
user to the last point of use, so that the user can continue with whatever task was in progress. This behavior
provides a better experience for the user and with the state restoration support built in to UIKit is relatively
easy to achieve.
The state preservation system in UIKit provides a simple but flexible infrastructure for preserving and restoring
the state of your app’s view controllers and views. The job of the infrastructure is to drive the preservation and
restoration processes at the appropriate times. To do that, UIKit needs help from your app. Only you understand
the content of your app, and so only you can write the code needed to save and restore that content. And
when you update your app’s UI, only you know how to map older preserved content to the newer objects in
your interface.
There are three places where you have to think about state preservation in your app:
● Your app delegate object, which manages the app’s top-level state
● Your app’s view controller objects, which manage the overall state for your app’s user interface
● Your app’s custom views, which might have some custom data that needs to be preserved
UIKit allows you to choose which parts of your user interface you want to preserve. And if you already have
custom code for handling state preservation, you can continue to use that code and migrate portions to the
UIKit state preservation system as needed.
The Preservation and Restoration Process
State preservation and restoration is an opt-in feature and requires help from your app to work. Your app
essentially provides UIKit with a list of objects and lets UIKit handle the tedious aspects of preserving and
restoring those objects at appropriate times. Because UIKit handlesso much of the process, it helpsto understand
what it does behind the scenes so that you know how your custom code fits into the overall scheme.
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State Preservation and RestorationWhen thinking about state preservation and restoration, it helps to separate the two processes first. State
preservation occurs when your app moves to the background. At that time, UIKit queries your app’s views and
view controllersto see which onesshould be preserved and which onesshould not. For each object thatshould
be preserved, UIKit writes preservation-related data to an on-disk file. The next time your app launches from
scratch, UIKit looks for that file and, if it is present, uses it to try and restore your app’s state. During the
restoration process, UIKit uses the preserved data to reconstitute your interface. The creation of actual objects
is handled by your code. Because your app might load objects from a storyboard file automatically, only your
code knows which objects need to be created and which might already exist and can simply be returned. After
those objects are created, UIKit uses the on-disk data to restore the objects to their previous state.
During the preservation and restoration process, your app has a handful of responsibilities.
● During preservation, your app is responsible for:
● Telling UIKit that it supports state preservation.
● Telling UIKit which view controllers and views should be preserved.
● Encoding relevant data for any preserved objects.
● During restoration, your app is responsible for:
● Telling UIKit that it supports state restoration.
● Providing (or creating) the objects that are requested by UIKit.
● Decoding the state of your preserved objects and using it to return the object to its previous state.
Of your app’s responsibilities, the most significant are telling UIKit which objects to preserve and providing
those objects during subsequent launches. Those two behaviors are where you should spend most of your
time when designing your app’s preservation and restoration code. They are also where you have the most
control over the actual process. To understand why that is the case, it helps to look at an example.
Figure 4-1 shows the view controller hierarchy of a tab bar interface after the user has interacted with several
of the tabs. As you can see, some of the view controllers are loaded automatically as part of the app’s main
storyboard file butsome of the view controllers were presented or pushed onto the view controllersin different
State Preservation and Restoration
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68tabs. Without state restoration, only the view controllers from the main storyboard file would be restored
during subsequent launches. By adding support for state restoration to your app, you can preserve all of the
view controllers.
Figure 4-1 A sample view controller hierarchy
Loaded at launch time from the main storyboard file
Added by the app after launch
UINavigation
Controller
MyViewController
MyPresented
Controller
UINavigation
Controller
Root
Nav 2
Nav 1
Root
Nav 1
UITabBar
Controller
MainStoryboard.storyboard
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69UIKit preserves only those objects that have a restoration identifier. A restoration identifier is a string that
identifies the view or view controller to UIKit and your app. The value of this string is significant only to your
code but the presence of thisstring tells UIKit that it needsto preserve the tagged object. During the preservation
process, UIKit walks your app’s view controller hierarchy and preserves all objects that have a restoration
State Preservation and Restoration
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70identifier. If a view controller does not have a restoration identifier, that view controller and all of its views and
child view controllers are not preserved. Figure 4-2 shows an updated version of the previous view hierarchy,
now with restoration identifies applied to most (but not all) of the view controllers.
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71Figure 4-2 Adding restoration identifies to view controllers
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72Depending on your app, it might or might not make sense to preserve every view controller. If a view controller
presents transitory information, you might not want to return to that same point on restore, opting instead
to return the user to a more stable point in your interface.
For each view controller you choose to preserve, you also need to decide on how you want to restore it later.
UIKit offerstwo waysto recreate objects. You can let your app delegate recreate it or you can assign a restoration
class to the view controller and let that class recreate it. A restoration class implements the
UIViewControllerRestoration protocol and is responsible for finding or creating a designated object at
restore time. Here are some tips for when to use each one:
●
If the view controller is always loaded from your app’s main storyboard file at launch time, do not
assign a restoration class. Instead, let your app delegate find the object or take advantage of UIKit’s
support for implicitly finding restored objects.
● For view controllers that are not loaded from your main storyboard file at launch time, assign a
restoration class. The simplest option is to make each view controller its own restoration class.
During the preservation process, UIKit identifies the objects to save and writes each affected object’s state to
disk. Each view controller object is given a chance to write out any data it wants to save. For example, a tab
view controller saves the identity of the selected tab. UIKit also saves information such as the view controller’s
restoration class to disk. And if any of the view controller’s views has a restoration identifier, UIKit asks them
to save their state information too.
The next time the app is launched, UIKit loads the app’s main storyboard or nib file as usual, calls the app
delegate’s application:willFinishLaunchingWithOptions: method, and then tries to restore the
app’s previous state. The first thing it does is ask your app to provide the set of view controller objects that
match the ones that were preserved. If a given view controller had an assigned restoration class, that class is
asked to provide the object; otherwise, the app delegate is asked to provide it.
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73Flow of the Preservation Process
Figure 4-3 shows the high-level events that happen during state preservation and shows how the objects of
your app are affected. Before preservation even occurs, UIKit asks your app delegate if itshould occur by calling
the application:shouldSaveApplicationState: method. If that method returns YES, UIKit begins
gathering and encoding your app’s views and view controllers. When it is finished, it writes the encoded data
to disk.
Figure 4-3 High-level flow interface preservation
UIKit
Save UI
Done
No
Yes
App supports
save?
application:
shouldSaveApplicationState:
application:
willEncodeRestorableState:
App Delegate
@property restorationIdentifier
encodeRestorableStateWithCoder:
View /View Controller Objects
@property restorationClass
View Controller Only
Start app preservation
Gather restorable objects
Encode restorable objects
Write state to disk
The next time your app launches, the system automatically looks for a preserved state file, and if present, uses
it to restore your interface. Because this state information is only relevant between the previous and current
launch cycles of your app, the file istypically discarded after your app finisheslaunching. The file is also discarded
any time there is an error restoring your app. For example, if your app crashes during the restoration process,
the system automatically throws away the state information during the next launch cycle to avoid another
crash.
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74Flow of the Restoration Process
Figure 4-4 shows the high-level events that happen during state restoration and shows how the objects of
your app are affected. After the standard initialization and UI loading is complete, UIKit asks your app delegate
if state restoration should occur at all by calling the application:shouldRestoreApplicationState:
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75method. Thisis your app delegate’s opportunity to examine the preserved data and determine ifstate restoration
is possible. If it is, UIKit uses the app delegate and restoration classes to obtain references to your app’s view
controllers. Each object is then provided with the data it needs to restore itself to its previous state.
Figure 4-4 High-level flow for restoring your user interface
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viewControllerWithRestoration
IdentifierPath:coder:
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decodeRestorableStateWithCoder:
View /View Controller Object
application:
didDecodeRestorableState:
application:
didFinishLaunchingWithOptions:
App Delegate
Obtain view controllers
Decode restorable objects
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76Although UIKit helps restore the individual view controllers, it does not automatically restore the relationships
between those view controllers. Instead, each view controller is responsible for encoding enough state
information to return itself to its previous state. For example, a navigation controller encodes information
about the order of the view controllers on its navigation stack. It then uses this information later to return
those view controllers to their previous positions on the stack. Other view controllers that have embedded
child view controllers are similarly responsible for encoding any information they need to restore their children
later.
Note:  Not all view controllers need to encode their child view controllers. For example, tab bar
controllers do not encode information about their child view controllers. Instead, it is assumed that
your app followsthe usual pattern of creating the appropriate child view controllers prior to creating
the tab bar controller itself.
Because you are responsible for recreating your app’s view controllers, you have some flexibility to change
your interface during the restoration process. For example, you could reorder the tabs in a tab bar controller
and still use the preserved data to return each tab to its previousstate. Of course, if you make dramatic changes
to your view controller hierarchy, such as during an app update, you might not be able to use the preserved
data.
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77What Happens When You Exclude Groups of View Controllers?
When the restoration identifier of a view controller is nil, that view controller and any child view controllers
it manages are not preserved automatically. For example, in Figure 4-6, because a navigation controller did
not have a restoration identifier, it and all of its child view controllers and views are omitted from the preserved
data.
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78Figure 4-5 Excluding view controllers from the automatic preservation process
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79Even if you decide not to preserve view controllers, that does not mean all of those view controllers disappear
from the view hierarchy altogether. At launch time, your app might still create the view controllers as part of
its default setup. For example, if any view controllers are loaded automatically from your app’s storyboard file,
they would still appear, albeit in their default configuration, as shown in Figure 4-6.
Figure 4-6 Loading the default set of view controllers
Loaded with the main storyboard file
Created during the restoration process
UINavigation
Controller
MyViewController
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80Something else to realize is that even if a view controller is not preserved automatically, you can still encode
a reference to that view controller and preserve it manually. In Figure 4-5 (page 79), the three child view
controllers of the first navigation controller have restoration identifiers, even though there parent navigation
controller does not. If your app delegate (or any preserved object) encodes a reference to those view controllers,
their state is preserved. Even though their order in the navigation controller is not saved, you could still use
those referencesto recreate the view controllers and install them in the navigation controller during subsequent
launch cycles.
Checklist for Implementing State Preservation and Restoration
Supporting state preservation and restoration requires modifying your app delegate and view controller objects
to encode and decode the state information. If your app has any custom views that also have preservable state
information, you need to modify those objects too.
When adding state preservation and restoration to your code, use the following list to remind you of the code
you need to write.
●
(Required) Implement the application:shouldSaveApplicationState: and
application:shouldRestoreApplicationState: methods in your app delegate; see “Enabling
State Preservation and Restoration in Your App” (page 82).
●
(Required) Assign restoration identifiers to each view controller you want to preserve. a non empty string
to their restorationIdentifier property; see “Marking Your View Controllers for Preservation” (page
83).
If you want to save the state of specific views too, assign non empty strings to their
restorationIdentifier properties; see “Preserving the State of Your Views” (page 86).
●
(Required) Assign restoration classes to the appropriate view controllers. (If you do not do this, your app
delegate is asked to provide the corresponding view controller at restore time.) See “Restoring Your View
Controllers at Launch Time” (page 83).
●
(Recommended) Encode and decode the state of your views and view controllers using the
encodeRestorableStateWithCoder: and decodeRestorableStateWithCoder: methods of those
objects; see “Encoding and Decoding Your View Controller’s State” (page 85).
● Encode and decode any version information or additional state information for your app using the
application:willEncodeRestorableStateWithCoder: and
application:didDecodeRestorableStateWithCoder:methods of your app delegate;see “Preserving
Your App’s High-Level State” (page 89).
State Preservation and Restoration
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81● Objects that act as data sources for table views and collection views should implement the
UIDataSourceModelAssociation protocol. Although not required, this protocol helps preserve the
selected and visible items in those types of views. See “Implementing Preservation-Friendly Data
Sources” (page 89).
Enabling State Preservation and Restoration in Your App
State preservation and restoration is not an automatic feature and apps must opt-in to use it. Apps indicate
their support for the feature by implementing the following methods in their app delegate:
application:shouldSaveApplicationState:
application:shouldRestoreApplicationState:
Normally, your implementations of these methods just return YES to indicate that state preservation and
restoration can occur. However, apps that want to preserve and restore their state conditionally can return NO
in situations where the operations should not occur. For example, after releasing an update to your app, you
might want to return NO from your application:shouldRestoreApplicationState: method if your
app is unable to usefully restore the state from a previous version.
Preserving the State of Your View Controllers
Preserving the state of your app’s view controllers should be your main goal. View controllers define the
structure of your user interface. They manage the views needed to present that interface and they coordinate
the getting and setting of the data that backs those views. To preserve the state of a single view controller,
you must do the following:
●
(Required) Assign a restoration identifier to the view controller; see “Marking Your View Controllers for
Preservation” (page 83).
●
(Required) Provide code to create or locate new view controller objects at launch time; see “Restoring
Your View Controllers at Launch Time” (page 83).
●
(Optional) Implement the encodeRestorableStateWithCoder: and
decodeRestorableStateWithCoder: methodsto encode and restore any state information that cannot
be recreated during a subsequent launch;see “Encoding and Decoding Your View Controller’s State” (page
85).
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82Marking Your View Controllers for Preservation
UIKit preserves only those view controllers whose restorationIdentifier property contains a valid string
object. For view controllers that you know you want to preserve, set the value of this property when you
initialize the view controller object. If you load the view controller from a storyboard or nib file, you can set
the restoration identifier there.
Choosing an appropriate value for restoration identifiers is important. During the restoration process, your
code uses the restoration identifier to determine which view controller to retrieve or create. If every view
controller object is based on a different class, you can use the class name for the restoration identifier. However,
if your view controller hierarchy contains multiple instances of the same class, you might need to choose
different names based on each view usage.
When it asks you to provide a view controller, UIKit provides you with the restoration path of the view controller
object. A restoration path is the sequence of restoration identifiers starting at the root view controller and
walking down the view controller hierarchy to the current object. For example, imagine you have a tab bar
controller whose restoration identifier is TabBarControllerID, and the first tab contains a navigation
controller whose identifier is NavControllerID and whose root view controller’s identifier is
MyViewController. The full restoration path for the root view controller would be
TabBarControllerID/NavControllerID/MyViewController.
The restoration path for every object must be unique. If a view controller has two child view controllers, each
child must have a different restoration identifier. However, two view controllers with different parent objects
may use the same restoration identifier because the rest of the restoration path providesthe needed uniqueness.
Some UIKit view controllers, such as navigation controllers, automatically disambiguate their child view
controllers, allowing you to use the same restoration identifiers for each child. For more information about the
behavior of a given view controller, see the corresponding class reference.
At restore time, you use the provided restoration path to determine which view controller to return to UIKit.
For more information on how you use restoration identifiers and restoration paths to restore view controllers,
see “Restoring Your View Controllers at Launch Time” (page 83).
Restoring Your View Controllers at Launch Time
During the restoration process, UIKit asks your app to create (or locate) the view controller objectsthat comprise
your preserved user interface. UIKit adheres to the following process when trying to locate view controllers:
1. If the view controller had a restoration class, UIKit asks that class to provide the view controller. UIKit
calls the viewControllerWithRestorationIdentifierPath:coder: method of the associated
restoration classto retrieve the view controller. If that method returns nil, it is assumed that the app does
not want to recreate the view controller and UIKit stops looking for it.
State Preservation and Restoration
Preserving the State of Your View Controllers
2012-09-19   |   © 2012 Apple Inc. All Rights Reserved.
832. If the view controller did not have a restoration class, UIKit asks the app delegate to provide the view
controller.UIKit callsthe application:viewControllerWithRestorationIdentifierPath:coder:
method of your app delegate to look for view controllers without a restoration class. If that method returns
nil, UIKit tries to find the view controller implicitly.
3. If a view controller with the correct restoration path already exists, UIKit uses that object. If your app
creates view controllers at launch time (either programmatically or by loading them from a resource file)
and assigns restoration identifiers to them, UIKit finds them implicitly through their restoration paths.
4. If the view controller was originally loaded from a storyboard file, UIKit uses the saved storyboard
information to locate and create it. UIKit saves information about a view controller’s storyboard inside
the restoration archive. At restore time, it uses that information to locate the same storyboard file and
instantiate the corresponding view controller if the view controller was not found by any other means.
It is worth noting that if you specify a restoration class for a view controller, UIKit does not try to find your view
controller implicitly. If the viewControllerWithRestorationIdentifierPath:coder: method of your
restoration class returns nil, UIKit stops trying to locate your view controller. This gives you control over
whether you really want to create the view controller. If you do not specify a restoration class, UIKit does
everything it can to find the view controller for you, creating it as necessary from your app’s storyboard files.
If you choose to use a restoration class, the implementation of your
viewControllerWithRestorationIdentifierPath:coder: method should create a new instance of
the class, perform some minimal initialization, and return the resulting object. Listing 4-1 shows an example
of how you might use this method to load a view controller from a storyboard. Because the view controller
was originally loaded from a storyboard, this method uses the
UIStateRestorationViewControllerStoryboardKey key to get the name of the original storyboard
file from the archive. Note that this method does not try to configure the view controller’s data fields. That
step occurs later when the view controller’s state is decoded.
Listing 4-1 Creating a new view controller during restoration
+ (UIViewController*) viewControllerWithRestorationIdentifierPath:(NSArray
*)identifierComponents
coder:(NSCoder *)coder {
MyViewController* vc;
NSString* storyboardName = [coder
decodeObjectForKey:UIStateRestorationViewControllerStoryboardKey];
UIStoryboard* sb = [UIStoryboard storyboardWithName:storyboardName bundle:nil];
if (storyboardName) {
vc = (MyViewController*)[sb
instantiateViewControllerWithIdentifier:@"MyViewController"];
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84thePush.restorationIdentifier = [identifierComponents lastObject];
thePush.restorationClass = [MyViewController class];
}
return vc;
}
Reassigning the restoration identifier and restoration class, as in the preceding example, is a good habit to
adopt when creating new view controllers. The simplest way to restore the restoration identifier is to grab the
last item in the identifierComponents array and assign it to your view controller.
For objects that were already loaded from your app’s main storyboard file at launch time, do not create a new
instance of each object. Instead, implement the
application:viewControllerWithRestorationIdentifierPath:coder:method of your app delegate
and use it to return the appropriate objects or let UIKit find those objects implicitly.
Encoding and Decoding Your View Controller’s State
For each objectslated for preservation, UIKit callsthe object’s encodeRestorableStateWithCoder: method
to give it a chance to save its state. During the decode process, a matching call to the
decodeRestorableStateWithCoder: method is made to decode that state and apply it to the object. The
implementation of these methods is optional, but recommended, for your view controllers. You can use them
to save and restore the following types of information:
● References to any data being displayed (not the data itself)
● For a container view controller, references to its child view controllers
●
Information about the current selection
● For view controllers with a user-configurable view, information about the current configuration of that
view.
In your encode and decode methods, you can encode any values supported by the coder, including other
objects. For all objects except views and view controllers, the object must adopt the NSCoding protocol and
use the methods of that protocol to write its state. For views and view controllers, the coder does not use the
methods of the NSCoding protocol to save the object’sstate. Instead, the codersavesthe restoration identifier
of the object and adds it to the list of preservable objects, which results in that object’s
encodeRestorableStateWithCoder: method being called.
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85The encodeRestorableStateWithCoder: and decodeRestorableStateWithCoder: methods of your
view controllers should always call super at some point in their implementation. Calling super gives the
parent class a chance to save and restore any additional information. Listing 4-2 shows a sample implementation
of these methods that save a numerical value used to identify the specified view controller.
Listing 4-2 Encoding and decoding a view controller’s state.
- (void)encodeRestorableStateWithCoder:(NSCoder *)coder {
[super encodeRestorableStateWithCoder:coder];
[coder encodeInt:self.number forKey:MyViewControllerNumber];
}
- (void)decodeRestorableStateWithCoder:(NSCoder *)coder {
[super decodeRestorableStateWithCoder:coder];
self.number = [coder decodeIntForKey:MyViewControllerNumber];
}
Coder objects are notshared during the encode and decode process. Each object with preservable state receives
its own coder that it can use to read or write data. The use of unique coders means that you do not have to
worry about key namespace collisions among your own objects. However, you must still avoid using some
special key names that UIKit provides. Specifically, each coder contains the
UIApplicationStateRestorationBundleVersionKey and
UIApplicationStateRestorationUserInterfaceIdiomKey keys, which provide information about the
bundle version and current user interface idiom. Coders associated with view controllers may also contain the
UIStateRestorationViewControllerStoryboardKey key, which identifies the storyboard from which
that view controller originated.
For more information about implementing your encode and decode methods for your view controllers, see
UIViewController Class Reference .
Preserving the State of Your Views
If a view has state information worth preserving, you can save that state with the rest of your app’s view
controllers. Because they are usually configured by their owning view controller, most views do not need to
save state information. The only time you need to save a view’s state is when the view itself can be altered by
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86the user in a way that is independent of its data or the owning view controller. For example, scroll views save
the current scroll position, which is information that is not interesting to the view controller but which does
affect how the view presents itself.
To designate that a view’s state should be saved, you do the following:
● Assign a valid string to the view’s restorationIdentifier property.
● Use the view from a view controller that also has a valid restoration identifier.
● For table views and collection views, assign a data source that adopts the
UIDataSourceModelAssociation protocol.
As with view controllers, assigning a restoration identifier to a view tells the system that the view object has
state that your app wants to save. The restoration identifier can also be used to locate the view later.
Like view controllers, views define methods for encoding and decoding their custom state. If you create a view
with state worth saving, you can use these methods to read and write any relevant data.
UIKit VIews with Preservable State
In order to save the state of any view, including both custom and standard system views, you must assign a
restoration identifier to the view. Views without a restoration identifier are not added to the list of preservable
objects by UIKit.
The following UIKit views have state information that can be preserved:
● UICollectionView
● UIImageView
● UIScrollView
● UITableView
● UITextField
● UITextView
● UIWebView
Other frameworks may also have views with preservable state. For information about whether a view saves
state information and what state it saves, see the reference for the corresponding class.
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87Preserving the State of a Custom View
If you are implementing a custom view that has restorable state, implement the
encodeRestorableStateWithCoder: and decodeRestorableStateWithCoder:methods and use them
to encode and decode that state. Use those methods to save only the data that cannot be easily reconfigured
by other means. For example, use these methods to save data that is modified by user interactions with the
view. Do not use these methods to save the data being presented by the view or any data that the owning
view controller can configure easily.
Listing 4-3 shows an example of how to preserve and restore the selection for a custom view that contains
editable text. In the example, the range is accessible using the selectionRange and setSelectionRange:
methods, which are custom methods the view uses to manage the selection. Encoding the data only requires
writing it to the provided coder object. Restoring the data requires reading it and applying it to the view.
Listing 4-3 Preserving the selection of a custom text view
// Preserve the text selection
- (void) encodeRestorableStateWithCoder:(NSCoder *)coder {
[super encodeRestorableStateWithCoder:coder];
NSRange range = [self selectionRange];
[coder encodeInt:range.length forKey:kMyTextViewSelectionRangeLength];
[coder encodeInt:range.location forKey:kMyTextViewSelectionRangeLocation];
}
// Restore the text selection.
- (void) decodeRestorableStateWithCoder:(NSCoder *)coder {
[super decodeRestorableStateWithCoder:coder];
if ([coder containsValueForKey:kMyTextViewSelectionRangeLength] &&
[coder containsValueForKey:kMyTextViewSelectionRangeLocation]) {
NSRange range;
range.length = [coder decodeIntForKey:kMyTextViewSelectionRangeLength];
range.location = [coder decodeIntForKey:kMyTextViewSelectionRangeLocation];
if (range.length > 0)
[self setSelectionRange:range];
}
}
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88Implementing Preservation-Friendly Data Sources
Because the data displayed by a table or collection view can change, both classes save information about the
currentselection and visible cells only if their data source implementsthe UIDataSourceModelAssociation
protocol. This protocol provides a way for a table or collection view to identify the content it contains without
relying on the index path of that content. Thus, regardless of where the data source places an item during the
next launch cycle, the view still has all the information it needs to locate that item.
In order to implement the UIDataSourceModelAssociation protocol successfully, your data source object
must be able to identify items between subsequent launches of the app. This means that any identification
scheme you devise must be invariant for a given piece of data. This is essential because the data source must
be able to retrieve the same piece of data for the same identifier each time it is requested. Implementing the
protocol itself is a matter of mapping from a data item to its unique ID and back again.
Apps that use Core Data can implement the protocol by taking advantage of object identifiers. Each object in
a Core Data store has a unique object identifier that can be converted into a URI and used to locate the object
later. If your app does not use Core Data, you need to devise your own form of unique identifiers if you want
to support state preservation for your views.
Note:  Remember that implementing the UIDataSourceModelAssociation protocol is only
necessary to preserve attributes such as the current selection in a table or collection view. This
protocol is not used to preserve the actual data managed by your data source. It is your app’s
responsibility to ensure that its data is saved at appropriate times.
Preserving Your App’s High-Level State
In addition to the data preserved by your app’s view controllers and views, UIKit provides hooks for you to
save any miscellaneous data needed by your app. Specifically, the UIApplicationDelegate protocol includes
the following methods for you to override:
● application:willEncodeRestorableStateWithCoder:
● application:didDecodeRestorableStateWithCoder:
If your app contains state that does not live in a view controller, but that needs to be preserved, you can use
the precedingmethodsto save and restore it. The application:willEncodeRestorableStateWithCoder:
method is called at the very beginning of the preservation process so that you can write out any high-level
app state, such as the current version of your user interface. The
application:didDecodeRestorableStateWithCoder: method is called at the end of the restoration
state so that you can decode any data and perform any final cleanup that your app requires.
State Preservation and Restoration
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If your app already implementsits own custom state preservation and restoration mechanism, you can continue
to use that mechanism and migrate your code to use UIKit’ssupport over time. The design of UIKit’s preservation
mechanism allows you to pick and choose which view controllers you want to preserve. Thus, you can designate
that only portions of your interface should be restored by UIKit, leaving the rest to be handled by your app’s
current process.
Figure 4-7 shows a sample view hierarchy containing a tab bar controller and the view controllersin its assorted
tabs. In this sample, because the tab bar controller has a restoration identifier associated with it, UIKit saves
the state of the tab bar controller and all other child view controllers that also have a restoration identifier.
Your app’s custom code would then need to preserve the state of the remaining view controllers. During
restoration, a similar process occurs. UIKit restores all of the view controllersthat it preserved while your custom
code restores the rest.
Figure 4-7 UIKit handles the root view controller
Tab Bar Controller
Navigation Controller View Controller View Controller
Presented
View Controller
View Controller
Presented
View Controller
View Controller
Presented
View Controller
View Controller
Presented
View Controller
UIKit restoration
Custom restoration
If you prefer to have your own code manage the root view controller of your app, the save and restore process
differs slightly. Because UIKit would not automatically save any view controllers, you need to encode them
manually in the application:willEncodeRestorableStateWithCoder: method of your app delegate.
State Preservation and Restoration
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90When you use the encodeObject:forKey: method of the coder to encode a view controller object, the
coder uses the view controller’s encodeRestorableStateWithCoder: method to do the encoding. This
process allows you to write arbitrary view controllers to the state preservation archive managed by UIKit.
When you decode archived view controllers during the next launch cycle, you muststill be prepared to provide
an instance of each view controller to UIKit. When you call the decodeObjectForKey: method to decode
your view controller, UIKit calls the
application:viewControllerWithRestorationIdentifierPath:coder:method of your app delegate
to retrieve the view controller object first. Only after UIKit has the view controller object does it call the
decodeRestorableStateWithCoder: method to return the view controller to its previous state. Your code
can use the application:viewControllerWithRestorationIdentifierPath:coder: method to
create the view controller and install it in your app’s view controller hierarchy.
Tips for Saving and Restoring State Information
As you add support for state preservation and restoration to your app, consider the following guidelines:
● Encode version information along with the rest of your app’s state. During the preservation process,
it is recommended that you encode a version string or number that identifies the current revision of your
app’s user interface. You can encode this state in the
application:willEncodeRestorableStateWithCoder: method of your app delegate. When your
app delegate’s application:shouldRestoreApplicationState: method is called, you can retrieve
this information from the provided coder and use it to determine if state preservation is possible.
● Do not include objects from your data model in your app’s state. Apps should continue to save their
data separately in iCloud or to local files on disk. Never use the state restoration mechanism to save that
data. Preserved interface data may be deleted if problems occur during a restore operation. Therefore,
any preservation-related data you write to disk should be considered purgeable.
● The state preservation system expects you to use view controllers in the ways they were designed to
be used. The view controller hierarchy is created through a combination of view controller containment
and by presenting one view controller from another. If your app displays the view of a view controller by
another means—for example, by adding it to another view without creating a containment relationship
between the corresponding view controllers—the preservation system will not be able to find your view
controller to preserve it.
● Remember that you might not want to preserve all view controllers. In some cases, it might not make
sense to preserve a view controller. For example, if the user left your app while it was displaying a view
controller to change the user’s password, you might want to cancel the operation and restore the app to
the previous screen. In such a case, you would not preserve the view controller that asks for the new
password information.
State Preservation and Restoration
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91● Avoid swapping view controller classes during the restoration process. The state preservation system
encodes the class of the view controllers it preserves. During restoration, if your app returns an object
whose class does not match (or is not a subclass of) the original object, the system does not ask the view
controller to decode any state information. Thus, swapping out the old view controller for a completely
different one does not restore the full state of the object.
● Be aware that the system automatically deletes an app’s preserved state when the user force quits
the app. Deleting the preserved state information when the app is killed is a safety precaution. (The system
also deletes preserved state if the app crashes at launch time as a similar safety precaution.) If you want
to test your app’s ability to restore its state, you should not use the multitasking bar to kill the app during
debugging. Instead, use Xcode to kill the app or kill the app programmatically by installing a temporary
command or gesture to call exit on demand.
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92Aside from the images and media files your app presents on screen, there are some specific resources that iOS
itself requires your app to provide. The system uses these resources to determine how to present your app on
the user’s home screen and, in some cases, how to facilitate interactions with other parts of the system.
App Store Required Resources
There are several things that you are required to provide in your app bundle before submitting it to the App
Store:
● Your app must have an Info.plist file. This file contains information that the system needs to interact
with your app. Xcode creates a version of this file automatically but most apps need to modify this file in
some way. For information on how to configure this file, see “The Information Property List File” (page
93).
● Your app’s Info.plist file must include the UIRequiredDeviceCapabilities key. The App Store
uses this key to determine whether or not a user can run your app on a specific device. For information
on how to configure this key, see “Declaring the Required Device Capabilities” (page 94).
● You must include one or more icons in your app bundle. The system uses these icons when presenting
your app on the device’s home screen. For information about how to specify app icons, see “App
Icons” (page 98).
● Your app must include at least one image to be displayed while your app islaunching. The system displays
this image to provide the user with immediate feedback that your app is launching. For information about
launch images, see “App Launch (Default) Images” (page 100).
The Information Property List File
The information property list (Info.plist) file contains critical information about your app’s configuration and
must be included in your app bundle. Every new project you create in Xcode has a default Info.plist file
configured with some basic information about your project. You can modify this file to specify additional
configuration details for your app.
Your app’s Info.plist file must include the following keys:
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App-Related Resources● UIRequiredDeviceCapabilities—The App Store uses this key to determine the capabilities of your
app and to prevent it from being installed on devices that do not support features your app requires. For
more information about this key, see “Declaring the Required Device Capabilities” (page 94).
● CFBundleIcons—Thisisthe preferred key forspecifying your app’sicon files. Older projects might include
the CFBundleIconFiles key instead. Both keys have essentially the same purpose but the
CFBundleIcons key is preferred because it allows you to organize your icons more efficiently. (The
CFBundleIcons key is also required for Newsstand apps.)
● UISupportedInterfaceOrientations—This key is included by Xcode automatically and is set to an
appropriate set of default values. However, you should add or remove values based on the orientations
that your app actually supports.
You might also want to include the following keys in your app’s Info.plist file, depending on the behavior
of your app:
● UIBackgroundModes—Include this key if your app supports executing in the background using one of
the defined modes; see “Implementing Long-Running Background Tasks” (page 58).
● UIFileSharingEnabled—Include this key if you want to expose the contents of your sandbox’s
Documents directory in iTunes.
● UIRequiresPersistentWiFi—Include this key if your app requires a Wi-Fi connection.
● UINewsstandApp—Include this key if your app presents content from the Newsstand app.
The Info.plist file itself is a property list file that you can edit manually or using Xcode. Each new Xcode
project contains a file called-Info.plist, where isthe name of your Xcode
project. This file is the template that Xcode uses to generate the actual Info.plist file at build time. When
you select this file, Xcode displays the property list editor that you can use to add or remove keys or change
the value of a key. For information about how to configure the contents of this file, see Property List Editor
Help .
For details about the keys you can include in the Info.plist file, see Information Property List Key Reference .
Declaring the Required Device Capabilities
The UIRequiredDeviceCapabilities key lets you declare the hardware or specific capabilities that your
app needs in order to run. All apps are required to have this key in their Info.plist file. The App Store uses
the contents of this key to prevent users from downloading your app onto a device that cannot possibly run
it.
App-Related Resources
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94The value of the UIRequiredDeviceCapabilities key is either an array or a dictionary that contains additional
keys identifying features your app requires (or specifically prohibits). If you specify the value of the key using
an array, the presence of a key indicates that the feature is required; the absence of a key indicates that the
feature is not required and that the app can run without it. If you specify a dictionary instead, each key in the
dictionary must have a Boolean value that indicates whether the feature is required or prohibited. A value of
true indicates the feature is required and a value of false indicates that the feature must not be present on
the device. If a given capability is optional for your app, do not include the corresponding key in the dictionary.
Table 5-1 liststhe keysthat you can include in the array or dictionary for the UIRequiredDeviceCapabilities
key. You should include keys only for the featuresthat your app absolutely requires. If your app can run without
a specific feature, do not include the corresponding key.
Table 5-1 Dictionary keys for the UIRequiredDeviceCapabilities key
Key Description
Include this key if your app requires(orspecifically prohibits) the presence
of accelerometers on the device. Apps use the Core Motion framework
to receive accelerometer events. You do not need to include this key if
your app detects only device orientation changes.
accelerometer
Include this key if your app is compiled only for the armv6 instruction set.
(iOS 3.1 and later)
armv6
Include this key if your app is compiled only for the armv7 instruction set.
(iOS 3.1 and later)
armv7
Include this key if your app requires (or specifically prohibits) autofocus
capabilities in the device’s still camera. Although most developers should
not need to include this key, you might include it if your app supports
macro photography or requires sharper images in order to perform some
sort of image processing.
auto-focus-camera
Include this key if your app requires(orspecifically prohibits) the presence
of Bluetooth low-energy hardware on the device. (iOS 5 and later.)
bluetooth-le
Include this key if your app requires(orspecifically prohibits) the presence
of a camera flash for taking pictures or shooting video. Apps use the
UIImagePickerController interface to control the enabling of this
feature.
camera-flash
Include this key if your app requires(orspecifically prohibits) the presence
of a forward-facing camera. Apps use the UIImagePickerController
interface to capture video from the device’s camera.
front-facing-camera
App-Related Resources
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95Key Description
Include this key if your app requires(orspecifically prohibits) Game Center.
(iOS 4.1 and later)
gamekit
Include this key if your app requires(orspecifically prohibits) the presence
of GPS (or AGPS) hardware when tracking locations. (You should include
this key only if you need the higher accuracy offered by GPS hardware.)
If you include this key, you should also include the location-services
key. You should require GPS only if your app needs location data more
accurate than the cellular or Wi-fi radios might otherwise provide.
gps
Include this key if your app requires(orspecifically prohibits) the presence
of a gyroscope on the device. Apps use the Core Motion framework to
retrieve information from gyroscope hardware.
gyroscope
Include this key if your app requires (or specifically prohibits) the ability
to retrieve the device’s current location using the Core Location framework.
(This key refers to the general location services feature. If you specifically
need GPS-level accuracy, you should also include the gps key.)
location-services
Include this key if your app requires(orspecifically prohibits) the presence
of magnetometer hardware. Apps use this hardware to receive
heading-related events through the Core Location framework.
magnetometer
Include this key if your app uses the built-in microphone or supports
accessories that provide a microphone.
microphone
Include this key if your app requires(orspecifically prohibits) the presence
of the OpenGL ES 1.1 interfaces.
opengles-1
Include this key if your app requires(orspecifically prohibits) the presence
of the OpenGL ES 2.0 interfaces.
opengles-2
Include this key if your app requires(orspecifically prohibits) peer-to-peer
connectivity over a Bluetooth network. (iOS 3.1 and later)
peer-peer
Include this key if your app requires(orspecifically prohibits) the presence
of the Messages app. You might require this feature if your app opens
URLs with the sms scheme.
sms
Include this key if your app requires(orspecifically prohibits) the presence
of a camera on the device. Apps use the UIImagePickerController
interface to capture images from the device’s still camera.
still-camera
App-Related Resources
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Include this key if your app requires(orspecifically prohibits) the presence
of the Phone app. You might require this feature if your app opens URLs
with the tel scheme.
telephony
Include this key if your app requires(orspecifically prohibits) the presence
of a camera with video capabilities on the device. Apps use the
UIImagePickerController interface to capture video from the device’s
camera.
video-camera
Include this key if your app requires (or specifically prohibits) access to
the networking features of the device.
wifi
For detailed information on how to create and edit property lists, see Information Property List Key Reference .
Declaring Your App’s Supported Document Types
If your app is able to open existing or custom file types, your Info.plist file should include information
about those types. Declaring file types is how you let the system know that your app is able to open files of
the corresponding type. The system uses this information to direct file requests to your app at appropriate
times. For example, if the Mail app receives an attachment, the system can direct that attachment to your app
to open.
When declaring your app’s supported file types, you typically do not configure keys in your Info.plist file
directly. In the Info tab of your target settings, there is a Document Settings section that you can use to specify
your app’s supported types. Each document type that you add to this section can represent one file type or
several file types. For example, you can define a single document type that represents only PNG images or one
that represents PNG,JPG, and GIF images. The decision to represent one file type or multiple file types depends
on how your app presents the files. If it presents all of the files in the same way—that is, with the same icon
and with the same basic code path—then you can use one document type for multiple file types. If the code
paths or icons are different for each file type, you should declare different document types for each.
For each document type, you must provide the following information at a minimum:
● A name. This is a localizable string that can be displayed to the user if needed.
● An icon. All files associated with a document type share the same icon.
● The file types. These are uniform type identifier (UTI) strings that identify the supported file types. For
example, to specify the PNG file type, you would specify the public.png UTI. UTIs are the preferred way
to specify file types because they are less fragile than filename extensions and other techniques used to
identify files.
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CFBundleDocumentTypes key in your app’s Info.plist file. The CFBundleDocumentTypes key contains
an array of dictionaries, where each dictionary represents one of your declared document types and includes
the name, icon, file type, and other information you specified.
For more information on the keys you use to declare your app’s document types, see Information Property List
Key Reference . For information about how to open files passed to your app by the system, see “Handling URL
Requests” (page 120).
App Icons
Every app must provide an icon to be displayed on a device’s Home screen and in the App Store. An app may
actually specify several different icons for use in different situations. For example, an app can provide a small
icon to use when displaying search results and can provide a high-resolution icon for devices with Retina
displays.
Regardless of how many different icons your app has, you specify them using the CFBundleIcons key in the
Info.plist file. The value of that key is an array of strings, each of which contains the filename of one of
your icons. The filenames can be anything you want, but all image files must be in the PNG format and must
reside in the top level of your app bundle. (Avoid using interlaced PNGs.) When the system needs an icon, it
choose the image file whose size most closely matches the intended usage.
Table 5-2 lists the dimensions of the icons you can include with your app. For apps that run on devices with
Retina displays, two versions of each icon should be provided, with the second one being a high-resolution
version of the original. The names of the two icons should be the same except for the inclusion of the string
@2x in the filename of the high-resolution image. You can find out more about specifying and loading
high-resolution image resources in Drawing and Printing Guide for iOS . For a complete list of app-related icons
and detailed information about the usage and preparation of your icons, see iOS Human Interface Guidelines.
Table 5-2 Sizes for images in the CFBundleIcons key
Icon Idiom Size Usage
Thisisthe main icon for appsrunning
on iPhone and iPod touch.
57 x 57 pixels
114 x 114 pixels
(@2x)
App icon (required) iPhone
Thisisthe main icon for appsrunning
on iPad.
72 x 72 pixels
144 x 144 pixels
(@2x)
App icon (required) iPad
App-Related Resources
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iTunes uses this icon when
presenting your app for distribution.
These files must be included at the
top level of your app bundle and the
names of the files must be
iTunesArtwork and
iTunesArtwork@2x (no filename
extension).
512 x 512
1024 x 1024 (@2x)
App icon for the App iPhone/iPad
Store (required)
This is the icon displayed in
conjunction with search results on
iPhone and iPod touch. This icon is
also used by the Settings app on all
devices.
29 x 29 pixels
58 x 58 pixels
(@2x)
Small icon for iPhone
Spotlight search
results and Settings
(recommended)
This is the icon displayed in
conjunction with search results on
iPad.
50 x 50 pixels
100 x 100 pixels
(@2x)
Small icon for iPad
Spotlight search
results and Settings
(recommended)
When specifying icon files using the CFBundleIcons key, it is best to omit the filename extensions of your
image files. If you include a filename extension, you must explicitly add the names of all image files (including
any high-resolution variants). When you omit the filename extension, the system automatically detects
high-resolution variants of your file, even if they are not included in the array.
If your iPhone app is running in iOS 3.1.3 or earlier, the system does not look for icons using your Info.plist
file. The CFBundleIcons key was introduced in iOS 5.0 and the CFBundleIconFiles key was introduced
in iOS 3.2. Instead of using these keys, the system looks for icon files with specific filenames. Although the sizes
of the icons are the same as those in Table 5-2 (page 98), if your app supports deployment on iOS 3.1.3 and
earlier, you must use the following filenames when naming your icons:
● Icon.png. The name for the app icon on iPhone or iPod touch.
● Icon-72.png. The name for the app icon on iPad.
● Icon-Small.png. The name for the search results icon on iPhone and iPod touch. This file is also used
for the Settings icon on all devices.
● Icon-Small-50.png. The name of the search results icon on iPad.
App-Related Resources
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99Important:  The use of fixed filenames for your app icons is for compatibility with earlier versions of iOS
only. Even if you use these fixed icon filenames, your app should continue to include the CFBundleIcons
or CFBundleIconFiles key in your app’s Info.plist file.
For more information about the CFBundleIcons key, see Information Property List Key Reference . For
information about creating your app icons, see iOS Human Interface Guidelines.
App Launch (Default) Images
When the system launches an app, it temporarily displays a static launch image on the screen. Your app provides
this image, with the image contents usually containing a prerendered version of your app’s default user
interface. The purpose of thisimage isto give the user immediate feedback that the app launched. It also gives
your app time to initialize itself and prepare its initial set of views for display. When your app is ready to run,
the system removes the image and displays your app’s windows and views.
Every app must provide at least one launch image. This image is typically in a file named Default.png that
displays your app’s initial screen in a portrait orientation. However, you can also provide other launch images
to be used under different launch conditions. All launch images must be PNG files and must reside in the top
level of your app’s bundle directory. (Avoid using interlaced PNGs.) The name of each launch image indicates
its purpose and how it is used. The format for launch image filenames is as follows:
.png
The  portion of the filename is either the string Default or a custom string that you specify using
the UILaunchImageFile key in your app’s Info.plist file. The  portion is the optional
string @2x and should be included only for imagesintended for use on Retina displays. Other optional modifiers
may also be included in the name, and several standard modifiers are discussed in the sections that follow.
Table 5-3 lists the dimensions for launch images in iOS apps. For all dimensions, the image width is listed first,
followed by the image height. For precise information about which size launch image to use and how to
prepare your launch images, see iOS Human Interface Guidelines.
Table 5-3 Typical launch image dimensions
Device Portrait Landscape
320 x 480 pixels Not supported
640 x 960 pixels (@2x)
iPhone and iPod touch
iPhone 5 and iPod touch (5th generation) 640 x 1136 pixels (@2x) Not supported
App-Related Resources
App Launch (Default) Images
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100Device Portrait Landscape
1024 x 748 pixels
2048 x 1496 pixels (@2x)
768 x 1004 pixels
1536 x 2008 pixels (@2x)
iPad
To demonstrate the naming conventions, suppose your iOS app’s Info.plist file included the
UILaunchImageFile key with the value MyLaunchImage. The standard resolution version of the launch
image would be named MyLaunchImage.png and would be in a portrait orientation (320 x 480). The
high-resolution version of the same launch image would be named MyLaunchImage@2x.png. If you did not
specify a customlaunch image name, these files would need to be named Default.png and Default@2x.png,
respectively.
To specify default launch images for iPhone 5 and iPod touch (5th generation) devices, include the modifier
string -568h immediately after the  portion of the filename. Because these devices have Retina
displays, the @2x modifier must always be included with launch imagesfor the devices. For example, the default
launch image name for a device is Default-568h@2x.png. (If your app has the UILaunchImageFile key
in its Info.plist file, replace the Default portion of the string with your custom string.) The -568h modifier
should always be the first one in the list. You can also insert other modifiers after the -568h string as described
below.
For more information about the UILaunchImageFile key, see Information Property List Key Reference .
Providing Launch Images for Different Orientations
In iOS 3.2 and later, an iPad app can provide both landscape and portrait versions of its launch images. Each
orientation-specific launch image must include a special modifier string in its filename. The format for
orientation-specific launch image filenames is as follows:
.png
Table 5-4 lists the possible modifiers you can specify for the  value in your image
filenames. As with all launch images, each file must be in the PNG format. These modifiers are supported for
launch images used in iPad apps only; they are notsupported for appsrunning on iPhone or iPod touch devices.
Table 5-4 Launch image orientation modifiers
Modifier Description
Specifies an upside-down portrait version of the launch image. A file with
this modifier takes precedence over a file with the -Portrait modifier
for this specific orientation.
-PortraitUpsideDown
App-Related Resources
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Specifies a left-oriented landscape version of the launch image. A file with
this modifier takes precedence over a file with the -Landscape modifier
for this specific orientation.
-LandscapeLeft
Specifies a right-oriented landscape version of the launch image. A file
with this modifier takes precedence over a file with the -Landscape
modifier for this specific orientation.
-LandscapeRight
Specifies the generic portrait version of the launch image. This image is
used for right-side up portrait orientations and takes precedence over the
Default.png image file (or your custom-named replacement for that
file). If a file with the -PortraitUpsideDown modifier is not specified,
this file is also used for upside-down portrait orientations as well.
-Portrait
Specifies the generic landscape version of the launch image. If a file with
the -LandscapeLeft or -LandscapeRight modifier is not specified,
this image is used instead. This image takes precedence over the
Default.png image file (or your custom-named replacement for that
file).
-Landscape
If you provide a launch image file with no orientation modifier, that file
is used when no other orientation-specific launch image is available. For
apps running on systems earlier than iOS 3.2, you must name this file
Default.png.
(none)
For example, if you specify the value MyLaunchImage in the UILaunchImageFile key, the custom landscape
and portrait launch images for your iPad app would be named MyLaunchImage-Landscape.png and
MyLaunchImage-Portrait.png. If you do not specify a custom launch image filename, you would use the
names Default-Landscape.png and Default-Portrait.png.
No matter which launch image is displayed by the system, your app always launches in a portrait orientation
initially and then rotates as needed to the correct orientation. Therefore, your
application:didFinishLaunchingWithOptions: method should always assume a portrait orientation
when setting up your window and views. Shortly after the
application:didFinishLaunchingWithOptions: method returns, the system sends any necessary
orientation-change notifications to your app’s window, giving it and your app’s view controllers a chance to
reorient views using the standard process.
For more information about how your view controllers manage the rotation process, see “Creating Custom
Content View Controllers” in View Controller Programming Guide for iOS .
App-Related Resources
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Universal apps must provide launch images for both the iPhone and iPad idioms. Because iPhone apps require
only one launch image (Default.png), whereas iPad apps typically require different images for portrait and
landscape orientations, you can usually do without device-specific modifiers. However, if you create multiple
launch images for each idiom, the names of device-specific image files are likely to collide. In that situation,
you can append a device modifier to filenames to indicate that they are for a specific platform only. The
following device modifiers are recognized for launch images in iOS 4.0 and later:
● ~ipad. The launch image should be loaded on iPad devices only.
● ~iphone. The launch image should be loaded on iPhone or iPod touch devices only.
Because device modifiers are notsupported in iOS 3.2, the minimalset of launch images needed for a universal
app (running in iOS 3.2 and later) would need to be named Default.png and Default~iphone.png. In
that case, the Default.png file would contain the iPad launch image (for all orientations) and the
Default~iphone.png file would contain the iPhone version of the image. (To support high-resolution displays,
you would also need to include a Default@2x~iphone.png launch image.)
Note:  If you are using the UILaunchImageFile key in your Info.plist file to specify a custom
base name for your launch image files, add device-specific versions as needed to differentiate the
launch images on different devices. For example, specify a UILaunchImageFile~ipad key to
specify a different base name for iPad launch images. Specifying different base nameslets a universal
app avoid naming conflicts among its launch images. For more information on how to apply device
modifiers to keys in the Info.plist file, see Information Property List Key Reference .
Providing Launch Images for Custom URL Schemes
If your app supports one or more custom URL schemes, it can also provide a custom launch image for each
URL scheme. When the system launches your app to handle a URL, it displays the launch image associated
with the scheme of the given URL. In this case, the format for your launch image filenames are as follows:
-.png
The  modifier is a string representing the name of your URL scheme name. For example, if your
app supports a URL scheme with the name myscheme, the system looks for an image with the name
Default-myscheme.png (or Default-myscheme@2x.png for Retina displays) in the app’s bundle. If the
app’s Info.plist file includesthe UILaunchImageFile key, the base name portion changesfrom Default
to the custom string you provide in that key.
App-Related Resources
App Launch (Default) Images
2012-09-19   |   © 2012 Apple Inc. All Rights Reserved.
103Note:  You can combine a URL scheme modifier with orientation modifiers. If you do this, the format
for the filename is
-.png.For
more information about the launch orientation modifiers,see “Providing Launch Imagesfor Different
Orientations” (page 101).
In addition to including the launch images at the top level of your bundle, you can also include localized
versions of your launch images in your app’s language-specific project subdirectories. For more information on
localizing resources in your app, see “Localized Resource Files” (page 105).
The Settings Bundle
Apps that want to display preferences in the Settings app must include a Settings bundle resource. A Settings
bundle is a specially formatted bundle that sits at the top of your app’s bundle directory and contains the data
needed to display your app’s preferences. Figure 5-1 shows an example of custom preferences displayed for
an app.
Figure 5-1 Custom preferences displayed by the Settings app
App-Related Resources
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104Note:  Because changing preferences in the Settings app requires leaving your app, you should use
a Settings bundle only for preferences that the user changes infrequently. Frequently changed
settings should be included directly inside your app.
Xcode provides support for creating a Settings bundle resource and adding it to your app. Inside the Settings
bundle, you place one or more property list files and any images associated with your preferences. Each
property-list file contains special keys and values that tell the Settings app how to display different pages of
your preferences. Changesto your app’s preferences are stored in the user defaults database and are accessible
to your app using an NSUserDefaults object.
For detailed information about how to create a Settings bundle, see Preferences and Settings Programming
Guide .
Localized Resource Files
Because iOS apps are distributed in many countries, localizing your app’s content can help you reach many
more customers. Users are much more likely to use an app when it is localized for their native language. When
you factor your user-facing content into resource files, localizing that content is a relatively simple process.
Before you can localize your content, you must internationalize your app in order to facilitate the localization
process. Internationalizing your app involves factoring out any user-facing content into localizable resource
files and providing language-specific project (.lproj) directories for storing that content. It also means using
appropriate technologies (such as date and number formatters) when working with language-specific and
locale-specific content.
For a fully internationalized app, the localization process creates new sets of language-specific resource files
for you to add to your project. A typical iOS app requires localized versions of the following types of resource
files:
● Storyboard files (or nib files)—Storyboards can contain text labels and other content that need to be
localized. You might also want to adjust the position of interface items to accommodate changes in text
length. (Similarly, nib files can contain text that needs to be localized or layout that needs to be updated.)
● Strings files—Strings files (so named because of their .strings filename extension) contain localized
text that you plan to display in your app.
●
Image files—You should avoid localizing images unless the images contain culture-specific content. And
you should never store text directly in your image files. Instead, store text in a strings file and composite
that text with your image-based content at runtime..
App-Related Resources
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105● Video and audio files—You should avoid localizing multimedia files unless they contain language-specific
or culture-specific content. For example, you would want to localize a video file that contained a voice-over
track.
For information about the internationalization and localization process, see Internationalization Programming
Topics. For information about the proper way to use resource files in your app, see Resource Programming
Guide .
Loading Resources Into Your App
Putting resources into your bundle is the first step but at runtime, you need to be able to load those resources
into memory and use them. Resource management is broken down basically into two steps:
1. Locate the resource.
2. Load the resource.
3. Use the resource.
To locate resources, you use an NSBundle object. A bundle object understands the structure of your app’s
bundle and knows how to locate resources inside it. Bundle objects even use the current language settings to
choose an appropriately localized version of the resource. The pathForResource:ofType: method is one
of several NSBundle methods that you can use to retrieve the location of resource files.
Once you have the location of a resource file, you have to decide the most appropriate way to load it into
memory. Common resource types usually have a corresponding class that you use to load the resource:
● To load view controllers (and their corresponding views) from a storyboard, use the UIStoryboard class.
● To load an image, use the methods of the UIImage class.
● To load string resources, use the NSLocalizedString and related macros defined in Foundation
framework.
● To load the contents of a property list, use the dictionaryWithContentsOfURL: method of
NSDictionary, or use the NSPropertyListSerialization class.
● To load binary data files, use the methods of the NSData class.
● To load audio and video resources, use the classes of the Assets Library, Media Player, or AV Foundation
frameworks.
App-Related Resources
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gets the location of the file in the app’s bundle (also known as the main bundle here). The second line creates
a UIImage object using the data in the file at that location.
NSString* imagePath = [[NSBundle mainBundle] pathForResource:@"sun" ofType:@"png"];
UIImage* sunImage = [[UIImage alloc] initWithContentsOfFile:imagePath];
For more information about resources and how to access them from your app, see Resource Programming
Guide .
App-Related Resources
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implement some of the common behaviors found in iOS apps.
Creating a Universal App
A universal app is a single app that is optimized for iPhone, iPod touch, and iPad devices. Providing a single
binary that adapts to the current device offers the best user experience but, of course, involves extra work on
your part. Because of the differences in device screen sizes, most of your window, view, and view controller
code for iPad is likely to be very different from the code for iPhone and iPod touch. In addition, there are things
you must do to ensure your app runs correctly on each device type.
Xcode provides built-in support for configuring universal apps. When you create a new project, you can select
whether you want to create a device-specific project or a universal project. After you create your project, you
can change the supported set of devices for your app target using the Summary pane. When changing from
a single-device project to a universal project, you must fill in the information for the device type for which you
are adding support.
The following sections highlight the changes you must make to an existing app to ensure that it runssmoothly
on any type of device.
Updating Your Info.plist Settings
Most of the existing keys in a universal app’s Info.plist file should remain the same. However, for any keys
that require different values on iPhone versus iPad devices, you can add device modifiers to the key name.
When reading the keys of your Info.plist file, the system interprets each key using the following format:
key_root-~
In this format, the key_root portion represents the original name of the key. The  and 
portions are both optional endings that you can use for keys that are specific to a platform or device. For apps
that run only on iOS, you can omit the platform string. (The iphoneos platform string is used to distinguish
apps written for iOS from those written for Mac OS X.) To apply a key to a specific device, use one of the
following values:
● iphone—The key applies to iPhone devices.
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Advanced App Tricks● ipod—The key applies to iPod touch devices.
● ipad—The key applies to iPad devices.
For example, to indicate that you want your app to launch in a portrait orientation on iPhone and iPod touch
devices but in landscape-right on iPad, you would configure your Info.plist with the following keys:
UIInterfaceOrientation
UIInterfaceOrientationPortrait
UIInterfaceOrientation~ipad
UIInterfaceOrientationLandscapeRight
Notice that in the preceding example, there is an iPad-specific key and a default key without any device
modifiers. Continue to use the default key to specify the most common (or default) value and add a specific
version with a device-specific modifier when you need to change that value. This guarantees that there is
always a value available for the system to examine. For example, if you were to replace the default key with
an iPhone-specific and iPad-specific version of the UIInterfaceOrientation key, the system would not
know the preferred starting orientation for iPod devices.
For more information about the keys you can include in your Info.plist file, see Information Property List
Key Reference
Implementing Your View Controllers and Views
The largest amount of effort that goes into creating universal apps is designing your user interface. Because
of the different screen sizes, apps often need completely separate versions of their interface for each device
idiom. This means creating new view hierarchies but might also mean creating completely different view
controller objects to manage those views.
For views, the main modification is to redesign your view hierarchies to support the larger screen. Simply
scaling existing views may work but often yields poor results. Your new interface should make use of the
available space and take advantage of new interface elements where appropriate. Doing so is better because
it results in an interface that feels more natural to the user, and does not just feel like an iPhone app on a larger
screen.
For view controllers, follow these guidelines:
● Consider defining separate view controller classes for iPhone and iPad devices. Using separate view
controllers is often easier than trying to create one view controller that supports both platforms. If there
is a significant amount of shared code, you could always put the shared code in a base class and then
implement custom subclasses to address device-specific issues.
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If you use a single view controller class for both platforms, your code must support both iPhone and iPad
screen sizes. (For an app that uses nib files, this might mean choosing which nib file to load based on the
current device idiom.) Similarly, your view controller code must be able to handle differences between
the two platforms.
For views, follow these guidelines:
● Consider using separate sets of views for iPhone and iPad devices. For custom views, this means defining
different versions of your class for each device.
●
If you choose to use the same custom view for both devices, make sure your drawRect: and
layoutSubviews methods especially work properly on both devices.
For information about the view controllers you can use in your apps, see View Controller Programming Guide
for iOS .
Updating Your Resource Files
Because resource files are often used to implement portions of your app’s user interface, you need to make
the following changes:
●
In addition to the Default.png file displayed when your app launches on iPhone devices, you must add
new launch images for iPad devices as described in “Providing Launch Images for Different
Orientations” (page 101).
●
If you use images, you may need to add larger (or higher-resolution) versions to support iPad devices.
●
If you use storyboard or nib files, you need to provide a new set of files for iPad devices.
● You must size your app icons appropriately for iPad, as described in “App Icons” (page 98).
When using different resource files for each platform, you can conditionally load those resources just as you
would conditionally execute code. For more information about how to use runtime checks,see “Using Runtime
Checks to Create Conditional Code Paths” (page 110).
Using Runtime Checks to Create Conditional Code Paths
If your code needs to follow a different path depending on the underlying device type, use the
userInterfaceIdiom property of UIDevice to determine which path to take. This property provides an
indication of the style of interface to create: iPad or iPhone. Because this property is available only in iOS 3.2
and later, apps that support earlier versions of iOS need to check for the availability of this property before
accessing it. Of course, the simplest way to check this property is to use the UI_USER_INTERFACE_IDIOM
macro, which performs the necessary runtime checks for you.
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110if (UI_USER_INTERFACE_IDIOM() == UIUserInterfaceIdiomPad) {
// The device is an iPad running iOS 3.2 or later.
}
else {
// The device is an iPhone or iPod touch.
}
Supporting Multiple Versions of iOS
Any app that supports a range of iOS versions must use runtime checks to prevent the use of newer APIs on
older versions of iOS that do not support them. For example, if you build your app using new features in iOS
6 but your app still supports iOS 5, runtime checks allow you to use recently introduced features when they
are available and to follow alternate code paths when they are not. Failure to include such checks will cause
your app to crash when it tries to use new symbols that are not available on the older operating system.
There are several types of checks that you can make:
● To determine whether amethod is available on an existing class, use the instancesRespondToSelector:
class method or the respondsToSelector: instance method.
● Apps that link against iOS SDK 4.2 and later can use the weak linking support introduced in that version
of the SDK. This support lets you check for the existence of a given Class object to determine whether
you can use that class. For example:
if ([UIPrintInteractionController class]) {
// Create an instance of the class and use it.
}
else {
// The print interaction controller is not available.
}
To use this feature, you must build your app using LLVM and Clang and the app’s deployment target must
be set to iOS 3.1 or later.
● Appsthat link against iOS SDK 4.1 and earlier must use the NSClassFromString function to see whether
a class is defined. If the function returns a value other than nil, you may use the class. For example:
Class splitVCClass = NSClassFromString(@"UISplitViewController");
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{
UISplitViewController* mySplitViewController = [[splitVCClass alloc]
init];
// Configure the split view controller.
}
● To determine whether a C-based function is available, perform a Boolean comparison of the function name
to NULL. If the symbol is not NULL, you can use the function. For example:
if (UIGraphicsBeginPDFPage != NULL)
{
UIGraphicsBeginPDFPage();
}
For more information and examples of how to write code that supports multiple deployment targets, see SDK
Compatibility Guide .
Launching in Landscape Mode
Apps that uses only landscape orientations for their interface must explicitly ask the system to launch the app
in that orientation. Normally, apps launch in portrait mode and rotate their interface to match the device
orientation as needed. For apps that support both portrait and landscape orientations, always configure your
views for portrait mode and then let your view controllers handle any rotations. If, however, your app supports
landscape but not portrait orientations, perform the following tasks to make it launch in landscape mode
initially:
● Add the UIInterfaceOrientation key to your app’s Info.plist file and set the value of this key to
either UIInterfaceOrientationLandscapeLeft or UIInterfaceOrientationLandscapeRight.
● Lay out your views in landscape mode and make sure that their layout or autosizing options are set
correctly.
● Override your view controller’s shouldAutorotateToInterfaceOrientation: method and return
YES for the left or right landscape orientations and NO for portrait orientations.
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112Important:  Apps should always use view controllers to manage their window-based content.
The UIInterfaceOrientation key in the Info.plist file tells iOS that it should configure the orientation
of the app status bar (if one is displayed) as well as the orientation of views managed by any view controllers
at launch time. In iOS 2.1 and later, view controllers respect this key and set their view’s initial orientation to
match. Using this key is equivalent to calling the setStatusBarOrientation:animated: method of
UIApplication early in the execution of your applicationDidFinishLaunching: method.
Note:  To launch a view controller–based app in landscape mode in versions of iOS before 2.1, you
need to apply a 90-degree rotation to the transform of the app’s root view in addition to all the
preceding steps.
Installing App-Specific Data Files at First Launch
You can use your app’s first launch cycle to set up any data or configuration files required to run. App-specific
data files should be created in the Library/Application Support// directory of your app
sandbox, where  is your app’s bundle identifier. You can furthersubdivide this directory to organize
your data files as needed. You can also create files in other directories, such as to your app’s iCloud container
directory or to the local Documents directory, depending on your needs.
If your app’s bundle contains data filesthat you plan to modify, you must copy those files out of the app bundle
and modify the copies. You must not modify any files inside your app bundle. Because iOS apps are code
signed, modifying files inside your app bundle invalidates your app’s signature and prevents your app from
launching in the future. Copying those files to the Application Support directory (or another writable
directory in your sandbox) and modifying them there is the only way to use such files safely.
For more information about the directories of the iOS app sandbox and the proper location for files, see File
System Programming Guide .
Protecting Data Using On-Disk Encryption
In iOS 4 and later, apps can use the data protection feature to add a level of security to their on-disk data. Data
protection uses the built-in encryption hardware present on specific devices (such as the iPhone 3GS and
iPhone 4) to store files in an encrypted format on disk. While the user’s device is locked, protected files are
inaccessible even to the app that created them. The user must explicitly unlock the device (by entering the
appropriate passcode) at least once before your app can access one of its protected files.
Data protection is available on most iOS devices and is subject to the following requirements:
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113● The file system on the user’s device must support data protection. This is true for newer devices, but for
some earlier devices, the user might have to reformat the device’s disk and restore any content from a
backup.
● The user must have an active passcode lock set for the device.
To protect a file, your app must add an attribute to the file indicating the desired level of protection. Add this
attribute using either the NSData class or the NSFileManager class. When writing new files, you can use the
writeToFile:options:error: method of NSData with the appropriate protection value as one of the
write options. For existing files, you can use the setAttributes:ofItemAtPath:error: method of
NSFileManager to set or change the value of the NSFileProtectionKey. When using these methods, your
app can specify one of the following protection levels for the file:
● No protection—The file is not encrypted on disk. You can use this option to remove data protection from
an accessible file. Specify the NSDataWritingFileProtectionNone option (NSData) or the
NSFileProtectionNone attribute (NSFileManager).
● Complete—The file is encrypted and inaccessible while the device is locked. Specify the
NSDataWritingFileProtectionComplete option (NSData) or the NSFileProtectionComplete
attribute (NSFileManager).
● Complete unless already open—The file is encrypted. A closed file isinaccessible while the device islocked.
After the user unlocks the device, your app can open the file and use it. If the user locks the device while
the file is open, though, your app can continue to access it. Specify the
NSDataWritingFileProtectionCompleteUnlessOpen option (NSData) or the
NSFileProtectionCompleteUnlessOpen attribute (NSFileManager).
● Complete until first login—The file is encrypted and inaccessible until after the device has booted and the
user has unlocked it once. Specify the
NSDataWritingFileProtectionCompleteUntilFirstUserAuthentication option (NSData) or
the NSFileProtectionCompleteUntilFirstUserAuthentication attribute (NSFileManager).
If you protect a file, your app must be prepared to lose access to that file. When complete file protection is
enabled, even your app loses the ability to read and write the file’s contents when the user locks the device.
Your app has several options for tracking when access to protected files might change, though:
● The app delegate can implement the applicationProtectedDataWillBecomeUnavailable: and
applicationProtectedDataDidBecomeAvailable: methods.
● Any object can register for the UIApplicationProtectedDataWillBecomeUnavailable and
UIApplicationProtectedDataDidBecomeAvailable notifications.
● Any object can check the value of the protectedDataAvailable property of the shared UIApplication
object to determine whether files are currently accessible.
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using the writeToFile:options:error: method to write the contents of an NSData object to disk, this
happens automatically. For existing files, adding data protection replaces an unprotected file with a new
protected version.
Tips for Developing a VoIP App
A Voice over Internet Protocol (VoIP) app allows the user to make phone calls using an Internet connection
instead of the device’s cellular service. Such an app needs to maintain a persistent network connection to its
associated service so that it can receive incoming calls and other relevant data. Rather than keep VoIP apps
awake all the time, the system allowsthem to be suspended and providesfacilitiesfor monitoring theirsockets
for them. When incoming traffic is detected, the system wakes up the VoIP app and returns control of itssockets
to it.
There are several requirements for implementing a VoIP app:
1. Add the UIBackgroundModes key to your app’s Info.plist file. Set the value of this key to an array
that includes the voip string.
2. Configure one of the app’s sockets for VoIP usage.
3. Before moving to the background, call the setKeepAliveTimeout:handler: method to install a handler
to be executed periodically. Your app can use this handler to maintain its service connection.
4. Configure your audio session to handle transitions to and from active use.
5. To ensure a better user experience on iPhone, use the Core Telephony framework to adjust your behavior
in relation to cell-based phone calls; see Core Telephony Framework Reference .
6. To ensure good performance for your VoIP app, use the System Configuration framework to detect network
changes and allow your app to sleep as much as possible.
Including the voip value in the UIBackgroundModes key lets the system know that it should allow the app
to run in the background as needed to manage its network sockets. This key also permits your app to play
background audio (although including the audio value for the UIBackgroundModes key is still encouraged).
An app with this key is also relaunched in the background immediately after system boot to ensure that the
VoIP services are always available. For more information about the UIBackgroundModes key, see Information
Property List Key Reference .
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In order for your app to maintain a persistent connection while it is in the background, you must tag your app’s
main communication socket specifically for VoIP usage. Tagging this socket tells the system that it should take
over management of the socket when your app is suspended. The handoff itself is totally transparent to your
app. And when new data arrives on the socket, the system wakes up the app and returns control of the socket
so that the app can process the incoming data.
You need to tag only the socket you use for communicating with your VoIP service. This is the socket you use
to receive incoming calls or other data relevant to maintaining your VoIP service connection. Upon receipt of
incoming data, the handler for this socket needs to decide what to do. For an incoming call, you likely want
to post a local notification to alert the user to the call. For other noncritical data, though, you might just process
the data quietly and allow the system to put your app back into the suspended state.
In iOS, most sockets are managed using streams or other high-level constructs. To configure a socket for VoIP
usage, the only thing you have to do beyond the normal configuration is add a special key that tags the
interface as being associated with a VoIP service. Table 6-1 lists the stream interfaces and the configuration
for each.
Table 6-1 Configuring stream interfaces for VoIP usage
Interface Configuration
For Cocoa streams, use the setProperty:forKey: method to add the
NSStreamNetworkServiceType property to the stream. The value of
this property should be set to NSStreamNetworkServiceTypeVoIP.
NSInputStream and
NSOutputStream
When using the URL loading system, use the setNetworkServiceType:
method of your NSMutableURLRequest object to set the network service
type of the request. The service type should be set to
NSURLNetworkServiceTypeVoIP.
NSURLRequest
For Core Foundation streams, use the CFReadStreamSetProperty or
CFWriteStreamSetProperty function to add the
kCFStreamNetworkServiceType property to the stream. The value for
this property should be set to kCFStreamNetworkServiceTypeVoIP.
CFReadStreamRef and
CFWriteStreamRef
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116Note:  When configuring your sockets, you need to configure only your main signaling channel with
the appropriate service type key. You do not need to include this key when configuring your voice
channels.
Because VoIP apps need to stay running in order to receive incoming calls, the system automatically relaunches
the app if it exits with a nonzero exit code. (This type of exit could happen when there is memory pressure
and your app is terminated as a result.) However, terminating the app also releases all of its sockets, including
the one used to maintain the VoIP service connection. Therefore, when the app is launched, it always needs
to create its sockets from scratch.
Formore information about configuring Cocoa streamobjects,see StreamProgrammingGuide . Forinformation
about using URL requests,see URL Loading System Programming Guide . And for information about configuring
streams using the CFNetwork interfaces, see CFNetwork Programming Guide .
Installing a Keep-Alive Handler
To prevent the loss of its connection, a VoIP app typically needs to wake up periodically and check in with its
server. To facilitate this behavior, iOS lets you install a special handler using the
setKeepAliveTimeout:handler: method of UIApplication. You typically install this handler in the
applicationDidEnterBackground: method of your app delegate. Once installed, the system calls your
handler at least once before the timeout interval expires, waking up your app as needed to do so.
Your keep-alive handler executes in the background and should return as quickly as possible. Handlers are
given a maximum of 10 seconds to perform any needed tasks and return. If a handler has not returned after
10 seconds, or has not requested extra execution time before that interval expires, the system suspends the
app.
When installing your handler, specify the largest timeout value that is practical for your app’s needs. The
minimum allowable interval for running your handler is 600 seconds, and attempting to install a handler with
a smaller timeout value will fail. Although the system promises to call your handler block before the timeout
value expires, it does not guarantee the exact call time. To improve battery life, the system typically groups
the execution of your handler with other periodic system tasks, thereby processing all tasks in one quick burst.
As a result, your handler code must be prepared to run earlier than the actual timeout period you specified.
Configuring Your App’s Audio Session
As with any background audio app, the audio session for a VoIP app must be configured properly to ensure
the app works smoothly with other audio-based apps. Because audio playback and recording for a VoIP app
are not used all the time, it is especially important that you create and configure your app’s audio session
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117object only when it is needed. For example, you would create the audio session to notify the user of an incoming
call or while the user was actually on a call. As soon as the call ends, you would then remove strong references
to the audio session and give other audio apps the opportunity to play their audio.
For information about how to configure and manage an audio session for a VoIP app, see Audio Session
Programming Guide .
Using the Reachability Interfaces to Improve the User Experience
Because VoIP apps rely heavily on the network, they should use the reachability interfaces of the System
Configuration framework to track network availability and adjust their behavior accordingly. The reachability
interfaces allow an app to be notified whenever network conditions change. For example, a VoIP app could
close its network connections when the network becomes unavailable and recreate them when it becomes
available again. The app could also use those kinds of changes to keep the user apprised about the state of
the VoIP connection.
To use the reachability interfaces, you must register a callback function with the framework and use it to track
changes. To register a callback function:
1. Create a SCNetworkReachabilityRef structure for your target remote host.
2. Assign a callback function to yourstructure (using the SCNetworkReachabilitySetCallback function)
that processes changes in your target’s reachability status.
3. Add that target to an active run loop of your app (such as the main run loop) using the
SCNetworkReachabilityScheduleWithRunLoop function.
Adjusting your app’s behavior based on the availability of the network can also help improve the battery life
of the underlying device. Letting the system track the network changes means that your app can let itself go
to sleep more often.
For more information about the reachability interfaces, see System Configuration Framework Reference .
Communicating with Other Apps
Apps that support custom URL schemes can use those schemes to receive messages. Some apps use URL
schemes to initiate specific requests. For example, an app that wants to show an address in the Maps app can
use a URL to launch that app and display the address. You can implement your own URL schemes to facilitate
similar types of communications in your apps.
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URLs targeted at the Maps, YouTube, and iPod apps. The handlers for these schemes are fixed and cannot be
changed. If your URL type includes a scheme that is identical to one defined by Apple, the Apple-provided app
is launched instead of your app.
Note:  If more than one third-party app registers to handle the same URL scheme, there is currently
no process for determining which app will be given that scheme.
To communicate with an app using a custom URL, create an NSURL object with some properly formatted
content and pass that object to the openURL: method of the shared UIApplication object. The openURL:
method launches the app that registered to receive URLs of that type and passes it the URL. At that point,
control passes to the new app.
The following code fragment illustrates how one app can request the services of another app (“todolist” in this
example is a hypothetical custom scheme registered by an app):
NSURL *myURL = [NSURL
URLWithString:@"todolist://www.acme.com?Quarterly%20Report#200806231300"];
[[UIApplication sharedApplication] openURL:myURL];
If your app defines a custom URL scheme, it should implement a handler for that scheme as described in
“Implementing Custom URL Schemes” (page 119). For more information about the system-supported URL
schemes, including information about how to format the URLs, see Apple URL Scheme Reference .
Implementing Custom URL Schemes
If your app can receive specially formatted URLs, you should register the corresponding URL schemes with the
system. A custom URL scheme is a mechanism through which third-party apps can communicate with each
other. Apps often use custom URL schemesto vend servicesto other apps. For example, the Maps app supports
URLs for displaying specific map locations.
Registering Custom URL Schemes
To register a URL type for your app, include the CFBundleURLTypes key in your app’s Info.plist file. The
CFBundleURLTypes key contains an array of dictionaries, each of which defines a URL scheme the app
supports. Table 6-2 describes the keys and values to include in each dictionary.
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119Table 6-2 Keys and values of the CFBundleURLTypes property
Key Value
A string containing the abstract name of the URL scheme. To ensure
uniqueness, it is recommended that you specify a reverse-DNS style of
identifier, for example, com.acme.myscheme.
The string you specify is also used as a key in your app’s
InfoPlist.strings file. The value of the key is the human-readable
scheme name.
CFBundleURLName
An array of strings containing the URL scheme names—for example, http,
mailto, tel, and sms.
CFBundleURLSchemes
Figure 6-1 shows the Info.plist file of an app that supports a custom scheme for creating “to-do” items.
The URL types entry corresponds to the CFBundleURLTypes key added to the Info.plist file. Similarly,
the “URL identifier” and “URL Schemes” entries correspond to the CFBundleURLName and
CFBundleURLSchemes keys.
Figure 6-1 Defining a custom URL scheme in the Info.plist file
Handling URL Requests
An app that has its own custom URL scheme must be able to handle URLs passed to it. All URLs are passed to
your app delegate, either at launch time or while your app isrunning or in the background. To handle incoming
URLs, your delegate should implement the following methods:
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application:didFinishLaunchingWithOptions: methods to retrieve information about the URL
and decide whether you want to open it. If either method returns NO, your app’s URL handling code is not
called.
●
In iOS 4.2 and later, use the application:openURL:sourceApplication:annotation: method to
open the file.
●
In iOS 4.1 and earlier, use the application:handleOpenURL: method to open the file.
If your app is not running when a URL request arrives, it is launched and moved to the foreground so that it
can open the URL. The implementation of your application:willFinishLaunchingWithOptions: or
application:didFinishLaunchingWithOptions: method should retrieve the URL from its options
dictionary and determine whether the app can open it. If it can, return YES and let your
application:openURL:sourceApplication:annotation: (or application:handleOpenURL:)
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121method handle the actual opening of the URL. (If you implement both methods, both must return YES before
the URL can be opened.) Figure 6-2 shows the modified launch sequence for an app that is asked to open a
URL.
Figure 6-2 Launching an app to open a URL
If your app is running but is in the background or suspended when a URL request arrives, it is moved to the
foreground to open the URL. Shortly thereafter, the system calls the delegate’s
application:openURL:sourceApplication:annotation: to check the URL and open it. If your delegate
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122does not implement this method (or the current system version is iOS 4.1 or earlier), the system calls your
delegate’s application:handleOpenURL: method instead. Figure 6-3 shows the modified process for
moving an app to the foreground to open a URL.
Figure 6-3 Waking a background app to open a URL
Note:  Apps that support custom URL schemes can specify different launch images to be displayed
when launching the app to handle a URL. For more information about how to specify these launch
images, see “Providing Launch Images for Custom URL Schemes” (page 103).
All URLs are passed to your app in an NSURL object. It is up to you to define the format of the URL, but the
NSURL class conforms to the RFC 1808 specification and therefore supports most URL formatting conventions.
Specifically, the class includes methods that return the various parts of a URL as defined by RFC 1808, including
the user, password, query, fragment, and parameter strings. The “protocol” for your custom scheme can use
these URL parts for conveying various kinds of information.
In the implementation of application:handleOpenURL: shown in Listing 6-1, the passed-in URL object
conveys app-specific information in its query and fragment parts. The delegate extracts this information—in
this case, the name of a to-do task and the date the task is due—and with it creates a model object of the app.
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you need to design your URL scheme accordingly and be prepared to handle those other calendar types in
your code.
Listing 6-1 Handling a URL request based on a custom scheme
- (BOOL)application:(UIApplication *)application handleOpenURL:(NSURL *)url {
if ([[url scheme] isEqualToString:@"todolist"]) {
ToDoItem *item = [[ToDoItem alloc] init];
NSString *taskName = [url query];
if (!taskName || ![self isValidTaskString:taskName]) { // must have a task
name
return NO;
}
taskName = [taskName
stringByReplacingPercentEscapesUsingEncoding:NSUTF8StringEncoding];
item.toDoTask = taskName;
NSString *dateString = [url fragment];
if (!dateString || [dateString isEqualToString:@"today"]) {
item.dateDue = [NSDate date];
} else {
if (![self isValidDateString:dateString]) {
return NO;
}
// format: yyyymmddhhmm (24-hour clock)
NSString *curStr = [dateString substringWithRange:NSMakeRange(0, 4)];
NSInteger yeardigit = [curStr integerValue];
curStr = [dateString substringWithRange:NSMakeRange(4, 2)];
NSInteger monthdigit = [curStr integerValue];
curStr = [dateString substringWithRange:NSMakeRange(6, 2)];
NSInteger daydigit = [curStr integerValue];
curStr = [dateString substringWithRange:NSMakeRange(8, 2)];
NSInteger hourdigit = [curStr integerValue];
curStr = [dateString substringWithRange:NSMakeRange(10, 2)];
NSInteger minutedigit = [curStr integerValue];
Advanced App Tricks
Implementing Custom URL Schemes
2012-09-19   |   © 2012 Apple Inc. All Rights Reserved.
124NSDateComponents *dateComps = [[NSDateComponents alloc] init];
[dateComps setYear:yeardigit];
[dateComps setMonth:monthdigit];
[dateComps setDay:daydigit];
[dateComps setHour:hourdigit];
[dateComps setMinute:minutedigit];
NSCalendar *calendar = [s[NSCalendar alloc]
initWithCalendarIdentifier:NSGregorianCalendar];
NSDate *itemDate = [calendar dateFromComponents:dateComps];
if (!itemDate) {
return NO;
}
item.dateDue = itemDate;
}
[(NSMutableArray *)self.list addObject:item];
return YES;
}
return NO;
}
Be sure to validate the input you get from URLs passed to your app; see “Validating Input and Interprocess
Communication” in Secure Coding Guide to find out how to avoid problems related to URL handling. To learn
about URL schemes defined by Apple, see Apple URL Scheme Reference .
Showing and Hiding the Keyboard
The appearance of the keyboard is tied to the responder status of views. If a view is able to become the first
responder, the system shows the keyboard whenever that view actually becomes the first responder. When
the user taps another view that does not support becoming the first responder, the system hides the keyboard
if it is currently visible. In UIKit, only views that support text entry can become the first responder by default.
Other views must override the canBecomeFirstResponder method and return YES if they want the keyboard
to be shown.
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for viewsthatsupport custom forms of input. Every responder object has an inputView property that contains
the view to be displayed when the responder becomes the first responder. When this property is nil, the
system displaysthe standard keyboard. When this property is not nil, the system displaysthe view you provide
instead.
Normally, user taps dictate which view becomes the first responder in your app, but you can force a view to
become the first responder too. Calling the becomeFirstResponder method any responder object causes
that object to try to become the first responder. If that responder object is able to become the first responder,
the custom input view (or the standard keyboard) is shown automatically.
For more information about using the keyboard, see Text, Web, and Editing Programming Guide for iOS .
Turning Off Screen Locking
If an iOS-based device does not receive touch events for a specified period of time, the system turns off the
screen and disables the touch sensor. Locking the screen is an important way to save power. As a result, you
should generally leave this feature enabled. However, for an app that does not rely on touch events, such as
a game that uses the accelerometers for input, disable screen locking to prevent the screen from going dark
while the app is running. However, even in this case, disable screen locking only while the user is actively
engaged with the app. For example, if the user pauses a game, reenable screen locking to allow the screen to
turn off.
To disable screen locking, set the idleTimerDisabled property of the shared UIApplication object to
YES. Be sure to reset this property to NO when your app does not need to prevent screen locking.
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the overall performance of your app. The operating environment for iOS apps is more constrained than that
for Mac OS X apps. The following sections describe the factors you should consider throughout the development
process.
Make App Backups More Efficient
Backups occur wirelessly via iCloud or when the user syncs the device with iTunes. During backups, files are
transferred from the device to the user’s computer or iCloud account. The location of files in your app sandbox
determines whether or not those files are backed up and restored. If your application creates many large files
that change regularly and putsthem in a location that is backed up, backups could be slowed down as a result.
As you write your file-management code, you need to be mindful of this fact.
App Backup Best Practices
You do not have to prepare your app in any way for backup and restore operations. Devices with an active
iCloud account have their app data backed up to iCloud at appropriate times. And for devices that are plugged
into a computer, iTunes performs an incremental backup of the app’s data files. However, iCloud and iTunes
do not back up the contents of the following directories:
● /AppName.app
● /Library/Caches
● /tmp
To prevent the syncing process from taking a long time, be selective about where you place files inside your
app’s home directory. Apps that store large files can slow down the process of backing up to iTunes or iCloud.
These apps can also consume a large amount of a user's available storage, which may encourage the user to
delete the app or disable backup of that app's data to iCloud. With this in mind, you should store app data
according to the following guidelines:
● Critical data should be stored in the /Documents directory. Critical data is any data
that cannot be recreated by your app, such as user documents and other user-generated content.
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Performance Tuning● Support files include files your application downloads or generates and that your application can recreate
as needed. The location for storing your application’s support files depends on the current iOS version.
●
In iOS 5.1 and later,store supportfilesin the /Library/Application Support
directory and add the NSURLIsExcludedFromBackupKey attribute to the corresponding NSURL
object using the setResourceValue:forKey:error: method. (If you are using Core Foundation,
add the kCFURLIsExcludedFromBackupKey key to your CFURLRef object using the
CFURLSetResourcePropertyForKey function.) Applying this attribute preventsthe filesfrom being
backed up to iTunes or iCloud. If you have a large number of support files, you may store them in a
custom subdirectory and apply the extended attribute to just the directory.
●
In iOS 5.0 and earlier, store support files in the /Library/Caches directory to
prevent them from being backed up. If you are targeting iOS 5.0.1, see How do I prevent files from
being backed up to iCloud and iTunes? for information about how to exclude files from backups.
● Cached data should be stored in the /Library/Caches directory. Examples of files
you should put in the Caches directory include (but are not limited to) database cache files and
downloadable content, such as that used by magazine, newspaper, and map apps. Your app should be
able to gracefully handle situations where cached data is deleted by the system to free up disk space.
● Temporary data should be stored in the /tmp directory. Temporary data comprises
any data that you do not need to persist for an extended period of time. Remember to delete those files
when you are done with them so that they do not continue to consume space on the user's device.
Although iTunes backs up the app bundle itself, it does not do this during every sync operation. Apps purchased
directly from a device are backed up when that device is next synced with iTunes. Apps are not backed up
during subsequent sync operations, though, unless the app bundle itself has changed (because the app was
updated, for example).
For additional guidance about how you should use the directories in your app, see File System Programming
Guide .
Files Saved During App Updates
When a user downloads an app update, iTunes installs the update in a new app directory. It then moves the
user’s data files from the old installation over to the new app directory before deleting the old installation.
Files in the following directories are guaranteed to be preserved during the update process:
● /Documents
● /Library
Although files in other user directories may also be moved over, you should not rely on them being present
after an update.
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Because the iOS virtual memory model does not include disk swap space, apps are more limited in the amount
of memory they have available for use. Using large amounts of memory can seriously degrade system
performance and potentially cause the system to terminate your app. In addition, apps running under
multitasking must share system memory with all other running apps. Therefore, make it a high priority to
reduce the amount of memory used by your app.
There is a direct correlation between the amount of free memory available and the relative performance of
your app. Less free memory means that the system is more likely to have trouble fulfilling future memory
requests. If that happens, the system can always remove suspended apps, code pages, or other nonvolatile
resources from memory. However, removing those apps and resources from memory may be only a temporary
fix, especially if they are needed again a short time later. Instead, minimize your memory use in the first place,
and clean up the memory you do use in a timely manner.
The following sections provide more guidance on how to use memory efficiently and how to respond when
there is only a small amount of available memory.
Observe Low-Memory Warnings
When the system dispatches a low-memory warning to your app, respond immediately. iOS notifies all running
apps whenever the amount of free memory dips below a safe threshold. (It does not notify suspended apps.)
If your app receives this warning, it must free up as much memory as possible. The best way to do this is to
remove strong references to caches, image objects, and other data objects that can be recreated later.
UIKit provides several ways to receive low-memory warnings, including the following:
●
Implement the applicationDidReceiveMemoryWarning: method of your app delegate.
● Override the didReceiveMemoryWarning method in your custom UIViewController subclass.
● Register to receive the UIApplicationDidReceiveMemoryWarningNotificationnotification.
Upon receiving any of these warnings, your handler method should respond by immediately freeing up any
unneeded memory. For example, the default behavior of the UIViewController class is to purge its view if
that view is not currently visible; subclasses can supplement the default behavior by purging additional data
structures. An app that maintains a cache of images might respond by releasing any images that are not
currently onscreen.
If your data model includes known purgeable resources, you can have a corresponding manager object register
forthe UIApplicationDidReceiveMemoryWarningNotification notification and remove strong references
to its purgeable resources directly. Handling this notification directly avoids the need to route all memory
warning calls through the app delegate.
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129Note:  You can test your app’s behavior under low-memory conditions using the Simulate Memory
Warning command in iOS Simulator.
Reduce Your App’s Memory Footprint
Starting off with a low footprint gives you more room for expanding your app later. Table 7-1 lists some tips
on how to reduce your app’s overall memory footprint.
Table 7-1 Tips for reducing your app’s memory footprint
Tip Actions to take
Because memory is a critical resource in iOS, your app should have no memory
leaks. You can use the Instruments app to track down leaks in your code, both
in Simulator and on actual devices. For more information on using Instruments,
see Instruments User Guide .
Eliminate memory
leaks.
Files reside on disk but must be loaded into memory before they can be used.
Property list files and images can be made smaller with some very simple
actions. To reduce the space used by property list files, write those files out
in a binary format using the NSPropertyListSerialization class. For
images, compress all image files to make them as small as possible. (To
compress PNG images—the preferred image format for iOS apps—use the
pngcrush tool.)
Make resource files as
small as possible.
If your app manipulates large amounts of structured data, store it in a Core
Data persistent store or in a SQLite database instead of in a flat file. Both Core
Data and SQLite provides efficient ways to manage large data sets without
requiring the entire set to be in memory all at once.
The Core Data framework was introduced in iOS 3.0.
Use Core Data or
SQLite for large data
sets.
You should never load a resource file until it is actually needed. Prefetching
resource files may seem like a way to save time, but this practice actually slows
down your app right away. In addition, if you end up not using the resource,
loading it wastes memory for no good purpose.
Load resources lazily.
Adding the -mthumb compiler flag can reduce the size of your code by up to
35%. However, if your app contains floating-point–intensive code modules
and you are building your app for ARMv6, you should disable the Thumb
option. If you are building your code for ARMv7, you should leave Thumb
enabled.
Build your program
using the Thumb
option.
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Table 7-2 lists tips for improving memory usage in your app.
Table 7-2 Tips for allocating memory
Tip Actions to take
With automatic reference counting (ARC), it is better to alloc/init objects and
let the compiler release them for you at the appropriate time. This is true even
for temporary objects that in the past you might have autoreleased to prevent
them from living past the scope of the current method.
Reduce your use of
autoreleased
objects.
Avoid loading a large resource file when a smaller one will do. Instead of using
a high-resolution image, use one that is appropriately sized for iOS-based
devices. If you must use large resource files, find ways to load only the portion
of the file that you need at any given time. For example, rather than load the
entire file into memory, use the mmap and munmap functions to map portions
of the file into and out of memory. For more information about mapping files
into memory, see File-System Performance Guidelines.
Impose size limits on
resources.
Unbounded problem sets might require an arbitrarily large amount of data to
compute. If the set requires more memory than is available, your app may be
unable to complete the calculations. Your appsshould avoid such sets whenever
possible and work on problems with known memory limits.
Avoid unbounded
problem sets.
For detailed information about ARC and memory management, see Transitioning to ARC Release Notes.
Move Work off the Main Thread
Be sure to limit the type of work you do on the main thread of your app. The main thread is where your app
handlestouch events and other user input. To ensure that your app is alwaysresponsive to the user, you should
never use the main thread to perform long-running or potentially unbounded tasks, such as tasks that access
the network. Instead, you should always move those tasks onto background threads. The preferred way to do
so is to use Grand Central Dispatch (GCD) or operation objects to perform tasks asynchronously.
Moving tasks into the background leaves your main thread free to continue processing user input, which is
especially important when your app is starting up or quitting. During these times, your app is expected to
respond to events in a timely manner. If your app’s main thread is blocked at launch time, the system could
kill the app before it even finishes launching. If the main thread is blocked at quitting time, the system could
similarly kill the app before it has a chance to write out crucial user data.
For more information about using GCD, operation objects, and threads, see Concurrency Programming Guide .
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The processors found in iOS-based devices are capable of performing floating-point calculations in hardware.
If you have an existing program that performs calculations using a software-based fixed-point math library,
you should consider modifying your code to use floating-point math instead. Hardware-based floating-point
computations are typically much faster than their software-based fixed-point equivalents.
Important:  If you build your app for ARMv6 and your code uses floating-point math extensively, compile
that code without the -mthumb compiler option. The Thumb option can reduce the size of code modules,
but it can also degrade the performance of floating-point code. If you build your app for ARMv7, you should
always enable the Thumb option.
In iOS 4 and later, you can also use the functions of the Accelerate framework to perform complex mathematical
calculations. Thisframework contains high-performance vector-accelerated librariesfor digitalsignal processing
and linear algebra mathematics. You can apply these librariesto problemsinvolving audio and video processing,
physics, statistics, cryptography, and complex algebraic equations.
Reduce Power Consumption
Power consumption on mobile devices is always an issue. The power management system in iOS conserves
power by shutting down any hardware featuresthat are not currently being used. You can help improve battery
life by optimizing your use of the following features:
● The CPU
● Wi-Fi, Bluetooth, and baseband (EDGE, 3G) radios
● The Core Location framework
● The accelerometers
● The disk
The goal of your optimizations should be to do the most work you can in the most efficient way possible. You
should always optimize your app’s algorithms using Instruments. But even the most optimized algorithm can
still have a negative impact on a device’s battery life. You should therefore consider the following guidelines
when writing your code:
● Avoid doing work that requires polling. Polling prevents the CPU from going to sleep. Instead of polling,
use the NSRunLoop or NSTimer classes to schedule work as needed.
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132● Leave the idleTimerDisabled property of the shared UIApplication object set to NO whenever
possible. The idle timer turns off the device’s screen after a specified period of inactivity. If your app does
not need the screen to stay on, let the system turn it off. If your app experiences side effects as a result of
the screen being turned off, you should modify your code to eliminate the side effects rather than disable
the idle timer unnecessarily.
● Coalesce work whenever possible to maximize idle time. It generally takes less power to perform a set of
calculations all at once than it does to perform them in small chunks over an extended period of time.
Doing small bits of work periodically requires waking up the CPU more often and getting it into a state
where it can perform your tasks.
● Avoid accessing the disk too frequently. For example, if your app saves state information to the disk, do
so only when that state information changes, and coalesce changes whenever possible to avoid writing
small changes at frequent intervals.
● Do not draw to the screen faster than is needed. Drawing is an expensive operation when it comes to
power. Do not rely on the hardware to throttle your frame rates. Draw only as many frames as your app
actually needs.
●
If you use the UIAccelerometer class to receive regular accelerometer events, disable the delivery of
those events when you do not need them. Similarly, set the frequency of event delivery to the smallest
value that is suitable for your needs. For more information, see Event Handling Guide for iOS .
The more data you transmit to the network, the more power must be used to run the radios. In fact, accessing
the network is the most power-intensive operation you can perform. You can minimize that time by following
these guidelines:
● Connect to external network servers only when needed, and do not poll those servers.
● When you must connect to the network, transmit the smallest amount of data needed to do the job. Use
compact data formats, and do not include excess content that simply is ignored.
● Transmit data in bursts rather than spreading out transmission packets over time. The system turns off
the Wi-Fi and cell radios when it detects a lack of activity. When it transmits data over a longer period of
time, your app uses much more power than when it transmitsthe same amount of data in a shorter amount
of time.
● Connect to the network using the Wi-Fi radios whenever possible. Wi-Fi uses less power and is preferred
over cellular radios.
●
If you use the Core Location framework to gather location data, disable location updates as soon as you
can and set the distance filter and accuracy levels to appropriate values. Core Location uses the available
GPS, cell, and Wi-Fi networks to determine the user’s location. Although Core Location works hard to
minimize the use of these radios, setting the accuracy and filter values gives Core Location the option to
turn off hardware altogether in situations where it is not needed. For more information, see Location
Awareness Programming Guide .
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133The Instruments app includes several instruments for gathering power-related information. You can use these
instruments to gather general information about power consumption and to gather specific measurements
for hardware such as the Wi-Fi and Bluetooth radios, GPS receiver, display, and CPU. For more information
about using these instruments, see Instruments User Guide .
Tune Your Code
iOS comes with several apps for tuning the performance of your app. Most of these tools run on Mac OS X and
are suitable for tuning some aspects of your code while it runs in iOS Simulator. For example, you can use
Simulator to eliminate memory leaks and make sure your overall memory usage is as low as possible. You can
also remove any computational hotspots in your code that might be caused by an inefficient algorithm or a
previously unknown bottleneck.
After you have tuned your code in Simulator, you should then use the Instruments app to further tune your
code on a device. Running your code on an actual device is the only way to tune your code fully. Because
Simulator runs in Mac OS X, it has the advantage of a faster CPU and more usable memory, so its performance
is generally much better than the performance on an actual device. And using Instruments to trace your code
on an actual device may point out additional performance bottlenecks that need tuning.
For more information on using Instruments, see Instruments User Guide .
Improve File Access Times
Minimize the amount of data you write to the disk. File operations are relatively slow and involve writing to
the flash drive, which has a limited lifespan. Some specific tips to help you minimize file-related operations
include:
● Write only the portions of the file that changed, and aggregate changes when you can. Avoid writing out
the entire file just to change a few bytes.
● When defining your file format, group frequently modified content together to minimize the overall
number of blocks that need to be written to disk each time.
●
If your data consists of structured content that is randomly accessed, store it in a Core Data persistent
store or a SQLite database, especially if the amount of data you are manipulating could grow to more than
a few megabytes.
Avoid writing cache files to disk. The only exception to this rule is when your app quits and you need to write
state information that can be used to put your app back into the same state when it is next launched.
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The networking stack in iOS includes several interfaces for communicating over the radio hardware of iOS
devices. The main programming interface is the CFNetwork framework, which builds on top of BSD sockets and
opaque types in the Core Foundation framework to communicate with network entities. You can also use the
NSStream classes in the Foundation framework and the low-level BSD sockets found in the Core OS layer of
the system.
For information about how to use the CFNetwork framework for network communication, see CFNetwork
Programming Guide and CFNetwork Framework Reference . For information about using the NSStream class,
see Foundation Framework Reference .
Tips for Efficient Networking
Implementing code to receive or transmit data acrossthe network is one of the most power-intensive operations
on a device. Minimizing the amount of time spent transmitting or receiving data helps improve battery life.
To that end, you should consider the following tips when writing your network-related code:
● For protocols you control, define your data formats to be as compact as possible.
● Avoid using chatty protocols.
● Transmit data packets in bursts whenever you can.
Cellular and Wi-Fi radios are designed to power down when there is no activity. Depending on the radio,
though, doing so can take several seconds. If your app transmits small bursts of data every few seconds, the
radios may stay powered up and continue to consume power, even when they are not actually doing anything.
Rather than transmit small amounts of data more often, it is better to transmit a larger amount of data once
or at relatively large intervals.
When communicating over the network, packets can be lost at any time. Therefore, when writing your
networking code, you should be sure to make it as robust as possible when it comes to failure handling. It is
perfectly reasonable to implement handlers that respond to changes in network conditions, but do not be
surprised if those handlers are not called consistently. For example, the Bonjour networking callbacks may not
always be called immediately in response to the disappearance of a network service. The Bonjour system
service immediately invokes browsing callbacks when it receives a notification that a service is going away,
but network services can disappear without notification. This situation might occur if the device providing the
network service unexpectedly loses network connectivity or the notification is lost in transit.
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If your app accesses the network using the Wi-Fi radios, you must notify the system of that fact by including
the UIRequiresPersistentWiFi key in the app’s Info.plist file. The inclusion of this key lets the system
know that it should display the network selection dialog if it detects any active Wi-Fi hot spots. It also lets the
system know that it should not attempt to shut down the Wi-Fi hardware while your app is running.
To prevent the Wi-Fi hardware from using too much power, iOS has a built-in timer that turns off the hardware
completely after 30 minutesif no running app hasrequested its use through the UIRequiresPersistentWiFi
key. If the user launches an app that includes the key, iOS effectively disables the timer for the duration of the
app’s life cycle. As soon as that app quits or is suspended, however, the system reenables the timer.
Note:  Note that even when UIRequiresPersistentWiFi has a value of true, it has no effect
when the device is idle (that is, screen-locked). The app is considered inactive, and although it may
function on some levels, it has no Wi-Fi connection.
For more information on the UIRequiresPersistentWiFi key and the keys of the Info.plist file, see
Figure 6-1 (page 120).
The Airplane Mode Alert
If your app launches while the device is in airplane mode, the system may display an alert to notify the user
of that fact. The system displays this alert only when all of the following conditions are met:
● Your app’s information property list (Info.plist) file contains the UIRequiresPersistentWiFi key
and the value of that key is set to true.
● Your app launches while the device is currently in airplane mode.
● Wi-Fi on the device has not been manually reenabled after the switch to airplane mode.
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136The iOS environment affects several aspects of how you design your app. Understanding some key aspects
should help you when writing your code.
Specialized System Behaviors
The iOS system is based on the same technologies used by Mac OS X, namely the Mach kernel and BSD
interfaces. Thus, iOS apps run in a UNIX-based system and have full support for threads, sockets, and many of
the other technologies typically available at that level. However, there are places where the behavior of iOS
differs from that of Mac OS X.
The Virtual Memory System
To manage program memory, iOS uses essentially the same virtual memory system found in Mac OS X. In iOS,
each program still hasits own virtual addressspace, but unlike Mac OS X, the amount of usable virtual memory
is constrained by the amount of physical memory available. This is because iOS does not support paging to
disk when memory getsfull. Instead, the virtual memory system simply releasesread-only memory pages,such
as code pages, when it needs more space. Such pages can always be loaded back into memory later if they
are needed again.
If memory continues to be constrained, the system may send low-memory notifications to any running apps,
asking them to free up additional memory. All apps should respond to this notification and do their part to
help relieve the memory pressure. For information on how to handle such notificationsin your app,see “Observe
Low-Memory Warnings” (page 129).
The Automatic Sleep Timer
One way iOS saves battery power is through the automatic sleep timer. When the system does not detect
touch events for an extended period of time, it dims the screen initially and eventually turns it off altogether.
If you are creating an app that does not use touch inputs, such as a game that relies on the accelerometers,
you can disable the automatic sleep timer to prevent the screen from dimming. You should use this timer
sparingly and reenable it as soon as possible to conserve power. Only apps that display visual content and do
not rely on touch inputs should ever disable the timer. Audio apps or apps that do not need to present visual
content should not disable the timer.
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The iOS EnvironmentThe process for disabling the timer is described in “Turning Off Screen Locking” (page 126). For additional tips
on how to save power in your app, see “Reduce Power Consumption” (page 132).
Multitasking Support
In iOS 4 and later, multitasking allows apps to run in the background even when they are not visible on the
screen. Most background appsreside in memory but do not actually execute any code. These apps are suspended
by the system shortly after entering the background to preserve battery life. Apps can ask the system for
background execution time in a number of ways, though.
For an overview of multitasking and what you need to do to support it, see “Background Execution and
Multitasking” (page 54).
Security
The security infrastructure in iOS isthere to protect your app’s data and the system as a whole. Security breaches
can and will happen, so the first line of defense in iOS is to minimize the damage caused by such breaches by
securing each app separately in its own sandbox. But iOS provides other technologies, such as encryption and
certificate support, to help you protect your data at an even more fundamental level.
For an introduction to security and how it impacts the design of your app, see Security Overview.
The App Sandbox
For security reasons, iOS places each app (including its preferences and data) in a sandbox at install time. A
sandbox is a set of fine-grained controls that limit the app’s access to files, preferences, network resources,
hardware, and so on. As part of the sandboxing process, the system installs each app in its own sandbox
directory, which acts as the home for the app and its data.
The iOS Environment
Security
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files. Figure A-1 shows the basic layout of a sandbox directory. For detailed information about the sandbox
directory and what belongs in each of its subdirectories, see File System Programming Guide .
Figure A-1 Sandbox directories in iOS
The iOS Environment
Security
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139Important:  The purpose of a sandbox is to limit the damage that a compromised app can cause to the
system. Sandboxes do not prevent attacksfrom happening to a particular app and it isstill your responsibility
to code defensively to prevent attacks. For example, if your app does not validate user input and there is
an exploitable buffer overflow in your input-handling code, an attacker could still hijack your app or cause
it to crash. The sandbox only prevents the hijacked app from affecting other apps and other parts of the
system.
Keychain Data
A keychain is a secure, encrypted container for passwords and other secrets. The keychain is intended for
storing small amounts of sensitive data that are specific to your app. It is not intended as a general-purpose
mechanism for encrypting and storing data.
Keychain data for an app isstored outside of the app’ssandbox. When the user backs up app data using iTunes,
the keychain data is also backed up. Before iOS 4.0, keychain data could only be restored to the device from
which the backup was made. In iOS 4.0 and later, a keychain item that is password protected can be restored
to a different device only if its accessibility is not set to kSecAttrAccessibleAlwaysThisDeviceOnly or
any other value that restricts it to the current device. Upgrading an app does not affect that app’s keychain
data.
For more on the iOS keychain, see “Keychain Services Concepts” in Keychain Services Programming Guide .
The iOS Environment
Security
2012-09-19   |   © 2012 Apple Inc. All Rights Reserved.
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Date Notes
2012-09-19 Contains information about new features in iOS 6.
Added information about the NSURL and CFURL keys used to prevent a
file from being backed up.
2012-03-07
Updated the section that describes the behavior of apps in the
background.
2012-01-09
2011-10-12 Added information about features introduced in iOS 5.0.
Reorganized book and added more design-level information.
Added high-level information about iCloud and how it impactsthe design
of applications.
2011-02-24 Added information about using AirPlay in the background.
2010-12-13 Made minor editorial changes.
2010-11-15 Incorporated additional iPad-related design guidelinesinto this document.
Updated the information about how keychain data is preserved and
restored.
Fixed several typographical errors and updated the code sample on
initiating background tasks.
2010-08-20
Updated the guidance related to specifying application icons and launch
images.
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Changed the title from iPhone Application Programming Guide .
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Document Revision HistoryDate Notes
Reorganized the book so that it focuses on the design of the core parts
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Tables and ListingsConcurrency is the notion of multiple things happening at the same time. With the proliferation of multicore
CPUs and the realization that the number of cores in each processor will only increase, software developers
need new ways to take advantage of them. Although operating systems like OS X and iOS are capable of
running multiple programs in parallel, most of those programs run in the background and perform tasks that
require little continuous processor time. It is the current foreground application that both captures the user’s
attention and keeps the computer busy. If an application has a lot of work to do but keeps only a fraction of
the available cores occupied, those extra processing resources are wasted.
In the past, introducing concurrency to an application required the creation of one or more additional threads.
Unfortunately, writing threaded code is challenging. Threads are a low-level tool that must be managed
manually. Given that the optimal number of threads for an application can change dynamically based on the
currentsystem load and the underlying hardware, implementing a correct threading solution becomes extremely
difficult, if not impossible to achieve. In addition, the synchronization mechanisms typically used with threads
add complexity and risk to software designs without any guarantees of improved performance.
Both OS X and iOS adopt a more asynchronous approach to the execution of concurrent tasksthan istraditionally
found in thread-based systems and applications. Rather than creating threads directly, applications need only
define specific tasks and then let the system perform them. By letting the system manage the threads,
applications gain a level ofscalability not possible with raw threads. Application developers also gain a simpler
and more efficient programming model.
This document describes the technique and technologies you should be using to implement concurrency in
your applications. The technologies described in this document are available in both OS X and iOS.
Organization of This Document
This document contains the following chapters:
●
“Concurrency and Application Design” (page 9) introduces the basics of asynchronous application design
and the technologies for performing your custom tasks asynchronously.
●
“Operation Queues” (page 17)shows you how to encapsulate and perform tasks using Objective-C objects.
●
“Dispatch Queues” (page 38) shows you how to execute tasks concurrently in C-based applications.
●
“Dispatch Sources” (page 56) shows you how to handle system events asynchronously.
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Introduction●
“Migrating Away from Threads” (page 74) provides tips and techniques for migrating your existing
thread-based code over to use newer technologies.
This document also includes a glossary that defines relevant terms.
A Note About Terminology
Before entering into a discussion about concurrency, it is necessary to define some relevant terminology to
prevent confusion. Developers who are more familiar with UNIX systems or older OS X technologies may find
the terms “task”, “process”, and “thread” used somewhat differently in this document. This document uses
these terms in the following way:
● The term thread is used to refer to a separate path of execution for code. The underlying implementation
for threads in OS X is based on the POSIX threads API.
● The term process is used to refer to a running executable, which can encompass multiple threads.
● The term task is used to refer to the abstract concept of work that needs to be performed.
For complete definitions of these and other key terms used by this document, see “Glossary” (page 84).
See Also
This document focuses on the preferred technologies for implementing concurrency in your applications and
does not cover the use of threads. If you need information about using threads and other thread-related
technologies, see Threading Programming Guide .
Introduction
A Note About Terminology
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8In the early days of computing, the maximum amount of work per unit of time that a computer could perform
was determined by the clock speed of the CPU. But as technology advanced and processor designs became
more compact, heat and other physical constraints started to limit the maximum clock speeds of processors.
And so, chip manufacturerslooked for other waysto increase the total performance of their chips. The solution
they settled on was increasing the number of processor cores on each chip. By increasing the number of cores,
a single chip could execute more instructions per second without increasing the CPU speed or changing the
chip size or thermal characteristics. The only problem was how to take advantage of the extra cores.
In order to take advantage of multiple cores, a computer needs software that can do multiple things
simultaneously. For a modern, multitasking operating system like OS X or iOS, there can be a hundred or more
programs running at any given time, so scheduling each program on a different core should be possible.
However, most of these programs are either system daemons or background applications that consume very
little real processing time. Instead, what is really needed is a way for individual applications to make use of the
extra cores more effectively.
The traditional way for an application to use multiple cores is to create multiple threads. However, as the
number of cores increases, there are problems with threaded solutions. The biggest problem is that threaded
code does not scale very well to arbitrary numbers of cores. You cannot create as many threads as there are
cores and expect a program to run well. What you would need to know is the number of cores that can be
used efficiently, which is a challenging thing for an application to compute on its own. Even if you manage to
get the numbers correct, there is still the challenge of programming for so many threads, of making them run
efficiently, and of keeping them from interfering with one another.
So, to summarize the problem, there needsto be a way for applicationsto take advantage of a variable number
of computer cores. The amount of work performed by a single application also needs to be able to scale
dynamically to accommodate changing system conditions. And the solution has to be simple enough so as to
not increase the amount of work needed to take advantage of those cores. The good news is that Apple’s
operating systems provide the solution to all of these problems, and this chapter takes a look at the technologies
that comprise this solution and the design tweaks you can make to your code to take advantage of them.
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Concurrency and Application DesignThe Move Away from Threads
Although threads have been around for many years and continue to have their uses, they do not solve the
general problem of executing multiple tasks in a scalable way. With threads, the burden of creating a scalable
solution rests squarely on the shoulders of you, the developer. You have to decide how many threads to create
and adjust that number dynamically as system conditions change. Another problem is that your application
assumes most of the costs associated with creating and maintaining any threads it uses.
Instead of relying on threads, OS X and iOS take an asynchronous design approach to solving the concurrency
problem. Asynchronous functions have been present in operating systems for many years and are often used
to initiate tasks that might take a long time, such as reading data from the disk. When called, an asynchronous
function does some work behind the scenes to start a task running but returns before that task might actually
be complete. Typically, this work involves acquiring a background thread, starting the desired task on that
thread, and then sending a notification to the caller (usually through a callback function) when the task is
done. In the past, if an asynchronous function did not exist for what you want to do, you would have to write
your own asynchronous function and create your own threads. But now, OS X and iOS provide technologies
to allow you to perform any task asynchronously without having to manage the threads yourself.
One of the technologies for starting tasks asynchronously is Grand Central Dispatch (GCD). This technology
takes the thread management code you would normally write in your own applications and moves that code
down to the system level. All you have to do is define the tasks you want to execute and add them to an
appropriate dispatch queue. GCD takes care of creating the needed threads and of scheduling your tasks to
run on those threads. Because the thread management is now part of the system, GCD provides a holistic
approach to task management and execution, providing better efficiency than traditional threads.
Operation queues are Objective-C objects that act very much like dispatch queues. You define the tasks you
want to execute and then add them to an operation queue, which handles the scheduling and execution of
those tasks. Like GCD, operation queues handle all of the thread management for you, ensuring that tasks are
executed as quickly and as efficiently as possible on the system.
The following sections provide more information about dispatch queues, operation queues, and some other
related asynchronous technologies you can use in your applications.
Dispatch Queues
Dispatch queues are a C-based mechanism for executing custom tasks. A dispatch queue executestasks either
serially or concurrently but alwaysin a first-in, first-out order. (In other words, a dispatch queue always dequeues
and starts tasks in the same order in which they were added to the queue.) A serial dispatch queue runs only
one task at a time, waiting until that task is complete before dequeuing and starting a new one. By contrast,
a concurrent dispatch queue starts as many tasks as it can without waiting for already started tasks to finish.
Dispatch queues have other benefits:
Concurrency and Application Design
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10● They provide a straightforward and simple programming interface.
● They offer automatic and holistic thread pool management.
● They provide the speed of tuned assembly.
● They are much more memory efficient (because thread stacks do not linger in application memory).
● They do not trap to the kernel under load.
● The asynchronous dispatching of tasks to a dispatch queue cannot deadlock the queue.
● They scale gracefully under contention.
● Serial dispatch queues offer a more efficient alternative to locks and other synchronization primitives.
The tasks you submit to a dispatch queue must be encapsulated inside either a function or a block object. Block
objects are a C language feature introduced in OS X v10.6 and iOS 4.0 that are similar to function pointers
conceptually, but have some additional benefits. Instead of defining blocks in their own lexical scope, you
typically define blocks inside another function or method so that they can access other variables from that
function or method. Blocks can also be moved out of their original scope and copied onto the heap, which is
what happens when you submit them to a dispatch queue. All of these semantics make it possible to implement
very dynamic tasks with relatively little code.
Dispatch queues are part of the Grand Central Dispatch technology and are part of the C runtime. For more
information about using dispatch queues in your applications, see “Dispatch Queues” (page 38). For more
information about blocks and their benefits, see Blocks Programming Topics.
Dispatch Sources
Dispatch sources are a C-based mechanism for processing specific types of system events asynchronously. A
dispatch source encapsulates information about a particular type of system event and submits a specific block
object or function to a dispatch queue whenever that event occurs. You can use dispatch sources to monitor
the following types of system events:
● Timers
● Signal handlers
● Descriptor-related events
● Process-related events
● Mach port events
● Custom events that you trigger
Dispatch sources are part of the Grand Central Dispatch technology. For information about using dispatch
sources to receive events in your application, see “Dispatch Sources” (page 56).
Concurrency and Application Design
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11Operation Queues
An operation queue is the Cocoa equivalent of a concurrent dispatch queue and is implemented by the
NSOperationQueue class. Whereas dispatch queues always execute tasks in first-in, first-out order, operation
queues take other factors into account when determining the execution order of tasks. Primary among these
factors is whether a given task depends on the completion of other tasks. You configure dependencies when
defining your tasks and can use them to create complex execution-order graphs for your tasks.
The tasks you submit to an operation queue must be instances of the NSOperation class. An operation object
is an Objective-C object that encapsulates the work you want to perform and any data needed to perform it.
Because the NSOperation class is essentially an abstract base class, you typically define custom subclasses
to perform your tasks. However, the Foundation framework does include some concrete subclasses that you
can create and use as is to perform tasks.
Operation objects generate key-value observing (KVO) notifications, which can be a useful way of monitoring
the progress of your task. Although operation queues always execute operations concurrently, you can use
dependencies to ensure they are executed serially when needed.
For more information about how to use operation queues, and how to define custom operation objects, see
“Operation Queues” (page 17).
Asynchronous Design Techniques
Before you even consider redesigning your code to support concurrency, you should ask yourself whether
doing so is necessary. Concurrency can improve the responsiveness of your code by ensuring that your main
thread is free to respond to user events. It can even improve the efficiency of your code by leveraging more
cores to do more work in the same amount of time. However, it also adds overhead and increases the overall
complexity of your code, making it harder to write and debug your code.
Because it adds complexity, concurrency is not a feature that you can graft onto an application at the end of
your product cycle. Doing it right requires careful consideration of the tasks your application performs and the
data structures used to perform those tasks. Done incorrectly, you might find your code runsslower than before
and is less responsive to the user. Therefore, it is worthwhile to take some time at the beginning of your design
cycle to set some goals and to think about the approach you need to take.
Every application has different requirements and a different set of tasks that it performs. It is impossible for a
document to tell you exactly how to design your application and its associated tasks. However, the following
sections try to provide some guidance to help you make good choices during the design process.
Concurrency and Application Design
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12Define Your Application’s Expected Behavior
Before you even think about adding concurrency to your application, you should alwaysstart by defining what
you deem to be the correct behavior of your application. Understanding your application’s expected behavior
gives you a way to validate your design later. It should also give you some idea of the expected performance
benefits you might receive by introducing concurrency.
The first thing you should do is enumerate the tasks your application performs and the objects or data structures
associated with each task. Initially, you might want to start with tasks that are performed when the user selects
a menu item or clicks a button. These tasks offer discrete behavior and have a well defined start and end point.
You should also enumerate other types of tasks your application may perform without user interaction, such
as timer-based tasks.
After you have your list of high-level tasks,start breaking each task down further into the set ofstepsthat must
be taken to complete the task successfully. At thislevel, you should be primarily concerned with the modifications
you need to make to any data structures and objects and how those modifications affect your application’s
overallstate. You should also note any dependencies between objects and data structures as well. For example,
if a task involves making the same change to an array of objects, it is worth noting whether the changes to
one object affect any other objects. If the objects can be modified independently of each other, that might be
a place where you could make those modifications concurrently.
Factor Out Executable Units of Work
From your understanding of your application’s tasks, you should already be able to identify places where your
code might benefit from concurrency. If changing the order of one or more steps in a task changes the results,
you probably need to continue performing those steps serially. If changing the order has no effect on the
output, though, you should consider performing those steps concurrently. In both cases, you define the
executable unit of work that represents the step or steps to be performed. This unit of work then becomes
what you encapsulate using either a block or an operation object and dispatch to the appropriate queue.
For each executable unit of work you identify, do not worry too much about the amount of work being
performed, at least initially. Although there is always a cost to spinning up a thread, one of the advantages of
dispatch queues and operation queues is that in many cases those costs are much smaller than they are for
traditional threads. Thus, it is possible for you to execute smaller units of work more efficiently using queues
than you could using threads. Of course, you should always measure your actual performance and adjust the
size of your tasks as needed, but initially, no task should be considered too small.
Concurrency and Application Design
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13Identify the Queues You Need
Now that your tasks are broken up into distinct units of work and encapsulated using block objects or operation
objects, you need to define the queues you are going to use to execute that code. For a given task, examine
the blocks or operation objects you created and the order in which they must be executed to perform the task
correctly.
If you implemented your tasks using blocks, you can add your blocks to either a serial or concurrent dispatch
queue. If a specific order is required, you would always add your blocks to a serial dispatch queue. If a specific
order is not required, you can add the blocks to a concurrent dispatch queue or add them to several different
dispatch queues, depending on your needs.
If you implemented your tasks using operation objects, the choice of queue is often less interesting than the
configuration of your objects. To perform operation objectsserially, you must configure dependencies between
the related objects. Dependencies prevent one operation from executing until the objects on which it depends
have finished their work.
Tips for Improving Efficiency
In addition to simply factoring your code into smaller tasks and adding them to a queue, there are other ways
to improve the overall efficiency of your code using queues:
● Consider computing values directly within your task if memory usage is a factor. If your application is
already memory bound, computing values directly now may be faster than loading cached values from
main memory. Computing values directly uses the registers and caches of the given processor core, which
are much faster than main memory. Of course, you should only do this if testing indicates this is a
performance win.
●
Identify serial tasks early and do what you can to make them more concurrent. If a task must be
executed serially because it relies on some shared resource, consider changing your architecture to remove
that shared resource. You might consider making copies of the resource for each client that needs one or
eliminate the resource altogether.
● Avoid using locks. The support provided by dispatch queues and operation queuesmakeslocks unnecessary
in most situations. Instead of using locks to protect some shared resource, designate a serial queue (or
use operation object dependencies) to execute tasks in the correct order.
● Rely on the system frameworks whenever possible. The best way to achieve concurrency is to take
advantage of the built-in concurrency provided by the system frameworks. Many frameworks use threads
and other technologies internally to implement concurrent behaviors. When defining your tasks, look to
see if an existing framework defines a function or method that does exactly what you want and does so
concurrently. Using that API may save you effort and is more likely to give you the maximum concurrency
possible.
Concurrency and Application Design
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Operation queues, dispatch queues, and dispatch sources are provided to make it easier for you to execute
more code concurrently. However, these technologies do not guarantee improvements to the efficiency or
responsiveness in your application. It is still your responsibility to use queues in a manner that is both effective
for your needs and does not impose an undue burden on your application’s other resources. For example,
although you could create 10,000 operation objects and submit them to an operation queue, doing so would
cause your application to allocate a potentially nontrivial amount of memory, which could lead to paging and
decreased performance.
Before introducing any amount of concurrency to your code—whether using queues or threads—you should
always gather a set of baseline metrics that reflect your application’s current performance. After introducing
your changes, you should then gather additional metrics and compare them to your baseline to see if your
application’s overall efficiency has improved. If the introduction of concurrency makes your application less
efficient or responsive, you should use the available performance tools to check for the potential causes.
For an introduction to performance and the available performance tools, and for links to more advanced
performance-related topics, see Performance Overview.
Concurrency and Other Technologies
Factoring your code into modular tasks is the best way to try and improve the amount of concurrency in your
application. However, this design approach may not satisfy the needs of every application in every case.
Depending on your tasks, there might be other options that can offer additional improvements in your
application’s overall concurrency. This section outlines some of the other technologies to consider using as
part of your design.
OpenCL and Concurrency
In OS X, the Open Computing Language (OpenCL) is a standards-based technology for performing
general-purpose computations on a computer’s graphics processor. OpenCL is a good technology to use if
you have a well-defined set of computations that you want to apply to large data sets. For example, you might
use OpenCL to perform filter computations on the pixels of an image or use it to perform complex math
calculations on several values at once. In other words, OpenCL is geared more toward problem sets whose
data can be operated on in parallel.
Although OpenCL is good for performing massively data-parallel operations, it is not suitable for more
general-purpose calculations. There is a nontrivial amount of effort required to prepare and transfer both the
data and the required work kernel to a graphics card so that it can be operated on by a GPU. Similarly, there
is a nontrivial amount of effort required to retrieve any results generated by OpenCL. As a result, any tasks that
interact with the system are generally not recommended for use with OpenCL. For example, you would not
Concurrency and Application Design
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15use OpenCL to process data from files or network streams. Instead, the work you perform using OpenCL must
be much more self-contained so that it can be transferred to the graphics processor and computed
independently.
For more information about OpenCL and how you use it, see OpenCL Programming Guide for Mac .
When to Use Threads
Although operation queues and dispatch queues are the preferred way to perform tasks concurrently, they
are not a panacea. Depending on your application, there may still be times when you need to create custom
threads. If you do create custom threads, you should strive to create as few threads as possible yourself and
you should use those threads only for specific tasks that cannot be implemented any other way.
Threads are still a good way to implement code that must run in real time. Dispatch queues make every attempt
to run their tasks as fast as possible but they do not address real time constraints. If you need more predictable
behavior from code running in the background, threads may still offer a better alternative.
As with any threaded programming, you should always use threads judiciously and only when absolutely
necessary. For more information about thread packages and how you use them, see Threading Programming
Guide .
Concurrency and Application Design
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16Cocoa operations are an object-oriented way to encapsulate work that you want to perform asynchronously.
Operations are designed to be used either in conjunction with an operation queue or by themselves. Because
they are Objective-C based, operations are most commonly used in Cocoa-based applications in OS X and iOS.
This chapter shows you how to define and use operations.
About Operation Objects
An operation object is an instance of the NSOperation class (in the Foundation framework) that you use to
encapsulate work you want your application to perform. The NSOperation classitself is an abstract base class
that must be subclassed in order to do any useful work. Despite being abstract, this class does provide a
significant amount of infrastructure to minimize the amount of work you have to do in your own subclasses.
In addition, the Foundation framework provides two concrete subclasses that you can use as-is with your
existing code. Table 2-1 lists these classes, along with a summary of how you use each one.
Table 2-1 Operation classes of the Foundation framework
Class Description
A class you use as-is to create an operation object based on an object and
selector from your application. You can use this class in cases where you have
an existing method that already performs the needed task. Because it does
not require subclassing, you can also use this classto create operation objects
in a more dynamic fashion.
For information about how to use this class, see “Creating an
NSInvocationOperation Object” (page 19).
NSInvocationOperation
A class you use as-isto execute one or more block objects concurrently. Because
it can execute more than one block, a block operation object operates using
a group semantic; only when all of the associated blocks have finished
executing is the operation itself considered finished.
For information about how to use this class,see “Creating an NSBlockOperation
Object” (page 20). This class is available in OS X v10.6 and later. For more
information about blocks, see Blocks Programming Topics.
NSBlockOperation
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Operation QueuesClass Description
The base class for defining custom operation objects. Subclassing
NSOperation gives you complete control over the implementation of your
own operations, including the ability to alter the default way in which your
operation executes and reports its status.
For information about how to define custom operation objects, see “Defining
a Custom Operation Object” (page 21).
NSOperation
All operation objects support the following key features:
● Support for the establishment of graph-based dependencies between operation objects. These
dependencies prevent a given operation from running until all of the operations on which it depends
have finished running. For information about how to configure dependencies, see “Configuring
Interoperation Dependencies” (page 29).
● Support for an optional completion block, which is executed after the operation’s main task finishes. (OS
X v10.6 and later only.) For information about how to set a completion block,see “Setting Up a Completion
Block” (page 30).
● Support for monitoring changes to the execution state of your operations using KVO notifications. For
information about how to observe KVO notifications, see Key-Value Observing Programming Guide .
● Support for prioritizing operations and thereby affecting their relative execution order. For more information,
see “Changing an Operation’s Execution Priority” (page 29).
● Support for canceling semantics that allow you to halt an operation while it is executing. For information
about how to cancel operations, see “Canceling Operations” (page 36). For information about how to
support cancellation in your own operations, see “Responding to Cancellation Events” (page 22).
Operations are designed to help you improve the level of concurrency in your application. Operations are also
a good way to organize and encapsulate your application’s behavior into simple discrete chunks. Instead of
running some bit of code on your application’s main thread, you can submit one or more operation objects
to a queue and let the corresponding work be performed asynchronously on one or more separate threads.
Concurrent Versus Non-concurrent Operations
Although you typically execute operations by adding them to an operation queue, doing so is not required.
It is also possible to execute an operation object manually by calling its start method, but doing so does not
guarantee that the operation runs concurrently with the rest of your code. The isConcurrent method of the
Operation Queues
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18NSOperation class tells you whether an operation runs synchronously or asynchronously with respect to the
thread in which its start method was called. By default, this method returns NO, which means the operation
runs synchronously in the calling thread.
If you want to implement a concurrent operation—that is, one that runs asynchronously with respect to the
calling thread—you must write additional code to start the operation asynchronously. For example, you might
spawn a separate thread, call an asynchronous system function, or do anything else to ensure that the start
method starts the task and returns immediately and, in all likelihood, before the task is finished.
Most developers should never need to implement concurrent operation objects. If you always add your
operations to an operation queue, you do not need to implement concurrent operations. When you submit a
nonconcurrent operation to an operation queue, the queue itself creates a thread on which to run your
operation. Thus, adding a nonconcurrent operation to an operation queue still results in the asynchronous
execution of your operation object code. The ability to define concurrent operations is only necessary in cases
where you need to execute the operation asynchronously without adding it to an operation queue.
For information about how to create a concurrent operation, see “Configuring Operations for Concurrent
Execution” (page 24) and NSOperation Class Reference .
Creating an NSInvocationOperation Object
The NSInvocationOperation class is a concrete subclass of NSOperation that, when run, invokes the
selector you specify on the object you specify. Use this classto avoid defining large numbers of custom operation
objects for each task in your application; especially if you are modifying an existing application and already
have the objects and methods needed to perform the necessary tasks. You can also use it when the method
you want to call can change depending on the circumstances. For example, you could use an invocation
operation to perform a selector that is chosen dynamically based on user input.
The process for creating an invocation operation is straightforward. You create and initialize a new instance of
the class, passing the desired object and selector to execute to the initialization method. Listing 2-1 shows
two methodsfrom a custom classthat demonstrate the creation process. The taskWithData: method creates
a new invocation object and supplies it with the name of another method, which contains the task
implementation.
Listing 2-1 Creating an NSInvocationOperation object
@implementation MyCustomClass
- (NSOperation*)taskWithData:(id)data {
NSInvocationOperation* theOp = [[NSInvocationOperation alloc] initWithTarget:self
selector:@selector(myTaskMethod:) object:data];
Operation Queues
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}
// This is the method that does the actual work of the task.
- (void)myTaskMethod:(id)data {
// Perform the task.
}
@end
Creating an NSBlockOperation Object
The NSBlockOperation class is a concrete subclass of NSOperation that acts as a wrapper for one or more
block objects. This class provides an object-oriented wrapper for applications that are already using operation
queues and do not want to create dispatch queues as well. You can also use block operationsto take advantage
of operation dependencies, KVO notifications, and other features that might not be available with dispatch
queues.
When you create a block operation, you typically add at least one block at initialization time; you can add more
blocks as needed later. When it comes time to execute an NSBlockOperation object, the object submits all
of its blocks to the default-priority, concurrent dispatch queue. The object then waits until all of the blocks
finish executing. When the last block finishes executing, the operation object marks itself as finished. Thus,
you can use a block operation to track a group of executing blocks, much like you would use a thread join to
merge the results from multiple threads. The difference is that because the block operation itself runs on a
separate thread, your application’s other threads can continue doing work while waiting for the block operation
to complete.
Listing 2-2 shows a simple example of how to create an NSBlockOperation object. The block itself has no
parameters and no significant return result.
Listing 2-2 Creating an NSBlockOperation object
NSBlockOperation* theOp = [NSBlockOperation blockOperationWithBlock: ^{
NSLog(@"Beginning operation.\n");
// Do some work.
}];
Operation Queues
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20After creating a block operation object, you can add more blocks to it using the addExecutionBlock:
method. If you need to execute blocks serially, you must submit them directly to the desired dispatch queue.
Defining a Custom Operation Object
If the block operation and invocation operation objects do not quite meet the needs of your application, you
can subclass NSOperation directly and add whatever behavior you need. The NSOperation class provides
a generalsubclassing point for all operation objects. The class also provides a significant amount of infrastructure
to handle most of the work needed for dependencies and KVO notifications. However, there may still be times
when you need to supplement the existing infrastructure to ensure that your operations behave correctly. The
amount of extra work you have to do depends on whether you are implementing a nonconcurrent or a
concurrent operation.
Defining a nonconcurrent operation is much simpler than defining a concurrent operation. For a nonconcurrent
operation, all you have to do is perform your main task and respond appropriately to cancellation events; the
existing class infrastructure does all of the other work for you. For a concurrent operation, you must replace
some of the existing infrastructure with your custom code. The following sectionsshow you how to implement
both types of object.
Performing the Main Task
At a minimum, every operation object should implement at least the following methods:
● A custom initialization method
● main
You need a custom initialization method to put your operation object into a known state and a custom main
method to perform your task. You can implement additional methods as needed, of course, such as the
following:
● Custom methods that you plan to call from the implementation of your main method
● Accessor methods for setting data values and accessing the results of the operation
● Methods of the NSCoding protocol to allow you to archive and unarchive the operation object
Listing 2-3 shows a starting template for a custom NSOperation subclass. (This listing does not show how to
handle cancellation but does show the methods you would typically have. For information about handling
cancellation, see “Responding to Cancellation Events” (page 22).) The initialization method for this class takes
a single object as a data parameter and stores a reference to it inside the operation object. The main method
would ostensibly work on that data object before returning the results back to your application.
Operation Queues
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21Listing 2-3 Defining a simple operation object
@interface MyNonConcurrentOperation : NSOperation
@property id (strong) myData;
-(id)initWithData:(id)data;
@end
@implementation MyNonConcurrentOperation
- (id)initWithData:(id)data {
if (self = [super init])
myData = data;
return self;
}
-(void)main {
@try {
// Do some work on myData and report the results.
}
@catch(...) {
// Do not rethrow exceptions.
}
}
@end
For a detailed example of how to implement an NSOperation subclass, see NSOperationSample .
Responding to Cancellation Events
After an operation begins executing, it continues performing its task until it is finished or until your code
explicitly cancelsthe operation. Cancellation can occur at any time, even before an operation begins executing.
Although the NSOperation class provides a way for clientsto cancel an operation, recognizing the cancellation
event is voluntary by necessity. If an operation were terminated outright, there might not be a way to reclaim
resources that had been allocated. As a result, operation objects are expected to check for cancellation events
and to exit gracefully when they occur in the middle of the operation.
Operation Queues
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periodically from your custom code and return immediately if it ever returns YES. Supporting cancellation is
important regardless of the duration of your operation or whether you subclass NSOperation directly or use
one of its concrete subclasses. The isCancelled method itself is very lightweight and can be called frequently
without any significant performance penalty. When designing your operation objects, you should consider
calling the isCancelled method at the following places in your code:
●
Immediately before you perform any actual work
● At least once during each iteration of a loop, or more frequently if each iteration is relatively long
● At any points in your code where it would be relatively easy to abort the operation
Listing 2-4 provides a very simple example of how to respond to cancellation events in the main method of
an operation object. In this case, the isCancelled method is called each time through a while loop, allowing
for a quick exit before work begins and again at regular intervals.
Listing 2-4 Responding to a cancellation request
- (void)main {
@try {
BOOL isDone = NO;
while (![self isCancelled] && !isDone) {
// Do some work and set isDone to YES when finished
}
}
@catch(...) {
// Do not rethrow exceptions.
}
}
Although the preceding example contains no cleanup code, your own code should be sure to free up any
resources that were allocated by your custom code.
Operation Queues
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Operation objects execute in a synchronous manner by default—that is, they perform their task in the thread
that calls their start method. Because operation queues provide threads for nonconcurrent operations,
though, most operations still run asynchronously. However, if you plan to execute operations manually and
still want them to run asynchronously, you must take the appropriate actions to ensure that they do. You do
this by defining your operation object as a concurrent operation.
Table 2-2 lists the methods you typically override to implement a concurrent operation.
Table 2-2 Methods to override for concurrent operations
Method Description
(Required) All concurrent operations must override this method and replace the
default behavior with their own custom implementation. To execute an operation
manually, you call its start method. Therefore, your implementation of this method
is the starting point for your operation and is where you set up the thread or other
execution environment in which to execute your task. Your implementation must
not call super at any time.
start
(Optional) This method is typically used to implement the task associated with the
operation object. Although you could perform the task in the start method,
implementing the task using this method can result in a cleaner separation of your
setup and task code.
main
(Required) Concurrent operations are responsible for setting up their execution
environment and reporting the status of that environment to outside clients.
Therefore, a concurrent operation must maintain some state information to know
when it is executing its task and when it has finished that task. It must then report
that state using these methods.
Your implementations of these methods must be safe to call from other threads
simultaneously. You must also generate the appropriate KVO notifications for the
expected key paths when changing the values reported by these methods.
isExecuting
isFinished
(Required) To identify an operation as a concurrent operation, override this method
and return YES.
isConcurrent
The rest of this section shows a sample implementation of the MyOperation class, which demonstrates the
fundamental code needed to implement a concurrent operation. The MyOperation class simply executes its
own main method on a separate thread that it creates. The actual work that the main method performs is
irrelevant. The point of the sample is to demonstrate the infrastructure you need to provide when defining a
concurrent operation.
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of the isConcurrent, isExecuting, and isFinished methods for the MyOperation class are relatively
straightforward. The isConcurrent method should simply return YES to indicate that this is a concurrent
operation. The isExecuting and isFinished methods simply return values stored in instance variables of
the class itself.
Listing 2-5 Defining a concurrent operation
@interface MyOperation : NSOperation {
BOOL executing;
BOOL finished;
}
- (void)completeOperation;
@end
@implementation MyOperation
- (id)init {
self = [super init];
if (self) {
executing = NO;
finished = NO;
}
return self;
}
- (BOOL)isConcurrent {
return YES;
}
- (BOOL)isExecuting {
return executing;
}
- (BOOL)isFinished {
return finished;
}
Operation Queues
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Listing 2-6 shows the start method of MyOperation. The implementation of this method is minimal so as
to demonstrate the tasks you absolutely must perform. In this case, the method simply starts up a new thread
and configures it to call the main method. The method also updates the executing member variable and
generates KVO notifications for the isExecuting key path to reflect the change in that value. With its work
done, this method then simply returns, leaving the newly detached thread to perform the actual task.
Listing 2-6 The start method
- (void)start {
// Always check for cancellation before launching the task.
if ([self isCancelled])
{
// Must move the operation to the finished state if it is canceled.
[self willChangeValueForKey:@"isFinished"];
finished = YES;
[self didChangeValueForKey:@"isFinished"];
return;
}
// If the operation is not canceled, begin executing the task.
[self willChangeValueForKey:@"isExecuting"];
[NSThread detachNewThreadSelector:@selector(main) toTarget:self withObject:nil];
executing = YES;
[self didChangeValueForKey:@"isExecuting"];
}
Listing 2-7 shows the remaining implementation for the MyOperation class. As was seen in Listing 2-6 (page
26), the main method is the entry point for a new thread. It performs the work associated with the operation
object and calls the custom completeOperation method when that work is finally done. The
completeOperation method then generates the needed KVO notifications for both the isExecuting and
isFinished key paths to reflect the change in state of the operation.
Operation Queues
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- (void)main {
@try {
// Do the main work of the operation here.
[self completeOperation];
}
@catch(...) {
// Do not rethrow exceptions.
}
}
- (void)completeOperation {
[self willChangeValueForKey:@"isFinished"];
[self willChangeValueForKey:@"isExecuting"];
executing = NO;
finished = YES;
[self didChangeValueForKey:@"isExecuting"];
[self didChangeValueForKey:@"isFinished"];
}
Even if an operation is canceled, you should always notify KVO observers that your operation is now finished
with its work. When an operation object is dependent on the completion of other operation objects, it monitors
the isFinished key path for those objects. Only when all objects report that they are finished does the
dependent operation signal that it isready to run. Failing to generate a finish notification can therefore prevent
the execution of other operations in your application.
Maintaining KVO Compliance
The NSOperation class is key-value observing (KVO) compliant for the following key paths:
● isCancelled
● isConcurrent
● isExecuting
Operation Queues
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27● isFinished
● isReady
● dependencies
● queuePriority
● completionBlock
If you override the start method or do any significant customization of an NSOperation object other than
override main, you must ensure that your custom object remains KVO compliant for these key paths. When
overriding the start method, the key paths you should be most concerned with are isExecuting and
isFinished. These are the key paths most commonly affected by reimplementing that method.
If you want to implement support for dependencies on something besides other operation objects, you can
also override the isReady method and force it to return NO until your custom dependencies were satisfied.
(If you implement custom dependencies, be sure to call super from your isReady method if you still support
the default dependency managementsystem provided by the NSOperation class.) When the readinessstatus
of your operation object changes, generate KVO notificationsfor the isReady key path to report those changes.
Unless you override the addDependency: or removeDependency: methods, you should not need to worry
about generating KVO notifications for the dependencies key path.
Although you could generate KVO notifications for other key paths of NSOperation, it is unlikely you would
ever need to do so. If you need to cancel an operation, you can simply call the existing cancel method to do
so. Similarly, there should be little need for you to modify the queue priority information in an operation object.
Finally, unless your operation is capable of changing its concurrency status dynamically, you do not need to
provide KVO notifications for the isConcurrent key path.
For more information on key-value observing and how to support it in your custom objects, see Key-Value
Observing Programming Guide .
Customizing the Execution Behavior of an Operation Object
The configuration of operation objects occurs after you have created them but before you add them to a
queue. The types of configurations described in this section can be applied to all operation objects, regardless
of whether you subclassed NSOperation yourself or used an existing subclass.
Operation Queues
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Dependencies are a way for you to serialize the execution of distinct operation objects. An operation that is
dependent on other operations cannot begin executing until all of the operations on which it depends have
finished executing. Thus, you can use dependencies to create simple one-to-one dependencies between two
operation objects or to build complex object dependency graphs.
To establish dependencies between two operation objects, you use the addDependency: method of
NSOperation. This method creates a one-way dependency from the current operation object to the target
operation you specify as a parameter. This dependency means that the current object cannot begin executing
until the target object finishes executing. Dependencies are also not limited to operations in the same queue.
Operation objects manage their own dependencies and so it is perfectly acceptable to create dependencies
between operations and add them all to different queues. One thing that is not acceptable, however, is to
create circular dependencies between operations. Doing so is a programmer error that will prevent the affected
operations from ever running.
When all of an operation’s dependencies have themselves finished executing, an operation object normally
becomes ready to execute. (If you customize the behavior of the isReady method, the readiness of the
operation is determined by the criteria you set.) If the operation object is in a queue, the queue may start
executing that operation at any time. If you plan to execute the operation manually, it is up to you to call the
operation’s start method.
Important:  You should always configure dependencies before running your operations or adding them
to an operation queue. Dependencies added afterward may not prevent a given operation object from
running.
Dependencies rely on each operation object sending out appropriate KVO notifications whenever the status
of the object changes. If you customize the behavior of your operation objects, you may need to generate
appropriate KVO notifications from your custom code in order to avoid causing issues with dependencies. For
more information on KVO notifications and operation objects, see “Maintaining KVO Compliance” (page 27).
For additional information on configuring dependencies, see NSOperation Class Reference .
Changing an Operation’s Execution Priority
For operations added to a queue, execution order is determined first by the readiness of the queued operations
and then by their relative priority. Readinessis determined by an operation’s dependencies on other operations,
but the priority level is an attribute of the operation object itself. By default, all new operation objects have a
“normal” priority, but you can increase or decrease that priority as needed by calling the object’s
setQueuePriority: method.
Operation Queues
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29Priority levels apply only to operations in the same operation queue. If your application has multiple operation
queues, each prioritizes its own operations independently of any other queues. Thus, it is still possible for
low-priority operations to execute before high-priority operations in a different queue.
Priority levels are not a substitute for dependencies. Priorities determine the order in which an operation queue
starts executing only those operations that are currently ready. For example, if a queue contains both a
high-priority and low-priority operation and both operations are ready, the queue executes the high-priority
operation first. However, if the high-priority operation is not ready but the low-priority operation is, the queue
executes the low-priority operation first. If you want to prevent one operation from starting until another
operation has finished, you must use dependencies (as described in “Configuring Interoperation
Dependencies” (page 29)) instead.
Changing the Underlying Thread Priority
In OS X v10.6 and later, it is possible to configure the execution priority of an operation’s underlying thread.
Thread policies in the system are themselves managed by the kernel, but in general higher-priority threads
are given more opportunities to run than lower-priority threads. In an operation object, you specify the thread
priority as a floating-point value in the range 0.0 to 1.0, with 0.0 being the lowest priority and 1.0 being the
highest priority. If you do not specify an explicit thread priority, the operation runs with the default thread
priority of 0.5.
To set an operation’s thread priority, you must call the setThreadPriority: method of your operation
object before adding it to a queue (or executing it manually). When it comes time to execute the operation,
the default start method uses the value you specified to modify the priority of the current thread. This new
priority remains in effect for the duration of your operation’s main method only. All other code (including your
operation’s completion block) is run with the default thread priority. If you create a concurrent operation, and
therefore override the start method, you must configure the thread priority yourself.
Setting Up a Completion Block
In OS X v10.6 and later, an operation can execute a completion block when its main task finishes executing.
You can use a completion block to perform any work that you do not consider part of the main task. For
example, you might use this block to notify interested clients that the operation itself has completed. A
concurrent operation object might use this block to generate its final KVO notifications.
To set a completion block, use the setCompletionBlock: method of NSOperation. The block you pass to
this method should have no arguments and no return value.
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30Tips for Implementing Operation Objects
Although operation objects are fairly easy to implement, there are several things you should be aware of as
you are writing your code. The following sections describe factors that you should take into account when
writing the code for your operation objects.
Managing Memory in Operation Objects
The following sections describe key elements of good memory management in an operation object. For general
information about memory management in Objective-C programs, see Advanced Memory Management
Programming Guide .
Avoid Per-Thread Storage
Although most operations execute on a thread, in the case of nonconcurrent operations, that thread is usually
provided by an operation queue. If an operation queue provides a thread for you, you should consider that
thread to be owned by the queue and not to be touched by your operation. Specifically, you should never
associate any data with a thread that you do not create yourself or manage. The threads managed by an
operation queue come and go depending on the needs of the system and your application. Therefore, passing
data between operations using per-thread storage is unreliable and likely to fail.
In the case of operation objects, there should be no reason for you to use per-thread storage in any case. When
you initialize an operation object, you should provide the object with everything it needsto do itsjob. Therefore,
the operation object itself provides the contextual storage you need. All incoming and outgoing data should
be stored there until it can be integrated back into your application or is no longer required.
Keep References to Your Operation Object As Needed
Just because operation objects run asynchronously, you should not assume that you can create them and
forget about them. They are still just objects and it is up to you to manage any references to them that your
code needs. This is especially important if you need to retrieve result data from an operation after it is finished.
The reason you should always keep your own references to operations is that you may not get the chance to
ask a queue for the object later. Queues make every effort to dispatch and execute operations as quickly as
possible. In many cases, queues start executing operations almost immediately after they are added. By the
time your own code goes back to the queue to get a reference to the operation, that operation could already
be finished and removed from the queue.
Operation Queues
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31Handling Errors and Exceptions
Because operations are essentially discrete entities inside your application, they are responsible for handling
any errors or exceptions that arise. In OS X v10.6 and later, the default start method provided by the
NSOperation class does not catch exceptions. (In OS X v10.5, the start method does catch and suppress
exceptions.) Your own code should always catch and suppress exceptions directly. It should also check error
codes and notify the appropriate parts of your application as needed. And if you replace the start method,
you must similarly catch any exceptions in your custom implementation to prevent them from leaving the
scope of the underlying thread.
Among the types of error situations you should be prepared to handle are the following:
● Check and handle UNIX errno-style error codes.
● Check explicit error codes returned by methods and functions.
● Catch exceptions thrown by your own code or by other system frameworks.
● Catch exceptions thrown by the NSOperation class itself, which throws exceptions in the following
situations:
● When the operation is not ready to execute but its start method is called
● When the operation is executing or finished (possibly because it was canceled) and its start method
is called again
● When you try to add a completion block to an operation that is already executing or finished
● When you try to retrieve the result of an NSInvocationOperation object that was canceled
If your custom code does encounter an exception or error, you should take whatever steps are needed to
propagate that error to the rest of your application. The NSOperation class does not provide explicit methods
for passing along error result codes or exceptionsto other parts of your application. Therefore, ifsuch information
is important to your application, you must provide the necessary code.
Determining an Appropriate Scope for Operation Objects
Although it is possible to add an arbitrarily large number of operations to an operation queue, doing so is
often impractical. Like any object, instances of the NSOperation class consume memory and have real costs
associated with their execution. If each of your operation objects does only a small amount of work, and you
create tens of thousands of them, you may find that you are spending more time dispatching operations than
doing real work. And if your application is already memory-constrained, you might find that just having tens
of thousands of operation objects in memory might degrade performance even further.
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32The key to using operations efficiently isto find an appropriate balance between the amount of work you need
to do and to keep the computer busy. Try to make sure that your operations do a reasonable amount of work.
For example, if your application creates 100 operation objectsto perform the same task on 100 different values,
consider creating 10 operation objects to process 10 values each instead.
You should also avoid adding large numbers of operationsto a queue all at once, or avoid continuously adding
operation objects to a queue faster than they can be processed. Rather than flood a queue with operation
objects, create those objects in batches. As one batch finishes executing, use a completion block to tell your
application to create a new batch. When you have a lot of work to do, you want to keep the queues filled with
enough operations so that the computer stays busy, but you do not want to create so many operations at
once that your application runs out of memory.
Of course, the number of operation objects you create, and the amount of work you perform in each, is variable
and entirely dependent on your application. You should always use tools such as Instruments and Shark to
help you find an appropriate balance between efficiency and speed. For an overview of Instruments, Shark,
and the other performance tools you can use to gather metrics for your code, see Performance Overview.
Executing Operations
Ultimately, your application needs to execute operations in order to do the associated work. In this section,
you learn several waysto execute operations as well as how you can manipulate the execution of your operations
at runtime.
Adding Operations to an Operation Queue
By far, the easiest way to execute operations is to use an operation queue, which is an instance of the
NSOperationQueue class. Your application is responsible for creating and maintaining any operation queues
it intends to use. An application can have any number of queues, but there are practical limits to how many
operations may be executing at a given point in time. Operation queues work with the system to restrict the
number of concurrent operationsto a value that is appropriate for the available cores and system load. Therefore,
creating additional queues does not mean that you can execute additional operations.
To create a queue, you allocate it in your application as you would any other object:
NSOperationQueue* aQueue = [[NSOperationQueue alloc] init];
To add operations to a queue, you use the addOperation: method. In OS X v10.6 and later, you can add
groups of operations using the addOperations:waitUntilFinished: method, or you can add block objects
directly to a queue (without a corresponding operation object) using the addOperationWithBlock: method.
Each of these methods queues up an operation (or operations) and notifies the queue that it should begin
Operation Queues
Executing Operations
2012-07-17   |   © 2012 Apple Inc. All Rights Reserved.
33processing them. In most cases, operations are executed shortly after being added to a queue, but the operation
queue may delay execution of queued operations for any of several reasons. Specifically, execution may be
delayed if queued operations are dependent on other operations that have not yet completed. Execution may
also be delayed if the operation queue itself is suspended or is already executing its maximum number of
concurrent operations. The following examples show the basic syntax for adding operations to a queue.
[aQueue addOperation:anOp]; // Add a single operation
[aQueue addOperations:anArrayOfOps waitUntilFinished:NO]; // Add multiple operations
[aQueue addOperationWithBlock:^{
/* Do something. */
}];
Important:  Never modify an operation object after it has been added to a queue. While waiting in a queue,
the operation could start executing at any time, so changing its dependencies or the data it contains could
have adverse effects. If you want to know the status of an operation, you can use the methods of the
NSOperation class to determine if the operation is running, waiting to run, or already finished.
Although the NSOperationQueue class is designed for the concurrent execution of operations, it is possible
to force a single queue to run only one operation at a time. The setMaxConcurrentOperationCount:
method lets you configure the maximum number of concurrent operations for an operation queue object.
Passing a value of 1 to this method causes the queue to execute only one operation at a time. Although only
one operation at a time may execute, the order of execution isstill based on other factors,such asthe readiness
of each operation and its assigned priority. Thus, a serialized operation queue does not offer quite the same
behavior as a serial dispatch queue in Grand Central Dispatch does. If the execution order of your operation
objectsisimportant to you, you should use dependenciesto establish that order before adding your operations
to a queue. For information about configuring dependencies, see “Configuring Interoperation
Dependencies” (page 29).
For information about using operation queues, see NSOperationQueue Class Reference . For more information
about serial dispatch queues, see “Creating Serial Dispatch Queues” (page 44).
Executing Operations Manually
Although operation queues are the most convenient way to run operation objects, it is also possible to execute
operations without a queue. If you choose to execute operations manually, however, there are some precautions
you should take in your code. In particular, the operation must be ready to run and you must always start it
using its start method.
Operation Queues
Executing Operations
2012-07-17   |   © 2012 Apple Inc. All Rights Reserved.
34An operation is not considered able to run until its isReady method returns YES. The isReady method is
integrated into the dependency management system of the NSOperation class to provide the status of the
operation’s dependencies. Only when its dependencies are cleared is an operation free to begin executing.
When executing an operation manually, you should always use the start method to begin execution. You
use this method, instead of main or some other method, because the start method performs several safety
checks before it actually runs your custom code. In particular, the default start method generates the KVO
notificationsthat operationsrequire to processtheir dependencies correctly. This method also correctly avoids
executing your operation if it has already been canceled and throws an exception if your operation is not actually
ready to run.
If your application defines concurrent operation objects, you should also consider calling the isConcurrent
method of operations prior to launching them. In cases where this method returns NO, your local code can
decide whether to execute the operation synchronously in the current thread or create a separate thread first.
However, implementing this kind of checking is entirely up to you.
Listing 2-8 shows a simple example of the kind of checks you should perform before executing operations
manually. If the method returns NO, you could schedule a timer and call the method again later. You would
then keep rescheduling the timer until the method returns YES, which could occur because the operation was
canceled.
Listing 2-8 Executing an operation object manually
- (BOOL)performOperation:(NSOperation*)anOp
{
BOOL ranIt = NO;
if ([anOp isReady] && ![anOp isCancelled])
{
if (![anOp isConcurrent])
[anOp start];
else
[NSThread detachNewThreadSelector:@selector(start)
toTarget:anOp withObject:nil];
ranIt = YES;
}
else if ([anOp isCancelled])
{
// If it was canceled before it was started,
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35// move the operation to the finished state.
[self willChangeValueForKey:@"isFinished"];
[self willChangeValueForKey:@"isExecuting"];
executing = NO;
finished = YES;
[self didChangeValueForKey:@"isExecuting"];
[self didChangeValueForKey:@"isFinished"];
// Set ranIt to YES to prevent the operation from
// being passed to this method again in the future.
ranIt = YES;
}
return ranIt;
}
Canceling Operations
Once added to an operation queue, an operation object is effectively owned by the queue and cannot be
removed. The only way to dequeue an operation is to cancel it. You can cancel a single individual operation
object by calling its cancel method or you can cancel all of the operation objects in a queue by calling the
cancelAllOperations method of the queue object.
You should cancel operations only when you are sure you no longer need them. Issuing a cancel command
puts the operation object into the “canceled” state, which prevents it from ever being run. Because a canceled
operation is still considered to be “finished”, objects that are dependent on it receive the appropriate KVO
notifications to clear that dependency. Thus, it is more common to cancel all queued operations in response
to some significant event, like the application quitting or the user specifically requesting the cancellation,
rather than cancel operations selectively.
Waiting for Operations to Finish
For the best performance, you should design your operations to be as asynchronous as possible, leaving your
application free to do additional work while the operation executes. If the code that creates an operation also
processes the results of that operation, you can use the waitUntilFinished method of NSOperation to
block that code until the operation finishes. In general, though, it is best to avoid calling this method if you
can help it. Blocking the current thread may be a convenient solution, but it does introduce more serialization
into your code and limits the overall amount of concurrency.
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36Important:  You should never wait for an operation from your application’s main thread. You should only
do so from a secondary thread or from another operation. Blocking your main thread prevents your
application from responding to user events and could make your application appear unresponsive.
In addition to waiting for a single operation to finish, you can also wait on all of the operations in a queue by
calling the waitUntilAllOperationsAreFinished method of NSOperationQueue. When waiting for an
entire queue to finish, be aware that your application’s other threads can still add operations to the queue,
thus prolonging the wait.
Suspending and Resuming Queues
If you want to issue a temporary halt to the execution of operations, you can suspend the corresponding
operation queue using the setSuspended: method. Suspending a queue does not cause already executing
operations to pause in the middle of their tasks. It simply prevents new operations from being scheduled for
execution. You might suspend a queue in response to a user request to pause any ongoing work, because the
expectation is that the user might eventually want to resume that work.
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37Grand Central Dispatch (GCD) dispatch queues are a powerful tool for performing tasks. Dispatch queues let
you execute arbitrary blocks of code either asynchronously or synchronously with respect to the caller. You
can use dispatch queues to perform nearly all of the tasks that you used to perform on separate threads. The
advantage of dispatch queues is that they are simpler to use and much more efficient at executing those tasks
than the corresponding threaded code.
This chapter provides an introduction to dispatch queues, along with information about how to use them to
execute general tasks in your application. If you want to replace existing threaded code with dispatch queues,
you can find some additional tips for how to do that in “Migrating Away from Threads” (page 74).
About Dispatch Queues
Dispatch queues are an easy way to perform tasks asynchronously and concurrently in your application. A task
is simply some work that your application needs to perform. For example, you could define a task to perform
some calculations, create or modify a data structure, process some data read from a file, or any number of
things. You define tasks by placing the corresponding code inside either a function or a block object and adding
it to a dispatch queue.
A dispatch queue is an object-like structure that manages the tasks you submit to it. All dispatch queues are
first-in, first-out data structures. Thus, the tasks you add to a queue are always started in the same order that
they were added. GCD provides some dispatch queues for you automatically, but others you can create for
specific purposes. Table 3-1 lists the types of dispatch queues available to your application and how you use
them.
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Dispatch QueuesTable 3-1 Types of dispatch queues
Type Description
Serial queues (also known as private dispatch queues) execute one task at a time in
the order in which they are added to the queue. The currently executing task runs on
a distinct thread (which can vary from task to task) that is managed by the dispatch
queue. Serial queues are often used to synchronize access to a specific resource.
You can create as many serial queues as you need, and each queue operates concurrently
with respect to all other queues. In other words, if you create four serial queues, each
queue executes only one task at a time but up to four tasks could still execute
concurrently, one from each queue. For information on how to create serial queues, see
“Creating Serial Dispatch Queues” (page 44).
Serial
Concurrent queues (also known as a type of global dispatch queue) execute one or
more tasks concurrently, but tasks are stillstarted in the order in which they were added
to the queue. The currently executing tasks run on distinct threads that are managed
by the dispatch queue. The exact number of tasks executing at any given point is variable
and depends on system conditions.
You cannot create concurrent dispatch queues yourself. Instead, there are three global
concurrent queues for your application to use. For more information on how to get the
global concurrent queues, see “Getting the Global Concurrent Dispatch Queues” (page
43).
Concurrent
The main dispatch queue is a globally available serial queue that executes tasks on the
application’s main thread. This queue works with the application’s run loop (if one is
present) to interleave the execution of queued tasks with the execution of other event
sources attached to the run loop. Because it runs on your application’s main thread, the
main queue is often used as a key synchronization point for an application.
Although you do not need to create the main dispatch queue, you do need to make
sure your application drains it appropriately. For more information on how this queue
is managed, see “Performing Tasks on the Main Thread” (page 51).
Main
dispatch
queue
When it comes to adding concurrency to an application, dispatch queues provide several advantages over
threads. The most direct advantage is the simplicity of the work-queue programming model. With threads,
you have to write code both for the work you want to perform and for the creation and management of the
threads themselves. Dispatch queues let you focus on the work you actually want to perform without having
to worry about the thread creation and management. Instead, the system handles all of the thread creation
and management for you. The advantage is that the system is able to manage threads much more efficiently
than any single application ever could. The system can scale the number of threads dynamically based on the
available resources and current system conditions. In addition, the system is usually able to start running your
task more quickly than you could if you created the thread yourself.
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39Although you might think rewriting your code for dispatch queues would be difficult, it is often easier to write
code for dispatch queues than it is to write code for threads. The key to writing your code is to design tasks
that are self-contained and able to run asynchronously. (This is actually true for both threads and dispatch
queues.) However, where dispatch queues have an advantage is in predictability. If you have two tasks that
access the same shared resource but run on different threads, either thread could modify the resource first
and you would need to use a lock to ensure that both tasks did not modify that resource at the same time.
With dispatch queues, you could add both tasksto a serial dispatch queue to ensure that only one task modified
the resource at any given time. This type of queue-based synchronization is more efficient than locks because
locks alwaysrequire an expensive kernel trap in both the contested and uncontested cases, whereas a dispatch
queue works primarily in your application’s process space and only calls down to the kernel when absolutely
necessary.
Although you would be right to point out that two tasks running in a serial queue do not run concurrently,
you have to remember that if two threads take a lock at the same time, any concurrency offered by the threads
is lost or significantly reduced. More importantly, the threaded model requires the creation of two threads,
which take up both kernel and user-space memory. Dispatch queues do not pay the same memory penalty
for their threads, and the threads they do use are kept busy and not blocked.
Some other key points to remember about dispatch queues include the following:
● Dispatch queues execute their tasks concurrently with respect to other dispatch queues. The serialization
of tasks is limited to the tasks in a single dispatch queue.
● The system determines the total number of tasks executing at any one time. Thus, an application with 100
tasks in 100 different queues may not execute all of those tasks concurrently (unless it has 100 or more
effective cores).
● The system takes queue priority levelsinto account when choosing which new tasksto start. For information
about how to set the priority of a serial queue, see “Providing a Clean Up Function For a Queue” (page
46).
● Tasks in a queue must be ready to execute at the time they are added to the queue. (If you have used
Cocoa operation objects before, notice that this behavior differs from the model operations use.)
● Private dispatch queues are reference-counted objects. In addition to retaining the queue in your own
code, be aware that dispatch sources can also be attached to a queue and also increment its retain count.
Thus, you must make sure that all dispatch sources are canceled and all retain calls are balanced with an
appropriate release call. For more information about retaining and releasing queues, see “Memory
Management for Dispatch Queues” (page 45). For more information about dispatch sources, see “About
Dispatch Sources” (page 56).
For more information about interfaces you use to manipulate dispatch queues, see Grand Central Dispatch
(GCD) Reference .
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40Queue-Related Technologies
In addition to dispatch queues, Grand Central Dispatch provides several technologies that use queues to help
manage your code. Table 3-2 lists these technologies and provides links to where you can find out more
information about them.
Table 3-2 Technologies that use dispatch queues
Technology Description
A dispatch group is a way to monitor a set of block objects for completion. (You can
monitor the blocks synchronously or asynchronously depending on your needs.)
Groups provide a useful synchronization mechanism for code that depends on the
completion of other tasks. For more information about using groups, see “Waiting
on Groups of Queued Tasks” (page 53).
Dispatch
groups
A dispatch semaphore is similar to a traditional semaphore but is generally more
efficient. Dispatch semaphores call down to the kernel only when the calling thread
needs to be blocked because the semaphore is unavailable. If the semaphore is
available, no kernel call is made. For an example of how to use dispatch semaphores,
see “Using Dispatch Semaphores to Regulate the Use of Finite Resources” (page 52).
Dispatch
semaphores
A dispatch source generates notifications in response to specific types of system
events. You can use dispatch sourcesto monitor eventssuch as process notifications,
signals, and descriptor events among others. When an event occurs, the dispatch
source submits your task code asynchronously to the specified dispatch queue for
processing. For more information about creating and using dispatch sources, see
“Dispatch Sources” (page 56).
Dispatch
sources
Implementing Tasks Using Blocks
Block objects are a C-based language feature that you can use in your C, Objective-C, and C++ code. Blocks make
it easy to define a self-contained unit of work. Although they might seem akin to function pointers, a block is
actually represented by an underlying data structure that resembles an object and is created and managed
for you by the compiler. The compiler packages up the code you provide (along with any related data) and
encapsulates it in a form that can live in the heap and be passed around your application.
One of the key advantages of blocks is their ability to use variables from outside their own lexical scope. When
you define a block inside a function or method, the block acts as a traditional code block would in some ways.
For example, a block can read the values of variables defined in the parent scope. Variables accessed by the
block are copied to the block data structure on the heap so that the block can access them later. When blocks
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41are added to a dispatch queue, these values must typically be left in a read-only format. However, blocks that
are executed synchronously can also use variables that have the __block keyword prepended to return data
back to the parent’s calling scope.
You declare blocks inline with your code using a syntax that is similar to the syntax used for function pointers.
The main difference between a block and a function pointer is that the block name is preceded with a caret
(^) instead of an asterisk (*). Like a function pointer, you can pass arguments to a block and receive a return
value from it. Listing 3-1 shows you how to declare and execute blockssynchronously in your code. The variable
aBlock is declared to be a block that takes a single integer parameter and returns no value. An actual block
matching that prototype is then assigned to aBlock and declared inline. The last line executes the block
immediately, printing the specified integers to standard out.
Listing 3-1 A simple block example
int x = 123;
int y = 456;
// Block declaration and assignment
void (^aBlock)(int) = ^(int z) {
printf("%d %d %d\n", x, y, z);
};
// Execute the block
aBlock(789); // prints: 123 456 789
The following is a summary of some of the key guidelines you should consider when designing your blocks:
● For blocks that you plan to perform asynchronously using a dispatch queue, it is safe to capture scalar
variables from the parent function or method and use them in the block. However, you should not try to
capture large structures or other pointer-based variables that are allocated and deleted by the calling
context. By the time your block is executed, the memory referenced by that pointer may be gone. Of
course, it issafe to allocate memory (or an object) yourself and explicitly hand off ownership of that memory
to the block.
● Dispatch queues copy blocks that are added to them, and they release blocks when they finish executing.
In other words, you do not need to explicitly copy blocks before adding them to a queue.
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42● Although queues are more efficient than raw threads at executing small tasks, there is still overhead to
creating blocks and executing them on a queue. If a block doestoo little work, it may be cheaper to execute
it inline than dispatch it to a queue. The way to tell if a block is doing too little work is to gather metrics
for each path using the performance tools and compare them.
● Do not cache data relative to the underlying thread and expect that data to be accessible from a different
block. If tasks in the same queue need to share data, use the context pointer of the dispatch queue to
store the data instead. For more information on how to access the context data of a dispatch queue, see
“Storing Custom Context Information with a Queue” (page 46).
●
If your block creates more than a few Objective-C objects, you might want to enclose parts of your block’s
code in an @autorelease block to handle the memory management for those objects. Although GCD
dispatch queues have their own autorelease pools, they make no guarantees as to when those pools are
drained. If your application is memory constrained, creating your own autorelease pool allows you to free
up the memory for autoreleased objects at more regular intervals.
For more information about blocks, including how to declare and use them, see Blocks Programming Topics.
For information about how you add blocks to a dispatch queue, see “Adding Tasks to a Queue” (page 47).
Creating and Managing Dispatch Queues
Before you add your tasks to a queue, you have to decide what type of queue to use and how you intend to
use it. Dispatch queues can execute tasks either serially or concurrently. In addition, if you have a specific use
for the queue in mind, you can configure the queue attributes accordingly. The following sections show you
how to create dispatch queues and configure them for use.
Getting the Global Concurrent Dispatch Queues
A concurrent dispatch queue is useful when you have multiple tasks that can run in parallel. A concurrent
queue is still a queue in that it dequeues tasks in a first-in, first-out order; however, a concurrent queue may
dequeue additional tasks before any previoustasksfinish. The actual number of tasks executed by a concurrent
queue at any given moment is variable and can change dynamically as conditions in your application change.
Many factors affect the number of tasks executed by the concurrent queues, including the number of available
cores, the amount of work being done by other processes, and the number and priority of tasks in other serial
dispatch queues.
The system provides each application with three concurrent dispatch queues. These queues are global to the
application and are differentiated only by their priority level. Because they are global, you do not create them
explicitly. Instead, you ask for one of the queues using the dispatch_get_global_queue function, asshown
in the following example:
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43dispatch_queue_t aQueue = dispatch_get_global_queue(DISPATCH_QUEUE_PRIORITY_DEFAULT,
0);
In addition to getting the default concurrent queue, you can also get queues with high- and low-priority levels
by passing in the DISPATCH_QUEUE_PRIORITY_HIGH and DISPATCH_QUEUE_PRIORITY_LOW constants to
the function instead. As you might expect, tasks in the high-priority concurrent queue execute before those
in the default and low-priority queues. Similarly, tasks in the default queue execute before those in the
low-priority queue.
Note:  The second argument to the dispatch_get_global_queue function is reserved for future
expansion. For now, you should always pass 0 for this argument.
Although dispatch queues are reference-counted objects, you do not need to retain and release the global
concurrent queues. Because they are global to your application, retain and release calls for these queues are
ignored. Therefore, you do not need to store references to these queues. You can just call the
dispatch_get_global_queue function whenever you need a reference to one of them.
Creating Serial Dispatch Queues
Serial queues are useful when you want your tasks to execute in a specific order. A serial queue executes only
one task at a time and always pulls tasks from the head of the queue. You might use a serial queue instead of
a lock to protect a shared resource or mutable data structure. Unlike a lock, a serial queue ensures that tasks
are executed in a predictable order. And as long as you submit your tasks to a serial queue asynchronously,
the queue can never deadlock.
Unlike concurrent queues, which are created for you, you must explicitly create and manage any serial queues
you want to use. You can create any number of serial queues for your application but should avoid creating
large numbers of serial queues solely as a means to execute as many tasks simultaneously as you can. If you
want to execute large numbers of tasks concurrently, submit them to one of the global concurrent queues.
When creating serial queues, try to identify a purpose for each queue, such as protecting a resource or
synchronizing some key behavior of your application.
Listing 3-2 shows the steps required to create a custom serial queue. The dispatch_queue_create function
takes two parameters: the queue name and a set of queue attributes. The debugger and performance tools
display the queue name to help you track how your tasks are being executed. The queue attributes are reserved
for future use and should be NULL.
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44Listing 3-2 Creating a new serial queue
dispatch_queue_t queue;
queue = dispatch_queue_create("com.example.MyQueue", NULL);
In addition to any custom queues you create, the system automatically creates a serial queue and binds it to
your application’s main thread. For more information about getting the queue for the main thread,see “Getting
Common Queues at Runtime” (page 45).
Getting Common Queues at Runtime
Grand Central Dispatch provides functions to let you access several common dispatch queues from your
application:
● Use the dispatch_get_current_queue function for debugging purposes or to test the identity of the
current queue. Calling this function from inside a block object returns the queue to which the block was
submitted (and on which it is now presumably running). Calling this function from outside of a block
returns the default concurrent queue for your application.
● Use the dispatch_get_main_queue function to get the serial dispatch queue associated with your
application’s main thread. This queue is created automatically for Cocoa applications and for applications
that either call the dispatch_main function or configure a run loop (using either the CFRunLoopRef
type or an NSRunLoop object) on the main thread.
● Use the dispatch_get_global_queue function to get any of the shared concurrent queues. For more
information, see “Getting the Global Concurrent Dispatch Queues” (page 43).
Memory Management for Dispatch Queues
Dispatch queues and other dispatch objects are reference-counted data types. When you create a serial dispatch
queue, it has an initial reference count of 1. You can use the dispatch_retain and dispatch_release
functions to increment and decrement that reference count as needed. When the reference count of a queue
reaches zero, the system asynchronously deallocates the queue.
It is important to retain and release dispatch objects, such as queues, to ensure that they remain in memory
while they are being used. As with memory-managed Cocoa objects, the general rule is that if you plan to use
a queue that was passed to your code, you should retain the queue before you use it and release it when you
no longer need it. This basic pattern ensures that the queue remains in memory for as long as you are using
it.
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45Note:  You do not need to retain or release any of the global dispatch queues, including the
concurrent dispatch queues or the main dispatch queue. Any attemptsto retain or release the queues
are ignored.
Even if you implement a garbage-collected application, you must still retain and release your dispatch queues
and other dispatch objects. Grand Central Dispatch does notsupport the garbage collection model for reclaiming
memory.
Storing Custom Context Information with a Queue
All dispatch objects (including dispatch queues) allow you to associate custom context data with the object.
To set and get this data on a given object, you use the dispatch_set_context and dispatch_get_context
functions. The system does not use your custom data in any way, and it is up to you to both allocate and
deallocate the data at the appropriate times.
For queues, you can use context data to store a pointer to an Objective-C object or other data structure that
helps identify the queue or its intended usage to your code. You can use the queue’s finalizer function to
deallocate (or disassociate) your context data from the queue before it is deallocated. An example of how to
write a finalizer function that clears a queue’s context data is shown in Listing 3-3 (page 46).
Providing a Clean Up Function For a Queue
After you create a serial dispatch queue, you can attach a finalizer function to perform any custom clean up
when the queue is deallocated. Dispatch queues are reference counted objects and you can use the
dispatch_set_finalizer_f function to specify a function to be executed when the reference count of
your queue reaches zero. You use this function to clean up the context data associated with a queue and the
function is called only if the context pointer is not NULL.
Listing 3-3 shows a custom finalizer function and a function that creates a queue and installs that finalizer. The
queue uses the finalizer function to release the data stored in the queue’s context pointer. (The
myInitializeDataContextFunction and myCleanUpDataContextFunction functionsreferenced from
the code are custom functions that you would provide to initialize and clean up the contents of the data
structure itself.) The context pointer passed to the finalizer function contains the data object associated with
the queue.
Listing 3-3 Installing a queue clean up function
void myFinalizerFunction(void *context)
{
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46MyDataContext* theData = (MyDataContext*)context;
// Clean up the contents of the structure
myCleanUpDataContextFunction(theData);
// Now release the structure itself.
free(theData);
}
dispatch_queue_t createMyQueue()
{
MyDataContext* data = (MyDataContext*) malloc(sizeof(MyDataContext));
myInitializeDataContextFunction(data);
// Create the queue and set the context data.
dispatch_queue_t serialQueue =
dispatch_queue_create("com.example.CriticalTaskQueue", NULL);
if (serialQueue)
{
dispatch_set_context(serialQueue, data);
dispatch_set_finalizer_f(serialQueue, &myFinalizerFunction);
}
return serialQueue;
}
Adding Tasks to a Queue
To execute a task, you must dispatch it to an appropriate dispatch queue. You can dispatch taskssynchronously
or asynchronously, and you can dispatch them singly or in groups. Once in a queue, the queue becomes
responsible for executing your tasks as soon as possible, given its constraints and the existing tasks already in
the queue. This section shows you some of the techniques for dispatching tasks to a queue and describes the
advantages of each.
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There are two ways to add a task to a queue: asynchronously or synchronously. When possible, asynchronous
execution using the dispatch_async and dispatch_async_f functions is preferred over the synchronous
alternative. When you add a block object or function to a queue, there is no way to know when that code will
execute. As a result, adding blocks or functions asynchronously lets you schedule the execution of the code
and continue to do other work from the calling thread. This is especially important if you are scheduling the
task from your application’s main thread—perhaps in response to some user event.
Although you should add tasks asynchronously whenever possible, there may still be times when you need
to add a task synchronously to prevent race conditions or other synchronization errors. In these instances, you
can use the dispatch_sync and dispatch_sync_f functions to add the task to the queue. These functions
block the current thread of execution until the specified task finishes executing.
Important:  You should never call the dispatch_sync or dispatch_sync_f function from a task that
is executing in the same queue that you are planning to pass to the function. This is particularly important
for serial queues, which are guaranteed to deadlock, but should also be avoided for concurrent queues.
The following example shows how to use the block-based variants for dispatching tasks asynchronously and
synchronously:
dispatch_queue_t myCustomQueue;
myCustomQueue = dispatch_queue_create("com.example.MyCustomQueue", NULL);
dispatch_async(myCustomQueue, ^{
printf("Do some work here.\n");
});
printf("The first block may or may not have run.\n");
dispatch_sync(myCustomQueue, ^{
printf("Do some more work here.\n");
});
printf("Both blocks have completed.\n");
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48Performing a Completion Block When a Task Is Done
By their nature, tasks dispatched to a queue run independently of the code that created them. However, when
the task is done, your application might still want to be notified of that fact so that it can incorporate the
results. With traditional asynchronous programming, you might do this using a callback mechanism, but with
dispatch queues you can use a completion block.
A completion block is just another piece of code that you dispatch to a queue at the end of your original task.
The calling code typically provides the completion block as a parameter when it starts the task. All the task
code has to do is submit the specified block or function to the specified queue when it finishes its work.
Listing 3-4 shows an averaging function implemented using blocks. The last two parameters to the averaging
function allow the caller to specify a queue and block to use when reporting the results. After the averaging
function computes its value, it passes the results to the specified block and dispatches it to the queue. To
prevent the queue from being released prematurely, it is critical to retain that queue initially and release it
once the completion block has been dispatched.
Listing 3-4 Executing a completion callback after a task
void average_async(int *data, size_t len,
dispatch_queue_t queue, void (^block)(int))
{
// Retain the queue provided by the user to make
// sure it does not disappear before the completion
// block can be called.
dispatch_retain(queue);
// Do the work on the default concurrent queue and then
// call the user-provided block with the results.
dispatch_async(dispatch_get_global_queue(DISPATCH_QUEUE_PRIORITY_DEFAULT, 0),
^{
int avg = average(data, len);
dispatch_async(queue, ^{ block(avg);});
// Release the user-provided queue when done
dispatch_release(queue);
});
}
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49Performing Loop Iterations Concurrently
One place where concurrent dispatch queues might improve performance is in places where you have a loop
that performs a fixed number of iterations. For example, suppose you have a for loop that does some work
through each loop iteration:
for (i = 0; i < count; i++) {
printf("%u\n",i);
}
If the work performed during each iteration is distinct from the work performed during all other iterations,
and the order in which each successive loop finishes is unimportant, you can replace the loop with a call to
the dispatch_apply or dispatch_apply_f function. These functionssubmit the specified block or function
to a queue once for each loop iteration. When dispatched to a concurrent queue, it is therefore possible to
perform multiple loop iterations at the same time.
You can specify either a serial queue or a concurrent queue when calling dispatch_apply or
dispatch_apply_f. Passing in a concurrent queue allows you to perform multiple loop iterations
simultaneously and isthe most common way to use these functions. Although using a serial queue is permissible
and does the right thing for your code, using such a queue has no real performance advantages over leaving
the loop in place.
Important:  Like a regular for loop, the dispatch_apply and dispatch_apply_f functions do not
return until all loop iterations are complete. You should therefore be careful when calling them from code
that is already executing from the context of a queue. If the queue you pass as a parameter to the function
is a serial queue and is the same one executing the current code, calling these functions will deadlock the
queue.
Because they effectively block the current thread, you should also be careful when calling these functions
from your main thread, where they could prevent your event handling loop from responding to events in
a timely manner. If your loop code requires a noticeable amount of processing time, you might want to
call these functions from a different thread.
Listing 3-5 shows how to replace the preceding for loop with the dispatch_apply syntax. The block you
pass in to the dispatch_apply function must contain a single parameter that identifies the current loop
iteration. When the block is executed, the value of this parameter is 0 for the first iteration, 1 for the second,
and so on. The value of the parameter for the last iteration is count - 1, where count is the total number
of iterations.
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50Listing 3-5 Performing the iterations of a for loop concurrently
dispatch_queue_t queue = dispatch_get_global_queue(DISPATCH_QUEUE_PRIORITY_DEFAULT,
0);
dispatch_apply(count, queue, ^(size_t i) {
printf("%u\n",i);
});
You should make sure that your task code does a reasonable amount of work through each iteration. As with
any block or function you dispatch to a queue, there is overhead to scheduling that code for execution. If each
iteration of your loop performs only a small amount of work, the overhead ofscheduling the code may outweigh
the performance benefits you might achieve from dispatching it to a queue. If you find this is true during your
testing, you can use striding to increase the amount of work performed during each loop iteration. With striding,
you group together multiple iterations of your original loop into a single block and reduce the iteration count
proportionately. For example, if you perform 100 iterations initially but decide to use a stride of 4, you now
perform 4 loop iterations from each block and your iteration count is 25. For an example of how to implement
striding, see “Improving on Loop Code” (page 77).
Performing Tasks on the Main Thread
Grand Central Dispatch provides a special dispatch queue that you can use to execute tasks on your application’s
main thread. This queue is provided automatically for all applications and is drained automatically by any
application that sets up a run loop (managed by either a CFRunLoopRef type or NSRunLoop object) on its
main thread. If you are not creating a Cocoa application and do not want to set up a run loop explicitly, you
must call the dispatch_main function to drain the main dispatch queue explicitly. You can still add tasks to
the queue, but if you do not call this function those tasks are never executed.
You can get the dispatch queue for your application’s main thread by calling the dispatch_get_main_queue
function. Tasks added to this queue are performed serially on the main thread itself. Therefore, you can use
this queue as a synchronization point for work being done in other parts of your application.
Using Objective-C Objects in Your Tasks
GCD provides built-in support for Cocoa memory management techniques so you may freely use Objective-C
objects in the blocks you submit to dispatch queues. Each dispatch queue maintains its own autorelease pool
to ensure that autoreleased objects are released at some point; queues make no guarantee about when they
actually release those objects.
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51If your application is memory constrained and your block creates more than a few autoreleased objects, creating
your own autorelease pool is the only way to ensure that your objects are released in a timely manner. If your
block creates hundreds of objects, you might want to create more than one autorelease pool or drain your
pool at regular intervals.
For more information about autorelease pools and Objective-C memory management, see Advanced Memory
Management Programming Guide .
Suspending and Resuming Queues
You can prevent a queue from executing block objects temporarily by suspending it. You suspend a dispatch
queue using the dispatch_suspend function and resume it using the dispatch_resume function. Calling
dispatch_suspend increments the queue’s suspension reference count, and calling dispatch_resume
decrementsthe reference count. While the reference count is greater than zero, the queue remainssuspended.
Therefore, you must balance allsuspend calls with a matching resume call in order to resume processing blocks.
Important:  Suspend and resume calls are asynchronous and take effect only between the execution of
blocks. Suspending a queue does not cause an already executing block to stop.
Using Dispatch Semaphoresto Regulate the Use of Finite Resources
If the tasks you are submitting to dispatch queues access some finite resource, you may want to use a dispatch
semaphore to regulate the number of tasks simultaneously accessing that resource. A dispatch semaphore
works like a regular semaphore with one exception. When resources are available, it takes less time to acquire
a dispatch semaphore than it does to acquire a traditional system semaphore. This is because Grand Central
Dispatch does not call down into the kernel for this particular case. The only time it calls down into the kernel
is when the resource is not available and the system needsto park your thread until the semaphore issignaled.
The semantics for using a dispatch semaphore are as follows:
1. When you create the semaphore (using the dispatch_semaphore_create function), you can specify
a positive integer indicating the number of resources available.
2. In each task, call dispatch_semaphore_wait to wait on the semaphore.
3. When the wait call returns, acquire the resource and do your work.
4. When you are done with the resource, release it and signal the semaphore by calling the
dispatch_semaphore_signal function.
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52For an example of how these steps work, consider the use of file descriptors on the system. Each application
is given a limited number of file descriptors to use. If you have a task that processes large numbers of files, you
do not want to open so many files at one time that you run out of file descriptors. Instead, you can use a
semaphore to limit the number of file descriptors in use at any one time by your file-processing code. The
basic pieces of code you would incorporate into your tasks is as follows:
// Create the semaphore, specifying the initial pool size
dispatch_semaphore_t fd_sema = dispatch_semaphore_create(getdtablesize() / 2);
// Wait for a free file descriptor
dispatch_semaphore_wait(fd_sema, DISPATCH_TIME_FOREVER);
fd = open("/etc/services", O_RDONLY);
// Release the file descriptor when done
close(fd);
dispatch_semaphore_signal(fd_sema);
When you create the semaphore, you specify the number of available resources. This value becomes the initial
count variable for the semaphore. Each time you wait on the semaphore, the dispatch_semaphore_wait
function decrements that count variable by 1. If the resulting value is negative, the function tells the kernel to
block your thread. On the other end, the dispatch_semaphore_signal function increments the count
variable by 1 to indicate that a resource has been freed up. If there are tasks blocked and waiting for a resource,
one of them is subsequently unblocked and allowed to do its work.
Waiting on Groups of Queued Tasks
Dispatch groups are a way to block a thread until one or more tasks finish executing. You can use this behavior
in places where you cannot make progress until all of the specified tasks are complete. For example, after
dispatching several tasksto compute some data, you might use a group to wait on those tasks and then process
the results when they are done. Another way to use dispatch groupsis as an alternative to thread joins. Instead
of starting several child threads and then joining with each of them, you could add the corresponding tasks
to a dispatch group and wait on the entire group.
Listing 3-6 shows the basic process for setting up a group, dispatching tasks to it, and waiting on the results.
Instead of dispatching tasks to a queue using the dispatch_async function, you use the
dispatch_group_async function instead. This function associates the task with the group and queues it for
execution. To wait on a group of tasks to finish, you then use the dispatch_group_wait function, passing
in the appropriate group.
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53Listing 3-6 Waiting on asynchronous tasks
dispatch_queue_t queue = dispatch_get_global_queue(DISPATCH_QUEUE_PRIORITY_DEFAULT,
0);
dispatch_group_t group = dispatch_group_create();
// Add a task to the group
dispatch_group_async(group, queue, ^{
// Some asynchronous work
});
// Do some other work while the tasks execute.
// When you cannot make any more forward progress,
// wait on the group to block the current thread.
dispatch_group_wait(group, DISPATCH_TIME_FOREVER);
// Release the group when it is no longer needed.
dispatch_release(group);
Dispatch Queues and Thread Safety
It might seem odd to talk about thread safety in the context of dispatch queues, but thread safety is still a
relevant topic. Any time you are implementing concurrency in your application, there are a few things you
should know:
● Dispatch queues themselves are thread safe. In other words, you can submit tasks to a dispatch queue
from any thread on the system without first taking a lock or synchronizing access to the queue.
● Do not call the dispatch_sync function from a task that is executing on the same queue that you pass
to your function call. Doing so will deadlock the queue. If you need to dispatch to the current queue, do
so asynchronously using the dispatch_async function.
● Avoid taking locks from the tasks you submit to a dispatch queue. Although it is safe to use locks from
your tasks, when you acquire the lock, you risk blocking a serial queue entirely if that lock is unavailable.
Similarly, for concurrent queues, waiting on a lock might prevent other tasks from executing instead. If
you need to synchronize parts of your code, use a serial dispatch queue instead of a lock.
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54● Although you can obtain information about the underlying thread running a task, it is better to avoid
doing so. For more information about the compatibility of dispatch queues with threads,see “Compatibility
with POSIX Threads” (page 82).
For additional tips on how to change your existing threaded code to use dispatch queues,see “Migrating Away
from Threads” (page 74).
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55Whenever you interact with the underlying system, you must be prepared for that task to take a nontrivial
amount of time. Calling down to the kernel or othersystem layersinvolves a change in context that isreasonably
expensive compared to calls that occur within your own process. As a result, many system libraries provide
asynchronous interfaces to allow your code to submit a request to the system and continue to do other work
while that request is processed. Grand Central Dispatch builds on this general behavior by allowing you to
submit your request and have the results reported back to your code using blocks and dispatch queues.
About Dispatch Sources
A dispatch source is a fundamental data type that coordinates the processing of specific low-level system
events. Grand Central Dispatch supports the following types of dispatch sources:
● Timer dispatch sources generate periodic notifications.
● Signal dispatch sources notify you when a UNIX signal arrives.
● Descriptor sources notify you of various file- and socket-based operations, such as:
● When data is available for reading
● When it is possible to write data
● When files are deleted, moved, or renamed in the file system
● When file meta information changes
● Process dispatch sources notify you of process-related events, such as:
● When a process exits
● When a process issues a fork or exec type of call
● When a signal is delivered to the process
● Mach port dispatch sources notify you of Mach-related events.
● Custom dispatch sources are ones you define and trigger yourself.
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Dispatch SourcesDispatch sourcesreplace the asynchronous callback functionsthat are typically used to processsystem-related
events. When you configure a dispatch source, you specify the events you want to monitor and the dispatch
queue and code to use to process those events. You can specify your code using block objects or functions.
When an event of interest arrives, the dispatch source submits your block or function to the specified dispatch
queue for execution.
Unlike tasks that you submit to a queue manually, dispatch sources provide a continuous source of events for
your application. A dispatch source remains attached to its dispatch queue until you cancel it explicitly. While
attached, it submits its associated task code to the dispatch queue whenever the corresponding event occurs.
Some events, such as timer events, occur at regular intervals but most occur only sporadically as specific
conditions arise. For this reason, dispatch sources retain their associated dispatch queue to prevent it from
being released prematurely while events may still be pending.
To prevent events from becoming backlogged in a dispatch queue, dispatch sources implement an event
coalescing scheme. If a new event arrives before the event handler for a previous event has been dequeued
and executed, the dispatch source coalesces the data from the new event data with data from the old event.
Depending on the type of event, coalescing may replace the old event or update the information it holds. For
example, a signal-based dispatch source provides information about only the most recent signal but also
reports how many total signals have been delivered since the last invocation of the event handler.
Creating Dispatch Sources
Creating a dispatch source involves creating both the source of the events and the dispatch source itself. The
source of the events is whatever native data structures are required to process the events. For example, for a
descriptor-based dispatch source you would need to open the descriptor and for a process-based source you
would need to obtain the process ID of the target program. When you have your event source, you can then
create the corresponding dispatch source as follows:
1. Create the dispatch source using the dispatch_source_create function.
2. Configure the dispatch source:
● Assign an event handler to the dispatch source; see “Writing and Installing an Event Handler” (page
58).
● For timer sources, set the timer information using the dispatch_source_set_timer function; see
“Creating a Timer” (page 62).
3. Optionally assign a cancellation handler to the dispatch source;see “Installing a Cancellation Handler” (page
60).
4. Call the dispatch_resume function to start processing events; see “Suspending and Resuming Dispatch
Sources” (page 73).
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57Because dispatch sources require some additional configuration before they can be used, the
dispatch_source_create function returns dispatch sources in a suspended state. While suspended, a
dispatch source receives events but does not process them. This gives you time to install an event handler and
perform any additional configuration needed to process the actual events.
The following sections show you how to configure various aspects of a dispatch source. For detailed examples
showing you how to configure specific types of dispatch sources, see “Dispatch Source Examples” (page 62).
For additional information about the functions you use to create and configure dispatch sources, see Grand
Central Dispatch (GCD) Reference .
Writing and Installing an Event Handler
To handle the events generated by a dispatch source, you must define an event handler to process those
events. An event handler is a function or block object that you install on your dispatch source using the
dispatch_source_set_event_handler or dispatch_source_set_event_handler_f function. When
an event arrives, the dispatch source submits your event handler to the designated dispatch queue for
processing.
The body of your event handler is responsible for processing any events that arrive. If your event handler is
already queued and waiting to process an event when a new event arrives, the dispatch source coalesces the
two events. An event handler generally sees information only for the most recent event, but depending on
the type of the dispatch source it may also be able to get information about other events that occurred and
were coalesced. If one or more new events arrive after the event handler has begun executing, the dispatch
source holds onto those events until the current event handler has finished executing. At that point, it submits
the event handler to the queue again with the new events.
Function-based event handlerstake a single context pointer, containing the dispatch source object, and return
no value. Block-based event handlers take no parameters and have no return value.
// Block-based event handler
void (^dispatch_block_t)(void)
// Function-based event handler
void (*dispatch_function_t)(void *)
Inside your event handler, you can get information about the given event from the dispatch source itself.
Although function-based event handlers are passed a pointer to the dispatch source as a parameter, block-based
event handlers must capture that pointer themselves. You can do thisfor your blocks by referencing the variable
containing the dispatch source normally. For example, the following code snippet capturesthe source variable,
which is declared outside the scope of the block.
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58dispatch_source_t source = dispatch_source_create(DISPATCH_SOURCE_TYPE_READ,
myDescriptor, 0, myQueue);
dispatch_source_set_event_handler(source, ^{
// Get some data from the source variable, which is captured
// from the parent context.
size_t estimated = dispatch_source_get_data(source);
// Continue reading the descriptor...
});
dispatch_resume(source);
Capturing variablesinside of a block is commonly done to allow for greater flexibility and dynamism. Of course,
captured variables are read-only within the block by default. Although the blocks feature provides support for
modifying captured variables under specific circumstances, you should not attempt to do so in the event
handlers associated with a dispatch source. Dispatch sources always execute their event handlers asynchronously,
so the defining scope of any variables you captured is likely gone by the time your event handler executes.
For more information about how to capture and use variables inside of blocks, see Blocks Programming Topics.
Table 4-1 lists the functions you can call from your event handler code to obtain information about an event.
Table 4-1 Getting data from a dispatch source
Function Description
Thisfunction returnsthe underlying system data type that the dispatch source
manages.
For a descriptor dispatch source, this function returns an int type containing
the descriptor associated with the dispatch source.
For a signal dispatch source, this function returns an int type containing the
signal number for the most recent event.
For a process dispatch source, this function returns a pid_t data structure
for the process being monitored.
For a Mach port dispatch source, this function returns a mach_port_t data
structure.
For other dispatch sources, the value returned by this function is undefined.
dispatch_source_-
get_handle
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59Function Description
This function returns any pending data associated with the event.
For a descriptor dispatch source that reads data from a file, this function
returns the number of bytes available for reading.
For a descriptor dispatch source that writes data to a file, this function returns
a positive integer if space is available for writing.
For a descriptor dispatch source that monitorsfile system activity, thisfunction
returns a constant indicating the type of event that occurred. For a list of
constants, see the dispatch_source_vnode_flags_t enumerated type.
For a process dispatch source, this function returns a constant indicating the
type of event that occurred. For a list of constants, see the
dispatch_source_proc_flags_t enumerated type.
For a Mach port dispatch source, this function returns a constant indicating
the type of event that occurred. For a list of constants, see the
dispatch_source_machport_flags_t enumerated type.
For a custom dispatch source, thisfunction returnsthe new data value created
from the existing data and the new data passed to the
dispatch_source_merge_data function.
dispatch_source_-
get_data
This function returns the event flags that were used to create the dispatch
source.
For a process dispatch source, this function returns a mask of the events that
the dispatch source receives. For a list of constants, see the
dispatch_source_proc_flags_t enumerated type.
For a Mach port dispatch source with send rights, thisfunction returns a mask
of the desired events. For a list of constants, see the dispatch_source_-
mach_send_flags_t enumerated type.
For a custom OR dispatch source, thisfunction returnsthe mask used to merge
the data values.
dispatch_source_-
get_mask
Forsome examples of how to write and install event handlersforspecific types of dispatch sources,see “Dispatch
Source Examples” (page 62).
Installing a Cancellation Handler
Cancellation handlers are used to clean up a dispatch source before it is released. For most types of dispatch
sources, cancellation handlers are optional and only necessary if you have some custom behaviors tied to the
dispatch source that also need to be updated. For dispatch sourcesthat use a descriptor or Mach port, however,
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60you must provide a cancellation handler to close the descriptor or release the Mach port. Failure to do so can
lead to subtle bugs in your code resulting from those structures being reused unintentionally by your code or
other parts of the system.
You can install a cancellation handler at any time but usually you would do so when creating the dispatch
source. You install a cancellation handler using the dispatch_source_set_cancel_handler or
dispatch_source_set_cancel_handler_f function, depending on whether you want to use a block object
or a function in your implementation. The following example shows a simple cancellation handler that closes
a descriptor that was opened for a dispatch source. The fd variable is a captured variable containing the
descriptor.
dispatch_source_set_cancel_handler(mySource, ^{
close(fd); // Close a file descriptor opened earlier.
});
To see a complete code example for a dispatch source that uses a cancellation handler, see “Reading Data
from a Descriptor” (page 64).
Changing the Target Queue
Although you specify the queue on which to run your event and cancellation handlers when you create a
dispatch source, you can change that queue at any time using the dispatch_set_target_queue function.
You might do this to change the priority at which the dispatch source’s events are processed.
Changing a dispatch source’s queue is an asynchronous operation and the dispatch source does its best to
make the change as quickly as possible. If an event handler is already queued and waiting to be processed, it
executes on the previous queue. However, other events arriving around the time you make the change could
be processed on either queue.
Associating Custom Data with a Dispatch Source
Like many other data types in Grand Central Dispatch, you can use the dispatch_set_context function to
associate custom data with a dispatch source. You can use the context pointer to store any data your event
handler needs to process events. If you do store any custom data in the context pointer, you should also install
a cancellation handler (as described in “Installing a Cancellation Handler” (page 60)) to release that data when
the dispatch source is no longer needed.
If you implement your event handler using blocks, you can also capture local variables and use them within
your block-based code. Although this might alleviate the need to store data in the context pointer of the
dispatch source, you should always use this feature judiciously. Because dispatch sources may be long-lived
in your application, you should be careful when capturing variables containing pointers. If the data pointed
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61to by a pointer could be deallocated at any time, you should either copy the data or retain it to prevent that
from happening. In either case, you would then need to provide a cancellation handler to release the data
later.
Memory Management for Dispatch Sources
Like other dispatch objects, dispatch sources are reference counted data types. A dispatch source has an initial
reference count of 1 and can be retained and released using the dispatch_retain and dispatch_release
functions. When the reference count of a queue reaches zero, the system automatically deallocatesthe dispatch
source data structures.
Because of the way they are used, the ownership of dispatch sources can be managed either internally or
externally to the dispatch source itself. With external ownership, another object or piece of code takes ownership
of the dispatch source and is responsible for releasing it when it is no longer needed. With internal ownership,
the dispatch source ownsitself and isresponsible for releasing itself at the appropriate time. Although external
ownership is very common, you might use internal ownership in cases where you want to create an autonomous
dispatch source and let it manage some behavior of your code without any further interactions. For example,
if a dispatch source is designed to respond to a single global event, you might have it handle that event and
then exit immediately.
Dispatch Source Examples
The following sections show you how to create and configure some of the more commonly used dispatch
sources. For more information about configuring specific types of dispatch sources,see Grand Central Dispatch
(GCD) Reference .
Creating a Timer
Timer dispatch sources generate events at regular, time-based intervals. You can use timers to initiate specific
tasksthat need to be performed regularly. For example, games and other graphics-intensive applications might
use timers to initiate screen or animation updates. You could also set up a timer and use the resulting events
to check for new information on a frequently updated server.
All timer dispatch sources are interval timers—that is, once created, they deliver regular events at the interval
you specify. When you create a timer dispatch source, one of the values you must specify is a leeway value to
give the system some idea of the desired accuracy for timer events. Leeway values give the system some
flexibility in how it manages power and wakes up cores. For example, the system might use the leeway value
to advance or delay the fire time and align it better with other system events. You should therefore specify a
leeway value whenever possible for your own timers.
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62Note:  Even if you specify a leeway value of 0, you should never expect a timer to fire at the exact
nanosecond you requested. The system does its best to accommodate your needs but cannot
guarantee exact firing times.
When a computer goes to sleep, all timer dispatch sources are suspended. When the computer wakes up,
those timer dispatch sources are automatically woken up as well. Depending on the configuration of the timer,
pauses of this nature may affect when your timer fires next. If you set up your timer dispatch source using the
dispatch_time function or the DISPATCH_TIME_NOW constant, the timer dispatch source uses the default
system clock to determine when to fire. However, the default clock does not advance while the computer is
asleep. By contrast, when you set up your timer dispatch source using the dispatch_walltime function, the
timer dispatch source tracks its firing time to the wall clock time. This latter option is typically appropriate for
timers whose firing interval is relatively large because it prevents there from being too much drift between
event times.
Listing 4-1 shows an example of a timer that fires once every 30 seconds and has a leeway value of 1 second.
Because the timer interval is relatively large, the dispatch source is created using the dispatch_walltime
function. The first firing of the timer occurs immediately and subsequent events arrive every 30 seconds. The
MyPeriodicTask and MyStoreTimer symbolsrepresent custom functionsthat you would write to implement
the timer behavior and to store the timer somewhere in your application’s data structures.
Listing 4-1 Creating a timer dispatch source
dispatch_source_t CreateDispatchTimer(uint64_t interval,
uint64_t leeway,
dispatch_queue_t queue,
dispatch_block_t block)
{
dispatch_source_t timer = dispatch_source_create(DISPATCH_SOURCE_TYPE_TIMER,
0, 0, queue);
if (timer)
{
dispatch_source_set_timer(timer, dispatch_walltime(NULL, 0), interval,
leeway);
dispatch_source_set_event_handler(timer, block);
dispatch_resume(timer);
}
return timer;
}
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63void MyCreateTimer()
{
dispatch_source_t aTimer = CreateDispatchTimer(30ull * NSEC_PER_SEC,
1ull * NSEC_PER_SEC,
dispatch_get_main_queue(),
^{ MyPeriodicTask(); });
// Store it somewhere for later use.
if (aTimer)
{
MyStoreTimer(aTimer);
}
}
Although creating a timer dispatch source isthe main way to receive time-based events, there are other options
available as well. If you want to perform a block once after a specified time interval, you can use the
dispatch_after or dispatch_after_f function. This function behaves much like the dispatch_async
function except that it allows you to specify a time value at which to submit the block to a queue. The time
value can be specified as a relative or absolute time value depending on your needs.
Reading Data from a Descriptor
To read data from a file or socket, you must open the file or socket and create a dispatch source of type
DISPATCH_SOURCE_TYPE_READ. The event handler you specify should be capable of reading and processing
the contents of the file descriptor. In the case of a file, this amounts to reading the file data (or a subset of that
data) and creating the appropriate data structures for your application. For a network socket, this involves
processing newly received network data.
Whenever reading data, you should always configure your descriptor to use non-blocking operations. Although
you can use the dispatch_source_get_data function to see how much data is available for reading, the
number returned by that function could change between the time you make the call and the time you actually
read the data. If the underlying file istruncated or a network error occurs, reading from a descriptor that blocks
the current thread could stall your event handler in mid execution and prevent the dispatch queue from
dispatching other tasks. For a serial queue, this could deadlock your queue, and even for a concurrent queue
this reduces the number of new tasks that can be started.
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64Listing 4-2 shows an example that configures a dispatch source to read data from a file. In this example, the
event handler reads the entire contents of the specified file into a buffer and calls a custom function (that you
would define in your own code) to processthe data. (The caller of thisfunction would use the returned dispatch
source to cancel it once the read operation was completed.) To ensure that the dispatch queue does not block
unnecessarily when there is no data to read, this example usesthe fcntl function to configure the file descriptor
to perform nonblocking operations. The cancellation handler installed on the dispatch source ensures that the
file descriptor is closed after the data is read.
Listing 4-2 Reading data from a file
dispatch_source_t ProcessContentsOfFile(const char* filename)
{
// Prepare the file for reading.
int fd = open(filename, O_RDONLY);
if (fd == -1)
return NULL;
fcntl(fd, F_SETFL, O_NONBLOCK); // Avoid blocking the read operation
dispatch_queue_t queue =
dispatch_get_global_queue(DISPATCH_QUEUE_PRIORITY_DEFAULT, 0);
dispatch_source_t readSource = dispatch_source_create(DISPATCH_SOURCE_TYPE_READ,
fd, 0, queue);
if (!readSource)
{
close(fd);
return NULL;
}
// Install the event handler
dispatch_source_set_event_handler(readSource, ^{
size_t estimated = dispatch_source_get_data(readSource) + 1;
// Read the data into a text buffer.
char* buffer = (char*)malloc(estimated);
if (buffer)
{
ssize_t actual = read(fd, buffer, (estimated));
Boolean done = MyProcessFileData(buffer, actual); // Process the data.
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65// Release the buffer when done.
free(buffer);
// If there is no more data, cancel the source.
if (done)
dispatch_source_cancel(readSource);
}
});
// Install the cancellation handler
dispatch_source_set_cancel_handler(readSource, ^{close(fd);});
// Start reading the file.
dispatch_resume(readSource);
return readSource;
}
In the preceding example, the custom MyProcessFileData function determines when enough file data has
been read and the dispatch source can be canceled. By default, a dispatch source configured for reading from
a descriptor schedules its event handler repeatedly while there is still data to read. If the socket connection
closes or you reach the end of a file, the dispatch source automatically stops scheduling the event handler. If
you know you do not need a dispatch source though, you can cancel it directly yourself.
Writing Data to a Descriptor
The process for writing data to a file or socket is very similar to the process for reading data. After configuring
a descriptor for write operations, you create a dispatch source of type DISPATCH_SOURCE_TYPE_WRITE. Once
that dispatch source is created, the system calls your event handler to give it a chance to start writing data to
the file or socket. When you are finished writing data, use the dispatch_source_cancel function to cancel
the dispatch source.
Whenever writing data, you should always configure your file descriptor to use non-blocking operations.
Although you can use the dispatch_source_get_data function to see how much space is available for
writing, the value returned by that function is advisory only and could change between the time you make
the call and the time you actually write the data. If an error occurs, writing data to a blocking file descriptor
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66could stall your event handler in mid execution and prevent the dispatch queue from dispatching other tasks.
For a serial queue, this could deadlock your queue, and even for a concurrent queue this reduces the number
of new tasks that can be started.
Listing 4-3 shows the basic approach for writing data to a file using a dispatch source. After creating the new
file, this function passes the resulting file descriptor to its event handler. The data being put into the file is
provided by the MyGetData function, which you would replace with whatever code you needed to generate
the data for the file. After writing the data to the file, the event handler cancels the dispatch source to prevent
it from being called again. The owner of the dispatch source would then be responsible for releasing it.
Listing 4-3 Writing data to a file
dispatch_source_t WriteDataToFile(const char* filename)
{
int fd = open(filename, O_WRONLY | O_CREAT | O_TRUNC,
(S_IRUSR | S_IWUSR | S_ISUID | S_ISGID));
if (fd == -1)
return NULL;
fcntl(fd, F_SETFL); // Block during the write.
dispatch_queue_t queue =
dispatch_get_global_queue(DISPATCH_QUEUE_PRIORITY_DEFAULT, 0);
dispatch_source_t writeSource =
dispatch_source_create(DISPATCH_SOURCE_TYPE_WRITE,
fd, 0, queue);
if (!writeSource)
{
close(fd);
return NULL;
}
dispatch_source_set_event_handler(writeSource, ^{
size_t bufferSize = MyGetDataSize();
void* buffer = malloc(bufferSize);
size_t actual = MyGetData(buffer, bufferSize);
write(fd, buffer, actual);
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67free(buffer);
// Cancel and release the dispatch source when done.
dispatch_source_cancel(writeSource);
});
dispatch_source_set_cancel_handler(writeSource, ^{close(fd);});
dispatch_resume(writeSource);
return (writeSource);
}
Monitoring a File-System Object
If you want to monitor a file system object for changes, you can set up a dispatch source of type
DISPATCH_SOURCE_TYPE_VNODE. You can use this type of dispatch source to receive notifications when a
file is deleted, written to, or renamed. You can also use it to be alerted when specific types of meta information
for a file (such as its size and link count) change.
Note:  The file descriptor you specify for your dispatch source must remain open while the source
itself is processing events.
Listing 4-4 shows an example that monitors a file for name changes and performssome custom behavior when
it does. (You would provide the actual behavior in place of the MyUpdateFileName function called in the
example.) Because a descriptor is opened specifically for the dispatch source, the dispatch source includes a
cancellation handler that closesthe descriptor. Because the file descriptor created by the example is associated
with the underlying file-system object, thissame dispatch source can be used to detect any number of filename
changes.
Listing 4-4 Watching for filename changes
dispatch_source_t MonitorNameChangesToFile(const char* filename)
{
int fd = open(filename, O_EVTONLY);
if (fd == -1)
return NULL;
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dispatch_get_global_queue(DISPATCH_QUEUE_PRIORITY_DEFAULT, 0);
dispatch_source_t source = dispatch_source_create(DISPATCH_SOURCE_TYPE_VNODE,
fd, DISPATCH_VNODE_RENAME, queue);
if (source)
{
// Copy the filename for later use.
int length = strlen(filename);
char* newString = (char*)malloc(length + 1);
newString = strcpy(newString, filename);
dispatch_set_context(source, newString);
// Install the event handler to process the name change
dispatch_source_set_event_handler(source, ^{
const char* oldFilename = (char*)dispatch_get_context(source);
MyUpdateFileName(oldFilename, fd);
});
// Install a cancellation handler to free the descriptor
// and the stored string.
dispatch_source_set_cancel_handler(source, ^{
char* fileStr = (char*)dispatch_get_context(source);
free(fileStr);
close(fd);
});
// Start processing events.
dispatch_resume(source);
}
else
close(fd);
return source;
}
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UNIX signals allow the manipulation of an application from outside of its domain. An application can receive
many different types of signals ranging from unrecoverable errors (such as illegal instructions) to notifications
about important information (such as when a child process exits). Traditionally, applications use the sigaction
function to install a signal handler function, which processes signals synchronously as soon as they arrive. If
you just want to be notified of a signal’s arrival and do not actually want to handle the signal, you can use a
signal dispatch source to process the signals asynchronously.
Signal dispatch sources are not a replacement for the synchronous signal handlers you install using the
sigaction function. Synchronous signal handlers can actually catch a signal and prevent it from terminating
your application. Signal dispatch sources allow you to monitor only the arrival of the signal. In addition, you
cannot use signal dispatch sources to retrieve all types of signals. Specifically, you cannot use them to monitor
the SIGILL, SIGBUS, and SIGSEGV signals.
Because signal dispatch sources are executed asynchronously on a dispatch queue, they do not suffer from
some of the same limitations as synchronous signal handlers. For example, there are no restrictions on the
functions you can call from yoursignal dispatch source’s event handler. The tradeoff for thisincreased flexibility
is the fact that there may be some increased latency between the time a signal arrives and the time your
dispatch source’s event handler is called.
Listing 4-5 shows how you configure a signal dispatch source to handle the SIGHUP signal. The event handler
for the dispatch source calls the MyProcessSIGHUP function, which you would replace in your application
with code to process the signal.
Listing 4-5 Installing a block to monitor signals
void InstallSignalHandler()
{
// Make sure the signal does not terminate the application.
signal(SIGHUP, SIG_IGN);
dispatch_queue_t queue =
dispatch_get_global_queue(DISPATCH_QUEUE_PRIORITY_DEFAULT, 0);
dispatch_source_t source = dispatch_source_create(DISPATCH_SOURCE_TYPE_SIGNAL,
SIGHUP, 0, queue);
if (source)
{
dispatch_source_set_event_handler(source, ^{
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});
// Start processing signals
dispatch_resume(source);
}
}
If you are developing code for a custom framework, an advantage of using signal dispatch sources is that your
code can monitor signals independent of any applications linked to it. Signal dispatch sources do not interfere
with other dispatch sources or any synchronous signal handlers the application might have installed.
For more information about implementing synchronous signal handlers, and for a list of signal names, see
signal man page.
Monitoring a Process
A process dispatch source lets you monitor the behavior of a specific process and respond appropriately. A
parent process might use this type of dispatch source to monitor any child processes it creates. For example,
the parent process could use it to watch for the death of a child process. Similarly, a child process could use it
to monitor its parent process and exit if the parent process exits.
Listing 4-6 shows the steps for installing a dispatch source to monitor for the termination of a parent process.
When the parent process dies, the dispatch source sets some internal state information to let the child process
know it should exit. (Your own application would need to implement the MySetAppExitFlag function to set
an appropriate flag for termination.) Because the dispatch source runs autonomously, and therefore owns
itself, it also cancels and releases itself in anticipation of the program shutting down.
Listing 4-6 Monitoring the death of a parent process
void MonitorParentProcess()
{
pid_t parentPID = getppid();
dispatch_queue_t queue =
dispatch_get_global_queue(DISPATCH_QUEUE_PRIORITY_DEFAULT, 0);
dispatch_source_t source = dispatch_source_create(DISPATCH_SOURCE_TYPE_PROC,
parentPID, DISPATCH_PROC_EXIT,
queue);
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{
dispatch_source_set_event_handler(source, ^{
MySetAppExitFlag();
dispatch_source_cancel(source);
dispatch_release(source);
});
dispatch_resume(source);
}
}
Canceling a Dispatch Source
Dispatch sourcesremain active until you cancel them explicitly using the dispatch_source_cancel function.
Canceling a dispatch source stops the delivery of new events and cannot be undone. Therefore, you typically
cancel a dispatch source and then immediately release it, as shown here:
void RemoveDispatchSource(dispatch_source_t mySource)
{
dispatch_source_cancel(mySource);
dispatch_release(mySource);
}
Cancellation of a dispatch source is an asynchronous operation. Although no new events are processed after
you call the dispatch_source_cancel function, events that are already being processed by the dispatch
source continue to be processed. After it finishes processing any final events, the dispatch source executes its
cancellation handler if one is present.
The cancellation handler is your chance to deallocate memory or clean up any resources that were acquired
on behalf of the dispatch source. If your dispatch source uses a descriptor or mach port, you must provide a
cancellation handler to close the descriptor or destroy the port when cancellation occurs. Other types of
dispatch sources do not require cancellation handlers, although you still should provide one if you associate
any memory or data with the dispatch source. For example, you should provide one if you store data in the
dispatch source’s context pointer. For more information about cancellation handlers,see “Installing a Cancellation
Handler” (page 60).
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72Suspending and Resuming Dispatch Sources
You can suspend and resume the delivery of dispatch source eventstemporarily using the dispatch_suspend
and dispatch_resume methods. These methods increment and decrement the suspend count for your
dispatch object. As a result, you must balance each call to dispatch_suspend with a matching call to
dispatch_resume before event delivery resumes.
When you suspend a dispatch source, any events that occur while that dispatch source is suspended are
accumulated until the queue is resumed. When the queue resumes, rather than deliver all of the events, the
events are coalesced into a single event before delivery. For example, if you were monitoring a file for name
changes, the delivered event would include only the last name change. Coalescing events in this way prevents
them from building up in the queue and overwhelming your application when work resumes.
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73There are many ways to adapt existing threaded code to take advantage of Grand Central Dispatch and
operation objects. Although moving away from threads may not be possible in all cases, performance (and
the simplicity of your code) can improve dramatically in places where you do make the switch. Specifically,
using dispatch queues and operation queues instead of threads has several advantages:
●
It reduces the memory penalty your application pays for storing thread stacks in the application’s memory
space.
●
It eliminates the code needed to create and configure your threads.
●
It eliminates the code needed to manage and schedule work on threads.
●
It simplifies the code you have to write.
This chapter providessome tips and guidelines on how to replace your existing thread-based code and instead
use dispatch queues and operation queues to achieve the same types of behaviors.
Replacing Threads with Dispatch Queues
To understand how you might replace threads with dispatch queues, first considersome of the ways you might
be using threads in your application today:
● Single task threads. Create a thread to perform a single task and release the thread when the task is done.
● Worker threads. Create one or more worker threads with specific tasks in mind for each. Dispatch tasks
to each thread periodically.
● Thread pools. Create a pool of generic threads and set up run loops for each one. When you have a task
to perform, grab a thread from the pool and dispatch the task to it. If there are no free threads, queue the
task and wait for a thread to become available.
Although these might seem like dramatically different techniques, they are really just variants on the same
principle. In each case, a thread is being used to run some task that the application has to perform. The only
difference between them is the code used to manage the threads and the queueing of tasks. With dispatch
queues and operation queues, you can eliminate all of your thread and thread-communication code and
instead focus on just the tasks you want to perform.
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Migrating Away from ThreadsIf you are using one of the above threading models, you should already have a pretty good idea of the type
of tasks your application performs. Instead ofsubmitting a task to one of your custom threads, try encapsulating
that task in an operation object or a block object and dispatching it to the appropriate queue. For tasks that
are not particularly contentious—that is, tasksthat do not take locks—you should be able to make the following
direct replacements:
● For a single task thread, encapsulate the task in a block or operation object and submit it to a concurrent
queue.
● For worker threads, you need to decide whether to use a serial queue or a concurrent queue. If you use
worker threads to synchronize the execution of specific sets of tasks, use a serial queue. If you do use
worker threads to execute arbitrary tasks with no interdependencies, use a concurrent queue.
● For thread pools, encapsulate your tasks in a block or operation object and dispatch them to a concurrent
queue for execution.
Of course, simple replacements like this may not work in all cases. If the tasks you are executing contend for
shared resources, the ideal solution is to try to remove or minimize that contention first. If there are ways that
you can refactor or rearchitect your code to eliminate mutual dependencies on shared resources, that is certainly
preferable. However, if doing so is not possible or might be less efficient, there are still ways to take advantage
of queues. A big advantage of queues is that they offer a more predictable way to execute your code. This
predictability means that there are still ways to synchronize the execution of your code without using locks or
other heavyweight synchronization mechanisms. Instead of using locks, you can use queues to perform many
of the same tasks:
●
If you have tasksthat must execute in a specific order,submit them to a serial dispatch queue. If you prefer
to use operation queues, use operation object dependencies to ensure that those objects execute in a
specific order.
●
If you are currently using locks to protect a shared resource, create a serial queue to execute any tasks
that modify that resource. The serial queue then replaces your existing locks as the synchronization
mechanism. For more information techniques for getting rid of locks, see “Eliminating Lock-Based
Code” (page 76).
●
If you use thread joins to wait for background tasks to complete, consider using dispatch groups instead.
You can also use an NSBlockOperation object or operation object dependencies to achieve similar
group-completion behaviors. Formore information on how to track groups of executing tasks,see “Replacing
Thread Joins” (page 79).
●
If you use a producer-consumer algorithm to manage a pool of finite resources, consider changing your
implementation to the one shown in “Changing Producer-Consumer Implementations” (page 80).
●
If you are using threads to read and write from descriptors, or monitor file operations, use the dispatch
sources as described in “Dispatch Sources” (page 56).
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75It isimportant to remember that queues are not a panacea for replacing threads. The asynchronous programming
model offered by queues is appropriate in situations where latency is not an issue. Even though queues offer
ways to configure the execution priority of tasks in the queue, higher execution priorities do not guarantee
the execution of tasks at specific times. Therefore, threads are still a more appropriate choice in cases where
you need minimal latency, such as in audio and video playback.
Eliminating Lock-Based Code
For threaded code, locks are one of the traditional ways to synchronize access to resources that are shared
between threads. However, the use of locks comes at a cost. Even in the non-contested case, there is always
a performance penalty associated with taking a lock. And in the contested case, there is the potential for one
or more threads to block for an indeterminate amount of time while waiting for the lock to be released.
Replacing your lock-based code with queues eliminates many of the penalties associated with locks and also
simplifies your remaining code. Instead of using a lock to protect a shared resource, you can instead create a
queue to serialize the tasks that access that resource. Queues do not impose the same penalties as locks. For
example, queueing a task does not require trapping into the kernel to acquire a mutex.
When queueing tasks, the main decision you have to make is whether to do so synchronously or asynchronously.
Submitting a task asynchronously letsthe current thread continue to run while the task is performed. Submitting
a task synchronously blocksthe current thread until the task is completed. Both options have appropriate uses,
although it is certainly advantageous to submit tasks asynchronously whenever you can.
The following sectionsshow you how to replace your existing lock-based code with the equivalent queue-based
code.
Implementing an Asynchronous Lock
An asynchronous lock is a way for you to protect a shared resource without blocking any code that modifies
that resource. You might use an asynchronous lock when you need to modify a data structure as a side effect
of some other work your code is doing. Using traditional threads, the way you would normally implement this
code would be to take a lock for the shared resource, make the necessary changes, release the lock, and
continue with the main part of your task. However, using dispatch queues, the calling code can make the
modifications asynchronously without waiting for those changes to be completed.
Listing 5-1 shows an example of an asynchronouslock implementation. In this example, the protected resource
defines its own serial dispatch queue. The calling code submits a block object to this queue that contains the
modifications that need to be made to the resource. Because the queue itself executes blocks serially, changes
to the resource are guaranteed to be made in the order in which they were received; however, because the
task was executed asynchronously, the calling thread does not block.
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76Listing 5-1 Modifying protected resources asynchronously
dispatch_async(obj->serial_queue, ^{
// Critical section
});
Executing Critical Sections Synchronously
If the current code cannot continue until a given task is complete, you can submit the task synchronously using
the dispatch_sync function. This function adds the task to a dispatch queue and then blocks the current
thread until the task finishes executing. The dispatch queue itself can be a serial or concurrent queue depending
on your needs. Because thisfunction blocksthe current thread, though, you should use it only when necessary.
Listing 5-2 shows the technique for wrapping a critical section of your code using dispatch_sync.
Listing 5-2 Running critical sections synchronously
dispatch_sync(my_queue, ^{
// Critical section
});
If you are already using a serial queue to protect a shared resource, dispatching to that queue synchronously
does not protect the shared resource any more than if you dispatched asynchronously. The only reason to
dispatch synchronously is to prevent the current code from continuing until the critical section finishes. For
example, if you wanted to get some value from the shared resource and use it right away, you would need to
dispatch synchronously. If the current code does not need to wait for the critical section to complete, or if it
can simply submit additional follow-up tasks to the same serial queue, submitting asynchronously is generally
preferred.
Improving on Loop Code
If your code has loops, and the work being done each time through the loop is independent of the work being
done in the other iterations, you might consider reimplementing that loop code using the dispatch_apply
or dispatch_apply_f function. These functions submit each iteration of a loop separately to a dispatch
queue for processing. When used in conjunction with a concurrent queue, thisfeature lets you perform multiple
iterations of the loop concurrently.
Migrating Away from Threads
Improving on Loop Code
2012-07-17   |   © 2012 Apple Inc. All Rights Reserved.
77The dispatch_apply and dispatch_apply_f functions are synchronous function calls that block the
current thread of execution until all of the loop iterations are complete. When submitted to a concurrent queue,
the execution order of the loop iterations is not guaranteed. The threads running each iteration could block
and cause a given iteration to finish before or after the others around it. Therefore, the block object or function
you use for each loop iteration must be reentrant.
Listing 5-3 shows how to replace a for loop with its dispatch-based equivalent. The block or function you pass
to dispatch_apply or dispatch_apply_f must take an integer value indicating the current loop iteration.
In this example, the code simply prints the current loop number to the console.
Listing 5-3 Replacing a for loop without striding
queue = dispatch_get_global_queue(DISPATCH_QUEUE_PRIORITY_DEFAULT, 0);
dispatch_apply(count, queue, ^(size_t i) {
printf("%u\n", i);
});
Although the preceding example is a simplistic one, it demonstrates the basic techniques for replacing a loop
using dispatch queues. And although this can be a good way to improve performance in loop-based code,
you must still use this technique discerningly. Although dispatch queues have very low overhead, there are
still costs to scheduling each loop iteration on a thread. Therefore, you should make sure your loop code does
enough work to warrant the costs. Exactly how much work you need to do is something you have to measure
using the performance tools.
A simple way to increase the amount of work in each loop iteration is to use striding. With striding, you rewrite
your block code to perform more than one iteration of the original loop. You then reduce the count value you
specify to the dispatch_apply function by a proportional amount. Listing 5-4 shows how youmightimplement
striding for the loop code shown in Listing 5-3 (page 78). In Listing 5-4, the block calls the printf statement
the same number of times as the stride value, which in this case is 137. (The actual stride value is something
you should configure based on the work being done by your code.) Because there is a remainder left over
when dividing the total number of iterations by a stride value, any remaining iterations are performed inline.
Listing 5-4 Adding a stride to a dispatched for loop
int stride = 137;
dispatch_queue_t queue = dispatch_get_global_queue(DISPATCH_QUEUE_PRIORITY_DEFAULT,
0);
dispatch_apply(count / stride, queue, ^(size_t idx){
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78size_t j = idx * stride;
size_t j_stop = j + stride;
do {
printf("%u\n", (unsigned int)j++);
}while (j < j_stop);
});
size_t i;
for (i = count - (count % stride); i < count; i++)
printf("%u\n", (unsigned int)i);
There are some definite performance advantages to using strides. In particular, strides offer benefits when the
original number of loop iterations is high, relative to the stride. Dispatching fewer blocks concurrently means
that more time is spent executing the code of those blocks than dispatching them. As with any performance
metric though, you may have to play with the striding value to find the most efficient value for your code.
Replacing Thread Joins
Thread joins allow you to spawn one or more threads and then have the current thread wait until those threads
are finished. To implement a thread join, a parent creates a child thread as a joinable thread. When the parent
can no longer make progress without the results from a child thread, it joins with the child. This process blocks
the parent thread until the child finishes its task and exits, at which point the parent can gather the results
from the child and continue with its own work. If the parent needs to join with multiple child threads, it does
so one at a time.
Dispatch groups offer semantics that are similar to those of thread joins but that have some additional
advantages. Like thread joins, dispatch groups are a way for a thread to block until one or more child tasks
finishes executing. Unlike thread joins, a dispatch group waits on all of its child tasks simultaneously. And
because dispatch groups use dispatch queues to perform the work, they are very efficient.
To use a dispatch group to perform the same work performed by joinable threads, you would do the following:
1. Create a new dispatch group using the dispatch_group_create function.
2. Add tasks to the group using the dispatch_group_async or dispatch_group_async_f function.
Each task you submit to the group represents work you would normally perform on a joinable thread.
3. When the current thread cannot make any more forward progress, call the dispatch_group_wait
function to wait on the group. This function blocks the current thread until all of the tasks in the group
finish executing.
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dependencies. Instead of having a parent thread wait for one or more tasks to complete, you would move the
parent code to an operation object. You would then set up dependencies between the parent operation object
and any number of child operation objects set up to do the work normally performed by the joinable threads.
Having dependencies on other operation objects prevents the parent operation object from executing until
all of the operations have finished.
For an example of how to use dispatch groups, see “Waiting on Groups of Queued Tasks” (page 53). For
information about setting up dependencies between operation objects, see “Configuring Interoperation
Dependencies” (page 29).
Changing Producer-Consumer Implementations
A producer-consumer model lets you manage a finite number of dynamically produced resources. While the
producer creates new resources (or work), one or more consumers wait for those resources (or work) to be
ready and consume them when they are. The typical mechanisms for implementing a producer-consumer
model are conditions or semaphores.
Using conditions, the producer thread typically does the following:
1. Lock the mutex associated with the condition (using pthread_mutex_lock).
2. Produce the resource or work to be consumed.
3. Signal the condition variable that there is something to consume (using pthread_cond_signal)
4. Unlock the mutex (using pthread_mutex_unlock).
In turn, the corresponding consumer thread does the following:
1. Lock the mutex associated with the condition (using pthread_mutex_lock).
2. Set up a while loop to do the following:
a. Check to see whether there is really work to be done.
b. If there is no work to do (or no resource available), call pthread_cond_wait to block the current
thread until a corresponding signal occurs.
3. Get the work (or resource) provided by the producer.
4. Unlock the mutex (using pthread_mutex_unlock).
5. Process the work.
With dispatch queues, you can simplify the producer and consumer implementations into a single call:
Migrating Away from Threads
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80dispatch_async(queue, ^{
// Process a work item.
});
When your producer has work to be done, all it hasto do is add that work to a queue and let the queue process
the item. The only part of the preceding code that changes is the queue type. If the tasks generated by the
producer need to be performed in a specific order, you use a serial queue. If the tasks generated by the producer
can be performed concurrently, you add them to a concurrent queue and let the system execute as many of
them as possible simultaneously.
Replacing Semaphore Code
If you are currently using semaphoresto restrict accessto a shared resource, you should consider using dispatch
semaphores instead. Traditional semaphores always require calling down to the kernel to test the semaphore.
In contrast, dispatch semaphores test the semaphore state quickly in user space and trap into the kernel only
when the test fails and the calling thread needs to be blocked. This behavior results in dispatch semaphores
being much faster than traditional semaphores in the uncontested case. In all other aspects, though, dispatch
semaphores offer the same behavior as traditional semaphores.
For an example of how to use dispatch semaphores, see “Using Dispatch Semaphores to Regulate the Use of
Finite Resources” (page 52).
Replacing Run-Loop Code
If you are using run loops to manage the work being performed on one or more threads, you may find that
queues are much simpler to implement and maintain going forward. Setting up a custom run loop involves
setting up both the underlying thread and the run loop itself. The run-loop code consists of setting up one or
more run loop sources and writing callbacks to handle events arriving on those sources. Instead of all that
work, you can simply create a serial queue and dispatch tasks to it. Thus, you can replace all of your thread
and run-loop creation code with one line of code:
dispatch_queue_t myNewRunLoop = dispatch_queue_create("com.apple.MyQueue", NULL);
Migrating Away from Threads
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the queue. You do not have to create or configure a thread, and you do not have to create or attach any
run-loop sources. In addition, you can perform new types of work on the queue by simply adding the tasks to
it. To do the same thing with a run loop, you would need to modify your existing run loop source or create a
new one to handle the new data.
One common configuration for run loops is to process data arriving asynchronously on a network socket.
Instead of configuring a run loop for this type of behavior, you can attach a dispatch source to the desired
queue. Dispatch sources also offer more options for processing data than traditional run loop sources. In
addition to processing timer and network port events, you can use dispatch sources to read and write to files,
monitor file system objects, monitor processes, and monitor signals. You can even define custom dispatch
sources and trigger them from other parts of your code asynchronously. For more information on setting up
dispatch sources, see “Dispatch Sources” (page 56).
Compatibility with POSIX Threads
Because Grand Central Dispatch manages the relationship between the tasks you provide and the threads on
which those tasks run, you should generally avoid calling POSIX thread routines from your task code. If you do
need to call them for some reason, you should be very careful about which routines you call. This section
provides you with an indication of which routines are safe to call and which are not safe to call from your
queued tasks. This list is not complete but should give you an indication of what is safe to call and what is not.
In general, your application must not delete or mutate objects or data structures that it did not create.
Consequently, block objects that are executed using a dispatch queue must not call the following functions:
pthread_detach
pthread_cancel
pthread_join
pthread_kill
pthread_exit
Although it is alright to modify the state of a thread while your task is running, you must return the thread to
its original state before your task returns. Therefore, it is safe to call the following functions as long as you
return the thread to its original state:
pthread_setcancelstate
pthread_setcanceltype
pthread_setschedparam
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Compatibility with POSIX Threads
2012-07-17   |   © 2012 Apple Inc. All Rights Reserved.
82pthread_sigmask
pthread_setspecific
The underlying thread used to execute a given block can change from invocation to invocation. As a result,
your application should not rely on the following functions returning predictable results between invocations
of your block:
pthread_self
pthread_getschedparam
pthread_get_stacksize_np
pthread_get_stackaddr_np
pthread_mach_thread_np
pthread_from_mach_thread_np
pthread_getspecific
Important:  Blocks must catch and suppress any language-level exceptions thrown within them. Other errors
that occur during the execution of your block should similarly be handled by the block or used to notify
other parts of your application.
For more information about POSIX threads and the functions mentioned in this section, see the pthread man
pages.
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83application  A specific style of program that displays
a graphical interface to the user.
asynchronous design approach  The principle of
organizing an application around blocks of code that
can be run concurrently with an application’s main
thread or other threads of execution. Asynchronous
tasks are started by one thread but actually run on
a different thread, taking advantage of additional
processor resourcesto finish their work more quickly.
block object  A C construct for encapsulating inline
code and data so that it can be performed later. You
use blocksto encapsulate tasks you want to perform,
either inline in the current thread or on a separate
thread using a dispatch queue. For more information,
see Blocks Programming Topics.
concurrent operation  An operation object that
does not perform its task in the thread from which
its start method was called. A concurrent operation
typically sets up its own thread or calls an interface
that sets up a separate thread on which to perform
the work.
condition  A construct used to synchronize access
to a resource. A thread waiting on a condition is not
allowed to proceed until another thread explicitly
signals the condition.
critical section  A portion of code that must be
executed by only one thread at a time.
custom source  A dispatch source used to process
application-defined events. A custom source calls
your custom event handler in response to events
that your application generates.
descriptor  An abstract identifier used to access a
file, socket, or other system resource.
dispatch queue  A Grand Central Dispatch (GCD)
structure that you use to execute your application’s
tasks. GCD defines dispatch queues for executing
tasks either serially or concurrently.
dispatch source  A Grand Central Dispatch (GCD)
data structure that you create to process
system-related events.
descriptor dispatch source  A dispatch source used
to processfile-related events. A file descriptorsource
calls your custom event handler either when file data
is available for reading or writing or in response to
file system changes.
dynamic shared library  A binary executable that
is loaded dynamically into an application’s process
space rather than linked statically as part of the
application binary.
framework  A type of bundle that packages a
dynamic shared library with the resources and
header files that support that library. For more
information, see Framework Programming Guide .
global dispatch queue  A dispatch queue provided
to your application automatically by Grand Central
Dispatch (GCD). You do not have to create global
queues yourself or retain or release them. Instead,
you retrieve them using the system-provided
functions.
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GlossaryGrand Central Dispatch (GCD)  A technology for
executing asynchronous tasks concurrently. GCD is
available in OS X v10.6 and later and iOS 4.0 and
later.
input source  A source of asynchronous events for
a thread. Input sources can be port based or
manually triggered and must be attached to the
thread’s run loop.
joinable thread  A thread whose resources are not
reclaimed immediately upon termination. Joinable
threads must be explicitly detached or be joined by
another thread before the resources can be
reclaimed. Joinable threads provide a return value
to the thread that joins with them.
library  A UNIX feature for monitoring low-level
system events. For more information see the kqueue
man page.
Mach port dispatch source  A dispatch source used
to process events arriving on a Mach port.
main thread  A special type of thread created when
its owning processis created. When the main thread
of a program exits, the process ends.
mutex  A lock that provides mutually exclusive
access to a shared resource. A mutex lock can be
held by only one thread at a time. Attempting to
acquire a mutex held by a different thread puts the
current thread to sleep until the lock is finally
acquired.
Open Computing Language (OpenCL)  A
standards-based technology for performing
general-purpose computations on a computer’s
graphics processor. For more information, see
OpenCL Programming Guide for Mac .
operation object  An instance of the NSOperation
class. Operation objects wrap the code and data
associated with a task into an executable unit.
operation queue  An instance of the
NSOperationQueue class. Operation queues
manage the execution of operation objects.
private dispatch queue  A dispatch queue that you
create, retain, and release explicitly.
process  The runtime instance of an application or
program. A process hasits own virtualmemory space
and system resources(including port rights) that are
independent of those assigned to other programs.
A process always contains at least one thread (the
main thread) and may contain any number of
additional threads.
process dispatch source  A dispatch source used
to handle process-related events. A process source
calls your custom event handler in response to
changes to the process you specify.
program  A combination of code and resourcesthat
can be run to perform some task. Programs need
not have a graphical user interface, although
graphical applications are also considered programs.
reentrant  Code that can be started on a new thread
safely while it is already running on another thread.
run loop  An event-processing loop, during which
events are received and dispatched to appropriate
handlers.
run loop mode  A collection of input sources, timer
sources, and run loop observers associated with a
particular name. When run in a specific “mode,” a
run loop monitors only the sources and observers
associated with that mode.
run loop object  An instance of the NSRunLoop
class or CFRunLoopRef opaque type. These objects
provide the interface for implementing an
event-processing loop in a thread.
Glossary
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during different phases of a run loop’s execution.
semaphore  A protected variable that restricts access
to a shared resource. Mutexes and conditions are
both different types of semaphore.
signal  A UNIX mechanism for manipulating a
process from outside its domain. The system uses
signals to deliver important messages to an
application, such as whether the application
executed an illegal instruction. For more information
see the signal man page.
signal dispatch source  A dispatch source used to
process UNIX signals. A signal source calls your
custom event handler whenever the processreceives
a UNIX signal.
task  A quantity of work to be performed. Although
some technologies (most notably Carbon
Multiprocessing Services) use this term differently,
the preferred usage is as an abstract concept
indicating some quantity of work to be performed.
thread  A flow of execution in a process. Each thread
has its own stack space but otherwise shares
memory with other threads in the same process.
timer dispatch source  A dispatch source used to
process periodic events. A timer source calls your
custom event handler at regular, time-based
intervals.
Glossary
2012-07-17   |   © 2012 Apple Inc. All Rights Reserved.
86This table describes the changes to Concurrency Programming Guide .
Date Notes
Removed obsolete information about autorelease pool usage with
operations.
2012-07-17
Updated the code for manually executing operations to handle
cancellation correctly.
2011-01-19
Added information about using Objective-C objects in conjunction with
dispatch queues.
2010-04-13 Updated to reflect support for iOS.
Corrected the start method for the nonconcurrent operation object
example.
2009-08-07
New document that describes technologies for executing multiple code
paths in a concurrent manner.
2009-05-22
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6 ContentsMainStage turns your computer into a powerful and customizable musical instrument
and effects processor that you can use with your music gear (your instruments,
microphones, controllers, and other equipment) in live performance.
This preface covers the following:
• About MainStage (p. 7)
• About the MainStage Documentation (p. 8)
• Additional Resources (p. 8)
About MainStage
For performing musicians, MainStage gives you the power and flexibility of Logic Pro in
an application optimized for live performance. Whether you are a keyboard player, guitarist,
vocalist, drummer, or play another instrument, you can use MainStage in your live
performance setup.
Some of the things you can do with MainStage include:
• Create custom sounds using a wide variety of software instruments and effects included
in Logic Studio. You can also use third-party plug-ins, ReWire applications, and external
sound modules.
• Organize your sounds for easy access when you perform.
• Create a visual layout that matches your hardware devices, putting the controls you
need at your fingertips.
• Connect MIDI devices to your MainStage concert so you can control parameters of your
sounds in real time.
• Trigger backing tracks and other audio files while you play.
• Loop your performances to create multitextured, dynamic sound environments.
• Record your performances in real time.
This is only a brief list of what you can do with MainStage. For a more detailed introduction,
see Introducing MainStage.
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PrefaceAbout the MainStage Documentation
Logic Studio includes several documents that will introduce you to MainStage, help you
get started working, and provide detailed information about the features and controls
of MainStage.
• MainStage User Manual: This onscreen manual (the MainStage User Manual) describes
the MainStage interface, commands, and menus, and gives step-by-step instructions
for creating MainStage concerts and for accomplishing specific tasks. It also includes
information on setting up your system. It is designed to provide the information you
need to get up to speed quickly so you can make use of the intuitive interface and
powerful features of MainStage.
If you want to start by learning how to set up audio and MIDI hardware to use with
MainStage, read Setting Up Your System. If you want to learn about the features and
controls in the MainStage interface, read The MainStage Interface. If you want to jump
right in and start using the application, skip ahead to Getting Started with MainStage,
then read the chapters on Edit mode, working with concerts, and Layout mode. If you
want to read about using MainStage in live performance, turn to Performing Live with
MainStage.
• Exploring MainStage: This booklet introduces the basics of MainStage in an easy,
approachable way. It aims to get new users up and running with MainStage quickly so
you can have confidence and continue learning at your own pace. Each chapter presents
major features and guides you in trying things out. This document is a PDF version of
the printed Exploring MainStage document included in the Logic Studio package.
• Logic Studio Instruments: This onscreen manual provides comprehensive instructions
for using the powerful collection of instruments included with Logic Pro and MainStage.
• Logic Studio Effects: This onscreen manual provides comprehensive instructions for
using the powerful collection of effects included with Logic Pro, MainStage, and
WaveBurner.
• Logic Studio Working with Apogee Hardware: This onscreen manual describes the use
of Apogee hardware with Logic Pro.
Additional Resources
Along with the documentation that comes with Logic Studio, there are a variety of other
resources you can use to find out more.
Release Notes and New Features Documents
Each application offers detailed documentation that covers new or changed features and
functions. This documentation can be accessed in the following location:
• Click the Release Notes and New Features links in the application Help menu.
8 Preface Welcome to MainStageMainStage Website
For general information and updates, as well as the latest news on MainStage, go to:
• http://www.apple.com/logicstudio/mainstage
Apple Service and Support Websites
For software updates and answers to the most frequently asked questions for all Apple
products, go to the general Apple Support webpage. You’ll also have access to product
specifications, reference documentation, and Apple and third-party product technical
articles.
• http://www.apple.com/support
For software updates, documentation, discussion forums, and answers to the most
frequently asked questions for MainStage, go to:
• http://www.apple.com/support/mainstage
For discussion forums for all Apple products from around the world, where you can search
for an answer, post your question, or answer other users’ questions, go to:
• http://discussions.apple.com
Preface Welcome to MainStage 9This chapter gives you a conceptual overview of MainStage and describes how you can
use it together with your instruments and other musical equipment when you perform
live.
This chapter covers the following:
• What Is MainStage? (p. 11)
• Using MainStage with Keyboard Controllers (p. 13)
• Using MainStage with Electric Guitars (p. 13)
• Using MainStage with Vocals, Drums, and Other Instruments (p. 13)
• How to Use MainStage in Your Music Setup (p. 13)
• Using MainStage in Live Performance (p. 16)
What Is MainStage?
MainStage is a music application designed for you to use in live performance. MainStage
turns your computer into a powerful multi-instrument and effects processor that you can
use on stage when you perform. Whether you play a keyboard, guitar, another instrument,
or sing, you can use MainStage with your instruments, microphones, and MIDI hardware
when you perform live.
MainStage lets you use the professional-quality instruments and effects included in
Logic Studio in your live performances. You access and modify the instruments and effects
in MainStage using the familiar Logic channel strip interface. If you play a USB or MIDI
keyboard controller, you can play and control a wide variety of software instruments,
including pianos and other keyboards, synthesizers, strings, horns, percussion, and more.
If you play electric guitar, you can perform using Logic Studio effects setups, including
amp simulation, overdrive, reverb, compression, and more. You can create your own
effects setups and switch between them easily. Vocalists and acoustic musicians can also
use effects setups with sound input through a microphone.
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1MainStage provides a flexible interface for organizing and accessing your sounds in
concerts. Concerts are MainStage documents that hold your sounds—a concert can store
all the sounds you’ll use in an entire performance or a series of performances. In a
MainStage concert, individual sounds are stored as patches, and each patch can contain
one or more channel strips, each with its own instruments and effects. You can add
channel strips, choose channel strip settings, add instruments and effects, and edit their
parameters to customize your sounds. You can even mix channel strips of different types
in a single patch.
You can organize patches in a concert by ordering them in the Patch List and also by
grouping them into sets. Sets are folders where you can store patches you want to keep
together.
Each concert also includes a visual interface, called a layout, with controls that you can
use to modify your patches in live performance. Layouts contain screen controls, which
are onscreen representations of keyboards, faders, knobs, buttons, pedals, drum pads,
and other hardware controls and displays. You make connections between your MIDI
devices and your MainStage concert by assigning hardware controls to the screen controls
in the concert. After you make these controller assignments, you map the screen controls
to channel strip and plug-in parameters, completing the connection so that you can easily
access and manipulate the parameters you want for each patch in the concert. You can
also map screen controls to actions, which provide the ability to select patches, control
the Tuner or metronome, provide visual feedback, and perform other functions.
Parameter
mapping
MainStage screen control Channel strip or 
plug-in parameter
Hardware control
Controller
assignment
MainStage lets you quickly and easily make controller assignments and parameter
mappings to speed your workflow. You can customize your layout to match the controls
on your MIDI hardware, to optimize the use of available screen space, or in other ways
that suit your needs.
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If you perform using a USB or MIDI keyboard controller, you can play and control MainStage
patches with software instruments using your controller. You can assign faders, knobs,
buttons, and other controls on the keyboard controller to screen controls in your concert,
and then map those screen controls to parameters in your patches. You can choose
exactly the parameters you want to have at your fingertips for each patch and access
them from your controller as you perform.
You can use MainStage with other MIDI controllers, including sustain pedals, expression
pedals, foot switches, MIDI guitars, and wind controllers that send standard MIDI messages.
You can also control external hardware synthesizers, ReWire applications, and other virtual
instruments using external instrument channel strips.
Using MainStage with Electric Guitars
If you play an electric guitar, you can use MainStage as a powerful, customizable
multi-effects processor. After you connect your instrument to your computer using an
audio interface, you send your guitar’s audio signal to audio channel strips in your patches,
where you can add effects including the Amp Designer and Pedalboard plug-ins designed
specifically for use with electric guitar. You can also use EQ, compression, reverb, overdrive,
and other Logic Studio effects in your guitar patches. You can control volume, effect
blend, or expression with an expression pedal, and use a foot switch to select patches
hands-free when you perform.
Using MainStage with Vocals, Drums, and Other Instruments
Vocalists and acoustic musicians can use MainStage by sending the audio output from
a microphone connected to their computer to audio channel strips in their patches. You
can use MainStage with Core Audio-compatible audio devices, such as audio interfaces
and digital mixers, for input from instruments and microphones, and for audio output to
speakers, monitors, a mixing board, or a public address (PA) system. In MainStage, you
can access a wide range of effects in your patches.
Drummers can also use MainStage by sending the audio output from microphones to
audio channel strips in their patches or by using drum pads or a virtual drum kit to control
the EXS24 mkII sampler, Ultrabeat, and percussion-oriented plug-ins.
How to Use MainStage in Your Music Setup
You can add MainStage to your music equipment setup by following these steps:
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You begin working in MainStage by creating a new concert from a template. MainStage
includes concert templates for keyboard, guitar, and other instruments, making it easy
to choose a template suited to your needs. MainStage recognizes many popular MIDI
controllers and automatically assigns hardware controls on the controller to corresponding
screen controls in the workspace, simplifying hardware setup.
For information about choosing a template to create a concert, see Choosing a Concert
Template.
Stage 2: Adding and Editing Patches to Customize Your Sounds
After you create a concert, you add patches for the sounds you want to play, and edit
the patches by adding channel strips, instruments, and effects, and adjusting their
parameters to “dial in” your custom sounds. You edit and organize patches in Edit mode.
In Edit mode, your patches are “live” so you can hear the results of your edits instantly.
You can select and play patches, choose channel strip settings, and edit channel strip
and plug-in parameters. You can quickly define key ranges for channel strips to create
keyboard layers and splits, scale expression and other parameters using transforms, and
filter incoming MIDI messages.
For information about editing patches, see Working with Patches in Edit Mode.
Stage 3: Organizing Your Patches for Easy Access
When you open a concert in Edit mode, the patches in the concert appear in the Patch List,
where you can select them and start playing. You can edit patch parameters, add channel
strips to existing patches or create new ones, and reorder patches to build your custom
collection of sounds to use when you perform.
You can also organize patches in sets for added flexibility. Sets are like folders that can
store groups of patches you want to keep together, which can be useful in several ways.
For example, you can store all your favorite lead synth patches in a set or store multiple
patches you intend to use in a single song, and quickly select the patches you want while
performing. You can also add channel strips at the set level, and have them available
with every patch in the set.
For information about organizing patches, see Working with Patches in Edit Mode. For
information about creating and editing sets, see Working with Sets in Edit Mode.
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Devices
In Layout mode, you arrange screen controls in the workspace to create the visual layout
corresponding to your hardware controls. MainStage features a variety of screen controls,
including keyboards, knobs, faders, pitch bend and modulation wheels, foot pedals, drum
pads, and more. Also included are screen controls to display parameter and system
informaton, text and images, and a selector that you can use to view and select patches
or markers while performing.
You can quickly add screen controls to the workspace, and move, resize, and copy them
to create your layout. Alignment guides and other tools make it easy to visually arrange
screen controls, and you can customize display color, text labels, and other parameters
in the Screen Control Inspector. You can also group controls and arrange the grouped
control as a single unit.
For information about working with screen controls in Layout mode, see Working with
Screen Controls.
Stage 5: Making Connections Between MainStage and Your Music Hardware
In Layout mode, you connect physical controls on your MIDI hardware to the screen
controls in your concert by assigning the physical controls to the corresponding screen
controls in the workspace. You can move and resize screen controls in the workspace
and customize the display of visual feedback for parameter values and other information.
You only need to make hardware controller assignments once for an entire concert,
greatly reducing the amount of work required to connect your hardware with your
computer.
For information about making hardware assignments, see Assigning Hardware Controls
to Screen Controls.
Stage 6: Mapping Screen Controls to the Parameters You Want to Control in
Performance
Edit mode is where you map screen controls to channel strip parameters. You can map
whichever parameters you want to modify for each patch to screen controls so they can
be easily manipulated from your hardware when you perform live. You can also map
screen controls to MainStage actions, such as selecting the next patch you want to play.
For information about mapping screen controls, see Mapping Screen Controls.
You need not follow these steps in a strict order; however, in most cases you will find
working easier if you create your layout before making hardware assignments and make
hardware assignments before you map screen controls. If you plan to use one of the
existing concert templates without modifying its layout significantly, you can concentrate
on stages 1 to 3 and stage 6.
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for each group of tasks. You customize and organize your patches in Edit mode and
customize your layout and make connections with your hardware in Layout mode. The
advantage of this division is that it separates tasks you normally perform only once, such
as setting up your layout (the Layout mode tasks), from those you are likely to repeat
more often, such as editing your sounds (the Edit mode tasks).
Using MainStage in Live Performance
After you have created a concert with your custom patches following the steps described
above, you’re ready to play. When you perform live, you can use your computer as the
final sound module and effects box in your rig. You can select a patch and start playing
it instantly. MainStage switches seamlessly between patches and can sustain notes from
the previous patch while you start playing the newly selected one. You can view feedback
about your patches, including names, parameter values, and audio output levels, in real
time. You can also adjust concert-wide effects using auxiliary channels and control other
concert-wide settings.
MainStage provides two modes optimized for performing live:Perform mode and Full
Screen mode. In Perform mode, the workspace fills the MainStage window but lets you
retain access to the Finder and to other applications. In Full Screen mode, the workspace
fills your entire screen, optimizing available screen space for your onscreen layout. You
can use whichever mode you prefer.
You can use MainStage with multiple MIDI controllers, microphones, musical instruments,
and other music equipment. For time-based effects such as reverb and delay, you can
set a pre-defined tempo, use MIDI input for tempo changes, or tap the tempo as you
perform.
For tips and other information about using MainStage when you perform live, see
Performing Live with MainStage.
16 Chapter 1 Introducing MainStageYou can use MainStage with a wide variety of MIDI controllers and Core Audio-compliant
audio devices. For basic information about designing and configuring your system,
including information about computer requirements, connecting audio and MIDI devices,
and configuring your audio hardware, see the “Setting Up Your System” chapter in the
Logic Pro User Manual.
Real-time generation and processing of digital audio requires intensive processing by
your computer. If you plan to work on large or complex projects, using a computer with
a faster processor and extra random-access memory (RAM) installed can facilitate your
productivity. Additional RAM is useful particularly when using a large number of effects
plug-ins and when playing sample-based software instruments. It is recommended that
you do not run other processor- or RAM-intensive applications simultaneously with
MainStage, particularly when performing live.
This chapter covers the following:
• Using MIDI Devices with MainStage (p. 17)
• Using Audio Devices with MainStage (p. 19)
• Using Effects Plug-ins with MainStage (p. 19)
• Using MainStage with Time Machine (p. 19)
Using MIDI Devices with MainStage
MainStage works with many USB and MIDI keyboard controllers and with other MIDI
devices such as foot pedals and switches. To work with MainStage, MIDI devices must
send standard MIDI control messages. MainStage receives standard MIDI messages and
can be used to control external MIDI devices using external MIDI instrument channel
strips. For more information about using keyboard controllers and other MIDI devices,
see the “Setting Up Your System” chapter in the Logic Pro User Manual.
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2Using MIDI Devices That Send Special MIDI Message Types
Certain types of hardware controls such as knobs (rotary controls) and buttons are capable
of sending several types of MIDI messages. When you assign these controls to MainStage
screen controls using the Learn process, MainStage analyzes the incoming MIDI data to
determine which type of message the hardware control is sending. In order for MainStage
to learn these controls correctly, be sure to turn knobs through their full range of motion
and to press buttons exactly three times during the Learn process.
Some MIDI controllers can send nonstandard or proprietary MIDI messages. MainStage
cannot process or respond to nonstandard MIDI messages, to “registered” or
“non-registered” parameter messages, or to system exclusive (SysEx) messages. MainStage
can process some system real-time messages and MIDI Machine Control (MMC) messages
when you assign a hardware control that sends these messages to a screen control.
Some devices feature buttons that send program change messages. You can use these
buttons to send program change messages to MainStage, but you cannot assign them
to control other parameters using MainStage screen controls.
Choosing a Controller Preset
Some keyboard controllers allow you to choose different presets or “scenes” that
reconfigure the messages sent by the controls on the device. In most cases, you should
choose a generic preset that sends standard MIDI messages rather than system exclusive
messages or messages intended for a particular application. After you have assigned
hardware controls to screen controls in MainStage, do not change the preset on the MIDI
device, or your assignments might be lost.
In some cases, you can change the message type the controller sends by choosing a
different preset or by reprogramming the device. Some devices may include software
that you can use to reprogram knobs, buttons, and other controls. For information about
reprogramming a MIDI device, see the documentation that came with the device.
Using MIDI Devices That Support Automatic Configuration
MainStage can automatically configure the screen controls in a concert to support many
popular MIDI controllers. If you are using a device that supports automatic configuration,
MainStage alerts you to select the appropriate preset on your device when you open a
new concert. After you select the preset on your MIDI device, the screen controls in the
concert are assigned to the corresponding controls on your hardware device so you can
use them in MainStage with no further configuration.
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MainStage works with Core Audio-compliant audio devices, including FireWire, USB,
ExpressCard, and PCI audio interfaces. You can connect microphones, electronic musical
instruments, and other musical equipment to your computer, or to an audio interface or
other audio device, and use them with MainStage. For detailed information about using
audio devices, see the “Setting Up Your System” chapter in the Logic Pro User Manual.
MainStage can require a large amount of available RAM, particularly when playing
sample-based software instruments. It is recommended that you test your system and
the concerts you plan to use before you perform using MainStage to make sure there is
enough available memory to select and play the patches you want to use without causing
audio drop-outs or distortion. Unlike in Logic Pro, you can choose different audio input
and output drivers in MainStage. For more information about choosing audio drivers, see
Setting MainStage Preferences.
Using Effects Plug-ins with MainStage
You can use all of the Logic Studio effects plug-ins, except for surround plug-ins, in
MainStage channel strips. For more information about the included effects plug-ins, refer
to the Logic Studio Instruments and Logic Studio Effects manuals. You can also use Apple
and third-party Audio Units effects in MainStage channel strips in the same way you use
them in Logic Pro channel strips.
Some Logic Studio effects, including Space Designer, require intensive realtime processing
of the audio signal. Using Space Designer on individual patches can affect the performance
of your concert, and in some cases result in audio dropouts or glitches, particularly if you
set the audio buffer to a smaller size. For this reason, it is recommended that you use
Space Designer sparingly in your concerts, and use a few Space Designer instances on
auxiliary channel strips shared between multiple patches, rather than in individual patches.
Some Audio Units plug-ins can introduce latency. Using effects that introduce latency,
such as compressors and limiters, can produce undesirable or unpredictable results during
live performance. Other Audio Units plug-ins, particularly instrument and amp modelling
plug-ins, require high levels of realtime processing and can affect the performance of
your concert.
Using MainStage with Time Machine
If you use Time Machine to back up the computer you are using to perform with
MainStage, be aware that if Time Machine runs while you are performing in Perform or
Full Screen mode the performance of your MainStage concert could be affected. To avoid
any impact on performance, it is recommended that you disconnect your Time Machine
backup drive when you perform with MainStage.
Chapter 2 Setting Up Your System 19You do all your work in MainStage in a single window, the MainStage window.
The MainStage window is organized to make it easy to work with your patches and the
layout of your concert. When you open MainStage, the workspace fills the center of the
window, with Inspectors and other editing areas on the sides and below. When you are
ready to perform, you can use one of two performance-oriented modes to maximize your
computer performance and also maximize your display space for easy viewing on stage.
The first time you open MainStage, the Choose Template dialog appears so that you can
choose a concert template to create a new concert. To learn how to open MainStage, see
Opening MainStage. For information about choosing a template, see Choosing a Concert
Template.
This chapter covers the following:
• The MainStage Window (p. 22)
• Layout Mode (p. 23)
• Edit Mode (p. 24)
• Perform Mode (p. 25)
• Full Screen Mode (p. 26)
• Customizing the MainStage Window (p. 26)
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3The MainStage Window
Some features of the MainStage interface are common to all modes, while others are
exclusive to certain modes.
Inspector
Workspace with 
Toolbar Activity Monitor screen controls
The main features of the MainStage window include:
• Toolbar: Includes buttons for quick access to common commands and tools. You can
customize the toolbar so that the commands you use most frequently are readily
available.
• Activity Monitor: Shows your computer’s processor and memory usage, and shows the
input from your MIDI devices as you edit and perform.
• Workspace: The “canvas” where you customize your onscreen layout, assign hardware
controls to screen controls, and view your concerts while you perform.
• Screen controls: The onscreen objects that correspond to the controls on your hardware
devices. You can add and arrange screen controls in the workspace, assign hardware
controls to screen controls, and then map them to parameters you want to control for
each patch in your concert. There are three types of screen controls:  panel controls,
shelf controls, and grouped controls.
• Channel strips: Channel strips are where you build and customize your sounds.
MainStage channel strips are similar to channel strips in Logic Pro, with Insert, Sends,
and I/O menus as well as level meters, faders, pan knobs, and other controls.
22 Chapter 3 The MainStage Interface• Inspectors: Inspectors appear below (in Edit mode) or along the left side of the MainStage
window (in Layout mode) when you select different items onscreen. The Inspectors
allow you to edit parameters and attributes for patches, sets, screen controls, channel
strips, and the concert. Most Inspectors feature tabs that make it easy to quickly access
the parameters you want to edit.
To make working easier, MainStage features four different modes, each suited to a different
task. You audition, edit, and organize your sounds and map screen controls in Edit mode.
You customize the visual arrangement of controls onscreen and make controller
assignments in Layout mode. You use either Perform mode or Full Screen mode when
you perform live.
Layout Mode
Layout mode is where you customize your onscreen layout and make connections between
your MIDI hardware and the screen controls in your concert. You drag screen controls
into the workspace and arrange them onscreen to customize your layout, then create
connections (called controller assignments) between your MIDI hardware and the screen
controls.
In the Screen Control Inspector, you can edit layout parameters to customize hardware
assignments and modify the visual look of the screen controls in your concert.
Screen Control Inspector Screen Controls Palette
• Screen Control Inspector: View and edit parameters for screen controls in the workspace,
including hardware input, appearance, and certain types of MIDI output parameters.
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add them to your onscreen layout. The palette has four tabs so that you can quickly
view all screen controls or only one type of screen control. Panel controls appear as
two-dimensional objects in the workspace, while shelf controls appear on an adjustable
three-dimensional shelf.
• Layout buttons: Along the left side of the workspace is a series of buttons that you can
use to quickly position selected screen controls in the workspace. You can align,
distribute, and group selected screen controls.
In Layout mode, unlike the other modes in MainStage, you can’t select or edit individual
patches. To learn what you can do in Layout mode, see Working in Layout Mode.
Edit Mode
Edit mode is where you create, customize, and organize your sounds. You can add patches,
add and edit channel strips, create keyboard layers and splits, and edit channel strip and
plug-in parameters. Edit mode is also where you map screen controls to channel strip
parameters and actions, and edit patch, set, and concert-level parameters.
Patch List Inspector (changes 
depending on the 
selection)
Channel Strips 
area
• Patch List: Shows the patches and sets in the concert. You can add patches and sets
to the Patch List, name them, and organize them. The Patch List includes an Action
menu with commands to create patches and sets, reset program change numbers, skip
items, and import and export patches and sets to use in other concerts.
24 Chapter 3 The MainStage Interface• Inspector (varies depending on the type of item selected): View and edit parameters for
the currently selected patch, channel strip, screen control, set, or for the concert. The
name of the Inspector changes to identify the type of item you are currently inspecting.
• Channel Strips area: View and edit the channel strips in your patches or at the concert
or set level. Channel strips appear in a vertical format similar to Logic Pro channel strips,
with many of the same controls. You can also add channel strips and save channel strip
settings.
To learn what you can do in Edit mode, see Working in Edit Mode and Working with
Concerts.
The remaining two modes, Perform mode and Full Screen mode, are both optimized for
performing live. You can use either one when you perform.
Perform Mode
In Perform mode, the workspace fills the entire MainStage window. The toolbar is visible
so that you can switch modes using the Mode buttons, use the Panic or Master Mute
buttons and the Tuner, and view CPU and memory levels and MIDI input in the Activity
Monitor. The browsers and Inspectors are hidden to maximize the size of the workspace,
making screen controls larger and easier to read in onstage situations. You can still access
the Finder and switch to other applications in Perform mode but cannot open plug-in
windows.
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In Full Screen mode, the workspace fills your entire computer display so that your screen
controls are as large as possible for maximum readability. Full Screen mode optimizes
your display for live performance when you want to use MainStage exclusively while you
play. Plug-in windows cannot be open in Full Screen mode.
To learn about using Perform mode and Full Screen mode when you perform live, see
Performing Live with MainStage.
Customizing the MainStage Window
You can customize the MainStage window to suit your way of working. In Edit mode, you
can adjust the width of the Patch List, show or hide the Inspectors and the Channel Strips
area, and customize the buttons on the toolbar.
Resizing the Workspace
You can adjust both the horizontal and vertical size of the workspace to give more room
to the Patch List, the Inspector, and the Channel Strips area.
To resize the workspace horizontally
1 Move the pointer to the space between the workspace and the Inspector.
The pointer becomes a resize pointer.
2 Drag up or down to resize the workspace.
To resize the workspace vertically
1 Move the pointer to the space between the workspace and the Channel Strips area.
26 Chapter 3 The MainStage InterfaceThe pointer becomes a resize pointer.
2 Drag left or right to resize the workspace.
Hiding and Showing the Inspector
You can hide the Inspector or show it if it is hidden.
To hide or show the Inspector
Do one of the following:
µ Choose View > Inspectors (or press Command-5).
µ In the toolbar, click the Inspectors button.
Hiding and Showing the Channel Strips Area
You can hide the Channel Strips area or show it if it is hidden. Hiding the Channel Strips
area gives you more room for the workspace.
To hide or show the Channel Strips area
Do one of the following:
µ Choose View > Channel Strips (or press Command-6).
µ In the toolbar, click the Channel Strips button.
Customizing the Toolbar
The toolbar at the top of the MainStage window contains buttons for frequently used
commands. You can customize the toolbar, adding buttons for the functions you use
most often and can return to the default set later.
The default set of toolbar buttons includes buttons for selecting the different window
modes, hiding the Inspector and the Channel Strips area, activating Master Mute, and
other common commands. You can customize the toolbar with additional buttons for
other commands and adjust the position and spacing of items. You can also hide the
toolbar to maximize available screen space. You customize the toolbar by dragging items
from the Customize Toolbar dialog to the toolbar.
To show the Customize dialog
Do one of the following:
µ Choose View > Customize Toolbar.
µ Control-click the toolbar, then choose Customize Toolbar from the shortcut menu.
The Customize Toolbar dialog appears, and spaces between buttons in the toolbar are
outlined in gray.
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µ Drag a button from the Customize dialog to the toolbar.
If you drag a button between two existing buttons, the buttons move to make room for
the new button.
To move a button in the toolbar
Do one of the following:
µ If the Customize Toolbar dialog is visible, drag the button to move it.
µ If the Customize Toolbar dialog is not visible, Command-drag the button to move it.
You can also rearrange the toolbar using set-width spaces, flexible spaces, and separators.
To add a space or a separator to the toolbar
µ Drag a space, flexible space, or separator from the Customize Toolbar dialog to the toolbar.
To return the toolbar to the default set of buttons
µ Drag the default button set, located at the bottom of the Customize Toolbar dialog, to
the toolbar.
You can also change the toolbar so that it shows only icons or only text by Control-clicking
the toolbar, then choosing Icon Only or Text Only from the shortcut menu.
To show only icons in the toolbar
Do one of the following:
µ Control-click the toolbar, then choose Icon Only from the shortcut menu.
µ In the Customize Toolbar dialog, choose Icon Only from the Show pop-up menu.
To show only text in the toolbar
Do one of the following:
µ Control-click the toolbar, then choose Text Only from the shortcut menu.
µ In the Customize Toolbar dialog, choose Text Only from the Show pop-up menu.
To show both icons and text in the toolbar
Do one of the following:
µ Control-click the toolbar, then choose Icon & Text from the shortcut menu.
µ In the Customize Toolbar dialog, choose Icon & Text from the Show pop-up menu.
To close the Customize dialog
µ When you are finishing customizing the toolbar, click Done.
To hide the toolbar
µ Choose View > Hide Toolbar.
When the toolbar is hidden, the menu item becomes Show Toolbar.
28 Chapter 3 The MainStage InterfaceYou can quickly start working in MainStage by choosing a concert template and trying
out the patch settings in the concert. This chapter provides a brief guided “walkthrough”
you can follow the first time you open MainStage. If you wish to continue learning the
major features of the application in a hands-on manner, consult the Exploring MainStage
guide included in the Logic Studio package.
This chapter covers the following:
• Before You Begin (p. 29)
• Opening MainStage (p. 30)
• Choosing a Concert Template (p. 30)
• Selecting Patch Settings in the Patch Library (p. 31)
• Adding a Patch (p. 32)
• Naming a Patch (p. 33)
• Selecting and Playing Patches (p. 33)
• Adding a Channel Strip (p. 34)
• Changing a Channel Strip Setting (p. 36)
• Learning a Controller Assignment (p. 37)
• Mapping a Screen Control (p. 39)
• Trying Out Full Screen and Perform Modes (p. 39)
Before You Begin
Before you start working in MainStage, you should connect the hardware equipment that
you plan to use, such as your keyboard controller, audio interface, instruments, or
microphones, to your computer. To use keyboard controllers and other MIDI devices with
MainStage, the devices should be capable of sending standard MIDI messages. If you’re
not sure whether this is the case for a particular device, consult the owner’s manual or
the product website. For more information, see Setting Up Your System.
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4Opening MainStage
You start by opening MainStage and creating a new concert from a template.
To open MainStage
µ Double-click the MainStage icon in your Applications folder or in the Dock.
Choosing a Concert Template
MainStage includes templates for different musical instruments, including Keyboards,
Guitar Rigs, Drums, Vocals, and more. You can choose a concert template in the Choose
Template dialog, which appears the first time you open MainStage and when you create
a new concert or close a concert.
To choose a concert template
1 Choose File > New Concert (or press Command-N).
2 In the Choose Template dialog, click the instrument category on the left you want to
view templates for.
A brief description below each template describes its features and intended use.
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4 Click Choose, or double-click the template.
A new concert created from the template opens in Edit mode. The workspace appears
in the center of the MainStage window, showing the screen controls in the concert. To
the left of the workspace is the Patch List, which shows the patches and sets in the concert.
The channel strips for the selected patch appear in the Channel Strips area to the right
of the workspace. The new concert may contain a single patch, or several patches. Below
the workspace, the Patch Library is open, so you can easily audition different patch settings
to find the one you want to use.
In the Choose Template dialog, you can view templates in either a grid or a Cover Flow
view. You can choose a different view using the view buttons, located in the lower-left
part of the dialog.
To choose a different view for the Choose Template dialog
µ To view templates in a grid, click the Grid button.
µ To view templates in Cover Flow, click the Cover Flow button.
For more information about opening, editing, and saving concerts, see Working with
Concerts.
Selecting Patch Settings in the Patch Library
When you open a concert or select a patch, the Patch Library opens in the Patch Inspector
below the workspace. The Patch Library contains a variety of patches optimized for the
instrument the concert is designed for. You can quickly audition patch settings in the
Patch Library and choose a setting for the selected patch.
To select a patch setting
1 Look through the settings in the Patch Library to find the one you want to use.
2 Click the patch setting.
You can start playing the patch immediately using the selected patch setting. You can
also search for patch settings by name.
To search for patch settings by name
1 Choose Find in Library from the Action menu in the upper-right corner of the Patch
Inspector.
2 Enter the name of the patch setting you want to find.
3 Click Find.
The first patch setting with the text you entered appears selected in the Patch Library.
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from the Action menu.
Note: If you have saved multiple patches to a .patch file using the Save as Set command
(or the Export as Set command in MainStage 1.0) in the Action menu, the saved file
appears as a patch in the Patch Library unless you have selected a different location for
saving the file. Clicking the saved file in the Patch Library causes an alert to appear while
the individual patches are opened from the .patch file.
Adding a Patch
You can add patches to the concert and organize them in the Patch List. The number of
patches is limited only by the amount of available memory in your system. When you
add a patch to a concert, the patch is selected so you can easily audition and select a
patch setting from the Patch Library.
To add a new patch
1 Click the Add Patch button (+), located in the upper-right corner of the Patch List.
The new patch appears in the Patch List, and the Patch Library is open in the Patch
Inspector.
2 Select the patch setting you want to use from the Patch Library.
If you want to play the patch using your keyboard controller, select a Keyboard patch. If
you want to play the patch using your electric guitar, select a Guitar Rig patch. For other
instruments or vocals, you can choose a template from the appropriate category or modify
a keyboard or guitar template to suit your needs.
3 If the patch uses an audio channel strip, make sure the channel strip is set to use the
correct audio input, then gradually raise the volume fader on the channel strip until you
hear sound on the channel.
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When you add a patch, by default it takes the name of the channel strip added with it.
You can give each patch a custom name to make it easier to identify and distinguish
between them.
To name a patch
1 Double-click the patch in the Patch List.
A field appears around the patch name, which is selected.
Double-click the 
patch name, then 
type a new name. 
2 Type a new name in the patch name field.
For more information about editing and organizing patches, see Working with Patches
in Edit Mode.
Selecting and Playing Patches
The patches in the concert appear in the Patch List along the left side of the MainStage
window. You can easily access the patches in your concert by selecting them in the
Patch List. You can quickly select patches by clicking them in the Patch List.
If you are using a MIDI controller, you can play patches that have a software instrument
channel strip using your controller. If you are playing an electric guitar or another
instrument or are using a microphone connected to an audio interface, you can play or
sing using patches that have an audio channel strip. Before playing through an audio
channel strip, first make sure that the channel strip is set to receive input on the channel
(or stereo pair of channels) to which your instrument or microphone is connected.
With the patch selected, try moving some controls on your MIDI controller and check to
see if the screen controls in the workspace respond. Some screen controls, including the
keyboard, modulation and pitch bend wheels, and sustain pedal screen controls, respond
to appropriate MIDI messages without needing to be assigned or mapped.
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to perform with or to use as a starting point for creating your own custom patches. You
can also add new patches and edit their channel strip settings to create your own unique
sounds.
For more information about organizing and selecting patches in the Patch List, see Working
with Patches in Edit Mode.
Adding a Channel Strip
You can add channel strips to a patch to create layered sounds and keyboard splits. When
you add a channel strip to a patch, you choose the type of channel strip, the output, and
other settings. You can mix both types in a single patch.
To add a channel strip to a patch
1 Make sure the patch is selected in the Patch List.
2 Click the Add Channel Strip button (+) in the upper-right corner of the Channel Strips
area.
The New Channel Strip dialog appears. You choose settings in the Channel Strip dialog
in the same way as when you add a patch.
3 In the New Channel Strip dialog, select the type of channel strip you want to create.
4 Choose the audio output for the channel strip from the Output pop-up menu.
5 For audio channel strips, choose mono or stereo format from the Format pop-up menu
and choose the audio input from the Input pop-up menu. For external instrument channel
strips, also choose the MIDI input, MIDI output, and MIDI channel from their respective
pop-up menus.
Important: Audio channel strips can produce feedback, particularly if you are using a
microphone for audio input. When you add an audio channel strip, the volume of the
channel strip is set to silence, and Feedback Protection is turned on to alert you when
feedback occurs on the channel strip. When you add an external instrument channel
strip, the volume of the channel strip is set to silence, but Feedback Protection is turned
off.
6 Optionally, you can add multiple channel strips to a patch by typing a number in the
Number field. You can add up to the maximum number for a channel strip type.
7 Click Create.
A new channel strip appears in the Channel Strips area, highlighted in white to indicate
that it is selected. The Channel Strip Inspector appears below the workspace, showing
different parameters for the new channel strip.
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you hear sound on the channel.
Most channel strip controls function in MainStage in the same way that they do in
Logic Pro. You can adjust channel strip output using the Volume fader, adjust pan position
using the Pan knob, and mute or solo the channel strip using the Mute and Solo buttons.
You can choose new channel strip settings, add and edit effects, add sends to busses,
and change the output in the same way as in Logic Pro. For audio channel strips, you can
switch between mono and stereo format using the Format button. For software instrument
channel strips, you can choose a different instrument from the Input pop-up menu.
You can also define the key range for a channel strip, create transform and velocity graphs,
and filter various MIDI messages to a channel strip in the Channel Strip Inspector. For
general information about working with channel strips, see the “Working with Instruments
and Effects” chapter of the Logic Pro User Manual. For more information about using
channel strips in MainStage, see Working with Channel Strips in Edit Mode.
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You can quickly change the instrument, effects, and other parameters for a channel strip
by selecting a new setting from the Channel Strip Library. The browser shows available
settings for the currently selected channel strip.
To select a new channel strip setting
1 Make sure that the channel strip you want to change is selected.
The selected channel strip is highlighted.
2 In the Channel Strip Inspector, click the Channel Strip Library tab.
Available channel strip settings appear in the Channel Strip Library. Logic Studio content
appears as a series of folders with different instrument and usage categories. If you have
GarageBand or have one or more Jam Pack collections installed on your computer, those
settings appear below the Logic Studio settings.
3 Click a category from the column on the left, then click subcategories from the columns
on the right until you see the settings you want.
Click a category in this 
column to see the 
available choices.
Click the channel strip 
setting you want to use from 
the columns to the right.
You can also search for channel strip settings by name and perform other functions using
the Channel Strip Library. For more information about the Channel Strip Inspector, see
Choosing Channel Strip Settings.
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When you select a patch or a channel strip setting, some channel strip parameters respond
to the controls on your MIDI device instantly. MainStage responds to notes played on a
keyboard controller, volume, pan, and expression messages, modulation and pitch bend
wheel messages, and sustain pedal messages without your having to configure any screen
controls to receive these messages. For other controls such as faders, knobs, and buttons,
you must assign these hardware controls to MainStage screen controls before you can
use them in your concert.
In MainStage, you assign hardware controls to screen controls in the Layout Inspector
using the Learn process, similar to learning controller assignments for a control surface
in Logic Pro. Learning controller assignments is a quick and easy method for assigning
hardware controls to screen controls.
Note: To be able to assign a hardware control to a screen control, the hardware control
must send standard MIDI messages. For more information, see Using MIDI Devices with
MainStage.
To learn a controller assignment
1 In the toolbar, click the Layout button.
MainStage switches to Layout mode.
2 In the workspace, select the screen control you want to learn.
The selected control appears highlighted in blue.
3 Click the Learn button in the Screen Control Inspector (or press Command-L).
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screen control is highlighted in red.
Click the Learn button to 
start learning hardware 
assignments.
4 On your MIDI device, move the control you want to assign. Move faders and knobs through
their full range of motion, and press buttons exactly three times (not too quickly) to
enable MainStage to correctly learn the MIDI message types sent by these controls.
The values in the Hardware Assignment pop-up menus change to reflect the type of
hardware control learned by the screen control. While the assignment is being learned,
incoming MIDI messages appear in the Activity Monitor above the workspace.
After the assignment is learned, the screen control responds when you move the
corresponding hardware control. This shows that the screen control is receiving MIDI
input and is correctly assigned.
5 While the Learn process is active, you can learn additional controller assignments by
selecting another screen control and moving the hardware control you want to assign
to it. You can learn as many assignments as you wish while the Learn button remains red.
6 When you are finished assigning controls, click the Learn button (or press Command-L)
again to turn off the Learn process.
For more information about making controller assignments, see Assigning Hardware
Controls to Screen Controls.
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After you have learned controller assignments for the screen controls you want to use,
you can map the screen controls to the parameters in your patches you will want to
control while you are performing. You will likely want to map screen controls to parameters
in each patch in a concert, so that you can easily access and modify the parameters you
want for each patch when you are performing live. You can also map parameters at the
concert level to control master volume, view master levels, or modify concert-wide effects.
There are two ways to map screen controls to parameters:  by visually selecting parameters
on channel strips or plug-in windows, or by choosing parameters in the Parameter
Mapping browser. To learn how to map a screen control to a channel strip or plug-in
parameter, see Mapping Screen Controls to Channel Strip and Plug-In Parameters. To
learn how to map a screen control to an action, see Mapping Screen Controls to Actions.
Trying Out Full Screen and Perform Modes
Now you can try playing your patches as you would in a performance. MainStage provides
two modes, Full Screen mode and Perform mode, that optimize the display of the
workspace for live performance. In Perform mode, you see the workspace and the toolbar,
so you can use the toolbar buttons and access other applications. In Full Screen mode,
the workspace occupies the entire screen, presenting the screen controls as large as
possible for easy viewing in concert environments.
To switch to Full Screen mode
Do one of the following:
µ Choose View > Full Screen (or press Command-4).
µ Click the Full Screen button.
To switch to Perform mode
Do one of the following:
µ Choose View > Perform (or press Command-3).
µ Click the Perform button.
You can try both of these modes, playing the patches you added or modified, and using
the controls on your MIDI controller to modify the parameters you have mapped to screen
controls.
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settings in the Patch Library, organize and select patches in the Patch List, edit patch
parameters in the Inspector, and map screen controls to parameters and actions. You can
create custom patches in Edit mode and organize them in the Patch List so that you can
easily access them when you perform.
This chapter covers the following:
• Working with Patches in Edit Mode (p. 41)
• Working with Channel Strips in Edit Mode (p. 48)
• Mapping Screen Controls (p. 69)
• Editing Screen Control Parameters in Edit Mode (p. 77)
• Working with Sets in Edit Mode (p. 81)
• Working at the Set Level (p. 83)
• Sharing Patches and Sets Between Concerts (p. 84)
• Recording the Audio Output of a Concert (p. 85)
Working with Patches in Edit Mode
Patches are the individual sounds you play using your keyboard controller (for MIDI
keyboardists) and the effects setups you use with your guitar, microphone, or other
instrument (for guitarists, vocalists, and other instrumentalists). MainStage patches can
contain multiple channel strips, each with a different instrument or effects setup.
Some basic patch operations, including adding and naming patches, selecting and naming
patches, and adding channel strips to patches, are described in Getting Started with
MainStage.
If MainStage is currently in Layout, Perform, or Full Screen mode, click the Edit button in
the top-left corner of the MainStage window to begin working in Edit mode.
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5Selecting Items in the Patch List
All of the patches and sets in a concert appear in the Patch List, located to the left of the
workspace. To select an item in the Patch List in Edit mode, you can click the item or use
key commands.
To select a patch in the Patch List
1 In the Patch List, located to the left of the workspace, click the patch.
Click a patch in the 
Patch List to select it, 
and start playing.
2 With the patch selected, you can start playing instantly.
You can also select patches in the Patch List using your computer keyboard.
To select a patch using your computer keyboard
µ Press the Down Arrow key to select the next (lower) patch in the Patch List.
µ Press the Up Arrow key to select the previous (higher) patch in the Patch List.
There are additional key commands you can use to select items in the Patch List.
Default key command Selects
Up Arrow Previous item (patch or set) in the Patch List
Down Arrow Next item (patch or set) in the Patch List
Command-Up Arrow Previous patch in the Patch List
Command-Down Arrow Next patch in the Patch List
Command-Left Arrow First patch of the previous set
Command-Right Arrow First patch of the next set
Note: When you use the Command-Arrow key commands listed above to select different
patches, the selected screen control remains selected in the workspace. This makes it
easy to see how a screen control is configured in different patches.
In addition to using key commands, you can select a patch (or set) in the Patch List by
typing the first few letters of its name.
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1 Click the border of the Patch List to select it.
2 With the Patch List selected, start typing the name of the patch. Once you type enough
letters to uniquely identify its name, the patch or set is selected.
You can also select a patch by typing its name in Perform or Full Screen mode. For
information, see Selecting Patches by Typing.
You can also select a patch using your computer keyboard by typing its patch number.
Patch numbers appear to the left of the patch names in the Patch List.
To select a patch by typing its patch number
1 Click the border of the Patch List to select it.
2 With the Patch List selected, type the patch number using your computer keyboard.
Skipping Items in the Patch List
You can skip patches or sets in the Patch List. When a patch or set is skipped, you can
still select the item by clicking it. However, when you use the arrow keys together with
the Command key to select items in the Patch List, skipped items are passed over and
the next non-skipped item is selected. Skipped items are also skipped when you use the
patch selector in Full Screen or Perform mode.
To skip a patch or set
1 Select the patch or set in the Patch List.
2 Choose Skip from the Action menu for the Patch List.
The item appears as a thin line in the Patch List.
To set a skipped patch or set to no longer be skipped
1 Select the item (patch or set) in the Patch List.
2 Choose Don’t Skip from the Action menu for the Patch List.
The item returns to full size in the Patch List.
Patches and sets are skipped only when you use the arrow keys together with the
Command key. Items set to be skipped are still selected when you use the arrow keys
alone or when you click them.
Collapsing Sets in the Patch List
You can collapse sets in the Patch List. When you collapse a set, you can select the set
and use any channel strips or busses at the set level but cannot select or play patches in
the set while in Edit mode.
To collapse a set
µ In the Patch List, click the disclosure triangle for the set.
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no effect on whether you can select patches in the set in Full Screen or Perform mode.
For information about creating and using sets, see Working with Sets in Edit Mode.
Copying and Pasting Patches
You can copy, paste, and duplicate patches in the Patch List using the standard Mac OS X
menu and key commands or by Option-dragging. When you paste or duplicate a patch,
it includes any mappings made to parameters in the original patch.
Reordering Patches in the Patch List
When you add a patch to a concert, the new patch appears below the currently selected
patch in the Patch List. You can reorder patches in the Patch List.
To reorder patches in the Patch List
µ Drag patches up or down in the Patch List until they appear in the order you want.
Moving Patches in the Patch List Repeatedly
The MainStage command set includes a Move Again command that lets you easily move
selected patches multiple times. You can use Move Again when you drag, paste, create,
or delete patches in the Patch List. By default, the Move Again command is not assigned
to a key command. To use it, you should first assign it to a key command in the Command
Editor. For information about using the Command Editor, see Using the Command Editor.
Creating a Patch from Several Patches
You can create a patch by combining several existing patches. The new patch contains
all of the channel strips of the selected patches.
To create a patch from several existing patches
1 In the Patch List, select the patches you want to use to create the new patch.
2 Choose “Create Patch from Selected Patches” from the Action menu at the upper-right
corner of the Patch List.
The new “combined” patch appears in the Patch List, labeled “Untitled Patch.”
Note: Creating a patch with more than three channel strips can affect performance,
particularly if the channel strips are audio channel strips, or if they use a large number of
plug-ins or processor-intensive plug-ins.
Setting the Time Signature for a Patch
You can set the time signature for a patch. Time signatures can be used with the Playback
plug-in and also control the beats for the metronome. When you set the time signature
for a patch, it overrides any concert- or set-level time signature.
To set the time signature for a patch
1 In the Patch Inspector, select the Attributes tab.
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3 Double-click the number in the field to the right, and enter the number of beats for one
measure of the time signature.
4 Choose the beat value from the pop-up menu to the right.
Changing the Tempo When You Select a Patch
You can give a patch its own tempo setting so that when you select the patch, the tempo
changes to the patch tempo setting. MainStage uses the new tempo until you select
another patch or set with its own tempo setting, tap a new tempo, or until MainStage
receives tempo information from incoming MIDI messages. For more information about
using and changing tempo in MainStage, see Using Tempo in a MainStage Concert.
To change the tempo using a patch
1 In the Attributes tab of the Patch Inspector, set the patch tempo using the Change Tempo
To value slider.
2 Select the Change Tempo To checkbox to activate the patch tempo when the patch is
selected.
Select the checkbox 
and set the tempo 
using the slider.
Setting Patch Program Change Numbers
When you add a patch to a concert, the patch is given a MIDI program change number
(the lowest available number between 0 and 127) until all available program change
numbers are taken. You can select patches using program change numbers when
performing by assigning buttons on a MIDI device to send program change messages.
You can change the program change number in the Patch Inspector.
To change the program change number for a patch
1 In the Patch List, select the patch.
When you select a patch, the Patch Inspector appears below the workspace.
2 In the Attributes tab of the Patch Inspector, select the Program Change checkbox.
3 Using the value slider, set the program change number.
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available program change numbers in a concert are already in use, any new patches
added to the concert will be given program change number zero (0), but the number is
inactive (the checkbox is not selected). Bank changes are not supported.
If you set a program change number so that it duplicates an existing program change
number, the word “Duplicate” appears in red next to the Program Change value slider.
If two or more patches have the same program change number, and the numbers are
active, the patch that appears first (highest) in the Patch List or patch selector is selected
when you send the program change message with the corresponding value.
You can reset program change numbers for all active (non-skipped) patches in a concert.
When you reset program change numbers, patches are assigned program change numbers
based on their order in the Patch List, starting from the top. The program change numbers
for skipped (inactive) patches are not reset.
To reset program change numbers for active patches in a concert
µ Choose Reset Program Change Numbers from the Action menu for the Patch List (or press
Command-Shift-Option-R).
You can assign buttons and other controls to send program change messages and use
them to select patches in the concert. For information about assigning buttons, see
Assigning Buttons.
Deferring Patch Changes
By default, when you switch patches, the new patch is ready to play immediately. You
can “defer” a patch change so that the patch change occurs after the last note of the
previous patch has been released or sustained.
To defer a patch change
µ In the Attributes tab of the Patch Inspector, select the Defer Patch Change checkbox.
Note: Deferring patch change works in Perform mode and Full Screen mode but does
not work when you are editing patches in Edit mode.
Instantly Silencing the Previous Patch
Sometimes you may want the sound of the previous patch to continue after you select
a new patch, as when you want to sustain a chord pad while soloing over it. At other
times, you may want to silence the sound of the previous patch instantly when you select
a new patch.
To instantly silence the previous patch when you select a patch
µ In the Attributes tab of the Patch Inspector, select the Instantly Silence Previous Patch
checkbox.
46 Chapter 5 Working in Edit ModeChanging the Patch Icon
Each patch has an icon that appears in the Patch List next to the patch name. By default,
the patch icon shows the type of channel strip created when the patch was added. You
can choose a new icon for a patch and use icons to visually distinguish patches in the
Patch List.
To change the icon for a patch
µ In the Attributes tab of the Patch Inspector, choose an icon from the Icon pop-up menu.
Changing the Tuning for a Patch
By default, patches use the same tuning method as the concert (or the set, if they are in
a set with its own tuning method). You can change the tuning for a patch so that it uses
a different tuning. When you change the tuning for a patch, it overrides any concert- or
set-level tuning method.
To change the tuning for a patch
1 In the Patch Inspector, select the Tuning tab.
2 Choose the tuning you want the patch to use from the Method pop-up menu.
Deleting Patches
You can delete a patch if you decide you no longer want it in the concert.
To delete a patch
1 Select the patch in the Patch List.
2 Choose Edit > Delete (or press the Delete key).
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Channel strips are the building blocks of your patches. They contain the instruments and
effects for the sounds you use in performance. MainStage channel strips use the channel
strip interface familiar from Logic Pro. MainStage channel strips have the same structure
and many of the same functions as Logic Pro channel strips. The main features of
MainStage channel strips are shown below:
Settings menu
Pan knob
Icon
Name
Mute and solo buttons
Insert slots
Send slots
Volume fader and 
level meter
In MainStage, you can use audio, software instrument, and auxiliary (aux) channel strips
in your patches and sets, and also at the concert level. You can also use external instrument
patches to “play” external hardware devices and ReWire applications. You can use channel
strips in MainStage just as you can in Logic Pro. You can adjust the volume level using
the Volume fader, adjust the pan position using the Pan knob, and mute or solo the
channel strip using the Mute and Solo buttons.
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512 audio channel strips, 256 external instrument channel strips, and 256 auxiliary (aux)
channel strips.
As in Logic Pro, you can add effects using the Insert slots, send the signal to an auxiliary
channel (aux) using the Sends slots, and choose a different output from the Output slot.
For audio channel strips, you can change the format between mono and stereo using
the Format button. For software instrument channel strips, you can change the instrument
using the Input slot. You can also choose, copy, and save channel strip settings, choose
a different channel strip type, or reset the channel strip from the channel strip menu.
Because MainStage is designed for live performance rather than recording and arranging,
there are a few differences between MainStage channel strips and Logic Pro channel
strips:
• MainStage channel strips include an Expression dial so that you can easily see the
current MIDI Expression being received by the channel strip.
• MainStage channel strips do not have a Record Enable or Bounce button.
• MainStage audio channel strips can use automatic Feedback Protection to alert you
when feedback occurs on the channel. For information about using Feedback Protection,
see Using Feedback Protection with Channel Strips.
• MainStage audio channel strips do not have an input monitoring (i) button. You can
use the Mute button to silence the channel strip.
• In MainStage, you can use the Format button to select mono or stereo format. MainStage
does not support surround input or surround processing.
• MainStage channel strips do not have Group or Automation Mode pop-up menus.
• MainStage channel strips include a Change All option in both Input and Output pop-up
menus that you can use to change either the input or output for all channel strips in
a patch, a set, or for the overall concert.
• In MainStage, the selected channel strip is highlighted in white.
• Only one channel strip in each patch–the first audio channel strip–sends audio to the
Tuner. The channel strip that sends audio to the Tuner is indicated by a tuning fork
icon at the top of the channel strip.
• In MainStage, the name of the channel strip changes when you select a new channel
strip setting, unless you have renamed it.
• In MainStage, the channel strip number (at the bottom of the channel strip) reflects its
order in the patch, not the concert.
• Surround plug-ins are not available in MainStage.
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information, by Control-clicking the channel strip and choosing the information you
want to display from the shortcut menu.
• The Playback plug-in is available only in MainStage, not in Logic Pro.
For more information about working with channel strips, see the “Working with
Instruments and Effects” and “Mixing” chapters in the Logic Pro User Manual. For complete
information about the instruments and effects available in Logic Studio, see the Logic Studio
Instruments and Logic Studio Effects guides.
To learn how to add a channel strip, see Adding a Channel Strip. To learn how to change
a channel strip setting, see Changing a Channel Strip Setting.
Selecting Channel Strips
When you add a channel strip to a patch (or add a channel strip at the set or concert
level), the channel strip is selected in the Channel Strips area, and available settings appear
in the Channel Strip Settings browser. You can select a channel strip directly by clicking
it in the Channel Strips area and also select an adjacent channel strip by using key
commands:
Key command Selection
Left Arrow The channel strip to the left
Right Arrow The channel strip to the right
Showing Signal Flow Channel Strips
In addition to the channel strips in a patch, you can view and edit signal flow channel
strips in the Channel Strips area. Signal flow channel strips include the Output and Master
channel strips for the concert, auxes that are receiving signal from a channel strip in the
patch, and any set- or concert-level channel strips that are available when the patch is
selected. You can also view signal flow channel strips at the set level.
When you show signal flow channel strips, channel strips at the concert level, including
Output and Aux channel strips, include a small concert icon near the top of the channel
strip to make it easy to distinguish them from patch-level channel strips. Channel strips
at the set level include a small folder icon so they can also be easily distinguished.
You can edit signal flow channel strips in the Channel Strips area. For example, you can
adjust the volume fader or pan slider of a signal flow channel strip, or add effects to an
aux channel strip.
To show signal flow channel strips
µ Choose Show Signal Flow Channel Strips from the Action menu in the upper-right corner
of the Channel Strips area.
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You can create an alias of a channel strip and use the alias in different patches or sets.
Aliases allow you to share highly memory-intensive plug-ins, such as third-party
multi-channel instruments and samplers, between different patches, rather than creating
multiple instances of these plug-ins. In some cases, creating an alias can be more efficient
(use fewer resources) than adding a concert- or set-level channel strip.
To create an alias of a channel strip
1 In the Channel Strips area, select the channel strip.
2 Choose Edit > Copy, or press Command-C (default).
3 In the Patch List, select the patch in which you want to use the alias.
4 Choose Edit > Paste as Alias, or press Command-Option-V (default).
The alias is pasted after the last channel strip in the patch (but before any signal flow
channel strips, if they are visible). An alias icon appears near the top of the alias to
distinguish it from the channel strips in the patch.
You can use an alias in multiple patches or sets. When you change any setting on the
original channel strip, those changes are reflected in the aliases of the channel strip. You
may want to audition each patch that uses an alias after changing the settings of the
original channel strip, to make sure it sounds the way you want.
Note: You can’t import a patch or set containing an alias, because the aliased channel
strip may not be available.
You can create an alias of a multi-output instrument, such as the EXS24 mkII, to use in
another patch or set in the concert. When you copy a multi-output instrument to create
an alias, be sure to select all of the aux channel strips for the instrument so that the
complete multi-output instrument is pasted as an alias. For information about using
multi-output instruments in MainStage, see Using Multiple Instrument Outputs in
MainStage.
Editing Channel Strips in MainStage
You can add instruments to software instrument channel strips and add effects to any
channel strip in the Channel Strips area. Adding instruments and effects to a channel
strip is the same in MainStage as it is in Logic Pro.
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the workspace when the channel strip is selected in the Channel Strips area. You can set
the key range and velocity offset, create a controller transform, and filter MIDI control
messages to the channel strip. You can also rename the channel strip and change the
channel strip color and icon. The Channel Strip Inspector has four tabs, which provide
the following functions:
• Channel Strip Library and Plug-In Library: With a channel strip selected, you can choose
channel strip settings from the Channel Strip Library. With an Insert slot selected, you
can choose settings for the plug-in from the Plug-In Library.
• Attributes: You can rename the channel strip and choose a different channel strip color
and icon.
• MIDI Input: You can create controller transforms in the MIDI Input tab. For software
instrument and external instrument channel strips, you can also choose the MIDI input
device, filter MIDI input, transpose the instrument, and create velocity scaling graphs.
• Layer Editor: For software instrument and external instrument channel strips, you can
define the key range, set floating split points, and set the minimum and maximum
velocity for the channel strip.
Using the Channel Strip Library you can access any Logic Studio channel strip. However,
some channel strips include plug-ins, particularly Space Designer, not suited for live
performance because of their intensive CPU usage. Using these channel strips can affect
the performance of your concert, resulting in audio dropouts and other issues.
Logic Studio surround effect plug-ins cannot be used with MainStage. If you choose a
channel strip setting containing one of these effects, the unused effects are shown disabled
(gray, with a diagonal line running through the effect name).
Choosing Channel Strip Settings
You can quickly change the instrument, effects, and other parameters for a channel strip
by choosing a new channel strip setting. You can choose a new channel strip setting in
one of two ways:  by using the Channel Strip Library or by using the Settings button at
the top of the channel strip.
To choose a channel strip setting from the Channel Strip Library
1 In the Channel Strips area, select the channel strip you want to change.
The selected channel strip is highlighted with a blue outline.
2 In the Channel Strip Inspector, click the Channel Strip Library tab.
Available settings for the channel strip appear in the Channel Strip Library. Logic Studio
content appears in a series of folders with different instrument categories. If you have
GarageBand installed, or have one or more Jam Packs installed on your computer, those
settings appear below the Logic Studio settings.
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on the right until you see the settings you want.
You can select a recent channel strip setting by clicking Recent in the column on the left,
and then selecting a recent setting from the second column. As in Logic Pro, you can also
choose a new channel strip setting from the Settings menu at the top of the channel
strip.
To choose a channel strip setting from the Settings menu
µ Click the Settings button at the top of the channel strip, then choose a new setting from
the menu that appears.
When you choose new channel strip settings from the Settings menu, the selected channel
strip setting does not appear selected in the Channel Strip Library.
You can also search for channel strip settings by name.
To search for channel strip settings in the Channel Strip Library
1 In the Channel Strip Inspector, select the Channel Strip Library tab.
2 Choose Find in Library from the Action menu in the upper-right corner of the Channel
Strip Inspector.
3 In the dialog that appears, type the text you want to search for.
The channel strip with the text in its name appears selected in the library.
4 If more than one channel strip includes the search text, choose “Find Next in Library”
from the Action menu to cycle through the channel strips with names containing the
text.
5 To change the channel strip setting, click the name of the new setting in the Channel
Strip Inspector.
The Channel Strip Library shows all channel strip settings available to Logic Studio
applications, including settings that may not be useful in MainStage, such as mastering
settings. If you choose a channel strip setting containing plug-ins not usable in MainStage,
the plug-ins appear with a bold diagonal line in the Channel Strips area.
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When you add a channel strip to a patch, the channel strip has a default name. You can
rename channel strips to distinguish your custom settings from the default ones.
To rename a channel strip
µ In the Attributes tab of the Channel Strip Inspector, select the name in the Name field
and type a new name.
Type a new name 
in the field.  
Changing the Channel Strip Color
Each channel strip has a color, which appears at the bottom of the channel strip and as
a layer above the keyboard screen control in the workspace and the Layer Editor. You
can change the color of a channel strip to make it easier to visually distinguish channel
strips.
To change the color of a Software Instrument channel strip
µ In the Attributes tab of the Channel Strip Inspector, choose a color from the Color pop-up
menu.
Choose a color from the 
pop-up menu.
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When you add a channel strip, the channel strip has a default icon, which appears above
the Settings menu. You can change the icon to help visually distinguish channel strips
with different instrument types or uses.
To change the icon for a channel strip
µ In the Attributes tab of the Channel Strip Inspector, choose an icon from the Icon well.
Choose an icon from 
the menu. Using Feedback Protection with Channel Strips
You can use “Feedback Protection” on audio and external instrument channel strips in
MainStage. When Feedback Protection is turned on for a channel strip, MainStage alerts
you when it detects feedback on the channel. When the feedback alert appears, the
channel is temporarily silenced. You can then choose to mute the channel while you find
and eliminate the source of the feedback, allow feedback on the channel, or continue to
use the channel and receive alerts when feedback occurs.
Feedback protection is turned on by default for audio channels strips and turned off by
default for external instrument channel strips. You can turn Feedback Protection on or
off for a channel strip in the Channel Strip Inspector.
To turn Feedback Protection on or off
µ In the Attributes tab of the Channel Strip Inspector, select the Feedback Protection
checkbox to turn Feedback Protection on. If it is on, deselect the checkbox to turn it off.
Setting Keyboard Input for a Software Instrument Channel Strip
In the Channel Strip Inspector, you can choose the keyboard controller from which the
channel strip receives MIDI input. If you are using a multitimbral instrument, you can also
choose the input for each MIDI channel. For example, you can use the EVB3 instrument
as a multitimbral instrument, and send input to the upper and lower register and the
foot pedal using three separate MIDI channels.
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1 In the Channel Strip Inspector, click the MIDI Input tab.
2 Choose the MIDI input device from the Keyboard pop-up menu in the Input section.
The names in the Keyboard pop-up menu correspond to keyboard screen controls in the
workspace.
To set multitimbral input for different MIDI channels
1 In the Channel Strip Inspector, click the MIDI Input tab.
2 Choose Multitimbral from the Keyboard pop-up menu in the Input section.
3 In the Multitimbral Settings dialog, choose the input device for each MIDI channel you
want to receive MIDI input.
Transposing Software Instrument Channel Strips
You can transpose (change the pitch of) a software instrument channel strip. When you
transpose a channel strip, every MIDI note received by the channel strip is transposed by
the number of semitones set in the Transpose value slider.
To transpose the MIDI input of a software instrument channel strip
1 Select the channel strip in the Channel Strips area.
2 In the MIDI Input tab of the Channel Strip Inspector, set the value using the Transpose
value slider. You can click the value and drag up or down to set the value, click the up
arrow or down arrow, or double-click the value and type a new value.
Filtering MIDI Messages
You can filter some MIDI messages for a channel strip in the Channel Strip Inspector.
When you select one or more MIDI message types in the Filter section of the Channel
Strip Inspector, the corresponding MIDI message types are filtered out of any incoming
MIDI data and are not sent to the channel strip.
You can filter the following types of MIDI messages:
• Pitch Bend
• Sustain (control message 64)
• Modulation (control message 1)
• Expression (control message 11)
• Aftertouch
To filter incoming MIDI messages
1 In the Channel Strip Inspector, click the MIDI Input tab.
2 In the Filter section of the MIDI Input tab, select the checkbox for the MIDI messages you
want to filter.
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controller transform will still send its output message type. It is also possible to filter the
output message type, but in this case the output of the controller transform will be filtered.
Setting a Channel Strip to Ignore Hermode Tuning
If a patch (or the concert or set containing the patch) is set to use Hermode tuning, but
the patch contains a channel strip (for example, one with a drum or percussion instrument)
that you do not want to use Hermode tuning, you can set the individual channel strip to
ignore Hermode tuning.
To set a channel strip to ignore Hermode tuning
µ In the MIDI Input tab of the Channel Strip Inspector, select the Ignore Hermode Tuning
checkbox.
For information about using Hermode tuning, see the Logic Pro User Manual.
Working with Graphs
Using graphs, you can graphically remap the values for some MIDI control messages so
that input values from your controller produce different output values for the channel
strip or plug-in parameter. Graphs make it easier to see and modify a range of values for
a parameter, such as velocity or filter cutoff.
You can use graphs for the following types of parameters:
• Controller transforms
• Velocity scaling (both input velocity and note input)
• Parameters to which a screen control is mapped
You open a graph window by clicking the button for that type of graph in the appropriate
Inspector. The Transform and Velocity Scaling graphs for the selected channel strip are
available in the MIDI Input tab of the Channel Strip Inspector. The Parameter graph for
the selected screen control is available in the tab for the individual mapping as well as
in the Mappings tab in the (Edit mode) Screen Control Inspector.
The graph shows the range of input values on the horizontal (x) axis, moving from left
to right, and shows the range of output values on the vertical (y) axis, moving from bottom
to top.
In the graph window, you have several ways of working. You can edit the graph curve
directly, edit values numerically using the Precision Editor, or use the Curve buttons to
set the graph to one of the predefined curves.
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there are a few features specific to one or another type. For Parameter graphs, you can
change the minimum and maximum range values for the graph using the Range Min
and Range Max value sliders. For information about controller transforms, see Creating
Controller Transforms. For information about velocity scaling, see Scaling Channel Strip
Velocity. For information about parameter mapping graphs, see Using Parameter Mapping
Graphs.
To edit a graph
1 Select the channel strip or screen control you want the graph to apply to.
2 Select the MIDI Input tab (for transform and velocity scaling graphs) or the Mapping tab
(for parameter mapping graphs).
3 Click the graph button for the type of graph you want to edit.
The graph window opens.
4 Do one of the following:
• Click one of the Curve buttons to set the graph to one of the preset curves.
• Click the curve at the point where you want to add a node, then drag the node to the
desired value. Drag horizontally to change the input value, or vertically to change the
output value.
As you drag, the current values of the node appear next to the pointer.
• Double-click the curve at the point where you want to add a node, then edit the values
for the node in the Precision Editor.
• Option-click any part of the curve (except a node), then drag the dotted part of the
curve to make the curve nonlinear.
5 Continue adding and adjusting points on the curve until you achieve the result you want.
6 When you are finished, click the close button at the upper-left corner of the graph window
to close it.
To invert the values of the graph
Do one of the following:
µ In the graph window, click the Invert button.
µ In the tab for the mapping, select the Invert Parameter Range checkbox.
To reset the graph to its default values
µ Click the Revert to Default button at the top of the graph window.
After you have edited a graph, the button for the graph in the Inspector shows the edited
shape of the graph in a dark blue color to make it easier to identify which graphs you
have edited and how.
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µ Press Escape (Esc).
Creating Controller Transforms
Using a transform graph, you can remap the values for some MIDI control messages so
that input values from your controller produce different output values for the channel
strip. A common use of the transform is for expression scaling, where input MIDI expression
values are mapped to different output values on a graphic curve.
In addition, you can transform input values for one message type to output values for
another message type. For example, you can transform MIDI volume values from your
controller to send expression values to the channel strip, or transform input breath values
to send modulation values. The transform graph provides a very flexible way of remapping
both the values and the output destination for these MIDI control messages. In MainStage,
you can transform values for expression, modulation, MIDI volume, and breath control
messages.
You choose the input and output message types and graphically create transform curves
in the MIDI Input tab of the Channel Strip Inspector. In a transform graph, the horizontal
axis represents input values from your controller, and the vertical axis represents output
values sent to the channel strip.
To set the input and output message types for a controller transform
1 In the Channel Strips area, select the channel strip for which you want to create a controller
transform.
2 In the Channel Strip Inspector, select the MIDI Input tab.
3 In the Controllers section, choose the input message type from the Input pop-up menu.
4 Choose the output message type from the Output pop-up menu.
Click the Transform button 
to edit the graph.
Choose the input and 
output message types 
from these menus.
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µ In the MIDI Input tab of the Channel Strip Inspector, click the Transform button.
The Transform graph opens.
If a patch contains more than one channel strip with a transform graph, the transform
curves for the other channel strips in the patch appear in the controller Transform graph
window behind the current curve. Each channel strip in the patch can have its own
controller transform.
For information about editing the graph, see Working with Graphs.
Scaling Channel Strip Velocity
You can scale the output velocity of a channel strip using the Velocity Scaling graphs.
You can scale output velocity based on note input or input velocity.
When you perform velocity scaling, each input velocity (regardless of the note being
played) is scaled to the output velocity.
When you perform note scaling, output velocity is scaled depending on the note in the
key range. This is useful when you want to have a parameter change in different parts of
the key range; for example, when a filter or attack parameter opens for higher note values
to give a brighter, sharper sound.
To open a velocity scaling graph
1 In the Channel Strips area, select the channel strip on which you want to perform velocity
scaling.
2 In the Channel Strip Inspector, select the MIDI Input tab.
3 In the MIDI Input tab, do one of the following:
• To open the velocity input graph, select the Velocity Input button.
• To open the note input graph, select the Note Input button.
The selected velocity scaling graph opens.
For information about editing the graph, see Working with Graphs.
Creating Keyboard Layers and Splits
If you play a keyboard controller, you can easily create keyboard layers and splits in your
MainStage patches. You create layers and splits by adding two or more channel strips to
a patch and setting the Low Key and High Key for each channel strip to define its key
range. The key range defines the range of notes on a keyboard controller that trigger
sound from a software instrument or external instrument in the channel strip. You can
define key ranges so that they overlap (for layered sounds) or are contiguous (for splits).
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strip in a patch and in the concert or set containing the patch (if either includes a channel
strip with a key range). You can define the key range for a channel strip in one of several
ways:  you can drag the edges of the layer, use the Learn buttons to define the Low and
High keys, or use the Low Key and High Key value sliders.
To open the Layer Editor
µ In the Channel Strip Inspector, click the Layer Editor tab.
To define a key range using the layers
1 In the Layer Editor, move the pointer over the left edge of the layer you want to
change/define.
The pointer changes to a resize pointer.
2 Drag the left edge of the layer to the note you want to use as the low key (the lowest
note in the key range).
3 Move the pointer over the right edge of the layer.
4 Drag the right edge of the layer to the note you want to use as the high key (the highest
note in the key range).
To define a key range using the Learn buttons
1 In the Channel Strips area, select the channel strip.
2 In the Channel Strip Inspector, click the Layer Editor tab.
3 Click the Learn button next to the Low Key value slider.
Click Learn and play the 
corresponding note on 
your music keyboard. 
4 On your keyboard controller, press the key you want to set as the lowest key in the key
range.
5 Click the Learn button again to turn off Learn mode for the Low Key.
6 Click the Learn button next to the High Key value slider.
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range.
8 Click the Learn button again to turn off Learn mode for the High Key.
When you play the patch, you hear the channel strip when you play notes inside the key
range. When you play notes outside the key range, no sound is generated from the
channel strip.
To define a key range using the value sliders
1 In the Channel Strips area, select the channel strip.
2 In the Channel Strip Inspector, click the Layer Editor tab.
3 Change the value in the Low Key value slider.
You can click the value and drag vertically, click the up arrow or down arrow, or
double-click the value and type a new value.
Set the high key and 
low key using these 
value sliders. 
4 Change the value in the High Key value slider.
You can click the value and drag vertically, click the up arrow or down arrow, or
double-click the value and type a new value.
Setting Floating Split Points
When a key range has a floating split point, the notes that define the boundaries of the
key range ends change depending on the keys you play as you approach the boundary
of the key range. You set floating split points in the Layer Editor tab of the Channel Strip
Inspector.
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range to C1, set a floating split point value of 3, then play notes immediately above C1
(for example, the notes F1-Eb1-D1), and continue playing downward past C1 (for example,
the notes C1-Bb0-A0), the split point moves down to include those notes, up to the
floating split point value (3 semitones). If, however, you start by playing notes immediately
below the Low Key (for example, the notes G0-A0-B0) and continue playing upward past
C1 (for example, the notes C1-D1-E1), the split point moves up to include those notes,
up to the floating split point value. (In this example, C1 and D1 would be included, but
not E1, which is four semitones above the Low Key.)
To set floating split points for a layer/key range
1 In the Layer Editor tab, click the Low Key Floating value slider and drag vertically to change
the value, or double-click the current value and type a new value (the value is the number
of semitones used for the split).
2 Click the High Key Floating value slider and drag vertically to change the value, or
double-click the current value and type a new value.
You can also create a keyboard split by adding a channel strip at the set level and adjusting
the key range of the channel strips in the patches in the set. The channel strip at the set
level takes precedence over any channel strips in patches in the set for the notes in its
key range. For information about adding a channel strip at the set level, see Working at
the Set Level.
Setting the Velocity Range
By default, the velocity of a channel strip extends from 1 to 127. You can limit the velocity
range so that the channel strip only responds when the notes you play on your controller
fall between the Min and Max values of the velocity range.
To set the velocity range for a channel strip
1 In the Channel Strips area, select the channel strip.
2 In the Channel Strip Inspector, click the Layer Editor tab.
3 In the Layer Editor, set the minimum velocity that triggers the channel strip using the
Velocity Min value slider. (Click the value and drag vertically to change the value, or
double-click the value and type a new value.)
4 Set the maximum velocity that triggers the channel strip using the Velocity Max value
slider.
Overriding Concert- and Set-Level Key Ranges
If a software instrument channel strip exists at the concert level, the concert-level channel
strip takes precedence over any patch-level software instrument channel strips within its
key range. This means that when you play any notes in the key range of the concert-level
channel strip on a keyboard controller, you hear only the concert-level channel strip, even
when a patch is selected.
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applies for all patches in the set. That is, the set-level channel strip takes precedence over
any patch-level channel strips within its key range.
You can override concert- or set-level channel strips for a channel strip on an individual
patch, so that the patch-level channel strip takes precedence over the concert-level or
set-level channel strips.
To override concert- or set-level key ranges
1 In the Patch List, select the patch with the channel strip that you want to override the
concert- or set-level channel strip.
2 In the Channel Strips area, select the channel strip with the key range that you want to
override the concert- or set-level key range.
3 In the Channel Strip Inspector, select the Layer Editor.
4 Select the “Override parent ranges” checkbox.
The “Override parent ranges” checkbox is available only if there is a concert- or set-level
channel strip.
Using the EXS24 mkII Instrument Editor in MainStage
For channel strips using the EXS24 mkII sampler instrument, you can edit sampler
instrument zones and groups in the EXS Instrument Editor. The EXS24 mkII Instrument
Editor works exactly the same in MainStage as it does in Logic Pro, with one exception:  in
MainStage, you cannot open the Sample Editor to edit individual audio samples.
In an EXS24 mkII instrument, a zone is a location into which a single sample (an audio
file) is loaded from a hard disk. You can edit zone parameters in Zone view mode. Zones
can be assigned to groups, which provide parameters that allow you to simultaneously
edit all zones in the group. You can define as many groups as desired. The Instrument
Editor has two view modes:  Zones view and Groups view. You can edit zones in Zones
view and edit group parameters in Groups view.
To open the EXS24 mkII Instrument Editor
1 In a channel strip using the EXS24 mkII, double-click the EXS24 slot in the I/O section.
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Click the Edit button 
to open the 
Instrument Editor.
The Instrument Editor opens. When you play notes on the keyboard of the EXS24 mkII
Instrument Editor, the notes are played on the selected channel strip. You can switch
between Zones view and Groups view, click individual zones to view their parameters,
click notes on the keyboard to hear the samples assigned to them, create zones and
groups, and edit zone and group parameters just as you can in Logic Pro.
For in-depth information about using the EXS24 mkII Instrument Editor, refer to the
Logic Studio Instruments Help.
Using Multiple Instrument Outputs in MainStage
MainStage supports the multiple output versions of the EXS24 mkII, Ultrabeat, and some
Audio Units instruments. You can insert multi output instruments and use them to route
different outputs to different physical outputs, apply different plug-ins or processing to
different outputs, or for other uses.
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in the Instrument Plug-In menu for the instrument.
The Plug-In menu shows specific information about output configurations, for
example:  EXS24:  Multi Output (5xStereo, 6xMono).
Note: Not all instruments support multiple outputs. If no multi output version is available
in the Plug-In menu, the instrument does not support multiple outputs.
To insert a multi output instrument
1 On the channel strip in which you want to use the multi output instrument, click the
Instrument slot.
2 Choose the instrument from the Plug-In menu, and choose the multi output version from
the submenu.
The instrument name appears in the Instrument slot, and a small Add (+) button appears
below the Solo button on the channel strip. The Output for the instrument is set to Output
1-2.
3 Double-click the Instrument slot to open the instrument (plug-in) window.
You need to set up the output routing for individual sounds or samples in the instrument
(plug-in window). You set up output routing for the EXS24 mkII in the Instrument Editor,
and set up output routing for Ultrabeat in the Output menu of the Assignment section
of the Ultrabeat window.
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Each time you add an output, a new section of the channel strip is added, with the next
available pair of outputs.
Each output uses the same instrument, but each can have its own inserts, volume, pan,
and expressions settings and its own effect sends, as well as its own outputs.
For more information about using multiple instrument outputs, see the Logic Pro
User Manual and the Logic Studio Instruments manual. Information about specific
instruments (for example, Ultrabeat) can be found in the chapters covering those
instruments.
Using External MIDI Instruments in MainStage
You can add an external MIDI instrument channel strip to a patch and use it to play an
external instrument, such as a hardware synthesizer. You can also use an external
instrument to “play” a ReWire application.
When you use an external MIDI instrument channel strip, you choose the MIDI channel
to send MIDI output from MainStage to the instrument, and choose the audio inputs to
receive audio from the instrument. The audio output from the instrument is routed to
the input of the channel strip, where you can process it using MainStage effects.
To add an external instrument channel strip
1 Click the Add Channel Strip (+) button in the upper-right corner of the Channel Strips
area.
2 In the New Channel Strip dialog, select External Instrument.
You can also choose the MIDI input and output, the format, and the audio input and
output for the channel strip. You can choose an audio channel or a ReWire application
for the input, but cannot choose a bus. The MIDI input pop-up menu shows the Keyboard
or MIDI Activity screen controls (which receive MIDI note input) currently in the workspace.
Note: When using an external instrument to send MIDI to a ReWire slave application
(such as Reason or Live), you should disable any MIDI input the slave application receives
directly from the hardware controller. For information about disabling MIDI input from
a hardware device, consult the documentation for the application.
For ReWire applications, when you add an external channel strip, set the MIDI port to the
ReWire slave. The Channel list also updates based on the port. Some ReWire slaves set
up multiple ports. To use a ReWire application with MainStage, open the ReWire application
after opening MainStage.
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instrument selected, MainStage sends note and other MIDI messages to the chosen MIDI
Output and MIDI Channel, receives audio from the chosen Input, and sends the audio
output to the chosen Output. You can also send a program change message to the
external instrument when you select the patch to control which program the external
instrument uses.
To send a program change to an external instrument when you select a patch
1 In the Channel Strip Inspector, click the MIDI Out tab.
2 In the MIDI Out tab, select the Send Program Change checkbox.
The Program Change value is set to –1 by default, so that no program change is sent
when you select the Send Program Change checkbox, until you change the value.
3 Set the program change number you want to send using the Send Program Change value
slider.
4 If you want to send a Bank Change message, select the Send Program Change checkbox,
then set the most-significant byte (MSB) and least-significant byte (LSB) of the bank
change number using the Bank MSB and Bank LSB value sliders.
When you select the patch, the program change and bank change messages are sent to
the external instrument. Also note that program and bank changes are sent when you
edit the program change and bank change value sliders in the Channel Strip Inspector
(so you can be sure that the values you enter send the correct program and bank change
messages). For more information about using external MIDI instruments, see the Logic Pro
User Manual.
If you want the external instrument to respond to the program change, but do not want
it to receive note or other MIDI information from your controller, click the MIDI Input tab
and choose None from the Keyboard pop-up menu.
You can also use a knob or fader mapped to the Program Change action to send program
changes to an external instrument.
To send program changes to an external instrument using a screen control
1 In the workspace, click the screen control you want to use to send program change
messages.
2 In the Screen Control Inspector, click the Unmapped tab.
3 In the Mapping browser, select the external instrument, then select MIDI Controller folder
from the submenu.
4 In the third column from the left, select Program Change.
The screen control is mapped to the Program Change parameter. By moving the hardware
control assigned to the screen control, you can send program changes to the external
instrument.
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external instrument when you map the screen control to the Program change parameter,
a program change (Program 0) is sent when you create the mapping. If you are editing
the program on the external instrument, your changes may be lost. To map the screen
control without sending an immediate program change to the external instrument, choose
None from the MIDI Out slot of the external instrument before you create the mapping,
then choose the external instrument in the MIDI Out slot. No program change is sent
until you move the knob or fader.
Using the Activity Monitor
As you work on your concert in Edit mode, the Activity Monitor in the toolbar shows the
current CPU and memory information as well as received MIDI messages. The CPU section
of the Activity Monitor glows red to indicate a CPU overload condition.
The Memory section of the Activity Monitor glows yellow to indicate a low-memory
condition. If an extreme low-memory condition occurs, an alert appears, warning you to
save the concert before MainStage quits. Low-memory conditions can be caused by
having too many memory-intensive channel strips or plug-ins in a concert or by using
other memory-intensive applications (including ReWire applications) together with the
concert. If a low-memory condition occurs, try reopening the concert and consolidating
some memory-intensive plug-ins or channel strips.
Deleting Channel Strips
You can delete a channel strip if you decide you no longer want it in a patch.
To delete a channel strip
1 Select the channel strip in the Channel Strips area.
2 Choose Edit > Delete (or press the Delete key).
Mapping Screen Controls
After you have created your patches and learned controller assignments for the screen
controls you want to use, you can map MainStage screen controls to channel strip and
plug-in parameters to modify the sound of your patches while you perform, or map them
to MainStage actions to control other functions.
You map screen controls to parameters in Edit mode. After you learn controller
assignments (in Layout mode), the screen controls in the workspace do not respond to
movements of physical controls on your MIDI hardware until you map them to channel
strip parameters (in Edit mode). There are two ways to map screen controls to
parameters:  by visually selecting parameters on channel strips or plug-in windows or by
choosing parameters in the Parameter Mapping browser.
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After you have made your controller assignments, you can begin mapping screen controls
to the parameters in your patches you will want to control while you are performing. You
will likely want to map screen controls to parameters in each patch in a concert, so that
you can easily access and modify the parameters you want for each patch when you are
performing live. You can also map parameters at the concert level to control master
volume, view master levels, or modify concert-wide effects.
You can map screen controls to channel strip and plug-in parameters in one of two
ways:  by mapping screen controls visually to parameters on the channel strip or in a
plug-in window or by using the Parameter Mapping browser.
You map screen controls to parameters in Edit mode. The screen controls in the workspace
do not respond to movements of physical controls on your MIDI hardware until you map
them to channel strip parameters.
To map a screen control to a channel strip or plug-in parameter
1 In the workspace, click the screen control you want to map.
The screen control is highlighted in blue. The Screen Control Inspector appears below
the workspace, showing the parameters for the selected screen control. The Screen Control
Inspector includes General and Mapping tabs as well as a tab labeled Unmapped.
2 Press Command-L.
The Screen Control Inspector opens to the Unmapped tab, showing the Parameter
Mapping browser. The Map Parameter button lights red to indicate that mapping is active.
3 To map the screen control to a channel strip parameter, click the control for the parameter
on the channel strip in the Channel Strips area.
70 Chapter 5 Working in Edit Mode4 To map the screen control to a plug-in parameter, double-click the plug-in in the Inserts
section of the channel strip to open the plug-in window, then click the parameter in the
plug-in window.
Click the parameter in 
a channel strip or 
plug-in window.
Click the screen control 
you want to map to a 
parameter.
The screen control is mapped to the selected parameter, and the Unmapped tab takes
the name of the parameter. You can continue mapping additional screen controls by
clicking them in the workspace and then clicking the corresponding parameters in a
channel strip or plug-in window.
5 When you are finished, press Command-L again (or click the Map Parameter button) to
turn off mapping.
To map a screen control using the Parameter Mapping browser
1 In the workspace, click the screen control you want to map.
The screen control is highlighted in blue. The Screen Control Inspector appears below
the workspace, showing the parameters for the selected screen control. The Screen Control
Inspector includes General and Mapping tabs as well as a tab labeled Unmapped.
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The Parameter Mapping browser appears, showing the channel strips and plug-ins
available for mapping as well as the Actions folder.
3 In the column on the left of the Parameter Mapping browser, select the channel strip
with the parameter to which you want to map the screen control.
Parameters for the selected channel strip appear in the columns on the right. Additional
folders for the instruments and effects in the channel strip may appear in these columns.
Click a folder to see the parameters for that instrument or effect.
4 Select the parameter you want to map.
Click the parameter to 
which you want to map 
the screen control.
Click the channel strip 
or plug-in with the 
parameter you want 
to map.
The screen control is mapped to the selected parameter, and the Unmapped tab takes
the name of the parameter. You can continue mapping additional screen controls by
clicking them in the workspace and then choosing parameters in the Parameter Mapping
browser. Using the Parameter Mapping browser, you can map parameters that are not
visible in plug-in windows.
You can also map screen controls to MainStage actions and to AppleScript scripts. For
more information about mapping screen controls, see Mapping Screen Controls.
Note: If you change the channel strip setting for a channel strip to which you have mapped
screen controls, you will lose any parameter mappings.
You can also edit velocity sensitivity for a channel strip, create controller transforms, and
filter various MIDI messages. For information about editing channel strips, see Editing
Channel Strips in MainStage.
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In addition to mapping screen controls to channel strip and plug-in parameters, you can
map them to MainStage actions. Actions let you select patches and sets; silence MIDI
notes; control the Tuner and the metronome; tap a new tempo; display information about
patches, MIDI messages, and other information; and perform other functions using screen
controls.
For a complete table of actions, including descriptions and usage notes, see Using
MainStage Actions.
The Actions folder, which appears in the Parameter Mapping browser along with available
parameters, contains actions for selecting patches and sets, showing the Tuner, activating
tap tempo, Master Mute, or Panic, and others. The Actions folder also contains an
AppleScript subfolder with useful scripts.
You can map button screen controls to actions for selecting different patches and use
physical buttons on your MIDI device to select patches when you perform. You can also
map buttons to actions for selecting different sets or selecting the concert. For information
about assigning buttons, see Assigning Buttons.
To map a screen control to an action
1 In the workspace, click the screen control you want to map.
The Screen Control Inspector appears below the workspace, showing the settings for the
selected screen control. If the screen control is currently mapped, a tab with the name
of the mapping is visible in addition to the General and Mapping tabs. If the control is
unmapped, the tab is labeled “Unmapped.”
2 Click the Unmapped (or name of mapping) tab.
The Parameter Mapping browser appears below the workspace. The Actions folder is
available in the Parameter Mapping browser.
3 In the column on the left of the Parameter Mapping browser, click the Actions folder.
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Click the Actions folder to 
see available actions.
Click the action you 
want to map from 
the submenu.
4 Select the action you want to map.
Note: If you map a knob screen control to an action to select a patch (such as the
−10 Patches, Previous Patch, Next Patch, or +10 Patches action), the screen control jumps
to the value of the hardware control, regardless of the setting of the Respond to Hardware
Move parameter in the Screen Control Inspector.
Mapping a Screen Control to Multiple Parameters
You can map a single screen control to multiple parameters and control how the screen
control modifies each mapped parameter. Mapping a screen control to multiple parameters
is also referred to as multimapping. You map a screen control to up to eight parameters
by adding mappings in the Screen Control Inspector.
To add a mapping
1 Map the screen control to a parameter or action, as described in Mapping Screen Controls
to Channel Strip and Plug-In Parameters and Mapping Screen Controls to Actions.
2 With the screen control selected, click the Add Mapping (+) button at the upper-right
corner of the Screen Control Inspector.
A new Unmapped tab appears in the Inspector, showing the Parameter Mapping browser.
3 In the Parameter Mapping browser, choose the parameter to which you want to map the
screen control.
If you add a mapping while the Learn process is active (the Map Parameter button is red),
you can immediately learn the new mapping. The Command Editor also includes key
commands for selecting the previous and next tab to make mapping to multiple
parameters easier. For information about using key commands, see Using the Command
Editor.
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by assigning key commands to select the previous and next tab or to select a specific tab
in the Screen Control Inspector. For information about assigning key commands, see
Using the Command Editor.
To view all mappings for a screen control
µ In the Screen Control Inspector, select the Mappings tab.
The mappings appear in a list view that shows the minimum and maximum range values
and patch change behavior for each mapping and includes buttons to open the Parameter
graph and Invert graph values for each mapping.
If you create multiple mappings for a screen control, you can define the relationships
between the first mapping and subsequent mappings. This can be especially useful when,
for example, you are mapping the same control to filter cutoff and filter resonance, and
you want to ensure that resonance does not exceed a certain maximum value as you
increase the cutoff value. The default relationship affects all future mappings (for the
same and other screen controls), but does not affect existing mappings. The default is
set to Scale the first time you open MainStage.
To define the default relationship between the first mapping and subsequent mappings
1 Select a screen control you want to map to multiple parameters.
2 Choose “Default Relation to First Mapping” from the Action menu, located in the
upper-right corner of the Screen Control Inspector.
3 Do one of the following:
• To set subsequent mappings to be offset by a fixed value from the first mapping, choose
Offset.
• To set subsequent mappings to scale by a constant ratio, starting from the same
minimum value, choose Scale.
• To set subsequent mappings to scale by a constant ratio to the point defined for the
mapping, starting from both the same minimum value and maximum value, choose
Pivot.
Using Parameter Mapping Graphs
Each parameter mapping has a Parameter graph. You can edit the graph to remap input
values to different output values for the parameter.
To open the Parameter graph for a mapping
µ In the tab for the mapping or in the Mappings tab, double-click the Graph button for the
mapping you want to edit.
The Parameter graph window opens. The title of the graph window shows the parameter
name.
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Mapping Screen Controls to All Channel Strips in a Patch
When you map a screen control to a channel strip parameter such as volume or pan, you
can map it to control the same parameter in all of the channel strips in the patch. This is
particularly useful when you want to control the overall volume of a layered sound, even
if the different layers are played across multiple keyboards.
To map a screen control to all channel strips in a patch
1 Map the screen control following the instructions in the preceding sections.
2 In the column on the left of the Parameter Mapping browser, select the Send to All folder.
3 Select the destination from the second column.
4 Select the parameter to map the screen control to from the third column.
You can map the screen control to actions for transposing software instrument channel
strips, channel strip parameters, and MIDI control message types from the Destinations
folder. When you map a screen control to all channel strips in a patch, the parameter to
which the screen control is mapped changes to the same value for all channel strips in
the patch when you move the screen control.
Note: When you map a drum map using Send to All, the Send to All folder contains MIDI
notes, not controllers.
Undoing Parameter Mapping
You can undo parameter mapping if you decide you don’t want to keep the mapping.
When you undo parameter mapping, all mappings created in the current Learn mode
(either by pressing Command-L or clicking the Map Parameter button) session are undone.
To undo parameter mappings
Do one of the following:
µ Choose Edit > Undo (or press Command-Z).
µ Press the Escape key.
Removing Screen Control Mappings
If you want a screen control to be free of any mappings, you can remove its existing
mapping. This can be useful with controls that pass through MIDI messages (for example,
for pitch bend and modulation wheels, or expression pedals) when you do not want them
to send MIDI messages for their pass-through control type. You do not need to remove
the mapping for a screen control when you remap it.
To reset the mapping for a screen control
1 In the workspace, click the screen control you want to map.
2 In the column on the left of the Parameter Mapping browser, click None.
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In Layout mode, you edit basic screen control parameters that are constant throughout
the entire concert. In Edit mode, you can edit screen control parameters for a specific
patch or set. You can also override concert- and set-level mappings for an individual
patch or set.
Overriding Concert- and Set-Level Mappings
By default, mappings you make at the concert level (to parameters and actions) take
precedence over mappings to individual patches or sets in the concert. If you map a
screen control to a parameter at the concert level (for example, to Master Volume), that
screen control cannot be mapped to a parameter or action in a patch or set, unless you
override the concert-level mapping.
Similarly, mappings you make at the set level take precedence over mappings for any
patches in the set. If you map a screen control to a parameter at the set level (for example,
to an effect on a set-level channel strip), that screen control cannot be mapped to a
parameter or action in a patch in the set, unless you override the set-level mapping.
If you try to map a screen control that is mapped at the concert or set level, text appears
in the Screen Control Inspector informing you that the screen control is mapped at another
level, and the parameters in the Screen Control Inspector are dimmed. You can override
the concert- and set-level mappings for an individual patch, and then map the screen
control at the patch level.
To override concert-level mappings
µ In the Screen Control Inspector, select the Override Concert Mapping checkbox.
Select the checkbox to 
override mappings at 
the concert level.
The parameters in the Screen Control Inspector become active.
To override set-level mappings and other parameters for a patch
µ In the Screen Control Inspector, select the Override Set Mapping checkbox.
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Mapping tabs for concert-level mappings are available only at the concert level, and
mapping tabs for set-level mappings are available only at the set level. When you override
a concert- or set-level mapping, the mapping tabs become available at the level of the
override.
Replacing the Parameter Label
You can replace the parameter label for a screen control (for an individual patch or set),
to make the label easier to identify.
To replace the parameter label for a screen control
1 Select the screen control in the workspace.
2 In the Screen Control Inspector, select the Attributes tab.
3 Select the Replace Parameter Label checkbox.
4 Enter the new label text in the field.
Choosing a Custom Color for a Screen Control
You can change the color of the active area of a screen control (for an individual patch
or set).
To choose a custom color for a screen control
1 Select the screen control in the workspace.
2 In the Screen Control Inspector, select the Attributes tab.
3 Select the Custom Color checkbox.
4 Choose a new color from the Custom Color pop-up menu.
Choosing a Custom Image for a Panel Screen Control
You can display a custom image for a panel control, and choose a different image for
each patch or set.
To choose a custom image for a panel screen control
1 In Edit Mode, Option-click the panel screen control in the workspace.
Panel and Image controls appear in the Screen Control Inspector.
2 In the Screen Control Inspector, select the Custom Image checkbox.
3 Click Image, then click Select...
An Open dialog appears.
4 Browse to the image you want to use, select the image, then click Choose Image.
Choosing Custom Text Color for a Screen Control
You can change the color of the text for a screen control (for an individual patch or set).
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1 Select the screen control in the workspace.
2 In the Screen Control Inspector, select the Attributes tab.
3 Select the Custom Label Color checkbox.
4 Choose a new color from the Custom Label Color menu.
Setting a Screen Control to Show the Hardware Value
By default, screen controls show the value of the parameter the control is mapped to. In
some cases, for example, when the screen control is assigned to a foot pedal, or when
the screen control is mapped to multiple parameters, it may be better to show the value
of the hardware control assigned to the screen control.
To set a screen control to show the hardware value
1 Select the screen control in the workspace.
2 In the Screen Control Inspector, select the Attributes tab.
3 Select the Show Input Value checkbox.
Setting Parameter Change Behavior for Screen Controls
You can set the behavior for saving parameter values for screen controls in individual
patches. This is useful, for example, when the default for saving parameter values is set
to Reset, but you want certain screen controls (for example, concert- and set-level screen
controls) to keep their current value when switching patches.
To set the behavior for saving parameter values in a patch
1 Select the patch.
2 Select the screen control for which you want to set the parameter change behavior.
3 In the Attributes tab of the Screen Control Inspector, choose the parameter change
behavior for the screen control from the “When a patch is changed and screen value
differs from saved patch” pop-up menu:
• To have the screen control use the default behavior set in MainStage preferences,
choose Preference.
• To preserve changes to parameter values when you change patches, choose Keep.
• To return values to the last saved value, choose Reset. When this value is chosen, you
should save the concert after making any changes you wish to keep to the patch, before
selecting another patch.
• To have the screen control use the last received value from the physical control assigned
to it, choose Match.
When you choose an item from the pop-up menu, a brief description of its function
appears below the menu.
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parameter values are also reset when you switch to Layout mode.
Setting Hardware Matching Behavior for Screen Controls
Some hardware synthesizers and music workstations let users control what happens
when you move a physical control that is set to a different value than the parameter it
modifies. The parameter value can instantly change to the position of the physical control
(sometimes called jump), it can change by the same amount (called relative), or it can not
change at all until the physical control matches its current value (called snap).
You can set the behavior for screen controls in MainStage to any of these behaviors when
you move the physical control assigned to the screen control.
To set the behavior for screen controls when you move a hardware control
1 Select the patch.
2 Select the screen control for which you want to set the hardware matching behavior.
3 In the Attributes tab of the Screen Control Inspector, choose the parameter change
behavior for the screen control from the “When hardware value differs from screen value”
pop-up menu:
• To have the screen control use the default behavior set in MainStage preferences,
choose Preference.
• To have the screen control instantly change to match the hardware value, choose Jump.
• To have the screen control change when the hardware control matches its current
value, choose Pickup.
• To have the screen control move relative to the hardware control, choose Relative.
Note: When you choose an item from the menu, a brief description of its function appears
below the menu.
Resetting and Comparing Changes to a Patch
You can reset changes to all parameters in a patch that are mapped to screen controls
to their last saved value, letting you hear the patch in its last saved (original) state, and
toggle between the original and modified states of the patch. There are two ways to reset
and compare changes to a patch: by using the Reset/Compare Patch button in the toolbar
or by using the Reset/Compare Patch action mapped to a screen control at the concert
level.
To reset changes to mapped patch parameters using the Reset/Compare Patch button
1 With the patch selected, click the Reset/Compare Patch button.
The patch is reset to its previously saved state.
2 To hear the patch in its modified state, click the Reset/Compare Patch button.
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1 In Layout mode, add a button screen control to your layout.
2 Assign a button on your hardware controller to the new button screen control.
3 In Edit mode, click the concert icon in the Patch List.
4 Select the new button screen control in the workspace.
5 In the Parameter Mapping browser, select the Actions folder, and then select the Reset/
Compare Patch action in the second column.
For more information about mapping a screen control at the concert level, see Controlling
the Overall Volume of a Concert.
Working with Sets in Edit Mode
Sets are like folders that let you organize patches you want to keep together. Using sets,
you can organize patches in any manner. For example, you can put all the patches you
want to use in the first part of a performance together or keep all your lead synth patches
together. Sets are flexible, so you can use them in whatever way suits your method of
working.
Here are some different ways you can use sets:
• To group similar or related sounds into “banks”
• To keep multiple patches you’ll use in a single song together
• To share a set-level instrument or channel strip between a group of songs
Creating Sets
You can create a new, empty set or create a set from a group of selected patches.
To create a new, empty set
µ Choose New Set from the Action menu in the upper-right corner of the Patch List.
A new set appears in the Patch List.
To create a set from a group of patches
1 In the Patch List, select the patches you want to include in the new set.
2 Choose New Set From Selection from the Action menu at the upper-right corner of the
Patch List.
The new set appears in the Patch List containing the selected patches. You can add new
patches to the set or drag existing patches into the set.
Renaming Sets
When you create a set, it is given a default name. You can rename a set in the same way
you rename a patch in the Patch List.
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1 Double-click the set in the Patch List.
A text field appears around the set name, which is selected.
2 Type a new name in the set name field.
Setting the Time Signature for a Set
You can set the time signature for a set. Time signatures can be used with the Playback
plug-in and also affect the beats of the metronome. When you set the time signature for
a set, it overrides the concert-level time signature (if one is set).
To set the time signature for a set
1 In the Set Inspector, select the Has Time Signature checkbox.
2 Double-click the number in the field to the right, and enter the number of beats for one
measure of the time signature.
3 Choose the beat value from the pop-up menu to the right.
Changing the Tempo When You Select a Set
You can give a set its own tempo setting so that when you select the set, the tempo
changes to the set tempo setting. MainStage uses the new tempo until you select another
patch or set with its own tempo setting, tap a new tempo, or until MainStage receives
tempo information from incoming MIDI messages. For more information about using
and changing tempo in MainStage, see Using Tempo in a MainStage Concert.
To change the tempo using a set
1 In the Patch List, select the set.
2 In the Set Inspector, set the set tempo using the “Change Tempo to” value slider.
3 Select the “Change Tempo to” checkbox to activate the set tempo when the set is selected.
Changing the Tuning for a Set
By default, new sets (and most existing ones) use the same tuning method as the concert.
You can change the tuning for a set so that it uses a different tuning. When you change
the tuning method for a set, the patches in the set use the set-level tuning unless you
change the tuning at the patch level.
To change the tuning for a set
1 In the Set Inspector, select the Tuning tab.
2 Choose the tuning you want the set to use from the Method pop-up menu.
82 Chapter 5 Working in Edit ModeOverriding Concert-Level Key Ranges for a Set
If a software instrument channel strip exists at the concert level, the concert-level channel
strip takes precedence over any set-level software instrument channel strips within its
key range. This means that when you play any notes in the key range of the concert-level
channel strip on a keyboard controller, you hear only the concert-level channel strip, even
when a patch is selected in a set with a set-level channel strip.
You can override the concert-level channel strip for a channel strip at the set level so that
the set-level channel strip takes precedence over the concert-level one.
To override concert- or set-level key ranges
1 In the Patch List, select the set with the channel strip that you want to override the
concert-level channel strip.
2 In the Channel Strips area, select the channel strip with the key range that you want to
override the concert-level key range.
3 Select the “Override parent ranges” checkbox.
Deleting Sets
You can delete a set if you decide you no longer want it in the concert.
To delete a set
1 Select the set in the Patch List.
2 Choose Edit > Delete (or press the Delete key).
When you delete a set, the patches in the set are also deleted. To delete the set without
deleting the patches, move the patches outside the set before you delete it.
Working at the Set Level
You can add channel strips at the set level and play the set-level channel strips together
with every patch in the set. This can be useful, for example, if you want to use the same
bass instrument in a single song or group of songs. You can place the patches for all of
the songs in a set, add a channel strip at the set level, and then add a bass instrument to
the set-level channel strip. You can set the key range of the bass instrument to play only
notes in the lower octaves so that you can play it together with your patches.
Important: If you add a channel strip at the set level, it takes precedence over all of the
channel strips in all of the patches in the set. For example, if you add a software instrument
channel strip at the set level, the software instrument for the set takes precedence over
all of the software instruments in all of the patches in the set that fall within the same
key range as the set-wide software instrument.
To add a set-level channel strip
1 In the Patch List, select the set.
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3 In the New Channel Strip dialog, select the type of channel strip you want to create.
4 Choose the audio output for the channel strip from the Output pop-up menu.
5 For audio channel strips, choose mono or stereo format from the Format pop-up menu
and choose the audio input from the Input pop-up menu.
6 Click Create.
Sharing Patches and Sets Between Concerts
You can export patches and sets from a concert and import them into another concert.
When you import a set, all the patches in the set are imported.
To export a patch
Do one of the following:
µ Drag the patch from the Patch List to the Finder.
The patch appears as a .patch file in the Finder.
µ Select the patch, choose “Save as Patch” from the Action menu in the Patch List, then
click Save.
The patch is exported to the ~/Library/Application Support/Logic/MainStage Patches
folder.
To export a set
Do one of the following:
µ Drag the set from the Patch List to the Finder.
The set appears as a .patch file in the Finder.
µ Select the set, choose “Save as Set” from the Action menu in the Patch List, then click
Save.
The set is exported to the MainStage Patches folder.
Note: You can also export an entire concert as a set by selecting the concert and choosing
Export Set from the Action menu.
You can export multiple patches or sets. When you export multiple patches by dragging
them to the Finder, each patch is exported as a .patch file. When you select multiple
patches and export them using the Export Patch command, the patches are grouped
into a single exported set. You can import patches or sets from the Finder to another
open concert.
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Do one of the following:
µ In Edit mode, drag the patch or set from the Finder to the Patch List.
µ Choose Load Patch/Set from the Action menu in the Patch List, select the patch or set
you want to import, then click Import.
Recording the Audio Output of a Concert
You can record the audio output of a MainStage concert. When you record audio output,
all audio on the output you choose is recorded (including the metronome, and so on).
Before you record audio output, make sure the correct output, recording location, and
file format are set in the Audio tab of MainStage preferences. For information about
setting recording preferences, see Setting MainStage Preferences.
To record audio in Edit mode
µ Click the Record button in the toolbar.
To turn off recording
µ Click the Record button again.
You can also map a screen control to the Record action to record audio in Perform and
Full Screen modes, and assign a key command to the action to turn recording on or off
using a hardware control.
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your performances, customize your onscreen layout, and make connections between
your MIDI hardware and MainStage.
A concert holds all the sounds you’ll use for an entire performance or a series of
performances. In a concert, you add, edit, and organize patches, and select patches while
you are performing. You can reorder patches in the Patch List and also organize them
into sets.
Concerts also contain layouts, where you visually arrange screen controls in the workspace
and make connections between your hardware devices and MainStage. You can add and
arrange screen controls and assign physical controls on your hardware MIDI devices to
screen controls in Layout mode. For information about customizing your layout, see
Working in Layout Mode.
You can also control the volume for an entire concert, add concert-wide effects, and make
other changes at the concert level.
This chapter covers the following:
• Opening and Closing Concerts (p. 88)
• Saving Concerts (p. 89)
• How Saving Affects Parameter Values (p. 89)
• Setting the Time Signature for a Concert (p. 90)
• Using Tempo in a MainStage Concert (p. 91)
• Defining the Source for Program Change Messages for a Concert (p. 92)
• Setting the Pan Law for a Concert (p. 93)
• Changing the Tuning for a Concert (p. 93)
• Silencing MIDI Notes (p. 93)
• Muting Audio Output (p. 94)
• Working at the Concert Level (p. 95)
• Controlling the Metronome (p. 101)
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6Opening and Closing Concerts
You can create a new concert from a template, open an existing concert to continue
working, and close and save concerts. You can add patches to a concert and organize
them in the Patch List. The number of patches is limited only by the amount of available
memory. You can add channel strips to an existing patch or to new ones you create and
can organize patches into sets. For information about patches and sets, see Working in
Edit Mode.
The process of creating a new concert from a concert template is described in Choosing
a Concert Template. You can open an existing concert to play the patches in the concert
or continue editing them.
To open an existing concert
Do one of the following:
µ Choose File > Open Concert, select the concert you want to open, then click Open.
µ Choose File > New to open the Choose Template dialog, click “Open an Existing Concert,”
then choose the concert from the Open dialog.
µ In the Finder, double-click the concert.
µ In the Finder, drag the concert over the MainStage icon in the Dock.
You can also reopen a recently open concert by choosing File > Open Recent Concert
and then choosing a concert from the submenu, or by opening the Choose Template
dialog, clicking Recent Concert, then choosing the concert you want to open.
By default, when you open a concert, it opens in Edit mode. You can change the default
behavior in MainStage preferences. For more information, see Setting MainStage
Preferences.
The first time you open a concert, the first patch is selected, and the Patch Library is open
so you can easily choose a patch setting. When you reopen a concert, the patch that was
selected when you last saved the concert is selected.
If any audio files or other assets are not found when you open a concert, a dialog appears
showing which assets are missing, and asking if you want to search for the assets, locate
them manually, or skip them.
Note: When you open a concert created with an earlier version of MainStage, it opens
as an untitled concert, and MainStage prompts you to save the concert as a MainStage 2
concert.
To close a concert
µ Choose File > Close Concert.
If you have edited the concert since the last time you saved it, you are prompted to save
your changes.
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When you save a concert, all of the changes you made to the patches and sets in the
concert, as well as the concert settings, are saved. To prevent losing your changes, be
sure to save your work periodically.
To save a concert
1 Choose File > Save Concert.
2 The first time you save a concert, the Save dialog appears. Enter a name for the concert,
and browse to the location where you want to save it, then click Save.
You can save a copy of a concert with a new name by choosing File > Save Concert As.
You can save a concert together with the assets (audio files, instruments, Ultrabeat
samples, and Space Designer impulse response files) the concert uses, similar to saving
a Logic song as a project.
To save a concert including its assets
1 Choose File > Save As.
2 In the Save As dialog, select the Include Assets checkbox.
3 Optionally, with the Include Assets checkbox selected, click the Advanced Options triangle,
then select the types of assets you want to include with the concert.
4 Click Save.
You can also save a concert as a template. When you save a concert as a template, the
template is available in the My Templates section of the Choose Template dialog.
To save a concert as a template
1 Choose File > Save as Template.
2 In the Save As dialog, enter a name for the template.
3 Click Save.
By default, templates are saved in the MainStage Concerts folder. When you save a concert
as a template, you can choose a different location to save the concert. If you save the
concert in a different location, it will not be available in the Choose Template dialog.
How Saving Affects Parameter Values
While a concert is open, any “performance” changes you make to channel strip parameters
(including volume, pan, and expression) or plug-in parameters are retained for as long
as the concert is open. If you close the concert without saving, the parameter values
revert to their previously saved state when you reopen the concert. If you save the concert
before closing it, the changed values are saved.
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saved state.
To revert a concert to its last saved state
µ Choose File > Revert to Saved.
All the changes you’ve made since the last time you saved the concert are lost when you
revert the concert to its last saved state.
If you change parameter values in a patch, select another patch, and later select the first
patch again, the parameter values will be as you left them when you selected the other
patch. You can also choose the default behavior for saving changes to values of parameters
to which screen controls are mapped. You can set the default to either have parameters
keep their current value when changing patches (the default behavior in MainStage
version 1.0), or to reset their values to the last saved value (similar to many hardware
synthesizers).
To set the default behavior for saving parameter values
1 Choose MainStage > Preferences.
2 In the Parameter Values section of the General preferences pane, choose the default
behavior from the “On patch changes” pop-up menu.
a To preserve changes to parameter values when you change patches, choose “Keep
current value.”
b To return parameters to their last-saved value when you change patches, choose “Revert
to saved value.”
You can also set the behavior for saving parameter values for screen controls in individual
patches. For information, see Setting Parameter Change Behavior for Screen Controls.
Setting the Time Signature for a Concert
You can set the time signature for a concert. Time signatures can be used with the Playback
plug-in and also affect the operation of the metronome. When you set the time signature
for a patch or set, it overrides the concert-level time signature while the patch or set is
selected. When you select a patch or set without a time signature, it uses the concert
time signature.
To set the time signature for a concert
1 In the Concert Inspector, select the Has Time Signature checkbox.
2 Double-click the number in the field to the right, and enter the number of beats for one
measure of the time signature.
3 Choose the beat value from the pop-up menu to the right.
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Each concert has a tempo, which you can change in different ways while you are
performing. Some plug-ins available in MainStage, including delay and tremolo effects,
synthesizer LFOs, and the metronome, can require a specific tempo. You can set the initial
tempo for a concert, and change the tempo by selecting a patch or a set with its own
tempo setting. You can also change the tempo in real time by tapping a new tempo or
have MainStage receive tempo changes from incoming MIDI messages.
When you open a MainStage concert, the tempo setting in the Concert Inspector is used
until you change the tempo by selecting a patch or set with its own tempo setting or by
tapping a tempo. When you change the tempo, MainStage uses the new tempo until
you change it again or until you close the concert.
You can set the tempo for a concert in the Concert Inspector, which appears in the
lower-left corner of the MainStage window when the concert icon is selected in the
Patch List. By default, the tempo for new concerts is set to 120 beats per minute (bpm).
To set the tempo for a concert
1 In the Patch List, select the concert icon.
2 In the Concert Inspector, set the tempo using the Tempo slider or value slider.
Set the tempo by 
dragging the 
Tempo slider or using 
the value slider.
You can use patches and sets to change the tempo when you select the patch or set
while performing. For information about patch tempo settings, see Changing the Tempo
When You Select a Patch. For information about set-level tempo settings, see Changing
the Tempo When You Select a Set.
Tapping the Tempo
MainStage includes a “tap tempo” feature that allows you to set the tempo in real time
while you perform. You can tap the tempo using the Tap Tempo button in the toolbar
(if it is visible) or using a key command.
To tap the tempo using the Tap Tempo button
µ Click the Tap Tempo button in the toolbar several times at the desired tempo.
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You can also tap the tempo using your computer keyboard.
To tap the tempo using a computer keyboard
µ Press Control-T several times at the desired tempo.
You can also tap the tempo using a screen control mapped to the Tap Tempo action. For
information about mapping screen controls to actions, see Mapping Screen Controls to
Actions.
Getting the Tempo from MIDI Input
You can also have MainStage receive tempo changes from incoming MIDI messages.
When the “Get tempo from MIDI input” checkbox is selected, MainStage listens to incoming
MIDI clock messages for tempo information. If it receives tempo information, the concert
tempo changes to the new tempo value.
To get the tempo from incoming MIDI clock messages
1 In the Concert Inspector, select the “Get tempo from MIDI input” checkbox.
2 Choose the MIDI clock source from the Device pop-up menu.
When the “Get tempo from MIDI input” checkbox is selected, the Tempo slider is dimmed
and cannot be edited. If MIDI messages MainStage receives do not include MIDI clock
information, MainStage uses the concert tempo setting and changes the tempo when
you select a patch or a set with its own tempo setting, or tap a new tempo. If MainStage
stops receiving MIDI clock messages, it continues to use the last received value for the
tempo until you select a patch or set with its own tempo setting or tap a new tempo.
Defining the Source for Program Change Messages for a Concert
By default, MainStage receives and responds to program change messages from all
connected MIDI controllers. Some MIDI controllers, however, send program change
messages while performing other operations. You can define the source for program
change messages for a concert, so the concert responds to messages for only one MIDI
device, port, or channel.
To define the source for program change messages
1 In the Attributes tab of the Concert Inspector, choose the device or port from which the
concert will receive program change messages from the Device pop-up menu.
2 If you want to limit messages to a single MIDI channel on the device, choose the MIDI
channel from the Channel pop-up menu.
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Audio signals panned to the center position may sound louder than signals panned hard
left or right. The Pan Law value determines the amount of volume reduction applied to
audio that is panned to the center position. You can choose from the following settings:
• 0 dB: With no change to the volume level, signals will seem louder when panned to
the center position, in comparison with extreme left or right pan positions.
• −3 dB: A full scale signal (0 dBfs) will have a level of −3 dB when panned to the center
position.
• −3 dB compensated: A full scale signal (0 dBfs) will have a level of 0 dB when panned
to the center position (or +3 dB when panned to extreme left or right positions).
To set the pan law for a concert
µ In the Attributes tab of the Concert Inspector, choose the pan law value for the concert.
Changing the Tuning for a Concert
By default, concerts use equal tempered tuning. You can change the tuning for a concert
so that it uses a different tuning.
To change the tuning for a concert
1 In the Concert Inspector, select the Tuning tab.
2 Choose the tuning you want the concert to use from the Method pop-up menu.
When you change the tuning of a concert, the tuning of the patches and sets in the
concert changes if their Tuning Method is set to “Use parent tuning.” Patches and sets
with a different tuning method are not affected.
Silencing MIDI Notes
MainStage also includes a Panic function, which works like the Panic function in Logic Pro.
The Panic function immediately silences any hanging MIDI notes.
To silence all MIDI notes
Do one of the following:
µ Press Control-P.
µ Double-click the MIDI Monitor in the toolbar.
µ If the Panic button is visible in the toolbar, click it.
µ If you have mapped the Panic function to a screen control, press or move the
corresponding controller.
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a Panic button. For information about customizing the toolbar, see Customizing the
Toolbar.
Muting Audio Output
Sometimes when you are playing or editing sounds, you may want to quickly mute
(silence) all audio output for the concert. MainStage includes a Master Mute button that
silences the output from every patch in the concert.
To quickly mute all sound
Do one of the following:
µ Press Control-M.
µ In the toolbar, click the Master Mute button.
µ If you have mapped the Master Mute function to a screen control, press or move the
corresponding controller.
The Master Mute button changes to show that the output is muted (a red diagonal line
covers the speaker icon). All output remains muted until you click the Master Mute button
again.
To unmute all sound
Do one of the following:
µ Press Control-M again.
µ In the toolbar, click the Master Mute button again.
µ If you have mapped the Master Mute function to a screen control, press or move the
corresponding controller.
Master Mute is also a mappable parameter in the Parameter Mapping browser. You can
map Master Mute to a button or other controller in your concerts so that you can quickly
mute all output when you are playing live in Perform or Full Screen mode.
In addition, you can mute audio output for a single channel strip by clicking its Mute (M)
button.
94 Chapter 6 Working with ConcertsWorking at the Concert Level
You can control the overall volume for a concert and make other changes at the concert
level. You can use busses at the concert level to control concert-wide effects or to control
the output of multiple channel strips assigned to the bus. You can also add channel strips
at the concert level and have the concert-level channel strips available with every patch
in the concert.
You can map screen controls to busses and to concert-level channel strips only at the
concert level, not at the patch or set level.
To make changes at the concert level
µ In Edit mode, select the concert icon in the Patch List.
Click the concert icon in 
the Patch List to work at 
the concert level.
Controlling the Overall Volume of a Concert
A MainStage concert contains Output and Master channel strips that you can use to
control the overall volume of the concert. The Master channel strip always controls the
output volume of the entire concert. If the concert has multiple Output channel strips,
each Output channel strip controls the volume level for a particular (mono or stereo)
physical output. You can use the Output and Master channel strips to control the overall
volume in the same way you control the overall volume of a Logic Pro project.
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At the concert level, the 
Channel Strips area 
shows the Output and 
Master channel strips, 
auxes, and other 
concert-level channel 
strips.
To control the overall volume level of a concert
µ Drag either the Output 1-2 volume fader or the Master volume fader.
You can map a screen control to a channel strip parameter or an action at the concert
level. For example, you can map the Output 1-2 Volume fader to a fader screen control
and use the hardware control assigned to that screen control to adjust the overall volume
of the concert.
To map a screen control at the concert level
1 Make sure the concert icon is selected in the Patch List.
2 Click the screen control you want to map.
The Parameter Mapping browser appears below the workspace.
3 In the Parameter Mapping browser, click the parameter to which you want to map the
screen control.
96 Chapter 6 Working with ConcertsIn the example above, you would click the fader screen control, click Out 1-2 in the left
column of the Parameter Mapping browser, and then click Volume in the second column
of the browser.
Screen controls can also display visual feedback about parameter values, including volume
level. For example, you can also map the Output 1-2 Volume fader to a level meter screen
control and have the level meter display the overall volume level while you are performing
live. In this case, you would map the level meter to Level in the second column of the
browser, rather than to Volume.
When you map a screen control at the concert level, you cannot map the same screen
control at the patch or set level unless you override the concert-level mapping. For
information about overriding concert-level mappings, see Overriding Concert- and
Set-Level Mappings.
Adding Concert-Wide Effects
You can add concert-wide effects such as reverb and delay using auxiliary (aux) channels.
When you choose a bus from the Send slot on a channel strip, a corresponding aux
appears at the concert level. You can insert effects on the aux and have those effects
apply to every channel strip sending its signal to the aux.
To send a channel strip signal to an aux
1 In the Patch List, select the patch you want to use with a concert-wide effect.
The channel strips for the patch appear in the Channel Strips area.
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Choose a bus from one 
of the Send slots.
3 Drag the Send knob next to the slot to set the amount of the signal sent to the aux.
To add a concert-wide effect to an aux
1 In the Patch List, select the concert icon.
The auxes in the concert appear in the Channel Strips area along with the concert-level
channel strips.
2 On an aux, click one of the Insert slots and choose an effect from the menu.
After you add an effect to an aux, you can edit the effect as you would any channel strip
effect, by double-clicking it to open the plug-in window, and then adjusting parameters
in the plug-in window. You can add multiple effects to an aux, and adjust the level and
pan of the aux using the channel strip controls on the aux.
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Channel Strips is active. For information about showing signal flow channel strips in the
Channel Strips area, see Showing Signal Flow Channel Strips.
Using Auxes to Control Channel Strip Output
You can also send the output of multiple channel strips to an aux (auxiliary channel) and
then use the aux to control the volume level and pan position of the channel strips.
Sending the output to an aux is also useful for adding EQ or compression to a group of
patches.
To send the output of a channel strip to an aux
1 In the Patch List, select the patch you want to control using an aux.
2 In the channel strip, click the Output slot and choose a bus from the menu.
When you send channel strip output to an aux, the volume fader of the channel strip
controls how much of the signal is sent to the aux.
To control the output of channel strips using an aux
1 In the Patch List, click the concert.
The concert is selected. The busses added to the concert appear in the Channel Strips
area along with the concert-level channel strips.
2 Drag the Volume fader on the aux to adjust the volume level of the overall aux output.
3 Drag the Pan knob on the aux to adjust the pan position of the overall aux output.
When you control the output of multiple channel strips using an aux, their relative volume
levels and pan positions are preserved, but the overall volume level and pan position are
modified by the aux Volume fader and Pan knob.
Adding Channel Strips at the Concert Level
You can add a channel strip at the concert level and use the concert-level channel strip
for a software instrument or audio input you want to use in every patch in the concert.
Important: When you add a channel strip at the concert level, it takes precedence over
the channel strips in the patches and sets in the concert. For example, if you add a
concert-level channel strip containing a software instrument, the software instrument
takes precedence over all of the software instruments in all of the patches and sets in the
concert, for the notes in its key range. This means that you will hear only the sound of
the concert-level software instrument and will not be able to play any software instruments
in a patch or set that fall in the same key range.
To add a concert-level channel strip
1 In the Patch List, select the concert.
2 Click the Add Channel Strip (+) button at the top of the Channel Strips area.
3 In the New Channel Strip dialog, select the type of channel strip you want to create.
Chapter 6 Working with Concerts 994 Choose the audio output for the channel strip from the Output pop-up menu.
5 For audio channel strips, choose mono or stereo format from the Format pop-up menu.
Important: Audio channel strips can produce feedback, particularly if you are using a
microphone for audio input. When you add an audio channel strip, the volume of the
channel strip is set to silence, and Feedback Protection is turned on to alert you when
feedback occurs on the channel strip. When you add an external instrument channel
strip, the volume of the channel strip is set to silence, but Feedback Protection is turned
off.
6 Click Create.
7 For software instrument channel strips, you can define the key range for the channel strip
in the Channel Strip Inspector so that the concert-level channel strip does not overlap
software instruments you plan to use in your patches and sets.
For information about defining the key range of a channel strip, see Creating Keyboard
Layers and Splits.
When you add a channel strip at the concert level, you can map screen controls to the
channel strip only at the concert level, not for individual patches or sets.
Using the MainStage Clock
Some plug-ins, including the Playback and Ultrabeat plug-ins included with Logic Studio,
require a time source, and use beat and tempo information in order to play in time.
Additionally, some third-party applications and plug-ins using their own sequencer or
playback engine may behave differently than sequencer-based plug-ins included in
Logic Studio. These plug-ins (which include Reason and other ReWire applications and
Reaktor) require a play message from the host application to begin playback and require
a stop message to end playback. They may also require a continue (also sometimes called
“resume”) message to continue playback from their current time position.
MainStage includes an internal beat clock or “time base” that you can use to control the
playback of these plug-ins. The MainStage clock generates beat, time position, and tempo
information so sequencer-oriented plug-ins can start, stop, and play in time. The MainStage
clock operates similarly to the song position in Logic Pro.
You can send play and stop messages in the following ways:
• Using the Play/Stop button in the toolbar, if it is visible
• Using the Metronome button in the toolbar, if it is visible (turning on the metronome
also starts the MainStage clock, if it is not already running)
• Using a screen control mapped to the Play/Stop, Play, or Stop action
• Using a screen control mapped to the Continue action to resume playback of a
third-party plug-in (but not a Playback plug-in)
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what information they require and what mode they are set to. Some plug-ins may only
make use of the beat information, while others may only make use of tempo information.
For example:
• The Playback plug-in can start immediately (if Snap To is set to Off), at the beginning
of the next bar (if Snap To is set to Bar), or at the next beat (if Snap To is set to Beat).
It can also start when you start the MainStage clock (if “Start with Play Action” is selected
in the Action menu).
• UltraBeat starts when you start the MainStage clock if its sequencer is turned on, except
in Pattern mode.
• Reason and other ReWire applications start when you start the MainStage clock, and
stop when you stop the MainStage clock.
• For plug-ins with synchronizable LFOs, the LFO can oscillate at the tempo set by the
MainStage clock.
You can view the beat information of the MainStage clock using a Parameter Text screen
control mapped to the Beat Count action. When the MainStage clock is running, the
current bar and beat are displayed in the screen control.
Important: When you start the MainStage clock, the audio engine is reset, causing a brief
interruption in the audio output from MainStage. In some cases, you may want to start
the MainStage clock at the beginning of a song or performance and use screen controls
mapped to individual plug-in parameters to start and stop those plug-ins to avoid an
interruption in the audio output while you are performing.
Controlling the Metronome
MainStage features a metronome that you can use to play in time with the concert tempo.
The metronome always plays at the current tempo of the concert.
You can start the metronome in one of several ways.
To start the metronome
Do one of the following:
µ Click the Metronome button in the toolbar, if it is visible.
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µ If you are using a Playback plug-in, click the Metronome button in the Playback window
(or click a button mapped to the Metronome button).
µ Click any of the listed buttons again to stop the metronome.
Note: Starting the metronome also starts the MainStage clock if it is not already running.
By default, the metronome sound is routed to the main outputs (Output 1-2). You can
route the metronome to another output pair, which can be useful in performance when
you want to hear the metronome sound through a separate audio output (for example,
a headphone mix) and not through the main outputs.
To change the audio output for the metronome sound
1 Choose MainStage > Preferences.
2 In the Metronome section of the General tab, choose a different audio output from the
Output pop-up menu.
You can also change the volume of the metronome relative to the overall audio output.
To change the relative output of the metronome sound
1 Choose MainStage > Preferences.
2 In the Metronome section of the General tab, drag the volume slider left or right to adjust
the relative volume of the metronome sound.
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hardware and MainStage in Layout mode.
You can’t change the position of physical faders, knobs, and other controls on your
instruments and other music hardware, but you can arrange the screen controls in your
MainStage concert in any order you like by editing the layout. You can modify an existing
layout or create one from a template, and you can export a layout and import it into
another concert.
Each concert template included with MainStage includes a built-in layout, optimized for
a type of musical instrument you use with MainStage.
You modify the layout of a concert in Layout mode. You can add and arrange screen
controls in the MainStage workspace to match your music hardware, optimize your display
size, and make assignments between controls on your MIDI hardware and the screen
controls in your concert. Below the workspace, the Screen Controls palette contains
different types of screen controls you can add to your layout. The Screen Control Inspector
appears to the left of the workspace, where you can learn controller assignments and
edit layout parameters.
This chapter covers the following:
• Modifying the Layout of a Concert (p. 104)
• Working with Screen Controls (p. 104)
• Assigning Hardware Controls to Screen Controls (p. 114)
• Editing Screen Control Parameters (p. 116)
• How MainStage Passes Through MIDI Messages (p. 121)
• Exporting a Layout (p. 122)
• Importing a Layout (p. 122)
• Changing the Aspect Ratio of a Layout (p. 123)
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7Modifying the Layout of a Concert
You can modify an existing layout by adding and arranging screen controls in the
workspace, changing existing controller assignments or making new ones, and editing
screen control parameters. The following sections describe how to add and arrange
controls onscreen, make hardware assignments, change the appearance of screen controls,
and edit layout parameters. You can also export a layout and import the layout into a
different concert. For information about importing and exporting layouts, see Exporting
a Layout.
To work with the layout of a concert, you switch to Layout mode.
To switch to Layout mode
µ Click the Layout button at the upper-left corner of the MainStage window.
Working with Screen Controls
Screen controls are objects in a MainStage concert that correspond to the physical controls
on your music hardware. Screen controls can also display patch numbers, parameters
values, and other information and update the displayed information in real time.
You can add screen controls to the workspace of your concert, where you can move and
resize them, group them together, and edit their appearance in different ways.
After you have arranged the screen controls for your concert, you make connections
between your MIDI hardware and the concert by assigning physical controls on your
hardware to the screen controls in the workspace. You only need to make hardware
assignments for a concert once, as long as you are using the same music hardware.
After you make controller assignments, you can map screen controls to channel strip
parameters in your patches or to actions. You map parameters in Edit mode. For
information about mapping parameters, see Mapping Screen Controls.
Screen Control Types
There are three types of screen controls you can use in a MainStage layout: panel controls,
shelf controls, and grouped controls. In the Screen Controls palette, located below the
workspace in Layout mode, each type has its own tab; in addition, there is a tab for all
controls. You can add screen controls to the workspace by dragging them from the palette
to the workspace.
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tab for My Grouped Controls appears in the palette. You can add your custom grouped
controls to the palette, so they will be available in every concert.
Panel Controls
Panel controls appear on a two-dimensional plane (or panel) in the workspace. You can
move a panel control to any position in the workspace, except onto the shelf of a shelf
control. Panel controls include:
• MIDI Activity light (displays MIDI note activity, and can be used as a substitute
“keyboard”)
• Round and directional knobs
• Vertical and horizontal faders
• Button
• Drum pad
• Vertical and horizontal level meters (used to visually display volume level or another
parameter)
• VU meter (used to visually display volume level or another parameter)
• Parameter text (used to dynamically display parameter names and values)
• Organ drawbar
• Progress indicator (used with the Playback plug-in)
• Waveform (used with the Playback plug-in)
• Selector (used to select patches while you are performing, or to select markers for use
with the Playback plug-in)
• Text (used to display song lyrics, performance notes, and other static information)
• Background (used to group a series of controls)
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When you add a shelf control, it appears on a three-dimensional shelf. You can move the
shelf, adjust the angle of the shelf, and place multiple shelf controls on the same shelf.
For example, if you have a keyboard screen control in your layout, you can add pitch
bend wheel and modulation wheel screen controls to the same shelf as the keyboard
screen control. Shelf controls include:
• Keyboard
• Modulation or pitch bend wheel
• Sustain pedal
• Foot pedal
• Foot switch
Grouped Controls
Grouped controls consist of individual controls that are grouped together to make them
easier to work with as a single unit. Grouped controls include:
• Selector grouped with increment and decrement buttons
• Keyboard grouped with mod wheel, pitch bend wheel, and sustain pedal
• Sustain and expression pedals
• Organ drawbars
• Guitar amp controls
• Guitar pedal controls
• Arrays of knobs and faders with uniform size and spacing
• Effects and tone control knobs
• Arrays of level meters and VU meters
• Arrays of parameter text displays
• Master output fader grouped with stereo level meter
• Arrays of drum pads
• Transport controls for use with Playback plug-in
• Channel strip controls
My Grouped Controls
The first time you add a custom grouped control to the Screen Controls palette, the
My Grouped Controls tab appears in the palette. You can add custom grouped controls
and name them so they will be accessible from every concert. For information about
adding custom grouped controls to the Screen Controls palette, see Grouping
Screen Controls.
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In Layout mode you can quickly add screen controls to your layout and arrange them in
the workspace.
To add a screen control
µ Drag the screen control from the Screen Controls palette to the workspace.
As you drag the screen control to the workspace, a white outline appears, showing where
it will be added. You can use the alignment guides to align the screen control with other
items in the workspace.
You can drag screen controls into the workspace in any order. If you plan to perform with
a keyboard controller, you might want to first drag a keyboard screen control into the
workspace, position it near the center, and then drag screen controls for the faders, knobs,
wheels, buttons, and other physical controls on the keyboard controller.
When you drag a screen control into the workspace, the control is selected, and the
available hardware assignments and other parameters for the screen control appear in
the Screen Control Inspector to the left of the workspace. Different types of screen controls
have different parameters, which are described in Editing Screen Control Parameters.
Adding Mod/Pitch Wheel Screen Controls
When you add mod/pitch wheels to a layout, by default they are configured to receive
the following MIDI message types:
• The first mod/pitch wheel is configured to receive modulation messages.
• The second mod/pitch wheel is configured to receive pitch bend messages.
• The third mod/pitch wheel is configured to receive aftertouch messages.
By default, modulation and pitch bend screen controls pass through the MIDI messages
for their common use—that is, mod wheels pass through MIDI modulation messages,
and pitch bend wheels pass through MIDI pitch bend messages. In most cases this is
desirable so that you can use them for their standard functions without any additional
setup. If you want to use these screen controls to control other parameters, choose “Do
not pass thru” from the MIDI Thru pop-up menu in the Screen Control Inspector.
Adding Foot Pedal Screen Controls
When you add a foot pedal to a layout, by default the first foot pedal you add is configured
to receive expression messages, and the second foot pedal you add is configured to
receive volume messages.
By default, expression pedal screen controls pass through the MIDI messages for their
common functions (expression or volume). If you want to use an expression pedal screen
control to control another parameter, choose “Don’t pass thru” from the MIDI thru pop-up
menu in the Screen Control Inspector.
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You can copy and paste screen controls using the standard Mac OS X menu items and
key commands.
To paste a copy of a screen control
Do one of the following:
µ Press Command-C to copy the selected screen control, then press Command-V to paste
a copy.
µ Option-drag the screen control to a new location in the workspace.
To add multiple instances of the same screen control in a row or column
1 Option-drag the screen control to create the first copy.
2 Choose Edit > Duplicate to create as many additional copies of the screen control as you
want.
The duplicated screen controls appear offset by the same amount as the first copy.
Option-drag the selected 
screen control.
Duplicate additional 
copies in a row.
Note: You can’t copy a panel control and a shelf control at the same time.
Moving Screen Controls
You can move screen controls to a new position whenever you are in Layout mode. You
can use the alignment guides to help align and position screen controls in an orderly
arrangement. You can move multiple controls together by selecting them (either by
Shift-clicking or “rubber-banding” them) and then dragging them to a new position. If
the panels for the screen controls are merged, rubber-banding selects the entire panel.
To move a screen control
Do one of the following:
µ Drag the screen control to a new position in the workspace.
µ Select the screen control, then press the arrow keys to move it in the workspace.
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Do one of the following:
µ Shift-click the screen controls, then drag them to a new position.
µ Hold down the Shift key as you drag around the controls, then drag them to a new
position.
You can constrain the movement of screen controls to either horizontal or vertical by
pressing Shift while dragging them.
If a screen control overlaps another screen control in the workspace when you switch
from Layout mode to another mode, an alert appears, asking if you want the overlapped
controls to be highlighted so you can adjust them before leaving Layout mode.
Resizing Screen Controls
You can resize screen controls to make them more easily visible or to fit them into a
smaller area. When you select a screen control, blue resize guides appear over it that you
can drag to resize the control.
To resize a screen control
1 Select the screen control in the workspace.
Blue resize guides appear over the screen control.
2 Drag the resize guides to resize the screen control.
Drag the outer resize 
guides to resize the 
screen control.
For screen controls with a text display area, such as a knob or fader, you can resize the
text display area independently from the control or resize them together.
To resize the text display area of a screen control
1 Select the screen control in the workspace.
2 Drag the inner resize guide to increase the area of the text display.
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Drag the inner resize 
guide to resize the 
text area.
Notice that when you resize the text display area, the rest of the screen control becomes
smaller. You can first resize the overall control, and then resize the text display area using
the inner resize guide.
Aligning and Distributing Screen Controls
MainStage includes controls for centering, aligning, and distributing screen controls in
the workspace.
To align screen controls
1 Select the screen controls in the workspace.
2 Do one of the following:
• To align the top edges of the screen controls, click the Align Top button.
• To vertically align the centers of the screen controls, click the Align Vertical Centers
button.
• To align the bottom edges of the screen controls, click the Align Bottom button.
• To align the left edges of the screen controls, click the Align Left button.
• To horizontally align the centers of the screen controls, click the Align Horizontal Centers
button.
• To align the right edges of the screen controls, click the Align Right button.
To distribute screen controls evenly
1 Select the screen controls in the workspace.
2 Do one of the following:
• To vertically distribute the screen controls, click the Distribute Vertically button.
• To horizontally distribute the screen controls, click the Distribute Horizontally button.
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controls and choosing commands from the Align and Distribute submenus in the shortcut
menu. The Distribute shortcut menu contains additional controls for distributing the
space between screen controls.
Adjusting the Shelf for a Shelf Control
When you add a shelf control such as a keyboard to the workspace, it appears at a default
angle, creating a three-dimensional appearance. You can adjust the angle of the shelf
control so that it appears more or less three-dimensional. This can be useful, for example,
if you want to see more of the keys on the keyboard or minimize the amount of space it
occupies onscreen.
To adjust the angle of the shelf for a shelf control
1 In the workspace, select the shelf control.
White alignment guides for the control’s shelf appear.
Alignment guides
2 Drag the lower alignment guide (the one aligned with the front of the shelf control).
Drag the lower alignment guide down to make the angle steeper (as though you are
looking down on the shelf control from above), or drag it up to make the angle less steep
(as though you are looking at it from the front).
Drag the front (lower) 
alignment guide to change 
the angle of the shelf.
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You can also move the shelf vertically to change its position in the workspace. When you
move the shelf vertically, all screen controls on the shelf (for example, a modulation or
pitch bend wheel and a keyboard) move with the shelf.
To move a shelf vertically
1 Select one of the screen controls on the shelf.
The alignment guides for the shelf appear.
Drag the rear (upper) 
guide to move the 
shelf vertically.
2 Place the pointer over the upper alignment guide (the one aligned with the rear of the
shelf control).
The pointer becomes a move pointer (a horizontal bar with up and down arrows).
3 Drag the upper alignment guide to move the shelf to a new position.
Grouping Screen Controls
You can group screen controls together, creating a grouped control. You can move and
resize the grouped control as a single unit. Grouping screen controls has no effect on
how they work in performance, but makes it easier to quickly create a layout. You can
group screen controls using the Group button, using the shortcut menu, or using a
background screen control.
To group screen controls using the Group button
1 Select the screen controls you want to group together.
The Group button is highlighted, indicating that the selected controls can be grouped.
2 Click the Group button, located below the align and distribute buttons on the left edge
of the workspace (or press Command-Shift-G).
The screen controls are grouped into a single, grouped control. If there is no background
around the screen controls, one is added to encompass them. Selecting any member of
the group selects the entire group so you can move and resize them together.
When you group screen controls, the edges of the background appear “dotted” to indicate
that the controls are grouped. When grouped controls are selected, the Ungroup button
is highlighted, indicating that the controls are grouped.
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1 Select the screen controls you want to group together.
2 Control-click the selected controls, then choose Group from the shortcut menu.
To group screen controls using a background screen control
1 Drag a background screen control to the workspace.
2 Size and position the background screen control.
3 Drag the screen controls you want to include in the grouped control so they are within
the borders of the background screen control.
If you want to move one of the grouped controls separately, you can ungroup the controls.
To ungroup screen controls
1 Select the grouped control.
2 Click the Group button again (or press Command-Shift-Option-G).
You can quickly add one or more screen controls to a group.
To add a screen control to a group
µ Drag the screen control into the group.
You can also move and resize individual controls in a group without ungrouping them.
To move or resize a screen control in a group
1 Select the individual screen control you want to move or resize.
The handles of the screen control appear so you can move or resize it independently
from the group.
2 Hold down the Command key as you move or resize the screen control.
You can add a panel or an image to the background of a grouped control to recreate the
look of a hardware panel and visually distinguish the grouped control in the workspace.
To add a panel to a background
1 Select the background.
The Screen Control Inspector appears to the left of the workspace.
2 In the Appearance section of the Screen Control Inspector, click the Panel well, and choose
a panel from the menu.
If an image has been previously selected for the background, select the Panel button
before choosing a texture for the background.
To add an image to a background
1 Select the background.
The Screen Control Inspector appears to the left of the workspace.
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3 Do one of the following:
• Drag an image to the Image well.
• Click the Select button, then navigate to the location containing the image you want
to use, and select the image.
You can add custom grouped controls to the Screen Controls palette, and use them in
the same concert or another concert. Grouped screen controls you add to the palette
appear in the My Grouped Controls tab.
To add a grouped control to the Screen Controls palette
Do one of the following:
µ Control-click the grouped control, then choose Add to Palette from the shortcut menu.
µ Select the grouped control, then choose Add to Palette from the Action menu at the
upper-right corner of the workspace.
After you add the first grouped control to the Screen Controls palette, the
My Grouped Controls tab appears. Select this tab (or the All tab) to see the custom grouped
controls you have added to the Screen Controls palette.
Deleting Screen Controls
If you decide you no longer want a screen control in your layout, you can delete it from
the workspace.
To delete a screen control
1 Select the screen control you want to delete.
2 Choose Edit > Delete (or press the Delete key).
When you delete a screen control, any assignments or mappings for the screen control
are deleted as well.
Assigning Hardware Controls to Screen Controls
To use MainStage with a MIDI controller, you assign hardware controls on the controller
(such as faders, knobs, buttons, drum pads, and pedals) to screen controls in the
workspace. After you assign a hardware control to a screen control, the screen control
receives the MIDI messages from the hardware control. You only need to make controller
assignments once for a concert as long as you use it with the same hardware.
You assign hardware controls to screen controls using the Learn process, which is similar
to the process for learning controller assignments for a control surface in Logic Pro. The
Learn process is described in Learning a Controller Assignment.
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type of MIDI message the control sends when you move it, and the range of values the
control is capable of sending. When you map the screen control to a channel strip
parameter or an action, MainStage converts (or “maps”) the range of values sent by the
hardware control to the optimal range of values usable by the parameter.
For example, many faders, knobs, and other MIDI controls send a range of numeric values
between 0 and 127. You could map a hardware knob with this range of values to control
the frequency parameter of an EQ effect, which has a range of usable values between
20 Hz and 20 kHz. When you map the screen control for the knob to the EQ frequency
parameter, MainStage converts the values sent by the hardware knob to be distributed
between the minimum (20 Hz) and maximum (20 kHz) values for the parameter.
Assigning Knobs
MIDI controllers can have different types of knobs or rotary controllers. Knobs can be
either absolute controllers, which send a fixed value determined by the knob’s position
or can be relative controllers, which increment or decrement the previous value regardless
of their exact position. Knobs can either have a fixed range of movement, or be continuous
(sometimes called endless rotary encoders).
When you assign a knob screen control using the Learn button, MainStage attempts to
determine which type of knob or rotary control on your hardware is sending the MIDI
message and sets the value in the Type pop-up menu in the Screen Control Inspector to
the correct value. For absolute controllers, the correct value is Absolute; for relative
controllers, the correct value can be either Relative (2’s complement) or Relative (Sign
magnitude), depending on the type of relative controller. In most cases, there is no need
to change the default values unless you intend to use the knob for a specific, non-standard
purpose.
When you assign a knob screen control, be sure Absolute is chosen from the Type pop-up
menu if the hardware controller is an absolute rotary controller, or one of the Relative
values is chosen if the hardware controller is a continuous rotary encoder. Moving the
knob through its full range of motion helps ensure that MainStage correctly determines
the type of knob you are assigning.
Assigning Buttons
MIDI controllers can have different types of buttons. Some buttons send a single value
each time you press them, while others alternate between two values when pressed.
Other buttons can send separate values when they are pressed and released (this type
of button is called a momentary or temporary button).
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to determine which type of button on your hardware is sending the MIDI message, and
sets the value in the Type pop-up menu in the Screen Control Inspector to the correct
value for that button type. To enable MainStage to determine the correct value, press
the button exactly three times when you are learning it. Pressing the button three times
helps ensure that MainStage determines if the button is a single value, an alternating
value (binary), or a momentary button. In most cases, there is no need to change the
default values unless you intend to use the button for a specific, non-standard purpose.
You can change the function of a momentary button to match the function of a single
value or alternating value button in MainStage.
To change the function of a momentary button
1 In Layout mode, be sure the button screen control is selected.
2 In the Screen Control Inspector, choose either Single Value or Alternating Value from the
Type pop-up menu.
Choose Single Value if you want the button to function as a single value button, or choose
Alternating Value if you want the button to function as an alternating value button. You
cannot change the function of a single value or alternating value button to match the
function of a momentary button.
Editing Screen Control Parameters
When you select a screen control in Layout mode, the parameters for the screen control
appear in the Screen Control Inspector where you can edit them. Most screen controls
share the same common parameters, but some types have different parameters according
to their function. The parameters for each type are described in the following section.
For most Hardware Input parameters, there is no need to change the default values
MainStage sets when you learn a controller assignment unless you intend to use the
screen control for a specific, non-standard purpose.
To edit screen control parameters
1 In Layout mode, select the screen control. (When you drag a screen control to the
workspace, it is selected.)
2 In the Screen Control Inspector, edit the parameters for the selected screen control by
choosing the menu item, typing text, clicking the button, or selecting the checkbox for
the parameters you want to edit.
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You can “lift,” or copy, certain parameters from a screen control and “stamp” them onto
other screen controls. This makes it easy to give multiple screen controls the same size,
appearance, and text attributes to create a uniform look in your layout. Parameters affected
by lift and stamp include the parameters in the Appearance and Text Labels headings in
the Screen Control Inspector (except the control type), as well as the size of the screen
control.
To lift parameters from a screen control
µ Control-click the screen control in the workspace, then choose Lift Attributes from the
shortcut menu.
To stamp parameters onto another screen control
µ Control-click the screen control in the workspace, then choose Stamp Attributes from
the shortcut menu.
You can Shift-click to select multiple screen controls, then Control-click the selection.
Common Screen Control Parameters
You can edit the following common parameters for button, knob, fader, knob, pedal,
footswitch, mod/pitch wheel, meter, VU meter, organ drawbar, progress indicator, and
parameter text screen controls.
Hardware Input
• Device pop-up menu: Shows the name of the device containing the assigned control.
The device name may correspond to the name of a keyboard controller, or to a port
on the controller, if it has multiple ports. You can choose another device, All, or
Unassigned.
• Channel pop-up menu: Choose the MIDI channel on which MainStage receives input
from the controller.
If you plan to use more than one keyboard when you perform, be sure that screen
controls such as faders and knobs are assigned to receive input from the correct
controller using the Device and Channel pop-up menus.
• Type pop-up menu: Choose the type of control messages to which the control responds.
Control types include the following three categories:
• Continuous Control:  Includes knobs, rotary encoders, faders, and most pedals that
send values in the range of 0-127. In most cases, these controls are set to Absolute.
Some rotary encoders can be set to Relative after you program the hardware device
to send relative controller messages. The different types of Relative control messages
represent different encoding types used by different vendors (who may refer to them
by proprietary names).
• Button Control—Toggle Only:  Includes buttons that send either one (Single) or two
(Alternating) values.
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send a value when the button is released as well as when it is pressed.
• Number pop-up menu: Choose the MIDI control number that the control sends. For
common MIDI controls, such as volume, the control name appears in the menu along
with the number.
• MIDI Thru pop-up menu: Choose whether the control automatically passes MIDI through
or does not pass MIDI through.
• Send Value to pop-up menu: Sends the current value of the screen control to supported
devices to display using an LED ring around a rotary encoder or to move a motorized
fader.
Appearance
• Color selector: Choose the color for the active part of the screen control, which visually
displays its current value in performance. (This parameter is not available for text or
meter screen controls.)
• Control pop-up menu: Choose the type for the screen control. If you change the control
to a different type, you may need to resize it in the workspace.
Text Labels
• Color selector: Choose the color for the text labels.
• Display pop-up menu: Choose what information is displayed in the text display area for
the control and how many lines are used to display it.
• Add hardware label checkbox and field: Select the checkbox, then type a hardware label
in the field to display it on the top line of the control’s text display.
Keyboard Screen Control Parameters
If you are using a keyboard controller or another MIDI device that sends MIDI note
messages, your layout should include a keyboard (or MIDI activity) screen control. You
can edit the following parameters for keyboard screen controls.
Hardware Assignment
• Device pop-up menu: Shows the name of the learned keyboard. The device name may
correspond to the name of the keyboard controller, or to a port on the controller, if it
has multiple ports. You can choose another device or choose All.
• Channel pop-up menu: Shows the MIDI channel on which MainStage receives input
from the keyboard. You can choose another channel or choose All.
• Velocity Sensitivity slider: Sets the velocity sensitivity for the keyboard. Less means that
higher velocities are required to trigger the maximum value, while More means that
lower velocities trigger the maximum value.
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menu in the Channel Strip Inspector, where you can select the device the channel strip
responds to.
• Number of Keys value slider: Enter the number of keys to display on the keyboard screen
control.
• Lowest Key value slider: Enter the note name for the lowest key.
• Lowest Key Learn button: Click the Learn button, then press the lowest key to have
MainStage learn it.
The Number of Keys and Low Key affect only the visual appearance of the screen control.
They do not affect what notes are received from your keyboard controller.
Layer Display
• Display keyboard layers checkbox: When active, a layer is displayed above the keyboard
in the workspace for each software instrument channel strip in a patch. The layers show
the name and color of the channel strip and respond when you play the keyboard.
• Height value slider: Sets the height of the layer display that appears above the keyboard.
MIDI Activity Screen Control Parameters
MIDI activity screen controls can indicate when MIDI note messages are received and can
also be used as smaller, “noteless” keyboard screen controls. You can edit the following
parameters for MIDI activity screen controls.
Hardware Input
• Device pop-up menu: Shows the name of the device to show MIDI activity for. You can
choose another device, All, or Unassigned.
• Channel pop-up menu: Choose the MIDI channel on which MainStage receives input
from the controller.
• Velocity Sensitivity slider: Set the amount of sensitivity for incoming MIDI data.
Settings
• Name field: Type a name for the screen control.
Appearance
• Color selector: Choose the color for the MIDI activity light.
Drum Pad Screen Control Parameters
You can use drum pad screen controls with hardware drum pads. You can edit the
following parameters for drum pad screen controls.
Hardware Input
• Device pop-up menu: Shows the name of the hardware device with the drum pad
control. You can choose another device, All, or Unassigned.
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that triggers the drum pad (set in the Note value slider) is not sent to any keyboard
screen controls in the patch, and so does not produce sound from any software
instrument plug-ins “played” using those keyboard screen controls.
• Channel pop-up menu: Choose the MIDI channel on which MainStage receives input
from the controller.
• Note value slider: Change the MIDI note for the drum pad to a different value than the
learned value.
Appearance
• Color selector: Choose the color for the active part of the screen control, so that you
can easily see when the drum pad is pressed.
Text Labels
• Color selector: Choose the color for the active part of the text label.
• Justification buttons: Click to set the text justification (left, center, or right).
• Display pop-up menu: Choose what information is displayed in the text display area
and how many lines are used to display text.
• Add hardware label checkbox and field: Select the checkbox, then enter hardware label
text in the field to display it on the top line of the control’s text display.
Waveform Screen Control Parameters
You can use waveform screen controls to display the audio waveform of the audio file
for a Playback plug-in. You can edit the Color and Hide Ruler parameters for waveform
screen controls.
• Color selector: Choose the color for the waveform display.
• Hide Ruler checkbox: When selected, the ruler at the top of the waveform display is not
visible.
Selector Parameters
You can use selector screen controls to display and select patches and sets, or to display
and select markers in audio files used by a Playback plug-in. You can edit the following
parameters for selector (patch or marker selector) screen controls.
• View Patches and Sets button: When active, both patches and sets are shown in the
selector.
• Dual Column Display checkbox: When selected, sets are displayed in the left column
and patches are displayed in the right column.
• Patches or markers button: When active, only patches are shown in the selector.
• Items to Display value slider: Set the number of items (lines) visible in the selector.
• Color selector: Choose the color for selected items in the selector.
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the selector.
• Patch Justification buttons: Click to set whether patches are left, center, or right justified
in the selector.
Text Screen Control Parameters
You can edit the following parameters for text screen controls after adding text to the
text field.
• Font button: Select text, then click to show the Font menu from which you can select
the font, style, color, and size.
• Alignment buttons: Select whether the selected text is left, right, or center aligned, or
justified.
• Text field: Enter the text you want to display onscreen.
• Show frame around text checkbox: When selected, a darker frame appears around the
text, showing the borders of the screen control.
Background Screen Control Parameters
You can use backgrounds for grouped controls. You can edit the following parameters
for background screen controls.
• Name field: Enter a name for the grouped control in the Name field.
• Description field: Enter a description for the grouped control in the Description field.
• Panel button and well: Click the Panel button, then choose a panel or texture for the
background from the menu that appears.
• Image button and well: Click the Image button, then drag an image into the well to use
it for the background.
• Select button: Click to open an Open File dialog to browse and select an image.
• Stretch to Fit checkbox: When selected, the image stretches to fill the area of the
background as completely as possible.
How MainStage Passes Through MIDI Messages
Some MIDI messages sent by your keyboard controller (or other MIDI device) are “passed
through” to any channel strips in the MainStage concert that are mapped to the same
controller (or device). Whether or not MIDI messages are passed through depends on
the following conditions:
• If there is no screen control in your layout assigned to receive the message type sent
by the controller, the messages are passed through.
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the screen control is set to Automatic or to the input device, the messages are passed
through. This is the default for screen controls set to receive volume, pan, expression,
sustain, modulation, pitch bend, and aftertouch messages.
• If a screen control for that MIDI message type exists, and the MIDI Thru parameter for
the screen control is set to “Do not pass through,” the data is not passed through. This
is the default for most other screen controls.
The reason for these exceptions is so that when you add a screen control for a modulation
wheel or a sustain pedal, for example, it “automatically” responds to the appropriate MIDI
message type, without your having to configure it further. If you want to have the screen
control respond to a different type of MIDI message, you can choose another MIDI message
type from the Number pop-up menu in the Screen Control Inspector.
Incoming MIDI messages that are passed through are passed to any channel strips mapped
to the same device sending those messages (that is, to the keyboard controller you are
using to “play” those channel strips). If there is no matching device, the MIDI messages
are sent to all channel strips.
You can also filter incoming MIDI messages for individual channel strips. For information
on filtering MIDI messages, see Filtering MIDI Messages.
Exporting a Layout
You can export a layout so that you can save it independently from the concert and
import it into other concerts.
To export a layout
1 Choose File > Export Layout (or press Command-Shift-Control-S).
2 In the Save As dialog, type a name for the layout, and browse to a location where you
want to save the layout (or use the default location).
3 Click Save.
Importing a Layout
You can import an exported layout into another concert, and then adjust it to work with
the mappings in the concert.
To import a layout into a concert
1 Choose File > Import Layout (or press Command-Control-O).
2 In the Open dialog, select the layout you want to import.
3 Click Open.
The layout for the concert changes to the imported layout.
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to convert the assignments and mappings in the layout to work with the concert. It uses
the following rules to convert imported assignments and mappings:
• Screen controls are assigned and mapped to screen controls of the same type if they
exist in the imported layout.
• Keyboard screen controls are assigned only to keyboard screen controls.
• If the arrangement of screen controls in the concert is similar to their arrangement in
the imported layout, screen controls are assigned and mapped to screen controls in
the same positions in the workspace.
• If the arrangement of screen controls in the concert is different, MainStage tries to
assign and map screen controls starting from the top-left corner of the workspace to
the bottom-right corner.
Because of the wide variety of possible layouts, not all assignments and mappings may
be converted as you intended, depending on the differences between the layouts. After
you import a layout into a concert, be sure to try the screen controls in the concert to
see if they work as expected. After importing the layout, you may need to manually
reassign some controls and then manually remap screen controls in your patches for the
concert to work with the new layout. If the imported layout has fewer screen controls
than the old layout, or has different types of screen controls, you will likely have to add
new screen controls after importing and then assign physical controls to the screen
controls to maintain the same level of functionality.
Changing the Aspect Ratio of a Layout
You can change the aspect ratio of a concert layout. Changing the aspect ratio lets you
use the concert with different monitor types:  16:10 (widescreen), 4:3 (standard), and 10:16
(portrait).
To change the aspect ratio of a layout
µ In the Action menu located in the upper-right corner of the workspace, choose Aspect
Ratio, then choose the aspect ratio from the submenu.
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can have a variety of uses, including playing backing tracks to accompany your
performance, playing song stems that you can mix live, and using a “backing band” while
you practice your performance.
You play back audio files using the Playback plug-in, which is available in the Instrument
menu. Using the Playback plug-in, you can start and stop playback of an audio file, cycle
(loop) playback, and fade out the audio. Using markers, you can shift playback to different
parts of the audio file. You can have files play at their original speed or synchronize
playback to the current tempo of the concert. You can also play back several audio files
together using multiple instances of the Playback plug-in and control them using groups.
The Playback plug-in is available only in MainStage. This chapter provides information
on how you can use the Playback plug-in in a MainStage concert. For detailed information
about the interface, parameters, and functions of the Playback plug-in and supported
audio file formats, see The Playback Plug-in.
This chapter covers the following:
• Adding a Playback Plug-in (p. 125)
• Using the Playback Plug-in (p. 130)
Adding a Playback Plug-in
The Playback plug-in is an Instrument plug-in and is available only for software instrument
channel strips. To use the Playback plug-in, you add it to a software instrument channel
strip, then select an audio file to play. You can add a Playback plug-in to a channel strip
in a patch or at the set or concert level.
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8Where you add an instance of the Playback plug-in depends on how you want to use it.
If you want to play back an audio file while you play a single patch, you can add it to the
patch. If you add a Playback plug-in at the set level, you can select different patches in
the set and have the audio file continue playing. This can be useful, for example, if the
set includes all the patches you’ll use in a song, and the Playback plug-in plays an audio
file with a backing track for the song. If you add a Playback plug-in at the concert level,
you can select different patches in the concert and have the audio file continue playing.
The ability to use the plug-in at any level gives you a great deal of creative freedom in
how you use it.
Each instance of the plug-in can play one audio file. You can use audio files in a variety
of file formats including AIFF, WAVE, and CAF. You can play audio files containing marker
information, including files exported (bounced) from Logic Pro and Apple Loops, and
shift playback to markers located at different time positions in the audio file.
There are two ways to add a Playback plug-in:  by dragging an audio file to the Channel
Strips area or from the Instrument slot on a channel strip.
To add a Playback plug-in by dragging an audio file
1 In the Patch List, select the patch to which you want to add a Playback plug-in. You can
also select a set or the concert icon.
2 Drag an audio file from the Finder to the space between channel strips in the Channel
Strips area.
A black line appears between the channel strips, and the pointer becomes an Add File
pointer as a new channel strip is created. The new channel strip contains a Playback
plug-in with the audio file you dragged to the Channel Strips area.
To add a Playback plug-in from the Instrument slot
1 Click the Add Channel Strip button to add a new channel strip to the patch, set, or concert.
2 In the new Channel Strip dialog, select Software Instrument as the type. Leave other
settings at their default values, or change them to suit your setup.
A new software instrument channel strip appears in the Channel Strips area.
3 In the I/O section of the channel strip, click the Instrument slot, choose Playback from
the menu, then choose either Mono or Stereo from the submenu.
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the MainStage window.
You can add an audio file to a Playback plug-in in one of several ways:  by dragging an
audio file, by clicking in the File field, or by using the Action menu in the plug-in window.
Adding an Audio File to the Playback Plug-in
After you add an instance of the Playback plug-in, you select and add the audio file you
want to play using the plug-in.
To add an audio file to the Playback plug-in
Do one of the following:
µ Drag the audio file to the Instrument slot with the Playback plug-in.
µ Drag the audio file to the “tape” area of the plug-in window.
µ Click the File field in the plug-in window, select an audio file in the Open dialog, then
click Open.
µ Choose Open File from the Action menu at the upper right of the Playback plug-in window,
select an audio file in the Open dialog, then click Open.
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appears in the Waveform display.
You can preview an audio file in the Open dialog by selecting the file and clicking Play.
To hear the file after adding it to the Playback plug-in, click the Play button in the plug-in
window.
Setting the Sync Mode for the Playback Plug-in
When you add an audio file to the Playback plug-in, MainStage looks for tempo information
in the file. For audio files containing tempo information (including Apple Loops and files
exported from Logic Pro), the file is scanned for transients (short bursts of audio energy
that usually occur on rhythmic beats). Transient information is stored in the audio file
and used to play the file with the best audio quality, even when the file is played at a
different tempo or pitch. For these audio files, you can use the Sync feature to set whether
the audio file plays at its recorded tempo or uses the current tempo of the concert. When
Sync is set to Off, the audio file plays at its recorded tempo, regardless of the current
tempo of the concert. This can be desirable, for example, when the audio file contains
non-pitched sounds or a sound effect. When Sync is set to On, the audio file plays at the
current tempo (set by the patch, set, or concert, by tapping the tempo, or by listening to
MIDI beat clock). This makes it easy to keep backing tracks, for example, in time with each
other and with your performance. Setting Sync to On can affect audio quality.
You set the Sync mode for an instance of the Playback plug-in from the Sync pop-up
menu, located in the lower-left corner of the plug-in window.
To set the Sync mode for a Playback plug-in
µ To have the audio file play back at its original tempo, choose Off from the Sync pop-up
menu.
µ To have the audio file play back at the current tempo of the concert, choose On from the
Sync pop-up menu.
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Sync pop-up menu is unavailable.
Choosing the Flex Mode for the Playback Plug-in
For audio files containing tempo information, you can choose between different flex
modes for playing back audio. Each flex mode is optimized for playback of a certain type
of audio file, and you can choose which flex mode an instance of the Playback plug-in
uses to play back the audio file you added. The flex modes available are:
• Slicing: Slices the audio material at transient markers and plays each slice at its original
speed. Slicing is a good choice for general use, particularly for rhythmic material.
• Rhythmic: Based on the time-stretching algorithm used for Apple Loops, Rhythmic is
best suited for playing non-monophonic material, such as rhythmic guitars, rhythmic
keyboard parts, and Apple Loops.
• Speed: Time-stretches material by playing the source material faster or slower, including
changing the pitch. Speed is recommended for percussive material.
• Polyphonic: Based on a phase vocoder, Polyphonic time-stretches material, delivering
high sonic quality with suitable polyphonic material. It is recommended for complex
polyphonic material and is good for all kinds of chords—such as guitar, piano, and
choir—and for complex mixes.
Because each flex mode can produce different results depending on the audio material,
it is recommended that you try out different flex modes for each instance of the Playback
plug-in to determine which provides the best playback for your audio files.
To choose the flex mode for a Playback plug-in
µ Choose Flex Mode from the Action menu at the upper right of the plug-in window, then
choose the flex mode from the submenu.
Note: For audio files that do not contain tempo information, the Flex Mode menu item
is unavailable.
Adding Screen Controls for the Playback Plug-in
You can use screen controls to control the parameters of the Playback plug-in, display
parameter values and the name of the audio file, and display the audio waveform of the
audio file. The Screen Controls palette includes a waveform screen control that you can
use with the Playback plug-in to view the waveform of the audio file. If the audio file
contains markers, you can also view the markers in the waveform screen control.
To add a waveform screen control to the workspace
1 Click the Layout button (in the upper-left corner of the MainStage window) to switch to
layout mode.
2 Drag a waveform screen control to the workspace, and position it as needed.
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a waveform screen control.
When you map the waveform screen control to the Playback plug-in, the waveform for
the audio file loaded in the Playback plug-in appears in the waveform screen control.
When you press the button you mapped to the Play/Stop parameter, the audio file starts
playing, and you see the waveform move across the waveform screen control.
You can add screen controls for other parameters, including Fade Out, Cycle, Tempo, and
so on, and map them to the corresponding parameters in the Mapping browser or in the
Playback plug-in window. You can also map a parameter text screen control to the File
field and have it display the name of the audio file being played.
Using the Playback Plug-in
The design of the Playback plug-in allows you to use it in many different ways. You should
plan how you intend to use the Playback plug-in when you are designing your concert
to use it most effectively. You can try out different placements and settings to decide
how you want to use the Playback plug-in in your concerts.
You start playback by sending a Play command to the Playback plug-in using a screen
control, such as a button, mapped to the Play/Stop parameter of the plug-in. To stop
playback, you send a Stop command using the same parameter. Alternatively, you can
set the plug-in to start when you select the patch or set, or when the Play action is
triggered. You can control other parameters of the Playback plug-in while you perform,
including the Fade Out and Cycle parameters. If the audio file contains marker information,
you can use the Go To Previous Marker and Go To Next Marker parameters to shift playback
to different parts of the audio file, or use the Go to Marker action to shift playback to a
specific marker.
Note: When mapping a screen control to the Go to Marker action (in the Markers
submenu), set both the Button On and Button Off parameters in the Screen Control
Inspector to the value of the marker, to ensure that the mapping works correctly.
130 Chapter 8 Playing Back Audio in MainStageA Playback plug-in in a patch plays only while the patch is selected. If you are using a
Playback plug-in at the set level, you can select different patches in the set (for example,
different lead synth or guitar solo patches) and have the audio file continue playing. If
you are using a Playback plug-in at the concert level, you can select different patches in
the concert and have the audio file continue playing.
The Playback plug-in provides an additional form of control using groups. If you use
multiple instances of the plug-in in your concert, you can use groups to control which
instances play together and which are mutually exclusive. When Playback instances are
in the same group, a change to the Play/Stop, Cycle, Fade Out, Return to Start, Go to
Previous Marker, or Go To Next Marker parameters in one instance changes that parameter
for every member of the group. You can use up to 26 groups, each identified by a different
letter. Starting one group stops all other groups, while ungrouped instances of the plug-in
continue playing.
If you are using multiple instances of the Playback plug-in in a group, you can start and
stop their playback together by starting or stopping any member of the group using a
screen control mapped to the Play/Stop parameter. When playback instances are grouped,
playback is “locked” so changes in position affect all members of the group. You can
control other aspects of playback, such as having the group fade out or loop playback,
using screen controls mapped to the corresponding controls in the plug-in window of
any member of the group. Playback instances that are not members of a group are not
affected.
You assign an instance of the Playback plug-in to a group from the Group pop-up menu,
located in the lower-right corner of the plug-in window.
To assign a Playback plug-in to a group
1 If the Playback plug-in window is not open, double-click its name in the Input slot to
open it.
2 Choose the letter of the group you want to assign the instance to from the Group pop-up
menu.
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play! MainStage features two modes, Full Screen mode and Perform mode, optimized for
live performance.
This chapter covers the following:
• Before the Performance Starts (p. 133)
• Using Full Screen Mode and Perform Mode (p. 134)
• Selecting Patches in Performance (p. 135)
• Using Screen Controls in Performance (p. 136)
• Handling Tempo Changes in Performance (p. 137)
• Tips for Performing with Keyboard Controllers (p. 137)
• Tips for Performing with Guitars and Other Instruments (p. 137)
• Using the Tuner (p. 138)
• Using the Playback Plug-in in Performance (p. 139)
• Recording Your Performances (p. 140)
• After the Performance (p. 141)
• Tips for Complex Hardware Setups (p. 141)
Before the Performance Starts
Here are a few things to check before you begin performing:
• Make sure your MIDI controllers, instruments, microphones, and other music equipment
is connected to your computer and is working.
• Test the audio output from MainStage using the audio interface and speakers or
monitors you plan to use in performance.
• Select a patch with a software instrument channel strip and play your keyboard
controller. Watch the Activity Monitor to make sure MainStage is receiving MIDI input
from the controller, and make sure you can hear the audio output.
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9• Make sure any instruments or microphones you plan to play through audio channel
strips are connected to the correct audio inputs on your audio interface. Select a patch
with an audio channel strip and play or sing to make sure you can hear audio output.
• For the best results, close any applications that you do not need while performing,
particularly applications with high processor or RAM requirements.
• If you use Time Machine to back up your computer, turn it off.
• Disconnect the computer running MainStage from any network connections.
Using Full Screen Mode and Perform Mode
When you perform live, you can use either Full Screen mode or Perform mode, depending
on which you prefer. Each mode offers some advantages for different performance
situations.
Working in Full Screen Mode
In Full Screen mode, the MainStage workspace fills the entire screen, and screen controls
appear at the maximum possible size for easy viewing. MainStage receives all keyboard
input (so no other key commands, including Mac OS X key commands, are active). You
can access the Master Mute and Panic functions and the Tuner using their key commands
or if you have mapped screen controls to these functions.
To switch to Full Screen mode
Do one of the following:
µ Choose View > Full Screen (or press Command-4).
µ Click the Full Screen button in the toolbar.
To leave Full Screen mode
Do one of the following:
µ Press the Escape (Esc) key.
µ Click the circled “X” in the upper-left corner of the screen.
µ Use the key command for one of the other modes (Command-1 through Command-3).
Working in Perform Mode
In Perform mode, the workspace fills the MainStage window, but the toolbar is still visible
so that you can access the Master Mute, Panic, Tuner, and other toolbar buttons. You can
resize the MainStage window and can also change the size of the workspace inside the
window using the zoom slider. You can access the Finder and other open applications
by clicking outside the MainStage window.
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Do one of the following:
µ Choose View > Perform (or press Command-3).
µ Click the Perform button in the toolbar.
By default, when you open MainStage, it opens in Edit mode. You can change the default
behavior in the General pane of MainStage preferences so that it opens in Perform or Full
Screen mode. For more information, see Setting MainStage Preferences.
Selecting Patches in Performance
In Full Screen or Perform mode, you can view and select patches using the patch selector
screen control in your layout. Patches and sets appear in the patch selector in the same
order as in the Patch List in Edit mode. Skipped items do not appear in the patch selector
and cannot be selected, but patches in collapsed sets do appear and can be selected.
For information about skipping items, see Skipping Items in the Patch List.
When you select a patch, you can start playing it instantly. If you are sustaining notes
from the previous patch, they will continue to be sustained until you release the notes
or the sustain pedal. If the previous patch contains effects (such as a reverb or delay effect)
with a release “tail,” the effect tail continues sounding for the amount of time set in the
Silence Previous Patch pop-up menu in MainStage preferences. For more information,
see Setting MainStage Preferences.
When performing, keep in mind the difference between patch parameters and parameters
controlled at the concert level. When you select a patch, its parameters are set to the
values at which you last saved the patch. If you have previously played the patch since
you opened the concert, they are set to the values at which you left them when you
played the patch. Parameters at the concert level, however, remain at their current value
when you select new patches. For example, if you select a patch with a channel strip set
to a volume 0 dB, but the Master volume fader at the concert level is set to −96 dB, you
will hear silence, not full volume. Similarly, parameters controlled at the set level remain
at their current value when you select a different patch in the set.
Also keep in mind that when you select a patch, the screen controls for knobs, faders,
and other controls in the workspace show the parameter values for the patch, which may
be different than the positions of the physical controls on your controller. When you
move the physical controls, the screen controls instantly update to show the current
value.
Selecting Patches Using Key Commands
You can select patches in the patch selector using the following key commands:
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Up Arrow The previous patch
Down Arrow The next patch
Left Arrow The first patch in the previous set
Right Arrow The first patch in the next set
Selecting Patches by Typing
You can select a patch in the Patch List by typing the first few letters of its name.
To select a patch by typing its name
µ Type the letter “f”, then begin typing the name of the patch.
Once you type enough letters to uniquely identify the patch name, the patch is selected.
µ To cancel typing, press Enter.
Selecting Patches Using Actions
If you have mapped screen controls to actions for selecting patches, such as selecting
the previous or next patch, you can select the patches using the physical controls assigned
to those screen controls as you perform. You can also select sets or the concert using
actions. Buttons are particularly useful for selecting patches, sets, or the concert using
actions.
When selecting patches using actions, skipped patches are also skipped. For example, if
you use a screen control mapped to select +10 patches, any skipped patches would not
be counted in the +10.
For more information, see Using MainStage Actions.
Selecting Patches Using Program Change Messages
If your MIDI device has buttons or other controls that send program change messages,
you can select patches in your concert by program change number. You can use program
change messages to select patches but not sets.
For information about how your MIDI device sends program change messages, consult
the documentation that came with the device or the manufacturer’s website. For
information about changing the program change number for a patch, see Setting Patch
Program Change Numbers.
Using Screen Controls in Performance
In performance, you use the controls on your MIDI hardware devices that are assigned
to screen controls to manipulate the parameters mapped to those screen controls. When
you select a new patch, the parameters you mapped for that patch are instantly available
for editing.
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Hardware Move parameter in the Screen Control Inspector. If the parameter is set to
Jump, the screen control instantly moves to the position of the hardware control. If the
parameter is set to Pickup, the screen control starts moving when the hardware control
reaches its current position. If the parameter is set to Relative, the screen control moves
in sync with the hardware control, starting from its current position.
Handling Tempo Changes in Performance
When you open the concert you plan to use in your performance, MainStage uses the
tempo for the concert you set in the Concert Inspector. If the “Get tempo from MIDI input”
checkbox is selected, MainStage uses incoming MIDI beat clock to set the tempo. For
information about setting and changing the tempo in a concert, see Using Tempo in a
MainStage Concert.
If you select a patch or set with its own tempo setting, the tempo changes to the new
setting. You can also change the tempo in real time while you perform using the Tap
Tempo feature, either by pressing Control-T repeatedly at the tempo you want to use,
by clicking the Tap Tempo button in the toolbar repeatedly, or using a screen control
mapping to the Tap Tempo action.
Tips for Performing with Keyboard Controllers
If you are using one of the Keyboards templates designed for use with a MIDI-compatible
keyboard controller, you can play your keyboard and use MainStage as a sophisticated
sound module and multi-effects processor. The patches in the template make extensive
use of the software instrument plug-ins included in Logic Studio as well as a wide range
of effects plug-ins.
Tips for Performing with Guitars and Other Instruments
If you are using one of the Guitar Rigs templates designed for use with electric guitar,
you can play your electric guitar and use MainStage as a multi-effects processor. The
patches in the template make extensive use of the Amp Designer amp simulation plug-in
and the Pedalboard effects plug-ins as well as other effects commonly used with guitars.
Guitar patches with Pedalboard-style screen controls can be assigned to a foot switch,
allowing you to bypass different effects in the channel strip. Some patches also allow you
to switch between channel strips with different effects using an expression pedal.
When playing guitars and other low-impedance instruments, be sure they are connected
to an audio input that matches the impedance of the instrument. Connecting a guitar to
a standard line-level audio input may produce a lower volume level for the guitar’s output
than intended.
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an audio interface connected to your computer and choosing the audio input channel
in audio channel strips in your patches.
For guitar patches that use multiple channel strips, you can control the overall volume
of the patch using a foot pedal. Using the following procedure, you can set the overall
volume for the patch (that is, for all channel strips) so it starts playing at the set volume
level but still control subsequent volume changes using the foot pedal.
Using the Tuner
MainStage includes a Tuner that you can use to tune guitars and other instruments you
play through an audio channel strip. The Tuner shows pitch on a circular scale with the
note name and octave displayed in the center of the scale. When you play a single note
on your instrument, the pitch is shown in relation to the correct pitch for the note
displayed.
You can use the Tuner on an instrument connected to the first audio channel strip in a
patch. Channel strips that can use the Tuner are indicated by a tuning fork icon near the
top of the channel strip.
To tune an instrument using the Tuner
1 Select the audio channel strip you want to use the Tuner with.
2 Click the Tuner icon in the toolbar (or press Command-T).
The Tuner appears in the workspace.
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As you play, the Tuner shows the note name of the closest note. If the note is not in tune,
red vertical bars appear, showing whether the note is sharp or flat. The bars appear to
the right of the note name if the note is sharp, and to the left if the note is flat.
4 Adjust the tuning peg for the string you are tuning.
When the note is in tune, a blue vertical bar appears in the center, above the note name.
Be sure to play only a single note at a time while tuning. The Tuner can’t tune to a chord
or interval or if you play different notes rapidly.
When using the Tuner with a patch containing multiple channel strips, only audio from
the first audio channel strip is sent to the Tuner, even if other channel strips in the patch
have the same input source. Before using the Tuner, make sure that the first audio channel
strip is active and not muted.
In the Channel Strips area, the channel strip that will send audio to the Tuner is indicated
by a tuning fork icon at the top of the channel strip.
If other channel strips in the patch have the same audio input source as the first channel
strip, the sound from those channel strips is still audible (unlike the output from the
Tuner). For example, if you are using a twin-amp patch from the Rock guitar concert
template, the output for the second amp is audible while you tune the guitar, unless you
mute its output (by setting the Expression pedal screen control to zero).
Using the Playback Plug-in in Performance
You can use the Playback plug-in to play backing tracks or other audio files while you are
performing, and trigger playback either when you select a patch or set, or using a button
or other screen control. You can control other Playback parameters to which you have
mapped screen controls, including fading out the sound and looping playback. For files
containing marker information, you can also use markers to switch playback to different
sections of the audio file. You can start and stop playback of multiple Playback plug-in
instances using the Group menu.
Where you add an instance of the Playback plug-in depends on how you want to use it.
If you want to play back an audio file while you play a single patch, you can add it to the
patch. If you add a Playback plug-in at the set level, you can select different patches in
the set and have the audio file continue playing. This can be useful, for example, if the
set includes all the patches you’ll use in a song, and the Playback plug-in plays an audio
file with a backing track for the song. If you add a Playback plug-in at the concert level,
you can select different patches in the concert and have the audio file continue playing.
The ability to use the plug-in at any level gives you a great deal of creative freedom in
how you use it.
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are a few ideas for how to use the Playback plug-in in different situations. You can try
them out or use them as a starting point for your own creative uses.
Some Playback Plug-in Usage Ideas
You can use the Playback plug-in in software instrument channel strips in a patch or at
the set or concert level.
• Add a Playback plug-in to a patch and use it to play a backing track while you play an
instrument on another channel strip in the patch.
• Add a Playback plug-in at the set level and use it to play a backing track that continues
while you select and play different patches in the set.
• Add a Playback plug-in at the concert level and use it to play a backing track or sound
effect while you select and play different patches in the concert.
• Add multiple instances of the Playback plug-in at the set or concert level, and use them
to play and remix different backing tracks.
Recording Your Performances
You can record a performance to an audio file. Before you record a performance, you can
choose the file format of the recorded audio file.
If you choose AIFF as the file format for recording, the maximum file size for the recorded
file is 2 gigabytes. If you choose WAVE as the file format, the maximum file size is
4 gigabytes. If you choose CAF as the file format, there is no practical limit to the file size.
You can choose the file format in the Audio pane of MainStage preferences and also set
the location of the recorded file and choose which audio outputs are recorded (if you are
using multiple sets of outputs in your concert). For information about recording
preferences, see Recording.
You can record in Perform or Full Screen mode by mapping a screen control to the Record
action. You can also assign a key command to the Record action and use it to record in
Perform mode but not in Full Screen mode.
To start recording to an audio file
µ Move the screen control mapped to the Record action (or press Option-R).
To stop recording
µ Move the screen control mapped to the Record action (or press Option-R again).
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Before closing your concert after your performance, remember that, for any screen controls
for which the On Patch Change parameter is set to “Reset to saved value,” any changes
to channel strip parameters or plug-in parameters you made while performing revert to
their previously saved state if you close the concert without saving. If you save the concert
before closing, the new values are saved in the concert.
Tips for Complex Hardware Setups
It is highly recommended that you test your concert thoroughly using the same setup
you plan to use in live performance prior to performing, at the performance location or
venue if possible. This is especially important for more complex hardware setups.
Using Multiple Keyboard Controllers in Performance
If you plan to use multiple keyboard controllers when you perform, you can choose
whether screen controls respond to MIDI messages from all controllers or only a specific
controller and whether channel strips receive input from all controllers or only a single
controller.
In Layout mode, screen controls can be set to respond to MIDI input on all MIDI ports
and channels or to only a specific device or channel. To have a screen control respond
to MIDI input from all controllers, choose All from both the Device and Channel pop-up
menus in the Layout Inspector. To have a screen control respond to a specific controller
or to the same channel as the keyboard screen control, choose that controller from the
Device pop-up menu.
In Edit mode, you set the device from which a channel strip receives MIDI input in the
Key Range section of the Channel Strip Inspector. By default, channel strips receive input
from the first controller in the layout. You can set a channel strip to receive input from
another device in the Input pop-up menu.
Using a Different Hardware Setup in Performance
If you use MainStage with a complex hardware setup, for example, with multiple MIDI
controllers or MIDI interfaces or with multiple audio inputs, you will achieve the best
results when you use exactly the same hardware setup you used when you created your
concert.
If you plan to use MainStage with different controllers, interfaces, or other devices than
the ones you used to create your concert, you need to relearn your hardware assignments
using your performance hardware setup. To facilitate working in this situation, you can
create two separate layouts, one for your studio setup and another for your performance
setup, with corresponding screen controls in each layout. Before you perform, import the
performance layout into your concert. The hardware assignments for your performance
setup are imported with the layout, and your mappings are maintained.
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how to open the Command Editor to customize key commands.
This chapter covers the following:
• Using the Command Editor (p. 143)
• MainStage Default Key Commands (p. 143)
Using the Command Editor
MainStage includes a Command Editor that lets you view and customize key commands.
You can assign key commands to functions that do not have a default key command and
change the key command for other functions. You can also create multiple command
sets and switch between them.
You can assign key commands to customize the current command set. You can also
choose a different command set, and import, export, duplicate, and delete command
sets in the Command Editor.
To open the Command Editor
µ Choose MainStage > Commands > Customize.
The Command Editor opens, showing the key commands for the selected command set.
For detailed information about working with the Command Editor, including information
on customizing, exporting, and importing command sets, see “Working with Key
Commands” in the “Basic Operations” chapter of the Logic Pro User Manual.
MainStage Default Key Commands
The following sections show all of the default key commands for MainStage, grouped by
function. These can significantly accelerate your workflow, particularly when creating
large or complex projects.
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10Concerts and Layouts
Includes key commands for creating, opening, and saving concerts and for exporting and
importing layouts.
Default key command Function
Command-N New concert
Command-O Open concert
Command-W Close concert, or close the active plug-in window
Command-S Save concert
Command-Shift-S Save concert as
Command-Control-O Import layout
Command-Shift-Control-S Export layout
Patches and Sets (Edit Mode)
Includes key commands for adding, selecting, exporting, and importing patches and sets.
Default key command Function
Command-Option-N Add a new patch
Command-Option-S Add a new set
Command-I Import patches or sets
Export patch, export set, or export as set
(depending on what is selected)
Command-E
Command-Up Arrow Select the previous patch
Command-Down Arrow Select the next patch
Command-Left Arrow Select the first patch in the previous set
Command-Right Arrow Select the first patch in the next set
Command-Shift-Option-S Create a new set from selected patches
Command-Shift-Option-R Reset program change numbers
Editing
Includes key commands for cutting, copying, pasting, and other common editing functions.
Default key command Function
Command-Z Undo the last command
Command-Shift-Z Redo the last undone command
Command-X Cut
Command-C Copy
Command-V Paste
Command-D Duplicate
144 Chapter 10 Key CommandsDefault key command Function
Command-A Select all
Actions
Includes key commands for some MainStage actions.
Default key command Function
Control-P Panic
Control-T Tap Tempo
Control-M Master Mute
Control-R Toggle Recording
Space bar Toggle Play/Stop
Parameter Mapping (Edit Mode)
Includes commands for learning mappings and locating mappings in the Parameter
Mappings browser.
Default key command Function
Command-L Map the selected parameter (turn on mapping)
Command-F Find in Parameter Mapping browser
Command-G Find again
Channel Strips (Edit Mode)
Includes commands for adding channel strips.
Default key command Function
Command-Option-A Add audio channel strip
Command-Option-I Add software instrument channel strip
Command-Option-F Show/Hide signal flow channel strips
Screen Controls (Layout Mode)
Includes key commands for learning controller assignments and for grouping and
ungrouping screen controls.
Default key command Function
Command-L Learn controller assignment (turn on the Learn process)
Command-Option-G Group screen controls
Command-Shift-Option-G Ungroup screen controls
Select the next screen control, select the Add hardware label
checkbox, and select the Add hardware label text field for entering
text
Command-Option-H
Chapter 10 Key Commands 145Full Screen Mode
Includes key commands for selecting patches and sets, sending MIDI panic,
muting/unmuting audio, and exiting Full Screen mode.
Default key command Function
Up Arrow Select the previous patch
Down Arrow Select the next patch
Left Arrow Select the first patch of the previous set
Right Arrow Select the first patch of the next set
P Send MIDI panic
M Mute/unmute all audio
Esc Exit Full Screen mode
Window and View
Includes key commands for switching modes and for showing Inspectors and other areas
of the interface.
Default key command Function
Command-1 Layout mode
Command-2 Edit mode
Command-3 Perform mode
Command-4 Full Screen mode
Command-5 Show/Hide Inspectors
Command-6 Show/Hide the Channel Strips area
Command-T Show/Hide the Tuner
Command-M Minimize the MainStage window
Command-Comma (,) Open MainStage preferences
V Show/Hide the active plug-in window
Help and Support
Includes the key command to open the MainStage User Manual.
Default key command Function
Command-Question Mark (?) MainStage User Manual
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stems, and other audio files. The Playback plug-in supports uncompressed mono or stereo
audio files in the AIFF, WAV, and CAF formats with a bit depth of 16 or 24 bits. You can
bounce a single stem from a Logic project or a set of stems from individual tracks.
You can use Playback to jump to song sections and repeat them. If you assign multiple
instances to groups, each song section can include multiple stems, which expands the
possibilities for live remixing of your material. These and other features make the Playback
plug-in a flexible, powerful, creative tool, both in the studio and in live performance.
This appendix covers the following:
• Getting to Know the Playback Interface (p. 148)
• Using the Playback Waveform Display (p. 149)
• Using the Playback Transport and Function Buttons (p. 150)
• Using the Playback Information Display (p. 151)
• Using the Playback Sync, Snap To, and Play From Parameters (p. 152)
• Using the Playback Group Functions (p. 153)
• Using the Playback Action Menu and File Field (p. 154)
• Using the Playback Shortcut Menu (p. 155)
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A AppendixGetting to Know the Playback Interface
The Playback interface resembles a hardware tape player. This section will familiarize you
with various areas of the Playback plug-in window.
Waveform display Action menu
Sync, Snap To, Play From,  Information display
and Group pop-up 
menus
Transport buttons
Function buttons
• Waveform display: The waveform display shows the waveform of the currently loaded
audio file, the current playback position, and the ruler. See Using the Playback Waveform
Display.
• Transport and function buttons: The transport and function buttons appear on either
side of the information display in the silver bar below the waveform display. See Using
the Playback Transport and Function Buttons.
• Information display: The information display shows the current playback position and
audio file length, meter, tempo, fade time, and pitch. See Using the Playback Information
Display.
• Sync, Snap To, Play From, and Group pop-up menus: The bar across the bottom of the
Playback window contains controls you use to set playback behavior: the Sync, Snap
To, Play From, and Group pop-up menus. See Using the Playback Sync, Snap To, and
Play From Parameters. The Group pop-up menu sets group membership for each
Playback instance. See Using the Playback Group Functions.
• Action menu and File field: The Action menu (with the gear icon) contains options for
adding an audio file, choosing the flex mode, and other functions. See Using the
Playback Action Menu and File Field. The File field displays the name of the currently
loaded audio file.
• Shortcut menu: You can add, edit, and remove markers using the shortcut menu (not
shown), which you can access by Control-clicking (or right-clicking) the waveform
display. See Using the Playback Shortcut Menu.
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The waveform display shows the waveform of the currently loaded audio file. The vertical
line in the center of the display indicates the current playback position as the waveform
scrolls from right to left. Above the waveform, the time ruler displays time in either hours,
minutes, and seconds (when Sync mode is off) or bars and beats (when Sync is on). If the
audio file contains marker information, the marker names and positions appear below
the time ruler.
File field Action menu
Playhead/playback 
position Time ruler Marker bar
You can drag the waveform horizontally to move to a different position while Playback
is stopped. Playback starts from the new position if the Play From parameter is set to
Current Position.
Note: The Snap To and Play From parameters can affect playback behavior. See Using
the Playback Sync, Snap To, and Play From Parameters.
Markers, if present, are indicated on the marker bar, below the ruler. You can load audio
files that contain markers, or add markers to the loaded audio file using the Add Marker
command in the shortcut menu. For information about adding, renaming, and deleting
markers, see Using the Playback Shortcut Menu.
To move to different markers with the marker bar
Do one of the following:
µ Click a marker in the marker bar to move it to the current playhead position (in the center
of the waveform display). Playback begins from this position if you are in play mode.
µ Click to the left of a marker to move the preceding marker to the centered current position
indicator. Repeated clicks move earlier markers to the current position indicator. Playback
begins from this position if you are in play mode.
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This section covers the buttons used for playback, fade, count-in, click, and marker
navigation operations.
Return to Start button
Play/Stop button Metronome button
Cycle button Fade Out button Count-in button
Previous/Next Marker 
button
• Return to Start button: Moves to the very beginning of the audio material, but does not
start playback. If Playback is in play mode, however, playback will continue from the
start of the audio file.
• Play/Stop button: Starts or stops playback. The position playback starts from is affected
by the Sync, Snap To, and Play From parameters. See Using the Playback Sync, Snap
To, and Play From Parameters.
• Cycle button: Cycles playback between the current marker and the next marker. Audio
is automatically crossfaded at the marker points to minimize clicks. If the file contains
no markers, playback of the entire file is cycled.
• Fade Out button: Gradually lowers the volume level to silence over the number of
seconds specified in the Fade Time parameter. The Fade Out button turns blue until
the fade out has completed and playback stops.
You can stop an active fade out by clicking the Fade Out button a second time. This
gradually restores audio playback to the full volume level over the same amount of
elapsed time as the fade out.
• Count-in button: Enables a one-bar count-in, using the MainStage metronome click.
The count-in always uses the concert tempo and meter, regardless of the Sync mode.
• Metronome button: Turns the MainStage metronome on or off. The metronome always
uses the concert tempo and meter, regardless of the Sync mode.
• Go to Previous Marker button: In play mode, immediately moves to the previous marker
(to the left of the current playhead position) if the audio material contains markers.
Playback continues from this position. If the audio file contains no markers, moves
backward 8 bars (if Sync is on) or 20 seconds (if Sync is off). Playback continues from
the new position.
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file if the current playhead position precedes the first marker. If the file contains no
markers, moves 8 bars (if Sync is on) or 20 seconds (if Sync is off). Press Play to start
playback from this position.
• Go to Next Marker button: In play mode, immediately moves to the next marker (to the
right of the current playhead position) if the audio file contains markers. Playback
continues from this position. If the audio file contains no markers, moves forward 8 bars
(if Sync is on) or 20 seconds (if Sync is off). Playback continues from the new position.
If Playback is stopped, moves to the next marker or to the end of the audio file if the
current playhead position is after the last marker. If the file contains no markers, playback
rewinds by 8 bars (if Sync is on) or 20 seconds (if Sync is off). Press Play to start playback
from the new position.
Using the Playback Information Display
The information display shows information about several key aspects of your audio
material, and lets you edit some of the displayed values.
• Position field: Shows the current position in hours, minutes, and seconds (when Sync
is off), or in bars and beats (when Sync is on).
• Length field: Displays the overall length of the loaded audio file in hours, minutes, and
seconds (when Sync is off), or in bars and beats (when Sync is on).
• Meter field: When Sync is on, lets you define the meter (time signature) of the audio
file. The bar and beat values can be altered independently. Editing the Meter field
changes the ruler display, and may alter the Length field display, but has no impact on
audio playback.
• Tempo field: Displays the MainStage concert tempo in beats per minute when Sync is
on. Playback follows only a single, constant tempo. The Tempo field is disabled when
Sync is off.
Note: Because Playback instances use the concert tempo when Sync is on, you can use
audio files recorded at different tempos, and have them all play back at the same tempo
(the concert tempo).
• Fade Time field: Sets the fade-out time in seconds. Drag vertically to adjust this value.
Click the Fade button to start or stop a fade-out.
Appendix A The Playback Plug-in 151• Pitch fields: Transpose audio playback when Sync is on. Drag vertically in either the
semi or cent field to transpose the audio file in semitones or cents (1/100 of a semitone).
The Pitch fields are disabled when Sync is off.
Using the Playback Sync, Snap To, and Play From Parameters
The Sync, Snap To, and Play From pop-up menus control various aspects of playback and
synchronization of the audio file.
• Sync pop-up menu: Controls whether playback is synchronized with the concert tempo.
When Sync is off, the audio file plays at its recorded tempo. When Sync is on, the file
plays at the current tempo of the concert.
Note: Only audio files that contain tempo information will play back at the MainStage
concert tempo when Sync is active. If the file contains no tempo information, the Sync
parameter is disabled.
• Snap To pop-up menu: Sets the value to which transport functions—including Play,
Return to Start, Previous Marker, and Next Marker—snap. The active transport function
is delayed until the next bar, beat, or marker is reached, depending on the current Snap
To setting. The Snap To setting always reflects the concert tempo and time signature,
regardless of the Sync setting.
• Off: Transport functions occur immediately, without waiting.
• Beat: Transport functions occur at the start of the next beat.
• Bar: Transport functions occur at the start of the next bar.
• Wait for Marker: Transport functions occur when the next marker is reached.
• Play From pop-up menu: Determines the position from which playback starts.
• Current Position: Playback starts from the current playhead position in the audio file.
This can be especially useful when you are setting up Playback instances in Edit
mode.
• Start: Playback starts from the beginning of the audio file.
• Current Marker: Playback starts from the start of the current marker (the marker to
the left of the current position) in the audio file.
• Relative Position: Playback is synced to the MainStage clock, so stopping and starting
playback follows the MainStage clock position. Using Relative Position is similar to
using a mute button.
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If you have multiple instances of the Playback plug-in in a concert, you can use groups
to control which instances play together and which instances operate independently.
Any Playback instance can either be assigned to one of 26 Groups, named A-Z, or not be
a member of any group. The linked operation of multiple instances can be used for
creative playback purposes, such as alternative versions of a song verse or chorus.
Only one group can be active at a time. For example, if two Playback instances are in
Group A, and four Playback instances are in Group B, activation of a transport function in
any Group A member will stop playback of all Group B members, and vice versa. Instances
that are not in any group are not affected.
All Playback instances that belong to a group will switch between states for the following
transport functions when changed in any group member:
• Return to Start
• Play or Stop
• Dragging in the waveform display
• Cycle
• Fade Out (time and action)
• Go to Previous (or Next) Marker
Important: Editing a parameter in one member of a group does not automatically update
the parameter value in other group members. To change the parameter value in all group
members, hold down Shift while you edit the parameter in any group member. This
applies to the Meter, Fade Time, Pitch, Sync, Snap To, and Play From parameters. You
need to set Sync to the same mode for all group members or you will hear playback drift
between grouped instances.
To assign a Playback instance to a group
µ Open the Group pop-up menu at the lower right of the interface and choose a letter.
Note: When a Playback instance is added to an existing group, some button states may
be different from other group members. If you want all group members to behave
identically when a transport button is used in any group member, make sure that the
states of all buttons match those of other group members before you add a Playback
instance to a group.
To remove a Playback instance from all groups
µ Choose the “–” item from the Group pop-up menu.
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The Action menu is found to the top right of the waveform display and contains the
following items:
• Open File: Opens a dialog from which you can preview and choose a file to load into
the Playback plug-in.
• Remove File: Removes the file currently loaded in the Playback plug-in.
• Flex Mode: For audio files containing tempo information, you can choose one of the
following time-stretching modes:
• Slicing is a good choice for general use, particularly for rhythmic material such as
drum parts. It works by dividing the audio material at transient markers. Each slice
is played back at its original speed.
• Rhythmic is best suited for playing polyphonic rhythmic audio material such as rhythm
guitar or keyboard parts.
• Speed is recommended when the concert tempo is the same as (or close to) the
recorded tempo of the audio file. It produces an effect like slowing down or speeding
up a tape recorder, without the artifacts of time stretching.
• Polyphonic is designed for complex polyphonic audio material and is a good choice
for guitar, piano, and choir parts, or for complete mixes.
• Start on Patch Change: Starts playback when you select the patch (or set) containing
the Playback instance.
• Start with Play Action: Starts playback of the Playback plug-in when the MainStage clock
starts. “Start with Play Action” follows the current Play From setting—that is, it waits
until the next event specified in the Play From setting.
The File field, which is located to the left of the Action menu, shows the name of the
currently loaded audio file. You can load an audio file in several ways.
To load an audio file
Do one of the following:
µ Click the File field to show an Open dialog, from which you can choose the file you want
to load.
µ Choose Open File from the Action menu to show an Open dialog, from which you can
choose the file you want to load.
µ Drag an audio file to the File field.
µ Drag an audio file into the waveform display.
µ Drag an audio file to the Instrument slot containing the Playback plug-in.
154 Appendix A The Playback Plug-inµ Drag an audio file between two channel strips. This creates a new channel strip with the
Playback plug-in inserted. The (dragged) audio file is automatically loaded into this new
Playback instance. You can drag multiple files between channel strips to create a new
channel strip for each file.
Note: Using either of the first two methods, you can preview files in the dialog before
adding one to the Playback instance. To preview the selected audio file in the dialog,
click the Play button. Click the Stop button in the dialog to stop playback.
Using the Playback Shortcut Menu
The Playback window includes a shortcut menu that lets you add, name, and remove
markers in the waveform display. You access the shortcut menu by Control-clicking the
waveform display. The shortcut menu contains the following commands.
• Add Marker: Adds a marker at the current position of the pointer, and opens a name
field. Enter the name, then press Return or click outside the name field.
• Remove Marker: Removes the marker to the left of the current position.
• Rename Marker: Opens a name field for the marker nearest to the clicked position.
Enter a new name, then press Return or click outside the name field.
• Remove All Markers: Removes all markers.
Appendix A The Playback Plug-in 155The Loopback plug-in lets you record virtual “tape loops,” play them back repeatedly,
and overdub new recordings while previous ones continue playing. You can use the
Loopback plug-in to create simple loops, recurring motifs, or complex, evolving textures.
Using Loopback as an insert plug-in in an instrument channel strip, you can create looped
performances with a single instrument, your voice, or other audio material. By inserting
Loopback in an aux channel strip and using it as a send effect, you can create loops with
multiple instruments, vocal performances, and other audio material routed from other
channel strips. Relative levels can be controlled with the Send knobs of the source channel
strips.
Loopback lets you create “sound-on-sound” backing tracks or grooves in your MainStage
performance. You can use multiple instances as a rhythm section, and switch between a
reduced and a full version of your rhythm parts, for example. The Loopback plug-in is a
flexible, powerful, creative tool both for the studio and for live performance. You can also
export loop performances as standard audio files to use in other plug-ins, including the
Playback plug-in.
This appendix covers the following:
• Getting to Know the Loopback Interface (p. 158)
• Using the Loopback Waveform Display (p. 159)
• Using the Loopback Transport and Function Controls (p. 159)
• Using the Loopback Information Display (p. 160)
• Using the Loopback Sync, Snap To, and Play From Parameters (p. 161)
• Using the Loopback Group Functions (p. 162)
• Using the Loopback Action Menu (p. 163)
• Adding Loopback to a Channel Strip (p. 164)
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B AppendixGetting to Know the Loopback Interface
The Loopback interface resembles a hardware tape-loop device. This section will familiarize
you with various areas of the Loopback interface.
Waveform display Action menu
Sync, Snap To, and  Information display
Play From pop-up menus
Transport buttons
Function buttons
• Waveform display: The waveform display shows the waveform of the recorded audio
material, the playhead position, and the ruler. See Using the Loopback Waveform
Display.
• Transport and Function controls: The transport and function buttons are located to the
left and right of the information display in the silver bar that spans the plug-in window.
See Using the Loopback Transport and Function Controls.
• Information display: The information display provides details on the current playback
position and recording length, meter, tempo, and fade time. See Using the Loopback
Information Display.
• Sync, Snap To, Play From, and Group pop-up menus: The black bar across the bottom
contains the Sync, Snap To, and Play From pop-up menus. These are used to set playback
and recording behavior. See Using the Loopback Sync, Snap To, and Play From
Parameters. The Group pop-up menu sets group membership for each Playback instance.
See Using the Loopback Group Functions.
• Action menu: The Action menu is accessed by clicking the button with the gear icon
at the top right of the interface. It provides import and export, monitoring, and other
commands. See Using the Loopback Action Menu.
158 Appendix B The Loopback Plug-inUsing the Loopback Waveform Display
The waveform display shows the waveform of the recorded audio material. The waveform
display updates in real time as you record new material. The vertical line in the center of
the display is the playhead, which shows the current playback or recording position as
the waveform scrolls from right to left. The ruler appears above the waveform, showing
bars and beats (musical time).
Using the Loopback Transport and Function Controls
This section covers the controls for recording, playback, fade, count-in, metronome, and
undo operations.
Record button
Play/Stop button
Reverse button
Fade Out button
Count-in button
Metronome button
Undo button
• Record button: Starts or stops recording. Click the Record button once to start recording
to the tape loop—a virtual tape loop, not an actual one. Click a second time to set the
length and start overdubbing. During overdubbing, the first recorded take plays back
while you record subsequent takes. Subsequent clicks toggle recording off or on, while
the tape loop keeps playing.
• Play/Stop button: Starts playback at the position set by the Play From and Snap To
parameters. If Loopback is playing or recording, stops immediately (without waiting
to reach the Snap To value). If loopback is recording and has not established length it
sets the length and just continues to play back with no overdubbing. See Using the
Loopback Sync, Snap To, and Play From Parameters.
Appendix B The Loopback Plug-in 159• Reverse button: Reverses the contents of the tape loop, so the sound plays back in
reverse. You can activate Reverse when Loopback is either playing or stopped.
• Fade Out button: Gradually lowers the volume level of the tape loop over the time
specified in the Fade Time field. The Fade Out button remains highlighted until the
fade-out has finished and playback stops.
The fade-out affects only previously recorded material. You can start recording during
a fade-out, and the new material is recorded and plays at full level. When you record
new material during a fade-out, Loopback does not stop when the fade-out has finished,
but continues playing the newly recorded material.
If the tape loop length has been set, pressing the Fade Out button (or activating a
screen control mapped to it) while Loopback is playing clears the buffer, but does not
reset the loop length. Pressing the Fade Out button while Loopback is stopped clears
the buffer. If the loop length was undefined when Loopback started playing, it also
resets the loop length.
• Count-in button: Enables a one-bar count-in, using the concert time signature.
• Metronome button: Turns the MainStage metronome on or off.
• Undo button: When pressed during playback or when stopped, removes the most
recently recorded take from the tape loop. Pressing Undo during the first beat of a new
take removes the previously recorded take.
Using the Loopback Information Display
The information display shows information about several key aspects of the audio material
in the tape loop, and lets you edit some of the displayed values.
• Position field: Indicates the current playhead position.
• Length field: Displays the length of the loop.
If Sync is set to Off, Loopback analyzes the first take and determines the tempo and
length, using the concert tempo as a starting point. After the length is set, it cannot
be changed (until you clear the tape loop).
If Sync is set to On, you can set the length (in the information display, or using a screen
control) before you record the first take. If you do not set the length, Loopback analyzes
the first take and sets the length using the concert tempo, rounding up to the next
whole bar.
160 Appendix B The Loopback Plug-in• Position dial: Displays the current playback position in the context of the overall loop
length.
• Meter field: Displays the meter (time signature) of the audio material. The bar and beat
values can be altered independently, which changes the ruler display and may alter
the Length field display, but does not affect audio playback. Cannot be changed once
the length is set without first clearing the tape loop.
• Tempo field: Displays the tempo in beats per minute. The tempo is “locked” after the
first recording and cannot be changed.
• Fade Time field: Indicates the fade-out time in seconds. Drag vertically to adjust this
value. See Using the Loopback Transport and Function Controls.
Using the Loopback Sync, Snap To, and Play From Parameters
The Sync, Snap To, and Play From pop-up menus in the bar at the bottom of the interface
control various aspects of playback and synchronization of the audio material.
• Sync pop-up menu: Enables or disables synchronization with the MainStage tempo and
clock.
• Snap To pop-up menu: Determines how Loopback starts, in play or record mode, when
stopped. It also quantizes the tape loop length “on the fly” by stopping the first take.
• Off: Loopback starts immediately, without waiting.
• Beat: Loopback starts or stops at the start of the next beat.
• Bar: Loopback starts or stops at the start of the next bar.
• Loop: Loopback waits for the amount of time defined by the Length parameter.
• Play From pop-up menu: Determines the playback start position within the audio
material.
• Loop Start: Playback starts from the beginning of the audio material.
• Relative Position: When you stop and restart the Loopback instance, playback
continues as if the plug-in had been playing continuously, without interruption. This
is useful when several Loopback instances are playing together, or when you are
using Loopback instances with Playback or Ultrabeat instances, allowing you to
effectively “mute” and “unmute” instances while keeping them in sync with each
other.
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If you have multiple instances of the Loopback plug-in in a concert, you can use groups
to control which instances record and play together and which instances operate
independently. Any Loopback instance can either be assigned to one of 26 Groups, named
A-Z, or not be a member of any group. The linked operation of multiple instances can be
used for creative purposes, such as alternative versions of a song verse or chorus.
Loopback and Playback instances share the same group functions. If you have instances
of Playback that you have assigned to a group, they will respond to any group functions
(except Record) as any Loopback instances assigned to the same group.
Only one group can be active at a time. For example, if two Loopback instances are in
Group A, and four Loopback instances are in Group B, activation of a transport function
in any Group A member will stop all Group B members, and vice versa. Instances that are
not in any group are not affected. Similarly, any Playback instance in Group A will also
respond, while Playback instances in Group B (or any other group) will stop.
All Loopback instances that belong to a group will switch between states for the following
transport functions when changed in any group member:
• Record
• Play or Stop
• Return to Start
• Dragging in the waveform display
• Fade Out (time and action)
• Count In
• Metronome
• Undo
• Reverse
Important: Editing a parameter in one member of a group does not automatically update
the parameter value in other group members. To change the parameter value in all group
members, hold down Shift while you edit the parameter in any group member. You need
to set Sync to the same mode for all group members or you will hear playback drift
between grouped instances.
To assign a Loopback instance to a group
µ Open the Group pop-up menu at the lower right of the interface and choose a letter.
162 Appendix B The Loopback Plug-inNote: When a Loopback instance is added to an existing group, some button states may
be different from other group members. If you want all group members to behave
identically when a transport button is used in any group member, make sure that the
states of all buttons match those of other group members before you add a Loopback
instance to a group.
To remove a Loopback instance from all groups
µ Choose the “–” item from the Group pop-up menu.
Using the Loopback Action Menu
The Action menu is found to the top right of the waveform display and contains the
following items:
• Export Tape Loop: Shows an export dialog, where you can name and choose a location
to save the tape loop to an AIFF audio file.
• Import Tape Loop: Shows an import dialog, where you can select and import a previously
exported tape loop or any short audio file.
• Clear Tape Loop: Deletes the entire tape loop in the Loopback plug-in.
• Monitor: You can choose one of the following monitoring modes for the Loopback
plug-in: On (monitoring is always on); During Record (monitoring is on only during
recording); or Off (monitoring is disabled).
Note: Some mixer routing configurations may result in no audio being heard through
Loopback. Use this menu command if you encounter this situation.
• When Patch or Set is Selected: You can choose one of the following functions to be
performed when the patch (or set) containing the Loopback plug-in is selected: Do
Nothing (the default); Clear (empties the entire tape loop); Start Playing (starts the
plug-in playing at its current settings); Start Recording (starts recording the first take
at the current plug-in settings); or Clear and Start Recording (clears the existing tape
loop and starts recording the first take at the current plug-in settings).
• On MainStage Clock Start: You can choose one of the following functions to be
performed when the MainStage clock starts: Do Nothing (the default); Clear (empties
the entire tape loop); Start Playing (starts the plug-in playing at its current settings);
Start Recording (starts recording the tape loop at the current plug-in settings); or Clear
and Start Recording (clears the existing tape loop and starts recording a new tape loop
at the current plug-in settings).
• Set Concert Tempo After First Take: With this item selected, and Sync set to Off, clicking
Record tarts recording the tape loop but does not start the MainStage clock (if it is
stopped). When you click Record a second time (or click Play), recording stops and the
tape loop continues playing. MainStage sets the Length and Tempo based on the
duration of the recorded take, and starts the MainStage clock.
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The Loopback plug-in is an insert plug-in. You can use it in any type of channel strip.
To add a Loopback instance to a channel strip
1 Click one of the Insert slots in the channel strip you want to use Loopback on.
2 Choose Delay from the shortcut menu that appears, choose Loopback from the submenu,
then choose Stereo from the second submenu.
164 Appendix B The Loopback Plug-inYou can set a variety of preferences in the MainStage preferences window. The preferences
window includes tabs for general, audio, MIDI, and display preferences, which are described
below.
This appendix covers the following:
• General Preferences (p. 165)
• Audio Preferences (p. 166)
• MIDI Preferences (p. 168)
• Display Preferences (p. 168)
General Preferences
These preferences let you set the tuning of software instruments, set the volume and
output for the metronome, choose what happens when you open MainStage, reset alerts,
and set whether screen controls highlight when their parameter values change.
Tuning
• Tuning slider: Sets the tuning for all software instruments in MainStage. Tuning is
centered around A440 Hz, in the range of 100 cents.
Metronome
• Output pop-up menu: Choose the audio output (or output pair) that the metronome
sound is routed to.
• Volume slider: Drag the slider to set the relative volume for the metronome sound.
Startup
• Startup Action pop-up menu: Choose the startup action when you open MainStage. The
choices are:
• Do Nothing: Does nothing. You can access the Choose Template dialog by choosing
File > New.
• Create New Concert from Template: Opens the Choose Template dialog.
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C Appendix• Open Most Recent Concert: Opens the last open concert in the same mode it was in
when you closed it.
• Open Most Recent Concert in Perform Mode: Opens the last open concert in Perform
mode.
• Open Most Recent Concert in Full Screen Mode: Opens the last open concert in Full
Screen mode.
Alerts
• Reset Warnings button: Click to reset the behavior of alerts for which you have selected
the “Do not show again” checkbox, so that they appear in the future when appropriate
conditions occur.
Parameter Values
• On Patch Change pop-up menu: Choose whether parameter values change or remain
the same when you change patches. By default, the On Patch Change parameter for
individual screen controls is set to Preference, in which case they follow the preference
behavior. If this parameter is set to another value for a screen control, the control follows
the value of its individual setting. The choices are:
• To preserve changes to parameter values when you change patches, choose “Keep
current value.”
• To return values to the last saved value, choose “Reset to saved value.”
• Respond to Hardware Move pop-up menu: Choose how screen controls respond when
you move the hardware controls assigned to them. By default, the Respond to Hardware
Move parameter for individual screen controls is set to Preference, in which case they
follow the preference behavior. If this parameter is set to another value for a screen
control, the control follows the value of its individual setting. The choices are:
• To have screen controls instantly change to match the hardware value, choose “Jump.”
• To have screen controls change when the hardware control matches its current value,
choose “Pickup.”
• To have screen controls move relative to the hardware control, choose “Relative.”
Audio Preferences
These preferences let you set the audio output and input drivers, set the size of the
I/O buffer, set the audio sample rate, and choose which note is displayed as middle C.
Audio
• Audio Output pop-up menu: Choose the device you want to use to hear the audio output
from MainStage.
166 Appendix C Setting MainStage Preferences• Audio Input pop-up menu: Choose the device you want to use as the source for audio
input.
• Setup buttons: Click the Audio Output Setup button to open the Audio/MIDI Setup
window and configure audio output. Click the Audio Input Setup button to open the
Audio/MIDI Setup window and configure audio input.
• I/O Buffer Size pop-up menu: Choose the size of the buffer for audio input and output
in samples. Smaller buffer sizes reduce the amount of latency, but also require more
work from the CPU and may result in playback artifacts. You may want to try different
settings to find the lowest setting that does not produce any artifacts.
• I/O Safety Buffer checkbox: When selected, MainStage uses an additional buffer to process
audio output streams, providing a safeguard against crackling noises that may occur
when using very low I/O Buffer Size settings. If turning on this preference doesn’t
improve things on your system, disable the checkbox and select a larger I/O buffer size
setting.
Note: Use of the I/O Safety Buffer preference increases the output latency and therefore
the round trip (input plus output) latency.
The latency for the current buffer size is displayed below the I/O Safety Buffer checkbox.
• Sample Rate pop-up menu: Choose the sample rate for audio input. If you are using an
audio interface or other audio device with MainStage, the Sample Rate value should
be set to the sample rate of your audio device.
• Apply Changes button: Click to apply changes to the input, output, sample rate, and
buffer size settings. If you do not click the Apply Changes button, changes are applied
when you close the Preferences window.
• Silence Previous Patch: Choose the amount of time sustained notes and effects tails
continue to sound before falling to silence when you select a new patch.
• Hot-Plug Behavior pop-up menu: Choose what action MainStage takes when you hot-plug
an audio device while MainStage is open. The choices are:
• Alert me: Displays an alert when a device is hot-plugged. The alert includes buttons
allowing you to use or ignore the device.
• Automatically Use Device: Switches the audio drivers to allow immediate use of the
hot-plugged device for audio input and output.
• Do Nothing: Does not switch the audio drivers.
• Display audio engine overload message: When selected, an alert appears when the audio
engine overloads.
Recording
• Output pop-up menu: Choose the audio output to record.
Appendix C Setting MainStage Preferences 167• Recordings Folder field and Set button: Click the Set button, then browse to choose the
location where recordings are saved. The file path of the chosen location appears in
the field.
• File Format pop-up menu: Choose the file format for audio recordings. The choices are:
• AIFF
• CAF
• WAVE
MIDI Preferences
These preferences let you view the current status of MIDI inputs, set the instrument voice
limiting threshold, and choose which note appears as middle C.
MIDI
• MIDI Status field and Setup button: Displays the number of detected MIDI inputs.
Instrument Voice Limiting
• CPU Usage Threshold: Set the level (percentage of CPU usage) above which voice limiting
is active. If you experience audio dropouts or glitches when performing with the current
setting, try lowering the threshold until the dropouts or glitches no longer occur.
MIDI
• Display Middle C As pop-up menu: Choose whether middle C is displayed as C3 or C4.
Display Preferences
This preference let you choose the default size at which plug-in windows are displayed.
• Default size pop-up menu: Choose whether plug-in windows are displayed at their
standard size (100%) or at a larger size.
168 Appendix C Setting MainStage PreferencesIn addition to mapping screen controls to channel strip and plug-in parameters, you can
map them to MainStage actions. Actions let you select patches and sets, silence MIDI
notes, control the Tuner and the metronome, tap a new tempo, display information about
patches, MIDI messages and other information, and perform other functions using screen
controls.
The Actions folder, which appears in the Parameter Mapping browser along with available
parameters, contains actions for a variety of MainStage functions. The Actions folder also
contains an AppleScript subfolder with useful scripts. The following table describes each
action and the type of screen control to map it to.
For information about mapping screen controls to actions, see Mapping Screen Controls
to Actions.
This appendix covers the following:
• Table of Actions (p. 169)
Table of Actions
For each action in the Actions folder, the Description column describes the function of
the action, and the Usage column tells which screen controls it is intended to be used
with.
Action Description Usage
Selects the patch 10 patches Button screen control
above the current patch in the
Patch List.
−10 Patches
Selects the patch above the Button screen control
current patch in the Patch List.
Prev Patch
Parameter Text screen control
(to display); Knob screen control
(to select)
Displays the name of the current
patch and can also be used to
change patches.
Current Patch
Parameter Text screen control
(to display); Knob screen control
(to select)
Displays the patch number of
the selected patch and can also
be used to change patches.
Current Patch Number
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Parameter Text screen control
(to display); Button screen
control (to change)
Displays the program change
number of the selected patch
and can be used to change to a
specific program.
Current Program Number
Selects the patch below the Button screen control
current patch in the Patch List.
Next Patch
Selects the patch 10 patches Button screen control
below the current patch in the
Patch List.
+10 Patches
Selects the set above the current Button screen control
patch in the Patch List.
Prev Set
Displays the name of the current Parameter Text screen control
set.
Current Set
Selects the set below the current Button screen control
patch in the Patch List.
Next Set
Displays the name of the Parameter Text screen control
concert.
Concert
Tuner Shows or hides the Tuner. Button screen control
Adjusts the overall tuning for the Knob or fader screen control
concert, from −100 cents to
+100 cents.
Master Tuning
Mutes or unmutes all audio Button screen control
(toggle).
Master Mute
Tap Tempo Use to tap a new tempo. Button screen control
Turns the metronome on or off Button screen control
and starts the “transport”
(toggle).
Metronome
Displays incoming MIDI beat Parameter Text screen control
clock messages.
MIDI Beat Clock
Displays the current bar and Button screen control
beat count from the “transport”
if it is running.
Beat Count
Displays incoming MIDI Button screen control
messages, the same as the MIDI
Activity display in the toolbar.
MIDI Display
Silences all MIDI notes and resets Button screen control
the audio engine.
Panic
Displays the current CPU usage, Parameter Text screen control
the same as the CPU Activity
display in the toolbar.
CPU Load
Turns audio recording on or off Button screen control
(toggle).
Record
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Starts or stops playback at the Button screen control
current transport position.
Play/Stop
Starts playback at the beginning Button screen control
of the song or file (bar 1, beat 1).
Play
Pauses playback at the current Button screen control
transport position.
Stop
Resumes playback at the current Button screen control
transport position.
Continue
Toggles the selected patch Button screen control
between its edited and last
saved state (toggle).
Reset/Compare Patch
Displays the current time in Parameter Text screen control
hours, minutes, and seconds.
Current Time
In addition to the actions in the Actions folder, there are two actions in the Send to All >
Destinations > Actions folder.
Action Description Usage
Transposes the software Button screen control
instrument played by the
keyboard up one octave.
Transpose Octave Up
Transposes the software Button screen control
instrument played by the
keyboard down one octave.
Transpose Octave Down
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2 Your iMac at a glance
4 Mac OS X basics
8 What you can do with your iMac
10 Listen to music on your computer or on the go
12 Create and edit your own movies
14 Search the Internet
16 Get more out of the Internet
18 Send and receive email
20 Organize, plan, and create
22 Keep your iMac’s software up-to-date
24 Learn more and solve problems
30 Install memory and an AirPort Card
32 Work more comfortably
34 Safety, cleaning, and power management
Once you’ve set up your iMac and followed the onscreen guide to connect to the
Internet, what’s next? Read on to find out how to get the most out of your iMac:2
Your iMac at a glance
Your computer has these built-in features:
Headphones port
CD-ROM or 
CD-RW drive
Install software, use
applications, and listen to
music CDs. If you have
the CD-RW drive, you
can create your 
own CDs. (For use only
with standard size,
circular discs.) 
USB port
Connect a USB device,
such as a joystick or
graphics tablet.
Apple Pro Mouse 
An optical mouse you
can use on almost 
any surface.
Media Eject key
Eject a CD.
Volume controls
® Power button
Turn your computer on 
or put it to sleep.
Two internal 
stereo speakers
Microphone3
FireWire
Transfer video from 
a DV camera. Connect
external hard disk drives,
printers, and scanners.
Modem
Connect to the Internet,
browse the World Wide
Web, and send email. 
Ethernet
Share files with another
computer and access 
a computer network, 
printer, or the Internet.
USB
Connect printers, Zip 
and other disk drives, 
digital cameras,
joysticks, and more.
VGA output
Connect an external
monitor or television for
video mirroring. 
Reset button
Use during
troubleshooting to restart
your computer.
Sound input
Record sounds using 
an analog microphone 
or other audio device.
To learn more about your iMac’s features:
m Choose Mac Help from the Help menu, then click 
Go under “Discover my iMac.”
Access door
Install additional memory
and an AirPort Card for
wireless networking.
Sound output  
Connect headphones,
external speakers, and
analog audio devices.4
Mac OS X basics
The Macintosh desktop is your starting place.
Finder icon
Click to open a 
Finder window so 
you can see the files
and applications on
your computer.
Window buttons
Click the red button to
close the window, the
yellow one to minimize it
into the Dock, and the
green one to resize it.
Apple menu
Use to change 
system settings, open
recent items, and restart
or shut down your
computer. To see the
menu, click the apple
() in the menu bar.
View buttons
Click to see your 
files as icons, in lists, 
or in columns.
Toolbar button
Click to show or hide 
the toolbar.
Toolbar icons
Click to navigate quickly
to different folders. 
Your home folder
contains your personal
documents.
Trash
Drag an item here to
delete it. Items remain
here until you choose
Empty Trash from the
Finder menu.
To learn more about Mac OS X:
m See the Welcome to Mac OS X document in the
Documents folder on your hard disk.
Modem status
Use this menu to connect
to and disconnect from
the Internet using 
a dialup modem.5
Dock
Click icons in the Dock 
to open applications,
documents, folders, 
or minimized windows.
Application menu
Shows the name of the
application you’re using. 
Use to set preferences 
or quit applications (other
than the Finder).
Document
Documents are files that
you create with an
application (such as a
letter you create with your
word processor). Doubleclick the icon to open the
file in the application used
to create it.
Folder
Folders help organize 
your files and
applications. Doubleclick a folder to 
see what’s inside.
Disc
This appears when a CD
is in the disc drive.
Double-click the icon to
see what’s on the disc.
To eject a disc, press and
hold the Media Eject ( )
key on the keyboard.
Application
Applications are software
programs (such as a
game or word processor)
that you use with your
computer. Double-click
an application’s icon to
open the application.6
Change the Mac OS to suit your preferences.
There are lots of ways to customize Mac OS X.
To change the size of 
the Dock or move it to 
a different place, open
System Preferences 
and click Dock.
To change Finder
settings, choose
Preferences from the
Finder menu.
To change icon sizes 
or the background of a
Finder window, choose
Show View Options from
the View menu.
Choose System
Preferences from 
the Apple menu to 
change most of your
computer’s settings.
To select a desktop
background picture, open
System Preferences and 
click Desktop.7
Click the icons in the Dock or toolbar to find and open files and applications.
The triangle indicates the 
application is open. Drag this bar up or down to
resize the Dock.
.Drag applications,
files, and folders
into the Dock for
one-click access.
This side of the Dock
shows application icons.
To set up the toolbar the
way you want it, choose
Customize Toolbar from
the Finder’s View menu,
then drag items to 
the toolbar.
Press a folder icon to 
see its contents and open
items in it.
This side of the Dock
shows files, windows,
and folders.8
Make your own CDs. Use iTunes to transfer music from your CD collection. If your iMac has
a CD-RW drive, burn your own music CDs. Transfer music to an iPod or other MP3 player to listen
on the go. Make a movie. Shoot video on a DV camcorder and import it into iMovie . Then
rearrange, edit, polish, and add titles and soundtracks. Connect to the Internet to send email and
browse the Web, or use iTools to post digital photos on the Web for everyone to see. 
Browse through the next few pages to find out more.
What you can do with your iMac
Not sure how to get the most out of your new iMac? Read on for a few ideas.9
Send digital photos to
friends and family.
Connect to the Internet
wirelessly.
Listen to music and burn
your own CDs.
Send email and surf 
the 'Net.
Import and edit
home movies.
The iMac is your
digital hub.
Put up to 1,000 songs in
your pocket.10
Listen to music on your computer or on the go.
Use iTunes to create a library of music and make your own CDs.
Library
Your collection of 
songs, imported from
your own audio CDs or
downloaded from the
Internet. Easily browse 
or search for music.
Radio Tuner
Choose from hundreds
of Internet radio
stations – jazz, rock,
talk, and more.
Audio CDs
Play an audio CD on your
computer. Import songs
to your Library
to play them without
the CD.
To learn more about iTunes:
m See iTunes Help, available in the Help menu.
m Go to www.apple.com/itunes 
Portable music
If you have an Apple
iPod, transfer up to 
1,000 songs for 
listening on the go. Go 
to www.apple.com/ipod
for more information.
Playlists
Make personalized
playlists using songs 
from your Library.
Arrange your music by
mood, artist, genre, or
however you like.
Equalizer
Adjust the sound to 
your tastes using 
the 10-band EQ with
22 presets.11
2
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1.
Click the icon in the Dock  to 
open iTunes. 
2.
Drag songs from the Library to a
playlist. Then click the playlist.
3.
Click Burn CD and insert a CD-R disc.
Then click Burn CD again to start.
. You can fit up to 74 minutes of songs on a
standard music CD.
. To find out which recordable CDs 
work best with your computer, go to
www.apple.com/itunes
If your computer has a CD-RW
drive, you can create your own
music CDs.12
Create and edit your own movies.
Use iMovie to edit video from a digital video camera.
2.
In iMovie, bring in your video 
clips, then edit and polish them 
into movies.
To learn more about iMovie:
m See iMovie Help, available in the Help menu.
m Go to www.apple.com/store to find compatible 
DV cameras or to purchase a 6-pin to 4-pin 
FireWire cable.
1.
Shoot video with a digital video
camera. Then connect the DV camera
using a FireWire cable.
3.
Export your finished movie 
back to tape in your DV camera 
or to a QuickTime file.13
With iMovie, you can add music, voiceovers, titles transitions, and more.
Playback controls 
Use these to play the movie in the
iMovie monitor. Click the Play Full
Screen button to use the 
entire screen.
iMovie monitor 
Preview your movie or
view video from a
connected DV camera.
Viewers
Click the clip viewer 
(eye tab) to edit and
place clips. Click the
timeline viewer (clock tab)
to edit sound.
Editing buttons 
Click to open panels for
adjusting and selecting
sounds, video effects,
titles, and transitions.
Shelf
Clips appear here when
you import them. Move
clips to the viewer
to make them part of
Mode switch your movie.
Switch between
importing from a DV
camera and editing.14
Search the 
Internet.
If you know the Internet
address, you can go 
there directly.
1
2
1.
Click the icon in the Dock to open
Internet Explorer.
To learn more about Internet Explorer: 
m Open Internet Explorer and choose 
Internet Explorer Help from the Help menu.
2.
Type the Internet address and press
Return on your keyboard.
. If you have a dialup connection, you can use the
modem status (W) to connect to and disconnect
from the Internet.
1
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1.
Click the icon in the Dock to 
open Sherlock. 
2.
Click the Internet icon and type
a question in the search field.
3.
Click the Search button ( ). Then
double-click an item in
the list of sites.
. Click the other buttons to find people, read the
news, shop, and more.
. Click the hard disk icon to search the files on
your computer.
Or you can search the Internet
with Sherlock.
2
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Get more out of the Internet with iTools.
iTools is a suite of Internet services integrated into Mac OS X.
iDisk 
Your own storage space on Apple’s Internet
server. Share photos, movies, and other
files over the Internet. Access your files from
another Macintosh or PC.
HomePage 
Build a personal Web site in three easy
steps. Create a photo album, publish 
an iMovie, post your résumé, and more.
Anyone can view your site on the World
Wide Web.
iCards 
Send an elegant iCard, just right for any
occasion. Choose a ready-made photo, or
create a personalized iCard using a photo
on your iDisk.
Email 
Get your own Mac.com email address. 
It’s easy and works with your favorite 
email application.
To learn more about iTools:
m Go to www.apple.com/itools and click Help on the
iTools menu bar.
. If you signed up for iTools when you first turned
on your computer, you already have an account.
Go to www.apple.com/itools to get started.
. To sign up for a new iTools account, open 
System Preferences and click Internet. Then
click Sign Up.17
Store pictures, movies, documents, and other files remotely.
1
2
2.
Drag files to a folder on your iDisk
1. to copy them.
Choose iDisk from 
the Go menu.
. To access your files from another 
computer, log into your iTools account at
www.apple.com/itools
. Anyone can access the files in your Public folder.
. To find out how to use pictures and other 
files from your iDisk to create a personal Web
site, go to www.apple.com/itools and click the
HomePage icon. 18
Send and 
receive email.
Follow these steps to create
and send a message.
1
1.
Click the Mail icon in the Dock
to open the Mail application.
. To check for new messages, click Get Mail. 
To view a message, click its subject. 
. If you entered email information or got a
Mac.com account when you first turned on your
computer, Mail is already set up. To set up a
new email account, choose Preferences from
the Mail menu, then click Accounts.19
To learn more about Mail:
m Open Mail, then choose Mail Help from the 
Help menu.
m Go to www.apple.com/macosx/applications/
mail.html
2
3
2.
To create a new email message, 
click Compose. 3.
Type the email address and a 
subject. Then type your message 
and click Send.20
Organize, plan, and create using AppleWorks.
Use AppleWorks for writing, drawing, making presentations, and more.
Layout capabilities 
Add photos, tables, 
charts, and sidebars. 
Link text frames, layer
graphics, and wrap text.
Word processing 
Write letters, create
brochures, make 
greeting cards and 
party invitations.
Presentation tool 
Create an onscreen 
slide presentation. 
Add movies, art, 
graphs, and charts.
Database 
Keep records, save
addresses, make
inventories. Merge
mailing information with
the word processor to
send form letters.
Customizable
templates 
Choose from a wide 
range of predesigned
documents and modify
them as needed. 
Spreadsheet 
Compute data easily 
using over 100 built-in
functions, then use
formatting options to
make it stand out.
Painting 
Create art from scratch 
or apply effects to 
existing pictures 
or scanned photos.
Extensive 
clip art libraries
Choose from over 
25,000 high-quality 
clip art images.21
. Click the Web tab to download more templates
from the Internet.
To learn more about AppleWorks:
m See AppleWorks Help, available in the Help menu.
m Go to the AppleWorks Web site at
www.apple.com/appleworks
1.
Click the icon in the Dock
to open AppleWorks. 2.
Click the type of document you want
to create, or click the Templates tab to
modify a ready-made document.
To get started using AppleWorks:
1
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Keep your iMac’s
software up-to-date.
Use Software Update to 
get the latest updates 
and drivers.
1.
Click the icon in the Dock
to open System Preferences. 2.
Click 
Software Update.
1
2
. To use Software Update, you must have an
Internet connection.23
3.
Then click
Update Now. 4.
Select the software you want to
update and then click Install.
3
4
. Click the name of a software item to learn
more about it.
. You can schedule your computer to check
automatically for software updates.24
Learn more 
about using your
computer.
Look in Mac Help for 
more information on using
your computer.
1
1.
Click the Finder icon 
in the Dock. 
2.
Then choose Mac Help from 
the Help menu. 
3.
Type a question 
and click Ask.
4.
Click an item in the list 
of Help topics.
. To browse the features of your computer, click
Go under “At a glance.”
. Click Quick Clicks topics for answers to
frequently asked questions.
. To look at Help for other applications, click
the ? button.
2
3
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These Apple Web sites will help you get the most out of your computer.
Apple Service and Support
www.apple.com/support  
Product support, software updates, and 
technical information.
Apple Store
www.apple.com/store 
Purchase the latest Apple and third-party hardware,
software, and accessories.
Macintosh Products Guide
www.apple.com/guide 
For great hardware and software products
for your Mac, check the Web site or look for
the Mac symbol. Also get contact and
support information for third-party software
manufacturers.
. From these Web sites you can quickly link to
other Apple Web sites around the world.26
If you don’t find the answer to your problem 
on the following pages:
Look in Mac Help.
m In Mac Help (see page 24), you can find a great deal of troubleshooting
advice, including information to help you solve problems with
m Connecting to the Internet
m Using software installation and restore discs
m Changing your computer’s settings
m Printing
m And more
m Click the Finder icon in the Dock, then choose Mac Help from the
Help menu. Type a question in the search window (for example, 
type “How do I eject a disc?”) and click Ask.
Switching between Mac OS X and Mac OS 9
Your iMac is set to use Mac OS X. Most applications made for Mac OS 9 will
work in the Mac OS X Classic environment. Just open the application as
you normally would. You can also start up your computer using Mac OS 9.
To set your computer to use Mac OS 9:
m Choose System Preferences from the Apple (K) menu in Mac OS X.
m Click the Startup Disk icon to open the Startup Disk pane.
m Select the Mac OS 9 folder as your startup disk. If the icons are
dimmed, click the padlock icon and enter the password you chose
when you first set up Mac OS X.
m Click Restart.
To set your computer to use Mac OS X again:
m Choose Control Panels from the Apple (K) menu.
m Open the Startup Disk control panel.
m Click the triangle next to the hard disk that contains your operating
system folders.
m Select the Mac OS X System as your startup disk.
m Click Restart.
If the computer won’t respond:
First, make sure the mouse and keyboard are connected.
m Unplug and then plug in the connectors and make sure they 
are secure.
Then try to cancel what the computer is doing.
m Try to force problem applications to quit. Hold down the Option and
Command (x) keys, then press the Esc key. Select the application and
click Force Quit.
Advice and troubleshooting27
If the computer still doesn’t respond, restart it.
m Hold the Power (®) button on the computer for five seconds. When 
the computer turns off, press the Power button again to restart it.
m If that doesn’t work, press the Reset ( ) button.
m If that doesn’t work, unplug the power cord from the computer. 
Then plug the power cord back in and press the Power button on 
the computer to turn it on.
Then do this:
If the problem occurs frequently when you use a
particular application:
m Check with the application’s manufacturer to see if it is compatible 
with your computer.
m For support and contact information about the software that came
with your computer, go to www.apple.com/guide
If the problem occurs frequently:
m You may need to reinstall your system software. Choose Mac Help 
from the Help menu and type “install system software” for more
information.
If you see a flashing question mark
during startup:
If the computer doesn’t start up after a delay, hold down the
Option key and restart your computer.
m When your computer starts up, click the hard disk icon, then click 
the arrow.
Then do this:
After the computer starts up: 
m Open System Preferences and click Startup Disk. Select a local 
Mac OS X System folder.
If the problem occurs frequently:
m You may need to reinstall your system software. Choose Mac Help 
from the Help menu and type “install system software” for more
information.
If the computer won’t turn on or start up:
First, make sure the power cord is connected.
m Make sure both ends of the power cord are plugged in securely. 
Make sure the power cord is plugged into a powered electrical outlet.
m If your computer is plugged into a power strip, make sure the power
strip is turned on.28
If that doesn’t work, or if you hear strange sounds during
startup:
m If you recently installed additional memory, make sure that it is
correctly installed and that it is compatible with your computer.
m If that doesn’t work, press the Reset ( ) button, wait a few seconds,
and then press the Power (®) button.
m See the service and support information that came with your iMac for
information on having your computer serviced.
If you can’t log into your computer:
Make sure you are typing your user name and 
password correctly.
m Make sure you are using the same capitalization and punctuation that
you used originally. Check to see if the Caps Lock key has been
pressed.
If that doesn’t work, reset your password.
m Insert the Mac OS X software install CD that came with your computer.
Restart your computer while holding down the C key. When the
Installer appears, choose Reset Password from the Installer menu and
follow the onscreen instructions.
If your printer won’t respond or work correctly:
Check all cables and connections.
m Make sure the printer is plugged into the computer and an electrical
outlet. Make sure the printer is turned on.
Make sure your computer is set up to use your printer.
m Install the software that came with your printer. See the documentation
that came with the printer for instructions.
m Open the Print Center application in the Utilities folder. Then select
your printer.
If you can’t eject a CD:
Make sure the disc is not in use.
m Quit all applications that are using files on the disc.
m Then press the Media Eject ( ) key at the top-right corner of the
keyboard.
m If that doesn’t work, drag the disc’s icon to the Trash.
m If that doesn’t work, restart the computer, then hold down the mouse
button. To restart, choose Restart from the Apple (K) menu.29
If you have a problem with a third-party
software program:
Make sure the software is compatible with your version of
system software.
m See the documentation that came with the software. You can check the
version of system software you have by choosing About This Mac from
the Apple (K) menu.
To resolve other problems with software, contact the
software manufacturer.
m For support and contact information about the software that came with
your computer, go to www.apple.com/guide
If you have a problem with your
Internet connection:
First, make sure the telephone line or Ethernet cable is
properly connected to your computer.
m Wait a while, then try connecting again.
If that doesn’t work, make sure your Internet settings are
configured correctly.
m Open the Internet Connect application in the Applications folder to
check your dialup or AirPort settings. Open System Preferences and
click Network to check your Internet settings.
m If you’re not sure of the correct information for your Internet settings,
contact your Internet service provider.
If the Apple Pro Mouse isn’t 
responding properly:
First, make sure the mouse and keyboard are connected.
m Unplug and then plug in the connectors and make sure they 
are secure.
If that doesn’t work, try using the mouse on another surface,
like a mouse pad or a notebook. 
m Non-reflective, opaque surfaces without repetitive patterns 
work best.
If you run out of room and want to keep the mouse clicked
while you lift it: 
m Click the mouse, then squeeze the sides with your thumb and fingers
and lift the mouse.
If the mouse clicks too easily or not easily enough: 
m Turn the ring on the bottom of the mouse to adjust the tension 
of the click. 
For the latest troubleshooting information, go to the 
Apple Support Web site at www.apple.com/support30
Install memory and an AirPort Card.
For detailed instructions, refer to Mac Help (see page 24).
Before installing:
m shut down the computer
m unplug all cables, except the power cord
m place the computer face down on a soft cloth
1.
Open the access door using a coin to
turn the latch. 2.
Touch the metal shield inside the
recessed latch area. Then unplug the
power cord.
3.
To install memory, insert a memory
module into one of the two lower
slots.
. Touch this metal before you touch any parts
inside the computer. Don’t walk around the
room until you’ve finished installing memory or
an AirPort Card.
.Be sure to align the notches on the module with
the small notches inside the slot.31
4.
To install an AirPort Card, detach the
antenna from the guide rail, then
remove the protective plastic cap.
5.
Connect the antenna firmly to the
AirPort Card and insert the card
sideways into the slot.
6.
Close the access door and use a coin
to close the latch.
. For instructions on using the AirPort software,
look in the Help Center, available in the Help
menu.
. Never turn your computer on unless all of its
internal and external parts are in place.The guidelines in this section can help you work more comfortably with
your computer. For detailed information about ergonomics, 
see Apple’s Environmental Health and Safety Web site at
www.apple.com/about/ergonomics
Keyboard
m When you use the computer keyboard, your shoulders should be
relaxed. Your upper arm and forearm should form an approximate
right angle, with your wrist and hand in roughly a straight line. 
m You may have to raise your chair so your forearms and hands are at the
proper angle to the keyboard. If this makes it impossible to rest your
feet flat on the floor, you can use a footrest with adjustable height and
tilt to make up for any gap between the floor and your feet. Or you may
lower the desktop to eliminate the need for a footrest. Another option
is to use a desk with a keyboard tray that is lower than the regular work
surface.
m Use a light touch when typing and keep your hands and fingers relaxed.
Avoid rolling your thumbs under your palms.
Mouse
m Position the mouse at the same height as your keyboard. Allow
adequate space to use the mouse comfortably.
Chair
m An adjustable chair that provides firm, comfortable support is best.
Adjust the height of the chair so your thighs are horizontal and your
feet flat on the floor.
m The back of the chair should support your lower back (lumbar region).
Follow the manufacturer’s instructions for adjusting the backrest to fit
your body properly.
Computer
m Arrange the computer so the top of the screen is slightly below your
eye level when you’re sitting at the keyboard. The best distance from
your eyes to the screen is up to you, although most people seem to
prefer 18 to 28 inches (45 to 70 cm). 
m Position the computer to minimize glare and reflections on the screen
from overhead lights and windows.
32
Work more comfortably.33
Important  Don’t lift the computer using the flip-out foot. You could
damage your computer. To move your computer, grab the handle on the
top of the computer with one hand; with your other hand, hold the
bottom of the computer.
Avoiding fatigue
m Change your seated position, stand up, or stretch whenever you start
to feel tired. Frequent short breaks are helpful in reducing fatigue.
m Use a light touch when typing or using a mouse and keep your hands
and fingers relaxed.
m Some computer users may develop discomfort in their hands, wrists,
or arms after periods of intensive work without breaks. 
If you begin to develop chronic pain or discomfort in your hands,
wrists, or arms, consult a qualified health specialist immediately.
m Allow adequate workspace so that you can use your keyboard and
mouse comfortably. Place papers or other items so you can view them
easily while using your computer. A document stand may make reading
papers more comfortable.
m Eye muscles must work harder to focus on nearby objects.
Occasionally focus your eyes on a distant object, and blink often while
you work.
m Clean your screen regularly. Keeping the screen clean helps reduce
unwanted reflections.
45–70 cm (18–28 in.)
Thighs tilted slightly
Shoulders
relaxed
Screen positioned
to avoid reflected
glare
Forearms 
and hands 
in a straight 
line
Forearms
level or tilted
down slightly
Lower back
supported
Feet flat on the floor
Top of the screen
at or slightly below
eye level (You may
need to adjust
the height of your 
monitor by raising 
your work 
surface.)
Clearance under
work surface34
Safety
Make sure that you
m keep these instructions handy for reference by you and others who
may use your computer
m follow all instructions and warnings regarding your system 
When setting up and using your computer, remember the following:
m Place your computer in a location with adequate ventilation. Never
block the vents on the computer.
m Your computer has a three-wire grounding plug that will only fit a
grounded AC outlet. If you are unable to insert the plug into the outlet,
contact a licensed electrician to replace the outlet with a properly
grounded outlet. 
m Make sure you only connect the modem to an analog phone line, the
type commonly used in residences. Do not connect a digital telephone
line to the modem, because it could damage the modem.
m Never turn on your computer unless all of its internal and external
parts are in place. Operating the computer when it is open or missing
parts can be dangerous and damage your computer.
Important  The only way to disconnect power completely is to unplug
the power cord. Make sure at least one end of the power cord is within
easy reach so that you can unplug the computer when you need to.
For your own safety and that of your equipment, always disconnect the
power plug (by pulling the plug, not the cord) if any of the following
conditions exists:
m you want to remove any parts (leave the cord disconnected as long as
the computer is open)
m the power cord or plug becomes frayed or otherwise damaged
m you spill something into the case
m your computer is exposed to rain or any other excess moisture
m your computer has been dropped or the case has been otherwise
damaged
m you suspect that your computer needs service or repair
m you want to clean the case (use only the recommended procedure
discussed in Mac Help)
Be sure that you always do the following:
m Keep your computer away from sources of liquids, such as drinks,
washbasins, bathtubs, shower stalls, and so on.
m Protect your computer from dampness or wet weather, such as rain,
snow, and so on.
Warning Electrical equipment may be hazardous if misused.
Operation of this product must always be supervised by an adult.
Do not allow children access to the interior of this product and do
not permit them to handle any cables.
Safety, cleaning, and power management35
Cleaning your computer equipment
To clean your computer equipment, use only the recommended
procedures discussed in Mac Help.
Power supply
The power supply in your computer is a high-voltage component and not
user-serviceable. If you suspect the power supply needs service, contact
your Apple-authorized dealer or service provider. 
Power-saving and environmental features
Your computer is equipped with energy-saving features that allow it to
conserve energy when not in use. For instructions on adjusting the system
and display sleep settings and additional energy-conservation information,
see Mac Help.
ENERGY STAR
®
As an ENERGY STAR®
partner, Apple has determined that this product
meets the ENERGY STAR®
guidelines for energy efficiency. The ENERGY
STAR®
program is a partnership with office product equipment
manufacturers to promote energy efficiency. Reducing energy
consumption of office products saves money and reduces pollution by
eliminating wasted energy.
Warning Do not attempt to access the high-voltage area or
power supply. If you suspect the power supply needs service,
contact your Apple-authorized dealer or service provider. 
Warning Do not clean the screen with a cleaner that contains
alcohol or acetone. Never spray cleaner directly onto the screen.
Liquid could drip inside the screen and cause an electrical shock.36
Communications, telephone, and modem 
regulation information
For information on FCC regulations, radio and television interference, and 
telephone and modem information related to this product, see the files in the
Communications Regulations folder, inside the Documents folder on your hard disk. 
Laser information
Warning  Making adjustments or performing procedures other than those specified in
your equipment’s manual may result in hazardous radiation exposure.
Do not attempt to disassemble the cabinet containing the laser. The laser beam 
used in this product is harmful to the eyes. The use of optical instruments, such as
magnifying lenses, with this product increases the potential hazard to your eyes. 
For your safety, have this equipment serviced only by an Apple-authorized 
service provider. 
Service warning label
High-risk activities warning
This computer system is not intended for use in the operation of nuclear facilities, aircraft
navigation or communications systems, or air traffic control machines, or for any other
uses where the failure of the computer system could lead to death, personal injury, or
severe environmental damage.
Camera information
The DV camera pictured on page 12 of this manual is not included with this product. The
model shown may not be available in all areas.
Mouse information
This product complies with the requirements of European Directives 72/23/EEC and
89/336/EEC. Complies with the Canadian ICES-003 Class B specification. This mouse is a
Class 1 LED product. (IEC 60825-1:1993+A1:1997+A2:2001)
Caution  Use of controls or adjustment or performance of procedures other than those
specified herein may result in hazardous radiation exposure.
Every effort has been made to ensure that the information in this manual is accurate.
Apple is not responsible for printing or clerical errors.
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iBooknce you’ve set up your iBook and followed the
onscreen guide to connect to the Internet, what’s
next? In this booklet you’ll find more information to help
you get the most out of your iBook:
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20 Productivity
22 Learning more and solving problems
28 Installing memory and an AirPort Card
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What can my iBook do?
Your computer has these built-in features:
Optional AirPort 
wireless Internet 
and networking
Using the optional AirPort
Card, you can connect to the
Internet, use email, share files,
play network games, and 
more—without any 
wires to hold you down.
Volume and 
brightness controls
Adjust sound volume and
screen brightness directly using
your keyboard.
Programmable 
function keys
Set the keyboard function 
keys to open your Web
browser, email application, 
or other favorite application 
or document automatically.
Optical disc drive
Install and run software, or listen
to music CDs. Play DVD videos
if you have the DVD or combo
DVD/CD-RW drive, or create
your own CDs if you have the
CD-RW or combo drive. Press
the eject key ( ) on the
keyboard to open the drive.
Battery level indicator
(underneath)
When you press the button 
on the battery, one to four
lights glow to show how
much charge is left.
Two built-in 
stereo speakers
Listen to music, movies, 
games, and multimedia.
Built-in microphone
Record sound or control 
your computer with spoken
commands.Modem
Connect to the Internet,
browse the World Wide
Web, and send and 
receive electronic mail.
3
Sleep indicator light
Pulsating light indicates that
the computer is in sleep.
® Power button
Turn your computer on, put
it to sleep, or shut it down.
Audio/video port
Connect headphones or
external speakers. Mirror
your iBook display on a 
TV or video projector.
Ethernet
Share files with another
computer or access 
a computer network.
USB
Connect printers, Zip and
other disk drives, digital
cameras, joysticks, 
and more.
FireWire
Connect a digital video
camera and use it to create
your own desktop movies.
You can also connect
FireWire hard disks,
printers, and more.
RGB port
Connect an external monitor
(using the included Apple
RGB Display Adapter).
Reset button
Use during troubleshooting
to restart your computer.
Kensington 
security slot
Attach a lock and cable 
to prevent theft.4
What are the basics?
The Macintosh desktop is your starting place.
Control Strip
Use this for 
convenient access to
often-used settings.
Application menu
Click here to switch 
between open applications.
Remote Access
Use this Control Strip button 
to connect to and disconnect 
from the Internet.
Disc
This appears when a CD
or DVD is in the disc drive.
Double-click the icon to
see what’s on the disc. 
To eject a disc, press the
eject key ( ) on the
keyboard.
Apple menu
Use this to select 
often-used applications
and tools. To see the
menu, click the apple ()
in the menu bar.
Trash
Drag items here to 
delete them. Items remain
here until you choose
Empty Trash from the
Special menu.
. For a quick tutorial on mouse and
desktop skills, choose Mac Tutorials
from the Help menu.5
Window close box 
Click this to close 
a window.
Hard disk
All of your files and
applications are kept here.
Double-click the icon to
open it.
Folder
Folders help 
organize your files 
and applications. 
Double-click
a folder to open it.
Document
Documents are files that you create 
with an application (such as a letter 
you create with your word processor).
Double-click the icon to open the file 
in the application used to create it.
Application
Applications are software programs 
(such as a game or word processor) 
that you use with your computer. 
Double-click an application’s icon 
to open the application.How do I find something on the Internet?
If you know the Internet address, you can go there directly.
6
1
Double-click 
“Browse the Internet” 
to open your Web browser.
2
Type the Internet address 
and press Return on 
your keyboard.7
2
Type what you want to find and 
click the Search button ( ). Then 
double-click an item in
the list of sites.
. Click the other buttons to find people, 
read the news, shop, and more.
Or you can search the Internet with Sherlock 2.
1
Choose Search Internet
from the File menu.8
How can I get started on the World Wide Web?
These Apple Web sites will help you get the most out of your computer.
www.apple.com/support 
Product support, software updates, and
technical information
. From these Web sites you can quickly
link to other Apple Web sites around 
the world.
www.apple.com/store 
Purchase the latest Apple hardware, 
software, and accessories.
www.apple.com/guide 
For great hardware and software
products for your Mac, check this 
Web site or look for the Mac symbol.
Also get contact and support
information for third-party software
manufacturers.9
www.apple.com/hotnews
The latest Apple news and events, software updates for your
Mac, and QuickTime hot picks
www.apple.com/macosx
Get the latest info on the world’s most
advanced OS–Mac OS X.
www.apple.com/icards
Send customized electronic postcards 
to your friends and family.KidSafe 
Make the Internet a safer place 
for your kids. KidSafe gives them
access to more than 100,000
educator-approved Web sites 
and blocks the rest.
10
What can I do with iTools?
iTools is a new class of Internet services created for Mac users.
iDisk 
Your own 20 MB of free storage 
on Apple’s Internet server. Share
photos, movies, and other files over
the Internet. Purchase additional
storage space.
Email 
Get your own Mac.com email
address. It’s easy and it works with
your favorite email programs.
HomePage 
Build a personal Web site in 
three easy steps. Create a photo
album, publish an iMovie, post your
resumé, and more. Now anyone can
view your page on the Internet.
iCards 
Send an elegant iCard, just right for
any occasion. Choose a ready-made
photo, or create a personalized
iCards using photos on your iDisk.11
To get started using iTools:
2
Follow the simple instructions 
to sign up for a free account.
. If you signed up with EarthLink and got 
a Mac.com email address when you first turned
on your computer, you already have an iTools 
account. Go to www.apple.com/itools and
enter your member name and password.
1
Go to www.apple.com/itools 
and click the Free Sign Up button.
To learn more about iTools:
m go to www.apple.com/itools and click Help on the 
iTools menu bar12
How do I use email?
Follow these steps to create and send a message:
1
Double-click the Mail icon 
on the desktop to open your 
email application.
. The first time you open the application, 
a setup assistant helps you connect to 
your email account.
. To check for new messages, 
click the Send & Receive button. 
To view a message, click its subject.13
2
To create a new email message, click
the New button.
3
Type the email address and 
a subject. Then type your 
message and click Send Now.Portable music
Take your iBook and your
entire music collection with
you, or transfer a few of
your favorites to an MP3
player.
Playlists
Make personalized 
playlists using songs from
your Library. Arrange your
music by mood, artist,
genre, or however you like.
What can I do with iTunes?
Create a library of music, listen to Internet radio, or transfer songs to a portable MP3 player.
Library
Your collection of 
songs, imported from 
your own audio CDs or
downloaded from the
Internet. Easily browse 
or search for music.
Radio Tuner
Listen to one of hundreds
of Internet radio stations—
jazz, rock, talk, and more.
Audio CDs
Play an audio CD on 
your computer. Import
songs to your Library.
To learn more about iTunes:
m see iTunes Help, available in the Help menu 
m go to www.apple.com/itunes 
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If your computer has a CD-RW drive, you can create your own music CDs.
1
Drag songs from the Library to a
playlist. Then double-click the playlist.
. You can fit up to 74 minutes of songs on 
a music CD.
2
Click Burn CD and insert a CD-R disc.
Then click Burn CD again to start.
. To find out which recordable CDs work best 
with your computer, go to www.apple.com/itunesHow can I watch movies and videos?
Watch live video on the Internet using QuickTime TV.
2
Double-click the 
QuickTime Player icon 
on the desktop.
3
Pull the tab to open 
the Favorites drawer. 
Then click a channel.
.With QuickTime, you can 
also watch movies you make with 
iMovie, listen to MP3 music files, 
and much more.
To learn more about QuickTime:
m see QuickTime Help, available in the Help menu
m go to www.apple.com/quicktime
1
Connect
to the Internet.
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If your computer has a DVD drive, you can watch DVD video.
. To use the whole screen to watch the 
movie, choose Present Video on Screen from
the Video menu.
. Connect your iBook to a television using the
optional Apple AV Cable to watch a DVD on TV
(see Mac Help to learn more).
. To learn more about the Apple DVD Player,
see Apple DVD Player Help, available in the
Help menu.
1
Insert a DVD video disc. 
Then choose Apple DVD Player 
from the Apple (K) menu. 
2
Use the controller to play 
the movie or see the DVD’s 
special features.18
How can I make a movie?
Use iMovie 2 to edit video from a digital video camera.
2
In iMovie, bring in your video 
clips, then edit and polish them 
into movies.
To learn more about iMovie:
m open the iMovie application, then go through 
the tutorial, available in the Help menu
m see iMovie Help, available in the Help menu
m go to www.apple.com/imovie to find 
compatible DV cameras
1
Shoot video with a digital video
camera. Then connect the DV camera
using a FireWire cable.
. Standard 6-pin-to-4-pin FireWire cable 
not included.
3
Export your finished movie 
back to tape in your DV camera 
or to a QuickTime file.19
With iMovie 2, you can add music, voice-overs, titles, transitions, and more.
Editing buttons 
Click these to open panels
for adjusting and selecting
sounds, video effects,
titles (text), and scene
transitions. Click the Clips
button to see the shelf.
iMovie monitor 
Preview your movie or
view video directly 
from a connected 
DV camera.
Shelf
To make clips part of your
movie after you import
them, move them from the
shelf to the clip viewer.
Viewers
Click the clip viewer 
(eye tab) to edit and place
clips. Click the timeline
viewer (clock tab) to 
edit sound.
Mode switch
Use this to switch between
importing from a DV
camera and editing.
Scrubber bar 
Use this to select sections of video.
Playback controls 
Use these to play the movie 
in the iMovie monitor. Click the
Play Full Screen button to 
use the entire screen.20
What can I do with AppleWorks?
Use AppleWorks for writing, drawing, making presentations, and more. 
Layout capabilities 
Add photos, tables, 
charts, and sidebars. 
Link text frames, layer
graphics, and wrap text.
Word processing 
Write letters, create
brochures, make 
greeting cards and 
party invitations.
Presentation tool 
Create an onscreen slide
presentation. Add movies,
art, graphs, and charts.
Database 
Keep records, save
addresses, make
inventories. Merge mailing
information with the 
word processor to send
form letters.
Customizable
templates 
Choose from a wide 
range of predesigned
documents and modify
them as needed. 
Spreadsheet 
Compute data easily 
using over 100 built-in
functions, then use
formatting options to
make it stand out.
Painting 
Create art from scratch 
or apply effects to 
existing pictures 
or scanned photos.
Extensive 
clip art libraries
Choose from over 
25,000 high-quality 
clip art images.21
To get started using AppleWorks:
1
Open AppleWorks, 
in the Applications folder 
on your hard disk.
2
Click the type of document you want to
create, or click the Templates tab 
to modify a ready-made document.
. Click the Web tab to download more templates
from the Internet.
To learn more about AppleWorks:
m see AppleWorks Help, available in the Help menu
m open the AppleWorks Getting Started file 
(on your hard disk in the AppleWorks folder)
m go to the AppleWorks Web site at
www.apple.com/appleworks22
How can I keep my computer software up-to-date?
Use the Software Update control panel to get the latest updates and drivers.
1
Connect to 
the Internet.
2
Choose Control Panels from the Apple
menu. Then choose Software Update
from the submenu.
3
Click the 
Update Now
button.23
4
Select the software you want to 
update and then click Install.
. Click the name of a software item to learn 
more about it. 
. You can schedule your computer to check
automatically for software updates.24
Where do I go to learn more?
Look in Mac Help for more information on using your computer.
2
Type a question and 
click Search.
. If you don’t see Mac Help 
in the Help menu, choose Finder
from the Application menu and
try again.
. You can browse through
information about your computer
by clicking one of the blue
underlined items in the window.
. If you want to see the Help 
for other applications on your
computer, choose Help Center
from the Help menu.
1
Choose Mac Help 
from the Help menu.25
. Underlined items are links. When you click a link, 
it goes to another Help topic, does something for you, 
or takes you to more information on the Internet.
3
Click an item in the list 
of Help topics.
. If you didn’t find what you were 
looking for, try rewording your question.If the computer won’t respond:
Try to cancel what the computer is doing.
m Press the Command (x) and period (.) keys at the same time.
m If that doesn’t work, hold down the Option and Command (x) keys
and then press the Esc key.
If the computer still doesn’t respond, restart it.
m Press and hold the Power button for 5 to 10 seconds to shut down
the computer. Then press the Power button to restart it.
m If that doesn’t work, hold down the Control and Command (x)
keys and then press the Power button.
m If that doesn’t work, gently press the reset ( ) button by inserting
the end of a paper clip into the small hole above the audio/video
port, wait a few seconds, and then press the Power button. You
need to reset the date and time (using the Date & Time control
panel) after you reset your iBook.
Then do this:
If the problem occurs when you use a certain application:
m If this is the only way that you can start up your computer, check
with the application’s manufacturer to see if it is compatible with
your computer.
If the problem occurs frequently:
m Choose Mac Help from the Help menu. Look at the section on how
to prevent and solve problems. You may need to check for
extension conflicts or reinstall your computer’s system software. 
If the computer “freezes” during startup 
or you see a flashing question mark:
Turn off system extensions.
m Start up your computer while holding down the Shift key.
If that does not work, start up using the system software CD.
m Insert your system software CD and start up while holding down
the C key. (Make sure the Caps Lock key is not engaged.) 
Then do this:
After the computer starts up, see the troubleshooting
information in the onscreen help.
m Choose Mac Help from the Help menu. Look at the section 
on how to prevent and solve problems. You may need to check for
extension conflicts or reinstall your computer’s system software.
If the background picture is different: 
m You started up your computer using the system software on your 
CD instead of your hard disk. If this is the only way that you can 
start up your computer, you probably need to reinstall the system
software on your hard disk. Look for instructions in Mac Help or
look for the system software installation program on your CD.
26
What if I have a problem?27
If the computer won’t turn on or start up:
Make sure the power adapter is plugged into the computer
and into a functioning power outlet.
m Your battery may need to be recharged. Press the small button on
the battery. One to four lights glow indicating the battery’s level of
charge.
If that does not work, reset the computer’s memory.
m Start up the computer and immediately hold down the Command
(x), Option, P, and R keys until you hear the startup sound twice.
If that does not work or if you hear a strange sound during
startup:
m If you recently installed additional memory, make sure that it is
correctly installed. Try removing the memory; if the computer starts
up normally, the memory is not compatible with your computer.
m If that doesn’t work, gently press the reset ( ) button by inserting
the end of a paper clip into the small hole above the audio/video
port, wait a few seconds, and then press the Power button. 
m See the service and support information that came with your iBook
for information on contacting Apple for service.
If you can’t eject a CD:
Make sure the disc is not in use.
m Quit all applications that are using files on the disc. 
m Then press the keyboard’s Eject key ( ), or drag the disc’s icon to
the Trash.
If the disc still won’t eject, eject it manually:
m Carefully insert the end of a straightened paper clip into the
emergency eject hole on the drive tray.
Other problems:
If you have a problem with your Internet connection:
m Make sure the telephone line is connected to the modem port (W)
and the line is functioning properly.
m Choose Mac Help from the Help menu. There you can find out how
to locate and change your Internet settings. 
m If you’re not sure of the correct information for your Internet
settings, contact your Internet service provider.
If you have a problem connecting other devices:
m Make sure that the device is properly connected. Try unplugging
and plugging in the device again.
m Check to see if the device has software that needs to be installed.
m If that doesn’t work, contact the device manufacturer.
m If you want to connect an older device, see Mac Help for
information on connecting older devices to your computer.
If you have a problem with an application:
m For problems with software, contact the software manufacturer. 
m For information on the software that came with your iBook,
including how to contact the manufacturer, see
www.apple.com/support/bundledsw
If you have a problem using your computer:
m Look at the information in Mac Help for instructions and
troubleshooting information.
If you suspect there may be a problem with your computer
hardware:
m You can use the Apple Hardware Test CD to help you determine if
there is a problem with one of your computer’s components, such
as the memory or processor.28
How do I expand my iBook?
1
Shut down your computer. Then
disconnect the power adapter and
phone cord. Turn the computer
over and remove the battery.
3
If necessary, remove the metal
clip and pull the AirPort Card
from the adapter. The adapter is
not used with the iBook.
. For instructions on using the AirPort software,
look in the Help Center, available in the Help menu.29
4
Flip up the wire bracket and
connect the end of the antenna to
the AirPort Card. Touch a 
metal surface inside the 
computer.
5
Slide the AirPort Card (with the
AirPort ID and barcode facing up)
under the wire bracket and 
into the slot.
6
Press the wire bracket down to
secure the card. Then replace the
keyboard and battery.
. You may need to reset the date and time
(using the Date & Time control panel) after
installing the AirPort Card.Add additional memory.
30
. Your iBook has one expansion slot that accepts
a 1.25-inch (or shorter), PC-100 compliant, 
SO-DIMM memory module. For more information
on installing memory, look in Mac Help, available in
the Help menu.
1
Shut down your computer. Then
disconnect the power adapter and
phone cord. Turn the computer
over and remove the battery.
2
Release the keyboard by sliding
the two plastic tabs away from the
display.
3
Lift up the keyboard, flip it over,
and lay it on the palm rests and
trackpad. Touch a metal surface
inside the computer.31
4
If necessary, remove the 
AirPort Card.
. To prevent scratching, place a soft 
cloth between the AirPort Card and the
iBook case.
5
Remove the two screws that
secure the RAM shield, then
carefully lift it out.
6
Insert the RAM into the slot at an
angle and press down to lock it in
place. Replace the RAM shield,
AirPort Card (if necessary),
keyboard, and battery.
. You may need to reset the date and time
(using the Date & Time control panel) after
you install memory.Keyboard and trackpad
When you use the keyboard and trackpad, your shoulders should be
relaxed. Your upper arm and forearm should form an angle that is
slightly greater than a right angle, with your wrist and hand in roughly
a straight line.
Use a light touch when typing or using the trackpad and keep 
your hands and fingers relaxed. Avoid rolling your thumbs under 
your palms.
Change hand positions often to avoid fatigue. Some computer users
may develop discomfort in their hands, wrists, or arms after intensive
work without breaks. If you begin to develop chronic pain or
discomfort in your hands, wrists, or arms, consult a qualified 
health specialist. 
This Not this
This Not this
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How do I work comfortably?33
Chair
An adjustable chair that provides firm, comfortable support is best.
Adjust the height of the chair so your thighs are horizontal and your
feet flat on the floor. The back of the chair should support your lower
back (lumbar region). Follow the manufacturer’s instructions for
adjusting the backrest to fit your body properly.
You may have to raise your chair so your forearms and hands are at the
proper angle to the keyboard. If this makes it impossible to rest your
feet flat on the floor, you can use a footrest with adjustable height and
tilt to make up for any gap between the floor and your feet. Or you can
lower the desktop to eliminate the need for a footrest. Another option
is to use a desk with a keyboard tray that’s lower than the regular work
surface.
External mouse
If you use an external mouse, position the mouse at the same height as
your keyboard and within a comfortable reach.
Built-in display
Adjust the angle of the display to minimize glare and reflections from
overhead lights and windows.
You can adjust the brightness of the screen when you take the
computer from one work location to another, if the lighting in your
work area changes.
For more information
For additional ergonomic information, see the Apple ergonomic 
Web site at www.apple.com/about/ergonomicsWhen setting up and using your computer, remember the following:
m Read all the installation instructions carefully before you plug your
computer into a wall socket.
m Keep these instructions handy for reference by you and others.
m Follow all instructions and warnings dealing with your system.
m Use only the Apple Portable Power Adapter that came with your
computer. Adapters for other electronic devices may look similar,
but they may damage your computer. 
m If your power adapter came equipped with a three-wire grounding
plug (a plug that has a third grounding pin), then this plug will fit
only a grounded AC outlet. If you are unable to insert the plug into
the outlet because the outlet is not grounded, contact a licensed
electrician to replace the outlet with a properly grounded outlet.
Do not defeat the purpose of the grounding plug!
m Always leave space around your power adapter. Do not use this
equipment in a location where airflow around the power adapter is
confined, such as a bookcase.
m Always disconnect the power adapter, phone line, and any other
cables before opening the computer to perform procedures such as
installing memory.
m Never turn on your computer unless all of its internal and external
parts are in place. Operating the computer with missing parts can
be dangerous and damage your computer.
m Do not connect a digital telephone line to the modem, because the
wrong type of line could damage the modem.
m When using your computer or when charging the battery, it is
normal for the bottom of the case to get warm. The bottom of the
computer case functions as a cooling surface that transfers heat
from inside the computer to the cooler air outside. The bottom of
the case is raised slightly to allow airflow that keeps the unit within
normal operating temperatures.
m Keep your computer away from sources of liquids, such as drinks,
washbasins, bathtubs, shower stalls, and so on.
m Protect your computer from dampness or wet weather, such as rain,
snow, and so on.
34
Is there anything else I need to know?
Follow these instructions for using your computer safely and wisely:For your own safety and that of your equipment, always disconnect the
power plug (by pulling the plug, not the cord), disconnect the phone
line, and remove the battery if any of the following conditions exists:
m you want to remove any parts (leave the cord disconnected as long
as the keyboard is open) 
m the power cord or plug becomes frayed or otherwise damaged
m you spill something into the case
m your computer is exposed to rain or any other excess moisture
m your computer has been dropped or the case has been otherwise
damaged
m you suspect that your computer needs service or repair
m you want to clean the case (use only the recommended procedure)
Important The only way to disconnect power completely is to unplug
the power plug, disconnect the phone cord, and remove the battery.
Make sure at least one end of the power cord is within easy reach so
that you can unplug the computer when you need to.
Your iBook has a unique appearance and finish that may contain minor
imperfections, some of which may increase over time. Exposing your
iBook to extreme temperatures or humidity may cause this process to
accelerate. Proper care and handling, as described in this manual, will
help keep your iBook looking its best.
To clean the case, do the following:
1 Disconnect the power plug and phone cord and remove the
battery. (Pull the plug, not the cord.)
2 Wipe the surfaces lightly with a clean, soft cloth.
Warning Do not use any substance containing isopropyl alcohol.
It can damage the case. If necessary, use products made specifically
for cleaning computers.
Warning To avoid damage to your computer, Apple recommends
that only an Apple-certified technician install additional RAM or an
AirPort Card. Consult the service and support information that
came with your computer for instructions on how to contact an
Apple-authorized service provider or Apple for service. If you
attempt to install additional RAM or an AirPort Card yourself, any
damage you may cause to your equipment will not be covered by
the limited warranty on your computer. See an Apple-authorized
dealer or service provider for additional information about this or
any other warranty question.
Warning Electrical equipment may be hazardous if misused.
Operation of this product, or similar products, must always 
be supervised by an adult. Do not allow children access to the
interior of any electrical product and do not permit them to handle
any cables.
Never push objects of any kind into this product through the
openings in the case. Doing so may result in fire or a dangerous
electric shock.
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Communications, Telephone, and Modem 
Regulation Information
For information on FCC regulations, radio and television interference, and 
telephone and modem information related to this product, see the files in the
Communications Regulations folder, inside the Documents folder on your hard disk. 
Laser Information
Warning Making adjustments or performing procedures other than those specified
in your equipment’s manual may result in hazardous radiation exposure.
Do not attempt to disassemble the cabinet containing the laser. The laser beam 
used in this product is harmful to the eyes. The use of optical instruments, such as
magnifying lenses, with this product increases the potential hazard to your eyes. 
For your safety, have this equipment serviced only by an Apple-authorized 
service provider. 
Service Warning Label
Apple Portable Power Adapter
The Apple Portable Power Adapter that comes with your computer is a high voltage
component and should not be opened for any reason, even when the computer is
turned off. If your computer needs service, contact your Apple-authorized dealer or
service provider.
Battery
Warning Risk of explosion if battery is replaced by an incorrect type. Dispose of
used batteries according to your local  environmental guidelines. Do not puncture or
incinerate.
High-Risk Activities Warning
This computer system is not intended for use in the operation of nuclear facilities,
aircraft navigation or communications systems, or air traffic control machines, or for
any other uses where the failure of the computer system could lead to death, personal
injury, or severe environmental damage.
Camera Information
The DV camera pictured on page 18 of this manual is not included with this product.
The model shown may not be available in all areas.
ENERGY STAR
®
As an ENERGY STAR®
partner, Apple Computer has determined that standard
configurations of this product meet the ENERGY STAR®
guidelines for energy
efficiency. The United States Environmental Protection Agency’s ENERGY STAR®
program is a partnership with office product equipment manufacturers to promote
energy-efficiency. Reducing energy consumption of office products saves money and
reduces pollution by eliminating wasted energy.
Every effort has been made to ensure that the information in this manual is
accurate. Apple is not responsible for printing or clerical errors.
Where’s the fine print?
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Communications Regulation Information
FCC Declaration of Conformity
This device complies with part 15 of the FCC rules. Operation is subject to the following two conditions: (1) This 
device may not cause harmful interference, and (2) this device must accept any interference received, including 
interference that may cause undesired operation. See instructions if interference to radio or television reception 
is suspected.
Radio and Television Interference
The equipment described in this manual generates, uses, and can radiate radio-frequency energy. If it is not 
installed and used properly—that is, in strict accordance with Apple’s instructions—it may cause interference with 
radio and television reception. 
This equipment has been tested and found to comply with the limits for a Class B digital device in accordance 
with the speciﬁcations in Part 15 of FCC rules. These speciﬁcations are designed to provide reasonable protection 
against such interference in a residential installation. However, there is no guarantee that interference will not 
occur in a particular installation. 
You can determine whether your computer system is causing interference by turning it off. If the interference
stops, it was probably caused by the computer or one of the peripheral devices. 
If your computer system does cause interference to radio or television reception, try to correct the interference
by using one or more of the following measures:
m Turn the television or radio antenna until the interference stops. 
m Move the computer to one side or the other of the television or radio.
m Move the computer farther away from the television or radio.
m Plug the computer into an outlet that is on a different circuit from the television or radio. (That is, make
certain the computer and the television or radio are on circuits controlled by different circuit breakers or 
fuses.)
If necessary, consult an Apple-authorized service provider or Apple. See the service and support information that 
came with your Apple product. Or, consult an experienced radio/television technician for additional suggestions. 
Important  Changes or modiﬁcations to this product not authorized by Apple Computer, Inc., could void the 
FCC Certiﬁcation and negate your authority to operate the product.
This product was tested for FCC compliance under conditions that included the use of Apple peripheral devices 
and Apple shielded cables and connectors between system components. It is important that you use Apple 
peripheral devices and shielded cables and connectors between system components to reduce the possibility of 
causing interference to radios, television sets, and other electronic devices. You can obtain Apple peripheral 
devices and the proper shielded cables and connectors through an Apple-authorized dealer. For non-Apple 
peripheral devices, contact the manufacturer or dealer for assistance. 
Responsible party (contact for FCC matters only):  Robert Steinfeld, Apple Computer, Inc., 1 Inﬁnite Loop,
Cupertino, CA 95014-2084, 408-974-2618.
Industry Canada Statement
This Class B device meets all requirements of the Canadian interference-causing equipment regulations. 
Cet appareil numérique de la Class B respecte toutes les exigences du Règlement sur le matériel brouilleur du 
Canada.8 Communications Regulation Information
VCCI Class 2 Statement
Notify Your Telephone Company
Some telephone companies require that you notify the local business ofﬁce when you hook up a modem to their 
lines.
Information You Need in the United States 
The optional internal modem complies with Part 68 of the FCC rules. On the back of this equipment is a label that 
contains, among other information, the FCC registration number and ringer equivalence number (REN). If 
requested, provide this information to your telephone company.
m Ringer equivalence number (REN):  0.8–0.9 The REN is useful to determine the quantity of devices you may 
connect to your telephone lines and still have all those devices ring when your telephone number is called. In 
most, but not all areas, the sum of the RENs of all devices connected to one line should not exceed ﬁve (5.0). 
To be certain of the number of devices you may connect to your line, as determined by the REN, you should 
contact your local telephone company to determine the maximum REN for your calling area. 
m Telephone jack type: USOC, RJ-11 An FCC-compliant telephone cord and modular plug are provided with this 
equipment. This equipment is designed to be connected to the telephone network or premises wiring using a 
compatible modular jack that complies with Part 68 rules. See the installation instructions for details.
Telephone Line Problems
If your telephone doesn’t work, there may be a problem with your telephone line. Disconnect the modem to see 
if the problem goes away. If it doesn’t, report the problem either to your local telephone company or to your 
company’s telecommunications people. 
If disconnecting the modem eliminates the problem, the modem itself may need service. See the service and 
support information that came with your Apple product for instructions on how to contact Apple or an Appleauthorized service provider for assistance. 
If you do not disconnect your modem when it is adversely affecting the telephone line, the telephone company 
has the right to disconnect your service temporarily until you correct the problem. The telephone company will 
notify you as soon as possible. Also, you will be informed of your right to ﬁle a complaint with the FCC. 
The telephone company may make changes in its facilities, equipment, operations, or procedures that could 
affect the operation of your equipment. If this happens, the telephone company will provide advance notice in 
order for you to make the necessary modiﬁcations to maintain uninterrupted service.
The optional internal modem will not work with party lines, cannot be connected to a coin-operated telephone, 
and may not work with a private branch exchange (PBX). 
Telephone Consumer Protection Act 
The Telephone Consumer Protection Act of 1991 makes it unlawful for any person to use a computer or other 
electronic device to send any message via a telephone fax machine unless such message clearly contains in a 
margin at the top or bottom of each transmitted page or on the ﬁrst page of the transmission, the date and time it 
was sent and an identiﬁcation of the business or other entity, or individual sending the message and the 
telephone number of the sending machine of such business, entity, or individual.Communications Regulation Information 9
Information You Need in Canada 
The Industry Canada (IC) label identiﬁes certiﬁed equipment. This certiﬁcation means that the equipment meets 
certain telecommunications network protective, operational, and safety requirements. The Department does not 
guarantee the equipment will operate to a user’s satisfaction. 
Before installing this equipment, make sure that you are permitted to connect to the facilities of the local 
telecommunications company. Be sure you use an acceptable method of connection to install the equipment. In 
some cases, you may extend the company’s internal wiring for single-line individual service by means of a certiﬁed
telephone extension cord. Be aware, however, that compliance with these conditions may not prevent 
degradation of service in some situations. 
Repairs to certiﬁed equipment should be made by an authorized Canadian maintenance facility designated by the 
supplier. Any equipment malfunctions or repairs or alterations that you make to this equipment may cause the 
telecommunications company to request that you disconnect the equipment. 
In Canada, contact Apple at: 7495 Birchmount Road, Markham, Ontario, L3R 5G2, 800-263-3394
Users should ensure for their own protection that the electrical ground connections of the power utility,
telephone lines, and internal metallic water pipe system, if present, are connected together. This precaution may 
be particularly important in rural areas.
Informations Destinés aux Utilisateurs Canadiens
L’étiquette d’Industrie Canada identiﬁe un matériel homologué. Cette étiquette certiﬁe que le matériel est 
conforme à certaines normes de protection, d’exploitation et de sécurité des réseaux de télécommunications. Le
Ministère n’assure toutefois pas que le matériel fonctionnera à la satisfaction de l’utilisateur.
Avant d’installer ce matériel, l’utilisateur doit s’assurer qu’il est permis de le raccorder au réseau de l’entreprise 
locale de télécommunication. Le matériel doit également être installé en suivant une méthode acceptée de 
raccordement. Dans certains cas, le cablage appartenant à l’entreprise utilisé pour un service individuel à ligne 
unique peut être prolongé au moyen d’un dispositif homologué de raccordement (cordon prolongateur 
téléphonique).
L’abonné ne doit pas oublier qu’il est possible que la conformité aux conditions énoncées ci-dessus n’empechent
pas la dégradation du service dans certaines situations. De fait, les entreprises de télécommunication ne 
permettent pas que l’on raccorde un matériel aux prises d’abonné, sauf dans les cas précis prévus par les tarifs 
particuliers de ces entreprises.
Les réparations de matériel homologué doivent être effectuées par un centre d’entretien canadien autorisé 
désigné par le fournisseur. La compagnie de télécommuncations peut demander à l’utilisateur de débrancher un 
appareil suite à des réparations ou des modiﬁcations effectuées par l’utilisateur ou à cause de mauvais 
fonctionnement.
Veuillez contacter le fournisseur suivant pour des informations supplémentaires :
Apple Canada, Inc.
7495 Birchmount Road
Markham, Ontario
Canada L3R 5G2
Apple Canada Customer Assistance Line: 800-263-3394
Warning  Users should not attempt to make such connections themselves, but should contact the appropriate 
electric inspection authority or electrician
m Load number: 0.3 The load number (LN) assigned to each terminal device denotes the percentage of the 
total load to be connected to the telephone loop that is used by the device, to prevent overloading. The 
termination of a loop may consist of any combination of devices, subject only to the requirement that the sum 
of the load numbers of all devices does not exceed 100.
m Telephone jack type:  CA-1110 Communications Regulation Information
Pour sa propre protection, I’utilisateur doit s’assurer que tous les ﬁls de mise à la terre du secteur, des lignes 
téléphoniques et les canalisations d’eau métalliques, s’il y en a, soient raccordés ensemble. Cette précaution est 
particulièrement importante dans les régions rurales.
Information You Need in the United Kingdom
This terminal equipment is intended for direct connection to the analogue Public Switched Telecommunications
Network and is approved for use within the United Kingdom with the following features:
m Modem facility
m Autocalling facility
m Autoanswer facility
m DTMF signaling
m Operation in the absence of proceed indication or upon detection of proceed indication
This product is in conformity with relevant regulatory standards following the provisions of European Council 
Directives 73/23/EEC (Low Voltage Directive) and 89/336/EEC amended by 92/31/EEC (EMC Directive).
Information You Need in Germany
Diese Modem-Karte ist als Endeinrichtung vorgesehen und muss an ein TAE mit F-Kodierung angeschlossen 
werden.
Diese Endeinrichtung ist in Konformität gemäss Niederspannungsrichtlinie 73 / 23 / EWG sowie EMC-Richtlinien
89 / 336 / EWG und 92 / 31 / EWG.
Information You Need in France
Ce matériel est conforme aux normes applicables de sécurité éléctrique d’après la directive 73 / 23 / CEE et aux 
normes applicables de comptabilité éléctromagnétique d’après la directive 89 / 336 / CEE, modiﬁé par la directive 
92 / 31 / CEE.
Avertissement  L’utilisateur ne doit pas tenter de faire ces raccordements lui-même; il doit avoir recours à un 
service d’inspection des installations électriques ou à un électricien, selon le cas.
m Numéro de charge : 0.3 L’indice de charge (IC) assigné à chaque dispositif terminal indique, pour éviter toute 
surcharge, le pourcentage de la charge totale qui sera raccordée à un circuit téléphonique bouclé utilisé par ce 
dispositif. La terminaison du circuit bouclé peut être constituée de n’importe quelle combinaison de dispositifs 
pourvu que la somme des indices de charge de l’ensemble des dispositifs ne dépasse pas 100.
m Type de prise téléphonique : CA-11Laser Information 11
Laser Information
Do not attempt to disassemble the cabinet containing the laser. The laser beam used in this product is harmful to 
the eyes. The use of optical instruments, such as magnifying lenses, with this product increases the potential 
hazard to your eyes. For your safety, have this equipment serviced only by an Apple-authorized service provider.
Your computer is a Class 1 laser product. The Class 1 label, located in a user-accessible area, indicates that the 
drive meets minimum safety requirements. A service warning label is located in a service-accessible area. The 
labels on your product may differ slightly from the ones shown here. 
High-Risk Activities Warning
This computer system is not intended for use in the operation of nuclear facilities, aircraft navigation or 
communications systems, or air trafﬁc control machines, or for any other uses where the failure of the computer 
system could lead to death, personal injury or severe environmental damage.
Warning  Making adjustments or performing procedures other than those speciﬁed in your equipment’s 
manual may result in hazardous radiation exposure.
Class 1 label Service warning label13
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1 Setting Up
Your Macintosh PowerBook has been designed so that you can set it up quickly and start 
using it right away. If you have never used a PowerBook or are new to Macintosh computers, 
read this chapter for an overview of PowerBook features and instructions on getting started. 
If you are an experienced user, you may already know enough to get started with your new 
PowerBook. Take a moment to look over the information in this manual to ﬁnd out about the 
new features of your Macintosh PowerBook.
Becoming Familiar With Your Macintosh PowerBook
Your PowerBook is designed to keep you working productively in any location. The 
information in this manual covers setting up, using, and expanding your PowerBook
hardware. With a PowerBook, you have
m easily conﬁgurable and expandable hardware.
m Mac OS system software along with software for connecting to the Internet.
m interactive online information and instructions for using the computer.
m a separate manual for troubleshooting, and system software reinstallation.
Hardware at a Glance
The illustrations on the next several pages show the built-in features of your computer,
including the expansion bays, PC Card slots, and the ports for connecting a printer, network, 
and other external equipment.14 Chapter 1
Your Computer’s Components and Controls
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Sleep indicator
Blinking green light indicates when the PowerBook is in sleep.
® Power button 
Turns your PowerBook on and off.
Microphone
Record sounds directly to your PowerBook hard disk with this built-in microphone.
¤ Brightness control
Increase or decrease the brightness of your PowerBook display.
Ï Volume control
Increase or decrease the volume of the sound coming from your built-in speakers and 
sound output port using this control.
— Mute button
Turn the sound off and on from the PowerBook external speakers and sound output port.
Trackpad
Move the pointer on the PowerBook display. The trackpad can also be set up so that you 
can double-click and select items directly instead of using the trackpad button.
Right expansion bay with a CD-ROM or DVD-ROM drive module inserted
Dual-function expansion bay that accepts either removable modules (3.5-inch or 5.25-inch 
size) or a PowerBook battery.
Ç Security slot
Protect your PowerBook by connecting a security cable.16 Chapter 1
Your Computer’s Ports and Connectors
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Infrared window
Allows you to use infrared (IR) communication to send ﬁles to another IR-equipped
computer or connect to a wireless IrDA network. 
g SCSI port (HDI-30) 
Connect up to seven external SCSI devices (such as external hard drives or scanners).
´ Printer/External modem port
Connect to printer, external modem, or LocalTalk network.
™ External monitor port
Connect to any external monitor with a VGA-style connector or to any Macintosh monitor 
using the included adapter.
Æ External TV out port 
Connect to any television, VCR, or other video device that supports S-Video, NTSC, or PAL
formats.
V ADB port
Connect a mouse, external keyboard, or other ADB device.
G Ethernet port (10Base-T)
Connect to a high-speed 10Base-T Ethernet network.
¯ Power adapter port
Connect the power adapter to your PowerBook. When connected, the power adapter 
provides power to your PowerBook and also charges the batteries inside the PowerBook.
PC Card slots
Expand the capabilities of your PowerBook using these two PC Card slots that support 
both PCMCIA and CardBus formats.
W Internal modem port (some models)
Connect a standard phone line directly to the optional internal modem. 
Left expansion bay with a PowerBook battery
Dual-function expansion bay that accepts either 3.5-inch removable modules or a 
PowerBook battery.
√ Sound input port
Connect an external line level microphone or other sound input device.
- Sound output port
Connect external speakers, headphones, or other sound output device.18 Chapter 1
Setting Up the Computer
Now that you know some essential details about your PowerBook, you’re ready to set it up 
and begin using it. Setting up your Macintosh PowerBook for the ﬁrst time is a quick and 
simple process. However, there are a few items that you need to have and things to do before 
you begin using your PowerBook.
Your PowerBook Battery
The battery that came with your PowerBook computer may be already inserted in an 
expansion bay. If not, you should insert it now so that it can be charged.
You can easily tell if the battery is already installed by looking at the left expansion bay. If you 
see an opening for a ﬂoppy disk, then the ﬂoppy disk drive module is installed and the 
battery is not installed. If you see a small button with four small lights to its right, the battery
is installed.
If Your PowerBook Did Not Come With the Battery Installed
If your PowerBook did not come with the battery inserted in the expansion bay, you should 
insert it in place of the ﬂoppy disk drive module in order to charge it. 
To remove the ﬂoppy disk drive module and insert the battery, follow these steps: 
1 Place your PowerBook on a hard ﬂat surface.
Important  Before following the setup instructions in this chapter, you may want to read 
“Arranging Your Work Area and Equipment” on page 87 for tips on adjusting your work 
furniture and computer so that you’re comfortable when using the computer.
PowerBook battery
PowerBook battery inserted
in the left expansion bay
Floppy disk drive module
inserted in the left expansion baySetting Up 19
2 Pull the left expansion bay release lever to partially eject the ﬂoppy disk drive module.
3 Slide the ﬂoppy disk drive module out of its compartment.
4 Gently slide the battery (with the battery name facing up) into the left expansion bay until 
the edge of the battery is ﬂush with the left side of the PowerBook.
Be sure the battery is completely inserted.
If Your PowerBook Came With the Battery Installed
New PowerBook computers that ship with a battery installed have a shipping label covering 
the battery to protect it from losing its charge completely. You need to remove the label 
before the battery will provide power for the computer.
1 With the display open, peel off the part of the shipping label on the computer’s case, taking 
care not to tear the label.
2 Pull the left expansion bay release lever to partially eject the battery.
3 Slide the battery out of its compartment. 
4 Carefully remove the shipping label from the battery.
Avoid touching the battery’s metal contacts as you peel off the label.
5 Replace the battery.
Wall St. User’s Manual
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Plugging In the Computer
Plugging in the power adapter recharges the computer’s battery. You should plug in the 
power adapter in case the battery has drained during shipping or storage.
When you are ready to begin, follow these steps: 
1 Plug one end of the power cord into the power adapter and the other end into an outlet or 
power strip.
2 Plug the power adapter plug into the power adapter port (marked with the icon ¯) on the 
back of the computer.
Warning  Use only the power adapter that came with your Macintosh PowerBook
computer. Adapters for other electronic devices (including other Macintosh PowerBook
models and other portable computers) may look similar, but they may damage your 
computer.
If your power adapter came equipped with a three-wire grounding plug—a plug that has a 
third (grounding) pin. This plug will ﬁt only a grounded AC outlet. If you are unable to 
insert the plug into the outlet because the outlet is not grounded, contact a licensed 
electrician to replace the outlet with a properly grounded outlet. Do not defeat the 
purpose of the grounding plug!
Power adapter plug
¯ Power adapter port
Power cord
Power adapterSetting Up 21
Opening the Display
1 Gently pull the display latch to release it.
2 Position the display at a comfortable viewing angle. 
You can adjust the angle of the display at any time by tilting it toward or away from you.22 Chapter 1
Turning the Computer On
To turn on the computer for the ﬁrst time, press the Power button (®) above the keyboard.
You should hear a tone when you turn on the computer. It takes the computer a few 
moments to start up. As the computer starts up, several messages appear on the screen, 
including an application to help you set up the Mac OS. 
Note: Certain system settings (such as sound volume, screen brightness, and AppleTalk
connection) may not be saved the ﬁrst time you set them if the battery has been completely 
discharged or has been out of the computer for three days or more. You will need to reset 
these system settings the second time you start up the computer.
® Power buttonSetting Up 23
Problems Turning the Computer On?
Nothing happened when you pressed the Power button.
m The battery may be drained. Make sure that you plugged in the power adapter, and that 
the power adapter is ﬁrmly connected to both the computer and a power source. If the 
power adapter is plugged into a power strip, make sure the power strip is plugged in and 
turned on. 
m If the computer doesn’t start up when you press the Power button, hold down the Shift,
Function (fn), and Control (ctrl) keys and then press the Power button (®). The Sleep 
indicator light glows brieﬂy while the computer goes through a reset process. After the 
power indicator light turns off, wait a few seconds and then press the Power button again 
to start up the computer. Once the battery has charged, you should be able to use the 
Power button normally.
m If the computer still doesn’t turn on, see the troubleshooting manual that came with your 
computer.
There is a slight delay after you press the power button before the computer 
starts up.
m Every time you press the power button, the PowerBook performs a check of the 
computer’s memory, causing a slight delay in startup. The more memory you have 
installed in the PowerBook, the longer the delay.
You see a picture of a disk with a blinking question mark on the screen.
m This icon usually means that the computer can’t ﬁnd system software on the hard disk or 
any disks attached to the computer. You may need to reinstall system software. See the 
troubleshooting manual that came with your computer.24 Chapter 1
Adjusting the Internal Display
Before you begin working with your new PowerBook, you may need to adjust your display so 
that items on the screen are easy to see. Your PowerBook comes with a control (labeled with 
the ¤ icon) that adjusts screen brightness.
m Use the brightness (¤) control to change the brightness of your display. 
If your display is too dark, press and hold the right side of the brightness control (labeled 
with the + icon) until items are easily visible on the screen. If your display is too bright, 
press and hold the left side of the brightness control (labeled with the – icon) until items 
are easily visible on the screen. 
Adjusting the Resolution of the Internal Display
You can increase the size of images on your built-in display by switching from the standard 
resolution to a scaled resolution. To do so, click the Resolution icon in the Control Strip. 
When you switch to a scaled resolution, items on the screen appear larger, making them 
easier to see. 
Note: Scaled resolutions may not appear as sharp as the standard display resolution.
¤ Brightness control
Resolution iconSetting Up 25
Moving Items on the Screen
You use your PowerBook trackpad to move items and select items on the screen. To move 
the arrow pointer on the screen, slide your ﬁnger across the trackpad. To select, click, or 
double-click an item on the screen, press the trackpad button.
The trackpad is sensitive to how fast you move your ﬁnger. To move the pointer a short 
distance across the screen, move your ﬁnger slowly across the trackpad. The faster you move 
your ﬁnger, the farther the pointer moves on the screen.
You can ﬁnd more information on setting up your PowerBook trackpad in the online help, 
available in the Help menu.
Trackpad Trackpad button
Tips for Using the Trackpad
For best results when using the trackpad, keep in mind these tips: 
m Use your index ﬁnger (left or right hand). Use only one ﬁnger.
m Use only your ﬁnger on the trackpad. Do not use a pen or any other object. 
m Keep your ﬁnger and the trackpad dry. If the trackpad becomes moist from 
humidity or condensation, gently wipe the trackpad with a clean cloth before you 
use it. 
m Never use any kind of cleaning solutions on your PowerBook trackpad.26 Chapter 1
Putting the Computer to Sleep
Sleep is a power conservation feature of Macintosh PowerBook computers that lets you 
quickly wake the computer and bypass the startup process. You can extend the period of 
time your battery will power the computer by putting the PowerBook to sleep when you 
won’t be using it for several minutes or more. The length of time the computer can be left in 
sleep depends on how much charge is left in the battery.
When the computer is in sleep, it has a darkened screen and appears to be off. A small green 
light ﬂashes on the case when the computer is in sleep.
To put the computer to sleep, follow these instructions:
1 Press the Power button (®).
The following dialog box appears.
2 Click the Sleep button.
You can also put your computer to sleep by doing one of the following: 
m closing the display
m choosing Sleep from the Special menu
m clicking the Energy Settings icon in the Control Strip and choosing Sleep Now from the 
menu that appears
3 To wake the computer, press the Power button (®) or any key on the keyboard (except for 
the fn key.)
The screen reappears as it was before the computer went to sleep.
Note: To decrease the time it takes for the computer to wake up from sleep, turn off 
AppleTalk. For more information, see the online help, available in the Help menu.
Warning  Once you put your computer to sleep, listen for the hard disk to stop spinning 
before you move your PowerBook. Moving your computer while the hard disk is spinning 
can damage your computer.
Energy Settings iconSetting Up 27
Problems Working With Computer Programs or the Mac OS
If software difﬁculties (such as a software error message on your screen) don’t allow you to 
use standard methods of quitting a program or restarting your computer, you can try using 
these special key combinations.
The reset key combination immediately turns off the computer. Then the sleep indicator 
light glows brieﬂy while the computer goes through the reset process. After the sleep 
indicator light turns off, wait a few seconds and then press the Power button again to start up 
the computer.
For more information on solving problems, see the troubleshooting manual that came with 
your computer.
To do this... ...press this key combination
Force a program to quit x-Option-Esc
Force the computer to restart x-Control–Power button
Force the computer to reset Shift-Fn-Control–Power button
Important  Only force the computer to reset if the other two key combinations are 
unsuccessful at solving your problem. When you force a reset, your computer’s default 
(original) settings will be restored. You may need to reconﬁgure settings for power 
management, memory, trackpad, TCP/IP, and AppleTalk if you reset the computer.28 Chapter 1
Turning the Computer Off
Always use one of the following methods to shut down the computer. If you don’t, you risk 
losing any work you haven’t saved. You also risk losing any open documents.
To turn the computer off, follow these instructions:
1 If the computer is in sleep, press the Power button (®) or any key on the keyboard (except 
for the fn key) to wake it.
2 Press the Power button.
The following dialog box appears: 
3 Press the Return key on the keyboard (or click the Shut Down button in the dialog box).
If any applications are still open, a message asks if you want to save your work before the 
computer shuts down.
Note: You can also turn off the computer by choosing Shut Down from the Special menu.
What’s Next
For more information about working with your computer’s hardware, refer to the following 
chapters in this manual: 
To learn more about the basics of your computer’s hardware, including the expansion bays, 
batteries and power, and connecting to a network, go to Chapter 2, “Using Your PowerBook
and Connecting to a Network.”
To learn how to connect additional equipment to your PowerBook, such as printers or 
external monitors, go to Chapter 3, “Connecting Additional Equipment.”
To learn how to install additional memory or remove your hard disk, go to Chapter 4,
“Installing a RAM Expansion Card and Removing Your Hard Disk.”29
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2 Using Your PowerBook and 
Connecting to a Network
This chapter provides information and instructions on using the built-in features of your 
Macintosh PowerBook such as expansion bays, batteries, and PC Card slots. In addition, this 
chapter describes connecting your PowerBook to a computer network and using your 
internal modem (available on certain conﬁgurations only).
The information in this chapter will help you get started using the features of your 
PowerBook. Many of these features, such as networking and infrared communication, require 
that you conﬁgure your system software or use speciﬁc applications. You can ﬁnd more 
information in the online help, available in the Help menu.
In this chapter you will ﬁnd information on using the following items: 
m expansion bays and expansion bay modules
m batteries and power management
m PC Card slots that support PCMCIA and CardBus formats
m infrared communication
m connecting to a local area network
m using your internal modem (available on certain PowerBook conﬁgurations)
For information on connecting additional equipment such as printers and external monitors, 
see Chapter 3, “Connecting Additional Equipment.”30 Chapter 2
Using the Expansion Bays
Your PowerBook comes with dual-function expansion bays that accept either expansion bay 
modules or PowerBook batteries. Expansion bay modules–such as a ﬂoppy disk drive, CDROM drive, or DVD-ROM drive–are removable, which allows you to easily switch or replace 
them with another module.
Dual-function expansion bays give you maximum ﬂexibility in setting up your PowerBook to 
meet your needs. For example, if you are working with your PowerBook at home or in the 
ofﬁce and you have the power adapter plugged in, you can have a ﬂoppy disk drive module 
in one expansion bay and a CD-ROM or DVD-ROM drive module in the other expansion bay.
If you are traveling on a long plane trip, you can have a battery in each expansion bay.
Using Expansion Bay Modules
Expansion bay modules and PowerBook batteries are inserted and removed in the same way.
You can switch expansion bay modules while the PowerBook is turned on, in sleep, or shut 
down. You should change batteries only when the PowerBook is shut down or in sleep 
(unless there is a charged battery in the other expansion bay). For more information on 
PowerBook batteries, see “Power Sources” on page 37.
If you purchase an expansion bay module from an independent supplier, be sure to follow 
the instructions that came with the device. Some modules may have special requirements.
Important  Only use expansion bay modules and batteries speciﬁcally designed for this 
PowerBook. Expansion bay modules and batteries from other PowerBook computers are 
not compatible.
Left expansion
bay
Right
expansion bay
Important  Don’t switch modules while the computer is starting up. Also take care not to 
remove a module if a ﬂoppy disk, CD-ROM disc, or other media is inserted (even if the 
computer is in sleep). If you remove a module (such as the CD-ROM drive) when a disc is 
inserted, you’ll see a message telling you to reinsert the module.Using Your PowerBook and Connecting to a Network 31
Removing an Expansion Bay Module
Before removing an expansion bay module from your PowerBook, you need to make sure 
that it is not in use and that it does not contain a ﬂoppy disk, CD, or other media. To remove 
an expansion bay module from your Macintosh PowerBook, follow these steps: 
1 Place your PowerBook on a hard ﬂat surface.
2 Click the Expansion Bay icon in the Control Strip to determine whether the expansion bay 
module is ready to be removed. 
If the Control Strip indicates that the expansion bay module is not removable, quit any 
application programs or ﬁles that may be using it. Then do one of the following: 
m Drag the icon of the ﬂoppy disk, CD, or other media that is inserted in the module to the 
Trash.
m Click the icon of the ﬂoppy disk, CD, or other media that is inserted in the module and 
choose Put Away from the File menu or choose Eject from the Special menu.
m Click the Expansion Bay icon in the Control Strip and choose Make Right Module 
Removable from the menu that appears.
Important  If you are going to remove both expansion bay modules at the same time, 
adjust your PowerBook display so that it is at a 90-degree angle to the computer. If the 
display is adjusted too far back, your PowerBook may tip backward when both expansion 
bays are empty.
90
o
Expansion Bay icon
Important  Do not remove an expansion bay module that is in use, or you may lose data. If 
you try to remove the module when it is in use, you’ll see a message telling you to 
reinsert it.32 Chapter 2
To be sure that the computer isn’t using the module, wait 5 seconds after quitting programs 
and ejecting a disk before you remove the module.
3 Pull the expansion bay release lever to eject the module.
When the lever is completely extended, the module will be partially out of the expansion bay.
4 Gently slide the expansion bay module out of the computer.
Important  If you see a message telling you to reinsert the module, the module is still in 
use. Reinsert the module and repeat step 2.Using Your PowerBook and Connecting to a Network 33
Inserting an Expansion Bay Module
The PowerBook battery and the optional ﬂoppy disk drive module can be placed in either 
expansion bay. The CD-ROM or DVD-ROM drive module (because of its larger size) can only 
be put in the right expansion bay.
To insert an expansion bay module, follow these steps: 
1 If the expansion bay that you want to use already has a module in place, remove it as 
described in the previous section.
2 Gently slide the module into the expansion bay until the edge of the module is ﬂush with the 
side of the PowerBook and you hear the module click into place.
Make sure that you insert the module with the label facing up.
Note: The right expansion bay can accept the wide 5.25-inch CD-ROM or DVD-ROM drive 
module or the narrower ﬂoppy disk drive module or PowerBook battery. When a narrower
device is in the expansion bay, a small ﬂap covers the empty part of the bay. When the wider 
CD-ROM or DVD-ROM drive module is inserted, the ﬂap folds into the bay.
Insert the module with
the label facing up.34 Chapter 2
Using a Disc in the CD-ROM or DVD-ROM Drive
Inserting a Disc
To load a disc in the drive, follow these steps: 
1 Make sure that the CD-ROM or DVD-ROM drive module is inserted into the right expansion 
bay.
2 Start up the PowerBook, if it’s not already on.
3 Press the Open button on the outside of the module to open its tray.
4 Pull the tray all the way open.
Open button
Drive spindle
Drive lens
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5 Place a disc in the tray, with the label facing up. 
Make sure the disc is lying ﬂat in the tray and is seated ﬁrmly on the spindle.
Note: CD-ROM and DVD-ROM drives have small locks on the drive spindle that securely 
hold the disc in place. When inserting a disc over these locks, you may need to apply 
additional pressure. Place the hole in the center of the disc directly over the drive spindle 
and press down until you feel the disc lock into place.
6 Push the tray in to close it.
Keep the tray closed except when loading discs. This prevents dust from getting inside the 
mechanism. Be sure to keep discs free of dust and grease.
Note: When the drive is in use, you may notice some vibration as the disc spins rapidly.
Certain discs can cause the drive to vibrate because they have heavily inked artwork or a label 
that creates an imbalance as the drive spins. Some vibration is not unusual for a high-speed 
CD-ROM or DVD-ROM drive. To minimize vibration from unbalanced discs, do not put labels 
on your discs. In addition, place the computer on a ﬂat, solid surface when using the drive.
Insert the disc,
label side up.36 Chapter 2
Ejecting a Disc
Follow these instructions to open the tray and eject a disc from the drive: 
1 Open the tray.
There are several ways to open the tray of your drive.
If a disc icon appears on your screen, do one of the following:
m Select the disc icon on your screen and drag the icon to the Trash.
m Click the disc icon and choose Put Away from the File menu or Eject from the Special 
menu.
m Click the Expansion Bay icon in the Control Strip and choose Make Right Module 
Removable from the pop-up menu that appears.
If no disc icon appears on your screen, do this:
m Press the Open button on your drive.
If you can’t eject a disc, try this method:
m If the standard methods of ejecting a disc do not work (or the computer is shut down), 
you can eject the disc manually. Carefully insert the end of a pen or straightened paper 
clip into the small recessed button next to the eject button, and push ﬁrmly until the tray 
disengages.
2 Take the disc out of the tray.
Store your discs in a safe place, away from heat, dust, and moisture.
3 Push the tray in to close it.
To avoid possible damage to the tray or the drive, keep the tray closed when you are not 
using it.
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Power Sources
Your computer can draw its operating power either from a PowerBook battery in one of the 
expansion bays or from an external power source, using the external power adapter that 
came with your computer.
AC Power
You can run your computer from an electrical outlet by plugging in the external power 
adapter that came with your computer. A battery in an expansion bay will automatically be 
charged whenever the external power adapter is plugged in.
Main Battery
The main lithium ion (LiIon) battery provides power to your computer when it is not 
plugged into an electrical outlet. 
This battery should provide power for 2–3.5 hours of work time (you may get longer work 
time, depending on the Macintosh PowerBook model you have and the battery conservation
features you use). You can ﬁnd more information about the battery and power conservation
software that came with your PowerBook in the online help, available in the Help menu. 
Note: The LiIon battery is charged whenever the external power adapter is connected. 
However, the adapter will charge the battery more quickly if the computer is shut down or in 
sleep.
Optional Second Battery
You can conﬁgure your computer with a battery in each expansion bay. This conﬁguration is 
especially useful when you need to use your PowerBook under battery power for a long 
amount of time, such as on a long plane ﬂight. You can purchase a second battery from an 
Apple-authorized dealer.
Note: When fully charged batteries are installed in both expansion bays, the batteries are 
discharged one at a time. The battery in the left expansion bay is discharged ﬁrst. When the 
charge in the left battery is depleted, the PowerBook switches to the battery in the right 
expansion bay.
Important  Be sure to use only the external power adapter that came with your computer 
or one made speciﬁcally for this PowerBook model.38 Chapter 2
Recharging the Battery
To recharge the battery inside the computer, plug in the external power adapter. You may 
also use an external battery charger designed speciﬁcally for your Macintosh PowerBook
model (available from other manufacturers).
When the AC adapter is plugged in, the LiIon battery is recharged whether the computer is 
off, on, or in sleep. However, the battery will recharge more quickly if the computer is off or 
in sleep.
Monitoring the Battery Charge
There are four ways you can determine the charge level of your battery:
m Look in the Battery Monitor portion of the Control Strip.
m See low-power messages on your display.
m Look at the battery level icon next to the clock in the menu bar.
m Look at the battery indicator level lights on the battery.
Power adapter plug
¯ Power adapter port
Power cord
Power adapter
Warning  Use only the external power adapter that came with your computer. Adapters 
for other electronic devices (including other portable computers) may look similar, but 
they may damage your computer.
If your power adapter came equipped with a three-wire grounding plug—a plug that has a 
third (grounding) pin—this plug will ﬁt only a grounded AC outlet. If you are unable to 
insert the plug into the outlet because the outlet is not grounded, contact a licensed 
electrician to replace the outlet with a properly grounded outlet. Do not defeat the 
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Using the Battery Level Indicator Lights
You can tell the charge left in your battery by looking at the battery level indicator lights on 
the battery itself. The charge can be checked with the battery inserted or outside the 
PowerBook.
Push the battery level indicator button to activate the battery level indicator 
lights.
The lights show how much charge is left in the battery. A lighted square indicates that the 
battery has power; an unlighted square indicates lack of charge. The indicator lights remain 
lit for a few seconds.
Note: The battery level indicator lights stay on while the battery is being charged by the 
external power adapter. When the battery is fully charged, the lights turn off.
Responding to Low-Power Messages
When the battery runs low, the computer displays a series of low-power messages. The work 
time remaining after you see the ﬁrst message varies depending on how you are using the 
computer. It’s a good idea to act promptly.
What You Should Do
When you see a low-power message, you should do one of the following: 
m Plug in the external power adapter.
m Save your work and shut down the computer.
m Put the computer to sleep, and quickly replace the depleted battery with a charged one.
What You Should Know
When the ﬁrst low-power message appears, the screen dims automatically to save power. If 
you continue to work without plugging in the power adapter or changing the battery, the 
computer displays a second low-power message indicating that the computer is about to put 
itself to sleep. Within a few seconds, the computer goes to sleep automatically to protect the 
contents of RAM. All activities are interrupted. It’s a good idea to save your work when you 
see the ﬁrst of the two low-power messages to make sure you don’t lose information.
Fully charged
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If you continue working until the computer goes to sleep automatically, you can wake it 
again as soon as you plug in the power adapter or replace the battery with a charged battery.
Maximizing Work Time
The amount of work time your PowerBook’s battery can provide before you need to 
recharge depends on the equipment you’re using with your computer and the steps you take
to conserve power while you work.
Battery-saving measures include the following (in order of effectiveness): 
m Make sure that power cycling is turned on.
Your PowerBook reduces the processor power when it is not being used in order to save 
battery power. For instructions on setting up power cycling, see the online help, available 
in the Help menu.
m Set your PowerBook to run in a reduced processor speed mode when performing tasks 
such as word processing that don’t require fast processing speed.
Setting your PowerBook to run in a reduced processor mode will provide additional 
battery savings but may affect system performance. For instructions, see the online help, 
available in the Help menu.
m Remove CD-ROM and DVD-ROM discs when they are not in use.
m Set the hard disk to spin down after a short time interval.
m Set your PowerBook display to turn off (instead of dim) when not in use.
m Reduce screen brightness using the brightness control (¤) on the PowerBook case.
m Set your PowerBook to sleep after inactivity of 5 minutes or less.
m Take advantage of the sleep feature of your PowerBook whenever your work is 
interrupted. You just need to close the display to put the computer in sleep.
You can ﬁnd more information on the power conservation software and battery
conservation tips in the online help, available in the Help menu.
Note: If your PowerBook came with an internal modem, it does not support the Energy
Saver feature “Wake up when the modem detects a ring.”
Important  Recharge a depleted battery as soon as possible. Leaving a depleted battery in 
the computer for a length of time (especially in a hot location, such as the trunk of a car) 
may damage the battery so that it can’t be recharged. If this happens, you need to replace 
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Removing or Replacing the Battery
PowerBook batteries are removed in the same way that expansion bay modules are. To
remove or replace the battery, follow these steps: 
1 Place your PowerBook on a hard, ﬂat surface.
2 Save your work and then shut down the computer, put it to sleep, or plug in the power 
adapter.
3 Pull the expansion bay release lever to eject the PowerBook battery.
4 Gently slide the battery out of the expansion bay.
5 Push the charged battery into the expansion bay to lock it into place. 
It’s a good idea to plug in the power adapter in case the battery is not fully charged.
Important  Batteries contain chemicals, some of which may be harmful to the 
environment. Please dispose of used batteries according to your local environmental 
guidelines.
Lithium-ion
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Using PC Cards
PC Cards (also known as PCMCIA or CardBus cards) are about the size of a thick credit card 
and have a 68-pin connector at one end. They come in many varieties, such as fax/modem 
cards, mass-storage cards, Ethernet connection cards, zoomed video cards, and wireless 
communication cards. You can use PC Cards to expand your Macintosh PowerBook’s
capabilities.
Your Macintosh PowerBook has two PC Card slots. You can insert a card into either slot, or 
(depending on the cards you’re using) you can use both slots simultaneously.
There are three types of PC Cards. The different types refer to the thickness of the card. A 
Type I card is 3.3 millimeters (mm) thick, a Type II card is 5 mm thick, and a Type III card is 
10.5 mm thick.
You can place a Type I or Type II card in either slot. You can place a Type III card only in the 
lower slot. When a Type III card is installed, you cannot use the upper slot. You may ﬁnd it 
useful to get in the habit of always using the lower slot ﬁrst to make sure the card is properly 
inserted.
A special type of PC Card supports “zoomed video,” which can display full-motion video in a 
window on the computer’s screen.
Note: Zoomed video cards must be placed in the lower PC Card slot.
This section describes how to insert and eject PC Cards and how to use PC Card modems. 
You can ﬁnd more information on using PC Cards in the online help, available in the Help 
menu.
Warning  Make sure only to use cards that are compatible with your Macintosh 
PowerBook. If you use an incompatible card, you may damage the card or your 
PowerBook. If you are not sure whether a PC Card is compatible with your PowerBook,
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Inserting a PC Card
To insert a card, do this: 
m Insert the card, label up, into the slot. Make sure the card is level.
You’ll feel some resistance as you slide the card in. When the card is ﬁrmly seated, you will 
feel it click into place.
An icon for the PC Card appears on the desktop.
You are now ready to use the card.
Consult the card’s documentation for details of its use.
A Type I or Type II PC Card
can be inserted in either
the upper or lower slot.
A Type III PC Card must
be inserted in the lower slot.44 Chapter 2
Ejecting a PC Card
You can eject a PC Card when your computer is on or off. You cannot eject a PC Card when 
the computer is in sleep. 
To eject a PC Card when the computer is on, follow these steps: 
1 If the computer is in sleep, press the Power button (®) to wake it.
2 Make sure that nothing is blocking the card slot.
3 Click the PC Card’s icon to select it.
4 Drag the card’s icon to the Trash to eject it from the card slot.
The card will partially eject from the card slot.
5 Pull the card out of the slot.
If you want to use the card again immediately, pull it out about an inch more, wait 10 
seconds, and then push it back in. 
You can also eject a PC Card by doing the following: 
m Click the card’s icon to select it. Then choose Put Away from the File menu or Eject from 
the Special menu. After the card is ejected, pull it out of the slot. (If a dimmed icon of the 
card remains on the desktop, drag it to the Trash.)
m Press the eject button for the slot containing the PC Card you want to eject. If the card is 
not in use, it will usually be ejected.
Warning  Do not force a PC Card out of the slot. Doing so may damage your computer 
or PC Card.
Important  Try to use the eject buttons only when the computer is turned off. Many PC 
Cards won’t eject this way if the computer is on.
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If You Can’t Eject a Card
If you are unable to eject a card, follow these steps: 
1 Shut down the PowerBook.
2 Straighten one end of a paper clip.
3 Insert the end of the straightened paper clip into the hole next to the slot that contains the 
card, and press gently but ﬁrmly until the card is ejected.
4 Pull the card out of the slot.
Using a Zoomed Video PC Card
The lower PC Card slot has circuitry for handling video signals, called “zoomed video.” You
can purchase PC Cards to which you can provide a video signal from a video camera, VCR, or 
other such device. The zoomed video card can only be used in the lower slot.
With a zoomed video card installed, the PowerBook can display video on the computer’s
screen or on an external monitor while performing other tasks at the same time. 
If you purchase a zoomed video PC Card, be sure it has software that works with your 
PowerBook.
If you can’t eject a card, insert
the end of a straightened paper
clip into the hole next to the slot.
This hole is for the upper slot. 46 Chapter 2
Using a PC Card Modem
If your PowerBook does not come with a built-in modem, you can purchase a PC Card 
modem. For information on using your built-in modem, see the section “Using Your
PowerBook’s Optional Internal Modem” on page 51. If you are using a PC Card modem, 
make sure you do the following: 
1 Install the communications software you want to use and any software that came with your 
modem.
2 Insert the PC Card modem.
A PC Card modem icon appears on the desktop.
3 Plug your modem into a working phone line.
4 To set up and connect, follow the instructions that came with your modem and 
communications software.
If you are having problems setting up your PC Card modem, try the following: 
m Make sure to choose your PC Card modem in your communications software.
Some modem ﬁles come with your PowerBook. If your PC Card modem is not listed, 
check the software that came with your modem. If you ﬁnd the ﬁle for your modem, drag 
it to the Modem Scripts folder inside the Extensions folder (which is in the System 
Folder).
If you can’t ﬁnd the ﬁle for your modem, try using the modem ﬁle for a different model 
from the same manufacturer. If this doesn’t help, you may be able to get the correct
modem ﬁle from your PC Card modem’s manufacturer.
m Make sure to choose the port for your PC Card modem.
The port shows the modem name or type, rather than the name of the PC Card slot. 
Some programs use a virtual port, the Data Port, to allow fax and data applications to 
share the modem. See the instructions that came with your modem and communications 
software to determine the speciﬁc setup procedure.
You must reselect the port if you remove the modem and later put it in the other slot.Using Your PowerBook and Connecting to a Network 47
Using the Infrared File Transfer Capability
Your PowerBook comes with built-in infrared (IR) communication features that let you send 
and receive data without wires. 
With IR communications, you can exchange ﬁles with another PowerBook or with a desktop 
Macintosh using an external IR module. You can also use IR to make a wireless connection to 
a network by means of a specialized local area network (LAN) access device that is 
compatible with the Infrared Data Association (IrDA) Standard speciﬁcations.
To transfer ﬁles, your computer and the other IR device must be within range of each other 
with their IR windows facing. The range depends on the devices and the method of 
communication.
Note: For best results, place the IR windows directly facing each other. If the angle between 
the windows is greater than 10 degrees, an IR connection may not be possible. 
IR-equipped PowerBook computers must be within 3 feet of each other to exchange ﬁles
using the IRTalk transfer protocol (at 230 kilobits per second). Your computer must be within 
3 feet of a LAN access device or another IrDA PowerBook to make a connection (at a 
communications rate of up to 4 megabits per second).
For information on setting up your software for IR communication, see the online help, 
available in the Help menu.
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Connecting to a Local Area Network
Your computer has built-in hardware allowing you to connect to the following types of 
networks:
m LocalTalk: To connect to a Local Talk network, you plug a LocalTalk cable to the printer/
external modem port (´) on the back of the PowerBook.
m Ethernet: To connect to a high-speed Ethernet network, you plug an Ethernet cable into 
the Ethernet port (G) on the back of the PowerBook.
Once your computer is connected to a network, see the online help, available in the Help 
menu, for information about printing to a network printer, accessing information on ﬁle
servers, and sharing ﬁles on your computer with other users. Ask your network administrator 
for information about network services such as Internet access and electronic mail.
Connecting to a LocalTalk Network
To connect your Macintosh PowerBook to a LocalTalk network, you need LocalTalk cables 
and a LocalTalk adapter (available from your Apple-authorized dealer). If a network 
administrator is responsible for network maintenance and upkeep at your location, ask for 
help connecting your computer to the network.
To connect your Macintosh to a LocalTalk network, do the following: 
1 Open the cover on the computer’s back panel to access the printer/external modem port 
(labeled with the ´ icon). 
2 Attach the LocalTalk adapter to the printer/external modem port.
´Printer/External
               modem port
-
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3 Attach a network cable between the LocalTalk adapter connected to your computer and a 
LocalTalk adapter on your existing network.
4 If you are using a LocalTalk adapter with RJ-11 (telephone) connectors, connect a terminator
to the unused RJ-11 connector on the LocalTalk adapter. A LocalTalk adapter with DIN-8 
connectors doesn’t require an external terminator. (For more information on terminators,
see the instructions that came with the Apple LocalTalk RJ-11 Connector Kit.)
See “Conﬁguring Your Network Connection” on page 50 for information on conﬁguring your 
LocalTalk connection.
-
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Connecting to a 10Base-T Ethernet Network
The built-in Ethernet capabilities of your Macintosh PowerBook allow you to connect to a 
standard (10 Mbit) Ethernet network. If a network administrator is responsible for network 
maintenance and upkeep at your location, ask for help connecting your computer to the 
network.
To connect your Macintosh PowerBook to an Ethernet network, use the Ethernet cable that 
came with your computer. (The connector on the cable looks like a standard telephone 
connector, but it is wider.)
To connect your PowerBook to an Ethernet network: 
1 Open the cover on the computer’s back panel to access your Ethernet connector (labeled 
with a G icon). 
2 Locate a modular Ethernet cable and connect one end of the cable to the network.
3 Connect the free end of the Ethernet cable to the Ethernet port.
4 Set up your PowerBook software to use Ethernet communication.
Configuring Your Network Connection
After you physically connect your computer to a network, you need to conﬁgure the software
for your network connection using AppleTalk and/or TCP/IP. You can ﬁnd more information
in the online help, available in the Help menu.
G Ethernet port
-
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Using Your PowerBook’s Optional Internal Modem
Some models of the Macintosh PowerBook come with an internal modem card installed in 
the communications slot inside your computer. To see if a modem is installed, open the 
modem panel on the left side of the computer. If you see a connector for a phone line, then 
the modem is installed.
Setting Up Your Modem’s Connections
To use the internal modem, you need the following:
m the single-line telephone cord supplied with your PowerBook, which has a standard RJ-11 
phone connector at each end
m an analog telephone line (the type found in most homes) with a modular jack 
You can ﬁnd more information on setting up your modem communication software to 
work with your PowerBook internal modem in the online help, available in the Help 
menu.
Connecting the Telephone Line to the Modem
Follow these steps to connect the telephone line to the modem.
1 Open the cover on the left side of the computer to expose the modem telephone line 
connector.
2 Locate the telephone cord that came with your PowerBook.
Phone line
connector
Modem panel
Important  Use the telephone cord that came with your computer or an equivalent 
single-line telephone cord. Other types of telephone cords may not work correctly with the 
modem.52 Chapter 2
3 Plug one end of the telephone cord into the internal modem port on your PowerBook.
4 Plug the other end of the telephone cord into your telephone wall socket.
Once the telephone line is connected, you are ready to begin using the modem.
Warning  The telephone line must be an analog line—the type used in residences. Do 
not connect a digital telephone line to the modem, because the wrong type of line could 
damage the modem.
Important  When you have established a modem connection with another computer or an 
online service, do not put the computer to sleep. Doing so will disconnect the modem.Using Your PowerBook and Connecting to a Network 53
What Modems Do
A modem allows your computer to communicate over telephone lines by converting 
information from the digital format used by the computer to the analog format used by most 
telephone systems. It dials the telephone number, establishes a connection with another 
modem, and controls the ﬂow of data so that communication takes place with optimal speed 
and accuracy.
To exchange data over a telephone line, your modem and the remote modem must establish 
a connection and agree on how data will be transmitted in these ways: 
m Connection speed:  Initially, your modem tries to connect at its fastest speed. If the 
remote modem cannot connect at this speed, your modem tries to use the next highest 
speed. The two modems continue this fallback process until they ﬁnd the highest speed 
supported by both.
There are several circumstances that may prevent your modem from communicating at its 
fastest speed. For example, the telephone number you use to connect to your ISP may 
not support the fastest speed of your modem.
m Error control:  Error control ensures data accuracy. Your modem and the remote modem 
must agree on an error control method. Your modem will try to use one of the methods it 
supports. If the remote modem doesn’t support any of these methods, error control isn’t
used. Modems can still communicate reliably without error control.
m Data compression:  Compression increases the speed of data transmission by up to four 
times. Your modem will try to use one of the data compression methods it supports. If 
the remote modem doesn’t support any of these methods, data compression isn’t used. 
Modems can still communicate reliably without data compression.
Your modem is set up to make the best possible connection with other modems 
automatically. You do not need to do anything.
Software for Your Modem
Your Macintosh PowerBook comes with modem software, including programs to connect to 
the Internet and to send and receive faxes. Some of this software is already installed for you. 
Other software, such as your fax software, needs to be installed from a separate CD that came 
with your computer. For instructions on using these programs, see their electronic manuals 
on your computer’s hard disk or on the CD that came with your computer.
Important  The actual speed of data transmission can vary with line conditions. Because 
Federal Communications Commission (FCC) rules restrict the power output of modems 
used by service providers, transmission speeds are limited to 53 Kbps (53,000 bits per 
second) in the United States. You can obtain speeds of 53 Kbps on downloads from an 
Internet service provider (ISP) that uses K56ﬂex modems.54 Chapter 2
Choosing the Port Setting
You must specify the modem port in each communications program before you can connect 
to another computer by modem. 
The following example shows how to specify the modem port in America Online (AOL) 
software.
1 Open AOL (on your hard disk).
2 If you are new to America Online, click Continue in the dialog box that appears. If you have 
an AOL account already, click Upgrade.
3 Follow the instructions on the screen to set up an AOL account or to upgrade your current
AOL account.
When you ﬁnish setting up your AOL account, the AOL Welcome window appears.
4 Click Setup in the Welcome window.
The Location window opens.
5 In the Port pop-up menu, choose Internal Modem.
6 In the Type pop-up menu, choose PowerBook/GV Internal 56.
7 In the Speed pop-up menu, choose 57600 bps.
Always choose the highest speed available. This is the speed at which the computer 
communicates with the modem.
8 Click Save.
Now the AOL software is ready to use with your modem.Using Your PowerBook and Connecting to a Network 55
Modem Tips and Troubleshooting
If you have problems using your modem, try the following suggestions: 
m Make sure the telephone cord is connected properly. Unplug the telephone cord and 
reconnect it to ensure a good connection. You may also want to try a different telephone 
cord.
Note: Your PowerBook internal modem does not support the Energy Saver feature 
“Wake up when the modem detects a ring.”
m Make sure the telephone line you are using is working.
Connect a telephone to the line. You should hear a dial tone when you lift the receiver.
Listen for noise on the line. If the telephone line quality is poor, your modem may have 
trouble maintaining a connection or sending and receiving faxes. If you have a problem 
with the line quality, try connecting again. If the problem persists, you may need to 
contact your telephone service provider.
Important  The PowerBook internal modem will not work with party lines, cannot be 
connected to a coin-operated telephone, and may not work with a private branch exchange 
(PBX).57
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3 Connecting Additional Equipment
The illustration below shows where equipment should be connected to your Macintosh 
PowerBook. In most cases, you should refer to the documentation that came with your 
equipment for instructions on connecting. The safest course is always to shut down your 
Macintosh PowerBook before you connect any cable other than the power adapter. However,
you can connect external devices to the sound input port (√), sound output port (-),
printer/external modem port (´), Apple Desktop Bus port (V), and Ethernet port (G)
while the computer is on.
Information is provided in this chapter for connecting the following devices: 
m printers and external modems
m SCSI devices
m external monitors and video display devices
m sound input and output devices
m mouse, keyboard, or other ADB devices
m security equipment to protect your PowerBook
External TV
out port 
™ External
         monitor port
Internal modem
Infrared port (some models)
- Sound output port
¯ Power adapter port V Apple Desktop Bus
     (ADB) port
√ Sound input port
´Printer/external
               modem port
g SCSI port
      (HDI-30)
Ethernet port
(10Base-T)
G
Æ W
-
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Connecting a Printer
Your PowerBook has a printer/external modem port, which you use to connect a printer.
The printer/external modem port can accept either a direct connection (to a printer such as 
a StyleWriter) or a LocalTalk network connection (to a printer such as a LaserWriter). See the 
documentation that came with your printer for speciﬁc information about the type of 
connection it requires. Your computer comes with most Apple printer software (called 
“printer drivers”) already installed. If you are using a printer from a manufacturer other than 
Apple, you may need to install a printer driver.
You use the Chooser to tell the computer which port you used to connect your printer. You
can ﬁnd more information on selecting a printer in the online help, available in the Help 
menu.
Connecting an External Modem
Your PowerBook provides several different ways to connect to the rest of the world using a 
modem. If your PowerBook came with the optional built-in modem, see “Using Your
PowerBook’s Optional Internal Modem” on page 51. If your PowerBook did not come with 
an internal modem, you can use a PC Card modem in your computer’s PC Card slot (see 
“Using a PC Card Modem” on page 46). You can also connect an external modem to the 
printer/external modem port on the back panel of the computer.
To connect an external modem, follow these steps: 
1 Connect the modem to a power source and to the phone line.
2 Make sure the modem is turned off.
3 With the computer shut down, connect the modem cable to the printer/external modem 
port (´).
4 Turn on the modem.
5 Start up the computer.
The external modem is ready to use.
´Printer/External
               modem port
-
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Connecting SCSI Devices
You can attach up to seven SCSI devices, including hard disk drives, CD-ROM drives, and 
scanners, to your computer by linking them together in a chain that starts at your computer’s
SCSI port.
To connect a SCSI device to your Macintosh PowerBook, you need an Apple HDI-30 SCSI
System Cable or equivalent. This cable is light gray, is about 19 inches long, and has 29 pins 
(one “missing” pin) on the end that connects to the PowerBook.
Refer to the manuals that came with your SCSI devices for instructions on installing any 
necessary software, setting SCSI ID numbers, and connecting SCSI cables and SCSI
terminators. The illustrations on the next page brieﬂy describe the proper positioning of 
SCSI terminators. A SCSI chain of devices must include a terminator on the ﬁrst and last 
devices in the chain (but nowhere else in the chain). Some devices include internal
terminators. Your Macintosh PowerBook is internally terminated.
The names and the part numbers of the cables mentioned in this chapter are as follows: 
Where to add cable terminators when connecting a single SCSI device
Type of Connection Name of Part Part Number
From your computer to a SCSI device Apple HDI-30 SCSI System 
Cable
M2538**/A
From SCSI device to SCSI device Apple SCSI Peripheral
Interface Cable
M0207
For SCSI disk mode Apple HDI-30 SCSI Disk 
Adapter Cable
M2539**/A
Warning  When connecting SCSI equipment, always turn off power to all devices in the 
chain, including your computer. If you don’t, you could lose information and damage your 
equipment.
Terminator
(If this SCSI device has an internal
terminator, omit this external terminator.)
HDI-30 SCSI system cable60 Chapter 3
Where to add cable terminators when connecting two or more SCSI devices
Using Your Macintosh PowerBook as a Hard Disk
The Apple HDI-30 SCSI Disk Adapter lets you connect your Macintosh PowerBook to another 
computer as a hard disk. The PowerBook internal drive appears on the desktop of the other 
computer as a hard disk icon, and you can transfer information between the computers by 
dragging ﬁles. This feature is called SCSI disk mode.
The Apple HDI-30 SCSI Disk Adapter cable is dark gray, is about 10 inches long, and has 30 
pins.
Connecting Your Computer as a Hard Disk
Before making any connections, you need to assign a unique SCSI ID number to the 
PowerBook. (The ID numbers allow the computer to communicate with several connected 
SCSI devices.)
1 Set up your system software to use your PowerBook in SCSI disk mode.
For information and instructions, see the online help, available in the Help menu. 
If you are connecting the PowerBook to an existing SCSI chain, make sure to give it an ID 
number different from those of the other devices. (Many devices include an ID number 
indicator on the back panel.)
2 Shut down the PowerBook and plug in the power adapter.
HDI-30 SCSI SCSI peripheral interface cables
system cable
Terminator
(If this SCSI device has an
internal terminator, omit
this external terminator.)
Important  Your Macintosh PowerBook hard disk uses Mac OS Extended format (also 
known as HFS Plus). In order to use your PowerBook in SCSI disk mode, the computer you 
are connecting to must be using Mac OS 8.1 or later. If the computer is using an earlier 
version of system software, you will not be able to see the ﬁles on your PowerBook hard 
disk.
Important  Turn off password protection before using SCSI disk mode. For instructions,
see the online help, available in the Help menu.Connecting Additional Equipment 61
3 Shut down the computer you are connecting to and turn off any other devices in the SCSI
chain.
4 Connect the small end of the Apple HDI-30 SCSI Disk Adapter to the SCSI port on your 
PowerBook.
5 If you are connecting the Macintosh PowerBook directly to the other computer (rather than 
to an external device in the SCSI chain), attach a SCSI system cable to the other computer.
6 Connect the large end of the Apple HDI-30 SCSI Disk Adapter cable to a SCSI peripheral 
interface cable attached to the SCSI port on the last device in the SCSI chain, or to the SCSI
system cable on the other computer.
7 Make sure that your PowerBook display is open.
8 Turn on the PowerBook by pressing the Power button (®). After a few seconds a SCSI icon 
appears on the screen, showing the ID number you assigned in step 1.
9 Turn on the other SCSI devices in the chain, if any.
10 Turn on the other computer.
Warning  Always shut down the PowerBook before connecting or disconnecting the 
SCSI disk adapter cable. Connecting the adapter cable while the computer is turned on 
can damage the computer.
Warning  Always keep your PowerBook display open while operating in SCSI disk mode 
because heat from the PowerBook is partially dissipated through the keyboard. Closing 
your display may cause the PowerBook to function improperly.
Warning  If you do not see the SCSI icon, and the computer starts up normally or 
displays an error message, press the Power button (®) to shut down (if you can) and 
then immediately disconnect your computer from the SCSI chain. (If you can’t choose 
Shut Down, try resetting your PowerBook by holding down the Shift, Function (fn), and 
Control (ctrl) keys and then pressing the Power button. If you cannot shut down your 
PowerBook, you should disconnect the cable anyway, or you may lose information.) Then 
go back and repeat steps 4 through 8, making sure to use the proper cables.62 Chapter 3
The PowerBook’s internal drive appears as a hard disk icon on the screen of the computer 
you connected it to. You can now transfer and use ﬁles as if the Macintosh PowerBook were 
an external disk drive.
Quitting SCSI Disk Mode
1 Shut down the computer your PowerBook is connected to.
2 Press the Power button (®) on the PowerBook.
3 Turn off any other SCSI devices in the chain.
4 Disconnect the PowerBook from the adapter cable.
5 If necessary, disconnect the adapter cable from the other computer or its SCSI chain.
You can leave the adapter cable attached if you wish.
Your equipment is now ready for normal use. If you disconnected the adapter cable from the 
other computer or SCSI chain, make sure that the SCSI chain is properly terminated.
Important  Do not leave the adapter cable attached to the PowerBook. If you do, the 
computer will behave as though it is still in SCSI disk mode when you try to restart.Connecting Additional Equipment 63
Using an External Monitor
You can connect an external monitor to your Macintosh PowerBook. The types of monitors 
you can use with this model and the way images are displayed on an external monitor differ 
somewhat from the features available with other PowerBook computers.
To make the best choice of an external monitor, keep the following in mind: 
m Your PowerBook can support a variety of external monitors, including 17-inch and 20-inch 
multiple-scan displays. 
m Your PowerBook display must be open when you use an external monitor because heat 
from the PowerBook is partially dissipated through the keyboard. Closing the display will 
cause the PowerBook to go to sleep. Macintosh PowerBook G3 Series computers do not 
work with the display closed.
m The computer’s back panel has a VGA-style connector. You can connect the cable for a 
VGA-style monitor directly to your PowerBook.
m To connect an Apple-compatible monitor to your PowerBook, you must use the video 
adapter that came with the computer.
m Images can appear on the internal display, the external monitor, or both, depending on 
your choice of resolution on the external monitor.
m When an image appears on both screens, it is exactly the same (this feature is known as 
“simulscan” or “video mirroring”). You cannot move the pointer or menu bar from one 
screen to the other (as you can when a second display is connected to most Macintosh 
desktop computers).
m When an external monitor offers the same resolution as the PowerBook’s internal display,
the image appears on both screens the ﬁrst time you turn on the computer.
m If a multiple-resolution external monitor provides a list of its capabilities, the list appears 
in the Control Strip. Otherwise the system uses a resolution of 640 x 480 pixels as the 
default for that monitor.
For more information on adjusting the resolution of an external monitor, see the online 
help, available in the Help menu.
Important  Video mirroring works only with the PowerBook display’s standard resolution.
For example, when the 12.1" display is set to its standard resolution (800 x 600) or the 
14.1" display is set to its standard resolution (1024 x 768), the display can mirror the 
external monitor. However, if you switch the resolution to 640 x 480, the built-in display 
will go dark because scaled resolutions cannot be used for video mirroring.64 Chapter 3
Connecting an External Monitor
To connect an external monitor to your PowerBook, follow these steps. Also consult the 
documentation that came with the monitor.
1 Press the Power button (®) once to get the Shut Down dialog box.
2 Click Shut Down or Sleep.
If you connect a monitor with your computer turned on, the computer will not recognize the 
monitor.
3 Place the monitor near the PowerBook.
Arrange the monitor so the top of the screen is slightly below eye level while you work. 
Position the monitor to minimize glare and reﬂections on the screen from lights and 
windows.
4 Make sure that the PowerBook display is open.
5 Make sure the monitor’s power cord is attached to the monitor. Plug the other end into a 
grounded outlet or power strip.
If your monitor’s power cord is designed to plug into the power receptacle on the back of a 
computer, you can obtain a cord with the correct plug from your Apple-authorized dealer.
If you are using a power strip, make sure it is turned on.
6 If you are connecting an Apple-compatible monitor, attach the monitor adapter (shown on 
the next page) that came with your computer to one end of the external monitor’s cable.
If you are connecting a VGA or SVGA monitor, skip this step.
Important  Keep the computer and the monitor at least 8 inches apart. Interference
between the monitor and your computer’s ﬂoppy disk drive can cause errors on your 
ﬂoppy disks.
8 inches minimum
Important  Macintosh PowerBook G3 Series computers do not support operation with the 
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7 Make sure the other end of the monitor’s cable is attached to the monitor. Then attach the 
end of the cable (with the monitor adapter, if you connected it) to the external monitor port 
(™) on the back of the PowerBook.
If you are connecting a VGA or SVGA monitor, do not use the adapter. Connect the monitor 
cable directly to the external monitor port on the PowerBook.
8 Turn on the external monitor.
9 Press the Power button (®) to turn on or wake your computer.
The external monitor is automatically activated. 
10 Click the Resolution icon in the Control Strip and select a resolution from the menu that 
appears.
If you select an external monitor resolution that matches the standard built-in resolution of 
your PowerBook display, the same image will appear on both the display and the external
monitor (known as “simulscan” or “video mirroring”). If you choose a different resolution, 
the PowerBook display will go dark and images will appear only on the external monitor. For
more information on the external monitor resolutions supported by your PowerBook, see 
the Technical Information booklet that came with your computer.
™ External monitor port
Monitor adapter
Monitor cable
(to Macintosh-compatible monitor)
-
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Important  Video mirroring works only with the PowerBook display’s standard resolution. 
For example, when the 12.1" display is set to its standard resolution (800 x 600) or the 14.1" 
display is set to its standard resolution (1024 x 768), the display can mirror the external
monitor. However, if you switch the resolution to 640 x 480, the built-in display will go dark 
because scaled resolutions cannot be used for video mirroring.66 Chapter 3
Trouble With the External Monitor?
m Nothing happened when you tried to turn on or wake the PowerBook.
Make sure that all your equipment is connected properly. Then try turning on or waking 
the computer again.
Make sure that the battery is charged, or that the power adapter is plugged into both the 
computer and an electrical outlet. If you are using a power strip, make sure it is turned
on.
m The computer is on, but the external monitor is dark.
Make sure that the monitor’s power cord is connected and that its power switch is on. Try
adjusting the monitor’s brightness and contrast settings. If this doesn’t work, try
restarting your computer.
Note: The screen-dimming feature in the Energy Saver control panel turns the screen 
brightness down to a low level when you haven’t used the computer for a few minutes. 
( You can think of dimming as display sleep.) Dimming also affects the external monitor.
When you move your ﬁnger on the trackpad or press a key on the keyboard, the 
brightness is restored on both screens. For information and instructions on setting screen 
dimming, see the online help, available in the Help menu.
m The PowerBook goes to sleep when you close the display.
The PowerBook display must be open when using an external monitor.
Disconnecting an External Monitor
1 Make sure your computer is shut down or in sleep.
2 Make sure your monitor is switched off.
3 Disconnect the monitor cable (for a VGA-style monitor) or monitor adapter (for an Apple 
monitor) from the external monitor port on the computer’s back panel. Connecting Additional Equipment 67
Using an External Video Display or Recording Device
Your PowerBook has an S-video output port (labeled with the Æ icon) where you can 
connect an external video display or recording device such as a television, videocassette 
recorder ( VCR), or video projection system. 
Note: Due to the display limitations of most televisions, images displayed on the television 
screen will be of lower quality than images on the built-in display or an external monitor. For
best results, always use an S-video connection when available. 
Using the S-video output port, you can display your PowerBook desktop on a television 
screen and record images from the desktop to a VCR.
PowerBook computers equipped with an S-video output port can output the following 
display formats:
m S-video: High-quality video format used by certain televisions, VCRs, and video 
projectors. You can connect a cable from an S-video device directly to the S-video output 
port (Æ) on the back panel of your PowerBook. S-video is recommended because it 
provides better quality.
m Composite video: Video format used by most televisions and VCRs. To connect a 
composite video device, you need to use the composite to S-video adapter that came with 
your PowerBook.
Æ S-video output port
-
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Warning  The S-video output port (labeled with the Æ icon) looks similar to the ADB 
port (labeled with the V icon) and the printer/modem port (labeled with the ´ icon). 
Only plug your S-video device into the S-video output port. Plugging a video device into 
the wrong port could damage your equipment.
RCA plug S-video plug
Composite to S-video adapter68 Chapter 3
Connecting Video Equipment to Your PowerBook
You can record and deliver a sophisticated presentation by combining the video and sound 
capabilities of your PowerBook. The steps that follow explain how to set up equipment for 
displaying the computer desktop on a television and recording the computer’s output to 
videotape. Use the information in this section as a guideline when connecting other external
video display and recording devices.
Note: You cannot use the S-video output port and the external monitor port at the same 
time.
To connect a television or VCR for output from the computer: 
1 Shut down your PowerBook and turn off the television or VCR.
2 Attach one end of a video cable (not included with your PowerBook) to the video in port on 
the television or VCR. Follow the directions that came with the television or VCR.
3 If you’re using an RCA-type cable, plug in the other end of the video cable to the composite 
to S-video adapter. If you’re using a device that supports S-video, skip this step.
4 Plug the S-video cable or adapter to the S-video output port (Æ) on the back panel of your 
PowerBook.
PowerBook connected to a television using an S-video cable
S-video cable (not included with your computer)
RCA-type cable (not included with your computer)
Important  If the connector doesn’t slide easily into the port, check the pin alignment and 
try again. Don’t use force, which could damage your equipment.
TV
S-video
       output port
Æ
S-video cable
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PowerBook connected to a television using an RCA-type cable
5 If you want to output sound as well as video from your PowerBook, use a 
dual-RCA-plug–to–stereo-miniplug cable (not included with your computer) to connect the 
sound output port on the back of your PowerBook to audio input ports on your television or 
VCR.
6 Turn on the computer and the television or VCR.
Your PowerBook starts up using the built-in display. The television is dark.
7 Click the Resolution icon in the Control Strip and select a NTSC or PAL compatible screen 
resolution from the menu that appears. For best results use 640 x 480, 60 Hz for NTSC
systems and 640 x 480, 50 Hz for PAL systems. 
The PowerBook display becomes dark and images appear on the television. 
8 To switch back to your PowerBook display, select the “built-in” resolution for your 
PowerBook from the Control Strip. 
TV
RCA In port
S-video
       output port
Æ
Composite to S-video adapter RCA-type cable
Dual-RCA-plug–to–stereo-miniplug cable
(not included with your computer)
Resolution icon70 Chapter 3
Trouble With the External Video Device?
m Nothing happens when you tried to turn on the PowerBook.
Make sure your equipment is connected properly. Then try pressing the Power button 
(®) again.
Make sure the battery is charged, or the power adapter is plugged into both the computer 
and an electrical outlet. If you are using a power strip, make sure it is turned on.
m The computer is on, but the television is dark.
Select an NTSC or PAL compatible resolution from the Resolution icon in the Control 
Strip. If the television is still dark, make sure that the television is on and set up to receive 
video from an outside source. See the manual that came with your television or other 
video device for more information. If this doesn’t work, try restarting your computer.
Note: The screen-dimming feature in the Energy Saver control panel turns the screen 
brightness down to a low level when you haven’t used the computer for a few minutes. 
Dimming also affects the television. When you move your ﬁnger on the trackpad or press 
a key on the keyboard, the brightness is restored on both screens. For information on 
screen dimming, see the online help, available in the Help menu.
Disconnecting an External Video Device
1 Make sure your computer is shut down or in sleep.
2 Make sure your television or other external video device is switched off.
3 Disconnect the S-video cable or S-video adapter from the S-video output port (Æ) on the 
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Connecting and Using Sound Input Devices
Your computer has a built-in microphone. In addition, you can connect a PlainTalk
microphone to the external sound input port (√). ( You can also connect a standard linelevel input microphone, although it is not suitable for speech recognition.) You can ﬁnd
more information on using the microphone to record sounds in the online help, available in 
the Help menu.
Note: When using an external microphone, set the volume to 50 percent and point the 
microphone away from the PowerBook speakers. Pointing the microphone towards the 
speakers with the volume set to maximum may result in feedback.
Because your PowerBook can receive sounds from a variety of different sources, such as the 
internal microphone, expansion bay module, or zoomed video card, you need to select a 
sound input source.
m Click the Sound Source icon in the Control Strip and choose an input source from the 
menu that appears.
-Sound output port
√Sound input port
-
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Sound Source icon72 Chapter 3
Connecting Sound Output Devices
The Macintosh PowerBook has a stereo sound output port (-) to which you can connect 
externally powered speakers, an ampliﬁer, headphones, or other audio output device. The 
sound output port accepts a standard stereo miniplug, like that used to attach headphones 
to a portable tape or CD player.
Your computer also has two stereo speakers, which play sound from the following sources: 
audio CD in the CD-ROM or DVD-ROM drive, external stereo device connected to the 
computer through the sound input port, zoomed video card, internal modem, or ﬁle on your 
hard disk.
The computer automatically selects the sound output source. If an external device, such as a 
pair of headphones, is connected, sound is routed there. If no external output device is 
connected, sound plays through the computer’s speakers.
Locking Your Computer 
You can purchase a security cable and lock to protect your Macintosh PowerBook. With a 
lock, you can secure your computer to a desk or table. See your Apple-authorized dealer or 
computer retailer for details on security devices.
Note: You can protect the contents of your hard disk by turning on password protection. 
You can ﬁnd more information on password security in the online help, available in the Help 
menu.
Important  A security locking cable does not prevent the removal of expansion bay 
modules or batteries or access to your RAM and hard disk.
Sample locking device
with security cable
Ç Security slotConnecting Additional Equipment 73
Connecting a Mouse, Keyboard, or Other ADB Device
You can connect a mouse, keyboard, graphics tablet, or other Apple Desktop Bus (ADB) 
device to the ADB port on the back panel of the PowerBook.
Note: You may experience a slight delay if you connect a mouse or other ADB device while 
the computer is turned on.
Connecting Other Devices
For instructions on connecting a device not discussed in this chapter, refer to the 
documentation that came with the device.
V Apple Desktop Bus (ADB) port
-
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4 Installing a RAM Expansion Card 
and Removing Your Hard Disk
This chapter provides information about installing a RAM expansion card and removing your 
PowerBook hard disk for service or security reasons.
Getting Ready
Before you open your computer, you need to make sure that you have a Phillips or a Torx T-8 
screwdriver (available from a hardware or electronics supply store). 
Removing the Keyboard and Internal Heat Sink
The design of your Macintosh PowerBook allows you to easily access the internal
components of the computer by removing the keyboard. The steps in this section explain 
how to remove the PowerBook keyboard and internal heat sink to access the RAM expansion 
slot and internal hard disk.
1 Place your PowerBook on a hard, ﬂat surface.
Warning  To avoid damage to your computer, Apple recommends that only an Applecertiﬁed technician install additional RAM. Consult the service and support information
that came with your Apple product for instructions on how to contact an Appleauthorized service provider or Apple for service. If you attempt to install additional RAM 
yourself, any damage you may cause to your equipment will not be covered by the limited 
warranty on your computer. See an Apple-authorized dealer or service provider for 
additional information about this or any other warranty question.76 Chapter 4
2 If your PowerBook is turned on, press the Power button (®). In the Shut Down dialog box, 
click Shut Down.
3 Unplug the power adapter and any other devices from the back of your PowerBook. Unplug 
any phone line from the internal modem. 
4 Adjust your display so that it is at a 90-degree angle to the computer.
If your display is tilted too far back, your PowerBook may tip backward when the expansion 
bay modules are removed in the next step.
5 Pull out both expansion bay release levers to eject the modules or batteries in both the 
expansion bays.
6 Remove the modules or batteries from both the expansion bays.
Warning  The internal components (including the internal heat sink) of your PowerBook
may be hot. If you have been using your PowerBook, wait 10 minutes before continuing, 
to let the internal components cool down.
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7 With your thumbs positioned slightly below the keyboard, place your ﬁngers inside the 
expansion bays and locate the small plastic tabs that hold the keyboard in place. 
The plastic tabs have small ridges on them and are located on the underside of the top shell 
of the PowerBook approximately one inch inside each expansion bay.
8 Gently slide the plastic tabs toward you until you see the lower portion of the keyboard pop 
up.
9 Lift the lower portion of the PowerBook keyboard up slightly and pull it back enough to 
displace the ﬁve metal tabs that hold the front of the keyboard in place.
Plastic tab
Plastic tab
Tabs78 Chapter 4
10 Flip the keyboard over and lay it on the palm rests and trackpad.
11 Remove the two screws that secure the internal heat sink (using a Phillips or Torx T-8 
screwdriver) and then lift it up by pulling on the small metal tab. 
You now have access to the internal components of your PowerBook.
Warning  The PowerBook internal heat sink may be hot. If you have been using your 
PowerBook, wait 10 minutes before continuing to let the internal components cool down.
Screws
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Installing a RAM Expansion Card
To install a RAM expansion card in your PowerBook, follow these steps: 
1 If you have not already done so, remove the PowerBook keyboard and internal heat sink as 
described in “Removing the Keyboard and Internal Heat Sink” on page 75.
2 Locate the empty RAM expansion slot. 
Note: If you ordered your PowerBook with additional memory, this slot may already have a 
RAM card installed. 
3 Gently touch the metal surface on the right side of the inside of the computer to discharge
any static electricity built up on your body.
This prevents damage to your Macintosh PowerBook or RAM card.
Don’t walk around while installing the card. If you do, touch the metal surface again to 
discharge any static electricity.
Important  Make sure that the RAM expansion card you are installing is made for your 
Macintosh PowerBook model. Components designed for other PowerBook models will not 
work with your computer.
RAM expansion slot
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4 Position the RAM expansion card at a 30-degree angle. Line up the notch in the PowerBook
RAM expansion card with the small tab in the RAM expansion slot.
5 Push the RAM expansion card into the plastic expansion slot. 
You may feel some resistance. If you are having trouble inserting the card, try pushing one 
side at a time.
6 Gently push the RAM expansion card down until the two snaps on either side of the card 
lock into place. 
Your RAM expansion card is now ready to use.
7 Skip ahead to “Replacing the Keyboard and Internal Heat Sink” on page 83.
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Removing Your PowerBook Hard Disk Drive
Your PowerBook was designed so that you could easily remove your internal hard disk drive 
for service or security needs.
1 If you have not already done so, remove the PowerBook keyboard and internal heat sink as 
described in “Removing the Keyboard and Internal Heat Sink” on page 75.
2 Locate the hard disk drive. 
3 Gently touch the metal surface on the left side of the inside of the computer to discharge any 
static electricity built up on your body.
This prevents damage to the Macintosh PowerBook or internal hard disk drive.
Don’t walk around while removing the hard disk drive. If you do, make sure you touch the 
metal surface again to discharge any static electricity.
Hard disk drive
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4 Loosen the screw that locks the hard disk in place.
Note: The hard disk screw stays attached to the hard disk; you do not need to remove it 
completely.
5 Gently pull up on the small metal tab (located on the left side of the hard disk) to disengage 
the hard disk from the logic board.
6 Carefully lift the hard disk out of the PowerBook.
Always store your internal hard disk in a safe place and avoid contact with the hard disk 
connectors.
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Replacing the Keyboard and Internal Heat Sink
Follow the steps in this section to replace your PowerBook keyboard.
1 Insert the internal heat sink and replace the two screws to secure it in place.
2 Press down on the bottom portion of the heat sink to secure it into place.
3 Flip the keyboard back on top of the opening in your PowerBook.
4 Insert the ﬁve small tabs at the top of the keyboard into the opening in the PowerBook case.
5 Press down on the lower portion of the keyboard until it snaps into place.
6 Replace the expansion bay modules.
Screws
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You are now ready to start working with your PowerBook again.
Warning  Never turn on your PowerBook G3 Series computer unless all of its internal
and external parts are in place. Operating the computer when it is open or missing parts 
can be dangerous, and can damage your computer.85
A P P E N D I X
Health, Safety, and Maintenance Tips
Health-Related Information About Computer Use
Muscle soreness, eye fatigue, and other discomforts and injuries sometimes associated with 
using computers can occur from performing any number of activities. In fact, misuse of the 
same muscles during multiple activities can create a problem that might not otherwise exist. 
For example, if you engage in nonwork activities that involve repetitive stress on the wrist—
such as bicycling—and also use your computer’s keyboard improperly, you may increase your 
likelihood of developing wrist problems. Some individuals are at greater risk of developing 
these problems because of their health, physiology, lifestyle, and general exposure to stress. 
Work organization and conditions, such as workstation setup and lighting, also play a part in 
your overall health and comfort. Preventing health problems is a multifaceted task that 
requires careful attention to the way you use your body every hour of every day.
The most common health effects associated with using a computer are musculoskeletal
discomfort and eye fatigue. We’ll discuss each area of concern in this appendix.
Musculoskeletal Discomfort
As with any activity that involves sitting for long periods of time, using a computer can make
your muscles sore and stiff. To minimize these effects, set up your work environment 
carefully, using the guidelines that follow, and take frequent breaks to rest tired muscles. To
make working with your computer more comfortable, allow enough space in your work area 
so that you can change position frequently and maintain a relaxed posture.
Another type of musculoskeletal concern is repetitive stress injuries (RSIs), also known as 
cumulative trauma disorders (CTDs). These problems can occur when a certain muscle or 
tendon is repeatedly overused and forced into an unnatural position. The exact causes of 
RSIs are not totally understood, but in addition to awkward posture, such factors as the 
amount of repetition, the force used in the activity, the individual’s physiology, workplace 
stress level, and lifestyle may affect the likelihood of experiencing an RSI.86 Appendix
RSIs did not suddenly arise when computers were invented; tennis elbow and writer’s cramp, 
for example, are two RSIs that have been with us for a long time. Although less common than 
other RSIs, one serious RSI discussed more often today is a wrist problem called carpal 
tunnel syndrome, which may be aggravated by improper use of computer keyboards. This 
nerve disorder results from excessive pressure on the median nerve as it passes through the 
wrist to the hand.
This section offers advice on setting up your work area to enhance your comfort while you 
use your computer. Since the effects of repetitive movements associated with using a 
computer can be compounded by those of other work and leisure activities to produce or 
aggravate physical problems, proper use of your computer system must be considered as just 
one element of a healthy lifestyle.
No one, of course, can guarantee that you won’t have problems even when you follow the 
most expert advice on using computer equipment. You should always check with a qualiﬁed
health specialist if muscle, joint, or eye problems occur.
Eye Fatigue
Eye fatigue can occur whenever the eyes are focused on a nearby object for a long time. This 
problem occurs because the eye muscles must work harder to view an object that’s closer 
than about 20 feet (6 meters). Improper lighting can hasten the development of eye fatigue. 
Although eye fatigue is annoying, there’s no evidence that it leads to permanent damage.
Whenever you’re engaged in an activity that involves close-up work—such as reading a 
magazine, doing craft work, or using a computer—be sure to have sufﬁcient glare-free 
lighting and give your eyes frequent rest breaks by looking up and focusing on distant 
objects. Remember to have your eyes examined regularly.
To prevent discomfort and eye fatigue: 
m Arrange your work space so that the furniture is properly adjusted for you and doesn’t
contribute to an awkward working posture.
m Take frequent short breaks to give your muscles and eyes a chance to rest.Health, Safety, and Maintenance Tips 87
Arranging Your Work Area and Equipment
The suggestions in this section can help you work more comfortably with you computer.
Chair
m An adjustable chair that provides ﬁrm, comfortable support is best. Adjust the height of 
the chair so your thighs are horizontal and your feet ﬂat on the ﬂoor.
The back of the chair should support your lower back (lumbar region). Follow the 
manufacturer’s instructions for adjusting the backrest to ﬁt your body properly.
Keyboard and Trackpad
m When you use the keyboard and trackpad, your shoulders should be relaxed. Your upper 
arm and forearm should form an approximate right angle, with your wrist and hand in 
roughly a straight line. 
m You may have to raise your chair so your forearms and hands are at the proper angle to 
the keyboard. If this makes it impossible to rest your feet ﬂat on the ﬂoor, you can use a 
footrest with adjustable height and tilt to make up for any gap between the ﬂoor and your 
feet. Or you may lower the desktop to eliminate the need for a footrest. Another option is 
to use a desk with a keyboard tray that’s lower than the regular work surface.
m Use a light touch when typing or using the trackpad and keep your hands and ﬁngers
relaxed. Avoid rolling your thumbs under your palms.
Some computer users may develop discomfort in their hands, wrists, or arms after intensive 
work without breaks. If you begin to develop chronic pain or discomfort in your hands, 
wrists, or arms, consult a qualiﬁed health specialist.
m Change hand positions often to avoid fatigue.
This Not this
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Mouse
If you use an external mouse, position the mouse at the same height as your keyboard. Allow 
adequate space to use the mouse comfortably.
Built-In Display
m Adjust the angle of the display to minimize glare and reﬂections from overhead lights and 
windows.
m You may need to adjust the brightness and contrast of the screen when you take the 
computer from one work location to another, or if the lighting in your work area changes.
External Monitor
If you use an external monitor, this suggestion may be helpful.
m If possible, arrange the monitor so the top of the screen is slightly below your eye level 
when you’re sitting at the keyboard. The best distance from your eyes to the screen is up 
to you, although most people seem to prefer 18 to 28 inches (45 to 70 cm).
Avoiding Fatigue
m Change your seated position, stand up, or stretch whenever you start to feel tired. 
Frequent short breaks are helpful in reducing fatigue.
m Allow adequate work space so that you can work comfortably. Place papers or other items 
so you can view them easily while using your computer. A document stand may make
reading papers more comfortable.
m Eye muscles must work harder to focus on nearby objects. Occasionally focus your eyes 
on a distant object, and blink often while you work. 
m Clean your screen regularly. Keeping the screen clean helps reduce unwanted reﬂections.
What About Electromagnetic Emissions?
There has been recent public discussion of the possible health effects of prolonged exposure 
to extremely low frequency (ELF) and very low frequency (VLF) electromagnetic ﬁelds. Such 
ﬁelds are associated with electromagnetic sources such as television sets, electrical wiring, 
and some household appliances—as well as computer monitors.
Apple has reviewed scientiﬁc reports and sought the counsel of government regulatory
agencies and respected health organizations. Based on the prevailing evidence and opinions, 
Apple believes that the electric and magnetic ﬁelds produced by computer monitors do not 
pose a health risk. In response to those customers who wish to reduce their exposure to 
electromagnetic ﬁelds, Apple has lowered the emission levels of its products. Health, Safety, and Maintenance Tips 89
Important Care and Safety Instructions
For your own safety and that of your equipment, always take the following precautions.
Disconnect the power plug (by pulling the plug, not the cord) and remove the expansion bay 
battery if any of the following conditions exists:
m you want to remove any parts (leave the cord disconnected as long as the keyboard is 
open)
m the power cord or plug becomes frayed or otherwise damaged
m you spill something into the case
m your PowerBook G3 Series computer is exposed to rain or any other excess moisture
m your PowerBook G3 Series computer has been dropped or the case has been otherwise
damaged
m you suspect that your PowerBook G3 Series computer needs service or repair
m you want to clean the case (use only the recommended procedure described later)
Important  The only way to disconnect power completely is to unplug the power cord and 
remove the batteries. Make sure at least one end of the power cord is within easy reach so 
that you can unplug the PowerBook G3 Series computer when you need to.
Be sure that you always do the following:
m Keep your PowerBook G3 Series computer away from sources of liquids, such as 
washbasins, bathtubs, shower stalls, and so on.
m Protect your PowerBook G3 Series computer from dampness or wet weather, such as rain, 
snow, and so on.
m Read all the installation instructions carefully before you plug your PowerBook G3 Series 
computer into a wall socket.
m Keep these instructions handy for reference by you and others.
m Follow all instructions and warnings dealing with your system.
To clean the case, do the following:
1 Disconnect the power plug. (Pull the plug, not the cord.)
2 Wipe the surfaces lightly with a clean, soft cloth dampened with water. Clean the screen with 
soft, lint-free paper.
Warning  Electrical equipment may be hazardous if misused. Operation of this product, 
or similar products, must always be supervised by an adult. Do not allow children access 
to the interior of any electrical product and do not permit them to handle any cables.90 Appendix
Caution
m If you have a problem with your computer and nothing in the computer manual solves 
the problem, take the computer to your Apple-authorized dealer or service provider.
Attempting to repair the computer yourself may void the limited warranty.
m Do not move the computer when you can hear its hard disk spinning. When you put the 
computer to sleep, wait until the screen is blank before moving the computer.
m Never force a connector into a port. Make sure that the connector matches the port and 
that it’s right side up. If the connector and port do not join easily, they do not match.
m Do not use the computer in wet or dusty environments.
m Keep dirt and liquids away from the ports on the back panel, the keyboard, and the 
trackpad. If you spill any food or liquid onto the computer, shut it down immediately,
unplug it, and remove the expansion bay modules before cleaning up the spill. 
Depending on what you spilled and how much got into the computer, you may have to 
bring the computer to an Apple-authorized service provider for cleaning.
m Do not touch the screen with any sharp or pointed objects.
m Use only the battery supplied with your computer, or an identical model. Batteries 
designed for other portable computers may look similar, but they may not work with your 
computer and may damage it.
m Use only the power adapter supplied with your computer, or an identical model. Adapters 
designed for other electronic devices may not work with your equipment and may 
damage it.
m When using your PowerBook or when charging the battery, it is normal for the bottom of 
the case to get warm. The bottom of the PowerBook case functions as a cooling surface
that transfers heat from inside the computer to the cooler air outside. The bottom of the 
case is raised slightly to allow airﬂow that keeps the unit within normal operating 
temperatures.
Important
m Use the computer only in environments where the temperature range is between 
50°F/10°C and 95°F/35°C.
m Do not expose the computer to very low (less than –13°F/–25°C) or very high (more 
than 140°F/60°C) temperatures.
m If the computer has been in a cold place for several hours, let it warm up to room 
temperature before you use it.Health, Safety, and Maintenance Tips 91
Caring for Batteries
m Always handle batteries carefully.
m Do not short-circuit the battery terminals (that is, do not touch both terminals with a 
metal object). Do not carry loose batteries in a pocket or purse where they may mix with 
coins, keys, or other metal objects. Doing so may cause an explosion or a ﬁre.
m Do not drop, puncture, disassemble, mutilate, or incinerate the battery.
m Recharge batteries only as described in this manual and only in ventilated areas. 
m Do not leave batteries in hot locations (such as the trunk of a car) for more than a day or 
two. Intense heat can shorten battery life. 
m Do not leave a battery in storage for longer than 6 months without recharging it.
Handling Floppy Disks
125° F (52° C)
50° F (10° C)
Do not use a
pencil or an 
eraser on a disk
or disk label.
Store disks at
temperatures
between 50° F
and 125° F.
Do not touch the
exposed part of the
disk behind the 
metal shutter.
Keep disks away 
from magnets.92 Appendix
Handling CD and DVD Discs
Traveling With the Macintosh PowerBook
Always bring the system software CD that came with your computer when you travel. If you 
experience system software problems while traveling, you may need it to correct any 
problems.
Take the necessary plug adapters if you’re traveling overseas. (You may need to use them 
with the power cord.) You do not need a voltage transformer. The power adapter can handle 
100 volts to 240 volts AC (50 Hz to 60 Hz).
Check the following diagrams to determine which plug adapters you’ll need, or ask your 
travel agent.
Do not put tape
on discs.
Do not scratch
discs.
Do not write
on discs.
Do not spill liquids
on discs.
Do not get
dust on discs.
Do not expose discs
to direct sunlight.
Outlet Type Locations
United States, Canada, parts of Latin America, Japan, 
Korea, the Philippines, Taiwan
Russia and the Commonwealth of Independent States 
(CIS), most of Europe, parts of Latin America, the Middle 
East, parts of Africa, Hong Kong, India, most of South Asia
Mexico, United Kingdom, Ireland, Malaysia, Singapore, 
parts of Africa 
China, Australia, New ZealandHealth, Safety, and Maintenance Tips 93
Airplanes and Airports
Some airlines have reported that use of portable electronic devices may have interfered with 
the aircraft’s ﬂight navigation or communications systems. Many airlines restrict or manage 
the use of electronic equipment during ﬂights. Please respect the regulations of the airlines.
A properly tuned X-ray machine or metal detector should cause no damage to your 
Macintosh PowerBook. But the motors that drive the belts on some security machines have 
magnets that can damage your information. To avoid problems, place the Macintosh 
PowerBook close to the entrance of the machine and remove it as soon as possible. At most 
airports you can also have the computer hand-inspected by security personnel.
Security ofﬁcials may require you to turn the Macintosh PowerBook on. Make sure you have 
a charged battery on hand. To speed up the security process, have your PowerBook in sleep 
instead of shut down. 
Handling Your Macintosh PowerBook
The safety instructions earlier in this appendix also apply when you are traveling. In addition, 
note these precautions: 
m Do not transport your Macintosh PowerBook while it is turned on. Put your computer to 
sleep or shut it down before you move it.
m Do not check your computer as baggage. Carry it with you.
International Repair and Service
Apple’s limited warranty covers your Macintosh PowerBook for one year, regardless of where 
it is purchased. The Apple-authorized service providers in more than 80 countries can handle 
most repairs (unless the repair involves a component speciﬁc to another area of the world). 
Bring a copy of your proof of purchase with you.
Storing the Macintosh PowerBook
1 Save your work on a hard disk or ﬂoppy disks.
2 Press the Power button and click Shut Down, or choose Shut Down from the Special menu.
3 Close the display.
4 Store the computer in a cool, dry place.
Storage temperatures should remain between –25°C and 60°C (between –13°F and 140°F). 
Avoid leaving the computer where temperatures may be extreme or unpredictable—in the 
trunk of a car, for example.94 Appendix
Service and Support
If your computer is malfunctioning but does not appear to be physically damaged, shut it 
down (and leave the power adapter plugged in, if possible) until you can get help.
If you know or suspect that your computer is physically damaged, disconnect the power 
adapter, remove the battery, and do not use the computer until it can be repaired.
Modem and Fax Safety
If you’re planning to install telephone wiring or telephone jacks, follow these precautions: 
m Never install telephone wiring during a lightning storm.
m Never install telephone jacks in wet locations unless the jacks are speciﬁcally designed for 
wet locations.
m Never touch uninsulated telephone wires or terminals unless the telephone line has been 
disconnected at the network interface.
m Use caution when installing or modifying telephone lines.
m Avoid using a telephone, other than a cordless type, during an electrical storm. There may 
be a remote risk of shock from lightning. 
m Never use a telephone to report a gas leak while in the vicinity of the leak. 
Important  See the service and support information that came with your computer for 
information about customer assistance.
Important  Disconnect the telephone line from the PowerBook before removing the 
keyboard to access the internal components.
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Préface
Bienvenue dans Pages
Pages est une application de traitement de texte 
standard mais puissante ; elle permet de créer 
facilement des documents de haute qualité, qu’il 
s’agisse d’une lettre, d’une invitation, d’un bulletin 
mensuel ou d’une brochure en tryptique. Cette 
préface présente les fonctionnalités de Pages 
ainsi que différentes ressources pour apprendre 
à l’utiliser.
Pages facilite la composition et la conception de divers documents sur votre ordinateur, d’un simple mémo à des rapports scolaires bien structurés, en passant par une 
brochure très stylisée et élégante. Avec les outils de Pages, vous pouvez facilement 
changer la disposition et l’aspect de n’importe quel document à mesure que vous 
travaillez. Présentez les données à l’aide des tableaux ou graphiques de Pages. Inté-
grez une multitude de types de texte et de graphisme ; vous pouvez même inclure 
des séquences vidéo, des liens et des séquences audio si vous prévoyez de publier 
votre document en ligne. Utilisez les modèles fournis avec Pages afin de créer des 
documents professionnels et uniformes. Vous pouvez également créer vos modèles. 
Avec Pages, vos mots sont un plaisir à lire.
Votre document Pages peut être exporté vers différents types de fichier, notamment 
HTML pour l’affichage en ligne, PDF et Microsoft Word.
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Vue d’ensemble des fonctionnalités de Pages
Simple d’utilisation
Grâce aux modèles fournis avec Pages, il est facile de créer des documents professionnels. Les espaces réservés pour le texte et les images permettent de personnaliser les 
documents par simple glisser-déposer. Importez des documents à partir de Microsoft 
Word et AppleWorks. Vous pouvez également créer vos modèles et les partager avec 
vos collègues.
Insérez des renvois, 
des tableaux et d’autres 
éléments mis en forme 
à la volée.
Ajoutez des graphismes 
par simple glisser-déposer.
Insérez plusieurs dispositions 
de colonne.
Utilisez les boutons des 
barres d’outils pour mettre 
en forme les pages et le 
texte à mesure que vous 
tapez.
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Modèles de pages
Chaque modèle dispose de blocs de composition Pages vous permettant d’élaborer 
un document à partir d’une sélection de dispositions de type professionnel.
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Styles
Tapez simplement le texte en utilisant un modèle, et les styles sont appliqués automatiquement aux paragraphes, caractères et listes numérotées ou à puces. Vous pouvez 
également sélectionner différents styles ou créer vos styles. Utilisez la fenêtre Inspecteur afin de mettre en forme la disposition des documents, du texte et des 
graphismes pendant votre travail.
Utilisez le menu Styles afin 
d’appliquer une mise en 
forme de texte cohérente 
dans tous vos documents.
Importez les photos 
d’iPhoto à l’aide du 
navigateur de média 
iLife.
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Traitement de texte puissant
Pages permet les dispositions à plusieurs colonnes, qui passent d’une page à l’autre 
lorsque vous tapez, ainsi que les documents déjà mis en forme qui permettent la 
création de documents exceptionnels. Il est également simple de configurer une table 
des matières, des pieds de page, des en-têtes et des numéros de page afin de créer 
des rapports professionnels ou universitaires.
Créez une table des 
matières qui se met à 
jour automatiquement.
Appliquez un style à 
la table des matières.
Créez des listes à puces 
ou numérotées.
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Pour en savoir plus
Pour tirer le meilleur parti de Pages, consultez les ressources suivantes :
Guide de l’utilisateur
Le présent guide décrit les fonctionnalités de Pages et explique comment l’utiliser. 
Pour lire ce guide au format PDF couleurs, choisissez Aide > Manuel de l’utilisateur 
Pages.
Le chapitre 1 de ce guide décrit les outils disponibles dans Pages et le chapitre 2 illustre 
la procédure pas à pas à suivre pour créer un document. Pour plus d’informations sur 
chaque étape, reportez-vous aux chapitres 3 à 10. Si vous souhaitez découvrir comment 
créer vos modèles, lisez le chapitre 11.
Aide en ligne
Pour afficher l’aide, choisissez Aide > Aide Pages. Vous pouvez parcourir la table des 
matières afin de rechercher une rubrique spécifique, ou saisir une question dans le 
champ de recherche afin de trouver une réponse concernant la façon d’effectuer 
une tâche.
Vous pouvez ajouter le bouton Aide à la barre d’outils Pages afin de rendre l’aide 
de Pages disponible d’un simple clic. Pour en savoir plus sur la personnalisation de 
la barre d’outils, reportez-vous à la section “La barre d’outils” à la page 23.
Remarque :  pour effectuer nombre des tâches décrites dans ce guide (et dans l’Aide 
Pages), vous utilisez des commandes de menu. Les instructions se présentent ainsi : 
m Choisissez Afficher > Zoom > Taille réelle.
Le premier terme après Choisissez est le menu sur lequel vous cliquez ; le terme 
suivant est l’élément sélectionné dans le menu, comme illustré ci-après.
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Les balises d’aide sont également disponibles pour de nombreux éléments à l’écran. 
Pour afficher une balise d’aide, positionnez le pointeur sur un élément pendant quelques secondes.
Visite guidée de Pages
Pour obtenir une démonstration à l’écran de ce que vous pouvez faire avec Pages, 
visualisez la visite guidée.
Pour visualiser la visite à l’écran :
m Choisissez Aide > Visite iWork, puis suivez les instructions à l’écran.
Modèles Pages
Pages est fourni avec des modèles qui illustrent les différents styles et dispositions 
que vous pouvez créer. Tapez directement du texte en utilisant un modèle afin de 
créer vos documents. Vous pouvez également utiliser les propriétés et éléments 
de ces modèles afin d’améliorer votre document en copiant et en collant des puces, 
des styles de graphique et des images d’arrière-plan, ou en utilisant les mêmes 
dispositions et styles.
Pour plus d’informations, reportez-vous à la section “Étape 1 :  Sélectionnez un type 
de document” à la page 30.
Fascicule de référence rapide de Pages
Le fascicule de référence rapide répertorie les raccourcis clavier de Pages. Vous pouvez 
également accéder aux raccourcis clavier en choisissant Aide > Raccourcis clavier Pages 
ou en recherchant “raccourcis clavier” dans l’aide en ligne.
Ressources Web
Rendez-vous sur www.apple.com/pages afin d’obtenir les mises à jour logicielles et les 
informations les plus récentes. Vous pouvez également acheter les produits Pages sur 
le Web.
Pour afficher une balise 
d’aide, positionnez le 
pointeur sur un élément.
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Pour en savoir plus sur les produits Pages et obtenir des informations à jour :
m Choisissez Aide > Pages sur le Web.
Support technique
Différentes options de support sont disponibles pour les utilisateurs de Pages. 
Pour plus d’informations, reportez-vous au guide AppleCare des services 
logiciels et de support fourni avec la documentation de Pages ou visitez le site 
www.apple.com/fr/support.
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1 Présentation de Pages
Ce chapitre présente les fenêtres et outils que vous 
utiliserez dans Pages.
Lorsque vous créez un document Pages, vous devez commencer par sélectionner un 
modèle avec lequel démarrer. Choisissez celui qui correspond le mieux à vos besoins 
et objectifs. Si vous souhaitez commencer avec un document brut, sans mise en forme 
prédéfinie, utilisez le modèle Vide.
Vous pouvez faire glisser ou positionner des objets sur une page, notamment des 
graphismes importés, des séquences et du son, ou encore des zones de texte, des 
graphiques, des tables et des formes que vous créez dans Pages. De nouvelles pages 
sont ajoutées automatiquement lorsque vous tapez des informations dans un document. Vous pouvez également ajouter des pages avec une mise en forme prédéfinie, 
avant ou après des pages existantes, en sélectionnant parmi celles qui sont proposées 
dans chaque modèle. Pour plus d’informations, reportez-vous à la section “Développement du modèle en ajoutant des pages” à la page 31.
Dans les modèles Pages, les pages contiennent des espaces réservésde texte et 
d’image qui illustrent l’aspect du document final. Vous pouvez remplacer le texte 
des espaces réservés par votre texte. Vous pouvez également remplacer les images 
des espaces réservés en y faisant glisser une image. Pour plus d’informations sur 
l’utilisation d’espaces réservés de texte et d’images, reportez-vous aux sections 
“Étape 2 :  Ajoutez du texte” à la page 33 et “Étape 5 :  Enregistrez et partagez le document” à la page 47.
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La fenêtre Pages
Lorsque vous ouvrez pour la première fois l’application Pages, le sélectionneur de 
modèles présente différents types de document. Si vous ne souhaitez utiliser aucun 
des modèles, vous pouvez créer un document vide. Pour commencer avec un document vide, sélectionnez-le et commencez à saisir le texte.
La fenêtre Pages affiche le document sur lequel vous travaillez. Vous pouvez faire 
glisser des fichiers image, des séquences et des fichiers son vers la fenêtre afin de 
les ajouter au document.
Lorsque vous travaillez dans le document, vous pouvez faire un zoom avant ou arrière 
afin de mieux voir ce que vous faites.
Personnalisez la barre d’outils 
afin d’inclure les outils que 
vous utilisez le plus souvent.
Les espaces réservés du 
texte indiquent où vous 
devez saisir le texte.
Les espaces réservés 
d’image indiquent la 
taille et la position des 
graphismes dans un 
modèle de document.
Les zones de texte contiennent du texte “flottant” à 
l’extérieur, au-dessus ou en 
dessous de la zone de texte 
principale.
La commande Prévisualiser 
permet de faire un zoom avant 
ou arrière afin d’agrandir ou de 
réduire le document à l’écran.
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Pour faire un zoom avant ou arrière sur le document, effectuez l’une des opérations suivantes :
Â Choisissez Afficher > Zoom > [niveau de zoom].
Â Cliquez sur la commande Prévisualiser dans le coin inférieur gauche de la fenêtre, 
puis choisissez un niveau d’agrandissement dans le menu local.
Â L’option Un vers le haut présente les pages dans un flux linéaire.
Â L’option Deux vers le haut présente deux pages côte à côte à l’écran.
Â L’option Ajuster la largeur adapte la largeur du document à celle de la fenêtre. Vous 
pouvez agrandir la fenêtre Pages afin qu’elle occupe tout l’écran, ou bien la rétrécir.
Â L’option Ajuster la page adapte la page du document à la taille de la fenêtre de 
l’écran.
F2644.book  Page 17  Thursday, January 13, 2005  5:18 PM18 Chapitre 1    Présentation de Pages
Mode Disposition
En mode disposition, vous pouvez afficher les contours des différentes zones de texte 
du document, notamment les en-têtes, les pieds de page, les zones de texte fixes, les 
largeurs de colonne et le corps du document, c’est-à-dire la zone de texte principale 
du document. Avec le mode disposition activé, les règles et guides d’alignement du 
document deviennent visibles.
Pour passer en mode disposition :
m Choisissez Afficher > Afficher la disposition.
Lorsque vous tapez du texte dans le corps du document, le texte passe automatiquement à la page suivante. Les autres zones de texte, telles que les en-têtes, les pieds de 
page et les zones de texte, ne passent pas aux pages suivantes ; elles conservent leur 
taille et leur largeur.
Dans l’exemple suivant, vous constatez que la disposition de la page comporte deux 
colonnes en haut, deux sauts de disposition, puis trois colonnes, une image en ligne 
et la zone de pied de page.
Pied de page
Deux colonnes de texte
Une image en ligne
Trois colonnes de texte
Deux sauts de 
disposition
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Texte d’espace réservé
Le texte d’espace réservé indique où le texte est positionné et comment il est mis 
en forme dans un modèle. Un nouveau modèle contient du texte d’espace réservé, 
des images d’espace réservé, des images d’arrière-plan ou d’autres éléments qui 
représentent les éléments du document terminé. Si vous cliquez sur le texte d’espace 
réservé, la totalité de la zone de texte est sélectionnée. Lorsque vous commencez la 
saisie, le texte d’espace réservé disparaît et il est remplacé par ce que vous tapez.
Espaces réservés d’image
De la même façon que le texte d’espace réservé, les espaces réservés d’image servent 
à indiquer la taille et la position des graphismes dans un modèle. Si vous cliquez une 
fois, les poignées de sélection apparaissent. Faites glisser votre image vers l’espace 
réservé afin de la remplacer.
Objets modèle
Certains objets apparaissent sur chaque page d’un document, à mesure que la longueur 
du document augmente. Ces objets sont appelés “objets modèle”. Si vous ne pouvez pas 
sélectionner un objet dans un modèle, il s’agit probablement d’un objet modèle. Pour 
en savoir plus, reportez-vous à la section “Ajout d’une image répétée pour l’arrière-plan” 
à la page 113.
Caractères de mise en forme (invisibles)
Lorsque vous travaillez dans un document Pages, vous pouvez afficher les marques 
indiquant les espaces, les sauts de paragraphe, les sauts de section ou d’autres types 
d’élément invisible, vous permettant ainsi de vérifier la mise en forme du document. 
Dans Pages, ces marques de mise en forme sont appelées caractères invisibles.
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Pour afficher les caractères invisibles :
m Choisissez Afficher > Afficher les caractères invisibles.
Le tableau ci-dessous illustre ce que représente chaque caractère de mise en forme.
Pour changer la couleur des caractères de mise en forme :
m Choisissez Pages > Préférences, cliquez sur la case de couleur Caractères invisibles, 
puis sélectionnez une couleur.
Caractères invisibles
  
Espace
Espace insécable (Option + Barre espace)
Tab
Saut de ligne (Maj + Retour)
Saut de paragraphe (Retour)
Saut de page
Saut de colonne
Saut de disposition
Saut de section
Point d’ancrage (pour les objets en ligne avec l’habillage du texte)
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Règles et guides d’alignement
Chaque fois que vous déplacez une image, une forme ou une zone de texte sur la 
page, les guides d’alignement apparaissent automatiquement afin de vous aider à 
positionner l’objet précisément à l’endroit où vous le souhaitez. Vous pouvez également utiliser les règles du document ou créer des guides d’alignement statiques 
qui restent sur la page afin de marquer la position des différents objets lorsque vous 
réorganisez les éléments sur la page. Pour savoir comment personnaliser le comportement des guides d’alignement, reportez-vous à la section “Guides d’alignement” à la 
page 39.
Vous pouvez également utiliser des règles pour positionner les objets précisément 
sur une page, et vous pouvez utiliser la règle horizontale pour définir les taquets de 
tabulation, les marges des pages et les largeurs des colonnes. Pour plus d’informations 
sur les taquets de tabulation, les marges des pages et les colonnes, reportez-vous 
aux sections “Définition de taquets de tabulation afin d’aligner le texte” à la page 64, 
“Définition des marges de page” à la page 102 et “Création de colonnes” à la page 102. 
Vous pouvez remplacer les unités de mesure qui apparaissent sur les règles par des 
pouces, des centimètres, des points ou des picas dans les Préférences Pages.
Vous pouvez également activer les règles sans les autres éléments de disposition.
Pour rendre les règles visibles sans les autres éléments de disposition :
m Choisissez Afficher > Afficher les règles, ou appuyez sur Commande + R.
Pour changer les valeurs des règles :
m Choisissez Pages > Préférences, puis choisissez une unité de mesure dans le menu 
local Unités de la règle.
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Le tiroir Styles
Lorsque vous créez un documen, vous pouvez utiliser un certain style de texte 
pour chaque titre de chapitre, titre de section, liste à puces et paragraphe de corps 
du texte. Chaque modèle est fourni avec une bibliothèque de styles prédéfinis parmi 
lesquels vous pouvez choisir. Le tiroir Styles répertorie et fournit un aperçu de tous 
les styles de texte du modèle que vous utilisez, ce qui vous permet de les créer, de 
les personnaliser et de les gérer facilement.
Pour ouvrir le tiroir Styles :
m Choisissez Afficher > Afficher le tiroir Styles (ou cliquez sur Style dans la barre d’outils 
et choisissez Afficher le tiroir Styles).
Les règles vous aident à
définir les marges et les 
tabulations à l’endroit 
où vous en avez besoin. 
Les guides d’alignement vous 
aident à positionner avec 
précision les objets sur la page. 
Dans le cas présent, les guides 
d’alignement sont bleus.
Les icônes bleues sur la règle du 
haut indiquent les retraits du texte 
et les tabulations. Faites-les glisser 
afin demodifier la position du texte.
Les rectangles bleus sous 
les règles indiquent les 
marges des colonnes. 
Faites-les glisser afin de 
modifier la largeur des 
gouttières des colonnes.
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Outils Pages
La barre d’outils
La barre d’outils Pages permet d’accéder en un seul clic à nombre des actions que 
vous utilisez lors de la création de documents dans Pages. Lorsque vous travaillez 
dans Pages et que vous savez quelles commandes vous utilisez le plus souvent, vous 
pouvez ajouter, supprimer et réorganiser les boutons de la barre d’outils afin de les 
adapter à votre style de travail.
Le jeu par défaut de boutons de barre d’outils est illustré ci-dessous.
Sélectionnez un style de 
paragraphe afin de l’appliquer 
aux paragraphes sélectionnés.
Sélectionnez un style de 
caractère afin de l’appliquer 
au texte sélectionné.
Sélectionnez un style de liste 
afin de l’appliquer au texte 
du paragraphe sélectionné.
Cliquez afin d’afficher et de 
masquer les styles de liste et 
de caractère dans le tiroir.
Appuyez dessus et choisissez 
une option afin de créer un style.
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Pour personnaliser la barre d’outils :
1 Choisissez Afficher > Personnaliser la barre d’outils.
2 Pour ajouter un élément à la barre d’outils, faites glisser son icône vers la barre d’outils 
en haut.
3 Pour supprimer un élément de la barre d’outils, faites-le glisser à l’extérieur de la barre 
d’outils.
4 Pour réorganiser les éléments dans la barre d’outils, faites-les glisser à un autre endroit 
sur la barre.
5 Pour réduire les icônes sur la barre d’outils, sélectionnez Petites icônes.
6 Pour n’afficher que les icônes ou le texte, choisissez une option dans le menu local 
Afficher.
Si vous reconfigurez fréquemment la barre d’outils, vous pouvez y ajouter le bouton 
Personnaliser.
Remarque :  vous pouvez restaurer le jeu par défaut de boutons de barre d’outils en 
faisant glisser celui-ci vers la barre d’outils. Pour savoir à quoi sert un bouton de la 
zone de dialogue Personnaliser, faites-le glisser vers la barre d’outils, puis positionnez 
le pointeur dessus jusqu’à ce qu’une balise d’aide apparaisse.
Ajoutez des zones de texte, des formes, 
des tableaux et des graphiques.
Ouvrez la fenêtre 
Inspecteur, le navigateur 
de média, la fenêtre 
Couleurs et le panneau 
Police.
Créez des dispositions 
de colonne à la volée.
Appliquez les styles 
au texte et aux listes.
Changez la façon dont le texte 
s’ajuste autour des objets.
Ajoutez des pages avec une mise en 
forme prédéfinie à votre document.
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La fenêtre Inspecteur
La fenêtre Inspecteur vous permet d’accéder facilement aux outils de mise en forme 
pendant que vous travaillez. Vous pouvez mettre en forme la plupart des éléments de 
votre document à l’aide des dix sous-fenêtres de la fenêtre Inspecteur, notamment la 
disposition du document, l’apparence du texte, la taille et la position des graphismes, 
et bien d’autres choses encore.
Pour ouvrir une fenêtre Inspecteur :
m Choisissez Afficher > Afficher l’Inspecteur (ou cliquez sur Inspecteur dans la barre 
d’outils).
Cliquez sur l’un des boutons du haut afin d’afficher la sous-fenêtre Inspecteur. 
Par exemple, le fait de cliquer sur le quatrième bouton à partir de la gauche affiche 
l’Inspecteur de texte. Plusieurs fenêtres de l’Inspecteur peuvent être ouvertes 
simultanément.
Pour ouvrir une autre fenêtre Inspecteur :
m Choisissez Afficher > Nouvel Inspecteur (ou appuyez sur la touche Option tout 
en cliquant sur Inspecteur dans la barre d’outils).
Le panneau Police
Pages utilise le panneau Police de Mac OS X, vous permettant d’utiliser n’importe 
quelle police de l’ordinateur dans vos documents.
Pour ouvrir le panneau Police :
m Choisissez Format > Police > Fenêtre des polices (ou cliquez sur Polices dans la barre 
d’outils).
Utilisez le panneau Police afin de sélectionner les polices, les tailles de police et d’autres 
fonctionnalités de mise en forme (ombrage, barré, etc.) Pour plus de détails sur l’utilisation du panneau Police et sur la modification de l’aspect du texte, consultez chapitre 3, 
“Mise en forme de texte et de paragraphes”.
Les boutons en haut de la 
fenêtre Inspecteur ouvrent les 
dix inspecteurs :  Document, 
Disposition, Habillage, Texte, 
Graphismes, Mesures, Tableaux, 
Graphiques, Liens et QuickTime.
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La fenêtre Couleurs
Utilisez la fenêtre Couleurs de Mac OS X pour choisir les couleurs du texte, des objets 
dessinés ou des ombres.
Pour ouvrir la fenêtre Couleurs :
m Choisissez Afficher > Afficher les couleurs (ou cliquez sur Couleurs dans la barre 
d’outils).
Pour plus d’informations sur l’utilisation de la fenêtre Couleurs pour définir la couleur 
des lignes, du texte et des formes, reportez-vous au chapitre 7, “Modification de 
propriétés d’objets”.
Raccourcis
Vous pouvez utiliser le clavier pour exécuter nombre des commandes et tâches des 
menus de Pages. Une liste complète de raccourcis clavier est disponible dans l’aide 
en ligne.
Pour afficher la liste des raccourcis clavier :
m Dans Pages, choisissez Aide > Raccourcis clavier Pages.
De nombreuses commandes sont également disponibles par l’intermédiaire de 
raccourcis clavier, auxquels vous pouvez accéder directement à partir de l’objet avec 
lequel vous travaillez.
Pour ouvrir un menu contextuel :
m Appuyez sur la touche Contrôle en cliquant sur un objet.
Les menus contextuels sont particulièrement utiles pour travailler sur les tableaux et 
les graphiques.
Le document Pages 
Si vous créez un long document ou que l’aspect visuel est un élément important, 
il peut être utile de réfléchir à l’aspect général du document avant de commencer 
à travailler. Voici quelques éléments à prendre en considération lors de la création 
d’un document.
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Disposition et style des documents
Pensez à l’aspect général du document, y compris sa disposition et l’utilisation de 
l’espace. La plupart de ces questions sont traitées dans chapitre 5, “Mise en forme de 
la disposition et de la table des matières d’un document”.
Â Quel type de document créez-vous et quel modèle correspond le mieux à la disposition dont vous avez besoin ?
Â Le document nécessite-t-il une orientation de type paysage ou portrait ? Prenez 
soin de définir cette option dans la boîte de dialogue Format d’impression avant de 
commencer. Reportez-vous à la section “Configuration de l’orientation et de la taille 
des pages” à la page 101.
Â Si vous concevez une disposition de page unique, les marges du document sontelles définies comme vous le souhaitez ? Reportez-vous à la section “Définition des 
marges de page” à la page 102.
Â Le document sera-t-il relié ? Si oui, tenez compte des numéros de page, des marges 
et des sauts de section sur les pages recto et verso du document. Reportez-vous 
à la section “Création d’un document avec des pages opposées gauche et droite” à 
la page 106.
Â Le document sera-t-il divisé en sections avec différentes dispositions, numérotations 
des pages, en-têtes et pieds de page ou éléments de conception ? Déterminez 
dans quels cas vous pouvez utiliser des sauts de disposition et des sauts de section. 
Reportez-vous à la section “Ajout d’en-têtes et de pieds de page, de numéros de 
page et de notes de bas de page” à la page 107.
Â La disposition du document nécessite-t-elle des colonnes ? Reportez-vous à la 
section “Création de colonnes” à la page 102.
Â Le document sera-t-il suffisamment long pour nécessiter une table des matières ? 
Si tel est le cas, prenez soin d’utiliser des styles d’en-tête cohérents dans l’ensemble 
du document. Reportez-vous à la section “Génération d’une table des matières” à la 
page 114.
Apparence du texte
Déterminez de façon globale la façon dont vous souhaitez utiliser le texte dans votre 
document(façon dont il sera utilisé pour mettre l’accent sur l’organisation du contenu 
et pour créer un design attrayant). La plupart de ces questions sont traitées dans 
chapitre 3, “Mise en forme de texte et de paragraphes”.
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Â Quelles polices utiliserez-vous dans le document ?
Â Existe-t-il des styles d’en-tête ou des polices que vous souhaitez utiliser de manière 
cohérente dans l’ensemble du document ? Consultez chapitre 4, “Utilisation de styles”.
Â Quelle forme ou image souhaitez-vous utiliser pour les puces ? Quels styles de 
nombre pour les structures ? Reportez-vous à la section “Création de listes à puces 
ou numérotées et de structures” à la page 69.
Â Allez-vous utiliser des légendes, des barres latérales ou d’autre texte mis en 
surbrillance dans votre document ? Reportez-vous à la section “Création de renvois, 
de barres latérales et de texte en surbrillance” à la page 72.
Utilisation des graphismes et autres médias
Déterminez la façon dont vous allez utiliser les éléments graphiques dans votre 
document, ainsi que la façon dont ils apparaîtront dans le flux du document, ainsi 
que les types de graphisme que vous pouvez utiliser. Pages fournit des outils que vous 
pouvez utiliser pour créer des tableaux et des graphiques afin d’organiser et d’afficher 
les informations. Pour en savoir plus sur la création de tableaux et de graphiques, 
consultez le chapitre 8, “Création de tableaux” et chapitre 9, “Création de graphiques”. 
Pour en savoir plus sur les autres utilisations des graphismes, consultez chapitre 6, 
“Utilisation de graphismes et autres médias”.
Â Comment les images seront-elles utilisées dans le document ?
Â Pouvez-vous utiliser des tableaux pour présenter clairement les informations ? 
Consultez chapitre 8, “Création de tableaux”.
Â Pouvez-vous utiliser des graphiques pour afficher les données de manière efficace ? 
Consultez chapitre 9, “Création de graphiques”.
Â Quel sera le format final du document (page imprimée, HTML, etc.) ? Reportez-vous 
à la section “Exportation vers d’autres formats de document” à la page 195.
Â Utiliserez-vous du son ou des séquences dans votre document ? Reportez-vous à la 
section “Ajout de son et de séquences” à la page 135.
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2
2 Création d’un document à 
l’aide des modèles de Pages
Ce chapitre fournit des informations de base 
sur l’utilisation de Pages. Il explique également 
comment utiliser les modèles de Pages pour créer 
facilement vos documents professionnels, avec 
une mise en page relativement complexe.
Avant de commencer à créer un document Pages, déterminez son utilisation. Si 
votre document est destiné à l’impression, quelle sera la taille du papier ? Quelle sera 
l’orientation de la page (portrait ou paysage) ? Comment sera-t-il plié ? Cela permet 
également de déterminer si le document sera long et nécessitera une table des 
matières et une numérotation des pages. Le fait de connaître ces paramètres vous 
permettra de choisir le modèle approprié et de le configurer correctement avant de 
commencer.
Importation d’un document Microsoft Word ou AppleWorks
Si vous avez déjà créé un document dans Microsoft Word ou dans AppleWorks, 
vous pouvez l’importer dans Pages et continuer à travailler dessus. Faites simplement glisser l’icône du document Microsoft Word ou AppleWorks vers l’icône de 
l’application Pages.
Vous pouvez également réexporter des documents Pages vers MS Word ou au 
format PDF, RTF (Rich Text Format) ou HTML. Pour plus d’informations sur l’importation et l’exportation de documents Microsoft Word, reportez-vous à la section 
“Exportation vers d’autres formats de document” à la page 195.
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Étape 1 :  Sélectionnez un type de document
Pour commencer un nouveau document Pages, double-cliquez sur l’icône Pages. 
Dans le sélectionneur de modèles, sélectionnez le modèle correspondant le mieux 
au type de document que vous souhaitez créer. Si vous souhaitez commencer dans 
un document ne contenant aucun espace réservé pour du texte ou des images, 
sélectionnez Vide.
En utilisant un modèle avec des espaces réservés pour du texte ou des images, 
vous pouvez facilement créer un document professionnel, tel qu’un rapport scolaire, 
une lettre commerciale, un journal ou une brochure, sans avoir à concevoir la mise 
en page. Chaque modèle comprend des styles prédéfinis pour les titres, les en-têtes, 
les tableaux, les notes de bas de page, les puces et autres fonctionnalités de mise en 
forme. 
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Si vous ne voyez pas le sélectionneur de modèles lorsque vous ouvrez Pages pour 
la première fois, vous pouvez l’afficher en définissant une préférence dans les Préfé-
rences Pages. Vous pouvez également configurer Pages afin d’ouvrir automatiquement 
un document vide ou le modèle de votre choix chaque fois que vous le démarrez.
Pour afficher le sélectionneur de modèles ou pour configurer le modèle par défaut 
pour les nouveaux documents :
m Sélectionnez Pages > Préférences, puis sélectionnez l’une des options suivantes :
Â Pour que le sélectionneur de modèles apparaisse systématiquement lorsque vous 
ouvrez Pages, sélectionnez “Pour les nouveaux documents :  Afficher la zone de 
dialogue du sélectionneur de modèles”.
Â Pour que Pages ouvre toujours le même type de document lorsque vous le lancez, 
sélectionnez “Pour les nouveaux documents :  Utiliser le modèle :  [nom du modèle]”, 
puis cliquez sur Choisir. Sélectionnez le nom d’un modèle, puis cliquez sur Choisir.
Lorsque vous avez sélectionné un modèle, un document s’ouvre à l’écran.
Développement du modèle en ajoutant des pages
Chaque page d’un modèle Pages présente une mise en page unique (à l’exception 
du modèle Vide). Vous pouvez choisir d’utiliser les mises en page qui s’affichent à la 
première ouverture du document. Si les mises en page ne satisfont pas à vos besoins, 
vous pouvez choisir parmi des mises en page supplémentaires qui s’intègrent au 
modèle.
Pour ajouter une page de modèle à partir de la page actuelle :
m Sélectionnez Insérer > Pages > [modèle de page] (ou cliquez sur Pages dans la barre 
d’outils et sélectionnez une page de modèle).
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La nouvelle page est ajoutée immédiatement à la suite de la page où vous avez placé 
le point d’insertion.
Pages supplémentaires :  
choisissez une page dans 
le menu local Pages.
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Étape 2 :  Ajoutez du texte
Si vous ouvrez un document vide, vous pouvez commencer à taper du texte. À mesure 
que vous tapez, le texte remplit la page. Lorsqu’une page est remplie, le texte passe 
automatiquement à la page suivante.
Si vous travaillez avec un modèle incluant des espaces réservés pour du texte ou 
des images, vous pouvez ajouter du texte et des graphismes aux zones des espaces 
réservés, comme indiqué ci-dessous.
Ajout de texte à des zones de texte d’espace réservé
Les modèles contiennent du texte d’espace réservé, qui montre à quoi ressemblera le 
texte et où il sera placé dans le document terminé. Le texte d’espace réservé est soit 
un libellé (par exemple, “Nom du destinataire”), soit du texte utilisant des caractères 
latins dans le corps document, dans les zones de texte, dans les en-têtes et ailleurs.
Zones de texte principales
Lorsque vous cliquez sur un texte d’espace réservé dans un modèle de document, 
l’ensemble de la zone de texte est mis en surbrillance.
Lorsque vous tapez du texte, le texte de l’espace réservé disparaît et il est remplacé 
par le texte que vous tapez. Celui-ci se comporte comme du texte standard.
Zones de texte
Une partie du texte d’espace réservé est contenue dans des zones de texte ou des 
cellules de tableau, afin de préserver la mise en forme. Lorsque vous cliquez sur du 
texte d’espace réservé qui se trouve dans une zone de texte, une bordure rectangulaire grise apparaît autour.
Texte d’espace réservé :  l’ensemble 
de la zone de texte est sélectionné 
lorsque vous cliquez.
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Pour sélectionner le texte d’un espace réservé dans une zone de texte :
m Cliquez une fois pour sélectionner la zone de texte, puis double-cliquez pour 
sélectionner le texte à l’intérieur de la zone.
En général, les bordures des zones de texte ne sont visibles que lorsque la zone de texte 
ou le texte qu’elle contient est sélectionné, ou lorsque vous avez activé le mode page. 
Pour savoir comment modifier l’aspect des zones de texte, reportez-vous à la section 
“Création de renvois, de barres latérales et de texte en surbrillance” à la page 72.
Tableaux
Certains tableaux contiennent du texte d’espace réservé. Lorsque vous sélectionnez 
du texte qui se trouve à l’intérieur d’une cellule de tableau, un rectangle jaune apparaît autour.
Pour sélectionner le texte d’un espace réservé dans un tableau :
1 Cliquez une fois pour sélectionner le tableau, puis cliquez une fois pour sélectionner 
une cellule.
Le texte à l’intérieur de la cellule est sélectionné en vue de sa modification lorsque 
vous sélectionnez la cellule. Vous pouvez savoir qu’il s’agit d’un texte d’espace réservé 
s’il est mis en surbrillance en bleu ; dans le cas contraire, il s’agit de texte standard.
2 Appuyez sur la touche Tab pour passer à la cellule suivante, ou sur Maj + Tab pour 
passer à la cellule précédente.
Pour en savoir plus sur l’utilisation de tableaux ou sur la modification de leur aspect, 
consultez le chapitre 8, “Création de tableaux”.
Bordure de zone de texte 
grise : bordure qui apparaît 
lorsque vous sélectionnez 
la zone de texte.
Cellule de tableau unique sélectionnée en vue de sa modification.
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Important :  les zones de texte et les tableaux contenant du texte d’espace réservé 
font partie de la conception par défaut du modèle. Pour préserver la conception, 
prenez soin de ne pas appuyer sur Suppr après avoir sélectionné la zone de texte ou 
le tableau. Le fait d’appuyer sur Suppr entraîne la suppression de l’objet sélectionné 
de la page. Si vous supprimez accidentellement une zone de texte ou un tableau, 
vous pouvez immédiatement le récupérer en cliquant sur Édition > Annuler 
Supprimer (ou en appuyant sur Commande + Z). De manière générale, si vous faites 
une erreur ou que vous changez d’avis sur une opération que vous avez effectuée, 
vous pouvez annuler immédiatement la dernière action via la commande Annuler.
Colonnes
Occasionnellement, les modèles peuvent contenir du texte d’espace réservé apparaissant dans des colonnes. Il peut être plus facile de travailler avec des colonnes de texte 
si la disposition du document est visible, mais vous pouvez également masquer la 
disposition afin de voir l’aspect du document terminé.
Pour afficher ou masquer la disposition du document :
m Cliquez sur Présentation > Afficher la disposition ou Masquer la disposition.
Il peut également être utile d’afficher les autres caractères de mise en forme (caractères invisibles) pendant votre travail, par exemple les tabulations et les sauts de 
paragraphe.
Pour afficher ou masquer les caractères invisibles :
m Cliquez sur Présentation > Afficher les caractères invisibles ou Masquer les caractères 
invisibles.
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Étape 3 :  Ajoutez des graphismes et d’autres éléments
Vous pouvez utiliser divers types d’élément dans un document Pages, notamment 
des images fixes, des séquences vidéo, du son, des formes dessinées, des graphiques 
et des tableaux. Les séquences vidéo et le son peuvent être utiles si vous prévoyez 
l’affichage du document final à l’écran au format HTML ou en tant que fichier Pages. 
Pour obtenir une liste plus complète des types de fichier acceptés par Pages, consultez 
le chapitre 6, “Utilisation de graphismes et autres médias”.
Placement d’images dans des espaces réservés d’image
Les images contenues dans les modèles Pages sont des espaces réservés d’image. 
Ceux-ci représentent la taille et la disposition des images que vous allez ajouter à 
votre document. Vous pouvez reconnaître un espace réservé d’image en y déplaçant 
le curseur ; une balise d’aide apparaît, vous invitant à le remplacer par votre image.
Pour remplacer une image dans un espace réservé d’image :
m Faites glisser l’image du navigateur de média ou du Finder vers l’espace réservé 
d’image.
Ajout d’images, de séquences vidéo et de fichiers son ailleurs 
dans votre document
Vous pouvez ajouter des images, des séquences vidéo ou des fichiers son à un document Pages en les faisant simplement glisser du Finder vers la fenêtre du document, 
ou en les faisant glisser à partir du navigateur de média. Celui-ci affiche les images 
stockées dans votre bibliothèque iPhoto, les fichiers son stockés dans votre bibliothèque iTunes, ainsi que les séquences vidéo stockées dans le dossier Séquences 
de votre dossier Départ.
Pour ouvrir le navigateur de média :
m Cliquez sur Présentation > Afficher le navigateur de média (ou cliquez sur Média dans 
la barre d’outils), puis sélectionnez iPhoto, iTunes ou Séquences pour afficher le type 
de fichier que vous souhaitez utiliser.
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Lorsque vous ajoutez un objet à un document, vous pouvez soit le placer dans une 
position fixe sur la page (objet fixe), de sorte que le texte que vous tapez s’affiche 
autour de l’objet, soit l’ancrer au texte (objet en ligne), de sorte qu’il se déplace avec le 
texte situé autour. Si vous créez un objet fixe, vous pouvez ajuster la position du texte 
autour de l’objet, en modifiant l’habillage. Pour en savoir plus sur la comparaison des 
objets fixes et des objets en ligne, reportez-vous à la section “Comparaison des objets 
fixes et des objets en ligne” à la page 117. Pour plus d’informations sur l’habillage de 
texte, reportez-vous à la section “Habillage d’un objet avec du texte” à la page 132.
Pour ajouter une image en ligne avec le texte :
m Placez le point d’insertion là où vous souhaitez que l’image apparaisse, puis cliquez 
sur Insérer > Choisir. Sélectionnez le fichier image et cliquez sur Insérer.
m Faites glisser une image de la sous-fenêtre iPhoto du navigateur de média vers la position où elle doit apparaître dans le texte. À mesure que vous faites glisser l’image sur 
le texte, le point d’insertion indique à quel endroit l’image apparaît si vous la déposez.
m Faites glisser une image du Finder vers la position où elle doit apparaître dans le texte. 
À mesure que vous faites glisser l’image sur le texte, le point d’insertion indique à quel 
endroit l’image apparaît si vous la déposez.
Pour ajouter une image fixe :
m Cliquez à l’extérieur des zones de texte dans le document afin qu’aucun point d’insertion ne soit visible, cliquez sur Insérer > Choisir, puis cliquez sur le fichier image et 
cliquez sur Insérer.
m Faites glisser une image de la sous-fenêtre iPhoto du navigateur de média vers une 
zone de votre document ne contenant pas de texte.
m Faites glisser une image du Finder vers une zone du document ne contenant pas de 
texte.
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Les images peuvent être rognées, redimensionnées et pivotées. Elles peuvent également être regroupées, ce qui facilite le repositionnement de plusieurs graphismes 
que vous souhaitez conserver ensemble. Vous pouvez également superposer des 
graphismes, ajuster leur opacité et ajouter des ombres afin de créer des effets visuels 
saisissants. Les images fixes peuvent également être masquées (rognées) de sorte que 
seule une partie de l’image soit visible sur la page. Pour plus d’informations sur l’utilisation d’images, consultez le chapitre 6, “Utilisation de graphismes et autres médias”. 
Pour en savoir plus sur l’ajustement des ombres et de l’opacité, consultez le chapitre 7, 
“Modification de propriétés d’objets”.
Pour en savoir plus sur l’ajout de formes, de tableaux et de graphiques simples, reportezvous à la section “Ajout de formes simples, de tableaux et de graphiques” à la page 121.
Ajout d’adresses Web et électroniques
Vous pouvez créer des liens actifs vers des adresses Web (URL) et des adresses électroniques. Lorsque vous cliquez sur un lien Web, il ouvre un navigateur Web et affiche la 
page Web spécifiée. Lorsque vous cliquez sur une adresse électronique, elle ouvre un 
programme de messagerie électronique et crée un nouveau message. Vous pouvez 
également créer des signets qui vous permettent de passer directement à un mot ou 
une phrase spécifique dans le document. Pour obtenir des instructions spécifiques 
sur la création de liens et de signets, reportez-vous à la section “Ajout de liens et de 
signets” à la page 137.
Positionnement du texte et des graphismes
Pages offre plusieurs outils qui permettent de positionner le texte, les images et les 
autres objets sur la page, de façon à pouvoir obtenir la mise en page souhaitée. Des 
guides d’alignement apparaissent dans certains modèles (ou vous pouvez créer vos 
guides) afin d’aligner les objets fixes n’importe où dans une page. Les règles affichent 
les mesures en pouces, en centimètres, en points ou en picas, de sorte que vous 
pouvez facilement savoir où placer un objet.
Pages affiche également des balises de position qui indiquent les coordonnées X et Y 
du coin supérieur gauche d’un objet lorsque vous le déplacez sur la page, ou l’angle 
de l’objet lorsque vous le faites pivoter. Lorsque vous redimensionnez un objet, des 
balises de taille apparaissent, affichant la hauteur et la largeur de l’objet.
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Règles
Vous pouvez afficher des règles afin de faciliter le positionnement des objets sur la 
page. Les règles indiquent la distance d’un objet par rapport au bord supérieur et 
au bord gauche de la page.
Pour afficher les règles :
m Choisissez Présentation > Afficher les règles.
Pour changer les unités de mesure dans les règles :
1 Cliquez sur Pages > Préférences.
2 Choisissez un élément dans le menu local Unités de la règle. Pour afficher les mesures 
sous forme de pourcentage de la distance dans la page, sélectionnez Afficher en pourcentage les unités de la règle.
Pour placer le point d’origine horizontal de la règle au centre de la page :
m Dans les Préférences Pages, sélectionnez Placer l’origine au centre de la règle.
Lorsque vous modifiez les paramètres de la règle dans les Préférences Pages, les 
nouveaux réglages s’appliquent à tous les documents affichés dans Pages, jusqu’à 
ce que vous changiez de nouveau les réglages.
Guides d’alignement
À mesure que vous déplacez les zones de texte et les images fixes dans le document, 
des guides d’alignement bleus apparaissent afin de vous aider à centrer et à aligner 
les objets dans la page. Ils apparaissent lorsque le centre ou le bord d’un objet s’aligne 
sur le centre ou le bord d’un autre objet ou encore sur le centre de la page, en fonction de vos préférences. Vous pouvez créer vos guides d’alignement afin d’aligner 
précisément les objets sur une page. Les guides d’alignement (même ceux que vous 
créez) n’apparaissent pas lorsque vous imprimez le document ; ils ne sont visibles que 
lors de l’édition d’un document.
Pour placer les guides d’alignement sur une page :
1 Cliquez sur Présentation > Afficher les règles afin de faire apparaître les règles en haut 
et à gauche de la page.
2 Cliquez à l’extérieur d’une zone quelconque de la page, afin que le point d’insertion 
ne soit pas visible.
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3 Placez le pointeur sur une règle et faites-le glisser sur la page. Un guide d’alignement 
bleu apparaît.
4 Faites glisser le guide à l’emplacement souhaité sur la page.
Pour supprimer les guides d’alignement que vous avez placés sur une page :
m Faites glisser le guide d’alignement à l’extérieur de la page.
Si les guides d’alignement vous gênent dans votre travail, vous pouvez les masquer 
temporairement.
Pour masquer temporairement les guides d’alignement :
m Maintenez la touche Commande enfoncée lorsque vous faites glisser un objet.
Vous pouvez activer ou désactiver les guides d’alignement et les balises de taille et 
de position dans les Préférences Pages. Vous pouvez également faire apparaître les 
guides d’alignement uniquement lorsque les bords des objets sont alignés, ou lorsque 
les centres des objets sont alignés.
Lorsque vous modifiez les réglages des guides d’alignement et des balises dans les 
Préférences Pages, les nouveaux paramètres s’appliquent à tous les documents affichés dans Pages, jusqu’à ce que vous changiez de nouveau les réglages.
Pour modifier le comportement des guides d’alignement et des balises affichés 
lorsque vous déplacez les objets :
1 Cliquez sur Pages > Préférences.
2 Pour désactiver les balises de taille et de position, désélectionnez “Édition :  Afficher la 
taille et la position des objets lors de leur déplacement”.
3 Pour désactiver les guides qui apparaissent lorsque le centre d’un objet est aligné sur un 
autre objet ou sur le centre de la page, désélectionnez “Guides d’alignement : Afficher 
les guides au centre de l’objet”.
4 Pour activer les guides d’alignement qui apparaissent lorsque les bords d’un objet 
sont alignées sur un autre objet ou sur le centre de la page, désélectionnez “Guides 
d’alignement :  Afficher les guides sur les bords de l’objet”.
Pour changer la couleur des guides d’alignement :
m Dans les Préférences Pages, cliquez sur le cadre de couleur Guides d’alignement et 
sélectionnez une couleur dans la fenêtre Couleurs.
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Verrouillage d’objets sur la page
Une fois que vous avez placé les graphismes exactement à l’emplacement souhaité 
sur la page, vous pouvez les verrouiller à cette position afin d’empêcher leur déplacement accidentel pendant votre travail.
Pour verrouiller un objet à sa position sur la page :
m Sélectionnez un objet et choisissez Disposition > Verrouiller.
Vous ne pouvez pas modifier un objet qui a été verrouillé à sa position sur la page. 
Pour déverrouiller un objet, cliquez sur Disposition > Déverrouiller.
Étape 4 :  Éditez le document
Une fois que vous avez tapé du texte dans le document, vous pouvez en supprimer 
ou en réorganiser (copier-coller) des parties, vérifier l’orthographe, ou encore rechercher et remplacer des mots ou phrases spécifiques.
Supprimer, copier et coller du texte
Si vous souhaitez copier ou déplacer une portion de texte d’une partie du document 
vers une autre, le moyen le plus simple consiste à le copier (ou couper) de son emplacement d’origine, puis à le coller à son nouvel emplacement. Si vous copiez du texte, 
vous ne le supprimez pas de son emplacement d’origine ; c’est le cas si vous coupez 
du texte.
Pour copier (ou couper) et coller du texte :
1 Sélectionnez le texte à copier ou à déplacer.
2 Cliquez sur Édition > Couper ou Copier.
3 Placez le curseur de texte à l’emplacement vers lequel vous souhaitez déplacer le 
texte, puis effectuez l’une des opérations suivantes :
Â Cliquez sur Édition > Coller afin de préserver la mise en forme originale du texte 
collé.
Â Cliquez sur Édition > Coller le style et l’appliquer afin de modifier la mise en forme 
du texte collé afin qu’elle corresponde à la mise en forme du texte situé autour.
Pour supprimer totalement le texte sélectionné :
m Cliquez sur Édition > Supprimer.
F2644.book  Page 41  Thursday, January 13, 2005  5:18 PM42 Chapitre 2    Création d’un document à l’aide des modèles de Pages
Recherche et remplacement de texte
Vous pouvez rechercher chaque instance d’un mot ou d’une phrase dans votre document. Si vous souhaitez remplacer toutes les instances d’un mot ou d’une phrase de 
votre document par autre chose (par exemple, si vous écrivez une lettre et que vous 
devez remplacer chaque instance du nom “Rodriguez” par “M. Rodriguez”), vous 
pouvez utiliser la fonctionnalité rechercher/remplacer.
Remarque :  il est impossible de chercher et de remplacer le texte d’un espace réservé. 
Pour cela, vous devez tout d’abord faire en sorte que le texte ne soit plus défini en 
tant que texte d’espace réservé. Cliquez sur le texte pour le sélectionner et désélectionnez “Définir comme texte pour espace réservé” dans Format > Avancé.
Pour rechercher, ou rechercher et remplacer, un mot dans un document :
1 Cliquez sur Édition > Rechercher > Rechercher.
2 Tapez le mot dans le champ Rechercher.
3 Si vous souhaitez remplacer le mot par un autre, tapez le nouveau mot dans le champ 
Remplacer.
4 Selon que vous souhaitez effectuer des changements délicats ou non, effectuez l’une 
des opérations suivantes :
Â Cliquez sur Suivant ou sur Précédent afin de mettre en surbrillance l’instance 
suivante ou précédente du mot. Continuez de cliquer sur Suivant ou sur Précédent 
jusqu’à ce que vous ayez localisé l’instance recherchée.
Â Cliquez sur Remplacer pour remplacer l’instance sélectionnée du mot par le 
nouveau mot, puis cliquez sur Suivant ou Précédent afin de rechercher l’instance 
suivante.
Â Cliquez sur Remplacer et rechercher afin de remplacer l’instance en surbrillance du 
mot et de rechercher la suivante.
Â Cliquez sur Remplacer tout afin de remplacer toutes les instances du mot par le 
nouveau.
5 Pour fermer la fenêtre Rechercher et remplacer lorsque vous avez terminé, cliquez sur 
le bouton Fermer dans le coin supérieur gauche.
Si vous souhaitez rechercher ou remplacer une phrase entière ou d’autres casses 
spécifiques d’un mot, vous pouvez utiliser la sous-fenêtre Avancé de la fenêtre Rechercher et remplacer.
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Pour remplacer un mot ou une phrase à l’aide des fonctionnalités avancées 
de recherche :
1 Cliquez sur Édition > Rechercher > Rechercher, puis cliquez sur Avancé.
2 Tapez le texte ou la phrase dans le champ Rechercher.
3 Si vous souhaitez uniquement rechercher le texte lorsqu’il apparaît avec un style de 
paragraphe particulier (par exemple, le style En-tête 1) choisissez le style dans le 
menu local Style. Pour plus d’informations sur les styles, consultez le chapitre 4, “Utilisation de styles”.
Sélectionnez l’option 
permettant de rendre la 
recherche sensible à la casse.
Sélectionnez l’option permettant de rechercher des 
mots entiers uniquement.
Tapez le texte que vous 
recherchez.
Sélectionnez l’option permettant de 
rechercher jusqu’à la fin du document, puis de reprendre au début.
Remplacez le texte 
une instance à la 
fois, ou toutes en 
même temps.
Recherchez vers l’arrière 
ou vers l’avant dans le 
document.
Choisissez le style de 
paragraphe dans lequel 
le texte apparaît.
Choisissez le style de 
paragraphe du nouveau 
texte.
Choisissez de rechercher dans 
l’ensemble du document ou uniquement dans le corps du texte principal.
F2644.book  Page 43  Thursday, January 13, 2005  5:18 PM44 Chapitre 2    Création d’un document à l’aide des modèles de Pages
4 Choisissez Tout le document dans le menu local Dans si vous souhaitez lancer la 
recherche dans tout le document, y compris les en-têtes, les pieds de page et les 
zones de texte ; cliquez sur Corps du texte principal si vous souhaitez uniquement 
rechercher dans le corps du texte principal du document.
5 Sélectionnez Respecter la casse si vous souhaitez uniquement rechercher les instances 
du texte présentant la même casse que celle indiquée dans le champ Rechercher ; à 
défaut, la recherche ne tient pas compte de la capitalisation.
6 Sélectionnez Mots entiers si vous souhaitez uniquement rechercher les instances où le 
texte apparaît sous forme de mot distinct ; à défaut, les résultats incluent les instances 
du texte apparaissant au sein de mots.
7 Si vous souhaitez remplacer le texte par un autre mot ou une autre phrase, tapez-le 
dans le champ Remplacer.
8 Si vous souhaitez changer le style de paragraphe du nouveau mot ou de la nouvelle 
phrase, choisissez un style dans le menu local Style.
9 Selon que vous souhaitez effectuer des changements délicats ou non, effectuez l’une 
des opérations suivantes :
Â Cliquez sur Suivant ou sur Précédent afin de mettre en surbrillance l’instance 
suivante ou précédente du texte. Continuez de cliquer sur Suivant ou sur Précédent 
jusqu’à ce que vous ayez localisé l’instance recherchée.
Â Cliquez sur Remplacer pour remplacer l’instance sélectionnée du texte par le 
nouveau texte, puis cliquez sur Suivant ou Précédent afin de rechercher l’instance 
suivante.
Â Cliquez sur Remplacer et rechercher afin de remplacer l’instance en surbrillance du 
texte et de rechercher la suivante.
Â Cliquez sur Remplacer tout afin de remplacer toutes les instances du texte par le 
nouveau mot ou la nouvelle phrase.
10 Pour fermer la fenêtre Rechercher et remplacer lorsque vous avez terminé, cliquez sur 
le bouton Fermer dans le coin supérieur gauche.
Si vous utilisez fréquemment la fenêtre Rechercher et remplacer, vous pouvez ajouter 
le bouton Rechercher à la barre d’outils de Pages afin qu’elle soit disponible d’un 
simple clic. Pour en savoir plus sur la personnalisation de la barre d’outils, reportezvous à la section “La barre d’outils” à la page 23.
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Vérification d’orthographe lors de la frappe
Pages utilise le correcteur orthographique de Mac OS X pour détecter les erreurs 
d’orthographe du document. Vous pouvez configurer le correcteur orthographique 
afin qu’il indique les erreurs lors de la saisie, ou vous pouvez à tout moment vérifier 
l’ensemble du document ou du texte sélectionné.
Pour mettre en évidence les mots mal orthographiés lors de la saisie :
m Cliquez sur Édition > Orthographe > Vérifier l’orthographe lors de la frappe.
Lors de la frappe, les mots mal orthographiés apparaissent soulignés avec une ligne 
pointillée rouge. Si vous n’êtes pas certain de l’orthographe du mot, vous pouvez 
afficher une liste des orthographes possibles.
Pour afficher une liste de suggestions d’orthographe :
1 Maintenez la touche Contrôle enfoncée et cliquez sur le mot mal orthographié. Une 
liste d’orthographes possibles apparaît (il est possible qu’aucune suggestion ne soit 
proposée si le mot n’est pas reconnu).
2 Choisissez l’orthographe correcte si elle s’affiche dans la liste.
Si vous êtes certain que le mot est correctement orthographié et que vous souhaitez 
l’ajouter au dictionnaire utilisé pour tous les documents, choisissez Mémoriser l’orthographe dans le menu local.
Si vous ne souhaitez pas que ce mot soit désigné comme mal orthographié, mais 
que vous ne souhaitez pas l’ajouter au dictionnaire utilisé pour tous les documents, 
choisissez Ignorer l’orthographe dans le menu local.
Une fois que vous avez corrigé le mot mal orthographié, la ligne rouge disparaît.
Pour vérifier mot par mot l’orthographe dans votre document :
m Placez le curseur dans un mot à vérifier, ou n’importe où dans le document, puis 
effectuez l’une des opérations suivantes :
Â Choisissez Édition > Orthographe > Vérifier l’orthographe.
Le correcteur orthographique commence la vérification de chaque mot du document, en commençant là où se trouve le curseur. Le premier mot mal orthographié 
est mis en surbrillance. Vous pouvez le corriger ou choisir de nouveau la même 
commande de menu, afin de continuer à vérifier le document. Pour parcourir le 
document plus rapidement, appuyez sur Commande + point-virgule (;) afin de 
poursuivre la vérification du document.
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Â Choisissez Édition > Orthographe > Orthographe.
La fenêtre Orthographe s’ouvre avec une liste d’orthographes suggérées. Si aucune 
ne semble correcte, vous pouvez retaper le mot et cliquer sur Proposition afin d’afficher une nouvelle liste de suggestions. Sélectionnez-en une et cliquez sur Corriger 
afin de l’appliquer au mot mal orthographié. Cliquez sur Rechercher le suivant afin 
de passer au mot mal orthographié suivant.
Utilisez le menu local Dictionnaire de la fenêtre Orthographe afin d’utiliser un dictionnaire d’une autre langue pour un mot sélectionné. Le changement de dictionnaire 
dans la fenêtre Orthographe ne change pas le dictionnaire pour le document entier, 
mais uniquement pour des mots individuels.
Le mot mal orthographié du document apparaît ici. Vous pouvez 
le resaisir ici, afin de rechercher 
d’autres orthographes suggérées.
Sélectionnez parmi la liste 
des orthographes suggérées.
Vous pouvez corriger ou ignorer 
le mot mal orthographié, puis 
rechercher le mot suivant, ou 
resaisir le mot et cliquer sur 
Proposition afin d’afficher une 
nouvelle liste de suggestions.
Ajoutez ou supprimez 
du dictionnaire le mot 
sélectionné.
Choisissez Tout le document si 
vous souhaitez également vérifier 
l’orthographe des en-têtes, des 
pieds de page, des légendes, etc.
Si nécessaire, choisissez un 
dictionnaire d’une autre 
langue pour un mot 
sélectionné.
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Si vous utilisez fréquemment la fenêtre Orthographe, vous pouvez ajouter le bouton 
Orthographe à la barre d’outils de Pages afin qu’elle soit disponible d’un simple clic. 
Pour en savoir plus sur la personnalisation de la barre d’outils, reportez-vous à la 
section “La barre d’outils” à la page 23.
Pour désactiver le correcteur orthographique :
m Choisissez Édition > Orthographe > Vérifier l’orthographe lors de la frappe afin 
de le désélectionner (assurez-vous que la coche n’est pas présente en regard de 
la commande de menu).
Étape 5 :  Enregistrez et partagez le document
Lorsque vous travaillez dans Pages, vous créez un document Pages. Tous les 
graphismes et les données graphiques sont contenus dans ce document, lequel peut 
être déplacé d’un ordinateur vers un autre. Cependant, les polices ne sont pas incluses 
dans le document, de sorte que si vous transférez un document Pages vers un autre 
ordinateur, assurez-vous que les polices utilisées dans le document ont été installées 
dans le dossier Polices de l’autre ordinateur.
Si vous ajoutez des séquences vidéo ou audio à un document, vous pouvez les 
enregistrer avec le document Pages afin de ne pas avoir à transférer ces fichiers 
séparément.
Il est judicieux d’enregistrer régulièrement le document pendant votre travail.
Pour enregistrer un document :
1 Choisissez Fichier > Enregistrer, ou appuyez sur Commande + S.
2 Attribuez un nom au document.
3 Cliquez sur le triangle d’affichage à droite du champ Enregistrer sous.
4 Choisissez l’emplacement où enregistrer le document.
5 Si vous prévoyez de partager le document entre des ordinateurs ou avec d’autres 
utilisateurs, effectuez une ou plusieurs des opérations suivantes :
Â Sélectionnez la case Copier l’audio et les séquences dans le document si votre 
document contient des séquences vidéo ou audio.
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Si vous ne sélectionnez pas cette case, tous les fichiers audio ou vidéo que vous 
avez inclus dans le document ne sont pas associés au document si vous le transférez vers un autre ordinateur ou que vous l’envoyez à quelqu’un d’autre. Les 
documents contenant des médias peuvent présenter des tailles de fichier élevées.
Â Sélectionnez la case Copier les images de modèle dans le document si vous avez 
créé le document à partir d’un modèle de page contenant une image.
Si vous ne sélectionnez pas cette case, tout fichier image faisant partie du modèle 
n’est pas conservé avec le document si vous le transférez vers un autre ordinateur 
ou que vous l’envoyez à quelqu’un d’autre. Les documents contenant des médias 
peuvent présenter des tailles de fichier élevées.
6 Cliquez sur Enregistrer.
Pour en savoir plus sur l’exportation d’un document vers d’autres formats de fichier 
(notamment Microsoft Word, HTML, RTF, texte brut, PDF), reportez-vous à la section 
“Exportation vers d’autres formats de document” à la page 195.
Pendant que vous travaillez dans le document, vous pouvez l’enregistrer fréquemment en appuyant sur Commande + S. Vous pouvez également enregistrer une copie 
de sauvegarde de la dernière version enregistrée du document. De cette façon, si vous 
changez d’avis quant aux modifications que vous avez effectuées, vous pouvez revenir 
à la dernière version enregistrée.
Pour enregistrer une copie de sauvegarde du document :
m Choisissez Pages > Préférences, puis sélectionnez la case Créer une copie de sauvegarde de la version précédente à chaque enregistrement.
Lorsque vous enregistrez le document, la version précédente est enregistrée dans le 
même emplacement que le document avec “Copie de sauvegarde de” placé avant le 
nom du fichier. Une seule version (la dernière version enregistrée) est sauvegardée.
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Pour enregistrer une version de votre document sous un autre nom ou à un autre 
emplacement :
1 Choisissez Fichier > Enregistrer sous.
2 Attribuez un nom à votre document.
3 Sélectionnez un emplacement pour l’enregistrement du document. Si vous ne pouvez 
pas accéder à l’emplacement souhaité, cliquez sur le bouton fléché en regard du 
champ Enregistrer sous, puis recherchez l’emplacement souhaité.
4 Cliquez sur Enregistrer.
Vous pouvez imprimer tout ou partie du document. Vous pouvez également afficher 
un aperçu du document avant de l’imprimer. Il s’agit là d’un bon moyen de vérifier 
que l’ensemble du texte et des graphismes se trouvent dans la zone imprimée de la 
page.
Pour afficher un aperçu avant impression :
m Choisissez Fichier > Imprimer, puis cliquez sur le bouton Aperçu dans la zone de 
dialogue Imprimer.
Pour imprimer un document :
1 Choisissez Fichier > Imprimer
2 Si vous souhaitez plusieurs copies du document, tapez le nombre d’exemplaires 
souhaité ; vous pouvez également sélectionner De et taper une plage de pages afin 
d’imprimer seulement une partie du document.
3 Cliquez sur Imprimer.
Si vous imprimez fréquemment, vous pouvez ajouter le bouton Imprimer à la barre 
d’outils de Pages. Pour en savoir plus sur la personnalisation de la barre d’outils, 
reportez-vous à la section “La barre d’outils” à la page 23.
Pour plus d’informations sur l’impression, reportez-vous à la section “Impression de 
documents” à la page 189.
F2644.book  Page 49  Thursday, January 13, 2005  5:18 PMF2644.book  Page 50  Thursday, January 13, 2005  5:18 PM51
3
3 Mise en forme de texte et de 
paragraphes
Ce chapitre décrit en détail comment modifier 
l’apparence des caractères du texte et des paragraphes, notamment la création de listes et la mise en 
surbrillance de sections de texte.
Mise en forme de la taille et de l’apparence du texte
Vous pouvez effectuer toutes les opérations de mise en forme du texte à l’aide des 
menus de Pages et de la fenêtre Inspecteur, ou via le panneau Police. Vous pouvez 
effectuer les opérations élémentaires de mise en forme à l’aide des commandes des 
menus de Pages. Les commandes du sous-menu Police du menu Format permettent 
d’appliquer les caractéristiques suivantes au texte :
Â Gras ou italique
Â Souligné ou relief
Â Plus grand ou plus petit
Â Espacé plus largement ou plus étroitement
Â En indice ou en exposant
Pour appliquer au texte sélectionné les caractéristiques gras, italique, souligné, 
relief, plus grand ou plus petit :
m Choisissez Format > Police > [Gras, Italique, Souligné, Relief, Plus grand ou Plus petit].
Pour placer le texte sélectionné en exposant ou en indice :
m Choisissez Format > Police > Ligne de base > [Valeur par défaut, Exposant, Indice].
Pour convertir le texte sélectionné en majuscules :
m Choisissez Format > Police > Majuscules > [Aucun, Tout en majuscule, Petites 
majuscules].
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Vous pouvez également effectuer plusieurs de ces opérations d’un seul clic à l’aide 
des boutons de barre d’outils. Vous pouvez ajouter les boutons suivants à la barre 
d’outils de Pages :
Â Exposant :  cliquez afin de convertir le texte sélectionné en exposant.
Â Indice :  cliquez afin de convertir le texte sélectionné en indice.
Â Plus petit :  cliquez de manière répétée afin de rendre le texte plus petit.
Â Plus grand :  cliquez de manière répétée afin de rendre le texte plus grand.
Pour en savoir plus sur la personnalisation de la barre d’outils, reportez-vous à la 
section “La barre d’outils” à la page 23.
Si vous souhaitez passer à une autre police, ou si vous modifiez fréquemment la mise 
en forme du texte, il peut être plus simple d’utiliser le panneau Police et l’Inspecteur 
du texte afin de mettre en forme le texte. Ces outils sont décrits dans les sections 
suivantes.
Vous pouvez également créer des effets graphiques attrayants avec le texte en modifiant la couleur de l’ombre, l’opacité et l’orientation sur la page. Pour en savoir plus 
sur ces options, consultez le chapitre 7, “Modification de propriétés d’objets”.
Utilisation du panneau Police pour mettre en forme du texte
Le panneau Police de Mac OS X vous permet d’accéder à toutes les polices installées 
sur votre ordinateur. Il offre un aperçu des caractéristiques disponibles (telles que gras 
et italique) ainsi que de la taille de chaque police. Les boutons du panneau Police 
permettent de souligner ou de barrer le texte, d’ajouter de la couleur et des ombres 
au texte. Vous pouvez même modifier la couleur de la page d’arrière-plan dans le 
panneau Police.
Pour ouvrir le panneau Police :
m Choisissez Format > Police > Fenêtre des polices (ou cliquez sur Polices dans la barre 
d’outils).
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Vous pouvez modifier l’apparence de n’importe quel texte d’un document en le 
sélectionnant, puis en sélectionnant des options dans le panneau Police. Lorsque 
vous effectuez des modifications de mise en forme dans le panneau Police, vous 
pouvez prévisualiser la police mise en forme.
Pour changer l’aspect et la taille du texte :
1 Dans le panneau Police, sélectionnez un style de police dans la colonne Famille, 
puis sélectionnez le style dans la colonne Style.
Si vous ne voyez pas toutes les familles de police installées sur l’ordinateur, sélectionnez 
Toutes les polices dans la colonne Collections ou tapez le nom de la police recherchée 
dans le champ de recherche en bas du panneau Police.
Un aperçu de la police sélectionnée apparaît dans la sous-fenêtre d’aperçu en haut du 
panneau Police. Si la sous-fenêtre d’aperçu ne s’affiche pas, choisissez Afficher l’aperçu 
dans le menu local Action dans le coin inférieur gauche du panneau Police.
Créez des effets 
intéressants à l’aide 
de ces boutons.
Prévisualisez la caracté-
ristique sélectionnée.
Recherchez des polices
en tapant un nom de
police dans le champ
de recherche.
Sélectionnez un style dans la 
liste afin de l’appliquer au texte 
sélectionné dans le document.
Sélectionnez une taille de police 
afin de l’appliquer au texte sélectionné dans votre document.
Le menu local 
Action.
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Remarque :  si vous avez trop de polices à parcourir pour trouver celles que vous 
utilisez souvent, vous pouvez les organiser en collections en cliquant sur le bouton 
Ajouter (+) afin de créer une collection de polices, puis en faisant glisser un style vers 
la nouvelle collection. En outre, si vous devez souvent changer de police, vous pouvez 
laisser le panneau Police ouvert. S’il occupe trop d’espace à l’écran, vous pouvez le 
réduire en faisant glisser le contrôle de redimensionnement (dans l’angle inférieur 
droit du panneau), de sorte que seuls les familles et styles de police de la collection 
sélectionnée soient visibles. Pour le fermer, choisissez Format > Police > Masquer les 
polices ou cliquez à nouveau sur le bouton Polices.
2 Ajustez la taille de police à l’aide du curseur ou du menu local.
3 Ajustez les réglages de typographie de la police sélectionnée en choisissant Typographie dans le menu local Action. Dans la fenêtre Typographie, cliquez sur les triangles 
d’affichage afin de visualiser et de sélectionner les différents effets typographiques 
disponibles pour la police sélectionnée. Les effets typographiques disponibles dépendent de la police.
Pour modifier le soulignement du texte sélectionné :
1 Cliquez sur le bouton Soulignement de texte dans le panneau Police (premier bouton 
à gauche) et choisissez Simple ou Double dans le menu local.
2 Pour changer la couleur de soulignement, choisissez Couleur dans le menu local 
Soulignement de texte, puis sélectionnez une couleur dans la fenêtre Couleurs.
Pour modifier les lignes barrées du texte sélectionné :
1 Cliquez sur le bouton Texte barré dans le panneau Police (deuxième bouton à partir 
de la gauche), puis choisissez Aucun, Simple ou Double dans le menu local.
2 Pour changer la couleur des lignes barrées, choisissez Couleur dans le menu local 
Texte barré, puis sélectionnez une couleur dans la fenêtre Couleurs.
Pour modifier la couleur du texte sélectionné :
m Cliquez sur le menu local Couleur du texte dans le panneau Police (troisième bouton 
à partir de la gauche), puis sélectionnez une couleur dans la fenêtre Couleurs.
Remarque :  vous pouvez également modifier la couleur du texte dans l’Inspecteur du 
texte, comme décrit dans la section “Définition de la couleur d’un texte dans l’Inspecteur du texte” à la page 64.
F2644.book  Page 54  Thursday, January 13, 2005  5:18 PMChapitre 3    Mise en forme de texte et de paragraphes 55
Pour modifier la couleur d’arrière-plan d’un paragraphe sélectionné :
m Cliquez sur le bouton Couleur du document dans le panneau Police (quatrième bouton 
à partir de la gauche), puis sélectionnez une couleur dans la fenêtre Couleurs.
Remarque :  vous pouvez également modifier la couleur d’arrière-plan dans l’Inspecteur du texte, comme décrit dans la section “Définition des couleurs de remplissage 
des paragraphes” à la page 76.
Pour ajouter des ombres au texte sélectionné :
1 Cliquez sur le bouton Ombre du texte dans le panneau Police (cinquième bouton 
à partir de la gauche).
2 Faites glisser le curseur Opacité de l’ombre (premier curseur à gauche) vers la droite 
afin de rendre l’ombre plus foncée.
3 Faites glisser le curseur Flou de l’ombre (curseur du milieu) vers la droite afin de 
rendre l’ombre plus floue.
4 Faites glisser le curseur Décalage de l’ombre (troisième curseur) vers la droite afin 
de séparer l’ombre du texte.
5 Faites tourner la molette Angle de l’ombre afin de définir la direction de l’ombre.
Remarque :  vous pouvez également définir les ombres du texte dans l’Inspecteur 
des graphismes, comme décrit dans la section “Ajout d’ombres” à la page 149.
Accents et caractères spéciaux
Si vous devez taper des caractères avec des accents, des symboles mathématiques, 
des flèches ou d’autres caractères spéciaux, vous pouvez utiliser les préférences International ou la palette de caractères. Vous pouvez également voir où se trouvent les 
caractères sur les claviers utilisés dans d’autres langues en utilisant le Visualiseur de 
clavier (vous pouvez par exemple voir la disposition des touches d’un clavier italien). 
Il s’agit là d’outils intégrés de Mac OS X.
Pour ajouter des accents aux caractères :
1 Choisissez Pomme > Préférences Système et cliquez sur International.
2 Cliquez sur Menu Saisie, puis sélectionnez la case en regard de Visualiseur de clavier.
3 Choisissez Afficher le Visualiseur de clavier dans le menu Saisie à droite de la barre de 
menus (celle qui ressemble à un drapeau ou à un symbole alphabétique).
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Le Visualiseur de clavier affiche les caractères de votre clavier. Si vous avez sélectionné 
une disposition différente ou une méthode d’entrée différente pour le clavier dans le 
menu Saisie, les caractères de la configuration du clavier sélectionnée s’affichent. Par 
exemple, si vous choisissez Américain dans le menu Saisie, vous voyez dans le Visualiseur de clavier les caractères qui s’affichent sur un clavier américain.
4 Pour mettre en surbrillance dans le Visualiseur de clavier les différents accents que 
vous pouvez taper, appuyez sur Option, ou sur les touches Option + Maj.
Les touches accentuées sont entourées en blanc. En fonction du clavier, vous pouvez 
ne pas avoir à appuyer sur les touches de modification pour afficher les caractères 
accentués.
5 Placez le point d’insertion dans le document à l’endroit où vous souhaitez taper.
6 Appuyez sur la touche de modification sur laquelle vous avez appuyé à l’étape 4 
(Maj, Option, Option + Maj ou aucune) et appuyez sur la touche qui se trouve à la 
même position que l’accent affiché dans le Visualiseur de clavier. Relâchez ensuite 
la touche de modification et appuyez sur la touche correspondant au caractère que 
vous souhaitez accentuer.
La touche accentuée modifie la touche que vous tapez ensuite. Par exemple, sur un 
clavier US, pour afficher le caractère “é”, appuyez sur Option et E (touche d’accent), 
puis appuyez sur E (touche à accentuer).
Pour afficher les configurations de clavier pour les autres langues :
1 Choisissez Pomme > Préférences Système et cliquez sur International.
2 Cliquez sur Menu Saisie, puis sélectionnez la case en regard de Visualiseur de clavier.
3 Pour afficher la disposition des caractères sur les claviers utilisés dans différents pays, 
sélectionnez la case Sur en regard de la configuration du clavier du pays ou de la 
méthode de saisie
Remarque :  des polices doivent être installées pour la langue que vous souhaitez voir 
dans le Visualiseur de clavier.
4 Choisissez Afficher le Visualiseur de clavier dans le menu Saisie à droite de la barre de 
menus (celle qui ressemble à un drapeau ou à un caractère alphabétique).
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Le Visualiseur de clavier affiche les caractères de la configuration du clavier ou de la 
méthode de saisie sélectionnée dans le menu Saisie. Par exemple, si vous choisissez 
Américain dans le menu Saisie, vous voyez dans le Visualiseur de clavier les caractères 
qui s’affichent sur un clavier américain.
5 Pour afficher la configuration du clavier d’un autre pays, choisissez sa configuration 
dans le menu Saisie.
Pour saisir des caractères et symboles spéciaux :
1 Placez le point d’insertion à l’endroit où le caractère ou symbole spécial doit apparaître.
2 Choisissez Édition > Caractères spéciaux afin d’ouvrir la palette de caractères (ou choisissez Caractères dans le menu local Action dans le coin inférieur gauche du panneau 
Police).
3 Choisissez le type de caractères à afficher dans le menu local Afficher dans la partie 
supérieure de la Palette de caractères.
Si le menu local ne s’affiche pas, cliquez sur le bouton dans le coin supérieur droit 
de la fenêtre afin d’afficher la partie supérieure de la fenêtre. Cliquez de nouveau sur 
ce bouton afin de masquer la partie supérieure de la fenêtre.
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4 Cliquez sur un élément de la liste de gauche afin de voir les caractères disponibles 
dans chaque catégorie.
5 Double-cliquez sur le caractère ou le symbole de droite que vous souhaitez insérer 
dans votre document, ou sélectionnez le caractère et cliquez sur Insérer. Si le caractère ou le symbole présente des variantes, elles apparaissent en bas de la fenêtre ; 
double-cliquez sur l’une d’elles afin de l’insérer dans le document.
Vous pouvez également activer les guillemets courbes dans le document, de sorte 
que les guillemets de début et de fin soient différents.
Pour utiliser des guillemets courbes :
m Choisissez Pages > Préférences, puis sélectionnez la case Utiliser les guillemets 
courbes.
Sélectionnez une catégorie 
de caractères.
Choisissez le type de 
caractère à afficher.
Sélectionnez un symbole.
Double-cliquez sur un 
symbole afin de l’insérer 
dans votre document.
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Fonctions typographiques avancées
Certaines polices, telles que Zapfino et Hoefler, présentent des fonctions typographiques avancées, qui vous permettent de créer différents effets. Si vous utilisez une telle 
police, vous pouvez modifier nombre de ces effets via le sous-menu Police du menu 
Format. Par exemple, vous pouvez ajuster les éléments suivants :
Â Suivi :  placer les caractères plus près ou plus loin
Â Ligature :  utiliser ou non des traits de plume stylisés entre les lettres ou à la fin ou 
au début de lignes
Â Ligne de base :  déplacer le texte plus haut ou plus bas que le texte qui l’entoure
Â Majuscules :  convertir tous les caractères en majuscules ou en petites majuscules
Davantage de fonctions typographiques avancées sont disponibles dans la fenêtre 
Typographie.
Pour ouvrir la fenêtre Typographie :
m Dans le panneau Police, choisissez Typographie dans le menu local Action (dans le 
coin inférieur gauche).
Définition de l’alignement et de l’espacement du texte
Pour ajuster l’alignement horizontal du texte dans le corps du document principal, 
utilisez le sous-menu Texte du menu Format. Ces commandes de menu alignent le 
texte de différentes façons :
Â Aligner à gauche :  aligne chaque ligne de texte le long de la marge gauche d’une 
page ou d’une colonne, ou du bord gauche d’un objet
Â Centrer :  définit le centre de chaque ligne de texte au centre d’une page, d’une 
colonne ou d’un objet
Â Aligner à droite :  aligne chaque ligne de texte le long de la marge droite d’une 
page ou d’une colonne, ou du bord droit d’un objet
Â Justifier :  espace les caractères de chaque ligne, de sorte que les lignes atteignent 
les marges gauche et droite d’une page ou d’une colonne, ou les bords d’un objet
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Pour aligner le corps du texte à gauche, au centre ou à droite, ou pour le justifier :
m Choisissez Format > Texte > [Aligner à gauche, Centrer, Aligner à droite, Justifier].
Remarque :  si vous souhaitez appliquer un retrait à la première ligne de texte d’un 
paragraphe, ou pour savoir comment annuler un retrait, reportez-vous à la section 
“Définition de retraits de paragraphe” à la page 68.
Ajustement de l’alignement du texte dans des zones de texte, 
des cellules de tableau ou des figures
Si vous souhaitez ajuster l’espacement entre des caractères ou des lignes, ou aligner 
le texte verticalement dans une zone de texte, une figure ou une cellule d’un tableau, 
vous devez utiliser l’Inspecteur du texte, décrit ci-dessous. L’Inspecteur du texte est 
également utile si vous devez fréquemment changer l’alignement et l’espacement 
du texte parce que vous pouvez le conserver ouvert à l’écran pendant votre travail.
Utilisation de l’Inspecteur du texte
Dans la sous-fenêtre Texte de l’Inspecteur du texte, vous pouvez changer la couleur et 
l’alignement du texte. Vous pouvez également ajuster l’espacement entre des caractères et des lignes.
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Pour ouvrir la sous-fenêtre Texte de l’Inspecteur du texte :
1 Choisissez Afficher > Afficher l’Inspecteur (ou cliquez sur Inspecteur dans la barre 
d’outils).
2 Cliquez sur le bouton Inspecteur du texte, puis sur Texte.
Pour aligner le texte à gauche, au centre, à droite ou pour le justifier :
1 Placez le curseur dans le paragraphe que vous souhaitez changer, ou sélectionnez 
plusieurs paragraphes.
2 Cliquez sur les boutons d’alignement horizontal en haut de l’Inspecteur du texte.
Vous pouvez aligner le texte d’une zone de texte fixe à gauche, à droite, au centre ou 
le justifier (aligné sur les bords droit et gauche). Le texte dans une zone de texte fixe, 
un tableau de cellule ou une forme peut également commencer à partir du haut, du 
centre ou du bas de la zone de texte. 
Faites glisser afin d’ajuster la quantité 
d’espace entre le texte et les bordures 
intérieures des zones de texte, des 
cellules de tableau et des figures.
Cliquez afin de modifier la 
couleur du texte sélectionné.
Le bouton Inspecteur du texte.
Boutons d’alignement horizontal :
cliquez afin d’aligner le texte sélectionné 
gauche, à droite, au centre ou à gauche 
et à droite.
Boutons d’alignement vertical : cliquez 
afin d’aligner le texte en haut, au centre 
ou en bas d’une zone de texte, d’une 
figure ou d’une cellule de tableau fixe.
Espacement de caractères et de lignes :
faites glisser afin d’ajuster l’espacement 
des caractères, des lignes et des paragraphes du texte sélectionné.
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Pour commencer du texte à partir du haut, du centre ou du bas d’une zone de 
texte, d’une cellule de tableau ou d’une figure :
1 Sélectionnez la zone de texte, la cellule de tableau ou la figure que vous souhaitez 
modifier.
2 Cliquez sur les boutons d’alignement vertical en haut de l’Inspecteur du texte.
Pour ajuster l’interligne dans un paragraphe :
1 Placez le curseur dans le paragraphe que vous souhaitez changer, ou sélectionnez 
plusieurs paragraphes.
2 Dans l’Inspecteur du texte, faites glisser le curseur Ligne afin d’ajuster l’interligne. 
Faites glisser le curseur vers la gauche pour rapprocher les lignes sélectionnées ; 
faites-le glisser vers la droite afin de les éloigner. Vous pouvez également choisir 
Simple, Double ou Multiple dans le sous-menu Interligne. L’option Multiple vous 
permet de définir des valeurs d’interligne entre simple et double, ou supérieures 
à double.
Pour définir des valeurs précises pour d’interligne dans un paragraphe :
1 Placez le curseur dans le paragraphe que vous souhaitez changer, ou sélectionnez 
plusieurs paragraphes.
2 Dans l’Inspecteur du texte, choisissez une interligne standard (Simple, Double, Multiple), 
ou l’option Au moins ou Entre dans le menu local Interligne (sous le champ Ligne).
Â Interligne standard :  l’espacement entre les lignes est proportionnel à la taille de la 
police. Utilisez cette option lorsque la distance relative entre les hampes montantes 
(parties des lettres situées au-dessus du haut de la ligne) et les hampes descendantes 
(parties situées sous le bas de la ligne) doit rester fixe.
Cliquez sur le texte sous le champ 
Interligne et choisissez une option 
d’interligne.
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Â Au moins :  la distance d’une ligne à la suivante ne sera jamais inférieure à la valeur 
définie, mais elle peut être supérieure pour les polices plus grandes, afin d’empêcher 
les lignes qui se chevauchent. Utilisez cette option lorsque la distance entre les 
lignes doit rester fixe, mais le chevauchement n’est pas souhaitable si le texte doit 
être plus large.
Â Entre :  la valeur que vous définissez est ajoutée à la taille de la police (ou en est 
soustraite). À mesure que la taille de la police change, la distance entre les lignes 
change également. Utilisez cette option pour définir une distance spécifique entre 
les hampes montantes et descendantes, quelle que soit la taille de la police.
3 Tapez une valeur dans le champ Ligne, ou cliquez sur les flèches vers le haut ou vers 
le bas en regard du champ.
Pour ajuster la quantité d’espace avant ou après un paragraphe :
1 Placez le curseur dans le paragraphe que vous souhaitez changer, ou sélectionnez 
plusieurs paragraphes.
2 Dans l’Inspecteur du texte, faites glisser le curseur Avant le paragraphe ou Après le 
paragraphe. Vous pouvez également saisir une quantité spécifique (par exemple 5 
points).
Remarque :  l’espacement avant un paragraphe n’apparaît pas si le paragraphe est le 
premier après un saut de disposition, ou s’il s’agit du premier paragraphe d’une zone 
de texte, d’une figure ou d’une cellule de tableau. L’espacement après un paragraphe 
n’apparaît pas s’il s’agit du dernier paragraphe avant un saut de disposition. Pour 
définir l’espacement autour du texte dans des zones, des figures et des cellules de 
tableau, utilisez la commande Marge intérieure, décrite dans la section “Mise en forme 
d’une zone de texte ou d’une figure” à la page 77.
Pour ajuster l’espace entre les caractères :
1 Placez le curseur sur le mot que vous souhaitez modifier, ou sélectionnez un bloc 
de texte.
2 Dans l’Inspecteur du texte, faites glisser le curseur Caractère. 
Faites glisser le curseur vers la gauche pour rapprocher les lettres sélectionnées ; 
faites-le glisser vers la droite afin de les éloigner.
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Définition de la couleur d’un texte dans l’Inspecteur du texte
Vous pouvez également utiliser la sous-fenêtre Texte de l’Inspecteur du texte pour 
changer la couleur du texte. Les modifications apportées à la couleur du texte dans 
l’Inspecteur du texte remplacent les modifications de la couleur du texte apportées 
dans le panneau Police, et inversement. Pour en savoir plus sur le panneau Police, 
reportez-vous à la section “Utilisation du panneau Police pour mettre en forme du 
texte” à la page 52.
Pour changer la couleur du texte :
1 Sélectionnez le ou les mots à modifier.
2 Dans l’Inspecteur du texte, cliquez sur le cadre de couleur.
3 Dans la fenêtre Couleurs, sélectionnez une couleur.
Pour en savoir plus sur l’utilisation de la fenêtre Couleurs, reportez-vous à la section 
“Utilisation de remplissages par des couleurs et des images” à la page 141.
Définition de taquets de tabulation afin d’aligner le texte
Si vous souhaitez ajouter, supprimer ou modifier des taquets de tabulation dans le 
corps du document ou dans une zone de texte fixe, une cellule de tableau ou une 
figure, vous pouvez utiliser la sous-fenêtre Onglets de l’Inspecteur du texte, ou manipuler directement les icônes d’onglet sur les règles. Il peut être plus rapide de mettre 
en forme quelques taquets de tabulation à l’aide des règles, mais si vous souhaitez 
créer de nombreux taquets positionnés précisément, l’Inspecteur du texte facilite 
l’opération. Ces deux méthodes sont décrites ci-dessous.
Remarque :  n’utilisez pas ces instructions pour définir des taquets de tabulation dans 
une liste ordonnée (structure). Pour savoir comment modifier les niveaux de retrait 
des listes, reportez-vous à la section “Création de listes à puces ou numérotées et de 
structures” à la page 69.
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Définition des taquets de tabulation à l’aide des règles
Des tabulations par défaut sont définies pour certains styles de texte. Les taquets 
apparaissent sur la règle horizontale lorsque vous choisissez Afficher > Afficher les 
règles et que vous sélectionnez du texte sur une page.
Vous pouvez placer des taquets lorsque vous souhaitez les insérer dans le corps 
du document ou dans des zones de texte.
Pour définir un nouveau taquet :
m Cliquez sur la règle horizontale sur laquelle vous souhaitez définir le taquet.
Pour modifier les tabulations :
1 Sélectionnez le texte à mettre en forme.
2 Sur la règle horizontale, faites glisser les taquets de tabulation bleus afin d’en modifier 
l’emplacement.
Pour remplacer une tabulation par un autre type :
m Cliquez sur l’icône de tabulation en appuyant sur la touche Contrôle et choisissez une 
option dans le menu contextuel. Vous pouvez également double-cliquer de manière 
répétée sur l’icône de tabulation dans la règle jusqu’à ce que le type de tabulation 
souhaité apparaisse.
Voici une description de ce que fait chaque type de tabulation :
Â Tabulation de gauche :  aligne le bord gauche du texte avec le taquet.
Â Tabulation centrale :  place le centre du texte sur le taquet.
Â Tabulation de droite :  aligne le bord droit du texte avec le taquet.
Â Tabulation décimale :  aligne la virgule des nombres avec le taquet (vous pouvez 
définir un caractère différent comme séparateur décimal ; reportez-vous à la section 
“Définition de taquets de tabulation à l’aide de l’Inspecteur du texte” ci-dessous).
Des taquets tabulations bleus apparaissent sur la règle horizontale 
lorsque vous sélectionnez du texte 
avec des tabulations sur une page.
Choisissez parmi ces 
types de tabulation.
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Pour supprimer une tabulation de la règle :
m Faites-la glisser à l’extérieur de la règle.
Définition de taquets de tabulation à l’aide de l’Inspecteur du 
texte
Chaque document comporte par défaut des taquets de tabulation, généralement 
espacés d’un demi pouce sur la page. Dans la sous-fenêtre Tabulations de l’Inspecteur 
du texte, vous pouvez modifier l’espacement par défaut des tabulations ou le caractère de tabulation décimale de l’ensemble du document. Vous pouvez également 
définir des taquets supplémentaires dans n’importe quel paragraphe, ou ajouter une 
ligne pointillée, de sorte que lorsque vous appuyez sur la touche Tab, une ligne pointillée s’affiche pour la tabulation. Cela s’avère utile, par exemple, pour l’insertion de 
lignes pointillées entre un titre de chapitre et son numéro de page dans une table 
des matières.
Pour ouvrir la sous-fenêtre Tabulations de l’Inspecteur du texte :
1 Choisissez Afficher > Afficher l’Inspecteur (ou cliquez sur Inspecteur dans la barre 
d’outils).
2 Cliquez sur le bouton Inspecteur du texte, puis sur Tabulations.
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Pour changer la distance des tabulations par défaut :
m Dans la sous-fenêtre Onglets de l’Inspecteur du texte, tapez une valeur dans le champ 
Tabulations par défaut.
Pour créer des taquets de tabulation :
1 Placez le point d’insertion dans le paragraphe (ou sur la première ligne) où vous 
souhaitez définir les taquets.
2 Cliquez sur le bouton Ajouter (+) dans le coin inférieur gauche de la sous-fenêtre 
Tabulations de l’Inspecteur du texte. Un taquet apparaît dans la colonne Taquets 
de tabulation.
3 Pour modifier l’espacement des tabulations, double-cliquez sur le taquet dans la 
colonne et tapez une nouvelle valeur.
Définissez la valeur du 
retrait de la première ligne 
de chaque paragraphe.
Si vous souhaitez appliquer un 
retrait à un paragraphe par 
rapport aux marges des pages, 
indiquez la valeur du retrait.
Ajoutez ou supprimez des taquets 
de tabulation dans la colonne.
Choisissez une ligne pointillée pour 
les taquets sélectionnés dans le 
paragraphe Taquets de tabulation.
Dans le cas d’un taquet de tabulation 
sélectionné dans la colonne Taquets 
de tabulation, sélectionnez la façon 
dont le texte doit être aligné.
Tapez un nouveau caractère afin 
de modifier le caractère de tabulation décimale.
Définissez la distance par défaut 
entre les tabulations.
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4 Une fois le taquet sélectionné, choisissez la façon dont le texte doit être aligné 
sur le taquet (Alignement gauche, centré, droit ou décimal).
5 Si vous souhaitez ajouter une ligne pointillée à la tabulation, choisissez un style 
de ligne (ou choisissez Aucun) dans le menu local Tirets.
Pour utiliser un autre caractère de tabulation décimale dans le document :
m Tapez un nouveau caractère dans le champ Caractère de tabulation décimal.
Pour supprimer un taquet de tabulation :
m Sélectionnez-le dans la colonne Taquets de tabulation, puis cliquez sur le bouton 
Supprimer (-).
Définition de retraits de paragraphe
Les paragraphes peuvent être mis en forme de sorte que la première ligne soit en 
retrait (ou dépasse) aussi loin que vous le souhaitez. Vous pouvez faire cela dans la 
sous-fenêtre Tabulations de l’Inspecteur du texte.
Pour définir le premier retrait de ligne (ou dépassement) d’un paragraphe :
1 Sélectionnez le ou les paragraphes à modifier.
2 Dans la sous-fenêtre Tabulations de l’Inspecteur du texte, tapez une valeur dans le 
champ Première ligne, sous Retraits du paragraphe. Si vous souhaitez que la première 
ligne soit en retrait par rapport à la deuxième ligne, la valeur Première ligne doit être 
supérieure à la valeur du champ Gauche. Si vous souhaitez que la première ligne 
dépasse le côté gauche de la marge du paragraphe, la valeur du champ Première 
ligne doit être inférieure à la valeur du champ Gauche.
Vous pouvez mettre en retrait un paragraphe en lui affectant différents retraits que le 
reste du document. Cela peut par exemple être utile lorsque vous incluez une longue 
citation dans le texte. Vous pouvez pour cela définir des retraits de paragraphe dans la 
sous-fenêtre Tabulations de l’Inspecteur du texte, ou faire glisser les icônes de marge 
dans la règle du document.
Pour définir des retraits de paragraphe à l’aide de la sous-fenêtre Tabulations de 
l’Inspecteur du texte :
1 Sélectionnez le ou les paragraphes à modifier.
2 Tapez une valeur dans le champ Gauche, sous Retraits du paragraphe. 
3 Tapez une valeur dans le champ Droite, sous Retraits du paragraphe.
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Pour changer les retraits de paragraphe à l’aide des règles :
1 Choisissez Afficher > Afficher les règles.
2 Pour changer le retrait de droite, faites glisser l’icône de retrait de droite (triangle bleu 
pointant vers le bas du côté droit de la règle horizontale) jusqu’à la position où vous 
souhaitez que le bord droit du corps du texte se termine.
3 Pour changer la marge de gauche, faites glisser l’icône de retrait de gauche (triangle 
bleu pointant vers le bas du côté gauche de la règle) vers l’emplacement où le bord 
gauche du corps du texte doit commencer. Pour changer la marge gauche indépendamment du retrait du paragraphe, maintenez enfoncée la touche Option lorsque 
vous faites glisser la souris.
4 Pour changer le retrait de la première ligne, faites glisser le retrait de première ligne 
(rectangle bleu) jusqu’à l’emplacement où la première ligne doit commencer. Si vous 
souhaitez que la première ligne reste alignée sur la marge de gauche, assurez-vous 
que le rectangle est aligné avec l’icône de retrait de gauche. Si vous souhaitez créer 
un retrait suspendu, faites glisser le rectangle vers la gauche de l’icône de retrait à 
gauche.
Création de listes à puces ou numérotées et de structures
Pages fournit des styles de puces et de numérotation prédéfinis permettant de créer 
des listes simples ou ordonnées).
Création de listes à puces ou numérotées
Les listes à puces et numérotées sont de simples listes sans hiérarchies d’informations 
imbriquées comme il en existe dans une structure.
Pour créer une liste à puces ou numérotées :
1 Placez le curseur sur la première ligne où doit commencer le texte de la liste.
2 Cliquez sur Liste dans la barre d’outils, puis choisissez le style de liste à utiliser.
Retrait de première ligne Retrait de droite
Retrait de gauche
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Vous pouvez également choisir un style de liste dans le tiroir Styles. Choisissez 
Afficher > Afficher le tiroir Styles, puis sélectionnez le style de liste souhaité. Si les 
styles de liste ne s’affichent pas dans le tiroir Styles, cliquez sur le bouton dans le 
coin inférieur droit du tiroir.
Chaque modèle peut comporter différents styles de liste. La plupart des modèles 
fournissent au moins les styles de liste suivants pour les listes à puces ou numérotées :
Â Puces :  puces élémentaires rondes
Â Listes numérotées :  chiffres arabes
3 Tapez le texte et appuyez sur Retour chaque fois que vous souhaitez commencer une 
nouvelle ligne à puce ou numérotée.
4 Pour inclure du sous-texte sous une ligne à puce ou numérotée, appuyez sur Maj + 
Retour (saut de ligne) afin de démarrer la nouvelle ligne sans puce ou sans numéro. 
Appuyez de nouveau sur Retour à la fin de la ligne afin d’insérer une nouvelle ligne 
à puce ou numérotée.
5 Lorsque vous avez terminé de saisir la liste, cliquez sur Liste dans la barre d’outils et 
choisissez Aucune, ou cliquez sur Aucune dans le tiroir Styles.
Vous pouvez créer vos styles de liste à l’aide d’autres puces de texte ou d’image fournies par Pages, ou en utilisant une image comme puce. Les listes numérotées peuvent 
également comporter divers styles de numérotation, ou utiliser des lettres à la place. 
Pour en savoir plus sur la modification ou la création de votre style de liste, reportezvous à la section “Modification et création de styles de liste” à la page 93.
Cliquez afin d’afficher 
les styles de liste dans 
le tiroir Styles.
Sélectionnez un style de 
liste afin de l’appliquer 
au texte sélectionné.
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Création de listes ordonnées (structures)
Certains styles de liste sont définis afin de créer des listes ordonnées (ou structures). 
Par exemple, le style de liste I. A. 1. a) offre différents styles de numérotation pour 
chaque niveau de retrait de la liste, ce qui vous permet de créer une hiérarchie 
d’informations.
Pour créer des listes ordonnées (structures), utilisez le style de liste I. A. 1. a) 
ou 1. 1.1. 1.1.1.
Pour créer une structure :
1 Placez le curseur sur la première ligne où doit commencer le texte de la liste.
2 Cliquez sur Liste dans la barre d’outils, puis choisissez I. A. 1. a) ou 1. 1.1. 1.1.1. Vous 
pouvez également choisir Afficher > Afficher le tiroir Styles et sélectionner un style. 
Si aucun style de liste ne s’affiche dans le tiroir Styles, cliquez sur le bouton dans le 
coin inférieur droit du tiroir Styles. Pour plus d’informations, reportez-vous à la section 
“Modification et création de styles de liste” à la page 93.
3 Pour mettre du texte vers le niveau de retrait suivant, choisissez Format > Texte > 
Augmenter le niveau du retrait de la liste (ou cliquez sur le bouton fléché Niveau 
de retrait sous l’onglet Liste de l’Inspecteur du texte).
4 Pour revenir au niveau de retrait de liste précédent, choisissez Format > Texte > 
Diminuer le niveau du retrait de la liste (ou cliquez sur le bouton fléché Niveau 
de retrait sous l’onglet Liste de l’Inspecteur du texte).
Remarque :  pour mettre rapidement du texte sélectionné en retrait à un niveau supé-
rieur ou inférieur, vous pouvez utiliser des raccourcis clavier :
Â Commande + crochet droit (]) :  augmente le niveau de retrait du texte sélectionné
Â Commande + crochet gauche ([) :  diminue le niveau de retrait du texte sélectionné
Vous pouvez également ajouter les boutons suivants à la barre d’outils Pages :
Â Augmenter :  augmente le niveau de retrait du texte sélectionné
Â Diminuer :  diminue le niveau de retrait du texte sélectionné
Pour en savoir plus sur la personnalisation de la barre d’outils, reportez-vous à la 
section “La barre d’outils” à la page 23.
5 Pour inclure du sous-texte sous un élément de structure, appuyez sur Maj + Retour 
afin de démarrer la ligne suivante sans la numéroter. Appuyez de nouveau sur Retour 
à la fin de la ligne afin de démarrer une nouvelle ligne numérotée.
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Remarque :  si vous tapez des paragraphes standard entre des éléments de structure, 
ou que vous ajoutez ou supprimez du texte entre des éléments de structure, et que 
la numérotation est perdue, sélectionnez le texte avec la numérotation incorrecte, 
puis sélectionnez Continuer à partir de la précédente dans la sous-fenêtre Tabulations 
de l’Inspecteur du texte afin de rendre la numérotation continue. Si vous avez besoin 
d’une numérotation discontinue, sélectionnez Première note et tapez le numéro 
auquel la numérotation doit commencer, puis appuyez sur Retour. Pour plus d’informations, reportez-vous à la section “Modification et création de styles de liste” à la 
page 93.
6 Pour revenir à du texte de paragraphe standard à la fin de la liste, cliquez sur Liste dans 
la barre d’outils et choisissez Aucune, ou sélectionnez Aucune dans le tiroir Styles. Si le 
point d’insertion du texte est en retrait, appuyez sur Commande + crochet gauche ([) 
afin de revenir au niveau de retrait 1, où vous pouvez commencer à taper le texte des 
paragraphes standard.
Création de renvois, de barres latérales et de texte en 
surbrillance
Les renvois et les barres latérales font ressortir le corps du texte principal dans un 
document. Pages offre au moins trois moyens simples mettre en surbrillance du texte:
Â Ajout de texte à des zones de texte
Â Ajout d’un arrière-plan (ou d’une couleur de remplissage) à des paragraphes
Â Saisie de texte dans les figures
Vous pouvez également utiliser des cellules de tableau pour les renvois. Pour en savoir 
plus sur l’utilisation de tableaux, consultez le chapitre 8, “Création de tableaux”.
Ajout de zones de texte
Vous pouvez ajouter des zones de texte afin de créer des blocs rectangulaires de texte 
n’importe où sur votre page. Vous pouvez mettre en forme du texte dans une zone de 
texte comme vous le feriez avec n’importe quel autre texte, en modifiant des couleurs, 
en ajoutant des ombres, en appliquant des styles, etc.
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Les zones de texte sont créées sous forme de zones de texte fixes, ce qui signifie 
qu’elles sont ancrées à une position dans la page. Le texte du corps de la page se 
positionne autour de ces zones.
Pour ajouter une zone de texte fixe :
1 Cliquez n’importe où en dehors des zones de texte du document de sorte que le point 
d’insertion ne soit pas visible.
2 Choisissez Insérer > Texte (ou cliquez sur Objets dans la barre d’outils, puis sélectionnez 
Texte). Une zone de texte apparaît sur la page.
3 Appuyez sur Commande + Retour afin de sélectionner la zone de texte, puis faites-la 
glisser afin de la positionner à l’emplacement souhaité sur la page.
4 Cliquez à l’intérieur de la zone de texte afin de positionner le point d’insertion et 
commencez à taper du texte. La zone de texte ne s’étend pas automatiquement si 
vous tapez trop de texte.
5 Faites glisser les poignées de sélection afin de redimensionner la zone de texte et 
d’afficher le texte caché. (Vous pouvez également créer des zones de texte liées, de 
sorte que le texte qui dépasse s’insère de manière continue dans une autre zone 
de texte. Pour en savoir plus sur les zones de texte liées, reportez-vous à la section 
“Zones de texte liées” plus loin.)
Remarque :  pour verrouiller la zone de texte sur la page afin qu’elle ne soit pas 
déplacée accidentellement pendant votre travail, choisissez Disposition > Verrouiller.
Pour en savoir plus sur la modification de l’espacement entre le texte et l’intérieur 
de la zone de texte, reportez-vous à la section “Mise en forme d’une zone de texte ou 
d’une figure” à la page 77. Pour en savoir plus sur la modification de l’aspect d’une 
zone de texte, reportez-vous à la section “Mise en forme d’une zone de texte ou d’une 
figure” à la page 77.
Si vous avez copié du texte à partir de votre document et que vous souhaitez le placer 
dans une zone de texte, vous pouvez en créer une à la volée.
Pour créer une zone de texte à partir du texte copié à partir d’un document :
1 Sélectionnez le texte souhaité, puis choisissez Édition > Copier.
2 Cliquez n’importe où à l’extérieur des zones de texte du document, puis choisissez 
Édition > Coller. Une zone de texte est créée, que vous pouvez mettre en forme 
comme vous le souhaitez.
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Zones de texte liées
Si le texte que vous tapez ne tient pas dans une zone de texte fixe, vous pouvez créer 
une zone de texte liée, de sorte que le texte passe d’une zone à l’autre. Chaque fois 
que vous éditez ou mettez en forme le texte de la première zone de texte, la zone de 
texte liée est également modifiée. Les zones de texte liées peuvent être positionnées 
séparément les unes des autres dans le document.
Pour créer une zone de texte liée :
1 Créez une zone de texte fixe selon la procédure décrite précédemment (reportez-vous 
à la section “Pour ajouter une zone de texte fixe :” à la page 73).
2 Positionnez et redimensionnez la zone de texte en fonction de vos besoins, puis 
tapez-y le texte.
Lorsque la zone de texte est trop pleine, appuyez sur Commande + Retour afin de 
la sélectionner. Un indicateur de découpage apparaît en bas de la zone de texte, 
indiquant que le texte s’étend au-delà du bas de la zone.
3 Cliquez sur le carré bleu du côté droit de la zone afin de créer une zone de texte liée.
La nouvelle zone de texte comporte un carré bleu plein du côté gauche. Celui-ci 
indique que cette zone de texte est liée à une précédente.
Un carré bleu ouvert à 
gauche indique qu’il n’y a 
pas de zones de texte liées 
avant celle-ci.
Un indicateur de découpage 
indique que le texte s’étend 
au-delà de la zone de texte.
Un carré bleu ouvert à droite 
indique qu’il n’y a pas de zones 
de texte liées après celle-ci. 
Cliquez dessus afin de créer 
une zone de texte liée.
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4 Faites glisser les zones de texte afin de les repositionner. L’enchaînement du texte 
à l’intérieur des zones suit toujours l’ordre dans lequel les zones ont été créées, quel 
que soit l’emplacement où vous les positionnez dans le document.
Pour déplacer des zones de texte liées :
1 Sélectionnez-les toutes, puis choisissez Édition > Copier.
2 Sélectionnez la destination et choisissez Édition > Coller.
Remarque :  si vous copiez et collez une zone liée unique, vous créez une zone de 
texte non liée unique, identique à celle que vous avez copiée.
Pour sélectionner uniquement le texte dans toutes les zones de texte liées :
m Sélectionnez le texte dans la première zone, puis appuyez sur Commande + A.
Un carré bleu rempli à 
droite indique que cette 
zone de texte est liée 
avant une autre.
Un carré bleu ouvert 
indique que cette zone 
de texte est la dernière 
Un carré bleu rempli à 
de cette série.
gauche indique que cette 
zone de texte est liée à 
une zone précédente.
F2644.book  Page 75  Thursday, January 13, 2005  5:18 PM76 Chapitre 3    Mise en forme de texte et de paragraphes
Définition des couleurs de remplissage des paragraphes
Dans certains cas, il peut s’avérer plus simple de mettre le texte en surbrillance en 
incluant une couleur de remplissage de paragraphe derrière le texte. Lorsque vous 
placez une couleur de remplissage de paragraphe derrière le texte, la couleur s’étend 
entre les marges de disposition et se déplace avec le texte.
Pour placer une couleur de remplissage de paragraphe derrière le texte :
1 Sélectionnez le ou les paragraphes auxquels vous souhaitez ajouter la couleur de 
remplissage.
2 Choisissez Afficher > Afficher l’Inspecteur (ou cliquez sur Inspecteur dans la barre 
d’outils), cliquez sur le bouton Inspecteur du texte, puis cliquez sur Plus.
3 Dans la sous-fenêtre Plus de l’Inspecteur du texte, sélectionnez la case Remplissage 
de paragraphe afin d’inclure une couleur de remplissage derrière le texte.
4 Cliquez sur le cadre Couleur de remplissage et sélectionnez une couleur dans la 
fenêtre Couleurs (pour plus d’informations sur la fenêtre Couleurs, reportez-vous à la 
section “Utilisation de remplissages par des couleurs et des images” à la page 141).
Ajout de texte dans une figure
Si vous souhaitez créer des renvois ou des barres latérales qui ne sont pas rectangulaires, vous pouvez placer du texte à l’intérieur de l’une des figures dessinées fournies 
par Pages. Toutes les figures, à l’exception des lignes, peuvent contenir du texte.
Pour ajouter du texte à une figure :
1 Placez une figure à l’emplacement souhaité sur la page. Pour en savoir plus sur l’ajout 
de figures, reportez-vous à la section “Ajout de formes simples, de tableaux et de 
graphiques” à la page 121.
2 Double-cliquez sur la figure et tapez le texte souhaité. Si le texte s’étend au-delà de 
la bordure de la figure, un indicateur de découpage apparaît.
Sélectionnez l’option permettant de placer 
une couleur de remplissage derrière le texte.
Sélectionnez une couleur de remplissage.
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3 Pour redimensionner la figure, sélectionnez-la et faites glisser les poignées de 
sélection. Si le point d’insertion se trouve à l’intérieur de la figure, appuyez sur 
Commande + Retour afin de quitter le mode édition de texte et sélectionnez la 
figure.
Vous pouvez mettre en forme le texte d’une figure, mais vous ne pouvez pas lier 
des figures.
Mise en forme d’une zone de texte ou d’une figure
Utilisez l’Inspecteur des graphismes pour mettre en forme les bordures, les ombres et 
l’opacité des zones de texte ou des figures. Pour plus d’informations sur la définition 
des propriétés des objets, consultez le chapitre 7, “Modification de propriétés d’objets”.
Utilisez l’Inspecteur d’habillage pour définir la façon dont le texte doit habiller une 
zone de texte ou une figure sur la page. Pour plus d’informations sur la définition de 
l’habillage du texte autour d’un objet, reportez-vous à la section “Habillage d’un objet 
avec du texte” à la page 132.
Vous pouvez mettre en forme des zones de texte ou des rectangles en colonnes en 
sélectionnant la zone de texte ou le rectangle et en choisissant le nombre de colonnes 
souhaité, comme vous le feriez pour définir les colonnes dans le corps du document. 
Pour plus d’informations sur la création et le mise en forme de colonnes, reportezvous à la section “Création de colonnes” à la page 102. Vous pouvez également placer 
des figures, des images et des graphiques dans des zones de texte et des figures, et 
vous pouvez ajouter des tableaux dans des zones de texte. Les objets ajoutés dans 
des zones de texte et des figures peuvent uniquement être ajoutés sous forme 
d’objets en ligne. Pour en savoir plus sur l’ajout d’objets en ligne, reportez-vous à la 
section “Utilisation de graphismes” à la page 117.
L’indicateur de découpage 
indique que le texte s’étend 
au-delà des bordures d’une 
figure.
F2644.book  Page 77  Thursday, January 13, 2005  5:18 PM78 Chapitre 3    Mise en forme de texte et de paragraphes
Vous pouvez modifier l’espace entre le texte et la bordure intérieure de la zone 
de texte, de la figure ou de la cellule du tableau. Cette mesure est appelée la marge 
intérieure. La quantité d’espace que vous indiquez est appliquée de manière uniforme 
autour du texte de chaque côté.
Pour définir l’espacement entre le texte et l’intérieur d’une zone de texte, d’une 
figure ou d’une cellule de tableau :
1 Sélectionnez la zone de texte, la figure ou la cellule de tableau. Si le point d’insertion 
se trouve à l’intérieur de l’objet, appuyez sur Commande + Retour afin de quitter le 
mode d’édition et sélectionnez l’objet.
2 Choisissez Afficher > Afficher l’Inspecteur (ou cliquez sur Inspecteur dans la barre 
d’outils), cliquez sur le bouton Inspecteur du texte, puis cliquez sur Texte.
3 Dans la sous-fenêtre Texte de l’Inspecteur du texte, faites glisser le curseur Marge 
intérieure vers la droite afin d’augmenter l’espace entre le texte et la bordure inté-
rieure de l’objet, ou tapez un nombre dans la zone Marge intérieure et appuyez sur 
Retour.
Spécifiez la quantité 
d’espace autour du texte 
dans une zone de texte, 
une figure ou une cellule 
de tableau.
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4
4 Utilisation de styles
Ce chapitre explique comment appliquer des styles 
aux paragraphes, aux caractères et aux listes afin 
de modifier rapidement et de manière cohérente 
l’apparence du texte. Il décrit également comment 
créer ou modifier des styles.
Lorsque vous rédigez et mettez en forme un document, vous pouvez créer différents 
aspects pour différents types de texte et de paragraphe, puis les utiliser de manière 
cohérente dans le document. Par exemple, vous pouvez utiliser la même police, la 
même couleur et le même interligne pour tous les en-têtes de premier niveau, ou 
utiliser le même aspect pour toutes les légendes de texte ou de photo. L’application 
de styles cohérents est également importante si vous créez une table des matières 
(pour en savoir plus sur la création d’une table des matières, reportez-vous à la section 
“Génération d’une table des matières” à la page 114).
Le moyen le plus simple de vous assurer que les styles de texte sont utilisés de 
manière cohérente consiste à créer des styles, que vous pouvez ensuite appliquer à 
n’importe quel texte. Les modèles incluent divers styles qui sont adaptés au type de 
document sur lequel vous travaillez. Les noms des styles, tels que En-tête, Corps ou 
Légende, suggèrent dans quels cas le style doit être utilisé. Si vous utilisez un modèle, 
vous pouvez appliquer les styles prédéfinis à l’endroit où vous en avez besoin.
Lorsque vous importez un document à partir de Microsoft Word, tous les styles qu’il 
contient sont importés dans le document Pages et peuvent être utilisés comme 
n’importe quel autre style créé dans Pages.
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À propos des styles de paragraphe, de caractère et de liste
Pages offre trois types différents de style prédéfinis, que vous pouvez appliquer 
au texte pour différents besoins.
Â Styles de paragraphe : ces styles peuvent être appliqués uniquement à des 
paragraphes entiers (portions de texte se terminant par un retour chariot), mais 
pas à des mots d’un paragraphe. Il s’agit des styles pour les titres, le corps du 
texte, les renvois, les légendes, les en-têtes et les pieds de page. Les styles de 
paragraphe peuvent inclure des spécifications de police, de taille, de couleur de 
texte, d’espacement des caractères et des lignes, d’ombrage du texte, de couleur 
d’arrière-plan, de retrait et de marge, de tabulation, etc. Si vous souhaitez créer 
une table des matières pour un document, vous devez utiliser des styles de 
paragraphe lors de la création de titres dans votre document. La plupart des 
documents utilisent plus de styles de paragraphe que de styles de caractère ou 
de liste.
Â Styles de caractère : vous pouvez appliquer un style de caractère à un groupe 
quelconque de caractères, y compris des mots ou des groupes de mots, ou des 
lettres dans un paragraphe. Des couleurs ou des tailles de police différentes pour 
mettre en évidence des mots ou des phrases sont des exemples courants de 
style de caractère. Des styles de caractère peuvent être appliqués au texte d’un 
paragraphe sans qu’il soit nécessaire de changer le style du paragraphe.
Â Styles de liste : lorsque vous souhaitez créer des listes simples ou une structure, 
vous pouvez appliquer des styles de liste à votre texte. Celles-ci mettent en forme 
automatiquement le texte avec des puces ou des numéros, selon le type de liste 
que vous choisissez. Vous pouvez également appliquer un retrait aux paragraphes 
en tant que blocs en modifiant leur niveau de retrait de liste (reportez-vous à la 
section “Création de listes à puces ou numérotées et de structures” à la page 69). 
Certains styles de liste sont élémentaires, pour les listes simples, tandis que d’autres, 
tels que I. A. 1. a) et 1. 1.1. 1.1.1., permettent de créer des structures.
Ces trois types de style se trouvent dans le tiroir Styles. Pour plus d’informations 
sur le tiroir Styles, reportez-vous à la section “Le tiroir Styles” à la page 22.
F2644.book  Page 80  Thursday, January 13, 2005  5:18 PMChapitre 4    Utilisation de styles 81
Application de styles
Le moyen le plus simple d’appliquer des styles de paragraphe et de liste consiste à 
utiliser les boutons Style et Liste de la barre d’outils Pages. Pour appliquer des styles 
de caractère, utilisez le tiroir Styles.
Vous pouvez ajouter le bouton Caractère à la barre d’outils afin de permettre l’ajout 
ou la modification de styles de caractère à partir de la barre d’outils Pages. Pour en 
savoir plus sur la personnalisation de la barre d’outils, reportez-vous à la section “La 
barre d’outils” à la page 23.
Pour appliquer un style à un paragraphe :
m Sélectionnez le ou les paragraphes à modifier, ou sélectionnez une zone de texte ou une 
forme entière contenant du texte. Ensuite, effectuez l’une des opérations suivantes :
Â Cliquez sur le bouton Style dans la barre d’outils et choisissez le style que vous 
souhaitez appliquer.
Â Choisissez Afficher > Afficher le tiroir Styles afin d’ouvrir le tiroir correspondant (ou 
cliquez sur Style dans la barre d’outils et choisissez Afficher le tiroir Styles). Dans le 
tiroir Styles, sélectionnez le style à appliquer.
Dans le tiroir Styles, 
sélectionnez le style 
à appliquer.
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Pour appliquer un style de caractère :
1 Sélectionnez le ou les mots à modifier.
2 Choisissez Afficher > Afficher le tiroir Styles afin d’ouvrir le tiroir correspondant 
(ou cliquez sur Style dans la barre d’outils et choisissez Afficher le tiroir Styles).
3 Dans le tiroir Styles, sélectionnez le style de caractère à appliquer. Si vous ne voyez 
pas les styles de caractère, cliquez sur le bouton dans le coin inférieur droit.
Vous pouvez ajouter le bouton Caractère à la barre d’outils et l’utiliser afin de changer 
rapidement les styles de caractère. Pour en savoir plus sur la personnalisation de la 
barre d’outils, reportez-vous à la section “La barre d’outils” à la page 23.
Pour appliquer un style de liste :
1 Placez le curseur là à l’endroit où vous souhaitez commencer la saisie dans la liste, 
puis effectuez l’une des opérations suivantes :
Â Cliquez sur le bouton Liste dans la barre d’outils et choisissez le style que vous 
souhaitez appliquer.
Â Choisissez Afficher > Afficher le tiroir Styles afin d’ouvrir le tiroir correspondant 
(ou cliquez sur Style dans la barre d’outils et choisissez Afficher le tiroir Styles). 
Dans le tiroir Styles, sélectionnez le style de liste à appliquer. Si les styles de liste 
ne s’affichent pas, cliquez sur le bouton dans le coin inférieur droit.
2 Tapez la liste en appuyant sur Retour afin de commencer chaque nouvel élément de 
la liste à puces ou numérotée.
Importation de styles à partir d’un autre document Pages
Vous pouvez importer des styles qui ont été définis dans un autre document Pages 
sans importer le contenu du document.
Pour importer des styles :
1 Choisissez Format > Importer des styles.
2 Sélectionnez le document contenant les styles à importer, puis cliquez sur Ouvrir.
Cliquez afin d’afficher les styles de liste.
Cliquez afin d’afficher les 
styles de caractère.
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3 Sélectionnez les styles à importer dans la zone de dialogue. Maintenez enfoncée la 
touche Commande en cliquant sur le nom des styles afin d’en sélectionner plusieurs, 
ou cliquez sur Sélectionner tout.
4 Pour remplacer dans un document des styles qui portent le même nom que ceux que 
vous importez, sélectionnez la case Remplacer les éléments dupliqués. Le remplacement d’un style affecte tout le texte qui utilise ce style, y compris celui qui se trouve 
dans des objets verrouillés.
Si un style importé porte le même nom qu’un style du document ouvert alors que 
vous ne cochez pas la case Remplacer les éléments dupliqués, un numéro est adjoint 
au nom du style importé. Par exemple, si vous copiez un style nommé “Corps” vers un 
document contenant déjà un style Corps, le style importé est nommé “Corps 2”.
5 Cliquez sur OK.
Les styles importés sont disponibles via le menu local Style de la barre d’outils et le 
tiroir Styles du document.
Substitutions de style
Lorsque vous apportez des modifications à des attributs de texte individuels, par 
exemple en utilisant la commande Police du menu Format pour mettre en italique un 
paragraphe de texte mis en forme avec le style Corps, sans sélectionner un nouveau 
style, vous avez créé une substitution de style. Autrement dit, la mise en forme du texte 
reste dans son style d’origine (Corps), mais vous avez appliqué des modifications 
(italique) au-dessus des attributs par défaut du style. Lorsque vous sélectionnez du 
texte auquel vous avez appliqué des substitutions de style, la flèche en regard du nom 
du style dans le tiroir Styles est rouge. La flèche en regard du nom d’un style de paragraphe s’affiche également en rouge si vous avez sélectionné du texte auquel un style 
de caractère ou de liste est appliqué.
Lorsque la flèche en regard du 
nom d’un style est rouge, cela 
signifie que vous avez appliqué 
des modifications à ce style dans 
le texte sélectionné.
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Des substitutions peuvent se produire lorsque vous modifiez la police, le type, la 
taille ou la couleur du texte, ou lorsque vous appliquez les options de mise en forme 
du texte dans le sous-menu Texte du menu Format, dans le panneau Police ou dans 
l’Inspecteur du texte.
Si vous appliquez des substitutions de style à du texte, puis que vous changez d’avis, 
vous pouvez facilement rétablir les attributs par défaut du style de paragraphe.
Pour supprimer des substitutions de style :
1 Choisissez Afficher > Afficher le tiroir Styles (ou cliquez sur Style dans la barre d’outils 
et choisissez Afficher le tiroir Styles).
2 Sélectionnez le texte à modifier.
3 Dans le tiroir Styles, cliquez sur la flèche à droite du style sélectionné et choisissez 
Rétablir le style original (ou double-cliquez sur le nom du style). Le texte sélectionné 
reprend les attributs par défaut du style sélectionné.
Recherche et remplacement de styles
Si vous souhaitez modifier l’aspect d’un document en remplaçant toutes les instances 
d’un style par un autre, vous pouvez rechercher et remplacer le style dans tout le 
document sans avoir à rechercher du texte spécifique.
Pour rechercher et remplacer un style :
1 Choisissez Afficher > Afficher le tiroir Styles (ou cliquez sur Style dans la barre d’outils 
et choisissez Afficher le tiroir Styles).
2 Dans le tiroir Styles, positionnez le pointeur sur le nom du style que vous souhaitez 
remplacer et cliquez sur la flèche à droite de son nom.
3 Choisissez Sélectionner toutes les versions de [nom du style]. Toutes les instances du 
style sont sélectionnées dans le document.
4 Sélectionnez le nom du style qui doit remplacer celui du texte sélectionné.
Vous pouvez également modifier un style de texte en copiant le style d’une instance 
du texte et en le collant sur un autre texte. Cela fonctionne pour les styles de paragraphe et de caractère.
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Pour copier et coller un style de paragraphe ou de caractère :
1 Positionnez le point d’insertion dans un paragraphe ou un mot dont vous souhaitez 
copier le style, puis choisissez Format > Copier le style de paragraphe ou Copier le 
style de caractère.
2 Placez le point d’insertion dans un paragraphe ou un mot que vous souhaitez modifier, 
puis choisissez Format > Coller le style de paragraphe ou Coller le style de caractère.
Le texte reprend le nouveau style, mais le contenu n’est pas modifié.
Si vous copiez et collez fréquemment des styles, vous pouvez ajouter à la barre d’outils 
les boutons Copier le style et Coller le style. Pour en savoir plus sur la personnalisation 
de la barre d’outils, reportez-vous à la section “La barre d’outils” à la page 23.
Modification et création de styles de paragraphe
Un paragraphe est un bloc de texte suivi d’un retour chariot. Pour ces blocs de texte, 
notamment les titres, le corps du texte, les pieds de page, les renvois, etc. vous pouvez 
définir l’apparence, l’espacement des tabulations, les marges, la couleur d’arrière-plan, 
les sauts de page, etc.
Si vous ne trouvez pas de style de paragraphe avec exactement le même aspect que 
celui souhaité dans les modèles Pages, vous pouvez modifier un style ou en créer un.
Pour modifier un style de paragraphe :
1 Choisissez Afficher > Afficher le tiroir Styles (ou cliquez sur Style dans la barre d’outils 
et choisissez Afficher le tiroir Styles). Sélectionnez le style de paragraphe qui correspond le mieux au style que vous souhaitez créer, ou sélectionnez Format libre.
2 Tapez du texte et mettez-le en forme comme vous le souhaitez. Pour plus d’informations 
sur la mise en forme de l’aspect du texte, reportez-vous à la section “Mise en forme de la 
taille et de l’apparence du texte” à la page 51.
3 Définissez l’alignement du texte, l’espace des caractères et des lignes, ainsi que l’espacement avant et après le paragraphe dans la sous-fenêtre Texte de l’Inspecteur du 
texte. Pour plus d’informations, reportez-vous à la section “Définition de l’alignement 
et de l’espacement du texte” à la page 59.
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4 Si le style de paragraphe nécessite des taquets de tabulation spéciaux, définissez-les 
dans la sous-fenêtre Tabulations de l’Inspecteur du texte. Pour plus d’informations, 
reportez-vous à la section “Définition de taquets de tabulation afin d’aligner le texte” 
à la page 64.
5 Si vous souhaitez que le style de paragraphe soit en retrait par rapport aux marges 
de la page, définissez les retraits de paragraphe dans la sous-fenêtre Tabulations de 
l’Inspecteur du texte.
Définissez le retrait de la première ligne.
Définissez le retrait de 
droite du paragraphe.
Définissez le retrait de 
gauche du paragraphe.
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6 Cliquez sur Plus dans l’Inspecteur du texte afin de sélectionner davantage d’options 
de mise en forme, comme décrit ci-dessous :
a Style de paragraphe suivant :  si vous souhaitez qu’un style de paragraphe 
particulier suive toujours le style actuel lorsque vous appuyez sur la touche 
Retour, choisissez le style dans le menu local. Par exemple, vous pouvez créer 
un style de légende de photo qui doit toujours être suivi d’un style particulier.
b Pagination et saut :  sélectionnez la façon dont le paragraphe peut être réparti entre 
les pages. Vous pouvez spécifier que les lignes de ce paragraphe doivent toujours 
rester ensemble sur la même page, doivent rester avec le paragraphe suivant ou 
peuvent uniquement apparaître en haut d’une page. Les deux dernières options sont 
particulièrement utiles pour les styles de titre. Sélectionnez la case “Éviter les lignes 
veuves et orphelines” afin d’éviter de laisser des lignes seules sur la page suivante ou 
précédente.
Choisissez un style de paragraphe 
devant suivre l’actuel lorsque vous 
appuyez sur la touche Retour.
Sélectionnez des options afin 
de déterminer les sauts de 
paragraphe entre les pages.
Choisissez une langue à 
utiliser par le dictionnaire.
Ajoutez une couleur 
d’arrière-plan au 
Supprimez les césures ou 
ligatures automatiques, si 
elles sont sélectionnées 
pour le document.
Définissez le texte au-dessus ou 
au-dessous du texte situé autour.
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c Langue :  choisissez une langue dans le menu local afin de spécifier la langue 
utilisée pour vérifier l’orthographe dans ce paragraphe. Si votre document inclut 
des citations ou des sections dans une autre langue, vous pouvez spécifier une 
langue pour le dictionnaire utilisé dans ces paragraphes. Le dictionnaire détermine 
la façon dont les mots sont orthographiés et coupés.
d Supprimer la césure pour un style de paragraphe :  sélectionnez la case si vous 
souhaitez désactiver la césure automatique pour ce style de paragraphe dans un 
document pour lequel la césure automatique est activée. Pour l’activer dans le 
document, utilisez l’Inspecteur des documents Reportez-vous à la page 99.
e Supprimer les ligatures :  sélectionnez la case si vous ne souhaitez pas utiliser de 
ligatures dans ce style de paragraphe dans un document pour lequel les ligatures 
sont activées. Pour l’activer dans le document, utilisez l’Inspecteur des documents 
(voir la page 99). Si du texte est sélectionné lorsque vous supprimez les ligatures, 
la modification s’applique au texte sélectionné en tant que substitution de style, 
jusqu’à ce que vous ayez effectué l’étape 7.
f Décalage de la ligne de base :  tapez un nombre dans le champ. Un nombre négatif 
place le texte plus bas que celui qui l’entoure. Un nombre positif place le texte plus 
haut que celui qui l’entoure. Si du texte est sélectionné lorsque vous définissez le 
décalage de la ligne de base, la modification s’applique au texte sélectionné en tant 
que substitution de style, jusqu’à ce que vous ayez effectué l’étape 7.
g Remplissage du paragraphe :  sélectionnez la case et cliquez sur le cadre de couleur 
afin de faire apparaître un arrière-plan en couleur derrière le paragraphe. Par exemple, 
vous pouvez créer un style de titre qui présente du texte blanc sur un arrière-plan 
foncé. La couleur s’étend de la marge de gauche du paragraphe jusqu’à la droite.
7 Dans le tiroir Styles, cliquez sur la flèche à droite du nom du style de paragraphe, puis 
choisissez l’une des options suivantes :
a Redéfinir le style à partir de la sélection :  redéfinit le style de paragraphe de 
l’ensemble du document.
Si vous choisissez cette option, les changements de mise en forme s’appliquent à 
toutes les autres instances de ce style dans l’ensemble du document. Cependant, 
les éventuels styles de caractère qui ont été appliqués ne sont pas modifiés.
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b Créer un style de paragraphe à partir de la sélection :  cette option ne modifie 
pas le style en cours, mais crée un style à partir de la mise en forme que vous avez 
effectuée au cours des étapes précédentes.
Si vous sélectionnez cette option, attribuez un nom au nouveau style, puis cliquez 
sur OK.
Pour créer un style de paragraphe de toutes pièces :
1 Sélectionnez un paragraphe de texte.
2 Choisissez Afficher > Afficher le tiroir Styles (ou cliquez sur Style dans la barre d’outils 
et choisissez Afficher le tiroir Styles). Dans le tiroir Styles, sélectionnez Format libre en 
haut de la liste Styles de paragraphe.
3 Mettez en forme le texte du paragraphe sélectionné, de sorte qu’il se présente comme 
vous le souhaitez. Pour en savoir plus sur la mise en forme de texte, consultez le 
chapitre 3, “Mise en forme de texte et de paragraphes”.
4 Cliquez sur le bouton Ajouter (+) en bas du tiroir Styles et choisissez Créer un style de 
paragraphe à partir de la sélection.
5 Attribuez un nom au nouveau style.
6 Si vous ne souhaitez pas appliquer le nouveau style au texte sélectionné, désélectionnez 
la case Appliquer ce nouveau style à la création.
7 Cliquez sur OK.
Les styles que vous modifiez ou créez sont disponibles uniquement dans le document 
sur lequel vous travaillez. Ils peuvent cependant être importés dans d’autres documents 
ou modèles. Pour savoir comment procéder, reportez-vous à la page 82.
Cliquez afin de créer un style.
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Modification et création de styles de caractère
Les styles de caractère sont des attributs de mise en forme qui sont appliqués à un 
ensemble de caractères de texte (tels qu’un mot ou un groupe de mots ou de lettres) 
sans modifier le style du paragraphe entier. Les styles de caractère définissent l’aspect 
du texte, notamment la police, la taille, la couleur, l’espacement des caractères, l’utilisation des ligatures, le décalage de la ligne de base et la langue. Si vous ne trouvez 
pas de style de caractère correspondant à vos besoins, vous pouvez modifier l’un des 
styles ou en créer un.
Pour modifier un style de caractère :
1 Choisissez Afficher > Afficher le tiroir Styles (ou cliquez sur Style dans la barre d’outils 
et choisissez Afficher le tiroir Styles), puis sélectionnez le style de caractère qui correspond le mieux au style que vous souhaitez définir, ou sélectionnez Aucun.
Si les styles de caractère ne sont pas visibles dans le tiroir Styles, cliquez sur le bouton 
avec le caractère souligné dans le coin inférieur droit du tiroir.
2 Tapez du texte et sélectionnez une police et une taille. Pour plus d’informations, 
reportez-vous à la section “Utilisation du panneau Police pour mettre en forme du 
texte” à la page 52.
3 Définissez la couleur du texte. Pour plus d’informations sur la modification de la 
couleur du texte, reportez-vous à la section “Définition de la couleur d’un texte dans 
l’Inspecteur du texte” à la page 64.
4 Définissez l’espacement des caractères. Pour plus d’informations sur la définition de 
l’espacement des caractères, reportez-vous à la section “Définition de l’alignement et 
de l’espacement du texte” à la page 59.
5 Définissez le décalage de la ligne de base, la ligature et la langue dans la sous-fenêtre 
Plus de l’Inspecteur du texte. Pour plus d’informations, reportez-vous à la section 
“Modification et création de styles de paragraphe” à la page 85.
Cliquez afin d’afficher les styles de liste.
Cliquez afin d’afficher les 
styles de caractère.
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6 Dans le tiroir Styles, cliquez sur la flèche à droite du nom du style de caractère, puis 
choisissez l’une des options suivantes :
a Redéfinir le style à partir de la sélection :  redéfinissez le style de caractère existant 
pour le document entier.
Si vous choisissez cette option, les changements de mise en forme s’appliquent à 
toutes les autres instances de ce style dans l’ensemble du document.
b Créer un style de caractère à partir de la sélection :  cette option ne modifie pas 
le style en cours, mais crée un style à partir de la mise en forme que vous avez effectuée au cours des étapes précédentes.
Si vous sélectionnez cette option, vous pouvez choisir les attributs à inclure dans le 
cadre du nouveau style de caractère. Cliquez sur le triangle d’affichage sous le champ 
Nom dans la zone de dialogue Nouveau style de caractère, puis sélectionnez les attributs souhaités. Attribuez un nom au nouveau style, puis cliquez sur OK.
Cliquez sur le triangle d’affichage 
afin d’afficher les attributs des 
caractères.
Cliquez afin de sélectionner 
uniquement les attributs 
qui remplacent le style de 
paragraphe sélectionné.
Sélectionnez les attributs à 
inclure dans le nouveau style 
de caractère.
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Pour créer un style de caractère de toutes pièces :
1 Sélectionnez du texte.
2 Mettez en forme le texte sélectionné, de sorte qu’il se présente comme vous le souhaitez. 
Vous pouvez définir la police, la taille du texte, sa couleur, la mise en forme (gras, italique, 
etc.), l’espacement des caractères et le décalage de la ligne de base. Pour en savoir plus 
sur la mise en forme de texte, consultez le chapitre 3, “Mise en forme de texte et de 
paragraphes”.
3 Cliquez sur le bouton Ajouter (+) en bas du tiroir Styles et choisissez Créer un nouveau 
style de caractère à partir de la sélection dans le menu local.
4 Attribuez un nom au nouveau style.
5 Si vous souhaitez inclure uniquement certains des attributs définis dans le nouveau 
style de caractère, cliquez sur le triangle d’affichage sous le champ Nom, puis sélectionnez les attributs souhaités.
6 Si vous ne souhaitez pas appliquer le nouveau style au texte sélectionné, désélectionnez la case Appliquer ce nouveau style à la création.
7 Cliquez sur OK.
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Modification et création de styles de liste
Les styles de liste sont utilisés pour créer des listes à puces et des listes numérotées. 
Vous pouvez également créer des listes ordonnées (structures) en utilisant un style de 
liste à numérotation progressive, tel que I. A. 1. a) ou 1. 1.1. 1.1.1. Si vous ne trouvez pas 
de style de liste correspondant à vos besoins, vous pouvez modifier l’un des styles ou 
en créer un.
Utilisez la sous-fenêtre Liste de l’Inspecteur du texte pour modifier ou créer des styles 
de liste. L’Inspecteur vous permet de choisir différents styles de puce ou de numérotation (par exemple des chiffres arabes ou romains). Concernant les puces, vous pouvez 
choisir parmi différents symboles de texte ou images proposés par Pages, utiliser une 
image vous appartenant ou n’afficher aucune puce.
Pour ouvrir la sous-fenêtre Liste de l’Inspecteur du texte :
1 Choisissez Afficher > Afficher l’Inspecteur (ou cliquez sur le bouton Inspecteur dans la 
barre d’outils).
2 Cliquez sur le bouton Inspecteur du texte, puis cliquez sur Liste.
Cliquez afin de passer au niveau 
de retrait suivant de la liste.
Ajustez la taille et la position 
des puces par rapport au texte.
Choisissez des puces ou une 
numérotation.
Sélectionnez une image 
pour les puces.
Ajustez le retrait des puces 
par rapport au premier retrait 
de paragraphe.
Définissez le niveau de retrait 
du texte par rapport aux puces.
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Pour modifier un style de liste à puces ou numérotée : 
1 Choisissez Afficher > Afficher le tiroir Styles (ou cliquez sur Style dans la barre d’outils 
et choisissez Afficher le tiroir Styles), puis sélectionnez le style de liste à puces ou 
numérotée qui correspond le mieux à vos besoins. Assurez-vous que le point d’insertion est visible sur la page afin de sélectionner un style de liste.
Si les styles de liste ne sont pas visibles dans le tiroir Styles, cliquez sur le bouton avec 
la liste à puces en bas du tiroir.
2 Choisissez l’un des styles de puce ou de numérotation suivants dans le menu local 
Puces et numérotation de la sous-fenêtre Liste de l’Inspecteur du texte :
Â Aucune puce :  choisissez cette option si vous ne souhaitez pas de puces visibles, 
mais plutôt spécifier le retrait des niveaux dans une liste ordonnée.
Â Puce de texte :  choisissez cette option pour utiliser un caractère de texte comme 
puce. Vous pouvez en sélectionner un dans la liste ou taper vos propres caractères 
dans le champ de texte. Certaines polices comportent des symboles pouvant être 
utilisés comme puces. Pour les utiliser, ouvrez la palette de caractères (choisissez 
Format > Police > Afficher les polices, puis choisissez Caractères dans le menu local 
Action). Sélectionnez le symbole de la puce dans l’Inspecteur du texte, puis doublecliquez sur le symbole de votre choix dans la palette de caractères. Appuyez ensuite 
sur la touche Retour.
Â Puce d’image :  Choisissez cette option pour utiliser l’une des puces d’image disponibles dans Pages puis sélectionnez-en une dans la liste.
Cliquez afin d’afficher les styles de liste.
Sélectionnez une couleur 
de puce de texte.
En ce qui concerne les puces de texte, 
choisissez un caractère disponible ou tapez 
un caractère dans le champ de texte.
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Â Image personnalisée :  choisissez cette option pour utiliser votre image comme 
puce. Localisez et sélectionnez le fichier image à utiliser dans la zone de dialogue 
Ouvrir. Pour changer d’image, cliquez sur Choisir ou faites glisser une nouvelle 
image dans le cadre.
Â Numéro :  choisissez cette option pour créer une liste numérotée. Vous devez également choisir un style de numérotation. Vous pouvez choisir des nombres arabes ou 
romains, ou des lettres.
Â Numérotation progressive :  pour en savoir plus sur la numérotation progressive, 
reportez-vous à la section “Pour modifier un style de liste à numérotation progressive pour les listes ordonnées” à la page 96.
3 Mettez en forme les puces.
a Pour augmenter ou réduire la taille d’une puce, tapez un nombre dans le champ 
Taille. Le fait de sélectionnez la case Adapter au texte permet de préserver le rapport 
de taille image/texte des puces, même si vous modifiez par la suite la taille de la 
police.
b Pour positionner le symbole de la puce plus haut ou plus bas par rapport au texte, 
tapez un nombre dans la zone Aligner (ou cliquez sur les flèches).
Sélectionnez une puce 
d’image dans la liste.
Pour les listes numérotées, choisissez un style de numérotation.
Redémarrez la numérotation 
ou poursuivez la numérotation 
précédente.
Ajustez le retrait des numéros par 
rapport à la marge de la page.
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c Pour définir la distance du retrait des puces par rapport à la marge, tapez un nombre 
dans le champ Retrait des puces. Une valeur plus élevée correspond à un retrait de la 
liste plus à droite.
d Pour définir le retrait du texte par rapport à la puce, tapez un nombre dans le champ 
Retrait du texte. Une valeur plus élevée correspond à un retrait du texte plus à 
droite.
4 Choisissez Afficher > Afficher le tiroir Styles (ou cliquez sur Style dans la barre d’outils 
et choisissez Afficher le tiroir Styles).
L’un des styles de liste est mis en surbrillance. Il s’agit du style qui a été appliqué au 
texte sélectionné. Si les styles de liste ne sont pas visibles, cliquez sur le bouton en bas 
du tiroir Styles. Le triangle à droite du nom du style est rouge, indiquant que vous 
avez appliqué des substitutions au style en le modifiant.
5 Cliquez sur la flèche rouge à droite du style sélectionné dans le tiroir Styles et choisissez 
l’une des options suivantes :
a Redéfinir le style à partir de la sélection :  redéfinit le style de liste dans l’ensemble 
du document.
Si vous choisissez cette option, les changements de mise en forme s’appliquent à 
toutes les autres instances de ce style dans l’ensemble du document.
b Créer un style de liste à partir de la sélection :  cette option ne modifie pas le style 
en cours, mais elle crée un style à partir de vos choix de mise en forme.
Si vous sélectionnez cette option, attribuez un nom au nouveau style, puis cliquez 
sur OK.
Pour modifier un style de liste à numérotation progressive pour les listes ordonnées
1 Choisissez Afficher > Afficher le tiroir Styles (ou cliquez sur Style dans la barre d’outils 
et choisissez Afficher le tiroir Styles), puis sélectionnez la liste ordonnée (structure) qui 
correspond le mieux à ce que vous souhaitez. Assurez-vous que le point d’insertion 
est visible sur la page afin de sélectionner un style de liste.
2 Choisissez Numérotation progressive dans le menu local Puces et numérotation, dans 
la sous-fenêtre Liste de l’Inspecteur du texte.
Cliquez afin d’afficher les styles de liste.
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3 Choisissez le style de numérotation que vous souhaitez dans le deuxième menu local.
4 Cliquez sur la flèche de retrait à droite afin de passer au deuxième niveau de retrait 
de la liste.
5 Choisissez le style de numérotation souhaité pour le deuxième niveau de retrait de 
la liste.
6 Répétez les étapes 4 et 5 jusqu’à ce que vous ayez défini les styles de numérotation 
(neuf niveaux de retrait maximum).
7 Choisissez Afficher > Afficher le tiroir Styles (ou cliquez sur Style dans la barre d’outils 
et choisissez Afficher le tiroir Styles).
L’un des styles de liste est mis en surbrillance. Il s’agit du style qui a été appliqué au 
texte sélectionné. Si les styles de liste ne sont pas visibles, cliquez sur le bouton en bas 
à droite du tiroir Styles. La flèche à droite du nom du style est rouge, ce qui indique 
que vous avez appliqué des substitutions au style en le modifiant.
8 Cliquez sur la flèche à droite du nom du style de liste, et choisissez l’une des options 
suivantes :
a Redéfinir le style à partir de la sélection :  redéfinit le style de liste dans l’ensemble 
du document.
Si vous choisissez cette option, les changements de mise en forme s’appliquent à 
toutes les autres instances de ce style dans l’ensemble du document.
Cliquez afin de passer au niveau 
de retrait suivant de la liste.
Choisissez Numérotation 
progressive afin de créer 
un style de liste ordonnée.
Pour chaque niveau de 
retrait de la liste, choisissez 
un style de numérotation.
Pour chaque niveau de 
retrait de la liste, définissez 
la distance de retrait du 
nombre et du texte associé.
F2644.book  Page 97  Thursday, January 13, 2005  5:18 PM98 Chapitre 4    Utilisation de styles
b Créer un style de liste à partir de la sélection :  cette option ne modifie pas le style 
en cours, mais crée un style à partir de la mise en forme que vous avez effectuée au 
cours des étapes précédentes.
Si vous sélectionnez cette option, attribuez un nom au nouveau style, puis cliquez 
sur OK.
Pour créer un style de liste de toutes pièces :
1 Sélectionnez du texte.
2 Choisissez Afficher > Afficher l’Inspecteur (ou cliquez sur Inspecteur dans la barre 
d’outils), cliquez sur Texte afin d’ouvrir l’Inspecteur du texte, puis cliquez sur Liste 
afin d’ouvrir la sous-fenêtre Liste.
3 Mettez en forme le texte de la liste sélectionnée, de sorte qu’il se présente comme 
vous le souhaitez. Vous pouvez sélectionner un symbole ou une image à utiliser en 
tant que puce, ainsi qu’un style de numérotation. Vous pouvez également définir la 
quantité de retrait pour chaque niveau de retrait de la liste, comme décrit ci-dessus.
4 Pour utiliser différents styles de puce ou de numérotation pour différents niveaux 
de retrait de liste, reportez-vous à la procédure de modification d’un style de liste 
ordonnée (ci-dessus).
5 Cliquez sur le bouton Ajouter (+) en bas à gauche du tiroir Styles et choisissez Créer 
un nouveau style de liste à partir de la sélection dans le menu local.
6 Attribuez un nom au nouveau style.
7 Si vous ne souhaitez pas appliquer le nouveau style au texte sélectionné, désélectionnez 
la case Appliquer ce nouveau style à la création.
8 Cliquez sur OK.
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5
5 Mise en forme de la disposition et de la table des matières 
d’un document
Ce chapitre décrit comment configurer la disposition 
générale d’un document, notamment les marges, la 
disposition des colonnes et les sauts de section, ainsi 
que comment générer une table des matières et des 
pieds de page.
Il est judicieux de configurer dès le début la mise en page des documents, notamment 
l’orientation et la taille de la page, les marges de la page, les graphismes en arrière-plan 
(filigranes), ainsi que les éventuelles différences entre les pages paires et impaires. Vous 
modifiez la plupart de ces réglages dans l’Inspecteur des documents et dans l’Inspecteur de disposition.
Pour ouvrir l’Inspecteur des documents :
m Choisissez Afficher > Afficher l’Inspecteur (ou cliquez sur Inspecteur dans la barre 
d’outils), puis cliquez sur le bouton Inspecteur des documents.
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La mise en forme définie dans l’Inspecteur des documents s’applique à l’ensemble 
du document. Si vous divisez le document en sections (par exemple en chapitres), 
vous pouvez appliquer différentes mises en forme à différentes sections. Vous pouvez 
également créer une mise en page différente pour la première page, la page de gauche 
et la page de droite de chaque section, ou utiliser différentes dispositions de colonnes 
de texte en fonction de l’emplacement dans le document. Ces réglages sont configurés 
dans l’Inspecteur de disposition. Pour en savoir plus sur la création de sections dans un 
document, reportez-vous à la section “Modification de la mise en forme de documents à 
l’aide de sauts de section” à la page 110. Pour en savoir plus sur la création de colonnes, 
reportez-vous à la section “Création de colonnes” à la page 102.
Le bouton Inspecteur des documents
Vous pouvez configurer la table des matières d’un document dans 
la sous-fenêtre T. des matières. Reportez-vous à la page 114.
Pour afficher les statistiques du document, par 
exemple le nombre de mots, la date et les motsclés, ouvrez la sous-fenêtre Info.
Pour spécifier la taille et l’orientation du papier, 
ouvrez la zone de dialogue Format d’impression.
Configurez des marges pour les bords 
gauche, droit, haut et bas de la page. Vous 
pouvez les définir séparément pour les documents avec des pages opposées gauche et 
droite.
Choisissez un style de note de bas 
de page.
Utilisez la césure automatique 
dans le document.
Utilisez n’importe quelle 
ligature de police disponible dans le document.
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Configuration de l’orientation et de la taille des pages
Par défaut, la plupart des modèles de page sont créés pour des tailles de papier standard, le texte étant imprimé avec une orientation verticale (portrait). Si le document 
nécessite une taille de papier différente ou que vous souhaitez l’imprimer avec une 
orientation horizontale (paysage), vous devez définir la taille et l’orientation du papier 
dès le début. De cette façon, lorsque vous travaillez dans le document, vous avez une 
idée plus précise de ce à quoi il ressemblera.
Si vous commencez avec un document vide, il est réglé par défaut sur l’orientation 
portrait.
Pour définir l’orientation et la taille de la page :
1 Choisissez Fichier > Format d’impression (ou cliquez sur Format d’impression dans 
l’Inspecteur des documents).
2 Cliquez sur un bouton dans la zone de dialogue Format d’impression pour définir 
l’orientation du papier.
3 Choisissez une taille de papier dans le menu local Taille de papier. Si la taille souhaitée 
n’est pas disponible dans le menu local Taille de papier, effectuez les opérations 
suivantes :
a Choisissez Taille de papier personnalisée dans le menu local Réglages.
b Cliquez sur Nouveau et attribuez un nom à la nouvelle taille de papier.
Orientation paysage avec 
le haut de la page du côté 
gauche du papier
Orientation portrait 
(par défaut pour la 
plupart des modèles)
Orientation paysage avec 
le haut de la page du 
côté droit du papier
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c Spécifiez la hauteur et la largeur du papier dans les champs Taille de papier, puis 
spécifiez les marges de la zone imprimable à utiliser dans les champs Marges 
d’impression.
d Cliquez sur Enregistrer.
e Choisissez Attributs des pages dans le menu local Réglages.
f Choisissez dans le menu local Taille de papier la nouvelle taille de papier que vous 
avez nommée, puis cliquez sur OK. Elle apparaît vers le bas de la liste.
Définition des marges de page
Les marges par défaut de la plupart des modèles de Pages, y compris le modèle vide, 
sont définies sur un pouce (2,54 cm) à partir des bordures gauche, droite, du haut et 
du bas de la page. Cela signifie que le texte du corps du document ne s’étendra pas 
au-delà de ces marges.
Pour changer les marges des pages :
m Dans la sous-fenêtre Document de l’Inspecteur des documents, saisissez des valeurs 
dans les champs Gauche, Droit, Haut et Bas.
Si vous souhaitez définir différentes marges dans différentes sections d’un document, 
vous devez utiliser l’Inspecteur de disposition. Pour en savoir plus sur la définition des 
marges, reportez-vous à la section “Modification de la disposition des colonnes et des 
pages” à la page 105.
Si vous créez un document à relier, vous pouvez faire en sorte que la marge des documents tienne compte du côté de la page qui sera relié (marge intérieure) et quel côté 
ne sera pas relié (marge extérieure). Pour cela, vous devez créer un document avec 
des pages opposées gauche et droite. Pour en savoir plus, reportez-vous à la section 
“Création d’un document avec des pages opposées gauche et droite” à la page 106.
Création de colonnes
Dans Pages, vous pouvez modifier la mise en page des différentes pages du document 
en créant des dispositions, séparées par des sauts de disposition. Une disposition est une 
partie d’un document dans laquelle vous avez défini des marges et des colonnes de 
disposition. Vous pouvez utiliser plusieurs dispositions dans une section de votre document, voire sur une même page.
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Vous pouvez organiser le texte en un maximum de dix colonnes, en ajustant la taille 
relative des colonnes et l’espacement entre les colonnes.
Pour créer de une à quatre colonnes de même largeur :
m Cliquez sur Colonnes dans la barre d’outils et sélectionnez le nombre de colonnes 
souhaité, jusqu’à quatre.
Si le bouton Colonnes ne se trouve pas dans la barre d’outils, ou que vous souhaitez 
plus de quatre colonnes, vous devez utiliser l’Inspecteur de disposition. Vous devez 
également l’utiliser pour créer des colonnes de différentes largeurs.
Pour créer plus de quatre colonnes :
1 Choisissez Présentation > Afficher l’Inspecteur (ou cliquez sur Inspecteur dans la barre 
d’outils), puis cliquez sur le bouton Inspecteur de disposition.
2 Cliquez sur Disposition dans l’Inspecteur de disposition.
3 Tapez le nombre de colonnes souhaité dans le champ Colonnes. Par défaut, les colonnes 
présentent la même largeur.
4 Pour redimensionner les colonnes :
a Sélectionnez la case Largeurs identiques.
b Sélectionnez une largeur de colonne ou de gouttière dans le tableau et tapez une 
nouvelle valeur, à l’aide des unités des règles de document.
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Une fois que vous avez créé le nombre de colonnes souhaité, vous pouvez les redimensionner à la volée à l’aide des règles du document, plutôt que de saisir la largeur 
des colonnes et des gouttières dans l’Inspecteur de disposition.
Pour ajuster la largeur des colonnes à l’aide des règles :
m Faites glisser les bords gauche et droit des zones de gouttière grises juste sous la règle 
horizontale.
Le bouton Inspecteur 
de disposition
Sélectionnez une largeur de colonne ou 
de gouttière et tapez une nouvelle valeur.
Définissez l’espace entre la disposition 
actuelle et les dispositions précédente 
et suivante.
Désélectionnez l’option afin de définir des 
largeurs de colonne différentes.
Définissez le nombre de colonnes.
Activez la disposition actuelle 
en haut d’une page.
Définissez les marges pour la disposition actuelle.
Les zones blanches sous la 
règle indiquent la zone de 
texte dans les colonnes.
Les zones grises indiquent les gouttières 
des colonnes.
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Modification de la disposition des colonnes et des pages
Vous pouvez utiliser des sauts de colonne et de disposition afin de créer différentes 
dispositions de texte sur une page. Les sauts de colonne terminent l’enchaînement du 
texte dans une colonne (en laissant le reste de la colonne vide) et le poursuivent dans 
la suivante. Les sauts de disposition terminent une disposition et en commencent une 
nouvelle avec un nombre de colonnes différent, des marges de colonne différentes ou 
un espace vide avant ou après la disposition.
L’utilisation de sauts de colonne ou de sauts de disposition n’a aucun effet sur les 
en-têtes, les pieds de page, la numérotation des pages ou les autres fonctionnalités 
de mise en forme propres au document ou à la section. Pour en savoir plus sur les 
fonctionnalités de mise en forme des sections, reportez-vous à la section “Modification 
de la mise en forme de documents à l’aide de sauts de section” à la page 110.
Vous pouvez appliquer les fonctionnalités de mise en forme décrites ici aux dispositions 
à une seule colonne ou à plusieurs colonnes.
Pour créer un saut de colonne :
1 Placez le curseur après le mot où vous souhaitez terminer l’enchaînement du texte.
2 Choisissez Insérer > Saut de colonne.
Le texte est interrompu à l’endroit où le curseur a été inséré et se poursuit dans la 
colonne de texte suivante. Si vous insérez un saut de colonne dans une disposition 
à une seule colonne, le texte se poursuit en haut de la page suivante.
Lorsque vous affichez des caractères de mise en forme invisibles dans un document, 
un symbole de saut de colonne apparaît de la façon suivante :
Pour changer le nombre de colonnes :
1 Placez le point d’insertion à la suite du mot où vous souhaitez terminer le nombre 
actuel de colonnes et passer à une autre disposition.
2 Choisissez Insérer > Saut de disposition.
Un saut de disposition est inséré et le point d’insertion est déplacé en haut de la 
disposition suivante. Lorsque vous affichez les caractères invisibles dans votre document, un symbole de saut de disposition apparaît comme suit :
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3 Définissez le nombre de colonnes souhaité, puis mettez-les en forme dans la sousfenêtre Disposition de l’Inspecteur de disposition.
Pour changer les marges de disposition des colonnes :
1 Choisissez Présentation > Afficher l’Inspecteur (ou cliquez sur Inspecteur dans la barre 
d’outils), puis cliquez sur le bouton Inspecteur de disposition.
2 Cliquez sur Disposition dans l’Inspecteur de disposition.
3 Pour changer les marges extérieures de la disposition de colonne, saisissez des valeurs 
dans les champs Gauche et Droite sous Marges de disposition.
4 Pour créer un espace au-dessus et en dessous de la disposition de colonne actuelle, 
saisissez des valeurs dans les champs Avant et Après sous Marges de disposition.
Remarque :  les nouvelles marges ne peuvent pas s’étendre en dehors des marges 
de page définies pour le document.
Pour déplacer une disposition vers le haut d’une page :
m Sélectionnez la case La disposition commence sur une nouvelle page dans la sousfenêtre Disposition de l’Inspecteur de disposition.
Création d’un document avec des pages opposées gauche 
et droite
Si vous prévoyez d’imprimer un document recto-verso et de le relier, il comportera 
des pages opposées gauche et droite. Dans ce cas, vous pouvez utiliser des marges 
et une disposition différentes pour les pages de gauche et de droite. Par exemple, 
vous pouvez souhaiter que les marges associées à la reliure soient plus larges que 
les marges extérieures (comme dans ce livre, par exemple), ou vous pouvez placer 
des numéros de page sur les coins extérieurs de chaque page. Pour cela, vous devez 
indiquer à Pages que ce document comporte des pages opposées.
Pour créer différentes marges pour des pages opposées gauche et droite :
1 Choisissez Afficher > Afficher l’Inspecteur (ou cliquez sur Inspecteur dans la barre 
d’outils), puis cliquez sur le bouton Inspecteur des documents.
2 Cliquez sur Document.
F2644.book  Page 106  Thursday, January 13, 2005  5:18 PMChapitre 5    Mise en forme de la disposition et de la table des matières d’un document 107
3 Sélectionnez la case Pages opposées.
Pour en savoir plus sur les autres options de mise en forme de documents disponibles 
avec les pages opposées, reportez-vous à la section “Modification de la mise en forme 
de documents à l’aide de sauts de section” à la page 110.
Ajout d’en-têtes et de pieds de page, de numéros de page 
et de notes de bas de page
Pages comporte des outils qui facilitent l’ajout de texte d’identification sur chaque 
page, ainsi que l’insertion et la mise en forme automatiques de notes de bas de page.
En-têtes et pieds de page
Les en-têtes et pieds de page apparaissent dans les marges du haut et du bas d’un 
document. En général, ils identifient le document, l’auteur, le numéro de page, etc.
Pour ajouter un en-tête ou un pied de page à votre document :
1 Choisissez Présentation > Afficher la disposition. Les zones d’en-tête et de pied de 
page s’affichent en haut et en bas de la page.
2 Placez le point d’insertion dans l’en-tête ou le pied de page et saisissez le texte, en 
le mettant en forme comme vous le feriez avec du texte normal. Pour plus d’informations sur la mise en forme de texte, reportez-vous à la section “Mise en forme de la 
taille et de l’apparence du texte” à la page 51.
Définissez les marges des pages 
opposées gauche et droite de 
façon. indépendante.
Tapez une valeur pour 
la marge sur les bords 
extérieurs des pages.
Tapez une valeur de 
marge de reliure.
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Tout ce que vous saisissez dans un en-tête ou un pied de page est répété sur chaque 
page. Si vous souhaitez changer le texte de l’en-tête ou du pied de page dans diffé-
rentes sections du document, reportez-vous à la section “Modification de la mise en 
forme de documents à l’aide de sauts de section” à la page 110. Pour générer automatiquement le numéro de page sur chaque page, utilisez des champs de texte au format 
mis à jour automatiquement, décrits plus loin.
Utilisation des champs de texte au format mis à jour automatiquement pour les numéros de page, la date et l’heure
Les champs de texte au format mis à jour automatiquement permettent d’insérer du 
texte pouvant être mis à jour automatiquement. Par exemple, l’insertion du champ de 
la date affiche la date actuelle chaque fois que vous ouvrez le document. De la même 
façon, les champs de numéro de page conservent le suivi des numéros lorsque vous 
ajoutez ou supprimez des pages. Pages fournit des champs de texte au format mis à 
jour automatiquement pour les dates, les numéros de page et le nombre de pages 
(nombre total de pages du document). Cela s’avère utile par exemple si vous souhaitez 
numéroter les pages “page 1 sur 4”.
Pour ajouter des numéros de page :
m Placez le point d’insertion à l’endroit où le numéro de page doit apparaître, puis 
cliquez sur Insérer > Numéro de page.
Pour ajouter le nombre de pages :
m Placez le point d’insertion à l’endroit où le nombre de pages doit apparaître, puis 
cliquez sur Insérer > Nombre de pages.
Pour ajouter et mettre à jour le format de la date et l’heure :
1 Placez le point d’insertion à l’endroit où la date et l’heure doivent apparaître, puis 
cliquez sur Insérer > Date et heure.
2 Sélectionnez un format de date et d’heure dans la zone de dialogue.
3 Si vous souhaitez que le document affiche toujours la date et l’heure actuelles, 
sélectionnez la case à cocher Mettre automatiquement à jour la date et l’heure 
quand le document est ouvert.
4 Cliquez sur Insérer.
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Pour modifier le format de la date et d’heure inséré :
m Cliquez sur le texte de la date et de l’heure en maintenant la touche Contrôle enfoncée, 
puis sélectionnez Modifier la date et l’heure dans le menu contextuel. Sélectionnez un 
nouveau format dans la zone de dialogue, puis cliquez sur Modifier.
Ajout des notes de bas de page
Lorsque vous marquez des éléments comme devant faire l’objet de notes de bas 
de page, Pages génère et met à jour automatiquement le format des notes de bas 
de page qui apparaissent en bas de la page. Vous pouvez choisir le style numérique 
Arabe (1, 2, 3) ou Romain (i, ii, iii). Vous pouvez également numéroter les notes de bas 
de page en continu dans le document, ou redémarrer la numérotation pour chaque 
section ou page du document.
Pour ajouter une note de bas de page :
1 Placez le point d’insertion à la fin du mot où vous souhaitez faire apparaître le numéro 
de la note de bas de page.
2 Choisissez Insérer > Note de bas de page.
Un numéro de note de bas de page apparaît et le point d’insertion se déplace vers le 
champ de note de bas de page correspondant en bas de la page.
3 Tapez les informations relatives aux notes de bas de page.
Vous pouvez mettre en forme le texte des notes de bas de page et leur numéro indé-
pendamment l’un de l’autre. Cependant, quel que soit le style de note de bas de page 
que vous choisissez (Arabe ou Romain), il sera appliqué à l’ensemble du document.
Pour sélectionner des nombres arabes ou romains pour toutes les notes de bas de 
page :
1 Choisissez Présentation > Afficher l’Inspecteur (ou cliquez sur Inspecteur dans la barre 
d’outils), puis cliquez sur le bouton Inspecteur des documents. Cliquez ensuite sur 
Document.
2 Choisissez “1,2,3” ou “i, ii, ii” dans le menu local Format.
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Pour redémarrer la numérotation des notes de bas de page :
m Choisissez Redémarre à chaque page ou Redémarre à chaque section dans le menu 
local Numérotation de la sous-fenêtre Document de l’Inspecteur des documents. 
Pour en savoir plus sur la division d’un document en sections, reportez-vous à la 
section “Modification de la mise en forme de documents à l’aide de sauts de section” 
à la page 110.
Pour mettre en forme le texte et les numéros des notes de bas de page :
m Sélectionnez le texte et mettez-le en forme comme n’importe quel autre texte en utilisant le panneau Police, l’Inspecteur du texte et le tiroir Styles. Pour plus d’informations 
sur la mise en forme du texte, consultez le chapitre 3, “Mise en forme de texte et de 
paragraphes”.
Modification de la mise en forme de documents à l’aide de 
sauts de section
Utilisez des sauts de section dans le document chaque fois que vous souhaitez scinder 
le document en sections avec différentes dispositions, numérotations ou autres mises 
en forme de documents. Vous pouvez utiliser des sauts de section pour rendre les 
éléments de mise en forme suivants différents d’une partie du document à l’autre :
Â En-têtes
Â Pieds de page
Â Numérotation des pages
Â Objets modèle (images d’arrière-plan répétées)
Pour créer un saut de section :
m Choisissez Insérer > Saut de section.
Lorsque vous affichez les caractères invisibles dans votre document, un symbole 
de saut de section s’affiche ressemblant à ceci :
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Lorsque vous insérez un saut de section, la nouvelle section du document “hérite” 
automatiquement de tous les attributs de mise en forme et de disposition de la 
section précédente. Pour changer ces attributs, utilisez l’Inspecteur de disposition 
pour reconfigurer la numérotation des pages, les en-têtes et pieds de page, ainsi 
que les marges.
Une fois que vous avez créé un saut de section, les modifications apportées aux objets 
modèle, en-têtes, pieds de page ou numéros de page s’appliquent uniquement à la 
section à laquelle vous apportez les modifications.
Pour définir des en-têtes et pieds de page différents dans une section d’un 
document :
1 Placez le point d’insertion dans la section du document que vous souhaitez modifier.
2 Choisissez Présentation > Afficher l’Inspecteur (ou cliquez sur Inspecteur dans la barre 
d’outils), puis cliquez sur le bouton Inspecteur de disposition.
3 Cliquez sur Section.
4 Désélectionnez la case Utiliser les en-têtes et pieds de page précédents.
5 Tapez le nouvel en-tête ou pied de page dans la zone d’en-tête ou de pied de page 
du document.
Pour redémarrer la numérotation des pages dans une section de document :
m Sélectionnez le bouton “Démarrer à” dans la sous-fenêtre Section de l’Inspecteur des 
documents, puis tapez le numéro de la première page de la section.
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Pour configurer différentes premières pages, sur les pages opposées de gauche et 
de droite, pour une section de document :
1 Pour rendre les en-têtes et les pieds de page de la première page uniques, sélectionnez 
la case “La première page est différente” dans la sous-fenêtre Section de l’Inspecteur de 
disposition, puis modifiez les en-têtes et les pieds de page.
2 Pour placer des en-têtes et des pieds de page différents d’une page sur l’autre, effectuez 
les opérations suivantes :
a Sélectionnez la case “Recto et verso différents” dans la sous-fenêtre Section de 
l’Inspecteur de disposition.
b Si vous souhaitez que la première page de la section commence toujours au recto 
ou au verso, choisissez Page verso ou Page recto dans le menu local “La section 
commence”. Dans le cas contraire, choisissez “N’importe quelle page”.
Rendez la numérotation des 
pages continue par rapport à 
la section précédente ou tapez 
un numéro afin de redémarrer 
la numérotation des pages.
Rendez les en-têtes et pieds 
de page différents sur la page 
première page ou les pages 
alternées, ou continuez à partir 
de la section précédente.
Faites en sorte que la nouvelle 
section commence sur une page 
de gauche ou de droite.
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Ajout d’une image répétée pour l’arrière-plan
Vous pouvez ajouter des filigranes, des logos ou d’autres images d’arrière-plan qui 
s’affichent au même endroit sur chaque page du document. Ces graphismes répétés 
sont appelés objets modèle.
Important : il se peut que les objets modèle n’apparaissent pas sur chaque page, selon 
que le document est divisé en sections et en fonction des réglages sélectionnés dans 
la sous-fenêtre Section de l’Inspecteur de disposition. Si vous souhaitez afficher diffé-
rents objets modèle pour différentes parties du document, vous pouvez diviser le 
document en sections.
Pour ajouter un objet modèle :
1 Cliquez à l’extérieur de l’enchaînement du texte du document, de sorte que le point 
d’insertion ne soit pas visible.
2 Ajoutez un graphisme. Vous pouvez ajouter une image importée, une forme dessinée, 
un tableau, un graphique ou une zone de texte. Pour savoir comment ajouter un 
graphisme, consultez le chapitre 6, “Utilisation de graphismes et autres médias”. 
Assurez-vous que le graphisme est un objet fixe (c’est-à-dire qu’il n’est pas placé en 
ligne avec le texte).
3 Positionnez le graphisme à l’emplacement souhaité sur la page.
4 Choisissez Format > Avancé > Déplacer l’objet vers le modèle de section. Les poignées 
de sélection disparaissent de l’objet, de sorte que vous ne pouvez plus le sélectionner.
Pour modifier ou déplacer un objet modèle, vous devez d’abord rendre les objets 
modèle sélectionnables pour l’ensemble du document. Les objets modèle se présentent différemment des autres objets, car ils comportent des poignées de sélection 
bleues.
Pour rendre les objets modèle sélectionnables :
m Choisissez Format > Avancé > Rendre les objets modèle sélectionnables.
Les objets modèle comportent 
des poignées de sélection bleues.
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Génération d’une table des matières
Pages peut automatiquement générer une table des matières pour un document. 
Pour créer une table des matières, vous devez associer une mise en forme appropriée 
aux en-têtes du document. Pour en savoir plus sur le texte stylisé, consultez le 
chapitre 4, “Utilisation de styles”.
Pour créer et mettre à jour une table des matières :
1 Choisissez Présentation > Afficher l’Inspecteur (ou cliquez sur Inspecteur dans la barre 
d’outils), puis cliquez sur le bouton Inspecteur des documents.
2 Cliquez sur Table des matières.
3 Sélectionnez les cases en regard des styles de paragraphe dont le texte doit apparaître 
dans la table des matières. Par exemple, si vous souhaitez que tous les en-têtes de 
premier niveau et les sous-en-têtes apparaissent dans la table des matières, sélectionnez 
le style de paragraphe que vous avez utilisé pour les en-têtes de premier niveau et pour 
les sous-en-têtes.
Cliquez afin de mettre à jour la 
table des matières après avoir 
apporté des modifications à 
votre document.
Sélectionnez la case dans 
la colonne “nº” si vous 
souhaitez que des numéros 
de page apparaissent avec 
chaque entrée.
Sélectionnez les styles de 
paragraphe dont le texte 
doit apparaître dans la 
table des matières.
F2644.book  Page 114  Thursday, January 13, 2005  5:18 PMChapitre 5    Mise en forme de la disposition et de la table des matières d’un document 115
Remarque :  si les styles que vous sélectionnez ne sont pas utilisés ailleurs dans le 
document, un message indique que la table des matières est vide lorsque vous la 
créez. Si vous sélectionnez des styles qui sont utilisés pour une grande quantité de 
texte dans le document, la table des matières sera trop longue. Prenez soin de sélectionner les styles qui désignent des en-têtes de rubriques, des sous-titres ou d’autres 
éléments à inclure dans la table des matières.
4 Dans la colonne “nº”, sélectionnez les cases des styles dont les entrées doivent 
présenter un numéro de page associé.
5 Placez le point d’insertion au début de la ligne où la table des matières doit apparaître, 
puis choisissez Insérer > Table des matières.
Remarque :  chaque table des matières que vous créez répertorie uniquement le 
contenu qui suit, jusqu’à la prochaine table des matières. Si vous souhaitez une table 
des matières principale pour l’ensemble du document, il doit s’agir de la seule table 
des matières et elle doit se trouver au début du document.
Pour mettre à jour la table des matières après avoir modifié un document :
m Cliquez sur n’importe quelle entrée dans la table des matières, ou cliquez sur Mettre 
à jour dans la sous-fenêtre Table des matières de l’Inspecteur des documents.
Définition du style d’une table des matières
Vous pouvez modifier l’aspect du texte de la table des matières comme pour tout 
autre texte. Vous pouvez également ajouter une ligne pointillée entre l’entrée de la 
table des matières et le numéro de page associé. Pour définir le style de la table des 
matières, créez de nouveaux styles de table des matières, comme décrit ci-dessous.
Pour modifier l’aspect d’une entrée de table des matières :
1 Sélectionnez le type d’entrée que vous souhaitez modifier (par exemple, toutes les 
entrées correspondant aux en-têtes de premier niveau). Toutes les entrées de même 
type sont automatiquement sélectionnées. Elles ne peuvent pas être sélectionnées 
séparément.
2 Choisissez Présentation > Afficher le tiroir Styles (ou cliquez sur Style dans la barre 
d’outils et choisissez Afficher le tiroir Styles). Notez que le tiroir Styles affiche à présent 
une liste de styles de table des matières. Le style de table des matières correspondant 
à l’entrée sélectionnée est également sélectionné.
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3 Pour modifier l’aspect du texte de l’entrée, effectuez les opérations suivantes :
a Utilisez le panneau Police, l’Inspecteur de texte et la fenêtre Couleurs afin de modifier 
l’aspect du texte comme pour n’importe quel texte de paragraphe. Pour en savoir 
plus sur la modification de l’aspect du texte, consultez le chapitre 3, “Mise en forme 
de texte et de paragraphes”.
b Pour créer des lignes pointillées d’une entrée jusqu’au numéro de page associé, 
sélectionnez l’entrée de la table des matières, cliquez sur l’onglet dans la colonne 
Taquets de tabulation de la sous-fenêtre Tabulations de l’Inspecteur de texte, puis 
choisissez un style de ligne dans le menu local Tirets.
c Pour changer le style dans le tiroir Styles afin qu’il corresponde à l’entrée, cliquez 
sur la flèche à droite du nom du style et choisissez Redéfinir le style à partir de la 
sélection.
d Pour créer un style de table des matières, cliquez sur la flèche à droite du nom du 
style et choisissez Créer un style de table des matières à partir de la sélection, puis 
attribuez un nom au nouveau style.
4 Pour renommer le style dans le tiroir Styles afin qu’il corresponde à l’entrée, cliquez 
sur la flèche en regard du nom du style, puis choisissez Renommer le style. Attribuez 
un nouveau nom au style.
5 Pour ajouter un nouveau style, cliquez sur le bouton Ajouter (+) dans le coin inférieur 
gauche du tiroir Styles, choisissez Créer un style de table des matières à partir de la 
sélection, puis attribuez un nom au nouveau style. Sélectionnez Appliquer ce nouveau 
style à la création si vous souhaitez qu’il soit appliqué immédiatement au texte 
sélectionné.
Cliquez sur la flèche et déterminez si vous devez redéfinir le 
style sélectionné, créer un style 
ou simplement le renommer.
Lorsqu’une entrée de table 
des matières est sélectionnée, 
le tiroir Styles affiche les styles 
de table des matières.
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6
6 Utilisation de graphismes et 
autres médias
Ce chapitre décrit comment ajouter et modifier 
divers médias dans vos documents.
Il existe plusieurs types de graphisme et d’autres médias que vous pouvez inclure dans 
les documents Pages, notamment les images (telles que les photos ou les fichiers PDF), 
des formes dessinées simples, des tableaux et des graphiques. Pour les documents 
présentés sur un écran, vous pouvez également ajouter des séquences vidéo et du son.
Utilisation de graphismes
Pages accepte tous les formats pris en charge par QuickTime, notamment les types de 
fichier image suivants :
Â TIFF
Â GIF
Â JPEG
Â PDF
Â PSD
Â EPS
Â PICT
En outre, Pages offre les outils permettant de créer des formes simples telles que 
des triangles, des rectangles et des flèches, ainsi que des tableaux et des graphiques. 
Pour plus d’informations sur le positionnement de formes simples, de tableaux et de 
graphiques, reportez-vous à la section “Ajout de formes simples, de tableaux et de 
graphiques” à la page 121.
Comparaison des objets fixes et des objets en ligne
Il est important de se rappeler qu’il existe deux moyens de placer des objets dans un 
document Pages :  en ligne ou fixe.
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À propos des objets en ligne
Les objets en ligne sont intégrés dans l’enchaînement du texte. Si vous tapez 
davantage de texte au-dessus, ils sont déplacés. Les poignées de sélection en haut 
des objets en ligne sont inactives. Vous ne pouvez pas faire glisser ces poignées 
pour redimensionner l’objet ; vous pouvez uniquement le redimensionner en faisant 
glisser les poignées actives.
Pour les objets en ligne, une icône d’ancrage est également visible dans le conteneur 
de l’objet lorsqu’il est sélectionné.
Si vous placez un graphisme ou une forme à l’intérieur d’une autre forme, d’une zone 
de texte ou d’une cellule d’un tableau, il ne peut être placé qu’en ligne avec le texte. 
Les images en ligne sont automatiquement redimensionnées afin de s’adapter aux 
marges de disposition du document. Pour déplacer un objet en ligne vers une autre 
position dans le texte, sélectionnez-le et faites-le glisser jusqu’à ce que le point 
d’insertion apparaisse à l’endroit où vous souhaitez déposer l’objet.
Les poignées de sélection
du haut sont inactives 
pour les objets en ligne.
Faites glisser les poignées de sélection actives vers le bas ou vers la 
droite pour les redimensionner.
Vue rapprochée de la 
poignée de sélection 
inactive (haut) et de la 
poignée de sélection 
active (bas).
Icône d’ancrage
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Vous pouvez convertir des objets en ligne en objets fixes, et inversement. Pour savoir 
comment procéder, reportez-vous à la section “Conversion entre objets fixes et en 
ligne” à la page 122.
Le texte est organisé différemment autour des objets fixes et des objets en ligne. Pour 
en savoir plus sur l’habillage du texte, reportez-vous à la section “Habillage d’un objet 
avec du texte” à la page 132.
Ajout d’objets fixes et d’objets en ligne
Lorsque vous insérez des graphismes dans un document Pages à partir d’une source 
externe ou que vous créez une forme, un tableau, un graphique ou une zone de texte 
dans Pages, vous pouvez positionner les graphismes de l’une des deux façons décrites 
ci-dessus :  en position fixe sur la page ou en ligne avec le texte. Les sections qui suivent 
décrivent en détail comment effectuer chacune de ces opérations.
Importation d’un graphisme ou d’un fichier multimédia
Les fichiers multimédia importés peuvent être des images, des fichiers PDF, des 
séquences QuickTime ou des animations Flash.
À propos des objets fixes
Les objets fixes sont ancrés à une position sur une page dans une section du document. Le fait de saisir davantage de texte sur la page n’a aucun effet sur pas la position 
d’un objet fixe, mais vous pouvez le faire glisser afin de le repositionner à l’endroit où 
vous le souhaitez, ou le redimensionner.
Faites glisser l’une ou l’autre 
des poignées de sélection afin 
de repositionner ou de redimensionner des objets fixes.
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Pour ajouter un fichier importé en ligne avec le texte, procédez de la façon suivante :
m Faites glisser l’image du Finder ou du navigateur de média vers la fenêtre du document jusqu’à ce que le point d’insertion s’affiche à l’endroit où l’image doit apparaître. 
Un contour bleu fin apparaît également autour de la zone de texte, indiquant que le 
graphique sera positionné en ligne. Relâchez l’image une fois que vous l’avez positionnée à l’endroit souhaité.
m Placez le point d’insertion à l’endroit où vous souhaitez que l’image apparaisse, 
choisissez Insérer > Choisir, puis sélectionnez le fichier et cliquez sur Insérer.
Pour ajouter un fichier importé en tant qu’objet fixe, effectuez l’une des opérations 
suivantes :
m Faites glisser le fichier du Finder ou du navigateur de média vers la fenêtre du document afin de l’insérer dans le document, en restant à l’extérieur de la zone de texte du 
corps principal. Ensuite, faites glisser le fichier afin de le positionner à l’emplacement 
souhaité.
m Cliquez à l’extérieur des zones de texte du document de sorte qu’aucun point d’insertion ne soit visible, puis choisissez Insérer > Choisir. Sélectionnez le fichier et cliquez 
sur Insérer.
Faites glisser l’image vers 
une position à l’intérieur de 
la zone de texte (indiquée 
par la fine bordure bleue).
L’image est positionnée 
au point d’insertion 
lorsque vous la relâchez.
Faites glisser l’icône de l’image 
vers l’extérieur de la zone de 
texte. Une épaisse bordure 
bleue apparaît autour des 
bords de la page.
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Les images importées peuvent être redimensionnées et pivotées, ce qui permet 
de modifier leur apparence sur une page. Les images fixes peuvent également être 
rognées (masquées). Vous pouvez également superposer des graphismes, ajuster 
leur opacité et ajouter des ombres afin de créer des effets visuels saisissants. Pour 
plus d’informations sur l’utilisation des graphismes, reportez-vous aux sections appropriées de ce chapitre. Pour en savoir plus sur l’ajustement des propriétés d’ombrage 
et d’opacité, consultez le chapitre 7, “Modification de propriétés d’objets”.
Ajout de formes simples, de tableaux et de graphiques
Pages fournit des outils permettant de créer des tableaux et des graphiques dans le 
document. Pages vous permet également de dessiner des formes simples (rectangles, 
cercles, triangles, flèches, etc.) que vous pouvez utiliser comme simples images dans 
un document.
Pour ajouter une forme, un tableau ou un graphique en ligne avec le texte :
1 Placez le point d’insertion à l’endroit où vous souhaitez que l’objet apparaisse dans 
le texte.
2 Sélectionnez l’objet à ajouter :
Â Pour les formes, choisissez Insérer > Forme > [type de forme] (ou cliquez sur Objets 
dans la barre d’outils et choisissez une forme).
Â Pour les tableaux, choisissez Insérer > Tableau (ou cliquez sur Objets dans la barre 
d’outils et choisissez Tableau).
Â Pour les graphiques, choisissez Insérer > Graphique (ou cliquez sur Objets dans la 
barre d’outils et choisissez Graphique), puis sélectionnez un type de graphique dans 
l’Inspecteur des graphiques.
Pour placer une zone de texte, une forme, un tableau ou un graphique fixe :
1 Cliquez n’importe où en dehors des zones de texte du document, de sorte qu’aucun 
point d’insertion ne soit visible.
2 Sélectionnez l’objet à ajouter :
Â Pour les zones de texte, choisissez Insérer > Texte (ou cliquez sur Objets dans la 
barre d’outils et choisissez Texte).
Â Pour les formes, choisissez Insérer > Forme > [type de forme] (ou cliquez sur Objets 
dans la barre d’outils et choisissez une forme).
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Â Pour les tableaux, choisissez Insérer > Tableau (ou cliquez sur Objets dans la barre 
d’outils et choisissez Tableau).
Â Pour les graphiques, choisissez Insérer > Graphique (ou cliquez sur Objets dans la 
barre d’outils et choisissez Graphique), puis sélectionnez un type de graphique dans 
l’Inspecteur des graphiques.
Une zone de texte, une forme, un tableau ou un graphique apparaît sur la page.
3 Faites glisser l’objet à l’endroit où vous souhaitez qu’il apparaisse sur la page.
Remarque :  vous pouvez également cliquer sur le bouton Objets de la barre d’outils 
en maintenant la touche Option enfoncée. Relâchez la touche Option, puis choisissez 
Forme, Texte, Tableau ou Graphique. Faites glisser le pointeur en croix sur la fenêtre du 
document afin de dessiner l’objet à l’endroit où vous souhaitez le placer. Il en résulte 
un objet fixe.
Vous pouvez modifier les couleurs, l’opacité, le contour et les ombres des formes et 
des zones de texte à l’aide de l’Inspecteur des graphismes. Pour plus d’informations 
sur la configuration des attributs d’une forme, consultez le chapitre 7, “Modification de 
propriétés d’objets”. Pour en savoir plus sur l’ajout de texte dans une forme, reportezvous à la section “Ajout de texte dans une figure” à la page 76.
Vous pouvez modifier le nombre de rangs et de colonnes d’un tableau, ainsi que 
modifier la conception et la mise en forme du tableau en utilisant l’Inspecteur des 
tableaux. Pour plus d’informations sur la conception de tableaux, consultez 
le chapitre 8, “Création de tableaux”.
Vous ajoutez les données au graphique à l’aide de l’Éditeur de graphiques. Vous 
pouvez modifier le style, les axes, les étiquettes et autres attributs des graphiques 
à l’aide de l’Inspecteur de graphiques. Pour plus d’informations sur la création de 
graphiques, consultez le chapitre 9, “Création de graphiques”.
Conversion entre objets fixes et en ligne
Une image importée en ligne avec du texte peut facilement être convertie en objet 
fixe sur la page, et inversement. Pour effectuer une conversion entre objets fixes et en 
ligne, utilisez l’Inspecteur d’habillage.
Pour la conversion entre des objets fixes et en ligne :
1 Choisissez Présentation > Afficher l’Inspecteur (ou cliquez sur Inspecteur dans la barre 
d’outils), puis cliquez sur le bouton Inspecteur d’habillage.
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2 Sélectionnez l’objet que vous souhaitez convertir dans le document, puis effectuez 
l’une des opérations suivantes :
a Pour placer l’objet en ligne, sélectionnez “Se déplace” avec le texte dans l’Inspecteur 
d’habillage.
b Pour rendre l’objet fixe, sélectionnez “Fixé sur la page” dans l’Inspecteur d’habillage.
Pour changer la façon dont le texte s’ajuste autour de l’objet, utilisez les contrôles 
d’habillage dans l’Inspecteur d’habillage. Pour plus d’informations sur l’habillage de 
texte, reportez-vous à la section “Habillage d’un objet avec du texte” à la page 132.
Utilisation de fichiers PDF en tant que graphismes
Si vous prévoyez d’augmenter ou de réduire fortement les dimensions d’un graphisme, 
envisagez de le convertir au format PDF avant de l’insérer dans Pages. Les fichiers PDF 
ne perdent pas leur précision lorsqu’ils sont redimensionnés. Les autres types de fichier 
peuvent ne pas conserver leur clarté aussi bien lorsqu’ils sont agrandis ou réduits.
Les fichiers PDF offrent également un bon moyen de déplacer des données tabulaires 
de documents Excel ou AppleWorks dans Pages. Si vous possédez des tableaux avec 
beaucoup de mises en forme sous Excel ou une feuille de calcul AppleWorks et que 
vous souhaitez les afficher dans un document, vous pouvez enregistrer la feuille de 
calcul au format PDF, puis placer ce fichier PDF sur une page, comme vous le feriez 
avec n’importe quel autre fichier graphisme externe.
Pour convertir un fichier Excel ou AppleWorks en fichier PDF :
1 Dans votre feuille de calcul Excel ou AppleWorks, sélectionnez la plage de tableaux 
que vous souhaitez afficher dans votre document.
2 Choisissez Fichier > Imprimer
3 Dans la zone de dialogue Imprimer, choisissez Options de sortie dans le menu local 
Copies et pages.
4 Sélectionnez la case Enregistrer comme fichier.
5 Choisissez PDF dans le menu local Format.
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6 Cliquez sur Enregistrer comme PDF.
7 Dans la zone de dialogue Enregistrer, attribuez un nom au fichier PDF, sélectionnez un 
emplacement, puis cliquez sur enregistrer.
Rognage (masquage) d’images fixes
Vous pouvez rogner des images sans modifier réellement les fichiers en masquant
des parties d’images. Cela permet d’importer des images complètes, tout en affichant 
uniquement une partie de ces images dans le document. Vous pouvez cependant 
repositionner et redimensionner des images masquées.
Pour rogner une image :
1 Importez le fichier que vous souhaitez masquer. L’image doit être positionnée en tant 
qu’objet fixe (pour plus d’informations, reportez-vous à la section “Comparaison des 
objets fixes et des objets en ligne” à la page 117).
2 Sélectionnez l’objet et choisissez Format > Masque. Un masque apparaît sur l’image, 
avec une “fenêtre” redimensionnable au centre.
3 Faites glisser la fenêtre afin de la centrer sur la partie de l’image à afficher. Faites 
glisser ses poignées de sélection afin de la redimensionner.
Â Pour conserver les proportions de la fenêtre, maintenez la touche Maj enfoncée 
à mesure que vous faites glisser les poignées de sélection.
Â Pour faire pivoter la fenêtre, maintenez la touche Commande enfoncée à mesure 
que vous faites glisser les poignées de sélection. Pour plus d’informations sur la 
manipulation d’objets à l’aide des poignées de sélection, reportez-vous à la section 
“Sélection, glissement et redimensionnement d’objets” à la page 128.
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4 Double-cliquez sur la fenêtre afin de rendre invisible la zone masquée. L’image 
masquée comporte une ligne pointillée autour de ses bordures visibles.
5 Faites glisser les poignées de sélection afin de redimensionner ou de faire pivoter la 
partie visible de l’image, ou faites glisser l’image entière afin de la repositionner sur 
la page. La partie visible de l’image peut également être convertie en une image en 
ligne via l’option Se déplace avec le texte dans l’Inspecteur d’habillage (pour plus 
d’informations, voir la section “Ajout d’objets fixes et d’objets en ligne” à la page 119).
Faites glisser les poignées 
de sélection afin de redimensionner la partie 
visible d’une image.
Faites glisser les poignées 
de sélection afin de redimensionner ou faire pivoter la 
partie visible de l’image.
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Pour changer la zone à afficher d’une image masquée :
1 Double-cliquez sur l’image masquée.
2 Cliquez sur la bordure pointillée de la fenêtre redimensionnable afin de la sélectionner.
3 Faites glisser les poignées de sélection afin de redimensionner ou faire pivoter la 
partie visible de l’image, ou faites glisser la fenêtre afin d’afficher une autre partie de 
l’image.
Pour ne plus masquer une image :
m Faites de l’image un objet fixe, sélectionnez-la, puis choisissez Format > Ne plus 
masquer. L’image complète est de nouveau visible.
Si vous masquez fréquemment des images, vous pouvez ajouter le bouton Masquer à la 
barre d’outils afin de travailler plus efficacement. Pour en savoir plus sur la personnalisation de la barre d’outils, reportez-vous à la section “La barre d’outils” à la page 23.
Utilisation du Navigateur de média
Les images de votre bibliothèque iPhoto, la musique de votre bibliothèque iTunes et 
les séquences vidéo de votre dossier Séquences sont facilement accessibles à l’aide 
du navigateur de média. Vous pouvez faire glisser des images, de la musique et des 
séquences directement à partir du navigateur de média vers le document ou vers un 
cadre d’image dans l’un des inspecteurs.
Pour ajouter une image à partir d’iPhoto :
1 Choisissez Présentation > Afficher le navigateur de média (ou cliquez sur Média dans 
la barre d’outils).
2 Choisissez iPhoto dans le menu local Navigateur de média et sélectionnez l’album 
souhaité.
3 Faites glisser une image miniature directement vers la fenêtre du document Pages afin 
de placer l’image en ligne avec le texte ou en position fixe sur la page, ou faites-la glisser 
vers un cadre d’image dans l’Inspecteur du texte ou l’Inspecteur des graphismes afin de 
l’utiliser comme remplissage d’image ou comme puce personnalisée (reportez-vous aux 
sections “Utilisation de remplissages par des couleurs et des images” à la page 141 et 
“Modification et création de styles de liste” à la page 93 pour plus d’informations).
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Pour ajouter de la musique à partir d’iTunes :
1 Choisissez iTunes dans le menu local Navigateur de média, puis sélectionnez la liste 
de lecture souhaitée.
2 Faites glisser un fichier son vers la fenêtre du document.
Pour ajouter une séquence :
1 Choisissez Séquences dans le menu local Navigateur de média.
2 Faites glisser une miniature de séquence directement vers la fenêtre du document.
Remarque :  pour visualiser les séquences répertoriées dans la sous-fenêtre Séquences 
du navigateur de média, vous devez les placer dans le dossier Séquences du Finder.
Redimensionnement, déplacement et superposition de 
texte ou de graphismes
Une fois que le texte et les graphismes se trouvent sur la page, ils se comportent 
sensiblement de la même façon. Ils peuvent être déplacés vers l’avant ou vers l’arrière 
l’un par rapport à l’autre, et mis en forme ou manipulés de façon similaire.
Sélectionnez l’album où se trouve 
l’image.
Choisissez iPhoto, iTunes ou 
Séquences.
Faites glisser une miniature vers 
la fenêtre du document ou vers 
un cadre d’image dans l’un des 
inspecteurs.
Recherchez un fichier par nom.
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Sélection, glissement et redimensionnement d’objets
Utilisez les poignées de sélection afin de redimensionner rapidement des objets. Pour 
conserver les proportions d’un objet ou pour définir des valeurs précises de taille et 
d’emplacement, utilisez l’Inspecteur des mesures. Pour en savoir plus sur l’utilisation 
de l’Inspecteur des mesures pour une manipulation précise des objets, reportez-vous 
aux sections “Modification de l’orientation” à la page 151 et “Ajustement de la taille et 
de la position d’objets” à la page 153.
Pour déplacer un objet fixe :
m Cliquez sur l’objet afin de le sélectionner (la poignée de sélection apparaît), puis 
faites-le glisser.
Évitez de faire glisser l’objet avec la poignée de sélection, car vous risqueriez de le 
redimensionner par inadvertance.
Pour déplacer un objet en ligne, effectuez l’une des opérations suivantes :
Â Cliquez sur l’objet afin de le sélectionner, puis faites-le glisser jusqu’à ce que le point 
d’insertion apparaisse à l’endroit où vous souhaitez placer l’objet dans le texte.
Â Sélectionnez l’objet et cliquez sur Édition > Couper. Placez le point d’insertion à 
l’endroit où vous souhaitez que l’objet apparaisse, puis cliquez sur Édition > Coller.
Pour redimensionner un objet :
1 Cliquez sur l’objet afin de le sélectionner. 
Si du texte est sélectionné à l’intérieur de l’objet, vous pouvez sélectionner l’objet 
entier en appuyant sur Commande + Retour.
2 Déplacez le pointeur près d’une poignée de sélection jusqu’à ce qu’il se transforme en 
une double flèche. Pour les objets en ligne, seules les poignées de sélection des coins 
inférieur gauche et droit peuvent être utilisées pour le redimensionnement.
3 Faites glisser une poignée de sélection afin de développer ou de réduire l’objet.
Â Pour redimensionner l’objet à partir du centre, appuyez sur la touche Option tout 
en faisant glisser la souris. 
Â Pour conserver les proportions de l’objet à mesure qu’il est agrandi ou réduit, 
appuyez sur la touche Maj tout en faisant glisser la souris.
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Pour faire pivoter un objet :
1 Sélectionnez l’objet.
2 Maintenez enfoncée la touche Commande et déplacez le pointeur vers une poignée 
de sélection active jusqu’à ce qu’elle devienne une double flèche courbe.
3 Faites glisser une poignée de sélection afin de faire pivoter l’objet.
Pour retourner des objets horizontalement ou verticalement :
m Sélectionnez l’objet, puis cliquez sur Disposition > Miroir horizontal ou Miroir vertical.
Si vous retournez fréquemment des objets, vous pouvez ajouter les boutons Miroir 
horizontal et Miroir vertical à la barre d’outils. Pour en savoir plus sur la personnalisation de la barre d’outils, reportez-vous à la section “La barre d’outils” à la page 23.
Pour déplacer un objet fixe à l’avant ou à l’arrière de texte ou d’un autre objet 
de la page :
1 Sélectionnez l’objet à déplacer.
2 Cliquez sur Disposition > Avancer d’un plan ou Reculer d’un plan.
3 Répétez l’étape 2 jusqu’à ce que l’objet se trouve dans la couche souhaitée.
4 Pour ramener l’objet en bas ou en haut de la pile, choisissez Disposition > Mettre à 
l’arrière-plan ou Mettre au premier plan.
Si vous superposez fréquemment des objets sur la page, vous pouvez ajouter les 
boutons Devant, Derrière, Plan sup. et Plan inf. à la barre d’outils afin de travailler plus 
efficacement. Pour en savoir plus sur la personnalisation de la barre d’outils, reportezvous à la section “La barre d’outils” à la page 23.
Pour sélectionner un objet fixe situé derrière du texte :
m Placez le pointeur à l’extérieur de la zone de texte et faites-le glisser sur la page 
jusqu’à ce que la poignée de sélection de l’objet apparaisse.
Remarque :  si le fait de cliquer sur un objet ne le sélectionne pas, ou s’il comporte 
des poignées de sélection bleues, il s’agit d’un objet modèle. Pour en savoir plus sur 
les objets modèle, reportez-vous à la section “Positionnement d’objets modèle” à la 
page 199.
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Pour sélectionner tous les objets d’un document :
Â Pour sélectionner tous les objets fixes d’un document (à l’exclusion des objets 
de la section modèle), cliquez à l’extérieur de la zone de texte et appuyez sur 
Commande + A.
Â Pour sélectionner tous les objets en ligne et le texte d’une zone de texte, placez le 
point d’insertion dans la zone de texte et appuyez sur Commande + A.
Regroupement et verrouillage d’objets fixes
Vous pouvez regrouper des objets fixes afin de les déplacer, les copier et les orienter 
comme un objet unique (il n’est en revanche pas possible de redimensionner un 
groupe d’objets). Vous pouvez verrouiller les objets fixes afin d’éviter de les déplacer 
par inadvertance pendant votre travail. Les objets en ligne ne peuvent pas être 
regroupés ou verrouillés.
Pour regrouper des objets :
1 Maintenez la touche Commande (ou Maj) enfoncée en sélectionnant les objets que 
vous souhaitez regrouper sur la page.
2 Choisissez Disposition > Grouper. Une zone avec des poignées de sélection grises 
apparaît autour des objets.
Une fois que vous avez regroupé ou verrouillé des objets, vous ne pouvez pas modifier les objets du groupe séparément tant que vous ne les avez pas dissociés ou 
déverrouillés.
Pour dissocier un objet groupé :
m Sélectionnez l’objet et choisissez Disposition > Dissocier.
Pour verrouiller des objets :
1 Maintenez enfoncée la touche Commande (ou Maj) en sélectionnant les objets à 
verrouiller.
2 Choisissez Disposition > Verrouiller.
Pour déverrouiller un objet :
m Sélectionnez l’objet et choisissez Disposition > Déverrouiller.
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Si vous regroupez et verrouillez fréquemment des objets sur la page, vous pouvez 
ajouter à la barre d’outils les boutons Regrouper, Dissocier, Verrouiller et Déverrouiller. 
Pour en savoir plus sur la personnalisation de la barre d’outils, reportez-vous à la 
section “La barre d’outils” à la page 23.
Utilisation de graphismes à canal Alpha
Les graphismes à canal Alpha contiennent une zone transparente qui laisse transparaître le texte ou les autres images. Vous pouvez également utiliser des canaux Alpha 
pour créer de la transparence autour d’images de formes irrégulières, de sorte que 
l’image ne soit pas entourée d’une zone rectangulaire. 
Lorsque vous insérez une image à canal Alpha dans Pages, vous n’avez rien d’autre à 
faire pour que la transparence fonctionne. Il vous suffit de la positionner, de la manipuler, puis de la ramener vers l’avant ou vers l’arrière comme n’importe quelle autre 
image.
De nombreux fichiers PDF, TIFF et PSD contiennent des graphismes à canal Alpha. 
Vous pouvez créer vos images à canal Alpha à l’aide d’applications telles que Adobe 
Photoshop, Corel Draw, Adobe Illustrator et Adobe Acrobat. Reportez-vous aux 
instructions fournies avec l’application afin de savoir comment créer des images à 
canal Alpha.
Cette image d’une loupe 
comporte un canal Alpha 
qui permet de voir le texte 
à travers la loupe.
La forme irrégulière 
de l’image est entourée 
d’un canal Alpha qui 
permet l’affichage du 
texte via le rectangle.
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Habillage d’un objet avec du texte
Lorsque vous placez un objet (image, forme, graphique, etc.) en position fixe ou en 
ligne avec le texte, vous pouvez décider de la façon dont le texte doit s’ajuster autour 
de l’objet. Vous pouvez choisir de placer le texte étroitement ou non autour de l’objet, 
ou faire en sorte que le texte s’affiche uniquement au-dessus et au-dessous de l’objet, 
ou d’un côté de l’objet. Pour définir ces options, utilisez l’Inspecteur d’habillage.
Pour ouvrir l’Inspecteur d’habillage :
m Choisissez Présentation > Afficher l’Inspecteur (ou cliquez sur Inspecteur dans la barre 
d’outils), puis cliquez sur le bouton Inspecteur d’habillage.
Les effets des réglages de l’Inspecteur d’habillage sont différents selon qu’il s’agit 
d’objets fixes et d’objets en ligne.
Le bouton Inspecteur 
d’habillage
Choisissez de placer un objet 
en ligne avec le texte ou en 
position fixe sur la page.
Habillez l’objet avec le texte à 
l’aide des boutons ci-dessous.
Définissez la quantité d’espace 
à conserver autour de l’objet 
et du texte qui l’entoure.
Cliquez afin que le texte 
habille l’objet plus ou 
moins étroitement.
Configurez le pourcentage 
de transparence de l’objet 
permettant de rendre le texte 
plus ou moins visible.
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Pour ajuster l’habillage du texte autour d’un objet fixe :
1 Sélectionnez l’objet.
2 Sélectionnez la case “L’objet provoque un retour automatique” dans l’Inspecteur 
d’habillage.
3 Cliquez sur un bouton dans l’Inspecteur d’habillage afin de sélectionner le côté 
de l’objet autour duquel le texte doit s’ajuster.
4 Pour ajuster le texte plus étroitement autour d’un objet avec un canal Alpha, cliquez 
sur le bouton “Faire tenir le texte” de droite. Pour qu’il s’ajuste de façon moins étroite, 
cliquez sur le bouton “Faire tenir” le texte de gauche.
Le texte s’ajuste à la 
gauche de l’objet.
Le texte s’ajuste au-dessus 
et au-dessous de l’objet.
Le texte s’ajuste à 
la droite de l’objet.
Le texte s’ajuste uniquement 
autour du côté droit ou 
gauche, en fonction du côté 
qui dispose du plus d’espace.
Le texte s’ajuste autour 
de l’objet.
Le texte s’ajuste autour 
des limites rectangulaires 
d’un objet.
Le texte s’ajuste plus étroitement autour d’un objet avec 
un canal Alpha.
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5 Tapez une valeur dans le champ Espace supplémentaire afin de spécifier l’espace 
minimum que vous souhaitez laisser entre l’objet et le texte qui l’entoure.
6 Si l’objet comporte des zones transparentes (un canal Alpha), configurez le pourcentage du canal Alpha auquel le texte doit apparaître via la transparence (une illustration 
est disponible dans la section “Utilisation de graphismes à canal Alpha” à la page 131).
Pour ajuster l’habillage du texte autour d’un objet en ligne :
1 Sélectionnez l’objet.
2 Sélectionnez la case “L’objet provoque un retour automatique” dans l’Inspecteur 
d’habillage.
3 Cliquez sur un bouton dans l’Inspecteur d’habillage afin de sélectionner la façon dont 
l’objet doit être positionné dans le texte.
4 Pour ajuster le texte plus étroitement autour d’un objet avec un canal Alpha, cliquez 
sur le bouton “Faire tenir le texte” de droite. Pour qu’il s’ajuste de façon moins étroite, 
cliquez sur le bouton “Faire tenir” le texte de gauche.
5 Tapez une valeur dans le champ “Espace supplémentaire” afin de spécifier l’espace 
minimum que vous souhaitez laisser entre l’objet et le texte qui l’entoure.
Alignez l’objet à gauche 
et ajustez le texte du 
côté droit.
L’objet est centré entre 
les lignes de texte.
Alignez l’objet à droite et 
ajustez le texte du côté 
gauche.
L’objet est aligné à gauche 
entre les lignes de texte.
L’objet est aligné à droite 
entre les lignes de texte.
Centrez l’objet et ajustez 
le texte de chaque côté.
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6 Si l’objet comporte des zones transparentes (un canal Alpha), configurez le pourcentage du canal Alpha auquel le texte doit apparaître via la transparence (une illustration 
est disponible dans la section “Utilisation de graphismes à canal Alpha” à la page 131).
Ajout de son et de séquences
Vous pouvez ajouter du son, des séquences et des fichiers Flash à votre document 
s’il sera affiché à l’écran sous forme de fichier HTML ou en tant que fichier Pages. 
Le fichier de séquence ou de son est lu lorsque l’utilisateur double-clique sur l’icône 
correspondante dans une page du document.
Pages accepte n’importe quel type de fichier QuickTime ou iTunes, notamment :
Â MOV
Â FLASH
Â MP3
Â MP4
Â AIFF
Â AAC
Important :  lorsque vous ajoutez un fichier multimédia à un document, le fichier 
ne fait pas partie du document Pages. Si vous transférez le document sur un autre 
ordinateur sans transférer le fichier multimédia, il n’apparaîtra pas dans le document. 
Prenez soin de transférer tous les fichiers multimédia vers l’ordinateur ou le serveur 
à partir duquel le document sera affiché ou incluez-les lors de l’enregistrement du 
document (dans la zone de dialogue Enregistrer, cliquez sur le triangle d’affichage à 
droite du champ Enregistrer, puis sélectionnez la case Copier l’audio et les séquences 
dans le document).
F2644.book  Page 135  Thursday, January 13, 2005  5:18 PM136 Chapitre 6    Utilisation de graphismes et autres médias
Ajustement des réglages de lecture multimédia
Dans l’Inspecteur QuickTime, vous pouvez définir le volume du son et des séquences 
dans le document, ainsi que spécifier si les fichiers multimédia doivent être lus une 
seule fois, ou être répétés en boucle.
Pour définir les préférences de lecture :
1 Choisissez Présentation > Afficher l’Inspecteur (ou cliquez sur Inspecteur dans la barre 
d’outils).
2 Cliquez sur le bouton Inspecteur QuickTime.
3 Cliquez sur la séquence afin de la sélectionner, puis faites glisser le curseur Volume 
vers la droite afin d’augmenter le volume de lecture, ou vers la gauche afin de le 
réduire.
4 Choisissez une option de répétition dans le menu local Répétition :
Â Aucune :  une seule lecture.
Â Boucle :  lecture en continu.
Â Lecture en boucle dans les 2 sens :  lecture en continu vers l’avant et vers l’arrière.
Vous pouvez également spécifier l’image de la séquence à afficher sur la page 
(appelée “affiche”) jusqu’à la lecture de la séquence.
Définissez le volume de lecture.
Définissez les options de 
répétition de lecture.
Sélectionnez l’image de la 
séquence qui s’affiche jusqu’à 
ce que la lecture commence.
Utilisez ces commandes afin de 
visualiser la séquence lorsque 
vous modifiez le document.
Le bouton Inspecteur 
QuickTime
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Pour définir l’affiche de la séquence :
1 Cliquez sur la séquence afin de la sélectionner.
2 Dans l’Inspecteur QuickTime, faites glisser le curseur Affiche jusqu’à ce que la 
séquence affiche l’image souhaitée.
Ajout de liens et de signets
Les liens et les signets sont utilisés dans les documents qui seront affichés à l’écran, 
soit sous forme de fichiers HTML, soit en tant que documents Pages. Vous pouvez 
ajouter des liens afin de passer à une autre page ou d’ouvrir un message électronique 
ou une URL sur Internet. Utilisez des signets pour marquer les passages du document 
auxquels vous souhaitez faire référence pendant votre travail.
Pour ajouter des liens vers un message électronique ou une page Web :
1 Sélectionnez le texte que vous souhaitez convertir en lien.
2 Choisissez Insérer > Lien > [Message électronique ou Page Web].
3 Tapez les informations requises, comme illustré ci-dessous.
Â PageWeb :  indiquez l’URL à afficher lorsque l’utilisateur clique sur le lien. La page 
Web apparaît dans le navigateur Web par défaut lorsque l’utilisateur clique sur le 
lien.
Utilisez ce type de lien Pour ouvrir Remarques
Page Web Une page dans un navigateur 
Web
Indiquez l’URL de la page 
que vous souhaitez ouvrir.
Message électronique Un nouveau message électronique avec l’objet et le 
destinataire spécifiés
Tapez l’adresse du destinataire 
et un objet.
Signet Une autre page du même 
document
Utilisez cette fonctionnalité 
pour naviguer rapidement 
dans le document pendant 
votre travail.
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Â Message électronique :  spécifiez l’objet du message et l’adresse électronique du 
destinataire. Lorsque l’utilisateur clique sur le lien, un message vide s’ouvre dans 
l’application de messagerie par défaut.
Pages détecte automatiquement les URL et les adresses électroniques lors de la 
saisie et il les convertit en liens. Vous pouvez désactiver cette fonctionnalité si vous 
le souhaitez.
Pour désactiver la détection automatique des URL et des adresses électroniques 
lors de la saisie :
m Choisissez Pages > Préférences, puis sélectionnez la case Détecter automatiquement 
les adresses électroniques et de page Web.
Tapez l’URL vers laquelle 
le lien doit renvoyer.
Le bouton Inspecteur 
des liens
Vous pouvez éditer le 
texte du lien qui s’affiche 
dans le document.
Sélectionnez l’option permettant 
de désactiver tous les liens, afin 
de pouvoir les éditer facilement.
Tapez l’objet du message.
Tapez l’adresse électronique du 
destinataire du message.
Vous pouvez éditer le texte du lien qui 
s’affiche dans le document.
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Pour ajouter des signets à un document :
1 Sélectionnez le texte pour lequel vous souhaitez créer le signet.
2 Choisissez Insérer > Signet.
Pour éditer et utiliser des signets :
1 Cliquez sur Signet dans l’Inspecteur des liens.
2 Cliquez sur un signet de la liste afin d’y accéder dans le document.
3 Double-cliquez sur un signet de la liste afin de changer son nom.
4 Cliquez sur l’en-tête de la colonne Nom ou Page afin de trier les signets par nom 
ou par numéro de page.
5 Cliquez sur le bouton Ajouter (+) afin d’ajouter de nouveaux signets.
6 Sélectionnez un signet dans la liste et cliquez sur le bouton Supprimer (-) afin de 
le supprimer.
Pour ajouter un lien vers un signet :
1 Choisissez Insérer > Lien > Signet, ou créez un signet dans la sous-fenêtre Signet de 
l’Inspecteur des liens.
2 Ouvrez la sous-fenêtre Lien dans l’Inspecteur des liens.
3 Sélectionnez le texte que vous souhaitez convertir en lien, puis sélectionnez la case 
Activer comme lien.
4 Choisissez Signet dans le menu local Relier à.
Cliquez sur Nom ou sur Page afin 
de trier la liste des signets.
Cliquez sur un signet afin d’y accéder 
dans le document ; double-cliquez 
dessus pour modifier son nom.
Cliquez sur Ajouter ou sur Supprimer 
afin d’ajouter de nouveaux signets ou 
de supprimer un signet sélectionné 
dans la liste.
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5 Choisissez le signet à lier dans le menu local Nom.
Pour désactiver les liens en vue de les modifier :
m Sélectionnez la case Désactiver tous les liens dans la sous-fenêtre Lien de l’Inspecteur 
des liens.
Choisissez le nom du signet.
Vous pouvez éditer le texte du lien 
qui s’affiche dans le document.
Sélectionnez l’option permettant 
de désactiver tous les liens, afin 
de pouvoir les éditer facilement.
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7
7 Modification de propriétés 
d’objets
Ce chapitre décrit les fonctions plus avancées 
permettant d’améliorer les graphismes et autres 
objets d’un document.
Vous pouvez manipuler directement les propriétés des objets, telles que la couleur, 
le style et l’épaisseur du trait, l’ombre, l’opacité et l’orientation à l’aide des inspecteurs 
et de la fenêtre Couleurs, comme décrit dans les sections suivantes.
Utilisation de remplissages par des couleurs et des images
Vous pouvez créer des effets intéressants par le biais des couleurs dans Pages. Une 
forme peut être remplie avec une couleur fixe, des dégradés de couleurs et même 
une image, par exemple une photo ou autre graphisme. 
Vous pouvez également ajuster l’opacité (transparence) d’un objet. Vous pouvez 
même utiliser des effets de remplissage et d’opacité afin de modifier des barres 
individuelles ou des secteurs dans des graphiques.
Sélection de couleurs
Vous pouvez utiliser la fenêtre Couleurs afin de sélectionner une couleur pour le texte, 
les formes, les arrière-plans et les ombres dans Pages.
Pour ouvrir la fenêtre Couleurs :
Â Choisissez Afficher > Afficher les couleurs (ou cliquez sur Couleurs dans la barre 
d’outils).
Â Vous pouvez également cliquer sur un cadre de couleur dans l’une des sous-fenê-
tres de l’inspecteur.
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Vous pouvez utiliser la roue des couleurs dans la fenêtre Couleurs afin de sélectionner 
des couleurs. La couleur que vous sélectionnez apparaît dans la zone en haut de la 
fenêtre Couleurs. Vous pouvez enregistrer cette couleur afin de l’utiliser ultérieurement, en la plaçant dans la palette de couleurs.
Pour sélectionner une couleur :
1 Cliquez n’importe où dans la roue des couleurs. La couleur sélectionnée s’affiche dans 
la zone des couleurs en haut de la fenêtre Couleurs.
2 Pour rendre la couleur plus claire ou plus sombre, faites glisser le curseur du côté 
droit de la fenêtre Couleurs.
3 Pour rendre la couleur plus transparente, faites glisser le curseur Opacité vers la 
gauche ou tapez un pourcentage dans le champ Opacité.
La couleur sélectionnée dans la roue 
des couleurs s’affiche dans cette zone. 
Les deux couleurs de cette zone indiquent que l’opacité est inférieure à 
100 %.
Utilisez le curseur pour définir des 
teintes plus claires ou plus sombres 
dans la roue des couleurs.
Faites glisser les couleurs à partir 
de la zone Couleurs afin de les stocker 
dans la palette de couleurs.
Cliquez afin de sélectionner une 
couleur dans la roue des couleurs.
Faites glisser le curseur Opacité vers 
la gauche afin de rendre la couleur 
plus transparente.
Cliquez sur l’icône représentant une 
loupe, puis cliquez sur n’importe 
quel élément à l’écran afin d’utiliser 
sa couleur.
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Pour ouvrir la palette de couleurs :
m Faites glisser la poignée en bas de la fenêtre Couleurs.
Pour enregistrer une couleur dans la palette de couleurs :
m Faites glisser une couleur de la zone des couleurs vers la palette de couleurs.
Pour appliquer à un objet de la page les couleurs que vous avez sélectionnées dans 
la fenêtre Couleurs, vous devez placez la couleur dans le cadre de couleur approprié 
d’une sous-fenêtre de l’inspecteur.
Pour appliquer une couleur à un objet de la page :
Â Sélectionnez un cadre de couleurs dans l’une des sous-fenêtres de l’inspecteur, puis 
cliquez sur une couleur dans la roue des couleurs.
Â Vous pouvez également faire glisser une couleur de la palette de couleurs ou de la 
zone des couleurs vers un cadre de couleur dans l’une des sous-fenêtres de 
l’inspecteur.
Pour utiliser la couleur d’un autre élément à l’écran :
1 Cliquez sur la loupe à gauche de la zone des couleurs dans la fenêtre Couleurs.
2 Cliquez sur l’élément de l’écran dont vous souhaitez utiliser la couleur. La couleur 
apparaît dans la zone des couleurs.
3 Sélectionnez l’élément auquel vous souhaitez appliquer la couleur dans la fenêtre 
du document, puis faites glisser la couleur de la zone des couleurs vers l’élément.
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Remplissage d’un objet avec de la couleur
Les objets peuvent être remplis avec une couleur unie ou avec un dégradé de couleurs, 
dans lequel deux couleurs s’intègrent progressivement l’une à l’autre. Pour changer la 
couleur d’un objet, utilisez l’Inspecteur des graphismes.
Pour ouvrir l’Inspecteur des graphismes :
m Choisissez Afficher > Afficher l’Inspecteur (ou cliquez sur Inspecteur dans la barre 
d’outils), puis cliquez sur le bouton Inspecteur des graphismes.
Pour définir la couleur de remplissage unie d’un objet :
1 Sur la page, sélectionnez l’objet dont vous souhaitez modifier la couleur.
2 Dans l’Inspecteur des graphismes, choisissez Remplissage couleur dans le menu local 
Remplir.
3 Cliquez sur le cadre de couleur sous le menu local Remplir afin d’ouvrir la fenêtre 
Couleurs.
4 Dans cette fenêtre, sélectionnez une couleur.
Pour remplir un objet avec un dégradé de couleurs :
1 Sur la page, sélectionnez l’objet dont vous souhaitez modifier la couleur.
2 Dans l’Inspecteur des graphismes, choisissez Remplissage dégradé dans le menu local 
Remplir.
3 Cliquez sur chaque cadre de couleur et choisissez chaque couleur dans la fenêtre 
Couleurs.
Choisissez une couleur unie, 
un dégradé de couleurs, une 
image teintée ou pas afin de 
remplir un objet dessiné.
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4 Pour configurer une direction pour le dégradé, utilisez la molette ou le champ Angle. 
Pour le retourner horizontalement ou verticalement, cliquez sur les boutons fléchés 
Angle.
5 Pour inverser le dégradé, cliquez sur la double flèche en regard des cadres de couleur.
Remplissage d’un objet avec une image
Vous pouvez placer une image ou une image teintée à l’intérieur d’une forme dessinée, 
d’une zone de texte, d’un élément de graphique ou d’une cellule de tableau.
Pour définir un remplissage d’image pour un objet :
1 Sélectionnez l’objet dans lequel vous souhaitez placer une image.
2 Dans l’Inspecteur des graphismes, choisissez Remplissage image dans le menu local 
Remplir, puis sélectionnez une image.
3 Pour changer l’image, cliquez sur Choisir, sélectionnez l’image, puis cliquez sur Ouvrir 
(ou faites glisser le fichier image du Finder ou du navigateur de média vers le cadre 
d’image dans l’Inspecteur des graphismes).
Cliquez sur chaque cadre de couleur 
afin de sélectionner les couleurs.
Inversez l’orientation du 
dégradé ou définissez sa 
direction en utilisant les 
boutons fléchés, la molette 
Angle ou en tapant une 
valeur.
Cliquez sur la double 
flèche afin d’inverser 
le dégradé.
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4 Choisissez une échelle d’image dans le menu local.
Â L’option Ajuster redimensionne au mieux l’image en fonction des dimensions de 
l’objet. Si la forme de l’objet est différente de celle de l’image d’origine, il se peut 
que des parties n’apparaissent pas ; un espace vide peut également apparaître 
autour de l’image.
Â Avec l’option Remplir, l’image paraît plus grande ou plus petite, en la dimensionnant 
afin de laisser le minimum d’espace autour de l’image, même si l’objet et l’image 
présentent des formes différentes.
Â L’option Étirer dimensionne l’image en fonction des dimensions de l’objet, mais elle 
présente une distorsion si l’objet présente une forme différente de celle de l’image 
d’origine.
Â L’option Dimensions d’origine place l’image dans l’objet sans modifier ses dimensions d’origine. Si l’image est plus grande que l’objet, vous ne voyez qu’une partie 
de l’image dans l’objet. Si l’image est plus petite que l’objet, elle est entourée 
d’espace vide.
Â L’option Mosaïque répète l’image à l’intérieur de l’objet si celle-ci est plus petite que 
l’objet. Si l’image est plus grande que l’objet, vous ne voyez qu’une partie de l’image 
dans l’objet.
Définissez la taille de 
l’image dans l’objet via 
le menu local.
Pour changer l’image, 
faites glisser une image 
vers le cadre d’image.
Dimensions d’origine
Ajuster Étirer
Mosaïque 
(grande image)
Remplir
F2644.book  Page 146  Thursday, January 13, 2005  5:18 PMChapitre 7    Modification de propriétés d’objets 147
Un remplissage avec image teintée place un masque transparent et coloré sur l’image 
de remplissage.
Pour définir un remplissage d’image teintée pour un objet :
1 Sélectionnez l’objet dans lequel vous souhaitez placer une image.
2 Dans l’Inspecteur des graphismes, choisissez Remplissage image teintée dans le menu 
local Remplir, puis sélectionnez une image.
3 Cliquez sur le cadre de couleur en regard du bouton Choisir, puis sélectionnez une 
couleur dans la fenêtre Couleurs. Faites glisser le curseur Opacité dans la fenêtre 
Couleurs afin de rendre la teinte plus foncée ou plus claire. Si vous faites glisser le 
curseur Opacité dans l’Inspecteur des graphismes, l’opacité de la teinte et de l’image 
change.
4 Choisissez l’échelle de couleurs dans le menu local, comme décrit ci-dessus.
5 Pour changer l’image, cliquez sur Choisir, sélectionnez l’image, puis cliquez sur Ouvrir 
(ou faites glisser le fichier image du Finder ou du navigateur de média vers le cadre 
d’image dans l’Inspecteur des graphismes).
Changement du style de trait
Pour les objets dessinés (formes), les éléments graphiques et les cellules de tableau, 
vous pouvez choisir un style et une couleur pour la bordure de l’objet, ou vous 
pouvez spécifier aucune bordure. Vous pouvez également placer une bordure autour 
des images importées. Vous pouvez définir un style et une couleur pour la bordure 
dans l’Inspecteur des graphismes et la fenêtre Couleurs.
Mosaïque (petite image)
Mosaïque (grande image)
Cliquez pour sélectionner une 
couleur de teinte pour l’image.
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Pour définir le style et la couleur du trait de la bordure d’un objet :
1 Sélectionnez l’objet que vous souhaitez modifier.
2 Dans l’Inspecteur des graphismes, choisissez un style de trait (ou Aucun) dans le menu 
local Trait. Pour les tableaux, seul un trait plein ou Aucun est disponible.
3 Pour modifier l’épaisseur du trait, tapez une valeur dans le champ Trait (ou cliquez sur 
les flèches).
4 Pour changer la couleur du trait, cliquez sur le cadre de couleur et sélectionnez une 
couleur.
5 Pour affecter des points de terminaison à la ligne, notamment une flèche ou un cercle, 
choisissez des points de terminaison gauche et droit dans les menus locaux.
Remarque :  le menu Insérer et le menu local Formes (dans la barre d’outils) incluent 
des lignes avec des flèches.
Vous pouvez définir la position des lignes et des objets dans l’Inspecteur des mesures. 
Reportez-vous à la section “Ajustement de la taille et de la position d’objets” à la page 153.
Tapez l’épaisseur du 
trait dans ce champ.
Choisissez les points de 
terminaison de la ligne 
Choisissez un trait plein, une 
ligne pointillée, une ligne 
discontinue ou aucun trait.
Cliquez sur le cadre de couleurs 
afin de choisir une couleur de trait.
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Ajout d’ombres
Les ombres confèrent une profondeur à la page. L’ombre d’un objet apparaît sur 
n’importe quel objet situé derrière. Vous pouvez créer divers effets d’ombre, ou 
supprimer l’ombre d’un objet.
Pour créer ou supprimer une ombre d’un objet :
1 Sélectionnez l’objet à modifier.
2 Dans l’Inspecteur des graphismes, sélectionnez la case Ombre afin d’ajouter une 
ombre à l’objet. Désélectionnez la case Ombre afin de faire disparaître l’ombre.
3 Définissez l’angle de l’ombre à l’aide de la molette Angle.
4 Ajustez le décalage de l’ombre en tapant un nombre dans la zone Décalage. 
Une valeur élevée de décalage de l’ombre fait apparaître l’ombre de l’objet plus 
longue et légèrement séparée de l’objet.
5 Définissez le flou de l’ombre en tapant un nombre dans la zone Flou. 
Une valeur de flou plus élevée fait apparaître l’ombre de l’objet plus diffuse ; une 
valeur plus faible confère à l’ombre des bords mieux définis.
6 Définissez l’opacité de l’ombre en tapant un nombre dans la zone Opacité. L’opacité 
de l’ombre est distincte de celle de l’objet, laquelle est définie à l’aide du curseur 
Opacité en bas de l’Inspecteur des graphismes.
7 Pour changer la couleur de l’ombre, cliquez sur le cadre des couleurs et sélectionnez 
une couleur.
Changez la couleur de l’ombre dans 
le cadre des couleurs.
Sélectionnez la case afin d’ajouter 
une ombre à un objet sélectionné.
Changez l’angle de l’ombre 
à l’aide de la molette Angle.
Les champs Décalage, Flou et 
Opacité permettent de modifier 
l’aspect de l’ombre.
F2644.book  Page 149  Thursday, January 13, 2005  5:18 PM150 Chapitre 7    Modification de propriétés d’objets
Ajustement de l’opacité
Vous pouvez créer des effets intéressants en rendant les objets plus ou moins 
opaques. Ainsi, lorsque vous placez un objet de faible opacité sur un autre objet, 
l’objet situé dessous transparaît via l’objet situé dessus. En fonction de la valeur 
définie pour l’opacité, les objets situés en dessous peuvent être facilement visibles, 
partiellement obscurcis ou totalement invisibles (opacité de 100 %). Vous pouvez 
modifier les réglages d’opacité de n’importe quel objet graphique de la page, notamment des formes dessinées, des photos et d’autres fichiers image, ainsi que des films. 
Définissez l’opacité des objets à l’aide de l’Inspecteur des graphismes.
Pour changer l’opacité d’un objet :
1 Sélectionnez l’objet.
2 Dans l’Inspecteur des graphismes, faites glisser le curseur Opacité.
Cet objet présente les propriétés 
d’ombre par défaut.
L’ombre de cet objet est définie 
avec un angle différent.
L’ombre de cet objet présente 
une valeur de décalage élevée.
L’ombre de cet objet présente 
le facteur de flou le plus faible.
Cet objet présente une 
couleur d’ombre différente.
L’ombre de cet objet présente 
un facteur de flou élevé.
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Remarque :  pour les objets dessinés, vous pouvez définir l’opacité des couleurs du 
remplissage et du trait séparément de l’opacité de l’objet. Si vous déplacez le curseur 
Opacité dans la fenêtre Couleurs afin de modifier la couleur du remplissage ou du 
trait, cette valeur d’opacité devient l’opacité maximale de l’objet. Ensuite, lorsque vous 
modifiez l’opacité de l’objet dans l’Inspecteur des graphismes, vous la modifiez par 
rapport à l’opacité définie dans la fenêtre Couleurs.
Modification de l’orientation
Vous pouvez retourner ou faire pivoter n’importe quel objet en utilisant l’Inspecteur 
des mesures. Par exemple, si vous possédez une image d’une flèche que vous souhaitez 
utiliser dans un document, mais que vous souhaitez qu’elle pointe dans une autre 
direction, vous pouvez inverser sa direction verticalement ou horizontalement, ou la 
faire pointer dans n’importe quel angle.
Pour ouvrir l’Inspecteur des mesures :
m Choisissez Afficher > Afficher l’Inspecteur (ou cliquez sur Inspecteur dans la barre 
d’outils), puis cliquez sur le bouton Inspecteur des mesures.
Ce cercle est défini sur une opacité 
de 100 %. La couleur de remplissage a été définie sur une opacité 
de 50 % dans la fenêtre Couleurs. 
Le contour du cercle a été défini 
sur une opacité de 100 % dans la 
fenêtre Couleurs.
Ce cercle est défini sur 
une opacité de 100 %.
Ce cercle est défini sur 
une opacité de 50 %.
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Pour retourner ou faire pivoter un objet :
1 Sélectionnez l’objet que vous désirez faire pivoter.
2 Dans l’Inspecteur des mesures, utilisez la molette ou le champ Angle afin de définir la 
direction de l’objet, ou cliquez sur les boutons de retournement horizontal ou vertical.
Redimensionnez les images 
et les films aux dimensions 
exactes en spécifiant la 
hauteur et la largeur.
Retournez une image latéralement ou horizontalement 
à l’aide de ces boutons.
Recherchez le nom de l’image ou 
du film sélectionné. Faites glisser 
son icône vers la page ou le 
Bureau afin d’en faire une copie.
Faites pivoter un objet à l’aide de 
cette molette ou de ce champ.
Placez un objet sur la page 
en indiquant les coordonnées X et Y.
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Ajustement de la taille et de la position d’objets
En plus de faire glisser les objets et leurs rectangles de sélection afin de les redimensionner ou de les repositionner sur la page, vous pouvez utiliser l’Inspecteur des 
mesures afin d’apporter des ajustements précis à leur taille et à leur position.
Pour définir la taille précise d’un objet :
1 Sélectionnez l’objet à redimensionner.
2 Dans l’Inspecteur des mesures, tapez un nombre dans les champs Largeur et Hauteur.
Pour préserver le rapport largeur/hauteur lorsque vous redimensionnez un objet :
m Sélectionnez la case Conserver les proportions dans l’Inspecteur des mesures, ou 
maintenez enfoncée la touche Maj en faisant glisser une poignée de sélection.
Pour rétablir la taille d’origine d’une image ou d’un film :
m Sélectionnez l’image ou le film et cliquez sur Dimensions d’origine dans l’Inspecteur 
des mesures.
Pour définir la position précise d’un objet fixe :
1 Sélectionnez l’objet que vous souhaitez positionner.
2 Dans l’Inspecteur des mesures, tapez les valeurs X et Y dans les champs Position.
Les coordonnées spécifiées déterminent la position du coin supérieur gauche du 
conteneur de l’objet.
Â La valeur X est mesurée à partir du bord gauche de la page.
Â La valeur Y est mesurée à partir du bord supérieur de la page.
Si vous faites pivoter un objet, les coordonnées X et Y spécifient le coin supérieur 
gauche du conteneur qui a pivoté.
Lignes
Pour les lignes, la taille et la position peuvent uniquement être ajustées dans l’Inspecteur des mesures si les lignes sont des objets fixes, qui ne sont pas placés en ligne 
avec le texte. Pour en savoir plus sur la comparaison des objets fixes et des objets en 
ligne, reportez-vous à la section “Comparaison des objets fixes et des objets en ligne” 
à la page 117.
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Lorsque vous tapez les coordonnées X et Y de la ligne dans l’Inspecteur des mesures, 
les coordonnées de départ correspondent au point de terminaison de la ligne du côté 
supérieur gauche la première fois que la ligne apparaît sur la page. Même si vous 
retournez ou faites pivoter la ligne par la suite, les coordonnées de départ correspondent toujours au même point de terminaison de la ligne.
Positionnez une ligne fixe sur la 
page en spécifiant les coordonnées 
X et Y pour le point de terminaison 
inférieur droit.
Positionnez une ligne fixe sur la 
page en spécifiant les coordonnées 
X et Y pour le point de terminaison 
supérieur gauche.
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8
8 Création de tableaux
Les tableaux sont utiles pour organiser les informations et pour créer des dispositions intéressantes. 
Ce chapitre traite des notions élémentaires liées à 
la conception de tableaux.
Pages offre de puissantes fonctions permettant de créer des tableaux attrayants contenant du texte ou des graphismes. Utilisez des tableaux pour organiser et comparer les 
données. En remplissant les cellules d’un tableau avec des graphismes, vous pouvez 
également créer et mettre en forme facilement des dispositions de graphismes. En 
fusionnant et en fractionnant des cellules, vous pouvez facilement mettre en forme des 
formulaires à remplir (par exemple des formulaires de commande).
Ce formulaire de 
données, inclus dans 
le modèle Lab Notes, 
est un ensemble de 
tableaux comprenant 
des cellules remplies 
avec des couleurs et 
des images.
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Ajout d’un tableau
Les tableaux peuvent être ajoutés en ligne avec le texte ou en position fixe sur la 
page. Pour en savoir plus sur les objets fixes et en ligne, reportez-vous à la section 
“Comparaison des objets fixes et des objets en ligne” à la page 117. Les tableaux fixes 
ne peuvent pas s’étendre sur plusieurs pages, contrairement aux tableaux en ligne.
Pour ajouter un tableau en ligne avec du texte :
1 Placez le point d’insertion à l’endroit où vous souhaitez que le tableau apparaisse 
dans l’enchaînement du texte.
2 Choisissez Insérer > Tableau (ou cliquez sur Objets dans la barre d’outils et choisissez 
Tableau). L’Inspecteur des tableaux apparaît.
3 Faites glisser les poignées de sélection disponibles pour redimensionner le tableau.
Pour positionner un tableau fixe :
1 Cliquez n’importe où en dehors des zones de texte du document, de sorte qu’aucun 
point d’insertion ne soit visible.
2 Choisissez Insérer > Tableau (ou cliquez sur Objets dans la barre d’outils et cliquez sur 
Tableau). Un tableau apparaît sur la page.
3 Faites glisser l’objet à l’endroit où vous souhaitez qu’il apparaisse sur la page.
Cette disposition, incluse 
dans le modèle de Photo 
Journal, a été créée via le 
remplissage de certaines 
cellules du tableau avec 
des images et d’autres 
avec des couleurs et du 
texte.
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Vous pouvez également dessiner vous-même un tableau.
Pour dessiner un tableau sur la page :
1 Maintenez la touche Option enfoncée tout en cliquant sur Objets dans la barre 
d’outils puis choisissez Tableau. 
2 Libérez la touche Option et déplacez le pointeur sur la page jusqu’à ce qu’il se 
transforme en réticule.
3 Faites-le glisser sur la page afin de créer un tableau de la taille souhaitée. Lorsque 
vous faites glisser le pointeur, le nombre de rangs et de colonnes augmente ou 
diminue avec la taille du tableau.
Remarque :  un tableau occupe au moins un rang entier d’un document. Vous ne 
pouvez pas habiller les côtés d’un tableau avec du texte. Pour en savoir plus sur 
l’habillage d’objets avec du texte, reportez-vous à la section “Habillage d’un objet 
avec du texte” à la page 132.
Pour redimensionner un tableau :
Â Faites glisser les poignées de sélection disponibles.
Â Si un tableau s’étend sur plusieurs pages, utilisez l’Inspecteur des mesures pour le 
redimensionner. Pour en savoir plus sur le redimensionnement d’objets à l’aide de 
l’Inspecteur des mesures, reportez-vous à la section “Ajustement de la taille et de la 
position d’objets” à la page 153.
Â Si un tableau en ligne s’étend sur plusieurs colonnes, vous devez redimensionner 
la colonne afin de redimensionner le tableau. Pour en savoir plus sur le redimensionnement d’objets à l’aide de l’Inspecteur des mesures, reportez-vous à la section 
“Ajustement de la taille et de la position d’objets” à la page 153. Pour en savoir plus 
sur l’utilisation de colonnes, reportez-vous à la section “Création de colonnes” à la 
page 102.
F2644.book  Page 157  Thursday, January 13, 2005  5:18 PM158 Chapitre 8    Création de tableaux
Sélection de cellules et de bordures d’un tableau
Vous pouvez saisir du texte dans une cellule d’un tableau en sélectionnant la cellule 
et en tapant le texte. Vous pouvez insérer des graphismes dans des tableaux en les 
insérant dans des cellules, de la même façon que vous remplissez un objet avec 
une image. Pour plus d’informations sur l’ajout de graphismes ou sur la définition 
de couleurs d’arrière-plan dans les cellules d’un tableau, reportez-vous à la section 
“Ajout d’images ou de couleurs à l’arrière-plan” à la page 168.
Vous pouvez appliquer les modifications à un tableau entier simultanément (en le 
sélectionnant) ou à certaines cellules. Pour placer du texte ou des graphismes dans 
des cellules d’un tableau ou dans des groupes de cellules, sélectionnez uniquement 
les cellules avec lesquelles vous souhaitez travailler. Vous pouvez sélectionner les 
cellules et bordures d’un tableau à l’aide des raccourcis suivants, ou en utilisant les 
boutons de sélection de l’Inspecteur des tableaux. Pour en savoir plus sur l’Inspecteur 
des tableaux, reportez-vous à la section “Mise en forme de tableaux” à la page 161.
Pour sélectionner le tableau entier, effectuez l’une des opérations suivantes :
Â Cliquez sur le tableau.
Â Si une cellule du tableau est sélectionnée, appuyez sur Commande + Retour afin 
de sélectionner le tableau entier.
Des poignées de sélection apparaissent sur les bords du tableau.
Sélection de cellules d’un tableau
Lorsqu’une cellule unique est sélectionnée, vous pouvez vous déplacer entre des 
cellules en appuyant sur les touches fléchées du clavier. Si vous tapez du texte dans 
ce mode, il remplace le texte présent dans la cellule. Vous pouvez également utiliser 
la touche Tab pour naviguer entre les cellules. Lorsque vous appuyez sur la touche 
Tab lorsque la cellule inférieure droite du tableau est sélectionnée, un nouveau rang 
est ajouté au tableau. Si vous appuyez sur la touche Tab lorsque la cellule inférieure 
droite du tableau est sélectionnée, un nouveau rang est ajouté au tableau.
Pour sélectionner une cellule unique d’un tableau :
m Cliquez sur une cellule tout en maintenant la touche Commande enfoncée. 
La bordure de la cellule sélectionnée est mise en surbrillance en jaune et un point 
d’insertion apparaît. Vous pouvez alors taper du texte dans la cellule.
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Pour sélectionner un groupe contigu de cellules d’un tableau :
m Double-cliquez sur une cellule puis faites glisser le pointeur vers les cellules adjacentes 
ou maintenez la touche Maj enfoncée lorsque vous sélectionnez les cellules adjacentes.
Pour sélectionner un groupe discontinu de cellules d’un tableau :
m Maintenez enfoncée la touche Commande en sélectionnant les cellules.
Pour sélectionner un rang ou une colonne entière :
1 Choisissez Afficher > Afficher l’Inspecteur (ou cliquez sur Inspecteur dans la barre 
d’outils), puis cliquez sur le bouton Inspecteur des tableaux.
2 Sélectionnez une cellule dans le rang ou dans la colonne que vous souhaitez 
sélectionner.
3 Cliquez sur le bouton Rang ou Colonne en bas de l’Inspecteur des tableaux.
Sélection des bordures des cellules d’un tableau
Si un tableau s’étend sur plusieurs pages ou colonnes, le fait de sélectionner la 
bordure en bas d’une page ou d’une colonne peut également avoir un effet sur 
la bordure en haut de la page ou colonne suivante.
Pour sélectionner plusieurs bordures :
1 Sélectionnez les cellules du tableau dont vous souhaitez sélectionner les bordures.
2 Choisissez Afficher > Afficher l’Inspecteur (ou cliquez sur Inspecteur dans la barre 
d’outils), puis cliquez sur le bouton Inspecteur des tableaux.
3 Cliquez sur l’un des boutons Bordures afin de sélectionner toutes les bordures, ou 
uniquement les bordures intérieures, extérieures, horizontales ou verticales des 
cellules sélectionnées.
Cliquez sur Rang afin de sélectionner 
un rang entier du tableau.
Cliquez sur Colonne pour sélectionner 
une colonne entière du tableau.
Cliquez sur un bouton pour sélectionner les bordures d’une cellule.
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Pour sélectionner une seule bordure :
Â Si le tableau n’est pas sélectionné, double-cliquez sur la bordure.
Â Si le tableau est sélectionné, cliquez sur la bordure.
Pour sélectionner un segment d’une bordure d’une cellule :
1 Sélectionnez le tableau.
2 Cliquez en maintenant la touche Option enfoncée afin de sélectionner un segment 
de bordure unique.
3 Pour sélectionner des segments de bordure supplémentaires, appuyez sur les touches 
Option et Maj lorsque vous cliquez.
Saisie et modification de texte dans les cellules d’un tableau
Pour taper du texte dans une cellule d’un tableau :
Â Si la cellule est vide, sélectionnez-la et commencez la saisie.
Â Pour remplacer du texte présent dans la cellule, sélectionnez la cellule, puis doublecliquez sur son contenu. Commencez la saisie.
Â Pour placer le point d’insertion dans le texte d’une cellule, sélectionnez le tableau 
puis cliquez afin de positionner le point d’insertion où vous le souhaitez. 
Commencez la saisie.
Pour permuter le contenu de deux cellules :
m Sélectionnez la cellule et faites-la glisser vers une autre. Une bordure bleue apparaît 
lorsque vous commencez à faire glisser la cellule ; le contenu des cellules est permuté.
Pour copier le contenu d’une cellule dans une autre cellule :
m Sélectionnez la cellule et commencez à la faire glisser. Une bordure bleue apparaît. 
Maintenez la touche Option enfoncée tout en faisant glisser la cellule dans la cellule 
souhaitée.
Pour supprimer le contenu (ainsi que le remplissage en arrière-plan) de cellules 
d’un tableau :
m Sélectionnez les cellules et appuyez sur la touche Suppr. 
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Mise en forme de tableaux
Vous pouvez concevoir l’aspect des tableaux de différentes façons, en modifiant 
l’épaisseur et la couleur des bordures des cellules, en supprimant de manière sélective des bordures de cellules, ou en fusionnant et en fractionnant des cellules afin 
de créer des dissymétries utiles dans le tableau.
Ajout de rangs et de colonnes à un tableau
Pour spécifier l’emplacement où ajouter un rang ou une colonne dans un tableau, 
utilisez les commandes du menu Format.
Pour ajouter un rang à un tableau :
m Sélectionnez une cellule ou un rang de tableau, puis choisissez Format > Tableau > 
Insérer un rang au-dessus ou Insérer un rang en dessous.
Pour ajouter une colonne à un tableau :
m Sélectionnez une cellule ou une colonne de tableau, puis choisissez Format > Tableau 
> Insérer une colonne avant ou Insérer une colonne après.
Mise en forme de rangs et de colonnes
Vous pouvez effectuer des opérations élémentaires de mise en forme de tableau, 
notamment fusionner et fractionner des cellules, ajouter et supprimer des rangs et 
des colonnes, ou encore ajouter ou supprimer le rang et la colonne d’en-tête, en 
utilisant la commande Tableau du menu Format (Format > Tableau) ou les menus 
contextuels, comme décrit ci-dessous. Cependant, si vous apportez de nombreuses 
modifications à un tableau, il peut être plus judicieux d’utiliser l’Inspecteur des 
tableaux.
Pour ouvrir le menu contextuel d’un tableau :
m Sélectionnez le tableau, puis maintenez enfoncée la touche Contrôle en cliquant de 
nouveau sur le tableau.
Pour ouvrir l’Inspecteur des tableaux :
m Choisissez Afficher > Afficher l’Inspecteur (ou cliquez sur Inspecteur dans la barre 
d’outils), puis cliquez sur le bouton Inspecteur des tableaux.
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Pour changer le nombre de rangs ou decolonnes d’un tableau :
1 Dans l’Inspecteur des tableaux, tapez le nombre de rangs souhaité dans le champ 
Rangs. Les rangs sont ajoutés en bas du tableau (sélectionnez la dernière cellule du 
tableau et appuyez sur Tab).
2 Tapez le nombre de colonnes souhaité dans le champ Colonnes. Les colonnes sont 
ajoutées à droite du tableau.
Pour supprimer les rangs ou les colonnes d’un tableau :
1 Sélectionnez le rang ou la colonne.
2 Choisissez Format > Tableau > Supprimer le rang ou Supprimer la colonne.
Remarque :  si vous sélectionnez des cellules et que vous appuyez sur Supprimer, 
seul le contenu de ces cellules est supprimé.
Fusionnez des cellules adjacentes ou 
fractionnez des rangs et des colonnes.
Sélectionnez l’option pour ajouter 
un rang ou une colonne d’en-tête.
Le bouton Inspecteur des tableaux
Tapez le nombre de rangs 
et de colonnes de tableaux.
Sélectionnez puis redimensionnez 
les rangs pour afficher tout le contenu.
Spécifiez la largeur des colonnes 
et la hauteur des rangs.
Sélectionnez les colonnes, les rangs 
et les bordures.
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Création d’un en-tête de rang ou d’une colonne de tableau
Vous pouvez ajouter un rang ou une colonne d’en-tête au début du tableau sur chaque 
page, si le tableau s’étend sur plusieurs pages (ou au début de chaque colonne ou zone 
de texte liée, si le tableau s’étend sur plusieurs colonnes ou zones de texte liées). 
Les rangs et colonnes d’en-tête présentent un aspect différent des autres cellules 
du tableau, mais leur style peut être modifié comme celui de n’importe quelle autre 
cellule. Cependant, vous ne pouvez pas fractionner un rang d’en-tête en plusieurs 
rangs, ou des colonnes d’en-tête en plusieurs colonnes.
Si un tableau s’étend sur plusieurs pages, colonnes ou zones de texte, la modification 
du texte ou de l’aspect de l’en-tête de rang ou de la colonne à un endroit entraîne la 
même modification dans l’ensemble du tableau.
Pour ajouter un rang ou une colonne d’en-tête :
1 Sélectionnez le tableau.
2 Choisissez Format > Tableau > Insérer un en-tête de rang ou Insérer un en-tête de 
colonne, ou dans l’Inspecteur des tableaux, sélectionnez les cases En-tête de rang 
ou En-tête de colonne.
Fusionner, fractionner et redimensionner des cellules de tableau
La fusion de cellules d’un tableau entraîne celle des cellules adjacentes en une seule 
cellule, ce qui a pour effet de supprimer la bordure, de sorte que les cellules se 
comportent comme une cellule unique. En ce qui concerne les cellules horizontalement contiguës, la fusion entraîne celle du texte des deux cellules d’origine, séparé 
par une tabulation. La fusion des cellules verticalement contiguës entraîne la fusion 
du texte des deux cellules d’origine, séparé par un retour chariot. Dans les deux cas, 
l’arrière-plan de la cellule reprend l’image ou la couleur de la cellule la plus en haut 
ou la plus à gauche.
Le fractionnement de cellules divise chaque cellule sélectionnée en deux parts égales, 
horizontalement (rangs) ou verticalement (colonnes). Les deux nouvelles cellules 
présentent des couleurs ou images d’arrière-plan identiques. Tout texte présent dans 
la cellule d’origine reste dans la cellule la plus en haut ou la plus à gauche.
Vous pouvez fractionner et fusionner des cellules à l’aide de commandes de menu, de 
menus contextuels ou de l’Inspecteur des tableaux. Pour redimensionner des cellules 
d’un tableau, utilisez l’Inspecteur des tableaux.
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Pour fusionner des cellules d’un tableau :
1 Sélectionnez un groupe de deux cellules adjacentes ou plus. Le groupe de cellules 
que vous choisissez doit former un rectangle.
2 Choisissez Format > Tableau > Fusionner les cellules.
Vous pouvez également fusionner des cellules en cliquant sur Fusionner les cellules 
dans l’Inspecteur des tableaux.
Pour fusionner des cellules horizontalement ou verticalement :
1 Sélectionnez une ou plusieurs cellules du tableau. Pour fractionner une colonne ou 
un rang entier, sélectionnez toutes les cellules de la colonne ou du rang.
2 Choisissez Format > Tableau > Diviser en rangs ou Diviser en colonnes. 
Il est également possible de diviser les cellules en rangs ou en colonnes en cliquant 
sur Diviser en rangs ou sur Diviser en colonnes dans l’Inspecteur des tableaux. Vous 
pouvez répéter l’opération de fractionnement afin de créer des unités de plus en plus 
petites dans une cellule du tableau. Pour fusionner à nouveau les cellules divisées, 
sélectionnez-les et choisissez Format > Tableau > Fusionner les cellules.
Pour redimensionner les cellules d’un tableau :
Â Sélectionnez les cellules et tapez des valeurs dans les champs Largeur de colonne et 
Hauteur de colonne dans l’Inspecteur des tableaux, puis appuyez sur Retour.
Â Sélectionnez les bordures des cellules et faites-les glisser pour les redimensionner.
Pour faire en sorte que toutes les cellules du tableau présentent la même taille :
m Sélectionnez le tableau et choisissez Format > Tableau > Répartir les rangs uniformé-
ment et Répartir les colonnes uniformément.
S’il y a trop de texte dans une cellule d’un tableau, un indicateur de découpage apparaît en bas de la cellule.
L’indicateur de découpage 
apparaît lorsqu’une cellule 
d’un tableau contient plus 
de texte qu’elle ne peut en 
afficher.
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Pour éviter le découpage, vous pouvez faire glisser les bordures de la cellule afin de 
la redimensionner ou faire glisser une poignée de sélection afin de redimensionner 
l’ensemble du tableau. Vous pouvez également faire en sorte que la hauteur des rangs 
du tableau diminue ou augmente en fonction du texte qu’ils contiennent.
Pour agrandir ou diminuer automatiquement les rangs d’un tableau afin de les 
adapter à leur contenu :
m Sélectionnez le tableau puis cochez la case Ajuster automatiquement au contenu 
dans l’Inspecteur des tableaux.
Si vous sélectionnez cette option, les cellules s’agrandissent automatiquement lorsque 
le texte saisi dépasse les limites des cellules. L’ajout de rangs ou de colonnes augmente 
les dimensions externes du tableau. À mesure que du texte est supprimé d’une cellule, 
la hauteur des rangs peut diminuer (si la cellule détermine la hauteur des rangs). Si 
l’option “Ajuster automatiquement au contenu” n’est pas sélectionnée, Pages tente de 
conserver les dimensions extérieures du tableau lorsque vous ajoutez des rangs et des 
colonnes. 
Remarque :  les cellules des tableaux ne peuvent pas s’étendre sur plusieurs pages, 
colonnes ou zones de texte.
Alignement de texte dans une cellule de tableau
Vous pouvez aligner le texte horizontalement et verticalement dans une cellule d’un 
tableau. Pour aligner du texte, utilisez la sous-fenêtre Texte de l’Inspecteur du texte.
Pour ouvrir la sous-fenêtre Texte de l’Inspecteur du texte :
m Choisissez Afficher > Afficher l’Inspecteur (ou cliquez sur le bouton Inspecteur dans 
la barre d’outils), puis cliquez sur le bouton Inspecteur du texte. Cliquez ensuite sur 
Texte.
Pour plus d’informations sur la sous-fenêtre Texte de l’Inspecteur du texte, reportezvous à la section “Utilisation de l’Inspecteur du texte” à la page 60.
Pour aligner le texte horizontalement dans une cellule d’un tableau :
m Sélectionnez la cellule et cliquez sur l’un des boutons d’alignement horizontal dans 
la sous-fenêtre Texte de l’Inspecteur du texte.
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Pour aligner le texte verticalement dans une cellule :
m Sélectionnez la cellule et cliquez sur l’un des boutons d’alignement vertical dans la 
sous-fenêtre Texte de l’Inspecteur du texte.
Vous pouvez spécifier l’espace entre le texte et la bordure de sa cellule en utilisant le 
curseur ou le champ Marge intérieure. La quantité indiquée est appliquée de manière 
uniforme des quatre côtés du texte. 
Pour ajuster l’espace autour du texte dans une cellule du tableau :
1 Cliquez sur la cellule (ou sélectionnez le tableau entier pour appliquer le même 
réglage à toutes les cellules).
2 Dans la sous-fenêtre Texte de l’Inspecteur du texte, faites glisser le curseur Marge 
intérieure vers la droite afin d’augmenter l’espace, ou entrez une valeur dans le champ 
et appuyez sur Retour.
Mise en forme des bordures de cellules
Vous pouvez modifier l’épaisseur et la couleur des bordures des cellules d’un tableau. 
Vous pouvez également masquer la bordure de n’importe quelle cellule.
Pour définir l’épaisseur et la couleur :
1 Sélectionnez une bordure ou un ensemble de bordures (pour plus d’informations, 
reportez-vous à la section “Sélection des bordures des cellules d’un tableau” à la page 
159).
Alignez le texte à droite.
Justifiez le texte (alignez le 
texte à droite et à gauche).
Alignez le texte à gauche.
Centrez le texte.
Faites commencer le texte 
en bas de la cellule.
Placez le texte en haut de 
la cellule.
Faites commencer le texte 
au centre de la cellule.
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2 Choisissez Afficher > Afficher l’Inspecteur (ou cliquez sur Inspecteur dans la barre 
d’outils), puis cliquez sur le bouton Inspecteur des graphismes.
3 Saisissez une valeur dans le champ Trait.
4 Cliquez sur le cadre Couleur de trait et sélectionnez une couleur dans la fenêtre 
Couleurs.
Pour masquer une bordure de cellule :
1 Sélectionnez une bordure de cellule ou un ensemble de bordures de cellule.
2 Dans l’Inspecteur des graphismes, choisissez Aucun dans le menu local Trait.
Pour créer un tableau sans bordure extérieure :
1 Sélectionnez le tableau.
2 Choisissez Afficher > Afficher l’Inspecteur (ou cliquez sur Inspecteur dans la barre 
d’outils), puis cliquez sur le bouton Inspecteur des tableaux.
3 Cliquez sur le deuxième bouton Bordures dans l’Inspecteur des tableaux afin de 
sélectionner les bordures extérieures.
4 Cliquez sur le bouton Inspecteur des graphismes, puis choisissez Aucun dans le menu 
local Trait.
Choisissez d’afficher ou de masquer 
les bordures de cellule sélectionnées.
Choisissez la couleur des bordures 
de cellules sélectionnées.
Tapez une épaisseur de rang pour 
les bordures de cellule sélectionnées.
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Ajout d’images ou de couleurs à l’arrière-plan
Vous pouvez ajouter des graphismes ou des couleurs à une cellule d’un tableau 
via le menu local Remplir de l’Inspecteur des graphismes. Vous pouvez ajouter des 
images ou des couleurs à des cellules d’un tableau, ou à l’ensemble du tableau.
Pour ajouter une image à une cellule d’un tableau :
1 Sélectionnez une cellule, un groupe de cellules ou l’ensemble du tableau (pour plus 
d’informations, reportez-vous à la section “Sélection de cellules et de bordures d’un 
tableau” à la page 158).
2 Choisissez Afficher > Afficher l’Inspecteur (ou cliquez sur Inspecteur dans la barre 
d’outils), puis cliquez sur le bouton Inspecteur des graphismes.
3 Choisissez Remplissage image dans le menu local Remplir. Si la cellule contient déjà 
une image, cliquez sur Choisir.
4 Sélectionnez une image et cliquez sur Ouvrir.
5 Utilisez le menu local Échelle afin de remplir la cellule de la façon souhaitée.
Si vous ajoutez une image au tabelau entier, lorsque vous sélectionnez une cellule 
individuelle, le menu local Remplir de l’Inspecteur des graphismes affiche Aucun. 
Pour plus d’informations sur l’utilisation de remplissages image, reportez-vous à la 
section “Remplissage d’un objet avec une image” à la page 145.
Définissez la dimension de l’image 
dans la cellule ou le tableau.
Pour changer d’image, faites 
glisser une nouvelle image dans 
le cadre ou cliquez sur Choisir.
Choisissez un remplissage image, un remplissage couleur, 
un remplissage d’image teintée ou un remplissage 
dégradé pour la cellule qui vous intéresse.
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Pour ajouter une couleur d’arrière-plan ou un remplissage dégradé :
1 Sélectionnez une cellule, un groupe de cellules ou l’ensemble du tableau (pour plus 
d’informations, reportez-vous à la section “Sélection de cellules et de bordures d’un 
tableau” à la page 158).
2 Dans l’Inspecteur des graphismes, choisissez Remplissage couleur ou Remplissage 
dégradé dans le menu local Remplir.
3 Cliquez sur le ou les cadre(s) de couleur et sélectionnez une ou plusieurs couleurs 
dans la fenêtre Couleurs.
Si vous ajoutez une couleur à l’ensemble du tableau, lorsque vous sélectionnez une 
cellule, le menu local Remplir de l’Inspecteur des graphismes affiche Aucun. Pour plus 
d’informations sur l’utilisation des remplissages couleur et dégradé, reportez-vous à la 
section “Utilisation de remplissages par des couleurs et des images” à la page 141.
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9
9 Création de graphiques
Vous pouvez transformer des données de feuilles 
de calcul en graphiques attrayants. Ce chapitre 
décrit les notions élémentaires de la création de 
graphiques dans Pages.
Pages fournit des outils permettant de créer des graphiques attrayants afin de présenter 
des données numériques. Vous pouvez copier et coller les données à partir d’une feuille 
de calcul ou les saisir directement dans l’Éditeur de graphiques et créer puis modifier les 
graphiques directement sur la page.
À propos des graphiques
Les graphiques illustrent la relation entre deux types de données. Par exemple, si vous 
représentez sous forme graphique la croissance de l’activité, vous affichez la relation 
entre la taille de l’entreprise et les années. Si vous représentez les résultats d’un vote 
parmi différents groupes démographiques, vous illustrez la relation entre le nombre 
de suffrages et le groupe démographique. Lorsque vous entrez des données pour 
un graphique, les deux types de données sont représentés sous forme de séries de 
données et de jeux de données.
Dans un graphique représentant l’activité d’une entreprise, une série de données 
peut par exemple représenter les bénéfices d’une région sur quatre années successives ; les jeux de données peuvent être les bénéfices de toutes les régions pour une 
seule de ces années. Dans l’illustration ci-dessous, les séries de données (bénéfices 
de chaque région) sont indiquées dans les rangs, les jeux de données (les bénéfices 
de chaque année) dans les colonnes. Chaque valeur (par exemple 17 pour la région 
1 en 2004) est un point-image.
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Les carrés de couleur en regard des étiquettes des rangs (région 1 et région 2) illustrent la couleur qui représente chaque série de données du graphique.
L’illustration ci-dessous montre sous forme graphique l’aspect de ces données.
Dans ce graphique, les séries de données sont représentées sous forme de rangs dans 
l’Éditeur de graphiques. Les points-images sont représentés sous forme d’une série de 
barres de couleur sombre et d’une série de barres de couleur claire.
Transposition de séries de données et d’ensembles de données
Vous pouvez facilement permuter les séries de données et les jeux de données dans 
les graphiques, sans avoir à resaisir les données, en utilisant le bouton Rang / colonne 
dans l’Éditeur de graphiques.
Ces carrés indiquent la couleur 
qui représente chaque série de 
données.
Les jeux de données contiennent 
un point-image (une barre) de 
chacune des séries de données.
Ces quatre barres représentent une série de données.
La légende du graphique désigne 
les deux séries de données.
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L’illustration ci-dessous montre les mêmes données, mais avec les jeux de données 
et les séries de données transposés.
Pour ce graphique, les séries de données sont représentées sous forme de colonnes 
dans l’Éditeur de graphiques illustré précédemment. Il y a désormais quatre séries 
de données représentées sous forme de quatre barres de couleurs différentes.
Les séries de données sont représentées différemment dans les différents types de 
graphique fournis par Pages.
Â Dans les graphiques à colonnes et les graphiques à barres, une série de données 
est représentée par une série de barres de même couleur (comme illustré ci-dessus). 
Â Dans un graphique à rangs (également appelé graphique), une série de données est 
représentée par un rang unique. 
Â Dans un graphique à couches, une série de données est représentée par une 
couche. 
Ce bouton fait des rangs de données 
de l’Éditeur de graphiques la série de 
données.
Ce bouton fait des colonnes de 
données de l’Éditeur de graphiques 
la série de données.
Ces deux barres représentent 
une série de données.
Les jeux de données contiennent un point-image (une barre) 
de chacune des quatre séries de 
données.
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Â Dans un graphique sectoriel, un seul jeu de données (le premier point-image de 
chaque série) est représenté sur le graphique (quel que soit le jeu répertorié en 
premier dans l’Éditeur de graphiques).
Ajout d’un graphique
Des graphiques peuvent être ajoutés en ligne avec le texte ou en position fixe sur 
la page. Pour en savoir plus sur les objets fixes et en ligne, reportez-vous à la section 
“Comparaison des objets fixes et des objets en ligne” à la page 117. Une fois que vous 
avez ajouté le graphique à la page, vous pouvez changer le type de graphique et le 
mettre en forme à l’aide de l’Inspecteur des graphiques, illustré plus loin dans ce 
chapitre.
Pour ajouter un graphique en ligne avec le texte :
1 Placez le point d’insertion à l’endroit où vous souhaitez que le graphique apparaisse 
dans le texte.
2 Choisissez Insérer > Graphique (ou cliquez sur Objets dans la barre d’outils et sélectionnez Graphique). Un graphique contenant des données d’espace réservé s’affiche 
sur la page. L’Inspecteur des graphiques et l’Éditeur de graphiques s’ouvrent.
Pour positionner un graphique fixe :
1 Cliquez n’importe où en dehors des zones de texte du document, de sorte qu’aucun 
point d’insertion ne soit visible.
2 Choisissez Insérer > Graphique (ou cliquez sur Objets dans la barre d’outils et sélectionnez Graphique). Un graphique contenant des données d’espace réservé s’affiche 
sur la page. L’Inspecteur des graphiques et l’Éditeur de graphiques s’ouvrent.
3 Faites glisser le graphique à l’endroit où vous souhaitez qu’il apparaisse sur la page.
Vous pouvez également dessiner un graphique sur la page.
Pour dessiner un graphique sur la page :
1 Maintenez la touche Option enfoncée tout en cliquant sur Objets dans la barre 
d’outils puis choisissez Graphique.
2 Relâchez la touche Option et déplacez le pointeur sur la page jusqu’à ce qu’il se transforme en réticule.
3 Faites-le glisser sur la page afin de créer un graphique de la taille souhaitée.
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Pour redimensionner le graphique sur la page :
m Sélectionnez le graphique dans la page et faites glisser les poignées de sélection 
actives.
Sélection d’un type de graphique
Pages fournit huit types de graphique parmi lesquels vous pouvez choisir, notamment des graphiques à barres, à rangs, à couches et sectoriels. Une fois que vous avez 
placé un graphique sur une page, vous pouvez modifier son type et le mettre en 
forme à l’aide de l’Inspecteur des graphiques.
Pour ouvrir l’Inspecteur des graphiques :
m Choisissez Présentation > Afficher l’Inspecteur (ou cliquez sur Inspecteur dans la barre 
d’outils), puis cliquez sur le bouton de l’Inspecteur des graphiques.
Pour sélectionner un type de graphique, effectuez l’une des opérations suivantes :
Â Choisissez Format > Graphique > [type de graphique].
Â Dans l’Inspecteur des graphiques, sélectionnez un graphique dans le menu local 
Type de graphique.
Choisissez parmi huit types 
de graphique différents dans 
l’Inspecteur des graphiques.
Le bouton Inspecteur des 
graphiques
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Modification de données dans un graphique
Pour modifier des données graphiques, ouvrez l’Éditeur de graphiques et saisissez 
les données en les tapant ou en copiant et collant à partir d’Excel, d’AppleWorks ou 
d’autres applications de feuille de calcul.
Pour ouvrir l’Éditeur de graphiques :
1 Sélectionnez le graphique à modifier.
2 Choisissez Format > Graphique > Afficher l’Éditeur de graphiques (ou cliquez sur 
Modifier données dans l’Inspecteur des graphiques).
Pour copier des données à partir d’une autre feuille de calcul vers l’Éditeur 
de graphiques :
1 Ouvrez la feuille de calcul avec les données souhaitées, puis sélectionnez toutes 
les cellules appropriées.
2 Choisissez Édition > Copier (ou appuyez sur Commande + C).
3 Sélectionnez la cellule supérieure dans la première colonne de l’Éditeur de graphiques.
4 Choisissez Édition > Coller (ou appuyez sur Commande + V).
Pour modifier les noms des rangs et des colonnes, ou les données d’une cellule :
m Double-cliquez sur une cellule ou sur une étiquette de rang ou de colonne, puis tapez 
les informations.
Pour réorganiser les rangs ou les colonnes dans l’Éditeur de graphiques :
m Faites glisser une étiquette de rang ou de colonne à un nouvel emplacement.
Cliquez sur ces boutons afin 
d’ajouter un autre rang ou une 
autre colonne de données.
Tapez les données graphiques 
directement dans les cellules 
de la feuille de calcul.
Faites glisser les étiquettes 
afin de les réorganiser.
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Pour ajouter des rangs ou des colonnes dans l’Éditeur de graphiques, effectuez 
l’une des opérations suivantes :
Â Cliquez sur Insérer un rang ou sur Insérer une colonne afin de placer un rang audessus du rang sélectionné, ou une colonne à gauche de celle sélectionnée. Si aucun 
rang ni aucune colonne n’est sélectionné, le nouveau rang ou la nouvelle colonne 
apparaît en bas ou à droite du tableau (pour visualiser le nouveau rang ou la nouvelle 
colonne, vous devez appuyer sur la touche Retour ou Tab ou agrandir la fenêtre de 
l’Éditeur de graphiques).
Â Sélectionnez n’importe quelle cellule vide, saisissez vos données et appuyez sur 
Retour. Un nouveau rang ou une nouvelle colonne est automatiquement créé.
Pour supprimer des rangs ou des colonnes :
m Sélectionnez l’étiquette du rang ou de la colonne et appuyez sur Suppr.
Mise en forme de graphiques
Vous pouvez redimensionner et repositionner des graphiques et des légendes comme 
n’importe quel autre objet. Vous pouvez mettre en forme les éléments des graphiques 
(polices, couleurs, étiquettes des axes et marques) en fonction de vos préférences. Vous 
pouvez également masquer la légende du graphique. La plupart des tâches de mise en 
forme des graphiques sont effectuées à l’aide de l’Inspecteur des graphiques. Vous 
pouvez également effectuer de nombreuses opérations à l’aide de menus contextuels.
Pour ouvrir le menu contextuel d’un graphique :
m Maintenez la touche Contrôle enfoncée et cliquez sur un graphique.
Pour masquer la légende du graphique :
1 Choisissez Présentation > Afficher l’Inspecteur (ou cliquez sur Inspecteur dans la barre 
d’outils), puis cliquez sur le bouton de l’Inspecteur des graphiques.
2 Sélectionnez le graphique.
3 Dans l’Inspecteur des graphiques, désélectionnez la case Afficher la légende.
Vous pouvez également sélectionner la légende et appuyer sur Suppr ; vous pouvez 
toujours afficher de nouveau la légende en sélectionnant la case Afficher la légende.
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Définition des couleurs des graphiques
Vous pouvez mettre en forme les barres, les portions et les couches qui apparaissent 
sur chaque type de graphique, de la même façon que vous mettez en forme tout 
autre objet dessiné. Vous pouvez leur affecter des remplissages de couleur, des 
remplissages dégradés, des remplissages d’image, des ombres, une opacité ou diffé-
rents styles de trait. Vous définissez ces attributs dans l’Inspecteur des graphismes.
Pour changer la couleur ou l’image d’une barre, d’une portion ou d’une couche :
1 Sélectionnez l’élément (barre, portion ou couche). 
Si vous sélectionnez une barre d’un graphique à barres, toutes les barres de cette série 
sont sélectionnées.
2 Vous pouvez modifier les propriétés de votre graphique comme vous le feriez avec 
n’importe quel dessin à l’aide de l’Inspecteur des graphismes. 
Pour plus d’informations sur la modification des propriétés des objets, consultez le 
chapitre 7, “Modification de propriétés d’objets”.
Modification des polices d’un graphique
Vous pouvez modifier les polices et les couleurs de texte utilisées pour les étiquettes 
des axes, les étiquettes des points-image et les légendes.
Pour modifier les polices d’un graphique :
1 Sélectionnez le texte à modifier. 
Pour modifier la police de tous les éléments d’un graphique, cliquez sur le graphique 
pour le sélectionner. Si vous sélectionnez le texte pour une étiquette de point-image 
ou d’axe, tout le texte de ce type est également sélectionné. Vous devez modifier la 
police des légendes séparément.
2 Choisissez Format > Police > Afficher les polices (ou cliquez sur Polices dans la barre 
d’outils) afin d’ouvrir le panneau Police.
3 Sélectionnez une police.
Pour plus d’informations sur le changement des couleurs du texte, reportez-vous à la 
section “Mise en forme de la taille et de l’apparence du texte” à la page 51.
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Ajout d’étiquettes et de marques d’axe
Utilisez la sous-fenêtre Axe de l’Inspecteur des graphiques pour mettre en forme la 
grille et l’aspect général des axes pour les graphiques à barres, les graphiques à lignes 
et les graphiques à couches. Vous pouvez définir la plage des valeurs à afficher le long 
de l’axe des valeurs, c’est-à-dire l’axe le long duquel vous lisez les valeurs des pointsimages. Pour les graphiques à colonnes (barres verticales), les graphiques à lignes et 
les graphiques à couches, l’axe des Y est l’axe des valeurs. Pour les graphiques à barres 
horizontales, l’axe des X est l’axe des valeurs. Les graphiques sectoriels ne comportent 
pas d’axe des valeurs. Pour en savoir plus sur la mise en forme des graphiques sectoriels, reportez-vous à la section “Graphiques sectoriels” à la page 183.
Pour afficher ou masquer les axes et les bordures des graphiques :
1 Sélectionnez le graphique.
2 Dans l’Inspecteur des graphiques, cliquez sur le bouton Axe s’il n’est pas sélectionné.
3 Sélectionnez un ou plusieurs éléments dans le menu local Axes et bordures.
Un élément sélectionné comporte en face une coche ; choisissez de nouveau 
l’élément afin de le désélectionner.
Pour définir la plage des valeurs numériques qui s’affichent sur la grille 
du graphique :
1 Sélectionnez le graphique.
Définissez des styles pour les 
étiquettes et les marques le 
long de la grille du graphique.
Sélectionnez des unités pour 
les valeurs du graphique.
Affichez ou masquez les axes 
et les bordures des graphiques.
Définissez la plage des valeurs 
qui apparaissent sur la grille 
du graphique.
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2 Dans l’Inspecteur des graphiques, cliquez sur le bouton Axe s’il n’est pas sélectionné.
3 Pour définir la valeur à l’origine du graphique, tapez un nombre dans le champ 
Minimum (sous Format de l’axe des valeurs).
La valeur Minimum ne peut pas être supérieure à la valeur minimale de l’ensemble 
du jeu de données.
4 Pour définir le nombre le plus élevé qui s’affiche sur l’axe des valeurs, tapez un 
nombre dans le champ Maximum.
La valeur Maximum ne peut pas être inférieure à la valeur maximale de l’ensemble 
du jeu de données.
5 Pour spécifier le nombre de marques sur l’axe entre les valeurs minimale et maximale, 
tapez un nombre dans le champ Intervalles.
Pour afficher la valeur de donnée minimale sur l’axe des valeurs :
1 Sélectionnez le graphique.
2 Dans l’Inspecteur des graphiques, cliquez sur le bouton Axe s’il n’est pas sélectionné.
3 Sélectionnez Afficher les étiquettes de valeur et Afficher la valeur minimale dans le 
menu local Axes des valeurs (menu local de l’axe des X ou des Y en fonction du 
graphique).
Un élément sélectionné est coché.
Pour spécifier des unités pour les valeurs des axes :
1 Sélectionnez le graphique.
2 Dans l’Inspecteur des graphiques, cliquez sur le bouton Axe s’il n’est pas sélectionné.
3 Sous Format des nombres, tapez du texte dans le champ Préfixe ou Suffixe (ou choisissez un symbole dans les menus contextuels).
Placement d’étiquettes de grille et de marques
Les menus contextuels Axe des X et Axe des Y de la sous-fenêtre Axe de l’Inspecteur 
des graphiques offrent différentes options pour le positionnement des marques, 
des étiquettes et du quadrillage le long de l’axe des valeurs ou de l’axe des séries. 
Les options de ces menus contextuels (illustrées ci-dessous) dépendent du type de 
graphique que vous sélectionnez.
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Pour les graphiques à barres verticales (graphiques à colonnes), les graphiques à 
lignes et les graphiques à couches, l’axe des Y est l’axe des valeurs et l’axe des X est 
l’axe des séries ; pour les graphiques à barres horizontales, l’axe des X est l’axe des 
valeurs. Voici l’apparence des menus locaux lorsqu’un graphique à colonnes est 
sélectionné.
Pour placer des étiquettes de grille et des marques le long d’un axe :
1 Sélectionnez le graphique.
2 Dans l’Inspecteur des graphiques, cliquez sur le bouton Axe s’il n’est pas sélectionné.
3 Pour ajouter des étiquettes de grille et des marques le long de l’axe des séries, 
sélectionnez une option dans le menu local Axe des X. Pour les graphiques à barres 
horizontales, sélectionnez parmi les mêmes options dans le menu contextuel Axe 
des Y.
4 Pour ajouter des étiquettes de grille et des marques à l’axe des valeurs, sélectionnez 
une option dans le menu contextuel Axe des Y. Pour les graphiques à barres horizontales, sélectionnez parmi les mêmes options dans le menu contextuel Axe des X.
Placez des marques le long 
de l’axe des X.
Affichez ou masquez le quadrillage 
de l’axe des X.
Définissez la direction du 
texte pour les étiquettes 
des axes des séries.
Affichez ou masquez les étiquettes 
des axes des séries.
Placez des marques le long 
de l’axe des Y.
Affichez ou masquez le quadrillage 
de l’axe des Y.
Affichez ou masquez les étiquettes 
de l’axe des valeurs.
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Mise en forme des éléments d’une série de données
Vous pouvez afficher la valeur numérique de chaque point-image d’une série.
Pour ajouter des étiquettes de points-images :
1 Sélectionnez le graphique ou un élément dans une série de données.
Pour tous les types de graphiques sauf les graphiques sectoriels, sélectionner un 
élément (barre) d’une série sélectionne automatiquement la série entière. Dans 
les graphiques sectoriels, vous pouvez sélectionner des portions individuelles.
2 Dans l’Inspecteur des graphiques, cliquez sur le bouton Série. 
3 Choisissez Afficher la valeur dans le menu local Réglages de point-image.
4 Pour spécifier le nombre de décimales à afficher, tapez un nombre dans le champ 
Décimales.
5 Pour changer la position des valeurs des points-images, choisissez une option dans 
le menu local Réglages de point-image.
6 Utilisez le panneau Police (Format > Police > Afficher les polices) pour choisir une 
police, une taille de police et un style pour les étiquettes de point-image.
Vous pouvez afficher les étiquettes des points-image des graphiques sectoriels sous 
forme de pourcentage de l’ensemble ou de valeurs absolues en sélectionnant ou 
désélectionnant Afficher les valeurs des portions en % dans le menu local Réglages 
de point-image. Vous pouvez également afficher le nom des séries.
Certains styles de graphique offrent davantage d’options pour la mise en forme des 
éléments des séries. Reportez-vous aux sections suivantes pour plus d’informations 
sur les options de mise en forme spéciales des graphiques sectoriels, à barres, à lignes 
et à couches. 
F2644.book  Page 182  Thursday, January 13, 2005  5:18 PMChapitre 9    Création de graphiques 183
Graphiques sectoriels
Pour les graphiques sectoriels, Pages ne représente que le premier jeu de données 
dans l’Éditeur de graphiques (le premier point-image de chaque série de données). 
Si les séries de données se trouvent dans des rangs dans l’Éditeur de graphiques, 
seule la première colonne est représentée ; si les séries de données se trouvent dans 
des colonnes dans l’Éditeur de graphiques, seul le premier rang est représenté. Par 
conséquent, un graphique sectoriel représente un seul jeu de données et chaque 
portion représente un élément de ce jeu. Les autres jeux de données de l’Éditeur 
de graphiques sont conservés, mais ils ne s’affichent pas dans le graphique sectoriel. 
Vous pouvez représenter n’importe quel jeu de données en le déplaçant vers la 
première position dans le rang ou dans la colonne.
Pour sélectionner des portions individuelles :
1 Sélectionnez le graphique, puis cliquez afin de sélectionner une portion unique.
2 Pour sélectionner des portions supplémentaires, effectuez l’une des opérations 
suivantes :
Â Pour sélectionner toutes les portions, choisissez Édition > Sélectionner tout (ou 
appuyez sur Commande + A).
Â Pour sélectionner des portions non contiguës, maintenez la touche Commande 
enfoncée lorsque vous sélectionnez chaque portion.
Â Pour sélectionner une rangée de portions contiguës, sélectionnez la première 
portion puis maintenez la touche Maj enfoncée tout en sélectionnant la dernière 
portion.
Dans les graphiques sectoriels, en plus d’afficher les valeurs des portions, vous pouvez 
afficher le nom des séries.
Pour afficher le nom d’une série dans un graphique sectoriel :
1 Sélectionnez le graphique ou des portions individuelles.
2 Dans l’Inspecteur des graphiques, cliquez sur le bouton Série. 
3 Sélectionnez Afficher le nom des séries dans le menu local Réglages de point-image 
(un élément est sélectionné lorsqu’il est coché).
4 Choisissez À l’intérieur ou À l’extérieur dans le menu local Réglages de point-image.
Vous pouvez séparer tout ou partie des portions.
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Pour séparer des portions individuelles :
1 Sélectionnez les portions individuelles. Pour sélectionner plusieurs portions, maintenez enfoncée la touche Commande lorsque vous cliquez sur chaque portion.
2 Faites glisser les portions du graphique sectoriel ou le curseur Éloigner jusqu’à ce que 
les portions du graphique soient placées à l’endroit où vous le souhaitez.
Vous pouvez également saisir un chiffre dans le champ Éloigner ou utiliser les flèches 
pour augmenter ou réduire la valeur d’éloignement.
Vous pouvez placer des ombres sur des portions individuelles ou sur le graphique 
entier. Si vous placez des ombres sur des portions individuelles, celles-ci semblent 
se trouver sur des couches différentes.
Pour placer des ombres sur des portions individuelles :
1 Sélectionnez le graphique ou des portions individuelles.
2 Dans l’Inspecteur des graphiques, cliquez sur le bouton Série.
3 Choisissez Individuelle dans le menu local Ombre.
4 Dans l’Inspecteur des graphiques, définissez les attributs des ombres. Pour plus 
d’informations, reportez-vous à la section “Ajout d’ombres” à la page 149.
Ajoutez des ombres aux 
portions individuelles ou 
au graphique entier.
Séparez les portions 
individuelles.
Éloignez une portion 
en utilisant le curseur 
Éloigner et en lui attribuant un nom de série.
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Pour placer une ombre sur le graphique entier :
1 Sélectionnez le graphique.
2 Dans la sous-fenêtre Séries de l’Inspecteur des graphiques, sélectionnez Groupe 
dans le menu local Ombre.
3 Dans l’Inspecteur des graphiques, définissez les attributs des ombres. Pour plus 
d’informations, reportez-vous à la section “Ajout d’ombres” à la page 149.
Vous pouvez également modifier l’opacité du graphique et de ses différents éléments, 
notamment la légende. Pour plus d’informations, reportez-vous à la section “Ajustement de l’opacité” à la page 150.
Pour faire pivoter un graphique sectoriel :
m Sélectionnez le graphique et faites glisser la molette Angle de rotation dans la sousfenêtre Séries de l’Inspecteur des graphiques, ou tapez une valeur dans le champ 
Angle de rotation.
Graphiques à barres et à colonnes
Il est possible d’appliquer des ombres à une série de données spécifique ou à l’ensemble 
du graphique. Vous pouvez ajuster l’opacité du graphique dans son ensemble ou pour 
des séries individuelles (mais pas des barres individuelles). Vous pouvez également 
ajuster l’espacement entre les jeux de données ou entre des barres individuelles.
Pour ajuster l’espacement entre des barres individuelles ou des jeux de données :
1 Sélectionnez le graphique.
2 Dans l’Inspecteur des graphiques, cliquez sur le bouton Séries s’il n’est pas 
sélectionné.
3 Pour changer l’espacement entre les barres, tapez une valeur (ou cliquez sur les flèches) 
dans le champ Espace entre les barres.
Séparez les barres individuelles 
du graphique.
Séparez les jeux de 
données du graphique.
Ajoutez des ombres aux barres 
ou aux jeux de données.
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4 Pour changer l’espace entre les jeux de données, tapez une valeur dans le champ 
Espace entre les jeux.
La valeur est le pourcentage de l’épaisseur des barres. Le fait de réduire l’espace entre 
les barres les rend plus épaisses. Vous pouvez également déplacer le pointeur près du 
bord d’une barre jusqu’à ce qu’il devienne une double flèche, puis faire glisser afin de 
rendre les barres plus épaisses ou plus fines.
Pour placer une ombre sur chaque barre :
1 Sélectionnez le graphique ou une série de données.
2 Dans la sous-fenêtre Séries de l’Inspecteur des graphiques, sélectionnez Individuelle 
dans le menu local Ombre.
Si vous sélectionnez une série de données et que vous choisissez un élément dans 
le menu local Ombre, le choix s’applique à toutes les séries du graphique.
3 Dans l’Inspecteur des graphiques, définissez les attributs des ombres. Pour plus 
d’informations, reportez-vous à la section “Ajout d’ombres” à la page 149.
Pour ajuster l’opacité d’un graphique :
m Sélectionnez le graphique et faites glisser le curseur Opacité dans l’Inspecteur des 
graphismes. Pour plus d’informations, reportez-vous à la section “Ajustement de 
l’opacité” à la page 150.
Graphiques à couches et à lignes
Dans les graphiques à couches et à lignes, vous pouvez utiliser des symboles (cercles, 
triangles, carrés et losanges) pour représenter les points-images.
Les points-images de cette 
série sont représentés à l’aide 
de triangles.
Les points-images de cette 
série sont représentés à l’aide 
de cercles.
F2644.book  Page 186  Thursday, January 13, 2005  5:18 PMChapitre 9    Création de graphiques 187
Pour utiliser un symbole pour les points-images d’une série :
1 Sélectionnez une série de données (couche ou ligne).
2 Dans la sous-fenêtre Séries de l’Inspecteur des graphiques, choisissez un symbole 
dans le menu local Symbole de point-image.
3 Remplissez le symbole en choisissant l’une des options dans le menu local Remplissage 
du symbole.
Pour définir la couleur et l’ombre des lignes :
m Utilisez les contrôles Trait et Ombre de l’Inspecteur des graphiques.
Pour en savoir plus sur l’utilisation de l’Inspecteur des graphismes dans le cadre du 
réglage de la couleur et de l’ombre de la ligne ainsi que du remplissage des symboles 
de points-image, consultez le chapitre 7, “Modification de propriétés d’objets”.
Choisissez un symbole à utiliser 
pour les points-images.
Remplissez les symboles des 
points-images avec de la couleur 
ou des images.
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10
10 Impression et exportation 
d’un document vers d’autres 
formats
Ce chapitre décrit les différents moyens permettant 
d’imprimer, d’afficher et de partager un document 
Pages. 
En plus d’imprimer ou de faxer un document, vous pouvez le partager électroniquement. En l’exportant vers d’autres formats de document, vous pouvez collaborer avec 
d’autres personnes qui utilisent AppleWorks ou Microsoft Word. Vous pouvez également rendre le document disponible sur le Web en le convertissant au format PDF 
ou HTML.
Impression de documents
Pages et Mac OS X offrent des outils pouvant imprimer tout ou partie d’un document 
dans diverses dispositions, ainsi qu’ajuster la couleur du document imprimé.
Définission de la taille et de l’orientation du papier
Avant d’imprimer, vous devez vous assurer que la taille et l’orientation du papier sont 
configurées comme vous le souhaitez. Pour cela, ouvrez la zone de dialogue Format 
d’impression.
Pour définir la taille et l’orientation du papier :
1 Choisissez Fichier > Format d’impression.
2 Dans la zone de dialogue Format d’impression, choisissez l’imprimante que vous allez 
utiliser dans le menu local Pour.
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3 Choisissez une taille de papier standard dans le menu local Taille de papier. Si vous 
souhaitez définir une taille de papier personnalisée, procédez de la façon suivante :
a Choisissez Taille de papier personnalisée dans le menu local Réglages.
b Cliquez sur Nouveau et attribuez un nom à la nouvelle taille de papier.
c Spécifiez la hauteur et la largeur du papier dans les champs Taille de papier, 
puis spécifiez les marges de la zone imprimable à utiliser dans les champs Marges 
d’impression.
d Cliquez sur Enregistrer.
e Choisissez Attributs des pages dans le menu local Réglages.
f Dans le menu local Taille de papier, sélectionnez la nouvelle taille de papier que 
vous avez nommée. Elle apparaît vers le bas de la liste.
g Cliquez sur OK.
Cliquez afin de créer une taille 
de papier personnalisée.
Attribuez un nom à la taille 
de papier personnalisée.
Cliquez afin de dupliquer ou de 
supprimer une taille de papier 
sélectionnée.
Si vous éditez les options de taille 
de papier personnalisée, cliquez 
sur Enregistrer afin d’enregistrer 
les modifications.
Définissez la hauteur et la 
largeur du papier.
Définissez les marges de la page.
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4 Sélectionnez une option d’orientation à l’aide d’un des boutons en bas de la zone de 
dialogue Format d’impression.
Impression de tout ou partie d’un document
Vous pouvez imprimer un document entier, une plage de pages sélectionnée, ou 
uniquement les pages paires ou impaires. Vous pouvez également imprimer plusieurs 
pages sur une même feuille de papier, ou imprimer les pages dans l’ordre inverse.
Pour vous assurer que la disposition est conforme à vos besoins, il est judicieux d’afficher un aperçu du document avant de l’imprimer.
Pour afficher un aperçu du document avant l’impression :
1 Choisissez Fichier > Imprimer, puis cliquez sur le bouton Aperçu dans la zone de 
dialogue Imprimer.
L’aperçu illustre l’aspect de chaque page d’un document lors de l’impression. Il 
n’affiche pas les effets de certaines options de mise en forme, telles que les bordures. 
Pour plus d’informations sur les options de mise en forme, reportez-vous à la section 
“Configuration de la disposition d’impression et autres options” à la page 192.
2 Sélectionnez la case Épreuve-écran dans le coin inférieur gauche de la fenêtre 
Aperçu afin de tenir compte des possibilités de votre imprimante. Par exemple, 
si vous imprimez un document couleur sur une imprimante noir et blanc, l’option 
Épreuve-écran affiche l’aperçu du document en noir et blanc.
3 Cliquez sur Imprimer afin d’imprimer votre document directement à partir de la 
fenêtre Aperçu.
Pour plus d’informations sur l’utilisation de l’aperçu, reportez-vous à l’aide. Choisissez 
Aide > Aperçu lorsque la fenêtre Aperçu est active.
Orientation paysage avec 
le haut de la page du côté 
gauche du papier
Orientation portrait (l’orientation par 
défaut de la plupart des modèles)
Orientation paysage avec 
le haut de la page du 
côté droit du papier
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Pour imprimer le document complet ou une plage de pages :
1 Choisissez Fichier > Imprimer
2 Choisissez l’imprimante que vous souhaitez utiliser dans le menu local Imprimante. 
Si l’imprimante que vous souhaitez utiliser n’apparaît pas dans la liste, choisissez 
Modifier la liste des imprimantes et ajoutez-la.
Pour en savoir plus sur l’ajout d’une imprimante, recherchez “Ajouter une imprimante” 
dans l’Aide Mac OS. Pour déterminer l’emplacement de l’imprimante que vous utilisez, 
positionnez le pointeur sur le nom de l’imprimante lorsque vous la sélectionnez dans 
le menu local Imprimante.
3 Tapez le nombre d’exemplaires que vous souhaitez imprimer dans le champ Copies, 
puis sélectionnez la case Triées si vous souhaitez imprimer chaque groupe de pages 
dans l’ordre avant d’imprimer le groupe suivant. Si vous souhaitez imprimer un lot de 
pages 1, puis de pages 2, puis de pages 3, etc., désélectionnez la case.
4 Pour imprimer le document entier, sélectionnez Toutes en regard de Pages.
5 Pour imprimer une plage de pages, sélectionnez De, puis tapez le numéro de la 
première page dans le champ De, et le numéro de la dernière page dans le champ “à”.
6 Cliquez sur Imprimer.
Configuration de la disposition d’impression et autres options
Le menu local Copies et pages de la zone de dialogue Imprimer offre plusieurs autres 
options d’impression, permettant notamment d’utiliser ColorSync pour ajuster la 
couleur (voir la page 194), d’imprimer un document dans l’ordre inverse, d’imprimer 
uniquement les pages paires ou impaires, d’imprimer une page de garde (page de 
séparation), etc. Une fois que vous avez défini vos options d’impression préférées, 
vous pouvez enregistrer ces paramètres en tant que valeur prédéfinie afin de les réutiliser ultérieurement sans effectuer de nouveau toutes les étapes.
Pour imprimer les pages du document dans l’ordre inverse :
m Choisissez Gestion du papier dans le menu local Copies et pages, puis sélectionnez 
la case Inverser l’ordre des pages.
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Pour imprimer uniquement les pages paires ou impaires :
m Choisissez Gestion du papier dans le menu local Copies et pages, puis sélectionnez 
Pages numérotées impaires ou Pages numérotées paires.
Pour imprimer plusieurs pages sur une même feuille de papier :
1 Choisissez Disposition dans le menu local sous le menu local Préréglages.
2 Choisissez le nombre de pages à afficher sur chaque feuille dans le menu local Page(s) 
par feuille.
3 Sélectionnez le sens de la disposition.
4 Choisissez le style de trait devant séparer chaque page imprimée du menu local 
Bordure.
Pour imprimer en recto verso :
m Choisissez Disposition dans le menu local sous le menu local Préréglages, puis sélectionnez l’une des options suivantes :
Â Reliure côté long :  imprime les pages à relier dans la longueur.
Â Reliure côté court :  imprime les pages à relier côté court du papier.
Remarque :  toutes les imprimantes ne peuvent pas être utilisées en recto verso. 
Reportez-vous à la documentation fournie avec l’imprimante.
Choisissez un style du trait afin 
de séparer les pages imprimées 
sur chaque feuille.
Imprimez d’abord de gauche 
à droite, puis vers le bas.
Imprimez les pages 
d’abord de droite à 
gauche, puis vers le bas.
Imprimez les pages 
d’abord de haut en bas, 
puis vers la droite.
Imprimez les pages 
d’abord de haut en bas, 
puis vers la gauche.
Affichez un aperçu de la 
disposition que vous avez 
configurée.
Sélectionnez les options
d’impression recto verso.
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Pour enregistrer les options d’impression sous forme de préréglage :
m Choisissez Enregistrer sous dans le menu local Préréglages de la zone de dialogue 
Imprimer et tapez un nom pour le préréglage.
Pour utiliser les mêmes paramètres ultérieurement, choisissez le nom du préréglage 
dans le menu local Préréglages.
Ajustement de la couleur du document avec ColorSync
Vous pouvez rendre les documents imprimés plus clairs, plus foncés ou leur affecter 
une teinte sépia, ou encore ajouter d’autres effets, via l’ajout d’un filtre Quartz à la 
sortie de l’imprimante. Le filtre utilise la technologie ColorSync afin de modifier le 
document imprimé sans modifier le document proprement dit. Vous pouvez également utiliser ColorSync pour modifier la résolution du document.
Remarque :  toutes les imprimantes ne peuvent pas imprimer en couleur. Reportezvous à la documentation fournie avec l’imprimante.
Pour ajuster la couleur d’un document :
1 Choisissez Fichier > Imprimer
2 Choisissez ColorSync dans le menu local sous le menu local Préréglages dans la zone 
de dialogue Imprimer.
3 Choisissez une option dans le menu local Conversion des couleurs :
Â Standard :  utilise les réglages par défaut dans Pages afin de contrôler la gestion des 
couleurs du document imprimé.
Â Dans Imprimante :  permet à l’imprimante que vous utilisez de contrôler la gestion 
des couleurs du document imprimé.
4 Choisissez une option dans le menu local Filtre Quartz.
Pour afficher un aperçu du document imprimé avec le filtre Quartz que vous avez 
choisi, cliquez sur Aperçu.
Une fois que vous avez sélectionné le filtre Quartz souhaité, vous pouvez enregistrer 
ce réglage dans le cadre du préréglage, comme décrit ci-dessus. Pour plus d’informations sur ColorSync et les filtres Quartz, reportez-vous à l’Aide Utilitaire ColorSync en 
ouvrant l’application ColorSync (située dans Applications/Utilitaires), puis en choisissant Aide > Aide Utilitaire ColorSync.
L’icône de l’utilitaire 
ColorSync
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Exportation vers d’autres formats de document
Vous pouvez partager vos documents Pages entre différentes plates-formes en les 
exportant vers d’autres formats, tels que Microsoft Word, PDF ou HTML.
Pour exporter un document vers un autre format de fichier :
1 Choisissez Fichier > Exporter.
2 Sélectionnez le type de document souhaité dans la zone de dialogue Exporter.
Â PDF : peut être visualisé ou imprimé en mode Aperçu ou dans n’importe quel outil 
d’affichage PDF, et peut être édité avec une application PDF
Â Word : peut être ouvert et édité dans Microsoft Word sous Mac OS X, ou sous 
Windows
Â HTML : permet l’utilisation de fichiers son et de séquences, et peut être affiché dans 
Safari ou d’autres applications qui affichent le code HTML
Â RTF : conserve l’essentiel de la mise en forme du texte et des graphismes ; peut être 
ouvert et édité dans un logiciel de traitement de texte
Â Texte brut : supprime la mise en forme du texte ; peut être ouvert et édité dans une 
application d’édition de texte, telle que TextEdit
3 Cliquez sur Suivant.
4 Tapez le titre du nouveau document et sélectionnez l’emplacement dans lequel 
l’enregistrer.
Remarque :  lorsque vous exportez un document vers d’autres formats, le nouveau 
document n’est pas forcément identique au document Pages.
Lors de l’exportation vers Microsoft Word, l’interligne n’est pas forcément identique, 
de sorte que le document Word peut comporter moins de pages que le document 
Pages. En outre, il est possible que certaines fonctionnalités typographiques et 
certains graphismes ne s’affichent pas, en particulier ceux qui utilisent la transparence 
(canaux alpha). Il est possible que les dispositions des tableaux et des colonnes ne 
soient pas exportées de manière identique, et que les graphiques créés dans Pages 
apparaissent sous forme d’images statiques dans d’autres formats de document. Les 
images n’apparaissent pas du tout dans le format Texte brut.
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11
11 Conception de modèles de 
document
Ce chapitre est destiné aux personnes qui souhaitent 
créer leurs propres modèles de document.
Il suppose que vous êtes déjà familiarisé avec les fonctionnalités de conception et 
de mise en forme de Pages décrites dans les chapitres précédents.
Les modèles fournis avec Pages fournissent des idées pour la mise en page, et définissent également l’aspect des graphiques, des tableaux et du texte. Dans chaque 
modèle, les attributs suivants peuvent être définis :
Â Orientation de la page
Â Marges de la page
Â Numérotation des pages
Â Graphismes en arrière-plan (filigrane)
Â Divers styles de texte, notamment le corps de texte, les en-têtes, les pieds de page, 
les renvois, etc.
Â Styles de table des matières
Â Styles de puce et de numérotation
Â Remplissages d’objet et styles de trait pour les objets dessinés
Â Couleurs et styles des graphismes
Â Aspect des tableaux
Â Mises en pages de modèles supplémentaires
Vous pouvez modifier n’importe lequel de ces attributs afin de créer vos modèles. 
La création de votre modèle peut également se résumer à la sélection d’un modèle 
existant et à l’ajout du logo de votre entreprise sur la page.
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Si vous souhaitez personnaliser un modèle, par exemple en ajoutant des images, 
en modifiant le texte d’un espace réservé ou en définissant de nouveaux styles 
de texte, reportez-vous aux sections correspondantes de ce chapitre, puis lisez 
“Étape 4 : Enregistrement d’un modèle personnalisé” à la page 207.
Si vous souhaitez créer un modèle de toutes pièces, commencez par un modèle vide. 
Il peut être utile de parcourir toutes les sections de ce chapitre dans l’ordre.
Étape 1 :  Configuration de document
Avant d’accéder aux niveaux plus détaillés de conception du document, vous devez 
commencer par définir la taille et l’aspect général du document. Cela permettra de 
garantir la cohérence dans le document. Pour configurer un document, commencez 
par effectuer les tâches suivantes :
1 Définissez la taille et l’orientation du papier.
Déterminez la taille et l’orientation du papier qui seront utilisées pour le document 
fini. Par exemple, si vous créez un modèle pour des enveloppes, prenez soin de sélectionner la taille d’enveloppe appropriée (ou de créer une taille personnalisée) avant de 
poursuivre la conception du document. Pour en savoir plus sur la définition de la taille 
et de l’orientation du papier, reportez-vous à la section “Configuration de l’orientation 
et de la taille des pages” à la page 101.
2 Définissez les marges de la page.
Définissez la zone de texte du corps et les zones de texte des en-têtes et des pieds 
de page. Si votre document sera relié, vous pouvez définir différentes marges pour 
les pages recto et verso. Les marges du document sont définies dans l’Inspecteur 
des documents. Pour plus d’informations, reportez-vous aux sections “Définition des 
marges de page” à la page 102 et “Création d’un document avec des pages opposées 
gauche et droite” à la page 106.
3 Insérez la numérotation des pages.
Si votre document nécessite une numérotation des pages ou des pieds de page, 
configurez-les à l’aide de l’Inspecteur des documents. Pour plus d’informations, 
reportez-vous à la section “Ajout d’en-têtes et de pieds de page, de numéros de page 
et de notes de bas de page” à la page 107.
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Positionnement d’objets modèle
Si vous souhaitez ajouter des images à l’arrière-plan de chaque page du document 
(par exemple un filigrane), placez-les en premier. Si vous créez de nouvelles sections 
dans votre document, elles héritent automatiquement des objets modèle que vous 
avez positionnés. Vous pouvez supprimer ou repositionner les objets modèle dans les 
sections suivantes, si vous le souhaitez.
Pour positionner un objet modèle :
1 Placez une image fixe n’importe où sur la page. Les objets en ligne ne peuvent pas 
être utilisés comme objets modèle.
2 Définissez la taille de l’objet.
3 Définissez l’opacité de l’objet. Pour plus d’informations, reportez-vous à la section 
“Ajustement de l’opacité” à la page 150.
4 Masquez toute partie de l’image qui ne doit pas apparaître. Pour plus d’informations, 
reportez-vous à la section “Rognage (masquage) d’images fixes” à la page 124.
5 Définissez l’habillage souhaité pour le texte. Pour plus d’informations, reportez-vous 
à la section “Habillage d’un objet avec du texte” à la page 132.
6 Si vous souhaitez que l’objet apparaisse derrière le texte, sélectionnez-le, puis choisissez Disposition > Placer à l’arrière-plan.
7 Choisissez Format > Avancé > Déplacer l’objet vers le modèle de section.
Une fois que l’objet a été placé dans la section modèle, il ne peut pas être sélectionné, 
et par conséquent vous ne pouvez pas le déplacer accidentellement. Si vous souhaitez 
le déplacer ou y apporter des modifications, vous pouvez le rendre sélectionnable.
Pour modifier un objet modèle :
m Choisissez Format > Avancé > Rendre les objets modèle sélectionnables, puis sélectionnez l’objet souhaité et modifiez-le.
Les objets modèle comportent des poignées de sélection bleues.
Les objets modèle comportent 
des poignées de sélection bleues.
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Pour supprimer un objet modèle et le faire apparaître sur une seule page :
m Choisissez Format > Avancé > Déplacer l’objet vers la page. L’objet n’est plus répété 
sur chaque page, mais il apparaît uniquement sur la page sélectionnée. Il peut être 
manipulé comme n’importe quel autre objet fixe.
Ajout de guides d’alignement
Les guides d’alignement créés dans un modèle de page y restent afin d’aider toute 
personne utilisant le modèle à positionner les éléments sur la page. Les guides apparaissent lorsque les règles ou la disposition sont affichées, et ils disparaissent lorsque 
les règles ou la disposition sont masquées.
Pour créer des guides d’alignement sur une page :
1 Accédez à la page à laquelle vous souhaitez ajouter les guides d’alignement.
2 Cliquez à l’extérieur du corps principal du document, de sorte que le point d’insertion 
ne soit pas visible.
3 Choisissez Afficher > Afficher les règles.
4 Placez le pointeur sur une règle et faites glisser le guide d’alignement bleu à l’emplacement souhaité sur la page. Vous pouvez changer la couleur des guides d’alignement 
via les Préférences Pages.
Étape 2 :  Définition de styles
Des styles par défaut doivent être définis pour les éléments suivants d’un document :
Â Styles de paragraphe
Â Styles de caractère
Â Styles de liste
Â Styles de table des matières
Â Styles de zone de texte
Â Styles de forme
Â Styles de tableau
Â Styles de graphique
Â Habillage du texte autour des objets
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Vous pouvez personnaliser ces différents éléments pour le modèle que vous créez, 
ou bien utiliser les valeurs par défaut du modèle dont vous êtes parti (y compris le 
modèle Vide).
Pour en savoir plus sur la création de styles de paragraphe, de styles de caractère et 
de styles de liste, consultez le chapitre 4, “Utilisation de styles”. Pour en savoir plus sur 
la création de styles pour la table des matières, reportez-vous à la section “Définition 
du style d’une table des matières” à la page 115.
Définition de styles par défaut pour les formes, les tableaux et les 
graphiques
Les styles par défaut des zones de texte, des formes, des tableaux et des graphiques 
déterminent l’aspect de chacun de ces objets lorsqu’il s’affiche pour la première fois 
sur la page (par exemple la couleur, la taille et l’orientation de la forme qui s’affiche 
lorsque vous choisissez Insérer > Forme > [forme]).
Vous pouvez définir des attributs par défaut pour les zones de texte, les formes, les 
tableaux et les graphiques en plaçant chacun de ces éléments sur une page, en les 
mettant en forme comme vous le souhaitez, puis en utilisant les commandes du 
menu Format afin de définir ces nouveaux attributs comme attributs par défaut.
Définition d’attributs pour les zones de texte et les formes
La définition des attributs par défaut pour les zones de texte et les formes est très 
similaire. Créez les zones de texte et les formes telles que vous les souhaitez, notamment pour les polices, les couleurs, l’opacité, les ombres, etc. Étant donné que la 
longueur et l’orientation du trait ne peuvent pas être définies dans un modèle, les 
attributs du trait (tels que la couleur, l’épaisseur et l’opacité) doivent être définis 
séparément.
Pour définir les styles par défaut des zones de texte et des formes :
1 Placez une zone de texte fixe et une forme sur la page. Pour en savoir plus sur le positionnement d’une zone de texte fixe, reportez-vous à la section “Création de renvois, 
de barres latérales et de texte en surbrillance” à la page 72. Pour en savoir plus sur le 
positionnement d’objets dessinés, reportez-vous à la section “Ajout de formes simples, 
de tableaux et de graphiques” à la page 121.
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2 Tapez du texte dans la zone et dans la forme, puis sélectionnez le texte et configurez 
ses attributs. Pour en savoir plus sur la configuration des attributs du texte, reportezvous à la section “Mise en forme de la taille et de l’apparence du texte” à la page 51.
3 Sélectionnez la zone de texte et la forme, puis définissez les attributs des deux (par 
exemple, la couleur de remplissage et le style de contour). Pour en savoir plus sur la 
définition des propriétés des objets, consultez le chapitre 7, “Modification de 
propriétés d’objets”.
4 Définissez l’habillage du texte de la zone de texte et de la forme dans l’Inspecteur 
d’habillage. Pour en savoir plus sur la définition de l’habillage du texte, reportez-vous 
à la section “Habillage d’un objet avec du texte” à la page 132.
5 Sélectionnez la forme ou la zone de texte, puis choisissez Format > Avancé > Définir 
un style de figure par défaut ou Définir un style de zone de texte par défaut.
6 Supprimez la zone de texte et la forme de la page.
Définition d’attributs de tableaux
Vous pouvez créer le tableau par défaut en fonction de vos préférences, en définissant 
le nombre de rangs et de colonnes, le style et la couleur du trait, les styles de texte, les 
ombres, etc.
Pour définir les attributs par défaut des tableaux :
1 Placez un tableau sur la page.
2 Sélectionnez le tableau et définissez ses attributs. Pour en savoir plus sur le positionnement et la mise en forme des tableaux, consultez le chapitre 8, “Création de 
tableaux”.
3 Définissez l’habillage du texte autour du tableau.
4 Choisissez Format > Avancé > Définir un style de tableau par défaut.
5 Supprimez le tableau de la page.
Remarque :  un tableau est constitué de plusieurs zones de mise en forme, notamment 
d’un en-tête de rang, d’un en-tête de colonne, de bordures internes et de bordures 
externes. Pour définir les attributs du tableau par défaut, vous devez appliquer chaque 
attribut à l’ensemble d’une zone de mise en forme. Par exemple, si vous modifiez la 
mise en forme d’une cellule d’un en-tête de rang, la modification n’est pas enregistrée 
dans le style de tableau par défaut et vous devrez modifier la mise en forme de 
l’ensemble des cellules de l’en-tête de rang.
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Définition de styles de graphique par défaut
Vous pouvez définir le type par défaut des graphiques, c’est-à-dire le type de graphique 
qui s’affiche lorsque vous choisissez Insérer > Graphique, ainsi que l’aspect par défaut 
de chaque type de graphique. Les attributs par défaut doivent être définis séparément 
pour chaque type de graphique.
Pour définir le style et la position par défaut des graphiques :
1 Positionnez un graphique sur la page.
2 Sélectionnez le graphique et définissez ses attributs. Pour en savoir plus sur le positionnement et la mise en forme des graphiques, consultez le chapitre 9, “Création de 
graphiques”.
3 Définissez l’habillage du texte autour des graphiques.
4 Une fois que vous avez mis en forme et positionné tous les graphiques, sélectionnez 
chacun d’eux, un par un, et choisissez Format > Avancé > Définir un style par défaut 
pour graphique [type de graphique].
5 Sélectionnez le type de graphique à utiliser par défaut (celui qui apparaît en premier 
lorsque vous choisissez Insérer > Graphique), puis choisissez Format > Avancé > Faire 
de [type de graphique] le type de graphique par défaut.
6 Supprimez les graphiques de la page.
Définition d’attributs par défaut des graphismes importés
Vous pouvez définir les ombres, l’opacité et la couleur du contour (trait) par défaut des 
graphismes importés.
Pour définir les attributs par défaut des images :
1 Positionnez une image sur la page.
2 Sélectionnez l’image et définissez ses attributs. Pour en savoir plus sur la définition 
des attributs des objets, reportez-vous aux sections “Changement du style de trait” à 
la page 147, “Ajout d’ombres” à la page 149 et “Ajustement de l’opacité” à la page 150.
3 Définissez l’habillage du texte autour de l’image.
4 Choisissez Format > Avancé > Définir un style d’image par défaut.
5 Supprimez l’image de la page.
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Étape 3 :  Création de texte et de graphismes destinés aux 
espaces réservés
Le texte et les graphismes d’espace réservé modélisent l’aspect du document fini. 
Ils fournissent également des instructions pour la personne qui utilise le modèle.
Création de texte d’espace réservé
Si vous souhaitez modifier du texte d’espace réservé qui existe déjà dans un modèle, 
vous devez le rendre modifiable.
Pour modifier du texte d’espace réservé :
1 Choisissez Format > Avancé > Activer la création de texte pour espace réservé.
2 Éditez le texte comme vous le feriez normalement.
3 Choisissez Format > Avancé > Désactiver la création de texte pour espace réservé.
Vous pouvez également définir votre texte comme texte d’espace réservé.
Pour créer du texte d’espace réservé :
1 Tapez du texte sur la page et mettez-le en forme de la façon souhaitée.
2 Sélectionnez le bloc de texte que vous souhaitez que les utilisateurs du modèle puissent modifier, puis choisissez Format > Avancé > Définir comme texte pour espace 
réservé.
Important :  lorsque vous sélectionnez des blocs de texte à définir comme texte 
d’espace réservé, prenez soin de ne pas sélectionner le caractère de saut de paragraphe final. Ce faisant, vous provoqueriez la suppression du paragraphe entier 
lorsque l’utilisateur commence à taper dans la zone de texte d’espace réservé, et 
le nouveau texte utiliserait les attributs du paragraphe suivant. Pour voir le caractère 
de saut de paragraphe, choisissez Afficher > Afficher les caractères invisibles.
Pour supprimer du texte d’espace réservé :
m Sélectionnez-le et appuyez sur Supprimer.
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Création de graphismes d’espace réservé
Les graphismes d’espace réservé facilitent le dimensionnement et le positionnement 
corrects des graphismes en les faisant simplement glisser sur les espaces réservés que 
vous avez créés.
Pour créer un graphisme d’espace réservé :
1 Positionnez et dimensionnez une image d’espace réservé sur la page (il peut s’agir 
d’une zone ombrée avec des instructions, par exemple).
2 Sélectionnez l’image et choisissez Format > Avancé > Définir comme espace réservé 
d’image.
Pour faire d’une image d’espace réservé une image ordinaire :
m Sélectionnez-la puis désélectionnez Définir comme espace réservé d’image dans 
le menu Format > Avancé. Un élément sélectionné comporte en face une coche ; 
choisissez de nouveau l’élément afin de le désélectionner.
Pour supprimer un graphisme d’espace réservé :
m Sélectionnez l’image et appuyez sur Suppr.
Création de mises en page pour les modèles pouvant être 
étendus
Vous pouvez rendre le modèle extensible, de sorte que les utilisateurs puissent 
simplement insérer les mises en page supplémentaires que vous avez créées. Celles-ci 
sont disponibles à l’aide de la commande Pages du menu Insérer (pour plus d’informations, reportez-vous à la section “Développement du modèle en ajoutant des 
pages” à la page 31).
1 Créez une disposition d’une ou plusieurs pages, en insérant un saut de section au 
début et à la fin de la disposition.
2 Choisissez Format > Avancé > Capturer les pages. Une zone de dialogue s’ouvre.
3 Attribuez un nom à la mise en page.
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4 Choisissez le nombre de pages à inclure dans la mise en page, à partir du menu local 
Inclure.
5 Supprimez les pages du modèle si vous souhaitez qu’elles apparaissent uniquement 
dans le sous-menu Pages, mais pas dans le modèle.
Pour gérer les dispositions de page que vous avez créées :
1 Choisissez Format > Avancé > Gérer les pages. Une zone de dialogue s’ouvre.
2 Sélectionnez un titre pour la page et cliquez sur les boutons fléchés vers le haut ou 
vers le bas afin de modifier sa position dans la liste.
Cliquez sur le bouton Suppr afin de le supprimer de la liste.
3 Cliquez sur Terminé.
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Étape 4 : Enregistrement d’un modèle personnalisé
Vous pouvez enregistrer votre nouveau modèle de façon à ce qu’il apparaisse dans 
le sélectionneur de modèles. Lorsqu’un autre utilisateur ouvre le modèle, il s’ouvre 
dans l’état dans lequel vous l’avez enregistré. Cela signifie que vous pouvez choisir 
de laisser le tiroir Styles ouvert ou fermé, ou d’afficher les caractères invisibles, les 
règles et les marques de disposition.
Pour enregistrer le modèle actuel comme modèle personnalisé :
1 Choisissez Fichier > Enregistrer comme modèle.
2 Attribuez un nom au modèle.
3 Votre modèle sera enregistré dans la sous-fenêtre Mes modèles du sélectionneur 
de modèles. Si vous ne souhaitez pas que le modèle apparaisse ici, enregistrez-le à 
un autre emplacement.
Vous pouvez créer une catégorie de modèle en créant un dossier à l’emplacement 
suivant :
[dossier Départ]/Bibliothèque/Application Support/iWork/Pages/Templates
4 Cliquez sur Enregistrer.
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1 Installation de votre logiciel
Ce fascicule a été conçu pour vous présenter Logic Studio et vous permettre de l’utiliser
le plus rapidement possible. Les rubriques suivantes seront traitées :
Â « À propos du coffret Logic Studio » à la page 2.
Â « À propos de l’Aide à l’écran » à la page 4.
Â « Mise à niveau de Mac OS X et de QuickTime » à la page 5.
Â « Installation de Logic Studio » à la page 6.
Â « Installation du contenu » à la page 10.
Â « Enregistrement de Logic Studio » à la page 12.
Â « Contacter le service d’assistance AppleCare » à la page 13.
Veuillez lire également le document Avant d’installer Logic Studio (se trouvant sur le DVD
d’installation de Logic Studio). Pour obtenir les dernières informations sur Logic Studio,
rendez-vous le site web de Logic Studio à l’adresse www.apple.com/fr/logicstudio.2
À propos du coffret Logic Studio
Logic Studio inclut tous les disques d’installation et de contenu nécessaires à l’installation de Logic Pro 8, de MainStage, de WaveBurner 1.5, de Soundtrack Pro 2 et de
Compressor 3. Logic Studio est également livré avec de la documentation imprimée
et au format PDF vous présentant ces applications.
DVD d’installation et de contenu
Les DVD suivants contiennent des logiciels, de la documentation et des données
supplémentaires.
Â DVD d’installation de Logic Studio :il s’agit de votre disque d’installation. Utilisez ce
DVD pour installer tous les composants logiciels dont l’application, les modules ainsi
que l’aide à l’écran.
Â DVD des Jam Packs 1 à 3 et DVD de contenu audio 1 à 3 :ces disques contiennent une
bibliothèque étendue d’effets sonores, de fonds musicaux et de boucles au format
Apple Loops. Ils proposent également un ensemble complet d’instruments logiciels
échantillonnés.
Important :les boucles Apple Loops sur ces disques sont proposées au format CAF
(Core Audio Format). Ces fichiers utilisent la compression Apple Lossless pour conserver une qualité audio optimale tout en occupant un espace minimal sur le disque
dur. Les fichiers des boucles Apple Loops plus anciens exploitaient le format AIFF.
Â DVD compilant des morceaux de démonstration et des guides d’initiation de Logic Studio:
ce DVD contient un ensemble de morceaux de démonstration et de guides d’initiation
vidéo pour vos applications Logic Studio. Ce disque constitue aussi un DVD vidéo afin
que vous puissiez visionner les guides d’initiation à l’aide de l’application Lecteur DVD
ou tout autre lecteur de DVD autonome compatible.
Remarque :pour utiliser les morceaux de démonstration, copiez simplement le dossier
Demo Songs du DVD sur votre disque dur. Ne lisez pas de morceau de démonstration
directement à partir du DVD car il est fort possible que cela ne fonctionne pas.
Documentation imprimée
En plus de ce document, vous trouverez dans votre coffret Logic Studio les supports
imprimés suivants :
Â Manuel de l’utilisateur de Logic Pro 8 : cet ouvrage est le document incontournable sur
tout ce qui a trait à Logic Pro et couvre en détail toutes les fonctionnalités du programme, à l’exception des modules.
Â Instruments et effets Logic Studio : ce guide porte sur l’utilisation de tous les modules
d’effets et d’instruments de Logic Studio. Ce guide est commun à toutes les applications Logic Studio pouvant accéder aux instruments ou aux effets. Il ne traite pas
d’un usage des modules propre à chaque application mais se concentre plutôt sur
leurs fonctions, leurs paramètres et leur utilisation.3
Â Premiers contacts avec Logic Pro 8 :ce manuel a été rédigé pour vous présenter
Logic Pro et vous permettre de l’utiliser le plus rapidement possible. Vous y trouverez la description des principaux aspects de l’interface, des commandes et des menus
de Logic Pro.
Â Premiers contacts avec Soundtrack Pro 2 :présente une vue d’ensemble de l’application et explique les principes de base du montage audio à l’aide de Soundtrack Pro.
Â Manuel de l’utilisateur de MainStage :ce manuel détaille l’utilisation de MainStage
pour les représentations en direct.
Documentation au format PDF
La documentation suivante est disponible au format PDF. Elle se trouve dans le dossier
Documentation du DVD d’installation de Logic Studio.
Â Tous les documents imprimés mentionnés ci-dessus sont également inclus sous
forme de fichiers.
Â Nouvelles fonctionnalités de Logic Pro 8 : ce document propose une vue d’ensemble
succincte des améliorations et autres modifications apportées à Logic Pro 8 (depuis
Logic Pro 7).
Â Prise en charge des surfaces de contrôle Logic Pro 8 : ce document traite de l’utilisation
des surfaces de contrôle dans Logic Pro 8.
Â Guide TDM de Logic Pro 8 et Utilisation de matériel Apogee :ces documents abordent
des aspects clé de l’utilisation de matériel TDM ou Apogee dans Logic Pro 8.
Â Manuel de l’utilisateur de Soundtrack Pro :ce manuel fournit des informations
détaillées sur l’utilisation de Soundtrack Pro dans le processus de post-production
audio.
Â Manuel de l’utilisateur de WaveBurner :ce document explique comment utiliser de
WaveBurner pour compiler, mastériser et graver des CD audio.
Â Manuel de l’utilisateur de Compressor :cet ouvrage fournit des informations complè-
tes sur l’utilisation de Compressor pour procéder à l’encodage rapide de fichiers,
et ce dans de nombreux formats standard.
Â Manuel de l’utilisateur de l’Utilitaire de réponses d’impulsion :ce document traite de
la création de réponses d’impulsion mono, stéréo et Surround personnalisées pour
Space Designer, l’effet de réverbération à convolution de Logic Studio à l’aide de
l’Utilitaire de réponses d’impulsion.
Â Manuel de l’utilisateur de l’Utilitaire de boucles Apple Loops :il propose des informations sur l’utilisation de l’Utilitaire de boucles Apple Loops permettant de créer des
boucles audio dans ce format.4
À propos de l’Aide à l’écran
L’aide à l’écran et les Informations de dernière minute sont accessibles à partir des
menus d’Aide des applications Logic Studio.
Aide à l’écran
L’Aide à l’écran (disponible à partir du menu Aide) vous permet d’accéder directement
aux informations relatives à ce que vous manipulez dans les applications. Le contenu
de l’aide à l’écran est identique à celui des manuels mais ce format bénéficie de recherches effectuables dans ce contenu.
Pour accéder à l’Aide à l’écran :
m Sélectionnez le nom du manuel souhaité dans le menu Aide.
Parcourez le contenu ou lancez des recherches pour accéder aux informations voulues
ou à la rubrique appropriée.
Informations de dernière minute
Ce document est publié en ligne et fait l’objet de mises à jour au fur et à mesure que
de nouvelles versions des applications Logic Studio sont commercialisées ou que des
informations inédites sont mises à disponibilité.
Pour vérifier la présence de mises à jour récentes, effectuez l’une des opérations
suivantes :
m Sélectionnez « Informations de dernière minute » dans le menu Aide de l’application.
Si Safari est le navigateur web par défaut de votre système, le fichier s’affiche directement dans Safari. Il se peut que d’autres navigateurs web ne soient pas prévus pour
assurer cette fonctionnalité, auquel cas le fichier est téléchargé à l’emplacement de
téléchargement par défaut.5
Mise à niveau de Mac OS X et de QuickTime
Avant d’installer Logic Studio, vous devez passer en revue la configuration minimale
requise indiquée dans le document Avant d’installer Logic Studio, accessible à partir du
disque d’installation de Logic Studio. Le cas échéant, vous devez mettre à jour votre
logiciel système pour vous assurer de bien disposer de la toute dernière version de
Mac OS X. Vous devez aussi mettre à niveau QuickTime à la version la plus récente.
Pour mettre votre logiciel système à jour :
1 Choisissez Pomme > Mise à jour de logiciels.
La fenêtre de mise à jour de logiciels s’affiche, indiquant les nouveaux logiciels ou
les mises à jour disponibles pour votre ordinateur.
2 Au besoin, suivez les instructions à l’écran pour mettre à jour Mac OS X avec
la dernière version.
Installer Logic Studio et saisir le numéro de série déverrouille automatiquement
les fonctionnalités multimédia étendues de QuickTime Pro.
Important :la procédure décrite brièvement ci-dessus n’est valable que pour les mises
à jour de logiciels gratuites. Elle part également du principe que vous disposez d’une
connexion à Internet. Les mises à jour payantes peuvent être achetées auprès de votre
détaillant Apple habituel. C’est le cas si vous devez mettre à jour votre logiciel système
d’une version principale de Mac OS X à l’autre, par exemple de la version 10.3 à la version 10.4.6
Installation de Logic Studio
Lorsque vous installez Logic Studio, ses composants se placent dans le dossier Applications de votre disque de démarrage. Vous pouvez choisir à votre gré l’emplacement
d’installation pour les paquets dont le contenu occupe plus d’espace.
Une installation complète de Logic Studio requiert l’insertion de chaque disque, en
commençant par le disque d’installation de Logic Studio. Une fois le contenu de ce
disque installé, vous êtes invité à insérer les disques restants (selon leur nom) pour
continuer l’installation des autres composants de Logic Studio.
Remarque :avant de pouvoir installer Logic Studio, vous devez ouvrir une session sur
votre ordinateur en tant qu’administrateur à l’aide du mot de passe d’administrateur.
Reportez-vous à l’Aide Mac pour en savoir plus.
Pour installer et autoriser l’accès à Logic Studio :
1 Insérez le DVD d’installation de Logic Studio dans votre lecteur de DVD.
2 Lancez l’installation en double-cliquant sur l’icône d’installation de Logic Studio,
puis suivez les instructions à l’écran.
3 Le programme d’installation effectue alors une vérification de la conformité à la configuration requise pour savoir si l’application Logic Studio peut être installée. Cliquez sur
Continuer.
4 Lisez les Informations de bienvenue, puis cliquez sur Continuer.
5 Lisez les informations reprises dans le document Avant d’installer, puis cliquez sur
Continuer.
6 Lisez le Contrat de licence du logiciel, puis cliquez sur Continuer.
7 Une zone de dialogue vous demandant si vous acceptez les termes du contrat de
licence s’affiche alors. Cliquez sur Accepter pour continuer.
8 Sélectionnez le disque de destination pour l’installation de Logic Studio, puis cliquez
sur Continuer.7
9 Dans la sous-fenêtre « Informations sur l’utilisateur », tapez vos prénom et nom. Saisir
le nom de votre entreprise est facultatif.
10 Pour le champ Numéro de série, le numéro de Logic Studio en question se trouve sur
l’étiquette du numéro de série du logiciel, celle collée sur la couverture de ce document.
Cliquez ensuite sur Continuer.
La sous-fenêtre d’installation personnalisée apparaît alors.
11 Sélectionnez les éléments à installer, puis cliquez sur Installer.
12 Un triangle d’affichage se trouve en regard de certains éléments. Cliquez dessus pour
révéler des éléments complémentaires pouvant être sélectionnés à leur tour.
Tapez votre nom
(obligatoire).
Tapez le nom de votre
entreprise (facultatif).
Saisissez votre numéro
de série, en incluant les
tirets (obligatoire).8
13 L’option de choisir un emplacement personnalisé vous est proposée pour certains
fichiers de contenu supplémentaire. Cliquez sur les icônes représentant des dossiers
dans la colonne Emplacement et choisissez Autre dans le menu local pour indiquer
un emplacement personnalisé.
Important :veuillez lire l’intégralité de la rubrique « Installation du contenu » à la
page 10 pour tout savoir sur ce type d’installation, particulièrement si vous mettez à
niveau Soundtrack Pro ou si vous avez installé auparavant des bibliothèques de Jam
Packs facultatives.
14 Après avoir configuré les éléments de la sous-fenêtre d’installation personnalisée,
le cas échéant, cliquez sur Installer.
15 Une zone de dialogue vous demandant vos nom et mot de passe apparaît alors.
Assurez-vous d’indiquer le nom et le mot de passe correspondant à un compte
d’utilisateur disposant d’autorisations d’administrateur. Cliquez sur OK une fois terminé.
Le programme affiche une barre de progression du processus d’installation et vous
invite à insérer des disques spécifiques pour continuer l’installation.
Une fois l’installation terminée, vous pouvez commencer à utiliser les applications
Logic Studio.
Avertissement :certains des disques de Logic Studio incluent quelques programmes
d’installation, dont l’icône est accessible à partir du Finder. Ne cliquez sur aucun
fichier d’un des disques depuis une fenêtre du Finder. Vous devez uniquement suivre
les messages qu’affiche le programme d’installation de Logic Studio. Lancer un de ces
programmes d’installation alors que celui de Logic Studio est toujours en cours d’exé-
cution peut entraîner une installation incomplète de Logic Studio, ce qui peut vous
obliger à reprendre tout le processus.9
Un mot sur la structure des dossiers
Pour éviter d’entraver le bon fonctionnement de Logic Studio, veillez à ne pas modifier
la structure des dossiers créés pendant l’installation du logiciel. Pour mémoire, les dossiers suivants se trouvent ainsi installés sur votre système :
Â /Bibliothèque/Applications Support/Logic et ~/Bibliothèque/Applications Support/
Logic
Â /Bibliothèque/Applications Support/Soundtrack Pro et ~/Bibliothèque/Applications
Support/Soundtrack Pro
Â /Bibliothèque/Applications Support/WaveBurner et ~/Bibliothèque/Applications
Support/WaveBurner
Ceux-ci ne doivent jamais êtres déplacés ou renommés. Veuillez utiliser des alias si vous
souhaitez travailler avec un dossier (le dossier Sampler Instruments par exemple) figurant à un autre emplacement.
Installation de Logic Node
Le dossier Node Installer (à la racine du DVD d’installation de Logic Studio) contient
tous les fichiers nécessaires à l’installation de Logic Node pour pouvoir utiliser l’application avec Logic Studio.
Pour installer Logic Node :
1 Copiez le dossier Node Installer du DVD d’installation de Logic Studio sur votre
ordinateur nœud.
2 Montez l’image disque LogicNode 8.0 du dossier en double-cliquant dessus.
3 Lancez l’installation en double-cliquant sur l’icône de LogicNode dans le volume
LogicNode 8.0 monté, puis suivez les instructions à l’écran.10
Installation du contenu
Logic Studio inclut du contenu supplémentaire, tel que des réponses d’impulsion
Surround, des boucles et des modèles, que vous pouvez installer ou non.
À propos du contenu pour Logic Studio
Voici une description succincte du contenu inclus avec Logic Studio, ainsi que les
emplacements d’installation par défaut. Dans certains cas, vous pouvez indiquer
des emplacements personnalisés pour ce contenu, tel qu’un autre disque dur ou
un dossier spécifique.
L’installation des éléments suivants est facultative :
Â Les fichiers de réponses d’impulsion Surround pour Logic Studio : ces fichiers sont nécessaires si vous comptez utiliser les capacités Surround de l’effet Space Designer.
Remarque :ces fichiers s’installent invariablement dans le dossier /Bibliothèque/
Audio/Impulse Response/Apple.
Â Jam Packs :fournit un ensemble complet de boucles Apple Loops, ainsi que des instruments logiciels à échantillons et des réglages de tranche de console, organisés par
genre musical. Les Jam Packs sont vendus séparément mais ils proposent des fichiers
de réglages et de modèles de tranches de console supplémentaires.
Â Effets sonores et fonds musicaux : inclut un ensemble complet d’effets sonores et de
boucles Apple Loops musicales. Ce supplément reprend également le contenu Apple
Loop des versions antérieures de Soundtrack Pro (voir aussi « Que se passe-t-il avec le
contenu Soundtrack Pro ? » à la page 12).
Remarque :l’emplacement par défaut du contenu Apple Loop est /Bibliothèque/
Audio/Apple Loops/Apple. Utiliser le dossier par défaut vous permet d’accéder aux
boucles Apple Loops à travers d’autres applications prenant en charge le format
Apple Loops, telles que GarageBand.
Â Extreme Analog :installe la bibliothèque Extreme Analog de l’EXS24 mkII, laquelle
propose une panoplie riche en sons de synthétiseur analogique pour l’échantillonneur EXS24 mkII.
Â Extreme Digital :installe la bibliothèque Extreme Digital de l’EXS24 mkII, complétant
l’EXS24 mkII d’une gamme étendue de sons de synthétiseur numérique.
Â Contenu GarageBand :installe les boucles Apple Loops et les réglages de tranche de
console inclus avec GarageBand.
Â Contenu du patrimoine Logic Pro :installe le contenu livré avec Logic Pro 7 mais qui
n’est plus inclus dans Logic Pro 8. Vous devrez installer ce contenu pour ouvrir des
projets Logic Pro 7 dans Logic Pro 8.11
Installation personnalisée de contenu
Le programme d’installation de Logic Studio prévoit une sous-fenêtre d’installation
personnalisée qui vous permet d’indiquer les applications et le contenu à installer.
Vous pouvez aussi utiliser cette sous-fenêtre pour installer ultérieurement le contenu
sélectionné, si vous choisissez de ne pas les installer avec les applications.
Si vous décidez d’installer les éléments sélectionnés du contenu plus tard, en utilisant
le programme d’installation de Logic Studio, le processus suit exactement ce qui est
décrit dans « Installation de Logic Studio » à la page 6, sauf que vous n’avez pas besoin
de taper votre numéro de série.
Les éléments de contenu que vous pouvez placer dans un emplacement personnalisé
sont différenciés par une icône représentant un dossier, reprise dans la colonne Emplacement de la sous-fenêtre d’installation personnalisée. Vous pouvez indiquer l’emplacement en cliquant sur le dossier approprié, puis en choisissant Autre dans le menu local.
Cliquez sur l’icône représentant un dossier, puis choisissez
Autre dans le menu local afin
d’indiquer un emplacement
personnalisé pour le contenu.
Cliquez sur le triangle
d’affichage pour
révéler des éléments
complémentaires.12
Installation de contenu pendant la mise à niveau
Si vous mettez à niveau Soundtrack Pro ou si vous avez installé auparavant des bibliothèques Jam Pack, vous devez être conscient de certains cas pouvant se présenter.
Que se passe-t-il avec les Jam Packs ?
Si vous choisissez d’installer des Jam Packs qui sont déjà sur votre ordinateur, seul
le contenu complémentaire inclus avec Logic Studio (à savoir les réglages de tranche
de console et les modèles) s’installent dans ce cas.
Que se passe-t-il avec le contenu Soundtrack Pro ?
Si vous avez opté pour l’emplacement par défaut ou un emplacement personnalisé
déjà utilisé (reprenant le contenu audio de Soundtrack Pro au format AIFF), le contenu
sur votre disque dur est alors conservé. Tout nouveau contenu audio, au format CAF,
s’installe à l’emplacement choisi (qu’il soit par défaut ou personnalisé).
Enregistrement de Logic Studio
Au premier démarrage d’une des applications Logic Studio, vous êtes invité à indiquer
les informations d’enregistrement. Par défaut, les données issues de votre fiche du Carnet d’adresses sont reprises automatiquement dans les champs appropriés.
Pour enregistrer Logic Studio pour un utilisateur présentant d’autres données que
celles tirées de votre fiche du Carnet d’adresses :
1 Remplissez les champs Nom, Adresse, Entreprise et Adresse électronique.
2 Si vous voulez recevoir des informations sur l’actualité des produits et sur les mises à
jour de logiciels Apple sur votre compte de messagerie, cochez la case.
3 Si vous voulez passer en revue les mentions légales Apple, cliquez sur Confidentialité.
4 Une fois terminé, cliquez sur S’enregistrer.
Logic Studio est à présent enregistré.
Remarque :si vous décidez de cliquer sur le bouton S’enregistrer plus tard, vous êtes
alors invité à nouveau à vous enregistrer toutes les cinq ouvertures d’une des applications Logic Studio.Contacter le service d’assistance AppleCare
Apple offre plusieurs types de service et d’assistance pour Logic Studio et votre maté-
riel Apple. Quel que soit votre problème, il est préférable d’avoir les informations suivantes à portée de main. Plus les informations fournies aux agents de l’assistance Apple
seront nombreuses, plus vite votre question pourra être répondue.
Â Le numéro d’identifiant d’assistance pour Logic Studio.
Remarque :ce numéro de onze chiffres figure sur la couverture de ce document.
Â La version de Mac OS X installée. Pour connaître la version de Mac OS X, choisissez
le menu Pomme > À propos de ce Mac.
Â La version de l’application installée à propos de laquelle vous avez une question.
Pour connaître la version de l’application installée sur votre ordinateur, choisissez
[Nom de l’application] > À propos de [Nom de l’application].
Vous pouvez également cliquer, tout en maintenant la touche Contrôle enfoncée,
sur l’icône de l’application dans le Finder, puis choisir Lire les informations dans
le menu contextuel.
Â Le modèle de l’ordinateur que vous utilisez.
Â La quantité de RAM installée sur votre ordinateur. Pour le savoir, choisissez Pomme >
À propos de ce Mac.
Â Une liste de tout matériel de tierce partie branché à l’ordinateur ou qui y est installé.
Veuillez préciser les données du fabricant et du numéro du modèle. Pensez également aux disques durs ainsi qu’aux interfaces audio et MIDI.
Â Une liste répertoriant les modules de tierce partie ou autres logiciels audio, MIDI ou
vidéo installés en plus de Logic Studio.
Â Une description exhaustive de la situation à l’origine de l’erreur. Précisez les messages d’erreur, les codes d’erreur et le texte exact des avertissements, le cas échéant.
Le service d’assistance AppleCare est disponible en ligne sur
http://www.apple.com/fr/support. Vous pouvez sélectionner l’application
pour retrouver des informations spécifiques la concernant.
Il existe également un élément dans le menu Aide de chaque application vous permettant d’accéder directement au site web AppleCare.
Pour accéder au site web AppleCare depuis l’application :
m Choisissez Aide > Assistance [Nom de l’application].
© 2007 Apple Inc. Tous droits réservés.
Apple, le logo Apple, Jam Pack, Logic, Mac, Mac OS, QuickTime et Soundtrack sont des marques d’Apple Inc. déposées aux
États-Unis et dans d’autres pays. Finder, GarageBand, MainStage et Safari sont des marques d’Apple Inc. AppleCare est une
marque de service d’Apple Inc., déposée aux États-Unis et dans d’autres pays.
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Mac Help Migration Assistant8 Chapter 1   Ready, Set Up, Go
Your MacBook Pro is designed so that you can set it up quickly and start using it right 
away. If you have never used a MacBook Pro or are new to Macintosh computers, read 
this chapter for help getting started. 
Important:  Read all the installation instructions (and the safety information starting on 
page 66) carefully before you first use your computer.
If you are an experienced user, you may already know enough to get started. Make 
sure you look over the information in Chapter 2, “Life with Your MacBook Pro,” to find 
out about the new features of this MacBook Pro.
Many answers to questions can be found on your computer in Mac Help. For 
information about using Mac Help, see “Getting Answers” on page 32. Apple may 
release new versions and updates to its system software, so the images shown in this 
book may be slightly different from what you see onscreen.Chapter 1   Ready, Set Up, Go 9
What’s in the Box
Setting Up Your MacBook Pro
Your MacBook Pro is designed so that you can set it up quickly and start using it right 
away. The following pages take you through the setup process, including these tasks:
Â Plugging in the 85W MagSafe Power Adapter
Â Connecting cables and accessing a network
Â Turning on your MacBook Pro and using the trackpad
Â Configuring a user account and other settings using Setup Assistant
Â Setting up the Mac OS X desktop and preferences
85W MagSafe Power Adapter AC power cord
®10 Chapter 1   Ready, Set Up, Go
Important:  Remove the protective film around the 85W MagSafe Power Adapter before 
setting up your MacBook Pro.
Step 1:  Plug in the 85W MagSafe Power Adapter to provide power to the 
MacBook Pro and charge the battery.
Make sure the AC plug is fully inserted into the power adapter and the electrical 
prongs on your AC plug are in their completely extended position. Insert the AC plug 
of your power adapter into a power outlet and the MagSafe connector into the 
MagSafe power port. As the MagSafe connector gets close to the port, you’ll feel a 
magnetic pull drawing it in.
To extend the reach of your power adapter, replace the AC plug with the AC power 
cord. First pull the AC plug up to remove it from the adapter, and then attach the 
included AC power cord to the adapter, making sure it is seated firmly.
When disconnecting the power adapter from an outlet or from the computer, pull the 
plug, not the cord.
®
MagSafe connector
AC power cord
AC plug ¯ MagSafe power portChapter 1   Ready, Set Up, Go 11
Note:  When you first connect the power adapter to your MacBook Pro, an indicator 
light on the MagSafe connector starts to glow. An amber light indicates the battery 
is charging. A green light indicates that the battery is fully charged. If you don’t see a 
light, make sure the connector is seated properly and the power adapter is plugged in.
Step 2:  Connect to a wireless or wired network.
Â To use a wireless network with the built-in AirPort Extreme technology, make sure the 
wireless base station is turned on and that you know the name of the network. After 
you turn on your MacBook Pro, Setup Assistant guides you through the connection 
process. For troubleshooting tips, see page 58. 
Â To use a wired connection, connect one end of an Ethernet cable to your 
MacBook Pro and the other end to a cable modem, DSL modem, or network.
Gigabit Ethernet port
(10/100/1000Base-T)
G
®
Ethernet
cable12 Chapter 1   Ready, Set Up, Go
Â To use a dial-up connection, you need the external Apple USB Modem, available from 
the online Apple Store at www.apple.com/store or from an Apple Authorized Reseller. 
Connect the Apple USB Modem to a USB port on your MacBook Pro, and then 
connect a phone cord (not included) from the modem into a phone wall jack. 
Step 3:  Press the power (®) button briefly to turn on your MacBook Pro.
You hear a tone when you turn on the computer.
It takes the MacBook Pro a few moments to start up. After it starts up, Setup Assistant 
opens automatically.
If your MacBook Pro doesn’t turn on, see “If your MacBook Pro doesn’t turn on or start 
up” on page 53.
®
® Power buttonChapter 1   Ready, Set Up, Go 13
Step 4:  Configure your MacBook Pro with Setup Assistant.
The first time you turn on your MacBook Pro, Setup Assistant starts. Setup Assistant 
helps you enter your Internet and email information and set up a user account on your 
MacBook Pro. If you already have a Mac, Setup Assistant can help you automatically 
transfer files, applications, and other information from your previous Mac. See the next 
section, “Migrating Information to Your MacBook Pro,” for more information.
If you don’t intend to keep or use your other Mac, it’s best to deauthorize it from 
playing music, videos, or audiobooks that you’ve purchased from the iTunes Store. 
Deauthorizing a computer prevents any songs, videos, or audiobooks you’ve purchased 
from being played by someone else and frees up another authorization for use. For 
information about deauthorizing, in iTunes, open Help > iTunes Help.14 Chapter 1   Ready, Set Up, Go
Migrating Information to Your MacBook Pro
You can follow the prompts in Setup Assistant to migrate existing user accounts, files, 
applications, and other information from another Mac computer. You can do this with 
one of the following methods:
Â Using a FireWire cable to connect the two computers together and transfer the 
information
Â Using an Ethernet cable connected directly between both computers, or connecting 
both computers to the same network
Â Wirelessly, directly between both computers, or with both computers on the same 
wireless network
Before performing migration, use Software Update on your other Mac to ensure you 
have the latest version of Mac OS X software—either Mac OS X v10.4.11 or Mac OS X 
v10.5.6 (or later). 
You can choose the items (user accounts, documents, movies, music, photos, and so 
on) that you want to migrate to your MacBook Pro. 
Important:  Don’t use the other Mac for anything else until the migration is complete.
If you don’t use Setup Assistant to transfer information when you first start up your 
computer, you can do it later using Migration Assistant. If the connection is terminated 
during migration, you can resume the migration at a later time using Migration 
Assistant on your MacBook Pro and your other Mac. Go to the Applications folder, open 
Utilities, and double-click Migration Assistant. Chapter 1   Ready, Set Up, Go 15
Step 5:  Customize the Mac OS X desktop and set preferences.
Menu bar
Dock System Preferences icon
Help menu Spotlight search icon
Finder icon16 Chapter 1   Ready, Set Up, Go
You can quickly customize the desktop using System Preferences. Choose Apple () > 
System Preferences from the menu bar or click the System Preferences icon in the 
Dock. System Preferences is your command center for most settings on your 
MacBook Pro. For more information, open Mac Help and search for “System 
Preferences” or for the specific preference you want to change.
Putting Your MacBook Pro to Sleep or Shutting It Down
When you finish working with your MacBook Pro, you can put it to sleep or shut 
it down.
Putting Your MacBook Pro to Sleep
If you’ll be away from your MacBook Pro for only a short time, put it to sleep. When the 
computer is in sleep, you can quickly wake it and bypass the startup process. 
To put your MacBook Pro to sleep, do one of the following:
Â Close the display.
Â Choose Apple () > Sleep from the menu bar.
Â Press the power (®) button and click Sleep in the dialog that appears.
Â Choose Apple () > System Preferences, click Energy Saver, and set a sleep timer.
NOTICE:  Wait a few seconds until the sleep indicator light starts pulsing (indicating 
that the computer is in sleep and the hard disk has stopped spinning) before moving 
your MacBook Pro. Moving your computer while the disk is spinning can damage the 
hard disk, causing loss of data or the inability to start up from the hard disk.Chapter 1   Ready, Set Up, Go 17
To wake your MacBook Pro:
Â If the display is closed, simply open it to wake up your MacBook Pro.
Â If the display is already open, press the power (®) button or any key on the keyboard.
When your MacBook Pro wakes from sleep, your applications, documents, and 
computer settings are exactly as you left them. 
Shutting Down Your MacBook Pro
If you aren’t going to use your MacBook Pro for a couple of days or longer, it’s best to 
shut it down. The sleep indicator light goes on briefly during the shutdown process.
To shut down your MacBook Pro, do one of the following:
m Choose Apple () > Shut Down from the menu bar.
m Press the power (®) button and click Shut Down in the dialog that appears.
If you plan to store your MacBook Pro for an extended period of time, see “Important 
Handling Information” on page 69 for information about how to prevent the battery 
from draining completely.2
2 Life with Your MacBook Pro
www.apple.com/macosx
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Basic Features of Your MacBook Pro
®
® Power button
Camera indicator light
iSight camera
Built-in stereo
speakers
Battery indicator
lights (side)
Microphone
Sleep 
indicator light
Infrared (IR)
receiver
Trackpad
Slot-loading
SuperDrive
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Built-in iSight camera and indicator light
Videoconference using the iChat application, take pictures with Photo Booth, or capture 
video with iMovie. The indicator light glows when the camera is operating.
Built-in stereo speakers
Listen to music, movies, games, and other multimedia files.
Built-in microphone
Capture sounds with the microphone (located above the Esc key on your keyboard) or 
talk with friends live over broadband using the included iChat application.
Built-in battery and battery indicator lights
Use battery power when you are away from a power outlet. Press the battery button to 
activate indicator lights that show the remaining battery charge. 
Trackpad
Click or double-click anywhere on the trackpad. Touch the trackpad with one or more 
fingers to move the pointer and use Multi-Touch gestures (described on page 26).
Sleep indicator light
A white light pulses when the MacBook Pro is in sleep.
Infrared (IR) receiver
Use an optional Apple Remote (available separately) with the IR receiver to control 
Front Row and Keynote on your MacBook Pro from up to 30 feet (9.1 meters) away.
Security slot
Attach a lock and cable (available separately) to prevent theft.
Slot-loading SuperDrive
This optical drive reads and writes to standard-size CDs and DVDs. 
® Power button
Turn your MacBook Pro on and off, or put it to sleep.22 Chapter 2   Life with Your MacBook Pro
Keyboard Features of Your MacBook Pro
®
Function (fn) key
esc
F1 F2 F3 F4 F5 F6 F7 F8 F9 F10 F11 F12
—
C
- Volume
keys
Brightness
keys
Media
Eject key
Mute
key
Exposé Dashboard Media
keys
Keyboard illumination
keys
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Function (fn) key
Press and hold this key to activate customized actions assigned to the function keys 
(F1 to F12). To learn how to customize function keys, choose Help > Mac Help from the 
menu bar and search for “function keys.”
¤ Brightness keys (F1, F2)
Increase ( ) or decrease ( ) the brightness of your MacBook Pro display.
Exposé key (F3)
Open Exposé for quick access to all your open windows.
Dashboard key (F4)
Open Dashboard to access your widgets. 
o Keyboard illumination keys (F5, F6)
Increase (o) or decrease (ø) the brightness of the keyboard illumination.
’ Media keys (F7, F8, F9)
Rewind ( ), play or pause (’), or fast-forward ( ) a song, movie, or slideshow.
— Mute key (F10)
Mute the sound coming from the built-in speakers and headphone port.
- Volume keys (F11, F12)
Increase (-) or decrease (–) the volume of sound coming from the built-in speakers and 
headphone port.
C Media Eject key
Press and hold this key to eject a disc that’s not in use. You can also eject a disc by 
dragging its desktop icon to the Trash.24 Chapter 2   Life with Your MacBook Pro
Ports on Your MacBook Pro
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Note:  Adapters and other accessories are sold separately at www.apple.com/store.
¯ MagSafe power port
Plug in the included 85W MagSafe Power Adapter to recharge the MacBook Pro battery.
G Gigabit Ethernet port
Connect to a high-speed Ethernet network, a DSL or cable modem, or another computer. 
The Ethernet port automatically detects Ethernet devices and doesn’t require an Ethernet 
crossover cable.
H One FireWire 800 port
Connect high-speed external devices, such as digital video cameras and storage devices. 
d Two high-speed USB (Universal Serial Bus) 2.0 ports
Connect an iPod, iPhone, mouse, keyboard, printer, disk drive, digital camera, joystick, 
modem, and more to your MacBook Pro. You can also connect USB 1.1 devices.
£ Mini DisplayPort (video out)
Connect to an external display or projection system that uses a DVI or VGA connector. 
You can purchase adapters for supported video formats.
, Audio in port
Connect your MacBook Pro to a line-level microphone or digital audio equipment. 
f Audio out port
Connect external speakers, headphones (including iPhone), or digital audio equipment. 
SD card slot
Easily transfer photos, videos, and data to and from your MacBook Pro with an SD card.26 Chapter 2   Life with Your MacBook Pro
Using the Multi-Touch Trackpad
Use the trackpad to move the cursor and to perform a variety of Multi-Touch gestures. 
Unlike typical trackpads, the entire MacBook Pro trackpad is a button, and you can click 
anywhere on the trackpad. To enable gestures and set other trackpad options, choose 
Apple () > System Preferences, and then click Trackpad.
Here are ways to use your MacBook Pro trackpad:
Â Two-finger scrolling lets you drag to scroll quickly up, down, or sideways in the active 
window. This option is on by default.Chapter 2   Life with Your MacBook Pro 27
Â Secondary clicking or “right-clicking” lets you access shortcut menu commands.
Â To set up a one-finger secondary-click zone in the bottom left or right corner of the 
trackpad, select Secondary Click under the One Finger option in Trackpad 
preferences.
Â To set up two-finger secondary-clicking anywhere on the trackpad, select 
Secondary Click under the Two Fingers option in Trackpad preferences. 
Note:  You can also secondary click by holding down the Control key while you click.
Secondary click zone28 Chapter 2   Life with Your MacBook Pro
The following trackpad gestures work in certain applications. When you perform these 
gestures, slide your fingers lightly on the surface of the trackpad. For more information, 
see Trackpad preferences or choose Help > Mac Help and search for “trackpad.”
Â Two-finger pinching lets you zoom in or out on PDFs, images, photos, and more.
Â Two-finger rotating lets you rotate photos, pages, and more.Chapter 2   Life with Your MacBook Pro 29
Â Three-finger swipe lets you rapidly page through documents, move to the previous or 
next photo, and more.
Â Four-finger swipe works in the Finder and all applications. Swiping four fingers to the 
left or right activates Application Switcher so you can cycle through open 
applications. Swiping four fingers up or down causes Exposé to show the desktop or 
display all open windows. 30 Chapter 2   Life with Your MacBook Pro
Using the MacBook Pro Battery
When the MagSafe power adapter isn’t connected, your MacBook Pro draws power 
from its built-in battery. The length of time that you can run your MacBook Pro varies, 
depending on the applications you use and the external devices connected to your 
MacBook Pro. 
Turning off features such as AirPort Extreme or Bluetooth®
 wireless technology and 
reducing screen brightness can help conserve battery charge, for example, when you’re 
traveling by air. Many of your system preferences are automatically set to optimize 
battery life. 
Your MacBook Pro comes with two graphics processors, one for better battery life and 
the other for higher performance. To switch between processors, open System 
Preferences, click Energy Saver, select “Better battery life” or “Higher performance,” and 
then follow the onscreen instructions. Select “Better battery life” when you can’t use 
your MagSafe power adapter or you’re not using graphics-intensive applications. Select 
“Higher performance” when you’re using graphics-intensive applications, such as video 
editing software and games. Changing graphics settings requires you to log out for the 
settings to take effect.
You can determine the charge remaining in the battery by looking at the eight battery 
level indicator lights on the left side of your MacBook Pro. Press the button next to the 
lights, and the lights glow briefly to show how much charge remains in the battery. 
Important:  If only one indicator light is on, very little charge is left. If no lights 
illuminate, the battery is completely drained and the MacBook Pro won’t start up 
unless the power adapter is connected. Plug in the power adapter to let the battery 
recharge. For more information about battery indicator lights, see page 54.Chapter 2   Life with Your MacBook Pro 31
You can also check the amount of battery charge remaining by viewing the Battery 
( ) status icon in the menu bar. The battery charge level displayed is based on the 
amount of power left in the battery with the applications, peripheral devices, and 
system settings you are currently using. To conserve battery power, close applications 
and disconnect peripheral devices not in use, and adjust your Energy Saver settings. 
For more information about battery conservation and performance tips, go to 
www.apple.com/batteries/notebooks.html.
Charging the Battery
When the power adapter that came with your MacBook Pro is connected, the battery 
charges whether the computer is on, off, or in sleep. The battery charges more quickly, 
however, if the computer is off or in sleep.
The battery in your MacBook Pro can be replaced only by an Apple Authorized Service 
Provider or an Apple Retail Store. 32 Chapter 2   Life with Your MacBook Pro
Getting Answers
Much more information about using your MacBook Pro is available in Mac Help on 
your computer and on the Internet at www.apple.com/support/macbookpro.
To get Mac Help:
1 Click the Finder icon in the Dock (the bar of icons along the edge of the screen).
2 Click the Help menu in the menu bar and do one of the following:
a Type a question or term in the Search field, and select a topic from the list of results 
or select Show All Results to see all topics.
b Choose Mac Help to open the Mac Help window, where you can click links or type a 
search question.Chapter 2   Life with Your MacBook Pro 33
More Information 
For more information about using your MacBook Pro, see the following:
To learn about See
Installing memory Chapter 3, “Boost Your MacBook Pro,” on page 35.
Troubleshooting your 
MacBook Pro if you have a 
problem
Chapter 4, “Problem, Meet Solution,” on page 49.
Finding service and support 
for your MacBook Pro
“Learning More, Service, and Support” on page 61. Or go to the 
Apple Support site at www.apple.com/support/macbookpro.
Using Mac OS X The Mac OS X website at www.apple.com/macosx. Or search for 
“Mac OS X” in Mac Help. 
Moving from a PC to a Mac “Why you’ll love a Mac” at www.apple.com/getamac/whymac. 
Using iLife applications The iLife website at www.apple.com/ilife. Or open an iLife 
application, open Help for the application, and then type a 
question in the search field.
Changing system preferences System Preferences by choosing Apple (K) > System 
Preferences. Or search for “system preferences” in Mac Help.
Using the trackpad Mac Help and search for “trackpad.” Or open System Preferences 
and click Trackpad. 
Using the iSight camera Mac Help and search for “iSight.”
Using the keyboard Mac Help and search for “keyboard.”
Using AirPort Extreme wireless 
technology
The AirPort Support page at www.apple.com/support/airport. 
Or open Mac Help and search for “AirPort.”34 Chapter 2   Life with Your MacBook Pro
Using Bluetooth wireless 
technology
The Bluetooth Support page at www.apple.com/support/
bluetooth. Or open the Bluetooth File Exchange application, 
located in the Utilities folder within the Applications folder, 
and choose Help > Bluetooth Help.
Caring for the battery Mac Help and search for “battery.”
Connecting a printer Mac Help and search for “printing.”
FireWire and USB connections Mac Help and search for “FireWire” or “USB”.
Connecting to the Internet Mac Help and search for “Internet.”
Connecting an external display Mac Help and search for “displayport.”
Apple Remote Mac Help and search for “remote.”
Front Row Mac Help and search for “Front Row.”
Burning a CD or DVD Mac Help and search for “burn disc.”
Specifications The Specifications page at support.apple.com/specs. 
Or open System Profiler by choosing Apple (K) > About This 
Mac from the menu bar, and then click More Info.
Apple news, free downloads, 
and online catalogs of 
software and hardware
The Apple website at www.apple.com.
Instructions, technical support, 
and manuals for Apple 
products
The Apple Support website at www.apple.com/support.
To learn about See3
3 Boost Your MacBook Pro
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This chapter provides information and instructions for upgrading the hard disk drive, 
and installing additional memory in your MacBook Pro.  
The battery in your MacBook Pro is not user-replaceable. If you think your battery 
needs to be replaced, contact an Apple Retail Store or an Apple Authorized Service 
Provider.
WARNING:  Apple recommends that you have an Apple-certified technician install 
replacement drives and memory. Consult the service and support information that 
came with your computer for information about how to contact Apple for service. If 
you attempt to install a replacement drive or memory and damage your equipment, 
such damage is not covered by the limited warranty on your computer.Chapter 3   Boost Your MacBook Pro 37
Replacing the Hard Disk Drive
You can upgrade the hard disk drive in your MacBook Pro. When you open the back of 
your MacBook Pro, the hard disk drive is located next to the built-in battery. The 
replacement drive must be a 2.5-inch drive with a Serial ATA (SATA) connector.
To replace the hard disk drive in your MacBook Pro:
1 Shut down your MacBook Pro. Disconnect the power adapter, Ethernet cable, USB 
cables, security lock, and any other cables connected to the MacBook Pro to prevent 
damaging the computer.
2 Turn over your MacBook Pro and remove the ten (10) screws that secure the bottom 
case. Remove the shorter screws at the angles shown in the illustration. Lift off the case 
and place it to the side. 
WARNING:  The internal components of your MacBook Pro can be warm. If you have 
been using your MacBook Pro, wait 10 minutes after shutting down to let the internal 
components cool before continuing.38 Chapter 3   Boost Your MacBook Pro
Important:  Because the screws are different lengths, note the screw lengths and 
locations so you can replace the screws correctly. Put them aside in a safe place.
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Important:  When you remove the bottom case, you expose sensitive internal 
components. Avoid touching anything other than the hard drive assembly when you 
remove or add a hard disk drive.
3 Touch a metal surface inside the computer to discharge any static electricity from 
your body.40 Chapter 3   Boost Your MacBook Pro
4 Locate the bracket at the top of the drive. Use a Phillips screwdriver to loosen the two 
captive screws that hold the bracket in place. Put the bracket aside in a safe place.
5 Using the pull tab, gently lift the drive out of the bay.
Pull tab
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6 Hold the drive by its sides while you gently pull the connector on the left side of the 
drive to disconnect it.
The connector is attached to a cable and remains in the hard disk drive bay.
Important:  There are four (4) mounting screws on the sides of your hard disk drive. 
If your replacement drive doesn’t include mounting screws, remove the ones from your 
old drive and mount them on the replacement drive before you install it.
7 Attach the connector to the left side of the replacement drive.
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8 Insert the replacement drive at an angle, making sure the mounting screws are seated 
properly.
9 Replace the bracket and tighten the screws. Chapter 3   Boost Your MacBook Pro 43
10 Replace the bottom case. Replace and tighten the ten screws you removed in step 2 in 
their proper locations, making sure to insert the shorter screws at the angles shown in 
the illustration.
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For information about installing Mac OS X and bundled applications, see “Reinstalling 
the Software That Came with Your MacBook Pro” on page 60.
Installing Additional Memory
Your computer has two memory slots that you access by removing the bottom case. 
Your MacBook Pro comes with a minimum of 4 gigabytes (GB) of 1066 MHz Double 
Data Rate (DDR3) Synchronous Dynamic Random-Access Memory (SDRAM) installed. 
Each memory slot can accept an SDRAM module that meets the following 
specifications:
Â Double Data Rate Small Outline Dual Inline Memory Module (DDR3) format
Â 30 mm (1.18 inches)
Â 1 GB, 2 GB, or 4 GB
Â 204-pin
Â PC3-8500 DDR3 1066 MHz Type RAM
You can add two 4 GB memory modules for a maximum of 8 GB of memory. For best 
performance, fill both memory slots and install an identical memory module in each 
slot.
To install memory in your MacBook Pro: 
1 Follow steps 1 through 3 beginning on page 37.
Important:  When you remove the bottom case, you expose sensitive internal 
components. Avoid touching anything other than the memory assembly when you 
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2 Push the levers on the sides of the memory module in an outward direction to release 
the module from the memory card slot. 
The memory pops up at an angle. Before removing it, make sure you see the half-circle 
notches. If you don’t, try pushing the levers outward again. 
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3 Hold the memory module by its notches and remove it from the slot. 
4 Remove the other memory module.
Important:  Hold the memory modules by their edges, and do not touch the gold 
connectors.
5 Insert the new memory module in the slot:
a Align the notch on the gold edge of the module with the notch in the lower memory 
slot.
b Tilt the card and push the memory into the slot.
c Use two fingers with firm, even pressure to push down on the memory module. 
You should hear a click when the memory is inserted correctly.
d Repeat to install an additional memory module in the top slot. Press down on the 
module to make sure it is level.Chapter 3   Boost Your MacBook Pro 47
6 Follow the instructions for replacing the bottom case in step 10 on page 43.
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Making Sure Your MacBook Pro Recognizes the New Memory
After installing additional memory in your MacBook Pro, check whether the computer 
recognizes the new memory. 
To check the computer’s memory:
1 Start up your MacBook Pro.
2 When you see the Mac OS X desktop, choose Apple () from the menu bar and then 
choose About This Mac.
For a detailed breakdown of the amount of memory installed in your computer, open 
System Profiler by clicking More Info, and then click Memory.
If your MacBook Pro doesn’t recognize the memory or doesn’t start up correctly, 
confirm that the memory you installed is compatible with your MacBook Pro and that 
it is installed correctly by reseating the memory.4
4 Problem, Meet Solution
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Occasionally you may have problems while working with your MacBook Pro. Read on 
for troubleshooting tips to try when you have a problem. You can also find more 
troubleshooting information in Mac Help and on the MacBook Pro Support website at 
www.apple.com/support/macbookpro.
When you experience a problem working with your MacBook Pro, there is usually a 
simple and quick solution. Think about the conditions that led up to the problem. 
Making a note of things you did before the problem occurred will help you narrow 
down possible causes and find the answers you need. Things to note include:
Â The applications you were using when the problem occurred. Problems that occur 
only with a specific application might indicate that the application is not compatible 
with the version of the Mac OS installed on your computer.
Â Any new software that you installed, especially software that added items to the 
System folder.
Â Any new hardware that you installed, such as additional memory or a peripheral.Chapter 4   Problem, Meet Solution 51
Problems That Prevent You from Using Your MacBook Pro
If your MacBook Pro doesn’t respond or the pointer doesn’t move
On rare occasions, an application may “freeze” on the screen. Mac OS X provides a way 
to quit a frozen application without restarting your computer.
To force an application to quit:
1 Press Command (x)-Option-Esc or choose Apple () > Force Quit from the menu bar.
The Force Quit Applications dialog appears with the application selected.
2 Click Force Quit.
The application quits, leaving all other applications open.
If you need to, you can also restart the Finder from this dialog.
Next, save your work in any open applications and restart the computer to make sure 
the problem is entirely cleared up.
If the problem occurs frequently, choose Help > Mac Help from the menu bar at the 
top of the screen. Search for the word “freeze” to get help for times when the computer 
freezes or doesn’t respond.
If the problem occurs only when you use a particular application, check with the 
application’s manufacturer to see if it is compatible with your computer. To get support 
and contact information for the software that comes with your MacBook Pro, go to 
www.apple.com/guide.
If you know an application is compatible, you might need to reinstall your computer’s 
system software. See “Reinstalling the Software That Came with Your MacBook Pro” on 
page 60.52 Chapter 4   Problem, Meet Solution
If your MacBook Pro freezes during startup, or you see a flashing question mark, 
or the display is dark and the sleep indicator light is glowing steadily (not in sleep)
The flashing question mark usually means that the computer can’t find the system 
software on the hard disk or any disks attached to the computer. 
Â Wait a few seconds. If the computer doesn’t soon start up, shut it down by pressing 
and holding the power (®) button for about 8 to 10 seconds. Disconnect all external 
peripherals and try restarting by pressing the power (®) button while holding down 
the Option key. When your computer starts up, click the hard disk icon, and then click 
the right arrow. After the computer starts up, open System Preferences and click 
Startup Disk. Select a local Mac OS X System folder.
Â If that doesn’t work, try using Disk Utility to repair the disk:
Â Insert the Mac OS X Install DVD into your computer. 
Â Restart your computer and hold down the C key as it starts up. 
Â Choose Installer from the menu bar, and then choose Open Disk Utility. When Disk 
Utility opens, follow the instructions in the First Aid pane to see if Disk Utility can 
repair the disk.
If using Disk Utility doesn’t help, you might need to reinstall your computer’s system 
software. See “Reinstalling the Software That Came with Your MacBook Pro” on 
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If your MacBook Pro doesn’t turn on or start up
Try the following suggestions in order until your computer turns on:
Â Make sure the power adapter is plugged into the computer and into a functioning 
power outlet. Be sure to use the 85W MagSafe Power Adapter that came with your 
MacBook Pro. If the power adapter stops charging and you don’t see the indicator 
light on the MagSafe connector turn on when you plug in the power cord, try 
unplugging and replugging the power cord to reseat it, or try another power outlet.
Â Check whether the battery needs to be recharged. Press the small button on the left 
side of your computer. You should see one to eight lights indicating the battery’s 
level of charge. If a single indicator light is on, connect your power adapter to 
recharge. For more information about battery indicator lights, see page 54.
Â If the problem persists, reset the MacBook Pro power manager by disconnecting the 
power adapter and holding down the power (®) button for at least 5 seconds. 
Â If you recently installed additional memory, make sure that it is correctly installed and 
is compatible with your computer. See whether removing and reinstalling the old 
memory allows the computer to start up (see page 44). 
Â Press the power (®) button and immediately hold down the Command (x), Option, 
P, and R keys simultaneously until you hear the startup sound a second time to reset 
the parameter RAM (PRAM). 
Â If you still can’t start up your MacBook Pro, see “Learning More, Service, and Support” 
on page 61 for information about contacting Apple for service.54 Chapter 4   Problem, Meet Solution
If the display suddenly goes black or your MacBook Pro freezes
Try restarting your MacBook Pro. 
1 Unplug any devices that are connected to your MacBook Pro, except the power 
adapter.
2 Press the power (®) button to restart the system.
3 Let the battery charge to at least 10 percent before plugging in any external devices 
and resuming your work. 
To see how much the battery has charged, click the Battery ( ) status icon in the 
menu bar.
The display might also darken if you have energy saver features set for the battery.
If you press the battery button, and all battery indicator lights flash five times 
quickly
Your battery needs to be replaced. Contact an Apple Retail Store or an Apple 
Authorized Service Provider (AASP).
If you press the battery button, and the battery indicator lights flash from left to 
right and then from right to left, five times in a row
Your battery is not recognized. Contact an Apple Retail Store or an Apple Authorized 
Service Provider.
If you forget your password
You can reset your administrator password and passwords for all other accounts.
1 Insert the Mac OS X Install DVD. Then restart your computer and hold down the C key as 
it starts up.Chapter 4   Problem, Meet Solution 55
2 Choose Utilities > Reset Password from the menu bar and follow the onscreen 
instructions.
If you have trouble ejecting a disc
Quit any applications that might be using the disc and try again. If that doesn’t work, 
restart the computer and then immediately press and hold the trackpad button.
Using Apple Hardware Test
If you suspect a problem with the MacBook Pro hardware, you can use the Apple 
Hardware Test application to help determine if there is a problem with one of the 
computer’s components, such as the memory or processor.
To use Apple Hardware Test:
1 Disconnect all external devices from your computer except the power adapter.
If you have an Ethernet cable connected, disconnect it.
2 Restart your computer and hold down the D key as it starts up. 
3 When the Apple Hardware Test chooser screen appears, select the language for your 
location.
4 Press the Return key or click the right arrow button.
5 When the Apple Hardware Test main screen appears (after about 45 seconds), follow 
the onscreen instructions.
6 If Apple Hardware Test detects a problem, it displays an error code. Make a note of the 
error code before pursuing support options. If Apple Hardware Test doesn’t detect a 
hardware failure, the problem might be software related.56 Chapter 4   Problem, Meet Solution
If this procedure doesn’t work, you can insert the Applications Install DVD and hold 
down the D key to use Apple Hardware Test.
Problems with Your Internet Connection
Your MacBook Pro has the Network Setup Assistant application to help walk you 
through setting up an Internet connection. Open System Preferences and click 
Network. Click the “Assist me” button to open Network Setup Assistant.
If you have trouble with your Internet connection, you can try the steps in this section 
for your type of connection or you can use Network Diagnostics.
To use Network Diagnostics:
1 Choose Apple () > System Preferences.
2 Click Network and then click “Assist me.” 
3 Click Diagnostics to open Network Diagnostics.
4 Follow the onscreen instructions.
If Network Diagnostics can’t resolve the problem, there may be a problem with the 
Internet service provider (ISP) you are trying to connect to, with an external device you 
are using to connect to your ISP, or with the server you are trying to access. You can try 
the following steps.
Cable Modem, DSL Modem, and LAN Internet Connections
Make sure all modem cables are firmly plugged in, including the modem power cord, 
the cable from the modem to the computer, and the cable from the modem to the 
wall jack. Also check the cables and power supplies to Ethernet hubs and routers. Chapter 4   Problem, Meet Solution 57
Turn the modem off and on and reset the modem hardware
Turn off your DSL or cable modem for a few minutes, and then turn it back on. Some 
ISPs recommend that you unplug the modem’s power cord. If your modem has a reset 
button, you can press it either before or after you turn the power off and on.
Important:  Instructions that refer to modems do not apply to LAN users. LAN users 
might have hubs, switches, routers, or connection pods that DSL and cable modem 
users do not have. LAN users should contact their network administrator rather than 
an ISP.
PPPoE Connections 
If you are unable to connect to your Internet service provider using PPPoE (Point to 
Point Protocol over Ethernet), make sure you have entered the correct information in 
Network preferences. 
To check your Network preference settings:
1 Choose Apple () > System Preferences.
2 Click Network.
3 Click Add (+) at the bottom of the network connection services list, and choose PPPoE 
from the Interface pop-up menu. 
4 Choose an Interface for the PPPoE service from the Ethernet pop-up menu. Choose 
Ethernet if you are connecting to a wired network or AirPort if you are connecting to a 
wireless network.
5 Enter the information you received from your service provider, such as account name, 
password, and the PPPoE service name (if your service provider requires it). 
6 Click Apply to make the settings active.58 Chapter 4   Problem, Meet Solution
Network Connections
Make sure the Ethernet cable is connected to your MacBook Pro and to the network. 
Check the cables and power supplies to your Ethernet hubs and routers.
If you have two or more computers attempting to share an Internet connection, be 
sure that your network is set up properly. You need to know whether your ISP provides 
only one IP address or multiple IP addresses, one for each computer.
If only one IP address is provided, then you must have a router capable of sharing the 
connection, also known as network address translation (NAT) or “IP masquerading.” 
For setup information, check the documentation provided with your router or ask 
the person who set up your network. The AirPort Base Station can be used to share 
one IP address among multiple computers. For information about using an AirPort 
Base Station, check Mac Help or go to the AirPort Extreme website at 
www.apple.com/support/airport.
If you can’t resolve the issue using these steps, contact your ISP or network 
administrator.
Problems with AirPort Extreme Wireless Communication
If you have trouble using AirPort Extreme wireless communication
Â Make sure the computer or network you are trying to connect to is running and has a 
wireless access point.
Â Make sure you have properly configured the software according to the instructions 
that came with your base station or access point.Chapter 4   Problem, Meet Solution 59
Â Make sure you are within antenna range of the other computer or the network’s 
access point. Nearby electronic devices or metal structures can interfere with wireless 
communication and reduce this range. Repositioning or rotating the computer might 
improve reception.
Â Check the AirPort (Z) status icon in the menu bar. Up to four bars appear, indicating 
signal strength. If you don’t see the bars, try changing your location.
Â See AirPort Help (choose Help > Mac Help, and then choose Library > AirPort Help 
from the menu bar). Also see the instructions that came with the wireless device for 
more information.
Keeping Your Software Up to Date
You can connect to the Internet and automatically download and install the latest free 
software versions, drivers, and other enhancements from Apple. 
When you are connected to the Internet, Software Update checks to see if any updates 
are available for your computer. You can set your MacBook Pro to check for updates 
periodically, and then you can download and install updated software.
To check for updated software:
1 Choose Apple () > System Preferences. 
2 Click the Software Update icon and follow the instructions on the screen.
Â For more information, search for “Software Update” in Mac Help. 
Â For the latest information about Mac OS X, go to www.apple.com/macosx.60 Chapter 4   Problem, Meet Solution
Reinstalling the Software That Came with Your MacBook Pro
Use the software installation discs that came with your computer to reinstall Mac OS X 
and any applications that came with your computer. You can choose “Archive and 
Install,” which saves your existing files and settings, or “Erase and Install,” which erases 
all your data.
Important:  Apple recommends that you back up the data on your hard disk before 
restoring software. Because the “Erase and Install” option erases your hard disk, you 
should back up your essential files before installing Mac OS X and other applications. 
Apple is not responsible for any lost data. 
Installing Mac OS X
To install Mac OS X:
1 Back up your essential files.
2 Make sure your power adapter is connected and plugged in.
3 Insert the Mac OS X Install DVD that came with your computer.
4 Double-click Install Mac OS X. 
5 Follow the onscreen instructions.
Note:  To restore Mac OS X on your computer to the original factory settings, click 
Options in the “Select a Destination” pane of the Installer, and then select “Erase and 
Install.” If you choose “Erase and Install,” you’ll see a message reminding you to use the 
Applications Install DVD to reinstall the bundled applications that came with your 
computer.
6 When the installation is complete, click Restart to restart your computer. 
7 Follow the prompts in the Setup Assistant to set up your user account.Chapter 4   Problem, Meet Solution 61
Installing Applications
If you reinstall Mac OS X on your computer and select the “Erase and Install” option, 
you must reinstall the applications that came with your computer, such as the iLife 
applications.
To install the applications that came with your computer:
1 Make sure your power adapter is connected and plugged in.
2 Insert the Applications Install DVD that came with your computer.
3 Double-click Install Bundled Software. 
4 Follow the onscreen instructions.
5 When the installation is complete, click Close.
Learning More, Service, and Support
Your MacBook Pro does not have any user-serviceable parts, except the hard drive and 
the memory. If you need service, contact Apple or take your MacBook Pro to an Apple 
Authorized Service Provider. You can find more information about the MacBook Pro 
through online resources, onscreen help, System Profiler, or Apple Hardware Test.
Online Resources
For online service and support information, go to www.apple.com/support. Choose 
your country from the pop-up menu. You can search the AppleCare Knowledge Base, 
check for software updates, or get help from Apple’s discussion forums. 
Onscreen Help
You can look for answers to your questions, as well as instructions and troubleshooting 
information, in Mac Help. Choose Help > Mac Help.62 Chapter 4   Problem, Meet Solution
System Profiler
To get information about your MacBook Pro, use System Profiler. It shows you what 
hardware and software is installed, the serial number and operating system version, 
how much memory is installed, and more. To open System Profiler, choose Apple () > 
About This Mac from the menu bar and then click More Info.
AppleCare Service and Support
Your MacBook Pro comes with 90 days of technical support and one year of hardware 
repair warranty coverage at an Apple Store retail location or an Apple-authorized repair 
center, such as an Apple Authorized Service Provider (AASP). You can extend your 
coverage by purchasing the AppleCare Protection Plan. For information, go to 
www.apple.com/support/products or the website for your country listed below.
If you need assistance, AppleCare telephone support representatives can help you 
with installing and opening applications, and basic troubleshooting. Call the support 
center number nearest you (the first 90 days are complimentary). Have the purchase 
date and your MacBook Pro serial number ready when you call.Chapter 4   Problem, Meet Solution 63
Note:  Your 90 days of complimentary telephone support begins on the date of 
purchase. Telephone fees may apply.
Telephone numbers are subject to change, and local and national telephone rates may 
apply. A complete list is available on the web:
Country Phone Website
United States 1-800-275-2273 www.apple.com/support
Australia (61) 1-300-321-456 www.apple.com/au/support
Canada (English)
(French)
1-800-263-3394 www.apple.com/ca/support
www.apple.com/ca/fr/support
Ireland (353) 1850 946 191 www.apple.com/ie/support
New Zealand 00800-7666-7666 www.apple.com/nz/support
United Kingdom (44) 0870 876 0753 www.apple.com/uk/support
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Locating Your Product Serial Number
Use one of these methods to find your computer’s serial number:
Â Turn over your MacBook Pro. The serial number is etched into the case near the 
hinge. 
Â Choose Apple () > About This Mac. Click the version number beneath the words 
“Mac OS X” to cycle through the Mac OS X version number, the build version, and the 
serial number. 
Â Click the Finder icon and open /Applications/Utilities/System Profiler. Click Hardware 
in the Contents pane.
Serial number5
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For your safety and that of your equipment, follow these rules for handling and 
cleaning your MacBook Pro and for working more comfortably. Keep these instructions 
handy for reference by you and others.
Important Safety Information
Built-in battery  Do not remove the battery from your MacBook Pro. The battery 
should be replaced only by an Apple Authorized Service Provider. Discontinue use of 
your MacBook Pro if it is dropped or appears crushed, bent, deformed, or damaged. Do 
not expose the computer to temperatures above 212° F or 100° C. 
Proper handling  Set up your MacBook Pro on a stable work surface that allows for 
adequate air circulation under and around the computer. Do not operate your 
MacBook Pro on a pillow or other soft material, as the material can block the airflow 
vents. Never place anything over the keyboard when operating your MacBook Pro. 
Never push objects into the ventilation openings. 
The bottom of your MacBook Pro may become very warm during normal use. If your 
MacBook Pro is on your lap and gets uncomfortably warm, move it to a stable work 
surface.
WARNING:  Incorrect storage or use of your computer may void the manufacturer’s 
warranty.
WARNING:  Failure to follow these safety instructions could result in fire, electric 
shock, or other injury or damage.Chapter 5   Last, but Not Least 67
Water and wet locations  Keep your MacBook Pro away from sources of liquid, such as 
drinks, washbasins, bathtubs, shower stalls, and so on. Protect your MacBook Pro from 
dampness or wet weather, such as rain, snow, and fog.
85W MagSafe Power Adapter  Make sure the AC plug or AC power cord is fully 
inserted into the power adapter before plugging the adapter into a power outlet. Use 
only the power adapter that came with your MacBook Pro, or an Apple-authorized 
power adapter that is compatible with this product. The power adapter may become 
very warm during normal use. Always plug the power adapter directly into a power 
outlet, or place it on the floor in a well-ventilated location.
Disconnect the power adapter and disconnect any other cables if any of the following 
conditions exists:
Â You want to add memory or upgrade the hard disk drive.
Â You want to clean the case (use only the recommended procedure described on 
page 71).
Â The power cord or plug becomes frayed or otherwise damaged.
Â Your MacBook Pro or power adapter is exposed to rain, excessive moisture, or liquid 
spilled into the case.
Â Your MacBook Pro or power adapter has been dropped, the case has been damaged, 
or you suspect that service or repair is required.
The MagSafe power port contains a magnet that can erase data on a credit card, iPod, 
or other device. To preserve your data, do not place these or other magnetically 
sensitive material or devices within 1 inch (25 mm) of this port.
If debris gets into the MagSafe power port, remove it gently with a dry cotton swab.68 Chapter 5   Last, but Not Least
MagSafe power specifications:
Â Frequency:  50 to 60 Hz, single phase
Â Line Voltage:  100 to 240 V
Â Output Voltage:  18.5 V DC, 4.6 A
Hearing damage  Permanent hearing loss may occur if earbuds or headphones are 
used at high volume. You can adapt over time to a higher volume of sound that may 
sound normal but can be damaging to your hearing. If you experience ringing in your 
ears or muffled speech, stop listening and have your hearing checked. The louder the 
volume, the less time is required before your hearing could be affected. Hearing 
experts suggest that to protect your hearing:
Â Limit the amount of time you use earbuds or headphones at high volume.
Â Avoid turning up the volume to block out noisy surroundings. 
Â Turn the volume down if you can’t hear people speaking near you.
High-risk activities  This computer system is not intended for use in the operation of 
nuclear facilities, aircraft navigation or communications systems, air traffic control 
systems, or for any other uses where the failure of the computer system could lead to 
death, personal injury, or severe environmental damage.Chapter 5   Last, but Not Least 69
Laser Information for Optical Disc Drives
The optical disc drive in your computer contains a laser that is safe in normal use but 
that may be harmful to your eyes if disassembled. For your safety, have this equipment 
serviced only by an Apple Authorized Service Provider. 
Important Handling Information
Operating environment  Operating your MacBook Pro outside these ranges may affect 
performance:
Â Operating temperature:  50° to 95° F (10° to 35° C)
Â Storage temperature:  -4° to 113° F (-20° to 45° C)
Â Relative humidity:  5% to 90% (noncondensing)
Â Operating altitude:  0 to 10,000 feet (0 to 3048 meters)
Turning on your MacBook Pro  Never turn on your MacBook Pro unless all of its 
internal and external parts are in place. Operating the computer when parts are 
missing may be dangerous and may damage your computer.
WARNING:  Making adjustments or performing procedures other than those specified 
in your equipment’s manual may result in hazardous radiation exposure. 
NOTICE:  Failure to follow these handling instructions could result in damage to your 
MacBook Pro or other property.70 Chapter 5   Last, but Not Least
Carrying your MacBook Pro  If you carry your MacBook Pro in a bag or briefcase, 
make sure that there are no loose items (such as paper clips or coins) that could 
accidentally get inside the computer through vent openings or the optical drive slot 
or get stuck inside a port. Also, keep magnetically sensitive items away from the 
MagSafe power port. 
Using connectors and ports  Never force a connector into a port. When connecting a 
device, make sure the port is free of debris, that the connector matches the port, and 
that you have positioned the connector correctly in relation to the port.
Using the optical drive  The SuperDrive in your MacBook Pro supports standard 12 cm 
(4.7 inch) discs. Irregularly shaped discs or discs smaller than 12 cm (4.7 inches) are not 
supported.
Handling glass parts  Your MacBook Pro contains glass components, including the 
display and trackpad. If they are damaged, don’t use your MacBook Pro until it has 
been repaired by an Apple Authorized Service Provider.Chapter 5   Last, but Not Least 71
Storing your MacBook Pro  If you are going to store your MacBook Pro for an 
extended period of time, keep it in a cool location (ideally, 71° F or 22° C) and discharge 
the battery to approximately 50 percent. To maintain the capacity of the battery, 
recharge the battery to 50 percent every six months or so.
Cleaning your MacBook Pro  When cleaning the outside of your MacBook Pro and its 
components, first shut down your MacBook Pro and unplug the power adapter. Then 
use a damp, soft, lint-free cloth to clean the computer’s exterior. Avoid getting 
moisture in any openings. Do not spray liquid directly on the computer. Do not use 
aerosol sprays, solvents, or abrasives that might damage the finish.
Cleaning your MacBook Pro screen  To clean your MacBook Pro screen, first shut down 
your MacBook Pro and unplug the power adapter. Then dampen the included cleaning 
cloth with just water and wipe the screen. Do not spray liquid directly on the screen.72 Chapter 5   Last, but Not Least
Understanding Ergonomics
Here are some tips for setting up a healthy work environment.
Keyboard and Trackpad
When you use the keyboard and trackpad, your shoulders should be relaxed. 
Your upper arm and forearm should form an angle that is slightly greater than a right 
angle, with your wrist and hand in roughly a straight line.
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Use a light touch when typing or using the trackpad and keep your hands and fingers 
relaxed. Avoid rolling your thumbs under your palms.
Change hand positions often to avoid fatigue. Some computer users might develop 
discomfort in their hands, wrists, or arms after intensive work without breaks. If you 
begin to develop chronic pain or discomfort in your hands, wrists, or arms, consult a 
qualified health specialist.
External Mouse
If you use an external mouse, position the mouse at the same height as the keyboard 
and within a comfortable reach.
Chair
An adjustable chair that provides firm, comfortable support is best. Adjust the height 
of the chair so your thighs are horizontal and your feet are flat on the floor. The back of 
the chair should support your lower back (lumbar region). Follow the manufacturer’s 
instructions for adjusting the backrest to fit your body properly.
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You might have to raise your chair so that your forearms and hands are at the proper 
angle to the keyboard. If this makes it impossible to rest your feet flat on the floor, you 
can use a footrest with adjustable height and tilt to make up for any gap between the 
floor and your feet. Or you can lower the desktop to eliminate the need for a footrest. 
Another option is to use a desk with a keyboard tray that’s lower than the regular work 
surface.
Built-in Display
Adjust the angle of the display to minimize glare and reflections from overhead lights 
and windows. Do not force the display if you meet resistance. The display is not meant 
to open past 130 degrees.
You can adjust the brightness of the screen when you take the computer from one 
work location to another, or if the lighting in your work area changes.
More information about ergonomics is available on the web: 
Apple and the Environment
Apple Inc. recognizes its responsibility to minimize the environmental impacts of its 
operations and products. 
More information is available on the web:
www.apple.com/about/ergonomics
www.apple.com/environment76
Regulatory Compliance Information
Compliance Statement
This device complies with part 15 of the FCC rules. 
Operation is subject to the following two conditions:  (1) 
This device may not cause harmful interference, and (2) 
this device must accept any interference received, 
including interference that may cause undesired 
operation. See instructions if interference to radio or 
television reception is suspected.
L‘utilisation de ce dispositif est autorisée seulement aux 
conditions suivantes: (1) il ne doit pas produire de 
brouillage et (2) l’utilisateur du dispositif doit étre prêt à 
accepter tout brouillage radioélectrique reçu, même si 
ce brouillage est susceptible de compromettre le 
fonctionnement du dispositif.
Radio and Television Interference
This computer equipment generates, uses, and can 
radiate radio-frequency energy. If it is not installed and 
used properly—that is, in strict accordance with Apple’s 
instructions—it may cause interference with radio and 
television reception. 
This equipment has been tested and found to comply 
with the limits for a Class B digital device in accordance 
with the specifications in Part 15 of FCC rules. These 
specifications are designed to provide reasonable 
protection against such interference in a residential 
installation. However, there is no guarantee that 
interference will not occur in a particular installation. 
You can determine whether your computer system is 
causing interference by turning it off. If the interference 
stops, it was probably caused by the computer or one of 
the peripheral devices. 
If your computer system does cause interference to 
radio or television reception, try to correct the 
interference by using one or more of the following 
measures:
Â Turn the television or radio antenna until the 
interference stops. 
Â Move the computer to one side or the other of the 
television or radio. 
Â Move the computer farther away from the television 
or radio. 
Â Plug the computer into an outlet that is on a different 
circuit from the television or radio. (That is, make 
certain the computer and the television or radio are on 
circuits controlled by different circuit breakers or 
fuses.) 
If necessary, consult an Apple Authorized Service 
Provider or Apple. See the service and support 
information that came with your Apple product. 
Or consult an experienced radio/television technician 
for additional suggestions. 
Important:  Changes or modifications to this product 
not authorized by Apple Inc. could void the EMC 
compliance and negate your authority to operate the 
product.
This product has demonstrated EMC compliance under 
conditions that included the use of compliant peripheral 
devices and shielded cables (including Ethernet network 
cables) between system components. It is important 
that you use compliant peripheral devices and shielded 
cables between system components to reduce the 
possibility of causing interference to radios, television 
sets, and other electronic devices.77
Responsible party (contact for FCC matters only):  
Apple Inc. Corporate Compliance 
1 Infinite Loop, MS 26-A 
Cupertino, CA 95014
Wireless Radio Use
This device is restricted to indoor use when operating in 
the 5.15 to 5.25 GHz frequency band.
Cet appareil doit être utilisé à l’intérieur.
Exposure to Radio Frequency Energy
The radiated output power of the AirPort Extreme 
technology is below the FCC radio frequency exposure 
limits. Nevertheless, it is advised to use the wireless 
equipment in such a manner that the potential for 
human contact during normal operation is minimized.
FCC Bluetooth Wireless Compliance
The antenna used with this transmitter must not be 
colocated or operated in conjunction with any other 
antenna or transmitter subject to the conditions of the 
FCC Grant.
Bluetooth Industry Canada Statement
This Class B device meets all requirements of the 
Canadian interference-causing equipment regulations.
Cet appareil numérique de la Class B respecte toutes les 
exigences du Règlement sur le matériel brouilleur 
du Canada.
Industry Canada Statement
Complies with the Canadian ICES-003 Class B 
specifications. Cet appareil numérique de la classe B est 
conforme à la norme NMB-003 du Canada. This device 
complies with RSS 210 of Industry Canada.
Bluetooth Europe—EU Declaration of 
Conformity
This wireless device complies with the R&TTE Directive.
Europe—EU Declaration of Conformity
The equipment complies with the RF Exposure 
Requirement 1999/519/EC, Council Recommendation of 
12 July 1999 on the limitation of exposure of the general 
public to electromagnetic fields (0 Hz to 300 GHz). 
Hereby, Apple Inc. declares that this 802.11a/b/g/n 
Mini-PCIe card is in compliance with the R&TTE 
Directive.
Complies with European Low Voltage and EMC 
Directives.
See: www.apple.com/euro/compliance
Korea Warning Statements
Singapore Wireless Certification
Taiwan Wireless Statements78
Taiwan Class B Statement
VCCI Class B Statement
External USB Modem Information
When connecting your MacBook Pro to the phone 
line using an external USB modem, refer to the 
telecommunications agency information in the 
documentation that came with your modem.
ENERGY STAR®
 Compliance
As an ENERGY STAR®
 partner, Apple has determined 
that standard configurations of this product meet the 
ENERGY STAR®
 guidelines for energy efficiency. The 
ENERGY STAR®
 program is a partnership with electronic 
equipment manufacturers to promote energy-efficient 
products. Reducing energy consumption of products 
saves money and helps conserve valuable resources. 
This computer is shipped with power management 
enabled with the computer set to sleep after 10 minutes 
of user inactivity. To wake your computer, click the 
mouse or trackpad button or press any key on the 
keyboard. 
For more information about ENERGY STAR®, visit: 
www.energystar.gov 79
Disposal and Recycling Information
This symbol indicates that your product must be 
disposed of properly according to local laws and 
regulations. When your product reaches its end of life, 
contact Apple or your local authorities to learn about 
recycling options.
For information about Apple’s recycling program, go to 
www.apple.com/environment/recycling.
Battery Disposal Information
Dispose of batteries according to your local 
environmental laws and guidelines.
California:  The coin cell battery in the optional Apple 
Remote contains perchlorates. Special handling and 
disposal may apply. Refer to: 
www.dtsc.ca.gov/hazardouswaste/perchlorate
Deutschland:  Das Gerät enthält Batterien. Diese 
gehören nicht in den Hausmüll. Sie können verbrauchte 
Batterien beim Handel oder bei den Kommunen 
unentgeltlich abgeben. Um Kurzschlüsse zu vermeiden, 
kleben Sie die Pole der Batterien vorsorglich mit einem 
Klebestreifen ab.
Nederlands:  Gebruikte batterijen kunnen worden 
ingeleverd bij de chemokar of in een speciale 
batterijcontainer voor klein chemisch afval (kca) worden 
gedeponeerd.80
Taiwan:
European Union—Disposal Information:  
The symbol above means that according to local laws 
and regulations your product should be disposed of 
separately from household waste. When this product 
reaches its end of life, take it to a collection point 
designated by local authorities. Some collection points 
accept products for free. The separate collection and 
recycling of your product at the time of disposal will 
help conserve natural resources and ensure that it is 
recycled in a manner that protects human health and 
the environment.Looking for Something?82 Looking for Something?
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1 Ready, Set Up, Go
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Mac Help Migration Assistant8 Chapter 1   Ready, Set Up, Go
Your MacBook Pro is designed so that you can set it up quickly and start using it right 
away. If you have never used a MacBook Pro or are new to Macintosh computers, read 
this chapter for help getting started. 
Important:  Read all the installation instructions (and the safety information starting on 
page 66) carefully before you first use your computer.
If you are an experienced user, you may already know enough to get started. 
Make sure you look over the information in Chapter 2, “Life with Your MacBook Pro,” 
to find out about the new features of this MacBook Pro.
Many answers to questions can be found on your computer in Mac Help. For 
information about using Mac Help, see “Getting Answers” on page 31. Apple may 
release new versions and updates to its system software, so the images shown in this 
book may be slightly different from what you see onscreen.Chapter 1   Ready, Set Up, Go 9
What’s in the Box
Setting Up Your MacBook Pro
Your MacBook Pro is designed so that you can set it up quickly and start using it right 
away. The following pages take you through the setup process, including these tasks:
Â Plugging in the 60W MagSafe Power Adapter
Â Connecting cables and accessing a network
Â Turning on your MacBook Pro and using the trackpad
Â Configuring a user account and other settings using Setup Assistant
Â Setting up the Mac OS X desktop and preferences
60W MagSafe Power Adapter AC power cord
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Important:  Remove the protective film around the 60W MagSafe Power Adapter before 
setting up your MacBook Pro.
Step 1:  Plug in the 60W MagSafe Power Adapter to provide power to the 
MacBook Pro and charge the battery.
Make sure the AC plug is fully inserted into the power adapter and the electrical 
prongs on your AC plug are in their completely extended position. Insert the AC plug 
of your power adapter into a power outlet and the MagSafe connector into the 
MagSafe power port. As the MagSafe connector gets close to the port, you’ll feel a 
magnetic pull drawing it in.
To extend the reach of your power adapter, replace the AC plug with the AC power 
cord. First pull the AC plug up to remove it from the adapter, and then attach the 
included AC power cord to the adapter, making sure it is seated firmly.
When disconnecting the power adapter from an outlet or from the computer, pull the 
plug, not the cord.
®
MagSafe connector
AC power cord
AC plug ¯ MagSafe power portChapter 1   Ready, Set Up, Go 11
Note:  When you first connect the power adapter to your MacBook Pro, an indicator 
light on the MagSafe connector starts to glow. An amber light indicates that the 
battery is charging. A green light indicates that the battery is fully charged. If you don’t 
see a light, make sure the connector is seated properly and the power adapter is 
plugged in.
Step 2:  Connect to a wireless or wired network.
Â To use a wireless network with the built-in AirPort Extreme technology, make sure the 
wireless base station is turned on and that you know the name of the network. After 
you turn on your MacBook Pro, Setup Assistant guides you through the connection 
process. For troubleshooting tips, see page 58. 12 Chapter 1   Ready, Set Up, Go
Â To use a wired connection, connect one end of an Ethernet cable to your 
MacBook Pro and the other end to a cable modem, DSL modem, or network.
Â To use a dial-up connection, you need the external Apple USB Modem, available from 
the online Apple Store at www.apple.com/store or from an Apple Authorized Reseller. 
Connect the Apple USB Modem to a USB port on your MacBook Pro, and then 
connect a phone cord (not included) from the modem into a phone wall jack. 
®
Ethernet
cable
Gigabit Ethernet port
(10/100/1000Base-T)
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Step 3:  Press the power (®) button briefly to turn on your MacBook Pro.
You hear a tone when you turn on the computer. 
It takes the computer a few moments to start up. After it starts up, Setup Assistant 
opens automatically.
If your computer doesn’t turn on, see “If your MacBook Pro doesn’t turn on or start up” 
on page 52.
®
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Step 4:  Configure your MacBook Pro with Setup Assistant.
The first time you turn on your MacBook Pro, Setup Assistant starts. Setup Assistant 
helps you enter your Internet and email information and set up a user account on your 
MacBook Pro. If you already have a Mac, Setup Assistant can help you automatically 
transfer files, applications, and other information from your previous Mac. See the next 
section, “Migrating Information to Your MacBook Pro,” for more information.
If you don’t intend to keep or use your other Mac, it’s best to deauthorize it from 
playing music, videos, or audiobooks that you’ve purchased from the iTunes Store. 
Deauthorizing a computer prevents any songs, videos, or audiobooks you’ve purchased 
from being played by someone else and frees up another authorization for use. 
For information about deauthorizing, in iTunes, open Help > iTunes Help.Chapter 1   Ready, Set Up, Go 15
Migrating Information to Your MacBook Pro
You can follow the prompts in Setup Assistant to migrate existing user accounts, files, 
applications, and other information from another Mac computer. You can do this with 
one of the following methods:
Â Using a FireWire cable to connect the two computers together and transfer the 
information
Â Using an Ethernet cable connected directly between both computers, or connecting 
both computers to the same network
Â Wirelessly, directly between both computers, or with both computers on the same 
wireless network
Before performing migration, use Software Update on your other Mac to ensure you 
have the latest version of Mac OS X software—either Mac OS X v10.4.11 or Mac OS X 
v10.5.6 (or later). 
You can choose the items (user accounts, documents, movies, music, photos, and so 
on) that you want to migrate to your MacBook Pro. 
Important:  Don’t use the other Mac for anything else until the migration is complete.
If you don’t use Setup Assistant to transfer information when you first start up your 
computer, you can do it later using Migration Assistant. If the connection is terminated 
during migration, you can resume the migration at a later time using Migration 
Assistant on your MacBook Pro and your other Mac. Go to the Applications folder, open 
Utilities, and double-click Migration Assistant. 16 Chapter 1   Ready, Set Up, Go
Step 5:  Customize the Mac OS X desktop and set preferences.
Menu bar
Dock System Preferences icon
Help menu Spotlight search icon
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You can quickly customize the desktop using System Preferences. Choose Apple () > 
System Preferences from the menu bar or click the System Preferences icon in the 
Dock. System Preferences is your command center for most settings on your 
MacBook Pro. For more information, open Mac Help and search for “System 
Preferences” or for the specific preference you want to change.
Putting Your MacBook Pro to Sleep or Shutting It Down
When you finish working with your MacBook Pro, you can put it to sleep or shut it 
down.
Putting Your MacBook Pro to Sleep
If you’ll be away from your MacBook Pro for only a short time, put it to sleep. When the 
computer is in sleep, you can quickly wake it and bypass the startup process. 
To put your MacBook Pro to sleep, do one of the following:
Â Close the display.
Â Choose Apple () > Sleep from the menu bar.
Â Press the power (®) button and click Sleep in the dialog that appears.
Â Choose Apple () > System Preferences, click Energy Saver, and set a sleep timer. 
NOTICE:  Wait a few seconds until the sleep indicator light starts pulsing (indicating 
that the computer is in sleep and the hard disk has stopped spinning) before you 
move your MacBook Pro. Moving your computer while the hard disk is spinning can 
damage it, causing loss of data or the inability to start up from the hard disk.18 Chapter 1   Ready, Set Up, Go
To wake your MacBook Pro:
Â If the display is closed, simply open it to wake your MacBook Pro.
Â If the display is already open, press the power (®) button or any key on the keyboard.
When your MacBook Pro wakes from sleep, your applications, documents, and 
computer settings are exactly as you left them. 
Shutting Down Your MacBook Pro
If you aren’t going to use your MacBook Pro for a couple of days or longer, it’s best to 
shut it down. The sleep indicator light goes on briefly during the shutdown process.
To shut down your MacBook Pro, do one of the following:
Â Choose Apple () > Shut Down from the menu bar.
Â Press the power (®) button and click Shut Down in the dialog that appears.
If you plan to store your MacBook Pro for an extended period of time, see “Important 
Handling Information” on page 69 for information about how to prevent your battery 
from draining completely.2
2 Life with Your MacBook Pro
www.apple.com/macosx
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Basic Features of Your MacBook Pro
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Built-in iSight camera and camera indicator light
Videoconference with others using iChat, take pictures with Photo Booth, or capture 
video with iMovie. The indicator light glows when the iSight camera is operating.
Built-in microphone
Capture sounds with the microphone (located above the Esc key on your keyboard) or 
talk with friends live over broadband using the included iChat application.
Built-in stereo speakers
Listen to music, movies, games, and multimedia files.
Built-in battery and battery indicator lights
Use battery power when you’re away from a power outlet. Press the battery button to 
activate indicator lights that show the remaining battery charge. 
Trackpad
Click or double-click anywhere on the trackpad. Touch the trackpad with one or more 
fingers to move the pointer and use Multi-Touch gestures (described on page 26). 
Sleep indicator light
A white light pulses when the MacBook Pro is in sleep.
Infrared (IR) receiver
Use an optional Apple Remote (available separately) with the IR receiver to control Front 
Row and Keynote on your MacBook Pro from up to 30 feet (9.1 meters) away. 
Security slot
Attach a lock and cable (available separately) to prevent theft.
Slot-loading SuperDrive
This optical drive reads and writes to standard-size CDs and DVDs. 
® Power button
Turn your MacBook Pro on or off, or put it to sleep.22 Chapter 2   Life with Your MacBook Pro
Keyboard Features of Your MacBook Pro
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Function (fn) key
Hold down this key to activate customized actions assigned to the function keys 
(F1 to F12). To learn how to customize function keys, choose Help > Mac Help from the 
menu bar and search for “function keys.”
Brightness keys (F1, F2)
Increase ( ) or decrease ( ) the brightness of the screen. 
Exposé key (F3)
Open Exposé for quick access to all your open windows.
Dashboard key (F4)
Open Dashboard to access your widgets. 
o Keyboard illumination keys (F5, F6) 
Increase (o) or decrease (ø) the brightness of the keyboard illumination.
’ Media keys (F7, F8, F9)
Rewind ( ), play or pause (’), or fast-forward ( ) a song, movie, or slideshow.
— Mute key (F10)
Mute the sound coming from the built-in speakers and audio out port.
- Volume keys (F11, F12)
Increase (-) or decrease (–) the volume of the sound coming from the built-in speakers 
or audio out port.
C Media Eject key
Hold down this key to eject a disc that’s not in use. You can also eject a disc by dragging 
its desktop icon to the Trash.24 Chapter 2   Life with Your MacBook Pro
Ports on Your MacBook Pro
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Note:  Adapters and other accessories are sold separately at www.apple.com/store.
¯ MagSafe power port
Plug in the included 60W MagSafe Power Adapter to recharge the MacBook Pro battery.
G Gigabit Ethernet port
Connect to a high-speed Ethernet network, a DSL or cable modem, or another computer. 
The Ethernet port automatically detects Ethernet devices and doesn’t require an 
Ethernet crossover cable.
H One FireWire 800 port
Connect high-speed external devices, such as digital video cameras and storage devices.
£ Mini DisplayPort (video out)
Connect to an external display or projection system that uses a DVI, Dual-Link DVI, or 
VGA connector. You can purchase adapters for supported video formats.
d Two USB (Universal Serial Bus) 2.0 ports
Connect an iPod, iPhone, mouse, keyboard, printer, digital camera, modem, and more to 
your MacBook Pro. You can connect one high-powered external USB device. 
SD card slot
Easily transfer photos, videos, and data to and from your MacBook Pro with an SD card.
f Audio out port
Connect external speakers, headphones (including iPhone), or digital audio equipment. 
You can specify audio analog line in functionality, to support line-level microphones and 
audio equipment, by selecting Audio In in the Sound pane of System Preferences.26 Chapter 2   Life with Your MacBook Pro
Using the Multi-Touch Trackpad
Use the trackpad to move the cursor and to perform a variety of Multi-Touch gestures. 
Unlike typical trackpads, the entire MacBook Pro trackpad is a button, and you can click 
anywhere on the trackpad. To enable gestures and set other trackpad options, choose 
Apple () > System Preferences, and then click Trackpad.
Here are ways to use your MacBook Pro trackpad:
Â Two-finger scrolling lets you drag to scroll quickly up, down, or sideways in the active 
window. This option is on by default.Chapter 2   Life with Your MacBook Pro 27
Â Secondary clicking or “right-clicking” lets you access shortcut menu commands.
Â To set up a one-finger secondary-click zone in the bottom left or right corner of the 
trackpad, select Secondary Click under the One Finger option in Trackpad 
preferences.
Â To set up two-finger secondary-clicking anywhere on the trackpad, select 
Secondary Click under the Two Fingers option in Trackpad preferences. 
Note:  You can also secondary click by holding down the Control key while you click.
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The following trackpad gestures work in certain applications. When you perform these 
gestures, slide your fingers lightly on the surface of the trackpad. For more information, 
see Trackpad preferences or choose Help > Mac Help and search for “trackpad.”
Â Two-finger pinching lets you zoom in or out on PDFs, images, photos, and more.
Â Two-finger rotating lets you rotate photos, pages, and more.Chapter 2   Life with Your MacBook Pro 29
Â Three-finger swipe lets you rapidly page through documents, move to the previous or 
next photo, and more.
Â Four-finger swipe works in the Finder and all applications. Swiping four fingers to the 
left or right activates Application Switcher so you can cycle through open 
applications. Swiping four fingers up or down causes Exposé to show the desktop or 
display all open windows. 30 Chapter 2   Life with Your MacBook Pro
Using the MacBook Pro Battery
When the MagSafe power adapter isn’t connected, your MacBook Pro draws power 
from its built-in battery. The length of time that you can run your MacBook Pro varies, 
depending on the applications you use and the external devices connected to your 
MacBook Pro. 
Turning off features such as AirPort Extreme or Bluetooth®
 wireless technology and 
reducing screen brightness can help conserve battery charge—for example, when 
you’re traveling by air. Many of your system preferences are automatically set to 
optimize battery life. 
You can determine the charge remaining in the battery by looking at the eight battery 
level indicator lights on the left side of your MacBook Pro. Press the button next to the 
lights, and the lights glow briefly to show how much charge remains in the battery. 
Important:  If only one indicator light is on, very little charge is left. If no lights 
illuminate, the battery is completely drained and the MacBook Pro won’t start up 
unless the power adapter is connected. Plug in the power adapter to let the battery 
recharge. For more information about battery indicator lights, see page 54.
You can also check the amount of battery charge remaining by viewing the 
Battery ( ) status icon in the menu bar. The battery charge level displayed is based 
on the amount of power left in the battery with the applications, peripheral devices, 
and system settings you are currently using. To conserve battery power, close 
applications and disconnect peripheral devices not in use, and adjust your Energy 
Saver settings. For more information about battery conservation and performance tips, 
go to www.apple.com/batteries/notebooks.html.Chapter 2   Life with Your MacBook Pro 31
Charging the Battery
When the power adapter that came with your MacBook Pro is connected, the battery 
recharges whether the computer is on, off, or in sleep. The battery recharges more 
quickly, however, when the computer is off or in sleep.
The battery in your MacBook Pro can be replaced only by an Apple Authorized Service 
Provider or an Apple Retail Store. 
Getting Answers
Much more information about using your MacBook Pro is available in Mac Help on 
your computer and on the Internet at www.apple.com/support/macbookpro.
To get Mac Help:
1 Click the Finder icon in the Dock (the bar of icons along the edge of the screen).
2 Click the Help menu in the menu bar and do one of the following:
a Type a question or term in the Search field, and select a topic from the list of results 
or select Show All Results to see all topics.
b Choose Mac Help to open the Mac Help window, where you can click links or type a 
search question.32 Chapter 2   Life with Your MacBook Pro
More Information
For more information about using your MacBook Pro, see the following:
To learn about See
Installing memory Chapter 3, “Boost Your MacBook Pro,” on page 35.
Troubleshooting your 
MacBook Pro if you have a 
problem
Chapter 4, “Problem, Meet Solution,” on page 49.
Finding service and support 
for your MacBook Pro
“Learning More, Service, and Support” on page 61. 
Or see the Apple Support website at 
www.apple.com/support/macbookpro.
Using Mac OS X The Mac OS X website at www.apple.com/macosx. Or search for 
“Mac OS X” in Mac Help. 
Moving from a PC to a Mac “Why you’ll love a Mac” at www.apple.com/getamac/whymac. 
Using iLife applications The iLife website at www.apple.com/ilife. Or open an iLife 
application, open Help for the application, and then type a 
question in the search field.
Changing system preferences System Preferences by choosing Apple (K) > System 
Preferences. Or search for “system preferences” in Mac Help.
Using the trackpad Mac Help and search for “trackpad.” Or open System Preferences 
and click Trackpad.
Using the keyboard Mac Help and search for “keyboard.”
Using the iSight camera Mac Help and search for “iSight.”
Using AirPort Extreme wireless 
technology
The AirPort Support page at www.apple.com/support/airport.Chapter 2   Life with Your MacBook Pro 33
Using Bluetooth wireless 
technology
The Bluetooth Support page at www.apple.com/support/
bluetooth. Or open the Bluetooth File Exchange application, 
located in the Utilities folder within the Applications folder, 
and choose Help > Bluetooth Help.
Caring for the battery Mac Help and search for “battery.”
Connecting a printer Mac Help and search for “printing.”
FireWire and USB connections Mac Help and search for “FireWire” or “USB.”
Connecting to the Internet Mac Help and search for “Internet.”
Connecting an external display Mac Help and search for “displayport.”
Apple Remote Mac Help and search for “remote.”
Front Row Mac Help and search for “Front Row.”
Burning a CD or DVD Mac Help and search for “burn disc.”
Specifications The Specifications page at www.apple.com/support/specs. 
Or open System Profiler by choosing Apple (K) > About This 
Mac from the menu bar, and then click More Info.
Apple news, free downloads, 
and online catalogs of 
software and hardware
The Apple website at www.apple.com.
Instructions, technical support, 
and manuals for Apple 
products
The Apple Support website at www.apple.com/support.
To learn about See3
3 Boost Your MacBook Pro
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This chapter provides information and instructions for upgrading the hard disk drive 
and installing additional memory in your MacBook Pro.  
The battery in your MacBook Pro is not user-replaceable. If you think your battery 
needs to be replaced, contact an Apple Retail Store or an Apple Authorized Service 
Provider.
WARNING:  Apple recommends that you have an Apple-certified technician install 
replacement drives and memory. Consult the service and support information that 
came with your computer for information about how to contact Apple for service. If 
you attempt to install a replacement drive or memory and damage your equipment, 
such damage is not covered by the limited warranty on your computer.Chapter 3   Boost Your MacBook Pro 37
Replacing the Hard Disk Drive
You can upgrade the hard disk drive in your MacBook Pro. When you open the back of 
your MacBook Pro, the hard disk drive is located next to the built-in battery. 
The replacement drive must be a 2.5-inch drive with a Serial ATA (SATA) connector.
To replace the hard disk drive in your MacBook Pro:
1 Shut down your MacBook Pro. Disconnect the power adapter, Ethernet cable, USB 
cables, security lock, and any other cables connected to the MacBook Pro to prevent 
damaging the computer. 
2 Turn over your MacBook Pro and remove the ten (10) screws that secure the bottom 
case. Remove the shorter screws at the angles shown in the illustration. Lift off the case 
and place it to the side. 
WARNING:  The internal components of your MacBook Pro can be warm. If you have 
been using your MacBook Pro, wait 10 minutes after shutting down to let the internal 
components cool before continuing.38 Chapter 3   Boost Your MacBook Pro
Important:  Because the screws are different lengths, note the screw lengths and 
locations so you can replace the screws correctly. Put them aside in a safe place.
Important:  When you remove the bottom case, you expose sensitive internal 
components. Avoid touching anything other than the hard drive assembly when you 
remove or add a hard disk drive.
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3 Touch a metal surface inside the computer to discharge any static electricity from your 
body.40 Chapter 3   Boost Your MacBook Pro
4 Locate the bracket at the top of the drive. Use a Phillips screwdriver to loosen the two 
captive screws that hold the bracket in place. Put the bracket aside in a safe place.
5 Using the pull tab, gently lift the drive out of the bay.
Bracket
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6 Hold the drive by its sides and gently pull the connector on the left side of the drive to 
disconnect it.
The connector is attached to a cable and remains in the hard disk drive bay.
Important:  There are four (4) mounting screws on the sides of your hard disk drive. 
If your replacement drive doesn’t include mounting screws, remove the ones from your 
old drive and mount them on the replacement drive before you install it.
7 Attach the connector to the left side of the replacement drive.
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8 Insert the replacement drive at an angle, making sure the mounting screws are seated 
properly.
9 Replace the bracket and tighten the screws. Chapter 3   Boost Your MacBook Pro 43
10 Replace the bottom case. Replace and tighten the ten screws you removed in step 2 in 
their proper locations, making sure to insert the shorter screws at the angles shown in 
the illustration.
For information about installing Mac OS X and bundled applications, see “Reinstalling 
the Software That Came with Your MacBook Pro” on page 60.
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Installing Additional Memory
Your computer has two memory slots that you access by removing the bottom case. 
Your MacBook Pro comes with a minimum of 2 gigabytes (GB) of 1066 MHz Double 
Data Rate (DDR3) Synchronous Dynamic Random-Access Memory (SDRAM) installed. 
Each memory slot can accept an SDRAM module that meets the following 
specifications:
Â Double Data Rate Small Outline Dual Inline Memory Module (DDR3) format
Â 30 mm (1.18 inches)
Â 204-pin
Â 1 GB, 2 GB, or 4 GB
Â PC3-8500 DDR3 SO-DIMM 1066 MHz Type RAM
You can add two 4 GB memory modules for a maximum of 8 GB of memory. For best 
performance, fill both memory slots and install an identical memory module in each 
slot.
To install memory in your MacBook Pro: 
1 Follow steps 1 through 3 beginning on page 37.
Important:  When you remove the bottom case, you expose sensitive internal 
components. Avoid touching anything other than the memory assembly when you 
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2 Push the levers on the sides of the memory module in an outward direction to release 
the module from the memory card slot. 
The memory pops up at an angle. Before removing it, make sure you see the half-circle 
notches. If you don’t, try pushing the levers outward again. 
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3 Hold the memory module by its notches and remove it from the slot. 
4 Remove the other memory module.
Important:  Hold the memory modules by their edges, and do not touch the gold 
connectors.
5 Insert the new memory module in the slot:
a Align the notch on the gold edge of the module with the notch in the lower memory 
slot.
b Tilt the card and push the memory into the slot.
c Use two fingers with firm, even pressure to push down on the memory module. 
You should hear a click when the memory is inserted correctly.
d Repeat to install an additional memory module in the top slot. Press down on the 
module to make sure it is level.Chapter 3   Boost Your MacBook Pro 47
Follow the instructions for replacing the bottom case in step 10 on page 43.
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Making Sure Your MacBook Pro Recognizes the New Memory
After installing additional memory in your MacBook Pro, check whether the computer 
recognizes the new memory. 
To check the computer’s memory:
1 Start up your MacBook Pro.
2 When you see the Mac OS X desktop, choose Apple () > About This Mac.
For a detailed breakdown of the memory installed in your computer, open System 
Profiler by clicking More Info, and then click Memory. 
If your MacBook Pro doesn’t recognize the memory or doesn’t start up correctly, 
confirm that the memory you installed is compatible with your MacBook Pro and that 
it is installed correctly.4
4 Problem, Meet Solution
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Occasionally you may have problems while working with your MacBook Pro. Read on 
for troubleshooting tips to try when you have a problem. You can also find more 
troubleshooting information in Mac Help and on the MacBook Pro Support website at 
www.apple.com/support/macbookpro.
If you experience a problem with your MacBook Pro, there is usually a simple and quick 
solution. Think about the conditions that led up to the problem. Making a note of 
things you did before the problem occurred will help you narrow down possible causes 
and find the answers you need. Things to note include:
Â The applications you were using when the problem occurred. Problems that occur 
only with a specific application might indicate that the application is not compatible 
with the version of the Mac OS installed on your computer.
Â Any new software that you installed, especially software that added items to the 
System folder.
Â Any hardware that you installed, such as additional memory or a peripheral.
Problems That Prevent You from Using Your MacBook Pro
If your MacBook Pro doesn’t respond or the pointer doesn’t move
On rare occasions, an application might “freeze” on the screen. Mac OS X provides a 
way to quit a frozen application without restarting your computer. 
To force an application to quit:
1 Press Command (x)-Option-Esc or choose Apple () > Force Quit from the menu bar.
The Force Quit Applications dialog appears with the application selected.Chapter 4   Problem, Meet Solution 51
2 Click Force Quit.
The application quits, leaving all other applications open.
If you need to, you can also restart the Finder from this dialog.
Next, save your work in any open applications and restart the computer to make sure 
the problem is entirely cleared up. 
If the problem occurs frequently, choose Help > Mac Help from the menu bar at the 
top of the screen. Search for the word “freeze” to get help for times when the computer 
freezes or doesn’t respond.
If the problem occurs only when you use a particular application, check with the 
application’s manufacturer to see if it is compatible with your computer. To get support 
and contact information for the software that came with your MacBook Pro, go to 
www.apple.com/guide.
If you know an application is compatible, you might need to reinstall your computer’s 
system software. See “Reinstalling the Software That Came with Your MacBook Pro” on 
page 60.
If your MacBook Pro freezes during startup, or you see a flashing question mark, or 
the screen is dark and the sleep indicator light is glowing steadily (not in sleep)
The flashing question mark usually means that the computer can’t find the system 
software on the hard disk or any disks attached to the computer. 52 Chapter 4   Problem, Meet Solution
Â Wait a few seconds. If the computer doesn’t soon start up, shut it down by holding 
down the power (®) button for about 8 to 10 seconds. Disconnect all external 
peripherals and try restarting by pressing the power (®) button while holding down 
the Option key. When your computer starts up, click the hard disk icon, and then click 
the right arrow. After the computer starts up, open System Preferences and click 
Startup Disk. Select a local Mac OS X System folder.
Â If that doesn’t work, try using Disk Utility to repair the disk:
Â Insert the Mac OS X Install DVD into your computer. 
Â Restart your computer and hold down the C key as it starts up. 
Â Choose Installer > Open Disk Utility. When Disk Utility opens, follow the instructions 
in the First Aid pane to see if Disk Utility can repair the disk.
If using Disk Utility doesn’t help, you might need to reinstall your computer’s system 
software. See “Reinstalling the Software That Came with Your MacBook Pro” on 
page 60.
If your MacBook Pro doesn’t turn on or start up
Try the following suggestions in order until your computer turns on:
Â Make sure the power adapter is plugged into the computer and into a functioning 
power outlet. Be sure to use the 60W MagSafe Power Adapter that came with your 
MacBook Pro. If the power adapter stops charging and you don’t see the indicator 
light on the power adapter turn on when you plug in the power cord, try unplugging 
and replugging the power cord to reseat it.Chapter 4   Problem, Meet Solution 53
Â Check whether the battery needs to be recharged. Press the small button on the left 
side of your computer. You should see one to eight lights indicating the battery’s 
level of charge. If a single indicator light is on, connect your power adapter to 
recharge. For more information about battery indicator lights, see page 54.
Â If the problem persists, return the computer to its factory settings by disconnecting 
the power adapter and holding down the power (®) button for at least 5 seconds. 
Â If you recently installed additional memory, make sure that it is correctly installed and 
is compatible with your computer. See whether removing it and reinstalling the old 
memory allows the computer to start up (see page 44). 
Â Press the power (®) button and immediately hold down the Command (x), Option, 
P, and R keys simultaneously until you hear the startup sound a second time. This 
resets the parameter RAM (PRAM). 
Â If you still can’t start up your MacBook Pro, see “Learning More, Service, and Support” 
on page 61 for information about contacting Apple for service.
If the screen suddenly goes black or your MacBook Pro freezes
Try restarting your MacBook Pro. 
1 Unplug any devices that are connected to your MacBook Pro, except the power 
adapter.
2 Press the power (®) button to restart the system.
3 Let the battery charge to at least 10 percent before plugging in any external devices 
and resuming your work. 
To see how much the battery has charged, look at the Battery ( ) status icon in the 
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The screen might also darken if you have energy saver features set for the battery.
If an audio device plugged into the audio port isn’t working
Choose Apple () > System Preferences, and open Sound preferences. Specify whether 
you want the port to be used for audio input or audio output. 
Note:  If you’re running Windows on your MacBook Pro, the port supports only audio 
output.
If you press the battery button, and all battery indicator lights flash five times 
quickly
Your battery needs to be replaced. Contact an Apple Retail Store or an Apple 
Authorized Service Provider.
If you press the battery button, and the battery indicator lights flash from left to 
right and then from right to left, five times in a row
Your battery is not recognized. Contact an Apple Retail Store or an Apple Authorized 
Service Provider.
If you forget your password
You can reset your administrator password and passwords for all other accounts.
1 Insert the Mac OS X Install DVD. Then restart your computer and hold down the C key as 
it starts up.
2 Choose Utilities > Reset Password from the menu bar. Follow the onscreen instructions.
If you have trouble ejecting a disc
Quit any applications that might be using the disc and try again. If that doesn’t work, 
restart the computer and then immediately press and hold the trackpad button.Chapter 4   Problem, Meet Solution 55
Using Apple Hardware Test
If you suspect a problem with the MacBook Pro hardware, you can use the Apple 
Hardware Test application to help determine if there is a problem with one of the 
computer’s components, such as the memory or processor. 
To use Apple Hardware Test:
1 Disconnect all external devices from your computer except the power adapter. 
If you have an Ethernet cable connected, disconnect it.
2 Restart your MacBook Pro while holding down the D key.
3 When the Apple Hardware Test chooser screen appears, select the language you want 
to use.
4 Press the Return key or click the right arrow button.
5 When the Apple Hardware Test main screen appears (after about 45 seconds), follow 
the onscreen instructions.
6 If Apple Hardware Test detects a problem, it displays an error code. Make a note of the 
error code before pursuing support options. If Apple Hardware Test doesn’t detect a 
hardware failure, the problem may be software related.
If this procedure doesn’t work, you can insert the Applications Install DVD and hold 
down the D key to use Apple Hardware Test. 56 Chapter 4   Problem, Meet Solution
Problems with Your Internet Connection
Your MacBook Pro has the Network Setup Assistant application to help walk you 
through setting up an Internet connection. Open System Preferences and click 
Network. 
Click the “Assist me” button to open Network Setup Assistant.
If you have trouble with your Internet connection, you can try the steps in this section 
starting with Network Diagnostics.
To use Network Diagnostics:
1 Choose Apple () > System Preferences.
2 Click Network and then click “Assist me.” 
3 Click Diagnostics to open Network Diagnostics.
4 Follow the onscreen instructions.
If Network Diagnostics can’t resolve the problem, there may be a problem with the 
Internet service provider (ISP) you are trying to connect to, with an external device you 
are using to connect to your ISP, or with the server you are trying to access. You can try 
the following steps.
Cable Modem, DSL, and LAN Internet Connections
Make sure all modem cables are fully plugged in. Check the modem power cord, 
the cable from the modem to the computer, and the cable from the modem to the 
wall jack. Also check the cables and power supplies for Ethernet hubs and routers. Chapter 4   Problem, Meet Solution 57
Turn the modem off and on to reset the modem hardware
Turn off your DSL or cable modem for a few minutes, and then turn it back on. 
Some ISPs recommend that you unplug the modem’s power cord. If your modem has a 
reset button, you can press it either before or after you turn the power off and on.
Important:  Instructions that refer to modems do not apply to LAN users. LAN users 
might have hubs, switches, routers, or connection pods that DSL and cable modem 
users do not have. LAN users should contact their network administrator rather than 
an ISP.
PPPoE Connections 
If you are unable to connect to your Internet service provider using PPPoE (Point to 
Point Protocol over Ethernet), make sure you have entered the correct information in 
Network preferences. 
To check PPPoE settings:
1 Choose Apple () > System Preferences.
2 Click Network.
3 Click Add (+) at the bottom of the network connection services list, and choose PPPoE 
from the Interface pop-up menu. 
4 Choose an interface for the PPPoE service from the Ethernet pop-up menu. Choose 
Ethernet if you are connecting to a wired network, or AirPort if you are connecting to a 
wireless network.
5 Enter the information you received from your service provider, such as the account 
name, password, and PPPoE service name (if your service provider requires it). 
6 Click Apply to make the settings active.58 Chapter 4   Problem, Meet Solution
Network Connections
Make sure the Ethernet cable is connected to your MacBook Pro and to the network. 
Check the cables and power supplies to your Ethernet hubs and routers.
If you have two or more computers sharing an Internet connection, be sure that your 
network is set up properly. You need to know if your ISP provides only one IP address 
or if it provides multiple IP addresses, one for each computer.
If only one IP address is provided, then you must have a router capable of sharing the 
connection, also known as network address translation (NAT) or “IP masquerading.” 
For setup information, check the documentation provided with your router or ask the 
person who set up your network. You can use an AirPort Base Station to share one 
IP address among multiple computers. For information about using an AirPort Base 
Station, check Mac Help or go to the Apple AirPort website at 
www.apple.com/support/airport.
If you cannot resolve the issue using these steps, contact your ISP or network 
administrator.
Problems with AirPort Extreme Wireless Communication
If you have trouble using AirPort Extreme wireless communication:
Â Make sure the computer or network you are trying to connect to is running and has a 
wireless access point.
Â Make sure you have properly configured the software according to the instructions 
that came with your base station or access point.Chapter 4   Problem, Meet Solution 59
Â Make sure you are within antenna range of the other computer or the network’s 
access point. Nearby electronic devices or metal structures can interfere with wireless 
communication and reduce this range. Repositioning or rotating the computer might 
improve reception.
Â Check the AirPort (Z) status icon in the menu bar. Up to four bars appear, indicating 
signal strength. If the signal strength is weak, try changing your location.
Â See AirPort Help (choose Help > Mac Help, and then choose Library > AirPort Help 
from the menu bar). Also see the instructions that came with the wireless device for 
more information.
Keeping Your Software Up to Date
You can connect to the Internet and automatically download and install the latest free 
software versions, drivers, and other enhancements from Apple. 
When you’re connected to the Internet, Software Update checks to see if any updates 
are available for your computer. You can set your MacBook Pro to check for updates 
periodically, and then you can download and install updated software.
To check for updated software:
1 Open System Preferences. 
2 Click the Software Update icon and follow the onscreen instructions.
Â For more information, search for “Software Update” in Mac Help. 
Â For the latest information about Mac OS X, go to www.apple.com/macosx.60 Chapter 4   Problem, Meet Solution
Reinstalling the Software That Came with Your MacBook Pro
You can use the software installation discs that came with your computer to reinstall 
Mac OS X and any applications that came with your computer. You can choose “Archive 
and Install,” which saves your existing files and settings, or “Erase and Install,” which 
erases all your data.
Important:  Apple recommends that you back up the data on your hard disk before 
restoring software. Because the “Erase and Install” option erases your hard disk, you 
should back up your essential files before installing Mac OS X and other applications. 
Apple is not responsible for any lost data. 
Installing Mac OS X
To install Mac OS X:
1 Back up your essential files.
2 Make sure your power adapter is connected and plugged in.
3 Insert the Mac OS X Install DVD that came with your computer.
4 Double-click Install Mac OS X. 
5 Follow the onscreen instructions.
Note:  To restore Mac OS X on your computer to the original factory settings, click 
Options in the “Select a Destination” pane of the Installer, and then select “Erase and 
Install.” If you choose “Erase and Install,” you’ll see a message reminding you to use the 
Applications Install DVD to reinstall the bundled applications that came with your 
computer.
6 When the installation is complete, click Restart to restart your computer. 
7 Follow the prompts in the Setup Assistant to set up your user account.Chapter 4   Problem, Meet Solution 61
Installing Applications
If you reinstall Mac OS X on your computer and select the “Erase and Install” option, 
you must reinstall the applications that came with your computer, such as the iLife 
applications.
To install the applications that came with your computer:
1 Make sure your power adapter is connected and plugged in.
2 Insert the Applications Install DVD that came with your computer.
3 Double-click Install Bundled Software. 
4 Follow the onscreen instructions.
5 When the installation is complete, click Close.
Learning More, Service, and Support
Your MacBook Pro does not have any user-serviceable parts, except the hard drive and 
the memory. If you need service, contact Apple or take your MacBook Pro to an Apple 
Authorized Service Provider. You can find more information about the MacBook Pro 
through online resources, onscreen help, System Profiler, or Apple Hardware Test.
Online Resources
For online service and support information, go to www.apple.com/support. Choose 
your country from the pop-up menu. You can search the AppleCare Knowledge Base, 
check for software updates, or get help from Apple’s discussion forums. 
Onscreen Help
You can look for answers to your questions, as well as instructions and troubleshooting 
information, in Mac Help. Choose Help > Mac Help.62 Chapter 4   Problem, Meet Solution
System Profiler
To get information about your MacBook Pro, use System Profiler. It shows you what 
hardware and software is installed, the serial number and operating system 
version, how much memory is installed, and more. To open System Profiler, 
choose Apple () > About This Mac from the menu bar and then click More Info.
AppleCare Service and Support
Your MacBook Pro comes with 90 days of technical support and one year of hardware 
repair warranty coverage at an Apple Store retail location or an Apple-authorized 
repair center, such as an Apple Authorized Service Provider. You can extend your 
coverage by purchasing the AppleCare Protection Plan. For information, go to 
www.apple.com/support/products or the website for your country listed below.
If you need assistance, AppleCare telephone support representatives can help you with 
installing and opening applications, and basic troubleshooting. Call the support center 
number nearest you (the first 90 days are complimentary). Have the purchase date and 
your MacBook Pro serial number ready when you call.Chapter 4   Problem, Meet Solution 63
Note:  Your 90 days of complimentary telephone support begins on the date of 
purchase. Telephone fees may apply. 
Telephone numbers are subject to change, and local and national telephone rates may 
apply. A complete list is available on the web:
Country Phone Website
United States 1-800-275-2273 www.apple.com/support
Australia (61) 1-300-321-456 www.apple.com/au/support
Canada (English)
(French)
1-800-263-3394 www.apple.com/ca/support
www.apple.com/ca/fr/support
Ireland (353) 1850 946 191 www.apple.com/ie/support
New Zealand 00800-7666-7666 www.apple.com/nz/support
United Kingdom (44) 0870 876 0753 www.apple.com/uk/support
www.apple.com/contact/phone_contacts.html www.apple.com/contact/phone_contacts.html64 Chapter 4   Problem, Meet Solution
Locating Your Product Serial Number
Use one of these methods to find your computer’s serial number:
Â Turn over your MacBook Pro. The serial number is etched into the case near the 
hinge. 
Â Choose Apple () > About This Mac. Click the version number beneath the words 
“Mac OS X” to cycle through the Mac OS X version number, the build version, and the 
serial number. 
Â Click the Finder icon and open /Applications/Utilities/System Profiler. Click Hardware 
in the Contents pane.
Serial number5
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For your safety and that of your equipment, follow these rules for handling and 
cleaning your MacBook Pro and for working more comfortably. Keep these instructions 
handy for reference by you and others.
Important Safety Information
Built-in battery  Do not remove the battery from your MacBook Pro. The battery 
should be replaced only by an Apple Authorized Service Provider. Discontinue use of 
your MacBook Pro if it is dropped or appears crushed, bent, deformed, or damaged. Do 
not expose the computer to temperatures above 212° F or 100° C. 
Proper handling  Set up your MacBook Pro on a stable work surface that allows for 
adequate air circulation under and around the computer. Do not operate your 
MacBook Pro on a pillow or other soft material, because the material can block the 
airflow vents. Never place anything over the keyboard when operating your 
MacBook Pro. Never push objects into the ventilation openings.
The bottom of your MacBook Pro may become very warm during normal use. If your 
MacBook Pro is on your lap and gets uncomfortably warm, move it to a stable work 
surface.
Water and wet locations  Keep your MacBook Pro away from sources of liquid, such as 
drinks, washbasins, bathtubs, shower stalls, and so on. Protect your MacBook Pro from 
dampness or wet weather, such as rain, snow, and fog.
WARNING:  Failure to follow these safety instructions could result in fire, electric 
shock, or other injury or damage.Chapter 5   Last, but Not Least 67
60W MagSafe Power Adapter  Make sure the AC plug or AC power cord is fully 
inserted into the power adapter before plugging the adapter into a power outlet. Use 
only the power adapter that came with your MacBook Pro, or an Apple-authorized 
power adapter that is compatible with this product. The power adapter may become 
very warm during normal use. Always put the power adapter directly into a power 
outlet, or place it on the floor in a well-ventilated location.
Disconnect the power adapter and disconnect any other cables if any of the following 
conditions exists:
Â You want to add memory or upgrade the hard disk drive.
Â You want to clean the case (use only the recommended procedure described on 
page 71).
Â The power cord or plug becomes frayed or otherwise damaged.
Â Your MacBook Pro or power adapter is exposed to rain, excessive moisture, or liquid 
spilled into the case.
Â Your MacBook Pro or power adapter has been dropped, the case has been damaged, 
or you suspect that service or repair is required.
The MagSafe power port contains a magnet that can erase data on a credit card, iPod, 
or other device. To preserve your data, do not place these or other magnetically 
sensitive material or devices within 1 inch (25 mm) of this port.
If debris gets into the MagSafe power port, remove it gently with a dry cotton swab.68 Chapter 5   Last, but Not Least
MagSafe power specifications:
Â Frequency:  50 to 60 Hz, single phase
Â Line Voltage:  100 to 240 V
Â Output Voltage:  16.5 V DC, 3.65 A
Hearing damage  Permanent hearing loss may occur if earbuds or headphones are 
used at high volume. You can adapt over time to a higher volume of sound that may 
sound normal but can be damaging to your hearing. If you experience ringing in your 
ears or muffled speech, stop listening and have your hearing checked. The louder the 
volume, the less time is required before your hearing could be affected. Hearing 
experts suggest that to protect your hearing:
Â Limit the amount of time you use earbuds or headphones at high volume.
Â Avoid turning up the volume to block out noisy surroundings. 
Â Turn the volume down if you can’t hear people speaking near you.
High-risk activities  This computer is not intended for use in the operation of nuclear 
facilities, aircraft navigation or communications systems, air traffic control systems, or 
for any other uses where the failure of the computer could lead to death, personal 
injury, or severe environmental damage.Chapter 5   Last, but Not Least 69
Laser Information for Optical Disc Drives
The optical disc drive in your computer contains a laser that is safe in normal use but 
that may be harmful to your eyes if disassembled. For your safety, have this equipment 
serviced only by an Apple Authorized Service Provider. 
Important Handling Information
Operating environment  Operating your MacBook Pro outside these ranges may affect 
performance:
Â Operating temperature:  50° to 95° F (10° to 35° C)
Â Storage temperature:  -4° to 113° F (-20° to 45° C)
Â Relative humidity:  5% to 90% (noncondensing)
Â Operating altitude:  0 to 10,000 feet (0 to 3048 meters)
Turning on your MacBook Pro  Never turn on your MacBook Pro unless all of its 
internal and external parts are in place. Operating the computer when parts are 
missing may be dangerous and may damage your computer.
WARNING:  Making adjustments or performing procedures other than those specified 
in your equipment’s manual may result in hazardous radiation exposure. 
NOTICE:  Failure to follow these handling instructions could result in damage to your 
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Carrying your MacBook Pro  If you carry your MacBook Pro in a bag or briefcase, make 
sure that there are no loose items (such as paper clips or coins) that could accidentally 
get inside the computer through vent openings or the optical drive slot or get stuck 
inside a port. Also, keep magnetically sensitive items away from the MagSafe power 
port. 
Using connectors and ports  Never force a connector into a port. When connecting a 
device, make sure the port is free of debris, that the connector matches the port, and 
that you have positioned the connector correctly in relation to the port.
Using the optical drive  The SuperDrive in your MacBook Pro supports standard 12 cm 
(4.7 inch) discs. Irregularly shaped discs or discs smaller than 12 cm (4.7 inches) are not 
supported and can become lodged in the drive.
Handling glass parts  Your MacBook Pro contains glass components, including the 
display and trackpad. If they are damaged, don't use your MacBook Pro until it has 
been repaired by an Apple Authorized Service Provider.Chapter 5   Last, but Not Least 71
Storing your MacBook Pro  If you are going to store your MacBook Pro for an 
extended period of time, keep it in a cool location (ideally, 71° F or 22° C) and discharge 
the battery to approximately 50 percent. To maintain the capacity of the battery, 
recharge the battery to 50 percent every six months or so.
Cleaning your MacBook Pro  When cleaning the outside of your MacBook Pro and its 
components, first shut down your MacBook Pro and unplug the power adapter. Then 
use a damp, soft, lint-free cloth to clean the computer’s exterior. Avoid getting 
moisture in any openings. Do not spray liquid directly on the computer. Do not use 
aerosol sprays, solvents, or abrasives that might damage the finish.
Cleaning the MacBook Pro screen  To clean the MacBook Pro screen, first shut down 
your MacBook Pro and unplug the power adapter. Then dampen the included cleaning 
cloth with just water and wipe the screen. Do not spray liquid directly on the screen.72 Chapter 5   Last, but Not Least
Understanding Ergonomics
Here are some tips for setting up a healthy work environment.
Keyboard and Trackpad
When you use the keyboard and trackpad, your shoulders should be relaxed. Your 
upper arm and forearm should form an angle that is slightly greater than a right angle, 
with your wrist and hand in roughly a straight line.
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Use a light touch when typing or using the trackpad and keep your hands and fingers 
relaxed. Avoid rolling your thumbs under your palms.
Change hand positions often to avoid fatigue. Some computer users might develop 
discomfort in their hands, wrists, or arms after intensive work without breaks. If you 
begin to develop chronic pain or discomfort in your hands, wrists, or arms, consult a 
qualified health specialist.
External Mouse
If you use an external mouse, position the mouse at the same height as the keyboard 
and within comfortable reach.
Chair
An adjustable chair that provides firm, comfortable support is best. Adjust the height 
of the chair so your thighs are horizontal and your feet are flat on the floor. The back of 
the chair should support your lower back (lumbar region). Follow the manufacturer’s 
instructions for adjusting the backrest to fit your body properly.
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You might have to raise your chair so that your forearms and hands are at the proper 
angle to the keyboard. If this makes it impossible to rest your feet flat on the floor, 
you can use a footrest with adjustable height and tilt to make up for any gap between 
the floor and your feet. Or you can lower the desktop to eliminate the need for a 
footrest. Another option is to use a desk with a keyboard tray that’s lower than the 
regular work surface.
Built-in Display
Adjust the angle of the display to minimize glare and reflections from overhead lights 
and windows. Do not force the display if you meet resistance. The display is not meant 
to open past 130 degrees.
You can adjust the brightness of the screen when you take the computer from one 
work location to another, or if the lighting in your work area changes.
More information about ergonomics is available on the web: 
Apple and the Environment
Apple Inc. recognizes its responsibility to minimize the environmental impacts of its 
operations and products. 
More information is available on the web:
www.apple.com/about/ergonomics
www.apple.com/environment76
Regulatory Compliance Information
FCC Compliance Statement
This device complies with part 15 of the FCC rules. 
Operation is subject to the following two conditions:  (1) 
This device may not cause harmful interference, and (2) 
this device must accept any interference received, 
including interference that may cause undesired 
operation. See instructions if interference to radio or 
television reception is suspected.
L‘utilisation de ce dispositif est autorisée seulement aux 
conditions suivantes: (1) il ne doit pas produire de 
brouillage et (2) l’utilisateur du dispositif doit étre prêt à 
accepter tout brouillage radioélectrique reçu, même si 
ce brouillage est susceptible de compromettre le 
fonctionnement du dispositif.
Radio and Television Interference
This computer equipment generates, uses, and can 
radiate radio-frequency energy. If it is not installed and 
used properly—that is, in strict accordance with Apple’s 
instructions—it may cause interference with radio and 
television reception. 
This equipment has been tested and found to comply 
with the limits for a Class B digital device in accordance 
with the specifications in Part 15 of FCC rules. These 
specifications are designed to provide reasonable 
protection against such interference in a residential 
installation. However, there is no guarantee that 
interference will not occur in a particular installation. 
You can determine whether your computer system is 
causing interference by turning it off. If the interference 
stops, it was probably caused by the computer or one of 
the peripheral devices. 
If your computer system does cause interference to 
radio or television reception, try to correct the 
interference by using one or more of the following 
measures:
Â Turn the television or radio antenna until the 
interference stops. 
Â Move the computer to one side or the other of the 
television or radio. 
Â Move the computer farther away from the television 
or radio. 
Â Plug the computer in to an outlet that is on a different 
circuit from the television or radio. (That is, make 
certain the computer and the television or radio are on 
circuits controlled by different circuit breakers or 
fuses.) 
If necessary, consult an Apple Authorized Service 
Provider or Apple. See the service and support 
information that came with your Apple product. 
Or consult an experienced radio/television technician 
for additional suggestions. 
Important:  Changes or modifications to this product 
not authorized by Apple Inc. could void the EMC 
compliance and negate your authority to operate the 
product.
This product has demonstrated EMC compliance under 
conditions that included the use of compliant peripheral 
devices and shielded cables (including Ethernet network 
cables) between system components. It is important 
that you use compliant peripheral devices and shielded 
cables between system components to reduce the 
possibility of causing interference to radios, television 
sets, and other electronic devices.77
Responsible party (contact for FCC matters only):  
Apple Inc. Corporate Compliance
1 Infinite Loop, MS 26-A
Cupertino, CA 95014
Wireless Radio Use
This device is restricted to indoor use when operating in 
the 5.15 to 5.25 GHz frequency band.
Cet appareil doit être utilisé à l’intérieur.
Exposure to Radio Frequency Energy
The radiated output power of the AirPort Extreme 
technology is below the FCC radio frequency exposure 
limits. Nevertheless, it is advised to use the wireless 
equipment in such a manner that the potential for 
human contact during normal operation is minimized.
FCC Bluetooth Wireless Compliance
The antenna used with this transmitter must not be 
colocated or operated in conjunction with any other 
antenna or transmitter subject to the conditions of the 
FCC Grant.
Bluetooth Industry Canada Statement
This Class B device meets all requirements of the 
Canadian interference-causing equipment regulations.
Cet appareil numérique de la Class B respecte toutes les 
exigences du Règlement sur le matériel brouilleur 
du Canada.
Industry Canada Statement
Complies with the Canadian ICES-003 Class B 
specifications. Cet appareil numérique de la classe B est 
conforme à la norme NMB-003 du Canada. This device 
complies with RSS 210 of Industry Canada.
Bluetooth Europe—EU Declaration of 
Conformity
This wireless device complies with the R&TTE Directive.
Europe—EU Declaration of Conformity
The equipment complies with the RF Exposure 
Requirement 1999/519/EC, Council Recommendation of 
12 July 1999 on the limitation of exposure of the general 
public to electromagnetic fields (0 Hz to 300 GHz). 
Hereby, Apple Inc. declares that this 802.11a/b/g/n 
Mini-PCIe card is in compliance with the R&TTE 
Directive.
Complies with European Low Voltage and EMC 
Directives.
See: www.apple.com/euro/compliance
Korea Warning Statements
Singapore Wireless Certification
Taiwan Wireless Statements78
Taiwan Class B Statement
VCCI Class B Statement
Russia
External USB Modem Information
When connecting your MacBook Pro to the phone line 
using an external USB modem, refer to the 
telecommunications agency information in the 
documentation that came with your modem.
ENERGY STAR®
 Compliance
As an ENERGY STAR®
 partner, Apple has determined 
that standard configurations of this product meet the 
ENERGY STAR®
 guidelines for energy efficiency. The 
ENERGY STAR®
 program is a partnership with electronic 
equipment manufacturers to promote energy-efficient 
products. Reducing energy consumption of products 
saves money and helps conserve valuable resources. 
This computer is shipped with power management 
enabled with the computer set to sleep after 10 minutes 
of user inactivity. To wake your computer, click the 
mouse or trackpad button or press any key on the 
keyboard. 
For more information about ENERGY STAR®, visit: 
www.energystar.gov79
Disposal and Recycling Information
This symbol indicates that your product must be 
disposed of properly according to local laws and 
regulations. When your product reaches its end of life, 
contact Apple or your local authorities to learn about 
recycling options.
For information about Apple’s recycling program, go to 
www.apple.com/environment/recycling.
Battery Disposal Information
Dispose of batteries according to your local 
environmental laws and guidelines.
California:  The coin cell battery in the optional Apple 
Remote contains perchlorates. Special handling and 
disposal may apply. Refer to:
www.dtsc.ca.gov/hazardouswaste/perchlorate
Deutschland:  Das Gerät enthält Batterien. Diese 
gehören nicht in den Hausmüll. Sie können verbrauchte 
Batterien beim Handel oder bei den Kommunen 
unentgeltlich abgeben. Um Kurzschlüsse zu vermeiden, 
kleben Sie die Pole der Batterien vorsorglich mit einem 
Klebestreifen ab.
Nederlands:  Gebruikte batterijen kunnen worden 
ingeleverd bij de chemokar of in een speciale 
batterijcontainer voor klein chemisch afval (kca) worden 
gedeponeerd.80
Taiwan:
European Union—Disposal Information:  
The symbol above means that according to local laws 
and regulations your product should be disposed of 
separately from household waste. When this product 
reaches its end of life, take it to a collection point 
designated by local authorities. Some collection points 
accept products for free. The separate collection and 
recycling of your product at the time of disposal will 
help conserve natural resources and ensure that it is 
recycled in a manner that protects human health and 
the environment.Looking for Something?82 Looking for Something?
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Préface
Introduction aux Systèmes TDM
En général, les workstations audio-numériques utilisent 
une de ces deux approches pour la phase de traitement 
du signal audio : usage des équipements DSP dédiés 
(systèmes TDM), ou des capacités de traitement natives 
de l’unité centrale de l’ordinateur.
Logic Pro permet d’utiliser les deux en conjonction : vos DSP basés sur le système TDM 
et les ressources de traitement natives de l’unité de centrale de l’ordinateur. 
Le lien entre le monde DSP et votre système TDM d’une part, avec la puissance de calcul de l’unité de centrale de l’ordinateur d’autre part, est nommé ESB TDM (Emagic System Bridge TDM).
Cet ESB TDM permet à l’unité de centrale de votre ordinateur de gérer les calculs d’un 
moteur audio (Direct TDM), et au DSP de l’équipement TDM d’en gérer un autre (DAE). 
Ceci grâce à l’utilisation de deux consoles différentes dans l’Environnement de Logic : 
Une console TDM (utilisant le DAE) et une console native (appelée console DTDM). La 
première gère les plug-ins TDM, alors que l’autre s’occupe des plug-ins natifs aux formats Audio Unit et Logic. 
Un maximum de huit sorties de console DTDM peut être affecté à la console TDM. Les 
signaux de sortie sont reçus par les entrées virtuelles ESB TDM—choisies comme 
entrées sur les Objets Aux TDM. Ceci permet l’utilisation de toutes les pistes Logic, de 
tous les plug-ins natifs et Audio Unit—dont les instruments logiciels—en conjonction 
avec le DSP du système TDM. 
La sortie des consoles TDM s’effectue via le matériel TDM Digidesign connecté. 
À propos de ce Guide
Ce guide vous présente tout “ce que vous devez savoir” pour que votre équipement 
TDM fonctionne avec Logic Pro. 
Nous allons vous présenter l’ESB TDM et l’EXS24 TDM, dont le rôle est d’étendre et amé-
liorer la flexibilité de votre système de production Logic et DAE/TDM.6 Préface    Introduction aux Systèmes TDM
De plus, vous apprendrez aussi à importer et exporter de l’audio entre les logiciels 
Logic et Pro Tools.
Nous supposons que vous avez connaissance des concepts généraux des DAW (Digital 
Audio Workstations) et des opérations informatiques de base.
Nous supposons également que vous avez connecté votre système TDM à votre Macintosh, et avez installé (et testé) le logiciel Pro Tools. Un système ProTools correctement 
installé et opérationnel assurera un système Logic Pro/DAE fiable.
Note :  Veuillez lire attentivement et respecter les instructions de votre manuel d’installation ProTools Digidesign. 
La connexion de votre interface MIDI avec tout synthétiseur ou module MIDI externe 
est également supposée être en mesure de fonctionner correctement. 
L’usage des fonctions de Logic Pro est abordé dans le Guide de Référence et le système d’Aide en Ligne—accessible depuis le menu Aide de Logic Pro.
Conventions utilisées dans ce Guide…
Avant de commencer, nous aimerions parler des conventions utilisées dans ce Guide.
Fonctions des Menus
Pour les fonctions accessibles via des menus hiérarchiques, les différents niveaux de 
menus sont présentés comme ceci : Menu > Option de Menu > Fonction.
Mentions importantes
Certains textes seront écrits comme ceci :
Important :  Informations sur une fonction ou un paramètre.
Ces mentions abordent un concept-clé ou des informations techniques devant être respectées ou prises en compte. Veuillez leur accorder une attention particulière.
Remarques
Certaines sections apportent des informations ou des conseils supplémentaires qui 
vous aideront à mieux utiliser le plug-in d’effet ou d’instrument. Ils sont écrits comme 
indiqué ci-dessous :
Note :  Informations sur une fonction ou un paramètre.
Raccourcis clavier
De nombreuses fonctions de Logic peuvent être activées ou sont accessibles à l’aide de 
raccourcis clavier—combinaisons de touches de l’ordinateur ou contrôleur MIDI. Les 
raccourcis clavier mentionnés dans ce guide sont basés sur le Jeu de Raccourcis Clavier 
par défaut, assigné par Assistant de Configuration Logic. 1
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1 Matériel et pilotes audio
Ce chapitre contient des informations nécessaires pour 
l’installation de Logic avec un matériel TDM. 
Dans la première partie, nous allons vous présenter le matériel TDM pouvant être utilisé avec Logic Pro et les pilotes (drivers) nécessaires à ce matériel. Vous trouverez 
ensuite des informations sur tous les réglages des pilotes appropriés. La dernière partie est consacrée à l’adaptation des morceaux ayant été produits sur différents équipements. 
Installation du matériel
Pour que Logic fonctionne sans problèmes, il faut une installation et une configuration 
correctes de la carte audio et des pilotes. Veuillez vous reporter à la documentation 
accompagnant votre carte audio pour configurer votre ordinateur et votre matériel afin 
d’obtenir des performances optimales.
Logic Pro est compatible avec tous les matériels audio disposant d’un pilote Core 
Audio, et avec tous les matériels Digidesign TDM fonctionnant avec DAE sous 
Mac OS X.
Vous pouvez aussi utilisez vos interfaces audio TDM en faisant usage de Core Audio. Ce 
peut être très bénéfique dans certains cases, si vous désirez ouvrir des morceaux créés 
sur des moteurs audio natifs. 
Nous allons tout d’abord nous concentrer sur la configuration du matériel compatible 
Digidesign TDM dans ce guide, mais nous couvrirons aussi les réglages appropriés au 
matériel Core Audio. Ces informations peuvent s’avérer utiles si vous désirez combiner 
à la fois le moteur natif et le moteur TDM de Logic, et faire usage d’un périphérique 
Core Audio en conjonction avec votre matériel TDM.
L’usage simultané de plusieurs cartes audio est utile pour augmenter le nombre 
d’entrées et de sorties, par exemple. En fonction de la puissance de l’ordinateur et du 
matériel audio connecté, ceci peut augmenter le nombre de pistes audio stéréo jusqu’à 
255 !8 Chapitre 1    Matériel et pilotes audio
Pilotes
Tous les équipements audio nécessitent un pilote (ou driver), qui agit comme agent de 
communication avec le logiciel Logic. Pour utiliser un matériel particulier, son ou ses 
pilotes doivent être activés.
La sélection et l’activation d’un périphérique audio spécifique s’effectue directement 
dans Logic, via les dialogues Audio > Hardware Audio et Pilotes. Normalement Logic 
reconnaît automatiquement tout matériel Core audio installé, et utilise un ensemble de 
réglages par défaut pour celui-ci—défini dans le tableau de bord Audio MIDI Setup. Toutefois, il peut être intéressant d’optimiser ces réglages pour votre configuration particulière, surtout si vous utilisez plusieurs cartes audio ou une carte munie de plusieurs 
entrées/sorties. 
Vous aurez alors à affiner les réglages du matériel audio.
Vous avez le choix entre les panneaux Core Audio, DAE et Direct TDM dans les préférences des pilotes de Logic. 
Core Audio
Le panneau Core Audio fait référence aux entrées et sorties audio internes de votre Mac, 
ou de tout autre matériel audio utilisant des pilotes Core Audio. Les paramètres du 
pilote Core Audio sont décrits dans le § “Paramètres Core Audio et Direct TDM” à la 
page 9.
DAE
DAE est l’abréviation de Digidesign Audio Engine (“moteur audio Digidesign”). Ce logiciel sert de pilote à de nombreuses cartes Digidesign, et son rôle principal est de faire 
fonctionner tout le matériel TDM et/ou d’accéder aux circuits DSP qu’elles hébergent. 
La carte Digidesign suivante est actuellement compatible avec Logic Pro via le DAE :
• ProTools HD Accel/HD/MIX/24/MIX
Les carte Digidesign suivantes sont incompatibles avec Logic Pro via le DAE :
• AudioMedia III, Digi001, M Box, Digi002 et 002R
Il est préférable d’exploiter ces cartes comme cartes d’entrée/sortie “pures”, par l’intermédiaire d’un pilote Core Audio.
Vous trouverez davantage d’informations sur les paramètres DAE au § “Paramètres 
DAE” à la page 12.
Direct TDM
Pour utiliser le DirectTDM, il faut un des périphériques TDM mentionnés ci-dessus de 
Digidesign, et l’ESB TDM (Emagic System Bridge TDM).
ESB TDM—fourni avec Logic Pro—relie la moteur audio natif DTDM au DAE.Chapitre 1    Matériel et pilotes audio 9
L’unité centrale de votre ordinateur peut alors effectuer divers traitements ou tâches 
dans la console de mixage DTDM native” de Logic : lecture de pistes audio, utilisation 
d’Instruments logiciels tels que ceux intégrés à Logic, plus les Instruments Audio Unit 
et des plug-ins d’effets. 
Vous pouvez envoyer dans votre console TDM jusqu’à 8 flux numériques audio émanant de cette console “native”, afin de leur faire subir d’autres traitements via des plugins TDM.
Les paramètres du pilote DirectTDM sont décrits dans le § “Paramètres Core Audio et 
Direct TDM”. Vous en saurez plus en lisant le § “ESB TDM” à la page 24.
Note :  Si vous maintenez la touche Contrôle lorsque vous démarrez Logic, un dialogue 
apparaît, vous permettant de désactiver séparément un pilote ou tous les pilotes audio, 
pour ce lancement particulier du programme. Vous pourrez ainsi démarrer Logic plus 
rapidement sans les pilotes audio, si vous désirez l’utiliser uniquement comme un 
séquenceur MIDI.
Note :  Il est bon de visiter régulièrement les pages web Digidesign (et celles du fabricant de votre matériel audio si vous utilisez d’autres périphériques Core Audio), afin 
d’avoir toujours les derniers pilotes. Le site web d’un fabricant est souvent une bonne 
source d’informations sur les pilotes disponibles, les problèmes de compatibilité et les 
conseils de dépannage.
Paramètres Core Audio et Direct TDM
Core Audio et Direct TDM ont les paramètres suivants en commun :
Taille du Buffer d’E/S 
Détermine la taille du buffer utilisé par le matériel audio pour l’entrée et la sortie. Les 
choix vont de 1024 à 32 samples (échantillons). Plus la taille du buffer est petite, moins 
vous aurez de “latence” lors du monitoring pendant un enregistrement, ou lors de l’utilisation d’instruments logiciels. 
Note :  Il peut arriver que la taille Taille du Buffer d’E/S choisie soit trop petite pour votre 
système, ce qui affecte la lecture, habituellement sous la forme de clics et de craquements. Vous devez alors chercher à obtenir la plus petite valeur possible pour la Taille 
du Buffer d’E/S avec laquelle vous n’aurez pas de genre d’inconvénients.
Mais plus la valeur de ce paramètre est réduite, plus l’unité centrale du système sera sollicitée. Sur les modèles de Macintosh actuels, vous devez pouvoir réduire cette valeur à 
son minimum. Un conseil : si vous trouvez qu’un réglage plus élevé de la Taille du Buffer 
d’E/S (plus grand) donne une latence suffisamment faible pendant le monitoring d’un 
enregistrement et la lecture d’un instrument logiciel, utilisez-la. Ceci réduit l’impact sur la 
(ou les) CPU(s) de votre système. Vous pouvez essayer d’utiliser un réglage plus faible lors 
de l’enregistrement (latence plus faible) et augmenter la valeur Taille du Buffer d’E/S pour 
une meilleure stabilité générale lors de l’édition ou du mixage (Bounce).10 Chapitre 1    Matériel et pilotes audio
Délai d’enregistrement
Ce paramètre, mesuré en samples (échantillons), permet de retarder l’enregistrement 
des Régions Audio d’une certaine durée fixe. Ce qui aide à compenser (lors d’une utilisation complexe) le retard qui peut être causé par une information de délai incorrecte 
fournie par le pilote. Normalement vous n’avez pas à vous soucier de ce paramètre.
Nombre de pistes audio maximum
Le Moteur Audio nécessite qu’il y ait de la mémoire système libre, qui ne sera assignée 
ni à Logic, ni à une autre application. La quantité de mémoire nécessaire dépend :
• du nombre maximal de pistes à lire, 
• du nombre de voies d’entrées/sorties fournies par pilote. 
Ce réglage permet de réduire la quantité de mémoire demandée par le pilote, en 
réduisant le nombre de pistes. Ceci peut être particulièrement utile si vous voulez utiliser d’autres applications ou pilotes simultanément. Les valeurs vont de 4 à 255 pistes.
Lorsque vous modifier la valeur Nombre de pistes audio maximum en faisant glisser le 
curseur vers la gauche ou la droite, la valeur Mémoire Système nécessaire est mise à jour 
en temps réel.
64 Bus
Cette case permet d’utiliser un maximum de 64 Objets Bus. Logic Pro restreint normalement le nombre d’Objets Bus à 32. SI vous désirez en créer davantage, cochez cette 
case et ajoutez les Objets désirés.
Mode Piste Universel
Si le Mode Piste Universel est activé vous pouvez relire des régions mono et stéréo sur 
une même piste. Les objets audio pairs ne seront pas considérés comme le canal droit 
des objets audio stéréo impairs situés à leur gauche, et chaque objet audio disposera 
de son propre bouton Mono/Stéréo. Selon que la région relue sera mono ou stéréo, le 
potentiomètre de panoramique se comportera comme un contrôleur de balance ou de 
panoramique. Si vous relisez une région mono et que le pan se trouve en position centrale, les deux canaux de l’objet audio délivreront le même niveau.
Note :  Le Mode Piste Universel dispose de possibilités de routage limitées, et il n’est 
pas possible de gérer séparément les canaux audio gauche et droit. 
Le Mode “Non-Piste Universel” est un mode pratique pour relire des fichiers mono diffé-
rents pour les canaux mono gauche et droit d’un objet audio, même si cet objet est 
connecté pour former une piste stéréo. Un plug-in stéréo/stéréo inséré sur cette piste 
stéréo jumelée recevra des signaux gauche et droit différents.Chapitre 1    Matériel et pilotes audio 11
Important :  Si vous souhaitez changer de pistes pour ou depuis le DAE/TDM, gardez le 
Mode Piste Universel désactivé en permanence. N’oubliez pas qu’à l’heure actuelle, le 
DAE/TDM ne fonctionne pas avec des fichiers entrelacés. Si vos pistes doivent alterner 
entre le DAE/TDM et d’autres systèmes, il vous faut utiliser des fichiers stéréo séparés 
(split stereo). Pour cela, cochez l’option suivante : Préférences > Audio > Général > Forcer 
l’enregistrement et la conversion des fichiers entrelacés en split stéréo.
Veuillez relancer Logic après avoir changé le réglage Mode Piste Universel.
Tampon de disque large
Cette option joue sur la quantité de données audio qui sont lues à l’avance sur le disque. Cette option est désactivée par défaut pour s’adapter aux exigences de disques 
durs rapides et d’ordinateurs puissants. Si vous voyez s’afficher de fréquents messages 
d’erreur alors que Logic fonctionne dans ce mode, il est préférable de la réactiver, de 
façon à pouvoir lire davantage de pistes, de façon plus fiable. Cela nécessite néanmoins davantage de RAM.
Enregistrement en 20/24 bits
Avec Logic vous pouvez enregistrer des fichiers en 24 bits si cette option est activée. 
Cela n’a néanmoins de sens que si votre interface travaille effectivement en 20 ou 24 
bits. Si votre équipement support cette résolution, vous pouvez sélectionner cette 
option dans la fenêtre Audio > Audio Hardware & Pilotes. 
Les enregistrements en 20 ou 24 bits offrent une amélioration significative de la dynamique, mais nécessitent des composants périphériques de qualité, tels que microphones, préamplis et convertisseurs AN/NA. Les fichiers 24 bits utilisent 1,5 fois plus de 
place sur le disque que des fichiers 16 bits comparables.
Note :  Vous trouverez de plus amples informations sur l’usage de ces résolutions, au 
chapitre suivant. 
Monitoring logiciel
Cette option permet d’activer ou non le Monitoring Logiciel (écoute du signal d’entrée 
réel). Veuillez noter que si l’option Monitoring logiciel est activée, l’écoute de contrôle 
de l’audio est assurée par Logic, donc un certain retard audible (communément appelé 
latence) est inévitable, bien qu’il puisse être suffisamment court pour rester inaudible. 
Si vous écoutez le signal enregistré via votre console de mixage ou si votre matériel 
audio est équipé d’un système de monitoring, vous pouvez laisser cette option désactivée.
La décision d’activer le Monitoring Logiciel, ou d’écouter le signal entrant en sortie de 
votre console de mixage (analogique), dépend du temps de latence que vous obtenez 
sur votre système.12 Chapitre 1    Matériel et pilotes audio
Paramètres DAE
Les paramètres DAE ne peuvent être réglés qu’après avoir activé le DAE. Pour cela, 
cochez la case Actif située en haut à gauche du panneau DAE. Vous aurez ensuite accès 
aux paramètres suivants :
Résolution Globale
Permet de choisir entre une résolution de 16 bits ou 24 bits en lecture et en enregistrement. 
Note :  Le DAE ne permet pas de travailler en 16 bits et 24 bits simultanément.
Type PT HD 
Ce paramètre permet de définir le nombre de pistes pour votre système PT HD ou HD 
Accel. Chaque option de ce menu permet de définir le nombre de pistes nécessaire, en 
fonction du nombre de PT HD DSP que vous désirez employer (et que vous possédez 
réellement) dans votre système.
Type MIX Card
Cette option de menu local détermine le nombre de pistes possible pour votre système MIX Card. Les options sont 32 pistes ou 64 pistes. Un réglage de 32 pistes économisera des ressources. Il est fortement recommandé, si vous utilisez DTDM en parallèle 
avec un matériel MIX.
A propos des fréquences d’échantillonnage et des résolutions
Certaines cartes audio, telles que Pro Tools HD, autorisent des fréquences d’échantillonnage élevées telles que 88.2, 96, 176.4 ou 192 kHz. Logic Pro est compatible avec 
de telles fréquences d’échantillonnage. Celles-ci peuvent être sélectionnées dans le 
menu Audio > Fréquence d’Échantillonnage. N’oubliez pas que ces fréquences d’échantillonnage élevées consomment deux à quatre fois plus d’espace disque, et que le 
Moteur Audio sera sollicité pour travailler deux fois à quatre plus vite. De plus, il faut 
considérer que l’amélioration de la qualité audio des enregistrements en 96 kHz, 
comparés à ceux en 44,1 kHz, est relativement mineure. Il y a une différence plus 
significative entre les enregistrements en 16 et 24 bits. La plupart des ingénieurs du 
son considère qu’un enregistrement en 44,1 kHz, 24 bits et le meilleur rapport entre 
qualité et usage efficace des ressources. Pour la production de DVD des fréquences 
d’échantillonnage plus élevées peuvent être nécessaires. 
Logic permet la lecture simultanée de fichiers audio ayant des résolutions en bits différentes (16 et 24) dans un même morceau, utilisant un moteur audio natif. 
SI vous désirez utiliser ces deux résolutions de façon native, vérifiez que le moteur 
DAE est réglé sur 24 bits. Chapitre 1    Matériel et pilotes audio 13
Indicateur TDM Setup
L’indicateur TDM Setup est une fenêtre de statut qui indique le processus TDM en 
cours, tel que lors de l’insertion d’un plug-in TDM, par exemple. Ce paramètre permet 
d’afficher ou pas cette fenêtre.
Relâcher en tâche de fond si arrêt
Nous recommandons fortement de ne pas désactiver cette option tant que le DAE et le 
pilote indépendant Digidesign Core Audio supporte cette fonction. 
L’activation de ce paramètre libérera le matériel TDM lorsque Logic n’est pas en mode 
Lecture ou Enregistrement, ce qui permet l’adressage de ce matériel par une autre 
application—telle que le logiciel Pro Tools ou un programme d’édition d’échantillons.
Paramètres communs 
En bas de chaque panneau des Pilotes vous pouvez voir quatre menus déroulants, contenant les réglages suivants.
Taille du buffer de calcul
Ce paramètre détermine la taille du buffer natif servant à calculer les mixages et les 
effets. Vous avez le choix entre des tailles de buffer Petit, Médium et Large. 
Note :  Des tailles de buffer élevées augmenteront la latence. Selon la vitesse du processeur, des tailles de buffer trop petites peuvent compromettre le traitement audio temps 
réel.














 























 

